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What’s new

What’s new in Motion
Motion 5.8 includes bug fixes and improved color adjustments, detailed below.

Enhance light and color
Automatically improve the color, color balance, contrast, and brightness of video or still 
images, powered by machine learning. See Color Adjustments filter.

System requirements
The minimum system requirement is macOS Sonoma 13.5. For more information, go to the 
Final Cut Pro tech specs webpage, then click Motion at the top of the page.

https://www.apple.com/final-cut-pro/specs/
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Motion basics

What is Motion?

Motion is a behavior-driven motion graphics application used to create stunning imaging 
effects in real time for a wide variety of broadcast, video, and film projects.

Animate anything, your way
•	 Animate graphics, images, and video clips using any of more than 200 built-in motion, 

simulation, and camera-move behaviors, such as Spin, Throw, Orbit, Dolly, and more.

•	 Animate the traditional way, using keyframes to create precise timing effects.

•	 Animate individual parameters of graphics and images—such as position, scale, and 
opacity—to make your visuals oscillate, wriggle, sync to music, dance randomly, and 
more.

•	 Build sophisticated particle systems to unleash animated swarming effects in 2D or 3D 
space.

•	 Boost production value by choosing ready-to-use animated content from a library of 
more than 1,300 professionally designed graphics.
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Set your text in motion
•	 Create polished text and then set it in motion to construct effects both simple (lower-

third titles and credit rolls) and complex (animated sequences).

•	 Build and animate 3D text with realistic texture, lighting, and shading. 

Blow minds, not budgets, with cinematic visual effects
•	 Build stunning visual effects and film looks using one or more of nearly 300 filters such 

as Glow, Strobe, Slit Scan, and Bleach Bypass.

•	 Create advanced compositing and color key effects (green screen and blue screen).

•	 Stabilize camera shake or create complex motion tracking effects such as match moving 
and corner-pinning.

•	 Retime footage to create high-quality slow-motion or fast-motion effects.

•	 Import clips recorded in Cinematic mode on iPhone, then create rack focus effects, 
switch focus between subjects, or modify depth of field.

Add depth and color to your production
•	 Orchestrate fluid 3D motion graphics for show intros, bumpers, commercials, or title 

sequences.

•	 Create advanced 3D compositions by adding and animating 3D objects or moving 
cameras in 3D scenes.

•	 Import and reorient 360° video, then apply effects and integrate titles or other graphics 
to create 360° Motion projects or 360° templates for Final Cut Pro for Mac.

•	 Automatically match the brightness of vibrant high dynamic range (HDR) media with 
standard dynamic range (SDR) elements in the same project, and quickly preview the 
project in different SDR and HDR color spaces.

Design next-level graphics effects
•	 Draw shapes, transparency masks, and gesture-based paint strokes to build advanced 

art compositions, then animate them using behaviors or keyframes. You can also 
rotoscope masks with keyframes to create traveling mattes. 

•	 Build complex patterns of repeating elements using the powerful replicator tool, then 
animate the resulting collages in 2D or 3D space.

•	 Maximize your compositions with royalty-free content, such as vector artwork, animated 
design elements, image generators, and high-resolution images.
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Integrate seamlessly with Final Cut Pro for Mac
•	 Create custom effect, transition, title, and generator templates for use in Final Cut Pro. 

You can also use Motion to customize the effects, transitions, titles, and generators that 
ship with Final Cut Pro.

•	 Create effect, transition, title, and generator templates that automatically conform to 
the color space of the Final Cut Pro project it’s applied to.

•	 Use rigging to map multiple parameters to a single control (for example, a slider that 
simultaneously manipulates size, color, and rotation of text) in Motion compositions or 
in templates exported to Final Cut Pro.

Export and share everywhere
•	 Export your masterpiece (or working copy) for use in other apps, publish it to video-

sharing websites, or optimize it for viewing on Apple devices such as iPad, iPhone, and 
Apple TV.

Note: For a complete list of topics covered in this user guide, click the Table of Contents at 
the top of the page.

Motion workflow
The basic process of working in Motion is described below. You don’t have to do every 
step, and you might do other tasks that aren’t listed here.

Step 1: Create a project
You can create a blank project, open a preset composition, or create a template for use in 
Final Cut Pro for Mac.

Step 2: Add media 
Typically, you import media to create a composition. You can, however, create entire 
projects using the built-in content that comes with Motion, such as preset particle 
emitters, text, or generators. Each media item added to your project becomes a layer in 
your composite.
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Step 3: Add or create effects
You can modify your media by applying filters, behaviors, and other built-in effects that 
come with Motion. Whether you’re building simple animated backgrounds, creating green 
screen composites or 3D composites, or assembling complex motion graphics animations, 
the effect possibilities are nearly limitless.

Step 4: Share your composition
When your project is finished, you can export it as a QuickTime movie, export it for viewing 
on Apple devices such as iPhone and iPad, or export it as an image sequence. You can also 
export a single frame or export a single selection as a movie.

Motion interface
The Motion interface is divided into several functional areas.

Project Browser
When you open Motion, the Project Browser appears. Use this window to create new 
projects or open existing projects.

See Create a new project.
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Motion window
After you open a project via the Project Browser, the Motion window appears. Use this 
window to build, modify, and preview your motion graphics projects.

By default, the Library and Inspector appear on the left side of the window. Choose 
Window > Window Layout, to set your workspace to one of two layouts: 

•	 Classic: The Library and Inspector appear on the left side of the Motion window, and 
the Timing pane is full width. Use this layout when working heavily in the Timeline, 
Keyframe Editor, or Audio Editor.

Note: If you have two displays connected to your computer, you can show the Timing 
pane (or canvas) on the second display to maximize your workspace. See Use a second 
display.

•	 Cinema: The Library and Inspector appear on the right side of the Motion window, 
and the Project pane is full height. Use this layout when working with many layers and 
groups.

The Motion window is divided into several functional areas, described in detail below.
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Library
The Library, located on the left side of the Motion window, contains effects, content, 
presets, behaviors, filters, and other elements available in Motion. You can expand the 
built-in Library content by adding fonts, music, or photos, or by saving content and effects 
that you create in Motion.

When you select an item in the Library, a visual preview appears in the top-left corner of 
the Motion window. This preview area also contains text information for the selected item, 
such as a description of the behavior, filter, or generator.
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Inspector
When you select an object in your Motion project—an image, video clip, or effect—its 
parameter controls become available in the Inspector, located on the left side of the Motion 
window, ready for adjustment.
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There are four Inspector categories, each of which displays parameter controls for the 
selected object:

•	 Properties Inspector: Contains controls for setting basic attributes of the selected 
object, such as position, scale, and blending.

•	 Behaviors Inspector: Contains controls for adjusting attributes of behaviors—animation 
and simulation effects that you can apply to objects in your project.

•	 Filters Inspector: Contains controls for adjusting attributes of filters—visual treatments 
that you can apply to objects in your project.

•	 Object Inspector: Contains controls that vary depending on the type of object selected. 
The name of this Inspector is also context-sensitive, changing depending on the type of 
object selected, such as Camera, Text, or Shape.

If you want the Inspector to remain locked to a specific pane for a selected object, click the 
pin button in the preview area (at the top of the Inspector). Then, when you select another 
object, the pinned Inspector does not change.

Heads-up display (HUD)
The most commonly used Inspector controls are also available in the heads-up display 
(HUD), a floating window that you can show or hide. See Transform layers in the HUD. 
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Project pane
The Project pane contains three lists, each of which provides access to a different aspect 
of your project:

•	 Layers list: Displays the hierarchy of objects (groups, layers, cameras, lights, behaviors, 
filters, and so on) in your project.

•	 Media list: Shows the files imported into your project.

•	 Audio list: Provides access to, and control of, audio files in your project.

More than simple lists of items in a project, these panes let you organize key attributes of a 
motion graphics composition, including the stacking order of image layers, audio settings, 
and source media settings.
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Canvas
The canvas is the visual workspace where you modify and arrange objects in your 
composition. What you see in the canvas is what is exported when you share your project.

Toolbar
The toolbar at the top of the Motion window contains controls to import media, add effects 
and other objects to your project, display interface components, and export your finished 
project.

To arrange toolbar controls to your liking, Control-click the toolbar, choose Customize 
Toolbar from the shortcut menu, then drag items from the window that appears to the 
toolbar. Use the Show pop-up menu in the customization window to display toolbar 
controls without their names, or to reduce the size of toolbar controls.
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Canvas toolbar
In the canvas toolbar, located in the center of the Motion window (under the canvas), you 
can access tools for creating and transforming objects. There are tools to manipulate 
objects in 2D or 3D space, to zoom or pan in the canvas, and to create text, shapes, and 
masks.

Timing toolbar
In the timing toolbar, located immediately below the canvas toolbar, you can access 
controls for project playback (transport controls) and keyframe recording. The timing 
toolbar also contains buttons to show or hide elements in the Timing pane.

Timing pane
The Timing pane, located at the bottom of the Motion window, lets you view and modify the 
time component of a project’s contents. There are three views to control different timing 
aspects of a project:

•	 Video Timeline: Provides an overview of objects in the project and how they’re laid out 
over time.

•	 Audio Timeline: Provides an overview of audio components in the project and how 
they’re laid out over time.

•	 Keyframe Editor: Displays the animation curves for animated parameters and effects.
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Basic components of Motion
The composition you build in Motion, then save and share, is called a project. The basic 
components of your project—images, video clips, applied special effects, and so on—are 
represented in the interface as objects that you can select, drag, and manipulate in various 
ways. There are several categories of objects that you’ll use in every project:

•	 Groups: The basic containers used in a project to organize imported media and Motion 
content and effects. A group can contain one or more objects, as well as other, nested 
groups.

•	 360° environments: The basic containers used in a project to organize imported 360° 
video. A 360° environment can contain 360° footage and standard footage, as well as 
filters.

See Intro to 360° video.
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•	 Layers: A specific kind of object that you can see in the canvas, including:

•	 Images or video clips: Still pictures and movies that you import into Motion. See Intro 
to adding and managing content.

•	 Shapes: Rectangles, circles, lines, and more complex shapes that you create in 
Motion using the shape tools. See Intro to shapes, masks, and paint strokes.

•	 3D Objects: 3D models in the USDZ format that you can add to your Motion project 
from the Library or import into Motion. See Intro to 3D objects.

•	 Masks: A special type of shape used to create regions of transparency in layers. See 
Intro to shapes, masks, and paint strokes.

•	 Paint strokes: Freehand shapes drawn in a single, continuous movement, or existing 
shapes that are converted into strokes. See Intro to shapes, masks, and paint 
strokes.

•	 Text: Type that you can add and animate in a project. See Intro to basic text.

•	 Particle systems: Sophisticated animation effects composed of swarming small 
particles. You can create your own particle systems or apply the pre-built particle 
systems that come with Motion. See Intro to particles.

•	 Replicators: Patterns of repeating visual elements you can create or apply to build 
cascading arrays of kaleidoscopic imagery. See Intro to replicators.

•	 Generators: Graphical images that come with Motion, including colors, stripes, 
gradients, and other patterns that you can add to your project. See Intro to using 
generators.

•	 Effects objects: Special effects that you apply to visual layers. Effects objects are not 
visible in the canvas on their own; rather, they modify the visual layers you see in the 
canvas. Motion includes the following effects objects: 

•	 Cameras: An angle of view that you can adjust or animate to create the illusion of 
panning, dollying, or zooming through your composition. See Add a camera.

•	 Lights: Simulated illumination sources that you can direct at any visible layer in the 
canvas. See Add lights.

•	 Behaviors: Sophisticated animation and simulation effects that you can apply to the 
visual layers in your project. For example, you can use the Spin behavior to make a 
shape rotate over time at a rate you specify. See Intro to behaviors.

•	 Filters: Special visual effects used to modify the appearance of visual layers in 
Motion. For example, you can use a blur filter to make an image or shape appear to 
be out of focus. You can also animate filters. See Intro to filters.

In the Motion User Guide, the term object is often used to describe the superset of all 
elements (groups, layers, and effects objects) that comprise and act upon a composition. 
Layer, however, always refers to the image-based elements acted upon—the visual media 
you see in the canvas.
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Using input devices with Motion
If you have a two-button or three-button mouse connected to your computer, you can 
right-click to access the same controls specified by the Control-click commands in this 
documentation.

Some keyboard shortcuts require you to use the Function key (Fn—next to the Control key) 
in conjunction with the keys specified in the user documentation. For more information 
about keyboard shortcuts in Motion, see Keyboard shortcuts.

If you have a trackpad or Magic Mouse, you can use various gestures for interface 
navigation, scrolling, frame-scrubbing, and zooming. You can also use gestures to change 
the size of icons in the Library. These gestures are discussed in their relative sections of 
the documentation.

For more information about trackpad and Magic Mouse gestures, choose Apple menu () > 
System Settings, then click Trackpad.

If your MacBook Pro has a Touch Bar, you can use familiar gestures like swipe and tap to 
quickly perform tasks in Motion. The Touch Bar contents are dynamic: The controls change 
depending on your current selection within Motion and other applications. Related buttons 
and sliders appear together in groups in the Touch Bar. See How to use the Touch Bar on 
your MacBook Pro.

https://support.apple.com/guide/mac-help/touch-bar-mchlbfd5b039/mac
https://support.apple.com/guide/mac-help/touch-bar-mchlbfd5b039/mac
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Create and manage projects

Intro to creating projects in Motion
Creating a project is the first step in the Motion workflow. The easiest way to create a new 
project (or to open an existing project) is to use the Project Browser window. When you 
open Motion, the Project Browser appears.

Use the options in the browser to specify the type of project you want to open:

•	 A new standard (“blank”) Motion project

•	 A previously opened Motion project

•	 A predesigned composition template that you can customize

•	 A new blank project based on one of the supplied Final Cut Pro templates (effects that 
you build in Motion for use in Final Cut Pro)

•	 A new, blank 360° Motion project or 360° Final Cut Pro template
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Before opening the new project, you can also use the Project Browser to modify your 
project properties—resolution (width and height), frame rate, duration, color processing, 
or aspect ratio. For example, you might want to choose properties to match your planned 
output format.

Regardless of the project properties you choose, after you create a project, Motion lets you 
import nearly any kind of media file supported by QuickTime. Further, you can mix media 
files with different properties in the same project. For example, you can combine video 
clips of different frame sizes with graphics files. In the end, the file you export uses the 
frame size and frame rate specified by the project properties.

After you create a project, you can or save or revert it, play it back, or modify its 
properties.

Create a new project in Motion
You can create a Motion project from scratch, using the standard project settings or 
custom properties.

Create a basic project
1.	 Open Motion, then choose File > New from Project Browser (or press Option-

Command-N).

2.	 In the Project Browser, select the Blank category in the left sidebar, then click the 
Motion Project icon.

3.	 In the right column, click the Preset pop-up menu and choose an option.

4.	 In the right column, click the Frame Rate pop-up menu and choose a frame rate.

Important: Frame rates cannot be changed after you create a project.

5.	 Click Open.

An untitled Motion project opens. The project is not saved to your storage device until 
you choose a save command from the File menu. For information about saving project 
files, see Save, autosave, and revert projects.

A new project with the settings you specified opens in the Motion window.

Create a project with custom properties
1.	 Open Motion, then choose File > New from Project Browser (or press Option-

Command-N).

2.	 In the Project Browser, select the Blank category in the left sidebar, then click the 
Motion Project icon.
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3.	 In the right column, click the Preset pop-up menu, then choose Custom.

Additional properties controls appear.

4.	 Set the resolution (width and height), projection type, color processing, field order, 
aspect ratio, frame rate, and default duration for your custom project.

See Project Properties Inspector controls.

5.	 Click Open.

A new, untitled Motion project opens using the custom properties you specified.

Create a 360° video-ready project
1.	 Open Motion, then choose File > New from Project Browser (or press Option-

Command-N).

2.	 In the Project Browser, click a project icon (such as Motion Project or Final Cut Effect).

3.	 In the right column, click the Preset pop-up menu, then choose a 360° Video option.

4.	 Click Open.

A new, untitled 360° Motion project opens.

See Intro to 360° video.
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Create a project prepopulated with specific media files
Creating a prepopulated project is an easy way to ensure your Motion project is set to the 
correct resolution, frame rate, and color processing of your source clips.

1.	 In Motion, do one of the following:

•	 Choose File >  Import As > Project (or press Shift-Command-I).

•	 Open the Project Browser, then click Import as Project.

2.	 In the dialog that appears, navigate to and select one or more media files, Shift-clicking 
to select contiguous items or Command-clicking to select noncontiguous items.

3.	 If needed, set the frame rate, aspect ratio, field order, and audio mix settings (by 
clicking Options in the dialog).

Fixed settings inherent to the selected files remain dimmed, but will propagate to the 
new project. For example, because movie files have an inherent frame rate, aspect ratio, 
and field order, those settings are dimmed in the dialog.

Except for the Frame Rate parameter, these settings can be modified after the project is 
created, in the Properties Inspector. See Intro to project properties.

Note: If you selected an item from an image sequence, select the Image Sequence 
checkbox to have Motion use each image as a frame in a video clip. See Image 
sequences. 

4.	 Click Import as Project.

A new project populated with the media you selected opens.
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Open an existing project in Motion
You can open projects and templates from the Project Browser, the Motion File menu, or 
the Finder.

Open a project from the Project Browser
1.	 In Motion, open the Project Browser (press Command-N), then select a project category 

in the sidebar.

2.	 Select an item from the middle of the browser.

A video preview, if available, plays in the preview area on the right.

3.	 If necessary, modify the resolution, frame rate, and default duration using the pop-up 
menus above the preview area.

4.	 Click Open.

The Project Browser closes and the project you selected opens in the Motion window. 

Open a project file from within Motion using the Open command
1.	 With Motion open, choose File > Open (or press Command-O).

2.	 In the dialog that appears, navigate to the project file you want, then click Open.

Open an existing Motion project file that does not appear in the Project Browser
Using the buttons at the bottom of the Project Browser, you can also open a specific 
project that doesn’t appear in the Project Browser, but is accessible through the Finder.

1.	 In the Project Browser in Motion, click Open Other (or press Command-O).

2.	 In the dialog that appears, navigate to a Motion project file, select it, then click Open.
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Open a recent project
Do either of the following:

•	 In Motion, choose File > Open Recent, then choose a project from the submenu.

•	 From the Project Browser in Motion, click Recent in the sidebar, select a project from 
the center of the browser, then click Open.

Open a project file from the Finder
From the Finder, do one of the following:

•	 Double-click a Motion project file. 

•	 Drag a Motion project file onto the Motion application icon in the Applications folder or 
in the Dock (if you’ve placed a Motion application icon in the Dock).

•	 Select a Motion project file, then choose File > Open (or press Command-O).

•	 Control-click a Motion project file, then choose Open from the shortcut menu.

The project you selected opens in the Motion window.

 Tip: You can search for Motion projects in the Finder using Spotlight. See Search for 
projects from the Finder. 

Close a project
•	 Click the close button in the top-left corner of the Motion window (or press 

Command-W).

Note: If you’re working on a Mac with Apple silicon and you open a Motion project 
containing media in video formats that are incompatible with Apple silicon, a dialog may 
appear instructing you to install Rosetta. After installing Rosetta, you must quit and reopen 
Motion. For more information, see the Apple support article about Rosetta.

Search for Motion projects from the Finder
•	 In the Finder, click the Spotlight icon (the magnifying glass in the macOS menu bar), 

then enter a search term.

Spotlight indexes the following properties of Motion projects:

Project property Description

Layer name The name of a layer in a project

Media name The name of a media object in a project

Pathname The path to a media object in a project

Text The content of a text object in a project

Description Text in the Project Description field in the Properties 
Inspector

Marker name The name of a marker in the Timeline of a project

Marker comment Text of a marker comment in a project

https://support.apple.com/102527
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Bypass the Project Browser in Motion
If you consistently create projects with a specific preset, template, or other starting 
project, you can bypass the Project Browser. This way, when you create a project, it’s 
opened in the Motion window with the settings you established.

1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 Click Project.

3.	 In the For New Documents area, click Use Project.

Note: If you haven’t assigned a preset project, the setting reads: Use Project: Nothing 
Selected. When you choose a project, the text updates to reflect the name of the 
selected project.

4.	 Click Choose.

5.	 In the window that appears, select a category in the sidebar and a project type from the 
center area, then choose a preset (if available) from the right column.

6.	 Click Open.

The selected project is assigned to the Use Project option in the Project pane of the 
Settings window. From now on, the Project Browser does not appear when you choose 
File > New (or press Command-N). Instead, a new project opens in the format set in Motion 
Settings.

Create and modify project presets in Motion
If you commonly create projects using properties that don’t match any available preset, 
you can create a custom preset for future use. Presets are created, modified, and deleted 
in the Presets pane of Motion Settings.

Note: The Default checkbox in the Presets pane of Motion Settings has no effect. To set a 
default project preset, see Bypass the Project Browser.

Create a custom preset
1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 Click Presets.

3.	 Click the Add button (+) beneath the presets list.

4.	 In the Project Preset Editor, enter the following information:

a.	 Name: Type a name for the preset.

b.	 Description: Type a brief description of what that preset is for, including significant 
characteristics such as frame size and frame rate.

c.	 Width and Height: Enter a frame size.

d.	 Projection Type: Choose Normal to create a standard project preset or 360° 
Monoscopic to create a 360° project preset.
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e.	 Color Processing: Choose Standard Gamut SDR, Wide Gamut HDR, or Automatic.

f.	 Pixel Aspect Ratio, Field Order, and Frame Rate: Choose settings from the 
corresponding pop-up menus.

5.	 Click OK.

The new preset appears in the Presets pane and in the Preset pop-up menu in the 
Project Browser.

6.	 When you’re done creating project presets, close Motion Settings.

Note: For more information on industry-standard frame sizes, pixel aspect ratios, field 
order, and frame rates, see Supported media formats.

Duplicate and edit an existing preset
The project presets that come with Motion cannot be modified. However, you can duplicate 
an existing preset and then modify it.

1.	 In Motion Settings, select a preset in the Presets pane.

2.	 Click Duplicate.

The duplicated preset appears underneath the original preset with “copy” appended to 
its title.

3.	 Select the duplicated preset, then click Edit.

If you select a built-in preset (designated by a lock icon), an alert dialog appears asking 
if you want to duplicate the preset.

4.	 When the Project Preset Editor appears, make your changes, then click OK.

Note: You cannot edit or delete locked project presets.

Delete a custom preset
1.	 In Motion Settings, select a preset in the Presets pane.

2.	 Click the Delete button (–) underneath the presets list.

Note: You cannot edit or delete locked project presets.
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Save, autosave, and revert projects in Motion
It’s wise to save early and often as you work on your project. In addition to preserving your 
work for future use, Motion’s save commands can be used in other ways to manage the 
development of your project. For example, if you want to keep your current composition 
but create a variant version, use the Save As command. If you want to gather all media 
used in a Motion project into a single folder, use the Collect Media option when you save. 
There are also commands that let you revert to a previously saved version of your project. 

Save a project
1.	 In Motion, choose File > Save (or press Command-S).

If the project has not been saved, a save dialog appears.

Note: If the project has been saved, the project file is updated without opening a dialog.

2.	 Enter a name into the Save As field, choose a save location on your computer or storage 
device, then click Save.

Save a duplicate of a project
1.	 In Motion, choose File > Save As (or press Shift-Command-S).

2.	 In the dialog that appears, enter a name in the Save As field, choose a save location on 
your computer or storage device, then click Save.

Save a project and collect all project media into a folder
When saving a project, you can have Motion copy all media files used in the project into a 
single folder, making portability and backup easier.

1.	 In Motion, choose File > Save As (or press Shift-Command-S).

2.	 In the dialog that appears, click the Collect Media pop-up menu, then choose Copy to 
Folder.

If you want to collect all media files in your project, including those not used in the 
current composition, select Include Unused Media.

3.	 Enter a new name for the file in Save As field, choose a save location on your computer 
or storage device, then click Save. 

Motion creates a folder with the name specified in the Save As field and places two 
items in the folder:

•	 A project file with the same name as the folder

•	 A folder named “Media” containing all media files used in the project
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Important: When using the Save As command, use a name that’s different from the 
name of any previously saved versions of the same project. Otherwise, you run the risk 
of overwriting a version of the project that you want to keep.

Revert a project to the last saved version
The Revert to Saved command discards all changes you’ve made to a project since the last 
time you saved it.

Note: You can also use the application’s unlimited undo feature to achieve the same 
purpose in incremental steps. For more information on the Undo command, see Edit menu.

•	 In Motion, choose File > Revert to Saved.

Important: This command cannot be undone.

Autosave projects to a specific storage location
By default, Motion automatically saves backups of your project at set intervals. In the 
Cache pane of Motion Settings, you can specify how frequently projects are autosaved, as 
well as the storage location of the autosaved project files. Autosaved project files are time- 
and date-stamped.

1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 Click Cache.

3.	 In the Autosave area, select Use Autosave Vault (if it’s not already selected).

By default, the Autosave Vault folder is located in your /Users/username/Movies/Motion 
Projects/ folder.

4.	 If you want to set a different location for the Autosave Vault folder, click Choose, select 
a new location, then click Choose.

Revert to an autosaved project
If you’ve been using the autosave feature to back up your project, you can revert your 
project to an earlier autosaved version.

1.	 In Motion, choose File > Restore from Autosave.

2.	 In the dialog that appears, click the pop-up menu, then choose a saved project.

The autosaved project opens in a new project window.
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Use templates

Intro to using templates in Motion
There are two kinds of templates in Motion: composition templates and Final Cut Pro 
templates. This section discusses composition templates. For information on 
Final Cut Pro for Mac templates, see Intro to Final Cut Pro templates. 

Composition templates are premade, royalty-free projects that you can customize. They’re 
intended to simplify the process of creating professional-looking titles and graphics, 
especially for recurring projects such as television series. Using composition templates, 
you can:

•	 Create placeholder layers (called drop zones) for easy placement of custom video or 
graphics.

•	 Customize placeholder text without overriding effects or keyframes already applied to 
the template text.

•	 Modify animation already applied to a template to suit your own timing needs.

Create projects from templates in Motion
Motion templates—shown in the Compositions category in the Project Browser sidebar—
are premade, royalty-free projects that you can customize. Each template contains 
graphics, text objects, and backgrounds.

You can also create custom templates for commonly used shots that you regularly create. 
For example, if you make titles for a news program, you can create templates for the 
opening title, interstitial graphics, bumpers, and other repetitious shots.

Create a project from a composition template
You can open a composition template from the Project Browser.

1.	 Open Motion, then choose File > New from Project Browser (or press Option-
Command-N).

2.	 In the Project Browser, select a category from the Compositions section in the sidebar.

The compositions for that category appear in the middle of the browser.
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3.	 Click a composition to see its basic properties (resolution, duration, and frame rate) and 
an animated preview on the right.

4.	 To create a project from the selected composition, click Open a Copy.

A new project opens in the Motion window. You can customize the project by editing the 
text or exchanging the graphic elements with your own. The changes you make to projects 
created using compositions do not overwrite the source template files.

Note: After you’ve installed Motion, additional compositions (and Library content) are 
available. See the Apple Support article About Motion Supplemental Content.

Create and save an original composition template
You can also build a custom template from scratch and save it to the Project Browser. 
Custom templates are standard Motion projects saved in a special way.

1.	 With a standard Motion project open, choose File > Publish Template.

2.	 In the dialog that appears, enter a name for the template and choose a category from 
the pop-up menu.

To create a custom category, click the Category pop-up menu, choose New Category, 
enter a descriptive name, then click Create.

3.	 Click the Theme pop-up menu, choose New Theme, enter a descriptive name, then click 
Create.

4.	 If you want the template project to retain media in the Media list that isn’t present in the 
composition, select “Include unused media.”

5.	 If you want a preview of the template to appear in the Project Browser, select Save 
Preview Movie.

Note: If you want to add the template to a Final Cut Pro project, select “Publish as 
Final Cut Generator.” See Intro to Final Cut Pro templates.

6.	 Click Publish.

The template is now available in the Project Browser, in the Compositions category you 
chose in step 2.

https://support.apple.com/103282
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Create stickers in Motion for the Messages app on iOS and 
iPadOS devices
If you’re a developer, you can create animated stickers for the Messages app on iOS and 
iPadOS devices. To simplify the process, you can use one of the premade sticker templates 
available in the Project Browser (or you can create a project from scratch).

1.	 Open Motion, then choose File > New from Project Browser (or press Option-
Command-N).

2.	 In the Project Browser, click Stickers in the Compositions section in the sidebar.

3.	 Click a composition in the middle of the browser to see its basic properties and an 
animated preview on the right.

The three available sticker sizes are those supported by the Messages app:

•	 Small: 300 x 300 pixels

•	 Medium: 408 x 408 pixels

•	 Large: 618 x 618 pixels

Note: Although you can change the duration of the project once it’s created, a two-
second duration or less is required for all sticker compositions.

4.	 To create a sticker project from the selected composition, click Open a Copy.

Modify your sticker project like any other Motion project by adding shapes, behaviors, 
filters, and so on.

Important: Your final render must be less than 500 KB. For best results, keep your 
project simple using line drawings and text. Additionally, avoid using filters that create 
animated change over time, such as the Noise filter (all of that information must be 
compressed for each frame, increasing the size of your project).

5.	 When you’re ready to render your project, choose Share > Export Image Sequence, 
choose PNG from the Export pop-up menu (in the Settings pane of the Export Image 
Sequence window), select the Create Sticker Sequence checkbox, then click Next.

6.	 Enter a name and choose a save location for the exported file, then click Save.

For more information, go to developer.apple.com/support/stickers/motion/ or developer.
apple.com/documentation/messages.

https://developer.apple.com/support/stickers/motion/
https://developer.apple.com/documentation/messages
https://developer.apple.com/documentation/messages
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Replace template media using drop zones

Intro to drop zones in Motion

Drop zones are placeholder graphics where template users can drag images or video to 
customize the project. When you modify one of the built-in composition templates that 
come with Motion, or create a composition template from scratch, you can add drop zone 
layers. A drop zone layer appears (in the canvas and in the Layers list) as a rectangle with 
a down arrow in its center. In the canvas, the drop zone’s layer name appears in the center 
of the graphic. Any media item (image or footage) dragged into the region defined by the 
drop zone replaces the drop zone placeholder graphic.

Note: If there are multiple overlapping drop zones in the canvas, the topmost one has 
priority when you drag an item over the zone. You can force all drop zones to appear by 
using the expose feature. See Control and expose drop zones.

Adding a drop zone to a Final Cut Pro template in Motion enables Final Cut Pro users to 
easily assign media to an editing project. See Intro to Final Cut Pro templates.

Create drop zones in Motion

You create drop zones in either of two ways: by adding an empty drop zone object or by 
converting an existing layer into a drop zone.

Add an empty drop zone
1.	 In Motion, choose Object > New Drop Zone or press Shift-Command-D.

A drop zone layer is added to the project.

2.	 Position and scale the drop zone layer.

3.	 If needed, rename the drop zone layer in the Layers list.

4.	 Open the Inspector and click Image to modify the drop zone parameters. 

For more information about using these parameters, see Drop zone controls.
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Resize a drop zone
1.	 In the Layers list or canvas in Motion, select a drop zone.

2.	 In the canvas toolbar, click the Select/Transform tool.

3.	 In the canvas, drag a transform handle to resize the drop zone.

 Tip: Press Shift while dragging to resize the drop zone proportionally.

Convert an image layer to a drop zone
1.	 Add a video clip or still image to your Motion project.

2.	 Position or resize the image or clip where you want the drop zone to appear.

For information about positioning and scaling images, see Intro to transforming layers in 
the canvas.

3.	 Open the Image Inspector and click the Drop Zone checkbox.

The drop zone parameters appear.

4.	 To replace the original image with a drop zone graphic, click the Clear button.

An active drop zone replaces the original image. For more information about using 
remaining Drop Zone parameters, see Drop zone controls.
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Modify drop zone images in Motion

After you add a source image to the drop zone, you can pan or resize the image within the 
boundary of the drop zone. You can add a solid color to the drop zone to fill empty areas 
that are the byproduct of panning or resizing the image.

Add an image to a drop zone
In Motion, do one of the following:

•	 In the toolbar, click Import, then drag an image from the dialog that appears to the drop 
zone in the Layers list or canvas. When the pointer changes to a curved arrow, release 
the mouse button.

•	 Drag an image from the Layers list, Library, Finder, or Media list (in the Project pane) to 
the drop zone in the Layers list or canvas. When the pointer changes to a curved arrow, 
release the mouse button.

•	 Drag an image from the Media list to the Source Media well in the Image Inspector.

•	 In the Image Inspector of the drop zone, click To and select a media item in the project 
from the pop-up menu.

Scale a drop zone image in the canvas
1.	 In Motion, select the drop zone.

2.	 Do one of the following:

•	 In the canvas, double-click the drop zone.

The Adjust Item tool is automatically selected.

•	 In the canvas, Control-click the drop zone, then select Drop Zone Pan & Scan.

•	 In the canvas toolbar, click and hold the transform tools pop-up menu, then select 
Adjust Item.

The drop zone bounding box appears as a dotted line.

3.	 Drag the scale handles in the canvas to resize the image.

The image’s bounding box appears as a solid line and scales uniformly. Portions of the 
image that extend beyond the edges of the drop zone appear semitransparent.
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Scale a drop zone image in the Inspector
1.	 In Motion, select the drop zone.

2.	 In the Image Inspector, drag the Scale slider.

To adjust the horizontal or vertical scale independently, click the Scale disclosure 
triangle to reveal the X and Y subparameters.

Note: The Scale parameter does not appear in the Inspector until an image is added to 
the drop zone.

Pan a drop zone image in the canvas
1.	 In Motion, select the drop zone.

2.	 Do one of the following:

•	 In the canvas, Control-click the drop zone, then select Drop Zone Pan & Scan.

•	 In the canvas toolbar, click and hold the transform tools pop-up menu, then select 
Adjust Item.

The drop zone bounding box appears as a dotted line.

3.	 Place the pointer over the drop zone image, and when the Pan tool appears, drag within 
the drop zone to pan the image.

The image’s bounding box appears as a solid line. The dotted line represents the edges 
of the drop zone. Portions of the image that extend beyond the edges of the drop zone 
appear semitransparent.

Pan a drop zone image via the Inspector
1.	 In Motion, select the drop zone.

2.	 In the Image Inspector, adjust the Pan parameter X and Y settings.

Note: The Pan parameter does not appear in the Inspector until an image is added to 
the drop zone.

Assign a background color to a drop zone
1.	 In Motion, select the drop zone.

2.	 In the Image Inspector, select the Fill Opaque checkbox.

Any empty portion of the drop zone is filled with black.

3.	 Use the Fill Color controls to choose a custom drop zone fill color.
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Drop zone controls in Motion

You can add any media object to any drop zone, but the object might not have the same 
dimensions as the drop zone. Motion provides controls to help ensure that the image 
placed in the drop zone is handled as you want—scaling, stretching, and positioning the 
object correctly. 

The Image Inspector contains the following drop zone controls:

•	 Type: A pop-up menu that converts the selected layer to a drop zone; click the pop-up 
menu, then choose Drop Zone to convert an image layer to a drop zone.

•	 Source Media: An image well that appears after an image is converted into a drop zone. 
Drag a media item to the well from the Media list to change the current drop zone 
image.

•	 To: A pop-up menu providing an alternative method of assigning media to the drop 
zone. The menu contains a list of media items in your project. Select an item to assign it 
to the drop zone.

•	 Pan: Value sliders to pan the media within the drop zone. Adjust the X value slider to 
move the media horizontally and the Y value slider to move the media vertically.

•	 Scale: A slider to uniformly scale the media in the drop zone. To resize the media 
horizontally or vertically, click the Scale disclosure triangle and adjust the X or Y 
parameter.

Note: The Pan and Scale parameters are not available until you add media to the drop 
zone.

•	 Fill Opaque: A checkbox that, when selected, fills the drop zone background with a 
color when the drop zone is scaled down or panned. If the Fill Opaque checkbox is not 
selected, the empty drop zone area remains transparent.

•	 Fill Color: A color control to set a color when the Fill Opaque checkbox is selected.

•	 Use Display Aspect Ratio: A checkbox that, when selected, resizes the drop zone 
according to selected Display Aspect Ratio Snapshot (in the Snapshots pane of the 
Project Inspector). For more information about display aspect ratios, see Add multiple 
aspect ratios to templates.

•	 Clear: A button to remove media from the drop zone, replacing it with a downward-
arrow graphic.
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Control and expose drop zones in Motion

When constructing your template, you can disable drop zones so you don’t accidentally 
apply media. Later, when using the template, you can turn drop zones back on.

You can also use the expose feature in Motion to reveal obscured drop zones in the canvas.

Turn drop zones on and off
•	 In Motion, choose View > Use Drop Zones.

A checkmark appears next to the menu item when drop zones are enabled (which means 
they accept objects dragged to them). When no checkmark appears next to the menu item, 
drop zones are disabled (which means they ignore objects dragged to them).

Expose all drop zones in a project
1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, and then in the dialog that appears, navigate to the item 
you want to import.

•	 In the Library or macOS Finder, navigate to the item you want to import.

2.	 While holding down the Command key, drag the item onto the canvas.

Objects in the canvas shrink and separate in an exploded view so you can see them all. 
Moving the pointer over an object reveals its Layers list name.

Note: You cannot Command-drag non-image objects (shapes, Motion projects, 
particles, and so on) to the canvas.

3.	 Release the mouse button to drop the object onto its target.

The object replaces its target, and the canvas view returns to normal.
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Template guidelines in Motion
When you work with templates, consider the following guidelines:

•	 Use descriptive group and layer names: Group and layer names in a template should 
describe each object’s function. For example, text objects in a titling template might be 
named “Main Title,” “Starring,” “Guest Star,” and so on. If you use visual elements in the 
template’s composition, their layer names should describe their function—“Background 
Texture,” “Divider,” and “Main Title Background,” for example. Descriptive layer names 
are especially important if others use the template.

•	 Create alternate versions of a template for each resolution you need: If you regularly 
create projects for a variety of output formats, you can build different display aspect 
ratios into a single template. For example, when you create a template with a 16:9 
aspect ratio, you can add an alternate version customized for 3:2 displays. For more 
information about creating alternate display versions in a single template, see Add 
multiple aspect ratios to templates.

•	 Place all media files used in a template in a central folder: To avoid problems with 
offline or missing media, move all media files for the template into a central folder 
on your computer before you begin working on the project. Although customized 
templates are saved in the /Users/username/Movies/ folder on your computer, media 
added to the template remains in its original location on disk. A central location for all 
media resources ensures that files are not lost. Alternatively, you can choose the File > 
Save As command, and use the Collect Media option. See Save, autosave, and revert 
projects.

Organize Motion templates in the Project Browser
You can organize and access custom templates in the Project Browser. All templates are 
organized into categories. You can add, delete, and rename categories in the Project Browser.

Add a category in the Project Browser
1.	 In Motion, choose File > New from Project Browser.

2.	 In the Project Browser, select a template type (Compositions, Final Cut Effects, Final Cut 
Generators, Final Cut Transitions, or Final Cut Titles) from the sidebar on the left.

3.	 Click the Add button (+) at the bottom of the sidebar.

4.	 In the dialog that appears, enter a name for the category.

5.	 Click Create.

The new category appears in the column on the left under the template type you 
selected.

Delete a category in the Project Browser
1.	 In Motion, choose File > New from Project Browser.

2.	 In the Project Browser, select a category in the sidebar. 

3.	 Press Delete or click the Delete button (–).

An alert dialog prompts you to confirm the deletion.

The folder on your system corresponding to that category is placed in the Trash, but is not 
deleted. Template files in that category’s folder are also placed in the Trash.
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Delete individual templates from the Project Browser
1.	 In Motion, choose File > New from Project Browser.

2.	 In the Project Browser, select a category from the sidebar, then select the template to 
delete.

3.	 Press Delete.

An alert dialog prompts you to confirm the deletion.

4.	 Click the Delete button.

Modify project properties

Intro to project properties in Motion
When you create a project, you specify a set of project properties—resolution, frame rate, 
color processing, duration, and so on. You can change most of these properties at any 
time, even after you add objects to the project.

The Properties Inspector lets you define the most essential attributes of a project. By 
choosing different parameters, you can accommodate nearly any video or film format you 
need to output to. These properties are the default settings used when you export your 
project.

Project background color, as well as how the background color is rendered, is also modified 
in the Properties Inspector.

Edit project properties in Motion
The Project object in the Layers list must be selected for the project’s Properties Inspector 
to be displayed. If another object is selected, that object’s properties are displayed in the 
Properties Inspector.
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Edit the properties of an existing project
1.	 In Motion, do one of the following:

•	 Choose Edit > Project Properties (or press Command-J).

•	 Select the Project object at the top of the Layers list, then open the Inspector and 
click Properties (if that pane is not showing already).

•	 Control-click an empty area of the canvas (in the gray area outside the project) and 
choose Project Properties from the shortcut menu.

The Properties Inspector opens.

2.	 In the Properties Inspector, change any necessary parameters.

Important: Project Frame Rate cannot be changed after a project is created.

The Properties Inspector for the project contains settings for video file format, 
timecode display, motion blur, and other project attributes.

Change the project background color
1.	 In Motion, do one of the following:

•	 Choose Edit > Project Properties (or press Command-J).

•	 Select the Project object at the top of the Layers list, then open the Inspector and 
click Properties.

The Properties Inspector opens. Two parameters in a project’s Properties Inspector 
affect the background color of a project and affect how a composition appears when 
exported out of Motion.

2.	 Set your project background properties using the following controls:

•	 Background Color: Use this color well to set the color appearing in the canvas when 
no other object obscures the background.

Note: When you export a project with a premultiplied alpha channel, Motion always 
renders against black.

•	 Background: Use this pop-up menu to set whether the background color is rendered 
as part of the alpha channel. If this menu is set to Solid, the background color 
creates a solid alpha channel. If it’s set to Transparent, the background color does 
not render as part of the alpha channel. In either case, the background color is 
visible in the canvas.

For more information about transparency, see Alpha channels.
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Project Properties Inspector controls in Motion
When the Project object is selected in the Layers list, the Properties Inspector is divided 
into several control groups: General, Rendering, Motion Blur, Reflections, and Description.

General controls
Use the controls in the General group to set or modify your project’s basic attributes.

•	 Preset: A pop-up menu to choose a common video format to base your preset on. After 
choosing a preset, you can adjust the other parameters in the Properties Inspector to 
customize your format settings. For more information about managing Motion project 
presets, see Create and modify project presets.

•	 Width and Height: A value slider to define the size of the canvas and the default output 
resolution of your project. Drag left or right over the values to decrease or increase 
them. Frame size is usually defined by the video format you plan on outputting to. For 
example, Broadcast HD video is 1920 x 1080, whereas 4K Ultra HD video has a frame 
size of 3840 x 2160.
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•	 Projection: A pop-up menu to set the project’s projection to Normal (flat video) or to 
360° Monoscopic (spherical video). If you are using 360° video, ensure Projection is set 
to 360° Monoscopic.

When a normal project is changed to a 360° project, existing root-level 2D groups are 
converted to 3D groups; you can navigate the project in 360° (the 360° Look Around 
and 360° Overview options are available in the Camera menu in the canvas); and the 
project is exported using the 360° Overview camera.

When you create a new 360° project (by choosing a 360° Video option in the Preset 
pop-up menu in the Project Browser), 360° Monoscopic is the default Projection 
setting. See Intro to 360° video.

•	 Pixel Aspect Ratio: A pop-up menu to set whether the project is created using square or 
nonsquare pixels. Computer displays, film, and high-definition video use square pixels, 
while standard-definition video uses nonsquare pixels. Choose Square for projects 
intended for the web, high-definition projects, and film, or choose a nonsquare pixel 
ratio corresponding to each international standard-definition broadcast format. A value 
slider to the right of this pop-up menu displays the numerical aspect ratio, in case you 
need to change the dimensions manually.

•	 Field Order: A pop-up menu to set field order if the project uses interlaced video. 
Project field order should match the field order of the device being used to output the 
resulting QuickTime file to video. When working with progressive-scan video or film, 
choose None.

•	 Frame Rate: A display field to see the project frame rate (in frames per second). Frame 
rate should match that of the format you output to. For example, film is 24 fps, PAL 
video is 25 fps, and NTSC video is 29.97 fps. 

Important: Frame rates cannot be changed for existing projects.

•	 Duration: A value field to modify the project’s Timeline duration. Use the adjacent pop-
up menu to define the duration units (Frames, Timecode, or Seconds).

•	 Override FCP Duration: A checkbox (available only in Final Cut Transition templates) 
that, when selected, overrides the default transition duration (as defined in the Editing 
pane of Final Cut Pro Settings). See Intro to Final Cut Pro templates.

•	 Start Timecode: A value field to set the starting timecode displayed in the project.

•	 Theme: A pop-up menu to assign a theme to the project.

•	 Designed for 4K: A checkbox available only in Final Cut Effect, Transition, Generator, or 
Title template projects that adds a metadata flag so that Final Cut Pro users can quickly 
find 4K templates (and filter out all non-4K templates). See Set template resolution.

•	 Color Processing: A pop-up menu to set the project’s working color space to Standard 
Gamut SDR (linear RGB with Rec. 709 color primaries), Wide Gamut HDR (linear RGB 
with Rec. 2020 color primaries), or Automatic (no native color space). See About color 
space and Manage automatic color processing.

 Tip: Use Automatic color processing when you’re mixing SDR and HDR elements in 
a single project or when you’re creating effect, generator, transition, or title templates 
for Final Cut Pro for Mac. When applied to the timeline, the template automatically 
conforms to the color space of the Final Cut Pro project.
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•	 HDR White Level: A slider (available only when Color Processing in Project Properties 
is set to Automatic) to adjust the brightness of SDR elements when converted to 
different color spaces (usually from SDR to HDR). SDR elements include text, shapes, 
particles, and other graphics created in Motion, as well as SDR images and clips. If SDR 
elements appear too dim at the default value (75%), increase the white level value to 
better integrate the SDR elements into the HDR scene. See Manage automatic color 
processing and Color parameters in the Properties Inspector.

 Tip: When creating templates in Motion for use in HDR Final Cut Pro projects, 
publish the HDR White Level slider to allow the brightness of graphics and any SDR 
media to be adjusted when the effect, transition, generator, or title is added to the 
Final Cut Pro timeline. See Intro to Final Cut Pro templates and Publish the HDR White 
Level slider in a template.

•	 Override FCP Color Space: A checkbox to ensure that an effect, transition, generator, or 
title template retains the same appearance when applied to the Final Cut Pro timeline, 
regardless of the Final Cut Pro library’s color processing setting.

Note: This checkbox is available only in Final Cut template projects and when the Color 
Processing parameter (in Project Properties) is set to Standard Gamut SDR or Wide 
Gamut HDR. For more information on creating templates, see Intro to Final Cut Pro 
templates.

•	 Background Color: A color control to set the background color of the canvas.

•	 Background: A pop-up menu to define whether the Background Color is rendered as 
part of the alpha channel. Regardless of the selection, the Background Color is visible in 
the canvas. Choose from these three options:

•	 Transparent: The background color does not render as part of the alpha channel.

•	 Solid: The background color creates a solid alpha channel.

•	 Environment: The background color creates a solid alpha channel and interacts with 
3D projects, including blend modes and reflections. In the following images of the 
canvas, Reflection is turned on for the elliptical shape (in the shape’s Properties 
Inspector). In the left image, the elliptical shape retains its original white color 
because Background is set to Solid. In the right image, the pink background is 
reflected in the elliptical shape because Background is set to Environment.
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Rendering, Motion Blur, and Reflections controls
Below the General section of the Properties Inspector are three groups of controls that can 
affect how your project looks when exported: Rendering, Motion Blur, and Reflections.

The Rendering controls determine how scaled-down media and 3D objects appear in your 
project. The Rendering section of the Properties Inspector has two controls:

•	 Image Downscaling: A pop-up menu that sets the filtering operation for media that is 
sized down. Choose from these two options:

•	 Smooth: The standard filtering operation for scaled-down images. Significant scaling 
may result in blurred images.

•	 Sharp: May preserve some image sharpness in significantly scaled-down images. 
For example, choose Sharp when scaling down 4K footage for use in a Broadcast HD 
1080 project, to retain more image detail and prevent image softening.

•	 3D Object Environment: A value slider that controls the environment intensity for 3D 
objects. See Modify a 3D object’s inherent size and orientation.

The Motion Blur controls simulate the effect a camera’s mechanical shutter has on a frame 
of film or video when the camera or its subject is moving. In Motion, motion blur affects 
objects in your project that are animated using behaviors or keyframes, creating more 
natural-looking motion in your project, even though the animation is artificial. As with a 
camera, faster objects have more blur; slower objects have less blur.

The Motion Blur section of the Properties Inspector has two settings:

•	 Samples: A slider to set the number of subframes rendered per frame, where one frame 
represents 360 degrees. Higher Samples values result in a higher-quality motion-blur 
effect, but are more processor-intensive. The default Samples value is 8. The maximum 
possible value is 256. 

•	 Shutter Angle: A slider to define the size of the motion blur that appears for animated 
objects. Increasing the shutter angle increases the number of frames over which the 
shutter is open. 

The following image shows a shape keyframed to move quickly across the canvas 
horizontally.
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In the next image, Motion Blur is enabled and Samples is set to the default value of 8.

Note: When using larger Shutter Angle values, it may be necessary to increase the 
Samples value to eliminate unwanted artifacts.

In the above image, the Shutter Angle is set to the default of 360 degrees, which 
represents 1 frame. In the following image, Shutter Angle is set to 1100 degrees.

The Reflections section of the Properties Inspector has one parameter:

•	 Maximum Bounces: A slider to limit the number of recursive reflections that can occur 
when two or more shiny objects reflect one another. This parameter is intended to 
prevent an endless repetition of reflective bounces. 

For more information about reflections, see Cast a reflection.

Description field
At the bottom of the Properties Inspector is a field where you can enter a brief description 
of the project, including significant characteristics of the project preset, such as frame size 
and frame rate.



53Motion User Guide

Project frame size in Motion
When you change the frame size of a project (using the Width and Height parameters in 
the Properties Inspector), you effectively change the size of the canvas, increasing or 
reducing layout space for objects in the project. 

Changing the size of the canvas does not change the size or position of objects in the 
canvas. Further, because the coordinate system in Motion uses 0, 0 as the center of the 
frame, all objects remain arranged in their current positions relative to the center of the 
frame as the edge of the frame shrinks toward the center. This can result in objects being 
cut off as the frame shrinks past their edges. 

In the following example, a project with a frame size of 1920 x 1080 is reduced to 
720 x 480, cutting off much of the image.

Note: Because Motion is resolution-independent, it’s not usually necessary to change 
your project’s frame size. You can output a project at any size, regardless of the current 
frame size, by changing the settings before you export, in the Share window. For example, 
if you build a project with a frame size for standard-definition broadcast, you can still 
export a half-resolution version of the project to post on the web by exporting to the 
necessary size.
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Add and manage content

Intro to adding and managing content in Motion
After you create a project, you add media—video clips, still images, special effects, and so 
on—to create a composition. Motion provides two easy ways to add this content to your 
project:

•	 Import: Click the Import button (or choose File > Import) to locate external video clips, 
still images, and audio files on your computer or on networked storage devices, then 
import this media into your Motion project. See Import media.

Media files imported from your computer or networked devices become source media. 
Source media can be scaled, cropped, exchanged or replaced, duplicated, revealed in 
the Finder, and so on. See Intro to source media.

•	 Library: Search the Library for high-quality content that comes with Motion (text styles, 
animated graphics, special effects, and so on), then add this content to your Motion 
project. See Show the Library.
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The Library, located on the left side of the Motion window, displays all of your available 
content in hierarchical, searchable lists. Here you can also preview selected content 
before you add it to your Motion project.
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Import media files

If it’s your first import in Motion
By default, Motion places imported media files in your project at the location of the 
playhead (the current frame in the Timeline). You can change that setting to have imported 
media always placed at the start of your project (frame 1). 

Set the start point of imported media
1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 In the Project pane, set “Create Layers At” to one of the following: 

•	 Current frame: New media layers are added at the current playhead position.

•	 Start of project: New media layers are added at the first frame of the project.

About importing media in Motion
In Motion, you can use video compressed with nearly any video codec. However, it’s best 
to use high-quality codecs with a minimum of compression. Codecs that highly compress 
files, such as MPEG-4, are less suitable for creating high-quality work.

Motion processes color in the RGB color space. Any clips that were captured or 
recompressed using a Y’CBCR-aware codec, such as DV, the Apple ProRes family, or 
Uncompressed 8-bit 4:2:2, are converted to the RGB color space when used in a Motion 
project. Clips exported from Motion using a Y’CBCR codec are converted back into the 
Y’CBCR color space.

Alpha channels
Not all codecs support alpha channels. Alpha channels are useful if you’re delivering 
an effects shot for use in someone else’s composition. If you’re required to export a 
composition using a codec with no alpha channel support, you must export the alpha 
channel as a separate grayscale media file.

Music and photos
You can import music and photo files from the Music and Photos categories in the Motion 
Library. When you add music and photo files via the Library, you can browse for files using 
the playlist and photo album features. See Add music and photo files.
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Project settings
You must adjust your Motion project settings when you import the following types of 
media:

•	 360° video: To be properly projected, imported 360° video must be contained within a 
360° environment (in the Layers list). See Create 360° projects and Add 360° video to a 
project.

•	 Wide-gamut HDR video: To be properly displayed, your project’s color-processing and 
render color space settings must be set appropriately. See Set the color processing 
method.

•	 Cinematic mode video: To be properly displayed and processed, your project’s color-
processing and render color space settings must be set appropriately. See Intro to 
Cinematic mode video.

•	 Interlaced video: Video shot on older devices may contain fields. To be properly 
displayed, you may need to adjust the clip’s field order. See Field Order in Source media 
controls.

For a complete list of file formats supported by Motion, see Supported media formats.

Import media in Motion
You can import media files (video clips, audio clips, and still images) into a Motion project 
one at a time or simultaneously.

Import media files using the Import command or the Import button
1.	 In Motion, do any of the following:

•	 Choose File > Import (or press Command-I).

•	 In the toolbar, click the Import button.

•	 Control-click an empty area of the Layers list or canvas (in the black area outside the 
project), then choose Import from the shortcut menu.

2.	 In the dialog that appears, navigate to and select one or more media files, Shift-clicking 
to select contiguous items or Command-clicking to select noncontiguous items.

3.	 Do any of the following:

•	 Click Import.

•	 Drag the file or files to the canvas.

•	 Drag the file or files into a group in the Layers list, or into the empty lower area of 
the Layers list.

If added to a group, the imported files appear as new layers in that group, placed 
above existing layers in the group. If added to the empty area, a new group is 
created containing the imported files.
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•	 Drag the file or files into a group in the Timeline layers list, or into the empty lower 
area of the Timeline layers list.

If added to a group, the imported files appear as new layers in that group, placed 
above existing layers in the group. If added to the empty area, a new group is 
created containing the imported files.

•	 Drag the file or files into the Timeline.

Note: For more information on adding objects to the Timeline, see Intro to the 
Timeline.

The media files appear in the canvas, and as layers inside the last-selected group in the 
Layers list.

Import media files into Motion from the Finder
1.	 Navigate through the Finder and select one or more media files, Shift-clicking to select 

contiguous items or Command-clicking to select noncontiguous items.

2.	 Do any of the following:

•	 Drag the file or files from the Finder to a location in the Motion canvas.

•	 Drag the file or files into a group in the Layers list in Motion, or into the empty lower 
area of the Layers list.

If added to a group, the imported files appear as new layers in that group, placed 
above existing layers in the group. If added to the empty area, a new group is 
created containing the imported files.

•	 Drag the file or files into a group in the Timeline layers list, or into the empty lower 
area of the Timeline layers list.

If added to a group, the imported files appear as new layers in that group, placed 
above existing layers in the group. If added to the empty area, a new group is 
created containing the imported files.

•	 Drag the file or files into the Timeline.

Note: For more information on adding objects to the Timeline, see Intro to the 
Timeline.
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Import image sequences
Sometimes, animated sequences are delivered as a series of sequentially numbered still 
images. Motion lets you import these sequences as a single object, with each image used 
as a sequential frame in a movie.

1.	 In Motion, do any of the following:

•	 Choose File > Import (or press Command-I).

•	 In the toolbar, click the Import button.

•	 Control-click an empty area of the Layers list or canvas (in the black area outside the 
project), then choose Import from the shortcut menu.

2.	 In the dialog that appears, navigate to the image sequence, then select an image in the 
sequence.

3.	 Select the Image Sequence checkbox.

Note: If the Image Sequence checkbox does not appear, click Options in the lower 
portion of the dialog.

4.	 Click Import.

Motion uses each image in the sequence as a frame in a video clip.

See Image sequences. 

Import media files without using them in the composition
You can also add media files to your project without having them appear in the 
composition. You do this by importing a file into the Media list, thereby storing media 
objects you might want to use in the future. When you import this way, the imported media 
does not appear in the canvas or in the Layers list. However, the media remains available in 
the Media list.

1.	 In the Project pane in Motion, click Media to open the Media list.

2.	 Do one of the following:

•	 In the toolbar, click Import, then drag media files from the dialog to the Media list.

•	 From the macOS Finder, drag media files to the Media list in Motion.

•	 With the Media list active, choose File > Import (or press Command-I); then, in the 
dialog, select a file and click Import.

•	 Control-click in the Media list, choose Import Media from the shortcut menu, then 
add a file from the dialog.

Note: You can also import files directly to the Media list from any Project pane (Layers 
list, Media list, or Audio list) by choosing File > Import As > Unused Media, selecting a 
file to add, then clicking Import.

The resulting media objects are added to the Media list but don’t appear in the canvas, 
Layers list, or Timeline.
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Import media files and create a new Motion project at the same time
You can also create a new project for files at the time of import. To do so, use the Import 
as Project command.

1.	 In Motion, choose File > Import As > Project or press Shift-Command-I.

2.	 In the dialog that appears, navigate to and select the one or more media files, Shift-
clicking to select contiguous items or Command-clicking to select noncontiguous items.

3.	 If needed, set the frame rate, aspect ratio, field order, and audio mix settings.

If you’re selecting items from an image sequence, select the Image Sequence checkbox 
to have Motion use each image as a frame in a video clip.

4.	 Click Import as Project.

The media files appear in a new Motion project.

Note: If you’re using a Mac with Apple silicon and you import media in a video format that 
is not compatible with Apple silicon, a dialog to install Rosetta is displayed. After installing 
Rosetta, you must quit and reopen Motion. For more information, see the Apple Support 
article about Rosetta.

Import layered Photoshop files in Motion
You can import layered Photoshop files into your Motion project. Many motion graphics 
professionals create layouts in Photoshop, then import the resulting multilayered file into 
Motion, where the layers are animated and combined with other imported and Motion-
generated objects.

There are several ways to import layered Photoshop files:

•	 With all Photoshop layers merged together as a single Motion layer

•	 By choosing a single Photoshop layer

•	 With each Photoshop layer preserved as a separate Motion layer, nested in a new group

Note: Individual layers are only preserved with imported 8-bit layered Photoshop files.

When you import all Photoshop layers as individual Motion layers, Motion places them in 
a new group in the Layers list and Timeline. Each layer retains the position, opacity, and 
blend mode of its corresponding original Photoshop layer. 

Although you can import Photoshop text layers, the text appears in Motion as noneditable 
bitmap graphics.

The following Photoshop effects are not imported into Motion:

•	 Layer effects

•	 Layer masks

•	 Adjustment layers

•	 Paths

•	 Shapes

 Tip: When creating Photoshop files for use in Motion, be aware of the pixel aspect 
ratio you’re using and whether your project requires you to work with square or nonsquare 
pixels. Additionally, if you plan to pan and zoom in or out of an imported graphic (such as 
a scanned map or photograph), use a high-resolution image that’s scaled to match (or 
exceed) the frame size of a sequence.

https://support.apple.com/102527
https://support.apple.com/102527
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Import a layered Photoshop file into Motion using the drop menu
1.	 Do one of the following:

•	 From the macOS Finder, drag a layered Photoshop file into the canvas, Layers list, or 
Timeline layers list.

•	 In the Motion toolbar, click Import (or choose File > Import), then drag a layered 
Photoshop file from the dialog into the canvas, Layers list, or Timeline layers list.

2.	 Before releasing the mouse button, pause until the canvas drop menu appears and the 
pointer becomes curved.

This menu presents commands for importing the layered file.

3.	 Continuing to press and hold the mouse button, choose a command from the drop 
menu, then release the mouse button:

•	 Import Merged Layers: All layers of the Photoshop file are collapsed into a single 
Motion layer.

•	 Import All Layers: A group is created, and each layer of the Photoshop file is 
preserved as a separate Motion layer in this new group.

•	 [Individual layers]: Each layer in the Photoshop file appears as a separate item in the 
drop menu. Selecting a layer adds only that layer to the project, where it appears as 
a single Motion layer.

Note: When a Photoshop file contains more layers than can be displayed in the drop menu, 
the Choose Layer option appears in the drop menu. After you click the Choose Layer 
option, the Pick Layer to Import dialog appears. 

Add a layered Photoshop file using the Import command
1.	 In the Motion toolbar, click Import (or choose File > Import).

2.	 In the dialog that appears, select the layered Photoshop file to import, then click Import.

The Pick Layer to Import dialog appears.

3.	 Choose a command from the Layer Name pop-up menu:

•	 Merged Layers: All layers of the Photoshop file are collapsed into a single Motion 
layer.

•	 All Layers: A group is created, and each layer of the Photoshop file is preserved as a 
separate Motion layer in this group.

•	 [Individual layers]: Each layer in the Photoshop file appears as a separate item in the 
drop menu. Selecting a layer adds only that layer to the project, where it appears as 
a single Motion layer.

If you don’t like the layer you chose, you can pick a different one from the Photoshop 
file without deleting or importing again. You do so by selecting the recently imported 
Photoshop layer, then choosing a different Photoshop layer from the Layer pop-up 
menu in the Properties Inspector. 
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Media file types

Supported media formats in Motion

You can import the following video, still image, and audio formats:

Video formats
•	 Animated GIFs

•	 Apple Animation codec

•	 Apple Intermediate codec

•	 Apple Log

•	 Apple ProRes (all versions)

•	 Apple ProRes RAW and Apple ProRes RAW HQ

•	 AVCHD (including AVCCAM, AVCHD Lite, and NXCAM)

•	 AVC-ULTRA (including AVC-LongG, AVC-Intra Class 50/100/200/4:4:4, and AVC-Intra 
LT)

•	 Dolby Vision Profile 8.4 (interpreted using static HLG tone mapping)

•	 DV (including DVCAM, DVCPRO, and DVCPRO50)

•	 DVCPRO HD

•	 H.264 (AVC)

•	 H.265 (HEVC)

•	 HDV

•	 iFrame

•	 Motion JPEG

•	 MPEG IMX (30 Mbps, 40 Mbps, 50 Mbps)

•	 QuickTime formats

•	 Uncompressed 8- and 10-bit 4:2:2

•	 XDCAM HD/EX/HD422

•	 XF-AVC

•	 XF-HEVC 

Container formats
•	 3GP

•	 AVI

•	 MOV (QuickTime)

•	 MP4 

•	 MTS/M2TS

•	 MXF
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Still image formats
•	 BMP

•	 GIF

•	 HEIF (requires macOS High Sierra 10.13)

•	 JPEG

•	 PNG

•	 PSD (merged and layered)

•	 SGI 

•	 TIFF

•	 TGA

•	 OpenEXR

Other image formats
•	 PDF files

Audio formats
•	 AAC (listed in the Finder with the .m4p filename extension)

•	 AIFF

•	 CAF

•	 MP3 

•	 MP4 

•	 WAV

Important: You cannot import rights-managed AAC files.

You can combine clips that are compressed with different codecs in the same project. You 
can also combine clips that have different frame sizes, pixel aspect ratios, and interlacing.

Although you can import movies in nearly any codec, avoid using highly compressed 
clips in projects. Excessively compressed clips can display undesirable visual artifacts. 
Fortunately, many formats are ideal for moving uncompressed or minimally compressed 
video files between applications, including Apple ProRes, Uncompressed 8- and 10-bit 
4:2:2, DVCPRO50, and so on.

Some codecs support an alpha channel, which defines areas of transparency in the clip. If 
an imported clip has an alpha channel, Motion uses the alpha channel in your project.

Note: If you’re using a Mac with Apple silicon and you import media in a video format that 
is not compatible with Apple silicon, a dialog to install Rosetta is displayed. After installing 
Rosetta, you must quit and reopen Motion.
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High-resolution still image files in Motion

You can import still image files using most popular still image formats, including SGI, PSD, 
BMP, JPEG, TIFF, and TGA. As with video clips, you can mix still image files with differing 
frame sizes and pixel aspect ratios. For a full list of eligible file types, see Supported media 
formats.

A common and effective use of still images in motion graphics work is the animation of 
high-resolution files. The dots per inch (DPI) qualification as defined in programs like 
Photoshop does not apply to video. If the dimensions of an imported image are larger than 
the frame size of the Motion project, the image extends beyond the borders of the canvas.

You can reduce the scale of the image to fit the project’s frame size. You can also animate 
the image’s Scale parameter (in the Properties Inspector) to zoom into or out of the image, 
or animate its Position parameter to pan the image.

Because Motion is graphics-card dependent, file-size import limitations vary from 
computer to computer. When you import an image that is too large, an alert dialog appears, 
stating, “This media is too large to render at full resolution, and will be shown at a lower 
quality.” Click OK to import the image at a lower quality.

When you import a still image, the image assumes a duration equal to the current duration 
of the project. Increasing the duration of the project does not increase the duration of an 
image that’s imported. Still images have infinite duration in Motion, so you can stretch 
them in the Timeline to be as long as necessary. For more information about modifying 
objects in the Timeline, see Intro to the Timeline.

Set the import size of large images in Motion

You can set an option in the Settings window to import large still images at their original 
size or scaled to fit the canvas size.

1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 In the Still Images & Layers area of the Project pane, click the Large Stills pop-up menu 
and choose a setting.
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There are two options:

•	 Do Nothing: Imports the image at its original size.

In the following example, a 1920 x 1080 image is imported into a Broadcast HD 720 
project (1280 x 720) with Do Nothing selected in Settings. The image is larger than 
the canvas.

•	 Scale to Canvas Size: Imports and scales the image to fit the project size while 
maintaining the image’s native aspect ratio. The scaling is the equivalent of using the 
Select/Transform tool to scale down the image in the canvas while pressing Shift.

To confirm that the image is merely transformed and has not changed resolution, you can 
select the image file in the Media list, then open the Media Inspector.

The Fixed Width and Fixed Height parameters display the resolution of the original file.
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Image sequences in Motion

Numbered image sequences store video clips as individual still image files. Each image file 
has a number in the filename that indicates where it fits into the sequence. In a film clip 
that’s been digitally scanned, each file represents a single frame. In a video clip that’s been 
converted to an image sequence, each file contains both fields of a single video frame, 
with the upper and lower lines of the image saved together.

Image sequences use the same variety of file formats as still image files. Some of the most 
popular formats for saving image sequences include SGI, BMP, JPEG, TIFF, and TGA. Like 
still image formats, many of these image sequence formats support alpha channels, which 
are used by Motion.

Because image sequences have been around for so long, they remain the lowest-common-
denominator file format for exchanging video across editing and compositing applications. 
Although QuickTime is increasingly used to exchange video clips between platforms, image 
sequences are still used, especially in film compositing.

As with QuickTime video clips, you can mix image sequences of different formats, using 
different frame sizes, pixel aspect ratios, frame rates, and interlacing.

Important: Any imported image sequence must contain three or more digits of padding—
for example, “imagename.0001.tif.”

Animated GIFs in Motion

You can import animated GIFs into Motion.

Note: Animated GIFs have a limited color palette and don’t support alpha channels or 
audio.

Set an animated GIF frame rate 
Depending on your project’s frame rate, the animated GIF may play at the wrong speed. 
You can correct this in the Project pane.

1.	 In the Media list of the Project pane, select the GIF.

2.	 In the Media Inspector, choose an option from the Frame Rate pop-up menu.

Note: Clips playing at a frame rate different from that of the project may not play 
smoothly.
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PDF files in Motion

The PDF file format is a PostScript-based document format that accommodates 
PostScript-based graphics and text, as well as bitmap graphics. Areas of transparency  
in a PDF file are also transparent in Motion.

PDF files are capable of storing PostScript-based illustrations. Unlike graphics file formats 
such as TIFF and JPEG, which save images as a collection of pixels at a given resolution 
divided into red, green, and blue channels, PostScript-based illustrations are saved 
as mathematical descriptions of how the artwork is drawn. As a result, PDF files using 
PostScript-based artwork and text have infinite resolution.

The practical difference between bitmap files and PostScript-based files is that scaling 
a bitmap beyond 100 percent results in the image progressively softening the more you 
increase its size. PostScript-based illustrations remain sharp and clear no matter how large 
or how small you scale them.

When importing a PDF file, its size is relative to the original page size of the file. As a 
result, even small graphics can have a large frame size, with empty space surrounding the 
graphic. When exporting a graphic as a PDF file for use in Motion, you may want to scale 
the graphic to fit the page dimensions, or reduce the page size in the source application’s 
page preferences to fit the graphic’s dimensions.

Fixing the resolution of a PDF object
Although PDF files have unlimited resolution, large PDF objects can consume a lot of 
video memory, which can hinder performance in Motion. To avoid this problem, limit the 
resolution of each PDF image to save video memory. By using fixed-resolution parameters, 
the files are rendered once, ensuring better performance.

The fixed-resolution parameters for PDF objects are adjusted in the Media Inspector. 
Select the PDF source media in the Media list to activate the Media Inspector. Adjust the 
following controls to modify the PDF’s fixed-resolution parameters:

•	 Pixel Aspect Ratio: A pop-up menu to assign a nonsquare pixel aspect ratio to the file. 
In most cases, the “From file” menu option is the best choice because it assigns the 
PDF source file’s native aspect ratio. Choose a different menu item only if you want to 
override that native setting.

•	 Fixed Resolution: A checkbox that, when selected, fixes the resolution of PDF source 
media to the size specified in the Fixed Width and Fixed Height sliders.

•	 Fixed Width: A slider to set the maximum horizontal resolution to which a PDF object 
can be smoothly scaled.

•	 Fixed Height: A slider to set the maximum vertical resolution to which a PDF object can 
be smoothly scaled.

•	 Use Background Color: A checkbox that, when selected, substitutes a custom 
background color for transparent portions of the PDF. Choose the background color in 
Background Color controls (described below).

•	 Background Color: Color controls (available when Use Background Color is selected) to 
set the background color for transparent portions of the PDF.

•	 Crop: Sliders (Left, Right, Bottom, and Top) to crop the edges of the PDF image, if 
necessary. These controls crop the PDF source media (and all layers linked to that 
source media). To crop an individual layer, use the Crop parameters in the layer’s 
Properties Inspector.
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Mixed content in PDF files
Although PDF files can contain a mix of PostScript-based art, PostScript text, and 
bitmapped graphics, each format has different scaling properties. PostScript-based art 
and text scale smoothly, but bitmapped graphics embedded in a PDF file are subject to the 
same scaling issues as other bitmapped graphics formats. As a result, bitmapped graphics 
can soften if scaled larger than their original size.

Note: Form objects, buttons, and JavaScript objects that are present in an imported PDF 
file do not appear in Motion.

Multipage PDF files
You can import multipage PDF files. When you do, a parameter called Page Number 
appears in the Properties Inspector when the PDF object is selected. Drag the slider to set 
which page is displayed in the canvas. Animate this parameter to display different pages 
over time.

Important: Multilayered PDF files are not supported. To import a multilayered illustration, 
export each layer as a separate PDF file and import these as a nested group of objects in 
Motion.

Alpha channels in Motion

Ordinary video clips and image files have three channels of color information: red, green, 
and blue. Many video and image file formats also support an additional alpha channel, 
which contains information defining areas of transparency. An alpha channel is a grayscale 
channel where white represents areas of 100 percent opacity (solid), gray regions 
represent translucent areas, and black represents 0 percent opacity (transparent).

When you import a QuickTime movie or an image file into a project, its alpha channel is 
immediately recognized by Motion. The alpha channel is then used to composite that 
object against other objects behind it in the canvas.

There are two ways to embed alpha channel information into files. Motion attempts to 
determine which of these methods a media file uses:

•	 Straight: Straight alpha channels are kept separate from the red, green, and blue 
channels of an image. Media files using straight alpha channels appear fine when used 
in a composition, but they can look odd when viewed in another application. Translucent 
effects such as volumetric lighting or lens flares in a computer-generated image can 
appear distorted until the clip is used in a composition.

•	 Premultiplied: The transparency information is stored in the alpha channel as well as in 
the visible red, green, and blue channels, which are multiplied with a background color 
(generally black or white).

The only time it really matters which kind of alpha channel an object has is when Motion 
doesn’t correctly identify it. If a media item’s alpha channel is set to Straight in the Media 
list when it’s really premultiplied, the image can appear fringed with the premultiplied color 
around its edges. If this happens, select the problematic item in the Media list, then change 
its Alpha Type parameter in the Media Inspector.
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Audio files in Motion

You can import many audio file formats into your project, including WAV, AIFF, .cdda, MP3, 
and AAC. Although Motion is not a full-featured audio editing and mixing environment like 
GarageBand or Logic Pro, you can import music clips, dialogue, and sound effects. If you 
import a QuickTime file with mono or stereo tracks of audio, the audio appears in the Audio 
Timeline.

You can import audio clips with various sample rates and bit depths. When you do, Motion 
resamples audio tracks to the sample rate and bit depth used by your computer. The 
default is 16-bit, 44.1 kHz float for the built-in audio interface. If you use a third-party 
audio interface, audio is remixed to the sample rate and bit depth used by that device. For 
information on adjusting audio sample rate on export, see Export a QuickTime movie.

You can import audio files with sample rates up to 192 kHz and with bit depths up to 32 
bits. Mono and stereo files are supported. Multichannel audio files are also supported.

For more information about file formats Motion supports, see Supported media formats. 
For more information on using audio in Motion, see Intro to audio.

A seamless way to browse for and import music from your music library is to use the Music 
category in the Motion Library. See Add music and photo files.

Text files in Motion

Motion can read and work with a variety of text files, both as media elements and as text 
data to incorporate in generators, particle systems, and replicator effects. See Add text.

Add Library content that comes with Motion

Show the Library in Motion
Motion ships with a collection of built-in art content and effects (text styles and fonts, 
animated graphics, filter effects, and so on) that you can use in your projects. This content 
is available in the Library, which is displayed on the left side of the Motion window (next to 
the Inspector).

The Library is divided into several areas:

•	 Preview area: At the top of the Library, a thumbnail image displays a video preview 
of content selected in navigation areas of the Library (special effects, text styles, 
graphical art, and so on). 

•	 Navigation pane: Just below the preview area is a two-column pane displaying the 
categories and subcategories of content and effects available in Motion. Navigation 
arrows let you step forward and back through recently viewed categories of content. A 
pop-up menu lets you filter content by theme (Abstract, Sci-Fi, Nature, and so on).
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•	 Library stack: When you select a category and subcategory in the navigation pane, the 
contents of the subcategory are shown in the lower area of the Library, known as the stack.

View the Library
If the Library is not visible in the Motion window, you can easily display it.

•	 Click the Library button in the top-left corner of the Motion window.

•	 In Motion, choose Window > Library (or press Command-2).

Collapse or expand the pane containing the Library and Inspector
To customize your workspace, you can collapse or expand the pane containing the Library 
and Inspector.

•	 Click the Library button or the Inspector button in the top-left corner of the Motion 
window.

When the Library button or Inspector button are both deselected, the pane collapses, 
and the Project pane, canvas, and Timing pane expand.
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Categories of Library content in Motion
The Library navigation pane contains the following categories of content that you can add 
to your project:

•	 Behaviors: Sophisticated animation and simulation effects (Spin, Grow, Gravity, and 
so on) that you can apply to objects and images in your project. Some behaviors can 
be applied only to specific objects. For example, Text Animation and Text Sequence 
behaviors can be applied only to text objects. See Intro to applying behaviors.

•	 Filters: Special effects used to modify the appearance of images, objects, and video 
clips in your project. You can apply filters to create artistic effects (blurs, glows, 
stylized looks), to perform image corrections (color balancing, sharpening), or to create 
complex compositing effects (green screen keying). Third-party FxPlug filters appear 
in the category to which they belong. Most filters can be applied to any layer (text, 
images, shapes, video footage, particles, and so on) in your project. See Intro to filters.

•	 Generators: Computer-generated art such as checkerboards, noise patterns, color 
rays, and animated text objects that you can add to your projects. See Intro to using 
generators.

•	 Particle Emitters: Animated swarms of small particles that let you add effects ranging 
from simulations of smoke, fire, and explosives to animated abstract textures. All 
premade particle systems can be customized after you add them to your project. See 
Intro to particles.

•	 Replicators: Patterns of repeating elements used to create kaleidoscopic effects (static 
or animated) in your compositions. All premade replicators can be customized after you 
add them to your project. See Intro to replicators.

•	 Shapes: Premade geometrical forms that you can use as visual elements or as image 
masks in your project. Each shape is a Bezier shape and can be customized using 
Motion’s shape-editing tools. See Intro to shapes, masks, and paint strokes.
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•	 3D Objects: Premade 3D objects in the USDZ file format (a zero-compression, 
unencrypted zip archive of the Universal Scene Description format) that can be added 
to a 2D or 3D project. Some 3D objects are animated. See Intro to 3D objects.

•	 Gradients: A selection of premade color spreads that can be applied to shapes, text, 
particles, and replicators in your project. See Gradient editor controls.

•	 Fonts: A browser containing all the fonts on your computer, which you can apply to text 
selected in the canvas. See Preview and apply fonts.

•	 Text Styles: Thematic type styles (Antique, Fantasy, Grunge, and so on) that let you 
modify the look of 2D text and 3D text in your project. See Use preset text styles.

•	 Shape Styles: Preset shape styles that add artistic line strokes (Abstract, Flora, and 
Liquid, for example) to shapes in your project. For example, dragging a shape style onto 
a shape instantly applies that style. See Intro to shapes, masks, and paint strokes.

•	 Materials: Preset 3D text materials that give 3D text a natural and realistic appearance, 
as they respond to lighting, exhibit reflectiveness, and so on. All premade materials 
can be customized after you add them to your project. See Intro to 3D text surface 
materials.

•	 Music: A browser for locating and importing files from your music library. The 
subcategories include the library and playlists created in Apple Music. The contents of 
each playlist appear in the Library stack. See Add music and photo files.

•	 Photos: A browser for locating and importing image files from your selected photo 
library. The contents of each photo album or photo library appear in the Library stack. 
You can change the photo library shown here by choosing a different photo app in the 
General pane of Motion Settings. See Add music and photo files.

•	 Content: Graphical elements used in the templates and presets that ship with Motion. 
Use these images, text elements, patterns, and animations to create custom design 
elements, such as particles and replicators, which can be saved to the Library for later 
use.

•	 Favorites: A place to save objects—built-in or custom-made in Motion—for future 
use, including cameras, layers, or groups. You can also place frequently used media 
files (such as PDF or TIFF files) into the Favorites category. Objects you place in the 
Favorites category are available to every project you create in Motion.

•	 Favorites Menu: Objects you place in the Favorites Menu folder appear in the Favorites 
menu, for even faster access. When you choose an item from the Favorites menu, that 
item is placed into the selected layer and is positioned at the center of the canvas. 
Objects you put in the Favorites Menu are available to every project in Motion.
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Add Library content to a project in Motion
You can add Library content (special effects and premade graphical elements) to a project 
in several different ways.

Add Library content to a project
1.	 In the Library in Motion, select a category and subcategory in the navigation pane and 

an item in the Library stack.

For example, select the Filters category, select a filter subcategory, then select a filter 
in the Library stack.

A preview of the selected Library item appears in the preview area. 

2.	 Do either of the following:

•	 Click the Apply button to the right of the preview area.

•	 Drag the item from the Library stack to a location in the canvas, or into the empty 
lower area of the Layers list or Timeline.

The item is placed inside a new group at the top of the Layers list and Timeline, and the 
content appears in the canvas or under the selected layer in your project.

Note: Some categories of Library content are designed to modify specific types of 
layers. For example, items in the Text Styles category of the Library can be applied only 
to text layers in your project. If nothing happens when you try to add a Library item, 
make sure you’ve applied it to a suitable group or layer. 

Add Library content to a specific group or layer in a project
1.	 In the Library in Motion, select a category and subcategory in the navigation pane and 

an item in the Library stack.

For example, click the Filters category, click a filter subcategory, then click a filter in the 
Library stack.

A preview of the selected Library item appears in the preview area.

2.	 Do either of the following:

•	 Select a specific group or layer in the Layers list or Timeline, then click Apply in the 
preview area.

•	 Drag the item from the Library stack to a specific group or layer in the Layers list or 
Timeline.

The item is placed in the group or applied to the layer. 

Note: Some categories of Library content are designed to modify specific types of 
layers. For example, items in the Text Styles category of the Library can only be applied 
to text layers in your project. If nothing happens when you try to add a Library item, 
make sure you’ve applied it to a suitable group or layer. 

There’s an additional way to add generators, behaviors, and filters—using the pop-up 
menus in the toolbar. See Add a generator, Apply or remove filters, and Add, remove, or 
disable behaviors.
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Add music and photo files in Motion
You can add files from your music and photo libraries to a project via the Motion Library.

Note: Although a connected iPod appears on your system as a hard disk, you can only 
browse for and import iPod files that are stored as data. Music transferred to the iPod via 
the Music app cannot be imported into Motion.

Add a file from Music
1.	 In the Library in Motion, select the Music category.

2.	 Select a subcategory, such as Music, Movies, or a playlist, then select a file.

If your Music library contains rights-protected audio files, such as songs purchased 
through the iTunes Store or downloaded with an Apple Music subscription, those items 
do not appear in the Music category of the Motion Library.

Note: To use a song you purchased from the iTunes Store in your project, you must be 
the copyright holder of the song or have express permission from the copyright holder. 
For more information, see the Motion software license agreement (choose Motion > 
About Motion, then click License Agreement).

3.	 Do one of the following:

•	 In the preview area, click Apply.

•	 Drag the file to the canvas, Layers list, Timeline, or Audio Timeline (if the file is an 
audio track or is a video that contains audio).

For more information on working with audio files, see Intro to audio.

Add a file from a photo application
1.	 In the Library in Motion, select the Photos category.

The albums (or libraries) appear in the adjacent navigation pane.

You can change the photo library shown here by choosing a different photo app in the 
General pane of Motion Settings. You can select only one photo app at a time. See 
General settings.

2.	 Select an album, then select a file from the stack.

3.	 Do one of the following:

•	 Click the Apply button to the right of the preview area.

•	 Drag the file to the canvas, Layers list, or Timeline.

When importing large-scale images into Motion, you can import the files at their native 
resolution or at the resolution of the Motion canvas. See Set the import size of large 
images.

If you import Cinematic mode videos from the Photos category, you can change the focus 
and depth of field settings created during recording on supported models of iPhone. See 
Intro to Cinematic mode video.
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Sort and search in the Library in Motion
You can display and sort content in the Library in any of several ways. You can also search 
for library content. 

View the Library in list view
•	 In Motion, click the List View button in the lower-right corner of the Library.

View the Library in icon view 
•	 In Motion, click the Icon View button in the lower-right corner of the Library.

Change the size of the icons while in icon view
In Motion, do one of the following:

•	 Click the Zoom control in the lower-left corner of the Library, then drag the slider to the 
right to make the icons larger, or to the left to make them smaller.

•	 On a Multi-Touch trackpad, pinch open to make the icons larger or pinch closed to make 
the icons smaller.

Sort using the Theme pop-up menu
The Theme pop-up menu under the preview area lets you sort Library content by thematic 
categories such as Abstract, Nature, Sci-Fi, and so on. 

•	 In the Library in Motion, select a category, then click the Theme pop-up menu and 
choose a theme.

Search for Library content
•	 In Motion, click the Search button at the bottom of the Library, then enter text in the 

Search field.

Note: The Search field is not available unless the Search button is selected.

Clear a file search
•	 In Motion, click the Clear button on the right side of the Search field.



76Motion User Guide

Manage Library folders and files in Motion
Although you can’t modify the effects, elements, and folders built into Motion, you can 
organize custom effects, elements, and folders in the Library the same way you manipulate 
files in the Finder. You can create folders and delete certain files or folders.

You can also easily create, save, and organize files and themes in the Library.

Create a new folder in the Library
You can create new folders in the subcategory column (the second column) or in the stack 
(the area under the category and subcategory columns) to better organize your custom 
Library content.

In Motion, do one of the following:

•	 Create a new folder in the subcategory column: Select a category, select the All folder 
in the subcategory column, then click the New Folder button (+) in the lower-left corner 
of the Library.

A new, untitled folder appears in the subcategory column.

•	 Create a new folder in the stack: Select a category, select the subcategory to contain 
the new folder, then click the New Folder button (+) in the lower-left corner of the 
Library.

A new, untitled folder appears in the stack.

For more information on saving custom Library content, see Save custom objects to the 
Library.

Rename a custom folder or file
In Motion, do one of the following:

•	 Rename a subcategory folder: In the subcategory column, click the name of a custom 
folder once to select it, click it again to activate the text field, enter a new name, then 
press Return.

•	 Rename a file or folder in the stack: In the stack, Control-click a custom file or folder, 
choose Rename from the shortcut menu, enter a new name, then press Return.

WARNING: Renaming a custom folder or file in the Library renames the item on your 
computer or networked storage device. If projects use files from the originally named 
folder, Motion may list the item as missing.
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Remove custom objects or folders from the Library
•	 In Motion, select a custom folder in the subcategory column or stack (or a custom 

object in the stack), then do one of the following:

•	 Choose Edit > Delete.

•	 Press Command-Delete.

WARNING: Deleting a custom folder or file in the stack removes that item from your 
computer or networked storage device and places the item in your Trash.

Delete a folder or file
•	 In the Library stack in Motion, Control-click the custom file, then choose Move to Trash 

from the shortcut menu.

Move a file into a folder
•	 In the Library stack in Motion, drag the file onto the folder icon.

The file is moved inside that folder.

When Library media is unavailable in Motion
As with any other object used in a Motion project, Library media must be present and 
installed on your computer for that media to appear correctly in Motion. If someone gives 
you a project file and you don’t have the same filters or fonts used in the file, a warning 
appears when you open the project, listing the items that are unavailable.

You can close the project and install the necessary files on your computer, or you can open 
the file. When you open a file with missing media, the following occurs: 

•	 Missing Content: Missing content is treated like any other missing media item. For more 
information about reconnecting media, see Reconnect offline media files.

•	 Missing Filters: When a filter is missing, a placeholder object appears in the Layers 
list and Timeline. When you reinstall the missing filter, the filter object replaces the 
placeholder, and the effect is applied properly.

•	 Missing Fonts: When fonts are missing, the text objects that use those fonts default to 
Helvetica as a temporary substitute. Missing international fonts substitute the default 
system font for the relevant language.
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Work with Library themes in Motion
Library themes help you organize projects that may share objects by allowing you to label 
specific objects with a default theme, such as Abstract, Nature, or Sci-Fi, or to assign 
objects to a custom theme. By default, some preset Library objects are assigned to a 
theme. For example, the Hypnotic particle emitter preset is in the Sci-Fi category.

Note: Library themes are different from the themes in the Themes pop-up menu of the 
Project Browser. Project Browser themes are applied to entire Motion projects and shared 
between Motion and Final Cut Pro when creating templates. For more information on 
creating templates for Final Cut Pro, see Intro to Final Cut Pro templates.

Sort using the Theme pop-up menu
•	 In the Library in Motion, select a category or subcategory, then choose a theme from 

the Theme pop-up menu.

Items belonging to the chosen theme appear in the stack.

Create a new custom theme
1.	 In the Library in Motion, below the preview area, choose New Theme from the Theme 

pop-up menu.

2.	 In the Create New Theme dialog, type a theme name, then click OK.

A new theme is added to the Library. New themes appear in the Theme pop-up menu.

Custom themes are saved in the “themes” document in your /Users/username/Library/
Application Support/Motion/Library/ folder.

Assign a theme to custom content
•	 In Motion, Control-click a custom item in the Library stack (such as a shape saved to 

the Favorites folder), choose Theme from the shortcut menu, then choose a theme from 
the submenu.

An item must be saved in the Library before you can assign a theme. See Save custom 
objects to the Library.

Items that can be assigned a theme include the following:

•	 Replicators

•	 Emitters

•	 Shapes

•	 Gradients

•	 Text styles

•	 Shape styles

•	 Layers or groups

Note: You cannot assign a theme to behaviors, filters, fonts, images, image sequences, or 
movies.
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Remove a custom theme
1.	 In the Library in Motion, click the Theme pop-up menu, then choose the theme you want 

to remove.

The Remove Theme item becomes available in the Theme pop-up menu.

2.	 Choose Remove Theme from the Theme pop-up menu.

The theme is removed from the list.

Note: You can only remove custom themes.

Save custom objects to the Library in Motion
You can save nearly any object in Motion to the Library, including animated cameras and 
lights, customized behaviors, filters, particle systems or replicators, shapes and text, as 
well as layers and groups. After an object is placed in the Library, it can be added to a 
project like any other element in the Library.

You can save multiple objects to the Library as one file or multiple files. For example, if you 
create an effect using multiple filters and you want to save the cumulative effect of those 
filters to apply to other objects, you can save the filters as one item in the Library.

Although you can save custom objects into their namesake folders, it’s better to save 
customized objects that you use frequently to the Favorites category. Because some 
Motion Library categories contain numerous items, placing custom items in the Favorites 
or Favorites Menu categories can save you search time. In the Favorites category, you can 
create additional folders to better organize custom items.

Note: You can create folders in the built-in categories, such as the Color filters 
subcategory; however, those folders appear only in the Library stack and not the sidebar. 
Folders added to the Favorites category appear in the Library sidebar.

Save a custom object to the Library
1.	 In Motion, open the Library and select the Favorites or Favorites Menu category, or 

another category.

Note: To save a custom object to a category other than the Favorites or Favorites Menu 
category, the object type must match the category. For example, you can save custom 
filters to the Filters category, but not to the Behaviors category or Generators category. 

2.	 Drag a customized object from the Layers list, Timeline, or Inspector into the stack at 
the bottom of the Library.

The item is saved to the Library in the category you selected and appears with a custom 
icon.

When you save a customized item, it’s placed in the /Users/username/Library/
Application Support/Motion/Library/ folder.
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Save multiple custom objects to the Library
1.	 In Motion, open the Library and select the Favorites or Favorites Menu category, or 

another category.

Note: To save a custom object to a category other than the Favorites or Favorites Menu 
category, the object type must match the category. For example, you can save custom 
filters to the Filters category, but not to the Behaviors category or Generators category. 

2.	 In the Layers list, select all objects to save and drag them to the stack, pressing and 
holding the mouse button.

3.	 When the drop menu appears, choose “All in one file” or “Multiple files,” then release 
the mouse button.

“All in one file” saves objects together, as one item in the Library. “Multiple files” saves 
them as individual objects in the Library.

Note: When saving objects of different types, it’s best to save them to the Favorites 
or Favorites menu category (or a folder you specifically create) for organizational 
purposes. If multiple objects of different types are saved, such as a shape with an 
applied behavior and text, the objects are added to the Content folder as “Untitled.” 

Create a custom note for a saved Library object
•	 In Motion, Control-click the object’s icon in the Library stack, choose Edit Description 

from the shortcut menu, enter notes in the dialog that appears, then click OK.

For information about renaming and organizing custom Library content, see Manage 
Library folders and files. 

Manage source media

Intro to source media in Motion
When you import an external media file into a Motion project, two things occur:

•	 An instance of that media (an image or video clip) is placed in your project, and is 
visible in the Layers list, canvas, and Timeline.

•	 A link to the external source media file on your computer or other connected device is 
shown as an item in the Media list in the Project pane.

Media used in Motion must remain connected to the source media files on your computer 
or networked device. If you move, delete, or rename external media files that correspond 
to media used in a Motion project, the source media link (in the Media list) and any layers 
in your project using that source media go “offline.” It’s easy to reconnect offline media in 
your project (as long as the external files are still available on your computer or networked 
device). See Reconnect offline media files.
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Because Motion is a nondestructive effects application, changes you make to media layers 
in your project are not applied to the external media on your computer or connected 
device. Rather, any changes you make to a media layer are applied to the instance of the 
media in Motion. 

You can view information about source media in two places in the Motion window:

•	 Media list: The second list in the project pane, itemizes all source media files (audio, 
image, image sequence, and QuickTime movie files) in your project. The items in this 
list are links to source media files that remain on your computer or networked device. 
Applied effects (such as filters or behaviors) and graphics content created in Motion 
(such as masks, shapes, or text) do not appear in the Media list. Columns in the Media 
list display information about each source file, including format, duration, frame rate, 
and so on. See Media list.

•	 Media Inspector: Available when you select a media item the Media list, displays 
information about the selected source media file (format, duration, frame rate, and 
so on). The Media Inspector also contains adjustable media controls for modifying 
instances of the source media file used in your project. See Display the Media Inspector.

View source media information

Media list in Motion

The Media list (the second list in the Project pane) itemizes all media files (audio, image, 
image sequence, and QuickTime movie files) in the project. Items in this list are links to 
source media files that remain on your computer or networked storage device. Applied 
effects (such as filters or behaviors) and graphics content created in Motion (such as 
masks, shapes, or text) do not appear in the Media list.

The columns in the Media list contain information about each media item, in the following 
categories:

•	 Preview: Displays a thumbnail of the media object. 

•	 Name: Lists the filename of the source media on disk where the object is linked. If you 
change the name of corresponding linked objects in the Layers list, this name doesn’t 
change.

•	 Kind: Lists the type of file—still image, QuickTime movie, image sequence, or audio file.

•	 In Use: Indicates that the media is in use in the project.

•	 Duration: Displays the total duration of the object, in frames or timecode, depending on 
what is displayed in the Timeline.

•	 Frame Size: Displays the frame size of the object, in pixels.

•	 Format: For QuickTime movies, displays the codec used. For still images, displays the 
method of compression that is applied based on the file type.

•	 Depth: Specifies the color depth of the image, such as 16 bits.

•	 Vid Rate: Displays the video frame rate of the object, in frames per second.

•	 Aud Rate: For audio files and QuickTime movies, displays the sample rate of the audio.

•	 Aud Bit Depth: For audio files and QuickTime movies, specifies the bit depth of the 
audio.
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•	 File Size: Shows the size of the source media file on disk.

•	 File Created: Shows the file creation date of the source media file on disk.

•	 File Modified: Shows the file modification date of the source media file on disk. This is a 
useful parameter for file management.

Show, sort, and search the Media list in Motion

Customize your view of the Media list to see the information most important to you.

Display the Media list
In Motion, do one of the following:

•	 If the Project pane is visible, click Media at the top of the pane.

•	 Choose Window > Media (or press Command-5).

The Media list opens.

Display and adjust columns in the Media list
In Motion, do one of the following:

•	 To display all visible columns in the Media list, drag the scroller at the bottom of the 
Media list.

•	 To show or hide a column, Control-click a column heading, then choose the item to 
show or hide from the shortcut menu.

Items in the list with a checkmark are displayed in the Media list. Items with no 
checkmark are hidden.

•	 To reorder the columns, drag a column heading left or right to a new position.

•	 To adjust column width, drag a border between column headings.

•	 To adjust row height, do one of the following:

•	 Position the pointer over a horizontal line and drag up or down to change the height 
of all rows. Icons and thumbnails resize themselves as you make the adjustment.

•	 Click the Scale control at the bottom of the Media list, then drag the slider left to 
decrease row height or right to increase row height.
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Sort Media list items in a column by file type
•	 In the Media list in Motion, click a column heading.

The layers are sorted in the column and a small arrow in the column heading indicates the 
direction of the sort. To reverse the direction of the sort, click the column heading.

Search for specific items in the Media list
•	 In Motion, click the Search button at the bottom of the Media list, then enter the name 

of items to view in the Search field.

As you type in the Search field, the Media list is filtered to show items containing the 
text you type.

To stop filtering and return to the complete list, click the Clear button on the right side of 
the Search field.

Reveal source media in Motion
Occasionally, you may need to find source media used in your project, to access additional 
information about an imported media file, or to locate the external file on your computer or 
networked storage device.

Show a layer’s source media link in the Media list
In Motion, do one of the following:

•	 Control-click a layer in the canvas, Layers list, or Timeline, then choose Reveal Source 
Media from the shortcut menu.

•	 Select a layer, then choose Object > Reveal Source Media (or press Shift-F).

The Media list opens, with the source media selected. The Media Inspector also opens, 
displaying information about the source media.



84Motion User Guide

Find external source media used in your project
•	 In Motion, open the Media list, Control-click a media item, then choose Reveal in Finder 

from the shortcut menu. 

A Finder window appears, and the external source media file used in your project is 
highlighted.

Preview a media file in a separate window
In the Project pane in Motion, click Media to open the Media list, then do any of the 
following:

•	 Open a file in a viewer window: Control-click a file, then choose Open in Viewer from 
the shortcut menu.

•	 Open a file in QuickTime Player: Control-click a file, then choose Open in QuickTime 
Player from the shortcut menu.

Adjust source media parameters

Display the Media Inspector in Motion

The Media Inspector displays adjustable parameters that define how an image or video 
clip is displayed and composited in the project. These parameters define the source 
media’s essential properties, including frame rate, pixel aspect ratio, interlacing, and alpha 
channel parameters. There are also parameters that allow you to define source media’s end 
condition, reversal, cropping, and timing.

Open the Media Inspector
•	 In Motion, open the Media list (the second list in the Project pane), select a media item, 

open the Inspector, then click Media.

The Media Inspector shows adjustable parameters for and information about the 
selected item in the Media list. For information about adjusting source media 
parameters, see Source media controls. 
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Source media controls in Motion

Motion attempts to interpret the correct parameter settings for each source media item you 
add to a project. However, additional manual adjustment is sometimes necessary. Because 
Motion is a nondestructive application, changes made to these parameters are not applied 
to the source media files on your computer or networked storage device. Parameter 
changes affect how files are used in Motion.

The following controls let you modify source media in the Media list. Modifying source 
media modifies all layers in a project linked to that media.

Note: The parameters described below do not apply to Photoshop files imported as 
separate layers. And PDF files with transparent backgrounds do not have the Alpha Type or 
Invert Alpha parameters.

•	 Alpha Type: A pop-up menu to set how Motion deals with alpha channels in the media 
item. An alpha channel contains information about areas of transparency in the image 
or movie. When you import an image file or QuickTime movie that has an alpha channel, 
its alpha channel is immediately recognized by Motion. There are several different ways 
to embed alpha channel information into files, which correspond to the options in this 
menu. Motion assigns an option based on an analysis of the object when it’s imported, 
but you can override the default if necessary, by choosing any of the following:
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•	 None/Ignore: The default setting for objects with no alpha channel. This option also 
allows you to ignore an object’s alpha channel, so the entire object appears solid.

•	 Straight: These alpha channels are kept separate from the red, green, and blue 
channels of an image. Media files using straight alpha channels appear fine when 
used in a composition, but they may look odd when viewed in another application. 
Translucent effects such as volumetric lighting or lens flares in a computer-
generated image can appear distorted until the clip is used in a composition. If 
Straight is chosen but you see a black, white, or color fringe around the object, 
this parameter is incorrectly set and should be changed to a Premultiplied option, 
depending on the color of the fringe.

•	 Premultiplied–Black: This type of alpha channel is multiplied with the clip’s red, 
green, and blue channels. As a result, objects with premultiplied alpha channels 
look correct, even with translucent lighting effects, because the entire image is 
precomposited against a solid color. This option interprets alpha channels that are 
precomposited against black.

•	 Premultiplied–White: This option interprets alpha channels that are precomposited 
against white.

•	 Guess Alpha Type: This option forces Motion to analyze the file in an attempt to 
figure out what kind of alpha channel is used. If you’re unsure, use this setting.

•	 Color Space Override: If the color space metadata for a video clip is missing or 
incorrect, use this pop-up menu to change the media’s color profile so that Motion 
processes and displays the selected video correctly. The options vary depending on 
the selected file. Rec. 601, Rec. 709, and Rec. 2020, Rec. 2020 HLG, and Rec. 2020 PQ 
are available for most files; sRGB IEC61966-2.1 and Adobe RGB are available for still 
images. See About color space.

 Tip: It’s best to set the correct color space for your media before attempting any 
color correction.

•	 Invert Alpha: A checkbox that, when selected, inverts an alpha channel that is 
incorrectly generated in reverse. Ordinarily, an alpha channel is a grayscale channel, 
where white represents areas of 100 percent opacity (solid), gray regions represent 
translucent areas, and black represents 0 percent opacity (transparent). 

•	 Pixel Aspect Ratio: A pop-up menu to set the type of pixel relevant to the project, 
square or nonsquare. In general, objects created for computer display, film, and high-
definition video use square pixels, while objects created for some video formats (such 
as DV, HDV, DVCPRO HD, and others) use nonsquare pixels. A value field to the right of 
this pop-up menu displays the numeric aspect ratio, in case you need a custom ratio. By 
correctly identifying each object you add to your project, you can mix and match both 
kinds of media.

•	 Field Order: A pop-up menu to choose a field order that matches the field order of the 
device used to capture an interlaced clip. There are three choices: None, Upper (Odd), 
and Lower (Even). If you choose incorrectly, the video will stutter during playback. When 
this happens, choose the opposite field order. Clips shot on film or with a progressive-
scan video camera have no interlacing; therefore, Field Order should be set to None. 
By correctly identifying each object in your project, you can mix and match clips with a 
different field order.
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•	 Frame Rate: A pop-up menu to choose a frame rate in frames per second (fps) that 
matches a clip’s native rate. For example, film is 24 fps, PAL video is 25 fps, and NTSC 
video is 29.97 fps. Additional frame rates are available for other video formats. If the 
frame rate you require is not listed, enter a number in the text field to the right of the 
pop-up menu. If you modify a QuickTime file’s frame rate but need to change it back 
to the file’s original rate, choose “From file” at the bottom of the Frame Rate pop-up 
menu.

Although you can mix clips using different frame rates, clips playing at a frame rate 
different from that of the project might not play smoothly.

Note: Project frame rates are determined by the project preset. To edit a preset or to 
create a preset, choose Motion > Settings and use the options in the Presets pane.

•	 Fixed Width and Fixed Height: Sliders (available for still images) to change the 
resolution of source media. When the Large Stills control (in Motion Settings) is set to 
Scale to Canvas Size, these values display the resolution of the original file. See Set the 
import size of large images.

When a PDF is selected in the Media list, these controls set the maximum resolution to 
which a PDF object can be smoothly scaled. See PDF files.

•	 Crop: Four sliders, visible when you click the disclosure triangle, that define the number 
of pixels to be cropped from each of the source media’s four sides, relative to the outer 
edge of the bounding box that surrounds that source media. Cropping an item in the 
Media list also crops all instances of that item in layers of the project. A similar Crop 
parameter appears in the Properties Inspector when you select a layer in the Layers list. 
See Properties Inspector controls.

•	 Timing: Three value sliders to set the start, end, and duration of the source media:

•	 Start: Sets the In point of the source media, in constant and variable speed modes. 
Adjusting this parameter moves the In point to the specified frame without affecting 
the duration of the media.

•	 End: Sets the Out point of the source media, in constant and variable speed modes. 
Adjusting this parameter moves the Out point to the specified frame without 
affecting the duration of the media.

•	 Duration: Sets the total duration of the source media. If Time Remap is set to 
Constant Speed, adjusting Duration also affects the Speed and Out point. If Time 
Remap is set to Variable Speed (in the Timing controls of the Properties Inspector), 
adjusting Duration does not affect variable speed playback.

•	 Linked Objects: A list of all objects in the Layers list that are linked to the selected 
source media in the Media list. The first column shows the name of the group containing 
an instance of the source media; the second column shows the layer name. Changing 
the layer name in the Layers list updates the name appearing in this list.

•	 Replace Media File: A button to relink media in your project to a source file on disk. This 
feature is primarily useful for relinking offline media, but can also be used to change 
source media (changing all layers that are linked to that source media). When a 3D 
object file is selected, only compatible 3D files (USDZ) are available for relinking.

•	 Metadata: An information pane displaying properties of the external media file on your 
computer or networked device that’s linked to the item selected in the Media list.
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Duplicating and deleting media files in Motion
When you delete a layer in the Layers list, by default Motion deletes the corresponding 
media item in the Media list (but does not delete the source media on your computer or 
connected storage device). If you want to delete a layer but retain its source media item in 
the Media list for future use, open Motion Settings and, in the General pane, deselect the 
“Automatically manage unused media” checkbox. See General settings.

When you duplicate a layer in the Layers list, a new instance of the source media is created 
in the Layers list—however, no new source item is created in the Media list. In a project 
with duplicated layers, you can adjust the attributes of all duplicates simultaneously by 
adjusting the source media’s parameters in the Media Inspector (see Display the Media 
Inspector).

If you’ve duplicated layers and want to delete them all at the same time, delete the 
corresponding media item in the Media list.

Exchange media in a project in Motion
You can overwrite an image layer with media from a different file. This process, called 
exchanging media, replaces the layer’s original source media link with a new source media 
link. When you exchange a layer’s source media, the layer retains its Property Inspector 
parameter values (including Position, Scale, and Opacity, and Blend Mode), as well as 
applied filters, behaviors, masks, or keyframes.

The exchange operation lets you replace layers in your project even after you’ve modified 
and animated them. If you’re unhappy with an element of your composition, exchange it 
with a new one.

Important: You can only exchange layers that are linked to source media files on your 
computer or networked device. You cannot exchange Motion-generated objects such as 
particle systems, generators, shapes, or text objects. You can only exchange 3D object 
files with other 3D object files.

Exchange media in a layer
1.	 Drag a media file from the Finder onto a layer in the Layers list in Motion.

2.	 When a curved pointer appears, release the mouse button.

The layer’s original source media is replaced by the new source media.
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Exchange source media in the Media Inspector
1.	 In the Media list in Motion, select the object to replace.

2.	 Open the Media Inspector or HUD (heads-up display).

Note: For information about opening the Media Inspector, see Display the Media 
Inspector. To open the HUD, press F7.

3.	 Click Replace Media File.

4.	 In the dialog that appears, navigate to the file that will replace the current source 
media.

5.	 Click Open.

The original source media is replaced by new source media in the Media list and in any 
layers in the project linked to the source media.

Reconnect offline media

Reconnect offline media files in Motion

Adding a media file to a Motion project creates a link between the resulting image layer in 
Motion and its corresponding source media file on your computer or connected storage 
device. If you move, delete, or rename media files on your computer or connected device, 
the linked layers in Motion go “offline.” Media can also go offline if you give someone a 
project file without also providing the source media it uses.

Offline layers appear as checkered rectangles that occupy the entire bounding box of the 
missing image.

When a layer goes offline, a question mark icon appears beside the empty preview 
thumbnail in the Layers list.
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In the Media list, a question mark icon replaces the missing preview thumbnail.

When you open a project file with offline media, a dialog appears listing all files that can’t 
be found. If the media files were moved to another folder or disk instead of being deleted, 
you might be able to locate them on your computer using the offline media search feature. 
If you know the location of the missing media files, you can display a manual reconnection 
dialog and navigate to the files without searching. If the file was renamed, you must locate 
it manually.

Manually reconnect an offline media file
1.	 In the alert dialog that appears in Motion, click Reconnect Media.

In the manual reconnection dialog that appears, navigate to the location of the missing 
file.

2.	 In the dialog that appears, navigate to the location of the missing file, select the file, 
then click Open.

The file is reconnected. If more than one missing media file appears in the same folder, all 
files are reconnected.

Search for and reconnect offline media files
If you can’t find the file manually, use the offline media search feature.

1.	 In the alert dialog that appears in Motion, click Search for Media.

Motion attempts to find the first missing file in the list. If the search is successful, a 
dialog shows the missing media file. 

2.	 Select the file, then click Open to reconnect it.

If the search is unsuccessful, try the steps in Manually reconnect an offline media file. 
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Reconnect offline media in the Media Inspector
If you do not immediately reconnect an offline layer, you can still save changes to the 
project and even close it again, then reconnect the offline layers later, via the Reconnect 
Media File button in the Media Inspector.

1.	 In Motion, open the Media list.

2.	 Select the offline layer to reconnect.

3.	 Open the Media Inspector, then click the Reconnect Media File button under the Linked 
Objects list.

Motion attempts to find the first missing file in the list. If the search is successful, a 
dialog appears with the missing media file selected. If the search is unsuccessful, you 
must navigate manually to file’s location, then select the file.

4.	 Click Open to reconnect the file.

Note: You can also use the File > Reconnect Media command.

If more than one missing media file appears in the same folder, clicking Open reconnects 
all files. 

Networked devices and removable media in Motion

Be careful when adding media files from a remote server to your project. Although the 
Import button (and Import command) can access the contents of other computers on your 
network, dragging remote media to your project does not copy the source file to your 
computer. The media source file remains on the remote device. As a result, when that 
remote device becomes unavailable, the corresponding item in your project goes offline. 
Further, depending on the speed of your network, you may experience performance issues 
when using media files on other computers.

Ideally, copy all media files used in your project onto a device that’s physically connected 
to your computer. If you must use media from a networked storage device, ensure that the 
device is always mounted on your system and that you have a high-performance network.

This is especially true for media from removable devices, such as flash drives, DVDs, and 
removable hard disks that are frequently disconnected from your computer. Always copy 
media files from such media to your local computer.
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Play back projects

Intro to project playback in Motion
The easiest way to play a project and see your animated sequence in real time is to use 
the transport controls in the timing toolbar at center of the Motion window. The transport 
controls let you start and stop your project’s playback, jump to the beginning or end of 
your project, advance your project frame by frame, and so on.

Underneath the transport controls, the playhead marks the current position in the Timeline 
(the current frame shown in the canvas). You can move the playhead by dragging it (known 
as scrubbing) or by clicking another area of the Timeline. 

As you review your work, you can:

•	 Play back your project using simple transport controls

•	 Adjust project timing

•	 Define a play range

•	 Optimize playback performance by manually rendering a portion or your entire project 
to random access memory (RAM)

•	 Play your project in full-screen player mode

•	 View the canvas (or Timing pane) on a second display

For information about graphics cards and performance, see Project playback performance.
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View and play back a project

Play back a project in Motion
You can play a project from the beginning, play it from a certain point, play a selection, and 
loop playback. You can also play video in full-screen view.

Play back a project
In Motion, do any of the following:

•	 Start project playback: In the timing toolbar, click the Play button (or press the Space 
bar). After you click Play, this control becomes a Pause button.

•	 Stop project playback: In the timing toolbar, click the Pause button (or press the Space 
bar). After you click Pause, this control becomes a Play button.

•	 Go to the start of a project: In the timing toolbar, click the Go To Start button (or press 
the Home key).

•	 Go to the end of a project: Press the End key.

•	 Play a project from the beginning: Pressing and holding the Option key, click the Play 
button in the timing toolbar. (You can also press Shift-Space bar.)

•	 Play a selection: Select the layer you want to play, then choose Mark > Play Selection 
(or press /).

•	 Play or mute audio: Click the Mute button, located on the left side of the timing toolbar.

Go to the next or previous frame
In Motion, do one of the following:

•	 Move the playhead forward by one frame: Press the Right Arrow key.

•	 Move the playhead backward by one frame: Press the Left Arrow key.

Scrub a project
In the Timeline or mini-Timeline in Motion, do one of the following:

•	 Drag the playhead to a new position.

•	 Click in the either side of the playhead.
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Loop project play back
The Loop button controls whether playback loops indefinitely, or whether playback stops at 
the end of the play range.

In Motion, do one of the following:

•	 In the timing toolbar, click the Loop button.

•	 Choose Mark > Loop Playback (or press Shift-L).

For more information on setting a play range, see Define the play range.

To control whether Motion displays media at full resolution in the canvas, and whether 
video playback is optimized for quality or performance, choose the corresponding options 
from the View pop-up menu in the upper-right corner of the Motion window. See Custom 
canvas view options.

Optimize playback using RAM preview in Motion
Each time you play a project in the canvas, Motion performs complex rendering 
calculations to represent the objects and effects that appear in each frame. The project 
plays back as quickly as possible up to the frame rate specified in the Properties Inspector. 
However, with a very complex project, playback quality can be hampered by the limitations 
of your computer hardware.

To improve real-time playback, you can manually render parts of your project and store the 
frames in your computer’s random access memory using the RAM Preview command.

RAM preview your entire project
•	 In Motion, choose Mark > RAM Preview > All.

The RAM Preview dialog appears, displaying a progress bar that shows which frame 
is being rendered, how many more frames remain, and an approximation of the time 
remaining. When RAM preview is completed, the dialog closes.

Note: Because some sections of a project may be more complex than others, the “Time 
remaining” value may be somewhat inaccurate.
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Interrupt the RAM preview
•	 In Motion, click the Stop button in the RAM Preview dialog.

The section that has been rendered is stored in RAM. When a section of your project is 
stored in RAM, a dotted line appears along the top of the Timeline ruler and the mini-
Timeline.

Clear RAM preview
You can manually delete RAM preview to make room for a new RAM preview or to free up 
RAM for other operations.

•	 In Motion, choose Mark > RAM Preview > Clear RAM Preview.

RAM preview the play range
You can restrict which frames are rendered by choosing to preview the play range or a 
selection. Using RAM preview on a selection renders all visible layers in the project from 
the first frame of the selection until the last.

1.	 Set a play range in your Motion project.

See Define the play range.

2.	 Choose Mark > RAM Preview > Play Range.

The RAM Preview dialog appears and displays a progress bar. When RAM preview is 
completed, the dialog closes. 
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RAM preview a selection
1.	 In Motion, Option-Command-drag in the Timeline to select a region to preview.

A highlight appears over the selected frames.

For more information on regions, see Edit a range of frames in the Timeline.

2.	 Choose Mark > RAM Preview > Selection.

The RAM Preview dialog appears. When RAM preview is completed, the dialog closes.

Use full-screen player mode in Motion
When you click the Maximize Canvas button below the canvas, the canvas expands to fill 
the Motion window. This is helpful for watching project playback without the distraction of 
the software interface. In this mode, the menus, toolbars, and timing display remain active.

Switch to full-screen player mode
In Motion, do one of the following:

•	 Choose Window > Player Mode.

•	 Click the Maximize Canvas button, located on the right side of the canvas toolbar.

•	 Press F8.

Return to normal view
In Motion, do one of the following:

•	 Choose Window > Player Mode again.

•	 Click the Maximize Canvas button again.

•	 Press F8 again.
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Use a second display in Motion
If you have two displays connected to your computer, you can show the canvas or Timing 
pane on the second display.

Note: You can also drag Motion project windows to the second display, allowing you to view 
more than one project at a time.

Show the canvas on a second display
•	 In Motion, choose Window > Show Canvas on Second Display.

The canvas and Project pane (Layers list, Media list, and Audio list) appear on the 
second display. Drag the right edge of the Project pane left or right to resize the canvas 
and Project pane.

Show the canvas in the main window
In Motion, do one of the following:

•	 Choose Window > Show Canvas in the Main Window.

•	 Choose Window > Revert to Original Layout.

Show the Timing pane on a second display
•	 In Motion, choose Window > Show Timing Pane on Second Display.

The Timing pane (Timeline, Audio Timeline, and Keyframe Editor) appears on the second 
display. Drag the right edge of the Timeline layers list left or right to resize the Timing 
pane and layers list.

Note: Click the Show/Hide Timeline button, Show/Hide Audio Timeline button, and 
Show/Hide Keyframe Editor button on the right side of the timing toolbar to show or 
hide the Timing pane interface elements.

Show the Timing pane in the main window
In Motion, do one of the following:

•	 Choose Window > Show Timing Pane in the Main Window.

•	 Choose Window > Revert to Original Layout.
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View and adjust project timing

Intro to the timing display in Motion
In the center of the timing toolbar, the timing display shows the current playhead 
position in your project or the total duration of your project. Further, you can display this 
information in different units—frames or timecode. The timing display also allows you to 
perform common timing tasks such as changing project duration, navigating to a specific 
frame, moving forward or backward in small or large increments, and scrubbing frames.

For detailed instructions, see:

•	 View or change timing information

•	 Navigate a project

•	 Change the duration of a project

View project timing information in Motion
You can set the timing display to show either the current playhead position or the total 
project duration. You can also set the timing display show this information in different 
units—frames or timecode.

Switch between display of playhead position and project duration
Do one of the following:

•	 In Motion, click the clock icon on the right side of the timing display.

When set to project duration, the clock icon looks like this:

When set to playhead position (known as current time), the clock icon looks like this:

•	 Click the down arrow on the right side of the timing display, then choose Show Current 
Time or Show Project Duration.
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When set to show project duration, the timing display shows the running time or number of 
frames in your project (depending on the unit of measure you choose to display). When set 
to show the current time, the timing display shows the frame number or timecode number 
of the current playhead position (depending on the unit of measure you choose to display).

Switch between display of frame numbers and timecode
The timing display offers two ways of measuring time in your project: frames or timecode. 
Frames are incremental still images starting at 1 or 0 and continuing for the duration 
of your project. Timecode is the standard eight-digit numeric system used in video 
production. Timecode runs like a clock from 00:00:00:00 to 23:59:59:29. The first two 
digits represent hours; the second two digits represent minutes; the third two digits 
represent seconds; and the final two digits represent frames, as in HH:MM:SS:FF.

•	 In Motion, click the down arrow on the right side of the timing display, then choose 
Show Frames or Show Timecode from the pop-up menu.

Frames and timecode counters have specific advantages, depending on the video format 
in which you’re originating and finishing. For example, if you’re designing a title sequence 
for a 35mm film that must be exactly 720 frames, set the timing display to show frames. If 
you’re building a television spot for broadcast (which uses the timecode standard), set the 
timing display to show timecode.

Move the playhead in Motion
You can also use the timing display to move the playhead.

Move the playhead to a specific frame or time
In Motion, do one of the following:

•	 With the timing display pop-up menu set to Show Frames and Show Current Time, 
double-click the number display, type the desired frame number, then press Return.

•	 With the timing display pop-up menu set to Show Timecode and Show Current Time, 
double-click the number display, type the desired timecode (in HH:MM:SS:FF format), 
then press Return.

Increase or decrease the current time one frame at a time
•	 In Motion, with the timing display pop-up menu set to Show Current Time, press the 

Left Arrow key to move the playhead backward or press the Right Arrow key to move the 
playhead forward.
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Move ahead or back in seconds, minutes, or hours
1.	 In Motion, ensure that the timing display pop-up menu is set to Show Current Time.

2.	 Double-click the timing display, then do one of the following:

•	 To move forward in seconds, enter a plus sign (+), enter the number of seconds to 
move forward, enter a period, then press Return. For example, to move 2 seconds 
ahead, enter “+2.” (with a period after the numeral 2), then press Return. To move 
ahead in minutes, enter two periods after the numeral, then press Return. To move 
ahead in hours, enter three periods after the numeral, then press Return.

•	 To move backward in seconds, enter a minus sign (–), then enter the number of 
seconds to move backward, enter a period, then press Return. For example, to move 2 
seconds backward, enter “–2.” (with a period after the numeral 2), then press Return. 
To move backward in minutes, enter two periods after the numeral, then press Return. 
To move backward in hours, enter three periods after the numeral, then press Return.

Move forward or backward a specific number of frames
In Motion, do one of the following:

•	 With the timing display pop-up menu set to Show Current Time, enter a plus sign (+) 
followed by the number of frames to move forward, then press Return.

•	 With the timing display pop-up menu set to Show Current Time, enter a minus sign (–) 
followed by the number of frames to move backward, then press Return.

Change project duration in Motion
By default, a new Motion project has a duration of ten seconds. You can change this 
duration to match the needs of your project.

Display project duration in the timing display
In Motion, do one of the following:

•	 In the timing display, click the down arrow, then choose Show Project Duration from the 
pop-up menu.

•	 In the timing display, click the clock icon to switch between project duration display and 
current time display.

Change the project duration
In Motion, do one of the following:

•	 With the timing display set to Show Project Duration, double-click the number, type a 
duration value, then press Return.

When the timing display is set to Show Timecode, you can type a precise timecode 
value in the HH:MM:SS:FF format (hours:minutes:seconds:frames).

•	 With the timing display set to Show Project Duration, drag left or right over the number 
to decrease or increase the duration.

•	 Choose Edit > Project Properties (or press Command-J), then change the value of the 
Duration field in the Properties Inspector.

Note: Click the down arrow to the right of the numbers in the timing display and choose 
Show Frames or Show Timecode to switch between viewing the project duration in frames 
or timecode.
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Change the default project duration
•	 In Motion, choose Motion > Settings (or press Command-Comma), click Project (if it’s 

not already selected), then enter a project length in the Project Duration field.

Note: The duration of any open project is not changed. This setting takes effect only in 
projects created after the preferences are set and Motion is quit and reopened.

Change the duration in seconds, minutes, or hours
1.	 In Motion, click the down arrow in the timing display, and make sure that the pop-up 

menu is set to Show Timecode and Show Project Duration.

2.	 Double-click the timing display, then do any of the following:

•	 Set the duration to an exact timecode value: Enter a specific timecode value in the 
HH:MM:SS:FF format (hours:minutes:seconds:frames), including a colon between 
each double-digit number.

•	 Set the duration in total seconds: Enter the number of seconds followed by a period, 
then press Return.

•	 Set a duration in total minutes: Enter the number of minutes followed by two periods, 
then press Return.

•	 Set a duration in total hours: Enter the number of hours followed by three periods, 
then press Return.

Define the play range in Motion
Ordinarily, clicking the Play button plays your project from the current frame (playhead) to 
the last frame. However, you can change the play range of your project by modifying the 
In and Out points in the Timeline ruler or by using Menu commands. You might do this to 
focus on a specific section as you fine-tune your project or make other changes to it.

Customize the playback In point
In Motion, do one of the following:

•	 In the ruler, drag the In point marker from the left edge of the ruler to the frame where 
you want to set the In point. As you drag, the playhead moves with your pointer. When 
you release the mouse button, the playhead snaps back to its previous position.

•	 In the ruler, move the playhead to the frame where you want to set the In point, then 
choose Mark > Mark Play Range In.

•	 In the ruler, move the playhead to the frame where you want to set the In point, then 
press Option-Command-I.
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Customize the playback Out point
In Motion, do one of the following:

•	 In the ruler, drag the Out point marker from the right edge of the ruler to the frame 
where you want to set the Out point.

•	 In the ruler, move the playhead to the frame where you want to set the Out point, then 
choose Mark > Mark Play Range Out.

•	 In the ruler, move the playhead to the frame where you want to set the Out point, then 
press Option-Command-O.

Reset playback In and Out points
In Motion, do one of the following:

•	 Choose Mark > Reset Play Range.

•	 Press Option-X.

The In and Out points reset themselves to the beginning and end of the project.

Navigate to playback In and Out points
In Motion, do any of the following:

•	 Navigate to an In point: Choose Mark > Go to > Play Range Start (or press Shift-Home).

•	 Navigate to an Out point: Choose Mark > Go to > Play Range End (or press Shift-End).

Project playback performance in Motion
When you play back a project, Motion attempts to display your sequence in real time. 
However, if your computer has an older graphics card, or if have more than one monitor 
connected to your graphics card, playback performance may be negatively affected.

Your graphics card also determines the maximum file size you can import into Motion. For 
most recommended cards, the image size limit is 4K or 8K. For the best results, resize 
very large images to the largest size required in the project, but no larger. Computers with 
graphics cards containing minimum amounts of video RAM (VRAM) may experience poor 
performance (or other issues) when creating 4K projects. For more information, visit the 
Motion website at apple.com/finalcutpro/motion.

Note: Because of hardware limitations and differences, the appearance of projects shared 
between computers with different installed graphics cards may vary. 

https://www.apple.com/finalcutpro/motion/
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Work in a basic project

Intro to basic compositing in Motion
After you create a project and add content, you can begin to edit and arrange the image 
layers in your composition. This process is known as compositing, the art of combining at 
least two images to produce an integrated final result. Motion graphics artists use various 
compositing techniques to create animated visual effects—transforming the physical 
properties of image layers (such as scale), adjusting opacity, applying filters, creating 
text and shapes, and so on. Compositing also includes special effects techniques such as 
keying, masking, color correction, and the creation of animated particle systems.

Most basic compositing tasks are performed in four areas of the Motion window:

•	 Layers list: Select image layers and effects objects in this hierarchical list. You can also 
rearrange the stacking order of image layers so that certain images appear above other 
images in the canvas. See Intro to the Layers list.

•	 Canvas: View and manipulate image layers in this visual workspace. Select onscreen 
editing tools in the canvas toolbar to perform basic layout tasks in the canvas—
selecting, moving, rotating, scaling, distorting, and so on. The onscreen tools let you 
adjust all of these properties by dragging in the canvas. See Intro to transforming layers 
in the canvas.

 Tip: Although you can select layers in the canvas, when multiple layers are stacked 
one atop another, it’s often easier to select specific layers in the Layers list.
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•	 Properties Inspector: You can also adjust layer properties using numeric controls—
sliders, dials, value fields, and so on. These controls in the Properties Inspector let 
you make the same adjustments afforded by the onscreen editing tools, but with 
more precision. Adjustments made in the canvas are simultaneously updated in the 
Inspector, and vice versa. For example, if you change a layer’s scale by dragging its 
corner handles in the canvas, the layer’s Scale parameter is updated in the Properties 
Inspector. See Adjust layers in the Properties Inspector. 

•	 HUD: Many of the numeric controls in the Properties Inspector are also available in the 
HUD (heads-up display), a floating window that you can show or hide. See Transform 
layers in the HUD.

Select and organize layers

Intro to the Layers list in Motion
When you add media content, the resulting element is represented in your Motion project 
as a layer. Think of layers as a series of visual overlays stacked on top of each other. These 
image layers combine to create the composition displayed in the canvas. Motion provides 
a graphical representation of this layer hierarchy in the Layers list of the Project pane. In a 
2D project, the stacking order of layers in the Layers list determines which layers appear in 
front of others in the canvas.

You can modify layers by applying effects objects to them. Effects objects also appear in 
the Layers list, under the group or layer to which they are applied. 

The Layers list contains the following objects:

•	 Layers: The basic image objects—video clips, still images, shapes, text, 3D objects, 
particle systems, and so on—in your project that combine to create a composition.

•	 Effects objects: Nonimage objects that modify image layers or groups. Effects objects 
include filters, behaviors, lights, cameras, and rigs. Effects objects appear in the Layers 
list indented under the layer or group that they modify.

•	 Groups: Containers that enclose layers and effects objects. When you create a layer, it’s 
placed inside a group. All image layers and effects objects—except for cameras, lights, 
rigs, and the Project object—must reside in groups. Masks, behaviors, and effects can 
be applied to groups or to layers. A group can also contain other groups nested inside 
it. In this way, you can construct complex hierarchies of nested groups, with each 
nested group subordinate to the group that contains it.

•	 360° environments: Containers that enclose 360° footage and filters. 360° 
environments cannot contain objects such as particles, replicators, or shapes. See Intro 
to 360° video.
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•	 Project object: An icon at the top of the Layers list that, when selected, makes the 
Project Inspector available. The Project Inspector displays parameters for publishing a 
template for use in Final Cut Pro. See Publish controls to Final Cut Pro and Add multiple 
aspect ratios to templates.

Additional icons and controls in each row of the Layers list provide information about the 
status of applied effects, allow you to lock layers, and let you turn applied effects on or off. 
See Layers list controls. 

Note: In Motion, any element that appears stacked in the Layers list is considered an 
object. That includes image layers, which are a special class of object defined as any 
image-based element—a video clip, a still image, a shape, text, a particle system, a 
replicator, and so on—that’s visible in the canvas. For example, a rotating a triangle shape 
is a layer, but the behavior object that animates it is not; a sepia-tone video clip is a layer, 
but the Sepia filter that makes it so warmly old-timey is not. In Motion help, the term object 
is often used to describe the superset of all elements (layers, groups, and effects objects) 
that form a composition. Layer, however, always refers to an image-based element.

Select layers and groups in Motion
To reorganize layers and groups in a project, you must select objects to move or modify. 
You can select layers and groups in the Layers list or canvas.

Note: You can also select, organize, and manipulate layers in the Timeline layers list. 
Changes made in the Timeline layers list are mirrored in the Layers list, and vice versa. See 
Intro to the Timeline.

Select layers or groups in the Layers list
In Motion, do one of the following:

•	 Select a single layer or group: Click a layer or group in the Layers list or canvas. All 
other selected objects are deselected.

Note: Selecting a group does not select the layers nested underneath it. However, 
operations performed on a selected group also affect layers nested in the group.

•	 Select multiple contiguous layers or groups: Click the first layer or group, then Shift-
click the last layer or group in the contiguous list.

•	 Select multiple noncontiguous layers or groups: While pressing and holding the 
Command key, click multiple layers in the Layers list. 
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Select layers in the canvas
In Motion, do one of the following:

•	 Select a single layer: In the canvas toolbar, click and hold the transform tools pop-up 
menu, choose Transform (if it’s not already selected), then click an image in the canvas.

•	 Select multiple layers: In the canvas toolbar, click and hold the transform tools pop-up 
menu, choose Transform (if it’s not already selected), then drag a selection rectangle 
around multiple images in the canvas, or press and hold the Shift key while clicking 
multiple images.

Add or remove selections when there are multiple selected layers
In Motion, do one of the following:

•	 Add to selected groups or layers: Command-click any unselected layer or group in the 
Layers list, or Shift-click any unselected layer in the canvas.

•	 Deselect a layer from multiple selected layers: Command-click any selected layer in the 
Layers list, or Shift-click any selected layer in the canvas.

Select all layers and groups
In Motion, do one of the following:

•	 Choose Edit > Select All (or press Command-A).

•	 Click the first group or layer in the Layers list, then Shift-click the last group or layer in 
the list.

Deselect all layers or groups
•	 In Motion, choose Edit > Deselect All (or press Shift-Command-A).
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Show and hide the Layers list in Motion
The Layers list is located in the Project pane, to the left of the canvas. You can show, hide, 
or resize the Project pane and Layers list to customize your workspace.

Collapse or expand the Project pane
•	 In Motion, choose Window > Hide Project Pane or Show Project Pane (or press F5).

Display the Layers list
In Motion, do one of the following:

•	 If the Project pane is visible, click Layers at the top of the pane.

•	 Choose Window > Layers (or press Command-4).

Resize the Project pane
In Motion, do one of the following:

•	 Resize horizontally: Drag the right edge of the pane left or right.

•	 Resize vertically: Drag the top edge of the Timing pane (between the Timeline ruler and 
the timing display) up or down.

Note: You can also choose Window > Hide Timing Pane. The Timing pane is hidden and 
the Project pane is expanded vertically.

Expose layers in the canvas in Motion
Motion’s expose commands provide a way of viewing multiple layers at once, “exploding” 
and rescaling them. The expose commands allow you to access all layers in a project in 
the canvas without having to drill down into the Layers list. Expose commands also let you 
select inactive layers at the playhead’s current position or jump to a selected layer’s In 
point.

Expose layers that are active at the playhead position
1.	 Click anywhere in the Motion canvas.

2.	 Press X.

Layers active at the current position of the playhead temporarily scale down and spread 
out over the canvas. Each active layer is represented by a white frame in the canvas. 
Moving the pointer over a frame reveals the layer’s name.

3.	 Click a layer in the canvas.

The elements move and rescale back to their original positions and the layer you clicked 
is selected in the canvas.
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Expose all layers in your project
1.	 Click anywhere in the Motion canvas.

2.	 Press Shift-X.

Layers in the project temporarily scale down and spread out over the canvas. Each layer 
in the project is represented by a white frame in the canvas. Moving the pointer over a 
frame shows the layer’s name.

3.	 Click a layer in the canvas.

The layers move and rescale back to their original positions; the layer is selected in the 
canvas; and the playhead moves to the middle frame of the selected layer.

Add and remove layers and groups in Motion
You can add and remove layers or groups in the Layers list. You can also add or remove 
layers (but not groups) in the canvas.

Add a layer to your project
In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears to the 
Layers list or canvas.

•	 Drag a media file from the macOS Finder to the Layers list or canvas.

•	 Drag a content item from the Motion Library to the Layers list or canvas.

For more information about adding content, see Intro to adding and managing content.

Create a group in the Layers list
In Motion, do one of the following:

•	 In the toolbar, click Add Object, then choose Group from the pop-up menu.

•	 Control-click an empty area of the canvas (in the gray area outside the composition), 
then choose New Group from the shortcut menu.

An empty group is added above the existing groups in the Layers list.
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•	 Choose Object > New Group (or press Shift-Command-N).

An empty group is added above the currently selected object. (If no object is selected, 
the empty group is added at the top of the Layers list).

Duplicate a layer
In Motion, do one of the following:

•	 In the Layers list, Option-drag the layer to the position you want (or Option-drag a layer 
in the canvas).

A duplicate of the layer you dragged is placed in the new position.

Note: You can also Option-drag layers between different open Motion projects (to the 
canvas or Layers list).

•	 Control-click a layer in the Layers list or canvas, then choose Duplicate from the 
shortcut menu.

Clone a layer
When you duplicate a layer, subsequent changes made to the original (source) layer are not 
inherited by the duplicated layers. However, when you use the Make Clone Layer command, 
changes made to filters and masks in the source layer propagate to the clones. Creating 
clone layers improves project playback and rendering performance.

Important: Behaviors don’t propagate to clone layers unless the behavior affects a filter or 
mask in the source layer.

In Motion, do one of the following:

•	 Select the layer to clone, then choose Object > Make Clone Layer (or press K).

•	 Control-click a layer in the Layers list, then choose Make Clone Layer from the shortcut 
menu.

A clone layer is created and appears in the canvas on top of the original layer. In the 
Layers list, the clone layer appears with the default name “Clone Layer.” A clone layer 
icon appears next to the name.

Note: You can modify clone layers independently of their source layer. However, you cannot 
modify the Frame Blending parameter (in the Timing controls of the Properties Inspector) 
of a clone layer created from a retimed source layer.
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Remove a layer or group
In Motion, do one of the following:

•	 Control-click a layer or group in the Layers list, then choose Cut or Delete from the 
shortcut menu.

•	 Select a layer or group in the Layers list, then choose Edit > Delete (or press Delete) or 
Edit > Cut.

The layer or group is removed. This action removes the object from the canvas as well.

Note: If you delete a media file (an imported image, image sequence, audio file, or 
QuickTime movie) from the project, the file is also removed from the Media list unless the 
“Automatically manage unused media” checkbox is deselected in the General pane of 
Motion Settings. When this setting is deselected, media files are deleted from the Layers 
list (and canvas) but remain in the project in the Media list. Drag an item from the Media list 
into the canvas to add it back to the Layers list. See Show, sort, and search the Media list.

Reorganize layers and groups in Motion
The order in which layers and groups appear in the Layers list determines which layers 
appear in front of other layers in the canvas. You can change the ordering of layers in the 
Layers list or in the canvas. However, it’s easiest to select layers and change their stacking 
order in the Layers list.

Additionally, you can change layer order using commands in the Object menu. These 
commands can be used with layers, effects objects, groups, or groups nested in another 
group. Reordering a group reorders all objects nested in that group.

Note: When using 3D groups, you can rearrange the depth order in 3D space to override 
the layer order in the Layers list. For more information about depth and layer hierarchy in 
3D groups, see Create 3D intersection.

Move a layer or group forward or backward in your composition
In Motion, do one of the following:

•	 Drag a layer or group up or down in the Layers list.

A position indicator shows the new position the selection occupies when you release 
the mouse button.

•	 Select a layer or group in the Layers list (or select a layer in the canvas), click the 
Object menu, then choose Bring to Front, Send to Back, Bring Forward, or Send 
Backward.

Note: You cannot use the Object menu reorder commands to move image layers out of 
the group they’re nested in.

The selected layer or group is reordered in the Layers list and canvas.

Note: Using the Bring and Send commands in the Object menu to move layers up and 
down in the nested hierarchy in any group is especially useful when working with selected 
objects in the canvas. See Object menu keyboard shortcuts.
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Move multiple layers or groups forward or backward in the composition
In Motion, do one of the following:

•	 In the Layers list, Shift-click to select multiple contiguous layers or groups or 
Command-click to select multiple noncontiguous layers or groups, then drag the items 
up or down in the Layers list.

A position indicator shows the new position the items occupy when you release the 
mouse button.

•	 In the Layers list, Shift-click to select multiple contiguous layers or groups or 
Command-click to select multiple noncontiguous layers or groups, click the Object 
menu, then choose Bring to Front, Send to Back, Bring Forward, or Send Backward.

Note: When you apply the Bring Forward or Send Backward arrangement command 
to noncontiguous selected layers, the layers move up or down the object hierarchy 
together, and any space between the layers remains.

Move a layer from one group to another
When you have more than one group, you can move layers back and forth between groups, 
changing their nested relationship in your project.

1.	 In Motion, select one or more layers.

2.	 Do one of the following:

•	 Drag the selected layers to a position underneath another group. A position indicator 
appears, showing where the layer is placed when you release the mouse button.

•	 Choose Edit > Cut (or press Command-X), then select the group to paste into, and 
choose Edit > Paste (or press Command-V).

Copy a layer from one group to another
In Motion, do one of the following:

•	 Option-drag selected layers from one group to another.

•	 Select layers, choose Edit > Copy (or press Command-C), then select the group to 
paste into, and choose Edit > Paste (or press Command-V).

•	 Select layers, choose Edit > Copy (or press Command-C), select the group to paste 
into, then Control-click an empty area of the canvas (in the gray area outside your 
composition) and choose Paste from the shortcut menu.

Copy a layer or group from one project to another
When you have more than one project open, you can copy layers or groups back and forth 
between projects.

1.	 In Motion, select one or more layers in the active project window.

2.	 Do one of the following:

•	 Drag the selected object to a position in the target project’s Layers list. A position 
indicator appears to show where the object is placed when you release the mouse 
button. 

•	 Choose Edit > Copy (or press Command-C), select a group in the target project, then 
choose Edit > Paste (or press Command-V).

•	 Option-drag a layer in the canvas to the canvas or Layers list of the target project.
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Rename a layer or group
Renaming groups and layers in the Layers list helps organize your project. When you 
rename a layer, the original name of the source media file on disk remains unchanged. 
Likewise, renaming a layer in the Layers list does not change the name of the layer’s 
corresponding source media in the Media list. See Intro to source media or Show, sort, and 
search the Media list.

1.	 In the Layers list in Motion, double-click the name of a group or layer, then enter a new 
name.

2.	 To confirm the name, press Return, or click in another layer or group.

Show, hide, solo, or lock layers in Motion
In the Layers list, you can disable layers and groups to make them invisible in the canvas 
without removing them from your composition. For example, if a large image layer 
obstructs other layers you want to adjust in the canvas, you can temporarily disable the 
offending layer. Similarly, you can disable effects objects—filters, behaviors, masks, and so 
on—to temporarily remove their effect on layers and groups.

If you disable a group, you also hide all layers and groups nested in it. Hidden layers and 
groups are not included when your project is exported.

In the Layers list, you can also solo or lock groups or layers to prevent accidental modification.

Enable or disable objects
When you disable an image layer or group, it becomes invisible in the canvas. When you 
disable an effects object (such as a behavior or filter), its effect is disabled.

Do one of the following:

•	 In Motion, deselect the activation checkbox to the left of an object in the Layers list.

•	 Select an object, then choose Object > Active (or press Control-T).

•	 Control-click an object, then choose Active from the shortcut menu.

When disabled, objects are dimmed in the Layers list. Disabled layers are hidden in the 
canvas; disabled effects objects no longer modify the group or layer they’re applied to. 

Note: If you disable layers in a group, the enclosing group’s checkbox displays a dash 
instead of a checkmark, indicating that some layers are not visible.
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Solo a layer or group
You can “solo” a layer or group to hide all other layers and groups in the project. This 
technique can be useful to isolate a single layer or group in the canvas to animate or 
manipulate it without interfering with other objects in your composition.

1.	 In the Layers list in Motion, select layers or groups to solo.

2.	 Choose Object > Solo (or press Control-S).

Note: You can also Control-click an object in the Layers list, then choose Solo from the 
shortcut menu.

All other layers or groups are deactivated, and only the soloed object is visible in the 
canvas. When the selected item is soloed, the solo menu item displays a checkmark.

Lock an object
Locked objects cannot be modified or moved, and their parameters cannot be altered or 
animated. However, animation and behaviors previously applied to a layer or group still 
play. Locking a group also locks all layers and groups nested in it.

Note: You cannot lock objects that contain published parameters (for use in Final Cut Pro). 
Such objects display a dimmed lock control. For more information about publishing 
parameters, see Adding controls to templates.

In Motion, do one of the following:

•	 Click the lock icon to the right of the object in the Layers list.

•	 In the Layers list, select a layer, group, or effects object, then choose Object > Lock (or 
press Control-L).

In the canvas, the bounding box of a disabled layer (or a disabled group of layers) turns 
white to indicate the item is locked. 
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Nest layers and groups

Intro to nesting layers and groups in Motion

Groups and layers in the Layers list appear in a hierarchy that shows which layers are 
nested inside which groups. Nested layers and groups appear underneath and indented to 
the right of their parent group.

It’s a good idea to group layers that work together as a unit. By nesting related layers 
you want to animate inside a group, you can save time by animating the enclosing group, 
instead of animating each layer. For example, when you select a group that has three layers 
nested in it, the entire group is selected as a single unit.

Transforming the selected group in the canvas moves all three layers simultaneously.

Regardless of how they’re nested, layers can always be modified independently. 
Subordinate groups can also be modified independently. In the following example, a filter 
is applied to a layer in a group containing three fish layers. All other layers in the group 
remain unaffected.
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However, If you apply the same filter to the group, all layers in that group are affected by 
the filter, as if they were a single layer.

Many filters produce different results when applied to a group, rather than individual layers 
in a group, as shown in the images below.

You can also nest groups inside other groups. You might do this if you’re creating a layer 
hierarchy to control the relationship of one group of layers to another, or if you’re grouping 
layers to which you want to apply a single set of behaviors and filters.

Note: You cannot group groups that appear at different hierarchical levels in the Layers list.

Collapse and expand groups in Motion

To make the Layers list easier to manage, you can collapse layers nested in a group. 
Collapsed groups appear as a single row in the Layers list, and can be moved or nested like 
any other layer. Each group’s thumbnail displays a preview of its composite, making it easy 
to see what’s nested inside when the group is collapsed.

Open or collapse a single group
In Motion, do one of the following:

•	 In the Layers list, click the disclosure triangle to the left of a group’s name and icon.

•	 Press the Up Arrow and Down Arrow keys to navigate up and down the Layers list, then 
press Option-Right Arrow to open a group or Option-Left Arrow to collapse a group.
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Group, ungroup, and nest layers in Motion

Nesting layers and groups in the Layers list helps you apply animation and other effects to 
specific elements of your composition. See Intro to nesting layers and groups.

Nest selected layers into a new group
1.	 In Motion, select all layers or groups you want to group together.

2.	 Choose Object > Group (or press Shift-Command-G).

The selected layers or groups are nested in a new group.

Ungroup nested layers
You can also delete a containing group and “un-nest” its contents.

1.	 In the Layers list in Motion, select a group containing the nested layers or groups.

2.	 Choose Object > Ungroup (or press Option-Command-G).

The layers or groups are moved up in the Layers list hierarchy. 

Note: You cannot ungroup groups that are at the root (project level) of the Layers list 
hierarchy.

Move a group inside another group
1.	 In the Layers list in Motion, select one or more groups.

2.	 Do one of the following:

•	 Drag the groups onto another group.

•	 Drag the groups to a position at the bottom of another group.

•	 Choose Edit > Cut (or press Command-X) to cut the groups, then select another 
group and choose Edit > Paste (or press Command-V).
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Constrain group size in Motion

By default, the size of a group is determined by the layers in that group. Because animated 
objects often grow in size, the active height and width of a group (its resolution) can 
become large. You can constrain the resolution of a group to a specific width and height.

The project in the following image contains a particle system. The animated particles, 
although not visible when they move off the canvas, make the group containing them large.

If a project contains growing objects that move or expand beyond the edges of the canvas, 
use the Fixed Resolution checkbox to decrease your computer processing time.

Note: The Group Inspector (which contains the Fixed Resolution parameter) is only 
accessible when a group is selected in the project.

Fix the resolution of a group
1.	 In the Layers list in Motion, select a group.

2.	 In the Group Inspector, select the Fixed Resolution checkbox.

By default, the group’s resolution is set to the project size; objects in the group but 
outside the canvas are cropped. An “R” indicator appears to the left of the Fixed 
Resolution checkbox, informing you that the group is rasterized. For more information 
on rasterization, see Intro to rasterization.

3.	 To set a resolution other than that of the project, adjust the Fixed Width and Fixed 
Height sliders.

If the group’s anchor point is offset, the cropping might not occur around the edges of 
the canvas, and objects may be cut off.

Note: When you select a layer in a fixed-resolution group, the bounding box around the 
layer appears at its original size, unaffected by the containing group’s resolution.
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Layers list controls in Motion
In each row of the Layers list, icons offer additional information about groups, layers, and 
effects objects. Clicking these icons modifies or turns effects, visibility, and locking on 
or off.

The Layers list contains the following controls:

•	 Activation checkbox: Turns the visibility of the group, layer, or effects object on or 
off. When an object’s visibility is off, you can still modify the object’s parameters and 
manipulate its onscreen controls (in the canvas).

•	 Preview: Displays a thumbnail of a layer or group. The group thumbnail represents the 
cumulative result of the composite up to that point in the project. (You can turn the 
display of the preview on or off in the Layers Columns section of the View menu.)

•	 Name field: Identifies the object by name. To edit the name, double-click the text area 
of a selected object, enter a new name, then press Return. In projects containing a 
camera, the Isolate button appears in the Name column.

•	 Isolate button: Appears for a selected layer, group, or camera object in a project that 
contains a camera. (For information about cameras, see Add a camera.) The Isolate 
button has an active and inactive state. Clicking the Isolate button for a layer or group 
sets that object to its original face-forward orientation (so you can apply a mask, for 
example). Clicking the button again returns to the previous view. Clicking the Isolate 
button for a camera takes you to that camera’s view.

Note: When a group or layer is isolated, the name of the item replaces the current 
camera listing in the Camera menu (in the upper-left corner of the canvas).

•	 Link icon: Appears when the layer has a corresponding audio element, such as a 
multichannel QuickTime file. To unlink the video and audio (to edit them separately), 
click the link icon. When they’re unlinked, a red slash appears through the icon. 

•	 2D/3D icon: Switches a group between 2D or 3D mode. The same icon appears to the 
left of the group name and indicates the 2D/3D status of the group. Layers cannot be 
2D or 3D—they are always 2D elements in a 2D or 3D group.
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•	 Lock icon: Locks an object to prevent changes from affecting that object. Locking a 
group prevents changes to layers and effects in that group. When the lock is disabled, 
its icon appears open.

•	 Mask, behavior, and filter icons: Appear when a mask, behavior, or filter is applied to 
the layer or group. To turn off the effect of the mask, behavior, or filter, click the icon so 
that it’s marked with a slash.

•	 Opacity slider: Displays the opacity (transparency) of the group or layer. You can adjust 
the slider to change the item’s opacity. This slider is not displayed by default. To display 
the Opacity slider in the Layers list, choose View > Layers Columns > Opacity.

•	 Blend Mode pop-up menu: Displays the blend mode of the layer or group. Click the 
pop-up menu to choose a blend mode. This pop-up menu is not displayed by default. 
To display the Blend Mode pop-up menu in the Layers list, choose View > Layers 
Columns > Blend Modes. For more information on blend modes, see How do blend 
modes work?

Layers list shortcut menu in Motion
The Layers list shortcut menu gives you access to additional commands to help organize 
and manipulate layers. Control-click a layer in the Layers list, then choose a command from 
the shortcut menu. The command is applied to the layer you Control-clicked.

Note: Not all options are available for all layers.

The Layers list shortcut menu contains the following commands:

•	 Cut: Removes the layer and places it on the Clipboard.

•	 Copy: Copies the layer to the Clipboard.

•	 Paste: Places the contents of the Clipboard in the selected location.

•	 Duplicate: Creates a layer identical to the selection.

•	 Delete: Removes the selected layer.

•	 Group: Places the selected layer or layers into a new group. See Intro to nesting layers 
and groups.

•	 Ungroup: Deletes a containing group, and moves its contents up one level in the Layers 
list hierarchy.

•	 Active: Enables or disables a layer, group, or effects object—the equivalent to clicking 
an object’s activation checkbox.
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•	 Solo: Hides other layers and groups in the project (so they are not visible in the canvas). 
When a layer or group is soloed, activation checkboxes for other layers and groups are 
dimmed. You can solo multiple layers and groups at a time.

•	 Isolate: Hides all other groups and layers, and restores the selected layer or group to 
a face-forward orientation for easier adjustment (such as the application of a mask, 
for example). This command becomes available only after you add a camera to your 
project. Choosing Isolate for a camera object activates that camera’s view. 

•	 3D Group: Switches the group from 2D mode to 3D mode. For more information about 
3D groups, see 2D and 3D group properties.

•	 Blend Mode: Sets the blend mode for the selected layer. This is equivalent to setting a 
value using the Blend Mode pop-up menu (when activated in View > Layers Columns).

•	 Add Image Mask: Adds an image mask to the selected layer. An image mask creates 
transparency by deriving an alpha channel from another layer, such as a shape, text, 
movie, or still image. See Intro to image masks.

•	 Make Clone Layer: Clones the selected layer. Like the Duplicate command, Make Clone 
Layer lets you make copies of a selected layer. However, copies created by the Make 
Clone Layer command are automatically modified to match changes made to the original 
layer. See Add and remove layers and groups.

•	 Reveal Source Media: Opens the Media list and highlights the media file associated with 
the selected clip.

When no items are selected in the Layers list, the shortcut menu provides this set of 
commands:

•	 New Group: Adds a group to the project above existing groups in the Layers list.

•	 Import: Opens a dialog used to import files from the Finder.

•	 Paste: Pastes any item copied to the Clipboard into the topmost group in the Layers list.

•	 Project Properties: Opens the Properties Inspector for the project, where you can 
modify the project’s background color, aspect ratio, field rendering, motion blur, 
reflections, and so on. See Intro to project properties.
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Customize the Layers list in Motion
You can modify the display of the Layers list to suit your needs. 

Adjust row height
In Motion, do one of the following:

•	 Click the Zoom control at the bottom of the Layers list, then drag the slider left to 
decrease row height or right to increase row height.

•	 Position the pointer over a horizontal line and drag up or down to decrease or increase 
the height of all rows.

The rows and thumbnails resize themselves as you make the adjustment.

Filter the Layers list
•	 In Motion, click the Search button, then enter the name of the objects to view in the 

Search field.

When you begin typing in the Search field, the Layers list hides objects that do not 
contain the text you type. Hidden objects continue to appear in the canvas.

Stop filtering and return to the complete Layers list
•	 In Motion, click the Clear button on the right side of the Search field.

The Search field is cleared, and the Layers list returns to the unfiltered view.

Show or hide mask, behavior, or filter objects
You can hide effects objects in the Layers list to simplify your view of layers and groups in 
your project. 

•	 In Motion, click the Show/Hide Masks, Show/Hide Behaviors, or Show/Hide Filters button 
in the lower-right corner of the Layers list.

When a button is dimmed, the effects object is hidden from view in the Layers list. 
However, the effect remains active in the canvas.
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Transform layers

Intro to transforming layers in Motion
The Motion interface provides three areas where you can transform the basic spatial 
properties of layers and groups—resizing, repositioning, rotating, cropping, and 
distorting them:

•	 In the canvas, where you can drag onscreen transform handles

•	 In the Properties Inspector, where you can adjust numeric controls (sliders, value fields, 
and so on) 

•	 In the HUD, where you can adjust a subset of the controls found in the Properties Inspector

When you transform a layer in any of these areas, the layer’s parameters are also updated 
in the other two sections of the Motion window.

Transform layers in the canvas

Intro to transforming layers in the Motion canvas

You can transform image layers in the canvas using onscreen controls (transform handles) 
to drag, resize, rotate, and more. Although you can perform the same modifications with 
more precision by adjusting parameter controls in the Properties Inspector, onscreen 
controls give you a more hands-on method of working.

Before transforming layers, you must make a selection in the Layers list or canvas. After 
you select a layer, a bounding box with transform handles appears in the canvas.

You can move selected layers anywhere in the frame shown in the canvas, and you can 
also drag layers past the edge of the frame. By default, when you move a layer past the 
edge of the frame, it becomes invisible; however, you can still manipulate the layer using its 
bounding box.

You can perform different adjustments in the canvas by choosing different transform tools 
in the canvas toolbar. The default tool—Select/Transform—lets you reposition, resize, 
and rotate a selected layer or group. Other transform tools let you distort or crop objects, 
create drop shadows, and more. 

Important: In 360° projects, onscreen controls are not always available. See Intro to 360° 
video.
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Transform layer properties in the Motion canvas

After you select a layer in the Layers list or canvas, you can choose a transform tool (from 
the pop-up menu in the canvas toolbar) to activate transform handles in the canvas. Drag 
the handles to manipulate basic image properties such as position, rotation, scale, and so 
on. For a list of transform tools and their functions, see Transform tools.

Activate the Select/Transform tool
The Select/Transform tool (the arrow) is the default transform tool. Use it to resize, 
reposition, or rotate layers in the canvas.

In Motion, do one of the following:

•	 If the Select/Transform tool (the arrow) is visible in the canvas toolbar, click it.

•	 If a different transform tool is visible in the canvas toolbar, click and hold the transform 
tools pop-up menu, then choose Select/Transform.

The Select/Transform tool is selected in the canvas toolbar, and transform handles appear 
in the canvas for each selected layer or group.

Choose a different transform tool
When you choose a transform tool from the pop-up menu in the canvas toolbar, transform 
handles appear in the canvas for each selected layer or group.

In Motion, do one of the following:

•	 In the canvas toolbar: Click and hold the transform tools pop-up menu, then choose a 
different tool. For a list of transform tools and their functions, see Transform tools.
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•	 In the canvas: In the canvas toolbar, click the active transform tool, then Control-click 
any layer in the canvas and choose a tool from the shortcut menu.

The options in the shortcut menu vary depending on the type of layer selected. For 
example, a shape layer contains shape-specific options such as Stroke, Edit Gradient, 
and Edit Points.

•	 With the Tab key: In the Layers list or canvas, select a layer, then press Tab. Pressing 
Tab repeatedly cycles through the transform tools in order. Pressing Shift-Tab cycles 
through the tools in reverse.

Note: When pressing Tab, the 3D Transform tool is activated between the Select/
Transform tool and the Anchor Point tool. For more information about 3D transforms, 
see Transform layers in 3D space.

Transform layers
1.	 In Motion, select one or more layers in the Layers list or canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose a tool.

3.	 Drag an onscreen control (such as a transform handle or control point) in the canvas.

If you selected a single layer, only that layer is modified. If you selected multiple layers, 
each is transformed. Each transformation occurs around each layer’s own anchor point.
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Transform a group
If you select and then transform an entire group, all layers and groups nested in it are 
treated as a single layer.

1.	 In Motion, select a group in the Layers list.

In the canvas, a single set of transform handles appears on a bounding box that 
encompasses all layers in the group. 

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose a 
tool.

3.	 Drag an onscreen control (such as a transform handle or control point) in the canvas.

All layer transforms occur around a single anchor point belonging to the group

If you select a layer and its parent group (but not the other layers in the group), the 
following occurs:

•	 The scale handles of the parent group remain available, and the scale handles of the 
individual layers within the group are dimmed. Dragging the group’s scale handles 
scales the group, not its nested objects.

•	 The rotation handles of the individual layers remain available. Dragging an object’s 
rotation handle rotates that object independently of the other objects in the group.

Nudge a selected layer or group
In Motion, do one of the following:

•	 To nudge a selected layer or group by a single pixel, press Command-Up Arrow, Down 
Arrow, Left Arrow, or Right Arrow.

•	 To nudge a selected layer or group by 10 pixels, press Shift-Command-Up Arrow, Down 
Arrow, Left Arrow, or Right Arrow.



126Motion User Guide

Transform tools in Motion

Use the transform tools to adjust and manipulate objects in the canvas. To select a tool, 
click and hold the transform tools pop-up menu in the canvas toolbar, then choose a 
different tool.

When you choose a transform tool and then select a layer or group, handles appear in the 
canvas. Drag the handles to move or transform an object in the canvas.

 Tip: Press Shift-S to select the Select/Transform tool. To quickly cycle through tools, 
press Tab. Press Shift-Tab to cycle through the tools in reverse.

Some of the tools are activated automatically when specific layers are selected. For 
example, the Edit Points tool is selected after you create a complex shape or mask layer, so 
you can immediately adjust the Bezier or B-Spline control points.

Icon Tool Description

Select/Transform tool (arrow) Activates selection and transform controls in the 
canvas for the selected object. Scale objects by 
dragging a corner point; rotate objects by dragging the 
center point. This is the default tool in the transform 
tools pop-up menu. See Change layer position, scale, 
or rotation.

Anchor Point tool Activates an anchor point control (the point around 
which an object scales or rotates) in the canvas for the 
selected object. Modify the anchor point by dragging it 
to a new position. See Move a layer’s anchor point.

Drop Shadow tool Activates a drop shadow control in the canvas for the 
selected object. Drag a corner handle to change the 
direction and offset of an object’s drop shadow. (This 
control doesn’t move the object.) See Add a drop 
shadow to a layer.

Distort tool Activates shear and distortion handles in the canvas 
for the selected object. Drag a midpoint handle to 
shear two adjacent corners at the same time, leaving 
the other two corners locked into place; drag a corner 
handle to distort a corner, leaving the other three 
corners locked into place. See Distort or shear a layer.
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Icon Tool Description

Crop tool Activates crop handles in the canvas for the selected 
object. Drag the edge or corner of the object to crop 
(hide) a portion of the object. See Crop a layer.

Edit Points tool Activates points and Bezier handles in the canvas for 
complex masks, shapes, and motion paths. See Modify 
shape or mask points.

Edit Shape tool Activates points and curvature handles in the canvas 
for simple shapes. See Draw simple shapes.

Transform Glyph tool Activates handles in the canvas for selected text 
characters (glyphs). See Transform text glyphs and 
other object attributes.

Adjust Item tool Activates handles in the canvas that modify specific 
parameters such as the amount or angle of a 
Directional Blur, the shape of a particle emitter, or the 
start and end points of a gradient. See Transform text 
glyphs and other object attributes.

Change layer position, scale, or rotation in Motion

The Select/Transform tool is the default tool in Motion.

Clicking the Select/Transform tool in the canvas toolbar activates handles in the canvas to 
adjust a layer’s position, scale, and rotation.

Note: The Select/Transform onscreen controls are not available for layers within a 360° 
environment.
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Change a layer’s position in the canvas
1.	 In Motion, select a layer in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Select/Transform (if it’s not already selected).

By default, the Select/Transform tool is the active tool. If you have another tool 
selected, such as a Mask or Shape tool, pressing S returns you to the Transform tools.

3.	 Drag anywhere inside the selected layer’s bounding box in the canvas.

The image is moved to a new position in the canvas, and the values are updated in the 
Position parameter of the Properties Inspector.

Resize a layer in the canvas
1.	 In Motion, select a layer in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Select/Transform (if it’s not already selected).

By default, the Select/Transform tool is the active tool. If you have another tool 
selected, such as a Mask or Shape tool, pressing S returns you to the Transform tools.

3.	 Do one of the following:

•	 Resize width and height at the same time: Drag a corner handle in the canvas. 

The width and height are resized independently, which may change the aspect ratio 
(ratio of width to height) of the image.

•	 Resize width and height proportionally: Shift-drag a corner handle in the canvas.

The aspect ratio (ratio of width to height) of the image remains the same.

•	 Resize either width or height: Drag the top or bottom handle to modify height; drag 
the left or right handle to modify width.

The width or height is resized independently of the other. 

•	 Resize around the anchor point: Option-drag any scale handle in the canvas.

The layer rescales, but the anchor point of the layer remains pinned to its position in 
the canvas. 
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As you drag the scale handles, the new width and height percentages appear in the status 
bar above the canvas and are updated in the Scale parameter of the Properties Inspector. 
See View dynamic canvas feedback.

Note: Scaling the width or height of a layer by a negative value reverses the image, flipping 
its direction.

Rotate a layer in the canvas
The Select/Transform tool also activates a handle used to rotate the image around its 
anchor point. For animation purposes, Motion keeps track of the number of times you’ve 
rotated the layer and stores this value in that layer’s Rotation parameter in the Properties 
Inspector.

1.	 In Motion, select a layer in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Select/Transform (if it’s not already selected).

By default, the Select/Transform tool is the active tool. If you have another tool 
selected, such as a Mask or Shape tool, pressing the S key returns you to the Transform 
tools.

3.	 In the canvas, do one of the following:

•	 Drag the rotation handle to rotate the layer.

•	 Press Shift while you drag the rotation handle to constrain the angle of the selected 
layer to 45-degree increments.

As you drag the rotation handle, the original angle of the layer is indicated by a small 
circle that appears on a larger circle surrounding the layer’s anchor point. The value of 
the Rotation parameter is updated in the Properties Inspector. Additionally, the status 
bar shows you the new angle of rotation. See View dynamic canvas feedback.
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Move a layer’s anchor point in Motion

Selecting the Anchor Point tool activates canvas controls to adjust the point in a layer 
around which geometric transforms are performed.

Note: The Anchor Point onscreen control is not available for layers within a 360° environment.

Layers rotate around the anchor point. The anchor point also affects resizing operations. 
For example, the default anchor point for any layer is the center of the bounding box that 
defines the layer’s edges. If you rotate a layer, it spins around this central anchor point. If 
you offset the anchor point, however, the layer no longer rotates around its own center, but 
instead rotates around the new anchor point.



131Motion User Guide

If you offset the anchor point, however, the layer no longer rotates around its own center, 
but instead rotates around the new anchor point.

Change the anchor point of a layer in the canvas
1.	 In Motion, select a layer in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Anchor Point.
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In the canvas, the selected layer’s anchor point appears as a round target surrounded 
with three color arrows representing the X, Y, and Z coordinate axes. For more 
information on coordinate axes, see Transform layers in 3D space.

3.	 Do one of the following:

•	 Drag the white circle to move the anchor point vertically or horizontally.

•	 Drag an arrow to move the anchor point along the corresponding axis.

As you drag the anchor point, a line stretches from the default position of the anchor 
point to its new position. Additionally, the status bar above the canvas shows you 
the anchor point’s new coordinates and the delta (amount of change) between the 
anchor point’s new and old positions, and the Anchor Point parameter is updated in 
the Properties Inspector.

Note: If the anchor point is close to the center or edges of the layer, and both Snapping 
and Dynamic Guides are turned on, the anchor point snaps to that location.

Add a drop shadow to a layer in Motion

Selecting the Drop Shadow tool enables canvas controls to create a drop shadow and 
modify its blur, angle, and distance from a layer.

Note: The Drop Shadow onscreen controls are not available for layers within a 360° 
environment.

A drop shadow, by default, is a dark, translucent, offset shape that falls behind a layer, as 
if a light were shining on the layer. Drop shadows are the same size as the layer to which 
they’re applied, although blurring a drop shadow might enlarge it somewhat. Drop shadows 
create the illusion of depth, so the foreground layer seems to pop out at the viewer. For 
this reason, drop shadows are frequently used to create the impression of space between 
two overlapping layers.
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Add and adjust a drop shadow in the canvas
1.	 In Motion, select a layer in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Drop Shadow.

In the canvas, a drop shadow bounding box appears around the selected layer. By 
default, the drop shadow is hidden behind the layer.

3.	 Do any of the following:

•	 Set the distance and angle of the shadow: Drag inside the bounding box.

•	 Adjust the blur of the drop shadow: Drag a corner handle on the bounding box.

The Drop Shadow parameters are updated in the Properties Inspector.

Alternatively, you can add a drop shadow by selecting a layer, then selecting the Drop 
Shadow activation checkbox in the Properties Inspector. See Properties Inspector controls.

Distort or shear a layer in Motion

Selecting the Distort tool activates canvas controls to reposition a layer’s corner points 
independently and to shear (slant) its midsection points horizontally or vertically.

Note: The Distort tool is not available for layers within a 360° environment.

Distort or shear a layer in the canvas
1.	 In Motion, select a layer in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.
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2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Distort.

In the canvas, a bounding box with eight handles appears around the selected layer. 

3.	 Do any of the following: 

•	 Stretch the layer into an irregular shape: Drag any of the four corner handles.

•	 Shear (slant) the layer: Drag any of the side handles or top and bottom handles. The 
top and bottom handles shear the layer horizontally. The left and right handles shear 
the layer vertically.

Note: Shearing a layer using the Distort tool does not affect the Shear parameter in the 
Transform area of the Properties Inspector. Instead, the Distort tool modifies the Four 
Corner parameters in the Properties Inspector to simulate a Shear effect. You can still 
modify the Shear parameter, effectively shearing the shear simulation for interesting 
results.

After you distort a layer, you can revert to the layer’s original shape by deselecting the 
layer’s Four Corner checkbox in the Properties Inspector. Doing so resets the shape of the 
layer without resetting the shape you defined by dragging in the canvas.
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Crop a layer in Motion

Selecting the Crop tool activates canvas controls to resize the borders of a layer.

Note: The Crop tool is not available for layers within a 360° environment.

Cropping lets you chop off any of the four edges of a layer to eliminate parts you don’t 
want to see in your composition. Common examples of layers you’d want to crop are 
video clips with a black line or unwanted vignetting around the edges. The crop operation 
can remove these undesirable artifacts. A layer might also be cropped to isolate a single 
element of the image.

When you crop an imported image using the Crop tool (which yields the same result as 
using the Crop controls in the layer’s Properties Inspector), only the instance of that file is 
cropped. The source image in the Media list is not cropped. To crop the source image, you 
must select the layer in the Media list, then use the Crop controls in the Media Inspector. 
See Source media controls.

Note: If you must isolate a more irregularly shaped layer, or you want to create a border of 
a specific shape, see Intro to shapes, masks, and paint strokes.
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Crop a layer in the canvas
1.	 In Motion, select a layer in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Crop.

In the canvas, a bounding box with eight crop handles appears around the selected 
layer. 

3.	 Do any of the following:

•	 Crop one edge: Drag the top, left, right, or bottom handle.

•	 Crop two adjacent edges: Drag a corner handle.

•	 Maintain the same aspect ratio while cropping: Press and hold the Shift key while 
dragging a handle.

The ratio between the layer’s width and height is preserved.

Note: If a layer is modified with the Distort tool, the Crop tool and its onscreen 
controls become disabled. However, you can still crop a distorted layer by adjusting 
its Crop parameter settings in the Properties Inspector.

The Crop parameters are updated in the Properties Inspector.

Move the crop area while keeping the underlying image in place
•	 With a crop applied in the Motion canvas, drag inside the crop area.

The crop area moves, allowing you to adjust the crop to a new location without 
changing its size or shape.

Move the image while keeping the crop area in place
•	 With a crop applied in the Motion canvas, press and hold the Command key while 

dragging inside the crop area.

The crop area remains static, but the image underneath it moves, allowing you to 
change the visible area of the layer.
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Modify shape or mask points in Motion

Selecting the Edit Shape tool activates canvas controls for adjusting simple shapes and 
masks.

Selecting the Edit Points tool activates control points in the canvas for adjusting complex 
shapes and masks.

Note: Onscreen control points are not available for layers within a 360° environment. (You 
cannot add shapes or masks to a 360° environment).

Modify a simple shape in the canvas
1.	 In Motion, after you create the simple shape or mask, click and hold the transform tools 

pop-up menu in the canvas toolbar, then choose Edit Rectangle or Edit Ellipse.

The shape or mask layer’s onscreen control points become active.

2.	 In the canvas, drag the control points to modify the shape of the layer.

For information on creating and adjusting simple masks and shapes, see Draw simple 
shapes and Draw simple masks.
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Modify a complex shape’s control points in the canvas
1.	 In Motion, after you create the complex shape or mask, click and hold the transform 

tools pop-up menu in the canvas toolbar, then choose Edit Points.

Note: You can also double-click the shape or Control-click the layer, then choose Edit 
Points from the shortcut menu.

The layer’s control points become active.

2.	 In the canvas, drag the control points (or the tangent handles attached to each control 
point) to modify the shape.

For information on creating complex shapes, see Intro to complex shapes and masks. 
For information on adjusting complex shapes, see Intro to editing control points.

Transform text glyphs and other object attributes in Motion

Selecting the Transform Glyph tool activates canvas controls (available only when a text 
layer is selected) to modify the position and X, Y, or Z rotation for individual characters 
(glyphs) in a text layer.

For information on using the Transform Glyph tool, see Intro to text glyphs.

Selecting the Adjust Item tool enables canvas controls that allow you to manipulate filters, 
replicators, generators, and other objects.

For example, you can use the Adjust Item tool to adjust the center point of a blur filter, the 
shape of a particle emitter, or the settings of a gradient. For examples, see Use onscreen 
gradient controls or Adjust a replicator using onscreen controls.

Note: The Transform Glyph and Adjust Item tools are not available for layers within a 360° 
environment. (You cannot add text to a 360° environment).
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Align layers in the Motion canvas

The Alignment submenu in the Object menu contains commands that let you reposition any 
number of simultaneously selected layers to align with one another in various ways. These 
commands make it easy to organize a jumble of layers into an even layout.

In each operation, the left, right, top, and bottom of the selected layers are defined by the 
bounding box that surrounds each layer. The position of the anchor point is ignored.

Align layers in the canvas with the Object menu
•	 Select the layers or groups you want to align, choose Object > Alignment, then choose 

any of the following from the submenu:

•	 Align Left Edges: Layers are moved horizontally so their left edges line up with the 
leftmost layer in the selection.

•	 Align Right Edges: Layers are moved horizontally so their right edges line up with the 
rightmost layer in the selection.

•	 Align Top Edges: Layers are moved vertically so their tops line up with the topmost 
layer in the selection.

•	 Align Bottom Edges: Layers are moved vertically so their bottoms line up with the 
bottommost layer in the selection.

•	 Align Far Edges: Layers are moved in Z space so their far edges line up with the 
farthest layer in the selection.

•	 Align Near Edges: Layers are moved in Z space so their near edges line up with the 
closest layer in the selection.

•	 Align Horizontal Centers: Layers are moved horizontally so their centers line up 
along the center point between the leftmost and rightmost layers in the selection.

•	 Align Vertical Centers: Layers are moved vertically so their centers line up along the 
center point between the topmost and bottommost layers in the selection.

•	 Align Depth Centers: Layers are moved in Z space so their centers line up along the 
center point between the farthest and nearest layers in the selection.

•	 Distribute Lefts: Layers are moved horizontally so the left sides of all layers are 
evenly distributed, from right to left, between the leftmost and rightmost layers in 
the selection.

•	 Distribute Rights: Layers are moved horizontally so the right sides of all layers are 
evenly distributed, from right to left, between the leftmost and rightmost layers in 
the selection.

•	 Distribute Tops: Layers are moved vertically so the tops of all layers are evenly 
distributed, from top to bottom, between the topmost and bottommost layers in the 
selection.
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•	 Distribute Bottoms: Layers are moved vertically so the bottoms of all layers are 
evenly distributed, from top to bottom, between the topmost and bottommost layers 
in the selection.

•	 Distribute Far: Layers are moved in Z space so the far edges of all layers are evenly 
distributed along the Z axis, from closest to farthest, between the closest and 
farthest layers in the selection.

•	 Distribute Near: Layers are moved in Z space so the near edges of all layers are 
evenly distributed along the Z axis, from closest to farthest, between the closest and 
farthest layers in the selection.

•	 Distribute Horizontal Centers: Layers are moved horizontally so the centers of all 
layers are evenly distributed, from left to right, between the leftmost and rightmost 
layers in the selection.

•	 Distribute Vertical Centers: Layers are moved vertically so the centers of all layers 
are evenly distributed, from top to bottom, between the topmost and bottommost 
layers in the selection.

•	 Distribute Depth Centers: Layers are moved in Z space so the centers of all layers 
are evenly distributed, from closest to farthest, between the closest and farthest 
layers in the selection.

Each of the above commands affects the Position parameter of each layer.

Adjust layers in the Inspector

Adjust layers in the Properties Inspector in Motion

You can adjust layer properties—spatial transforms, blending, drop shadows, and so on—
using controls in the Properties Inspector. These controls often let you make the same 
adjustments afforded by the transform tools, but with more precision. Adjustments made 
in the canvas are simultaneously updated in the Inspector, and vice versa. The available 
controls vary depending on the type of layer you select in the Layers list or canvas.
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When the Project object (located at the top of the Layers list) is selected, controls become 
available in the Properties Inspector that allow you to modify the project’s background 
color, aspect ratio, field rendering, motion blur, reflections, and other global settings. For 
more information on project properties, see Intro to project properties.

Open the Properties Inspector
In Motion, do one of the following:

•	 Click Inspector in the top-left corner of the Motion window, then click Properties.

•	 Choose Window > Inspector (or press F1), then click Properties.

The Inspector opens. The preview area contains a visual preview of the selected layer 
and can show the multiple frames of moving footage. The Inspector preview area is 
similar to the Library preview area, but it has no Apply button.

Collapse or expand the pane containing the Properties Inspector
In Motion, do one of the following:

•	 Choose Window > Inspector (or press F1).

•	 In the toolbar, click the Inspector button, then in the Inspector, click Properties.

Show or hide a group of controls in the Properties Inspector 
In Motion, do one of the following:

•	 Position the pointer over a row that contains a section name (Transform or Blending, for 
example), then click Show or Hide.

•	 Double-click the empty space in a row that contains a section name.
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Modify layer values in the Properties Inspector
1.	 In the Layers list or canvas in Motion, select a layer.

2.	 In the Properties Inspector, drag a slider or dial, choose an item from a pop-up menu, 
select a checkbox, drag a slider, or enter a new number in a value field.

Reset a layer value to its default state
•	 In the Properties Inspector in Motion, click the Animation menu in a parameter row (the 

down arrow that appears when you move the pointer over the right side of the row), 
then choose Reset Parameter.

For more information on how to use the parameter controls, see Intro to using color 
controls. For a description of the controls in the Properties Inspector, see Properties 
Inspector controls.

Properties Inspector controls in Motion

The Properties Inspector displays the adjustable parameters for most layers and groups. 
Available parameters may change depending on the currently selected object.

Important: The Transform, Cast Reflections, Four Corner, Crop, Lighting, Shadow, and 
Reflection parameters are not available for layers within 360° environments. Only basic 
Blending, Drop Shadow, and Timing parameters are available for 360° environments.

Transform parameters
•	 Position: Value sliders that define the X (horizontal), Y (vertical), and Z (depth) positions 

of each layer.

Click the disclosure triangle next to the Position parameter to reveal dials that adjust 
position around all three axes (X, Y, and Z).

The coordinate system used by Motion specifies the center of the canvas as 0, 0, 0 
regardless of the frame size of the project. Moving a layer to the left subtracts from the 
X value, while moving it to the right adds to the X value. Moving a layer up adds to the Y 
value, and moving a layer down subtracts from the Y value. Moving a layer closer adds 
to the Z value, while moving a layer farther away subtracts from the Z value. 
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Each layer’s position is centered on its anchor point. Offsetting the anchor point also 
offsets the position of the layer relative to the X, Y, and Z position values you’ve set.

•	 Rotation: A dial that controls a one-dimensional value representing the number 
of degrees of rotation around the Z axis. A positive value rotates the layer 
counterclockwise; a negative value rotates the layer clockwise. Rotating a layer beyond 
360 degrees results in multiple rotations when the Rotation parameter is animated.

Click the disclosure triangle next to the Rotation parameter to reveal dials that adjust 
rotation around all three axes (X, Y, and Z), as well as the Animate pop-up menu.

•	 Animate: A pop-up menu that sets the interpolation for animated 3D rotation 
channels to one of two options:

•	 Use Rotation: The default interpolation method. Layer rotates from its start 
angle to its final angle. Depending on the animation, the layer might twist before 
reaching its final orientation (the last keyframed value). For example, if the X, Y, 
and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, 
the layer rotates on all axes before reaching its final orientation.

•	 Use Orientation: This alternate interpolation method provides smoother 
interpolation but does not allow multiple revolutions. Use Orientation interpolates 
between the layer’s start orientation (first keyframe) to its end orientation 
(second keyframe).

Note: The Rotation parameter must be keyframed for its Animate parameter options 
to have any effect. For information about keyframing, see Intro to keyframing. For 
information about 3D rotation, see Transform layers in 3D space.

•	 Scale: A slider that controls the layer’s scale, relative to its original size. By default, the 
horizontal and vertical scale of a layer is locked to the layer’s original aspect ratio—
represented by a single percentage. Click the disclosure triangle to display independent 
percentages for the X, Y, and Z scales of the layer.

Note: Setting a layer’s scale to a negative value flips the layer.

•	 Shear: Value sliders that define the X and Y shear of the layer. A layer with no shear has 
X and Y shear values of 0. Positive values shear in one direction, while negative values 
shear in the other.

•	 Anchor Point: Value sliders that define the X and Y position of the anchor point relative 
to the center of the layer. Coordinates of 0, 0 center the anchor point in the bounding 
box defining the outer edge of the layer. Click the disclosure triangle to expose an 
additional value slider defining the Z position.
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Blending parameters
•	 Opacity: A slider that sets the transparency of the layer. See Modify layer opacity.

•	 Blend Mode: A pop-up menu that sets the Blend Mode of the layer. See Intro to layer 
blending.

•	 Preserve Opacity: A checkbox that, when selected, renders the layer visible only where 
another layer is visible behind it in the composite. The front layer uses the opacity value 
of the layer behind it. See Modify layer opacity.

•	 Casts Reflections: A pop-up menu that determines whether a layer casts a reflection. 
Choose from three options:

•	 Yes: The layer is seen reflected in nearby reflective layers.

•	 No: The layer is ignored by reflective surfaces.

•	 Reflection Only: The layer becomes invisible, but appears in reflective surfaces 
around it.

Note: Reflections are only visible when layers are in a 3D group. For more 
information on 3D groups, see 2D and 3D group properties.

Color parameters
In a project with Color Processing set to Automatic, additional color management controls 
become available when you select an image or clip in the Layers list.

•	 Conversion: A pop-up menu that sets the media’s color conversion type. Choose from 
two options:

•	 Automatic: Lets Motion determine the conversion type (based on the media and the 
Render Color Space setting in the View pull-down menu).

•	 Manual: Displays the Conversion Type pop-up menu, with options to choose a 
conversion type other than the default.

Important: In most cases, manually converting an image or clip is unnecessary—
Automatic will choose the best conversion type for all media in the project, adjusting 
the dynamic range of an image or clip to better match the project’s Render Color 
Space setting (in the View pull-down menu).
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•	 Conversion Type: A pop-up menu (available only when Manual is chosen from the 
Conversion pop-up menu) that converts a clip from one color space to another using 
tone mapping. Choose from five options:

•	 To/From 100% HDR (HLG): Converts a clip to or from 100% of the HDR HLG dynamic 
range whenever the clip needs to be tone mapped. For example, if the Render Color 
Space is set to Rec. 709, the full dynamic range of HLG is tone mapped to the full 
(but more limited) dynamic range of SDR, resulting in an HLG image that appears 
correct in the project. If the Render Color Space is set to HDR Rec. 2020 HLG, 
the full (but limited) dynamic range of Rec. 709 is inverse tone mapped to the full 
dynamic range of HLG. (If the clip is HLG and the render color space is set to HDR 
Rec. 2020 HLG, then no conversion occurs.)

In general, use this option when your SDR media needs to expand to the maximum 
dynamic range of HLG HDR, or when HLG media contains HDR-level brightness 
(brighter than SDR media).

(This is the default conversion type applied to HLG media when the Conversion pop-
up menu is set to Automatic.)

•	 To/From 75% HDR (HLG): Converts a clip to or from 75% of the HDR HLG dynamic 
range whenever the clip needs to be tone mapped. For example, if the Render Color 
Space is set to Rec. 709, 75% of the dynamic range of HLG is tone mapped to the 
full (but more limited) dynamic range of SDR. If the Render Color Space is set to HDR 
Rec. 2020 HLG, the full (but limited) dynamic range of SDR is tone mapped to 75% of 
the dynamic range of HLG. (If the clip is HLG and Render Color Space is set to HDR 
Rec. 2020 HLG, then no conversion occurs.)

In general, use this option to keep SDR media at SDR-level brightness when used in 
an HDR HLG project, or when HLG media doesn’t contain HDR-level brightness (such 
as an SDR clip that’s recorded and encoded as HLG).

•	 To/From HDR (PQ): Converts a clip to or from HDR PQ based on the project’s 
current render color space. For example, when the render color space is set to HDR 
Rec. 2020 HLG, a PQ clip is converted from PQ to HLG so it appears correct in the 
project.

When this option is selected, the PQ Peak (nits) slider becomes available in the clip’s 
Properties Inspector, letting you adjust the peak brightness (nits value) of a PQ clip. 
The PQ Peak (nits) value is the default value of the PQ clip (1,000 nits, or the value 
of any peak mastering metadata in the clip).

(This is the default conversion type for PQ media when the Conversion pop-up menu 
is set to Automatic.)

•	 Use HDR White Level (75%): Instructs an image or clip to use the HDR White 
Level slider (in the Project Properties Inspector) to adjust its brightness. If you’ve 
previously changed the default value of the HDR White Level slider in the Project 
Properties Inspector, that value is displayed in the pop-up menu.

(This is the default conversion type for SDR media when the Conversion pop-up 
menu is set to Automatic.)

•	 None: No conversion occurs.

For more information, see Manage automatic color processing.
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Drop Shadow parameters
An activation checkbox that turns the drop shadow of a layer on and off. When selected, 
additional controls become available:

•	 Color: Color controls that set the drop shadow’s color. The default color is black.

•	 Opacity: A slider that sets the drop shadow’s transparency.

•	 Blur: A slider that specifies the drop shadow’s softness.

•	 Distance: A slider that sets how close or far a layer’s drop shadow is to the layer. The 
farther away a drop shadow is, the more distance there appears to be between the layer 
and anything behind it in the composition.

•	 Angle: A dial that lets you change the direction of the drop shadow. Changing the Angle 
of the drop shadow changes the apparent direction of the light casting the shadow.

•	 Fixed Source: A checkbox that, when selected, renders the drop shadow as if cast by a 
fixed light source, regardless of camera or text movement.

Four Corner parameters
An activation checkbox that turns distorting on and off. If a layer is distorted and this 
checkbox is deselected, the layer resumes its original shape, although the distorted 
coordinates are maintained. Reselecting the checkbox reenables the distortion effect 
specified by the Four Corner coordinate parameters.

When the Four Corner checkbox is selected, value sliders to modify the X and Y 
coordinates of the layer’s four corner points (Bottom Left, Bottom Right, Top Right, and 
Top Left) become available. You can also control these parameters visually in the canvas 
using the Distort tool. See Transform tools.

Crop parameters
An activation checkbox that turns cropping on and off. If a layer is cropped and this 
checkbox is deselected, the layer resumes its original size, although the cropping values 
are maintained. Reselecting the checkbox reenables the cropping effect specified by the 
crop parameters.

When the Crop checkbox is selected, value sliders to modify the layer’s four edges (Left, 
Right, Bottom, and Top) become available. You can also control these parameters visually 
in the canvas using the Crop tool. See Crop a layer.

Timing parameters
Value sliders to control all aspects of clip retiming. See Intro to retiming media in the 
Timeline.
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Lighting parameters
The Lighting parameter controls appear only when the parent group is set to 3D.

•	 Shading: A pop-up menu that sets how a layer responds to lights in the scene. There 
are three options:

•	 Inherited: The layer uses the shading value of its parent.

•	 On: The layer can be lit.

•	 Off: The layer ignores lights.

•	 Highlights: A checkbox that, when selected, causes lit layers to show highlights. This 
parameter has no effect if Shading is set to Off. Click the disclosure triangle to reveal 
an additional Shininess parameter.

•	 Shininess: A slider that sets the strength of a layer’s highlights. Higher values create 
a glossier appearance. This parameter is disabled when the Highlights checkbox is 
deselected.

See Add lights.

Shadows parameters
The Shadows parameter controls appear only when the parent group is set to 3D.

•	 Cast Shadows: A checkbox that sets whether a shadow is cast when a layer lies 
between a light source and another layer.

Note: This parameter does not affect drop shadows.

•	 Receive Shadows: A checkbox that controls whether neighboring layers’ shadows affect 
the current layer. When this checkbox is deselected, light affects the layer as if the 
shadow-casting layer did not exist.

•	 Shadows Only: A checkbox that, when selected, specifies that a layer blocks light and 
casts a shadow, while the layer itself does not appear in the scene.

See Intro to 3D shadows.

Reflection parameters
The Reflection parameter controls appear only when the parent group is set to 3D. The 
Reflection parameter controls are not available for 3D particle emitters, 3D replicators, 
or normal text layers. However, the Reflection parameters are available for flattened text, 
which is activated by the Flatten checkbox in the Layout pane of the Text Inspector.

•	 Reflectivity: A slider that controls the shininess of the layer’s surface. When set to 0%, 
there’s no reflectivity. When set to 100%, the layer is totally reflective, like a mirror.

•	 Blur Amount: A slider that controls how blurry the reflection appears, creating the 
appearance of soft focus due to the surface quality of the reflecting layer.

•	 Falloff: A checkbox that controls whether the reflection fades with distance from the 
layer, producing a more realistic result. Click the disclosure triangle to show additional 
controls that adjust the falloff effect: Begin Distance, End Distance, and Exponent. The 
Exponent slider adjusts how quickly the reflection becomes fainter as reflected layers 
move away from the reflecting layer.

•	 Blend Mode: A pop-up menu that determines the blend mode used for the reflection.

See Reflection controls.
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Media parameters
The Media parameters (available when an image layer is selected) contain a thumbnail of 
the current layer and the “To” pop-up menu. 

•	 To: A pop-up menu that lets you choose another image layer in your project to replace 
the current layer. The replaced media remains in your project in the Media list.

Timing parameters
Use the Timing controls to set the selected object’s In and Out points, as well as the 
duration of the object. See Timing controls.

Transform layers in the HUD in Motion
Like the Inspector, the HUD (heads-up display) is contextual and changes its controls 
based on the selected object. For example, when you select an image layer, its HUD 
contains opacity, blend mode, and drop shadow controls.

When you select a shape layer, its HUD contains additional controls for adjusting fill, 
outline, width, feathering, and so on. When you apply an effects object to a layer or group 
(a filter, behavior, particle emitter, and so on), HUDs for effects also become available.

Display a HUD
In Motion, do one of the following:

•	 Select a layer or group, then choose Window > Show HUD (or press F7).

•	 Select a layer or group, then click the HUD button in the toolbar (to the left of the Share 
button).

•	 Press D.
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Switch between HUDs of a selected layer
In Motion, do one of the following:

•	 Click the small arrows to the right of the object name in the HUD title bar to list all 
possible HUDs that can be displayed for the selected object, then choose the HUD to 
view from the pop-up menu.

•	 Press D to cycle through all HUDs for the selected object. To cycle the HUDs in reverse, 
press Shift-D.

The HUDs are cycled in the order in which the effects were applied.

When you select multiple objects of the same type, a combined HUD appears (with 
“Multiple Selection” displayed in its title bar). You can adjust the parameters common to 
the selected objects.

Jump to the Inspector from the HUD
Most of the time, the HUD displays a subset of the parameters visible in the Inspector for 
the selected object. If you’re working in the HUD, you can jump to the Inspector to access 
the remainder of the controls for that object.

•	 In Motion, click the Inspector icon (the “i”) in the upper-right corner of the HUD.

The Inspector corresponding to the HUD appears.

Edit multiple objects at the same time in the HUD
For simultaneous adjustment to work, the objects must be the same (such as two Throw 
behaviors or two shapes).

1.	 In the Layers list or canvas in Motion, select the objects (of the same type) to modify.

2.	 In the HUD titled “Multiple Selected,” adjust the parameters.
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Transform 2D layers in 3D space in Motion
By using the 3D Transform tool, you can manipulate any 2D object in 3D space.

Move a layer in 3D space
1.	 In the Motion canvas toolbar, click the 3D Transform tool (or press Q).

2.	 Select a layer or group in the Layers list or canvas.

3D handles appear on the selected object in the canvas.

3.	 Do any of the following:

•	 Move the object horizontally: Drag the red arrow to move the object along its X axis.

•	 Move the object vertically: Drag the green arrow to move the object along its Y axis.

•	 Move the object forward or backward: Drag the blue handle to move the object along 
its Z axis.

 Tip: If the blue handle is facing forward, drag left or right to move the object 
forward or backward.

•	 Rotate the object around its X axis: Move the pointer over the top rotation handle 
until a red rotation ring appears, then drag the ring.

•	 Rotate the object around its Y axis: Move the pointer over the left rotation handle 
until a green rotation ring appears, then drag the ring.
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•	 Rotate the object around its Z axis: Move the pointer over the right rotation handle 
until a blue rotation ring appears, then drag the ring.

For more information about working in a 3D project, see Intro to 3D compositing.

Adjust opacity and blending

Modify layer opacity in Motion
The opacity and blending controls for each layer appear in the Properties Inspector and in 
the default HUD for any selected layer.

By stacking layers with varying opacities, you can merge images together in ways not 
otherwise possible. For example, if you have two full-screen background images you want 
to use together, you can set the opacity of the layer in front to 50%, allowing the layer in 
back to show through.

You can overlap as many layers as you want, and by varying their opacities, selectively 
reveal layers in the back.
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Change a layer’s opacity
1.	 In the Layers list or canvas in Motion, select a layer.

2.	 Do one of the following:

•	 In the Properties Inspector, adjust the Opacity slider (in the Blending section).

•	 In the HUD, adjust the Opacity slider.

Note: Some layers, such as text and shapes, have additional opacity parameters in their 
respective panes in the Inspector. For example, setting a shape’s Opacity value in the 
Properties Inspector and setting its Opacity value in the Style Inspector require separate 
controls that have multiplicative effects. In other words, if Opacity is set to 50% in the 
Properties Inspector, then set to 50% in the Style pane of the Shape Inspector, the 
resulting opacity for the text is 25%.

Limit the visibility of overlapping layers
The Preserve Opacity checkbox in the Properties Inspector lets you limit a layer’s visibility 
to areas of the canvas where the layer overlaps nontransparent regions of other layers.

•	 In Motion, with a layer (the dolphin image in this example) selected in the canvas or 
Layers list, select the Preserve Opacity checkbox in the Properties Inspector.

The only area of the layer visible is the area that overlaps the layer behind it.
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Layer blending

Intro to layer blending in Motion

While the Opacity parameter defines a uniform level of transparency for a layer, the blend 
modes allow you many more creative options to control how the overlapping images 
interact, based on the colors in each layer. By default, each layer’s blend mode is set to 
Normal, so changes to a layer’s opacity uniformly affect every part of the image equally.

Blend modes can create transparency in a layer regardless of the setting of its Opacity 
parameter. This is because the pixels of an image with a selected blend mode are 
combined with the pixels of any layers lying immediately below in the canvas. For example, 
if you overlap two layers, then set the blend mode of the top one to Screen, the darker 
areas of the screened image become transparent, while the lighter areas remain more 
solid, resulting in the following image:

Important: The transparency created by most of the available blend modes affects how 
a layer combines with overlapping layers underneath. These blend modes do nothing to 
affect a layer’s alpha channel. For information about blend modes that do affect a layer’s 
alpha channel, see Alpha channel blend modes.

Each blend mode combines layers in different ways. For example, setting the top layer’s 
blend mode to Multiply yields a result opposite to that of the Screen blend mode, as the 
darker areas of the image remain solid, and the lighter areas become transparent.

Blend modes only affect the combination of a layer with the layers below it. Any layers 
appearing above have no effect on this interaction, even if the layer is transparent.
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For overlapping layers with different blend modes, the bottommost pair of layers is 
combined first, and that combination then interacts with the next layer up, and so on until 
all overlapping layers are combined for the final image. In this case, each layer with a 
specified blend mode only interacts with the image below it, whether that image is a single 
layer or a pair of layers blended together.

Each of Motion’s blend modes works in conjunction with the Opacity parameter to alter 
the interaction between the foreground and background layers. Adjusting a layer’s opacity 
lessens the blending effect assigned to it, even as it reduces that layer’s visibility, allowing 
you to customize any blend mode to better suit your needs.

Blend modes have no interaction with your project’s background color (unless the 
background is set to Environment).

Change a layer’s blend mode in Motion

You can change a layer’s blend mode in several ways.

Modify a layer’s blend mode
With a layer selected in Motion, do one of the following:

•	 In the HUD, click the Blend Mode pop-up menu, then choose a different mode.

•	 In the Properties Inspector, click the Blend Mode pop-up menu, then choose a different 
mode.

•	 Choose Object > Blend Mode, then choose a different mode from the submenu.

•	 Control-click a layer in the canvas, Layers list or Timeline, then choose Blend Mode and 
a different mode from the shortcut menu.

•	 In the Layers list, display the Blend Mode column (choose View > Layers Columns > 
Blend Mode), then click a layer’s Blend Mode pop-up menu and choose a different 
mode.

How do blend modes work in Motion?

Each blend mode presents a different method of combining (compositing) two or more 
images. Blend modes work in addition to a layer’s alpha channel and opacity parameter.

To understand the descriptions of each blend mode in this chapter, it’s important to 
understand that blend modes mix colors from overlapping images based on the brightness 
values in each color channel in an image. Every image consists of a red, green, and blue 
channel, and sometimes an additional alpha channel. Each channel contains a range of 
brightness values that define the intensity of each pixel in the image that uses some of the 
channel’s color.

The effect that each blend mode has on overlapping layers depends on the range of color 
values in each layer. The red, green, and blue channels in each overlapping pixel are 
mathematically combined to yield the final image.
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These value ranges can be described as blacks, midrange values, or whites. These regions 
are loosely illustrated by the chart below.

For example, the Multiply blend mode renders white color values in an image transparent, 
while black values are left alone. All midrange color values become translucent, with colors 
in the lighter end of the scale becoming more transparent than the colors in the darker end 
of the scale.

Note: Changing a project’s Color Processing setting (in the Project Properties Inspector) 
between Standard Gamut SDR, Wide Gamut HDR, or Automatic may affect the look of 
blended images or groups. See Set the color processing method.

How do blend modes affect groups in Motion?

Blend modes work differently depending on whether they’re used with groups or layers.

Pass Through
When a group is set to Pass Through (the default blend mode for groups), each layer in 
the group blends with all layers and groups that appear underneath it in the Layers list—
including layers in other groups. Pass Through is available only for groups.

Important: The Pass Through blend mode is not available for 360° environments. See Intro 
to graphics in 360° projects.

Normal
When a group is set to Normal, each layer in the group blends with all layers that appear 
underneath it in the Layers list—within the same group.

Other blend modes
When you set a group to any other available blend mode, the following happens:

•	 The layers in that group are blended according to their own blend modes.

•	 The resulting composite of all layers in that group is then blended with other groups 
lower in the Layers list, according to the selected blend mode for the original group.
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Types of blend modes in Motion

The following section describes how blend modes cause layers to combine to create 
different results. The blend modes are presented in the order in which they appear in the 
Blend Mode pop-up menu, arranged into groups of modes that create similar results.

Most of the examples in this section are created by combining the following two reference 
images:

The resulting image illustrates how differently the color values from each image interact 
under each blend mode. When examining the results, pay attention to the white and black 
areas of the color squares, as well as to the highlights and shadows in the chimpanzee image. 
These show you how each blend mode treats the whites and blacks in an image. The other 
brighter and darker colors serve to illustrate each blend mode’s handling of overlapping 
midrange color values. The yellow, red, pink, and blue squares, in particular, all have very 
different color and luminance values that contrast sharply from example to example.

Important: Depending on the blend mode, layer and group ordering may or may not be 
important. Some blend modes behave differently depending on which image is on top.

Normal blend mode
The default blend mode for layers. In a layer set to Normal, any transparency is caused by 
the Opacity parameter or by an alpha channel.

Darkening blend modes
The following blend modes tend to create a result darker than either of the original images:

•	 Subtract: Darkens all overlapping colors. Whites in the foreground image go black, while 
whites in the background image invert overlapping color values in the foreground image, 
creating a negative effect. Blacks in the foreground image become transparent, while 
blacks in the background image are preserved. Overlapping midrange color values are 
darkened based on the color of the background image. In areas where the background 
is lighter than the foreground, the background image is darkened. In areas where the 
background is darker than the foreground, the colors are inverted. The order of two 
layers affected by the Subtract blend mode is important.
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•	 Darken: Emphasizes the darkest parts of each overlapping image. Whites in either 
image allow the overlapping image to show through completely. Lighter midrange color 
values become increasingly translucent in favor of the overlapping image, while darker 
midrange color values below that threshold remain solid, retaining more detail. The 
order of two layers affected by the Darken blend mode does not matter.

The Darken blend mode is useful for using one image to texturize another selectively, 
based on its darker areas. You can also use Screen, Color Burn, and Linear Burn for 
variations on this effect.

•	 Multiply: Like Darken, Multiply emphasizes the darkest parts of each overlapping image, 
except that midrange color values from both images are mixed together more evenly. 
Progressively lighter regions of overlapping images become increasingly translucent, 
allowing whichever image is darker to show through. Whites in either image allow the 
overlapping image to show through completely. Blacks from both images are preserved 
in the resulting image. The order of layers affected by the Multiply blend mode does not 
matter.

The Multiply blend mode is useful in situations where you want to knock out the white 
areas of a foreground image and blend the rest of the image with the colors in the 
background. For example, if you superimpose a scanned sheet of handwritten text 
over a background image using the Multiply blend mode, the resulting image becomes 
textured with the darker parts of the foreground.
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•	 Color Burn: Intensifies the dark areas in each image. Whites in the background 
image replace the foreground image, while whites in the foreground image become 
transparent. Midrange color values in the background image allow midrange color 
values in the foreground image to show through. Lighter midrange color values in 
the background image allow more of the foreground image to show through. Darker 
midrange values in all visible overlapping areas are then mixed together, resulting in 
intensified color effects. The order of two layers affected by the Color Burn blend mode 
is important.

•	 Linear Burn: Similar to Multiply, except that darker overlapping midrange color values 
are intensified, as with Color Burn. Progressively lighter color values in overlapping 
images become increasingly translucent, allowing darker colors to show through. 
Whites in either image allow the overlapping image to show through completely. The 
order of two layers affected by the Linear Burn blend mode does not matter.

Lightening blend modes
The following blend modes tend to create a lighter result than either of the original images.

•	 Add: Emphasizes the whites in each overlapping image and lightens all other 
overlapping colors. The color values in every overlapping pixel are added together. The 
result is that all overlapping midrange color values are lightened. Blacks from either 
image are transparent, while whites in either image are preserved. The order of two 
layers affected by the Add blend mode does not matter.
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The Add blend mode is useful for using one image to selectively texturize another, 
based on its lighter areas such as highlights. You can also use Lighten, Screen, Color 
Dodge, and Linear Dodge to create variations of this effect.

•	 Lighten: Emphasizes the lightest parts of each overlapping image. Every pixel in each 
image is compared, and the lightest pixel from either image is preserved, so the final 
image consists of a dithered combination of the lightest pixels from each image. Whites 
in both images show through in the resulting image. The order of two layers affected by 
the Lighten blend mode does not matter.

•	 Screen: Like Lighten, Screen emphasizes the lightest parts of each overlapping image, 
except that the midrange color values of both images are mixed together more evenly. 
Blacks in either image allow the overlapping image to show through completely. Darker 
midrange values underneath a specific threshold allow more of the overlapping image to 
show. Whites from both images show through in the resulting image. The order of two 
layers affected by the Screen blend mode does not matter.

The Screen blend mode is useful for knocking out the blacks behind a foreground 
subject, instead of using a Luma Key. It’s mainly useful when you want the rest of the 
foreground subject to be mixed with the background image, based on its brightness. It’s 
good for glow and lighting effects and for simulating reflections. You can also use the 
Add, Lighten, and Color Dodge blend modes to create variations of this effect.
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•	 Color Dodge: Preserves whites in either the foreground or background image. Blacks 
in the background image replace the foreground image, while blacks in the foreground 
image become transparent. Midrange color values in the background image allow 
midrange color values in the foreground image to show through. Darker values in the 
background image allow more of the foreground image to show through. All overlapping 
midrange color values are mixed together, resulting in interesting color mixes. Reversing 
the two overlapping images results in subtle differences in how the overlapping 
midrange color values are mixed together.

•	 Linear Dodge: Similar to Screen, except that lighter midrange color values in 
overlapping regions become intensified. Blacks in either image allow the overlapping 
image to show through completely. Whites from both images show through in the 
resulting image. The order of two layers affected by the Linear Dodge blend mode does 
not matter.
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Complex blend modes
The following blend modes create results by applying a combination of effects, based on 
the original images. Each mode can create a variety of results depending on the specific 
values of the images being mixed together. Some of these modes are designed to simulate 
the effect of shining a light through the top layer, effectively projecting upon the layers 
beneath it.

•	 Overlay: Causes whites and blacks in the foreground image to become translucent and 
interact with the color values of the background image, causing intensified contrast. 
Whites and blacks in the background image replace the foreground image. Overlapping 
midrange values are mixed together differently depending on the brightness of the 
background color values. Lighter background midrange values are mixed by screening. 
Darker background midrange values are mixed by multiplying. The visible result is 
that darker color values in the background image intensify the foreground image, 
while lighter color values in the background image wash out overlapping areas in the 
foreground image. The order of two layers affected by the Overlay blend mode is 
important.

The Overlay blend mode is useful for combining areas of vivid color in two images.

•	 Soft Light: Similar to the Overlay blend mode, makes whites and blacks in the 
foreground image translucent. However, the translucent whites and blacks continue 
to interact with the color values of the background image. Whites and blacks in the 
background image replace the foreground image. All overlapping midrange color values 
are mixed together, creating a more even tinting effect than the Overlay blend mode. 
The order of two layers affected by the Soft Light blend mode is important.
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The Soft Light blend mode is useful for softly tinting a background image by mixing it 
with the colors in a foreground image.

•	 Hard Light: Causes whites and blacks in the foreground image to block the background 
image. Whites and blacks in the background image interact with overlapping midrange 
color values in the foreground image. Overlapping midrange color values are mixed 
together differently depending on the brightness of the background color values. 
Lighter background midrange values are mixed by screening. Darker background 
midrange values are mixed together by multiplying. The visible result is that darker 
color values in the background image intensify the foreground image, while lighter color 
values in the background image wash out overlapping areas in the foreground image. 
The order of two layers affected by the Hard Light blend mode is important.

•	 Vivid Light: Similar to the Hard Light blend mode, with two exceptions: Vivid Light mixes 
midrange color values together more intensely, and preserves whites and blacks from 
either overlapping image in the end result. (Dithering can cause overlapping areas of 
solid white and solid black.) Overlapping midrange color values are mixed together 
differently depending on the brightness of the background color values. Lighter 
midrange values become washed out, while the contrast of darker midrange color 
values is increased. The overall effect is more pronounced than with the Hard Light 
blend mode. Reversing the two overlapping images results in subtle differences in how 
the overlapping midrange color values are mixed together.
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•	 Linear Light: Similar to the Hard Light blend mode, except that overlapping midrange 
color values are mixed together with higher contrast. Whites and blacks in the 
foreground image block the background image. Whites and blacks in the background 
image interact with overlapping midrange color values in the foreground image. 
Overlapping midrange color values are mixed together. Lighter background colors 
brighten the foreground image, while darker colors darken it. The order of two layers 
affected by the Linear Light blend mode is important.

•	 Pin Light: Similar to the Hard Light blend mode, except that overlapping midrange 
color values are mixed together differently based on their color value. Whites and 
blacks in the foreground image block the background image. Whites and blacks in the 
background image interact with overlapping midrange color values in the foreground 
image. The methods used by the Pin Light blend mode to mix two images are somewhat 
complex. Overlapping midrange color values are treated differently depending on which 
of the four regions of the luminance chart they fall into:

•	 Lighter and darker areas of the foreground image falling close to the whites and 
blacks are preserved.

•	 Areas of the foreground image falling near the center of the midrange are tinted by 
the background color.

•	 Darker areas of the foreground image between the blacks and center of the 
midrange are lightened.

•	 Lighter areas of the foreground image between the whites and the center of the 
midrange are darkened.

The result might appear alternately tinted or solarized, depending on the lightness 
or darkness of the overlapping values. This blend mode lends itself to more abstract 
effects. The order of two layers affected by the Pin Light blend mode is important.
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•	 Hard Mix: Similar to the Hard Light blend mode, except that the saturation of 
overlapping midrange color values is intensified, resulting in extremely high-contrast 
images. Whites and blacks are preserved. Although the order of two layers doesn’t 
affect the overall look of two images blended using the Hard Mix blend mode, there 
might be subtle differences.

Inversion blend modes
The following two blend modes create results that often appear to resemble aspects of a 
photographic negative of the selected layer.

•	 Difference: Similar to the Subtract blend mode (in the Darkening category), except that 
areas of the image that would be severely darkened by the Subtract blend mode are 
colorized differently. The order of two layers affected by the Difference blend mode 
does not matter.

•	 Exclusion: Similar to the Difference blend mode, except that the resulting image is 
lighter overall. Overlapping areas with lighter color values are lightened, while darker 
overlapping color values become transparent. The order of two layers affected by the 
Exclusion blend mode does not matter.
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Alpha channel blend modes in Motion

The Stencil and Silhouette blend modes let you use a single layer’s alpha channel or luma 
values to isolate regions of background layers and groups. (Similar effects can be accomplished 
using shape and image masks. In addition, masks might provide you with a greater degree of 
control, depending on your needs. See Intro to shapes, masks, and paint strokes.)

Stencil modes crop out all non-overlapping parts of layers underneath the layer used as the 
stencil. Silhouette modes do the opposite, punching holes in overlapping layers underneath 
in the shape of the layer used as the silhouette.

When working in a 3D group, changes in depth order affect the Stencil and Silhouette 
blend modes differently:

•	 Two layers in a 3D group with the upper layer set to Stencil Alpha or Stencil Luma: The 
blend mode remains in effect when the upper layer is moved behind the lower layer in Z 
space.

•	 Two layers in a 3D group with the upper layer set to Silhouette Alpha or Silhouette 
Luma: The blend mode does not remain in effect when the upper layer is moved behind 
the lower layer in Z space.

When you use the Stencil or Silhouette blend modes in a group set to the Pass Through 
blend mode, the resulting effect carries down through every layer in every group that lies 
underneath it in the Layers list (unless the group that contains it is rasterized). This is a 
powerful, but not always desired effect, because it prevents you from placing a background 
group to fill the transparent area. You can limit the Stencil or Silhouette blend mode to 
affect only those layers in the same enclosing group by setting the group’s blend mode 
to anything other than Pass Through. For example, if you set the enclosing group of 
the two layers in the Silhouette Alpha example to Normal, then add a group underneath 
containing additional layers, those layers show through the transparent areas created by 
the silhouetted group.

The following blend modes modify the alpha channel of the layer to which the blend mode 
is applied:

•	 Stencil Alpha: Uses the alpha channel of the affected layer to crop out all non-
overlapping parts of layers and groups underneath it in the Layers list.
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•	 Stencil Luma: Does the same thing as the Stencil Alpha blend mode, but uses the 
affected layer’s luma value to define transparency. Stencil Luma is useful if the layer 
you want to use for cropping has no alpha channel of its own.

•	 Silhouette Alpha: The reverse of the Stencil Alpha blend mode, useful for cutting holes 
in underlying layers.

•	 Silhouette Luma: The reverse of Stencil Luma.

•	 Behind: Forces the layer to appear behind all other layers and groups, regardless of its 
position in the Layers list and Timeline. If multiple layers or groups are set to Behind, 
they appear behind all other groups not set to Behind, in the order in which they appear 
in the Layers list.

•	 Alpha Add: Works similarly to the Add blend mode, but instead of adding the color 
channels of overlapping layers, it adds their alpha channels together. Try using this 
blend mode instead of Motion’s default method of alpha channel compositing for a 
different treatment of overlapping areas of translucency.

•	 Light Wrap: Blurs bright areas in the background layer at the edge of a matte. This 
is intended to create a more organic, seamless composite, where light from the 
background appears to bleed onto the foreground layer as would occur in a natural, 
noncomposited image. To adjust the parameters that affect the Light Wrap, such as 
Amount, Intensity, Opacity, and Mode, apply the Green Screen Keyer filter and make 
those adjustments in the Filters Inspector. See Green Screen Keyer filter controls.

Note: Motion applies the Light Wrap effect at the end of the rendering process. When 
you add other filters to the layer, such as color-correction effects, they’re rendered 
before the Light Wrap effect.
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View and navigate in the canvas

Zoom or pan the canvas in Motion
You can zoom in on the canvas to allow precision alignment and placement of objects, and 
you can zoom out to get a sense of the big picture or to see the path of a moving object. 
You can also pan the canvas to modify your view of a composition. Zooming and panning 
does not change the size or layout of the images in your project. It only changes your 
working view of the entire composition.

Zoom using the Zoom tool
1.	 In the Motion canvas toolbar, click and hold the view tools pop-up menu, then choose 

Zoom.

Zoom mode is activated in the canvas.

2.	 Do any of the following:

•	 Click in the canvas to zoom in.

•	 Press Option and click in the canvas to zoom out.

•	 Drag right or left in the canvas to smoothly zoom in or out.

Zoom using other methods
In Motion, do one of the following:

•	 Click the Zoom Level pop-up menu at the top-right side of the canvas, then choose a 
zoom percentage.

•	 Holding down the Space bar and Command key (in that order), drag the pointer 
horizontally in the canvas. The zoom occurs around the spot clicked in the canvas.

•	 On a Multi-touch device, Pinch closed to zoom out or pinch open to zoom in. After you 
zoom in, use a two-finger swipe in any direction to scroll around.
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Zoom a specific area of the canvas
In Motion, do one of the following:

•	 Zoom in: Pressing and holding the Space bar and the Command key (in that order), drag 
the pointer over an area in the canvas; while still pressing and holding the keys, click in 
the canvas to zoom in 50 percent increments of the current zoom level. 

•	 Zoom out: Pressing and holding the Space bar, Command key, and Option key (in that 
order), click in the canvas to zoom out in 50 percent increments of the current zoom 
level.

Note: To pan the canvas without selecting the Pan tool, press and hold the Space bar and 
drag in the canvas.

Zoom to make the project fill the canvas
•	 In Motion, click the Zoom Level pop-up menu, then choose Fit.

Pan using the Pan tool
1.	 In the Motion canvas toolbar, click and hold the view tools pop-up menu, then choose 

Pan.

Pan mode is activated in the canvas.

2.	 Drag in the canvas to move your composition in different directions.

Pan using a keyboard shortcut
•	 In Motion, pressing and holding the Space bar, drag the pointer in the canvas.

Reset the canvas Zoom level or Pan
In Motion, do one of the following:

•	 In the canvas toolbar, double-click the Zoom tool.

Note: Double-clicking the Pan tool resets pan, but not zoom.

•	 Click the Zoom Level pop-up menu at the top-right side of the canvas, then choose 
100%.
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View dynamic canvas feedback in Motion
The status bar at the top-left side of the canvas shows information about layer transforms, 
color, coordinates, and playback frame rate—dynamically, as you modify layers.

Turn display of the status bar on or off
1.	 In Motion, press Command-Comma to open Motion Settings.

2.	 In the Appearance pane of Motion Settings, select or deselect the Dynamic Tool Info 
checkbox.

When you select Dynamic Tool Info, the status bar appears above the canvas whenever 
you adjust a layer by dragging in the canvas. For example, when you scale an object in 
the canvas, the width and height values are displayed in the status bar.

Display pixel color
Some motion graphics projects require you to match or align colors in your project. The 
status bar can provide visual and numeric information about the color of the pixel under 
the pointer, as well as the value of the alpha channel. No clicking is necessary—as you 
move the pointer over the canvas, the status bar updates.

1.	 In the Appearance pane of Motion Settings, select the Color checkbox.

2.	 Click the Display Color As pop-up menu, then choose a color format:

•	 RGB: The red, green, blue, and alpha components of the color are represented in 
values from 0–1. Super-white values can exceed the 0–1 value range.

•	 RGB (percent): The red, green, blue, and alpha components of the color are 
represented in values from 1–100.

•	 HSV: The hue is represented in values from 1–360, and the saturation and value 
(luminance) are represented in values from 1–100.

3.	 Move the pointer over an image in the canvas.

The color information displayed in the status bar updates as you move the pointer.

Display the current pointer position
For precise placement of objects in the canvas, it can be helpful to know the exact pixel 
position of the pointer. The status bar can display this information in an X and Y coordinate 
system (Cartesian). The center point of the canvas is 0, 0.

•	 In the Appearance pane of Motion Settings, select the Coordinates checkbox.

When you move the pointer in the canvas, the coordinate information updates in the 
status bar.
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Display playback frame rate
Part of the way Motion plays back a project in real time is by lowering the frame rate when 
a sequence is too complex to render at full speed. You can monitor the current frame 
rate—in frames per second (fps)—in the status bar.

Note: The frame rate appears in the status bar only while a project is playing.

•	 In the Appearance pane of Motion Settings, select the “Frame rate (only during 
playback)” checkbox.

When you play the project, the frame rate appears in the status bar.

Custom canvas view options in Motion
The pop-up menus in the top-right side of the canvas let you customize various view 
settings, including zoom level, color channels, rendering options, overlay options, and 3D 
view layouts.

Important: In 360° projects, many of the View and Overlay options, such as rulers, guides, 
safe zones, and so on are not always available. See Intro to 360° video.

Zoom Level pop-up menu
Choose any of several default zoom levels. Zooming the canvas changes the current view 
of the window, not the size of the images in your project. See Zoom or pan the canvas.

Channels pop-up menu
Choose which color channels are displayed in the canvas:

•	 Color: Shows the image as it would appear on a video monitor. Visible layers appear in 
natural color and transparent areas reveal the background color as set in the Properties 
Inspector for the project. The background color is black by default. To change it, press 
Command-J, then choose a color from the Background Color control in the Properties 
Inspector.

Note: To export the background color with the project, make sure the Background pop-
up menu in the Properties Inspector is set to Solid. This option creates a solid alpha 
channel on export (when exporting using a codec that supports alpha channels). When 
the Background pop-up menu is set to Transparent, the color is visible in the canvas, 
but does not render as part of the alpha channel.

•	 Transparent: Shows the background area of the canvas as transparent. A checkerboard 
pattern appears by default where no images block the background.

•	 Alpha Overlay: Displays the image in normal color, but adds a red highlight over 
transparent areas of the image.
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•	 RGB Only: Displays the normal mix of red, green, and blue channels but displays 
transparent areas (including semitransparent areas) as opaque.

•	 Red: Displays only the red channel as a range of black to white.

•	 Green: Displays only the green channel as a range of black to white.

•	 Blue: Displays only the blue channel as a range of black to white.

•	 Alpha: Displays the alpha (transparency) channel of the layers in the canvas.

•	 Inverted Alpha: Displays an inverted view of the alpha (transparency) channel.

•	 Exposure: Displays the overexposed areas of the composition. Out of gamut values are 
indicated in the canvas by a red-and-white stripe pattern.

•	 Saturation: Displays the oversaturated areas of the composition. Out of gamut values 
are indicated in the canvas by a blue-and-white stripe pattern.

Render menu
Choose the render quality and resolution of the canvas display, and enable or disable 
features that can impact playback performance. When an option is active, a checkmark 
appears beside the menu item. If a complex project is causing your computer to play at 
a very low frame rate, you can make changes in this menu to reduce the strain on the 
processor. This frees you from waiting for the image to be rendered at full resolution each 
time you make an adjustment, allowing you to watch complex projects at high frame rates 
while you work.

The Render pop-up menu displays the following items:

•	 Dynamic: Reduces the quality of the image displayed in the canvas during playback or 
scrubbing in the Timeline or mini-Timeline, allowing for faster feedback. Also reduces 
the quality of an image as it is modified in the canvas. When playback or scrubbing is 
stopped, or the modification is completed in the canvas, the image quality is restored 
(based on the Quality and Resolution settings for the project).

•	 Full: Displays the canvas at full resolution (Shift-Q).

•	 Half: Displays the canvas at half resolution.

•	 Quarter: Displays the canvas at one-quarter resolution.

•	 Draft: Renders objects in the canvas at a lower quality to allow optimal project 
interactivity. There’s no anti-aliasing.

•	 Normal: Renders objects in the canvas at a medium quality. Shapes are anti-aliased, but 
3D intersections are not. This is the default setting.

•	 Best: Renders objects in the canvas at best quality, which includes higher-quality image 
resampling, anti-aliased intersections, anti-aliased particle edges, and sharper text.

•	 Custom: Allows you to set additional controls to customize rendering quality. Choosing 
Custom opens the Advanced Quality Options dialog. See Advanced Quality settings.

•	 Lighting: Turns the effect of lights in a project on or off. This setting does not turn off 
lights in the Layers list (or light scene icons), but it disables light shading effects in the 
canvas.

•	 Shadows: Turns the effect of shadows in a project on or off.

•	 Reflections: Turns the effect of reflections in a project on or off. 

•	 Depth of Field: Turns the effect of depth of field in a project on or off.
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•	 Motion Blur: Enables/disables the preview of motion blur in the canvas. Disabling motion 
blur may improve performance.

Note: When creating an effect, title, transition, or generator template for use in 
Final Cut Pro, the Motion Blur item in the View pop-up menu controls whether motion 
blur is turned on when the project is applied in Final Cut Pro. See Intro to Final Cut Pro 
templates.

•	 Field Rendering: Enables/disables field rendering. Field rendering is required for smooth 
motion playback on many TV monitors. Field rendering nearly doubles rendering time, 
so disabling this item may improve performance.

Note: When creating an effect, title, transition, or generator template for use in 
Final Cut Pro, the Field Rendering setting in the View pop-up menu does not control 
whether field rendering is applied in Final Cut Pro. Rather, field rendering is controlled 
in the Properties Inspector for the project. (Press Command-J to open the Properties 
Inspector.) When Field Order is set to anything other than None, field rendering is used 
in Final Cut Pro, regardless of the Field Rendering status in the View pop-up menu.

•	 Frame Blending: Enables/disables frame blending in the canvas. Frame blending can 
smooth the appearance of video frames by interpolating the pixels between adjacent 
frames to create a smoother transition.

View and Overlay pop-up menu
Choose layout guides and controls that can be viewed in the canvas. When an option is 
active, a checkmark appears beside the menu item. (Many of these menu options are also 
available in the View menu in the menu bar.)

The View and Overlay pop-up menu displays the following items:

•	 Show Overlays: Enables or disables the display of rulers, grids, guides, and other layout 
overlays in the canvas. This setting must be on to view any other overlay items. To turn 
the camera overlays on or off, use Show 3D Overlays.

Note: You can also press Command-Slash (/).

•	 Rulers: Turns display of the rulers along the edge of the canvas on or off. You can 
specify where the rulers appear in the Canvas pane (Alignment section) of Motion 
Settings. See Use rulers and guides.

Note: You can also press Shift-Command-R.

•	 Grid: Turns a grid display on and off in the canvas. You can set the spacing and color of 
the grid in the Canvas pane (Alignment section) of Motion Settings.

In 360° projects, the Grid command is not always available. See Intro to 360° video.

Note: You can also press Command-Apostrophe (‘).

•	 Guides: Turns display of manually created guides on and off. Guides can only be 
created if rulers are displayed. You can change the color of the guides in the Canvas 
pane (Alignment section) of Motion Settings.

Note: You can also press Command-Semicolon (;).

•	 Dynamic Guides: Turns display of automatic dynamic guides on and off. These guides 
appear when you drag a layer past edges of other layers when snapping is enabled 
(choose View > Snap). You can change the color of dynamic guides in the Canvas pane 
(Alignment section) of Motion Settings.

Note: You can also press Shift-Command-Colon (:).
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•	 Safe Zones: Turns display of the title safe and action safe guides on and off. By default, 
these guides are set at 80% and 90%. You can change these settings and the color of 
the guides in the Canvas pane (Zones section) of Motion Settings.

Note: You can also press the Apostrophe key (‘).

•	 Film Zone: Turns display of film aspect ratio guides on and off. This can be helpful if you 
are creating a project for videotape to be transferred to film. You can change the size of 
the guides as well as their color in the Canvas pane (Zones section) of Motion Settings.

Note: You can also press Shift-Quotation Mark (”).

•	 Handles: Turns display of object handles in the canvas on and off. Some onscreen 
transformations, such as resizing, require visible object handles. Handles appear only 
on selected objects.

•	 Lines: Turns display of lines that outline an object on and off. Lines appear only on 
selected objects.

•	 Animation Path: Turns animation paths on and off. These editable paths indicate the 
route along which animated objects travel. If the selected object is not positionally 
animated, this command does not appear to have any effect. If handles are not 
displayed, the path curves cannot be adjusted in the canvas. Except for the Motion Path 
behavior, animation paths created by behaviors are for display only and are not editable.

•	 Show 3D Overlays: Turns 3D overlays in the canvas on and off, including Camera 
overlays, 3D view tools, 3D compass, inset view, 3D grid, and 3D scene icons. (3D 
overlays appear in projects that contain 3D groups. See View 3D overlays.)

Note: You can also press Option-Command-Slash (/).

•	 3D View Tools: Turns the Camera menu and 3D view tools in the canvas on and off. See 
Use 3D view tools.

•	 Compass: Turns the 3D compass in the canvas on and off. Using red, green, and 
blue axes, the compass shows your current orientation in 3D space. The red axis is X 
(horizontal), the green axis is Y (vertical), and the blue axis is Z (depth). See Cameras 
and views.

•	 Inset View: Turns the inset view in the canvas on and off. When enabled, a temporary 
window appears in the lower-right corner of the canvas displaying an active camera or 
Perspective view of the project, helping you stay oriented as you move objects in 3D 
space. In the 3D pane of Motion Settings, you can change the size of the inset view, as 
well as control whether the inset view appears on transform changes, on all changes, or 
manually. See Set a 3D inset view.

•	 3D Grid: Turns the grid in the canvas on and off. The 3D grid helps you stay oriented 
and can be used to guide the placement of objects in your project. The 3D grid appears 
when you are in a 3D workspace. See Display a 3D grid.

Note: In 360° projects, the 3D grid is not always available. See Intro to 360° video.

•	 3D Scene Icons: Turns the display of cameras and lights in the canvas on or off. Scene 
icons appear in the canvas as wireframe icons. Lights appear with red (X), green (Y), 
and blue (Z) adjust 3D handles that let you transform and rotate them. The handles are 
still displayed when the 3D scene icons command is turned off. See Display 3D scene 
icons.
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•	 Correct for Aspect Ratio: Applies an artificial distortion of the canvas in projects with 
nonsquare pixels. When the setting is on, the computer monitor simulates what a 
TV monitor displays. When the setting is off, projects with nonsquare pixels appear 
stretched. This is because computer monitors have square pixels. This setting does not 
modify the output of the project.

•	 Show Full View Area: When enabled, this setting lets you see the portion of a layer that 
extends beyond the edge of the canvas. This setting is disabled by default, because it 
slows your project’s interactivity.

•	 Use Drop Zones: Turns drop zones on and off. When Use Drop Zones is enabled, a 
checkmark appears next to the menu item, and drop zones accept objects dragged to 
them. When this command is turned off, drop zones ignore objects dropped onto them. 
See Intro to drop zones.

•	 Save View Defaults: Saves the current state of all settings in this menu as the default 
state for new projects.

View Layouts pop-up menu
Choose a preferred view your project in the canvas. You can view the canvas as a single 
workspace or choose from available window arrangements in the menu. (Although the 
workspace views are available for 2D projects, they are most useful when working in 3D 
space.)

The View Layouts pop-up menu displays the following items:

•	 Single: The default value, displays a single window in the canvas.

•	 Two-up, side by side: Displays two windows in the canvas, one next to the other.

•	 Two-up, top and bottom: Displays two windows in the canvas, one on top of the other.

•	 Three-up, large window below: Displays three windows, two next to each other on top 
and a larger window below.
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•	 Three-up, large window right: Displays three windows, two stacked on the left side and 
a larger window spanning the right side.

•	 Four-up, large window right: Displays four windows, three stacked on the left side and 
one larger window on the right side.

•	 Four-up: Displays four windows, all the same size.

Advanced Quality settings in Motion
When you choose Custom in the Quality section of the Render pop-up menu (or in the 
View > Quality menu), the Advanced Quality Options dialog appears. 

The Advanced Quality Options dialog provides additional controls to fine-tune rendering 
performance and quality. It contains the following items:

•	 Quality: A pop-up menu that sets rendering quality. These settings are identical to the 
Quality settings in the Render pop-up menu. (For more information on the Render popup 
menu, see Custom canvas view options.) 

Choose one of four settings from this pop-up menu (each setting activates different 
options in the dialog):

•	 Draft: None of the quality options are selected, and the Text Quality parameter is set 
to Low. This option allows optimal project interactivity.

•	 Normal: “Shape anti-aliasing” is selected, and the Text Quality parameter is set to 
Medium. This option allows project interactivity that is slower than Draft, but much 
faster than Best.

•	 Best: “High-quality resampling,” “Shape anti-aliasing,” and “Anti-alias 3D 
intersections” are selected. Text render quality is set to High. This option slows 
down project interactivity.

•	 Custom: Lets you set your own combination of render settings.

•	 High Quality Resampling: Turns on high-quality resampling (increasing or reducing the 
number of pixels in an image).

•	 Text Quality: A pop-up menu that sets text-rendering quality to Low, Medium, or High. 
When High is selected, project interactivity may slow.

•	 Shape anti-aliasing: Renders shapes at a higher resolution, then scales objects back to 
regular resolution to ensure smooth edges.

•	 Anti-alias 3D intersections: Renders objects intersecting in 3D space at a higher 
resolution, then scales objects back to regular resolution to ensure smooth edges.
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Use rulers and guides in Motion
Using rulers and guides (line overlays) in the canvas can help you compose or align 
elements of your project, as well as snap objects to rulers.

Note: In 360° projects, rulers are not always available. See Intro to 360° video.

Turn on rulers
•	 In Motion, click the View pop-up menu at the top-right side of the canvas, then choose 

Rulers (or press Shift-Command-R). 

When canvas rulers are enabled, a checkmark appears next to the item in the pop-up 
menu.

By default, rulers appear along the left and top sides of the canvas.

Change the location of the rulers
1.	 In Motion, choose Motion > Settings.

2.	 In the Canvas pane, click Alignment, then choose a ruler layout from the Ruler Location 
pop-up menu.

Add a horizontal or vertical guide to the canvas
1.	 In Motion, click in the gray area of the horizontal or vertical ruler, then drag into the 

canvas.

As you drag, the position of the guide is displayed in the canvas.

Note: Rulers and Guides must be enabled in the View pop-up menu (or by pressing 
Command-Shift-R and Command-Semicolon).

The ruler units are in pixels, with the 0, 0 point in the center of the canvas.

2.	 When the guide is in the location you want, release the mouse button.
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Simultaneously add a horizontal and vertical guide to the canvas
1.	 Drag from the corner where the rulers meet, then continue dragging into the Motion 

canvas.

2.	 When the guides are in the location you want, release the mouse button.

Remove a guide from the canvas
•	 Drag the guide off the Motion canvas. 

To delete the guide, drag into the Project pane or Timing pane areas of the Motion 
window, then release the mouse button.

Change the color of the guides
1.	 In Motion, choose Motion > Settings.

2.	 In the Canvas pane, click Alignment, click or Control-click the Guide Color well, then 
select a color.
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Work in a 3D project

Intro to 3D compositing in Motion
Motion includes a robust set of tools for creating three-dimensional layers that intersect 
and interact with one another. The 3D features in Motion are powerful, yet flexible, allowing 
to you combine 2D elements and 3D elements to create different effects.

Use the 3D features in Motion to:

•	 Rotate or reposition 2D layers in 3D space

•	 Create intersecting 3D layers

•	 Add a 3D camera and convert your entire project to 3D

When you convert your project to 3D, additional advanced features become available, 
allowing you to:

•	 Add camera behaviors to create animated point-of-view dollies, pans, and zooms—
without keyframing

•	 Add lights and environmental lighting effects
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•	 Enable realistic shadow effects so that objects in your project cast and receive shadows

•	 Enable realistic reflections to give your objects surface shine and other real-world 
reflective properties

 Tip: Before you begin creating 3D environments, learn the basics of the 3D coordinate 
system in Motion. See Intro to 3D coordinates.

You can also create 3D text in a Motion project or add cameras to a 360° Motion project.

3D coordinates

Intro to 3D coordinates in Motion
In a standard 2D Motion project, coordinates are measured in two dimensions, along two 
axes: X (side to side) and Y (up and down). A 3D Motion project contains an additional 
dimension (depth), which is measured along the Z axis (front to back). All three axes (X, 
Y, and Z) meet in the center of the canvas, at a point called the origin, where X = 0, Y = 0, 
and Z = 0. Moving an object to the left subtracts from the X value, while moving it to the 
right adds to the X value. Moving an object up adds to the Y value, while moving it down 
subtracts from the Y value. Moving an object “closer” adds to the Z value, while moving it 
farther away subtracts from the Z value.

In a 2D project, the X and Y axes remain static: X always runs horizontally, and Y always 
runs vertically. However, in a 3D project, you can change your point of view, which 
reorients (from your perspective) the direction of the 3 axes. As a result, moving an object 
up (from your perspective) doesn’t always mean increasing its Y position value.

Note: In a new project, the canvas is oriented with the Z axis pointing straight at you. This 
orientation preserves the traditional two-dimensional orientation of the X and Y axes.

Motion uses the following conventions for 3D coordinates:

•	 Object movement is along an axis.

•	 Object rotation is around an axis.

•	 Each axis is color-coded: X is red; Y is green; and Z is blue.

•	 Positive rotation is counterclockwise around an axis.

•	 The coordinates of an object (as shown in the Inspector) are relative to the coordinates 
of the group in which the object resides. See Relative coordinates.



180Motion User Guide

Relative coordinates in Motion
In Motion, the coordinates of an object are relative to the coordinates of the group that the 
object resides in. For example, if you position an empty group at X, Y, and Z coordinates of 
100, 100, 100, and then add an image layer to the group, the layer’s coordinates are shown 
in the Properties Inspector as 0, 0, 0. However, in the canvas the image layer appears 
offset (100 pixels right of center, 100 pixels above center, and 100 pixels “closer” to you). 
The layer’s absolute coordinates in the canvas may be the same as those of its parent 
group (100, 100, 100), but the Properties Inspector displays the layer’s relative coordinates 
(0, 0, 0—the center of the layer’s parent group). 

Rotation values are also relative to a layer’s parent. For example, rotating the group 45° 
also rotates the image layer 45° in the canvas; however, in the layer’s Properties Inspector, 
the Rotation value remains 0°—the rotation value of the layer relative to its parent group.
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Transform layers in 3D space in Motion
In Motion, 2D layers and groups can exist in the same project as 3D layers and groups. You 
can manipulate any 2D layer in 3D space by using the 3D Transform tool.

Move a layer in 3D space
1.	 In the Motion canvas toolbar, select the 3D Transform tool (or press Q).

2.	 Select a layer or group in the Layers list or canvas.

A bounding box with 3D handles appears on the selected object in the canvas.

3.	 Do any of the following:

•	 Move the object horizontally: Drag the red arrow to move the object along its X axis.

•	 Move the object vertically: Drag the green arrow to move the object along its Y axis.

•	 Move the object forward or backward: Drag the blue handle to move the object along 
its Z axis.

 Tip: If the blue handle is facing forward, drag left or right to move the object 
forward or backward.

As you drag, the active arrow turns yellow, and the status bar above the canvas displays 
the current coordinates of the object as well as the distance the object has moved (delta). 
Coordinates are given in the form of X, Y, and Z. See View dynamic canvas feedback.
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Rotate a layer in 3D space
1.	 In the Motion canvas toolbar, select the 3D Transform tool (or press Q).

2.	 Select a layer or group in the Layers list or canvas.

A bounding box with 3D handles appears on the selected object in the canvas.

3.	 Move the pointer over one of the rotation handles (small circles surrounding the arrows) 
until a color rotation ring appears, then drag the ring.

•	 The red ring rotates the object around its X axis.

•	 The green ring rotates the object around its Y axis.

•	 The blue ring rotates the object around its Z axis.

As you drag, the status bar above the canvas displays the absolute rotation values as well 
as the amount of rotation change (delta).

Note: If the values do not appear in the status bar, go to the Appearance pane in Motion 
Settings (press Command-Comma), then select the “Dynamic Tool Info” checkbox.
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Rotate a layer around all axes simultaneously
1.	 In the Motion canvas toolbar, select the 3D Transform tool (or press Q).

2.	 Select a layer or group in the Layers list or canvas.

3D handles appear on the selected object in the canvas. 

3.	 Pressing and holding the Command key, move the pointer over one of the rotation 
handles (small circles surrounding the arrows) until all three rotation rings appear, then 
drag within the rings (but not over the rotation handle).

The object rotates around all three axes simultaneously, and the status bar above the 
canvas displays the absolute rotation values as well as the amount of rotation change 
(delta).

Display a subset of the 3D transform handles
In Motion, do any of the following:

•	 Display the axis arrows only: Press the Comma key (,).

•	 Display the rotation handles only: Press the Period key (.).

•	 Display the scale handles only: Press the Slash key (/).

When you press any key a second time, the display switches back to the default, with all 
three of the onscreen controls visible.
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Transform a layer in 3D space using the HUD
As an alternative to dragging in the canvas, you can transform layers and groups in 3D 
space using graphic controls in the HUD.

1.	 In the Motion canvas toolbar, select the 3D Transform tool (or press Q).

2.	 Select a layer or group in the Layers list or canvas.

3.	 Choose Window > Show HUD or press D.

4.	 In the HUD, do any of the following:

•	 Move a layer: Drag in any of the three Move squares to reposition the object along 
its Z axis, X and Y axes, or X and Z axes. Press and hold the Command key while 
dragging to simultaneously scale the object as it’s moved, preserving its size relative 
to the camera.

•	 Rotate a layer: Drag in the Rotate square to rotate the object around the X and Y 
axes. To rotate around the Z axis, press and hold the Command key while dragging.

•	 Resize a layer: Drag in the Scale square to uniformly resize the selected object in the 
canvas. To constrain scaling to the axis corresponding to the initial direction of the 
drag, press and hold the Command key while dragging.

•	 Choose an axis type: Click the Adjust Around pop-up menu, then choose an item. 
Local Axis (the default) orients 3D transforms to the object’s local coordinates. 
World Axis orients 3D transforms to the coordinates of the 3D grid in the canvas. 
View Axis orients 3D transforms to the view space of the current view, with the 
Z axis aligned along the view’s line of sight. For more information on views, see 
Cameras and views.
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3D intersection

Create 3D intersection in Motion
By default in Motion, the order of layers in the Layers list determines the stacking order 
of layers in the canvas. In other words, layers higher up in the Layers list appear in the 
canvas on top of layers that are lower in the Layers list. This hierarchy of layer organization 
is called layer order. Even when you move a layer forward in Z space using 3D transform 
handles, that layer does not pass through or move in front of layers that are higher in the 
Layers list. Layer order prevents intersection and interaction of layers.

Important: 3D objects intersect only with like objects. In other words, 3D text objects 
intersect only with other 3D text objects, and 3D objects intersect only with other 3D 
objects. Additionally, 3D text and 3D objects use layer order: For 3D text or 3D objects to 
appear above other non-3D text or non-3D object layers, the 3D text or 3D object must be 
positioned above the other layers in the Layers list; the text’s or object’s Z position in the 
canvas has no effect. See 3D text intersection.

In the image below, groups “Orange A” and “Yellow B” are positioned at the same point 
in 3D space. But because they are layer-ordered, “Orange A” does not intersect with 
“Yellow B.”

To have objects intersect in the canvas, you must convert groups in your project to depth 
order. You do this by converting 2D groups to 3D groups.

In the image below, because the parent group has been converted to 3D, groups “Orange 
A” and “Yellow B” now intersect.
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To summarize:

•	 Groups and layers nested in 2D groups are composited in layer order.

•	 Groups and layers nested in 3D groups are composited in depth order.

A Motion project can contain both 2D and 3D groups, and both groups can be parents 
or nested children of one another. And you can convert a group from 2D to 3D, and vice 
versa, at any time.

Convert a group from 2D to 3D to enable intersection
•	 In the Layers list in Motion, select a 2D group, then do one of the following:

•	 Click the 2D icon to the right of the group in the Layers list.

•	 Choose Object > 3D Group (or press Control-D).

•	 In the Group Inspector, click the Type pop-up menu, then choose 3D.

The 2D group icon is replaced by a 3D group icon, and layers and groups nested in the 
parent group are converted to depth order, allowing intersection with other depth-ordered 
layers and groups. To change a group from 3D to 2D, use the same method described 
above.

Important: Some operations, as well as the application of some filters or a mask, cause 
a group to be rasterized. When a group is rasterized, it’s converted into a bitmap image. 
Rasterization affects 2D and 3D groups in different ways, sometimes preventing 3D 
intersection. See Intro to rasterization.
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2D and 3D group properties in Motion
2D groups and 3D groups behave in different ways. And in the Group Inspector, 2D groups 
and 3D groups have different parameters.

The Group Inspector for 3D groups contains Flatten and Layer Order parameters. Selecting 
the Flatten checkbox places layers and groups inside the 3D group into a two-dimensional 
plane. Selecting the Layer Order checkbox composites layers and groups inside the 3D 
group according to their position in the Layers list rather than by depth order (position in 
the canvas along the Z axis). See Create 3D intersection.

The Group Inspector for 2D groups contains the Fixed Resolution parameter. Selecting 
the Fixed Resolution checkbox lets you manually set the size of a group, using sliders. By 
default, Fixed Resolution is disabled and the size of the group is determined by the layers 
in that group. See Constrain group size.

2D group properties
•	 Nested layers and groups are composited in the canvas in layer order (hierarchical order 

in the Layers list). However, adjacent 3D groups that are not nested in 2D groups can 
intersect based on depth order.

In the example above, the two gray balls in the 2D “Foreground” group are composited 
on top of the rest of the scene. “Orange A” and “Yellow B” intersect because they are 
3D groups, but neither of them can intersect with the 2D root-level groups.

•	 A 2D group can be nested in a 3D group.

•	 A 2D group not nested in a 3D group is locked to the camera, even if the camera is 
animated. For more information about cameras, see Cameras and views.
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•	 Filters are applied to a 2D group in local space—that is, flat to the image.

•	 When lights are used, the group is lit as a single object; nested layers and groups are 
not lit individually.

Note: 2D groups not nested inside 3D groups are not affected by lights.

•	 Because it is flat, a 2D group has Drop Shadow, Four Corner, and Crop parameters in 
the Properties Inspector.

•	 2D groups can have a fixed resolution.

3D group properties
•	 Nested layers and groups are composited in depth order (according to their position 

along the Z axis).

•	 When a 3D group is nested in a 2D group, the 3D group is flattened. This means that 
the nested 3D group acts like a flat card and ignores the camera. In addition, the 
flattened group does not intersect with layers of the 2D group or other groups in the 
project. 

•	 Filters are applied to a 3D group in view space. In other words, the filter affects the 
group as if it were applied to the lens of the camera viewing the group.

•	 When lights are used on a 3D group, the group’s nested layers and groups are lit 
individually.

•	 Only a 3D group with the Flatten parameter enabled has Crop, Drop Shadow, and Four 
Corner parameters in the Properties Inspector.



189Motion User Guide

Add cameras to create 3D environments

Intro to 3D cameras in Motion
By default, newly created Motion projects are 2D, planar environments. When you add a 
scene camera and convert your project to a 3D environment, the following occurs:

•	 A third dimension (depth) is activated in the canvas, represented by the Z axis.

•	 A camera object is added to the Layers list and to the canvas (as a wireframe icon that 
you can drag like any other object in Motion). Like a real-world camera, a Motion scene 
camera lets you frame a custom point of view during your sequence. And like a real 
camera, a Motion scene camera can be static or set into motion to create elaborate 
tracking shots.

•	 Controls become available in the Inspector for adjusting your camera’s angle of view 
and other properties. See Camera controls.

•	 3D overlays become available in the canvas to help you view and arrange your 3D 
elements. See View 3D overlays.

•	 Additional reference views (called reference cameras) become available so that you can 
see your 3D project from various angles (from the front, back, sides, and so on). See 
Cameras and views.

•	 A group of camera behaviors becomes available, allowing you to apply sophisticated 
animated camera moves. See Add Camera behaviors.

Add a camera in Motion
To convert your project to 3D, add a scene camera. 

Add a scene camera to a Motion project
1.	 In Motion, do one of the following:

•	 In the toolbar, click Add Object, then choose Camera from the pop-up menu.

•	 Choose Object > New Camera (or press Option-Command-C). 

If your project contains no existing 3D groups, the following dialog appears:

If your project is empty or already contains at least one 3D group, go to step 3.
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2.	 Do one of the following:

•	 To add a camera without converting 2D groups in your project to 3D groups, click 
Keep as 2D.

•	 To add a camera and convert 2D groups in your project to 3D groups, click Switch to 
3D.

The following happens: 

•	 A camera object is added to the Layers list and canvas (represented there by a 
wireframe icon).

•	 The 3D Transform tool in the canvas toolbar is selected.

•	 The Camera HUD becomes available (if it isn’t visible, press F7).

•	 The Camera Inspector becomes available.

•	 The Camera pop-up menu (set to Active Camera) becomes available in the upper-left 
corner of the canvas.

3.	 Click the Camera pop-up menu in the upper-left corner of the canvas, then choose a 
camera view.

The view in the canvas updates to show the camera view you chose. You can choose 
a scene camera that you added or one of the default reference camera views 
(Perspective, Front, Back, Left, and so on). See Camera pop-up menu and Cameras and 
views.

You can create cameras to look at your scene from different points of view. You can place 
cameras, animate them, and apply behaviors to them. Creating multiple cameras lets you 
make different cameras active at different times, allowing you to “cut to” different views 
over the course of the project.
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Cameras and views in Motion
In a 3D workspace, everything is seen from the viewpoint of a camera. If you want to export 
your project specifically from a camera view, you must add a scene camera. When you add 
a scene camera to a project, additional reference cameras become available to help you see 
your composition from various angles, such as top, bottom, left, and right. Scene cameras 
are used for rendering output when you export your project; what you see through the scene 
camera represents your final render. Reference cameras are not used for rendering.

Scene cameras
There are two types of scene cameras:

•	 Framing: Sets the camera origin (or anchor point) at the focal plane (a plane perpendicular 
to the camera’s local Z axis—in other words, perpendicular to your line of sight as you 
look at the canvas). Rotating a Framing camera causes it to orbit round the origin.

•	 Viewpoint: Sets the camera origin (or anchor point) at the center of projection, “inside” 
the virtual camera. Rotating a Viewpoint camera causes it to pivot—also known as 
panning (horizontal) or tilting (vertical).

By default, the first camera you add to a project is a Framing camera. You can change the 
camera type in the Camera Inspector (see Camera controls). Once you change the camera 
type, any subsequent cameras added to the project are set to the last-selected camera type.

Scene cameras appear in the Layers list and canvas (as wireframe objects that you can 
move and rotate to change your point of view).

Note: New, default 360° projects are created with Viewpoint cameras. See Intro to 360° video.

Reference cameras
There are two types of views provided by the reference cameras:

•	 Orthogonal: Views the scene by looking straight down one of the world axes: X, Y, or 
Z. The Front and Back cameras look straight down the Z axis. The Top and Bottom 
cameras look straight down the Y axis. The Left and Right cameras look straight down 
the X axis. Orthogonal views do not show perspective.

•	 Perspective: Views the scene with perspective distortion, the way a real-world camera 
would. (Scene cameras also view the scene in perspective.)
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Reference camera views are selected in the canvas, via the Camera pop-up menu or the 
3D compass.

Reference cameras do not appear as objects in the Layers list or canvas.

Work with camera views and overlays

View 3D overlays in Motion

After you add a camera to your project, six 3D overlays become available in the canvas to 
help you view and arrange your 3D elements: 

•	 Camera pop-up menu: Sets the camera view.

•	 3D view tools: Control reference and scene cameras.

•	 Inset view: Displays the scene from a different camera’s perspective.

•	 3D grid: Shows the ground plane of the 3D world.

•	 3D compass: Changes the canvas view in 3D space.

•	 3D scene icons: Display onscreen representations of cameras, lights, and edge-on lines. 
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Show or hide 3D overlays
In Motion, do one of the following:

•	 Choose View > 3D Overlays, then choose an overlay type.

•	 Click the View pop-up menu above the canvas, then choose an overlay type.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is 
enabled in the canvas.

Camera pop-up menu in Motion

The Camera pop-up menu, located in the upper-left corner of the canvas, lists the active 
camera view. Choose from a list of scene cameras and reference cameras. This menu also 
contains several view-related commands.

Note: In a 360° video project, three additional camera views are available (360° Look 
Around, 360° Overview, and Mirror VR Headset). See Intro to 360° video.

The Camera pop-up menu is divided into three sections:

•	 The top section lets you select the active scene camera as well as any other scene 
cameras you’ve added to your project. For more information on scene cameras, see 
Cameras and views.

•	 Active Camera/Camera: When you choose Active Camera from the pop-up menu, the 
topmost camera in the Layers list at the current playhead position (in the Timeline) 
becomes the active camera. The active camera is the camera through which you 
view your project in the canvas. It’s also the camera view that’s rendered when you 
export your project. If a project contains only one scene camera (as shown above), 
two items appear at the top of this pop-up menu: Active Camera and Camera, which 
represent the same camera.
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If a project contains more than one scene camera (as shown below), all scene 
cameras appear at the top of the Camera pop-up menu, under the Active Camera 
item. To make a different scene camera the active camera, choose a different 
camera from the top section of the pop-up menu. (Scene cameras listed in this 
section of the Camera pop-up menu appear in the same order as they do in the 
Layers list.)

See Work with multiple cameras.

•	 The middle section of the Camera pop-up menu lets you choose a reference camera 
to help you see your composition from various angles. Choose any of the following to 
activate a reference camera view:

•	 Perspective: Like a real-world camera, views the scene with perspective distortion. 
For example, layers farther away from the camera appear smaller than layers closer 
to the camera. The perspective view defaults to a view from the front center.

•	 Front: This orthogonal camera looks straight down the Z axis and shows a 
perpendicular view from the front of the scene.

•	 Back: This orthogonal camera looks straight down the Z axis and shows a 
perpendicular view from the back of the scene.

•	 Left: This orthogonal camera looks straight down the X axis and shows a 
perpendicular view from the left of the scene.

•	 Right: This orthogonal camera looks straight down the X axis and shows a 
perpendicular view from the right of the scene.

•	 Top: This orthogonal camera looks straight down the Y axis and shows a 
perpendicular view from the top of the scene.

•	 Bottom: This orthogonal camera looks straight down the Y axis and shows a 
perpendicular view from the bottom of the scene.

Note: The orthogonal camera views (Front, Back, Left, Right, Top, and Bottom) 
ignore perspective.

The reference camera views cannot be exported. However, you can still animate a scene 
camera when a reference camera view is selected.
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Because objects (except 3D text) are 2D (flat), they may not be visible in the canvas 
when you choose an orthogonal camera view (Front, Back, Left, Right, Top, and 
Bottom). This is because orthogonal views are at right angles (perpendicular) to 2D 
elements in your project. When you select an object that’s invisible to an orthogonal 
reference camera, a thin white line represents the object in the canvas. See Display 3D 
scene icons.

Note: Layers in 360° environments are not visible in orthogonal camera views.

•	 The bottom section of the Camera pop-up menu allows access to five frequently used 
commands:

•	 Reset View: Resets the camera view to its default orientation. (Control-R)

•	 Select Active Camera: Selects the active camera in the project—the topmost camera 
in the Layers list that is visible at the current frame (when there are multiple cameras 
existing at the same frame in time). (Control-Option-C)

•	 Fit Objects Into View: Reframes the current camera to fit the selected objects into 
the canvas. (F)

•	 Frame Object: Frames the selected objects in the active view. If no objects are 
selected, Frame Object resets the reference camera to view all objects in the scene. 
(Shift-Command-F)

•	 Focus On Object: Used when a camera has depth of field turned on. Adjusts the 
camera’s Focus Offset to the selected object. (Control-F)

After you choose a camera view (scene camera or reference camera), use the 3D view 
tools to pan, orbit, or dolly the camera.

Use 3D view tools in Motion

The 3D view tools in the upper-right corner of the canvas become available after you add a 
camera to your project. Use these tools to modify the position and orientation of reference 
and scene cameras, thereby changing your view of objects in 3D space.

A scene camera indicator (a gray camera icon) appears to the left of the 3D view tools 
when a scene camera is the active camera. This icon is a reminder (not a button or control) 
that when you use the 3D view tools, you are moving the scene camera, which affects your 
project’s output.

Pan, orbit, or dolly using the 3D view tools
In Motion, do one of the following:

•	 Pan: Drag over the leftmost control to move the camera along the X and Y axes relative 
to the current view.

•	 Orbit: Drag over the middle control to orbit the camera around the selected scene 
object. If nothing is selected, the camera orbits around its focal plane. For more 
information on the camera focal plane, see Camera controls. Orbit can affect X, Y, and Z 
Position values, as well as X and Y Rotation values.
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Note: If you use the orbit control to change an orthogonal reference camera, an asterisk 
appears next to the view’s name in the Camera pop-up menu, indicating that the view is 
no longer a true orthogonal view.

•	 Dolly: Drag over the rightmost control to dolly the camera, moving it along the Z axis 
relative to the current view.

 Tip: Double-clicking a 3D view tool resets all parameters that can be affected by 
the tool.

Pan, orbit, or dolly in small or large increments
In Motion, do one of the following:

•	 To adjust the camera in increments of 10, press and hold the Shift key while dragging in 
the Pan, Orbit, or Dolly controls.

•	 To adjust the camera in increments of .01, press and hold the Option key while dragging 
in the Pan, Orbit, or Dolly controls.

Pan, orbit, or dolly using keyboard commands and a two-button or three-button 
mouse
In Motion, do one of the following:

•	 Pan: Drag in the canvas while pressing and holding the Option key and the right mouse 
button.

•	 Orbit: Drag in the canvas while pressing and holding the Command key and the right 
mouse button.

•	 Dolly: Drag in the canvas while pressing and holding the Command key, the Option key, 
and the right mouse button.

Reset your camera
In Motion, do one of the following:

•	 Double-click the Pan, Orbit, or Dolly tool.

•	 Click the Camera pop-up menu (in the upper-left corner of the canvas), then choose 
Reset View.

•	 In the Properties Inspector for the camera, click the Animation menu in a parameter row 
(the down arrow that appears when you move the pointer over the right side of the row), 
then choose Reset Parameter.
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Use the 3D compass in Motion

Located in the lower-left corner of the canvas, the 3D compass acts as an orientation and 
shortcut device. It has active and passive states, depending on whether the pointer is 
positioned over it. In its passive state, it displays the orientation of the three world axes (X, 
Y, and Z). In its active state, the compass presents color-coded shortcuts to activate the 
reference (orthogonal and perspective) cameras.

Show or hide the 3D compass
•	 In Motion, click the View pop-up menu above the canvas, then choose Show 3D 

Overlays and 3D Compass.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is 
enabled in the canvas.

Select a reference camera view using the 3D compass
1.	 In Motion, position the pointer over the 3D compass.

The 3D compass changes to its active state, displaying a labeled icon for each 
reference camera view.

2.	 Click the icon representing the camera to activate.

The view in the canvas updates to the selected reference camera view.

Select a camera view using the 3D compass
1.	 In Motion, position the pointer over the 3D compass.

The 3D compass changes to its active state.

2.	 Control-click the 3D compass, then choose a scene camera or reference camera view 
from the shortcut menu.

The view in the canvas changes to the selected camera view.
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Set a 3D inset view in Motion

When you move an object (a layer, group, camera, or light) in a 3D project, an inset view 
appears in the lower-right corner of the canvas, showing the scene from a different 
camera’s point of view. If you’re viewing the scene through the active camera, the inset 
view shows the Perspective camera’s point of view. If you’re viewing the scene through any 
other camera, the inset view shows the active camera. Use the inset view to see the results 
of changes that you make in orthogonal views.

Show the inset view
•	 In Motion, click the View pop-up menu above the canvas, then choose Show 3D 

Overlays and Inset View.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is 
enabled in the canvas.

You can set the inset view’s size and when it appears in the canvas by opening Motion 
Settings (press Command-Comma), then adjusting the settings in the 3D pane.

Display a 3D grid in Motion

The 3D grid shows the ground plane of the 3D world. The ground plane is, as the name 
states, a plane attached to the ground of the scene, where Y equals 0. The ground plane 
represents the dividing line between up and down, that is, between positive Y values and 
negative Y values. It is centered on 0, 0, 0.
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Show the 3D grid
•	 In Motion, click the View pop-up menu above the canvas, then choose Show 3D 

Overlays and 3D Grid.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is 
enabled in the canvas.

Display 3D scene icons in Motion

3D scene icons are onscreen wireframe representations of cameras and lights in your 
project. (When a scene camera is active, its 3D scene icon is not visible because you’re 
viewing the scene through that camera. To see the camera’s scene icon, click the Camera 
pop-up menu and choose a different camera view.) 

When you rotate a flat layer (a shape or image) so that its plane is perpendicular to the 
screen, another type of 3D scene icon becomes visible: an edge-on line that lets you see 
and manipulate an object that would otherwise be invisible.

Note: No 3D scene icons appear in exported images or video clips.

 Tip: Double-click a camera scene icon to select it and change the current view to that 
camera.

Show the 3D scene icons
•	 In Motion, click the View pop-up menu above the canvas, then choose Show 3D 

Overlays and 3D Scene Icons.

A checkmark next to an overlay type in the pop-up menu indicates that the overlay is 
enabled in the canvas.
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3D viewport layouts in Motion
Viewports are window divisions in the canvas that display multiple camera views at the 
same time. Viewports can help you animate and position objects in 3D space. The default 
viewport is a single camera view. You can add more viewports by clicking the gray box in 
the top-right corner of the canvas, then choosing an arrangement:

•	 Single: The default value, displays a single viewport window in the canvas.

•	 Two-up, side by side: Displays two viewport windows in the canvas, one next to the 
other.

•	 Two-up, top and bottom: Displays two viewport windows in the canvas, one on top of 
the other.

•	 Three-up, large window below: Displays three viewport windows, two next to each other 
on top and a larger window below.

•	 Three-up, large window right: Displays three viewport windows, two stacked on the left 
side and a larger window spanning the right side.

•	 Four-up, large window right: Displays four viewport windows, three stacked on the left 
side and one larger window on the right side.

•	 Four-up: Displays four viewport windows, all the same size.
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When working with multiple viewports, the most recent view clicked in is the active view. 
The active viewport is highlighted with a yellow border. Only the active viewport displays 
transform handles.

Note: The active viewport in the canvas is not the same as the active camera. See Cameras 
and views.

Work with multiple cameras in Motion
If a scene contains more than one camera, you can set the topmost camera in the Layers 
list and Timeline to be the active camera at the current frame. Although the active camera 
is the default camera used for export, you can select any scene camera to export. (The 
active camera is not the same as the active view. The active view is the last viewport you 
clicked in when working with multiple viewports.)

Note: Dragging and dropping an object onto the canvas adds the object to the scene at the 
focal plane of the current camera. Dragging an object into the Layers list or importing a file 
positions the object at 0, 0, 0 in the canvas.
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Make a camera active based on its layer order
•	 In the Motion canvas, click the Camera pop-up menu, then choose Active Camera.

The topmost camera in the Layers list at the current frame becomes the active camera 
(Camera 2 in the example above).

Make a specific camera the active camera
•	 In the Motion canvas, click the Camera pop-up menu, then choose a scene camera.
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Scale, position, and animate cameras in Motion
Motion gives you various ways to scale, position, “walk,” and animate cameras. After 
you position cameras in a project, you can select a single camera view using the Isolate 
command. See Isolate an object in the canvas.

Scale a camera
Use the Scale parameter in the Properties pane of the Inspector to scale what a scene 
camera sees. For example, when the camera “shrinks,” the scene it views seems to become 
larger.

1.	 In Motion, select a camera in the canvas, Layers list, or Timeline.

2.	 In the Properties Inspector, drag the Scale slider.

Note: Changing the Scale value does not affect a camera’s Angle of View parameter. 
Additionally, changing the Scale value only affects framing cameras. For more 
information about framing cameras, see Cameras and views and Camera controls.

Position a camera in the canvas
In Motion, do one of the following:

•	 Drag a camera or its onscreen controls in the canvas.

See Transform layers in 3D space.

•	 Select a camera in canvas, Layers list, or Timeline, then adjust the Position or Rotation 
controls in the Properties Inspector.

•	 Select a camera in canvas, Layers list, or Timeline, then adjust the 3D transform 
controls in the HUD. 

See Transform layers in 3D space.

•	 Select a camera in canvas, Layers list, or Timeline, then adjust the 3D view tools in the 
upper-right corner of the canvas.

See Use 3D view tools.
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Position a camera using the Walk 3D View tool
The Walk 3D View tool lets you position a camera in 3D space as you would in a computer 
game, using a keyboard-and-mouse navigation method.

1.	 In Motion, select a camera, click and hold the view tools pop-up menu in the canvas 
toolbar, then choose Walk 3D View.

The pointer changes to indicate that the Walk 3D View tool is active.

2.	 Use the Up Arrow, Down Arrow, Right Arrow, and Left Arrow keys to move the camera in 
3D space; press and hold the Option key while using the arrow keys to move the camera 
more slowly.

You can also drag in the canvas to orient the camera.

If you’re using a scene camera, you can also record the movement you create using the 
Walk 3D View tool, by creating keyframes. For more information on keyframing, see Add 
keyframes.

Note: The Walk 3D View tool is available only when Active Camera, Camera, or 
Perspective is selected from the Camera pop-up menu. For more information on the 
Camera pop-up menu, see Camera pop-up menu.

Animate a camera
In Motion, do one of the following:

•	 Add keyframes to a camera parameter in the Camera Inspector or Properties Inspector.

For more information on animating with keyframes, see Intro to keyframing.

•	 Apply a basic behavior or a Camera behavior to a camera.

For more information on Camera behaviors, see Add Camera behaviors.

•	 Apply a Parameter behavior to camera parameter in the Camera Inspector or Properties 
Inspector.

For more information on Parameter behaviors, see Add or remove a Parameter behavior.
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Isolate an object in the canvas in Motion
The Isolate command (and Isolate button) temporarily aligns the current view with the 
selected object and hides all other objects in the scene, facilitating access to distant or 
obscured objects.

The Isolate command is not intended for creating a camera view to be rendered or 
exported, but rather to temporarily restrict your view to a single object so you can modify 
or manipulate that object more effectively.

Isolate an object
1.	 In Motion, select the object to isolate in the canvas, Layers list, or Timeline.

2.	 Do one of the following:

•	 Choose Object > Isolate (or press Control-I).

•	 In the Layers list or Timeline, click the Isolate button (the small white rectangle next 
to the object’s name).

The current view changes to align itself with the selected object, and all other 
objects in the scene are hidden.

When an object is isolated, a temporary camera is created and listed in the Camera 
pop-up menu. The camera shares its name with that of the isolated object.

Exit the isolated view
In Motion, do one of the following:

•	 Choose Object > Isolate (or press Control-I).

•	 In the Layers list or Timeline, click the Isolate button (the small white rectangle next to 
the object’s name).

•	 Choose a different camera from the Camera pop-up menu.

Note: You can isolate as many objects as you have viewports. It’s a common workflow to 
edit an object in an isolated view while looking at the results through a scene camera in 
another viewport. After an object is isolated in a view, you can activate another viewport 
and isolate a different object. See 3D viewport layouts.
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Camera controls in Motion
You can modify a scene camera’s properties in the Camera Inspector (and in the Camera 
HUD). 

To open the Camera Inspector, select a camera in the canvas, Layers list, or Timeline, then 
click Camera in the Inspector.

The Camera Inspector contains the following parameter controls:

•	 Camera Type: A pop-up menu to set the type of camera used. There are two options: 

•	 Framing: Sets the camera origin at the focal plane. The focal plane of a camera is a 
plane located at a distance equal to the camera’s focal distance along its local Z axis 
(or line of sight) and oriented perpendicular to the camera’s local Z axis.

•	 Viewpoint: Sets the camera origin at the center of projection, “inside” the virtual 
camera.

•	 Angle of View: A slider to set the number of degrees in which the camera sees. Values 
range from 0 to 180 degrees.

Note: When you animate the Angle of View parameter on a Framing camera, the result 
is an opposing dolly effect. An opposing dolly zooms in the opposite direction that the 
camera moves. When you animate the Angle of View parameter on a Viewpoint camera, 
the result is a regular camera zoom.
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•	 Near Plane: A slider to set the distance where the camera begins to see objects. 
Objects closer to the camera than this distance are not rendered from this camera’s 
point of view.

•	 Far Plane: A slider to set the distance where the camera ceases to see objects. Objects 
farther from the camera than this distance are not rendered from this camera’s point of 
view.

•	 Near Fade: A slider to set the softness factor for the near plane. The softness factor 
sets a boundary range over which near objects fade in.

•	 Far Fade: A slider to set the softness factor for the far plane. The softness factor sets a 
boundary range over which far objects fade out.

Note: Camera depth of field parameters are also contained in this window. For a 
complete description of these controls see Intro to depth of field.

The Camera HUD contains the Camera Type, Angle of View, Focal Length, and DOF Blur 
Amount parameters, which are also available in the Inspector. The Camera HUD also 
contains 3D transform controls. See Transform layers in 3D space.

Depth of field

Intro to depth of field in Motion

In the real world, cameras have a limited range of focus. Objects within that range appear 
sharp, and the farther outside that range an object is, the blurrier it appears. This effect is 
used by camera operators to help limit which part of a scene the viewer pays attention to. 
Motion lets you simulate that phenomenon, thereby increasing the sense of depth in a 3D 
scene.

Note: The Depth of Field setting in the canvas Render menu is not available in 360° 
projects. For more information on working with 360° media, see Intro to 360° video.
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Every camera in Motion has a focus offset that determines the precise location of perfect 
focus. Stretching away from that point in either direction are near and far focus points, 
which determine the range of the depth of field.
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Turn depth of field on or off in Motion

When depth of field is employed, playback performance may be significantly impacted. To 
alleviate this issue, you can disable the effects of depth of field settings while working on 
other aspects of your project.

Enable or disable depth of field effects
•	 In Motion, click the Render pop-up menu in the upper-right corner of the canvas, then 

choose Depth of Field (or press Control-Option-D).

When a check mark is visible next to the menu item, the effects are rendered. When no 
check mark is visible, all objects remain in focus.

Turn off depth of field in the Inspector
•	 In Motion, select a camera in the Layers list or Timeline, then, in the Camera Inspector, 

set the DOF Blur Amount value (in the Depth of Field section) to 0.

Depth of Field controls in Motion

You can modify a camera’s depth of field parameters in the Camera Inspector:

•	 DOF Blur Amount: A slider to control the maximum amount of blur applied to out-of-
focus objects.

•	 Focus Offset: A slider to set the distance from the camera where objects are in perfect 
focus. 

•	 Near Focus: A slider to set the nearest point of focus, measured in pixels as an offset 
from the focal distance.

•	 Far Focus: A slider to set the farthest point of focus, measured in pixels as an offset 
from the focal distance.

•	 Infinite Focus: A checkbox that sets the far focus to infinity, overriding the setting 
chosen in the Far Focus slider.

•	 Filter: A pop-up menu to set the type of blur algorithm used to render the out-of-focus 
areas. Choices include Gaussian or Defocus. The Defocus setting renders a more 
realistic effect, but may impact performance.

 Tip: For best results, use Gaussian when setting up a scene, and Defocus for final 
output.

•	 Filter Shape: When the Filter pop-up menu is set to Defocus, this pop-up menu lets 
you choose between a disk-shaped, or polygon-shaped render kernel. Different shapes 
produce subtly different blur patterns simulating different types of camera lenses.

•	 Sides: When the Filter Shape pop-up menu is set to Polygon, this slider sets the number 
of sides in the polygon.

•	 Depth: A pop-up menu to set the depth to Radial or Planar. Although Radial typically 
exhibits more realistic results, there are some cases where it may look artificial. These 
include cases where the camera is set to a high DOF Blur Amount, or if the image layer 
is close to the edge of the frame, is very large, is rotated, and so on. In these cases, 
switching to Planar may improve results. 
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Camera behaviors

Add Camera behaviors in Motion
Although most types of behaviors in Motion can be applied to cameras, there is an 
additional set of behaviors specifically designed to be applied to cameras in a 3D project. 
These Camera behaviors create common camera moves such as dollying, panning, and 
zooming without keyframing.

There are six camera-specific behaviors: Dolly, Focus, Framing, Sweep, Zoom In/Out, and 
Zoom Layer. 

Add a Camera behavior
1.	 In Motion, select a scene camera in the Layers list, canvas, or Timeline.

2.	 In the toolbar, click Behaviors, choose Camera, then choose an item from the submenu.

The behavior is applied to the camera object and appears under it in the Layers list and 
Timeline.

Dolly behavior in Motion
The Dolly behavior moves the camera a specified distance along the camera’s Z axis.

After you apply this behavior, the Dolly section of the Behaviors Inspector contains the 
following parameter controls:

•	 Distance: A slider to set the distance of the dolly movement.

•	 Speed: A pop-up menu to set the type of interpolation used for the movement. The 
value can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

The HUD contains the same controls as the Inspector.

Focus behavior in Motion
The Focus behavior animates the camera’s Focus Offset parameter to focus on a target 
object. For more information on camera focus settings, see Intro to depth of field. 

 Tip: Use this behavior to perform a rack-focus effect during a scene.

After you apply this behavior, the Focus section of the Behaviors Inspector contains the 
following parameter controls:

•	 Target: An image well to specify the object upon which the camera will focus. Drag an 
object from the Layers list into the well.

•	 Transition: A slider to set how long it takes for the camera to reach the focus position, 
measured as a percentage of the behavior’s duration.

•	 Speed: A pop-up menu to set the type of interpolation used for the movement. Values 
include Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

The HUD contains the same controls as the Inspector.
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Framing behavior in Motion

The Framing behavior animates the camera along a path to position it in front of a selected 
layer. You can control how the layer fits into the frame at the ending position, and you can 
control the shape of the path to affect the amount of bend or curvature, as well as the apex 
of such a curved path. Other parameters allow you to customize the camera’s orientation 
along the path, the speed at which it travels, and at what point it begins orienting towards 
the target object.

The Framing behavior has handles to allow you to manipulate the path and ending position 
in the canvas. For more information on using the Framing behavior’s handles, see Use 
Framing behavior onscreen controls.

 Tip: Multiple framing behaviors can be arranged consecutively to move a camera from 
one object to another over the course of a scene.

WARNING: Applying a Framing behavior before or after a Basic Motion behavior, such 
as Motion Path or Throw, can create unexpected results. These behaviors can continue 
to affect the object even after the behavior ends. For example, if a Framing behavior is 
applied after a Motion Path behavior is applied, the residual effect of the Motion Path is 
combined with the path generated by the Framing behavior, resulting in the target object 
being framed improperly.

After you apply this behavior, the Framing section of the Behaviors Inspector contains the 
following parameter controls:

•	 Target: An image well to specify the object upon which the camera is framed. Drag an 
object from the Layers list into the well.

•	 Target Face: A pop-up menu to specify which side (face) of the target layer the camera 
points to at the end of the framing behavior. For example, when you choose “Bottom 
(-y),” the camera swoops in from its original position to frame the bottom of the object, 
pointing up along the Y axis.
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•	 Up Vector: A pop-up menu that provides a constraint for the camera to keep it the right 
way up. By default, the camera is upright along the Y axis. When you choose “Target 
+X,” the camera moves from its original position and rotates so that it’s perpendicular 
to the X axis of the target object, making its upright axis +X (the right side of the X 
axis, based on the 0, 0, 0 coordinate system). When you choose “World +X,” the camera 
moves from its original position and rotates so that it is perpendicular to the +X axis of 
the 3D space (rather than the axis of the target layer). When you choose “Auto,” Motion 
tries to guess the upright axis.

For more information on coordinates, see Intro to 3D compositing.

•	 Framing: A pop-up menu to specify how the target should be framed. The menu choices 
include the following:

•	 Fit Horizontally: Positions the camera so the full width of the target fits in the width 
of the frame.

•	 Fit Vertically: Positions the camera so the full height of the target fits in the height of 
the frame.

•	 Fit Both: Positions the camera so both width and height of the target fit in the frame.

•	 Simple Fit: Positions the camera so both width and height of the project fit in the 
frame. If the target object is larger or smaller than the project dimensions, it may not 
properly fill the frame.

•	 Custom Fit: This option appears when you modify the Framing Offset parameter 
(described below). 

•	 Framing Offset: Three value sliders (X, Y, and, when expanded, Z) to offset (in pixels) 
the point on the target that is centered, relative to the camera. By adjusting Framing 
Offset, you can target a point other than the center of the object. The Z slider moves 
the camera nearer to or farther from the target.

•	 Offset Path Apex: A slider to set the position along the path (from the original position 
to the framing position) where the bend (if any) occurs if the user chooses to offset the 
path. Offset Path Apex is expressed as a value between 0 and 1 (0 being at the start of 
the path, 1 being the end, and 0.5 being halfway along the path).

•	 Path Offset: Three value sliders (X, Y, and, when expanded, Z) to offset the camera’s 
position from the path, measured in pixels.

•	 Orientation: A pop-up menu to set whether the camera is oriented towards the target 
at every frame (Orient to Current) or oriented towards the target at its final position 
(Orient to Final).

•	 Position Transition Time: A slider to set how long it takes the camera to reach the 
framing position, measured as a percentage of the behavior’s duration.

•	 Rotation Transition Time: A slider to set how long it takes the camera to reach the 
framing orientation, measured as a percentage of the behavior’s duration.
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•	 Transition: A pop-up menu to set the speed of the transition. Choices include Constant, 
Ease In, Ease Out, Ease Both, Accelerate, or Decelerate. 

•	 Ease Out Time: A slider to set the percentage of the behavior’s duration when the ease-
out effect starts. The ease out ramps down the behavior’s effect until the end of the 
behavior.

•	 Ease Out Curve: A slider that sets the rate of the ease-out effect.

The HUD contains a subset of the controls in the Inspector.

Use Framing behavior onscreen controls in Motion

When you select a Framing behavior in the Layers list, onscreen controls become available 
in the canvas, allowing you to create a custom framing size and shape, and to visually 
adjust the Framing Offset and Offset Path Apex parameters.

Note: To use the Framing behavior onscreen controls, you must first assign a layer to the 
Target image well in the Behaviors Inspector.

Target a point other than the center of the layer
By default, the Framing behavior targets the center of the layer. You can instruct the 
camera to frame another area of the target layer using the Framing Offset parameter’s 
onscreen controls.

1.	 In Motion, click the Camera pop-up menu in the upper-left corner of the canvas, then 
choose Perspective.

2.	 Select a framing behavior in the Layers list or Timeline.

In the canvas, a white rectangle with four corner handles appears. This rectangle is the 
Framing Offset parameter onscreen control.

3.	 Do one of the following:

•	 Drag any of the four corner handles to adjust the Z value.

Note: Because the onscreen controls may be imprecise, use the value sliders in the 
Behaviors Inspector to limit value changes to the Z axis alone.

•	 Drag inside the white rectangle to adjust the X or Y values.
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Set the location of the camera motion path apex
If the Framing behavior settings create a curved camera motion path, you can adjust the 
vertex (the highest point of the curve) using the Offset Path Apex parameter’s onscreen 
control.

1.	 In Motion, click the Camera pop-up menu in the upper-left corner of the canvas, then 
choose Perspective.

2.	 With the Framing behavior selected, drag the Offset Path Apex (the small white box) 
along the white line that connects the red curved motion path to reposition the apex.

 Tip: If you don’t see the small white box, drag over the dolly tool (in the top-left 
corner of the canvas) to zoom out a bit.

Offset the camera motion path
You can offset the camera’s motion path that is created by the Framing behavior using the 
Path Offset parameter’s onscreen controls.

1.	 In Motion, click the Camera pop-up menu in the upper-left corner of the canvas, then 
choose Perspective.

2.	 With the Framing behavior selected, do one of the following:

•	 Drag the green arrow to adjust the path along the Y axis.

•	 Drag the red arrow to adjust the path along the X axis.

•	 Drag the blue arrow to adjust the path along the Z axis.

•	 Drag inside the white circle (where the color circles meet) to adjust the path along all 
three axes simultaneously.

Note: If the transform controls (color arrows) appear within the framing onscreen 
controls in the canvas, the framing is adjusted rather than the camera motion path. If 
this occurs, orbit the camera view so that the transform controls are offset from the 
framing control.

For more information on the 3D transform controls, see Transform layers in 3D 
space.
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Sweep behavior in Motion

The Sweep behavior pivots the camera across a specified arc.

After you apply this behavior, the Sweep section of the Behaviors Inspector contains the 
following parameter controls:

•	 Start: A dial to set the camera’s starting angle relative to its current orientation. A 
nonzero value causes the camera to jump to this value at the start of the behavior.

•	 End: A dial to set the camera’s final angle relative to its Start parameter value.

•	 Speed: A pop-up menu to set the type of interpolation used for the rotation. The value 
can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

•	 Axis: A pop-up menu to set the axis around which the sweep occurs. Value can be set to 
Tilt X, Swivel Y, or Roll Z.

The HUD contains the same controls as the Inspector.

Zoom In/Out behavior in Motion

The Zoom In/Out behavior animates the camera’s Angle of View parameter.

After you apply this behavior, the Zoom In/Out section of the Behaviors Inspector contains 
the following parameter controls:

•	 Zoom: A slider to set a proportional value to modify the camera’s Angle of View 
parameter. For more information about the Angle of View parameter, see Camera 
controls.

•	 Speed: A pop-up menu to set the type of interpolation for the movement. The value can 
be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

The HUD contains the same controls as the Inspector.

Zoom Layer behavior in Motion

The Zoom Layer behavior moves a camera to the position of a target object’s anchor point. 
When the camera reaches the object’s anchor point, the angle of view changes while 
offsetting the camera’s position based on the Zoom parameter. (This parameter is set to 0 
by default so no animation of the Angle of View occurs.) 

This behavior also lets you animate the camera’s Angle of View during the camera’s 
movement, based on the behavior’s Transition value. For more information about the Angle 
of View parameter, see Camera controls.

After you apply this behavior, the Zoom Layer section of the Behaviors Inspector contains 
the following parameter controls:

•	 Object: An image well to set the target of the camera’s movement. Drag an object from 
the Layers list into the well.

•	 Transition: A slider to specify how far into the behavior the camera stops moving and 
the camera’s Angle of View parameter begins to animate instead.
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If Transition is set to 50% in a Zoom Layer behavior that has a length of 300 frames, 
the camera move takes 150 frames to arrive at the position of the target object and 
then stops moving for the duration of the behavior, and the camera’s Angle of View 
parameter animates over the rest of the duration. If Transition is set to 100%, the 
camera move takes the full 300 frames to arrive at the position of the target object, and 
the camera’s angle of view does not animate. If the Zoom Layer behavior’s duration is 
100 frames and Transition is set to 50%, the camera move takes 50 frames to arrive at 
the position of the target object.

•	 Speed: A pop-up menu to set the type of interpolation used for the rotation. The value 
can be set to Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate.

•	 Zoom: A slider to set a proportional value to modify the camera’s Angle of View 
parameter. A nonzero value determines how much the angle of view (and thus 
perspective) changes relative to the camera’s initial angle of view. A zero value for 
Zoom leaves the Angle of View parameter unchanged.

The HUD contains the same controls as the Inspector.

Lighting

Intro to 3D lighting in Motion
You can apply lighting to a motion graphics project to enhance the depth and scope of 
compositions, and to help create realistic environments for composites. Although light 
sources are not visible, you can simulate a visible light source by combining a point light 
with an image or shape, as shown in the example below.

 Tip: Use the Match Move behavior to move a simulated light source with a light in a 
video clip. For more information on the Match Move behavior, see Match move an object.

Motion’s lighting system works only on 3D groups (and the layers and groups nested 
within them). When you add lights to a scene, two groups of properties contribute to the 
appearance of lights: 

•	 Light properties: You can adjust the quality of a light itself by selecting a light object in 
your project, then modifying its parameters in the Light Inspector. 

•	 Object lighting properties: You can adjust how an image layer in your project (a still 
image, video clip, shape, and so on) receives light cast by light objects by selecting the 
layer, then adjusting Lighting parameters in the Properties Inspector. 
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You can manipulate any of the following light properties: type of light, intensity, and color. 
A light bulb, the sun, and lighting in a dance club have different appearances. You can use 
lighting properties to simulate these differences. You can use multiple lights to mix color. 
If one red and one blue spot light are pointed at a white object, they mix to make magenta. 
Each type of light has its own attributes. It may take a combination of light types to achieve 
a specific effect. For example, you might want to combine a dim ambient light with a spot 
light to add depth or prevent total darkness where the spot light’s effect drops off.

Add lights in Motion
You can add a lights to your project one at a time, or you can add sets of lights that have 
been predesigned to create specific lighting styles.

Add a light to a project
1.	 In Motion, do one of the following:

•	 In the toolbar, click Add Object, then choose Light from the pop-up menu.

•	 Choose Object > New Light (or press Shift-Command-L).

If your project contains no existing 3D groups, the following dialog appears:

If your project already contains at least one 3D group, go to step 3.

If you select Keep as 2D, a light will have no effect until you create at least one 3D 
group at the root level (not a 3D group nested within a 2D group).

2.	 Click Switch to 3D.

A light object is added to the Layers list, canvas (represented there by a wireframe 
icon), and Timeline; the 3D Transform tool in the canvas toolbar becomes active; and 
the Light Inspector opens.

3.	 Adjust the light in the Light Inspector.

Add a preset lighting style
You can add a group of lights all at once by selecting one of Motion’s preset lighting styles.

1.	 In Motion, do one of the following:

•	 Click Add Object in the toolbar, choose New Light Setup, then choose one of the 
preset lighting styles.

•	 Choose Object > New Light Setup and choose one of the preset lighting styles.
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2.	 If a dialog appears stating that you have no 3D groups in the project, click Switch to 3D.

A new group containing lights is added to the project. The number and types of lights 
varies depending on the preset style you chose.

3.	 Make any adjustments to the newly added lights to customize them for your scene. 

Note: Choosing a new light setup does not remove or replace any lights that are already 
in the project.

 Tip: If you’re using 3D text, turn off any lighting effects before adding scene lights 
to avoid unexpected or conflicting results. See Adjust 3D text lighting.

Disable rendering of lighting
Lighting effects can significantly impact playback performance. You can temporarily 
disable lighting to improve playback speed while working on other aspects of your project.

•	 In Motion, click the Render pop-up menu in the top-right corner of the canvas, then 
choose Lighting (or press Option-L).

3D Light controls in Motion
When you create a light, or select a light object in the Layers list, the Light Inspector 
opens. In the Light Inspector, you can adjust the following parameters:

•	 Light Type: A pop-up menu to specify any of four light types:

•	 Ambient: Emits light in all directions, illuminating all objects in the scene from all 
directions equally. This type of light has no position and no representation in the 
canvas. The most common use for ambient lights is to add an overall fill effect or 
color cast.

Note: There’s no global ambience property in Motion, so you may have to add an 
ambient light to prevent total blackness.

•	 Directional: Emits parallel rays of light in a specified direction from a source located 
at an infinite distance. Rotate the directional light icon (a wireframe cylinder with one 
end removed) in the canvas to change the direction in which the light is cast. The 
circle represents the back of the light, and the lines indicate the direction the light is 
traveling.
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•	 Point: Emits light outward from a single point in 3D space in all directions. Optionally, 
you can add falloff based on an object’s proximity to the light. This is the default 
light in Motion, and it produces results similar to that of an incandescent light bulb.

•	 Spot: Emits light from a conical light source and casts an elliptical pattern on objects 
hit by the light. Using a spot light allows for a high degree of accuracy when you 
need to limit the area affected by the light.

•	 Color: A standard set of controls to select the color of the light.

•	 Intensity: A slider that acts as a dimmer switch for lighting. If you use a Directional light 
at 100% intensity pointed straight at a red object, the object looks red. If you lower the 
intensity, the object and scene get darker. However, if you increase the intensity above 
100% you may begin to overexpose your scene, eventually causing the object to appear 
white. The Intensity value slider ranges from 0 and 400, but there’s no upper limit for 
Intensity (use the adjacent value slider to set a value above 400).

Note: Multiple lights interacting with an object combine to increase the object’s 
apparent brightness as they would in the real world. If you have two spot lights 
overlapping in space and pointing in the same direction with Intensity set to 100%, you 
see the same result as having a single spot light with its Intensity set to 200%.

•	 Falloff Start: A slider to adjust where the falloff point of a light begins. In the real 
world, light falls off—or has less of an effect—as the distance from the light source 
increases. Usually, falloff starts at the center of the light object. Setting Falloff Start 
adds additional control to your lighting. This parameter applies to light types that use a 
Position parameter (Point and Spot).
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In the example below, a light is positioned slightly above the origin of the scene. There 
are three rings of cards at a distance of 200, 500, and 1000 units from the light. (In 
this example, a visible light source—the bulb at the center of the rings of cards—is 
simulated for illustrative purposes.) The light’s Intensity is set to 100% and Falloff is set 
to 10%. When Falloff Start is set to 0 (left, below), the light begins to fall off by the time 
it hits the innermost ring. When Falloff Start is set to 200 (right, below), the inner ring is 
lit at 100% intensity and the outer rings are slightly brighter than before.

When Falloff Start is increased to 500 (left, below), the inner and middle rings are lit at 
100% intensity, and the outer ring is brighter than before. Finally, when Falloff Start is 
set to 1000 (right, below), all rings are lit at 100% intensity.

In the next example, the image on the left contains a light with Intensity set to 100%, 
while the image on the right has a light Intensity of 500%. In the image on the right, 
the outer rings are slightly brighter, but the innermost ring is overexposed. If the 
Falloff Start of the light in the image on the right is increased to 1000, the rings are 
overexposed.
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•	 Falloff: A slider to control the rate of falloff for a point or spot light based on the Falloff 
Start setting. At low values, light falls off over a long distance from the light source; 
therefore, the light travels farther in the image. At high values, the falloff occurs more 
rapidly.

•	 Diameter: A slider that becomes available when Light Type is set to Directional, Point, or 
Spot. Diameter affects how lights are reflected as highlights in 3D text objects.

•	 Cone Angle: A dial that becomes available only when Light Type is set to Spot. The 
cone angle is measured from the center of the light outward and can be set to a value 
between 0 and 90 degrees. The distance of the light from its target affects the result 
of this parameter. If the light is close, a wider spot cone angle may be needed to light 
more of the object. If the light is farther away, a lower cone angle may be needed to 
isolate objects.

•	 Soft Edge: A dial that becomes available only when Light Type is set to Spot. Like Cone 
Angle, this parameter can be set to a value between 0 and 90 degrees. Its starting point 
begins at the outer edge of the cone angle. If set to 0, spot lights have a hard edge. Low 
values produce a slight softening effect to the boundary of the lit area. Higher values 
produce a wide, more natural fade. Adding softness expands the area of your light, so 
you might need to adjust the angle to achieve a specific effect.

Note: Point lights, directional lights, and spot lights also contain a set of parameters to 
control how they cast shadows. For more information on these parameters, see Intro to 
3D shadows.

The Light HUD contains the Light Type, Color, Intensity, Falloff Start, and Falloff 
parameters, which are also available in the Inspector. The Light HUD also contains 3D 
transform controls. See Transform layers in 3D space.

Additional lighting controls in Motion
Layers and groups have properties that control how they react to lights in a scene. When 
layer or group is selected, you can adjust these parameters in the Lighting section of 
the Properties Inspector. Groups have a single Shading parameter. Layers have Shading, 
Highlights, Shininess, and Diameter parameters.

•	 Shading: A pop-up menu to set how an object responds to lights in the scene. If set to 
On, the object can be lit. If set to Off, the object ignores scene lights. If set to Inherited 
(the default), the object uses the Shading value of its parent.

Note: When a layer or group is nested in one or more parent groups, setting its Shading 
parameter to On overrides any Shading parameter settings applied to the parent 
groups.

•	 Highlights: A checkbox to control whether lit objects show highlights. This parameter 
has no effect if Shading is set to Off. Click the disclosure triangle to reveal an additional 
Shininess parameter.

•	 Shininess: A slider to set how strong an object’s highlights appear. Higher values 
create a glossier appearance. This Shininess parameter is disabled when the Highlights 
parameter is deselected.

Note: The Highlights and Shininess parameters are not available for 3D text or 3D 
objects.
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Shadows

Intro to 3D shadows in Motion
Motion projects that include point lights or spot lights can create more natural, realistic 
effects by casting shadows. Shadows are created when an opaque or semi-opaque object 
(a layer or group) blocks light from hitting another object. To see a shadow in Motion, you 
need at least three things: A shadow-casting light source, an object to cast a shadow, and 
another object upon which the shadow is cast. Multiple lights cast multiple shadows that 
may or may not be visible depending on the relative positions and settings of the objects in 
the scene.

Note: Ambient lights do not cast shadows.

In Motion, you can control whether a light source creates shadows and whether each 
object in the scene receives shadows or casts shadows (or both). You can even have an 
invisible object cast a shadow. The strength, sharpness, shape, and position of the shadow 
depends on the type and positions of the lights and relative position of all three objects.

WARNING: Some changes you make to 3D objects cause shadows to disappear. This 
occurs when the change causes rasterization of the 3D object—adjusting the opacity of 
a group or turning on the glow attributes for a text layer, for example. Flattening the 3D 
group allows it to cast shadows again. For more information about disappearing shadows, 
see How rasterization affects shadows. 

Cast shadows versus drop shadows
There are two common types of shadow effects used in motion graphics work: drop 
shadows and cast shadows. Motion can create both effects, but because they have 
different purposes and applications, it may be helpful to consider the differences between 
them. 

Cast and drop shadows simulate the effect of light blocked by an opaque object. But a cast 
shadow is a 3D effect requiring a light source and an object for the shadow to fall upon, 
whereas a drop shadow is a 2D effect simulating a cast shadow without a light source and 
therefore is limited to a very small range of settings.
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Drop shadows are commonly used to simulate depth and separate foreground objects 
from the background in 2D projects. The classic drop shadow effect is used on light-color 
titles so the text is legible against dark and light backgrounds. In a drop shadow effect, the 
imaginary light source does not create any shading effect on the surface of the object, and 
the shadow’s position is set at a fixed direction. A drop shadow is rendered as a part of the 
foreground object, so it doesn’t interact with background objects. However, because it is 
an effect, its appearance can be customized. The softness, opacity, position, and color can 
be adjusted and animated without having to manipulate a light source. 

Cast shadows are true 3D effects, and their appearance is determined by the light source 
and the other objects in the scene. Multiple cast shadows interact with each other and take 
their shapes based on the surfaces and positions of the objects upon which they are cast.

This section addresses cast shadow effects. For information on drop shadows, see Add a 
drop shadow to a layer.

Cast a 3D shadow in Motion
Shadows are controlled in the Light Inspector. To improve performance, you can 
temporarily turn off the rendering of shadows in the canvas.

Cast a shadow
•	 In the Motion canvas or Layers list, select the light, then select the Shadows activation 

checkbox in the Light Inspector.

Note: To cast a shadow, the light must be offset from the object casting the shadow, 
and the object casting the shadow needs to be offset from the layer receiving its 
shadow.

Disable rendering of shadows
Rendering shadows can significantly impact playback performance. You can temporarily 
disable shadows to improve playback speed while working on other aspects of your 
project.

•	 In Motion, click the Render pop-up menu above the canvas, then choose Shadows (or 
press Control-Option-S).
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3D shadow controls in Motion
Shadows are controlled by adjusting settings in two places:

•	 Shadows section in the Light Inspector: Use these parameter controls to set the shadow 
properties of point lights and spot lights. 

•	 Shadows section in the Properties Inspector: Use these parameter controls to set the 
casting and receiving properties of layers.

Note: 2D groups at the root level of the project (not nested in other groups) do not have 
lighting or shadow controls. To enable shadows on such a group, convert it to 3D or embed 
it in another 3D group.

Shadows controls in the Light Inspector
•	 Shadows: A checkbox to turn on Shadows controls. The Shadows checkbox lets you set 

some lights to cast shadows, and others not to cast shadows.

Selecting this checkbox causes the light to cast shadows on objects in front of it if 
the objects also have shadow controls enabled. Deselecting it prevents the light from 
generating shadows, regardless of settings of individual objects. 

•	 Opacity: A slider to control the apparent opacity of the shadow.

•	 Softness: A slider to specify how blurry a shadow will appear. 

Note: The appearance of a shadow depends on the rendering quality of the object 
casting it. Because a shadow may be larger than the original object, you may see some 
jagged edges or aliasing on the shadow. If you see such artifacts, check how your 
image looks when the project is set to Best quality, rather than Draft or Normal. For 
more information about canvas display quality, see Custom canvas view options.

•	 Uniform Softness: A checkbox to constrain the results of the softness slider to a 
uniform amount of blur on the shadow regardless of distance between the light, the 
object casting the shadow, and the object receiving the shadow.

By deselecting the checkbox, you enable nonuniform softness, so that when objects are 
farther from each other, more blur is applied.
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Note: Enabling nonuniform softness can impact playback performance.

Note: Intersecting objects reveal an unnatural effect of using uniform softness. Because 
an equal amount of blur is applied to the entire shadow, the blur appears to spill out 
in front of the intersecting object, creating a strange appearance. This effect can be 
eliminated in either of two ways: by deselecting the Uniform Softness checkbox or 
by setting the object to not receive shadows (by deselecting the Receive Shadows 
checkbox in the Properties Inspector).

•	 Color: Standard color controls to set the color of the shadow. Although semitransparent 
objects cast lighter shadows than opaque objects, you cannot create light transmission 
effects wherein a semitransparent object projects some of its own color onto another 
object, as stained glass does. For more information on using the color controls, see Use 
basic color controls.

Note: When Shadows are enabled for point lights, spot lights, and directional lights, 
Motion uses the multiply compositing mode to blend shadows with the objects upon 
which they’re cast. This means that the result is a darkening effect, regardless of the 
color of the shadow. If you select a shadow color lighter than the background upon 
which it is cast, the shadow may not be visible. So, for example, when Shadows are 
enabled for a light, it’s not possible to cast a white shadow on a dark surface. To 
override this effect, you must disable the Shadows parameter for the light. For more 
details, see Shadows without lights.
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Shadows controls in the Properties Inspector
Every layer in a 3D group has Shadows controls in its Properties Inspector. This includes 
shapes, video clips, particles, and so on. Lights, Cameras, and 2D groups at the root level 
of the project (not nested in another group) do not have Shadows controls. 

•	 Cast Shadows: A checkbox to set whether a layer casts a shadow if it lies between a 
light source and another layer.

•	 Receive Shadows: A checkbox to control whether other layers cast shadows on the 
currently selected layer. The following image depicts an object (the white ring) with the 
Receive Shadow checkbox selected and the Casts Shadow checkbox deselected.

•	 Shadows Only: A checkbox that allows an object to block light and cast a shadow, while 
the object itself does not appear in the scene. 

You can select both Receive Shadows and Shadows Only, which makes the object 
invisible except for the regions where a shadow is cast upon it.
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How shadows interact with 3D layers in Motion
When using shadows with layers such as particle systems, text objects, or replicators 
that are set to 3D, shadows are cast from one part of the object onto another part. This is 
called self-shadowing.

Modifying the object in a way that causes rasterization prevents shadows from displaying.

In some cases you may be able to find another way to perform the effect that does not 
require rasterization. For example, in the following images, rather than modifying the 
opacity of the particle emitter, which causes rasterization, you can modify the opacity of 
the particle cells and maintain the shadows.

In the second image above, rasterization interferes with the depth order of the particle 
system, and particles appear in front of the letter A. In the third image, no rasterization 
occurs, and particles appear in their proper depth order, in front of and behind the letter A. 
See How rasterization affects shadows.
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Shadows without lights in Motion
Lighting and shadows can each be disabled independently. You can keep shadows visible, 
even when lighting is disabled, allowing you to keep the original unshaded look of the 
scene. Turning off lighting also changes the way shadows are rendered.

When shading (the visible effect of lighting) is disabled, shadows behave differently. 
Rather than being multiplied with the object upon which they are cast, the shadow’s color 
and opacity are controlled only by the Shadows settings in the Light Inspector.

This allows you to create shadows of any color or opacity, from traditional dark shadows to 
bright color shadows or even white shadows.

You can disable shading globally in the View menu (choose View > Render Options > 
Lighting to remove the checkmark from the menu item) or in the Render pop-up menu 
above the canvas (choose Lighting to remove the checkmark from the menu item). You can 
also disable shading for a specific layer by setting the Shading parameter in the Properties 
Inspector to Off.
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With spot lights, enabling shadows but disabling shading can create a seemingly strange 
result where the shadow is suddenly cut off because it has exceeded the scope of the light 
cone. Because the shading effect of the light cone is turned off, the shadow edge looks 
unnatural.

To correct such an occurrence, increase the Cone Angle parameter in the Light Inspector.

Reflections

Cast a reflection in Motion
In the real world, all objects exhibit some degree of reflectivity based on surface shine, 
brightness, angle of view, and proximity to reflected objects. Motion simulates this natural 
effect, equipping every object with a set of parameters to create and control realistic-
looking reflections. When reflections are enabled for a layer, all other layers in the project 
are reflected but may only be visible from specific angles and distances.

In Motion, reflections are controlled in the Properties Inspector. To improve performance, 
you can temporarily turn off the rendering of reflections in the canvas.

Cast a reflection
•	 In Motion, select the layer to receive the reflection, then select the Reflection activation 

checkbox in the Properties Inspector.

Note: To cast reflections, layers must be offset from each other (for example, X rotation 
or Z position).

Disable rendering of reflections
Rendering reflections can significantly impact playback performance. You can temporarily 
disable reflections to improve playback speed while working on other aspects of your project.

•	 In Motion, click the Render pop-up menu above the canvas, then choose Reflections (or 
press Control-Option-R).
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Reflection controls in Motion
Reflections are controlled by adjusting settings in the Reflection section and Blending 
section of Properties Inspector:

Reflection section controls
•	 Reflection: An activation checkbox that enables reflections based on the settings of the 

parameters in the object (a layer or group).

•	 Reflectivity: A slider that controls how shiny the object’s surface appears. 0% indicates 
no reflectivity, while 100% is perfectly reflective, like a mirror.

•	 Blur Amount: A slider that controls whether real reflections appear in sharp focus or 
quite blurry, depending on the surface quality of the reflecting object.

•	 Falloff: A checkbox that determines whether the reflection fades with distance from the 
object, producing a more realistic result.

When the Falloff checkbox is selected, additional controls become available. Click the 
disclosure triangle beside the Falloff checkbox to reveal these controls:

•	 Begin Distance: A slider that determines the distance (inside the reflection) where 
the falloff begins. When the slider is set to 0, falloff starts at the reflection plane.

•	 End Distance: A slider that determines the distance where the falloff ends, beyond 
which the reflection isn’t visible. Adjusting this slider moves the falloff point closer 
to the reflection plane, which causes less of the reflected image to appear.

•	 Exponent: A slider that controls how quickly a reflection gets fainter as the reflected 
object gets farther from the reflective surface.

•	 Blend Mode: A pop-up menu that sets the blend mode used for the reflection. Blend 
modes other than Add are useful for achieving different looks, even if they aren’t 
physically intuitive. For more information about blend modes, see Intro to layer 
blending.

Note: The Reflection parameter is not available for 3D text and 3D objects.
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Blending section controls
•	 Casts Reflection: The Properties Inspector of every layer or group also contains a Casts 

Reflection pop-up menu (in the Blending section) that controls whether an object is 
reflective. There are three options:

•	 Yes: The object is reflected in nearby reflective objects.

•	 No: The object is ignored by reflective surfaces.

•	 Reflection Only: The object becomes invisible, but appears in reflective surfaces 
around it.

How groups affect reflections in Motion
In addition to choosing reflection settings for individual layers, you can adjust settings for 
an entire group. Reflection settings (in the Properties Inspector) for a group override the 
settings of individual layers in the group. For example, if a layer in a group is not set to 
receive reflections, turning that setting on for the whole group forces the individual layer 
to receive them. Turning off the setting for the group allows the layer’s settings to act as 
expected.

Cast Reflection settings (in the Properties Inspector) work differently. If the group is set to 
cast reflections, individual objects’ reflections can still be turned off (or set to Reflection 
Only). However, if the group is set to not cast reflections at all, individual objects never 
cast a reflection, regardless of their setting.

For more information about the Reflection settings and Cast Reflection settings in the 
Properties Inspector, see Reflection controls.
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Limit recursive reflections in Motion
When a reflective object (layer or group) is reflected in another object, the first object can 
be seen in the reflection, potentially causing an endless repetition of reflections. Motion 
limits the number of reflective bounces that can occur in a scene, preserving performance 
and preventing the viewer from getting lost in infinity. The number of allowed reflections is 
set per project.

Limit the number of recursive reflections in a project
1.	 In Motion, choose Edit > Project Properties (or press Command-J).

The Properties Inspector for the project opens.

2.	 In the Reflections section, adjust the Maximum Bounces slider.
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Manage timing

Intro to the Timeline in Motion
The Timeline is where you control all timing aspects of a project. You can set the frames 
where objects begin and end, align multiple effects so they occur simultaneously, control 
object duration, and even perform common trim operations to edit the objects as you 
would in a nonlinear video-editing application. The Timeline is located under the timing 
toolbar, in the Timing pane.

The Timeline consists of three areas: 

•	 Timeline layers list: On the left side of the Timing pane, this area displays a hierarchical 
list of objects (layers, groups, and effects objects) in your project, mirroring the 
contents of the Layers list in the Project pane. You can add media to your project by 
dragging it into the Timeline layers list. 

•	 Timeline track area: On the right side of the Timing pane, this area displays color bars 
(timebars) that correspond to the object names in the Timeline layers list; the length of 
each timebar represents the duration of each object over the course of your project. 
You can adjust timing and synchronization by edit by moving, trimming, or slipping 
timebars in the track area.

•	 Timeline ruler: Above the track area, this numbered strip measures the timing of objects 
in frames. Here, you can drag the playhead to navigate through your project as well as 
perform various timing tasks. 

In addition to the Timeline, the Timing pane contains two related partitions that can be 
shown or hidden: the Audio Timeline and the Keyframe Editor.
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Display of the Timing pane is controlled by three buttons in timing toolbar: the Show/Hide 
Timeline button, Show/Hide Audio Timeline button, and Show/Hide Keyframe Editor button.

A mini-Timeline, located at the bottom of the canvas, provides controls to perform quick 
edits such as moving, trimming, and slipping without opening the Timing pane. See Edit in 
the mini-Timeline.

 Tip: You can show the Timeline on a second display, providing a larger workspace for 
manipulating the timing of objects. See Use a second display.

Display or resize the Timing pane in Motion
Show or hide the Timing pane
In Motion, do one of the following:

•	 Choose Window > Video Timeline (or press Command-7).

•	 Click the Show/Hide Timeline button in the timing toolbar.

Note: To collapse the entire Timing pane (Timeline, Audio Timeline, and Keyframe 
Editor), make sure that all three buttons in the lower-right corner of the Motion project 
window are dimmed.

Resize the Timing pane
In Motion, do one of the following:

•	 Drag the timing toolbar (the lighter gray toolbar just above the Timing pane) up or down.

•	 Drag the boundary (the dark line) between the Library or Inspector and the Timing pane 
to the left or right.

•	 Deselect both the Library button and the Inspector button in the top-left corner of the 
Motion window.
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Add objects to the Timeline

Intro to adding objects to the Motion Timeline
Just as you can drag objects (media and effects) to the Layers list or canvas, you can drag 
objects to the Timeline. There are two ways to do this:

•	 Add media to the Timeline layers list. This method is identical to the workflow for 
dragging media to the Layers list in Project pane.

•	 Add media and effects objects to the Timeline track area. With this method, you can 
control how media is added to the project—inserted, exchanged with existing media, 
and so on—with a series of drop menu commands. 

Additionally, you can set drag-and-drop preferences to customize how and where objects 
are placed the Timeline. 

Drag to the Timeline layers list in Motion
Just as you can add media to the Layers list, you can drag media into the Timeline layers 
list. When you do so, a layer is added to the Timeline layers list (and also to the Layers list, 
and canvas), and a corresponding timebar appears in the track area.

Library effects (behaviors, filters, and so on) can also be dragged into the Timeline layers 
list. However, because effects objects are applied to media layers (images, video, audio, 
and so on), they cannot be grouped by themselves.

Note: You can also drag images and clips to the Timeline track area. See Drag to the 
Timeline track area.

Add a layer to a group
1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears to the 
Timeline layers list (but don’t release the mouse button yet).

•	 Drag a media item from the Library or Media list to the Timeline layers list (but don’t 
release the mouse button yet).

2.	 Do any of the following:

•	 Add the item as the topmost layer in a group: As you drag, position the pointer over 
a group, and when the group is highlighted, release the mouse button.

•	 Add the item between two existing layers: As you drag, position the pointer between 
two layers, and when a blue position indicator appears, release the mouse button.

•	 Replace an existing image layer: As you drag, position the pointer over an existing 
layer, and when the pointer becomes a curved arrow, release the mouse button. 

The new layer is added to the Timeline layers list, Layers list and canvas.

Note: If the media item is a clip with multiple audio tracks, a drop menu will appear, 
allowing you to choose between mixing down the multiple tracks to stereo or importing 
audio tracks individually. See Add audio files.
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Add a layer to a new group between existing groups
1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears to the 
Timeline layers list between two existing groups.

•	 Drag a media item from the Library or Media list to the Timeline layers list to the 
Timeline layers list between two existing groups.

2.	 When the position indicator appears, release the mouse button.

A new group containing the new layer is created between the existing groups.

Note: Adding 360° video this way places the footage in a standard group rather than in a 
360° environment. See Add 360° video to a project.

Create a group above existing groups
1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears to the 
Timeline layers list, below the lower edge of the bottom layer.

•	 Drag a media item from the Library or Media list to the Timeline layers list to the 
Timeline layers list, below the lower edge of the bottom layer.

2.	 Release the mouse button.

A new group is created above the other existing groups in the hierarchy of groups and 
layers.

Note: Adding 360° video this way places the footage in a standard group rather than in a 
360° environment. See Add 360° video to a project.

Drag to the Timeline track area in Motion
When you drag a media item into the Timeline track area, a drop menu appears with 
options for how the new layer should be incorporated. Depending on where in the track 
area you drop the item, the menu displays different options: Composite, Insert, Overwrite, 
or Exchange.

You can also drag effects objects (behaviors, filters, and so on) from the Library into the 
Timeline track area. However, because effects objects (such as filters) are applied to media 
layers, they can’t be added as standalone objects.

Note: If you release the mouse button before the drop menu appears, the item is added as 
a composite edit—above the other tracks in the Timeline and on top of other layers in the 
canvas.
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Add a layer to a new Timeline track
To add a layer to a new Timeline track without modifying any other layer in your project, 
use the Composite edit. The Composite edit places the layer in the track above the one you 
drag to.

1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears to the 
Timeline track area.

•	 Drag a media item from the Library or Media list to the Timeline layers list to the 
Timeline track area.

As you drag, a tooltip appears at the pointer, indicating the current frame number.

2.	 When you reach the frame where you want the new layer to start, position the pointer 
over the layer you want as a background, and continue holding down the mouse button 
until the drop menu appears.

3.	 Choose Composite from the drop menu.

The new layer is composited into the project above the layer you dragged to.
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Insert a layer, splitting an existing layer
To insert a layer into a new Timeline track and split an existing layer at the insertion point, 
moving it forward in time to make room for the new layer, use the Insert command. For 
example, if you insert a 100-frame movie into a group containing an existing layer, the 
new movie is added to the Timeline at the frame where you drop it, pushing the remaining 
frames of the original movie out 100 frames.

If you insert a new item midway through an existing layer, the existing layer is split into two 
layers, each on its own track.

1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears to an 
existing bar in the Timeline track area.

•	 Drag a media item from the Library or Media list to an existing bar in the Timeline 
track area.

As you drag, a tooltip appears at the pointer, indicating the current frame number.

2.	 Continue dragging to the frame where you want the new layer to start, holding down the 
mouse button until the drop menu appears.

3.	 Choose Insert from the drop menu.

The new layer is inserted into the track, breaking the original bar into two, and pushing the 
frames after the insertion farther out in time.
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Replace an existing layer with a new layer
To replace an existing layer with a new layer in the Timeline, use the Overwrite command.

If the new layer is shorter than the one currently in the group, the Overwrite option splits 
the duration of the existing layer and deletes only the frames where the new layer appears.

1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears onto 
a bar in the Timeline track area.

•	 Drag a media item from the Library or Media list onto a bar in the Timeline track area.

As you drag, a tooltip appears at the pointer, indicating the current frame number.

2.	 Drag to the frame where you want the new layer to start, holding down the mouse 
button until the drop menu appears.

3.	 Choose Overwrite from the drop menu.

The frames of the new layer replace the frames of the original layer. If the original layer 
contained more frames than the new one, the old layer is split into two layers and the 
additional frames remain.

Replace an existing layer with a layer of the same duration
To replace an existing layer with a layer of the same duration, use the Exchange command. 
The Exchange command is a variant of the Overwrite option, but instead of dropping the 
entire duration of the new layer into the project, the duration of the existing layer is used. 
For example, if you drag a 30-second clip over a 5-second clip, choosing Exchange swaps 
the existing 5 seconds with the first 5 seconds of the longer clip. If you exchange a longer 
clip with a shorter one—for example, swapping a 10-second clip with one that lasts only 5 
seconds—the first 5 seconds are replaced, and the final 5 seconds of the original remain.

The exchange edit transfers any filters, behaviors, and keyframes from the original layer 
onto the new layer.
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Note: You cannot use the Exchange command with audio files.

1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a media file from the dialog that appears onto 
a bar in the Timeline track area.

•	 Drag a media item from the Library or Media list onto a bar in the Timeline track area.

As you drag, a tooltip appears at the pointer, indicating the current frame number.

2.	 Drag to the frame where you want the new layer to start, holding down the mouse 
button until the drop menu appears.

3.	 Choose Exchange from the drop menu.

The old layer is replaced by the new layer.

Add multiple layers
When you drag more than one item to the Timeline, the new layers appear in their own 
tracks above any existing layers. This is equivalent to performing a composite edit with 
a single object. A drop menu lets you choose whether the additional layers should be 
stacked up as a composite, or whether they should appear one after another (sequentially).
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1.	 In Motion, do one of the following:

•	 In the toolbar, click Import, then in the dialog that appears, Shift-click or Command-
Click to select multiple items, and drag them to the Timeline track area.

•	 In the Library or Media list, Shift-click or Command-click to select multiple items, 
then drag them to the Timeline track area.

2.	 Drag to the frame where you want the new layers to start, holding down the mouse 
button until the drop menu appears.

3.	 Do any of the following:

•	 Stack the layers at the same start point: Choose Composite from the drop menu.

Multiple layers are added to the project at the same point in time, each new layer on 
its own track.

•	 Stack the layers in sequential order: Choose Sequential from the drop menu.

Multiple layers are added into the project, each in its own track, one after another in 
the Timeline.

If you release the mouse button in the Timeline track area before the drop menu appears, a 
composite edit is applied by default. Alternatively, you can drop the multiple layers into the 
Timeline layers list; doing so results in a composite edit.

Adjust Timeline dragging settings in Motion
You can specify where an item is dropped when you add it to the Timeline Layers list: at 
the start of the project or at the current playhead position. You can also set the delay time 
before a drop menu appears when you drag a media item to the Timeline track area.

Specify where new objects appear in the Timeline layers list
1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 Click Project.

3.	 In the Still Images & Layers section, click the appropriate button to create layers at 
“Current frame” or “Start of project.”

Note: The Create Layers At preference applies only when you drag items to the Timeline 
layers list, Layers list, or canvas. Clips dropped on a specific frame in the Timeline track 
area appear at the exact location where you release the mouse button.

Set the drop menu delay time for items added to the Timeline track area
You can modify the time it takes for the drop menu to open when you drag items into the 
Timeline track area.

1.	 In Motion, choose Motion > Settings (or press Command-Comma).

The Settings window appears.

2.	 Click General.

3.	 In the Interface section, adjust the Drop Menu Delay slider to set the delay pause for 
drop menus in Motion.
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Manage Timeline layers and tracks

Intro to managing Timeline layers and tracks in Motion
The Timeline layers list (on the left side of the Timing pane) mirrors the Layers list in the 
Project pane and displays your project objects (groups, layers, filters, behaviors, masks, 
and so on) and their stacking order. When you reorder in the Timeline Layers list, the 
change is immediately reflected in the Layers list in the Project pane. The Timeline layers 
list contains many of the same controls as the Layers list in the Project pane. See Layers 
list controls.

The Timeline track area (on the right side of the Timing pane) displays each object in a 
project as a color bar (known as a timebar). Different colors represent different types of 
objects.

The Timeline track area can contain the following timebars and other icons:

•	 Group or 360° environment: A double blue bar. For groups and 360° environments with 
multiple layers, the lower bar lists the number of objects in the group.

•	 Object (video clip, still, shape, text, particle system, replicator, camera, or light): A blue 
bar.

Note: When the object is a Cinematic mode video clip (recorded on supported iPhone 
models), focus points appear below the blue timebar. See Intro to Cinematic mode video.
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•	 Mask: A gray bar.

•	 Behavior or Filter: A thin purple bar.

•	 Keyframe: A red diamond beneath the keyframed object (selected keyframes appear 
white).

•	 Audio: A green bar displaying the audio waveform. Audio tracks are not displayed by 
default. See Adjust audio.

Select and organize Timeline layers in Motion
The Timeline layers list, on the left side of the Timing pane, mirrors the Layers list in the 
Project pane. You can select, reorganize, show, hide, and lock layers in the Timeline layers 
list the same way you do in the Layers list. Changes made to one list are reflected in the 
other. See the following topics:

•	 Select layers and groups

•	 Add or remove layers and groups

•	 Reorganize layers and groups

•	 Show, hide, solo, or lock objects

•	 Nest layers and groups

•	 Layers list controls

•	 Layers list shortcut menu
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Unlink video and audio in the Motion Timeline
Ordinarily, objects that contain both audio and video are linked so they remain in sync. This 
link is represented by an icon in the Timeline layers list.

Note: To display the Audio Timeline, click the Show/Hide Audio Timeline button, located on 
the right side of the timing toolbar.

Objects that are linked are always edited together in the Timeline. Operations such as 
cut, copy, paste, and split affect both audio and video. However, if you want to break that 
relationship so you can move or edit the audio or video without the other tagging along, 
you can disable that link and move either object freely. Beware that this might result in your 
audio and video playing out of sync.

Manipulate audio and video elements separately
1.	 In the Timeline layers list in Motion, click the link icon to the right of the object name for 

the video or audio element.

A slash appears over the link icon in all previously linked layers.

2.	 Move, trim, or slip the audio bar or video bar.

The link icon also appears in the Layers list and the Audio list of the Project pane.
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Customize the Timeline in Motion
You can customize the display of the Timeline layers list and track area to suit your needs.

Show or hide mask, filter, or behavior objects
You can hide effects objects in the Timeline Layers list and track area to simplify your view 
of layers in your project. 

•	 In Motion, click the Show/Hide Masks, Show/Hide Filters, or Show/Hide Behaviors button 
at the top of the Timeline layers list.

When a button is dimmed, the effects object and its corresponding bar are hidden from 
view in the Timeline layers list and track area. However, the effect remains active in the 
canvas.

Modify the track display
You can display your timebars in the Timeline track area in any of several different ways to 
suit your preferred working style.

1.	 In Motion, choose Motion > Settings (or press Command-Comma), then click 
Appearance.

2.	 In the Timeline section of the Appearance pane, choose an item from the Timebar 
Display pop-up menu:

•	 Name: Displays the name of the object on the timebar.

•	 Name Plus Thumbnail: Displays the name of the object and a single thumbnail on the 
timebar.

•	 Filmstrip: Displays frames of the object on the timebar.

Regardless of the Timebar Display setting, timebars for cameras, lights, behaviors, and 
filters are labeled with names only. When Timebar Display is set to Filmstrip, computer 
processing time is increased.
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Adjust Timeline track height
You can adjust the height of tracks displayed in the track area. Audio and object tracks can 
be resized separately. However, some tracks, including filters and behaviors, cannot be 
resized.

Do one of the following:

•	 In Motion, drag a row separator between two layers in the Timeline layers list up or 
down to modify the vertical size of the tracks.

•	 Click the pop-up menu at the bottom of the Timeline layers list, then choose a new size. 
Options include Mini, Small, Medium, and Large.

Scroll the track area
You can scroll horizontally in the track area to see portions of your timebars that extend 
beyond the immediate workspace. 

•	 In Motion, drag the scroller under the track area left or right.

Zoom the track area
In Motion, do one of the following:

•	 Drag the handle at either end of the scroller, inward to zoom in, or outward to zoom out.

To zoom from the center of the visible area, press and hold the Shift key while you drag 
a handle.

•	 Drag the zoom slider left to zoom out or right to zoom in at the position of the playhead.
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•	 Press Option-Command-Equal Sign (=) to zoom in.

•	 Press Option-Command-Minus Sign (–) to zoom out.

Note: If your whole desktop zooms, choose Apple menu () > System Settings, 
click Accessibility, click Zoom, then deselect the “Use keyboard shortcuts to zoom” 
checkbox.

•	 On a Multi-Touch trackpad, pinch open to zoom in and pinch closed to zoom out.

Zoom the track area to fit the entire project or play range
In Motion, do one of the following:

•	 Click the Zoom Time View button in the upper-right corner of the Timeline.

•	 With the Timeline active, press Shift-Z or Option-Command-0.

•	 Choose View > Zoom Time View > To Project or View > Zoom Time View > To Play 
Range.

Edit objects in the Timeline

Edit in the Timeline in Motion
As you design your project, you arrange layers spatially in the canvas and temporally 
in the Timeline. When you select a layer, group, or effects object in the Layers list or 
Timeline layers list, its timebar is selected in the Timeline track area. Drag a bar forward or 
backward in time, or trim it to correspond with the timing of other bars.

Motion uses the terms move, trim, slip, and split to describe the different ways of editing 
timebars:

•	 Move: Changes the location of an object in the Timeline without affecting its content or 
duration. See Move objects in the Timeline.

•	 Trim: Changes the duration of an object in the Timeline without affecting its location or 
content. See Trim objects in the Timeline.

•	 Slip: Changes the content of an object in the Timeline without affecting its location or 
duration. See Slip video layers in the Timeline.

•	 Split: Divides an object into multiple objects that you can manipulate in separate tracks. 
See Split objects in the Timeline.

As you can with objects in the Layers list, you can delete objects in the Timeline, as well as 
cut, copy, or paste them. 

You can also modify all timebars in a group by editing the group timebar. 
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Move objects in the Timeline in Motion
Move an object when you want it to begin and end at a different point in the Timeline.

Move an object in the Timeline
•	 In the Timeline track area in Motion, drag a bar left or right to move it in time.

As you drag, a tooltip appears, identifying the new In and Out points; a delta symbol 
(triangle) indicates the amount of change in frames or timecode.

Move an object and snap it to neighboring objects
In Motion, do one of the following:

•	 Click to select the Snapping button in the upper-right corner of the Timeline, then drag 
a bar in the track area.

•	 Press Shift as you drag a bar in the Timeline.

Vertical lines appear in the track, corresponding to the In and Out points of other timebars. 
The active bar snaps to these lines as you drag.

Move an object to the playhead position
You can move a timebar to a new location in its track by using the Move Selected In Point 
or Move Selected Out Point command. This command shifts the position of the selected 
object to the current playhead position. You can also use this command to move and align 
multiple objects in one operation.

1.	 In the Timeline track area in Motion, select the bar to move.

Shift-click to select multiple bars, if desired.

2.	 Place the playhead at the point in the Timeline where you want to move the bar.

3.	 Do one of the following: 

•	 Align the beginning of the bar to the playhead: Choose Mark > Move Selected In 
Point (or press Shift-Left Bracket).

•	 Align the end of the bar to the playhead: Choose Mark > Move Selected Out Point (or 
press Shift-Right Bracket).
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Move an object to a specific frame
1.	 In the Timeline track area in Motion, select the bar (or bars) to move, then type the 

number of the frame (or timecode) where you want to move the bar.

A value field appears, displaying the number you typed.

2.	 Press Return.

The bar’s In point moves to the specified frame number. If you selected more than one 
bar, they all move to the specified frame number.

Move an object a specific number of frames
In Motion, do one of the following:

•	 To move a timebar forward a specific number of frames, select the bar in the Timeline 
track area, type a plus sign (+) followed by the number of the frames you want to move, 
then press Return.

•	 To move a timebar backward a specific number of frames, select the bar, type a minus 
sign (–) followed by the number of the frames you want to move, then press Return.
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Trim objects in the Timeline in Motion
Trim an object’s timebar when you want to shorten or lengthen its duration in the Timeline. 
You can trim the beginning or end of the object by dragging from the left or right edge of 
the bar (the In and Out points). You can also trim an object by using menu commands and 
corresponding keyboard shortcuts. You can trim multiple objects simultaneously, and you 
can trim on the fly while your project is playing back.

Note: Video and audio objects cannot be trimmed to be longer than the duration of their 
source media. To extend a video or audio object beyond the duration of its source media, 
you must change the object’s End Condition to Loop, Ping Pong, or Hold in the object’s 
Properties Inspector. This limitation does not apply to other objects, such as still images, 
cameras, text, and shapes, all of which you can extend without restriction. You can also 
change the effective duration of a clip without adding or removing frames, by changing the 
clip’s playback speed. For more information on the Timing controls, see Intro to retiming 
media in the Timeline.

When you trim a video object in the track area, Motion provides a visual representation of 
how much additional footage is available in the object’s source clip: a dimmed extension 
on either end of the bar indicating that unused frames exist in the source video clip. If you 
see no dimmed extensions when you trim a bar, there are no unused frames in the source 
clip. Consequently, you cannot lengthen the object (unless you change the object’s End 
Condition in the Properties Inspector for the clip).

Trim an object in the Timeline
1.	 In the Timeline track area in Motion, move the pointer to one end of the bar you want to 

trim.

The pointer changes to a trim pointer.

2.	 Drag the end of the bar until it reaches the frame where you want the object to start or 
end.

As you drag, a tooltip indicates the new In or Out point, and the new duration of the 
object.



251Motion User Guide

Trim an object and snap its In or Out point to neighboring objects
•	 In Motion, press and hold the Shift key as you drag the edge of a bar in the track area.

Vertical lines appear in the track, corresponding to the In and Out points of other bars. 
The active bar snaps to these lines as you drag.

Trim one or more objects via the Mark menu
1.	 In Motion, select one or more objects to trim.

2.	 Place the playhead at the frame where you want the new In or Out point.

3.	 Choose Mark > Mark In (or press I) or Mark > Mark Out (or press O) to set a new In point 
or Out point.

All selected objects are trimmed to the new point.

Trim an image or video layer without trimming its applied effects objects
You can trim a layer without affecting the duration of its applied effects objects (masks, 
filters, and so on).

•	 In Motion, press and hold the Command key while you drag the edge of the image or 
video clip.

The object is trimmed independently of its applied effects objects.

Slip video layers in the Timeline in Motion
Slip a video layer when you want to use a different section of your source clip without 
changing the layer’s duration or where it appears in the Timeline.

Important: Slipping is only possible after you’ve trimmed a video layer’s timebar.

For example, if you have a shot of a door opening that is three seconds long and you want 
to trim it by one second, you can use the Slip function to select which one-second section 
to use: the first second as the door leaves the jamb, the next second where the door 
swings open, or the last second where it bangs against the wall.

As with trimming, when you slip a video layer in the track area, Motion provides a visual 
representation of how much additional footage is available in the object’s source clip: A 
dimmed extension on either end of the bar indicates that unused frames exist in the source 
video clip. You can only slip a bar as far as the existing unused frames in the source media. 
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Slip a video layer in the Timeline
1.	 In Motion, with the pointer over the video layer’s timebar, press and hold the Option key.

The pointer turns into the slip pointer.

2.	 Still pressing and holding the Option key, drag the middle part of the bar left or right.

Dragging to the left replaces the frames with a section from later in the source material; 
dragging to the right uses frames from earlier in the clip.

Split objects in the Timeline in Motion
You can divide a single object into multiple objects, each in its own Timeline track. Splitting 
lets you turn one object into multiple pieces and then manipulate each segment of the 
object on its own track. For example, you can split an object into multiple tracks over time 
if want to apply an effect to the object over a specific, finite segment of time. Or you might 
split an object into multiple tracks to create the illusion that the object is moving in 3D 
space, passing in front of other objects. When working in 3D, you can even split camera 
tracks.

Split an object in the Timeline
1.	 In the Timeline in Motion, select the object to split.

2.	 Drag the playhead to the frame where you want the split to occur.

3.	 Choose Edit > Split.

The object is broken into two pieces, each positioned on its own track.
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Delete objects in the Timeline in Motion
Motion provides three ways to remove an object from the Timeline track area:

•	 Delete: Removes the object, leaving a gap in the track.

•	 Ripple Delete: Removes the object and closes up the gap left behind.

•	 Cut: Deletes the object, leaving a gap in the Timeline, and copies the object to the 
Clipboard for later pasting.
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Delete an object
1.	 In Motion, select the object to delete.

2.	 Choose Edit > Delete (or press Delete).

You can also Control-click the object, then choose Delete from the shortcut menu.

Ripple delete an object
1.	 In Motion, select the object to delete.

2.	 Choose Edit > Ripple Delete (or press Shift-Delete).

Cut an object
1.	 In Motion, select the object to delete.

2.	 Choose Edit > Cut (or press Command-X).

You can also Control-click the object, then choose Cut from the shortcut menu.

Copy and paste objects in the Motion Timeline
As in other applications, in Motion you can copy and paste objects. Copying leaves an 
object in place and copies it to the Clipboard for later pasting.

When you paste an object, it’s placed at either the position of the playhead or at the 
beginning of the project (see If it’s your first import). For the purposes of simplicity, the 
remainder of this section assumes pasted objects are placed at the playhead position.

Objects with applied filters, behaviors, keyframes, and other effects retain those effects 
when cut, copied, and pasted. You can also copy or cut filter and behavior objects from 
one media layer and then paste them into another media layer, effectively transferring the 
effect to a different media item.

In addition to ordinary pasting, Motion lets you paste as an insert, overwrite, or exchange 
edit. These three commands appear in the Paste Special dialog:

•	 Insert into time region: Pastes the Clipboard contents into the project, pushing existing 
objects farther down in time.

•	 Overwrite into time region: Pastes the Clipboard contents into the project, deleting any 
existing objects at the same point in time.

•	 Exchange media with existing object: Replaces the selected object in the project with 
the Clipboard contents.

Note: Paste Special can also be used with selected regions in the Timeline to perform a 
special type of paste. See Edit a range of frames in the Timeline.

Copy an object to the Clipboard
1.	 In the Finder or in the Timeline, Media list, or Layers list in Motion, select an object to 

copy.

2.	 Choose Edit > Copy (or press Command-C).
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Paste an object into the Timeline
1.	 In the Timeline in Motion, select a group to paste the copied item into.

2.	 Move the playhead to the desired time position.

3.	 Choose Edit > Paste (or press Command-V).

The pasted object is placed in a new track at the top of the other layers in the active group. 
If no group is selected, the object is pasted into the group it was copied from. If it was 
copied from outside the current project, a new group is created. Pasting multiple objects 
retains the relative object and layer order of the Clipboard contents.

Paste an object, pushing other objects farther ahead in the Timeline
1.	 In the Timeline in Motion, select a group to paste the copied item into.

2.	 Move the playhead to the desired time position.

3.	 Choose Edit > Paste Special (or press Option-Command-V).

The Paste Special dialog appears.

4.	 Select “Insert into time region.”

5.	 Click OK to confirm your edit.

The object is inserted at the selected position, splitting other objects in the same time 
region and pushing them to the right in the Timeline.

Paste an object, deleting other objects in the same time region
1.	 In the Timeline in Motion, select a group to paste the copied item into.

2.	 Move the playhead to the desired time position.

3.	 Choose Edit > Paste Special (or press Option-Command-V).

The Paste Special dialog appears.

4.	 Select “Overwrite into time region.”

5.	 Click OK to confirm your edit.

The object is pasted at the selected position, overwriting other objects in the same time 
region.

Paste an object, replacing another object
1.	 In the Timeline in Motion, select an object to replace with the copied item.

2.	 Move the playhead to the desired time position.

3.	 Choose Edit > Paste Special (or press Option-Command-V).

The Paste Special dialog appears.

4.	 Select “Exchange media with existing object.”

5.	 Click OK to confirm your edit.

The object is pasted at the selected position, replacing the other object.
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Group tracks in the Timeline in Motion
You can edit in the group track, even if the group is collapsed and its nested objects are 
not visible in the Timeline track area.

Group tracks contain two color bars. The narrow, dark-blue upper bar edits all objects in 
the group as a single unit. It’s labeled with the name of the group (“Group” by default). The 
lower group bar—taller and a lighter shade of blue—edits individual objects in the group. 
The lower group bar displays information about the names of individual objects in the 
group, as well as the number of objects that overlap in composited areas of the Timeline. 

Motion lets you move objects in the Timeline via the group track. Depending on where you 
drag in the group track, you can move all objects, individual objects, or just those objects 
that overlap in time (composited objects). 

Trimming the edges of the upper group bar trims the edges of the objects in the group. 
If there’s only one object, trimming the upper group bar trims that object. If there’s more 
than one object lined up with the edge of the group, trimming the group trims all those 
objects.

You cannot trim overlapping objects via the group track.

You can modify the upper group bar to be longer or shorter than the contents of the 
group (the lower group bar). For example, you might shorten the upper group bar to hide a 
section of the objects in it. Objects that extend beyond the ends of the upper group bar are 
not displayed in the canvas.

In addition to moving and trimming, you can slip video layers in the group track. Any 
portion of the lower group bar that contains only one video layer can be slipped in this 
manner. Areas where more than one layer overlap can be slipped by Control-clicking the 
group bar and choosing a video layer from the shortcut menu. See Edit the group track in 
the Timeline. 
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Edit the group track in the Motion Timeline
There are a variety of editing tasks you can perform directly in the group track. This is 
equivalent to making similar edits to the various tracks contained within the group, but it’s 
sometimes more efficient to make such changes in the group track instead.

Move all objects in a group at once
•	 Drag the upper group bar left or right.

All objects in the group move in time.

Move a single object in a group
1.	 In the Timeline track area in Motion, click an area of the lower group bar where a single 

object is visible.

That object is highlighted in the group track.

2.	 Drag the section left or right to move the object in the group forward or backward in 
time.

The selected object moves in time.

Move overlapping (composited) objects in a group
•	 In the Timeline track area in Motion, drag an area of the lower group bar where multiple 

objects overlap.

The composited objects move in time.

Trim objects in a group
•	 In the Timeline track area in Motion, drag an end of the upper group bar right or left in 

the track area.

Objects in the group that share the same In and Out point with the group are trimmed 
along with the group.

Change the duration of the group independently of the objects in it
•	 In Motion, while pressing and holding the Command key, drag either end of the upper 

group bar left or right in the Timeline track area.

Only the group is trimmed.

Note: After you manually change the length of the upper group bar, it’s no longer updated 
when you add or modify the objects to the group. To restore automatic updating, realign 
the edges of the upper group bar with the edges of the first and last clips in the group.
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Slip a video layer via the group track
•	 In Motion, while pressing and holding the Option key, drag an area in the lower group 

bar where the video layer is located in the Timeline track area.

If there are overlapping (composited) layers, before performing this operation, Control-
click the overlapping region, then choose the desired video layer from the shortcut 
menu.

Note: You can only slip a layer if it has been trimmed first. For more information on slipping, 
see Slip video layers in the Timeline.

Dragging right slips the video clip to an earlier portion of the source media. Dragging left 
slips the video clip to a later portion of the source media. Either way, the position of the 
clip in the Timeline and its duration are unchanged. 

Navigate in the Timeline in Motion
Motion provides many controls for navigating the Timeline. You can drag the playhead 
to “scrub” through your project as quickly or slowly as you want, or immediately jump 
to a specific frame. Additionally, you can jump to object boundaries, markers, and other 
important indicators in the Timeline.

Many navigation tasks are also accessible in the timing toolbar.

Note: The timing display can be set to show frames or timecode. To set the timing 
display duration to frames, Click the down arrow on the right side of the timing display, 
then choose Show Frames from the pop-up menu. See Switch between display of frame 
numbers and timecode.

In addition to moving to new positions in time, you can navigate directly to objects in the 
Timeline, such as objects, markers, and keyframes. 

Play back your project
In Motion, do one of the following:

•	 In the timing toolbar, click the Play button.

•	 Press the Space bar.

For more options, such as advancing frame-by-frame or starting playback from the 
beginning of the project, see Play back a project.
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Move the playhead to a new point in time
In Motion, do one of the following:

•	 Double-click the current frame number in the timing display, enter a new frame number, 
then press Return.

•	 Drag left or right over the current frame number in the timing display to rewind or 
advance.

•	 Drag the playhead in the Timeline ruler to the frame you want.

•	 Click the Timeline ruler at the frame number where you want to move the playhead.

•	 With the canvas or Project pane active, type a new frame number, then press Return to 
jump to that frame.

•	 With the Timeline active (and no objects selected), type a new frame number, then 
press Return to jump to that frame.

Navigate by frame
To make it easier to find specific frames in your project, you can step through the Timeline 
frame by frame, rather than skimming it.

In Motion, do any of the following:

•	 Move forward a specific number of frames: Type a plus sign (+), then type the number 
of frames to move forward.

•	 Move backward a specific number of frames: Type a minus sign (–), then type the 
number of frames to move backward.

•	 Move forward or backward one frame at a time: Press the Left Arrow key to move 
backward or the Right Arrow key to move forward.

You can also choose Mark > Go to > Previous Frame or Mark > Go to > Next Frame.

•	 Move forward or backward ten frames at a time: Choose Mark > Go to > 10 Frames Back 
(or press Shift-Left Arrow) or Mark > Go to > 10 Frames Forward (or press Shift-Right 
Arrow).

Move ahead or back in seconds, minutes, or hours
1.	 In Motion, make sure the timing display is set to show timecode.

If the timing display is showing frames, click the down arrow, then choose Show 
Timecode from the pop-up menu.

2.	 Double-click in the timing display.

3.	 Do any of the following:

•	 Move forward in seconds: Enter a plus sign (+), enter the number of seconds to 
move forward, then enter a period. For example, to move 2 seconds ahead, enter 
“+2.” (with a period after the number), then press Return. 

•	 Move forward in minutes: Enter a plus sign (+), enter the number of seconds to move 
forward, then enter two periods after the number. (To move ahead in hours, enter 
three periods after the number.)

•	 Move backward in seconds: Enter a minus sign (–), enter the number of seconds to 
move backward, then enter a period. For example, to move 2 seconds backward, 
enter “–2.” (with a period after the number), then press Return.
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•	 Move backward in minutes: Enter a minus sign (–), enter the number of seconds to 
move backward, then enter two periods after the number. (To move backward in 
hours, enter three periods after the number.)

Navigate by jumping
To move the playhead quickly from point to point in the Timeline, do one of the following in 
Motion:

•	 Jump to the beginning of the project: Click the “Go to start of project” button in the 
transport controls (under the canvas), or choose Mark > Go to > Project Start, or press 
Home.

•	 Jump to the end of the project: Click the “Go to end of project” button in the transport 
controls, or choose Mark > Go to > Project End, or press End.

•	 Jump to the next keyframe: With an animated object selected, choose Mark > Go to > 
Next Keyframe, or press Shift-K.

•	 Jump to the previous keyframe: With the animated object selected, choose 
Mark > Go to > Previous Keyframe.

Jump to the beginning or end of an object in the Timeline
1.	 In Motion, select the object to navigate to.

2.	 Do one of the following:

•	 Choose Mark > Go to > Selection In Point or Mark > Go to > Selection Out Point.

•	 Press Shift-I (for the In point) or Shift-O (for the Out point).

Show and modify keyframes in the Motion Timeline
You can move or delete keyframes that are displayed in the Timeline. You can also display 
the animation curve for a selected keyframe, using the Keyframe Editor.

For more information on the Keyframe Editor, see Intro to keyframing.

Display keyframes in the Timeline track area
•	 In the upper-right corner of the Timeline in Motion, click the Show/Hide Keyframes 

button.

When the Show/Hide Keyframes button is highlighted, keyframes appear below objects 
in the track area.

Note: Don’t confuse the Show/Hide Keyframes button with the Show/Hide Keyframe 
Editor button, located on the right side of the timing toolbar. The former turns the display 
of keyframes in the Timeline track area on and off; the latter expands and collapses the 
Keyframe Editor in the Timing pane.
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Move a keyframe’s position in time
Moving a keyframe in the Timeline modifies the keyframe’s position in time (but not its 
value). 

•	 In the Timeline in Motion, drag the keyframe to the left or right. 

When selected, the keyframe appears white.

Change a keyframe’s value
To change a keyframe’s value (as opposed to its position in time), do one of the following in 
Motion:

•	 Control-click the keyframe, choose the parameter to adjust from the shortcut menu, 
enter a new value, then press Return.

•	 Use the Keyframe Editor, which lets you change both the value and interpolation of the 
keyframe.

Copy and paste keyframes
1.	 In the Timeline in Motion, select the object that contains the keyframes you want to 

copy.

2.	 In the Timeline track area, select or Shift-select keyframes, then choose Edit > Copy (or 
press Command-C).

3.	 In the Timeline track area, select the target object for the copied keyframes, then 
choose Edit > Paste (or press Command-V).

Delete a keyframe or group of selected keyframes
•	 In the Timeline track area, select the keyframe or keyframes to delete, then do one of 

the following:

•	 Press Delete.

•	 Control-click a selected keyframe, then choose Delete Keyframes from the shortcut 
menu.

Delete all keyframes
•	 In the Timeline track area in Motion, Control-click a keyframe, then choose Delete All 

Keyframes from the shortcut menu.

Display an animation curve in the Keyframe Editor
•	 Control-click a keyframe on a track in Motion, then choose Show in Keyframe Editor 

from the shortcut menu.

The Keyframe Editor appears underneath the Timeline, showing the animation curve and 
a new, untitled curve set.
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Work in the ruler

Intro to the Timeline ruler in Motion
You can perform several timing tasks in the ruler above the Timeline track area:

•	 Drag the playhead to a specific frame to view the project at a specific time.

•	 Drag the In and Out points of your project so playback occurs only within the specified 
frames. See Define the play range.

•	 Select a range of frames, so you can delete, cut, or paste into them. See Edit a range of 
frames in the Timeline.

•	 Add or edit project markers, which can be added to your project to identify an important 
frame or range of frames. See Intro to Timeline markers.

Edit a range of frames in the Motion Timeline
You can make changes to a range of frames, known as a region. Selecting a region allows 
you to make changes to multiple objects in a specific range of time in the Timeline. For 
example, you can cut or copy a section of time to remove it from your project completely, 
or just move it to a new position in Timeline. Regions need not align with object edges in 
the Timeline—you can create a region that begins midway through an object.

Note: Pasting a region does not paste it at the current playhead location. To move a pasted 
region to the playhead location, press the Shift key while you drag the pasted object. As 
you approach the current playhead location, the object snaps into place.

You can also paste objects into a defined region using the Paste Special command, which 
lets you insert, overwrite, or exchange objects in the Timeline. Additionally, you select a 
region and insert blank frames, creating an empty placeholder for a clip you don’t yet have.

Select a region (a range of frames)
•	 In Motion, while pressing and holding the Command and Option keys, drag in the 

Timeline ruler.

A light highlighted band appears over the selected frames.
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Move a region
•	 In the Timeline track area in Motion, position the pointer over a region, then drag to 

move the region.

Note: This operation does not move objects within the region.

Deselect tracks from a region
•	 In the Timeline track area in Motion, Command-click a track in a region to deselect the 

track.

Paste into a region
1.	 In Motion, select an object.

2.	 Press Command-C to copy or Command-X to cut your selection.

3.	 Pressing and holding the Command and Option keys, drag in the ruler to select a region.

4.	 Choose Edit > Paste Special.

The Paste Special dialog appears.

5.	 Select “Insert into time region” or “Overwrite into time region,” then click OK.

The Clipboard contents are pasted into the region using the method you specified. For 
more information on the different editing types, see Drag to the Timeline track area.
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Insert time into a project
1.	 In the Timeline track area in Motion, while pressing and holding the Command and 

Option keys, drag in the ruler to select a region.

Drag as wide an area as you want to insert.

2.	 Choose Edit > Insert Time.

The number of frames you selected in step 1 is added to the project, beginning at the 
end of the selected region, pushing any existing objects farther forward in time.

If you insert time into a region that contains a video clip, the clip is split onto two tracks, 
and objects beyond the split point are placed in a new group.
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Work with markers

Intro to Timeline markers in Motion
A marker is a visual reference point in the Timeline that identifies a specific frame. You can 
add as many markers as you want in the Timeline ruler while playing the project, or when 
the playhead is stopped.

Use markers to:

•	 Add a visual reference to an object at a specific point in time. See Add, move, and 
delete Timeline markers.

•	 Quickly navigate to specific points in a sequence. See Navigate with Timeline markers.

•	 Align other objects or keyframes to an important point in time.

•	 Add notes about a specific area in your project. See Edit Timeline marker information.

•	 Customize effects templates for use in Final Cut Pro. See Intro to template markers

You can assign different colors to different types or markers and create marker groups.

There are two types of markers: project markers and object markers. Project markers are 
fixed to a specific frame or timecode value in the ruler. Object markers are attached to an 
object and move around as you move the object in the Timeline.
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Add, move, and delete Timeline markers in Motion
You can add, delete, or move Timeline markers.

Add a project marker
1.	 In Motion, place the playhead at the frame where you want the marker.

2.	 Ensure that no objects are selected, then do any of the following:

•	 Add a project marker at the playhead: Choose Mark > Markers > Add Marker, or 
press M.

•	 Add a project marker a specific frame: Shift-click at the desired point in the Timeline 
ruler, or Control-click at the desired point in the Timeline ruler, then choose Add 
Marker from the shortcut menu.

A green marker is added to the Timeline ruler.

Note: You can also press Shift-M to add a project marker at the playhead position, even if 
an object is selected.

Add an object marker
1.	 In Motion, place the playhead at the frame where you want the marker.

2.	 Select the object to add the marker to, then do one of the following:

•	 Choose Mark > Markers > Add Marker.

•	 Press M.

A red marker is added to the bar for the selected object.

In this way, you can add object markers at specific frames while you play back your project.

Move a marker
•	 In Motion, drag the marker left or right to a new location.

Delete a marker
In Motion, do one of the following:

•	 Drag the marker vertically out of the area where it resides, then release the mouse 
button.

•	 Double-click the marker, then click Delete Marker in the Edit Marker dialog.

•	 For project markers, position the playhead over the marker, then choose 
Mark > Markers > Delete Marker. 

•	 For object markers, position the playhead over the marker, select the group or object, 
then choose Mark > Markers > Delete Marker.

•	 Control-click the marker, then choose Delete Marker from the shortcut menu.
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Delete all project markers
In addition to deleting a single marker, you can delete all markers from your project in 
one step.

1.	 Make sure no objects are selected in your Motion project (choose Edit > Deselect All or 
press Shift-Command-A).

2.	 Choose Mark > Markers > Delete All Markers.

Delete all markers in a specific object
Do one of the following:

•	 In Motion, select the object containing the markers you want to delete, then choose 
Mark > Markers > Delete All Markers.

Edit Timeline marker information in Motion
You can edit the information for a marker, including its name, starting frame, duration, and 
color. You can also add comments to the marker. Comments appear in a tooltip when the 
pointer is placed over the marker.

Edit marker information
1.	 In Motion, open the Edit Marker dialog by doing one of the following:

•	 Double-click a marker.

•	 Control-click a Marker, then choose Edit Marker from the shortcut menu.

•	 Move the playhead to a marker, then choose Mark > Markers > Edit Marker (or press 
Option-Command-M).

2.	 Enter a name in the Name field.

3.	 Enter text in the Comment field.

This comment appears as a tooltip when you place the pointer over project markers.

4.	 Enter a Start value or drag in the Start field.

The marker moves to the frame number you enter (or timecode number, if the timing 
display is set to show timecode).

5.	 Enter a Duration value or drag in the Duration field to specify the range of frames (or 
timecode) for the marker.
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6.	 Click a Color button to set the marker color.

Note: For information on the other marker types listed in the Type pop-up menu, see 
Intro to template markers.

7.	 Click OK to accept your changes.

Text added to the Name and Comment fields for project markers appears in a small 
window when you place the pointer over the marker.

Navigate with Timeline markers in Motion
You can jump from your current playhead position to a nearby project marker forward or 
backward.

Jump to the next marker
•	 In Motion, Control-click the Timeline ruler, then choose Next Marker from the shortcut 

menu.

The playhead jumps to the starting position of the next project marker.

Alternatively, you can choose Mark > Go To > Next Marker or press Option-Command-Right 
Arrow.

Jump to the previous marker
•	 In Motion, Control-click the Timeline ruler, then choose Previous Marker from the 

shortcut menu.

The playhead jumps to the starting position of the previous project marker.

Alternatively, you can choose Mark > Go To > Previous Marker or press Option-Command-
Left Arrow.

Jump to the next or previous marker using the Edit Marker dialog
You can also navigate to adjacent markers using the Edit Marker dialog.

•	 In Motion, double-click a marker, then click the arrow buttons in the Edit Marker dialog.

The playhead does not move, but the Edit Marker dialog remains open and the contents 
are replaced with the information for the next marker. 
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Edit in the mini-Timeline in Motion
The mini-Timeline lies just above canvas toolbar and below the canvas, providing an at-a-
glance look at where selected objects fit into your overall project.

The mini-Timeline also has a playhead to indicate which frame you’re viewing as well as 
In point and Out point markers to identify the play range. The length of the mini-Timeline 
represents the duration of the entire project.

You can drag the playhead through the mini-Timeline to scrub your project, or to jump to a 
specific point in time. In the mini-Timeline, you can also change the play range of the entire 
project as well as move, trim, or slip a selected object. 

You can also perform many nonlinear editing functions in the mini-Timeline. You can drag 
clips or images from the Import dialog, or objects from the Library (such as replicators or 
shapes), to the mini-Timeline. You can also move, trim, and slip objects to change which 
portion of the object appears at which point in time. For more information on editing 
functions such as Move, Trim, and Slip, see Edit in the Timeline.
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Add an object to the mini-Timeline
1.	 In Motion, do one of the following:

•	 In the Motion toolbar, click Import, then in the dialog that appears, drag a media file 
to the mini-Timeline.

•	 Drag a media file from the macOS Finder to the Motion mini-Timeline. 

•	 In Motion, drag an item from the Library to the mini-Timeline.

As you drag, a tooltip appears to indicate the frame where the item will be placed.

2.	 When you reach the desired frame, release the mouse button.

The object is added to the project beginning at that frame.

Add multiple objects to the mini-Timeline
You can add multiple objects to the mini-Timeline at once. You can choose to add the 
objects sequentially (one after another) or as a composite (all at the same point in time).

1.	 Do one of the following:

•	 In the Motion toolbar, click Import, then in the dialog that appears, Shift-click to 
select multiple media files and drag them to the mini-Timeline.

•	 In the macOS Finder, Shift-click to select multiple media files, then drag them to the 
Motion mini-Timeline. 

•	 In the Motion Library, Shift-click to select multiple items, then drag them to the mini-
Timeline.

As you drag, a tooltip appears to indicate the frame where the items will be placed.

2.	 Without releasing the mouse button, drag to the desired frame.

A drop menu appears.

3.	 Choose an edit type from the drop menu, then release the mouse button.

Depending on the item dragged to the Timeline, up to four drop options are available. 
For more information on the Timeline drop menu, see Drag to the Timeline track area.
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Move an object in time
1.	 In the Layers list, Timeline layers list, or canvas in Motion, select the object you want to 

move.

The object appears in the mini-Timeline.

2.	 In the mini-Timeline, drag the object left or right to reposition it in time.

A tooltip appears, indicating the new In and Out point of the object, as well as the 
amount of change from the previous position.

3.	 When you reach the position you want, release the mouse button.

Shorten or lengthen (trim) an object
1.	 In Motion, select the object to display it in the mini-Timeline.

2.	 Position the pointer over the beginning or ending edge of the bar in the mini-Timeline.

The pointer changes to a trim pointer.

3.	 Drag the edge of the bar to change its duration.

A tooltip appears, indicating the new In or Out point and the amount of change that your 
edit is causing.

You cannot trim a layer to be longer than the number of frames available in the 
corresponding media file unless its End Condition is set to Hold, Loop, or Ping Pong in the 
Timing controls.

Slip a video clip (or other multiframe object) in the mini-Timeline
1.	 In Motion, select the multiframe object you want to modify.

2.	 Position the pointer over the body of the clip in the mini-Timeline, then press and hold 
the Option key.

The pointer changes to a slip pointer.

3.	 Continuing to press and hold the Option key, drag left or right in the mini-Timeline to 
use a later or earlier part of the clip.

A tooltip appears, indicating the new In and Out points.

Note: You cannot slip a clip if it hasn’t been trimmed first. See Slip video layers in the 
Timeline.

Snap the playhead to a project marker in the mini-Timeline
•	 In Motion, press and hold the Shift key while dragging the playhead in the mini-Timeline.

The playhead snaps to the frame that contains a project marker.
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Retime media

Intro to retiming media in the Motion Timeline
Your motion graphics projects may require you to perform special timing tricks on media: 
speeding up a clip, slowing it down, or playing it back at different speeds. There are several 
ways to retime a clip:

•	 Manipulate clip timing in the Timeline with the help of modifier keys. Indicators in the 
Timeline help you visualize loops and other retiming conditions. See Retime media in the 
Timeline.

•	 Adjust the Timing controls in the Properties Inspector to modify speed and playback 
attributes of media clips. See Timing controls.

•	 Apply a Retiming behavior designed for common retiming tasks, including hold frames, 
strobing, looping, and so on. Take some time to look over the Retiming behaviors in the 
Library before spending a lot of time in the Inspector creating your own custom retiming 
from scratch. See Intro to Retiming behaviors.

Retime media in the Motion Timeline
You can modify the duration and playback speed of video tracks in the Timeline using the 
retime pointer or loop pointer. 

Speed and duration are interdependent; that is, if you increase a clip’s playback speed, its 
duration decreases, and vice versa. For example, a 60-frame video clip played back at 30 
frames per second takes two seconds to display its 60 frames. If its In point is frame 1, its 
Out point is frame 60. Playing back the same clip at 15 frames per second would take twice 
as long; the clip’s In point remains the same, but its Out point becomes 120.

Shorten the video clip’s duration and speed up its playback speed
1.	 In Motion, with the pointer positioned over the end of a video clip’s bar in the Timeline 

track area (the clip’s Out point), press and hold the Option key.

The pointer turns into the retime pointer.

2.	 Continuing to press and hold the Option key, drag the Out point of the clip’s bar to the 
left.

As you drag, the tooltip displays the clip’s speed and duration.

Note: The retime pointer is available only when the Time Remap pop-up menu is set to 
Constant Speed in the Timing controls. When Time Remap is set to Variable Speed, the 
retime pointer has no effect. You cannot retime images, effects, and other nonvideo 
objects.
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Lengthen a video object’s duration and slow down its playback speed
1.	 In Motion, with the pointer positioned over the end of a video clip (the Out point), press 

and hold the Option key.

The pointer turns into the retime pointer.

2.	 Continuing to press and hold the Option key, drag the Out point of the clip’s bar to the 
right.

As you drag, the tooltip displays the clip’s speed and duration.

Loop a clip
Another way to extend a video clip’s duration is to loop it. When a looped clip reaches its 
last frame, it starts playing again from its first frame. You can easily loop a clip by adjusting 
it in the Timeline.

1.	 In Motion, with the pointer positioned over the end of a video clip (the Out point), press 
and hold the Option and Shift keys.

The pointer turns into the loop pointer.

2.	 Continuing to press and hold the Option and Shift keys, drag the Out point of the bar to 
the right.

As you drag, the tooltip displays the clip’s Out point, total Duration, and Loop Duration.

A looped object displays barriers to indicate where loops begin and end in the Timeline.

Change the loop point of a clip
Moving the first loop barrier in a layer’s bar changes the point where the clip loops.

•	 In the Timeline track area in Motion, drag the first loop barrier left or right.

The end point of the clip’s loop moves as you drag.
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Timing controls in Motion
Media layers (video clips and still images) have timing parameter controls in the Properties 
Inspector. To see the timing controls, move the pointer over the right side of the Timing 
category in the Properties Inspector, then click Show. When multiple objects of the same 
type are selected, parameters with common values are editable in the Properties Inspector. 
When different types of objects are selected, such as a clip and text, the Timing controls 
are not available.

Note: Still images and other layers without an inherent time dimension have a reduced set 
of Timing controls (In point, Out point, and Duration).

The Properties Inspector contains the following timing controls:

•	 Time Remap: A pop-up menu that sets how time is remapped in the clip. There are two 
menu choices:

•	 Constant Speed: Retimes the entire clip using the same value.

•	 Variable Speed: Animates the speed of the clip over time.

•	 Speed: A value slider that sets the speed of the clip as a percentage. The default is 
100%. Values lower than 100 play back the clip more slowly than its original speed and 
also extend the duration of the clip. Values higher than 100 play back the clip faster 
than its original speed and shorten the duration of the clip. 

This parameter appears only when Time Remap is set to Constant Speed.

•	 Retime Value: A value slider (available when Time Remap is set to Variable Speed) 
used to adjust the time value of the clip at a given frame. When you set Time Remap 
to Variable Speed, two keyframes are generated at the first and last frame of the clip. 
The two default keyframes represent 100% constant speed. Adding keyframes to this 
parameter and assigning them different Retime Values makes the speed of the clip ramp 
from one speed to another.

•	 In: A value slider that sets the In point of the layer, in both constant and variable speed 
modes. Adjusting this parameter moves the layer In point to the specified frame without 
affecting the duration of the layer.

•	 Out: A value slider that sets the Out point of the layer, in both constant and variable 
speed modes. Adjusting this parameter moves the layer Out point to the specified frame 
without affecting the duration of the layer.

•	 Duration: A value slider that sets the total duration of the layer. If Time Remap is set 
to Constant Speed, adjusting Duration will also affect the Speed and the Out point. If 
Time Remap is set to Variable Speed, adjusting Duration does not affect variable speed 
playback.

•	 Reverse: A checkbox that controls whether the clip is played back in reverse.

•	 Frame Blending: A pop-up menu that sets the method used to determine how the image 
is blended during each frame of playback. The Frame Blending pop-up menu contains 
the following items:

•	 None: Displays the frame from the original clip nearest the source frame.

•	 Blending: The default setting. Displays a blend of the individual pixels of adjacent 
frames.
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•	 Motion-Blur Blending: Applies a motion blur algorithm to the blended frames.

•	 Optical Flow: Uses an optical flow algorithm to blend the two frames surrounding 
a given frame. Using this method affects playback performance most significantly. 
To display frames properly, Motion analyzes the clip to determine the directional 
movement of pixels. Only the portion of the clip used in the project (the clip between 
the In and Out points) is analyzed. When you choose Optical Flow, an analysis 
indicator appears in the right corner of the canvas toolbar.

If you play back the project before the analysis is complete, the clip plays as if Frame 
Blending is set to None. When the analysis is complete, the indicator disappears, 
and the clip plays back properly. You can perform optical flow analysis on multiple 
clips simultaneously. The clips are processed in the order—the first clip you apply 
optical flow to is processed first, and so on.

Note: The more motion contained in a clip, the longer the analysis takes.

For information on pausing, reordering, or stopping a clip analysis, see Manage 
retiming analysis.

Important: When importing interlaced footage and using the Optical Flow method 
for frame blending, be sure the Field Order parameter (in the Media Inspector) is 
assigned to the correct value. Otherwise, artifacts may appear in the retimed layer.

•	 End Condition: A pop-up menu to set how playback continues when the end of the clip 
is reached. There are four options:

•	 None: The default setting. The layer’s duration in your project is equal to the 
duration of its source media file.

•	 Loop: When the last frame of the clip is reached, the clip loops back to the first 
frame and plays again. This can cause a jump in the clip’s apparent playback unless 
the clip was designed to loop seamlessly.

•	 Ping-Pong: When the last frame of the clip is reached, the next iteration of clip 
playback is reversed. If you set a clip of a ball rolling on the floor to loop with the 
Ping-Pong option, it would appear to roll forward, then backward, then forward again 
for the duration of the layer. The Ping-Pong option lets you extend the duration of 
some video clips more smoothly than the Loop option.

•	 Hold: This option freezes the last frame of the clip for the amount set in the End 
Duration slider.

Note: When using the Hold option with interlaced footage, ensure that field order is 
properly set in the Media Inspector. To modify a clip’s field order, select the clip in 
the Media list, then choose an option from the Field Order pop-up menu in the Media 
Inspector.

•	 End Duration: A slider to set the number of frames by which the clip is extended at the 
end of its duration. This value can be adjusted only if End Condition is set to a value 
other than None.
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Manage retiming analysis in Motion
You can display processing information and modify analysis when retiming a clip. 

Display more information about ongoing clip analysis
In Motion, do one of the following:

•	 Choose Window > Show Task List (or press F9).

•	 Click the analysis indicator (on the right side of the canvas toolbar, beside the Maximize 
Canvas button).

The Background Task List window appears.

The Background Task List shows all processes Motion is working on in the background. 
Each task is labeled, has a progress bar, and displays text describing how far along the 
task is. You can interrupt current and pending operations by pressing the pause button 
next to the progress bar.

Pause clip analysis
•	 In the Background Task List window in Motion, click the Pause button.

A message appears detailing how many frames have been processed.

Note: When analysis is paused, projects play back at a much improved speed.

Restart clip analysis
•	 In the Background Task List window in Motion, click the Restart button.
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Reorder clip analysis
•	 In the Background Task List window in Motion, drag the clip to analyze to the top of the 

list.

Analysis begins on the repositioned clip, and the clip previously being processed is 
paused.

Close the Background Task List window when analysis is complete 
•	 In the Background Task List window in Motion, select the “Close when tasks are 

complete” checkbox.
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Animate with behaviors

Intro to behaviors in Motion
Behaviors are animation and simulation effects that you can apply to image layers, 
cameras, and lights to build sophisticated motion effects without keyframes. Some 
behaviors even adjust individual parameters of objects in your project, allowing you to 
customize animated effects with extreme precision.

Behaviors are designed to be flexible and can be combined with one another to create all 
kinds of effects.

Behavior categories are organized alphabetically in the Library.
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•	 You can preview a behavior before you apply it.

•	 You can apply a behavior by dragging it from the Library onto an object in the Layers 
list, Timeline, or canvas, or by using the Behaviors pop-up menu in the toolbar. You can 
apply a behavior to an individual parameter from within the Inspector.

•	 You can adjust an applied behavior using controls in the Behaviors Inspector or HUD. 
(For a list of parameter controls in each behavior, see Intro to behavior types.)

Behaviors versus keyframes in Motion
When you apply a behavior to an object (or to a specific object parameter) in your project, 
no keyframes are added. Rather, behaviors automatically generate a range of values that 
are then applied to an object’s parameters, creating animation over the duration of the 
behavior. Changing the parameters of a behavior alters the animation.

Traditional keyframes, on the other hand, apply specific values to a parameter. When 
you apply two or more keyframes with different values to a parameter, you animate that 
parameter from the first keyframed value to the last.

By design, behaviors are most useful for creating generalized, ongoing motion effects. 
They’re also extremely useful for creating animated effects that might be too complex 
or time-consuming to keyframe manually. Keyframing, in turn, might be more useful for 
creating specific animated effects where the parameter you’re adjusting is required to hit 
a specific value at a specific time. For more information about using keyframes in Motion, 
see Intro to keyframing.

The animation created by behaviors can be converted into keyframes. See Convert 
behaviors to keyframes.
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Browse and apply behaviors

Browse for behaviors in Motion
All available behaviors appear in the Library and in the Behaviors pop-up menu in the 
toolbar.

Select the Behaviors category in the left pane of the Library to reveal the behavior 
subcategories in the right pane. Selecting a subcategory reveals all behaviors of that type 
in the Library stack (below the category and subcategory panes).

When you select a behavior in the Library, a short description and preview of the behavior 
appear in the preview area.



281Motion User Guide

The animated previews help you understand how each behavior works. Although most 
previews are self-explanatory, the Parameter category previews show before-and-after 
examples of the behavior’s effect on an animated object, with the gear graphic turning red 
to show the object after the behavior takes effect. For Simulation behaviors, the red gear 
graphic identifies the object that the selected behavior is applied to.

You can apply behaviors from the Library or from the Behaviors pop-up menu in the 
toolbar. See Intro to applying behaviors.

Apply behaviors

Intro to applying behaviors in Motion

Most behaviors are applied to objects in the canvas, Layers list, or Timeline. However, the 
Parameter category of behaviors are applied in the Inspector to a specific parameter you 
want to animate.

Important: Text, Particles, Replicator, Audio, Shape, and Camera behaviors should only be 
applied to their namesake objects.

When you apply a behavior to an object, the object parameters affected by that behavior 
are animated based on the behavior’s default settings. For example, if you apply the 
Gravity behavior to an object in the canvas, that object’s position is animated and it moves 
down, according to the Gravity behavior’s default setting. In most cases, a behavior’s 
duration is the Timeline duration of the object to which it is applied (the length of the bar 
in the Timeline track area). For example, if you apply a Spin behavior to an object that 
begins at frame 20 and ends at frame 300, the Spin behavior’s duration is also frame 20 to 
frame 300.

Not all behaviors automatically apply motion to an object. Some behaviors, such as Throw, 
require you to set the throw velocity before the object is “thrown.” Other behaviors, such 
as Orbit Around, require a source object to act as the central object for other objects to 
move around.

In addition to applying behaviors to objects, you can apply behaviors to groups in the 
Layers list or Timeline. Depending on the applied behavior, all objects nested in that group 
are affected in one of two ways: as if they were a single object or as individual elements.
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Add, remove, or disable behaviors in Motion

Applying a behavior to an object animates specific parameters of that object. Because 
behaviors don’t add keyframes, removing a behavior eliminates the animated effect. All 
types of behaviors are removed in the same way.

Apply a behavior to an object
In Motion, do one of the following:

•	 Drag a behavior from the Library to an appropriate object in the canvas, Layers list, or 
Timeline.

Applying behaviors from the Library lets you preview the behavior animation in the 
Library preview area.

•	 Select an object in the canvas, Layers list, or Timeline, then select a behavior from the 
Library and click Apply in the preview area.

•	 Select an object in the canvas, Layers list, or Timeline, click Behaviors in the toolbar, 
then choose a category and behavior from the pop-up menu.

Apply a behavior to multiple objects
1.	 In Motion, select all objects to apply the behavior to.

In the Layers list, canvas, or Timeline, Shift-click to select a contiguous set of objects, 
or Command-click to select noncontiguous objects.

2.	 Do one of the following:

•	 In the toolbar, click Behaviors, then choose a category and behavior from the pop-up 
menu.

•	 Select a behavior in the Library, then click Apply in the preview area.

Remove a behavior from an object
1.	 In Motion, select a behavior in the Layers list, Timeline, Behaviors Inspector, or pop-up 

menu in the title bar of the HUD.

2.	 Do one of the following:

•	 Choose Edit > Delete.

•	 Press Delete.

Note: You can also Control-click a behavior in the Layers list or Timeline, then 
choose Delete from the shortcut menu.
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Where applied behaviors appear in Motion

When you apply a behavior to a layer or group, the behavior appears nested underneath 
that layer or group in the Layers list and in the Timeline.

A behavior icon (a gear) also appears to the right of the (layer or group name in the Layers 
list and Timeline. Clicking this icon enables and disables all behaviors applied to that 
object. The actual parameters that let you adjust the attributes of a behavior appear in the 
Behaviors Inspector.

New behaviors that you apply to an object appear above behaviors applied previously.

When you apply a behavior to an object (or parameter) in your project, a behavior icon (a 
gear) appears in the row of the affected parameter in the Properties, Behaviors, or Filters 
Inspector. This icon shows you that a behavior is influencing that parameter. When you 
apply a behavior to a parameter that has been animated with keyframes (and the playhead 
is positioned over one of those keyframes), a behavior icon (a gear) appears within a 
keyframe icon (a diamond).
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To modify the settings of an applied behavior, Control-click any parameter row that has a 
behavior icon, then choose a listed behavior from the shortcut menu. When you do so, the 
Behaviors Inspector opens, showing the individual controls for the behavior you chose, 
ready for adjustment.

Alternatively, you can open the Behaviors Inspector by moving the pointer over the right 
side of a parameter row that has a behavior icon, clicking the down arrow that appears, and 
then choosing an applied behavior from the pop-up menu. 

Animation paths
When some behaviors are applied to an object, an animation path appears in the canvas 
displaying the projected path of the object over time. Consider this path a “preview” of 
the animation created by the behavior. Unlike animation paths created using keyframes 
or the path created by the Motion Path behavior, animation paths for behaviors cannot be 
edited. To show or hide all types of paths, click the View pop-up menu above the canvas, 
then choose Animation Path (when the checkmark beside the menu command disappears, 
animation paths are hidden in the canvas).
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Behavior effects in the Keyframe Editor
If you open the Keyframe Editor and look at a parameter affected by a behavior, you see a 
noneditable curve that represents the behavior’s effect on that parameter. The noneditable 
curve (in this example, position channel animation that corresponds to the Oscillate 
parameter behavior) appears in addition to that parameter’s editable curve, which can be 
used in combination to keyframe that parameter. For more information about the Keyframe 
Editor, see Display the Keyframe Editor.

Note: Use the pop-up menu above the Keyframe Editor to select which parameters are 
displayed and to create curve sets. For more information on curve sets, see Create a 
custom curve view.

Add or remove a Parameter behavior in Motion

A standard behavior is applied to an object and typically affects multiple parameters of that 
object. However, the special class of behavior known as the Parameter behavior is applied 
to a specific parameter of your choosing. In this way, you can modify a single parameter 
belonging to a filter, particle system, shape, text, or any other object in your project. You 
can even apply a Parameter behavior to a parameter of another behavior.

A Parameter behavior’s effect on an object depends on the parameter to which it is 
applied. For example, if you apply the Randomize parameter behavior to a particle emitter’s 
Position parameter, the emitter drifts randomly around the screen when the project plays. 
Applying the Randomize parameter behavior to a shape’s Scale parameter makes the shape 
randomly grow and shrink.
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Apply a Parameter behavior to a specific parameter of an object
1.	 In the Layers list in Motion, select the object to apply the Parameter behavior to.

2.	 Do one of the following:

•	 In the Inspector, Control-click a parameter’s name, choose Add Parameter Behavior, 
then choose an item from the submenu.
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•	 Click the parameter’s Animation menu (the down arrow that appears when you move 
the pointer over the right side of a parameter row), choose Add Parameter Behavior, 
then choose an item from the submenu.

•	 Control-click a parameter in the HUD, choose Add Parameter Behavior from the 
shortcut menu, then choose an item from the submenu.

•	 Control-click a parameter in the Keyframe Editor parameter list, then choose a 
Parameter behavior from the shortcut menu.

Use the pop-up menu above the Keyframe Editor to choose the parameters you want 
displayed in the Keyframe Editor. See Choose a curve view.

When you apply a Parameter behavior, the Behaviors Inspector opens.
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Apply a Parameter behavior to an object
You can also apply a Parameter behavior to an object. However, the behavior does not take 
effect until you assign a specific parameter to be influenced.

1.	 In Motion, do one of the following:

•	 Drag a Parameter behavior from the Library to an appropriate object in the canvas, 
Layers list, or Timeline.

Note: When applying a behavior to a camera or light, it’s usually easier to drag the 
behavior to a camera or light in the Layers list or Timeline than to the wireframe 
object in the canvas.

•	 Select an object in the canvas, Layers list, or Timeline, click Behaviors in the toolbar, 
choose Parameter, then choose a behavior from the submenu.

The behavior is applied to the object, but no parameter is assigned to the behavior.

2.	 To assign a specific parameter to the Parameter behavior, do one of the following:

•	 Select the Parameter behavior in the Layers list, click the Apply To pop-up menu in 
the Behaviors Inspector, then choose a parameter from the submenu.

•	 Select the Parameter behavior in the Layers list, click the Apply To pop-up menu in 
the HUD, then choose a parameter from the submenu.

The parameter you chose appears in the Apply To text field.

Apply a Parameter behavior to a parameter of another behavior
Parameter behaviors can also be applied to the parameters of other behaviors. For 
example, you can apply the Oscillate parameter behavior to the Drag parameter of the 
Orbit Around behavior. As a result, the orbital drag fluctuates, causing the object to fall 
toward the center of its orbit.
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1.	 In Motion, select a behavior that you’ve already applied to an object.

2.	 Do one of the following:

•	 Control-click a parameter’s name in the Inspector, choose Add Parameter Behavior, 
then choose an option from the submenu.
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•	 Click the parameter’s Animation menu in the Inspector (the down arrow that appears 
when you move the pointer over the right side of a parameter row), choose Add 
Parameter Behavior, then choose an option from the submenu.

•	 Control-click a parameter in the HUD, choose Add Parameter Behavior from the 
shortcut menu, then choose an option from the submenu.

•	 Control-click a parameter in the Keyframe Editor parameter list, then choose a 
Parameter behavior from the shortcut menu.

Use the pop-up menu above the Keyframe Editor to choose the parameters you want 
displayed in the Keyframe Editor. See Choose a curve view.
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Remove a Parameter behavior
1.	 In Motion, select a Parameter behavior in the Layers list, Timeline, Behaviors Inspector, 

or pop-up menu in the title bar of the HUD.

2.	 Do one of the following:

•	 Choose Edit > Delete.

•	 Press Delete.

Note: You can also Control-click the behavior in the Layers list or Timeline, then 
choose Delete from the shortcut menu.

Note: If you save a Parameter behavior as a favorite, the parameter assignment is saved 
with the rest of that behavior’s settings. As a result, the saved behavior will affect the 
same parameters of any object it’s applied to.

Reassign a Parameter behavior in Motion

After you apply a Parameter behavior, it remains assigned to that parameter unless you 
reassign it using the Apply To pop-up menu.

The Apply To pop-up menu displays all parameters available for the object to which 
the behavior is applied. If an object has other behaviors or filters applied to it, those 
parameters also appear in submenus of the Apply To pop-up menu.

1.	 In the Layers list, Timeline, or Behaviors Inspector in Motion, select the Parameter 
behavior to reassign.

2.	 In the Behaviors Inspector or HUD, choose a new parameter from the Apply To pop-up 
menu (click “To”).

The Parameter behavior is applied to the newly chosen parameter and the Apply To 
field is updated to reflect the new assignment. In the Inspector, a behavior icon (a gear) 
appears next to the new parameter.



292Motion User Guide

Where Parameter behaviors appear in Motion

Like other behaviors, Parameter behaviors appear nested underneath the objects they’re 
applied to in the Layers list and Timeline, along with any other behaviors applied to that 
object.

Note: Although Parameter behaviors appear nested under objects in the Layers list, each 
Parameter behavior is applied to a single parameter of an object, and not to the object 
itself.

Whereas standard behaviors display a simple gear icon in the Layers list, Parameter 
behavior icons contain a funnel-shaped image at the center of the gear. The funnel 
represents the “channeling” of individual parameters.

The same icon appears in the Timeline.

Control-clicking a parameter’s name in the Inspector, or clicking the down arrow on 
the right side of a parameter row (visible when you move the pointer over it) opens the 
Animation menu, which displays the names of behaviors applied to that parameter.

Choosing a behavior opens the Behaviors Inspector.
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As with all other behaviors, when a Parameter behavior is applied to an object in your 
project, a behavior icon (a gear) appears over the Keyframe button of the affected 
parameter in the Properties, Behaviors, or Filters Inspector where it is applied.

Manage behaviors and behavior timing

Disable, lock, or rename behaviors in Motion
When you apply a behavior to an object, the behavior appears in three places: the Layers 
list, the Timeline, and the Behaviors Inspector.

The Behaviors Inspector contains all editable parameters for a behavior that’s been applied 
to an object. The Layers list and Timeline have several controls for each behavior:

Note: In the Layers list and Timeline, Control-clicking an object’s behavior icon (the small 
gear) opens a shortcut menu that displays behaviors applied to that object. Choose a 
behavior from this menu to display its parameter controls in the Inspector.

Disable the effect of a single behavior
•	 In Motion, deselect the behavior’s activation checkbox in the Layers list, Timeline, or 

Behaviors Inspector.

Behaviors that are disabled have no effect on the object to which they’re applied.

Disable the effect of all behaviors applied to an object or layer
•	 In Motion, click the behavior icon that appears to the right of the object name in the 

Layers list or Timeline.

A slash appears through a disabled behavior’s icon, the behavior names are dimmed, 
and their effect disabled.
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Lock a behavior
•	 In Motion, click the lock icon that appears to the right of a behavior’s name in the 

Layers list or Timeline.

You cannot modify the parameters of a locked behavior.

Show or hide all behaviors
•	 In Motion, click the Show/Hide Behaviors button at the bottom of the Layers list (or at 

the top of the Timeline layers list).

This button neither enables nor disables behaviors applied to objects in your project; it 
merely controls their visibility as objects in the Layers list and Timeline.

Rename a behavior
•	 In the Layers list or Timeline in Motion, double-click a behavior name, enter a new 

name, then press Return.

Copy, paste, or move behaviors in Motion
After you add behaviors to an object, there are a number of ways to copy and move them 
among the other items in the Timeline or Layers list. Behaviors can be cut, copied, pasted, 
or duplicated like any other item in Motion. When you cut or copy a behavior in the Timeline 
or Layers list, you also copy the current states of that behavior’s parameters.

When you duplicate an object, you duplicate all behaviors applied to it. This way, if you’re 
creating a project with a number of objects that use the same behavior, you can apply that 
behavior to the first instance of that object, and then duplicate that object as many times 
as necessary.

Cut or copy a behavior
1.	 In Motion, select a behavior in the Layers list or Timeline.

2.	 Do one of the following:

•	 Choose Edit > Cut (or press Command-X) to remove the behavior and place it on the 
Clipboard.

•	 Choose Edit > Copy (or press Command-C) to copy the behavior to the Clipboard.

Paste a behavior
1.	 In Motion, select an object in the Layers list or Timeline.

2.	 Choose Edit > Paste (or press Command-V).

The cut or copied behavior is applied to the selected object, with all its parameter 
settings intact.



295Motion User Guide

Transfer a behavior from one object to another
You can also move a behavior from one object to another in the Layers list or Timeline by 
dragging it to a new position.

•	 In the Layers list or Timeline in Motion, drag a behavior from one object and drop it on 
top of another.

Note: If you move a Parameter behavior to another object, it’s applied to the same 
parameter it affected in the previous object—as long as the corresponding parameter 
exists. If the parameter does not exist, the parameter assignment (Apply To field) is set 
to None.

Duplicate a behavior
You can also duplicate a behavior in place.

1.	 In Motion, select a behavior in the Layers list or Timeline.

2.	 Do one of the following:

•	 Choose Edit > Duplicate (or press Command-D).

•	 Control-click the behavior to duplicate, then choose Duplicate from the shortcut 
menu.

Note: You can also use the Cut, Copy, and Paste commands from the shortcut menu 
to duplicate a behavior.

Drag a duplicate of a behavior to another object
You can also duplicate a behavior and apply the duplicate to another object in the Layers 
list or Timeline.

•	 In the Layers list or Timeline in Motion, Option-drag a behavior to another object.

The behavior is duplicated and applied to the second object, and the original behavior is 
left in its original location.
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Reorder behaviors
1.	 In the Layers list or Timeline in Motion, drag the behavior up or down in the list of 

nested behaviors applied to the same object.

A position indicator appears.

2.	 When the position indicator is in the correct row, release the mouse button.

All behaviors combine according to a predetermined order of operations (see Behavior 
order of operations) regardless of their order in the Layers list. Therefore, reordering the 
behaviors has no effect on the resulting animations, with a few exceptions:

•	 The Stop behavior suspends the activity of all behaviors beneath it in the Layers list 
that affect the same parameter. The Stop behavior has no effect on behaviors above it 
in the Layers list.

•	 Parameter behaviors are applied in the order that they are added, from the bottom to 
the top in the Layers list, so you need to think about how you are building the operation. 
For example, imagine a circle shape with an X Position of 50 in the canvas. If you apply 
a Rate Parameter behavior with a positive Rate value to the X Position of the circle, the 
circle will move to the right from its starting X Position of 50. If you then apply a Negate 
Parameter behavior to the circle’s X Position, the circle will start at –50 in the canvas 
and move to the left. The effect you see in the canvas is the result of each behavior 
acting upon the previously applied behavior: an X Position value of 50 is modified by the 
Rate behavior (in a positive direction), which is in turn modified by the Negate behavior, 
changing the X Position and rate to negative values.

If you swap the order of Rate and Negate in the Layers list, Negate is processed first. 
The circle’s X Position value of 50 is turned into –50. This is then passed as the input to 
Rate, which moves the circle in a positive direction. Now the circle begins at the –50 X 
Position in the canvas and moves to the right.
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Modify behavior timing

Intro to behavior timing in Motion

You can change a behavior’s timing to control when it starts, how long it lasts, and when it 
stops. There are several ways to do this:

•	 Use the Stop parameter behavior to suspend a behavior’s effect on a single parameter.

•	 Trim the length of a behavior’s bar in the Timeline.

•	 Drag a behavior’s bar left or right in the Timeline.

•	 Change the Start Offset or End Offset parameter to stop a behavior before the end of its 
bar’s duration in the Timeline.

Stop a behavior in Motion

The easiest way to control behavior timing is to use the Stop behavior (in the Parameter 
category). The Stop behavior halts the animation occurring in a single parameter, whether 
the animation is based on keyframes in the Keyframe Editor or behaviors applied to that 
object.

Stop a parameter from animating
1.	 In the Timeline in Motion, move the playhead to the frame where you want animation to 

stop.

2.	 Select the affected object, then open the Properties Inspector.

3.	 Control-click the parameter to stop, choose Add Parameter Behavior from the shortcut 
menu, then choose Stop.

If the behavior was applied to one dimension of a multidimensional parameter, open that 
parameter’s disclosure triangle and Control-click the dimensional parameter to access 
the same shortcut menu, then choose Stop.

The parameter is animated until the frame where the Stop behavior begins.

Note: When applied in this way, the Stop behavior takes effect at the current frame 
(regardless of the Create Layers At setting in Motion Settings).

4.	 To assign the Stop behavior to a different parameter, choose a new parameter from the 
Apply To pop-up menu in the Stop section of the Behaviors Inspector.

The Stop behavior halts the animation of all behaviors that affect the selected parameter 
of that object. For example, if the Gravity, Edge Collision, and Rotate behaviors are applied 
to a shape and you apply the Stop parameter to the shape layer’s Position parameter, the 
shape stops moving but continues rotating.

To control when animation affecting that parameter is stopped, trim the Stop behavior in 
the Timeline. For more information on trimming behaviors, see Trim behaviors.
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Trim behaviors in Motion

When you apply a behavior to an object, the duration of the behavior in the Timeline 
defaults to the duration of the object to which it’s applied. However, a behavior can be 
modified to limit the duration of its effect. For example, if you apply the Spin behavior to 
a replicator layer, by default that replicator spins for its entire duration. If you trim the Out 
point of the Spin behavior, the spinning stops at the new position of the Out point.

As you trim the behavior bar in the Timeline, a tooltip appears, indicating the new location 
of the Out point as well as the new duration of the behavior.

Important: The motion of a Simulation behavior cannot be stopped or changed by trimming 
its duration in the Timeline. See Controlling Simulation behaviors.

Change the duration of a behavior in the Timeline
1.	 In the Timeline in Motion, move the pointer to the In or Out point of any behavior bar.

2.	 When the pointer changes to the trim pointer, do one of the following:

•	 Drag the In point to the right to delay the beginning of the behavior’s effect.

•	 Drag the Out point to the left to end the behavior’s effect before the end of the 
object it’s modifying.

Trimming the Out point of a behavior often sets the object to its original state beyond the 
Out point behavior. For many behaviors, using the Stop behavior to pause the object’s 
animation is a more efficient method than trimming its Out point. Another way to stop 
a behavior’s effect and leave the affected object in the transformed state is to adjust a 
behavior’s Start and End Offset parameters. See Offset Parameter behavior timing for more 
information.
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Controlling Simulation behaviors in Motion

The ideal use for behaviors (with the exception of Motion Tracking behaviors) is creating 
fluid motion graphics that do not require specific timing. This is especially true with the 
Simulation behaviors, which let you create sophisticated interactions among multiple 
objects in your project with minimal editing.

Unlike Basic Motion behaviors, you cannot stop or change the motion of a Simulation 
behavior in the Timeline. However, you can affect the rate of a Simulation behavior by 
modifying its duration in the Timeline. You can also change the starting frame of the 
behavior.

Because the Simulation behaviors mimic natural effects, such as Gravity, the laws of 
inertia apply: An external force sets the object in motion, and that object stays in motion 
even after the active force is no longer present. Changing the duration of a Timeline bar 
for a Simulation behavior does stop the “active” force on the object but does not stop the 
motion of the object. You can, of course, control Simulation behaviors by modifying their 
parameters.

In the following image, the Orbit Around behavior is applied to the small orange circle. The 
large blue circle is assigned as the object that the orange circle moves around. The red 
animation path represents the motion of the small orange circle over its duration. The Orbit 
Around behavior is the same duration as the large circle to which it is applied.

In the next image, the Orbit Around behavior is trimmed in the Timeline to a shorter 
duration than the object to which it is applied. Notice the change in the shape of the 
animation path: Where the Orbit Around behavior ends, the object (the small orange circle) 
stops moving around its target and continues moving off the canvas. The Orbit Around 
behavior—the active force—is no longer present, but the motion of the orange circle does 
not stop.
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Modify behavior timing in Motion

In addition to changing a behavior’s duration, you can also move its position in the Timeline 
relative to the object it’s applied to. This lets you set the frame where that behavior begins 
to take effect.

Move a behavior in the Timeline
1.	 In the Timeline in Motion, click anywhere in the middle of a behavior’s bar.

2.	 Drag the behavior bar to the left or right to move it to another position in the Timeline.

As you move the bar, a tooltip displays the new In and Out points for the behavior. The 
tooltip also displays the delta value, which shows the number of frames you’ve moved 
the bar.

Offset Parameter behavior timing in Motion

Many Parameter behaviors have two additional parameters, Start Offset and End Offset, 
used to change the frame where a Parameter behavior’s effect begins and ends.

Use the Start Offset slider to delay the beginning of the behavior’s effect, relative to the 
first frame of its position in the Timeline. Adjust this parameter to make the Parameter 
behavior start later.

Use the End Offset slider to extend the behavior’s effect relative to the last frame of its 
position in the Timeline. Using this slider to stop the effect, instead of trimming the end of 
the behavior bar in the Timeline, lets you freeze the behavior’s effect on the object for its 
remaining duration.

The following example shows how to use the Start Offset and End Offset parameter with 
the Ramp behavior (applied to the Scale parameter of a shape).

Use the Start Offset and End Offset parameters
1.	 In the Layers list, Timeline, or canvas in Motion, select an image layer, such as a shape.

2.	 In the Properties Inspector, Control-click the Scale parameter, then choose 
Add Parameter Behavior > Ramp from the shortcut menu.

The Ramp behavior is applied to the Scale parameter of the layer, and the Behaviors 
Inspector opens. The Ramp behavior lets you create a gradual transition in any 
animatable parameter.
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3.	 Set the Start Value to 0 and the End Value to 200, then play the project.

The layer scales from its original size to twice its original size over the duration of the 
layer.

4.	 Set the Start Offset to 90 and the End Offset to 90.

The layer does not begin scaling until frame 90, and stops scaling 90 frames from its 
last frame in the Timeline.

Behavior order of operations in Motion
There’s no limit to the number of behaviors you can add to an object. Multiple behaviors 
applied to a single object work together to create a final animated effect.

In general, each behavior applies a value to a specific parameter. The values generated by 
all behaviors that affect the same parameters are combined to create the end result. For 
example, if you apply the Throw, Spin, and Gravity behaviors to a single object, the Throw 
and Gravity behaviors combine to affect the position of the object. The Spin behavior 
affects the rotation of the object.

When combining different behavior types (such as Parameter and Simulation behaviors) or 
combining behaviors and keyframes, it’s important to understand the behaviors’ order of 
operations. Motion evaluates behaviors and keyframes in the following order:

1. Keyframes

2. Simulation behaviors

3. All other behaviors

Parameter behaviors are applied in the order in which they are added, from the bottom of 
the Layers list up (like the order of filters and the compositing order of image layers). See 
Copy, paste, or move behaviors.

Important: The order of operations is always in effect—regardless of the order in which 
behaviors are applied or keyframes are added to a layer or group.

Use the following guidelines for animating objects with multiple behaviors or keyframes:

•	 When you animate an object with keyframes and then apply a behavior, the effect of the 
keyframes is evaluated first.

For example, if you animate the Rotation parameter of an object using keyframes and 
then apply a Rotational Drag (Simulation) behavior to the object, Motion evaluates the 
keyframed rotation, and then applies the drag (from the Simulation behavior) to the 
keyframed animation.

•	 When you animate an object with any behavior and then add keyframes, the effect of 
the keyframes is evaluated first.

For example, if you animate an object so it rotates in a clockwise direction using the 
Spin behavior and then keyframe the Rotation parameter so the object rotates in a 
counterclockwise direction, the object rotates in the counterclockwise direction. Motion 
always evaluates keyframes first.

•	 When you animate an object with a behavior and then apply a Simulation behavior, the 
Simulation behavior is evaluated before the first behavior (and therefore may have no 
effect).
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For example, if you animate the Rotation parameter of an object using the Oscillate 
(Parameter) behavior and then apply a Rotational Drag (Simulation) behavior to the 
object, the object oscillates, but is not slowed by the Rotational Drag behavior. Motion 
evaluates the Simulation behavior (Rotational Drag) before the Parameter behavior 
(Oscillate), applying the drag to a 0 value. There is no data for the Simulation behavior 
to affect.

Note: Although the Spin behavior appears in the Basic Motion category, Spin is treated 
as a Simulation behavior in the order of operations.

For information on combining keyframes with behaviors, see Combining behaviors with 
keyframes.

Behaviors and keyframes

Combining behaviors with keyframes in Motion
Any object can have behaviors and keyframes applied to it simultaneously. When this 
happens, the values generated by the behavior and the keyframed values applied to the 
parameter are combined to yield the final value for that parameter. This lets you combine 
the automatic convenience of behaviors with the direct control of keyframing to achieve 
your final result.

Note: Motion has a specific order of operations for keyframes and behaviors. See Behavior 
order of operations.

For example, if you create an animation path using keyframes, you can create a completely 
predictable and smooth movement.

However, if you apply the Randomize parameter behavior to the same object, its effect 
combines with the keyframed motion path you created. As a result, the animation path 
follows the general direction you want, with random variation in it to make it interesting.

Although this example shows how you can combine behaviors and keyframes to create 
animation paths, you can combine behaviors and keyframes for any parameter.
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Behaviors and keyframes in the Keyframe Editor in Motion
When you keyframe a parameter that’s already affected by a behavior, the keyframes add 
to or subtract from the effect of the behavior. This effect is shown in the Keyframe Editor, 
which displays two curves for each parameter modified by both a behavior and one or more 
keyframes:

•	 A bold, editable curve displaying the effect of keyframes on the parameter

•	 A lighter, noneditable curve displaying the combined effect of the behavior and 
keyframes on the parameter at each frame.

Dragging a keyframe on the bold curve also modifies the lighter curve, because the 
keyframe is modifying the values generated by the behavior.

Important: The value displayed in the Inspector for the affected parameter reflects 
the combined result of keyframes and behaviors applied to that parameter. Editing a 
parameter’s values in the Inspector only results in changes made to the underlying 
parameter value, whether keyframed or not. This parameter value is then combined with 
the behavior’s effect, yielding a final value that might differ from the value you entered.

When you combine keyframes with multiple behaviors, the results can appear to be 
unpredictable, depending on the combination of behaviors applied.

Keyframing parameters in behaviors in Motion
You can also apply keyframes to specific parameters of behaviors in your project. Doing 
so gives you more control when animating a behavior’s parameters. For example, you can 
keyframe the Speed parameter of the Oscillate parameter behavior to increase the rate of 
oscillation over time, creating a more complex animation path.

For more information about keyframing the parameters of behaviors, see Apply keyframes 
to behaviors.



304Motion User Guide

Convert behaviors to keyframes in Motion
Behaviors are best suited for fluid effects in which precise timing is not necessary. 
However, there might be projects in which you want finite control over the animated effects 
created with behaviors. If necessary, several of the behaviors can be baked into keyframes. 
This means that the animation curves created by the behaviors (which have no keyframes) 
can be converted into keyframed animation curves. You can then modify the keyframes in 
the Keyframe Editor to meet more precise timing requirements.

Because many (though not all) behaviors affect shared object parameters, when you 
convert a behavior to keyframes, all other behaviors applied to the same object are also 
converted into keyframes. The keyframes are applied to the individual parameters that the 
behaviors originally affected. Additionally, when behaviors applied to other objects affect 
the object being converted (for example, the Attractor or Repel behavior), their effect is 
baked into the object’s resulting keyframes value. The original behaviors remain applied 
to the other objects, but the resulting effect is not doubled as a result of the keyframes 
combining with the behavior.

Convert behaviors to keyframes
1.	 In Motion, do one of the following:

•	 In the Layers list, select an object that has behaviors to convert.

•	 In the Inspector, select a behavior to convert.

2.	 Choose Object > Convert to Keyframes (or press Command-K).

A dialog asks you to confirm the conversion to keyframes.

3.	 Click Convert.

All behaviors are converted into keyframes, even if some of the behaviors fall outside of 
the object’s time range.

Converting a behavior to keyframes can result in a very large number of keyframes. 
You can simplify your keyframes using the Reduce Keyframes command. See Simplify a 
keyframe curve.

Note: You cannot selectively convert individual behaviors. The Convert to Keyframes 
command converts all behaviors applied to an object.

You cannot convert many of the Simulation, Replicator, Particle, or Text behaviors into 
keyframes. Simulation behaviors such as Vortex can affect the parameters of all objects in 
a project, and baking such a behavior would create an overwhelming amount of keyframes. 
Such behaviors are designed to create very complex motion that would be too time-
consuming to keyframe manually.

If a behavior (or an object with applied behaviors) can be baked, the Convert to Keyframes 
command appears in the Object menu when the behavior or object is selected. If the 
Convert to Keyframes command is dimmed, keyframes cannot be generated from the 
behavior.
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Adjust behaviors

Intro to adjusting behaviors in Motion
You edit behavior parameters in the Behaviors Inspector or in the HUD. All behavior 
parameters appear in the Behaviors Inspector. Each behavior has a subset (or sometimes a 
complete set) of parameters that appear in the HUD. The HUD and the Behaviors Inspector 
reference the same parameters, so changing a parameter in one changes the same 
parameter in the other.

In general, the parameters that appear in the HUD are the most essential for modifying 
that behavior’s effect. Frequently, the controls available in a behavior’s HUD are more 
descriptive and easier to use than those in the Behaviors Inspector.

For example, the Fade In/Fade Out behavior HUD contains a graphical control for adjusting 
a layer’s fade time.

However, the Fade In/Fade Out Behaviors Inspector contains standard sliders for adjusting 
a layer’s fade time.
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Adjust behaviors in Motion
You can modify an applied behavior by adjusting its parameter controls in the Behaviors 
Inspector or in the HUD.

Display the HUD for a behavior
•	 In Motion, do one of the following:

•	 Select the behavior to modify in the Layers list, Timeline, or Behaviors Inspector.

•	 Control-click an object in the canvas, then choose a behavior from the Behaviors 
submenu in the shortcut menu.

Note: If the HUD doesn’t appear, choose Window > Show HUD (or press F7 or D).

Display the Behaviors Inspector
1.	 In Motion, select an object with an applied behavior.

2.	 Do one of the following:

•	 In the Inspector, click Behaviors (if that pane is not already showing).

•	 Click the “i” in the upper-right corner of the behavior’s HUD.

•	 If the Library is displayed, press Command-3.

Edit multiple behaviors at the same time
If you’ve applied the same behavior to multiple objects, you can modify all instances of that 
behavior at the same time.

1.	 In the Layers list or the Behaviors Inspector in Motion, Command-click to select multiple 
behaviors of the same type.

For example, you might select all Throw behaviors applied to different objects in your 
project.

2.	 Do one of the following:

•	 In the HUD titled “Multiple Selected,” adjust the parameter controls.

•	 In the Behaviors Inspector, adjust the parameter controls.

Only behaviors that apply are available. When you adjust the parameters, all selected 
behaviors are modified.

For detailed information about the adjustable parameter controls in each type of behavior, 
see the following:

Intro to basic Motion behaviors

Intro to Parameter behaviors

Intro to Retiming behaviors

Intro to Simulation behaviors

Additional behaviors
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Behavior types and parameters

Intro to behavior types in Motion
There are 11 kinds of behaviors in Motion:

•	 Audio behaviors: Create simple audio effects, such as fade-ins and fade-outs, pans, and 
fly-bys. See Intro to audio behaviors.

•	 Basic Motion behaviors: Create common animation effects such as rotation, scaling, 
motion paths, fade-ins, fade-outs, and more. See Intro to basic Motion behaviors.

•	 Camera behaviors: Animate points of view by creating basic camera moves such as 
dollies, pans, and zooms. See Add Camera behaviors.

•	 Motion Tracking behaviors: Analyze the motion present in video clips to stabilize camera 
shake or pin moving objects to one another (match move). See Intro to tracking.

•	 Parameter behaviors: Animate a specific parameter of any object, including filters, 
behaviors, cameras, and lights. For example, you can apply the Oscillate behavior to 
text opacity to make letters fade in and out. See Intro to Parameter behaviors.

•	 Particles behaviors: Animate individual particles in a particle system. See Apply 
behaviors to particles.

•	 Replicator behaviors: Animate replicator patterns to build stunning kaleidoscopic 
effects. See Apply the Sequence Replicator behavior.

•	 Retiming behaviors: Change the playback speed of footage to create slow-motion and 
fast-motion effects, freeze frames, reverse playback, or strobe and stutter frames. See 
Intro to Retiming behaviors.

•	 Shape behaviors: Animate the vertices of shapes or masks to create morphing polygons 
and other effects. See Intro to Shape behaviors.

•	 Simulation behaviors: Apply real-world simulation animations, such as gravity, orbital 
attraction, repelling force, and edge collision to create sophisticated interactions among 
multiple objects in your project. See Intro to Simulation behaviors.

•	 Text behaviors: Set your text in motion to create advanced titling effects. See Intro to 
animated text and Apply the Sequence Text behavior.

Note: Audio, Camera, Motion Tracking, Particles, Replicator, Shape, and Text behaviors are 
discussed in their respective chapters.
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Basic Motion behaviors

Intro to basic Motion behaviors

Basic Motion behaviors animate specific parameters of the object to which they’re applied. 
Some affect position, while others affect scale, rotation, or opacity. 

There are nine Basic Motion behaviors:

•	 Align To behavior aligns a target object to an animated source object.

•	 Fade In/Fade Out behavior makes an object dissolve into view or fade away.

•	 Grow/Shrink behavior makes an object enlarge or reduce its size over time.

•	 Motion Path behavior creates a spline path for an object to move along.

•	 Move behavior pulls an object to a target point in the canvas.

•	 Point At behavior causes an object to turn toward a target point.

•	 Snap Alignment to Motion behavior points an object in the direction it’s moving on an 
animation path.

•	 Spin behavior rotates an object around a single axis.

•	 Throw behavior pushes an object in a single direction.

Note: Building consecutive Basic Motion behaviors or placing a Basic Motion behavior 
before or after the Camera Framing behavior can create unexpected results. These 
behaviors can continue to affect the object even after the behavior ends, thus influencing 
the subsequent behavior’s animation path. For example, if a Framing behavior is applied 
after a Motion Path behavior, the residual effect of the Motion Path behavior is combined 
with the animation path generated by the Framing behavior. Consequently, the target 
object might be framed improperly. For information about Camera behaviors, see Add 
Camera behaviors.

Align To behavior in Motion

The Align To behavior lets you dynamically align the position of a target object to the 
position of a source object. The behavior can be static, so that the target object is always 
aligned to the source object; or the behavior can be animated, so that the target object 
aligns to the source object over time. The scale of the source object is also considered in 
the target object’s alignment (the size of the target object does not change).

This behavior is ideal for creating dynamic slide transitions in which images pull or push 
each other onscreen and offscreen, or animations in which a shape remains aligned to text 
even as the text changes size.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Object: An image well into which you drag the source object.

•	 Align: A pop-up menu that sets the target object’s alignment axis with the source 
object.

•	 To: A pop-up menu that sets the source object’s alignment axis with the target object.
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When the source or target object is a text layer, additional alignment options are 
available:

•	 Text Baseline: Aligns to the line on which the text rests and below which the 
descenders extend.

•	 Text Ascender: Aligns to the portion of lowercase text that is taller than the text’s 
x-height.

•	 Text Descender: Aligns to the portion of text that extends below its baseline.

•	 Text Cap Height: Aligns to the height of the text’s capital letters above the baseline.

•	 Text X-Height: Aligns to the height of the lowercase text.

Each of the text options has an additional submenu to set left, right, or center 
alignment.

•	 Target Alignment: Value sliders that allow you to set the target object’s alignment axis 
anywhere on the source object. This parameter is available only when Custom is chosen 
from the Align pop-up menu.

•	 Source Alignment: Value sliders that allow you to set the source object’s alignment axis 
anywhere on the target object. This parameter is available only when Custom is chosen 
from the To pop-up menu.

•	 Offset: Value sliders that move the target object away from the axis chosen in the Align 
pop-up menu.

•	 Alignment: A pop-up menu that controls how the target object moves with the source 
object (when the source object changes over time). There are two choices:

•	 Continuous: Dynamically aligns the target to the source’s current size and position 
on every frame.

•	 Fixed Frame: Aligns the target object to a specific frame along the behavior’s 
duration. When Fixed Frame is chosen from the Alignment pop-up menu, an 
additional parameter becomes available:

•	 Align Frame: A slider that sets the frame used for the Fixed Frame parameter. For 
example, when Align Frame is set to 100 percent, the target object is aligned to 
the last frame of the behavior; when Fixed Frame is set to 0 percent, the target 
object is aligned to the first frame of the behavior.

•	 Transition: A pop-up menu that sets how the target object is animated from its current 
position to its new position over the duration of the behavior (the interpolation method). 
The value can be set to None, Constant, Ease In, Ease Out, Ease Both, Accelerate, 
Decelerate, or Custom. For example, when Ease In is chosen, the animation begins 
slowly and increases to normal speed as it moves through the duration of the behavior.

When Custom is chosen from the Transition pop-up menu, an additional parameter 
becomes available:

•	 Custom Amount: A slider that allows you to keyframe the target object’s animation 
(from nonaligned to aligned). By default, a keyframe is set at the first and last points 
of the behavior to create an animation of 0 percent to 100 percent, where at 0 the 
target object is at its original position, and at 100 the target object is fully aligned 
with the source object (according to the Align To parameter settings).

For more information on interpolation, see Curve interpolation methods.
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When Constant, Ease In, Ease Out, Ease Both, Accelerate, or Decelerate is chosen from 
the Transition pop-up menu, an additional parameter becomes available:

•	 End Offset: A slider to offset the end of the effect of the Align To behavior. By 
default, the align animation is in effect until the end of the behavior. For example, to 
stop the animation 60 frames from the end of the object (or project), drag the End 
Offset slider to 60 or enter 60 in the adjacent value slider. Using this slider to stop 
the effect, rather than trimming the end of the behavior in the Timeline, freezes the 
end of the effect for the remaining duration of the object. Trimming the end of the 
behavior resets the text to its original settings. 

•	 Ignore Sequencing: A checkbox that instructs the Align To behavior to ignore any 
source object animation created by a text sequence behavior.

Note: In addition to adjusting the target object in the Inspector, you can modify the target 
object’s position by dragging the behavior’s onscreen control in the canvas. Dragging the 
onscreen control modifies the Offset parameter.

Fade In/Fade Out behavior in Motion

The Fade In/Fade Out behavior lets you dissolve into and out of any object by ramping the 
opacity of the object from 0 percent to 100 percent at the start, and then back to 0 percent 
at the end. You can eliminate the fade-in or fade-out effect by setting the duration of the 
Fade In Time or Fade Out Time to 0 frames.

The Fade In/Fade Out behavior is useful for introducing and removing animated elements. 
For example, you can apply the Fade In/Fade Out behavior to text that moves across the 
screen to make it fade into existence, and then fade away at the end of its duration.

Note: You cannot apply the Fade In/Fade Out behavior to a camera or light. 

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Fade In Time: A slider defining the duration, in frames, over which the object fades in 
from 0 to 100 percent opacity from the first frame of the object. A duration of 0 frames 
results in a straight “cut” into the object, making it appear instantly.

•	 Fade Out Time: A slider defining the duration, in frames, over which the object fades 
out from 100 to 0 percent opacity at the last frame of the object. A duration of 0 frames 
results in a straight cut-away from the object, making it disappear instantly.

•	 Start Offset: A slider that lets you delay the beginning of the behavior’s effect relative 
to its first frame in the Timeline. Adjust this parameter to make the behavior start later. 
This parameter value is measured in frames.

•	 End Offset: A slider that lets you offset the end of the behavior’s effect relative to its 
last frame in the Timeline, in frames. Adjust this parameter to make the behavior stop 
before the end of the behavior bar in the Timeline.

The HUD lets you set the Fade In and Fade Out durations with a graphical control. Drag 
anywhere in the shaded area of the Fade In or the Fade Out ramp to adjust the duration of 
the effect.
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Note: Continue dragging beyond the limits of the graphical HUD control to extend the 
durations of the Fade In or Fade Out.

Note: This behavior is multiplicative; this means that the Fade In and Fade Out parameters 
are multiplied by the object’s current opacity to produce the resulting level of transparency. 

Grow/Shrink behavior in Motion

The Grow/Shrink behavior lets you animate the scale of an object, enlarging or reducing its 
size over time. At the first frame of the behavior, the object appears at its original size; the 
settings of the behavior determine whether the object grows or shrinks over the duration 
of the effect. The vertical and horizontal growth rates can be set to independent values, for 
asymmetrical effects.

You can use the Grow/Shrink behavior with high-resolution graphics to zoom into an image, 
such as a map or photograph. You can combine this behavior with the Throw or Wind 
behavior to pan across the image while zooming into it. The Grow/Shrink behavior can 
also be used to emphasize or de-emphasize images in your project. For example, you can 
enlarge an object to make it the center of attention, or shrink the object while introducing 
another object to move the viewer’s eye to the new element.

Note: You cannot apply the Grow/Shrink behavior to a camera or light.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Increment: A pop-up menu that sets how the behavior’s effect progresses over its 
duration in the Timeline. There are three options:

•	 Continuous Rate: Uses the Scale Rate parameter to grow or shrink the object by a 
steady number of pixels per second.

•	 Ramp to Final Value: Grows or shrinks the object from its original size to the 
specified percentage plus the original scale in the Scale To parameter. If the 
behavior is shortened in the Timeline, the Grow/Shrink effect occurs faster.

•	 Natural Scale: Uses an exponential curve so that the animation progresses slowly 
when the scale values are small, and speeds up when the values are large, creating 
the illusion of scaling at a constant speed. This is the default option.

•	 Scale Rate/Scale To: A slider that sets the speed and magnitude of the effect 
(depending on the command chosen in the Increment pop-up menu). Click the 
disclosure triangle to reveal X and Y sliders that adjust horizontal or vertical scale 
independently.



312Motion User Guide

•	 Curvature: A slider that adjusts the acceleration from the original to the final size. 
Higher Curvature values ease into and out of the effect. Because Curvature is defined 
by the length of the behavior in the Timeline, minus the End Offset, this setting does 
not affect the overall duration of the effect.

Note: The Curvature parameter is not available when the Increment parameter is set to 
Natural Scale.

•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline.

The HUD consists of two rectangular regions. The first, a rectangle with a dotted line, 
represents the original size of the object. The second, a solid rectangle, represents the 
relative growth rate. Drag a border of the solid rectangle to grow or shrink the object. Drag 
the slider to adjust the scale of the HUD controls, increasing or decreasing their effect.

Motion Path behavior in Motion

The Motion Path behavior lets you create a 2D or 3D motion path for an object to follow. 
When you apply this behavior, the motion path defaults to an open spline: a straight line 
defined by two points at the beginning and end of the path. You can also choose from 
preset path shapes, such as a closed spline, loop, rectangle, or wave, or use a shape to 
define a path. A shape used as the source for a motion path can be animated.

For more information on customizing the Motion Path behavior, see Work with the Motion 
Path behavior.

The first point on the path is the position of the object in the canvas at the first frame of 
the behavior. Option-click anywhere on the path to add Bezier points, which allow you to 
reshape the motion path by creating curves.
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When you play the project, the object moves along the assigned path. (To show or hide the 
motion path, choose Show Overlays from the View pop-up menu above the canvas.) The 
speed at which the target object travels is defined by the duration of the behavior. Speed is 
also affected by the Speed parameter, which lets you modify the object’s velocity—adding 
acceleration and deceleration at the beginning and end of the behavior, for example. You 
can also create a custom preset defining how the object travels along the path.

Note: When you switch between the Path Shape options, the Inspector and the HUD 
display parameters specific to the selected option.

The Motion Path behavior is an easy way to create predictable motion without using the 
Keyframe Editor. It’s also a great way to create reusable motion paths that you can save in 
the Library for future use.

When the Motion Path behavior is added to an object, the Adjust Item tool is selected, 
allowing you to modify the default path in the canvas by adding points and using the Bezier 
(or B-Spline) controls attached to each point to adjust each curve. You can also move and 
resize preset motion path shapes, such as a rectangle or wave, in the canvas.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Path Shape: A pop-up menu that defines the shape of the path on which the object 
travels. Choose one of the following path shapes:

•	 Open Spline: The default shape, a straight path defined by two points at the 
beginning and end of the path. You can choose to work with Bezier or B-Spline 
control points. Option-click (or double-click) anywhere on the path to add points.

Note: You cannot add points to a motion path when Circle or Rectangle is selected 
from the Path Shape pop-up menu. To change the shape of a path when Geometry is 
selected from the Path Shape pop-up menu, edit the source shape.

•	 Closed Spline: A closed path with the last point in the same location as the first 
point. You can choose to work with Bezier or B-Spline control points. Option-click (or 
double-click) anywhere on the path to add points.

•	 Circle: A simplified version of Closed Spline, in which the X radius or Y radius can 
be adjusted to create a circle or an ellipse. Use the outer control points to resize the 
circle (or rectangle) motion path’s shape.

•	 Rectangle: A closed path in which the width and the height can be adjusted to create 
a square or a rectangle.

•	 Wave: A wavy path (a sine wave) defined by two points, one at the beginning and 
one at the end of the path, and controlled by the End Point, Amplitude, Frequency, 
Phase, and Damping parameters.
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•	 Geometry: A path based on a shape or mask. The object travels along the edge of 
the shape or mask. In the following image, the outline of the shape on the left is 
used as the motion path in the composition shown on the right.

Note: The Path Shape parameters work similarly to text on a path. For more 
information about working with text on a path, see Create text on a path.

•	 Shape Type: A pop-up menu (available when Path Shape is set to Open Spline or Closed 
Spline) that sets how the path is manipulated, using Bezier or B-Spline control points.

•	 Bezier: Lets you manipulate the path manually by dragging Bezier handles.

Note: For more information about creating and adjusting Bezier curves, see Edit 
Bezier control points.

•	 B-Spline: Lets you manipulate the path by dragging B-Spline control points. The 
points themselves do not lie on the surface of the shape. Instead, each B-Spline 
control point is offset from the shape’s surface, “magnetically” pulling that section 
of the shape toward itself to create a curve. B-Splines are extremely smooth—by 
default, there are no sharp angles in B-Spline shapes, although you can create 
sharper curves, if necessary.

Note: For more information about working with B-Spline curves, see Edit B-Spline 
control points.

•	 Radius: A slider (available when Circle is the defined path shape) that sets the size 
of the circular path. Click the disclosure triangle to adjust the X radius and Y radius 
independently.

Note: When the Motion Path behavior is selected, you can also drag the onscreen 
control points to resize the circle. Press Shift while dragging to resize the X and Y radii 
uniformly.

•	 Size: A slider (available when Rectangle is the defined path shape) that modifies the 
size of the rectangular path. Click the disclosure triangle to adjust the X scale and Y 
scale independently.

Note: When the Motion Path behavior is selected, you can also drag the onscreen 
control points to resize the rectangle. Press Shift while dragging to resize the X and Y 
scales uniformly.

•	 Offset: A slider (available when Circle, Rectangle, or Geometry is the defined path 
shape) that sets where the object starts moving on the path.

•	 End Point: Value sliders (available when Wave is the defined path shape) that set the 
location of two default points on the wave’s path. The end points can also be adjusted 
using the wave’s onscreen controls (active by default when the Motion Path behavior is 
selected). Moving the left end point moves the entire path; moving the right end point 
lengthens, shortens, or angles the path.
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•	 Amplitude: A slider (available when Wave is the defined path shape) that defines half 
the distance from the highest point to the lowest point in the wave. Higher values result 
in more extreme waves.

•	 Frequency: A slider (available when Wave is the defined path shape) that sets the 
number of waves. Higher values result in more waves.

•	 Phase: A dial (available when Wave is the defined path shape) that defines the degree 
of the offset of waves from the start and end points of the path. When Phase is set to 
0 degrees (default), the wave begins and ends at half the distance from the highest 
point to the lowest point in the wave. When Phase is set to 90 degrees, the wave begins 
and ends at the highest point in the wave. When set to –90 degrees, the wave begins 
at the lowest point in the wave. When set to 180 degrees, the waves are the same as 0 
degrees, but inverted.

•	 Damping: A slider (available when Wave is the defined path shape) that progressively 
diminishes the oscillation of the wave. Positive values diminish the wave forward (from 
left to right); negative values diminish the wave backward (from right to left). The 
following illustration shows positive damping applied to the wave motion path.

•	 Attach to Shape: A checkbox (available when Geometry is the defined path shape) that, 
when selected, forces the motion path to follow the source shape at its original location. 
When disabled, the motion path can exist in a location other than its source shape.

Note: When Attach to Shape is selected, you cannot move the object to another 
location.

 Tip: To align the rotation of an object to match all changes made to its position along 
an animation path, apply the Snap Alignment to Motion behavior. See Snap Alignment to 
Motion behavior.

•	 Shape Source: An object well (available when Geometry is the defined path shape) 
that specifies the object (a shape or mask) used as the motion path source. Choose an 
available shape from the adjacent To pop-up menu, or drag a shape from the Layers list 
into the object well.

•	 Direction: A pop-up menu that defines the object’s direction along the path. There are 
two options:

•	 Forward: The object moves in a forward direction along the path (from the start point 
to the end point, depending upon the Offset parameter).

•	 Reverse: The object moves in a backward direction along the path (from the end 
point to the start point, depending upon the Offset parameter).

Note: The Offset parameter is available when Path Shape is set to Circle or 
Rectangle.
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•	 Speed: A pop-up menu that defines the object’s velocity from the first to the last point 
in the motion path. There are eight choices:

•	 Constant: The object moves at a steady speed from the first to the last point on the 
motion path.

•	 Ease In: The object starts at a slow speed, then reaches and maintains a steady 
speed through the last point on the motion path.

•	 Ease Out: The object starts at a steady speed, then gradually decelerates to a stop 
at the last point of the motion path.

•	 Ease Both: The object slowly accelerates from the first point on the motion path, 
then gradually decelerates to a stop at the last point of the motion path.

•	 Accelerate: The object moves along the path with increasing speed.

•	 Decelerate: The object moves along the path with decreasing speed.

•	 Natural: The speed at which the object moves over the path is determined by the 
shape of the path. For example, if the path is a U-shape curve, the object moves 
faster as it moves toward the low point of the U and slower as it moves up the edges.

•	 Custom: Object speed is defined by keyframes for the object’s speed from 0 to 100 
percent. In other words, you determine the position of the object along the path in 
time.

•	 Custom Speed: A slider (available when Speed is set to Custom) that modifies the 
Custom Speed velocity curve in the Keyframe Editor. For example, you can keyframe 
custom values to make an object travel forward to a specific percentage of the path, 
then backward, then forward, and so on before reaching the end of the animation.

•	 Apply Speed: A pop-up menu that determines how the Speed parameter (velocity) is 
applied over the duration of the behavior. (Loops must be set to a value greater than 1 
for the Apply Speed parameter to have any effect.) There are two choices:

•	 Once Per Loop: The velocity, as defined by the Speed parameter, is applied to each 
cycle. For example, if Loops is set to 3 and Speed is set to Accelerate, the object 
accelerates each time it travels over the path. The speed is applied to the entire 
duration, ignoring the Loops setting.

•	 Over Entire Duration: The velocity, as defined by the Speed parameter, is applied one 
time over the duration of the behavior. For example, if Loops is set to 3 and Speed 
is set to Accelerate, the object accelerates the first time it travels over the path, but 
not the second and third time.

•	 Loops: A slider that sets the number of times the object travels the motion path over the 
duration of the behavior. For an object to travel its path more than once, or to “ping-
pong,” loops must be set to a value greater than 1.

•	 End Condition: A pop-up menu that defines the behavior of the object after it reaches 
the end of its motion path. There are two options:

•	 Repeat: The object travels the motion path the number of times defined by the Loop 
parameter.

•	 Ping-Pong: The object moves along the path until it reaches the last point on the 
path, then moves backward to the first point on the path. The number of “ping-
pongs” is defined by the Loops parameter.
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•	 Control Points: Value sliders (available when the path shape is Open Spline or Closed 
Spline) that set the X, Y, and Z coordinates of the motion path control points. (Click the 
disclosure triangle to display the X, Y, and Z value sliders.)

Note: You cannot apply Parameter behaviors to the control points.

Work with the Motion Path behavior

The following tasks demonstrate how to customize the Motion Path behavior.

Change the shape of the motion path
With an applied Motion Path behavior selected in the Layers list, Timeline, or Behaviors 
Inspector, do any of the following:

•	 In the Behaviors Inspector in Motion, click the Path Shape pop-up menu, then choose a 
shape option.

•	 If Path Shape is set to Open Spline or Closed Spline, double-click the motion path in the 
canvas to add control point points, and then edit the points. See Intro to editing control 
points.

•	 If Path Shape is set to Circle, Rectangle, or Wave, drag the transform handles in the 
canvas.

•	 If Path Shape is set to Geometry, modify the shape of the source geometry.

Use geometry for a motion path shape
You can use a shape animated with behaviors or keyframes as the source for a motion 
path. This includes animated transforms (a shape changing its location in the canvas) and 
animated control points (a shape changing its shape due to keyframed control points).

1.	 In Motion, import (or draw) the shape to use as the path source.

2.	 With an applied Motion Path behavior selected, open the Behaviors Inspector, then 
choose Geometry from the Path Shape pop-up menu.

The Shape Source well appears in the Inspector and HUD.

3.	 From the Layers list, drag the shape you created in step 1 into the Shape Source well, 
and when the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and the shape is used as the source shape 
for the motion path.

Note: You can disable the source shape in the Layers list (by deselecting its activation 
checkbox) so that the source shape is not visible in your project.

Select another geometry source for a motion path shape
•	 In Motion, with an applied Motion Path behavior selected, open the Behaviors Inspector, 

click the To pop-up menu (located next to the Shape Source well), then choose the 
object to use as the motion path’s shape source.

Note: To align the rotation of the object to the shape of its motion path, you can apply 
the Snap Alignment to Motion behavior (in the Basic Motion behaviors subcategory).
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Move the object and its motion path
•	 In the Layers list or canvas in Motion, select the object (not the Motion Path behavior), 

then drag the object in the canvas.

Note: To move the object and its motion path when Path Shape is set to Geometry, 
select the source object, then move the object in the canvas.

Distance the object from the path
By default, the object is locked to the motion path by its anchor point.

•	 In the canvas toolbar in Motion, click and hold the transform tools pop-up menu, choose 
Anchor Point, then drag the anchor point in the canvas.

For more information on using the Anchor Point tool, see Move a layer’s anchor point.

Note: A separate Offset parameter lets you offset the starting location of the object on 
the motion path (but does not offset the object from the path).

Use the Custom Speed parameter
1.	 In the Layers list in Motion, select an applied Motion Path behavior.

2.	 In the Behaviors Inspector or HUD, click the Speed pop-up menu, then choose Custom.

The Custom Speed parameter control becomes available. By default, a keyframe is set 
at the first and last points of the behavior to create an animation of 0 percent to 100 
percent, where at 0 the object is at the beginning of the path, and at 100 the object is 
at the end of the path. This is the same velocity used with the Constant preset.

3.	 Press A to turn on keyframe recording.

Note: When keyframe recording is on, all keyframeable parameter value sliders are 
tinted red, to remind you that any value change entered creates a keyframe.

4.	 Move the playhead to the position where you want to create a keyframe, then enter a 
percentage value in the Custom Speed field.

For example, a value of 90 moves the object 90 percent of the way through the motion 
path.

5.	 Continue moving the playhead and adding keyframes to obtain the result you want, then 
press A again to turn off keyframe recording.

Note: If you change the Speed parameter to a preset (such as Constant) after creating a 
custom speed, the custom velocity channel is ignored but remains intact.
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Adjust a motion path in 3D space
The easiest way to modify a motion path in 3D space is to add a camera to your project and 
manipulate the path in a modified camera view.

1.	 If there’s no camera in your Motion project, add a camera by doing one of the following:

•	 In the toolbar, click Add Object, then choose Camera from the pop-up menu.

•	 Choose Object > New Camera (or press Option-Command-C).

Note: If none of your project groups are set to 3D, a dialog appears asking if you 
want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera 
to affect the groups.

2.	 Do one of the following:

•	 Click the pop-up menu in the upper-left corner of the canvas (the default option is 
Active Camera), then choose a camera view. This example uses the Top view.

•	 With the Active Camera (or another camera view) selected, drag in the Orbit tool (the 
center tool in 3D view tools in the upper-right corner of the canvas) to rotate the 
camera manually to a new view.

Note: If you use the 3D view tools with any camera selected, you are moving the 
camera, not just changing the camera view.

Depending on the camera view, the object on the path might not be visible. For 
example, if the object has not been rotated in X or Y space and you are working in 
Top view, the camera is looking down perpendicularly (on the Y axis) on the object. 
The motion path and its points are still visible (as long as the Motion Path behavior is 
selected).

In the following image, the motion path appears flat when viewed from above—the 
affected object only moves in X and Y space.
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3.	 Drag a control point up or down to adjust the object in Z space.

In the following image, the path is no longer flat—the affected object moves in X, Y, and 
Z space.

To enter specific values for the control point locations, click the Control Points 
disclosure triangle in the Motion Path behavior parameters. The first value field is X, the 
second value field is Y, and the third value field is Z.

4.	 To reset the camera view, do one of the following:

•	 Double-click the 3D view tool that you previously adjusted. For example, if you 
dragged the Orbit tool to rotate the current camera, double-click the Orbit tool to 
reset the camera.

•	 If you chose (or modified) a default camera view (such as Top, Right, Left, and so 
on), choose Active Camera from the Camera menu, or choose View > 3D View > 
Active Camera.

•	 With the camera selected, click the reset button in the Properties Inspector.

For more information about working with cameras in a 3D project, see Intro to 3D cameras.
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Move behavior in Motion

The Move behavior places a point in the canvas that creates a specific location for an 
object or group to move toward or away from in a straight line. When used with other 
behaviors, Move can create complex motions. For example, in the following illustration, an 
Orbit Around behavior is applied to the airplane shape.

In the next illustration, a Move behavior is added to the airplane shape. The destination 
point of the Move path is positioned in the center of the circle. While the airplane circles 
around (obeying the Orbit Around behavior), it is also drawn to the center of the target 
(obeying the Move behavior), creating a spiraling motion path.

 Tip: The Move behavior is useful in 3D mode because it lets you simulate camera 
movements without using a camera. For example, when you apply the Move behavior to a 
group that contains objects offset in Z space, you can create a dolly-like move.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Position: Value sliders to define the X, Y, and Z position of the target point. The target 
(the end of the Move path) is placed at the center of the canvas by default.

Note: You can also drag the target point in the canvas using the Adjust Item tool.

•	 Strength: A slider defining the speed at which the object moves toward the target. With 
a value of 0, the object doesn’t move at all. The higher the value, the faster the object 
moves.

•	 Direction: A pop-up menu that sets whether the object moves toward the target point or 
away from the target point.

•	 Speed: A pop-up menu that defines the object’s velocity from its position in the canvas 
to the position of the target. There are six choices:

•	 Constant: The object moves at a steady speed from its position toward the target.

•	 Ease In: The object starts at a slow speed, then reaches and maintains a steady 
speed toward the target.
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•	 Ease Out: The object starts at a steady speed, then gradually decelerates to a stop 
when it reaches the target.

•	 Ease Both: The object slowly accelerates, then decelerates to a stop when it reaches 
the target.

•	 Accelerate: The object moves toward the target with increasing speed.

•	 Decelerate: The object moves toward the target with decreasing speed.

Note: To move the object more slowly toward its target, extend the duration of 
the Move To behavior in the Timeline or mini-Timeline. To move the object faster, 
shorten the duration of the behavior.

Point At behavior in Motion

The Point At behavior causes an object or group to turn toward a target point. Use the 
Point At behavior with the Move To behavior to create animated objects that not only move 
toward a point (or each other), but that turn in the direction of the target.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Object: An object well that defines the target object. To set the target object, drag an 
object from the Layers list to this object well. You can also drag the target object from 
the Layers list onto the Point At behavior.

•	 Transition: A slider that determines how long it takes the object to go from its starting 
orientation to pointing at the center of the target object. This parameter is useful when 
the object is pointing at a moving target object.

If Transition is set to 50% in a 300-frame project, and the target object is not moving, 
the point-at object takes 150 frames to point at (or orient to) the center of the target 
object and then stops moving for the duration of the behavior. If Transition is set to 
100%, the point-at object takes the full 300 frames to point at the target object. If the 
Point At behavior’s duration is 100 frames, and Transition is set to 50%, the point-at 
object takes 50 frames to orient to the target object.

If Transition is set to 50% in a 300-frame project, and the target object is animated, 
the point-at object takes 150 frames to point at (or orient to) the center of the target 
object and then continues following the animated target object for the duration of the 
behavior. If Transition is set to 100%, the point-at object takes the full 300 frames to 
point at the target object.

•	 Speed: A pop-up menu that defines the object’s velocity from its position in the canvas 
to the position of the target. There are six choices:

•	 Constant: The object moves at a steady speed from its position toward the target.

•	 Ease In: The object starts at a slow speed, then reaches and maintains a steady 
speed toward the target.

•	 Ease Out: The object starts at a steady speed, then gradually decelerates to a stop 
when it reaches the target.

•	 Ease Both: The object slowly accelerates, then gradually decelerates to a stop when 
it reaches the target.

•	 Accelerate: The object moves toward the target with increasing speed.

•	 Decelerate: The object moves toward the target with decreasing speed.
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•	 Axis: A pop-up menu that lets you align the rotation of the object to the X, Y, or Z axis. 
The default axis is Z. This parameter specifies which axis points at the target after the 
movement is complete.

•	 Invert Axis: A checkbox that flips the object so it faces the proper direction. Select the 
checkbox if the object is aligned on the correct axis, but appears backwards.

Snap Alignment to Motion behavior

This behavior aligns the rotation of an object to match all changes made to its position along 
an animation path. Snap Alignment to Motion is meant to be combined with behaviors that 
animate the position of an object, or with a keyframed animation path you create yourself.

In the following example, a graphic of an airplane is shown traveling a spiral motion path. 
On its own, the orientation of the graphic doesn’t change, because only the Position 
parameter is affected.

If you add the Snap Alignment to Motion behavior to the airplane graphic, the Rotation 
parameter is affected, and the graphic points in the direction of motion, without the need 
for additional keyframing.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Rotation Axis: A pop-up menu to rotate the object around the X, Y, or Z axis. You can 
also choose All to rotate the object around all three axes. The default rotation axis is Z. 
All uses the acceleration direction as “up,” like a roller coaster.

•	 Axis: A pop-up menu to specify whether the object aligns to its horizontal or vertical axis.

•	 Invert Axis: A checkbox that, when selected, flips the object so it faces the proper 
direction. Select this checkbox if the object is aligned on the correct axis, but appears 
backwards. 

•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. For example, if End Offset is set to 60, 
the object actively snaps to the direction of the path until 60 frames before the end of 
behavior in the Timeline.
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Spin behavior in Motion

The Spin behavior animates the rotation of an object, spinning it around a single axis. If you 
trim the end of the Spin behavior to be shorter than the duration of the object it’s applied 
to, it remains at the angle of the last frame of the behavior, as long as there are no other 
behaviors or keyframes are affecting that object’s Rotation parameter.

Uses for Spin are fairly obvious, but another way to use the Spin behavior is with objects 
that have an off-center anchor point. Because objects rotate around the anchor point, if 
you change an object’s anchor point before you apply a Spin behavior to it, you can change 
the look of the motion you create. For more information on changing an object’s anchor 
point, see Move a layer’s anchor point.

Note: Although the Spin behavior appears in the Basic Motion category, Spin is treated as 
a Simulation behavior in the Motion application’s order of operations. See Behavior order of 
operations.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox (available when Spin is applied to an object that contains 
multiple objects—such as a group, particle emitter, or text) that, when selected, causes 
each object in the layer or group to rotate as an individual object. When this checkbox 
is deselected, the entire layer or group spins uniformly.

•	 Increment: A pop-up menu that sets how the behavior’s effect progresses over its 
duration in the Timeline. There are two choices:

•	 Continuous Rate: Uses the Spin Rate parameter to spin the object by a steady 
number of degrees per second.

•	 Ramp to Final Value: Spins the object for the number of degrees specified in the Spin 
To parameter over the behavior’s duration in the Timeline.

•	 Spin Rate/Spin To: A dial to set the speed at which the object spins. When Increment 
is set to Continuous Rate, Spin Rate defines a continuous rate of spin in degrees per 
second. When Increment is set to Ramp to Final Value, Spin To defines a number of 
degrees to spin over that object’s duration. Negative values result in clockwise motion; 
positive values result in counterclockwise motion.

•	 Axis: A pop-up menu that sets whether the object spins about the X, Y, or Z axis. You 
can also choose Custom, which yields additional Longitude and Latitude parameters. 
The following illustration shows the Spin behavior’s HUD control set to the Z axis. When 
you drag the center of the Spin HUD, Axis is automatically set to Custom.
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When Axis is set to Custom, additional Latitude and Longitude controls become 
available. These controls allow the object to spin at an angle (not locked to the X, Y, or 
Z axes).

The following image shows how longitude and latitude relate to the Spin HUD control.

•	 Latitude/Longitude: A dial (available when Axis is set to Custom) that specifies the 
axis of rotation.

The HUD controls include an outer ring and an inner control. Drag along the edge of the 
outer ring to manipulate an arrow that indicates the direction and speed the object spins. 
Adjust the length of the arrow to change the speed at which the spinning occurs—drag 
around multiple times to increase the rate of the spin.

The inner arrow controls the axis about which the object or group spins. When you drag 
the inner controls, a globe control becomes available to adjust the object’s spin in degrees 
longitude and latitude.

Note: You can spin the arrow around the ring multiple times to rotate the object more 
quickly.
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Throw behavior in Motion

The Throw behavior is the simplest way to set an object in motion. Controls let you adjust 
the speed and direction of a single force that’s exerted on the object at the first frame of 
the behavior. After this initial force is applied, the object continues drifting in a straight line 
at the same speed, for the duration of the Throw behavior.

A simple example of using the Throw behavior is to send a series of offscreen objects 
moving across the screen. When used in conjunction with other behaviors such as Grow/
Shrink and Fade In/Fade Out, you can create sophisticated moving elements without 
keyframing a single parameter.

The Throw behavior is also useful when you’re moving an object through a simulation. 
For example, you might move the object past other objects that have Attractor or Repel 
behaviors applied to them. Because the Throw behavior only applies a single force to move 
the target object at the initial frame of the behavior, any other behaviors that interact with 
the target object have potentially greater influence over its motion.

Important: The Throw behavior does not apply a continuous force, nor can you create 
changes in direction or speed, because Throw cannot be keyframed. To create keyframed 
changes in direction or speed, use the Wind behavior. To create a more complex animation 
path, use the Motion Path behavior.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple child objects, such as a group, a particle emitter, a replicator, or 
a text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Increment: A pop-up menu that sets how the behavior’s effect progresses over its 
duration in the Timeline. There are two choices:

•	 Continuous Rate: Sets the speed of the object at a steady number of pixels per 
second, specified in the Throw Velocity parameter.

Note: When the canvas displays a nonsquare pixel image, the vertical rate is in pixels 
per second, and the horizontal rate is the perceptual equivalent.

•	 Ramp to Final Value: Moves the object from its original position to the specified 
distance (in pixels) in the Throw Distance parameter.

•	 Throw Velocity/Throw Distance: A slider that sets either velocity or distance, depending 
on the setting in the Increment pop-up menu. When Increment is set to Continuous 
Rate, the Throw Velocity slider sets a continuous speed for the object to move in X, Y, 
or Z space. When Increment is set to Ramp to Final Value, the Throw Distance slider 
sets a total distance (in pixels) for the object to travel in X, Y, and Z space over its 
duration. The standard slider is limited to 100 pixels. Use the value slider to enter values 
greater than 100.
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The 2D HUD lets you specify the direction and speed of the Throw behavior by dragging 
an arrow in a circular region. The direction of the arrow defines the direction of movement 
in X and Y space, and the length of the arrow defines speed (velocity). A slider adjusts 
the scale of the HUD control, increasing or decreasing the effect of the direction/speed 
control.

When you click the 3D button, additional 3D controls become available. The center arrow 
now defines the direction the object is thrown in 3D space (X, Y, and Z axes). The Speed 
slider lets you increase or decrease the velocity of the thrown object.

In the 2D and 3D Throw HUDs, press the Shift key while dragging the arrow to constrain 
it to 45-degree angles. In the 2D HUD, press the Command key to change the arrow’s 
direction without affecting its length.

Note: The maximum speed you can define with the HUD is not the maximum possible 
speed. Higher values can be entered into the Throw Velocity/Throw Distance parameter in 
the Behaviors Inspector.
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Parameter behaviors

Intro to Parameter behaviors in Motion

A Parameter behavior is applied to a specific object parameter, and the animation is limited 
to just that parameter. You can apply the same Parameter behavior to different parameters, 
resulting in different animations. For example, you can apply the Oscillate behavior to the 
opacity of an object to make the object fade in and out, or you can apply the Oscillate 
behavior to the rotation of an object to make the object rock back and forth. You can also 
apply Parameter behaviors to filter parameters, generator parameters, the parameters of 
particle systems, or even the parameters of other behaviors.

There are 19 Parameter behaviors:

•	 Audio behavior links any parameter to the dynamic sound properties of an audio file.

•	 Average behavior smooths animation transitions.

•	 Clamp behavior restricts an animated parameter to a minimum and maximum value.

•	 Custom behavior lets you make your own behaviors. 

•	 Exponential behavior modifies the speed of animations to create more organic effects.

•	 Link behavior synchronizes the value of one parameter to that of another parameter. 

•	 Logarithmic behavior modifies the speed of an animation to create more organic effects. 

•	 MIDI behavior lets you edit and animate parameters using a MIDI controller.

•	 Negate behavior inverts a parameter value to its opposite.

•	 Oscillate behavior animates a parameter by cycling it between two values.

•	 Overshoot behavior animates a parameter beyond its defined end value, before 
springing back.

•	 Quantize behavior modifies an animation to make parameter values change in 
incremental steps.

•	 Ramp behavior creates gradual changes in animations.

•	 Randomize behavior creates jittery animations by applying a continuous sequence of 
randomly increasing and decreasing values.

•	 Rate behavior increases a parameter over time.

•	 Reverse behavior reverses the direction of an animated parameter.

•	 Stop behavior abruptly suspends the animation of a parameter.

•	 Track behavior applies motion tracking data to a parameter of an effect (a filter, for 
example).

•	 Wriggle behavior creates jittery animations, but with a slower effect than that of the 
Randomize behavior.
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Audio behavior in Motion

The Audio behavior lets you animate nearly any parameter based on properties of an audio 
file, such as bass frequency. For example, the Audio parameter behavior can be applied to 
the Scale parameter of an object, causing the object to scale up and down based on the 
amplitude of the bass. See Apply the Audio parameter behavior.

Average behavior in Motion

The Average behavior smooths the transition from one value to another in animations that 
are keyframed and in behaviors that are applied to a parameter. Use the Average behavior 
to smooth out animated effects. Averaged motion moves more fluidly, while averaged 
changes to parameters such as Opacity and to filter parameters appear to happen more 
gradually. Use the Window Size parameter to adjust the amount of smoothing applied to 
the affected parameter.

 Tip: The Average behavior can be used to smooth out the sequence of values generated 
by a Randomize behavior.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Window Size: A slider that adjusts the amount of smoothing applied to the affected 
parameter, by specifying the number of adjacent frames to average together. Higher 
values apply more smoothing by averaging a wider range of values, resulting in more 
fluid animation. Lower values average a narrower range of values, resulting in less 
smoothing, with values closer to the original.

•	 Apply To: A pop-up menu that displays the parameter affected. You can also use this 
control to reassign the behavior to a different parameter.

Clamp behavior in Motion

The Clamp behavior sets a minimum and maximum value for an animated parameter. In 
the following image, the center star has an applied Vortex behavior set to affect the two 
airplane shapes. As a result, the airplanes circle around the center star, as indicated by the 
red animation paths.

In the next image, a Clamp behavior is applied to the X Position parameter of the outer 
airplane shape. The Max value is set to 230 and the Min value is set to 0. As a result, the 
animation path is “clamped”—the image can travel 230 pixels to the right but cannot move 
left past the 0 point, creating a half-circle animation.
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The circle motion path is essentially cut in half. If a negative value is entered in the Min 
value slider, the image moves past the 0 point.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Clamp At: A pop-up menu that sets whether the behavior restricts clamping to a 
minimum value, a maximum value, or both minimum and maximum values.

•	 Min: A value slider that lets you define the minimum amount of change for an animated 
parameter.

•	 Max: A value slider that lets you define the maximum amount of change for an animated 
parameter.

The value is represented as a percentage, in pixels, or in degrees, depending on the 
parameter assignment. For example, if Clamp is applied to the Rotation parameter, the 
Min and Max values are degrees. If Clamp is applied to the X Position parameter, the 
values are in pixels.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.

Custom behavior in Motion

The Custom behavior lets you make your own behaviors by creating a set of parameters, 
then keyframing them to create the type of animation you want to apply to an object. By 
saving custom behaviors you create in the Library, you can build your own collection of 
behaviors to suit your needs.

The Custom behavior is not applied like the other Parameter behaviors described in this 
section. Rather, you apply the Custom behavior like any other non-Parameter behavior 
in Motion: by dragging it from the Library onto an object in the canvas or Layers list, or 
by selecting an object in the canvas or Layers list, clicking Behaviors in the toolbar, then 
choosing the behavior from the pop-up menu.

Note: Although the Custom behavior is a Parameter behavior, it does not appear in the 
shortcut menu when you Control-click a parameter.

Unlike other behaviors, the Custom behavior doesn’t apply default parameters in the 
Behaviors Inspector. Instead, a pair of pop-up menus lets you add and remove any 
parameters you want to use.
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Adjust this behavior using the controls in the Behaviors Inspector:

•	 Add Parameter: A pop-up menu used to add parameters you want to keyframe to 
create custom animation. Choose a parameter from this menu to add it to the Custom 
parameter list for keyframing.

•	 Remove Parameter: A pop-up menu listing parameters you’ve added to the current 
Custom behavior. Choose a parameter from this menu to remove it from the Custom 
parameter list, along with any keyframes applied to that parameter.

Add a Custom behavior in Motion

Before adding custom parameters to a Custom behavior, you must apply the Custom 
behavior to an object in your project.

Add a Custom behavior to an object
1.	 In Motion, do one of the following:

•	 In the Layers list, select the object you want to add a Custom behavior to, click 
Behaviors in the toolbar, choose Parameter, then choose a behavior from the submenu.

•	 In the Library, select the Behaviors category, select the Parameter subcategory, then 
drag the Custom icon to the object in the canvas, Layers list, or Timeline.

The Custom behavior is applied to the object. The behavior has no effect until you 
add a parameter to the behavior.

2.	 In the Custom area of the Behaviors Inspector, click the Add Parameter pop-up menu, 
then choose a parameter to add. 

This menu contains every animatable parameter.

The parameter you chose appears near the top of the Custom area in the Behaviors 
Inspector.

After you add the parameters to animate in your Custom behavior, you can keyframe 
them in the Keyframe Editor to create whatever animated effect you require. For more 
information on keyframing parameters to create animation, see Apply keyframes to 
behaviors.

After you animate the parameters you added, you can save the Custom behavior into 
the Library for future use. For more information about saving Custom behaviors to the 
Library, see Save custom behaviors.
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Remove a parameter from the Custom parameter list
•	 In Motion, click the Remove Parameter pop-up menu, then choose a parameter to 

remove.

That parameter no longer appears in the Custom parameter pop-up menu. Any 
keyframes applied to that parameter are deleted.

Exponential behavior in Motion

The Exponential behavior creates more natural animations when scaling objects, especially 
when using high values. For example, when an object scales from very small to very large, 
our eyes erroneously perceive the animation to slow down as the object reaches its upper 
scale values. The Exponential parameter behavior allows such an animation to speed up the 
scaling as the values increase to compensate for that illusion, and create a more uniform-
looking scale effect.

 Tip: When applied to parameters other than Scale, the Exponential parameter behavior 
creates more organic animations than other interpolation modes.

You can also change the interpolation modes of keyframes to Exponential. See Set curve 
interpolation.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Start Value: A slider to set the value that’s added to the parameter at the first frame of 
the Exponential behavior.

•	 End Value: A slider to set the value the Exponential behavior reaches at the last frame 
of the behavior. Over the life of the behavior, the parameter the Exponential behavior 
is applied to makes a transition from the Start Value to the End Value, plus the original 
value.

•	 Start Offset: A slider to delay the beginning of the behavior’s effect relative to the 
first frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior start later.

•	 End Offset: A slider to offset the end of the behavior’s effect relative to the last frame 
of its position in the Timeline, in frames. Adjust this parameter to make the behavior 
stop before the end of the behavior bar in the Timeline. Using this slider to stop the 
effect, instead of trimming the end of the behavior bar in the Timeline, freezes the end 
of the effect for the remaining duration of the object. Trimming the end of the behavior 
bar resets the object to its original parameter.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.
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Link behavior in Motion

The Link behavior forces the value of one parameter to match that of another “linked” 
parameter. The source parameter can be attached to the same object or to another object. 
The linked parameters must contain numerical data. Parameters controlled by checkboxes, 
menus, and other non-numeric values cannot be linked. The linked parameters also must 
contain the same number of attributes. You cannot link a compound parameter such as 
Scale X-Y-Z to a parameter such as Opacity, which has only one slider. You can, however, 
link a compound parameter such as Scale X-Y-Z to Position X-Y-Z.

The values of the source parameter can be scaled to more accurately apply to the 
destination parameter. For example, a source parameter with a range of 1–100 can be 
scaled when applied to a parameter with a range of 0–1. The values can also be offset 
from the source, and the effect can be mixed with the destination value to create different 
effects.

The Link behavior can be applied to a parameter animated with behaviors or keyframes; 
however, the Link behavior does not affect the parameter when the Start Values or End 
Values are zero.

When using the Link behavior to control an object’s position parameter, the linked 
coordinates are based on the center point of the current group. So when an object is linked 
to another object in the same group, it shares an identical position. However, if the source 
object is in a different group, the coordinates might appear offset in space.

If your goal is to match an identical position across groups with different center points, you 
can create an invisible reference object in the group containing the source, link it to the 
source object, then use the Match Move behavior to copy the reference object’s position 
to that of the intended target. Match Move compensates for inter-group position offsets 
and provides the option to attach one object to another or to mimic the source object’s 
transformations. For more information about the Match Move behavior, see Intro to match 
moving.
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You can also link to the group’s coordinates instead of the object’s, and use the Offset 
parameters in the Link behavior to obtain the position you want. However, if that group is 
subsequently added to another group, the linked object might not move as expected.

 Tip: You can make coordinated animations using text layers. For example, link the Scale 
parameter of a rectangle (the target object) to the Object Size of a text layer (the source 
object) to create an animation in which the rectangle automatically changes its size based 
on the size of the text string. Use the Link behavior together with the Align To behavior to 
create a box that automatically fits whatever text is typed “into” it.

Note: When a link behavior is added, it’s not enabled by default. To activate the behavior, 
click the activation checkbox beside the behavior name in the Behaviors Inspector.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Source Object: An object well that defines the source object in which the source 
parameter resides. Click the To pop-up menu to select a source object in the current 
project. 

•	 Source Parameter (Compatible Parameters): A pop-up menu and assignment field 
showing the parameter that serves as the source for the Link behavior. Click the pop-
up menu to choose a new source parameter. Only parameters with the same value type 
and number of attributes as the parameter selected in the Apply To (Target Parameters) 
pop-up menu appear here.

When a text layer is used as a source, additional parameters appear.

Note: When possible, Source Parameter defaults to the parameter chosen in the Apply 
To row (described below).

Important: Changing the Apply To (Target Parameters) setting changes which 
parameters appear in the Source Parameter pop-up menu. If you can’t find the 
parameter you’re looking for, you might need to choose a target parameter.

•	 Apply To (Target Parameters): A pop-up menu and assignment field showing the 
parameter affected. Click the pop-up menu to reassign the behavior to another 
parameter.

When a text layer is used as a target, additional parameters appear.

•	 Apply Mode: A pop-up menu that sets how the values from the source parameter affect 
the target parameter. The choices include:

•	 Add to source: Adds the source parameter value to the existing value of the target 
parameter.

•	 Multiply by source: Multiplies the source parameter value with the existing value of 
the target parameter.

•	 Replace with source: Replaces the existing value of the target parameter with that of 
the source parameter.

•	 Mix Over Time: A pop-up menu that sets how rapidly the source parameter values 
begin to affect the target parameter. Options include: Ease In, Ease Out, Ease In/Out, 
Accelerate, Decelerate, Accelerate/Decelerate, and Custom Mix.

•	 Mix Time Range: A slider (available when the Mix Over Time pop-up menu is set to an 
ease or acceleration option) that controls the number of frames over which the ease or 
acceleration occurs.
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 Tip: Ease In and Accelerate begin at the In point of the Link behavior; Ease Out and 
Decelerate end at the Out point of the Link behavior. Therefore, you can trim the Link 
behavior in the Timeline to specify where the ease or acceleration begins or ends.

•	 Custom Mix: A slider (available when the Mix Over Time parameter is set to Custom Mix) 
that can be animated to create a user-determined mix between the source and target 
parameter values.

•	 Scale: A slider that specifies a value to be multiplied with the Source Parameter before 
it is applied to the target.

•	 Apply Link When: A pop-up menu that limits when values from the source are applied to 
the target. There are five choices:

•	 Any source value: No limits are placed on the source parameter values. An offset 
slider for each setting associated with the source parameter appears at the bottom 
of the Behaviors Inspector.

•	 Source value above minimum: The link applies only when the source value exceeds a 
defined minimum value. If the source value falls below the defined minimum, the link 
behavior stops. When selected, the Clamp Source Values Within Range checkbox 
as well as offset and minimum sliders for each setting associated with the source 
parameter appear at the bottom of the Behaviors Inspector.

•	 Source value below maximum: The link applies only when the source value stays 
below a defined maximum value. If the source value exceeds the defined maximum, 
the link behavior stops. When selected, the Clamp Source Values Within Range 
checkbox as well as offset and maximum sliders for each setting associated with the 
source parameter appear at the bottom of the Behaviors Inspector.

•	 Source value between min and max: The link applies only when the source value 
stays within a defined range. If the source value falls below the defined minimum, or 
exceeds the defined maximum, the link behavior stops. When selected, the Clamp 
Source Values Within Range checkbox as well as offset, minimum, and maximum 
sliders for each setting associated with the source parameter appear at the bottom 
of the Behaviors Inspector.

•	 Source value outside min and max: The link applies only when the source value stays 
outside of a defined range. If the source value falls above the defined minimum, 
or below the defined maximum, the link behavior stops. When selected, the Clamp 
Source Values Within Range checkbox as well as offset, minimum, and maximum 
sliders for each setting associated with the source parameter appears at the bottom 
of the Behaviors Inspector.

•	 Clamp Source Value Within Range: A checkbox that becomes available when the Apply 
Link pop-up menu is set to a choice requiring a minimum or maximum value. When 
selected, values that exceed the defined range are pinned to the highest or lowest 
allowable setting.
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•	 Source Frame Mode: A pop-up menu that specifies whether the animation created by 
the linked parameters is continuous (with the source parameter value over the duration 
of the behavior) or fixed (to a source parameter value at a certain point in the duration 
of the behavior). There are two options:

•	 Continuous: The target object’s linked parameter value matches the value of the 
source object’s parameter.

In the following example, the size of the yellow rectangle (the target parameter) is 
linked to the size of the animated text object (the source parameter), and Source 
Frame Mode is set to Continuous. The size of the rectangle matches the size of the 
animated text over the duration of the behavior.

(In this example, an Align To behavior—using the text as the target object—is also 
applied to the rectangle so that the rectangle remains aligned to the position of the 
text.)

•	 Fixed: Fixes the value of the linked target parameter to the value of the source 
parameter at a specific point in the duration of the behavior (as defined by the 
Source Frame slider).

In the following example, the size of the yellow rectangle (the target parameter) is 
linked to the size of the sequenced text object (the source parameter), Source Frame 
Mode is set to Fixed, and Source Frame is set to 50%. The size of the rectangle is 
fixed to the size of the text halfway through the sequence behavior.

•	 Source Frame: A slider (available when Source Frame Mode is set to Fixed) that defines 
the point in the source parameter’s animation that is applied to the target parameter.

•	 (Parameter) offset: A slider that lets you create a constant offset between the source 
parameter value and the value applied to the target parameter.

•	 (Parameter) min: One or more sliders that become available when the Apply Link pop-up 
menu is set to “Source value above minimum,” “Source value between min and max,” or 
“Source value outside min and max.” A “min” slider appears for each component of the 
source parameter. Adjusting this slider defines a minimum value to limit when the link 
behavior is active.

•	 (Parameter) max: One or more sliders that become available when the Apply Link pop-
up menu is set to “Source value below maximum,” “Source value between min and max,” 
or “Source value outside min and max.” A “max” slider appears for each component of 
the source parameter. Adjusting this slider defines a maximum value to limit when the 
link behavior is active.
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Logarithmic behavior in Motion

The Logarithmic behavior is the inverse of the Exponential behavior. Like the Exponential 
behavior, it creates more natural animations when scaling objects, especially when using 
high values. The Logarithmic parameter behavior applies a mathematical function to create 
a logarithmic curve (rather than linear) between the two values—the effect ramps up 
quickly, and then the effect slows down. This allows the animation to progress slowly when 
the scale values are small and speed up when the scale values are large. When applied to 
parameters other than Scale, the Logarithmic parameter behavior creates more organic 
animations than other interpolation modes.

The Logarithmic behavior can be applied to parameters animated with behaviors or 
keyframes; however, Logarithmic does not affect the parameter unless the Start Values or 
End Values are nonzero.

Note: You can also change the interpolation modes of keyframes to Logarithmic. See Set 
curve interpolation.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Start Value: A slider that sets the value added to the parameter at the first frame of the 
Logarithmic behavior.

•	 End Value: A slider that sets the value of the Logarithmic behavior at the last frame. 
Over the life of the behavior, the parameter that the Logarithmic behavior is applied to 
makes a transition from the Start Value to the End Value, plus the original value.

•	 Start Offset: A slider that delays the beginning of the behavior’s effect relative to the 
first frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior start later.

•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline. Using this slider to 
stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes 
the end of the effect for the remaining duration of the object. Trimming the end of the 
behavior bar resets the object to its original parameter.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.
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MIDI behavior in Motion

The MIDI behavior lets you edit and animate object parameters using standard MIDI 
devices, such as a synthesizer. For the true motion graphics mixmaster.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Control Type: A pop-up menu that sets the mode of the MIDI controller. There are three 
modes:

•	 Note: Use this mode when the control is a keyboard key on the MIDI device.

•	 Controller: Use this mode when the control is a knob, dial, key, slider, or foot pedal 
on the MIDI device.

•	 Learning: Use this mode to “teach” Motion which control (such as a knob, dial, or 
key) you want to use on the MIDI device to manipulate the parameter to which the 
MIDI behavior is applied. When in Learning mode, the first knob, dial, or key that you 
adjust on the MIDI device is set as the control.

Note: When the MIDI behavior is first applied, Learning is the default control type.

•	 ID: A slider that displays the identification number of the MIDI control (such as a knob, 
dial, or key) that you are manipulating.

•	 Value: A slider that displays the standard MIDI value between 0 and 1 when you’re 
manipulating the MIDI control.

•	 Scale: A slider that multiplies the Value parameter in the MIDI behavior. This means 
that when Scale is increased, the MIDI control has a larger range of value and a greater 
effect on the parameter it’s controlling. For example, when you use a knob to adjust 
an object’s rotation, the default rotation value range (when Scale is set to 1) for a full 
turn of the knob might only be 30 percent. When the Scale value is increased to 13, the 
rotation value of a full turn of the knob is increased to 370 degrees.

•	 Apply To: A pop-up menu (parameter assignment control) that shows the parameter 
affected, and that can be used to reassign the behavior to another parameter.
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Add a MIDI behavior in Motion

You apply the MIDI behavior in the same way as all other Parameter behaviors. In the 
following examples, the MIDI behavior is used to adjust an object’s opacity and rotation.

Note: This behavior can only be used if you have a MIDI device correctly connected to your 
computer.

Use the MIDI behavior to adjust an object’s opacity
1.	 Select an object in the Layers list in Motion, then locate the Opacity parameter in the 

Properties Inspector.

2.	 Control-click the parameter, then choose Add Parameter Behavior > MIDI from the 
shortcut menu.

The MIDI parameters are displayed in the Behaviors Inspector. By default, Control Type 
is set to Learning.

Like all other Parameter behaviors, the Apply To field displays the parameter to which 
the behavior is applied.

3.	 On your MIDI device, tweak the control (such as the knob, dial, or key) you want to use 
as the controller for the Opacity parameter.

The identification number of the MIDI control is displayed in the ID field. The value 
range of the control is 0 to 127, the default MIDI control value.

Because an object’s opacity can only fall between 0 (completely transparent) to 100 
(completely opaque), the default MIDI values are sufficient to adjust the parameter.

Note: When in Learning mode, the first control adjusted on the MIDI device is set as the 
control. To reset the selected controller, choose Learning from the Control Type pop-up 
menu, then adjust another control on the MIDI device.

Use the MIDI behavior to adjust an object’s rotation
1.	 Select an object in Motion, then locate the Rotation parameter in the Properties 

Inspector.

2.	 Control-click the parameter, then choose Add Parameter Behavior > MIDI from the 
shortcut menu.

3.	 On your MIDI device, tweak the control (knob, dial, key, and so on) you want to use as 
the controller for the Rotation parameter.

The default Value range is 0 to 1. Because the Rotation value of an object can be much 
larger, you can use the Scale parameter to multiply the Value range.

4.	 To give the control more sensitivity, increase the Scale value.
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Negate behavior in Motion

The Negate behavior inverts the value of each keyframe and behavior effect in the 
parameter to which it’s applied by multiplying the parameter by –1. The Negate behavior 
basically flips each parameter value to its opposite. Animation paths are flipped, rotation is 
reversed, and any effect’s parameter is changed to its opposite.

For example, applying the Negate behavior to the Position parameter of an object with 
an animation path results in the animation path moving to the opposite quadrant of the 
canvas.

Note: If you want to reverse the motion taking place on an animation path, rather than 
flipping the shape of the animation path itself, use the Reverse parameter behavior.

Adjust this behavior using the control in the Behaviors Inspector:

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.

Oscillate behavior in Motion

The Oscillate behavior animates a parameter by cycling it between two values. You can 
customize how wide apart the high and low values are as well as the number of oscillations 
per minute. The Oscillate behavior can create all kinds of cyclical effects. For example, 
if you apply the Oscillate behavior to the rotation property of an object, it will rock back 
and forth. This happens because the rotation property cycles back and forth between 
the original rotation value plus and minus the Amplitude value that’s set in the Oscillate 
behavior.

Applying the Oscillate behavior to the X value of the Scale parameter instead causes the 
width of the object to cycle, and it repeatedly stretches and compresses for the duration of 
the behavior.

The Oscillate behavior is additive, meaning that the value generated by this behavior is 
added to the original value of the parameter to which it’s applied.
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Adjust this behavior using the controls in the Behaviors Inspector:

•	 Wave Shape: A pop-up menu that sets the shape of the oscillation’s wave. There are 
four shapes:

•	 Sine: The default wave shape, creates a smooth animation between values. For 
example, if Oscillate is applied to an object’s Opacity parameter, and the Wave 
Shape is set to Sine, the object gracefully fades in and out.

•	 Square: Creates abrupt changes in values. For example, when Oscillate is applied 
to an object’s Opacity parameter, and the Wave Shape is set to Square, the object 
flashes on and off (like turning a light switch on and off).

•	 Sawtooth: Ramps upward over time and then drops sharply. For example, when 
Oscillate is applied to an object’s Opacity parameter, and the Wave Shape is set to 
Sawtooth, the object fades in slowly and fades out abruptly (like using a light dimmer 
to fade up a light, and then flicking the power switch off).

•	 Triangle: Similar to the sine wave, creates a smooth animation between values but 
with sharper changes at the transitions. For example, when Oscillate is applied to an 
object’s Opacity parameter, and the Wave Shape is set to Triangle, the object fades 
in and out more acutely than it does with the Sine Wave setting.

•	 Phase: A slider that sets the point of the specified oscillation where the behavior starts. 
This parameter lets you put multiple objects with identical Oscillate behaviors out of 
phase with one another so they don’t all look the same.
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•	 Amplitude: A slider that sets the maximum values between which the parameter 
oscillates. The parameter swings between the amplitude value and the negative of the 
amplitude value. Higher values result in more extreme swings from the beginning to the 
ending of each oscillation.

•	 Speed: A slider that sets the speed at which the oscillation occurs, in oscillations per 
minute. Higher values result in faster oscillations.

•	 Half Range: A checkbox that, when selected, cuts the sine wave (or other wave shape) 
in half and prevents it from crossing the value of 0. For example, when Amplitude is set 
to 100, the parameter oscillates between 100 and –100. When Half Range is selected, 
however, the parameter oscillates between 100 and 0. When Amplitude is set to –100, 
the parameter oscillates between –100 and 0.

 Tip: When you’re oscillating position parameters, set Wave Shape to Sine and enable 
Half Range to create a bouncing effect.

•	 Start Offset: A slider that delays the beginning of the behavior’s effect relative to the 
first frame of its position in the Timeline. Adjust this parameter to make the behavior 
start later. The units of this parameter are in frames.

•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline. Using this slider to 
stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes 
the end of the effect for the remaining duration of the object. Trimming the end of the 
behavior bar resets the object to its original parameters.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.
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Create a decaying oscillation in Motion

When you apply the Oscillate behavior to an object’s rotation or position, a common 
effect is to “decay” or “dampen” the animation over time. This means that the animation 
gradually slows or comes to a stop. You can achieve this effect using keyframes to slow the 
amplitude of the oscillation.

Decay an oscillating rotation using keyframes
1.	 In the Timeline in Motion, drag the playhead to the frame where you want the animation 

to begin, then press A to enable keyframe recording.

2.	 In the Layers list, select the Oscillate behavior.

3.	 In the Behaviors Inspector, set the Amplitude to the maximum value you want to use in 
your project.

Note: When keyframe recording is enabled, any value change to a parameter using the 
Inspector, HUD, or canvas creates a keyframe.

4.	 In the Timeline, drag the playhead to the frame where you want the animation to come 
to a stop and set the Amplitude value to 0.

When the object is selected, you can see the dampening of the animation—caused by 
the keyframed Amplitude parameter—in the Keyframe Editor (when Animated is chosen 
from the pop-up menu above the Keyframe Editor). The following illustration shows the 
keyframed Amplitude parameter of the Oscillate behavior superimposed over the resulting 
change to the Oscillate curve itself. See Display the Keyframe Editor and Keyframe Editor 
controls.

Note: The Oscillate behavior must be selected for its curve to be visible in the Keyframe 
Editor. 
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Overshoot behavior in Motion

The Overshoot behavior creates an animation that ramps from a start value to an end 
value, but overshoots the end value and oscillates around it, quickly making a realistic 
spring-back effect.

Note: Applying the Overshoot behavior to a parameter with a maximum value has no effect. 
In other words, if a parameter’s maximum value is 100—and the parameter is set to 100—
there’s no value to “overshoot.” You can lower the parameter’s maximum value to provide 
room to create the animation. Additionally, the Overshoot behavior’s Start Offset and End 
Offset parameters may need to be adjusted so that the overshoot animation stays within 
the maximum range allowed by the parameter over the behavior’s duration.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Start Value: A slider that sets the value added to the parameter at the first frame of the 
Overshoot behavior.

•	 End Value: A slider that sets the value the Overshoot behavior reaches at the last frame 
of the behavior. Over the life of the behavior, the parameter that the Overshoot behavior 
is applied to animates from the Start Value to the End Value, plus the original value.

•	 Ramp Duration: A slider that sets the duration of the animation between the Start Value 
and the End Value (as a percentage of the total duration of the behavior). For example, 
if the behavior has a duration of 300 frames and Ramp Duration is set to 50%, the 
duration of the initial ramp is 150 frames and the duration of the overshoot/ramping 
down is 150 frames.

•	 Cycles: A slider that determines the number of oscillations around the End Value before 
settling.

Note: Changing the duration of the Overshoot behavior affects the speed of the Ramp 
Duration and Cycles.

•	 Acceleration: A slider that determines how quickly the animation approaches the End 
Value. Higher values create more acceleration in the animation curve and a higher 
overshoot effect.

•	 Start Offset: A slider that delays the beginning of the behavior’s effect relative to the 
first frame of its position in the Timeline. Adjust this parameter to make the behavior 
start later. The units of this parameter are in frames.
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•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline. Using this slider to 
stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes 
the end of the effect for the remaining duration of the object. Trimming the end of the 
behavior bar resets the object to its original parameters.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.

Quantize behavior in Motion

The Quantize behavior creates an incremental animation in any keyframed or behavior-
influenced parameter. For example, if opacity is animated so an object gradually fades in 
over time, you can add the Quantize behavior to make the object become opaque in steps.

Note: The Quantize behavior only works with animated parameters.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Step Size: A value slider that defines the size of the steps, based on the units of the 
parameter to which it’s applied. For example, when Quantize is applied to rotation, the 
steps are in degrees (even though this parameter is not a dial control). When applied to 
position, the steps are in pixels.

The left image below shows the projected path (the red line) of a layer with an applied 
Throw behavior. The right image displays the same animation path after the Quantize 
behavior is added. In this example, the Step value is set to 90.

•	 Offset: A slider that offsets the steps. For example, when Quantize is applied to 
a Position parameter and Step Size is set to 100, an object “steps” in increments 
restricted to 100 pixels; thus, the step offset is 100, 200, 300, and so on. If Offset is set 
to 50, the step offset is restricted to 50, 150, 250, and so on.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.
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Ramp behavior in Motion

The Ramp behavior creates a gradual transition in any parameter that can be animated, 
from the Start Value to the End Value. The speed of the transition is defined by the 
length of the Ramp behavior in the Timeline, and by the behavior’s end value. Additional 
parameters allow you to define how the transition occurs; whether it’s at a single, 
continuous speed; or whether it accelerates over time.

Ramp is a versatile behavior. If you apply it to the Scale property, it works like the Grow/
Shrink behavior. If you apply it to the Opacity property, you can fade an object in or out in 
different ways. Although you can use the Ramp behavior to mimic other Motion behaviors, 
it can be applied to any parameter. It’s an additive behavior, meaning that the value it 
generates is added to the original value of the parameter to which it’s applied.

For example, to animate different segments of a bar graph so each segment grows to a 
specific length, apply the Ramp behavior to each bar’s Crop parameter. After you arrange 
the different bars with their starting Crop values, the Ramp behaviors move the Top Crop 
parameter up, giving the illusion that each bar is growing. Set the End Value parameter of 
each Ramp behavior to the length you want each bar to reach, and you’re done!

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Start Value: A slider to set the value that’s added to the parameter at the first frame of 
the Ramp behavior.

•	 End Value: A slider that sets the value the Ramp behavior reaches at the last frame of 
the behavior. Over the life of the behavior, the parameter that the Ramp behavior is 
applied to transitions from the Start Value to the End Value, plus the original value.

•	 Curvature: A slider that eases the acceleration at which the Ramp behavior transitions 
from the Start Value to the End Value. Higher Curvature values result in an ease in/
ease out effect, where the transition begins slowly, gradually speeds up as the behavior 
continues, then gradually slows to a stop as it reaches the end. Because Curvature is 
defined by the length of the behavior in the Timeline, this parameter does not affect the 
overall duration of the effect.

•	 Start Offset: A slider that delays the beginning of the behavior’s effect relative to the 
first frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior start later.

•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline. Using this slider to 
stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes 
the end of the effect for the remaining duration of the object. Trimming the end of the 
behavior bar resets the object to its original parameter.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.
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Randomize behavior in Motion

The Randomize behavior creates a continuous sequence of randomly increasing and 
decreasing values, based on the parameters defining the range and type of values 
generated. Use Randomize to create jittery effects, such as twitchy rotation, flickering 
opacity, and other effects requiring rapid and varied changes over time that would be time-
consuming to keyframe.

Although the values created with this behavior appear to be random, they’re predetermined 
by the parameter settings you’ve chosen. As long as you don’t change the parameters, 
the frame-by-frame values created by this behavior remain the same. If you don’t like the 
randomly generated values, click the button to the right of the seed value in the Behaviors 
Inspector to pick a new random seed number. This number is used to generate a new 
sequence of values.

The Apply Mode parameter determines how values generated by this behavior are 
combined with other behaviors and keyframes that affect the same parameter. This 
provides you with different ways of using a Randomize behavior to modify a parameter’s 
preexisting values.

The Randomize behavior can be modified with other behaviors, such as Average and 
Negate, to exercise further control over the values generated.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Amount: A slider (available when the Apply Mode—described below—is set to Add, 
Subtract, or Add and Subtract) that defines the maximum value the Randomize behavior 
will generate.

•	 Multiplier: A slider (available when the Apply Mode—described below—is set to 
Multiply) that defines the maximum value the Randomize behavior will generate.

•	 Apply Mode: A pop-up menu that determines how values generated by this behavior are 
combined with other behaviors and keyframes that affect the same parameter. Choose 
Add, Subtract, Multiply, or Add and Subtract.

•	 Frequency: A slider that sets the amount of random variation per second. Higher values 
generate faster variations; lower values generate slower variations.

•	 Noisiness: A slider that adds an additional overlay of random variance to the Frequency 
you’ve set. Higher Noisiness values result in more erratic variations in the affected 
parameter.

•	 Link: A checkbox available when you apply Randomize to a two-dimensional parameter 
(such as Scale) or to a three-dimensional parameter (such as Position) that consists of 
X, Y, and/or Z values. Select this checkbox to keep the behavior’s effect on each value 
proportional.

•	 Affect Subobjects: A checkbox (available when you apply Randomize to a parameter of 
the Sequence Replicator behavior) that, when selected, gives each replicated cell in the 
canvas a different random behavior. When Affect Subobjects is deselected, each object 
undergoes the same animation.

•	 Random Seed: A button that picks a new random seed number. This number is used to 
generate new sequences of values, based on the other parameters of this behavior.

•	 Start Offset: A slider that delays the beginning of the behavior’s effect relative to the 
first frame of its position in the Timeline. Adjust this parameter to make the behavior 
start later. The units of this parameter are in frames.
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•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline. Using this slider to 
stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes 
the last random value generated by this behavior for the remaining duration of the 
object. Trimming the end of the behavior bar resets the parameter to its original value.

•	 Apply To: A pop-up menu shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.

Rate behavior in Motion

The Rate behavior increases a parameter’s value over time, with the rate of increase 
determined by the Rate slider. Unlike the Ramp behavior, this behavior has no end value, 
but continues to increase or decrease the parameter it’s applied to until the end of the 
parameter.

Note: To decrease a parameter over time, enter a negative value into the Rate parameter.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Rate: A slider that sets a rate of increase over time for the affected parameter, 
measured in percentage increase per second.

•	 Curvature: A slider that eases the acceleration at which the Rate behavior transitions 
from the Start Value to the End Value. Higher Curvature values result in an ease in/
ease out effect, beginning slowly, gradually speeding up as the behavior continues, 
then gradually slowing to a stop as it reaches the end. Because Curvature is defined 
by the length of the behavior in the Timeline, this parameter does not affect the overall 
duration of the effect.

•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline. Using this slider to 
stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes 
the last random value generated by this behavior for the remaining duration of the 
object. Trimming the end of the behavior bar resets the parameter to its original value.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.

Reverse behavior in Motion

Unlike the Negate behavior, which inverts the value of the parameter to which it’s applied, 
the Reverse behavior reverses the direction of any animation that affects a parameter, 
whether it’s caused by behaviors or keyframes. For example, when you apply the Reverse 
behavior to path animation that begins at the left and moves to the right, the animation 
path won’t move, but the object instead begins at the right and moves to the left. The 
Reverse behavior basically switches the beginning and ending points of animated objects.

Adjust this behavior using a single control in the Behaviors Inspector:

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.
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Stop behavior in Motion

The Stop behavior suspends parameter animation (created by keyframes or applied 
behaviors) of an object. For example, if you assign the Stop parameter behavior to the 
Position parameter of an object moving across the screen and rotating, the object ceases 
to move across the screen but continues to rotate.

Each behavior’s effect on the object is frozen at the first frame of the Stop behavior in the 
Timeline. Keyframes applied to that parameter cease to have any effect for the duration of 
the Stop behavior in the Timeline. If the Stop behavior is shorter than the object to which 
it’s applied, all keyframes and behaviors affecting that channel immediately take effect 
after the last frame of the Stop behavior. See Stop a behavior.

Adjust this behavior using a single control in the Behaviors Inspector:

•	 Apply To: A pop-up menu that shows the parameter being stopped, and that can be 
used to reassign the Stop behavior to another parameter.

Track behavior in Motion

The Track behavior applies tracking data to a parameter of an effect, such as the center 
point of the Light Rays filter. For more information on using the Track behavior, see Track 
the position of a filter or object.

Wriggle behavior in Motion

The Wriggle behavior works similarly to the Randomize behavior, but with a slower effect.

 Tip: A Wriggle behavior applied to an Opacity parameter set to 100% does not have 
much effect. This is because there isn’t much room to “wriggle.” For a better result, set the 
Opacity to 0, or change the Apply Mode to Subtract.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Amount/Multiplier: A slider that defines the maximum value that the Wriggle behavior 
generates. The Amount slider is available when the Apply Mode is set to Add, Subtract, 
or Add and Subtract. The Multiplier is available when the Apply Mode is set to Multiply. 

•	 Apply Mode: A pop-up menu that determines how values generated by this behavior 
are combined with other behaviors and keyframes that affect the same parameter. This 
provides you with different ways of using a Wriggle behavior to modify a parameter’s 
preexisting values. The options are Add, Subtract, Multiply, or Add and Subtract.

•	 Frequency: A slider that sets the amount of random variation per second. Higher values 
generate faster variations, whereas lower values generate slower variations.

•	 Wriggle Offset: A slider that offsets the sequence of random values when you want to 
apply the same Wriggle behavior to multiple objects. By offsetting each object’s version 
of the Wriggle behavior, you can prevent objects from moving in sync.

•	 Noisiness: A slider that adds an additional overlay of random variance to the Frequency 
you’ve set. Higher Noisiness values result in more erratic variations in the affected 
parameter.

•	 Link: A checkbox available when you apply the Wriggle behavior to a two-dimensional 
parameter (such as Scale) or three-dimensional parameter (such as Position) that 
consists of X, Y, and/or Z values. Select this checkbox to keep the behavior’s effect on 
each value proportional.
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•	 Affect Subobjects: A checkbox available when the Wriggle behavior is applied to a 
parameter of the Sequence Replicator behavior. When Affect Subobjects is selected, 
each object has a different wriggle behavior. When Affect Subobjects is deselected, 
each object undergoes the same animation.

•	 Random Seed: A button that picks a new random seed number. This number is used to 
generate new sequences of values, based on the other parameters of this behavior.

•	 Start Offset: A slider that delays the beginning of the behavior’s effect relative to the 
first frame of its position in the Timeline. Adjust this parameter to make the behavior 
start later. This parameter is measured in frames.

•	 End Offset: A slider that offsets the end of the behavior’s effect relative to the last 
frame of its position in the Timeline, in frames. Adjust this parameter to make the 
behavior stop before the end of the behavior bar in the Timeline. Using this slider to 
stop the effect, instead of trimming the end of the behavior bar in the Timeline, freezes 
the last random value generated by this behavior for the remaining duration of the 
object. Trimming the end of the behavior bar resets the parameter to its original value.

•	 Apply To: A pop-up menu that shows the parameter affected, and that can be used to 
reassign the behavior to another parameter.

Retiming behaviors

Intro to Retiming behaviors in Motion

Retiming behaviors modify timing and playback—slowing down, speeding up, looping, and 
reversing clips, among other effects. Although you can also control basic clip timing in the 
Properties Inspector, the Retiming behaviors are more flexible, letting you define which 
portion of the clip is modified by a timing change. Further, any timing changes made to a 
clip using the Inspector’s Timing controls are respected by the Retiming behaviors. For 
example, if you change the speed of a clip to 50% in the Properties Inspector and then 
apply a Retiming behavior, the Retiming behavior uses that half-speed clip as its source. 
(For more information about Timing controls in the Properties Inspector, see Intro to 
retiming media in the Timeline.)

There are 11 Retiming behaviors:

•	 Flash Frame behavior inserts a range of random frames into the playback of a clip.

•	 Hold Frame behavior freezes the frame at the behavior’s In point.

•	 Loop behavior replays a segment of a clip.

•	 Ping Pong behavior replays a segment of a clip backward and then forward.

•	 Replay behavior triggers playback of a clip segment that begins at a different frame in 
your project.

•	 Reverse behavior plays a clip or image sequence backwards.

•	 Reverse Loop behavior replays a segment of a clip in reverse.

•	 Scrub behavior moves a virtual playhead around a clip.

•	 Set Speed behavior changes the playback rate of a clip.

•	 Strobe behavior simulates the look of a strobe light or lower-frame-rate video.

•	 Stutter behavior randomly inserts hold frames, of random durations, into the playback 
of a clip.
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Flash Frame behavior in Motion

The Flash Frame behavior inserts a user-defined range of random frames (adjacent to the 
current frame) into the playback of a clip.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Random Frames: A slider that sets the probability that a frame within the duration of 
the behavior is replaced with a random frame. When this value is set to 0, no random 
frames are inserted. When set to 100, every frame is random. The default value is 10%.

•	 Frame Range: A slider that defines the range from which the random frames are chosen, 
based around the current frame. The default value is 10 frames.

•	 Duration: A slider that sets the duration of the sequence of random frames. The default 
value is 1, which means one random frame is inserted at a time. When Duration is set 
to 30, for example, 30-frame sequences (chosen from the Frame Range) are randomly 
inserted. The Duration value overrides the Random Frame count (so a new random 
frame does not interrupt the sequence).

•	 Random Seed: A button that picks a new random seed number. This number is used to 
generate new values, based on the other parameters of this behavior.

Hold Frame behavior in Motion

The Hold Frame behavior holds the frame at the behavior’s In point for the duration of the 
behavior. The clip continues playing normally after the behavior’s Out point. For example, if 
the Hold Frame behavior begins at frame 60 and ends at frame 300, the clip plays normally 
until frame 59; frame 60 is held for 240 frames; and then normal playback resumes—frame 
61 of the clip—at frame 301.

The Hold Frame behavior is applied at the current frame, rather than at the start of the object.

Adjust this behavior using a single control in the Behaviors Inspector:

•	 Offset: A slider that sets the offset for the hold frame. When set to 0 (the default), the 
frame at the start of the behavior is the hold frame. When set to 60, however, the frame 
at the start of the behavior (the hold frame) is the start frame plus 60 frames. This 
parameter is measured in frames.

 Tip: Flickering may occur if you apply the Hold Frame behavior to interlaced footage. 
To avoid this, ensure that Field Order is properly set in the Inspector. To change field 
order, select the footage in the Media list, open the Media pane in the Inspector, then 
choose a field order option from the Field Order pop-up menu. See Source media 
controls.

Loop behavior in Motion

The Loop behavior loops a segment of the clip within the duration of the behavior. The 
loop’s starting frame is derived from the start frame of the behavior. For example, if the 
behavior is applied at the start of a clip, and Loop Duration is set to 30, the first 30 frames 
of the clip loop repeatedly until the end of the behavior. At the end of the behavior, normal 
playback resumes from the frame at the end of the loop duration.

Adjust this behavior using a single control in the Behaviors Inspector:

•	 Loop Duration: A slider that sets the duration of the looped frames. The default value is 
30 frames.
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Ping Pong behavior in Motion

The Ping Pong behavior “ping-pongs” playback of a segment of the clip within the duration 
of the behavior. The ping-pong effect’s starting frame is derived from the start frame of the 
behavior. For example, if the behavior is applied at the start of a clip, and Duration is set to 
30, the first 30 frames of the clip play forward, then play in reverse, then forward, and so on 
until the end of the behavior. At the end of the behavior, normal playback resumes.

Adjust this behavior using the control in the Behaviors Inspector:

•	 Duration: A slider that sets the duration of the ping-pong frames. The default value is 
30 frames.

Replay behavior in Motion

The Replay behavior resets the playhead at the beginning of the behavior to a specific 
frame, then plays the clip normally from that frame. The clip plays back normally after the 
end of the behavior. Use this behavior to trigger playback of the clip at different times, 
without making multiple copies of the movie object.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Start From: A pop-up menu that determines whether the replay starts from an absolute 
frame number or an offset from the frame at the start of the behavior. There are two 
menu items:

•	 Absolute Frame: Sets the replay to start at the frame specified in the Start Time 
parameter. For example, if the behavior starts at frame 60 of the clip and Start 
Frame is set to 30, when playback reaches frame 60, the clip starts playback over 
from frame 30.

•	 Offset Frame: Offsets the start frame of the replay. For example, if the behavior 
starts at frame 60 of the clip, and Start Frame is set to 30, when playback reaches 
frame 60, the clip starts playback at frame 90. If Start Frame is set to –30, the clip 
starts playback over from frame 30.

•	 Start Time: A slider that sets the start frame where the replay begins. The default is 
frame 1.

Reverse behavior in Motion

The Reverse behavior plays the clip or image sequence backwards.

There are no parameters for this behavior.

Reverse Loop behavior in Motion

The Reverse Loop behavior loops a segment of the clip in reverse within the duration of 
the behavior. If Loop Duration is set to 30 and the behavior begins at frame 1, frames 1–30 
are played in reverse, then frames 31–60 are played in reverse, frames 61–90 are played in 
reverse, and so on.

 Tip: To achieve a nice stutter effect, set Loop Duration to 2.

Adjust this behavior using a single control in the Behaviors Inspector:

•	 Loop Duration: A slider that sets the duration of the looped frames to be played in 
reverse. The default value is 30 frames.
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Scrub behavior in Motion

Like the Scrub filter, the Scrub behavior moves a virtual playhead around a clip, allowing 
you to change the timing of the clip without moving it in the Timeline. Additionally, the 
Scrub behavior lets you animate the offset parameter using keyframes or Parameter 
behaviors, often with interesting results. Try applying the Oscillate behavior to the Frame 
offset, with the Offset From parameter set to Current Frame. Scrub does not affect clip 
audio.

Note: You can also apply Parameter behaviors to the Retime Value parameter in the Timing 
controls for the clip object. The Timing controls are located in the Properties Inspector. 
Time Remap must be set to Variable Speed to access the Retime Value parameter.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Frame Offset: A slider that sets the offset of the virtual playhead.

•	 Offset From: A pop-up menu that sets the position where the virtual playhead is offset. 
There are two menu items: First Frame or Current Frame.

Set Speed behavior in Motion

The Set Speed behavior lets you change the speed (playback rate) of a clip. The speed 
specified in the behavior begins at the behavior’s In point and exists for the duration of 
the behavior. The clip continues playing at its default speed after the behavior’s Out point. 
For example, if the Set Speed behavior begins at frame 60 and ends at frame 300, the clip 
plays normally until frame 59, plays back at the rate specified in the behavior from frame 
60 to frame 300, then resumes its default playback speed at frame 301. You can apply an 
ease-in or ease-out effect to the speed change.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Speed: A slider that sets the speed of the clip as a percentage. The default is 100% (the 
clip’s normal speed). A Speed setting of 50% plays the clip at half speed.

Note: The Speed parameter can be keyframed to create variable playback rate changes.

•	 Ease In Time: A slider that sets the number of frames over which the ease-in speed 
change occurs (from the start of the behavior). The default value is 20 frames.

•	 Ease In Curve: A slider that defines the curvature of the ramp when easing into the 
speed change. A value of 0 creates a sharp transition to the new speed; a value of 100 
creates the smoothest ease in to the new speed. The default is 50%.

•	 Ease Out Time: A slider that sets the number of frames over which the ease-out speed 
change occurs (from the end of the behavior). The default value is 20 frames.

•	 Ease Out Curve: A slider that defines the curvature of the ramp when easing out of the 
speed change. A value of 0 creates a sharp transition from the new speed to the original 
speed; a value of 100 creates the smoothest ease out. The default is 50%.
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Strobe behavior in Motion

The Strobe behavior simulates the look of a strobe light or lower-frame-rate video by 
holding a number of frames as defined by the Strobe Duration parameter over the playback 
of the clip. For example, when Strobe Duration is set to 10, frame 1 is held for 10 frames, 
frame 11 for 10 frames, frame 21 for 10 frames, and so on. The frames in between (2–10, 
12–20, 22–30, and so on) do not appear.

Adjust this behavior using a single control in the Behaviors Inspector:

•	 Strobe Duration: A slider that sets the number of frames to hold. A value of 1 plays the 
clip at normal speed. The default value is 5 frames.

Stutter behavior in Motion

The Stutter behavior randomly inserts hold frames of random durations into the playback 
of a clip. The effect is similar to that of a videocassette tape that sticks during playback.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Stutter Amount: A slider that sets the probability that a hold frame is generated at the 
given frame. When set to 0%, no hold frames are created; when set to 100%, every 
frame is a hold frame. Values between 0 and 100 indicate the probability of frames 
(within the duration of the behavior) that are replaced by hold frames. The default value 
is 10%.

•	 Duration Range: A slider that sets the maximum duration of hold frames. A value of 
1 inserts single-frame hold frames at a frequency determined by the Stutter Amount 
parameter. Increasing the Duration Range increases the range of hold frames. For 
example, a value of 30 creates random hold frames with a minimum of 1 frame and a 
maximum of 30 frames. The default value is 3 frames.

•	 Random Seed: A button that picks a random seed number to generate new values, 
based on the other parameters of this behavior.
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Simulation behaviors

Intro to Simulation behaviors in Motion

Simulation behaviors perform one of two tasks. Some Simulation behaviors, such 
as Gravity, animate the parameters of an object in a way that simulates a real-world 
phenomenon. Other Simulation behaviors, such as Attractor and Repel, affect the 
parameters of objects surrounding the object to which they’re applied. These behaviors 
allow you to create sophisticated interactions among multiple objects in your project with 
minimal adjustments. Like the Basic Motion behaviors, Simulation behaviors also affect 
specific object parameters. Examples include Attractor, Gravity, and Repel.

Important: Several Simulation behavior parameters contain object wells into which you 
drag target objects used as attractors, repellers, orbiters, and so on. Dragging an object to 
a well can be tricky—be sure to drag the object name (or thumbnail) from the Layers list to 
the object well in the Inspector without releasing the mouse button until the pointer is over 
the object well. If you click the object in the Layers list and release the mouse button, that 
behavior object is deselected its parameters are no longer displayed in the Inspector. This 
applies to all object wells, including mask source wells and image wells.

There are 16 Simulation behaviors:

•	 Align to Motion behavior changes the orientation of an object to match its direction 
along an animation path.

•	 Attracted To behavior pulls an affected object toward a designated target.

•	 Attractor behavior pulls objects toward the affected object.

•	 Drag behavior simulates the force of friction on a moving object, slowing it down over 
time. 

•	 Drift Attracted To behavior pulls an affected object toward a designated target, then 
makes the object come to rest, rather than overshooting the target and bouncing 
around.

•	 Drift Attractor behavior pulls other objects toward the affected object, then makes 
those objects come to rest, rather than overshooting the affected object and bouncing 
around.

•	 Edge Collision behavior causes an object to collide with and bounce off the edges of 
the canvas frame.

•	 Gravity behavior causes an object to fall over time.

•	 Orbit Around behavior causes the affected object to circle around a designated target.

•	 Random Motion behavior animates an object along a random path.

•	 Repel behavior pushes objects away from the affected object.

•	 Repel From behavior pushes the affected object away from a designated target.

•	 Rotational Drag behavior simulates the force of friction on spinning objects.

•	 Spring behavior causes the affected object to move back and forth around a designated 
target.

•	 Vortex behavior causes objects to circle around the affected object.

•	 Wind behavior “blows” an object in a specified direction.
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Align to Motion behavior

The Align to Motion behavior changes the rotation of an object to match changes made 
to its direction along an animation path. This behavior is meant to be combined with 
Simulation behaviors that animate the position of an object or with a keyframed animation 
path you create yourself.

Note: The Align to Motion behavior does not work on objects animated using the Motion 
Path behavior. Instead, use the Snap Alignment to Motion behavior (in the Basic Motion 
subcategory).

Unlike the Snap Alignment to Motion behavior, which produces absolute changes in 
rotation that precisely match changes in direction, Align to Motion has a springy reaction 
and creates a more lively effect.

In the above example, the airplane travels along the keyframed animation path, but the 
plane isn’t aligned to the animation path (notice the rotation handle). Using the Align to 
Motion behavior, the airplane’s angle of rotation moves so it points in the direction of the 
animation path. By adjusting the Drag parameter, you can make the object careen wildly 
about its anchor point as it goes around curves in the animation path.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple child objects, such as a group, a particle emitter, a replicator, or 
a text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Rotation Axis: A pop-up menu that rotates the object around the X, Y, or Z axis. You can 
also select All to rotate the object around all three axes. The default rotation axis is Z.

•	 Axis: A pop-up menu that sets whether the object aligns to its horizontal or vertical 
axis.

•	 Invert Axis: A checkbox that flips the orientation with which the object aligns to the 
motion.
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•	 Spring Tension: A slider that adjusts how quickly the object’s rotation changes to match 
a change in the object’s direction. Lower values create a delay between a change to 
an object’s position and its subsequent change in rotation. Higher values create more 
responsive changes in rotation.

•	 Drag: A slider that adjusts whether the change in rotation made by this behavior 
overshoots the new direction of the object. Low drag values result in springy changes in 
rotation, where the object rotates back and forth as it overshoots changes in direction. 
High drag values dampen this effect, making the object’s rotation stick more closely 
to the changes made in rotation. Higher values also cause the object’s rotation to lag 
behind the object’s change in position.

Attracted To behavior in Motion

An object with the Attracted To behavior applied moves toward a single specified target, 
the object of attraction. Additional parameters allow you to adjust the area of influence 
that defines how close an object must be to move toward the object of attraction, and how 
strongly it is attracted.

The Drag parameter lets you define whether attracted objects overshoot and bounce about 
the attracting object, or whether they eventually slow down and stop at the position of the 
target object.

You can apply two or more Attracted To behaviors to a single object, each with a different 
object of attraction, to create tug-of-war situations where the object bounces among all 
objects it’s attracted to.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple child objects, such as a group, a particle emitter, a replicator, or 
a text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Object: An object well that defines the object of attraction. To set the defined target 
object, drag the object from the Layers list to the Object well in the Attracted To HUD 
or Inspector. In the Layers list, you can also drag the target object onto the Attracted To 
behavior.

•	 Strength: A slider defining the speed at which the object moves toward the object of 
attraction. With a value of 0, the object doesn’t move at all. The higher the value, the 
faster the object moves.
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•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially. There are two menu items:

•	 Linear: Object attraction falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is attracted, and the faster it moves toward the object of attraction.

•	 Falloff Rate: A slider that sets how quickly the force of attraction between objects 
affected by this behavior falls off. A low Falloff Rate value results in objects quickly 
getting up to speed as they move toward the object of attraction. A high Falloff Rate 
causes objects to accelerate much more slowly. When set to Exponential, the attraction 
falls off more quickly than when set to Linear.

•	 Influence: A slider that defines the radius of the circle of influence, in pixels. Objects 
that fall within the area of influence move toward the object of attraction. Objects 
outside the area of influence remain in place.

•	 Drag: A slider that reduces the distance attracted objects overshoot the object of 
attraction. Lower Drag values result in the object overshooting the object of attraction, 
moving past and then careening back around toward the target object again and again. 
Higher Drag values result in the object coming to rest sooner.

•	 Include X, Y, and Z: Buttons that specify the axes on which the affected object (or 
objects) moves around the object to which it is attracted. When Z is enabled, the object 
moves about its attractor object in Z space.

Attractor behavior in Motion

The Attractor behavior, when applied to an object, causes other objects that lie within 
the area of influence to move toward it. You can manipulate the strength with which other 
objects are attracted, as well as the distance required for attraction to begin.

By default, objects overshoot the object of attraction and bounce around, never coming to 
rest. The Drag parameter lets you adjust this behavior, changing whether attracted objects 
overshoot and bounce around, or whether they eventually slow down and stop at the 
position of the target object.

The Attractor behavior can affect all objects in the canvas that fall within the area of 
attraction, or you can limit its effect to a specific list of objects by using the Affect 
parameter.

The Attractor behavior can also be applied to objects in motion. If you animate the position 
of the target object to which you’ve applied the Attractor behavior, all other objects in the 
canvas continue to be attracted to its new position.
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Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect: A pop-up menu that limits which objects in your project are affected by the 
Attractor behavior. There are three options:

•	 All Objects: All objects in the canvas are affected by the Attractor behavior.

•	 Related Objects: The default setting. Only other objects in the same group as the 
object of attraction are affected.

•	 Specific Objects: Only objects appearing in the Affected Objects list are affected by 
the Attractor behavior.

•	 Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-
up menu. Drag objects from the Layers list into this list to have the objects affected by 
this behavior. To remove an item from the list, select the item and click Remove. The 
Affected Objects list contains the following columns:

•	 Layer: This column lists the name of the layer containing the object.

•	 Name: This column lists the name of the object.

•	 Strength: A slider that sets the speed at which attracted objects move toward the target 
object. With a value of 0, attracted objects don’t move at all. The higher the value, the 
faster attracted objects move.

•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially. There are two menu items:

•	 Linear: Object attraction falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is attracted, and the faster it moves toward the object of attraction.

•	 Falloff Rate: A slider that sets how quickly the force of attraction between objects 
affected by this behavior falls off. A low Falloff Rate value results in objects quickly 
getting up to speed as they move toward the object of attraction. A high Falloff Rate 
causes objects to accelerate much more slowly. When set to Exponential, the attraction 
falls off more quickly than when set to Linear.

•	 Influence: A slider that defines the radius of the circle of influence in pixels. Objects 
that fall within the area of influence move toward the object of attraction. Objects 
outside the area of influence remain in place.

•	 Drag: A slider that reduces the distance attracted objects overshoot the object of 
attraction. Lower Drag values result in the object overshooting the object of attraction, 
moving past and then careening back around toward the target object again and again. 
Higher Drag values result in the object coming to rest sooner.

•	 Include X, Y, and Z: Buttons that specify the space in which the object (or objects) 
moves toward the target object. For example, when X and Y are enabled, the object 
moves in the XY plane; when Y and Z are enabled, the object moves in the YZ plane.
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Drag behavior in Motion

The Drag behavior simulates the force of friction on a moving object, slowing it down 
over time. Applying the Drag behavior is an easy way to decelerate objects with multiple 
behaviors that create complex motion.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Amount: Sliders that slow down an object over time, causing it to eventually come to a 
stop. Higher Drag values result in the object coming to rest sooner. Click the Amount 
disclosure triangle to adjust the drag applied to the X, Y, and Z values separately. An 
example of this is to create a situation where an object’s vertical speed slows down 
faster than its horizontal speed.

•	 Include X, Y, and Z: Buttons that specify the space that Drag affects. For example, when 
X and Y are enabled, the object drags in the XY plane; when Y and Z are enabled, the 
object drags in the YZ plane.

Drift Attracted To behavior in Motion

The Drift Attracted To behavior is similar to the Attracted To behavior, but by default an 
object moves toward the object of attraction and comes to rest, rather than overshooting 
the object of attraction and bouncing around.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Object: An object well that defines the object of attraction. To set the defined target 
object, drag the object from the Layers list to the Object well in the Drift Attracted To 
HUD or Inspector. In the Layers list, you can also drag the target object onto the Drift 
Attracted To behavior.

•	 Strength: A slider that sets the speed at which the object moves toward the object of 
attraction. With a value of 0, the object doesn’t move at all. The higher the value, the 
faster the object moves.

•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially. There are two menu items:

•	 Linear: Object attraction falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is attracted, and the faster it moves toward the object of attraction.
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•	 Falloff Rate: A slider that sets how quickly the force of attraction between objects 
affected by this behavior falls off. A low Falloff Rate value results in objects quickly 
getting up to speed as they move toward the object of attraction. A high Falloff Rate 
causes objects to accelerate much more slowly. When set to Exponential, the attraction 
falls off more quickly than when set to Linear.

•	 Influence: A slider that sets the radius of the circle of influence, in pixels. Objects that 
fall within the area of influence move toward the object of attraction. Objects outside 
the area of influence remain in place.

•	 Drag: A slider that reduces the distance attracted objects overshoot the object of 
attraction. Lower Drag values result in the object overshooting the object of attraction, 
moving past and then careening back around toward the target object again and again. 
Higher Drag values result in the object coming to rest sooner.

•	 Include X, Y, and Z: Buttons that specify the space in which the affected object (or 
objects) drifts toward the object to which it is attracted. For example, when X and Y are 
enabled, the object drifts in the XY plane; when Y and Z are enabled, the object drifts in 
the YZ plane.

Drift Attractor behavior in Motion

The Drift Attractor behavior is similar to the Attractor behavior, but by default objects 
within the area of influence move toward the object of attraction and come to rest, rather 
than overshooting the object of attraction and bouncing around.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect: A pop-up menu that limits which objects in your project are affected by the Drift 
Attractor behavior. There are three options:

•	 All Objects: All objects in the canvas are affected by the Drift Attractor behavior.

•	 Related Objects: The default setting. Only other objects in the same group as the 
object of attraction are affected.

•	 Specific Objects: Only objects appearing in the Affected Objects list are affected by 
the Drift Attractor behavior.

•	 Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-
up menu. Drag objects from the Layers list into this list to have those objects affected 
by the behavior. To remove an item from the list, select the item and click Remove. 
There are two menu items:

•	 Layer: This column lists the name of the layer containing the object.

•	 Name: This column lists the name of the object.

•	 Strength: A slider that sets the speed at which attracted objects move toward the target 
object. With a value of 0, attracted objects don’t move at all. The higher the value, the 
faster attracted objects move.

•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially. There are two options:

•	 Linear: Object attraction falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is attracted, and the faster it moves toward the object of attraction.
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•	 Falloff Rate: A slider that determines how quickly the force of attraction between 
objects affected by this behavior falls off. A low Falloff Rate value results in objects 
quickly getting up to speed as they move toward the object of attraction. A high Falloff 
Rate causes objects to accelerate much more slowly. When Falloff Type is set to 
Exponential, the attraction falls off more quickly than when set to Linear.

•	 Influence: A slider that sets the radius of the circle of influence, in pixels. Objects that 
fall within the area of influence move toward the object of attraction. Objects outside 
the area of influence remain in place.

•	 Drag: A slider that reduces the distance attracted objects overshoot the object of 
attraction. Lower Drag values result in the object overshooting the object of attraction, 
moving past and then careening back around toward the target object again and again. 
Higher Drag values result in the object coming to rest sooner.

•	 Include X, Y, and Z: Buttons that specify the space in which the object (or objects) drift 
toward the target object. For example, when X and Y are enabled, the object drifts in 
the XY plane; when Y and Z are enabled, the object drifts in the YZ plane.

Edge Collision behavior in Motion

The Edge Collision behavior is ideal for setting up complex motion simulations with objects 
that do not exit the canvas. Objects with the Edge Collision behavior applied come to a 
stop or bounce after colliding with the edge of the canvas frame. For example, if you apply 
the Throw behavior to an object and set the velocity to send the object toward the edge 
of the frame, then apply Edge Collision, the object will bounce off the edge of the frame 
according to the Bounce Strength parameter. Edge Collision has no effect on objects larger 
than the canvas.

The angle at which the object bounces depends on the angle at which it hits the edge of 
the frame; the speed it travels after bouncing is set by the Bounce Strength parameter.

Important: By default, the Edge Collision behavior uses the size of the project and 
the bounding box to determine how the object collides with the edge of the canvas. 
An object bounces off the right and left edges of the project at its bounding box. With 
groups (particles, text, and objects), only the object’s center is used. You can make the 
object travel farther off the canvas before it bounces by adjusting the Width and Height 
parameters. If you’re using this behavior with an object that has an alpha channel that’s 
smaller than its bounding box, adjust the Crop parameter in the object’s Properties 
Inspector to fit the bounding box as closely as possible to the edge of the image.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Bounce Strength: A slider that sets the speed at which objects travel after colliding with 
an edge. A value of 0 causes objects to come to a complete stop when colliding with 
an edge that’s perpendicular to the direction of motion. Higher values cause an object 
to move faster after bouncing. This parameter only slows the object in the direction 
perpendicular to the bounced edge.
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•	 Active Edges: Six checkboxes that define which collision box edges are detected by the 
Edge Collision behavior. You can turn edges on and off in any combination.

•	 Left Face: Defines the left edge for the collision.

•	 Right Face: Defines the right edge for the collision.

•	 Top Face: Defines the top edge for the collision.

•	 Bottom Face: Defines the bottom edge for the collision.

•	 Back Face: Defines the back edge (in Z space) for the collision.

•	 Front Face: Defines the front edge (in Z space) for the collision.

•	 Width: A slider that sets a width (the right and left edges of the canvas) other than the 
size of project. By default, Width is set to the project size.

•	 Height: A slider that sets a height (the top and bottom edges) other than the size of 
project. By default, Height is set to the project size.

•	 Depth: A slider that sets a depth (the back and front faces, in Z space) for the edge 
collision. By default, Depth is set to 100 pixels.

Gravity behavior in Motion

The Gravity behavior causes an object, or the objects in a group (when Affect Subobjects 
is selected), to fall over time. The gravitational acceleration can be increased or decreased, 
resulting in a change to the rate of fall. Objects affected by the Gravity behavior continue 
to fall past the bottom edge of the canvas (unless the Edge Collision behavior has been 
applied).

The following illustration shows an object affected by the Throw, Snap Alignment to 
Motion, and Gravity behaviors all at once.

As you can see, the Gravity behavior can be used in conjunction with other behaviors that 
animate the position of objects to create natural-looking arcs and animation paths that 
simulate thrown objects falling to the ground. For example, apply the Throw behavior to an 
object to send it flying through the air, and then apply the Gravity behavior to it to make 
the object arc up and then fall down past the bottom of the canvas.

You can also set the Acceleration parameter to a negative value, effectively applying 
“antigravity” to the object and making it fly up.
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Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Acceleration: A slider that sets the strength of gravity affecting the target object. The 
higher this value, the faster the target object falls.

Orbit Around behavior in Motion

Similar to the Attracted To behavior, the Orbit Around behavior’s default parameter settings 
give the object sufficient initial velocity to orbit around another object in a perfect circle.

Note: Behaviors such as Attractor and Repel applied to nearby objects may disrupt an 
object with the Orbit Around behavior applied to it.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox, available when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Object: An object well that defines the object to orbit around. To set the defined target 
object, drag the object from the Layers list to the Object well in the Orbit Around 
HUD or Inspector. In the Layers list, you can also drag the target object onto the Orbit 
Around behavior.

•	 Strength: A slider that sets the speed of the object.

•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially. The default is Linear.

•	 Linear: Object attraction falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is attracted, and the faster it moves toward the object of attraction.

•	 Falloff Rate: A slider that sets how quickly the force of attraction between objects 
affected by this behavior falls off. A low Falloff Rate value results in objects quickly 
getting up to speed as they move toward the object of attraction. A high Falloff Rate 
causes objects to accelerate much more slowly. When set to Exponential, the attraction 
falls off more quickly than when set to Linear.
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•	 Influence: A slider that defines the radius of the circle of influence in pixels. Objects 
that fall within the area of influence move toward the object of attraction. Objects 
outside the area of influence remain in place.

•	 Drag: A slider that causes the orbit to decay. The default value for Orbit Around is 0, 
which results in a stable orbit. Any other value causes the orbit to decay and the object 
to spiral into the object of attraction.

•	 Include X, Y, and Z: Buttons that specify the space in which the orbit occurs. For 
example, when X and Y are enabled, the object orbits in the XY plane. In the illustration 
below, X and Y are selected in the Include parameter. The red motion paths represent 
the motion of the white stars around the target object (the blue circle). The light gray 
box represents the boundary of the group.

In the illustration below, Y and Z are turned on in the Include parameter. The stars move 
around the target object in the YZ plane.
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•	 Pole Axis: A pop-up menu that becomes available when the X, Y, and Z axes are enabled 
in the Include parameter. Because all points are at a fixed distance from the target or 
attractor object (the Pole Axis), the object can be visualized on a sphere of all possible 
orbits, with the target object at the center of the sphere. The Pole Axis defines the two 
points on the sphere that the orbit must pass through. There are four menu items:

•	 X: Aligns the Pole Axis set to the X plane. 

•	 Y: Aligns the Pole Axis to the Y plane.

•	 Z: Aligns the Pole Axis to the Z plane.

•	 Random: When Random is selected, the axes shift to a different random position.

•	 Direction: A pop-up menu that sets whether objects move in a clockwise or 
counterclockwise direction.

Random Motion behavior

The Random Motion behavior animates the position of an object and makes that object 
move around the canvas along a random path. The Random Motion behavior is useful for 
creating varied animation paths for large numbers of objects you want to move at the same 
time. For example, you can create an arrangement of ten objects in the canvas and apply 
the Random Motion behavior to them all.

Although the motion created with this behavior appears to be random, it’s predetermined 
by the group of parameters you’ve chosen. As long as you don’t change the parameters, 
the animation path created by this behavior remains the same. If you don’t like the path 
that was randomly generated, click the button to the right of the seed value in the HUD 
or in the Behaviors Inspector to pick a new random seed number. This number is used to 
generate a new path.

You can also use the Random Motion behavior to add variation to the animation paths 
created by other behaviors that affect an object’s position. In the following example, 
adding Random Motion to an object with the Orbit Around behavior results in a more erratic 
animation path from orbit to orbit, although it still moves around the center as before.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox that appears when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Amount: A slider that determines the speed the object moves by changing the length of 
the animation path. Higher values result in faster motion and longer animation paths.
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•	 Frequency: A slider that determines the number of twists and turns in the animation 
path, which can be seen by the crookedness of the resulting animation path. Higher 
values create more turns in the animation path. Lower values result in straighter 
animation paths.

•	 Noisiness: A slider that determines an additional level of jaggedness along the 
animation path shape defined by the Amount parameter. Higher values result in a more 
jagged-looking animation path.

•	 Drag: A slider that controls the speed the object moves along the animation path. While 
the Amount parameter controls the length of the animation path, the Drag parameter 
shrinks or enlarges the animation path as a whole.

•	 Include X, Y, and Z: Buttons that specify the space in which random motion is in effect. 
For example, when X and Y are enabled, the motion occurs in the XY plane; when Y and 
Z are enabled, the motion occurs in the YZ plane.

•	 Random Seed: A button that picks a random seed number used to generate new 
animation paths, based on the values you’ve picked in the other parameters of this 
behavior.

Repel behavior in Motion

If you apply the Repel behavior to an object, that object pushes away all other objects 
within the area of influence in the canvas. The strength with which objects are pushed 
away can be increased or decreased, as can the distance repelled objects travel.

You can also specify which objects are affected by this behavior, creating an effect where 
only specific objects are moved, while others remain still.

The Repel behavior is the opposite of the Attractor behavior, and is part of a group of 
simulation behaviors that create complex animated relationships between two or more 
objects.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect: A pop-up menu that limits which objects in your project are affected by the 
Repel behavior. There are three options:

•	 All Objects: All objects in the canvas are affected by the Repel behavior.

•	 Related Objects: The default setting. Only other objects in the same group as the 
repelling object are affected.

•	 Specific Objects: Only objects appearing in the Affected Objects list are affected by 
the Repel behavior.
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•	 Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-
up menu. Drag objects from the Layers list into this list to be affected by the Attractor 
behavior when the Specific Objects option is selected in the Affect pop-up menu. To 
remove an item from the list, select the item and click Remove. The Affected Objects 
list contains the following columns:

•	 Layer: This column lists the name of the layer containing the object.

•	 Name: This column lists the name of the object.

•	 Strength: A slider that defines the speed at which repelled objects move away from the 
object. With a value of 0, repelled objects don’t move at all. The higher the value, the 
faster repelled objects move.

•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially.

•	 Linear: Repulsion between objects falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is repelled, and the faster it moves away from the object doing the repelling.

•	 Falloff Rate: A slider that sets how quickly the force of repulsion between objects 
affected by this behavior falls off. A low Falloff Rate value results in objects quickly 
getting up to speed as they move away from the object of repulsion. A high Falloff Rate 
causes objects to accelerate much more slowly. When set to Exponential, the attraction 
falls off more quickly than when set to Linear.

•	 Influence: A slider that defines the radius of the circle of influence in pixels. Objects 
that fall within the area of influence move away from the object of repulsion. Objects 
outside the area of influence remain in place.

•	 Drag: A slider that reduces the distance repelled objects travel away from the repelling 
object.

•	 Include X, Y, and Z: Buttons that specify the space in which the objects move away from 
the object with the applied Repel behavior. For example, when X and Y are enabled, the 
object moves away in the XY plane; when Y and Z are enabled, the object moves away 
in the YZ plane.

Repel From behavior in Motion

Whereas the Repel behavior pushes other objects away, the Repel From behavior has the 
converse effect, making the object it’s applied to move away from a selected object in the 
canvas.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox that appears when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Object: An object well that defines the object to be repelled from.

•	 Strength: A slider that sets the speed at which the object is repelled. With a value of 0, 
the object is not repelled at all. The higher the value, the faster the object is repelled.



369Motion User Guide

•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially.

•	 Linear: Repulsion between objects falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is repelled, and the faster it moves away from the object doing the repelling.

•	 Falloff Rate: A slider that sets how quickly the force of repulsion between objects 
affected by this behavior falls off. A low Falloff Rate value results in objects quickly 
getting up to speed as they move away from the object of repulsion. A high Falloff Rate 
causes objects to accelerate much more slowly. When set to Exponential, the attraction 
falls off more quickly than when set to Linear.

•	 Influence: A slider that defines the radius of the circle of influence in pixels. Objects 
that fall within the area of influence move away from the object of repulsion. Objects 
outside the area of influence remain in place.

•	 Drag: A slider used to reduce the distance the object or objects travel away from the 
repelling object.

•	 Include X, Y, and Z: Buttons that specify the space in which the object moves away from 
the selected object. For example, when X and Y are enabled, the object moves in the XY 
plane; when Y and Z are enabled, the object moves in the YZ plane.

Rotational Drag behavior in Motion

Rotational Drag is similar to the Drag behavior, except that it affects Rotation instead 
of position. Rotational Drag simulates friction affecting objects that are spinning due to 
keyframed or behavior-driven changes to the Rotation parameter. By setting higher Drag 
values, you can slow rotational changes to an eventual stop.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox that appears when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Amount: A slider used to slow down an object’s rotation over time, causing it to 
eventually come to a stop. Higher Amount values result in the rotation ending sooner.
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Spring behavior in Motion

The Spring behavior creates a relationship between two objects, so that an object with the 
Spring behavior applied to it moves back and forth around a second object. The Attract To 
parameter defines the object that serves as the target and center of the Spring behavior. 
Additional parameters let you adjust the speed of the behavior (Spring Tension) and the 
acceleration of the object at each change in direction (Relaxed Length).

If the Attract To object is at rest, the resulting motion is fairly simple and the springing 
object moves back and forth in a straight line. If the Attract To object is in motion, the 
springing object’s motion is much more complex, changing direction according to the 
velocity of the Attract To object.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox that appears when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Attract To: An object well that defines the object of attraction. To set the defined target 
object, drag the object from the Layers list to the Attract To well in the Spring HUD 
or Inspector. In the Layers list, you can also drag the target object onto the Spring 
behavior.

•	 Spring Tension: A slider that determines how fast the object is pulled toward the object 
of attraction.

•	 Relaxed Length: A slider that sets the distance from the target object where object 
attraction diminishes to zero. As the springing object’s distance increases past this 
point, the force of attraction increases proportionally, to bring it back toward the target 
object.

•	 Repel: A checkbox that, when selected, pushes objects apart as the target object gets 
closer to the object of attraction than the Relaxed Length value. When this checkbox is 
deselected, no repelling force is applied.

•	 Include X, Y, and Z: Buttons that specify the space in which the affected object moves 
back and forth around the assigned object. For example, when X and Y are enabled, 
the object moves back and forth in the XY plane; when Y and Z are enabled, the object 
moves back and forth in the YZ plane.
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Vortex behavior in Motion

The opposite of the Orbit Around behavior, the Vortex behavior exerts a force on all objects 
surrounding the object to which the Vortex behavior is applied.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect: A pop-up menu that limits which objects in your project are affected by the 
Vortex behavior. There are three options:

•	 All Objects: All objects in the canvas are affected by the Vortex behavior.

•	 Related Objects: The default setting. Only other objects in the same group as the 
object of attraction are affected.

•	 Specific Objects: Only objects appearing in the Affected Objects list are affected by 
the Vortex behavior.

•	 Affected Objects: A list that appears when Specific Objects is chosen in the Affect pop-
up menu. Objects you drag from the Layers list into this list are affected by the Attractor 
behavior when the Specific Objects option is selected in the Affect pop-up menu. To 
remove an item from the list, select the item and click Remove. The Affected Objects 
lists contains the following columns:

•	 Layer: This column lists the name of the layer containing the object.

•	 Name: This column lists the name of the object.

•	 Strength: A slider that sets the speed at which the affected objects move about the 
object of attraction.

•	 Falloff Type: A pop-up menu that determines whether the distance defined by the 
Influence parameter falls off linearly or exponentially. The default is Linear.

•	 Linear: Object attraction falls off in proportion to the object’s distance.

•	 Exponential: The closer an object is within the area of influence, the more strongly it 
is attracted, and the faster it moves toward the object of attraction.

•	 Falloff Rate: A slider that sets how quickly the force of attraction between objects 
affected by this behavior falls off. A low Falloff Rate value results in objects quickly 
getting up to speed as they move toward the object of attraction. A high Falloff Rate 
causes objects to accelerate much more slowly. When set to Exponential, the attraction 
falls off more quickly than when set to Linear.

•	 Influence: A slider that defines the radius of the circle of influence, in pixels. Objects 
that fall within the area of influence move toward the object of attraction. Objects 
outside the area of influence remain in place.

•	 Drag: A slider that causes the vortex to decay. The default value for Vortex is 0, which 
results in a stable vortex. Any other value causes the vortex to decay and the object to 
spiral into the object of attraction.

•	 Include X, Y, and Z: Buttons that specify the space in which the objects vortex around 
the target object. For example, when X and Y are enabled, the object circles around in 
the XY plane; when Y and Z are enabled, the object circles around in the YZ plane.
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•	 Pole Axis: A pop-up menu that becomes available when the X, Y, and Z axes are enabled 
in the Include parameter. Because all points are at a fixed distance from the target or 
attractor object (the Pole Axis), the object can be visualized on a sphere of all possible 
orbits, with the target object at the center of the sphere. The Pole Axis defines the two 
points on the sphere that the orbit must pass through. See this parameter’s discussion 
in Orbit Around behavior.

•	 Direction: A pop-up menu that sets whether objects move in a clockwise or 
counterclockwise direction.

Wind behavior in Motion

Apply the Wind behavior to an object to animate its position and move it in a specified 
direction. Unlike the Throw behavior, the velocity specified by the Wind behavior is a 
continuous force, and its parameters can be keyframed to achieve gradual changes in 
speed and direction.

The Wind behavior is better than the Throw behavior when you want to vary the speed 
of the affected object. You can apply another behavior (such as Randomize or Ramp) or 
keyframe the Velocity parameter of the Wind behavior to vary the speed and direction 
of the object. You cannot make gradual changes in speed or direction with the Throw 
behavior.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Affect Subobjects: A checkbox that appears when this behavior is applied to an object 
that contains multiple objects, such as a group, a particle emitter, a replicator, or a 
text layer. When this checkbox is selected, all objects enclosed in the parent object 
are affected individually. When this checkbox is deselected, all objects enclosed in the 
parent object are affected by the behavior together.

•	 Air Thickness: A slider and value slider that adjust how fast the object accelerates on 
the X, Y, or Z axis when the speed is changed. Lower values (simulating thinner air) have 
less effect when pushing the object, so it takes longer to get up to speed. Higher values 
(thicker air) have more effect and push the object up to speed more quickly.

•	 Velocity: A slider and value slider that adjust the speed on the X, Y, or Z axis where the 
simulated air is blowing the object. Higher values result in faster motion.
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The HUD lets you specify the direction and speed of the Wind behavior by dragging an 
arrow in a circular region. The direction of the arrow defines the direction of movement in X 
and Y space, and the length of the arrow defines speed (velocity). A slider lets you adjust 
the scale of the HUD control, increasing or decreasing the effect the control has over the 
object.

Press the Shift key while dragging the arrow to constrain the direction to 45-degree 
angles. Press the Command key to change the arrow’s direction without affecting its 
length.

When you click the 3D button, a center arrow control defines the direction the object is 
“blown” by the wind in 3D. The Speed slider increases or decreases the velocity of the 
blown object.

Note: The maximum speed you can define with the HUD is not the maximum speed 
possible. Higher values can be entered into the Velocity parameter in the Behaviors 
Inspector.



374Motion User Guide

Additional behaviors in Motion
Audio, Camera, Motion Tracking, Particles, Replicator, Shape, and Text behaviors are 
designed specifically to be applied to their respective objects: Audio files, cameras, 
particle emitters or cells, replicators or replicator cells, shapes, and text.

Save and share custom behaviors

Save custom behaviors in Motion
You can save customized behaviors to the Library in any of several organizational 
categories for future use. Behaviors saved in the Library appear with a custom icon. You 
can also save multiple behaviors to the Library as a single file or as multiple files. For 
example, if you create an animation that uses multiple behaviors and you want to save the 
cumulative effect of those behaviors, you can save them all as one item in the Library.

Alternatively, you can create new folders in existing categories. You can create a folder 
in the Favorites or Behaviors category. Folders created in the Behaviors category appear 
in the Library sidebar. Folders created in the subcategories, such as the Basic Motion 
subcategory, appear in the Library stack and not the sidebar.

Save a behavior to the Library
1.	 In Motion, open the Library and select the Favorites, Favorites Menu, or Behaviors 

category.

For organizational purposes, it’s best to save custom behaviors to the Favorites or 
Favorites menu category. 

2.	 Drag the customized behavior to save from the Layers list, Timeline, or Inspector into 
the stack at the bottom of the Library.

Note: If a custom behavior is dragged to another subcategory, such as the Glow (Filters) 
subcategory, it is placed in the Behaviors category and the Behaviors category becomes 
active.

Save multiple behaviors to the Library
1.	 In Motion, open the Library and select the Favorites, Favorites Menu, or Behaviors 

category.

2.	 In the Layers list, select all behaviors to save and drag them to the stack, holding down 
the mouse button until a drop menu appears.

3.	 Choose “All in one file” or “Multiple files” from the drop menu, then release the mouse 
button.

“All in one file” saves behaviors together. They are listed as one item in the Library. 
“Multiple files” saves the behaviors as individual objects in the Library.

When you save a customized item to the Library, it is saved in the /Users/username/Library/
Application Support/Motion/Library/ folder.
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Delete custom behaviors in Motion
You can delete custom behaviors from the Library, if necessary.

Delete a custom behavior
•	 In the Library in Motion, Control-click the custom behavior, then choose Move to Trash 

from the shortcut menu.

Delete a custom folder from a subcategory in the Library
•	 In Motion, control-click the folder in the Library, then choose Move to Trash from the 

shortcut menu.

You can also delete the folder from the macOS Finder. The folder is stored in the /Users/
username/Library/Application Support/Motion/Library/ folder. If the Library folder is hidden 
in the Finder, press and hold the Option key, and choose Go > Library.

Important: Deleting a custom object or folder cannot be undone.

Move behaviors in Motion to another computer 
Each customized behavior you drag into the Motion Library is saved as a separate file in 
the /Users/username/Library/Application Support/Motion/Library/ folder on your computer. 
For example, a saved custom behavior named “My Motion Path” in the Favorites folder of 
the Library appears in the /Users/username/Library/Application Support/Motion/Library/
Favorites/ folder. Items saved to the Library appear in the macOS Finder with a .molo 
filename extension (“Motion Library object”). These items cannot be opened from the 
Finder.

You can move saved behaviors to other computers that have Motion installed.

Copy a custom behavior to another computer
•	 Copy Motion custom behaviors from your computer’s /Users/username/Library/

Application Support/Motion/Library/ folder to the same folder on another computer that 
has Motion installed.
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Animate with keyframes

Intro to keyframing in Motion
Keyframing is the process of assigning different parameter values to an object at specific 
points in time to animate some aspect of the object. Although behaviors are ideal for 
quickly adding complex motion or effects to an object, keyframes provide additional 
precision, ensuring that a specific event happens at the exact frame you choose. For 
example, if you want to time a movement or effect to match a musical beat or a word in the 
soundtrack, a keyframe is the best tool for the job.

When you set more than one keyframe for a parameter, Motion interpolates the in-between 
frames, generating a smooth change over time. For example, if you want a title to change 
from green to blue over time, you can set two keyframes at two points in time. The first 
keyframe defines the text’s color as green, and the second keyframe sets the color to blue. 
Motion makes the frames between those points change smoothly from green to blue.

Motion lets you keyframe color values, position, rotation, opacity, and almost every other 
parameter in the application—for both image layers and effects objects (cameras, lights, 
behaviors, filters, and so on). For example, keyframes allow you to animate static filters and 
modify behaviors, resulting in complex, precisely timed animations.

There are two basic ways to add keyframes to your project. And you can edit keyframes in 
several areas of the Motion window: in the Inspector, in the HUD, in the Timeline track area, 
and in the Keyframe Editor.
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Add keyframes in Motion
Motion provides two basic ways to apply keyframes to animate your project:

•	 Record button method: Turn on the Record button to create a new keyframe whenever 
you adjust any parameter. This method is useful when you want to create keyframes for 
multiple parameters in your project.

•	 Initial-keyframe method: Manually add a keyframe to a parameter to have any further 
adjustment of that parameter create additional keyframes at the current playhead 
position. This method is useful when you want to create keyframes for a single 
parameter of a specific object in your project.

Important: When you animate parameters using the initial-keyframe method, you 
cannot turn off or suspend keyframe recording.

Add keyframes to one or more parameters using the Record button
1.	 In Motion, do one of one following:

•	 Click the Record button on the left side of the timing toolbar.

•	 Press A.

•	 Choose Mark > Record Animation.

The Record button is highlighted.

2.	 Select an object in the canvas, Layers list, or Timeline.

3.	 Drag the playhead to a new position in time.
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4.	 Modify one or more parameters by doing any of the following:

•	 Use the onscreen controls to move, scale, or manipulate objects.

•	 Use the controls in the Inspector or HUD to move, scale or manipulate objects.

Keyframes are added at the current playhead position for any parameters you 
modified.

5.	 Repeat steps 3 and 4 to add additional keyframes.

As long as the Record button is enabled, any parameter modifications your make in your 
project are recorded as new keyframes. In the Inspector, all modifiable parameters are 
highlighted red to remind you that parameter changes are being recorded as keyframes. 

Turn off the Record button
If keyframe recording is enabled, you can turn it off the same way you turned it on.

In Motion, do one of the following:

•	 Click the Record button on the left side of the timing toolbar.

•	 Press A.

•	 Choose Mark > Record Animation.

Add keyframes to a single parameter using the initial-keyframe method
1.	 In Motion, select an object in the canvas, Layers list, or Timeline.

2.	 Modify a parameter by doing one of the following:

•	 Use the onscreen controls to move, scale, or manipulate the object.

•	 Use the controls in the Inspector or HUD to move, scale or manipulate the object.

3.	 Create an initial keyframe by doing one of the following:

•	 Press Control-K.

Pressing Control-K adds a keyframe to the last parameter you modified (in step 2 
above). For example, if you scale a layer using its onscreen handles and then press 
Control-K, a keyframe is added to the Scale parameter.

•	 In the Transform section of the Properties Inspector, click the Add/Delete Keyframe 
button (the diamond outline) on the far-right side of the parameter you want to 
keyframe.



379Motion User Guide

Note: When you move the pointer over the Add/Delete Keyframe button, a plus sign 
appears inside the diamond); after you add a keyframe, the diamond turns solid gray.

•	 In the Transform section of the Properties Inspector, click the Animation menu on 
the far right side of a parameter, then choose Add.

Note: The Animation menu (a down arrow) is hidden until you position the pointer 
over the far-right side of the parameter row you want to add a keyframe to.

•	 In the Inspector, Control-click a parameter’s name, then choose Add from the 
shortcut menu.

A keyframe for the parameter you modified is added at the current frame. The 
parameter value appears red in the Inspector, indicating that keyframing is now turned 
on for that parameter.

4.	 Move the playhead to a new time position.

5.	 Modify the same parameter again, as described in step 2.

Another keyframe is added at the current frame.
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Animate in the canvas with keyframes

Add an animation path in the canvas in Motion
The easiest way to apply keyframes is to manipulate objects directly in the canvas while 
the Record button is enabled. Using this method, you can animate changes to basic 
parameters such as scale, rotation, position, distort, and so on.

When the Record button is enabled and you move the playhead to a new frame, any change 
you make to any object generates new keyframes. When animating an object’s position, an 
animation path is created—a red line in the canvas showing the direction of motion (with a 
small white arrow at the beginning of the line) and the location of keyframe points (small 
white diamonds along that path).

Note: To view the animation paths of keyframed objects, ensure that Animation Path is 
selected in the View pop-up menu (in the upper-right corner of the canvas).

If the playhead is positioned on a previously set keyframe, changes you make modify that 
keyframe rather than the curve, regardless of whether the Record button is on or off.

Move an object across the screen
1.	 In the timing toolbar in Motion, click the Record button (or press A) to turn on keyframe 

recording.

2.	 Place the playhead at the starting frame.
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3.	 In the canvas, place the object in a starting position.

4.	 Move the playhead forward.

5.	 In the canvas, drag the object to the ending position.

6.	 Click the Record button (or press A) to turn off keyframe recording.

A red animation path shows the route the object will take when you play back your 
project, flying from position one to position two over the interval you set. 

Note: If you can’t see the animation path, click the View pop-up menu above the 
canvas, then choose Animation Path. When this setting is active, a checkmark appears 
next to it in the View pop-up menu.
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Modify animation paths in Motion
You can modify an animation path by adding keyframes to or deleting keyframes from the 
path, or by dragging keyframes on the path.

Additionally, you can set the keyframe type to curved or angled, changing the shape of 
the path.

When you drag a keyframe in the canvas, the frame number corresponding to that keyframe 
and its X, Y, and Z position values are displayed in the status bar (above the canvas).

Add keyframe points to an animation path
•	 In Motion, double-click or Option-click the animation path.

A new keyframe point is added. By default, keyframe points are curved Bezier points.

Reposition a keyframe point
After you add keyframe to an animation path, you can change its location in canvas, 
thereby changing the shape of the path.

•	 In Motion, drag a keyframe point to a new position in the canvas.

The shape of the animation path changes, based on the new position of the keyframe 
point.
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Reposition the entire animation path
In Motion, do one of the following:

•	 Pressing and holding the Option and Command keys, drag a keyframe point on the 
animation path.

•	 Pressing and holding the Option and Command keys, drag a portion of the animation 
path between two keyframe points.

•	 Pressing and holding the Option and Command keys, drag the object’s center onscreen 
control.

The animation path and the object are moved to a new position in the canvas, and no new 
keyframes are created.

Reposition an object on an animation path
When you move an object on an animation path to a new position in the canvas, a portion 
of the animation path is repositioned along with the object.

•	 In Motion, make sure the object is positioned on the animation path between two 
keyframe points, then drag the object (but not its center onscreen control).

The object is moved to a new position in the canvas, and a new keyframe point is 
created at that position.

Note: If the object is on a keyframe point, dragging the object does not create a new 
keyframe; rather, the current keyframe point is moved along with the object to a new 
position in the canvas.

Change the angle of a keyframe point
By default, keyframe points on an animation path use Bezier curves. You can modify the 
curve angle by dragging tangent handles or by converting Bezier keyframe points to linear 
points.

In Motion, do any of the following:

•	 Change the angle of a Bezier keyframe point: Click to select a Bezier keyframe point in 
the canvas, then drag its tangent handles.

•	 Convert a smooth Bezier keyframe point to a sharp linear point: Control-click a 
keyframe point in the canvas, then choose Linear from the shortcut menu.

The tangent handles of the keyframe point disappear, leaving a sharply angled linear 
keyframe. To quickly convert the keyframe point back to a curved Bezier point with 
tangent handles, Command-drag the keyframe.

•	 Convert a sharp linear keyframe point to a smooth Bezier point: Control-click the 
keyframe point and choose Smooth from the shortcut menu.

Tangent handles appear on the Smooth keyframe point, and the animation path 
becomes curved. To quickly convert a curved Bezier point back to a sharply angled 
linear point, Command-click the keyframe.

Note: The Very Smooth option is not available for animation paths and remains dimmed 
in the shortcut menu.

For more information on manipulating Bezier points, see Intro to complex shapes and 
masks.
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Delete, disable, or lock a keyframe point
Deleting a keyframe point modifies the shape of the animation path; disabling a keyframe 
point temporarily removes it from the path; locking a keyframe point prevents editing.

In Motion, do any of the following:

•	 Delete a keyframe point: Control-click a keyframe point in the canvas, then choose 
Delete Point from the shortcut menu (or select the keyframe point, then press Delete).

The keyframe is removed, changing the shape of the animation path.

•	 Disable a keyframe point: Control-click a keyframe point in the canvas, then choose 
Disable Point from the shortcut menu.

The keyframe is disabled and no longer influences the shape of the animation path. To 
re-enable the keyframe, Control-click the disabled keyframe, then choose Enable Point 
from the shortcut menu.

•	 Lock a keyframe point: Control-click a keyframe point in the canvas, then choose Lock 
Point from the shortcut menu.

The keyframe is locked and can no longer be edited. To unlock the keyframe, Control-
click the locked keyframe point, then choose Unlock Point from the shortcut menu.

Animate in the Inspector

Animate from the Inspector in Motion
Although you can animate basic object properties by dragging onscreen controls in the 
canvas, many other parameters are accessible only in the Inspector. Each section of the 
Inspector contains keyframeable parameters. For example, you can animate the position 
and shape of a mask, the color and styles of a text object, or the options in a generator. 
The parameters that are keyframeable depend on which object is selected and which 
effects are applied to that object.

Animate parameters in the Inspector using the Record button
1.	 In the Motion canvas, select the object to keyframe.

2.	 In the timing toolbar, click the Record button (or press A) to turn on keyframe recording.

3.	 Drag the playhead to the frame where you want the effect to begin.
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4.	 Open the Inspector containing the parameter you want to modify (the Properties 
Inspector, in this example).

Note: When the Record button is turned on, animatable parameter values appear red.

5.	 Set the parameter to the beginning value.

6.	 Move the playhead to a new position.

7.	 In the Inspector, change the parameter to a new value.

8.	 Click the Record button (or press A) again to turn off keyframe recording.

The parameter now changes over time.
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Animate parameters in the Inspector by setting an initial keyframe (Record button 
is off)
1.	 In the Motion canvas, select the object to keyframe.

2.	 Place the playhead on the frame where you want the effect to begin.

3.	 Open the Inspector containing to the parameter you want to modify.

4.	 Set the parameter to the beginning value, then do one of the following:

•	 Press Control-K.

•	 In the Inspector, click the parameter’s Animation menu (the down arrow that appears 
when you place the pointer over the right side of a parameter row), then choose Add.

•	 In the Inspector, Control-click the parameter name, then choose Add from the 
shortcut menu.

•	 In the Inspector, click the Add/Delete Keyframe button (the diamond outline) on the 
far-right side of the parameter you want to keyframe.

Note: When you move the pointer over the Add/Delete Keyframe button, a plus sign 
appears inside the diamond; after you add a keyframe, the diamond turns solid gray.

A yellow keyframe is added at the current frame, and the parameter appears red in 
the Inspector.

5.	 Move the playhead to a new position.

6.	 In the Inspector, change the parameter to a new value.

The parameter now changes over time.
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Animation menu controls in Motion
The Animation menu in the Inspector provides access to additional keyframing options.

Every keyframeable parameter in the Inspector has an Animation menu, available by 
Control-clicking a parameter’s name to reveal a shortcut menu, or by moving the pointer 
to the right side of a parameter row in the Inspector, then clicking the down arrow that 
appears.

Note: If the Animation menu corresponds to a parameter that cannot be animated, the 
Keyframes menu items are dimmed.

The Animation menu contains the following items:

•	 Reset Parameter: Removes keyframes and settings for this parameter, resetting the 
parameter to its default value.

•	 Show in Keyframe Editor: Opens the Keyframe Editor and displays the parameter’s 
keyframes and curves. See Display the Keyframe Editor.

•	 Add: Adds a keyframe at the current frame in the project. If the playhead is positioned 
on a frame where a keyframe has been added, this menu command is dimmed. To add 
a keyframe without accessing the Animation menu in the Inspector, press Control-K; 
doing so adds a keyframe to the last modified parameter of the object (regardless of the 
status of the Record button) at the current frame.

•	 Delete: Deletes the keyframe. The Delete option is available only if the playhead is 
positioned on a frame where a keyframe exists.

•	 Previous: Moves the playhead to the previous keyframe for this parameter. The Previous 
command is available only if a keyframe exists earlier in the project.

•	 Next: Moves the playhead to the next keyframe for this parameter. The Next command 
is available only if a keyframe exists later in the project.

Note: You can also choose Mark > Go To > Previous Keyframe (or press Option-K) or 
Mark > Go To > Next Keyframe (or press Shift-K) to move from keyframe to keyframe.
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•	 Enable/Disable Animation: Activates or deactivates keyframes for the parameter. 
Choosing Disable Animation hides the keyframes already set, restoring the parameter to 
its default value. However, the keyframes are not thrown away. (A dash appears in the 
parameter row to indicate that the animation is disabled.) Choosing Enable Animation 
returns the parameter to its last keyframed state.

•	 Add Parameter Behavior: Opens a submenu listing all available Parameter behaviors you 
can use to animate the parameter. See Add or remove a Parameter behavior.

•	 Add To Rig: Lets you add a parameter to an existing rig, or to a new rig. Rigs are 
useful when you create templates for Final Cut Pro. See Intro to rigging and Intro to 
Final Cut Pro templates.

•	 Publish: Sends the parameter control to Final Cut Pro when you create and save a 
template for the editing application. The Publish command also lets you send rig 
controls (widgets) to Final Cut Pro. For more information on the Publish command, see 
Publish controls to Final Cut Pro. For more information on rigging, see Intro to rigging.

Use the Animation menu in Motion
You can use the Animation menu in the Inspector to manage common keyframing tasks.

Note: The Animation menu (a down arrow) is hidden until you position the pointer over the 
far-right side of a parameter row in the Inspector.

Set keyframes using the Animation menu
1.	 In the Inspector in Motion, change the value of the parameter you want to keyframe.

2.	 Click the Animation menu for the affected parameter, then choose Add.

A keyframe is added at the frame and the affected parameter appears red in the 
Inspector, indicating that any further changes at other playhead locations will add 
keyframes to this parameter.

3.	 To set another keyframe for the same parameter, move the playhead to the next 
location, then change the value of the parameter.

Delete a keyframe
1.	 In the Timeline in Motion, move the playhead to a frame where there’s a keyframe.

2.	 In the Inspector, click the Animation menu for the parameter you want to change, then 
choose Delete.

Note: To delete all keyframes for a parameter, choose Reset Parameter from the 
Animation menu.

Remove all keyframes for a parameter
•	 In the Inspector in Motion, click the Animation menu for the parameter you want to 

reset, then choose Reset Parameter.

All keyframes are removed for that parameter.
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Keyframe controls in the Inspector in Motion
In the Inspector, basic keyframe controls are available on the right side of animatable 
parameter rows. These controls allow you to determine the status of a parameter at a 
glance, to add or delete keyframes at the current playhead position, and to navigate to next 
and previous keyframes in the Timeline.

At the far-right side of a parameter row is the Add/Delete Keyframe button (the diamond 
outline). Moving the pointer over the Add/Delete Keyframe button reveals a plus sign (+) 
inside the diamond. Click the button to place a keyframe for that parameter at the current 
frame.

After you add a keyframe, the diamond turns solid gray. Moving the pointer over a solid 
gray diamond (a keyframe) reveals a minus (–) sign inside the diamond. Click the button to 
delete the keyframe for that parameter at the current frame.

If a parameter is keyframed at the current frame, as well as before and after the current 
frame, additional navigation controls appear:

•	 Previous Keyframe: A partial diamond with a left-facing arrow appears when there’s a 
keyframe in the Timeline to the left of the playhead position. Click this control to move 
to a previous keyframe in the Timeline.

•	 Next Keyframe: A partial diamond with a right-facing arrow appears when there’s a 
keyframe to the right of the playhead position. Click this control to move to the next 
keyframe in the Timeline.

•	 Add/Delete Keyframe: A diamond-shaped button with several states. A diamond outline 
indicates that there’s no keyframe at the current frame. Click this button to add a 
keyframe at the playhead position. When you add a keyframe, the diamond turns gray, 
indicating that there’s a keyframe at the current frame. Clicking the gray diamond 
deletes the keyframe.
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Animate from the HUD in Motion
Parameters that appear in the HUD can be keyframed using the Record button or by setting 
an initial keyframe. Using this technique, you can animate basic object properties such as 
opacity or position, or create advanced effects such as setting static filters into motion. In 
this example, the HUD is used to animate an object’s opacity.

Animate a parameter from the HUD
1.	 In the Timeline in Motion, move the playhead where you want to begin to animate.

2.	 Do one of the following:

•	 In the timing toolbar, click the Record button (or press A) to turn on keyframe 
recording, then click a slider handle in the HUD.

Even if you don’t change the slider’s value, clicking it sets a keyframe at that point. 
This way, the parameter remains at its previous value from the beginning of the clip 
until that keyframe, then begins the interpolation toward the next keyframe.

•	 With the Record button off, click a slider handle in the HUD, then press Control-K.

A keyframe for that parameter is added at the playhead position.

3.	 Move the playhead forward to a new time.

4.	 Change the same parameter slider.

5.	 Move the playhead forward again.

6.	 Change the same parameter slider again.

7.	 If keyframe recording is on, click the Record button again (or press A) to turn off 
keyframe recording.
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Use keyframes to modify behaviors

Apply keyframes to behaviors in Motion
You can also use keyframes to animate behaviors. Combining behaviors and keyframes is a 
powerful way to enhance behaviors’ usefulness.

For example, you might want to apply a Gravity behavior, but delay the object’s fall until 
five seconds into the clip. Keyframes allow you to manipulate the parameters of each 
behavior.

Certain parameters cannot be animated, such as the Throw Velocity parameter of the 
Throw behavior and the Spin Rate parameter of the Spin behavior.

If a parameter can be animated, the following occurs:

•	 In the Inspector, the parameter row includes an Add/Delete Keyframe button (a diamond 
outline).

•	 When keyframe recording is turned on (via the Record button) or a keyframe has been 
added (via the Inspector), the parameter value appears red in the Inspector.

•	 When you add keyframes to a parameter that has been animated with a behavior, a 
behavior icon (a gear) appears within a keyframe icon (a diamond).

Note: In Motion, you can convert all behaviors applied to an object into keyframes using the 
Convert to Keyframes command in the Object menu. See Convert behaviors to keyframes.

Keyframe a behavior’s parameters using the Record button
1.	 Select an object in the Motion canvas.

2.	 Apply a behavior.

For more information about applying behaviors, see Intro to applying behaviors.

3.	 In the timing toolbar, click the Record button (or press A) to turn on keyframe recording.

4.	 Place the playhead at the frame where you want the effect to begin changing.

5.	 In the Inspector or HUD, adjust the behavior’s parameter settings.

See Animate from the Inspector and Animate from the HUD.

6.	 Move the playhead to a new time position.

7.	 Adjust the behavior settings again.

8.	 Click the Record button (or press A) to turn off keyframe recording.
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Combining keyframes and behaviors in Motion
When you combine keyframes with behaviors, Motion adds the two sets of instructions 
together. For example, if you apply a Throw behavior toward the upper left of the canvas, 
and at the same time add keyframes that instruct the object to move to the right, the 
behavior-driven object moves less leftward because the keyframes are pushing it in an 
opposite direction. The larger the Throw velocity rate, the more the behavior overpowers 
the keyframes, and vice versa.

You can use this method to enhance and control the effects of behaviors. For example, you 
can apply a Gravity behavior that causes an object to fall toward the bottom of the canvas, 
and then keyframe the object’s position to move across the canvas from left to right. As a 
result, the object falls as it moves rightward.

Likewise, you can apply a Fade In/Fade Out behavior, but use keyframes on the object’s 
Opacity parameter to limit the maximum opacity to 80 percent. The resulting clip fades in, 
but not completely.

Additionally, you can convert behaviors to keyframes. See Convert behaviors to keyframes.

Work with keyframes in the Timeline

View keyframes in the Timeline in Motion
When keyframing, it’s often helpful to view your keyframes in the Timeline. This lets you 
move keyframes to line them up with other important timing elements in your project such 
as edit points, sound cues, markers, and other keyframes. In the Timeline, keyframes 
appear in the track area as small red (or white, when selected) diamonds beneath the 
object they animate. You can also view keyframe values in the Timeline, and delete 
keyframes you don’t need.

View keyframes in the Timeline
•	 In the upper-right corner of the Timeline in Motion, click the Show Keyframes button so 

that it’s highlighted blue.

Any applied keyframes appear in the track area as small red (or white, when selected) 
diamonds beneath the object they animate.
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Identify a keyframe’s value
•	 In Motion, Control-click (or double-click) a keyframe in the Timeline and view its value 

in a shortcut menu.

Note: Multiple keyframes on the same frame are listed in the menu.

Display a keyframe with its associated animation curve in the Keyframe Editor
•	 In Motion, Control-click the keyframe in the Timeline, then choose Show in Keyframe 

Editor from the shortcut menu.

The Keyframe Editor appears below the Timeline. For information on working in the 
Keyframe Editor, see Display the Keyframe Editor.

Modify keyframes in the Timeline in Motion
When keyframes are visible in the Timeline, you can change their positions in time. Moving 
a keyframe in time does not modify the keyframe’s parameter value. Rather, it changes the 
position in time when the keyframe occurs. This can have a significant effect on the nature 
of the animation. For example, if you have two keyframes that animate an object from 
the top of the screen to the bottom over a duration of five seconds, dragging one of the 
keyframes farther from the other forces the animation to occur more slowly.

The value of a keyframe can also be modified in the Timeline.

When multiple keyframe values are set in the same frame, only one keyframe marker 
appears in the Timeline. However, you can choose to edit any of its values.

Move a keyframe in the Timeline
•	 In the Timeline track area in Motion, drag the keyframe left or right to adjust its position 

in time.

Edit a keyframe value in the Timeline
1.	 In the Timeline track area in Motion, Control-click (or double-click) the keyframe.

A shortcut menu appears displaying all of the parameters keyframed at the current 
frame.
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2.	 Choose the keyframe parameter to edit.

3.	 Enter a value into the value field, then press Return.

Note: To exit an active value field without making changes, press Esc.

Copy and paste keyframes in the Timeline
1.	 In the Timeline track area in Motion, select one or more keyframes.

Shift-click to select multiple contiguous keyframes; Command-click to select multiple 
noncontiguous keyframes.

2.	 Choose Edit > Copy (or press Command-C).

3.	 Move the playhead to the frame where you want to paste the keyframes.

4.	 In the Timeline layers list, select the target object (or objects) for the copied keyframes, 
then choose Edit > Paste (or press Command-V).

Note: You can copy and paste keyframes from multiple objects to single or multiple 
objects. The objects must share the same parameters for the keyframes to apply.

Delete a keyframe in the Timeline
•	 In the Timeline track area in Motion, Control-click the keyframe to delete, then choose 

Delete Keyframes from the shortcut menu.

If there are multiple keyframes applied at the playhead position, they’re all deleted.

Delete all of an object’s keyframes in the Timeline
•	 In the Timeline track area in Motion, Control-click any keyframe, then choose Delete All 

Keyframes from the shortcut menu.

For more control of effects using keyframes, you can use the Keyframe Editor. 

Note: Although you can delete keyframes in the Timeline, there is no way to add 
keyframes from the Timeline.
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Align a keyframe to a marker in the Timeline
In the Timeline, you can align a keyframe with other important timed events. For example, 
you might want to align a filter keyframe applied to one object with the In or Out point of 
another object, or to a marker, or to a keyframe in another track.

1.	 In the top-right corner of the Timeline in Motion, click the Show Keyframes button so 
that it’s highlighted blue.

2.	 In the top-right corner of the Timeline, click the Snapping button so that it’s highlighted 
blue.

3.	 Pressing and holding the Shift key, drag a keyframe in the Timeline until the keyframe 
snaps to a marker, another keyframe, or the In or Out point of another object.

Effect duration and keyframe timing in Motion
When you change the duration of an effect such as a filter or behavior in the Timeline track 
area, the timing of all keyframes applied to that effect is scaled proportionally. This means 
that keyframed changes to an effect speed up or slow down when the effect is shortened 
or lengthened. This happens whether you change the duration of the effect bar, or change 
the duration of the image bar an effect is applied to. 

Object parameters such as Position, Rotation, Scale, Opacity, and so on are not affected.

 Tip: To change the duration of a timebar without altering the timing of keyframes, press 
and hold the Command key while dragging one end of the bar left or right.
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Work in the Keyframe Editor

Display the Keyframe Editor in Motion
The Keyframe Editor provides a visualization of changing keyframe values in the form of 
animation curves. Animation curves plot keyframes on a line over time; changing keyframe 
values modifies the shape of the curve. In the Keyframe Editor, you can view and modify 
these curves to fine-tune animation in your project.

On the left side of the Keyframe Editor, a parameter list shows parameters that have 
keyframes. And on the right side, a graph area displays animation curves for those 
keyframed parameters. The Keyframe Editor makes it easy to add and delete keyframes, 
as well as move them in two-dimensional space to modify their values (up-down) and 
their positions in time (left-right). You can manipulate curves and define a variety of 
interpolation methods, creating dramatically different types of effects.

For a complete list of Keyframe Editor features, see Keyframe Editor controls.

Show the Keyframe Editor
In Motion, do one of the following:

•	 Click the Show/Hide Keyframe Editor button on the right side of the timing toolbar.

•	 Choose Window > Keyframe Editor.

•	 Press Command-8.

The Keyframe Editor appears in the Timing pane (under the Timeline if the Timeline is also 
displayed).
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Keyframe Editor controls in Motion
The Keyframe Editor comprises a list of parameters on the left, a multifunctional graph 
on the right where keyframes and curves for each parameter are displayed, and tools for 
modifying keyframes and curves. These elements are described below:

•	 Show Curve Set pop-up menu: Choose an item from the menu to filter the parameters 
shown in the Keyframe Editor. See Choose a curve view.

•	 Keyframe editing tools: Select any of three tools for editing keyframes and curves in the 
graph:

•	 Edit Keyframes tool: Select and edit keyframes the same way you edit Bezier curves.

•	 Sketch Keyframes tool: Manually draw curves that generate keyframes conforming to 
the shape drawn.

•	 Transform Keyframes tool: Drag a selection box to enclose and manipulate a group 
of keyframes simultaneously.

For more information about using these tools, see Modify keyframes in the Keyframe 
Editor.

•	 Parameter list: View keyframeable parameters of selected objects, including image 
layers, filters, and behaviors. When you select multiple objects in the Layers list or 
Timeline, you can compare their parameters here. The parameter list contains the 
following items:

•	 Activation checkbox: Checkboxes in the left column set which parameters are 
displayed in the graph. Deselect a checkbox to hide a parameter’s keyframes and 
curves from the graph on the right.

•	 Parameter name: Object and parameter names appear in the second column of the 
parameter list. Control-click a parameter name to apply a Parameter behavior from 
the shortcut menu.



398Motion User Guide

•	 Value: Parameter values at the playhead position appear in the third column. Modify 
a parameter value by dragging left or right over the number in this field. Or double-
click the field, then enter a new value. The value displayed and editing options 
depend on several factors: If the playhead is on a keyframe, this field shows the 
value for that keyframe, and adjusting the value alters the keyframe. If the playhead 
is not on a keyframe, this field shows the value of that parameter at the current 
frame. If the parameter has keyframes, adjusting the value creates a new keyframe 
at that frame. (For more information on changing the values of keyframes, see 
Modify keyframes in the Keyframe Editor.)

•	 Keyframe and keyframe navigation buttons: Keyframe controls appear in the fourth 
column. These controls are identical to those found in the Inspector: the Previous 
Keyframe button, Add/Delete Keyframe button, and Next Keyframe button. See 
Animate from the Inspector.

•	 Animation menu: The Animation menu appears for each parameter in the list. To 
open this menu, position the pointer over the far-right side of a parameter row, 
then click the down arrow that appears. The Animation menu in the Keyframe Editor 
contains all commands found in the Inspector’s Animation menu, plus several 
additional commands:

•	 Reset Parameter: Removes keyframes and settings for the parameter, restoring 
the default value.

•	 Add: Adds a keyframe at the current frame in the Keyframe Editor. If the playhead 
is positioned on a frame where a keyframe has been added, this command is 
unavailable. (Alternatively, you can use a keyboard shortcut—Control-K—to add a 
keyframe.)

•	 Delete: Deletes the current keyframe. This command is available if the playhead 
is positioned on a frame where a keyframe exists.

•	 Previous: Moves the playhead to the previous keyframe for this parameter. This 
command is available if a keyframe exists earlier in the project.

•	 Next: Moves the playhead to the next keyframe for this parameter. This command 
is available if a keyframe exists later in the project.

•	 Enable/Disable Animation: Activates or deactivates the keyframed value. 
Choosing Disable Animation hides the keyframes you set, restoring the parameter 
to its default value. However, the keyframes are not thrown away. Choosing 
Enable Animation returns the parameter to its last keyframed state.
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•	 Interpolation: Sets the type of curve for the parameter. See Curve interpolation 
methods for examples of the different interpolation methods. Choose Constant, 
Linear, Bezier, Continuous, Exponential, or Logarithmic. Exponential and 
Logarithmic are only visible from the Interpolation submenu when you Control-
click a keyframe in the Keyframe Editor.

•	 Before First Keyframe: Defines what happens between the first keyframe and the 
beginning of the clip. See Set curve extrapolation for examples of extrapolation 
methods. Choose Constant, Linear, Ping-Pong, Repeat, or Progressive. You can 
also turn the extrapolation into keyframes by choosing Generate Keyframes.

•	 After Last Keyframe: Defines what happens between the last keyframe and 
the end of the clip. See Set curve extrapolation for examples of extrapolation 
methods. Choose Constant, Linear, Ping-Pong, Repeat, or Progressive. You can 
also turn the extrapolation into keyframes by choosing Generate Keyframes.

•	 Lock/Unlock Parameter: Locks the parameter from changes. When a parameter is 
locked, neither keyframes nor curves are adjustable.

•	 Reduce Keyframes: Opens the Reduce Keyframes dialog, which lets you apply a 
thinning algorithm to the keyframes for the parameter. This reduces the number 
of keyframes in a parameter while preserving the shape of the curve. The thinning 
algorithm can be adjusted in two ways: Increasing the Maximum Error Tolerance 
results in fewer keyframes; increasing the Smoothing Factor makes smoother 
curves between keyframe values.

•	 Set to Curve Snapshot: Reverts keyframe changes made in the selected curve 
to the most recent snapshot. This command is available when Take/Show Curve 
Snapshot is turned on (the camera button in the upper-right corner of the 
Keyframe Editor). See Compare curve snapshots.

•	 Graph area: Shows the keyframes and curves of active parameters (those in the 
parameters list). Each curve is a different color, although some colors are duplicated. 
Areas before the first keyframe and after the last keyframe are represented by dotted 
lines. Selected parameters and keyframes appear white.

A time ruler shows the locations of keyframes, project markers, playback In and Out 
points, and the playhead. Zoom controls at the bottom of the graph let you focus 
on specific regions of the sequence. For more information on using the zoom/scroll 
controls, see Customize the Timeline.

•	 Audio Waveform pop-up menu: Turns on the display of audio waveforms for the 
selected item in the background of the graph. This lets you line up a video effect with 
an audio event. If there are multiple audio tracks in the project, you can use this menu 
to view the waveform of any individual audio track in the project, or the overall audio 
mix in the Output audio track.
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•	 Clear Curve List button: Deletes all items in the parameter list from a custom set.

•	 Fit Visible Curves in Window button: Scales the graph area vertically and horizontally 
so that the curve is entirely visible. This button does not change the value of your 
keyframes.

•	 Take/Show Curve Snapshot button: Turns on and turns off the state of all curves in the 
Keyframe Editor. With a snapshot turned on, the original unaltered curve is represented 
by a lighter color—visible in the background behind the curves you’re adjusting—and 
can be used as a reference showing the curve’s original values. As long as you remain 
in the Keyframe Editor editing the current set of curves, the snapshot curve remains 
available. Clicking this button again causes the current snapshot to disappear. For more 
information about curve snapshots, see Compare curve snapshots.

•	 Snapping button: Enables snapping. When this control is enabled, keyframes snap to 
markers, other keyframes, and other snappable items.

•	 Auto-Scale Vertically to Fit Curves button: Rescales the graph vertically so that the 
curve is entirely visible. This does not change the value of your keyframes.

 Tip: You can show the Keyframe Editor on a second display, providing a larger 
workspace for modifying keyframes and curves. See Use a second display.
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Modify keyframes and curves in the Keyframe Editor

Add or delete keyframes in the Keyframe Editor in Motion

To add or delete keyframes in the Keyframe Editor, select the Edit Keyframes tool (above 
the parameter list), then perform the following tasks:

Add a keyframe
•	 In the parameter list (on the left side of the Keyframe Editor) in Motion, click the 

Animation menu for any parameter, then choose Add.

Note: The Animation menu (a down arrow) is hidden until you place the pointer over the 
far-right side of the parameter’s row in the list.

A keyframe is added at the position of the playhead.

Add a keyframe to an existing animation curve
•	 In the Keyframe Editor in Motion, double-click or Option-click the animation curve in the 

graph area.

A keyframe is added to the curve at the pointer position. The new keyframe is set to the 
interpolation method used by the rest of that curve. For example, Position parameters 
use Bezier curves by default, so new keyframes are added as Bezier keyframes. For 
more information on interpolation methods, see Set curve interpolation.

Add a keyframe to an animation curve and adjust its value
•	 In the Keyframe Editor in Motion, Option-drag a curve segment.

A keyframe is added to the segment at the pointer position, and its value is displayed as 
you drag the keyframe.

Delete a keyframe
In Motion, do one of the following:

•	 Select the keyframe in the Keyframe Editor, then press Delete.

Note: You can drag a selection box around multiple keyframes.

•	 Control-click the keyframe, then choose Delete from the shortcut menu.

•	 Move the playhead to the frame where the keyframe occurs, then do one of the 
following in the parameter list:

•	 Click the Animation menu for the keyframed parameter and choose Delete.

The Animation menu is hidden until you place the pointer over the right side of a 
parameter row.

•	 Move the pointer over the gray diamond (the keyframe), then click the minus sign (–) 
that appears in the center of keyframe.
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Delete all of a parameter’s keyframes
•	 In Motion, in the parameter list in the Keyframe Editor, click the Animation menu for a 

parameter, then choose Reset Parameter.

The Animation menu is hidden until you place the pointer over the right side of a 
parameter row.

Note: You can also use the corresponding Animation menu in the Inspector.

Modify keyframes in the Keyframe Editor in Motion

To modify keyframe values in the Keyframe Editor, select the Edit Keyframes tool (above 
the parameter list), then perform the following tasks:

Change the value of a keyframe
In Motion, do one of the following:

•	 In the graph area of the Keyframe Editor, drag the keyframe along the Y axis (up-down) 
to change its parameter value. To change its position in time, drag along the X axis 
(left-right).

Press and hold the Shift key while you drag to constrain movement to one axis. (To 
constrain keyframes to the Y axis, select “Lock keyframes in time in Keyframe Editor” in 
the Time pane of the Motion Settings window.)

When dragging a keyframe in the graph, numbers appear indicating the position and 
value of the keyframe. The first number is the frame number (or timecode number) and 
the second number is the parameter value.

When you drag two keyframes closer along the X axis, the transformation between 
those values happens more quickly. When you drag keyframes farther apart from each 
other, the change happens more slowly.
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•	 Double-click the keyframe to modify, enter a value in the value field, then press Return.

This changes the value of the keyframe along the Y axis (up-down).

Note: To dismiss an active value field without making changes, press Esc.

•	 In the parameter list, drag a value slider:

•	 Drag right to increase the keyframe value.

•	 Drag left to decrease the keyframe value.

•	 Press and hold the Shift key while dragging to change the value in increments of 10.

•	 Press and hold the Option key while dragging to change the value in increments of 
.01.

Move a keyframe in time by a specific number of frames
1.	 In Motion, select a keyframe in the Keyframe Editor.

2.	 Do any of the following:

•	 Move the selected keyframe to a specific frame: Enter the number of frames, then 
press Return.

•	 Move the selected keyframe forward by a specific number of frames: Enter a plus 
sign (+) and the number of frames, then press Return.

•	 Move the selected keyframe back by a specific number of frames: Enter a minus sign 
(–) and the number of frames, then press Return.

Change keyframe values by moving an entire curve
You can select and move animation curves in the graph area of the Keyframe Editor.

•	 Pressing and holding the Option and Command keys, drag a keyframe on the curve (or a 
curve segment between two keyframes) up or down.
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Reverse, lock, or disable keyframes in Motion

With the Edit Keyframes tool (above the parameter list) selected, you can also perform 
advanced keyframe modifications. You can reverse keyframes to invert the corresponding 
animated effect without re-animating it, lock keyframes (individually or in groups) to 
prevent accidental adjustment, or disable an entire curve to suspend animation for that 
parameter.

Reverse keyframes
1.	 In the Keyframe Editor in Motion, drag a selection rectangle to select the keyframes to 

reverse.

2.	 Control-click a selected keyframe, then choose Reverse Keyframes from the shortcut 
menu.

The keyframes are reversed.

Lock keyframes
•	 In the Keyframe Editor in Motion, select the keyframes to lock, then Control-click one of 

the keyframes in the graph and choose Lock from the shortcut menu.

Locking prevents further modification the keyframes. (You can also lock all keyframes 
in the Keyframe Editor by selecting “Lock keyframes in time in Keyframe Editor” in the 
Time pane of Motion Settings.)

Disable a curve
•	 In the Keyframe Editor in Motion, select the keyframes to disable, then Control-click a 

keyframe in the graph and choose Disable from the shortcut menu. 

Disabled keyframes are ignored and have no effect on the object’s animation. If you 
disable a keyframe, the curve readjusts itself as if that keyframe didn’t exist, even 
though the keyframe is present in the Keyframe Editor, in a dimmed state.

Copy and paste keyframes and curves in Motion

With the Edit Keyframes tool (above the parameter list) selected, you can copy and paste 
keyframes and animation curves. This technique is useful for copying a keyframed effect 
from one object to another, for moving a keyframe segment earlier or later in the same 
parameter, or for creating keyframes in one parameter and applying them to another.
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Copy and paste keyframes
Use this technique to copy and paste a segment of an animation curve from one parameter 
to another, or from one object to another.

1.	 In Motion, select keyframes by doing one of the following:

•	 In the Keyframe Editor, drag a selection rectangle around the keyframes.

•	 In the Keyframe Editor, Shift-click the keyframes you want to select.

Note: If the curve appears white but the keyframes do not, the keyframes are not 
selected.

2.	 Copy or cut the selected keyframes by doing one of the following:

•	 Choose Edit > Copy (or press Command-C).

•	 Choose Edit > Cut (or press Command-X).

3.	 To paste the keyframes to a different parameter, do the following:

a.	 Select the destination parameter in the parameter list (on the left side of the 
Keyframe Editor).

b.	 Place the playhead at the point where you want the keyframes to begin.

c.	 Choose Edit > Paste (or press Command-V).

The keyframes are added to the new parameter.

Note: Pasted keyframes might not make a curve identical to the original if the 
parameter scales are different.

Copy and paste an animation curve
Use this technique to copy and paste an entire animation curve from one parameter to 
another, or from one object to another.

1.	 In Motion, select an animation curve by doing one of the following:

•	 Select a row in the parameter list of the Keyframe Editor.

•	 Shift-click or Control-click in the parameter list of the Keyframe Editor to select 
multiple rows.

2.	 Choose Edit > Copy (or press Command-C) to copy the selected curve.

Note: You cannot use the Cut command on a complete curve.

3.	 To paste the curve to a different parameter, do the following:

a.	 In the parameter list of the Keyframe Editor, select the destination parameter.

b.	 Choose Edit > Paste (or press Command-V).

The curve is added to the new parameter.

Note: Pasted animation curves might not make a curve identical to the original if the 
parameter scales are different.
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Draw an animation curve in Motion

The Sketch Keyframes tool (next to the Edit Keyframes tool) lets you sketch animation 
curves in the Keyframe Editor graph area, creating keyframes as you go. To sketch a curve, 
the parameter to animate must first appear in the parameter list. See Create a custom 
curve view for methods of displaying curves.

Sketch an animation curve
1.	 In Motion, in the parameter list in the Keyframe Editor, select the parameter to sketch.

2.	 Select the Sketch Keyframes tool (the pencil icon above the parameter list).

3.	 Drag in the graph area to sketch an animation curve.

Drawing new keyframes overwrites existing keyframes at the frames where you draw.

Add an individual keyframe using the Sketch Keyframes tool
1.	 In Motion, in the parameter list of the Keyframe Editor, select the parameter to modify.

2.	 Select the Sketch Keyframes tool (the pencil icon above the parameter list).

3.	 Click in the graph area to add a keyframe.

Additional clicks create additional individual keyframes.
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Transform curve segments in Motion

Use the Transform Keyframes tool to drag a selection rectangle around multiple keyframes 
and then manipulate their positions by dragging the bounding box or adjusting its handles. 
Dragging the bounding box moves the selected keyframes in whatever direction you move. 
As a result, you can affect where the keyframes are positioned in time or you can affect 
their parameter values, or you can do both at the same time. Adjusting a bounding box 
handle scales the keyframes, changing their timing and parameter values.

Draw a selection box using the Transform Keyframes tool
1.	 In Motion, select the Transform Keyframes tool (above the parameter list in the 

Keyframe Editor).

2.	 In the graph area, drag to create a selection rectangle enclosing the keyframes you 
want to manipulate.

A bounding box with eight handles appears in the graph area.

Important: When transforming keyframes using the Transform Keyframes tool, by 
default keyframes are adjusted in whole-frame increments. You can adjust keyframe in 
sub-frame increments if the “Allow sub-frame keyframing” checkbox is selected in the 
Time pane of Motion Settings. Sub-frame adjustments allow greater precision, but use 
the Next/Previous Keyframe controls (or keyboard shortcuts) to move the playhead to 
keyframes that are between frames. If you move a sub-frame-adjusted keyframe using 
the pointer, the frame snaps to the nearest whole frame. 

Drag the bounding box to change keyframe timing and parameter values
•	 In the Keyframe Editor in Motion, drag inside a bounding box to move the box and the 

enclosed keyframes.

Moving left and right repositions the keyframes in time, and moving up and down 
increases and decreases the parameter values of the keyframes.

Note: No matter where you drag the box, only the keyframes you selected are 
manipulated—even if the repositioned box overlaps keyframes outside the original 
selection. To manipulate additional keyframes, redraw the selection box in the graph 
area.
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Scale the bounding box relative to the handle opposite the one you’re dragging
•	 In the Keyframe Editor in Motion, drag any handle of a bounding box to resize it.

The bounding box changes shape relative to the handle on the opposite side or corner 
of the box, which remains locked in place.

Scale the bounding box about its center
•	 In Motion, while pressing and holding the Option key, then drag a handle of a bounding 

box in the Keyframe Editor.

Both sides of the box scale up or down around its center as you drag along the axes.

Deform the bounding box asymmetrically
•	 In Motion, while pressing and holding the Command key, then drag a corner handle of a 

bounding box in the Keyframe Editor.

Each corner handle moves independently of the other three corner handles of the 
bounding box.

Deselect the bounding box
In Motion, do one of the following:

•	 In the Keyframe Editor, click once anywhere outside the bounding box.

•	 Choose the Edit Keyframes tool.

The bounding box disappears.

 Tip: You can also draw a new bounding box outside of the old one to surround a 
different group of keyframes.

Apply parameter behaviors to curves in Motion

Parameter behaviors can also be applied to curves via the Keyframe Editor.

Apply a Parameter behavior to an animation curve
•	 In Motion, in the Keyframe Editor parameter list, Control-click a curve name and choose 

a Parameter behavior from the shortcut menu.

Compare curve snapshots in Motion

When modifying keyframes, it’s helpful to have a frame of reference for your curves. 
A saved reference of curves lets you compare modified curves to the original curves. 
Additionally, a saved reference—known as a curve snapshot—acts as a safety net if you 
need to restore a curve’s original state.

Take a curve snapshot
•	 In Motion, in the upper-right corner of the Keyframe Editor, click the Take/Show Curve 

Snapshot button.
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With Take/Show Curve Snapshot enabled, as you move keyframes in the Keyframe 
Editor, the original curve—as it appeared when you took the snapshot—retains its color. 
As long as you remain in the Keyframe Editor editing the current set of curves with the 
Take/Show Curve Snapshot button enabled, the snapshot curve remains available.

Revert a curve to its most recent snapshot
If, after editing a curve, you want to revert to the snapshot, you can do so from the 
Animation menu in the Keyframe Editor.

•	 In the Keyframe Editor in Motion, click the Animation menu for the parameter you want 
to revert, then choose Set to Curve Snapshot.

The Animation menu (a down arrow) is hidden until you move the pointer over the right 
side of the parameter row.

The curve reverts to the state of its most recent snapshot. 

Important: If you leave the Keyframe Editor, or load a different set of curves into the 
Keyframe Editor, curve snapshots are taken again, replacing the previous curve snapshots.

Set curve interpolation and extrapolation

Set curve interpolation in Motion

Although you can manually create nearly any curve shape to build the animation you want, 
the Keyframe Editor provides tools to control the automatic interpolation of curves—that 
is, the computed values between keyframes. Depending on the interpolation method you 
choose, you can dramatically alter the shape of animation curves, and therefore the impact 
of your effects.

To set the interpolation for a curve, you select the keyframe you want to modify, then 
choose a distribution algorithm. For more information about the preset algorithms, see 
Curve interpolation methods.

Set an interpolation method for a keyframe
In Motion, do one of the following:

•	 Control-click a keyframe in the Keyframe Editor, choose Interpolation from the shortcut 
menu, then choose a method from the submenu.

•	 Select multiple keyframes, Control-click one of them, choose Interpolation from the 
shortcut menu, then choose a method from the submenu. 

The interpolation method chosen is applied to the entire selection.
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Set an interpolation method for a curve segment
•	 In Motion, Control-click a segment between two keyframes in the Keyframe Editor, 

choose Interpolation from the shortcut menu, then choose a method from the submenu.

Only the segment between the surrounding two keyframes is affected by the 
interpolation method you choose. You can set different interpolation methods for other 
segments of the same curve.

When different interpolation methods are applied to segments of an animation curve, 
the methods used in the curve appear with a dash next to their name in the Interpolation 
submenu (in the Keyframe Editor parameter list).

Change the interpolation method for an entire parameter
•	 In the parameter list of the Keyframe Editor in Motion, click the Animation menu for the 

parameter, then choose a method from the Interpolation submenu.

The Animation menu (a down arrow) remains hidden until you position the pointer over 
the far-right side of the parameter row you want to modify.

The selected interpolation method is applied to that parameter’s curve.

Change the interpolation method for multiple parameters
1.	 In the parameter list of the Keyframe Editor in Motion, Shift-click to select multiple 

parameters.

2.	 In the Keyframe Editor parameter list, open the Animation menu for the parameter, then 
choose a method from the Interpolation submenu.

The Animation menu (a down arrow) remains hidden until you position the pointer over 
the far-right side of the parameter row you want to modify.
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Curve interpolation methods in Motion

The Interpolation submenu of the Animation menu (and the shortcut menu that appears 
when you Control-click a keyframe) contains the following methods that set the shape of 
curves between keyframes:

•	 Constant: When applied to a keyframe or curve segment, this method holds the 
keyframe at its current value and then abruptly changes to the new value at the next 
keyframe.

•	 Linear: When applied to a keyframe, this method creates a uniform distribution of values 
through the keyframe from its two adjacent keyframes. When applied to a segment, this 
method creates uniform distribution of values between points.

•	 Bezier: This method lets you manipulate the keyframe curve manually by dragging the 
tangent handles. If multiple Bezier keyframes are selected, or Bezier interpolation is 
applied to the curve segment, the handles of all selected keyframes are modified.
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•	 Continuous: This method behaves like Bezier interpolation, but without access to the 
tangent handles (which are calculated automatically). The parameter begins to change 
gradually, reaching its maximum rate of acceleration at the midpoint, then tapers 
off slightly as it approaches the second keyframe. When applied to a keyframe, the 
segments before and after the keyframe are affected. When applied to a curve segment, 
the segment between the keyframes is affected.

•	 Exponential: This method creates an exponential curve between the current keyframe 
and the next, changing the value slowly at first, then reaching its maximum rate of 
acceleration as it approaches the next keyframe.

•	 Logarithmic: This method creates a logarithmic curve between the current keyframe and 
the next, changing the value rapidly at first, then slowing drastically as it approaches 
the next keyframe.
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•	 Ease In: This method has a reverse-inertia effect, so a value change slows coming into a 
keyframe. When applied to a curve segment, the value change eases into the segment. 
This option is available only when you Control-click a keyframe; it is not available in the 
Animation pop-up menu.

•	 Ease Out: This method creates a typical inertia-like lag, so a value change begins 
more slowly coming out of a keyframe. When applied to a curve segment, the value 
change eases out of the segment. This option is available only when you Control-click a 
keyframe; it is not available in the Animation pop-up menu.

•	 Ease Both: This method combines Ease In with Ease Out, applying both at once. This 
option is available only when you Control-click a keyframe; it is not available in the 
Animation pop-up menu.
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Convert to Bezier interpolation in Motion

Bezier interpolation—the default keyframe type—is the most flexible method of curve 
generation because it allows manual modification of the curve. If you’ve converted Bezier 
keyframes to linear keyframes, Motion lets you convert them back to Bezier keyframes.

Convert a linear keyframe into a Bezier keyframe
•	 In the Keyframe Editor in Motion, Command-drag a keyframe.

Bezier tangent handles appear and your mouse movement controls one of the handles. 
Adjust the handle to create a custom curve around the keyframe.

Note: Command-clicking a Bezier keyframe resets it to Linear interpolation.

To simultaneously modify the tangent handles of more than one keyframe point, Shift-click 
to select multiple points, then adjust the tangent handles. If there are no tangent handles 
on the keyframe point, drag the point while holding down the Command key.

Adjust tangents of a keyframe point
Each Bezier keyframe point has two tangent handles that adjust the angle of curve at the 
keyframe. By default, these handles are locked together (moving one moves the other, 
creating a uniform curve at the keyframe point). However, you can break the handle to 
create separate curve segments on each side of a keyframe point. Doing so lets you create 
irregular curves.
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In Motion, do any of the following:

•	 “Break” tangent handles to adjust one independently of the other: Press and hold the 
Option key and drag a tangent’s handle, or Control click a tangent handle, then choose 
Break Handle from the shortcut menu.

•	 Relink broken tangent handles: Press and hold the Option key while dragging a tangent, 
or Control-click a tangent handle and choose Link and Align Handles.

•	 Reset the Bezier keyframe: While pressing and holding the Command key, drag the 
keyframe in the keyframe graph.

•	 Constrain a tangent handle’s angle to 45-degree increments: While pressing and 
holding the Shift key, drag the handle.

Set curve extrapolation in Motion

When you begin adding keyframes, you instruct Motion to modify the in-between frames 
to interpolate the effect. But what values are used for the frames before the first keyframe 
and after the last one?

By default, when you add your first keyframe, that same value is extended forward and 
backward to the beginning and end of the clip (as if you hadn’t added a keyframe). In other 
words, the frames before that first keyframe remain at the value of that first keyframe. 
Similarly, the frames after the last keyframe hold at that last defined value.

You can override this default behavior to create loops and other patterns. This is known as 
extrapolation. When you apply an extrapolation method to a parameter, animation is added 
beyond your first or last keyframes. Extrapolation is useful when you need to extend the 
duration of an effect such as a moving background. Several extrapolation algorithms are 
available in the Before First Keyframe and After First Keyframe submenus of the Animation 
menu. For descriptions of the preset algorithms, see Curve extrapolation methods.

Apply an extrapolation method to a parameter before the first keyframe
•	 In the Keyframe Editor in Motion, click the Animation menu for the parameter to change, 

then choose an item from the Before First Keyframe submenu.

The Animation menu (a down arrow) remains hidden until you position the pointer over 
the far-right side of the parameter row you want to modify.
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Apply an extrapolation method to a parameter after the last keyframe
•	 In the Keyframe Editor in Motion, click the Animation menu for the parameter to change, 

then choose an item from the After Last Keyframe submenu.

The Animation menu (a down arrow) remains hidden until you position the pointer over 
the far-right side of the parameter row you want to modify.

Curve extrapolation methods in Motion

The following extrapolation options are available in the Before First Keyframe and After Last 
Keyframe submenus. (In each of the illustrated examples below, the extrapolation setting is 
applied after the last keyframe.)

•	 Constant: This method, the default, holds the beginning or ending segments of the 
curve to the same value as the first or last keyframe.

•	 Linear: This method extends the curve beyond the first or last keyframes uniformly, 
along the existing trajectory of the first or last keyframe.
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•	 Ping-Pong: This method copies the curve and repeats it, alternating forward and 
backward.

•	 Repeat: This method duplicates the curve, applying it again and again.

•	 Progressive: This method extends the curve by repeating the existing shape of the 
curve, but rather than returning to the exact values, repeats from the existing end value.
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Convert extrapolated curves to keyframes in Motion

By default, keyframe extrapolation occurs without creating keyframes. This lets you 
experiment with various methods. However, you can convert an extrapolation method into 
keyframes to further manipulate them, using the Generate Keyframes command. You can 
choose how many extrapolation cycles you want converted into keyframes. Cycles after the 
number chosen remain in the extrapolated state.
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Convert extrapolation data into keyframes
1.	 In the Keyframe Editor in Motion, click the Animation menu for the parameter you want 

to modify, then choose Generate Keyframes from the Before First Keyframe or After Last 
Keyframe submenu.

Note: The Animation menu (a down arrow) remains hidden until you position the pointer 
over the far-right side of the parameter row you want to modify.

2.	 In the Generate Keyframes dialog, select the number of cycles to be keyframed.

3.	 Click OK to confirm your selection.

Choose which curves are displayed in the Keyframe Editor

Choose a curve view in Motion

Displaying too many parameters in the Keyframe Editor can make the graph area difficult 
to read. You can limit the list of parameters displayed in the graph area by choosing a view 
option from the Show Curve Set pop-up menu.

Located at the top of the parameter list, this unlabeled pop-up menu lets you display built-
in parameter curve sets as well as custom sets you build yourself. (For information about 
creating a custom curve set, see Create a custom curve view.) The Curve Set pop-up menu 
displays the name of the selected curve set (Animated, All, or Modified, for example).

View all parameters for all selected objects
•	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 

All.

By default, only animated parameters display curves in the graph. Nonanimated 
parameters appear as dotted lines. Deselect a parameter’s activation checkbox to hide 
it in the graph. You can display or hide all parameters associated with a group or object 
by selecting or deselecting its checkbox.



420Motion User Guide

View only animated (keyframed or behavior-influenced) parameters
•	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 

Animated.

Parameters with more than one keyframe are displayed.

View keyframes for a specific parameter of an object
•	 In the Inspector in Motion, click the Animation menu for the parameter, then choose 

Show in Keyframe Editor.

The Animation menu (a down arrow) remains hidden until you position the pointer over 
the far-right side of the parameter row you want to modify.

The keyframes appear in the Keyframe Editor and an untitled curve set is selected in the 
Show Curve Set pop-up menu.

View parameters changed from their default values
•	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 

Modified.

This option shows the parameters that have been modified from their default values, or 
that are currently being modified (in the canvas, Inspector, or HUD).

View only active parameters
•	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 

Active.

This option shows only parameters being modified in real time. For example, with Active 
selected, dragging an object in the canvas displays its X, Y, and Z Position parameters 
in the Keyframe Editor.

View keyframes corresponding to a specific parameter
•	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose a 

parameter type (such as Rotation, Opacity, or Retiming).

Only parameters of the chosen type are displayed.

View keyframes corresponding to a specific parameter for multiple objects
1.	 In the Layers list, canvas, or Timeline layers list in Motion, Shift-select the objects that 

contain keyframes you want to view.

2.	 In the Keyframe Editor, click the Show Curve Set pop-up menu, then choose a 
parameter type (such as Scale).

Only parameters of the chosen type are displayed for the selected objects.
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Create a custom curve view in Motion

In addition to using the built-in curve set views, you can make and manage your own view 
using the last two options in the Show Curve Set pop-up menu: New Curve Set and Manage 
Curve Sets. As you create and store custom parameter sets, they appear in the Show Curve 
Set pop-up menu (at the top of the parameter list in the Keyframe Editor), allowing you 
to switch between them. Deleting, duplicating, and modifying custom sets is done in the 
Manage Curve Sets dialog (accessible from the Show Curve Set pop-up menu).

Create a custom curve set
1.	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 

New Curve Set.

2.	 In the dialog that appears, enter a name for the set, then click OK.

After you create a curve set, you can choose it from the Show Curve Set pop-up menu.

Add parameters to a custom curve set
In Motion, do one of the following:

•	 After you create a custom curve set, drag a parameter name from any pane in the 
Inspector into the Keyframe Editor parameter list.

•	 In the Inspector, click the Animation menu for the parameter, then choose Show in 
Keyframe Editor.

The Animation menu (a down arrow) remains hidden until you position the pointer over 
the far-right side of the parameter row you want to modify.

The parameter is added to the custom curve set.
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Delete a parameter from a custom curve set
•	 In the Keyframe Editor in Motion, drag the parameter out of the list.

Delete all parameters from a custom curve set
•	 In Motion, click the Clear Curve List button in the top-right corner of the Keyframe 

Editor.

Delete a custom curve set
1.	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 

Manage Curve Sets.

2.	 In the Manage Curve Sets dialog, select the name of the set to delete.

3.	 Click the Delete button (–) at the top of the dialog.

The set is deleted.

4.	 Click Done to close the dialog.

Duplicate a custom curve set
1.	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 

Manage Curve Sets.

2.	 In the Manage Curve Sets dialog, select the name of the set to duplicate.

3.	 Click the Duplicate button at the top of the dialog.

The set is duplicated.

4.	 Double-click the set name in the list, then enter a name for the set.

5.	 Click Done to close the dialog.

The new set now appears in the Show Curve Set pop-up menu. These sets are saved 
with the project, so each time you reopen the project, they are available. You can store 
as many parameter sets as you like. After you store a set, you can change or delete that 
set as needed.
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Switch between custom curve sets
Use the Manage Curve Sets dialog to switch back and forth between custom curve sets 
that contain common animated parameters. For example, if you created a custom curve set 
for an object’s Position and Rotation parameters, and your project also contains another 
object with animated Position and Rotation parameters, you can switch back and forth 
between their curve sets.

1.	 In the Keyframe Editor in Motion, click the Show Curve Set pop-up menu, then choose 
Manage Curve Sets.

2.	 In the Manage Curve Sets dialog, select the Relative checkbox in the left column.

The curve set is displayed for the currently selected object.

Save an animation curve in Motion
After you apply keyframed animation to an object, you can save its curve to the Library 
and then apply your custom animation to an object in any project. Further, if you create 
animation that uses multiple curves and you want to save the cumulative effect of the 
animation, you can save all curves as one item in the Library.

Animation curves saved in the Library appear with a custom icon.

Save an animation curve to the Library
1.	 In Motion, open the Library and select the Favorites or Favorites Menu category.

2.	 Drag the name of the parameter animation curve to save from the parameter list in the 
Keyframe Editor into the stack at the bottom of the Library.

The saved animation curve is placed in the /Users/username/Library/Application Support/
Motion/Library/Favorites folder or the /Users/username/Library/Application Support/
Motion/Library/Favorites Menu folder.

Note: If you drag an animation curve to another subcategory, such as the Glow (Filters) 
subcategory, the curve is placed in the Content category, which becomes active.

Save multiple animation curves to the Library
1.	 In Motion, open the Library and select the Content, Favorites, or Favorites Menu category.

2.	 In the parameter list of the Keyframe Editor, select the animation curves you want to 
save and drag them to the stack, holding down the mouse button.

3.	 When the drop menu appears, choose “All in one file” or “Multiple files.”

“All in one file” saves the animation curves together, listed as one item in the Library. 
“Multiple files” saves the curves as individual items in the Library.

Note: When you Control-click an animation curve icon in the Library stack, the Edit 
Description shortcut menu item becomes available. This is a handy tool for entering 
custom notes about an item saved in the Library. After you choose Edit Description, enter 
your notes in the text field, then click OK.
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Although you can save animation curves into the Content category of the Library, for ease 
of organization it’s recommended that you save items you use frequently in the Favorites 
category. For information on naming items saved to the Library, saving multiple items of 
different types to the Library, as well as creating and organizing folders in the Library, see 
Save custom objects to the Library.

Use the mini-curve editor in Motion
Mini-curve editors provide a way to animate parameters outside the Keyframe Editor’s 
interface using keyframes in a graph. Animations created in a mini-curve editor don’t 
appear in the Keyframe Editor.

Two Particle behaviors—Scale Over Life and Spin Over Life—have mini-curve editors in the 
Inspector (when the Increment Type parameter is set to Custom). Mini-curve editors are 
also present for paint objects, in the Stroke pane of the Shape Inspector.

By default, the mini-curve editor is collapsed and shows a scaled-down representation of 
the parameter curve.

Expand a mini-curve editor
•	 In Motion, click the disclosure triangle next to the collapsed mini-curve editor in the 

Inspector.

The expanded mini-curve editor appears.

When expanded, the mini-curve editor shows a representation of the relevant animation 
curve. In the example above, the Over Life parameter is mapped to the X axis and the 
Custom Spin parameter is mapped to the Y axis.
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Add keyframes in the mini-curve editor
The procedure for adding keyframes in a mini-curve editor is slightly different than the 
procedure for adding them in the full-sized Keyframe Editor.

In the mini-curve editor in Motion, do one of the following:

•	 Double-click the curve.

•	 Option-click the curve.

•	 Control-click the curve, then choose Add Keyframe from the shortcut menu.

Modify a keyframe value in the mini-curve editor
1.	 In the mini-curve editor in Motion, double-click a keyframe.

Its value field is activated.

2.	 Enter a value in the value field, then press Return.

Note: To dismiss an active value field without making changes, press Esc.

Rescale the mini-curve editor so the entire curve is visible
•	 In Motion, select the Auto Fit checkbox (located beneath the lower-right corner of the 

mini-curve editor).

The animation curve is scaled to fit within the confines of the mini-curve editor.

The mini-curve editor provides the Edit Keyframes, Sketch Keyframes, and Transform 
Keyframes tools, and each functions in the same manner as in the Keyframe Editor. For more 
information on using the Edit Keyframes tool, see Modify keyframes in the Keyframe Editor. 
For more information on using the Sketch Keyframes tool, see Draw an animation curve. For 
more information on using the Transform Keyframes tool, see Transform curve segments.

Animate on the fly in Motion
Motion lets you create animations while your project is playing back. The next time the 
project is played back, all changes are incorporated.

Because so many of Motion’s effects are displayed in real time, you can perform a sort of 
“visual mix” and modify the parameters of your effects while the project is playing back. 
Adjust any slider or parameter, interactively manipulate objects in the canvas, and then, 
if you don’t like the results, rewind and do it again. Each time you alter a parameter, you 
replace the keyframes previously assigned.

Animate a parameter on the fly via the Inspector or HUD
1.	 In Motion, click the Record button, press A, or choose Mark > Record Animation to turn 

on keyframe recording.

2.	 Click the Play button or press the Space bar to begin playback.

3.	 As your project plays, adjust a parameter slider in the Inspector or HUD.

4.	 Click the Record button again to turn off keyframe recording.

The changes you made during playback are recorded as keyframes for that parameter. 
You can view them in the Keyframe Editor.

Note: You can also animate on the fly using the initial keyframe method. For more 
information on the initial keyframe method, see Add keyframes.
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Delete keyframes recorded on the fly
If you don’t like the animation you made, you can delete the keyframes and try again. 

In Motion, do one of the following:

•	 Choose Edit > Undo (or press Command-Z) to revert to the state before you began 
recording your animation.

•	 Select one or more keyframes, then press Delete.

•	 Control-click a keyframe, then choose Delete from the shortcut menu.

•	 Select a keyframe, then choose Delete from the Animation menu for that parameter.

Note: To delete all keyframes for a parameter, click the Animation menu in the Keyframe 
Editor parameter list or Inspector, then choose Reset Parameter.

Create a handmade animation path in the canvas
A common use for animating on the fly is to create hand-drawn animation paths. Although 
you can choose various curve types, it is very difficult to simulate semi-random movement 
except by sketching with a mouse or tablet pen.

1.	 In Motion, click the Record button, press A, or choose Mark > Record Animation to turn 
on keyframe recording.

2.	 Click the Play button to begin playback.

3.	 Select the object to manipulate and drag it in the pattern of your choice.

The position and speed of your movement are recorded and applied to the position 
keyframes for that object.

You can further manipulate the path by dragging individual keyframes, or re-recording a 
new animation path for that object.
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Simplify a keyframe curve in Motion
When a parameter contains at least one keyframe, or when the Record button is enabled, 
a keyframe is added every time you modify a parameter at a new playhead position. If you 
animate while the project is playing, you create a keyframe at every frame. Additionally, 
when you convert a behavior to keyframes, you often end up with an unwieldy amount of 
keyframes.

In many cases, the curve created by your animation can be represented using fewer 
keyframes. Often, this provides a smoother rate of change and lets you take advantage of 
interpolation methods such as Bezier or Continuous.

You can streamline your keyframe curves in two ways: by simplifying an existing animation 
curve using the Reduce Keyframes command in the Animation menu for that parameter or 
by adjusting keyframe thinning options before recording keyframes. 

Reduce keyframes in an existing animation curve 
1.	 In Motion, click the Animation menu for the parameter you want to modify, then choose 

Reduce Keyframes.

Note: The Animation menu (a down arrow) remains hidden until you position the pointer 
over the far-right side of the parameter row you want to modify.

2.	 In the Reduce Keyframes dialog, adjust the Error Tolerance and Smoothing parameters 
to obtain the curve you want.
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Adjust keyframe thinning before animating on the fly
Use the Recording Options dialog to adjust the Keyframe Thinning setting or to disable 
recording during playback. (This setting has no effect on ordinary keyframing.)

1.	 In Motion, do one of the following:

•	 Choose Mark > Recording Options (or press Option-A).

•	 Double-click the Record button (in the timing toolbar).

2.	 In the Recording Options dialog, select a Keyframe Thinning option:

•	 Off: No thinning is applied. Keyframes are added at every frame where the parameter 
is changed.

•	 Reduced: Motion eliminates keyframes that can easily be replaced with a simple 
curve.

•	 Peaks Only: Only keyframes with dramatic value changes are recorded.

•	 Don’t record keyframes during playback: Select this checkbox if you don’t want 
keyframes to be recorded while the project is playing back.

3.	 Click OK.

Disable animation recording during playback
If the Record button is enabled or a parameter contains at least one keyframe, keyframes 
are added when you make parameter adjustments. To prevent creating accidental 
animation, you can restrict automatic keyframing so it happens only when the project is not 
playing.

1.	 In Motion, choose Mark > Recording Options.

2.	 In the Recording Options dialog, select “Don’t Record keyframes during playback.”

3.	 Click OK.
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Create Final Cut Pro templates

Intro to Final Cut Pro templates in Motion
Final Cut Pro for Mac ships with numerous effects, titles, transitions, and generators that 
were created in Motion. Effects, titles, transitions, and generators are collectively referred 
to as templates in Motion. You can modify the default Final Cut Pro templates or create 
your own templates from scratch. If you’re a content creator, you can build and distribute 
custom Final Cut Pro templates to other artists, editors, or clients.

When you save a Final Cut Pro template in Motion, the resulting effect, title, transition, 
or generator automatically becomes available in one of the Final Cut Pro browsers. 
For example, a transition template saved in Motion appears as a new transition in the 
Transitions browser in Final Cut Pro, ready to be applied to an editing project. In Motion, 
you can choose which parameters to publish, allowing the Final Cut Pro user complete, 
partial, or no control over modifying the effect.

What’s more, you can create a template that automatically conforms to the color space of 
the Final Cut Pro project it’s applied to.

There are four types of Final Cut Pro templates available:

•	 Final Cut Effect: Create a custom effect that can be applied to clips in the Final Cut Pro 
timeline. A sepia-tone color correction might make an audience think of days gone 
by, while a radiant glow might suggest an otherworldly setting. See Create an effect 
template.

•	 Final Cut Transition: Create a custom transition that can be applied to clips in the 
Final Cut Pro timeline. A transition artfully connects the edit point between two clips. 
One scene might dissolve into the next in a cloud of smoke, or one setting might 
displace another through a kaleidoscope. See Create a transition template.

•	 Final Cut Title: Create a custom text animation that can be added to a Final Cut Pro 
sequence. Text might flare in or out in a fiery glow, or fall into place from offscreen. See 
Create a title template.

•	 Final Cut Generator: Create graphical content that can be added to a Final Cut Pro 
project. A Final Cut Generator is nearly identical to any other Motion project—it can 
include text, shapes, replicators, camera moves and lighting, generators, and so on. It 
can be static or animated. See Create a generator template.

After you create a specific effect, transition, title, or generator, you can change its 
template type. You can also convert a Final Cut template to a standard Motion project. 
Conversely, you can change a standard Motion project to a Final Cut template.

See Convert a template to another type or Convert a Motion project to a template.
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How do templates work?

Template workflow in Motion
Creating templates for Final Cut Pro in Motion involves several simple steps:

Step 1: Select a template type
In the Motion Project Browser, create a new project by selecting one of four template 
types—Final Cut Effect, Final Cut Transition, Final Cut  Title, or Final Cut Generator—then 
choose your project settings and click Open.

Step 2: Add Motion effects to the template placeholders
The new Motion template project that opens contains graphical placeholders—target 
layers (a down arrow graphic in the canvas) where you drag Motion behaviors, filters, 
and other special effects. You can include temporary images to preview the effect you’re 
building. Ultimately, these effects will be applied to footage in Final Cut Pro. See Template 
placeholders vs. drop zones.

Step 3: Add additional layers and effects (if necessary)
If your effect requires additional graphics, add new layers to the template (shapes, 3D 
objects, paint strokes, particles, and so on) and modify them with effects (lighting, camera 
moves, or filters, for example). 

Note: These new graphics will ultimately be composited over Final Cut Pro clips and cannot 
be separated from the effect.

Step 4: Add user interface controls to make the template adjustable in 
Final Cut Pro
To allow Final Cut Pro users to modify specific parameters, you can “publish” sliders, 
checkboxes, or dials, making them available in the Final Cut Pro Inspector.

Step 5: Save the template project
When you save a template in Motion, the effect, transition, title, or generator is exported 
to the relevant Final Cut Pro media browser (the Effects Browser, Titles Browser, 
Transitions Browser, or Generators Browser). In Final Cut Pro, when the template is added 
to the timeline or applied to a clip in the timeline, an activation checkbox and published 
parameter controls appear in the Final Cut Pro inspector.

The duration of the effect is determined by the length of the Final Cut Pro clip it’s applied 
to. Special markers allow you to control the template’s timing in Final Cut Pro. See Intro to 
template markers

After you create a template, you can convert it to a different template type convert it to 
a different template type. For example, if you’re working in an effect template, you can 
change it to a transition without starting from scratch.
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Template placeholders vs. drop zones in Motion
Most of the Final Cut Pro templates in Motion contain placeholder layers, which appear in 
the canvas as down arrow graphics.

In Motion, you drag effects objects (behaviors, filters, and so on) into these placeholder 
layers. The result is a custom effect that you can later apply to clips in Final Cut Pro. When 
you do so, two things happen in Final Cut Pro:

•	 The target clip in the Final Cut Pro timeline populates the placeholder.

•	 The effects embedded in the placeholder are applied to the target clip.

Placeholder layers are not intended to hold source media (images or video clips) that you 
apply in Motion. Although you can drag an image or clip into a placeholder in Motion to test 
what the effect will look like, those images are not used in Final Cut Pro.

If you want users to be able to add additional source media to an applied template in 
Final Cut Pro, you can add one or more drop zones to the template in Motion. Drop zones 
remain empty until users assign source media to them in Final Cut Pro.

Placeholders and drop zones can be scaled or transformed in templates to create certain 
looks and movements. For example, you can create a picture-in-picture effect by adding 
a drop zone to a template, scaling the drop zone down, then positioning it in a corner of 
the canvas. When a user applies the template to a clip in Final Cut Pro, that clip populates 
the effect, and an empty drop zone appears in the corner of the Viewer; the user can then 
assign a different clip to the picture-in-picture drop zone.

Placeholders and drop zones share many of the same parameters, such as Pan, Scale, 
and Fill Color. If you modify placeholder parameters in Motion (in the placeholder’s Image 
Inspector), those adjustments do not affect the clip in Final Cut Pro to which the effect 
template is applied. For drop zones, however, parameter modifications made in Motion do 
affect the media assigned to the drop zone in Final Cut Pro. For more information on drop 
zone (and placeholder) parameters, see Drop zone controls.

Note: Drop zones can also be used when creating Motion-specific templates (not for use in 
Final Cut Pro). See Intro to drop zones.
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Create templates for Final Cut Pro

Work with effect templates

Create an effect template in Motion

Use the Final Cut Effect template to create a custom stylized effect that can be applied to 
clips in the Final Cut Pro timeline.

For information on working with 360° templates, see Creating 360° templates for 
Final Cut Pro.

Create a new effect template
1.	 In Motion, choose File > New from Project Browser (or press Option-Command-N).

2.	 In the Project Browser, click Final Cut Effect, then click the Preset pop-up menu and 
choose a project size.

3.	 Optional: Choose Custom from the Preset pop-up menu, then select your project 
properties.

To create a template that automatically conforms to the Final Cut Pro color space, 
choose Automatic from the Color Processing pop-up menu.
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Important: Be sure to create the template at the highest resolution you will use in your 
Final Cut Pro project. If you’re creating 4K-specific templates, you can click the Search 
button in the Final Cut Pro media browsers to display only templates designed for use in 
4K projects. See Set template resolution.

4.	 Click Open (or press Return).

A new, untitled Motion project opens, with the Effect Source placeholder layer selected.

Note: You cannot delete the Effect Source placeholder from an effect template. Nor can 
you create additional Effect Source placeholders.

5.	 To add a reference image to the Effects Source placeholder to preview your work, do 
one of the following:

•	 In the toolbar, click Import, then drag a still image from the dialog to the placeholder 
arrow in the canvas (or to the Effect Source layer in the Layers list). 

•	 From the Finder or Library, drag a still image to the placeholder arrow in the canvas 
(or to the Effect Source layer in the Layers list).

Be sure to release the mouse button when the pointer is over the placeholder (the down 
arrow in the canvas or Effect Source layer in the Layers list). If you miss the target, you 
create a new layer, which cannot be dragged to the placeholder layer.

The image is added to the Effect Source layer, replacing the arrow graphic in the 
canvas. This image is temporary media used to preview the result of the effect you’re 
building. It’s not used in the Final Cut Pro effect, but does appear in the Effects browser 
icon. To clear the image, see Clear media from a template placeholder.

For more information on using reference images, see Use placeholder images in 
templates.

6.	 Add filters or behaviors to the Effect Source layer to create a custom effect.

The filter and behavior parameters can be modified and animated. For more information 
on working with filters, see Intro to filters. For more information on behaviors, see Intro 
to behaviors.

7.	 Optional: Add and modify new layers such as shapes, 3D objects, paint strokes, 
particles, and so on.

These new graphics will ultimately be composited over Final Cut Pro clips and cannot be 
separated from the effect.
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8.	 To allow Final Cut Pro users to modify specific parameters, choose Publish from the 
Animation pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or dial) 
available in the Final Cut Pro Inspector when the custom effect is applied to a clip. 
Published parameters can be adjusted and keyframed in Final Cut Pro. See Adding 
controls to templates.

Note: If the template’s Color Processing is set to Standard Gamut SDR or Wide Gamut 
HDR, you can select “Override FCP Color Space” (in the Project Properties Inspector) 
to ensure that the effect retains the same appearance when applied to the Final Cut Pro 
timeline, regardless of the Final Cut Pro library’s color-processing setting. See Set the 
color-processing method.

9.	 Optional: When you’re satisfied with the custom effect you’ve built, you can remove the 
preview image from the template by selecting the Effect Source layer, then clicking the 
Clear button in the Image Inspector.

10.	Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Effects 
Browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category. Categories represent how the effects are 
organized in the Motion Project Browser and in the Final Cut Pro Effects browser. 
Custom categories also appear in the browsers.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in 
the Final Cut Pro browsers. A theme is a metadata tag that assists in categorizing 
different templates as being part of a single family. For example, you may have 
different template types that are related to the same project, such as a transition, an 
effect, and a group of titles.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you want to save for later inclusion), select “Include 
unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

11.	Click Publish.

The template and remaining media are saved and exported to the Final Cut Pro Effects 
browser. If you did not remove the reference image, it appears in the template’s 
thumbnail in the Final Cut Pro Effects browser.
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Apply the effect in Final Cut Pro
•	 In Final Cut Pro, click the Effects browser button in the toolbar, locate the effect in the 

browser, then apply the effect to a clip in the timeline.

Images or clips used in the Motion placeholder layer appear in the Effects browser icon, 
but are not applied to the clip in the Final Cut Pro timeline.

For information about applying and editing effects in Final Cut Pro, see the Final Cut Pro 
User Guide.

Modify a Final Cut Pro effect in Motion 

Many of the presets in the Final Cut Pro Effects browser were created in Motion. You can 
modify them in Motion, then save them as custom effects in Final Cut Pro.

For a step-through example of modifying a preset Final Cut Pro Effect, see Example: 
Modify a Final Cut Pro effect.

1.	 In Final Cut Pro, click the Effects browser button on the far-right side of the toolbar (or 
press Command-5). 

2.	 In the Effects browser, locate the effect to edit.

To preview the effect, move the pointer over the effect’s thumbnail.

3.	 Control-click the effect, then do one of the following:

•	 If the effect is a Final Cut Pro preset, choose “Open a copy in Motion” from the 
shortcut menu.

A copy of the project opens in Motion, and the duplicated file appears in the 
Final Cut Pro Effects browser.

•	 If the effect is a template created in Motion, choose “Open in Motion” from the 
shortcut menu.

The original project opens in Motion.

4.	 Modify the project in Motion, then do one of the following:

•	 Save a copy of a Final Cut Pro preset with the default name: Choose File > Save.

•	 Save a copy of a Final Cut Pro preset with a new name: Choose File > Save As, 
complete the save dialog information, then click Publish.

•	 Save the updated Motion-created template and overwrite the original version: 
Choose File > Save. 

•	 Save the updated Motion-created template as a copy: Choose File > Save As, 
complete the save dialog information, then click Publish.

Note: When a preset Final Cut Pro effect is applied to the Final Cut Pro timeline 
and then modified in Motion, the saved changes do not affect instances of the 
default preset in the Final Cut Pro timeline. However, if the version of a preset in the 
Final Cut Pro timeline has already been modified in Motion, any subsequent changes 
made to the template in Motion affect instances of the effect in the Final Cut Pro 
timeline.

The template is saved and appears in the Effects browser in Final Cut Pro.

https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro/welcome/mac
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Example: Modify a Final Cut Pro effect in Motion

In Final Cut Pro, the Bokeh Random effect adds moving, blurred particles to a clip. This 
example describes how to modify that effect in Motion by adding and removing parameter 
controls.

Note: Bokeh comes from the Japanese term boke, meaning blur or haze. Bokeh is a term 
used in photography to describe the aesthetic quality of a blurred image.

Use Motion to add a control to the Bokeh Random effect
1.	 In Final Cut Pro, select a clip in the timeline, then click the Effects browser button in the 

toolbar.

2.	 In the Effects browser, select the Light category, Control-click the Bokeh Random 
effect, then choose “Open a copy in Motion” from the shortcut menu.

A copy of the template opens in Motion, and the duplicated file appears in the 
Final Cut Pro Effects browser.

3.	 In the Layers list in Motion, click disclosure triangles to open the Light Layer 02 group, 
the Bokeh group, and then the Circles group.

Note that the effect is composed of behaviors, a Gaussian Blur filter, and rigged particle 
parameters. For detailed information on rigging parameters, see Intro to rigging.

4.	 In the Circles group, select the Bokeh 4 particle emitter.
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5.	 In the Emitter Inspector, click the Color Mode pop-up menu (in the Cell Controls 
section), then choose Colorize.

6.	 Select a new color from the Color controls (just under the Color Mode pop-up menu).

In the canvas, the Bokeh 4 emitter’s circular particles change to the new color.
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7.	 Do one of the following:

•	 Click the Color parameter’s Animation menu (the down arrow that appears when you 
place the pointer over the right side of the parameter row), then choose Publish.

•	 Control-click the Color parameter’s name, then choose Publish from the shortcut 
menu.

8.	 In the Layers list, click the Project object, and then in the Project Inspector, click 
Publishing.

The controls that are published in the preset Bokeh Random effect are listed: Type, 
Blend Mode, Size, Number, Pattern, Speed, Blur Amount, Opacity, and Color. After you 
save this template in Motion (as described below), the modified effect will be added 
to the Effects inspector in Final Cut Pro, making the Color parameter available to 
Final Cut Pro users.
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Use Motion to remove a control from the Bokeh Random effect
•	 In Motion, in the Publishing pane of the Project Inspector, do one of the following:

•	 Click the Type parameter’s Animation menu (the down arrow that appears when you 
place the pointer over the right side of the parameter row), then choose Unpublish.

•	 Control-click the Type parameter’s name, then choose Unpublish from the shortcut 
menu.

The Type control is removed from the list and will not be available in Final Cut Pro.

Save the modified Bokeh Random effect
•	 In Motion, choose File > Save (or press Command-S).

Note: To save the effect with a different name or to a different category in the Effects 
Browser, choose File > Save As. The initially created file (Bokeh Random Copy) remains 
in the Final Cut Pro Effects browser and Motion Project Browser, but can be deleted in 
the macOS Finder, in the /Users/username/Movies/Motion Templates/ folder.

The effect is now ready for use in Final Cut Pro. Unlike the original preset, Bokeh 
Random Copy includes a control to change the color of the particles, and no longer 
includes a control to change the shape of the particles.

Work with transition templates

Create a transition template in Motion

Use the Final Cut Transition template to create a custom transition that can be applied to 
clips in the Final Cut Pro timeline.

Create a new transition template
1.	 In Motion, choose File > New from Project Browser (or press Option-Command-N).

2.	 In the Project Browser, click Final Cut Transition, then choose a project size from the 
Preset pop-up menu.



440Motion User Guide

3.	 Optional: Choose Custom from the Preset pop-up menu, then select your project 
properties.

To create a template that automatically conforms to the Final Cut Pro color space, 
choose Automatic from the Color Processing pop-up menu.

Important: Be sure to create the template at the highest resolution you will use in your 
Final Cut Pro project. If you’re creating 4K-specific templates, you can click the Search 
button in the Final Cut Pro media browsers to display only templates designed for use in 
4K projects. See Set template resolution.

4.	 Click Open (or press Return).

A new, untitled Motion project opens containing two placeholder layers: Transition A 
and Transition B.

Note: You cannot delete the Transition A and Transition B placeholders from a transition 
template. Nor can you create additional Transition placeholders.
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5.	 To add the first reference image to the placeholders to preview your work, do one the 
following:

•	 In the toolbar, click Import, then drag a still image onto the Transition A layer in the 
Layers list (or onto the Transition A arrow in the canvas). 

•	 From the Finder or Library, drag a still image onto the Transition A layer in the Layers 
list (or onto the Transition A arrow in the canvas).

Be sure to release the mouse button when the pointer is over a placeholder (the 
down arrow in the canvas or Transition A layer in the Layers list). If you miss the 
target, you create a new layer, which cannot be dragged to the placeholder layer.

6.	 To add the second reference image to the placeholders to preview your work, do one 
the following:

•	 In the toolbar, click Import, then drag another still image onto the Transition B layer 
in the Layers list (or onto the Transition B arrow in the canvas). 

•	 From the Finder or Library, drag another still image onto the Transition B layer in the 
Layers list (or onto the Transition B arrow in the canvas).

The images are added to the Transition A and B placeholder layers, replacing 
the down arrow graphics in the canvas. The images serve as temporary media to 
preview the result of the transition you’re building. The images aren’t used in the 
Final Cut Pro transition, but an image does appear in the Transitions browser icon. To 
clear the image, see Clear media from a template placeholder.

For more information on using reference images, see Use placeholder images in 
templates.

7.	 Modify Transition A and Transition B so they flow into each other midway through the 
transition, using filters, behaviors, or other combinations of effects.

For example, animate a lens flare generator that moves across the screen as Transition 
A fades into Transition B.

When designing the template, think about how best to line up the end of incoming clip 
A with the beginning of the transition, and the end of the transition with incoming clip 
B. For example, a transition that begins on a full-screen Placeholder A and ends on a 
full-screen Placeholder B avoids jarring jumps. Because the default behavior between 
the transition placeholders is a simple cut, to smooth out the transition, you may need 
to adjust the placeholder timebars to overlap in the Timeline, then animate their opacity 
using keyframes or a behavior.

For more information on working with filters, see Intro to filters. For more information on 
behaviors, see Intro to behaviors.

8.	 Optional: Add and modify new layers such as shapes, 3D objects, paint strokes, 
particles, and so on.

These new graphics will ultimately be composited over Final Cut Pro clips and cannot be 
separated from the effect.
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9.	 To allow Final Cut Pro users to modify parameters, choose Publish from the Animation 
pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or dial) 
available in the Final Cut Pro inspector when the custom effect is applied to a clip. 
Published parameters can be adjusted and keyframed in Final Cut Pro. See Adding 
controls to templates.

Note: If the template’s Color Processing is set to Standard Gamut SDR or Wide Gamut 
HDR, you can select “Override FCP Color Space” (in the Project Properties Inspector) 
to ensure that the effect retains the same appearance when applied to the Final Cut Pro 
timeline, regardless of the Final Cut Pro library’s color-processing setting. See Set the 
color-processing method.

10.	Optional: When you’re satisfied with the transition you’ve built, you can remove the 
preview images from the template by selecting each Transition layer, then clicking the 
Clear button in the Image Inspector.

The temporary image is removed.

11.	Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Transitions 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category. Categories represent how the effects are 
organized in the Motion Project Browser and in the Final Cut Pro Transitions browser. 
Custom categories also appear in the browsers.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in 
the Final Cut Pro browsers. A theme is a metadata tag that assists in categorizing 
different templates as being part of a single family. For example, you may have 
different template types that are related to the same project, such as a transition, an 
effect, and a group of titles.

d.	 To retain unused media in the project (media or audio in the Media list that is not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

12.	Click Publish.

The template and remaining media are saved and exported to the Final Cut Pro 
Transitions browser. If you did not remove the reference image, it appears in the 
template’s thumbnail in the Final Cut Pro Transitions browser.
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Override the default transition length set in Final Cut Pro
The duration of transition template is determined by the Final Cut Pro project settings. 
However, you can override that default duration in Motion.

•	 In Motion, select the Project object in the Layers list, then select the Override FCP 
Duration checkbox in the Properties Inspector.

The transition also has adjustable In and Out points in the Final Cut Pro project.

Apply the transition in Final Cut Pro
•	 In Final Cut Pro, click the Transitions browser button in the toolbar, locate the transition 

in the browser, then apply the transition to a clip in the timeline.

Images or clips in the Motion placeholder layer appear in the Transitions browser icon, 
but are not applied to the clip in the Final Cut Pro timeline.

For information on applying and editing transitions in Final Cut Pro, see the Final Cut Pro 
User Guide.

Example: Create a blur transition in Motion

This example demonstrates how to create an original, simple Final Cut Pro transition in 
Motion. Clip A dissolves into clip B with a prism blur effect.

1.	 In Motion, choose File > New (or press Command-N).

2.	 In the Project Browser, select Final Cut Transition, choose the project preset required 
for your Final Cut Pro project, set the Duration to 200 frames, then click Open.

Note: To create a transition that automatically conforms to the Final Cut Pro color 
space, choose Custom from the Preset pop-up menu, then choose Automatic from the 
Color Processing pop-up menu. See Create templates that conform to the Final Cut Pro 
color space.

The project opens and contains a single group with two placeholder layers: Transition A 
and Transition B.

3.	 Optional: To preview what the effect will look like, drag a still image from the Finder, 
Library or Import dialog (click Import in the toolbar to open the dialog) to Transition A in 
the Layers list and then drag a different still image to Transition B, releasing the mouse 
button when the pointer changes to a curved arrow.

These images are for preview purposes only, and will not be saved to Final Cut Pro.

Note: This example does not use any images.

When you play the project (press the Space bar), no transition is present by default. 
Transition A ends, and transition B begins abruptly.

4.	 In the Timeline, position the pointer over the end of the Transition A bar, then trim the 
bar by dragging its ending edge to the end of the project.

https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro/welcome/mac
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5.	 Trim the Transition B bar by dragging its beginning edge to frame 300.

Note: This example uses a 600-frame project.

6.	 Animate the opacity of Transition A by doing the following:

a.	 Click the Record button (press A) and select Transition A.

b.	 Drag the playhead to frame 1, then set Opacity to 100 in the Properties Inspector.

Because the default Opacity value is 100, move the Opacity value slider back and 
forth, or enter 100 in the adjacent value slider to be sure a keyframe is created.

 Tip: To see keyframes in the Timeline, click the Show/Hide Keyframes button in 
the upper-right corner of the Timeline.

c.	 Drag the playhead to frame 300, then set Opacity to 100 in the Properties Inspector.

Again, adjust the Opacity value to be sure a keyframe is created. This prevents any 
dipping to black as transition A fades into transition B.

d.	 Drag the playhead to frame 330, then set Opacity to 0 in the Properties Inspector.

When you play the project, Transition A fades into Transition B.

7.	 In the Layers list, select the Group. 

8.	 In the toolbar, click Filters, then choose Blur > Prism.

9.	 Animate the blur amount of the Prism filter by doing the following:

a.	 Drag the playhead to frame 1, then open the Filters Inspector and set Amount to 0.

b.	 Drag the playhead to frame 280, then in the Filters Inspector, set Amount to 0.
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c.	 Drag the playhead to frame 315, then in the Filters Inspector, set Amount to 50.

d.	 Drag the playhead to frame 350, then in the Filters Inspector, set Amount to 0.

When you play the project, Transition A fades into Transition B with a prism blur that 
moves right, then left.

10.	Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Transitions 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category. Categories appear in the Motion Project 
Browser and the Final Cut Pro Transitions browser.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and the 
Final Cut Pro browsers. A theme is a metadata tag that helps categorize templates.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template that you may decide to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

After the prism blur transition is applied to the Final Cut Pro timeline, its duration can 
be easily modified. For more information transition duration, see Create a transition 
template.
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Create a transition background in Motion

You might want a custom transition to include a background image or clip. For example, 
if your Transition A and Transition B clips are animated to scale down, you can apply 
a background image to cover the black areas of the exposed frame. You can create a 
background by adding a drop zone to the transition template. After you apply the transition 
to a clip in the Final Cut Pro timeline, you can assign source media to the drop zone.

Drop zones in templates allow Final Cut Pro users to place media into designated regions 
of the applied effect. You can add filters, behaviors, animations, and other effects to 
drop zones in Motion to affect clips later added to those drop zones in Final Cut Pro. See 
Template placeholders vs. drop zones and Intro to drop zones.

1.	 In the toolbar in Motion, click Add Object, then choose Drop Zone from the pop-up 
menu (or choose Object > New Drop Zone).

A drop zone layer (titled “Drop Zone”) appears in the layers list and canvas.

2.	 Select the drop zone layer, then do one of the following in the Image Inspector:

•	 Use a clip as the drop zone’s source media in Final Cut Pro: Click the Source pop-up 
menu, then choose Media.

When the transition is added to a Final Cut Pro project, a Drop Zone image well 
appears in the Final Cut Pro inspector. Using this image well, an editor can add a 
source clip that appears as a background during the custom transition. Using the 
drop zone’s onscreen controls (accessed by double-clicking the drop zone in the 
Final Cut Pro viewer), an editor can pan or scale the source clip within the drop zone. 
For more information, refer to the Final Cut Pro User Guide.

•	 Use a still image as the drop zone’s media source in Final Cut Pro: Click the Source 
pop-up menu, then choose Timeline Pin.

When the transition is added to a Final Cut Pro project, you can select a single frame 
of a clip as the source frame in the drop zone by dragging a numbered handle along 
the timeline. See the Final Cut Pro User Guide.

•	 Use a clip or image as the drop zone’s reference image while working on the 
transition template in Motion: Click the “To” pop-up menu, then choose an image or 
clip.

The drop zone remains empty until a user assigns source media to it in Final Cut Pro.

Note: You can set a drop zone background color that’s apparent when the drop zone’s 
source media is panned or scaled. See Intro to drop zones. 

https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro/welcome/mac
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Modify a Final Cut Pro transition in Motion

Many presets in the Final Cut Pro Transitions Browser were created in Motion. You can 
modify them in Motion, then save them as custom transitions in Final Cut Pro.

1.	 In Final Cut Pro, click the Transitions browser button on the far-right side of the toolbar 
(or press Shift-Command-5).

2.	 In the Transitions browser, locate the transition to edit.

To preview the effect, move the pointer over the transition’s thumbnail.

3.	 Control-click the transition and do one of the following:

•	 If the transition is a Final Cut Pro preset, choose “Open a copy in Motion” from the 
shortcut menu.

A copy of the project opens in Motion, and the duplicated file appears in the 
Final Cut Pro Transitions browser.

Note: The “Open a copy in Motion” command is not available for FxPlug transitions.

•	 If the transition is a template created in Motion, choose “Open in Motion” from the 
shortcut menu.

The original project opens in Motion.

4.	 Modify the project in Motion, then do any of the following:

•	 Save a copy of the Final Cut Pro preset with the default name: Choose File > Save.

•	 Save a copy of the Final Cut Pro preset with a new name: Choose File > Save As, 
complete the save dialog information, then click Publish.

•	 Save the updated Motion-created template and overwrite the original version: 
Choose File > Save. 

•	 Save the updated Motion-created template as a copy: Choose File > Save As, 
complete the save dialog information, then click Publish.

Note: If the preset Final Cut Pro transition was applied to the Final Cut Pro timeline 
before being modified in Motion, the saved changes do not affect instances of the 
transition in the Final Cut Pro timeline. However, after the modified transition is 
applied to the Final Cut Pro timeline, any subsequent changes made in Motion to the 
template affect instances of the transition in the Final Cut Pro timeline.

The template is saved and appears in Transitions browser in Final Cut Pro.
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Work with title templates

Create a title template in Motion

Use the Final Cut Title template to create a custom title that can be applied to clips in the 
Final Cut Pro timeline.

For information on working with 360° templates, see Creating 360° templates for 
Final Cut Pro.

Create a new title template
1.	 In Motion, choose File > New from Project Browser (or press Option-Command-N).

2.	 In the Project Browser, click Final Cut Title, then click the Preset pop-up menu and 
choose a project size.

3.	 Optional: Choose Custom from the Preset pop-up menu, then select your project 
properties.

To create a template that automatically conforms to the Final Cut Pro color space, 
choose Automatic from the Color Processing pop-up menu.

Important: Be sure to create the template at the highest resolution you will use in your 
Final Cut Pro project. If you’re creating 4K-specific templates, you can click the Search 
button in the Final Cut Pro media browsers to display only templates designed for use in 
4K projects. See Set template resolution.
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4.	 Click Open (or press Return).

A new, untitled Motion project opens containing two layers: a text layer (Type Text Here) 
and a placeholder layer (Title Background).

5.	 To add a reference image to the Title Background placeholder to preview your work, do 
one of the following:

•	 In the toolbar, click Import, then drag a still image from the dialog to the placeholder 
arrow in the canvas (or to the Title Background layer in the Layers list).

•	 From the Finder or Library, drag a still image to the placeholder arrow in the canvas 
(or to the Title Background layer in the Layers list).

Be sure to release the mouse button when the pointer is over a placeholder (the 
arrow in the canvas or Transition layer in the Layers list). If you miss the target, you 
create a new layer, which cannot be dragged to the placeholder layer.

The image is added to the Title Background layer, replacing the down arrow graphic 
in the canvas. This image is temporary media used to preview the effect you’re 
building. It’s not used in the Final Cut Pro title, but does appear in the Titles browser 
icon. To clear the image, see Clear media from a template placeholder.

For more information on using reference images, see Use placeholder images in 
templates.

6.	 Modify the text as needed and add animation, filters, text behaviors, and other effects 
to create custom titles.

Because users can change the text in Final Cut Pro, it’s not necessary to modify the 
default text (“Type Text Here”) in Motion. You can adjust and animate parameters in the 
Text Inspector, Filters Inspector, Behaviors Inspector, and Properties Inspector to create 
a memorable title sequence. For more information about using text, see Intro to basic 
text and Intro to animated text.

7.	 Optional: Add and modify new layers such as shapes, 3D objects, paint strokes, 
particles, and so on.

These new graphics will ultimately be composited over Final Cut Pro clips and cannot be 
separated from the effect.
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8.	 To allow Final Cut Pro users to modify specific parameters, choose Publish from the 
Animation pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or 
dial) available in the Final Cut Pro inspector when the custom title is added to a clip. 
Published parameters can be adjusted and keyframed in Final Cut Pro. See Adding 
controls to templates. For information specific to publishing text parameters, see 
Publishing template text controls.

Note: If the template’s Color Processing is set to Standard Gamut SDR or Wide Gamut 
HDR, you can select “Override FCP Color Space” (in the Project Properties Inspector) 
to ensure that the effect retains the same appearance when applied to the Final Cut Pro 
timeline, regardless of the Final Cut Pro library’s color-processing setting. See Set the 
color-processing method.

9.	 Optional: When you’re satisfied with the custom title you’ve built, you can remove the 
preview image from the template by selecting the Effect Source layer, then clicking the 
Clear button in the Image Inspector.

The temporary image is removed and not saved to the template’s Media folder. See 
Where are templates saved?

10.	Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Titles browser 
as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category. Categories represent how the effects are 
organized in the Motion Project Browser and in the Final Cut Pro Titles browser. 
Custom categories also appear in the browsers.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in 
the Final Cut Pro browsers. A theme is a metadata tag that assists in categorizing 
different templates as being part of a single family. For example, you may have 
different template types that are related to the same project, such as a transition, an 
effect, and a group of titles.

d.	 To retain unused media in the project (media or audio in the Media list that is not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

11.	Click Publish.

The template and remaining media are saved and exported to the Final Cut Pro Titles 
browser. If you did not remove the reference image, it appears in the template’s 
thumbnail in the Final Cut Pro Titles browser.
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Apply the title in Final Cut Pro
1.	 Click the Titles and Generators button in the top-left corner of the Final Cut Pro window.

2.	 In the sidebar, click Titles, then locate the title to add.

3.	 Do one of the following:

•	 Drag the title into the timeline, above the clip you want to composite it over.

When you release the mouse button, the title is anchored to the clip, and the clip is 
used as the background. The title can span multiple clips in the timeline. The clips 
populate the Title Background placeholder, inheriting any transforms, filters, or other 
effects applied to the placeholder in Motion.

•	 Drag the title into an empty area of the main timeline.

When you release the mouse button, the title is added as a standalone title clip (that 
is not composited over a video clip). If the title effect contains a Title Background 
placeholder, the placeholder is ignored, and a background clip cannot be specified. 
Drag the In and Out points to increase or decrease the duration of the title.

For information on working with titles in Final Cut Pro, see the Final Cut Pro User Guide.

Create a title background in Motion

In a title template, the Title Background placeholder is not intended to hold source media 
(images or video clips) added in Motion. Although you can drag an image or clip onto the 
Title Background placeholder in Motion to preview how the titles will look composited over 
media, those images are never used in Final Cut Pro. If you want to give Final Cut Pro users 
the option of adding their own source media to a title, add a drop zone to the title template 
in Motion. 

Drop zones can be any size and can be placed in any region of the frame. You can add 
filters, behaviors, and animations to drop zones in Motion so those effects influence clips 
later added in Final Cut Pro. For more information on drop zones, see Intro to drop zones. 
To better understand the difference between placeholders and drop zones, see Template 
placeholders vs. drop zones.

Create a background for a title template
•	 In a Final Cut Title project in Motion, do one of the following:

•	 In the toolbar, click Add Object, then choose Drop Zone from the pop-up menu.

•	 Choose Object > New Drop Zone (or press Command-Shift-D).

A drop zone layer (titled “Drop Zone”) appears in the layers list and canvas.

When the template is saved in Motion, the title is added to the Final Cut Pro Titles 
browser. When a Final Cut Pro editor adds the title to the timeline, a Drop Zone image 
well appears in the Final Cut Pro Title inspector. Using this image well, an editor can 
add a source clip that appears beneath the titles. Using the drop zone’s onscreen 
controls (accessed by double-clicking the drop zone in the Viewer), an editor can 
pan or scale the source clip within the drop zone. For more information, refer to the 
Final Cut Pro User Guide.

 Tip: From Motion, you can publish a rigged checkbox that turns the drop zone on 
or off in the main Final Cut Pro timeline. Alternatively, you can create two versions of 
the title template, one that uses a standard drop zone as a background and one that 
doesn’t. For more information on rigging, see Intro to rigging. For more information on 
publishing, see Adding controls to templates.

https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro/welcome/mac
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Modify a Final Cut Pro title in Motion

The presets in the Final Cut Pro Titles browser were created in Motion. You can modify 
these presets in Motion, then save them as new title effects in Final Cut Pro.

1.	 Click the Titles and Generators button in the top-left corner of the Final Cut Pro window.

2.	 In the sidebar, click Titles, then locate the title to edit.

To preview the title effect, move the pointer over title’s thumbnail.

3.	 Control-click the title and do one of the following:

•	 If the title is a Final Cut Pro preset, choose “Open a copy in Motion” from the 
shortcut menu.

A copy of the project opens in Motion, and the duplicated file appears in the 
Final Cut Pro Titles browser.

•	 If the title is a template created in Motion, choose “Open in Motion” from the 
shortcut menu.

The original project opens in Motion.

4.	 Modify the project in Motion, then do one of the following:

•	 Save a copy of the Final Cut Pro preset with the default name: Choose File > Save.

•	 Save a copy of the Final Cut Pro preset with a new name: Choose File > Save As, 
complete the save dialog information, then click Publish.

•	 Save the updated Motion-created template and overwrite the original version: 
Choose File > Save. 

•	 Save the updated Motion-created template as a copy: Choose File > Save As, 
complete the save dialog information, then click Publish.

Note: If the preset Final Cut Pro title was applied to the Final Cut Pro timeline 
before being modified in Motion, the saved changes do not affect instances of the 
title in the Final Cut Pro timeline. However, after the modified title is applied to the 
Final Cut Pro timeline, any subsequent changes made in Motion to the template 
affect instances of the title in the Final Cut Pro timeline.

The template is saved and appears in Titles browser in Final Cut Pro.
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Work with generator templates

Create a generator template in Motion

Use the Final Cut Generator template to create a custom generator that can be applied 
to clips in the Final Cut Pro timeline. A generator template is similar to a standard Motion 
project. However, when saved, it’s exported to the Generators browser in Final Cut Pro.

Like any content added to a Final Cut Pro project, a generator template can be composited 
over a clip in the Final Cut Pro timeline, or added to the main timeline. The duration of the 
generator in Final Cut Pro is determined by its duration when created and saved in Motion.

For information on working with 360° templates, see Creating 360° templates for 
Final Cut Pro.

Create a new generator template
1.	 In Motion, choose File > New from Project Browser (or press Option-Command-N).

2.	 In the Project Browser, click Final Cut Generator, then choose a project size from the 
Preset pop-up menu.

3.	 Optional: Choose Custom from the Preset pop-up menu, then select your project 
properties.

To create a template that automatically conforms to the Final Cut Pro color space, 
choose Automatic from the Color Processing pop-up menu.
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Important: Be sure to create the template at the highest resolution you will use in your 
Final Cut Pro project. If you’re creating 4K-specific templates, you can click the Search 
button in the Final Cut Pro media browsers to display only templates designed for use in 
4K projects. See Set template resolution.

4.	 Click Open (or press Return).

A new, untitled project opens. The project contains no placeholders.

5.	 Build the project as you would any other Motion project, using shapes, text, behaviors, 
camera animation, and so on.

Note: You can also add drop zones to create additional effects, such as a picture-in-
picture effect. Drop zones allow Final Cut Pro users to place media into designated 
regions of the applied effect. See Intro to drop zones and Template placeholders vs. 
drop zones.

6.	 To allow Final Cut Pro users to modify specific parameters, choose Publish from the 
Animation pop-up menu of each parameter you want to make accessible.

Publishing a parameter makes its user interface control (the slider, checkbox, or dial) 
available in the Final Cut Pro inspector when the custom effect is applied to a clip. 
Published parameters can be adjusted and keyframed in Final Cut Pro. See Adding 
controls to templates.

Note: If the template’s Color Processing is set to Standard Gamut SDR or Wide Gamut 
HDR, you can select “Override FCP Color Space” (in the Project Properties Inspector) 
to ensure that the effect retains the same appearance when applied to the Final Cut Pro 
timeline, regardless of the Final Cut Pro library’s color-processing setting. See Set the 
color-processing method.

7.	 Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Generators 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category. Categories represent how the effects are 
organized in the Motion Project Browser and in the Final Cut Pro Generators browser. 
Custom categories also appear in the browsers.
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c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create themes. Themes appear in the Motion Project Browser and in 
the Final Cut Pro browsers. A theme is a metadata tag that assists in categorizing 
different templates as being part of a single family. For example, you may have 
different template types that are related to the same project, such as a transition, an 
effect, and a group of titles.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

8.	 Click Publish.

The template is saved and exported to the Final Cut Pro Generators browser.

Apply the generator in Final Cut Pro
1.	 Click the Titles and Generators button in the top-left corner of the Final Cut Pro window.

2.	 Click Generators, then locate the generator to add.

3.	 Do one of the following:

•	 Drag the generator into the timeline, above the clip you want to composite it over.

The generator can span multiple clips in the timeline.

•	 Drag the generator to an empty section of the main timeline.

When you release the mouse button, the generator is added as a standalone clip 
(that is not composited over another clip). Drag the generator’s In and Out points in 
the timeline to change the duration.

For information on working with generators in Final Cut Pro, see the Final Cut Pro User 
Guide.

Modify a Final Cut Pro generator

Many presets in the Final Cut Pro Generators Browser were created in Motion. You can 
modify these presets in Motion, then save them as generators in Final Cut Pro.

1.	 Click the Titles and Generators button in the top-left corner of the Final Cut Pro window.

2.	 In the sidebar, click Generators, then locate the generator to edit.

To preview the generator, move the pointer over the generator’s thumbnail. 

3.	 Control-click the generator and do one of the following:

•	 If the generator is a Final Cut Pro preset, choose “Open a copy in Motion” from the 
shortcut menu.

A copy of the project opens in Motion.

•	 If the generator is a template created in Motion, choose “Open in Motion” from the 
shortcut menu.

The original project opens in Motion.

https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro/welcome/mac
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4.	 Modify the project in Motion, then do any of the following:

•	 Save a copy of the Final Cut Pro preset with the default name: Choose File > Save.

•	 Save a copy of the Final Cut Pro preset with a new name: Choose File > Save As, 
complete the save dialog information, then click Publish.

•	 Save the updated Motion-created template and overwrite the original version: 
Choose File > Save.

•	 Save the updated Motion-created template as a copy: Choose File > Save As, 
complete the save dialog information, then click Publish.

Note: If the preset Final Cut Pro generator was applied to the Final Cut Pro timeline 
before being modified in Motion, the saved changes do not affect instances of the 
title in the Final Cut Pro timeline. However, after the modified title is applied to the 
Final Cut Pro timeline, any subsequent changes made in Motion to the template 
affect instances of the title in the Final Cut Pro timeline.

The template is saved and appears in Generators browser in Final Cut Pro.

Convert project types

Convert a Motion project to a Final Cut Pro for Mac template
You can convert a standard Motion project to an effect, generator, title, or transition 
template for use in Final Cut Pro for Mac. When you convert a standard project to a 
template project, you specify which layers in the project are used for the template’s 
required placeholders. For example, when you convert a standard Motion project to a Final 
Cut Transition template, you must identify the two layers that will be used as the Transition 
A placeholder (incoming clip) and the Transition B placeholder (outgoing clip).

You can also publish a standard Motion project as a Final Cut Generator (without 
conversion).

Convert a standard Motion project to an effect
A Final Cut Effect template must contain an Effect Source placeholder. When converting 
a project to an effect, you can choose to add an empty placeholder, or to use an image 
already in your project as a placeholder.

1.	 In Motion, choose File > Convert Project To > Effect.

2.	 In the dialog, click the Effect Source pop-up menu, then do one of the following:

•	 To add a new, empty Effect Source placeholder: Choose New Effect Source.

•	 To use an existing reference image as an Effect Source placeholder: Choose an 
image layer name from the list.

•	 To use an existing drop zone as the Effect Source placeholder: Choose a drop zone 
name from the list.

Note: If the selected drop zone contains an image, the image is retained in the Effect 
Source placeholder.

3.	 Click Convert.
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4.	 Choose File > Save, then do the following:

a.	 In the dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Effects 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can create a custom category by choosing New Category. Categories represent 
how the effects are organized in the Motion Project Browser and in the Final Cut Pro 
Effects browser. Custom categories also appear in the browsers.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

5.	 Click Publish.

The template is exported to the Final Cut Pro Effects browser, where it can be applied to 
the timeline and edited like any other effect.

See Create an effect template.

Convert a standard Motion project to a generator
1.	 In Motion, choose File > Convert Project To > Generator.

Note: Although you can’t add an Effect Source, Transition A, Transition B, or Title 
Background placeholder to a Motion project, you can add standard drop zones that let 
Final Cut Pro users insert customized content into the generator.

2.	 Choose File > Save, then do the following:

a.	 In the dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Generators 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can create a custom category by choosing New Category. Categories represent 
how the effects are organized in the Motion Project Browser and in the Final Cut Pro 
Generators browser. Custom categories also appear in the browsers.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?
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e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

3.	 Click Publish.

The template is exported to the Final Cut Pro Generators browser, where it can be 
applied to the timeline and edited like any other generator.

See Create a generator template.

As an alternative to converting a Motion project to a Final Cut generator, you can publish a 
Motion project as a Final Cut generator by choosing File > Publish Template.

 Tip: You can also save the Motion project as a QuickTime file, then import the 
QuickTime movie into the Final Cut Pro project like any other footage.

Convert a standard Motion project to a title
A Final Cut Title template contains an optional Title Background placeholder. When 
converting a project to a title, you can choose to add no placeholder, to add an empty 
placeholder, or to use an image already in your project as a placeholder.

1.	 In Motion, choose File > Title.

2.	 In the dialog, click the Title Source pop-up menu, then do one of the following:

•	 To add no Title Background placeholder: Choose None.

•	 To add a new, empty Title Background placeholder to the project: Choose New 
Placeholder.

•	 To add a Title Background placeholder containing a reference image: Choose an 
image layer name from the list.

•	 To use an existing drop zone as the Title Background placeholder: Choose a drop 
zone name from the list.

Note: If the selected drop zone contains an image, the image is retained in the Title 
Background placeholder.

3.	 Click Convert.

4.	 Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Titles browser 
as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can create a custom category by choosing New Category. Categories represent 
how the effects are organized in the Motion Project Browser and in the Final Cut Pro 
Titles browser. Custom categories also appear in the browsers.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?
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e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

5.	 Click Publish.

The template is exported to the Final Cut Pro Titles browser, where it can be applied to 
the timeline and edited like any other title.

See Create a title template and Create a title background.

Convert a standard Motion project to a transition
A Final Cut Transition template must contain a Transition A placeholder and a Transition 
B placeholder. When converting, you can choose to add empty placeholders, or to use 
images already in your project as placeholders.

1.	 In Motion, choose File > Transition.

2.	 In the dialog, click the Transition A pop-up menu, then do one of the following:

•	 To add a new, empty Transition A placeholder: Choose New Placeholder.

•	 To use an existing reference image as the Transition A placeholder: Choose an image 
layer name from the list.

•	 To use an existing drop zone as the Transition A placeholder: Choose a drop zone 
name from the list.

3.	 Click the Transition B pop-up menu, then choose an option as described in Step 2 above.

4.	 Click Convert.

5.	 Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Transitions 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can create a custom category by choosing New Category. Categories represent 
how the effects are organized in the Motion Project Browser and in the Final Cut Pro 
Transitions browser. Custom categories also appear in the browsers.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

6.	 Click Publish.

The template is exported to the Final Cut Pro Transitions browser, where it can be 
applied to the timeline and edited like any other transition.

See Create a transition template and Create a transition background.
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Convert a template to another type in Motion
If necessary, you can convert a Final Cut Pro for Mac effect, generator, title, or transition 
template to a different template type. You can also convert any template to a standard 
Motion project.

Convert a generator, title, or transition to an effect
A Final Cut Effect template must contain an Effect Source placeholder. When converting a 
standard project to an effect template, you can choose to add an empty placeholder, or to 
add a placeholder that contains an image already in your project.

1.	 In Motion, choose File > Convert Project To > Effect.

2.	 In the dialog that appears, click the Effect Source pop-up menu, then do one of the 
following:

•	 To add a new, empty effect placeholder: Choose New Effect Source.

•	 To add an effect placeholder containing a reference image: Choose an image layer 
name from the list.

3.	 Click Convert.

4.	 Choose File > Save, then do the following:

a.	 In the dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Effects 
browser as “New Template.”

b.	 Choose an option from the Category pop-up menu.

You can create a custom category by choosing New Category. Categories represent 
how effects are organized in the Motion Project Browser and in the Final Cut Pro 
Effects browser.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can also create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

5.	 Click Publish.

The template is exported to the Final Cut Pro Effects browser, where it can be applied to 
the timeline and edited like any other effect.

See Create an effect template.
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Convert an effect, title, or transition to a generator
A Final Cut  Generator template contains no placeholders. If the project you’re converting 
(such as an effect or transition) includes a placeholder with a reference image, the 
placeholder is converted to a standard drop zone containing the image.

1.	 In Motion, choose File > Convert Project To > Generator.

2.	 Choose File > Save, then do the following:

a.	 In the dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Generators 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category by choosing New Category. Categories 
represent how effects are organized in the Motion Project Browser and in the 
Final Cut Pro Generators browser.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

3.	 Click Publish.

The template is exported to the Final Cut Pro Generators browser, where it can be 
applied to the timeline and edited like any other generator.

See Create a generator template.

Convert an effect, generator, or transition to a title
A Final Cut Title template contains an optional Title Background placeholder. When 
converting a standard project to a title template, you can choose to add no placeholder, to 
add an empty placeholder, or to add a placeholder that contains an image already in your 
project.

1.	 In Motion, choose File > Convert Project To > Title.

2.	 In the dialog, click the Title Source pop-up menu, then do one of the following:

•	 To add no Title Background placeholder: Choose None.

•	 To add a new, empty Title Background placeholder: Choose New Placeholder.

•	 To add a placeholder containing a reference image: Choose an image layer name 
from the list.

3.	 Click Convert.
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4.	 Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Titles browser 
as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category by choosing New Category. Categories 
represent how the effects are organized in the Motion Project Browser and in the 
Final Cut Pro Titles browser.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

5.	 Click Publish.

The template is exported to the Final Cut Pro Titles browser, where it can be applied to 
the timeline and edited like any other title.

See Create a title template.

Convert an effect, generator, or title to a transition
A Final Cut Transition template must contain a Transition A placeholder and a Transition 
B placeholder. When converting, you can choose to add empty placeholders, or to add 
placeholders that contain images already in your project.

1.	 In Motion, choose File > Convert Project To > Transition.

2.	 In the dialog, click the Transition A pop-up menu, then do one of the following:

•	 To add a new, empty placeholder: Choose New Placeholder.

•	 To add a placeholder containing a reference image: Choose an image layer name 
from the list.

3.	 Click the Transition B pop-up menu, then do one of the following:

•	 To add a new, empty placeholder: Choose New Placeholder.

•	 To add a placeholder containing a reference image: Choose an image layer in your 
project.

4.	 Click Convert.
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5.	 Choose File > Save, then do the following:

a.	 In the save dialog, enter a name for the template.

If you don’t specify a name, the template appears in the Final Cut Pro Transitions 
browser as “New Template.”

b.	 Choose a category from the Category pop-up menu.

You can also create a custom category by choosing New Category. Categories 
represent how the effects are organized in the Motion Project Browser and in the 
Final Cut Pro Transitions browser.

c.	 If needed, choose a theme from the Theme pop-up menu.

You can create a theme by choosing New Theme. Themes let you categorize 
template types in the Motion Project Browser and in the Final Cut Pro browsers.

d.	 To retain unused media in the project (media or audio in the Media list that’s not 
used in the template but which you may want to include in the template later), select 
“Include unused media.”

For information on where template-related files are saved, see Where are templates 
saved?

e.	 If you want a preview movie to appear in the Motion Project Browser, select Save 
Preview Movie.

6.	 Click Publish.

The template is exported to the Final Cut Pro Transitions browser, where it can be 
applied to the timeline and edited like any other transition.

See Create a transition template.

Convert a template to a standard Motion project
1.	 In Motion, choose File > Convert Project To > Composition.

Any placeholder elements are converted to drop zones.

2.	 Once you’ve created your project, choose File > Save, complete the save dialog 
information, then click Save.
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Use placeholder images in templates in Motion
When creating a template for Final Cut Pro, you can add an image to a placeholder layer, 
replacing the down arrow graphic in the canvas. This allows you to:

•	 Preview the effect you’re building in Motion

•	 Create a thumbnail image for the effect in Final Cut Pro

However, this image is not used when the effect is applied to a clip in Final Cut Pro.

Important: When adding preview media to a placeholder, use a still image rather than a 
video clip. Video clips can introduce timing conflicts in Final Cut Pro.

Add a placeholder image to a template
In Motion, do one of the following:

•	 In the toolbar, click Import, then drag a still image from the dialog to the placeholder 
arrow in the canvas (or to the Effect Source layer in the Layers list); when the pointer 
becomes a curved arrow, release the mouse button.

•	 From the Finder or Library, drag a still image to the placeholder arrow in the canvas (or 
to the Effect Source layer in the Layers list); when the pointer becomes a curved arrow, 
release the mouse button.

Note: An image added to a placeholder is fit based on the template project settings 
in Motion. Because the image in the placeholder is not used when the template is 
applied to a Final Cut Pro project, stretching or scaling of the media does not affect the 
destination Final Cut Pro clip.

When you publish the template, the image is saved with the template and is used as the 
thumbnail for the effect in the Final Cut Pro browser. You can change the image used for 
the thumbnail in the Final Cut Pro browser by replacing the placeholder image.

Replace an image in a template placeholder
1.	 To replace a reference placeholder image, do one of the following in Motion:

•	 In the toolbar, click Import, then drag a still image from the dialog to the Effect 
Source layer in the Layers list; when the pointer becomes a curved arrow, release the 
mouse button.

•	 From the Finder or Library, drag a still image to the Effect Source layer in the Layers 
list; when the pointer becomes a curved arrow, release the mouse button.

2.	 Choose File > Save (or press Command-S).

The “Media exists outside the document. Do you wish to copy it?” dialog appears.

3.	 Do one of the following: 

•	 To save the new image with the template in the /Users/username/Movies/ folder in 
the macOS Finder, click Copy.

When you save the template, the new image is saved with the template and is used 
as the thumbnail for the effect in Final Cut Pro browser. 

•	 To save the template without the new image, click Don’t Copy.
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Clear media from a template placeholder
When you save a template containing a placeholder image, that image is stored on your 
computer in the same folder as the template (/Users/username/Movies/Motion Templates/), 
potentially creating multiple instances of media files and taking up storage space. To save 
storage space, you can clear placeholder images from templates before saving.

1.	 In the template project in Motion, select an Effect Source, Title Background, Transition 
A, or Transition B placeholder.

2.	 In the Image Inspector, click the Clear button in the Final Cut Placeholder controls.

The preview media is removed from the template, and the placeholder arrow reappears 
in the affected layer. 

Note: When you clear a placeholder image, its source media is not loaded into 
Motion the next time you modify the template (by choosing the “Open a copy in 
Motion” command in the Final Cut Pro media browsers). And if you previously added 
a placeholder image to create a thumbnail for a Final Cut Pro effect, clearing the 
placeholder image from the template in Motion deletes the thumbnail from Final Cut Pro.

Manually remove media saved with a template
1.	 In the macOS Finder, go to the /Users/username/Movies/Motion Templates/ folder.

2.	 In the appropriate Effects, Titles, or Transitions folder, open the theme folder that 
contains your template, then open the Media folder.

3.	 Drag the media to the Trash.
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Add parameter controls to Final Cut Pro effects

Adding controls to templates in Motion
When you use a template in Motion to create an effect, transition, title, or generator for 
Final Cut Pro, you can “publish” nearly any parameter. Publishing a parameter places its 
user interface control (a slider, dial, checkbox, and so on) in the Final Cut Pro inspector, 
ready to be adjusted. Publishing parameters also lets you decide how much control (if any) 
a Final Cut Pro user has over modifying an effect.

When creating templates in Motion, you have the following publishing options:

•	 Publish no parameters, making the effect a nonmodifiable preset with no adjustable 
controls in the Final Cut Pro inspector.

•	 Publish specific parameters, giving users limited control over modifications made in the 
Final Cut Pro inspector.

•	 Publish the template project’s HDR White Level slider, giving users control over 
adjusting the brightness of SDR elements (such as images or text, shapes, particles or 
other objects created in Motion) in the template. See Create templates that conform to 
the Final Cut Pro color space.

•	 Publish rig widgets, which map multiple parameters to a few pop-up menus, sliders, 
or checkboxes, enabling editors to make complex effect adjustments with simplified 
controls.

Publish controls to Final Cut Pro from Motion
The following tasks describe how to publish parameters, compound parameters, 
rig controls, and other template elements. Published parameters appear in the 
Final Cut Pro inspector.

Publish a parameter control
1.	 In Motion, in the effect, transition, title, or generator template, select the image layer, 

filter, or behavior containing the parameter to publish.

2.	 In the selected item’s Inspector, do one of the following:

•	 Click the parameter’s Animation menu (the down arrow that appears when you place 
the pointer over the far-right side of the parameter row), then choose Publish.
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Note: If the parameters you want to publish are not visible, place the pointer over the 
right side of the parameter group row and click Show.

•	 Control-click the parameter’s name, then choose Publish from the shortcut menu.

3.	 Save the template.

When you apply the modified effect, transition, title, or generator to a clip in the 
Final Cut Pro timeline, the parameter control you published appears in the Final Cut Pro 
inspector, ready for adjustment.

Publish compound parameter controls (a parameter with nested subparameters)
1.	 In the template project in Motion, select the image layer or effects object containing the 

compound parameter (such as Rotation) to publish.

2.	 Open the selected item’s Inspector.

To publish a compound parameter to Final Cut Pro in a collapsed state (its 
subparameters hidden by a disclosure triangle), make sure the parameter’s disclosure 
triangle is closed.

To publish a compound parameter in an expanded state (disclosure triangle open and its 
subparameters exposed), make sure the parameter’s disclosure triangle is open.

3.	 Do one of the following:

•	 Control-click the parameter’s name, then choose Publish from the shortcut menu.

•	 Click the parameter’s Animation menu (the down arrow that appears when you place 
the pointer over the right side of the parameter row), then choose Publish.

4.	 Save the template.

The parameter and its subparameter controls are published. When the modified 
effect is applied to a clip in Final Cut Pro, the compound parameter retains its state 
(collapsed or expanded) at the time of publishing. If the result is not what you expected, 
click the disclosure triangle in the Final Cut Pro inspector to expand or collapse the 
subparameters manually. 
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Note: Examples of parameters with subparameters include Scale (with X, Y, and Z 
values) and Shear (with X and Y values).

Publish subparameter controls of a compound parameter
You can also publish specific subparameters of a compound parameter. This is a good way 
to limit an editor’s control over effects parameters in a Final Cut Pro project.

1.	 In the template project in Motion, select the image layer or effect object containing the 
subparameter to publish.

2.	 In the item’s Inspector, click the compound parameter’s disclosure triangle to show its 
subparameters.

3.	 For each parameter to publish, do one of the following:

•	 Click the parameter’s Animation menu (the down arrow that appears when you place 
the pointer over the right side of the parameter row), then choose Publish.

•	 Control-click the parameter’s name, then choose Publish from the shortcut menu.

4.	 Save the template.

The subparameter control is published. When you apply the modified effect to a clip in 
Final Cut Pro, the subparameter appears in the Final Cut Pro inspector.

Publish an activation checkbox for a filter or behavior
Publishing a filter or behavior activation checkbox lets Final Cut Pro users quickly turn an 
effect on or off.

1.	 In the template project in Motion, select the filter or behavior whose activation 
checkbox you want to publish.

2.	 In the Behaviors or Filters Inspector, do one of the following:

•	 In the heading row of the behavior or filter, click the Animation menu (the down 
arrow that appears when you place the pointer over the right side of the row), then 
choose Publish.

•	 Control-click the behavior or filter name, then choose Publish from the shortcut menu.

Note: If you publish only the blue activation checkbox and no other parameters in 
the behavior or filter’s group of controls, only the checkbox is published.

3.	 Save the template.

When you apply the modified effect to a clip in Final Cut Pro, a checkbox with the name 
of the published filter or behavior appears in the Final Cut Pro inspector. Deselecting 
the checkbox disables the effect of that filter or behavior (including its constituent 
parameters).
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Publish a rig control (widget)
1.	 In Motion, add a rig to the template, assigning specific parameters to the rig’s widget 

controls.

For more information about building rigs, creating widgets, and assigning parameters, 
see Intro to rigging.

2.	 Select the rig, then do one of the following in the Rig Inspector:

•	 In the Checkbox, Pop-up, or Slider widgets, click the Animation menu (the down 
arrow that appears when you place the pointer over the right side of the widget’s 
parameter row), then choose Publish from the shortcut menu.

•	 Control-click the Checkbox, Pop-up, or Slider parameter name, then choose Publish 
from the shortcut menu.

3.	 Save the template.

When you apply the modified effect, transition, title, or generator to a clip in the 
Final Cut Pro timeline, the rig control you published appears in the Final Cut Pro 
inspector.

Publish a gradient editor control
1.	 In the template project in Motion, select the image layer or effect object that contains 

the gradient editor to publish.

2.	 In the item’s Inspector, Control-click the Gradient parameter, then choose Publish from 
the shortcut menu.

3.	 Save the template.

When you apply the modified effect, transition, title, or generator to a clip in the 
Final Cut Pro timeline, the gradient editor control appears in the Final Cut Pro inspector.

Publish a filter’s onscreen controls
You can publish a filter’s onscreen controls so that Final Cut Pro users can make filter 
adjustments by dragging handles in the Final Cut Pro viewer.

1.	 In the template project in Motion, select the filter object.

2.	 In the Filters Inspector, select the Publish OSC checkbox.
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3.	 Save the template.

When you apply the modified effect, transition, title, or generator to a clip in the 
Final Cut Pro timeline, the onscreen controls for the filter appear in the Final Cut Pro 
viewer.

Note: When you publish onscreen controls, their corresponding numeric controls in the 
Inspector are not published. You must publish Inspector parameter controls separately. See 
Publish a parameter control.

For more information about filter onscreen controls, see Adjust filters in the canvas and 
Publish filter controls to Final Cut Pro.

Manage template controls in Motion
The following tasks describe how to review, reorder, and unpublish parameters, as well as 
how to customize a published parameter name.

Review parameter controls to be published
1.	 In the Layers list of the template project in Motion, click Project.

2.	 In the Project Inspector, click Publishing.

Parameters (for all object types) set to be published appear in the list.

Note: When you publish a filter’s onscreen controls by selecting the Publish OSC 
checkbox, no OSC parameter appears in the Publishing pane of the Project Properties 
Inspector. When the effect is applied in Final Cut Pro, the onscreen controls are visible 
in the viewer.

Reorder parameter controls in the Publishing pane
1.	 In the Layers list of the template project in Motion, click Project.

2.	 In the Project Inspector, click Publishing.

3.	 Drag a parameter up or down in the Published Parameters list.

Rename a published parameter control
1.	 In the Layers list of the template project, click Project.

2.	 In the Project Inspector, click Publishing.

3.	 In the Published Parameters list, double-click the name of a parameter, enter a name, 
then press Return.

Note: To navigate to the originally published parameter (before the name change), 
Control-click the parameter and choose Reveal Original Parameter.

Unpublish a parameter control in the Inspector
•	 In Motion, select a layer or effect object in the Layers list, then in the Inspector, do one 

of the following:

•	 Click the published parameter’s Animation menu (the down arrow that appears 
when you place the pointer over the right side of the parameter row), then choose 
Unpublish.

•	 Control-click the published parameter’s name, then choose Unpublish from the 
shortcut menu.
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Unpublish a parameter control in the Publishing pane
1.	 In the Layers list of the template project in Motion, click Project.

2.	 In the Project Inspector, click Publishing, then do one of the following:

•	 Click the Animation menu (the down arrow that appears when you place the pointer 
over the right side of the parameter row), then choose Unpublish from the shortcut 
menu.

•	 Control-click the parameter name, then choose Unpublish from the shortcut menu.

Publishing template text controls in Motion
When you apply a title or generator containing text to a clip in Final Cut Pro, the Title 
inspector becomes available. The Title inspector in Final Cut Pro displays any published 
text parameters in the template. When you publish a text parameter already in the 
Final Cut Pro Text inspector, the parameter appears in both the Title inspector and the 
Text inspector. Changes made to the parameters in the Title inspector affect the same 
parameters in the Text inspector, and vice versa.

The Text inspector in the Final Cut Pro includes many of the same controls available in the 
Motion Text Inspector. If you want to control a parameter not included in the Final Cut Pro 
Text inspector, publish that parameter in the title or generator template in Motion.

For more information on working with text in Final Cut Pro, see the Final Cut Pro User 
Guide. For more information on Motion’s text parameters, see Intro to editing text.

Template items that can’t be published in Motion
The following Motion items cannot be published in templates for Final Cut Pro:

•	 Audio of any kind, including Source Audio wells in the Audio Parameter behavior

•	 Image wells (except for drop zone Source Media wells)

•	 Mini-curve editors

•	 Timing controls in the Image Inspector or Media Inspector

•	 Retiming behaviors (such as Ping Pong, Loop, and Stutter)

•	 The Range Minimum/Range Maximum slider rig widget

•	 Placeholder Pan and Scale controls in template placeholders

•	 Project properties (such as Color Processing, Pixel Aspect Ratio, Frame Rate, and 
Background Color in the Properties Inspector)

Note: When Color Processing is set to Automatic, you can publish the HDR White Level 
slider in Project properties to better match the brightness of SDR elements in the 
template with HDR media (in an HDR HLG or HDR PQ Final Cut Pro project).

•	 Some Green Screen Keyer filter and Luma Keyer filter controls (keying templates are not 
recommended). See Guidelines for creating templates.

•	 Noncompound groups of controls, such as the Lighting parameter in the Properties 
Inspector

•	 Onscreen path for the Motion Path behavior

Note: Although you can publish a Motion Path behavior to Final Cut Pro, the path does 
not appear in the Final Cut Pro viewer.

https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro/welcome/mac
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In general, Motion lets you publish most controls in the application. However, some 
publishable controls are not supported in Final Cut Pro. The following items have 
components that are not accessible after a template is added to a Final Cut Pro project:

•	 Color parameters in the Properties Inspector (Automatic projects only when an image or 
clip is selected)

•	 Parameters related to text path onscreen controls

•	 Mask or shape control points

•	 Parameters with deselected activation checkboxes

•	 The Histogram in the Levels color-correction filter

•	 Audio behavior parameter controls

Note: Audio files saved in a Motion template are not available in Final Cut Pro.

Control template timing and animation

Intro to template markers in Motion
Template markers—a special category of Timeline markers in Motion—control the timing 
of templates in Final Cut Pro. When building a template in Motion, you typically don’t know 
the duration of the clips that will be applied to it in Final Cut Pro. By default, the duration 
of a template is determined by the length of the Final Cut Pro clip it’s applied to. Template 
markers let you control the timing of a template after it’s applied in Final Cut Pro, by 
designating regions in the Final Cut Pro timeline to be played, ignored, or looped.

There are five types of template markers:

•	 Build In: Designates an opening section (or intro) of a template, and instructs 
Final Cut Pro to play that section at the same speed as the original template (as created 
in Motion), regardless of the duration of the clip in the Final Cut Pro timeline. For 
example, if a Build In marker is present at the 30-second mark, the first 30 seconds 
retain the original timing (as created in Motion). Beyond the 30-second mark, the 
template is time-stretched (or time-shrunk) to the duration of the Final Cut Pro clip.

•	 Build Out: Designates an ending section (or outro) of a template, and instructs 
Final Cut Pro to play that section at the same speed as the original template (as created 
in Motion), regardless of the duration of the clip in the Final Cut Pro timeline. For 
example, if a Build Out marker is present 30 seconds from the end of the Final Cut Pro 
clip, the last 30 seconds retain the original timing (as created in Motion). Prior to the 
Build Out marker, the template is time-stretched (or time-shrunk) to the duration of the 
Final Cut Pro clip.

If no Build In or Build Out markers are present, the entire template is time-stretched 
to correspond to the duration of the clip in Final Cut Pro. For example, if you apply an 
effect template that is three minutes long to a six minute long clip in Final Cut Pro, the 
effect stretches over the six-minute duration of the Final Cut Pro clip.

Note: Transition templates assume a default duration in Final Cut Pro (determined in 
Final Cut Pro Settings). This duration can conflict with the effects of template markers. 
For information on how to override the Final Cut Pro default duration, see Create a 
transition template.
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•	 Project Loop End: Indicates where the template should begin looping playback—for 
example, when you need to recycle animation in a template to match the length of 
a long clip in Final Cut Pro. You can also use a Project Loop End marker to force 
Final Cut Pro to play a template at its original speed (as created in Motion) rather than 
at a speed timed to match the duration of the clip the template is applied to. See Force 
Final Cut Pro to play a template at its original speed. 

•	 Poster Frame: Poster Frame markers determine the frame of a template to be used as 
the thumbnail for the template in the Final Cut Pro Effects browser, Transitions browser, 
or Titles browser.

•	 Text Edit: Text Edit markers identify ideal edit points in your title templates.

Add template markers in Motion
Use template markers to create an intro section, outro section, looping point, or poster 
frame (a frame that appears as a thumbnail in the Final Cut Pro browser) in a Final Cut Pro 
template. You can also create a Text Edit marker to designate edit points in a title template 
for Final Cut Pro.

Create an intro section in a template
Adding a Build In marker to a template creates an intro section. When the template is 
applied to a clip in Final Cut Pro, frames between the beginning of the project and the Build 
In marker (the intro) play at the same speed as in the original Motion template. Frames 
after the Build In marker are retimed to match the duration of the Final Cut Pro clip.

1.	 In Motion, move the playhead to the frame where you want the template’s intro section 
to end, then press Shift-M.

A green project marker appears in the Timeline ruler, and a (subtle) green vertical line 
appears in the mini-Timeline.

2.	 Do one of the following:

•	 Position the playhead over the marker, then choose Mark > Markers > Edit Marker.

•	 Double-click the marker.

•	 Control-click the marker, then choose Edit Marker from the shortcut menu.

3.	 In the Edit Marker dialog, click the Type pop-up menu and choose an option:

•	 Build In – Mandatory: Choose this marker type to play the frames between the 
beginning of the project and the Build In – Mandatory marker at the same speed as 
in the original Motion template. Beyond the marker, the effect is time-stretched or 
time-shrunk to match the duration of the Final Cut Pro clip.

•	 Build In – Optional: This marker type has the same effect as the Build In – Mandatory 
marker (described above), but adds a checkbox in the Final Cut Pro inspector to 
optionally disable the intro’s playback (frames before the marker are not played, and 
frames after the marker are retimed to match the duration of the Final Cut Pro clip).
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The project marker becomes a Build In marker, the Timeline ruler displays a dashed 
gold line over the affected region, and a Build In checkbox is added to the Published 
Parameters list in the Publishing pane of the Project Inspector.

Create an outro section in a template
Adding a Build Out marker to a template creates an outro section. When the template is 
applied to a clip in Final Cut Pro, frames between the Build Out marker and the end of 
the project (the outro) play at the same speed as in the original Motion template. Frames 
before the Build Out marker are retimed to match the duration of the Final Cut Pro clip.

1.	 In Motion, move the playhead to the frame where you want the marker to appear, then 
press Shift-M.

A green project marker appears in the Timeline ruler, and a (subtle) green vertical line 
appears in the mini-Timeline.

2.	 Do one of the following:

•	 Position the playhead over the marker, then choose Mark > Markers > Edit Marker.

•	 Double-click the marker.

•	 Control-click the marker, then choose Edit Marker from the shortcut menu.

3.	 In the Edit Marker dialog, click the Type pop-up menu and choose an option:

•	 Build Out – Mandatory: Choose this marker type to play the frames between the 
Build Out – Mandatory marker and the end of the project at the same speed as in the 
original Motion template. Prior to the marker, the effect is time-stretched (or shrunk) 
to match the duration of the Final Cut Pro clip.

•	 Build Out – Optional: This marker has the same effect as the Build Out – Mandatory 
marker (described above) but adds a checkbox in the Final Cut Pro inspector to 
optionally disable the outro’s playback (frames before the marker are retimed to 
match the duration of the Final Cut Pro clip, and frames after the marker are not 
played).
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The project marker becomes a Build Out marker, the Timeline ruler displays a 
dashed gold line over the affected region, and a Build Out checkbox is added to the 
Published Parameters list in the Publishing pane of the Project Inspector.

Specify the frame where the template begins looping playback
You can add a Project Loop End marker to instruct Final Cut Pro to begin looping playback 
at a specific frame. When playback reaches this frame, the project plays from the 
beginning of the project or from the Build In marker, if present. Frames beyond the Project 
Loop End marker are never played.

1.	 In Motion, move the playhead to the frame where you want the marker to appear, then 
press Shift-M.

A green project marker appears in the Timeline ruler, and a (subtle) green vertical line 
appears in the mini-Timeline.

2.	 Do one of the following:

•	 Position the playhead over the marker, then choose Mark > Markers > Edit Marker.

•	 Double-click the marker.

•	 Control-click the marker, then choose Edit Marker from the shortcut menu.

3.	 In the Edit Marker dialog, click the Type pop-up menu, then choose Project Loop End.
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The project marker becomes a Project Loop End marker, and the Timeline ruler displays 
a dashed gold line over the affected region.

Setting a marker type to Project Loop End changes any marker set to a Build Out type back 
to Standard. Similarly, if a Project Loop End marker exists, adding a Build Out marker resets 
the loop marker back to Standard.

To ensure sure smooth looping of animation in a template, position the Project Loop End 
marker at a frame in the Timeline where the animation is in a position similar to its position 
in the first frame of the template. For example, to loop an animated text crawl, have the 
text entering the left edge of the canvas in the first frame of the template and leaving the 
right edge of the canvas at the Project Loop End marker.

 Tip: Adding a loop marker to the second frame in a template makes the effect time-
invariant—the first frame of the project loops forever. This can be useful for generators 
that do not contain animation (such as a solid color generator), or for filters that aren’t 
animated by default (such as a color-correction filter).

Note: Templates with applied Time filters (Echo, Scrub, Strobe, Trails, or WideTime) should 
not use Loop markers, because unexpected timing results can occur.

Force Final Cut Pro to play a template at its original speed
When you apply a template in Final Cut Pro, the template is retimed to match the duration 
of the clip it’s applied to. The Build In and Build Out markers force Final Cut Pro to play 
back the intros and outros you designate at their original speed (as created in Motion). 
However, if you want to force Final Cut Pro to play the template at its original speed 
throughout, use a Project Loop End marker.

1.	 In Motion, create a template with a duration much longer than the clips it will be applied 
to in Final Cut Pro.

2.	 Move the playhead to the last frame in the template, then add a Project Loop End 
marker as described in the previous task.

When applied to a clip in Final Cut Pro, the template will play at its original speed for the 
duration of the clip (because the clip will end long before reaching the template’s loop 
point).
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Set the frame to be used as the template’s thumbnail in the Final Cut Pro browser
You can add a Poster Frame marker to instruct Final Cut Pro to use a specific frame of 
a template as the template thumbnail in the Final Cut Pro Effects browser, Transitions 
browser, or Titles browser.

1.	 In Motion, move the playhead to the frame you want to use as the poster frame, then 
press Shift-M.

A green project marker appears in the Timeline ruler, and a (subtle) green vertical line 
appears in the mini-Timeline.

2.	 Do one of the following:

•	 Position the playhead over the marker, then choose Mark > Markers > Edit Marker.

•	 Double-click the marker.

•	 Control-click the marker, then choose Edit Marker from the shortcut menu.

3.	 In the Edit Marker dialog, click the Type pop-up menu, then choose Poster Frame.

Although the project marker appearance does not change, it becomes a Poster Frame 
marker (a tooltip appears if you move the pointer over the marker).

If a Poster Frame marker exists, adding a new Poster Frame marker resets the first 
marker to Standard.

Specify a frame as an ideal text edit point in a title template
You can add Text Edit markers to specify the optimal edit points for text in a title template. 
For example, if your title animates offscreen, you can add a Text Edit marker to quickly 
navigate to a frame where the text is visible in the Final Cut Pro viewer.

The Text Edit marker is only available in the Final Cut  Title template.

1.	 In Motion, move the playhead to the frame where you want the marker.

2.	 Select the text to add the marker to, then do one of the following:

•	 Choose Mark > Markers > Add Marker.

•	 Press M.

A red object marker is added to the timebar of the selected object.

3.	 Do one of the following:

•	 Position the playhead over the marker, then choose Mark > Markers > Edit Marker.

•	 Double-click the marker.

•	 Control-click the marker, then choose Edit Marker from the shortcut menu.

4.	 In the Edit Marker dialog, click the Type pop-up menu, then choose Text Edit.

Although the object marker appearance does not change, it becomes a Text Edit marker.

You can add multiple Text Edit markers to a template.

In the Final Cut Pro timeline, double-click the title to enter text-edit mode. In the viewer, 
use the Next Text Layer and Previous Text Layer buttons to navigate between Text 
Edit markers. For more information about working with titles in Final Cut Pro, see the 
Final Cut Pro User Guide.

https://support.apple.com/guide/final-cut-pro/welcome/mac
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Move a marker
•	 In Motion, drag the marker to a new position in the Timeline ruler or timebar.

When you drag the marker, the current frame is displayed above the pointer.

Change the marker type
1.	 In Motion, do one of the following:

•	 Position the playhead over the marker, then choose Mark > Markers > Edit Marker.

•	 Double-click the marker.

•	 Control-click the marker, then choose Edit Marker from the shortcut menu.

2.	 In the Edit Marker dialog, click the Type pop-up menu, then choose a marker type.

The Build In and Build Out markers appear as small green arrows in the Timeline ruler. 
The Project Loop Out marker appears as a small orange arrow. At the top of the ruler, 
the area specified as the intro, outro, or loop section displays a gold glow.

For more information on the Edit Marker dialog, see Intro to Timeline markers.

Animation guidelines for templates in Motion
Effect, title, transition, and generator templates can include animation like a standard 
Motion project. When the template is added to a clip in Final Cut Pro, animation in the 
placeholder is applied to the clip, whether created by behaviors or keyframes.

Animation in the template that is longer than the duration of the clip to which it’s applied in 
Final Cut Pro is scaled to fit.

Important: If you don’t want your template animation scaled to fit the duration of a clip in 
Final Cut Pro, you can use markers to designate segments where the animation is locked. 
Additionally, you can use markers to designate sections where animation loops indefinitely 
in the Final Cut Pro project. See Intro to template markers.

When publishing parameters in your templates, consider the following guidelines:

•	 When possible, avoid publishing keyframed parameters. Published keyframes may 
cause unexpected results when you edit or when you animate the parameters in the 
Final Cut Pro inspector.

•	 Publishing a parameter that’s controlled by a behavior may yield unexpected results. 
For example, if you publish an Opacity parameter (in the Properties Inspector) that’s 
controlled by a Fade In/Fade Out behavior, adjusting the opacity parameter after the 
template is added to the Final Cut Pro project may not work as expected.

•	 Because the duration of templates often conflicts with the duration of the Final Cut Pro 
clips they’re applied to, you can publish nonanimated parameters in the template, then 
keyframe those parameters in Final Cut Pro.

•	 Use behaviors instead of keyframes in templates when possible. Behaviors can be a 
more flexible animation tool for templates. Behaviors don’t rely on specific timing or use 
keyframes to create an animation. Publish behavior parameters that you want to control 
in Final Cut Pro.
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Timing guidelines for templates in Motion
Depending on the template type, different timing rules apply when you apply the template 
to a clip in the Final Cut Pro timeline. When publishing parameters and applying templates, 
consider the following guidelines:

•	 Final Cut Effect: When you apply an effect template in Final Cut Pro, the effect is 
integrated into the clip. For example, when a color-correction effect template that’s 
300 frames in Motion is saved and applied to a 2,300-frame clip in Final Cut Pro, the 
resulting effect is 2,300 frames.

Animated effect templates are also scaled according to the duration of the clip they’re 
applied to in Final Cut Pro. For example, if a template in Motion is 300 frames long, and 
the placeholder layer is animated to rotate 360 degrees (one complete rotation) from 
frames 0 to 300, when the template is applied to a 900-frame clip in Final Cut Pro, the 
complete rotation is stretched to 900 frames.

You can override the timing adjustment in Final Cut Pro by applying markers to the 
template in Motion. For example, to control frame-counting effects, such as Timecode 
generators, apply special markers to instruct Final Cut Pro when to play specific ranges 
of the template. See Add template markers.

•	 Final Cut Transition: In Final Cut Pro, the default transition duration is set in the Editing 
pane of Final Cut Pro Settings. When you apply a transition template to an edit point in 
the Final Cut Pro timeline, the duration of the transition effect is modified to the default 
transition duration. For example, in a Final Cut Pro Broadcast HD 1080 project (29.97 
fps) with a default transition duration of two seconds, an applied 300-frame transition 
template is compressed to 60 frames (2 seconds at 29.97 fps).

To override the transition duration setting in Final Cut Pro Settings, select the Override 
FCP checkbox in the Properties Inspector in Motion. If this checkbox is selected when 
the transition is saved, the transition retains its original duration when added to the 
Final Cut Pro project.

Whether the transition duration uses the Final Cut Pro default or is overridden, you can 
adjust the In and Out points of the transition in the Final Cut Pro timeline.

•	 Final Cut Title: When added to a Final Cut Pro project, a title template is anchored to the 
clip it’s applied to. Its duration is based on the duration of the template in Motion. After 
the title is applied, you can adjust its duration in the Final Cut Pro timeline.

•	 Final Cut Generator: When added to a Final Cut Pro project, a generator template uses 
its default duration (its duration when the template was created and saved in Motion). 
After the generator is applied, you can adjust its duration in the Final Cut Pro timeline.
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Set template resolution in Motion
Before you create a template, decide what resolution your project requires. Although the 
template scales to fit the resolution of the Final Cut Pro project it’s applied to, you should 
create the template at the highest resolution you will use.

Additionally, you can save a template in multiple display aspect ratio settings, for delivery 
to different-sized screens. See Add multiple aspect ratios to templates.

Note: An image added to a placeholder is fit based on the template project settings in 
Motion. Because the image in the placeholder is not used when the template is applied to a 
Final Cut Proo project, stretching or scaling of the media does not affect the Final Cut Pro 
clip the template is applied to.

When you create templates with 4K resolution, you can add a metadata flag so that 
Final Cut Pro users can quickly find 4K templates (and filter out all non-4K templates).

Flag a template as having 4K resolution
•	 In the Layers list in Motion, select the Project object and then select the Designed for 

4K checkbox in the Properties Inspector.

After the template is published to Final Cut Pro, select the 4K Only checkbox in the 
Final Cut Pro media browsers to display only templates designed for use in 4K projects. 
(The 4K Only checkbox appears only in Final Cut Pro projects using one of the 4K or 5K 
formats.)

Add multiple aspect ratios to templates in Motion
When creating a template for Final Cut Pro, you can build alternate versions that have 
different display aspect ratios—all within a single template. For example, when you create 
a template with a 16:9 aspect ratio, you can add an alternate version customized for 4:3 
displays. When the template is applied to a clip Final Cut Pro, the editing application 
chooses the version that matches its display aspect ratio. These alternate display versions 
of a single template are called snapshots. Snapshots eliminate the need to create multiple 
versions of the same template for multiple display ratios.

You can also create square or vertical display aspect ratios, suitable for social media 
platforms. See the Final Cut Pro User Guide.

If you expect a template to be applied to differently sized clips in Final Cut Pro, perform the 
workflow described in this section before saving the template.

https://support.apple.com/guide/final-cut-pro/welcome/mac
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Add a display aspect ratio to a template
1.	 In the Layers list in Motion, select the Project object.

2.	 In the Project Inspector, click Snapshots.

The Display Aspect Ratio Snapshots list appears, showing the project’s current default 
aspect ratio.

3.	 Click the Add button (+) and choose a different aspect ratio from the shortcut menu.

If you chose Custom, the Custom Display Aspect Ratio calculator appears.

The new aspect ratio appears in the list.

4.	 In the Display Aspect Ratio Snapshots list, click the new aspect ratio.

The project shifts to the new aspect ratio.

Note: You cannot add a snapshot that matches an existing Display Aspect Ratio 
snapshot.

5.	 To reposition your objects to better fit the new aspect ratio, click Edit Snapshot.

A small floating window appears, indicating that you are in aspect ratio-edit mode.

6.	 Position and scale the layers in your project to fit the new display aspect ratio, then 
click the Stop Rig Edit Mode button in the floating window.

Click the items in the snapshots list to view the results in the canvas.

Note: When working with an alternate snapshot, the resolution listed in the Properties 
pane of the Inspector (when Project is selected in the Layers list) may seem strange. 
This is because the Display Aspect Ratio is shown, rather than the Pixel Aspect Ratio.

7.	 Choose File > Save or File > Save As, then do the following:

a.	 In the save dialog, enter a name for your template.

b.	 Choose a category from the Category pop-up menu.

c.	 If needed, choose a theme from the Theme pop-up menu.

d.	 To retain unused media in the project (media or audio in the Media list not used in 
the project), select “Include unused media.”

When the template is applied to the Final Cut Pro timeline, the template aspect ratio 
that matches the Final Cut Pro project is used.
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Create a custom display aspect ratio (DAR) snapshot
Pixel Aspect Ratio (PAR) is the ratio of the width of a pixel to its height. For example, 
NTSC pixels are slightly taller than they are wide. They have a pixel aspect ratio of 10/11 
(approximately 0.9091). Display Aspect Ratio (DAR) is a ratio of the final displayed image’s 
width to its height. For example, the iPad display aspect ratio is 1.3333 (also written as 
4:3), but HD televisions have a display ratio of 1.78:1 (also written as 16:9).

To calculate the display aspect ratio of an image from its dimensions and pixel aspect ratio, 
multiply the pixel aspect ratio by the width and divide by the height. Common aspect ratios 
include 4:33 (also referred to as standard or 1.33:1) and 16:9 (widescreen or 1.78:1). Older 
monitors and TVs are generally 4:3, so the screen is 33 percent wider than it is high. Newer 
HD monitors and TVs are 78 percent wider than they are high.

1.	 In the Layers list in Motion, select the Project object.

2.	 In the Project Inspector, click Snapshots.

3.	 Click the Add button (+) and choose Custom from the shortcut menu.

4.	 Click the Pixel Aspect Ratio pop-up menu, then choose an option.

The pixel aspect ratio (PAR) appears in the field to the right of the pop-up menu.

5.	 Enter the width and height in the fields to the right of the PAR value.

The new custom DAR is listed in the Display Aspect Ratio Snapshots list.

Set a template to override the Final Cut Pro color 
space
When you create an effect, generator, title, or transition template in the Standard Gamut 
SDR or Wide Gamut HDR color space, then apply the template to a Final Cut Pro project 
that has a different color space, your effect might not appear as expected. For example, 
if you create a Final Cut effect in SDR color space, then apply the effect to a Final Cut Pro 
project that’s part of an HDR library, the effect switches to the Wide Gamut HDR color 
space. You can ensure a consistent result regardless of the Final Cut Pro library’s color 
space setting by selecting the Override FCP Color Space checkbox.

1.	 In the Layers list of the template project in Motion, select the Project object.

2.	 In the Properties Inspector, select the Override FCP Color Space checkbox.

Note: The checkbox is not available when Color Processing (in the Project Properties 
Inspector) is set to Automatic.

If Override FCP Color Space is not selected, and you apply an effect in a Final Cut Pro 
library, all processing happens in the working color space of the library.

For more information on the library and output color space in Final Cut Pro, see the 
Final Cut Pro User Guide.

If you create an effect, generator, title, or transition template using Automatic color 
processing, the template automatically conforms to the color space of the Final Cut Pro 
project when applied to the timeline. The Override FCP Color Space checkbox is not 
available in Automatic projects.

https://support.apple.com/guide/final-cut-pro/welcome/mac
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Create templates that automatically conform to 
the Final Cut Pro color space
If you’re creating an effect, transition, title, or generator that includes both SDR and 
HDR elements—or you plan to work in multiple color spaces in Final Cut Pro for Mac—
use Automatic color processing to create a template that automatically conforms to the 
Final Cut Pro color space.

For example, when a template is applied to the timeline in an SDR Final Cut Pro project, 
the template renders in SDR and any HDR elements in the template (such as video from a 
newer iPhone) are tone mapped to SDR. When a template is applied to the timeline in an 
HDR HLG Final Cut Pro project, the template renders in HDR, and any SDR elements (such 
as shapes or text created in Motion) are inverse tone mapped to HLG.

Additionally, use Automatic color processing while building templates to:

•	 Easily integrate SDR elements (such as text, shapes, particles, or other objects created 
in Motion) with HDR media in the same template project, using intelligent tone mapping 
to match your SDR or HDR color space.

•	 Quickly preview a template in different SDR and HDR color spaces using the View > 
Render Color Space pull-down menu.

•	 Adjust the brightness levels of SDR images and elements to match the brightness levels 
of HDR media using the HDR White Level slider.

•	 Publish the HDR White Level slider to adjust the brightness of SDR images and elements 
once the effect, transition, generator, or title is added to the Final Cut Pro timeline in an 
HDR HLG or HDR PQ project. This lets you better match the brightness of SDR elements 
in the template with HDR media in the Final Cut Pro project.

Set the color processing for a new template project
1.	 In Motion, choose File > New from Project Browser (or press Option-Command-N).

2.	 In the Project Browser, click the type of template you want to create (Final Cut Effect, 
Final Cut Generator, Final Cut Transition, or Final Cut Title).

3.	 In the right column, click the Preset pop-up menu, then choose Custom.
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4.	 Click the Color Processing pop-up menu, then choose Automatic.

5.	 Set any other custom properties (resolution, projection type, aspect ratio, frame rate, 
and so on).

See Project Properties Inspector controls.

6.	 Click Open.

A new, untitled Motion template project opens set to Automatic Color Processing (and 
the custom properties you specified).
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Set the color processing for an existing template project
1.	 In the Layers list of the Motion template, select the Project object (or press 

Command-J).

2.	 In the Properties Inspector, click the Color Processing pop-up menu, choose Automatic, 
then click OK.

Note: Once set to Automatic, the project’s working color space is determined by the 
Render Color Space setting (in the View pull-down menu).

Publish the HDR White Level slider in a template
You can publish an HDR White Level slider to give editors control over adjusting the 
brightness of SDR elements—images or clips, or objects created in Motion (such as text, 
shapes, or replicators)—in an HDR HLG or HDR PQ Final Cut Pro project.

Note: In general, the HDR White Level slider has no effect on HDR media. However, when 
you apply templates including certain filters to HDR media, the image or clip may be 
affected by the HDR White Level slider. See About filters and color processing.

1.	 In the Layers list of the Motion template, select the Project object (or press 
Command-J).

2.	 In the Properties Inspector, click the Color Processing pop-up menu, choose Automatic, 
then click OK.
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3.	 In the Properties Inspector, do one of the following:

•	 Control-click HDR White Level, then choose Publish from the shortcut menu.

•	 Move the pointer to the right of the HDR White Level slider, click the Animation pop-
up menu (the down arrow), then choose Publish.

4.	 Save the template.

Once the template is applied to the Final Cut Pro timeline, the HDR White Level slider is 
available in the effect, transition, title, or generator inspector.
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Where are Final Cut Pro templates saved in 
Motion?
When you save a Final Cut template, the project and all associated files are saved in your /
Users/username/Movies/Motion Templates/ folder on your computer, organized by template 
type. For example, a Final Cut Effect template is saved to /Users/username/Movies/Motion 
Templates/Effects/; a Final Cut Transition is saved to /Users/username/Movies/Motion 
Templates/Transitions/, and so on. The template types include Compositions (templates 
created in Motion for use in Motion), Effects, Generators, Titles, and Transitions.

When you save a template in Motion, you assign a category and have the option to assign a 
theme.

In the macOS Finder, templates are stored according to the following folder hierarchy: 
template type/category/theme. For example, if you save a Final Cut Effect template to 
the Blur category with an optional News theme, it is stored in the Finder in the /Users/
username/Movies/Motion Templates/Effects/Blur/News/yourtemplatename/ folder.

Note: You can also sort by theme in the Motion Project Browser using the Theme pop-up 
menu. 

Contents of the template folder
Each template folder contains the following items:

•	 large.png: This file is used for the preview in the Motion Project Browser and as a 
preview in the Final Cut Pro browser when the project loads in the background.

•	 small.png: This file is used for the thumbnail preview of the template in the Final Cut Pro 
browser. The current frame when the template is saved in Motion is used for the 
preview frame.

•	 yourtemplatename.mov: This file is used for the movie preview of the template that 
plays when the template is selected in the Motion Project Browser. This file is created 
when you select the “Save Preview Movie” checkbox before saving.

•	 yourtemplatename.moef, -.motn, -.moti, or -.motr: This is the Motion template’s project 
document.

•	 .moef is the filename extension for a Final Cut Effect template.

•	 .motn is the filename extension for a Final Cut Generator template.

•	 .moti is the filename extension for a Final Cut Title template.

•	 .motr is the filename extension for a Final Cut Transition template.

•	 Media folder: This folder contains all media in the project—media used in the 
placeholder and other clips and images used in the project, including content such as 
particle cell sources. If you clear the media in the template placeholder before saving 
the template, that media is not saved in the Media folder.

Note: If you select “Include unused media” in the save dialog, media in the Media list 
(the storage area for media not used in the Motion project), is included in the Media 
folder.
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Sharing templates
To share templates and associated media files between users and computers, place the 
associated template files in the same folder structure on another user’s computer in the /
Users/username/Movies/Motion Templates/ folder.

Using masks in templates in Motion
You can use shapes and masks in any Final Cut Pro template type. For the best template 
results, use the following guidelines:

•	 Limit the use of shapes to generator templates. Shapes are ideal generator template 
elements because they can be scaled in Final Cut Pro without degradation. (However, 
too many shapes in a template can adversely impact performance in Final Cut Pro.)

•	 A shape added to a placeholder layer is converted to a mask. When a template with a 
masked placeholder is applied to a clip in Final Cut Pro, the mask is applied to the clip. 
Objects in the template outside the placeholder are not affected.

•	 Mask parameters (Roundness, Feather, and Mask Blend Mode, and so on) can be 
published so they are editable in Final Cut Pro. However, the onscreen mask controls in 
Motion are not available in Final Cut Pro. To reposition a template mask in Final Cut Pro, 
publish the mask’s transform parameters (located in the mask’s Properties Inspector). 
For more information on publishing, see Adding controls to templates.

For more information on working with shapes and masks, see Intro to shapes, masks, and 
paint strokes.

Guidelines for better templates

Guidelines for creating templates in Motion
To get the best results when creating custom templates for Final Cut Pro for Mac, consider 
the following suggestions:

•	 Although a template scales to fit the resolution of the Final Cut Pro project it’s applied 
to, you should create the template at the highest resolution you will use. See Set 
template resolution.

•	 If you plan to loop template animation, or need to match the template and a 
Final Cut Pro project frame for frame, create the template with the same frame rate as 
the Final Cut Pro project. For more information on looping template animation, see Add 
template markers.

•	 Although you can drag a video clip into a placeholder layer for preview purposes, the 
clip’s duration can interfere with timing built into the template. For that reason, it’s 
better to use still images in template placeholders when you need to preview an effect.

•	 Complex Motion layer effects such as particle emitters and replicators might negatively 
affect Final Cut Pro performance.
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•	 When you transform (scale, rotate, distort, and so on) a Final Cut Title using the tools 
in the viewer or Video inspector, any underlying clips in the Final Cut Pro timeline are 
also affected. To transform titles independently of any underlying clips, turn off the 
Title Background placeholder (deselect its checkbox in the Layers list), then save 
the template. You can also delete the Title Background placeholder, but this isn’t 
recommended in case you want to use the placeholder if you later modify the template.

•	 The first time you save a template that’s a work in progress, deselect the Save Preview 
Movie checkbox in the save dialog. Doing so prevents Motion from creating a movie 
preview each time you save the draft template. (The preview movie appears in the 
Motion Project Browser.) When you’re ready to save the final version of the template, 
select the Save Preview Movie checkbox to create the preview movie.

•	 When creating complex templates that involve multiple drop zones, use a Final Cut 
Generator or Final Cut Title template.

•	 As with any project in Motion, too many effects (such as filters, text objects, and so on) 
adversely impact performance in Final Cut Pro.

•	 Create animation using behaviors rather than keyframes. Behaviors are easier to modify 
when the template is applied in Final Cut Pro.

•	 Avoid publishing parameters animated with behaviors or keyframes. Published 
parameters allow template customization in Final Cut Pro.

•	 Shapes are nice graphic elements to add to a template project (outside of the 
placeholder), as they can be scaled without degradation. (Shapes added to a 
placeholder become masks). However, too many shapes in a template will adversely 
impact performance in Final Cut Pro.

•	 Ensure that “Create Layers At” in the Project pane of Motion Settings is set to “Start of 
project.”

•	 In the Motion Timeline, ensure that all filter and behavior bars extend to the end of the 
project.

•	 Before saving a template, decide whether you want to save or clear preview media 
(images added to a placeholder), based on the following considerations:

•	 Media not cleared is saved with the template, creating longer render times and 
consuming storage space.

•	 Media saved with the template is available when the template is reopened in Motion 
(via the “Open in Motion” command in the Final Cut Pro media browsers), allowing 
you to pick up where you left off in the previous template-building session.

•	 When keying green screen or blue screen footage, using a keying template is not 
recommended. Footage should be keyed directly in its own project in Final Cut Pro or 
Motion. This is because the Green Screen Keyer and Luma Keyer filters analyze the 
footage they’re initially applied to. You can render a keyed clip with its alpha channel 
and add the clip to a Final Cut Pro project. See Intro to color keying.

•	 Do not use image sequences when creating templates.

•	 If an object in a template has an applied Link Parameter behavior, do not move the 
object to another group. Doing so breaks the links.

•	 If you publish parameters for an object and then delete that object, all parameters set to 
be published are also deleted.
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•	 Do not use deprecated filters (older filters that are no longer supported in Motion) in a 
template. Although the filter may render correctly in Motion, it may not render correctly 
after the template is applied to a Final Cut Pro clip.

•	 If using a third-party filter, ensure that your template contains a Project Loop End 
marker (or that the project’s duration is set to one frame). If the template does not 
contain a Project Loop End marker, the effect is re-rendered in Final Cut Pro following 
certain editing actions, such as blading or trimming.

•	 Template placeholder layers cannot be duplicated. If a group that contains a 
placeholder is duplicated, other objects in the group are duplicated, but not the 
placeholder.

Tips for color processing in templates in Motion
To get the best results when creating templates that automatically conform to the 
Final Cut Pro for Mac project color space, consider the following suggestions:

•	 If you’re creating a template that includes SDR and HDR elements, or plan to work in 
multiple color spaces in Final Cut Pro, set your template’s Color Processing (in the 
Project Properties Inspector) to Automatic. The effect, transition, title, or generator 
automatically conforms to the color space of the Final Cut Pro project it’s applied to. 
See Create templates that conform to the Final Cut Pro color space.

•	 All objects you create in Motion—text, shapes, particles, replicators, and so on—
are SDR elements, regardless of the project’s color space. In a template with color 
processing set to Automatic, SDR elements are inverse tone mapped to display 
correctly in HDR.

•	 When a template’s color processing is set to Automatic, the HDR White Level slider 
becomes available in the Project Properties Inspector. Use the HDR White Level slider 
to adjust the brightness of SDR elements to better match the higher brightness levels of 
HDR media as you build your template.

•	 To adjust the brightness of SDR elements once the template is applied to an HDR 
Final Cut Pro project, publish the HDR White Level slider.

•	 An HDR White Level slider published with a template is available only in HDR HLG or 
HDR PQ projects in Final Cut Pro. (The slider is not available when the template is 
applied to an SDR project in Final Cut Pro.)

•	 In general, if you apply a template to a Final Cut Pro project that contains HDR images 
or clips, adjusting the HDR White Level slider has no effect on the brightness of the 
HDR media. For example, when a Final Cut Generator that includes text and particles 
using an HDR image as the particle cell source is added to the Final Cut Pro timeline, 
adjusting the HDR White Level slider affects the brightness of the text, but doesn’t 
affect the brightness of the particles.

However, when a template that includes a filter that processes in SDR is applied to HDR 
media, the image or clip is may be affected by the HDR White Level slider. For example, 
when a Final Cut Effect that includes the Tint or Glow filter is applied to an HDR clip in 
the Final Cut Pro timeline, adjusting the HDR White Level slider affects the brightness of 
the HDR clip. See About filters and color processing.

•	 With the exception of the Color Balance filter, any Motion filter that includes a color well 
(such as Tint, Bevel, or Glint) processes color in SDR and is affected by the HDR White 
Level slider.
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•	 Many of the effects, transitions, titles, and generators that ship with Final Cut Pro 
include a Graphics HDR Level slider. This slider has the same functionality as Motion’s 
HDR White Level slider.

•	 When you apply templates containing SDR elements (such as text or shapes) created 
in Motion to HLG or PQ Final Cut Pro projects, keep in mind that any SDR elements 
that appear too dim on a bright HDR clip may appear differently on a darker HDR clip. 
The brightness of the SDR elements doesn’t change—only the perception of it against 
different backgrounds.

•	 When you apply templates containing SDR elements to the Final Cut Pro timeline, the 
SDR elements are automatically tone mapped. It’s usually not necessary to adjust the 
Color Conform controls in the Final Cut Pro Video Inspector.

•	 A template’s Color Processing setting may affect the appearance of your project. For 
example, when the project is changed from Standard Gamut SDR to Wide Gamut HDR or 
Automatic, the effect of some filters or blend modes may change in appearance.

•	 Because templates are applied directly to media in the Final Cut Pro timeline, it’s 
recommended that you perform most color correction in Final Cut Pro to view changes 
in context. Final Cut Pro provides video scopes and other tools that precisely measure 
the luma and chroma levels of your media in different color spaces. See Intro to color 
correction in the Final Cut Pro User Guide for Mac.

However, if you’re creating a template that includes media—such as an image or 
clip used in a logo, lower-third title, or as a particle cell source—you can use the 
Color Adjustments filter to adjust the highlights, midtones, shadows, or other color 
parameters of the image. You can also publish the Color Adjustments filter parameters 
to adjust settings once the template is applied to a Final Cut Pro project.

•	 Although you can publish an image or clip’s Color parameters (in the Properties 
Inspector in Automatic projects), this workflow is not supported in Final Cut Pro. To 
convert media, use the Color Conform controls in the Final Cut Pro Video Inspector. See 
Automatic color management in the Final Cut Pro User Guide for Mac.

•	 If you’re unsure of an imported clip’s format (HLG, PQ, and so on), select the clip in the 
Media list, then check its metadata in the Media Inspector.

•	 To determine the nits value of an image or clip, you can display HDR luminance values in 
the Motion canvas.

•	 In earlier versions Final Cut Pro, a template that contained certain filters could clip the 
HDR media the template was applied to. Final Cut Pro 10.6.6 now automatically tone 
maps templates, preventing clipping in most projects. In a few cases, however, applying 
a Motion template to a PQ clip (with peak luminance levels greater than 1,000 nits) in 
the Final Cut Pro timeline may clip the media (or dim the project’s output).

•	 If you apply a Motion template that contains SDR elements (or filters that process in 
SDR) to a PQ clip with very high nits values, you may see unexpected results.

For general template guidelines, see Guidelines for creating templates.

https://support.apple.com/guide/final-cut-pro/intro-to-color-correction-ver761ca98b/mac
https://support.apple.com/guide/final-cut-pro/intro-to-color-correction-ver761ca98b/mac
https://support.apple.com/guide/final-cut-pro/automatic-color-management-ver808063493/mac
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Build rigs

Intro to rigging in Motion
Even a relatively basic Motion project contains numerous parameter controls. You can 
customize and even combine multiple controls using rigging.

Rigging lets you map one or more parameters at preset values to a single control. For 
example, you can rig a single slider to change the size, color, and tracking of a text object 
to a specific range of preset values. Or you can rig a single checkbox to activate shadows 
and reflections for all objects in a project.

The customized global controls (checkboxes, pop-up menus, and sliders) in a rig are 
called widgets. You can create widgets to adjust nearly any parameter of any object in 
your project, including behaviors, filters, particle systems, replicators, text, shapes, video 
clips, images, cameras, lights, and so on. Widgets can even control other widgets. There’s 
no limit to the number of parameters each widget affects. You can use multiple widgets 
in a rig to create a customized control panel where a few controls modify a wide range of 
parameters in the project.

Rigging is especially useful in Final Cut Pro templates, allowing users to modify a complex 
group of parameters with a small set of controls, or limiting user control to ensure that 
junior compositors, editors, and others in the production pipeline adhere to established 
specs and client needs. But rigs are also useful in Motion, allowing you to simplify the 
control set of a complex project. Instead of making changes by manipulating individual 
parameters, you can modify the Motion project using just a few widgets in a rig. For 
examples showing how rigs can simplify a Motion project, see How to use a single rig and 
How to use multiple rigs.

The following image shows a Rig in the Inspector with a single slider widget controlling the 
color of two star shapes. With the slider in its current position, the big star is orange and 
little star is pink. As you drag the slider toward the right, both stars become white.
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How does rigging work in Motion?
When you create a rig and add a widget control, you assign sets of snapshots to the 
widget. A snapshot is a record of parameter states for one or more objects in your project. 
Widgets let you switch between stored snapshots. For example, you can use a checkbox 
widget to record a snapshot of a shape’s Scale and Color parameters at one set of values 
(large and red) and then record another snapshot at a different set of values (small and 
green). In this example, when you select and deselect the checkbox widget (in the Widget 
Inspector), the shape snaps from large and red to small and green, and vice versa. See 
Intro to snapshots.

There are three types of widgets, each offering a different level of control over snapshots:

•	 Slider: The most complex widget, lets you apply gradual changes between multiple 
snapshots. See Slider widget. 

•	 Pop-up menu: A slightly more complex widget, lets you choose from among multiple 
snapshots. See Pop-up menu widget.

•	 Checkbox: The most basic widget, toggles between two snapshots. See Checkbox 
widget. 

There are several ways to record snapshots. The most basic method is to use the Rig 
Edit Mode button in the Widget Inspector. In rig edit mode, any changes you make to the 
parameters of any object update the active snapshot in that widget. See Build a simple rig. 
For additional ways to assign snapshots, see Intro to snapshots.

There are several factors to consider when using rigs:

•	 Each parameter in a project can be assigned to only one widget at a time. However, you 
can store many values for that parameter as different snapshots that can be accessed 
using a pop-up menu or slider widget.

•	 Because a parameter cannot be controlled simultaneously by two widgets, you cannot 
duplicate (or cut/copy and paste) a rig or widget. Similarly, if you duplicate or copy and 
paste an object with rigged parameters, the new object’s parameters are not rigged.

•	 If a parameter is assigned to a widget, that parameter cannot be modified while you 
are actively recording a different widget’s snapshot. For example, if you have a slider 
widget controlling a shape object’s color, and you begin recording a snapshot for a 
different widget, the shape’s color is not modifiable.

•	 Some parameter types cannot be rigged. Some parameters that use the mini-curve 
editor to affect an object over a range (such as the various “over stroke” parameters in 
the Shape inspector) cannot be added to a rig or modified while recording a snapshot. 
If you modify a parameter that cannot be rigged in edit mode, the change is applied 
globally—affecting all snapshots containing that object.
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Build a simple rig in Motion
The following task describes how to add a basic rig to a project, add a widget to the rig, 
then assign parameters and snapshots (parameter states) to the widget.

1.	 In Motion, do one of the following:

•	 In the toolbar, click Add Object, then choose Rig from the pop-up menu.

•	 Choose Object > New Rig (or press Control-Command-R).

A new rig is added to the project (shown in the Layers list and Timeline layers list).

2.	 In the Rig Inspector, click one of the three buttons:

•	 Add Slider: Adds a slider widget to the rig, enabling users to apply gradual changes 
between multiple parameter states 

•	 Add Pop-up: Adds a pop-up menu widget to the rig, enabling users to choose from 
among multiple parameter states

•	 Add Checkbox: Adds a checkbox widget to the rig, enabling users to toggle between 
two parameter states 

The new widget (in this example, a pop-up menu widget) appears in the Rig Inspector:
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The widget also appears in the Layers list under its parent rig:

When the Widget is selected, the Widget Inspector opens.

By default, the widget contains empty placeholders for snapshots (parameter states). 
In this example, the pop-up menu widget contains three options: Snapshot 1, Snapshot 
2, and Snapshot 3. You can rename them using the Rename button. See Rename a 
snapshot in a pop-up menu widget. 

3.	 To assign parameters and snapshots (specific parameter states) to the widget, do the 
following: 

a.	 In the Rig inspector or the Widget inspector, click the Edit Mode Start button.

A window appears containing the Stop Rig Edit Mode button. The appearance of this 
window indicates that you are in rig edit mode: Any changes you make to parameters 
of any object in your project will be recorded as a snapshot.

b.	 Record a snapshot by making changes to objects in your project in the canvas, the 
HUD, or the Inspector.

In this example, any changes you make are applied to the Snapshot 1 pop-up menu 
item.
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c.	 When you finish making changes to parameters, click Stop Rig Edit Mode.

The snapshot is stored and the parameters you modified are added to the Widget 
Inspector, alongside a joystick icon indicating that the parameter is rigged.

d.	 To set additional snapshots, choose an unassigned snapshot in the widget (in this 
example, choose Snapshot 2 from the pop-up menu), then adjust the parameters. To 
add more parameters, repeat steps a, b, and c.

After you add snapshots to a widget, adjusting the widget control (the checkbox, pop-
up menu, or slider) loads a snapshot, changing the state of affected parameters in your 
project.

For information about other methods to create snapshots, see Intro to snapshots and 
Control rigs from Animation menus.

Work with widgets in Motion
A rig has no effect until it contains a widget with assigned snapshots (parameter states). 
Widgets are special controls used to drive parameters in the project.

Widgets are represented in four places in the Motion window: 

•	 In the Layers list, under the parent rig.

•	 In the Rig Inspector. If the rig has multiple widgets, they all appear here.

•	 In the HUD.

•	 In the Widget Inspector.

Widgets can be reordered and renamed. Renaming widgets can be important if you have 
multiple widgets of the same type. Otherwise you see a list of controls that have identical, 
generic names.
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When viewing the Widget Inspector, the controls for the selected widget are displayed.

When viewing the Rig inspector, controls for all widgets in the rig are displayed.

The Widget Inspector and Rig Inspector both display the parameter controls used to 
modify the widget (an Edit Mode button and the parameters you’ve assigned to it). 
However, the HUD displays only the assigned widget control (the checkbox, pop-up menu, 
or slider that toggles or adjusts the widget), not the parameters used to modify the widget.

When a rig is selected, the HUD shows all widget controls assigned to that rig.
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Add a widget and assign a parameter in a single step
As an alternative to creating a widget using the buttons in the Rig Inspector, you can create 
a rig and a widget and then apply a parameter to the widget in a single step.

In Motion, do one of the following:

•	 In the Inspector, click a parameter’s Animation menu (the down arrow that appears 
when you position the pointer over the right side of a parameter row), choose Add To 
Rig, choose a rig, then choose a widget type from the submenu.

•	 Drag a parameter row from any Inspector pane to a rig object in the Layers list.

Dropping the parameter row immediately on the rig object creates a slider widget. 
Pausing briefly causes a drop menu to appear, allowing you to select the widget type 
you want to create. 

A new widget appears in the Layers list, under its parent rig. In the Widget Inspector, the 
parameter you chose appears under the Edit Mode button, ready for snapshot assignment. 
See Create and manage snapshots and Control rigs from Animation menus.

Reorder widgets in a rig
•	 In the Layers list in Motion, drag the widgets into the order you want them to appear.

Rename a widget
By default, each widget is named according to its type (“Checkbox,” for example). 
However, you can assign a custom name to identify the settings the widget will affect.

•	 In Motion, double-click the widget name in the Layers list, enter a new name, then press 
Return.

Widget names cannot be changed in the Rig Inspector or Widget Inspector.

Note: If the widget has been published, the name change does not carry through to 
the published parameter. To synchronize names, rename the widget manually in the 
Publishing pane of the Project Inspector, or unpublish and republish the newly named 
widget.

Move a widget to another rig
If there are multiple rigs in a project, widgets can be moved easily between the 
different rigs.

•	 In the Layers list in Motion, drag the widget you want move onto another rig.
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Delete a widget from a rig
In Motion, select the widget, then do one of the following:

•	 Press Delete.

•	 Choose Edit > Delete.

•	 Control-click the widget, then choose Delete from the shortcut menu.

Widget types

Slider widget in Motion
Slider widgets let you select values interpolated between snapshots. When you drag the 
slider, the affected parameters change gradually, ramping between the values of adjacent 
snapshots. Each snapshot assigned to a slider is represented by a separate snapshot 
tag—a small shaded circle underneath the slider widget.

For information on adding snapshot tags, see the tasks in Create and manage snapshots. 

Clicking a snapshot tag sets the value of the slider to the tag’s value and enables the 
tag’s snapshot for editing. Setting the slider to values between tags causes the rigged 
parameter values to be interpolated between the surrounding snapshot values.

The activation checkboxes in the Rig Inspector and in the Layers list (beside the slider 
widget) have no effect on the constituent parameters of the slider.

Slider widgets contain the following controls in the Rig Inspector and Widget Inspector:

•	 Slider: Use this widget control to move between snapshots. The snapshot tags beneath 
the slider indicate the saved snapshots.



500Motion User Guide

•	 Snapshot tags: The small (unlabeled) shaded circles underneath the slider indicate 
saved snapshots. Double-click below the slider to add snapshot tags. Add as many 
snapshot tags as you want. Snapshot tags work similarly to tags that represent 
individual colors in a gradient. To learn how tags are used when creating gradients, see 
Gradient editor controls.

•	 Edit Mode: Click the Start button to enable snapshot recording. For more information 
about recording snapshots, see Intro to snapshots.

Note: When you record a snapshot (using the Edit Mode button or the methods 
described in Intro to snapshots), the affected parameters (those you modify in the 
Inspector or via onscreen controls in the canvas) are added to the widget. When you 
finish recording a snapshot, new controls for the modified parameters appear in the 
Widget Inspector. These parameters are duplicates of the same parameters that occur 
in other Inspector panes. Parameters controlled by a rig display a special icon (a 
joystick) on the right side of the parameter row in the Inspector.

•	 Range Minimum: Use this parameter (in the Options section) to set the low end of the 
numeric range displayed next to the slider widget. For example, if you want the slider 
widget to range from 0 to 11, set Range Minimum to 0.

•	 Range Maximum: Use this parameter (in the Options section) to set the high end of the 
numeric range displayed next to the slider widget. For example, if you want the slider 
widget to range from 0 to 11, set Range Maximum to 11. If you want the slider widget to 
range from 0 to 100, set Range Maximum to 100. 

Note: Range Minimum and Range Maximum have no effect on the actual parameter 
values that the slider widget controls. Range Minimum and Range Maximum merely 
designate an arbitrary numeric range that’s displayed next to the slider widget.

•	 Interpolation: Use this pop-up menu (in the Options section) to set how values on the 
slider are interpolated. The interpolation applies to the segment of the slider between 
the current snapshot tag and the next one. You can set interpolation methods for each 
segment of the slider. By default, all segments are set to Linear. There are three menu 
options:

•	 Constant: Holds the value of the first snapshot until the slider reaches the next 
snapshot, at which point the parameter changes. (This is similar to changing states 
using a pop-up menu widget.)

•	 Linear: Creates a simple interpolation between states.

•	 Ease: Creates a smooth interpolation, where the effect is weighted towards the 
nearer snapshot tag.
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Pop-up menu widget in Motion
Pop-up menu widgets are similar to checkbox widgets but allow you to save more than two 
parameter states (snapshots). Each item in a pop-up menu widget represents a snapshot. 
When you choose an item in the pop-up menu, the affected parameters in your project 
toggle to a different saved state.

The activation checkboxes in the Rig Inspector and in the Layers list (beside the pop-up 
menu widget) have no effect on the constituent parameters of the pop-up menu.

Pop-up menu widgets contain the following controls in the Rig Inspector and Widget 
Inspector:

•	 Pop-up: Use this widget control to switch between multiple saved snapshots.

•	 Rename: Use this button to enter a custom name for the item in the pop-up menu. See 
Rename a snapshot in a pop-up menu widget. 

•	 Add/Delete: Click the Add button (+) to add an item to the pop-up menu; click the 
Delete button (–) to remove an item. Each item represents a new snapshot.

•	 Edit Mode: Click the Start button to enable snapshot recording. For more information 
about recording snapshots, see Intro to snapshots.

Note: When you record a snapshot (using the Edit Mode button or the methods 
described in Intro to snapshots), the affected parameters (those you modify in the 
Inspector or via onscreen controls in the canvas) are added to the widget. When you 
finish recording a snapshot, new controls for the modified parameters appear in the 
Widget Inspector. These parameters are duplicates of the same parameters that occur 
in other Inspector panes. Parameters controlled by a rig display a special icon (a 
joystick) on the right side of the parameter row in the Inspector.

•	 Initial Value: Use this control (in the Options section) to set the initial value for the pop-
up menu widget when it’s published and used as a template in Final Cut Pro. There are 
three options:

•	 Last Saved: When the template is used in Final Cut Pro, the pop-up menu value 
defaults to the menu item assigned when the project was last saved. This option 
ensures a consistent pop-up menu state, while still permitting users to choose 
alternate states manually. This is the default setting.
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•	 Sequential: Each time the template is used (in a single project) in Final Cut Pro, the 
setting of this pop-up menu changes, cycling through the available menu items. The 
first time the template is used, this pop-up menu defaults to the first menu item. The 
next time the template is used, the pop-up menu is set to the second menu item, 
and so on. For example, in a wipe transition template with a pop-up menu widget 
assigned to control the shape of the wipe, the first time you add the template to the 
Final Cut Pro timeline, the wipe is a star; the next time you apply the template to the 
Final Cut Pro timeline, the wipe is a circle, and so on.

•	 Random: Each time the template is used in Final Cut Pro, another menu item from 
this pop-up menu is assigned by default. For example, in a title template with a pop-
up menu widget assigned to control the title’s font, each successive time the title is 
used in a project, a font is randomly selected from the font list.

Checkbox widget in Motion
Checkbox widgets allow you to switch between two snapshots—that is, between two sets 
of parameter states. Typically, checkbox widgets are used to create an on/off type of 
effect, although you can store any parameter states in either snapshot, creating more of a 
toggle effect.

The activation checkboxes in the Rig Inspector and in the Layers list (beside the checkbox 
widget) have no effect on the constituent parameters of the checkbox.

Checkbox widgets contain the following controls in the Rig Inspector and Widget Inspector:

•	 Checkbox: Use this widget control to switch between two snapshots (parameter states).

•	 Edit Mode: Click the Start button to enable snapshot recording. For more information 
about recording snapshots, see Intro to snapshots.

Note: When you record a snapshot (using the Edit Mode button or the methods 
described in Intro to snapshots), the affected parameters (those you modify in the 
Inspector or via onscreen controls in the canvas) are added to the widget. When you 
finish recording a snapshot, new controls for the modified parameters appear in the 
Widget Inspector. These parameters are duplicates of the same parameters that occur 
in other Inspector panes. Parameters controlled by a rig display a special icon (a 
joystick) on the right side of the parameter row in the Inspector.
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Manage parameter snapshots

Intro to snapshots in Motion
When you click the Edit Mode Start button in the Widget Inspector or Rig Inspector, Motion 
begins recording parameter changes you make (including parameters you animate). Also, a 
window appears containing a Stop Rig Edit Mode button.

The parameter changes you make while in rig edit mode are stored in the current snapshot 
(the item selected in the widget checkbox, pop-up menu, or slider). Other snapshots in 
the rig are unaffected. After you stop rig edit mode, any parameter you modified (in the 
canvas, or in the HUD or Inspector) is added to the Widget Inspector, and its state is saved 
in the snapshot.

Only one snapshot can be modified per edit mode session. To edit more than one 
snapshot, end the editing session, select another snapshot (by clicking another snapshot 
tag for a slider, by choosing a new menu item for a pop-up menu, or by changing the state 
of a checkbox), then start a new edit mode session.

Parameters affected by a rig display a joystick icon on the right side of the parameter row.
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Any parameter controlled by a rig is added to the Widget Inspector, below the Edit Mode 
Start button and above the Options parameters.

Note: Each parameter can be controlled by only one widget. After a parameter is assigned 
to a widget, you cannot assign that parameter to additional widgets.

You can add parameters to a widget after a snapshot is created by clicking the Start Rig 
Edit Mode button again and making changes to new parameters (see Create and manage 
snapshots) or by manually adding parameters to the widget (see Control rigs from 
Animation menus).

Important: After a parameter is added to a widget, changes made to that parameter modify 
the selected snapshot even if Rig Edit Mode is stopped, and even if the Widget Inspector is 
not visible.

How snapshots are saved in Motion
Snapshots are saved in the widget. Any parameter affected by a snapshot is persistently 
displayed in the widget (even if that parameter is unmodified by the current snapshot 
setting). Parameter controls in widgets are duplicates of the parameter controls they’re 
linked to.

•	 For slider widgets, you must select a snapshot tag before enabling Edit Rig Mode.

•	 For pop-up menu widgets, there are as many snapshots as there are menu items. Add 
menu items by clicking the Add button (+) to the right of the pop-up menu in the Widget 
Inspector. Making changes to the parameters affects the selected pop-up menu item.

•	 For checkbox widgets, there are two snapshots: one for the selected state and one for 
the deselected state. Making changes to the linked parameters affects the snapshot for 
the current state of the checkbox.
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After parameters are added to the widget, they can be modified only when a specific 
snapshot tag is selected. If a slider widget is set between two tags, you cannot modify 
parameters. 

Create and manage snapshots in Motion
You can record and modify snapshots using the controls in the Rig Inspector or Widget 
Inspector.

Record a snapshot
1.	 In Motion, select a rig or widget in the Layers list.

For information about creating rigs and widgets, see Build a simple rig.

2.	 In the Rig Inspector or Widget Inspector, choose a snapshot state from the widget 
control you want to record to:

•	 Slider widget: Select a snapshot tag (one of the gray shaded circles under the slider) 
to record to. To create a new snapshot tag, double-click an empty area below the 
slider. When selected, the snapshot tag is highlighted blue. 

•	 Pop-up menu widget: Click the pop-up menu, then choose an item (Snapshot 1, 
Snapshot 2, or Snapshot 3) to record to.

•	 Checkbox widget: To record to the selected state, select the checkbox. To record to 
the deselected state, deselect the checkbox.

3.	 Click the Edit Mode Start button under the widget control you prepared in step 2.

A window appears containing a Stop Rig Edit Mode button. The appearance of this 
window indicates that changes you make to parameters will be recorded.

4.	 Make changes to one or more parameters of one or more objects in your project using 
the onscreen controls in the canvas or the numeric controls in the HUD or Inspector.

Each adjustment you make is recorded to the snapshot setting selected in the widget 
(the checkbox, pop-up menu item, or slider position).
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5.	 After you set the parameters to the desired snapshot state, click the Stop Rig Edit Mode 
button.

Recording is stopped, and the snapshot is stored to the widget. Modified parameters 
are added to the Rig Inspector and Widget Inspector (under the Edit Mode Start button) 
alongside a joystick icon indicating that the parameter is rigged.

6.	 To set additional snapshots, choose an unassigned snapshot in the widget, then adjust 
the parameters. To add more parameters, repeat steps 2–5.

Add a snapshot tag to a slider widget
By default there are two recordable snapshot settings in a slider widget, represented by 
snapshot tags: shaded gray circles under the slider, and at either end. When you record 
snapshots to these two tags, values along the slider between the two tags are interpolated; 
in other words, when you drag the slider, the affected parameters change gradually, 
ramping between the values of adjacent snapshots.
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You can add additional snapshot tags to the slider widget to create more complex ranges 
of parameter change.

1.	 In Motion, select a rig or widget in the Layers list.

For information about creating rigs and widgets, see Build a simple rig.

2.	 In the Rig Inspector or Widget Inspector, double-click an empty area below a slider 
widget.

A new snapshot tag appears under the slider. Parameters at this position inherit their 
values based on the interpolation point between the two snapshot tags adjacent to the 
new snapshot tags. You can reorder snapshot tags by dragging them left or right under 
the slider.

To record new or additional parameter values for a snapshot tag, see “Record a 
snapshot” above.

Change the value of a snapshot tag
You can quickly change the value of a snapshot tag without entering Rig Edit Mode.

Do one of the following:

•	 Click a slider widget tag, then enter a number in the value slider.

•	 Double-click a slider widget tag, then enter a number in the value field.

Delete a snapshot tag from a slider widget
•	 In Motion, drag the tag away from the area under the slider.

Rename a snapshot in a pop-up menu widget
By default the snapshot settings in a pop-up menu widget are named Snapshot 1, Snapshot 
2, and Snapshot 3. You can give them more descriptive names using the Rename button.

1.	 Select a rig or widget in the Layers list in Motion.

For information about creating rigs and widgets, see Build a simple rig.

2.	 In the Rig Inspector or Widget Inspector, choose an item from the pop-up menu 
(Snapshot 1, Snapshot 2, or Snapshot 3), then click the Rename button.

3.	 Enter a new name in the highlighted field, then press Return.

The menu item updates to the new name.

4.	 Repeat steps 2 and 3 to rename additional pop-up menu items.
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Add snapshot items to a pop-up menu widget
By default, the pop-up menu widget contains three menu items (Snapshot 1, Snapshot 2, 
and Snapshot 3). You can add or remove menu items using the Add or Delete button.

1.	 Select a rig or widget in the Layers list in Motion.

For information about creating rigs and widgets, see Build a simple rig.

2.	 In the Rig Inspector or Widget Inspector, choose an item from the pop-up menu, then 
do one of the following:

•	 Add a menu item: Click the Add button (+) to the right of the pop-up menu, enter a 
name for the new item in the highlighted field, then press Return.

New snapshots are added below the currently selected snapshot.

•	 Remove a menu item: Click the Delete button (–) to the right of the pop-up menu.

Control rigs from Animation menus in Motion
Using the Animation menu, you can create or modify a rig while you’re modifying specific 
parameters in your project. 

Add a parameter to a rig
•	 In the Inspector in Motion, click the Animation menu for the parameter (the down arrow 

that appears when you place the pointer over the right side of a parameter row), choose 
Add to Rig > Rig, then choose a rig and a specific widget from the submenus.

The parameter is added to the selected widget in the rig.

Note: You can also create a rig via this submenu.
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Remove a parameter from a widget
•	 In the Inspector in Motion, click the Animation menu (the down arrow that appears 

when you place the pointer over the right side of a parameter row) of the parameter to 
remove, then choose Remove from Widget [name of widget].

The parameter is removed from the widget.

Note: Parameters can be removed from a widget in the parameter list in the Widget 
Inspector or in the Inspector containing the original parameter.

Reveal the widget driving a parameter
•	 In the Inspector in Motion, click the Animation menu (the down arrow that appears when 

you place the pointer over the right side of a parameter row) for the parameter, then 
choose Reveal Widget [name of widget].

The Inspector displays the Widget pane.

Reveal the original parameter used in a widget
•	 In the Widget inspector (not the Rig Inspector) in Motion, click the Animation menu (the 

down arrow that appears when you place the pointer over the right side of a parameter 
row) for the parameter, then choose Reveal Target Parameter.

The Inspector containing the original parameter is opened and the parameter briefly 
blinks yellow.

Note: The Reveal Target Parameter command can be especially helpful when a widget 
is driving multiple similarly named parameters from different objects. This command 
allows you to identify the parent object. 

How to use rigs

How to use a single rig in Motion
Although rigs are often used to build global controls for use in Final Cut Pro templates, 
they’re also useful in Motion, to simplify the control set of a complex project. Instead of 
making changes by manipulating individual parameters in various Inspectors, you can 
modify the Motion project using just a few widgets in a single rig.

You can make changes to a Motion project by adjusting widgets in the Rig Inspector, in the 
Widget Inspector, or in the Rig HUD. However, it may be easiest to adjust widgets in the Rig 
HUD, which displays only the widgets you’ve created (and none of the additional controls 
used to create and customize widget settings).
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A rig is especially helpful when you need to share a complex project with multiple users 
or when the project is designed to be updated each time it’s used. For example, you can 
create a basic project for an animated lower-third title that incorporates two text objects 
and a background replicator.

Each time the project is used, the size and position of the lower third (a replicator in this 
example) must change to match the length of the text, and the color must cycle through 
your project’s color scheme. By adding a rig to the project, you can create a small set of 
controls that modify only the parameters such changes require.

As an alternative to adjusting widgets in the Rig HUD, you can publish the widgets, then 
adjust them in the Project Inspector. (Open the Project Inspector by selecting the Project 
object at the top of the Layers list.) For more information about publishing, see Publish rigs 
to Final Cut Pro.

You can even apply keyframes to a slider widget to create dynamic animated effects 
based on saved snapshots in the slider. (Pop-up menu and checkbox widgets cannot be 
keyframed, nor can they accept behaviors. See Widget animation.)
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How to use multiple rigs in Motion
You can create multiple rigs in a single project to better organize related widgets. Likewise, 
you can group each rig in the Layers list with the object or objects it affects. That way you 
can quickly navigate to the relevant rig to control the specific, related parameters.

You can also use one widget to control another. Treat the widget as you would another 
parameter control when manipulating a snapshot for a widget.

Note: You cannot create recursively controlled widgets. That is, you cannot use one widget 
to drive a second widget that’s already driving the first.

Widget animation in Motion
When a Motion project contains a rig with a slider widget, you can use keyframes to 
animate the parameters modified by the slider (using the same keyframing method you use 
for unrigged parameters). Keyframing a slider widget lets you create powerful and complex 
effects where multiple parameters driven by a single widget are animated simultaneously. 
In rig edit mode, you can also apply Parameter behaviors to a rigged object.

Note: Pop-up menu widgets and checkbox widgets cannot be keyframed, nor can they 
accept behaviors.

For more information about animating with keyframes, see Intro to keyframing.
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Publish rigs from Motion to Final Cut Pro
Rigging is especially useful in Final Cut Pro templates, allowing users to modify a complex 
group of parameters with a small set of controls, or limiting user control to ensure that 
junior compositors, editors, and others in the production pipeline adhere to established 
specs and client needs. After you add widgets (sliders, pop-up menus, and checkboxes) 
to a rig in a Final Cut Pro template in Motion, you must choose which widgets you want 
to publish. When you save the template, its published widgets become available in 
Final Cut Pro.

Publish a widget to Final Cut Pro
•	 In the Rig or Widget Inspector in Motion, Control-click the name of the parameter to 

publish, then choose Publish from the shortcut menu.

Note: The template must be saved for its published parameter controls to be available in 
Final Cut Pro.

View published parameters in Motion
You can review the parameters set to be published in your template by opening the Project 
Inspector.

1.	 In Motion, click the Project object at the top of the Layers list.

2.	 In the Project Inspector, open the Publishing pane.

The Publishing pane displays all published parameters, including widgets. When saved 
in a template, published parameters also appear in the inspector in Final Cut Pro. For 
more information about publishing, see Adding controls to templates.
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Create particles

Intro to particles in Motion
Particle systems let you create sophisticated effects involving large numbers of 
automatically animated objects.

You can add a premade particle system to your composition from the Library, or you can 
create your own custom particle effects using nearly any image layer or group in your 
project, including still images, shapes, text, and movies.

Particle systems consist of two basic elements:

•	 Particle emitter: A special type of effect applied to a layer, causing the layer to multiply 
and animate according to the parameters you set in the Inspector.

•	 Particle cell: The image layer that’s multiplied and animated by the particle emitter.

The emitter and cells have separate sets of parameters that control the particle system’s 
behavior. If you imagine that a garden hose is a particle system, the nozzle acts as the 
emitter, while the water represents the flow of particles. Changing the parameters of the 
emitter changes the shape from which the particles are emitted as well as their direction. 
Changing the cell’s parameters affects each particle.
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Each particle created in the canvas is essentially a duplicate of the cell, and is animated 
according to the parameters of that particle system over its lifetime.

The layer you use as a particle system’s cell determines the appearance of that particle 
system. Particle systems can contain multiple cells (image layers), resulting in the release 
of several types of particles from a single emitter. Many of the most sophisticated particle 
presets in the Particle Emitters library are constructed in this way.
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Add a particle system to a project

Add a particle system in Motion
There are two basic ways to add a particle system to a Motion project: 

•	 Choose a preset from the Particle Emitters category of the Library.

•	 Create a custom particle system using your own image, video clip, shape, or text. You 
can also use multiple images as source cells for a single particle system.

Note: For an example of working with a particle system in a 360° project, see Example: 
Integrate particles into a 360° project.

Add a preset particle system from the Library
The easiest way to add a particle system to your project is to use a preset in the Particle 
Emitters category of the Library. There are many types of particle effects to choose from. 
If you find one close to what you need, you can easily customize its parameters after you 
add it to your project. Particle systems are added to a project exactly like any other object 
in Motion.
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1.	 In the Library in Motion, select the Particle Emitters category, then select a 
subcategory, such as Nature, Pyro, SciFi, and so on.

2.	 In the Library stack under the categories and subcategories, select a particle preset.

An animated preview of the selected particle emitter plays in the Library preview area.

3.	 Do one of the following:

•	 Click Apply in the preview area to add the selected particle system to the center of 
the canvas.

Note: If Create Layers At is set to “Start of project” in the Project pane of Motion 
Settings, the particle system is added at the first frame. See If it’s your first import.

•	 Drag the particle system from the Library stack into the canvas to the position where 
you want it to appear.

•	 Drag the particle system from the Library stack into a group in the Layers list or 
Timeline layers list.

•	 Drag the particle system from the Library stack to the track area of the Timeline or 
mini-Timeline; when you reach the frame where you want the new particles to start, 
release the mouse button.

The new particle emitter layer appears in the Layers list and in the canvas, composited 
against any other layers you’ve already added. 

When you add a particle system from the Library, the system acts as it did in the preview 
area. If necessary, modify the particle system parameters in the HUD or Inspector. You can 
modify a particle system only after it’s added to a project.

Note: Some emitters look best when motion blur is enabled. Preset Library emitters that 
benefit from motion blur include Jelly Bands, Light Transit, Rain Streaks, and Silly String. 
To enable motion blur, choose Motion Blur from the Render pop-up menu (above the 
canvas), or choose View > Render Options > Motion Blur.
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Create a custom particle system
To create a custom particle system, you must select a layer in your project to use as the 
source for a cell in a new particle emitter. You can use any layer in your project as a cell 
source, including still images, video clips, text, or shapes created in Motion. The layer you 
select when you create an emitter becomes the first cell in that particle system. The cell 
specifies the look of the particles generated in the canvas.

Note: You can also use a group as the source for an emitter cell, but your computer’s 
processing performance may slow drastically.

1.	 In Motion, create an image layer to serve as the cell source for the particles that your 
emitter will generate.

This example uses an image of a simple white circular gradient, such as the “basic blur” 
image located in the Library (in Content > Particle Images).

2.	 Move the object in the canvas to the location where you want the center of your particle 
system to be.

3.	 With the object selected, do one of the following:

•	 In the toolbar, click the Make Particles button.

•	 Press E.

The new custom particle emitter layer appears in the Layers list and in the canvas, 
composited against any other layers you’ve already added. If necessary, modify the 
particle system parameters in the HUD or Inspector. 
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Create complex particles using multiple source layers
You can add as many cells as you want in a single emitter, creating complex compositions 
with different overlapping particles.

1.	 Add one or more image layers to your Motion project.

2.	 In the Layers list, select the layers to use as the particle cells, then do one of the 
following:

•	 In the toolbar, click the Make Particles button.

•	 Press E.

A new particle emitter layer appears in the Layers list and in the canvas. The 
emitter’s cells (the image layers you selected in the previous step) appear in Layers 
list under the emitter object.

3.	 To create additional cells for the emitter, drag layers in the Layers list onto an existing 
emitter.

Note: An item dragged from the Library to an emitter is not added to the emitter; 
instead, it’s added as a layer in a new group.

The layers you drag are copied to the particle system, appearing as new source cells 
in the Layers list (under the emitter) and in the canvas as part of the complex particle 
system. The original layers remain as standalone items in the project. To hide an original 
layer in the canvas, deselect its activation checkbox in the Layers list. (However, note 
that if you delete an original layer, its source cell is deleted from the particle system.)

When you play the project, each source cell generates particles simultaneously, according 
to each source cell’s parameters. When selected in the Layers list, each cell displays its 
own Particle Cell Inspector.

Note: When multiple sources are used to create a particle system, the resulting emitter is 
positioned in the canvas at the average of the sources’ positions.

Optimize particle system resolution to improve playback performance
Particle systems often create particles that grow or move off the canvas before they “die.” 
This can make the size of a layer or group much larger than the dimensions of the canvas. 
Although the particles are not visible after they move off the canvas (unless Show Full View 
Area is enabled in the View menu), they’re still present in the project and are processed. 
You can improve playback performance by constraining the resolution (height and width) of 
the group containing the particle emitter.

Note: Using a movie with applied filters as a particle cell source adversely impacts your 
computer’s processing performance. For better performance, export your sequence with 
the filter applied, then import it back into Motion and use the movie as the cell source.

1.	 In the Layers list in Motion, select a group that contains a particle emitter.

2.	 In the Group Inspector, select the Fixed Resolution checkbox.

See Constrain group size.
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Anatomy of a particle emitter in Motion
After you add a particle emitter to a project, the following occurs:

•	 An emitter appears in the Layers list and is selected.

•	 A cell containing the image or images to be “particle-ized” appears as a sublayer 
underneath the emitter (click the disclosure triangle beside the emitter layer to hide or 
reveal its cells).

•	 The original source layer (the cell source) is disabled.

Note: Changes made to the original source layer, such as opacity or shearing, are also 
applied to the particles even after the emitter is created.

•	 In the canvas, a bounding box with transform handles appears around the selected 
particle system.

Note: For projects with a frame rate greater than 30 frames per second (fps), you may 
see only the bounding box (not the first particle) at the first frame of your project. 
Because Motion generates particles at a default rate of 30 per second, there’s no 
guarantee that a particle will appear on every frame.

•	 The first particle appears in the canvas in the same location as the original (now-
disabled) source layer. 

•	 The Emitter HUD appears. If you’ve hidden the HUD, press F7 to show it.

•	 The Emitter Inspector becomes available.
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By default, the first frame of a new particle system (with a single cell) has one particle. If 
you play your project (press the Space bar), additional particles are generated and emerge 
from the center of the emitter.

By default, new cells emit one particle per frame in all directions (for 30-fps projects), 
and each particle moves 100 pixels per second away from the emitter over a lifetime of 5 
seconds (150 frames in a 30-fps project).

Note: Use the Initial Number control in the Particle Cell Inspector to change the default 
behavior so a particle system begins with a burst of particles at the first frame. See Emitter 
controls.
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Adjust a particle system

Modify basic particle attributes in Motion
You can make basic adjustments to a particle system by replacing its source image, 
adjusting cell opacity, removing unwanted cells, changing the emitter’s size or position in 
the canvas, or removing the entire emitter.

Replace a preset emitter’s cell source image
After you add a preset emitter to your project, you can customize it by replacing its source 
image.

1.	 Locate the file you want to use as the replacement graphic and add it to your Motion 
project.

2.	 Do one of the following:

•	 In the Layers list, drag the new layer to the emitter cell source you want to replace.

•	 In the Emitter or Particle Cell Inspector, drag the new layer to the Particle Source 
well of the emitter cell you want to replace.

Note: If the cell layer is not visible, click the disclosure triangle next to the emitter.

3.	 When the pointer becomes a curved arrow, release the mouse button.

The original cell source image is replaced with the new layer.

4.	 Optional: Hide the source layer you imported by deselecting its activation checkbox in 
the Layers list. 

The cells based on this layer remain in your particle system, but the static cell source 
layer is hidden in the canvas.

Adjust an emitter’s cell opacity
Adjust the opacity of individual cells in a particle system by modifying the cell parameters 
in the Particle Cell Inspector or by modifying the cell source layer’s opacity in the 
Properties Inspector.

In Motion, do one of the following:

•	 Select a cell in the Layers list, then adjust the Opacity tag in the gradient editor in 
the Particle Cell Inspector (or change Color Mode to Colorize and adjust the Opacity 
parameter in the Color controls). For information about adjusting opacity and color, see 
Change gradient color and opacity.

•	 Select the original, deselected cell source layer—not the cell in the emitter—and 
change its opacity in the HUD or Properties Inspector.
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Adjust an emitter’s size or position using onscreen controls
You can modify the size and position of particle emitters in the canvas using onscreen 
transform controls.

1.	 In the Layers list in Motion, select the particle emitter to adjust.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Adjust Item. 

When the Adjust Item tool is selected, emitter onscreen controls appear in the canvas. 
These controls vary depending upon the shape of the emitter (chosen from the Shape 
pop-up menu in the Emitter Inspector).

3.	 Resize the emitter in the canvas by dragging the emitter shape’s outline, or one of its 
corner points, or (for a Line emitter shape) one of the plus signs (+) on either end of the 
line.

4.	 Reposition the emitter in the canvas by dragging inside the emitter shape (but not 
directly on the outline).

Remove a cell from an emitter
You can remove a cell from an emitter that contains multiple cells.

•	 In the Layers list in Motion, select the cell to remove, then press Delete.

The original source layers remain in the project (in the Layers list).

Remove an emitter from a project
•	 In the Layers list in Motion, select the particle emitter, then press Delete.

The emitter and its cells are removed from the project, but the original source layers 
remain in the project.
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Modify particle system parameters in the HUD

Adjust particles from the HUD in Motion

When you create an emitter, the particle system begins working according to the default 
parameters in its Emitter Inspector and Particle Cell Inspector. You can modify the most 
important of these parameters in the Emitter HUD. 

Display an Emitter HUD
•	 In Motion, select the emitter in the Layers list, Timeline, or canvas.

The Emitter HUD appears. (If it does not appear, click the HUD button in the toolbar or 
press F7.)

Adjust parameters for a 2D emitter in the Emitter HUD
In the Emitter HUD in Motion, do any of the following:

•	 Drag a slider:

•	 Birth Rate: Sets how many particles are created every second.

•	 Life: Sets how long each particle remains onscreen (in seconds) before disappearing 
from existence.

•	 Scale: Sets the size of each particle, relative to the original size of the cell.

•	 Emission Range: Sets the angle at which particles are emitted.

•	 Drag in the graphical emission control to modify several parameters simultaneously: 
Emission Range, Emission Angle, and Emission Speed. See Emitter HUD controls.
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Adjust parameters for a 3D emitter in the Emitter HUD
When the 3D checkbox in the Emitter Inspector is selected, the Emitter HUD offers 
additional 3D controls for manipulating the emitter in 3D space. 

In the Emitter HUD in Motion, do any of the following:

•	 Drag any of the following sliders:

•	 Birth Rate: Sets how many particles are created every second.

•	 Life: Sets how long each particle remains onscreen (in seconds) before disappearing 
from existence.

•	 Scale: Sets the size of each particle, relative to the original size of the cell.

•	 Emission Range: Sets the angle at which particles are emitted.

•	 Drag in the graphical emission control to modify the Emission Latitude and Emission 
Longitude parameters. See Emitter HUD controls.

Transform an emitter in 3D space via the HUD
When you select a 2D or 3D particle emitter in the Layers list and then click the 3D 
Transform tool (in the canvas toolbar), the Emitter HUD expands to display additional 
controls that allow you to transform the emitter in X, Y, and Z space:

1.	 In Motion, with an emitter selected in the Layers list, click the 3D transform tool in the 
canvas toolbar.

2.	 In the Emitter HUD, drag in any of the control squares to move, rotate, or scale the 
emitter in 3D space.
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These controls are available in both 2D emitters and 3D emitters. 

For more information on using the 3D transform controls in the HUD, see Transform 
layers in 3D space.

For particle systems containing multiple cells, the Emitter HUD parameters simultaneously 
modify the effect of each cell’s parameters relative to one another. This means that for a 
particle system consisting of two cells with different scale values, changing the scale in 
the HUD resizes both cells simultaneously. For example, increasing the scale in the HUD 
by 200% does not change the scale of both cells to 200%, but resizes the cells relative to 
their original scale values.

For this reason, in emitters with multiple cells, the HUD parameters are displayed as 
percentages. When you modify the parameters of a single cell, the cell parameters are 
adjusted directly.
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Emitter HUD controls in Motion

Adjust an emitter using the controls in the Emitter HUD:

•	 Birth Rate: A slider that defines how many particles are created every second.

•	 Life: A slider that defines how long each particle remains onscreen (in seconds) before 
disappearing from existence.

•	 Scale: A slider that defines the size of each particle, relative to the original size of the cell.

•	 Emission Range: A slider that defines the angle at which particles are emitted.

•	 Emission control (not labeled): A circular graphical control that lets you modify several 
parameters simultaneously, described below:

•	 Emission Range (2D only): Drag the two points on the outer ring of the graphical 
emission control to define the range of degrees at which particles are generated. In 
other words, the Emission Range parameter defines the size of the “slice” of the pie 
graph that the particles fill when generated. This graphical control adjusts the same 
parameter as the Emission Range slider.

•	 Emission Angle (2D only): Drag the blue arrows clockwise or counterclockwise to 
change the direction in which particles are emitted (within the angle defined by the 
Emission Range control).

•	 Emission Speed (2D only): Drag the blue arrows outward or inward to define how 
quickly particles move away from the emitter.

Use the following modifier keys to more precisely manipulate the graphical emission 
control in the HUD:

•	 Shift (while adjusting Emission Angle): Restricts angles to 45-degree increments.

•	 Shift (while adjusting Emission Range): When working with a 2D emitter, restricts 
to 22.5-degree increments.

•	 Command: When working with a 2D emitter, adjusts Emission Angle only.

•	 Option: When working with a 2D emitter, adjusts Emission Speed only.

•	 Emission Latitude/Emission Longitude control (3D only): When using a 3D particle 
emitter (when the 3D checkbox is selected in the Emitter Inspector), the spherical 
emission control of the HUD lets you modify the Emission Latitude and Emission 
Longitude parameters.

Drag the sphere in the center of the circle to modify the emission direction (in 
degrees latitude and longitude) of the particles. You can also enter specific values in 
the Emitter Inspector.



527Motion User Guide

Drag the Emission Range slider (above the sphere) to define the range of degrees 
at which particles are generated. In other words, this control defines the size of the 
cone that the particles fill when generated in 3D space.

Modify particle system parameters in the Inspector

Adjust particles from the Inspector in Motion

Particle emitter parameters and particle cell parameters, though closely related, serve 
different purposes:

•	 Particle emitter parameters control the overall shape and direction of the animated 
mass of particles. Other emitter parameters simultaneously modify the parameters of all 
cells inside that emitter. You can adjust emitter parameters in the Emitter Inspector.

•	 Particle cell parameters control the behavior of particles after they’re generated by the 
emitter. You can adjust cell parameters in the Particle Cell Inspector.

Adjust a particle emitter in the Emitter Inspector
1.	 In Motion, select an emitter object in the Layers list.

2.	 In the Inspector, click Emitter.

3.	 Adjust the emitter controls.

The controls of the Emitter Inspector are dynamic—different parameters appear 
depending on the number of cells in the particle system, the emitter shape that’s used, 
and whether the 3D checkbox is selected or deselected.

For a complete list of these controls, see Emitter controls.

Adjust a particle cell in the Particle Cell Inspector
1.	 In Motion, select any cell in an emitter in the Layers list.

2.	 In the Inspector, click Particle Cell (if the pane is not already displayed).

3.	 Adjust the cell controls.

For a complete list of these controls, see Particle cell controls.
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Single-cell vs. multi-cell controls in Motion

If a particle system has only one cell, the Emitter Inspector displays both the Emitter 
Controls and the Cell Controls. In this case, you can control every aspect of the particle 
system from a single Inspector.

However, when a particle system has two or more cells, the Emitter Inspector replaces 
individual cell controls with a group of Global Controls, which are located below the Emitter 
Controls and are hidden by default. (The Cell Controls are still available in the Particle Cell 
Inspector.)

Changes made using the global controls modify the effect of each cell’s parameters 
relative to the other cells in the system. For example, in a particle system with three cells 
that have different Scale values, increasing the Scale parameter in the Emitter Inspector 
multiplies the Scale value of all three cells by the same percentage. This has the result of 
increasing or reducing the size of every particle in the system, while keeping the size of 
each particle relative to one another the same. For this reason, the global control values of 
multi-cell particle systems appear as percentages.
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Emitter controls in Motion

The parameters in the Emitter Controls section of the Emitter Inspector determine how 
particles are distributed and rendered in your project.

Several of these controls are identical to those found in the Emitter HUD, with one 
difference: Although the emission control in the Emitter HUD lets you manipulate the 
Range, Angle, Latitude (3D), Longitude (3D), and Speed parameters using a single 
graphical control, the Emitter Inspector uses individual numeric controls for each 
parameter.

Note: The settings for emitters in the Properties Inspector and Emitter Inspector can be 
keyframed to change values over time. However, there’s no way to control the animation of 
individual particles.

Some parameters in the Emitter Inspector depend on the settings of other parameters. All 
combinations of parameters are described below:

•	 Shape: A pop-up menu to set the overall shape of the emitter. Different shapes 
significantly alter the distribution of generated particles. When you choose an emitter 
shape, different Emitter Inspector parameters appear that are unique to that shape. 
For example, when Rectangle is the selected shape, Outline, Tile Fill, and Random Fill 
become available in the Arrangement options.

The Shape pop-up menu contains the following items:

•	 Point: The default shape for new emitters, specifies a single point of emission for a 
particle system.
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•	 Line: Particles emerge from a line. Using the onscreen controls (with the Adjust Item 
tool selected in the canvas toolbar) or controls in the Properties Inspector, you can 
specify the length and location of the line. In the Inspector, you can set a specific 
number of points where particles emerge. This emitter shape is useful for creating 
sheets of particles that cascade over a wide area.

•	 Rectangle: Particles emerge from a rectangle along its edge, or in a tile-fill or 
random-fill pattern. Using the onscreen controls (with the Adjust Item tool selected 
in the canvas toolbar), you can specify the size and location of the rectangle: 
Drag the corners to adjust width and height; drag edges to adjust width or height 
independently. Choose different rectangle patterns using the Arrangement 
parameter (described below). In the following image, the Arrangement parameter is 
set to Outline.

Use modifier keys to more precisely manipulate the corners of the Rectangle 
onscreen controls (with the Adjust Item tool selected in the canvas toolbar):

•	 Option: Adjustments to size are scaled uniformly, with the anchor point remaining 
fixed.

•	 Shift: Adjustments to size are made proportionally.
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•	 Circle: Particles emerge from a circle-shaped emitter. Depending on the setting 
you choose in the Arrangement parameter (described below) particles emerge in an 
outline, tile-fill, or random-fill pattern. Using the onscreen controls (with the Adjust 
Item tool selected in the canvas toolbar), you can specify the size and location of the 
circle. In the following image, the shape’s Arrangement parameter is set to Outline.

•	 Burst: Particles emerge from a burst pattern. Using the onscreen controls (with 
the Adjust Item tool selected in the canvas toolbar), you can specify the size and 
location of the burst.

•	 Spiral: Particles emerge from a spiral pattern. Using the onscreen controls (with 
the Adjust Item tool selected in the canvas toolbar), you can specify the size and 
location of the spiral.
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•	 Wave: Particles emerge from a waveform. Using the onscreen controls (with the 
Adjust Item tool selected in the canvas toolbar) or the Start Point and End Point 
controls in the Emitter Inspector, you can specify the length and location of the 
wave.

•	 Geometry: Particles emerge from the edge of a shape, defined by a spline object 
used as the shape source. The following image on the right shows the shape used as 
the emitter source. The image on the left shows particles emerging from the edge of 
the shape source.

To apply a shape as the geometry shape source for a particle emitter, drag the shape 
to the Shape Source well in the Emitter Inspector (when the Shape pop-up menu is 
set to Geometry).
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•	 Image: Particles emerge from within an area defined by an image or from only the 
edges of the image. The image may or may not have an alpha channel. If it does, 
the shape of the alpha channel can also be used to define the emitter shape. The 
following image on the right shows the image used as the emitter image source; the 
image on the left shows the particles emerging from within the image.

To apply an image as the image source for a particle emitter, drag the image to the 
Image Source well in the Emitter Inspector (when the Shape pop-up menu is set to 
Image).

•	 Box: This option is available when the 3D checkbox (described below) is selected 
in the Emitter Inspector. Particles are emitted from a three-dimensional cube along 
its surface (Outline), or in a tile-fill or random-fill pattern (set in the Arrangement 
pop-up menu, described below). Using the onscreen controls (with the Adjust Item 
tool selected in the canvas toolbar), you can specify the size and location of the 
rectangle. Drag the front horizontal edge to adjust height; drag the front vertical 
edge to adjust width; drag a back edge to adjust depth; drag a front corner to adjust 
the width and height simultaneously. To reposition the emitter, drag inside the shape 
(but not on an edge or corner point). The following image shows a Box shape with 
Arrangement set to Tile Fill.
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•	 Sphere: This option is available when the 3D checkbox (described below) is selected 
in the Emitter Inspector. Particles are emitted from a three-dimensional sphere along 
its surface (Outline), or in a tile-fill or random-fill pattern (set in the Arrangement 
pop-up menu, described below). Using the onscreen controls (with the Adjust Item 
tool selected in the canvas toolbar), you can specify the radius and location of the 
sphere. Drag the outline of the sphere to adjust its radius; drag inside the sphere to 
reposition it in the canvas.

•	 Arrangement: A pop-up menu (available when the Shape pop-up menu is set to 
Rectangle, Circle, Image, Box, or Sphere) to specify the pattern used to generate 
particles. There are three menu options:

•	 Outline: Emits particles along the edge of the shape in 2D emitters and along the 
surface of the shape in 3D emitters.

•	 Tile Fill: Emits particles from a tiled pattern of rows, columns, and ranks (for 3D 
emitters) in the circle, rectangle, image, box, or sphere. You can specify the number 
of columns, rows, and ranks, as well as the tile offset.

•	 Random Fill: Emits particles randomly from within the circle, rectangle, image, box, 
or sphere.

•	 Size/Radius: A slider (available when the Shape pop-up menu is set to Rectangle or 
Box) to set the size of the rectangle or cube from which particles are emitted. When 
Rectangle is the selected shape, the Width and Height controls become available. When 
Box is the selected shape, an additional Depth control becomes available. When Circle 
is the selected shape, this parameter becomes Radius.

Note: Height is measured in project pixels, and Width is measured in square pixels, to 
ensure that a numerically square shape will look square when Correct for Aspect Ratio 
is enabled in the View pop-up menu in the top-right corner of the canvas.

•	 Columns: A slider available when Shape is set to Rectangle, Circle, Image, Box, or 
Sphere, and Arrangement is set to Tile Fill. Sets the number of horizontal emitter 
points on a grid over the selected emitter shape. In the case of an irregular shape 
(nonrectangular), grid points that fall outside of the shape are ignored.

•	 Rows: A slider available when Shape is set to Rectangle, Circle, Image, Box, or Sphere, 
and Arrangement is set to Tile Fill. Sets the number of vertical emitter points on a grid 
over the selected emitter shape. In the case of an irregular shape (nonrectangular), grid 
points that fall outside of the shape are ignored.

•	 Ranks: A slider (available when Shape is set to Box or Sphere, and Arrangement is set to 
Tile Fill) to set the number of points in Z space on a grid over the selected shape from 
which particles are emitted.

•	 Tile Offset: A slider available when Shape is set to Rectangle, Circle, Image, Box, or 
Sphere, and Arrangement is set to Tile Fill. Values from 0 to 100% offset the rows 
toward the right, and values from 0 to –100% offset the rows toward the left. A value of 
50 or –50% creates a “brickwork” pattern.

•	 Image Source: An image well (available when Shape is set to Image) to specify the 
object used to define the shape of the emitter. 

•	 Shape Source: An image well (available when Shape is set to Geometry) to specify a 
spline object used to define the shape of the emitter.
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•	 Emission Alpha Cutoff: A slider available when Shape is set to Image. When the Image 
Source object contains an alpha channel, this slider defines the minimum opacity value 
necessary to create particles at that point on the source image. For example, when 
Emission Alpha Cutoff is set to 25%, particles appear only where the alpha value of 
the image is equal to or greater than 25% opacity. The lower the Emission Alpha Cutoff 
value, the more particles appear. For this parameter to be effective, the alpha channel 
must have areas of varying transparency.

•	 Start Point: Value sliders (available when the Shape pop-up menu is set to Line or 
Wave) to define, in X and Y coordinates, the first point of the line used as the emitter 
shape. Click the disclosure triangle to modify the Z position of the start point. You can 
adjust these values in the canvas using the onscreen controls (with the Adjust Item tool 
selected in the canvas toolbar).

•	 End Point: Value sliders (available when Shape is set to Line or Wave) to define, in X 
and Y coordinates, the second point of the line used as the emitter shape. Click the 
disclosure triangle to modify the Z position of the start point. You can adjust these 
values in the canvas using the onscreen controls (with the Adjust Item tool selected in 
the canvas toolbar).

•	 Emit At Points: A checkbox available when Shape is set to Line, Rectangle (with 
Arrangement set to Outline or Random), or Circle (with Arrangement set to Outline 
or Random), Burst, Spiral, Wave, Geometry, Box (with Arrangement set to Outline), 
or Sphere (with Arrangement set to Outline). When the Emit At Points checkbox is 
selected, particles emerge from a limited number of points (as defined in the Points 
parameter, described below). When the checkbox is deselected, particles may emerge 
from anywhere on the line or edge. When the Adjust Item tool is selected in the canvas 
toolbar, the points are visible in the canvas.

•	 Points/Points Per Arm: A slider available when the Emit At Points checkbox is selected 
and Shape is set to any of the following: Line, Rectangle, Image, or Circle (with 
Arrangement set to Outline or Random Fill); or Burst, Spiral, Wave, or Geometry. Defines 
the number of points where particles are emitted. For Rectangle or Circle shapes, the 
particles are emitted from evenly distributed points along the edge of the shape when 
Arrangement is set to Outline. When the Adjust Item tool is selected in the canvas 
toolbar, the points are visible in the canvas.

Using a large number of points may slow your computer’s processing performance.

•	 Radius: A slider (available when Shape is set to Circle, Burst, Spiral, or Sphere) to define 
the size of the shape from which particles are emitted.

•	 Twists: A slider (available when Shape is set to Spiral) to set the number of turns in the 
spiral. The default value is 0.25.
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•	 Number of Arms: A slider (available when Shape is set to Burst or Spiral) to set the 
number of branches from which particles are emitted. The default value is 3.

•	 Amplitude: A slider (available when Shape is set to Wave) to define half the distance 
from the highest point to the lowest point in the wave. Higher values result in more 
extreme waves.

•	 Frequency: A slider (available when Shape is set to Wave) to set the number of waves. 
Higher values result in more waves.

•	 Phase: A dial (available when Shape is set to Wave) to set the degree of the offset of 
the waves from the start and end points of the path. When set to 0 degrees (default), 
the wave begins and ends at half the distance from the highest point to the lowest 
point in the wave. When set to 90 degrees, the wave begins and ends at the highest 
point in the wave. When set to -90 degrees, the wave begins at the lowest point in the 
wave. When set to 180 degrees, the waves are the same as they are at 0 degrees, but 
inverted.

•	 Damping: A slider (available when Shape is set to Wave) to set the direction of 
progressive diminishment of the oscillation of the wave. Positive damping values 
diminish the wave forward (from left to right); negative values diminish the wave 
backward (from right to left).

•	 Offset: A slider available when Shape is set to Line, Rectangle (with Arrangement set 
to Outline), Circle (with Arrangement set to Outline), Burst, Spiral, Wave, Geometry, or 
Image. Offsets the emitter itself or the particles generated on the shape. For example, 
when the emitter Shape is a Line, changing the Offset value moves the emitter’s 
position in the canvas. When the emitter Shape is a Rectangle and Arrangement is set 
to Outline, changing the Offset value moves the particles along the edge of the shape.

•	 3D: A checkbox that, when selected, enables the Box and Sphere options in the Shape 
pop-up menu. Further, because all emitter shapes can be manipulated in 3D space, 
additional 3D parameters are available for all emitter shapes when the 3D checkbox is 
selected: Render Particles, Emission Latitude, and Emission Longitude. These additional 
parameters appear in the Emitter Inspector and HUD.

Note: When the 3D checkbox is selected, particles cannot receive reflections, and the 
Reflections parameter (in the Properties Inspector) is no longer available for the emitter. 
Additionally, when the 3D checkbox is selected, In Global 3D (Better) must be selected 
from the Render Particles pop-up menu for particles to cast shadows and to be affected 
by lights.

For more information on the additional 3D controls in the HUD, see Adjust particles from 
the HUD.
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•	 Emission Angle: A dial (available when the Shape pop-up menu is set to a 2D shape) 
to set the direction in which particles travel. This control works in conjunction with the 
Emission Range control (described below). It’s equivalent to one of the functions of the 
graphical emission control in the Emitter HUD.

Note: When using an emitter shape other than a Point, such as a Line, Circle, Rectangle, 
Spiral, Burst, or Wave, and with Arrangement set to Outline, setting the Emission Angle 
parameter to 180 degrees and the Emission Range parameter to 0 degrees restricts the 
emission of particles to the inside of the shape. Setting the Emission Angle parameter 
to 0 degrees and the Emission Range parameter to 0 degrees restricts the emission of 
the particles to the area outside the shape.

•	 Emission Range: A dial to restrict the area around the center of each emission point 
where particles are generated, in the direction of the Emission Angle. It’s equivalent to 
one of the functions of the graphical emission control in the Emitter HUD.

Note: When using a Line, Circle, Rectangle, Spiral, Burst, or Wave (but not Geometry) 
shape, setting Emission Range to 0 degrees keeps particles perpendicular to the 
emitter when they emerge.

•	 Render Particles: A pop-up menu (available when the 3D checkbox is selected) to select 
between two rendering methods for the particles:

•	 In Local 3D (Faster): The default setting, renders particles faster but does not allow 
for intersections with layers in the emitter group or with layers in other groups. Nor 
does it allow particles to cast shadows.

•	 In Global 3D (Better): Allows the particles to intersect with layers in the emitter 
group and with layers in other groups. When turned on, your project’s playback 
performance is slowed.

Important: For the 3D particles to cast shadows, and be affected by lights and 
depth-of-field settings, you must select the 3D checkbox and choose In Global 3D 
(Better) from the Render Particles pop-up menu.

•	 Emission Latitude: A dial (available when the 3D checkbox is selected) to set the 
emission direction (in degrees latitude) of the particles.

•	 Emission Longitude: A dial (available when the 3D checkbox is selected) to set the axis 
of rotation (in degrees longitude) from which the particles are emitted.
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•	 Depth Ordered: A checkbox (available when the 3D checkbox is selected) that, when 
deselected, causes particle distribution to be completely random, regardless of size. 
Consequently, particle arrangements may appear to violate the rules of perspective.

When selected, this checkbox draws the particles in the particle system according to 
each particle’s actual 3D position in the project. In other words, particles closer to the 
camera appear larger; particles farther from the camera appear smaller.

•	 Render Order: A pop-up menu to set whether new particles are drawn on top of or 
underneath particles that have already been generated. There are two options:

•	 Oldest First: New particles appear on top of older particles.

•	 Oldest Last: New particles appear underneath older particles.

•	 Interleave Particles: A checkbox that, when selected, mixes together particles 
generated from multiple cells. Deselecting this checkbox layers particles in the same 
order as the cells that generate them.
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Note: This option has no effect with particle systems containing only one cell. Leaving 
this option off speeds rendering with multiple cells.

•	 Face Camera: A checkbox (available when 3D is enabled) that forces the particle system 
to face the active scene camera. For more information on cameras, see Add a camera.

Particle cell controls in Motion

Think of the particle cell as the “mold” for the particles generated in the canvas by the 
emitter. The parameters in the Cell Controls group determine how particles behave after 
they are released from the emitter. Cell controls appear at the bottom of the Emitter 
Inspector when a particle system is selected, and in the Particle Cell Inspector when a 
particle cell is selected.

Adjust an emitter’s cells using the Cell Controls:

•	 Birth Rate: A slider that defines the birth rate of the cell—that is, how many particles 
of this cell emerge from the emitter every second. Higher values create denser particle 
effects.
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•	 Birth Rate Randomness: A slider that defines an amount of variance in the Birth Rate 
of generated particles. A value of 0 results in no variance (particles emerge from the 
emitter at the same rate). A value greater than 0 introduces a range of random variance 
to the Birth Rate value.

•	 Initial Number: A slider that defines the initial number of particles. This control 
determines how many particles of this cell appear at the first frame of a particle effect. 
The result is an initial burst of particles that eventually evens out according to the Birth 
Rate setting.

•	 Life: A slider that defines the duration of every particle, in seconds—that is, how long 
each particle lasts before vanishing from existence. This effect is similar to how sparks 
disappear after flying away from a sparkler. Unless the Color Over Life setting or 
Opacity Over Life setting (both described below) is used to fade each particle out over 
its life, particles immediately vanish at the end of their lifetimes.

•	 Life Randomness: A slider that defines an amount of variance in the life of generated 
particles. A value of 0 results in no variance—all particles from the selected cell emerge 
with the same lifetime. A value greater than 0 introduces a range of random variance to 
the Life value.

•	 Speed: A slider that defines initial speed—that is, how quickly each particle flies away 
from the emitter. This, in conjunction with the Life and Birth Rate settings, determines 
how many particles appear in the canvas at a given frame. This parameter is equivalent 
to one of the functions of the graphical emission control in the HUD.

•	 Speed Randomness: A slider that defines an amount of variance in the speed of 
generated particles. A value of 0 results in no variance—all particles from the selected 
cell emerge with the same speed. A value greater than 0 introduces a range of random 
variance to the Speed setting.
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•	 Align Angle: When this checkbox is selected, particles rotate to match the shape on 
which they are positioned. This parameter is available in all cases but the following: 
when the Shape setting (in the Emitter Inspector) is Rectangle, Circle, Image, Box, 
and Sphere and the Arrangement setting is Tile Fill or Random Fill; or when the Shape 
setting is Point.

•	 Angle: A dial that sets the angle of rotation, in degrees, at which new particles are 
created.

•	 Angle Randomness: A dial that sets an amount of variance in the angle of generated 
particles.

•	 Spin: A dial that animates particles in a system by initially spinning each particle around 
its center. Adjustments to this control are in degrees per second.

•	 Spin Randomness: A dial that sets an amount of variance in the spin of generated 
particles. A value of 0 results in no variance—all particles from the selected cell spin at 
the same rate. A value greater than 0 introduces a range of random variance to the Spin 
setting.

•	 Additive Blend: By default, particles are composited together using the Normal blend 
mode. Select this checkbox to composite all overlapping generated particles together 
using the Additive blend mode, which intensifies the brightness of overlapping objects. 
This blending occurs in addition to the compositing method set in the Blend Mode 
parameter of the Properties Inspector.

•	 Color Mode: A pop-up menu that sets how particles are tinted. There are five options:

•	 Original: Particles are generated using the original colors from the source layer. 
When this setting is selected, the Opacity Over Life gradient editor becomes 
available (described below).
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•	 Colorize: Particles are tinted using the color specified in the Color parameter. When 
this setting is selected, additional Color and Opacity Over Life controls appear 
(described below).

•	 Over Life: Particles are tinted based on their age, with the range of possible colors 
defined by the Color Over Life gradient editor (described below). 

•	 Pick From Color Range: Particles are tinted at random, with the range of possible 
colors defined by the Color Range gradient editor (described below). A point on the 
gradient is randomly chosen, so the relative sizes of each color region determine the 
frequency of the color being used.

•	 Take Image Color: Each new particle’s color is based on the color of the image at the 
position where the particle was generated. This menu item is available only when the 
Shape pop-up menu in the Emitter Inspector is set to Image.

•	 Opacity Over Life: A gradient editor (available when the Color Mode is set to Original or 
Colorize) that animates changes to the opacity of particles over their lifetime. For more 
information on using gradient controls, see Change gradient color and opacity.

•	 Color: Color controls (available when the Color Mode pop-up menu is set to Colorize) 
to set the color of particles. You can also modify the alpha channel of each particle, 
altering its opacity. This parameter is unique to the cell object. You can click the color 
well to choose a color, use the eye dropper, or open the disclosure triangle and adjust 
the Red, Green, Blue, and Opacity channel sliders. See Use basic color controls.
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•	 Color Over Life: A gradient editor (available when the Color Mode is set to Over Life) 
that sets the range of color that each particle assumes as it ages, beginning with 
the leftmost color in the gradient, and progressing through the range of colors until 
finally reaching the rightmost color at the end of its life. For more information on using 
gradient controls, see Change gradient color and opacity.

•	 Color Repetitions: A slider (available when Color Mode is set to Over Life) that sets the 
number of times the gradient color pattern is repeated over the life of the particle.

•	 Color Range: A gradient editor (available when Color Mode is set to Pick From Color 
Range) that sets a range of colors used to randomly tint new particles. The direction of 
the gradient colors is not relevant. Color Range has the same controls as the Color Over 
Life gradient editor.

•	 Scale: A slider that defines the scale of every particle of a cell. Click the disclosure 
triangle next to the Scale parameter to reveal separate X, Y, and Z scaling 
subparameters. Use X and Y to resize the width and height of generated particles; use 
Z to change the depth of 3D text particles. This control affects the initial scale of the 
particle (compared to the Scale Over Life behavior in the Particles behavior category).

Note: When you use an image as a particle cell source and set a low Scale value, set the 
render quality in the Render pop-up menu (above the canvas) or the View menu to Best 
(choose View > Quality > Best).

•	 Scale Randomness: A slider that defines an amount of variance in the scale of 
generated particles. A value of 0 results in no variance—all particles from the selected 
cell emerge with the same size. A value greater than 0 introduces a variance defined by 
the Scale parameter, plus or minus a random value falling within the Scale Randomness 
setting. Click the disclosure triangle next to the Scale parameter to reveal separate X, 
Y, and Z scaling subparameters. Use X and Y to vary the width and height of generated 
particles; use Z to vary the depth of 3D text particles.
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•	 Attach To Emitter: A slider that sets how closely particles follow the position of a 
moving emitter. If set to zero, particles follow their own path after being emitted, trailing 
along the motion path the emitter is following. If this parameter is set to 100, in the 
absence of other behaviors, all generated particles follow the emitter, surrounding it in 
a moving cloud of particles.

•	 Play Frames: A checkbox (available if the particle system was created from a QuickTime 
movie) that controls playback. If selected, the animation or video clip used to generate 
each particle loops. If deselected, particles are generated using the still frame specified 
by the Random Start Frame parameter or the Source Start Frame parameter (both 
described below).

•	 Random Start Frame: A checkbox (available if the particle system was created from 
a QuickTime movie) that introduces variation into animated particles generated from 
QuickTime objects. If selected, each newly generated particle begins at a different 
frame of the animation. Stills are chosen randomly if Random Start Frame is deselected.

•	 Source Start Frame: A slider available if the particle system was created from a 
QuickTime movie and Random Start Frame is deselected. Use this control to set the 
start frame of the animation (if the Play Frames checkbox is selected) or the still frame 
to display (if the Play Frames checkbox is deselected). 

•	 Hold Frames: A slider (available if the particle system was created from a QuickTime 
movie) that sets the number of times each frame of the source movie is repeated during 
playback. The larger the Hold Frames value, the slower your playback.

•	 Hold Frames Randomness: A slider (available if the particle system was created from a 
QuickTime movie) that varies the number of frames to “hold.” 

•	 Show Particles As: A pop-up menu that sets whether particles are displayed in a 
preview mode or as they actually appear. By default, this parameter is set to Image, 
which displays each particle as it’s supposed to appear. However, the nonimage preview 
modes play more efficiently when viewing a complex particle system and also provide 
other ways of analyzing particle motion. There are four menu items:
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•	 Points: Displays each particle as a single point. This is the fastest preview mode, 
useful for displaying the type and speed of particle motion in a system.

•	 Lines: Displays each particle as a line. This is a good preview mode to use to analyze 
the vector of each particle’s motion. The length of each line is determined by that 
particle’s speed, and the angle of each line equals each particle’s direction.

•	 Wireframe: Displays each particle as a bounding box. Because the bounding boxes 
are good indicators of each particle’s orientation in the system, this preview mode is 
useful for evaluating the movements of individual particles. For example, it’s easy to 
see the angle of rotation for particles spinning or following a complex motion path.
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•	 Image: The default setting, displays the full particle system effect.

Note: The option chosen in the Show Particles As pop-up menu appears in your final 
render. Used deliberately, this can result in some interesting effects.

•	 Point Size: A slider (available when Show Particles As is set to Points) that sets the 
largeness of the points.

•	 Random Seed: Although particle systems seem random, they’re deterministic. This 
means that the variation in each particle system is created based on the number shown 
in the Random Seed field. Unless this seed number is changed, a particle system with 
the same Random Seed value always plays back with the same motion. If you don’t 
like the current random motion or distribution of the particle system, you can change 
the seed value by typing a new number or clicking Generate. This changes the random 
calculations performed for that system for all randomness parameters.

•	 Particle Source: In particle systems with more than one cell, an image well representing 
each cell appears at the bottom of the Emitter Inspector. Each Particle Source well has 
a checkbox you can use to enable or disable that cell.

Adjust basic emitter properties in Motion
You can modify an emitter’s position, scale, blend mode, drop shadow, and other attributes 
in the Properties Inspector. These properties are separate from the emitter parameters in 
the Emitter and Particle Cell Inspectors. 

1.	 In Motion, select an emitter object in the Layers list, Timeline, or canvas.

2.	 In the Inspector, click Properties.

3.	 Adjust the controls.

For detailed information on all Properties Inspector parameters, see Properties Inspector 
controls.

Note: When you select a particle cell and open the Properties Inspector, only one 
parameter group is available: the Timing controls, which adjust the In and Out points of the 
particle cell. See Particle system timing.
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Animate emitters and cells

Animating emitters and cells in Motion
By adding behaviors to a particle system’s emitter, or to the cells themselves, you can 
create sophisticated, organic animation that would be impossible to accomplish any other 
way. You can animate an emitter using behaviors designed specifically for particles, or 
by using Basic Motion, Parameter, or Simulation behaviors. You can also animate emitter 
parameters and cell parameters with keyframes.

Consider the following guidelines when animating a particle system:

•	 Apply the Particles behaviors (Scale Over Life and Spin Over Life) to modify and animate 
the rotation and size of the particles over their lifetime.

•	 Apply behaviors to particle cells or to the emitter to create even more varied effects 
(simulation behaviors can be especially effective). Any behavior that you apply to a cell 
is in turn applied to each particle the cell generates.

•	 Apply a Simulation behavior to an emitter or another object in your project (an object 
that is not part of the particle system) to make particles interact with other objects in 
the project. For example, applying the Repel behavior to an object will cause particles to 
weave around that object.

•	 Keyframe the Emitter Inspector parameters to modify the particle system’s overall 
characteristics over time, such as increasing or decreasing the size, speed, or lifetime 
of newly generated particles.

•	 Keyframe the emitter’s Position parameter (in the Properties Inspector) to alter the 
position and geometric distribution of a particle system over time, such as creating a 
path of bubbles that follows an object onscreen. For more information on keyframing, 
see Animate from the Inspector.

•	 Use Motion Tracking behaviors to track an emitter to a moving object in a clip, or to 
apply existing tracking data in your project to an emitter. For more information about 
Motion Tracking behaviors, see Intro to tracking.
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Apply behaviors to particles in Motion
Applying behaviors to particle systems is a quick and easy way to move emitters in your 
project and to create nearly limitless animations.

There are two ways to apply behaviors to a particle system:

•	 To the emitter: Behaviors applied to emitters affect the emitter itself, not its individual 
particles. For example, using the Throw behavior to send an emitter flying across the 
canvas creates a trail of particles.

•	 To the emitter cell: Behaviors applied to cells are in turn applied to each particle 
generated from that cell. This can result in extremely complex animations with dozens 
of particles moving according to the behaviors you’ve defined. Behaviors applied to 
cells have no effect on the position of the emitter.

Apply a behavior to an emitter
In Motion, do one of the following:

•	 Drag a behavior from the Library onto an emitter in the canvas, Layers list, or Timeline.

•	 Select the emitter, click Behaviors in the toolbar, then choose a behavior from the pop-
up menu.

•	 Select an object in the canvas, Layers list, or Timeline, then select a behavior from the 
Library stack and click Apply in the preview area.

In the canvas, the emitter begins to move according to the parameters of the applied 
behavior.

Note: Not all behaviors instantly activate an object when applied. For example, you must 
adjust the Throw Velocity parameter of a Throw behavior to cause an object to move.
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Apply a behavior to a cell
Behaviors applied to cells are in turn applied to each particle generated from that cell.

In Motion, do one of the following:

•	 Drag a behavior from the Library onto a cell in the Layers list.

•	 Select a cell in the Layers list, click Behaviors in the toolbar, then choose a behavior 
from the pop-up menu. 

•	 Select a cell in the Layers list, then select a behavior from the Library stack and click 
Apply in the preview area.

Particles move according to the parameters of the applied behavior.

In the canvas, the emitter begins to move according to the parameters of the applied 
behavior.

Note: Not all behaviors instantly activate an object when applied. For example, you must 
adjust the Throw Velocity parameter of a Throw behavior to cause an object to move.

 Tip: If you don’t see the expected result when applying behaviors to particle cells, 
try selecting or deselecting the Affect Subobjects checkbox (in the Behaviors Inspector) 
or selecting a different option from the Affect pop-up menu in the HUD or Behaviors 
Inspector. These parameters determine whether the entire object (such as the particle 
emitter) or its components (such as the particle cells) are affected by the behavior and 
how an object interacts with surrounding objects, respectively. (The Affect Subobjects 
checkbox appears in the Behaviors Inspector only when the Throw and Spin behaviors are 
applied to a group containing multiple objects, such as a group, particle emitter, or text.)
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Apply a Parameter behavior to an emitter or cell parameter
You can apply Parameter behaviors to parameters in the Emitter Inspector or Particle 
Cell Inspector. A Parameter behavior is a special kind of behavior that animates a single 
parameter of an object.

In Motion, do one of the following:

•	 Drag a behavior from the Parameter category of behaviors in the Library onto an emitter 
or cell in the Layers list or Timeline, then, in the Behaviors Inspector, click the To pop-
up menu and choose a parameter from the submenus.

•	 Select an emitter or cell in the Layers list or Timeline, click Behaviors in the toolbar, 
and choose a Parameter behavior; then, in the Behaviors Inspector, click the To pop-up 
menu and choose a Parameter from the submenus.

•	 In the Emitter or Particle Cell Inspector, Control-click a parameter, then choose a 
Parameter behavior from the shortcut menu.

The Parameter behavior is applied to the parameter you chose. Play back your project to 
see the result.

See Intro to Parameter behaviors.

Apply a Particles behavior to an emitter or cell
The Particles category of behaviors in the Library contains two behaviors specifically for 
use with the cells or an emitter in a particle system:

•	 Scale Over Life: This behavior lets you grow or shrink the particles in a system over the 
duration of each particle’s life. 

•	 Spin Over Life: This behavior lets you spin the particles in a system over the duration of 
each particle’s life.

In Motion, do one of the following:

•	 Drag a behavior from the Particles category of behaviors in the Library onto an emitter 
or cell in the Layers list or Timeline.

•	 Select an emitter or cell in the Layers list or Timeline, click Behaviors in the toolbar, 
then choose a behavior from the Particles submenu.

For a description of each Particles behavior parameter, see Scale Over Life controls and 
Spin Over Life controls.
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Particles behavior controls

Scale Over Life controls in Motion

The Scale Over Life behavior has one main parameter control and three optional parameter 
controls that vary, depending on the selected Increment Type:

•	 Increment Type: A pop-up menu that sets the method used to resize particles over their 
lifetimes. There are four options:

•	 Natural Scale: Specifies starting and ending scale percentages used to animate 
each particle’s size over its lifetime. Natural Scale uses an exponential curve to allow 
the animation to progress slowly when the scale values are small, and speed up 
when the values are large. This creates the illusion that the scaling is occurring at a 
constant speed.

•	 Rate: Specifies a steady rate at which particles change size over their lifetimes. 

•	 Birth and Death Values: Specifies starting and ending scale percentages used 
to animate each particle’s size over its lifetime. The scale amount generated by 
this option for a specific particle at a specific time is multiplied by the preexisting 
particle Scale (defined in the Cell Controls section of the Emitter Inspector). 

•	 Custom: Lets you customize the scale of the particles over their lifetimes with a 
mini-curve editor (described below). 

Scale At Birth: A slider (available when Increment Type is set to Natural Scale or Birth 
and Death Values) that defines the initial size of particles when they’re created. Click 
the disclosure triangle next to the Scale At Birth parameter to reveal separate X, Y, and 
Z subparameters. Use X and Y to change the width and height of generated particles; 
use Z to change the depth of 3D text particles.

•	 Scale At Death: A slider (available when Increment Type is set to Natural Scale or Birth 
and Death Values) that defines the size of each particle at the end of its lifetime. Click 
the disclosure triangle next to the Scale At Death parameter to reveal separate X, Y, and 
Z subparameters. Use X and Y to change the width and height of generated particles; 
use Z to change the depth of 3D text particles.

•	 Scale Rate: A slider (available when Increment Type is set to Rate) that defines how 
quickly each particle changes size. Positive values grow particles over time, while 
negative values shrink particles over time. Click the disclosure triangle next to the Scale 
Rate parameter to reveal separate X, Y, and Z subparameters. Use X and Y to change 
the width and height of generated particles; use Z to change the depth of 3D text 
particles.

•	 Custom Scale controls: A group of controls (a mini-curve editor and two sliders, 
described below) that appears when Increment Type is set to Custom. Use the mini-
curve editor for more precise control over the Scale of particles in your particle system.

•	 Mini-curve editor (unlabeled): A graph with curves and control points you can drag 
to adjust the scale of particles. For more information on using mini-curve editors, 
see Use the mini-curve editor.

•	 Custom Scale: A slider to adjust the value of the selected keyframe in the mini-curve 
editor. 

•	 Over Life: A slider to adjust the position of the selected keyframe in the life of the 
particle. 
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Spin Over Life controls in Motion

The Spin Over Life behavior has one main parameter control and three optional parameter 
controls that vary, depending on the selected Increment Type:

•	 Increment Type: A pop-up menu that sets the method used to spin particles over their 
lifetimes. There are three options:

•	 Rate: Specifies a steady rate and direction in which particles spin over their lifetime. 

•	 Birth and Death Values: Specifies starting and ending spin degrees used to animate 
each particle’s rotation over its lifetime. The spin amount generated by this option 
for a specific particle at a specific time is added to the preexisting particle spin 
(defined in the Cell Controls section of the Emitter Inspector). 

•	 Custom: Lets you customize the spin of the particles over their lifetimes with a mini-
curve editor (described below).

•	 Spin Rate: A slider (available when Increment Type is set to Rate) that determines how 
quickly each particle spins and the direction of the spin. Positive values spin particles 
faster over time and in a counterclockwise direction; negative values spin particles 
slower over time and in a clockwise direction.

•	 Spin At Birth: A slider (available when Increment Type is set to Birth and Death Values) 
that determines the initial spin of the particles when they’re created.

•	 Spin At Death: A slider (available when Increment Type is set to Birth and Death Values) 
that determines the spin of the particles at the end of their lifetimes.

•	 Custom Spin controls: A group of controls (a mini-curve editor and several other 
controls, described below) available when Increment Type is set to Custom. Use the 
mini-curve editor for more precise control over the Spin of particles in your particle 
system.

•	 Mini-curve editor (unlabeled): A graph with curves and control points you can drag 
to adjust the spin of particles. For more information on using mini-curve editors, see 
Use the mini-curve editor.

•	 Custom Spin: A dial to adjust the value of the selected keyframe in the mini-curve 
editor. 

•	 Over Life: A slider to adjust the position of the selected keyframe in the life of the 
particle.
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View emitter or cell keyframes in Motion
You can also animate emitter or cell parameters using keyframes. When you do so, a 
curve describing that animation is available in the Keyframe Editor. The selected object 
determines which curves appear in the Keyframe Editor (when Animated is selected from 
the pop-up menu in the top-left corner of the Keyframe Editor). For more information about 
animating with keyframes, see Intro to keyframing.

Display keyframed emitter or cell curves
In Motion, do one of the following:

•	 Display keyframed emitter curves: With the Keyframe Editor open (press Command-8 
if it’s not already open), select an emitter in the Layers list to display animated emitter 
parameters such as Position and Rotation (in the Properties Inspector) or Emission 
Angle and Range.

•	 Display keyframed cell curves: With the Keyframe Editor open (press Command-8 if it’s 
not already open), select a cell in the Layers list to display animated parameters such as 
Birth Rate or Angle.

Note: To view a specific animated parameter in the Keyframe Editor, click the 
parameter’s Animation menu (the down arrow that appears when you place the pointer 
over the right side of a parameter row in the Inspector), then choose Show In Keyframe 
Editor.

The parameter is displayed in the Keyframe Editor in a new, untitled curve set.

For more information about keyframe curves, see Display the Keyframe Editor.
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Create 3D particles in Motion
Two emitter pattern styles in the Shape pop-up menu have 3D options: Box and Sphere. 
The Box and Sphere shape options are available only when the 3D checkbox is selected in 
the Emitter Inspector.

Although the Rectangle, Circle, Line, Wave, Image, and Geometry emitter shapes have 
no inherent 3D parameters, they can be moved and rotated in 3D space. Additionally, the 
Line and Wave emitter shapes have quasi-3D properties: Their start and end points can be 
moved into Z space (depth).

And when you nest an emitter in a 3D group, you can use Simulation behaviors to pull 
particles out of their X and Y planes, into Z space.
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Turn an existing 2D particle system into 3D particles
1.	 After adding an emitter to a Motion project, select the 3D checkbox in the Emitter 

Inspector.

For information about adding an emitter, see Add a particle system.

2.	 If your project does not contain a camera, click Add Object in the toolbar, then choose 
Camera from the pop-up menu.

If your project is a 2D project, a dialog appears asking if you want to switch your 2D 
groups to 3D.

3.	 Click Switch to 3D.

A camera is added to the project, and your layers are turned into 3D layers.

4.	 In the 3D view tools (in the upper-right corner of the canvas), drag inside the Orbit tool 
(the center tool).

As the camera rotates, you can see that the particles are emitted in X, Y, and Z space 
(all three dimensions).

 Tip: Use Simulation behaviors to create animated particles in 3D space that interact 
with other objects in the project. For example, use Orbit Around to create particles that 
circle around a target object. See Intro to Simulation behaviors.

5.	 Optional: If you want the particles to face the camera as it rotates around the emitter, 
select the Face Camera checkbox in the Emitter Inspector.
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Create a 3D box or sphere particle emitter
1.	 After adding an emitter to a Motion project, select the 3D checkbox in the Emitter 

Inspector.

For information, see Emitter controls.

2.	 In the Emitter Inspector, click the Shape pop-up menu, then choose Box or Sphere.

Particles emanate from a box or sphere pattern, in 3D space.

Make particles intersect with other layers
Particles can intersect with other rotated layers in 3D space.

•	 In the Emitter Inspector in Motion, click the Render Particles pop-up menu, then choose 
In Global 3D (Better).

In the following image on the left, with Global 3D selected, particles intersect with other 
objects in the project that are transformed in 3D space. In the image on the right, with 
Local 3D selected, particles do not intersect with other objects.

Particle system timing in Motion
When you create a particle system, its duration can be as long or short as necessary, 
regardless of the duration of the original source layers used to create the particle system. 
The duration of a particle system is defined by the duration of the emitter object. Changing 
the In or Out point of an emitter in the Properties Inspector, Timeline, or mini-Timeline 
changes the duration of the entire particle system.

By default, particles are generated by every cell in a system for the duration of the emitter. 
The duration of each generated particle is defined by the Life parameter of the cell that 
generated it, and not by the duration of the cell itself.

The duration of the cell governs the time span over which new particles are generated. You 
can change a cell’s duration by dragging its position or its In and Out points in the Timeline. 
In this way, you can adjust the timing that defines when each cell’s particles emerge.
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For example, you can create a particle system that simulates an explosion by offsetting 
the appearance of different types of particles. First, dense white sparks emerge from the 
center. Half a second later, more diffuse orange blast particles appear around a larger 
area. One second after that, hot smoke emerges from underneath both of these layers, and 
smoky remains are left as the particles fade away.

You can offset a cell in the Timeline or mini-Timeline so that the cell starts before the 
emitter. This creates a “pre-roll” in which the particle simulation begins before the 
particles are drawn.

For more information on adjusting the timing of layers in the Timeline, see Intro to the 
Timeline.

Using graphics in particle systems in Motion
Creating a particle system from scratch begins with designing the particles you want it to 
emit. You can use any image, shape, text, or movie supported by Motion as a source for 
a cell.

Still images
Particle systems that use still images as their cell sources render in real time much faster 
than systems that use video or animation clips. A still image is often all you need to create 
a compelling particle system. 

Use the following guidelines when creating graphics for use as particles:

•	 Graphics size: If you’re not sure what size you want your particles to be, it’s a good idea 
to make your graphics larger rather than smaller. Increasing the size of particles beyond 
the size of the original graphic can introduce unwanted artifacts. One caveat, however, 
is that the larger the cell source size, the slower your playback performance.

•	 Particle edges: The quality of the edges of your graphics can be extremely important 
for creating convincing particles. Soft, translucent edges might look better than hard, 
over-defined ones.

•	 Object color: By default, particles are created using the original colors of the source 
image used as the cell. If necessary, you can tint the emitted particles using the Color 
Mode controls in the Emitter and Particle Cell Inspectors. Choose between tinting all 
particles with a single color or creating a gradient tint that changes color over time. You 
can also choose to apply a gradient preset to the particles (see Use a gradient preset). 
Tinting particles applies the tint color uniformly over the entire particle system.

•	 Alpha channels: Always create graphics that you want to use as cells with predefined 
alpha channels. For more information on importing files with alpha channels, see Alpha 
channels.
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QuickTime movies
You can also use QuickTime movies as the image source of a particle cell. For example, 
you can create an animation in Motion, render it as a QuickTime movie, then import 
it into another Motion project to use as image source for a cell. In general, the same 
recommendations for creating still graphics apply to the creation of animation or video 
clips you intend to use as cells, but there are additional considerations.

Use the following guidelines when creating animations for use as particles:

•	 Playback performance: Using a video clip as the image source of a particle cell may 
impact your project’s playback performance.

•	 Retimed clips: If you retime a video clip (in the Properties Inspector or with a Retiming 
behavior) used as the image source for a particle cell, the effect of the retiming is 
carried through to the particle system.

•	 Looping clips: Particles created from QuickTime clips loop over and over for the 
duration of each particle’s life. If the clip you use doesn’t loop well, there will be a 
jump cut at every loop point. Another option is to use very short movies to introduce 
randomness into the appearance of the particle system.

•	 Minimal compression: Ideally, QuickTime clips to be used as particles should be saved 
using a high-quality codec, such as Animation, Uncompressed 8- and 10-bit 4:2:2, or 
ProRes 4444. Other codecs can be used, but they might introduce unwanted artifacts 
depending on the level of compression used.

Using filters and masks with particles in Motion
You can apply filters or masks to an emitter. (However, you cannot apply filters or masks to 
the cells in an emitter.)

Filters
When you apply a filter to an emitter, the entire particle system is transformed, including 
every element in the onscreen pattern.

Note: Although you cannot apply a filter to an individual cell, you can apply a filter to the 
image source of a cell (the disabled layer in Layers list used to create the particle cell).

For more information on applying filters to layers in your project, see Intro to filters.
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Masks
You can apply masks to the image source of a particle cell. The effect of the mask on the 
cell source is carried through to the emitted particles.

You can also apply masks to the emitter object itself.

For more information on working with masks, see Intro to masks and transparency.

Save custom particle effects in Motion
After you create a particle system, you can save it as a particle preset in the Particle 
Emitters, Favorites, or Favorites Menu folder in the Library, for future use. When you place 
particle systems in the Library, they become particle presets that can be used like any 
other particle preset.

 Tip: For organizational purposes, create a folder of your own in the Favorites or 
Favorites Menu category to store custom particle systems.

Save a particle system to the Library
1.	 In Motion, open the Library and select the Particle Emitters, Favorites, or Favorites 

Menu category.

2.	 Drag the emitter you want to save from the Layers list into the stack at the bottom of 
the Library.

The customized emitter is saved in the /Users/username/Library/Application Support/
Motion/Library/ folder (in the Particle Emitters, Favorites, or Favorites Menu subfolder). 
Any custom layers created in Motion (such as a shape layer) that you used to create 
that particle system are included in the file.
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Create replicators

Intro to replicators in Motion
The Motion replicator builds complex patterns of repeating elements—from a simple line of 
animated shapes to flowing kaleidoscopic imagery—without manual duplication or tedious 
keyframing.

You can add a preset replicator to your project from the Library, or you can create your own 
custom replicator using nearly any image layer in your project, including video, still images, 
shapes, or text.

Replicators consist of two basic elements:

•	 Replicator: A special type of effect that generates multiple duplicates of an image layer, 
then arrays the copies in the canvas, creating a complex pattern. You specify the shape 
and arrangement of the pattern, such as a spiral, circle, or box.

•	 Cell: The image layer that’s duplicated and assembled as a pattern in the canvas.

The replicator and its cells have separate sets of parameters that control the look of the 
mosaic pattern you see in the canvas. Changing the replicator parameters modifies the 
overall onscreen pattern, allowing you to create rectangular, circular, spiral, and other 
geometric layouts. Changing the cell parameters affects each element in the onscreen 
pattern, allowing you to modify attributes such as the angle, color, and scale of the pattern 
pieces.

You can also modify elements in the pattern by making changes to the source layer used 
to create a cell. For example, if you use a rotated rectangle shape as the replicator source 
layer, the replicated elements in the canvas appear rotated. If the source layer has applied 
filters, the effects of the filters are retained in the elements of the replicator pattern.
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Unlike particle systems, replicator patterns are static by default. However, many of the 
preset replicators available in the Library are already animated, and you can always 
manually keyframe parameters of custom replicators, or apply behaviors. For example, 
by keyframing a replicator’s Offset parameter, you can create a wave of dots that slither 
across the screen.

You can add behaviors to the replicator or its cells to create even more varied effects 
(simulation behaviors are especially effective). Behaviors applied to a replicator or a 
replicator cell can be applied to each element of the pattern. This lets you achieve almost 
limitless variation and complexity that would take hours to animate using keyframes. You 
can also apply a behavior such as Vortex to another object in your project (an object that 
is not part of the replicator pattern), and have the pattern elements circumnavigate that 
object.

A special behavior called Sequence Replicator choreographs the parameters of your 
onscreen elements (their position, scale, and opacity, for example) in a sequential 
animation. See Apply the Sequence Replicator behavior.

Replicators take advantage of the Motion app’s 3D capabilities. Some replicator shapes are 
inherently 3D, and others can have points that exist in 3D space. Additionally, behaviors 
applied to a replicator in 3D space can pull pattern elements out of a plane. See Work with 
3D replicators.

Note: Although you can replicate any image layer in your project, you cannot replicate 
replicators themselves, or particle emitters, lights, cameras, or rigs.

Replicators vs. particle systems in Motion
Although the replicator and a particle system share many parameters, they’re very different 
tools. Both use layers (shapes, text, images, and so on) as cell sources, and both generate 
onscreen elements from those sources. However, each produces a unique effect from 
those raw materials. A particle system generates dynamic (animated) elements that change 
over time: Particles are born, emerging from an onscreen “emitter”; they move across the 
canvas; and they die, according to the “laws of nature” you specify in the parameters of 
the system.

A replicator, however, is not a dynamic simulation. Its elements are not emitted like 
particles, and thus have no birth rate, life, or speed parameters. The replicator builds a 
pattern of static copies of a source layer in an arrangement that you specify. Although the 
replicated elements you see onscreen are static by default, you can animate a replicator’s 
parameters. For example, you can designate a simple star shape as the source of your 
onscreen pattern and then replicate the star multiple times along the outline of a circle. By 
keyframing a few parameters of your new replicator object, you can launch the stars into 
animated orbit around the center of the circle, making them change color as they whirl.
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Add a replicator to a project

Add a replicator in Motion
There are two basic ways to add a replicator to a Motion project: 

•	 Choose a preset from the Replicators category of the Library.

•	 Create a custom replicator using your own image, shape, or video clip as a cell source. 
You can increase replicator complexity by using multiple cell sources.

Add a preset replicator from the Library
1.	 In the Library in Motion, select the Replicators category, then select a subcategory, 

such as Mattes, Transitional, Backgrounds, and so on.

2.	 In the Library stack under the categories and subcategories, select a replicator object.

A preview of the selected replicator appears in the Library preview area.

3.	 Do one of the following:

•	 Click Apply in the preview area to add the replicator to the center of the canvas.

Note: If Create Layers At is set to “Start of project” in the Project pane of Motion 
Settings, the replicator is added at the first frame. See If it’s your first import.

•	 Drag the replicator from the Library stack into the canvas at the position where you 
want it to appear.

•	 Drag the replicator from the Library stack to a group in the Layers list or Timeline 
layers list.

•	 Drag the replicator to the track area of the Timeline or mini-Timeline. When you 
reach the frame where you want the new replicator to start, release the mouse 
button.

The replicator preset appears in the project, composited above objects below it in 
the Layers list.

To modify the default parameters, see Adjust a replicator from the HUD and Adjust a 
replicator from the Inspector.
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Create a simple custom replicator
You can create a custom replicator pattern by designating an image layer in your project 
as a source for the cell. Applying a replicator to that layer creates a nonanimated, filled 
rectangular pattern. You can then modify the replicator parameters to suit your project 
needs.

1.	 In Motion, create a layer to serve as the cell source for a custom replicator.

This example uses a bird graphic from the Content folder in the Library.

2.	 Select the layer in the Layers list or canvas, then do one of the following:

•	 In the toolbar, click the Replicate button.

•	 Choose Object > Replicate (or press L).

The new custom replicator layer appears in the Layers list and in the canvas, 
composited against any other layers you’ve already added.

To modify the default parameters, see Adjust a replicator from the HUD and Adjust a 
replicator from the Inspector. 
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Create a complex replicator using multiple source layers
You can create a more complex pattern containing multiple elements by adding multiple 
image sources to a single replicator. Each source becomes a cell in the replicator, and each 
cell has its own set of parameters.

1.	 In the Layers list or Timeline in Motion, select the layers to replicate.

This example uses two graphics from the Content folder in the Library.

Note: Shift-click to select contiguous layers; Command-click to select noncontiguous 
layers.

2.	 Do one of the following:

•	 In the toolbar, click the Replicate button.

•	 Choose Object > Replicate (or press L).

The cells of the default replicator pattern are created from the source layers (which are 
deselected so they don’t appear in the composition).

When multiple cells create a replicator pattern, the elements appear at the same points 
on the pattern. The replicator is positioned at the average of the source’s positions.
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Add additional cells to an existing replicator
•	 In the Layers list in Motion, drag an existing image layer onto the replicator.

Note: You cannot drag a media item from the Library onto a replicator in the Layers list.

The layer is duplicated as a new cell in the replicator.

Note: If the layer you drag to a replicator is a shape or mask, a drop menu appears, 
giving you the option to add it as a replicator cell or as a mask. See Using filters and 
masks with replicators.

Anatomy of a replicator in Motion
After you add a replicator to a project, the following occurs:

•	 A replicator appears in the Layers list and is selected.

•	 One or more cells containing the image or images to be replicated appear as sublayers 
underneath the parent replicator (click the disclosure triangle beside the replicator layer 
to hide or reveal its cells).

•	 The original source layer (the cell source) is disabled.

Note: Changes made to the original source layer, such as opacity or shearing, are also 
applied to the pattern even after the replicator is created.

•	 In the canvas, a bounding box with transform handles appears around the selected 
replicator.
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•	 For custom replicators, the Adjust Item tool is selected in the canvas toolbar so you can 
immediately begin dragging the replicator’s onscreen handles.

With the Adjust Item tool selected, dragging the bounding box outline or corner points 
in the canvas resizes the replicator. Dragging inside the bounding box (but not the 
outline) repositions the replicator object as a whole.

•	 The Replicator HUD appears. If you’ve hidden the HUD, press F7.

•	 The Replicator Inspector becomes available.

The replicator and its cell (or cells) have separate parameters that control the look of the 
mosaic pattern you see in the canvas. Changing the replicator parameters modifies the 
overall onscreen pattern, allowing you to create rectangular, circular, spiral, and other 
geometric layouts. Changing the cell parameters affects each element in the onscreen 
pattern, allowing you to modify attributes such as the angle, color, and scale of the pattern 
pieces.

After replicators are modified, you can save them in the Library for later use. See Save 
custom replicators.

Adjust a replicator

Modify basic replicator attributes in Motion
After adding a preset replicator or creating a custom replicator, you modify it further by 
replacing its source image, adjusting cell opacity, or changing the replicator pattern’s size 
or position in the canvas.

Replace a preset replicator’s source image
After adding a preset replicator to your project, you can customize it by replacing its 
source image.

1.	 Locate the file you want to use as the replacement graphic and add it to your Motion 
project.

2.	 Do one of the following:

•	 In the Layers list, drag the new layer to the replicator cell you want to replace.

•	 In the Replicator Inspector, drag the new layer to the Object Source well of the 
replicator cell you want to replace.

Note: If the cell layer is not visible, click the disclosure triangle next to the replicator layer.

3.	 When the pointer becomes a curved arrow, release the mouse button.

The original source image is replaced with the new image.

4.	 Optional: Hide the new source layer by deselecting its activation checkbox in the Layers 
list. 

The cells based on this layer remain in your replicator pattern, but the source layer itself 
is hidden in the canvas.
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Adjust replicator element opacity
You can adjust the opacity of individual elements in a replicator by modifying the cell 
parameters in the Replicator Cell Inspector or by modifying the source layer’s opacity in 
the Properties Inspector.

In Motion, do one of the following:

•	 Select the cell in the Layers list, then adjust the Opacity tag in the gradient editor in 
the Replicator Cell Inspector (or change Color Mode to Colorize and adjust the Opacity 
parameter in the Color controls).

•	 Select the original source layer—not the replicator cell—and change its opacity in the 
HUD or Properties Inspector.

Change the stacking order of elements
The elements in the pattern are stacked according to their order in the Layers list and 
Timeline. In a replicator with multiple cells, changing cell stacking order changes the 
appearance of the pattern in the canvas.

•	 In the Layers list in Motion, drag a cell to a new position above or below other cells in 
the replicator.

Adjust a replicator’s size or position using onscreen controls
1.	 In the Layers list In Motion, select the replicator to adjust.

2.	 In the canvas toolbar, click the transform tools pop-up menu, then choose Adjust Item.

The replicator onscreen controls appear in the canvas. The onscreen controls vary 
depending on the shape of the replicator (chosen from the Shape pop-up menu in the 
Replicator Inspector).

3.	 To resize the replicator, drag the replicator shape’s outline in the canvas.

4.	 To reposition the replicator, drag inside the shape (but not directly on the outline) in the 
canvas.
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The size or position of the replicator shape is adjusted. For example, if the shape is a 
spiral or circle, dragging the shape outline changes the Radius parameter value. Dragging 
inside the shape (but not directly on the outline) repositions the replicator in the canvas.

If the replicator shape is a rectangle, dragging a corner or edge of its bounding box 
changes the Size parameter value. Depending on which handle you drag, you can 
constrain the transform to width, height, or depth (in a box-shaped replicator). Or you 
can drag a corner handle to scale the replicator in multiple dimensions simultaneously.
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Remove a replicator or cell in Motion
In a replicator that contains multiple cells, you can remove cells to change the appearance 
of the onscreen pattern. You can also remove a replicator (and its cells) entirely.

Remove a cell from a replicator
•	 In the Layers list or Timeline in Motion, select the cell to remove, then press Delete.

The cell is removed from the Layers List, and the replicator pattern in the canvas is 
modified.

Remove a replicator and its cells from a project
•	 In Motion, select a replicator in the Layers list or Timeline, then press Delete.

The original source layer or layers remain in the project.

Adjust a replicator from the HUD in Motion
When you create a replicator from a source layer, the onscreen pattern is built using the 
default parameters in the Replicator Inspector and Replicator Cell Inspector. You can 
modify the most important of these parameters in Replicator HUD and the Replicator Cell 
HUD. The HUD also provides quick access to the Opacity and Blend Mode parameters, 
located in the Properties Inspector.

Adjust a replicator in the Replicator HUD
1.	 In the Layers list or Timeline in Motion, select a replicator.

The HUD appears. (If it does not appear, press F7.)

2.	 Modify any of the controls in the HUD: Opacity, Blend Mode, Shape, Arrangement, 
Columns, Rows, or Origin.

These controls are a subset of the controls in the Replicator Inspector and in the 
Properties Inspector. See Replicator controls and Adjust additional replicator properties.

Adjust a cell in the Replicator Cell HUD
1.	 In the Layers list or Timeline in Motion, select a replicator cell.

The HUD appears. (If it does not appear, press F7.)

2.	 Modify any of the controls in the HUD: Angle, Angle End, Angle Randomness, Scale, 
Scale End, or Scale Randomness.

These controls are a subset of the controls in the Replicator Cell Inspector. See 
Replicator cell controls.
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Modify a replicator in the Inspector

Adjust a replicator from the Inspector in Motion

Replicator and replicator cell parameters, though closely related, serve different purposes: 

•	 Replicator parameters control the overall shape, arrangement, offset, stacking order, 
build order, and number of elements in the replicator pattern.

•	 Replicator cell parameters control the behavior and appearance of the individual 
elements in the replicator pattern.

For a replicator with only one cell (one source image), the replicator and replicator cell 
controls appear in the same Replicator Inspector. In this case, you can control every aspect 
of the replicator using these controls. However, in replicators with multiple cells, each cell 
has its own Replicator Cell Inspector containing all parameters for that cell.

Adjust a replicator in the Replicator Inspector
1.	 In Motion, select a replicator in the Layers list or Timeline.

2.	 In the Inspector, click Replicator.

3.	 Adjust the Replicator Controls and Cell Controls.

The contents of the Replicator Inspector are dynamic: Different parameters appear 
depending on the option you choose in the Shape pop-up menu. Also, different parameters 
appear depending on the option you choose in the Arrangement pop-up menu.

For a complete list of these controls, see Replicator controls.
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Adjust a cell in the Replicator Cell Inspector
1.	 In Motion, select a replicator cell in the Layers list or Timeline.

2.	 In the Inspector, click Replicator Cell.

3.	 Adjust the Cell Controls.

For a complete list of these controls, see Replicator cell controls.
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Replicator controls in Motion

The parameters in the Replicator Inspector give you complete control over every aspect 
of the pattern created by the selected replicator. This includes the shape upon which the 
pattern is built and the shape’s related parameters, such as the size of the pattern, how the 
elements are arranged in the pattern, and so on.

Some parameters in the Replicator Inspector depend on the settings of other parameters. 
All combinations of parameters are described below:

•	 Shape: A pop-up menu to set the overall shape of the onscreen replicator pattern. The 
default setting is Rectangle. Choose any of up to ten shape styles from the menu to 
alter the distribution of the pattern elements. 

The Shape pop-up menu contains the following items:

•	 Line: Elements are positioned on a line. In the Inspector, you can set a specific 
number of points on the line—one element is positioned at every point (including the 
end points of the line).

•	 Rectangle: Elements are positioned in a rectangle along the replicator outline, or in a 
tile or random fill pattern. When Rectangle is selected, the Arrangement parameter 
becomes available (described below).
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•	 Circle: Elements are positioned in a circle along the replicator outline, or in a tile or 
random fill pattern. When Circle is selected, the Arrangement parameter becomes 
available. In the following image, the circle’s Arrangement is set to Outline.

•	 Burst: Elements are positioned in a flare pattern.

•	 Spiral: Elements are positioned in a spiral pattern. 

•	 Wave: Elements are positioned on a waveform.
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•	 Geometry: Elements are positioned along the edge of a shape, defined by a spline 
object used as the shape source. See Create a custom replicator shape.

For information on using the Geometry shape, see Replicator cell controls.

•	 Image: Elements appear within an area defined by an image or along its border, 
depending on the Arrangement setting. The image may have an alpha channel; if so, 
the shape of the alpha channel can also be used to define the pattern. See Create a 
custom replicator shape.

•	 Box: This option is available when the 3D checkbox (described below) is selected 
in the Replicator Inspector. Elements are positioned in a three-dimensional cube 
along the replicator outline, or on its surface in a tile or random fill pattern. Using the 
onscreen controls (with the Adjust Item tool selected in the canvas toolbar), you can 
specify the size and location of the rectangle. Drag the front horizontal outline edge 
to adjust height; drag the front vertical edge to adjust width; drag a back edge to 
adjust depth; drag a front corner to simultaneously adjust the width and height. To 
reposition the replicator, drag in the replicator (but not on an edge or corner point). 
In the following image, the box’s Arrangement is set to Tile.

•	 Sphere: This option is available when the 3D checkbox (described below) is selected 
in the Replicator Inspector. Elements are positioned in a three-dimensional sphere 
along the replicator outline, or on its surface in a tile or random fill pattern. Using the 
onscreen controls (with the Adjust Item tool selected in the canvas toolbar), you can 
specify the radius and location of the circle. Drag the outline of the sphere to adjust 
its radius; drag in the sphere to reposition it in the canvas.
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•	 Arrangement: A pop-up menu (available when the Shape pop-up menu is set to 
Rectangle, Circle, Image, Box, or Sphere) to specify the layout of the elements in the 
selected shape. There are three menu options:

•	 Outline: Elements are positioned along the edge of the shape.

•	 Tile Fill: Elements are positioned in a tiled pattern of rows and columns in the circle, 
rectangle, image, box, or sphere pattern. You can specify the number of columns 
and rows, as well as the tile offset. This is the default setting.

•	 Random Fill: Elements are positioned randomly within the circle, sphere, rectangle, 
or box pattern.

•	 Size/Radius: A slider (available when Shape is set to Rectangle or Box) to set the size 
of the rectangle or cube shape. Click the disclosure triangle to display separate Width, 
Height, and Depth (for the Box shape) parameters. When Circle is the selected shape, 
this parameter becomes Radius.

Note: For projects using the default camera settings and a default Z position for the 
replicator, Height is measured in pixels, and Width is measured in square pixels, to 
ensure that a numerically square shape looks square when Correct for Aspect Ratio is 
enabled (in the View pop-up menu).

•	 Shape Source: An image well (available only when Shape is set to Geometry) to specify 
a shape object as the source for the replicator pattern. To set the shape source for the 
replicator, drag a shape from the Layers list or Timeline into the Shape Source well.

•	 Image Source: An image well (available when the Shape parameter is set to Image) to 
specify an image object as the source for the replicator shape. To set the image source, 
drag an image from the Layers list or Timeline into the Image Source well.

•	 Emission Alpha Cutoff: A slider (available when the Image Source object contains an 
alpha channel) to set the minimum opacity value necessary to create an element at 
that point on the source image. For example, when set to 25%, elements appear only at 
points where the alpha value of the image is equal to or greater than 25% opacity. The 
lower the Emission Alpha Cutoff value, the more cells appear. For this parameter to be 
effective, the alpha channel must have areas of varying transparency.
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•	 Start Point: Value sliders (available when Shape is set to Line or Wave) to define, in 
X and Y coordinates, the first point of the line or wave on which the elements are 
positioned. Click the disclosure triangle to modify the Z position (depth) of the start 
point. You can adjust these values in the canvas using the onscreen controls (with the 
Adjust Item tool selected in the canvas toolbar).

•	 End Point: Value sliders (available when Shape is set to Line or Wave) to define, in X and 
Y coordinates, the end point of the line or wave on which the elements are positioned. 
Click the disclosure triangle to modify the Z position (depth) of the end point. You can 
adjust these values in the canvas using the onscreen controls (with the Adjust Item tool 
selected in the canvas toolbar).

•	 Amplitude: A slider (available only when Shape is set to Wave) to define half the 
distance from the highest point to the lowest point in the wave. Higher values result in 
more extreme waves.

•	 Frequency: A slider (available only when Shape is set to Wave) to define the number of 
waves. The default is value is 1.

•	 Phase: A dial (available only when Shape is set to Wave) to define the degree of offset 
of the waves from the start and end points of the path. When set to 0 degrees (default), 
the wave begins and ends at half the distance from the highest point to the lowest point 
in the wave. When set to 90 degrees, the wave begins and ends at the highest point in 
the wave. When set to –90 degrees, the wave begins at the lowest point in the wave. 
When set to 180 degrees, the waves are the same as at 0 degrees, but are inverted.

•	 Damping: A slider (available only when Shape is set to Wave) to set the diminishing 
oscillation of the wave. Positive damping values diminish the wave forward (from left to 
right); negative values diminish the wave backward (from right to left).
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•	 Points: A slider that does the following:

•	 When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement 
is set to Outline or Random Fill, specifies the number of evenly distributed element 
points along the edge of the shape. 

•	 When Shape is set to Line or Wave, specifies the number of evenly distributed 
element points on the line or wave. 

•	 When Shape is set to Geometry, specifies the number of evenly distributed element 
points around the shape.

When the Adjust Item tool is selected in the canvas toolbar, these points are visible in 
the canvas.

•	 Offset: A slider that does the following: 

•	 When Shape is set to Line or Wave, moves the elements along the line or wave.

•	 When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is 
set to Outline, moves the elements along the edge of the shape.

•	 When Shape is set to Geometry, moves the position of the elements along the edge 
of the shape.

•	 Build Style: A pop-up menu and related controls to specify how elements are built 
over the replicator shape. When Shape is set to Rectangle, Circle, or Image, and 
Arrangement is set to Outline; or when Shape is set to Geometry, the pop-up menu 
contains the following options:

•	 Clockwise: Places the elements along the shape in a clockwise direction.

•	 Counter Clockwise: Places the elements along the shape in a counterclockwise 
direction.



578Motion User Guide

When Shape is set to Rectangle or Image, and Arrangement is set to Tile Fill, and 
Origin is set to Upper Left, Upper Right, Lower Left, or Lower Right, the Build Style 
pop-up menu contains the following options:

•	 Across: Builds the elements across the pattern in the direction implied by the 
Origin parameter.

•	 By Row: Builds the elements over the pattern by row.

•	 By Column: Builds the elements over the pattern by column.

When Shape is set to Box, and Arrangement is set to Tile Fill, and Origin is set to 
Front Upper Left, Front Upper Right, Front Lower Left, Front Lower Right, Back 
Upper Left, Back Upper Right, Back Lower Left, or Back Lower Right, the Build Style 
pop-up menu contains the following options:

•	 Across: Builds the elements across the pattern in the direction implied by the 
Origin parameter.

•	 By Row, Column, Rank: Builds the elements over the pattern by row, column, then 
rank starting from the Origin.

•	 By Column, Row, Rank: Builds the elements over the pattern by column, row, then 
rank starting from the Origin.

•	 By Row, Rank, Column: Builds the elements over the pattern by row, rank, then 
column starting from the Origin.

•	 By Column, Rank, Row: Builds the elements over the pattern by column, rank, 
then row starting from the Origin.

•	 By Rank, Row, Column: Builds the elements over the pattern by rank, row, then 
column starting from the Origin.

•	 By Rank, Column, Row: Builds the elements over the pattern by rank, column, 
then row starting from the Origin.

•	 Radius: A slider (available when Shape is set to Burst, Spiral, Circle, or Sphere) to set 
the size of the selected shape.

•	 Twists: A slider (available only when Shape is set to Spiral) to set the number of turns in 
a spiral. The default value is 0.25. When Number of Arms is set to one, a single spiral is 
created.

•	 Number of Arms: A slider (available only when Shape is set to Burst or Spiral) to set the 
number of branches on which the elements are positioned. The default value is 3.
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•	 Points Per Arm: A slider (available only when Shape is set to Burst or Spiral) to set the 
number of element points on each branch of the burst or spiral. When the Adjust Item 
tool is selected in the canvas toolbar, the points are visible in the canvas.

•	 Columns: A slider (available when Shape is set to Rectangle, Circle, or Image, and 
Arrangement is set to Tile Fill; or when Shape is set to Box or Sphere and Arrangement 
is set to Outline or Tile Fill) to specify the number of vertical columns on a grid over 
the selected replicator. In irregular shapes (nonrectangular), points that fall outside the 
shape are ignored.

•	 Rows: A slider (available when Arrangement is set to Tile Fill) to set the number 
of horizontal rows on a grid over the selected replicator. In irregular shapes 
(nonrectangular), points that fall outside the shape are ignored. This control is also 
available for Box and Sphere when Arrangement is set to Outline or Tile Fill. 

•	 Ranks: A slider (available when Shape is set to Box and Arrangement is set to Tile 
Fill or Outline; or when Shape is set to Sphere and Arrangement is set to Tile Fill) to 
specify the number of points in Z space (depth) on a grid over the selected replicator. In 
irregular shapes (nonrectangular), points that fall outside the shape are ignored.

•	 Tile Offset: A slider (available when Shape is set to Rectangle, Circle, Image, Box, or 
Sphere, and Arrangement is set to Tile Fill) to specify the amount (in percentage points) 
that the elements are offset from the pattern. Values from 0 to 100% offset the rows 
toward the right, and values from 0 to –100% offset the rows toward the left. A value of 
50 or –50% creates a brickwork pattern. 
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•	 Origin: A pop-up menu to specify how the elements traverse across the pattern from a 
point of origin. For example, when set to Left, the elements sweep across the pattern 
from left to right. When set to Upper Right, the elements traverse from the upper-right 
corner point of the shape to the lower-right corner.

When Shape is set to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set 
to Tile Fill or Random Fill the Origin pop-up menu contains the following options:

•	 Upper Left: Elements originate in the upper-left corner of the pattern and end in the 
lower-right corner.

•	 Upper Right: Elements originate in the upper-right corner of the pattern and end in 
the lower-left corner.

•	 Lower Left: Elements originate in the lower-left corner of the pattern and end in the 
upper-right corner.

•	 Lower Right: Elements originate in the lower-right corner of the pattern and end in 
the upper-left corner.

•	 Center: Elements originate in the center of the pattern and move outward. This is the 
default Origin option.

•	 Left: Elements originate at the left side of the pattern and end at the right side.

•	 Right: Elements originate at the right side of the pattern and end at the left side.

•	 Top: Elements originate at the top of the pattern and end at the bottom.

•	 Bottom: Elements originate at the bottom of the pattern and end at the top.

When Shape is set to Circle or Sphere, and Arrangement is set to Tile Fill or Random 
Fill, the Origin pop-up menu contains the following options:

•	 Center: Elements originate in the center of the pattern and build outward. This is the 
default Origin option.

•	 Edge: Elements originate along the edge of the pattern and build inward.

When Shape is set to Box, and Arrangement is set to Tile Fill or Random Fill, the Origin 
pop-up menu contains the following options:

•	 Front Upper Left: Elements originate in the front upper-left corner of the pattern and 
end in the back lower right.

•	 Front Upper Right: Elements originate in the front upper-right corner of the pattern 
and end in the back lower left.

•	 Front Lower Left: Elements originate in the front lower-left corner of the pattern and 
end in the back upper right.
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•	 Front Lower Right: Elements originate in the front lower-right corner of the pattern 
and end in the back upper left.

•	 Back Upper Left: Elements originate in the back upper-left corner of the pattern and 
end in the front lower right.

•	 Back Upper Right: Elements originate in the back upper-right corner of the pattern 
and end in the front lower left.

•	 Back Lower Left: Elements originate in the back lower-left corner of the pattern and 
end in the front upper-right.

•	 Back Lower Right: Elements originate in the back lower-right corner of the pattern 
and end in the front upper-left.

•	 Left: Elements originate at the left side of the pattern and end at the right side. The 
pattern is identical on each row.

•	 Right: Elements originate at the right side of the pattern and end at the left side. The 
pattern is identical on each row.

•	 Top: Elements originate at the top of the pattern and end at the bottom. The pattern 
is identical on each rank.

•	 Bottom: Elements originate at the bottom of the pattern and end at the top. The 
pattern is identical on each rank.

•	 Front: Elements originate at the front of the pattern and end at the back. The pattern 
is identical on each column.

•	 Back: Elements originate at the back of the pattern and end at the front. The pattern 
is identical on each column.

•	 Center: Elements originate in the center of the pattern and move outward. This is the 
default Origin option.

•	 X Axis: Elements originate along the X axis of the pattern and move outward.
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•	 Y Axis: Elements originate along the Y axis of the pattern and move outward.

•	 Z Axis: Elements originate along the Z axis of the pattern and move outward.

Note: The Origin pop-up menu also determines where the Sequence Replicator behavior 
starts its animation. For more information on the Sequence Replicator behavior, see 
Apply the Sequence Replicator behavior.

•	 Shuffle Order: A checkbox that, when selected, rearranges the order in which the 
elements appear.

•	 Replicate Seed: A random seed generator button and field (available when Shape is set 
to Rectangle, Circle, Image, Box, or Sphere, and Arrangement is set to Random Fill) to 
modify the Random Fill pattern. Click the button to right of the seed value set a new 
random seed number.

Although the result of the Random Fill option from the Arrangement pop-up menu 
seems random, it’s deterministic. This means that the random variation in the pattern is 
created based on the number shown. Unless this seed number is changed, a replicator 
with the same parameter settings and source object always appears the same. If you 
don’t like the current random fill, you can change the seed number by typing a new 
number or clicking Generate. This changes the random calculations performed for that 
pattern. This parameter is also used to randomize the Shuffle Order parameter.

•	 3D: A checkbox that, when selected, enables the Box and Sphere options in the Shape 
pop-up menu.
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•	 Reverse Stacking: A checkbox that, when selected, inverts the order in which elements 
are stacked. To see the effect of this parameter, elements must be overlapping.

•	 Face Camera: A checkbox (available when the 3D checkbox is selected) that forces 
pattern elements to face the camera when the camera or the replicator is rotated. 
When Face Camera is deselected, the elements face forward in the replicator pattern 
and appear flat (unless the source layer or pattern elements are rotated in 3D space). 
Because Motion does not support 3D objects (other than 3D text), this option is key to 
giving 2D layers the appearance of 3D as the camera is animated.

Note: Because replicator pattern elements are 2D (flat) objects (unless 3D text is 
used as the replicator source), the pattern elements are not visible when you use the 
orthogonal reference camera views, such as Left, Right, and Top (unless the source 
layer or pattern elements are rotated in 3D space). This is because orthogonal views are 
at right angles (perpendicular) to the elements. For more information on using cameras, 
see Intro to 3D cameras.

Create a custom replicator shape in Motion

Two settings in the Shape pop-up menu (in the Replicator Inspector) let you set a custom 
layout pattern for elements in the replicator: 

•	 Geometry: Places elements in the replicator pattern along the outline of a custom 
geometry shape (a circle or Bezier shape, for example). 

•	 Image: Places elements in the replicator pattern along the outline of (or as a fill within) 
an image or video clip. 
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Use a geometry object as the shape source of the replicator pattern
1.	 Add a shape as a new layer in your Motion project.

2.	 In the Layers list, select the replicator, then, in the Replicator Inspector, click the Shape 
pop-up menu and choose Geometry.

The Shape Source well appears in the Inspector and HUD.

3.	 From the Layers list, drag the shape to the Shape Source well.

4.	 When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and is used as the source for the shape of 
the replicator. To hide the original shape you created in step 1, deselect its checkbox in 
the Layers list.

Note: Image objects cannot be used as a shape source when the Shape pop-up menu is 
set to Geometry.

Use an image as the shape source of the replicator pattern
1.	 Add a shape or other image that contains an alpha channel as a new layer in your 

Motion project.

2.	 In the Layers list, select the replicator, then, in the Replicator Inspector, click the Shape 
pop-up menu and choose Image.

The Image Source well appears in the Inspector and HUD.
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3.	 From the Layers list, drag the image into the Image Source well, and when the pointer 
becomes a curved arrow, release the mouse button.

A thumbnail of the image appears in the well and is used as the source for the shape 
of the replicator pattern. To hide the original shape you created in step 1, deselect its 
checkbox in the Layers list.

If your source image has areas of varying transparency, you can set a minimum opacity 
value necessary to create a replicator element on the source image using the Emission 
Alpha Cutoff slider. For example, when set to 50%, elements appear only at points 
where the alpha value of the image is equal to or greater than 50% opacity.

4.	 To set the type of pattern, click the Arrangement pop-up menu, then choose an option:

•	 Outline: Pattern elements are placed along the rectangular outline of the image 
source.

•	 Tile Fill: Pattern elements are flanked in rows and columns inside the borders of the 
image source.

•	 Random: Pattern elements are distributed in random fashion inside the borders of 
the image source.

Replicator cell controls in Motion

Adjust replicator cells using the controls at the bottom of the Replicator Inspector (for 
replicators with a single cell) or in the Replicator Cell Inspector (for replicators with 
multiple cells):

•	 Align Angle: A checkbox (available when Shape is set to Rectangle, Circle, Image, Box, 
or Sphere, and Arrangement is set to Tile Fill or Random Fill) that forces replicator 
elements to rotate to match the shape they’re positioned on. 

•	 Angle: A dial to set (in degrees) the rotation of the replicator elements. When the 3D 
checkbox is selected in the Replicator Inspector, the default dial modifies the Z angle. 
To modify the rotation of the pattern elements on all three axes (X, Y, and Z), click the 
disclosure triangle and adjust the X, Y, and Z dials. When the 3D checkbox is selected, 
this parameter group also displays the Animate pop-up menu (described below).
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•	 Animate: A pop-up menu (available as a subparameter of the Angle parameter when the 
3D checkbox is selected) that sets the angle interpolation for keyframed animation of 
the Angle parameter. There are two menu choices: 

•	 Use Rotation: The default interpolation method. When the Angle parameter is 
keyframed, pattern elements rotate from their start rotation to their final rotation. 
Depending on the animation, the elements may twist before reaching their final 
orientation (the last keyframed value). For example, if the X, Y, and Z Angle 
parameters are animated from 0 degrees to 180 degrees in a project, the elements 
rotate on all axes before reaching their final orientation.

•	 Use Orientation: This alternate interpolation method provides smoother animation 
but does not allow multiple revolutions. It interpolates between the pattern elements’ 
start orientation (first keyframe) and their end orientation (second keyframe).

•	 Angle End: A dial to set (in degrees) the rotation of the replicator elements at the end of 
the pattern. The angle value of the elements at the end of the pattern equals the Angle 
value (start) plus the Angle End value. For example, if Angle is set to 0 degrees and 
Angle End set to 90 degrees, the elements are not rotated at all at their origin, and are 
rotated by 90 degrees at the end of the pattern.

In a 3D project, using the default dial modifies the Z angle. To modify the rotation of the 
pattern elements on all three axes (X, Y, and Z), click the disclosure triangle and adjust 
the individual X, Y, and Z dials. When the 3D checkbox is selected, this parameter group 
also displays the Animate pop-up menu (described below).

•	 Animate: A pop-up menu (available as a subparameter of the Angle End parameter 
when the 3D checkbox is selected) that sets the angle interpolation for keyframed 
animation of the Angle parameter. There are two menu choices:

•	 Use Rotation: This is the default interpolation method. When the Angle End 
parameter is keyframed, pattern elements rotate from their start rotation to 
their final rotation. Depending on the animation, the elements may twist before 
reaching their final orientation (the last keyframed value). For example, if the X, Y, 
and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, 
the elements rotate on all axes before reaching their final orientation.

•	 Use Orientation: This alternate interpolation method provides smoother animation 
but does not allow multiple revolutions. It interpolates between the pattern 
elements’ start orientation (first keyframe) and their end orientation (second 
keyframe).
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•	 Angle Randomness: A dial that defines an amount of variance in the rotation of 
replicator elements. A value of 0 results in no variance—all elements have the same 
rotational value. A value greater than 0 introduces a variance. The angle for an element 
is defined by the Angle and Angle End parameter, plus or minus a random value falling 
within the range set in Angle Randomness parameter.

In a 3D project, using the default dial or value slider (when the disclosure triangle is 
closed), modifies the Z angle. To modify the rotation of the pattern elements on all 
three axes (X, Y, and Z), click the disclosure triangle and adjust the X, Y, and Z dials. 
When the 3D checkbox is selected, this parameter group also displays the Animate 
pop-up menu (described below).

•	 Animate: A pop-up menu (available as a subparameter of the Angle Randomness 
parameter when the 3D checkbox is selected) that sets the angle interpolation for 
keyframed animation of the Angle Randomness parameter. There are two menu 
choices:

•	 Use Rotation: This is the default interpolation method. When the Angle 
Randomness parameter is keyframed, pattern elements rotate from their start 
rotation to their final rotation. Depending on the animation, the elements may 
twist before reaching their final orientation (the last keyframed value). For 
example, if the X, Y, and Z Angle parameters are animated from 0 degrees to 180 
degrees in a project, the elements rotate on all axes before reaching their final 
orientation.

•	 Use Orientation: This alternate interpolation method provides smoother animation 
but does not allow multiple revolutions. It interpolates between the pattern 
elements’ start orientation (first keyframe) and their end orientation (second 
keyframe).

•	 Additive Blend: By default, replicator elements are composited together using the 
Normal blend mode. Select this checkbox to composite all overlapping elements using 
the Additive blend mode, to intensify the brightness of overlapping objects. This 
blending occurs in addition to the compositing method set in the Blend Mode parameter 
in Properties Inspector. 

•	 Color Mode: A pop-up menu to specify how replicator elements are tinted. There are 
five menu options:

•	 Original: Elements are created using the original colors from the source layer. When 
this setting is chosen, the Opacity Gradient editor becomes available (described 
below). 
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•	 Colorize: Elements are tinted using the color specified in the Color parameter. 
When this setting is chosen additional Color and Opacity Gradient controls become 
available (described below).

•	 Over Pattern: Elements are tinted based on how they’re ordered in the pattern. When 
Over Pattern is chosen, the Color Gradient editor becomes available (described 
below).

•	 Pick From Color Range: Elements are tinted at random, with the range of possible 
colors and transparency defined by the Color Range gradient editor (described 
below). A point on the gradient is randomly chosen, so the relative sizes of each 
color region determine the frequency of the color being used.

For more information on using the gradient controls, see Change gradient color and 
opacity.

•	 Take Image Color: Each element’s color is based on the color of the image at the 
position of the element point. This mode is only available when an image in used as 
the replicator shape.

•	 Color: This color well becomes available when the Color Mode is set to Colorize. Use it 
to specify a color to tint replicator elements. You can also alter each element’s opacity. 
This parameter is unique to the cell object. You can click the color well to choose a 
color, or open the disclosure triangle and use the Red, Green, Blue, and Opacity channel 
sliders or value sliders.

•	 Opacity Gradient: A gradient editor (available when Color Mode is set to Original or 
Colorize) to change the opacity of replicator elements over the pattern. This gradient 
control is limited to grayscale values, used to represent varying levels of transparency. 
White represents solid elements; progressively darker levels of gray represent 
decreasing opacity; and black represents complete transparency. A simple white 
to black gradient represents a pattern that is solid at its origin, but which fades out 
gradually. For more information on using gradient and opacity gradient controls, see 
Change gradient color and opacity.
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•	 Color Gradient: A gradient editor (available when Color Mode is set to Over Pattern) to 
specify the range of color and transparency of the pattern, beginning with the leftmost 
color in the gradient, then progressing through the range of colors to the rightmost 
color at the end of the pattern. 

Gradual color changes do not appear in each element, but only across the pattern as a 
whole.

An Opacity control is available at the top of the gradient editor. 

•	 Color Range: A gradient editor (available when Color Mode is set to Pick From Color 
Range) to specify the range of colors and transparency used to randomly tint the 
pattern.

•	 Color Repetitions: A slider (available when Color Mode is set to Over Pattern) to set the 
number of times the gradient is repeated over the pattern. 

•	 Scale: A slider to set the scale of replicator elements. By default, Scale is set to 100%—
the size of the replicator elements is equal to the size of the source layer. Click the 
disclosure triangle next to the Scale parameter to reveal separate X, Y, and Z scaling 
subparameters. Use X and Y to resize the width and height of elements separately; use 
Z to change the depth of 3D text elements.
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•	 Scale End: A slider to set the scale of the replicator elements at the end of the pattern, 
relative to the Scale value. For example, if Scale is set to 100% and Scale End set to 
50%, the elements are 100% at their origin and half their size at the end of the pattern. 
Click the disclosure triangle next to the Scale End parameter to reveal separate X, Y, 
and Z scaling subparameters. Use X and Y to resize the width and height of elements 
separately; use Z to change the depth of 3D text elements.

•	 Scale Randomness: A slider to set an amount of variance in the scale of replicator 
elements. A value of 0 results in no variance—all elements in the pattern are the 
same size. A value greater than 0 introduces a variance. The scale for an element is 
defined by the Scale parameter, plus or minus a random value falling within the range 
of values set in Scale and the Scale End. Click the disclosure triangle next to the Scale 
Randomness parameter to reveal separate X, Y, and Z scaling subparameters. Use X 
and Y to resize the width and height of elements separately; use Z to change the depth 
of 3D text elements.

•	 Play Frames: A checkbox (available when the replicator uses a QuickTime object as 
the source for a cell) that loops playback of the animation or video clip used for each 
element. If this checkbox is deselected, the animation or clip is frozen at the still frame 
specified by the Random Start Frame parameter or the Source Start Frame parameter 
(described below).

•	 Random Start Frame: A checkbox (available when the replicator uses a QuickTime 
object as the source for a cell) that introduces variation so that each element in 
the pattern begins at a different frame of the clip. If the Play Frames checkbox is 
deselected, still frames are chosen randomly.

•	 Source Start Frame: A slider (available when the replicator uses a QuickTime object 
as the source for a cell and if Random Start Frame is deselected) that designates the 
start frame of the clip (when the Play Frames checkbox is selected) or the still frame to 
display (when Play Frames is deselected).
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•	 Source Frame Offset: A slider (available when the replicator uses a QuickTime object as 
the source for a cell and Random Start Frame is deselected) to offset the start frame 
chosen in the Source Start Frame slider. At their origin, the elements play the animation 
from the frame specified in the Source Start Frame slider. Each adjacent pattern 
element in the canvas advances the start frame by the offset amount.

•	 Hold Frames: A slider (available when the replicator uses a QuickTime object as the 
source for a cell) to set the number of times each frame of the source movie is repeated 
during playback. The larger the Hold Frames value, the slower your playback.

•	 Hold Frames Randomness: A slider (available when the replicator uses a QuickTime 
object as the source for a cell) to vary the number of frames to hold.

•	 Show Objects As: A pop-up menu that sets whether replicator elements are displayed 
in a preview mode or as they actually appear. The nonimage modes play back more 
efficiently when viewing a complex replicator pattern. By default, this pop-up menu is 
set to Image, which displays each element as it is supposed to appear. Choose one of 
the following four options:

•	 Points: Displays each element as a single point. This is the fastest preview mode. 
When you choose Points, the Point Size slider appears, allowing you to increase the 
size of the points for easier viewing. In the following image, the Point Size is set to 8.
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•	 Lines: Displays each element as a line. This option is effective only when elements of 
the replicator are animated using Simulation behaviors or the Throw (Basic Motion) 
behavior. The movement of each pattern element is represented by a line; use this 
view to analyze motion vectors of elements. The length of each line is determined by 
that element’s speed, and the angle of each line equals each element’s direction. In 
the following image, the replicator elements are animated using the Vortex behavior.

Note: Element movement created by the Sequence Replicator behavior or by 
keyframing the replicator parameters is not displayed.

•	 Wireframe: Displays each element as a bounding box. Because the bounding boxes 
are good indicators of each element’s orientation in the pattern, this preview mode 
is useful for evaluating the movements of individual elements. For example, it’s easy 
to see the angle of rotation for elements that are spinning or following a complex 
motion path.

•	 Image: Displays elements as they will appear in your final render. This is the default 
setting.

Note: The option chosen in the Show Objects As pop-up menu appears in your final 
render. 
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•	 Random Seed: Sets the values applied to the Angle Randomness, Scale Randomness, 
Pick From Color Range, Random Start Frame, or Hold Frame Randomness parameters 
seems random. In other words, random variation in the pattern is created based on 
the number shown in the Random Seed field. Unless this seed number is changed, a 
replicator with the same parameter settings appears the same. If you don’t like the 
current random scale or angle, change the seed number by typing a new number the 
field or by clicking Generate.

•	 Object Source: An image well displaying a thumbnail of the replicator cell. To swap out a 
cell, drag a new source layer from the Layers list to the Object Source well.

In a replicator with multiple cells, each cell appears in a separate image well listed at 
the bottom of the Replicator Inspector. A checkbox lets you enable or disable that cell.

Adjust additional replicator properties in Motion
You can modify a replicator’s position, scale, blend mode, drop shadow, and other basic 
attributes in the Properties Inspector. These properties are separate from the replicator 
parameters in the Replicator and Replicator Cell Inspectors, which control the shape and 
size of the replicator, as well as all aspects of its pattern and cells. 

1.	 In Motion, select a replicator in the Layers list, Timeline, or canvas.

2.	 In the Inspector, click Properties.

3.	 Adjust the controls.

For detailed information about the Properties Inspector, see Properties Inspector controls.

Note: When you select a replicator cell (as opposed to the replicator, itself) and open the 
Properties Inspector, only one group of parameters is available: the Timing controls, which 
adjust the In and Out points of the replicator cell.
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Animate replicators

Animating replicators in Motion
By adding behaviors or keyframes to a replicator or its cells, you can quickly animate the 
pattern of replicated images in complex, dramatic ways:

•	 Apply Basic Motion or Simulation behaviors to a replicator object to animate an entire 
replicator pattern as a whole; or apply those behaviors to replicator cells to animate 
each element in the pattern symmetrically. To make replicator elements interact with 
other objects in your project, apply a Simulation behavior to the replicator or another 
object (an object that’s not part of the replicator). For example, applying the Orbit 
Around behavior to an object will cause replicator elements to circle around that object. 

•	 Use the Sequence Replicator behavior—a special behavior designed for replicators—to 
animate individual pattern elements in turn over time, without creating keyframes. 

•	 Use Parameter behaviors to animate individual parameters in the Replicator Inspector or 
Replicator Cell Inspector.

•	 Use keyframes to animate individual parameters in the Replicator Inspector or 
Replicator Cell Inspector. Or use keyframes in the Properties Inspector to animate a 
replicator’s position, rotation, or opacity over time. 

Apply behaviors to replicators in Motion
You can apply Basic Motion, Parameter, and Simulation behaviors to a replicator. Some 
behaviors can be applied directly to replicator cells, such as Throw and Spin (from the 
Basic Motion subcategory) and Gravity and Edge Collision (from the Simulation category).

In Motion, do one of the following:

•	 Drag a behavior from the Library onto a replicator or replicator cell in Layers list or 
Timeline.

•	 Select a replicator or replicator cell in the Layers list or Timeline, then click the 
Behaviors in the toolbar and choose a behavior from the pop-up menu.

The behavior is applied to the replicator or cell, which begins to move according to the 
parameters of the behavior.

Not all behaviors instantly activate a layer when applied. For example, when you apply 
the Throw behavior to a layer, you must adjust the Throw Velocity parameter to make 
the layer move.

See Intro to behaviors.

As previously noted, the replicator also has a special behavior called Sequence Replicator, 
which animates individual cells in sequence over time. See Apply the Sequence Replicator 
behavior.
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Replicator behavior considerations in Motion
When you apply one of the Simulation behaviors, or the Spin or Throw behavior, to a 
replicator that already has keyframed animation, some animation created by the keyframes 
is ignored. For example, if you keyframe the Angle parameter in the Cell Controls of the 
Replicator Inspector to make the pattern elements rotate over time, and then you apply a 
Spin behavior—with the Affect Subobjects checkbox selected—the elements ignore the 
replicator’s Angle keyframes and rotate according to the rate set in the Spin behavior 
parameters. To rotate the entire replicator layer and enable the Angle keyframe animation, 
deselect Affect Subobjects in the Spin parameters.

Apply the Sequence Replicator behavior in Motion
The Sequence Replicator behavior animates elements of a replicator in sequence over time. 
This is the only way to animate elements individually—keyframing the cell parameters or 
applying other behaviors affects all elements in the pattern uniformly.

Using the Sequence Replicator behavior, you can select and apply replicator cell 
parameters such as Position, Color, Scale, Rotation, or Opacity, then animate those 
parameters in a cascading sequence that passes through each element in a replicator 
pattern.

The starting point for the sequence animation is based on the replicator’s origin or build 
style. For example, if a spiral replicator’s Origin parameter is set to Center, the sequence 
animation begins at the center of the spiral and moves outward.

You can apply the Sequence Replicator behavior to a replicator or to its cells. Either 
method results in the same animation.

Note: After you create a Sequence Replicator behavior, you can save it to the Library as a 
custom behavior.
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Apply the Sequence Replicator behavior
In Motion, do one of the following:

•	 In the Layers list or Timeline, select a replicator or replicator cell, click Behaviors in the 
toolbar, then choose Replicator > Sequence Replicator.

•	 In the Library, select the Behaviors category, select the Replicator subcategory, then 
drag the Sequence Replicator from the stack to a replicator or replicator cell in the 
Layers list, Timeline, or canvas.

The Sequence Replicator controls appear in the Behaviors Inspector. For the behavior to 
have any effect on the replicator, you must add parameters using the Parameter pop-up 
menu at the top of the Sequence Replicator controls. For details, see the next task.

Add and animate parameters in the Behaviors Inspector
After you apply the Sequence Replicator behavior to a replicator, you must assign one 
or more parameters for the behavior to modify. In the following example, the Rotation, 
Opacity, and Scale parameters are assigned to the Sequence Replicator behavior in the 
Behaviors Inspector.

1.	 In the Layers list or Timeline in Motion, select the Sequence Replicator behavior.

2.	 In the Parameter row of the Behaviors Inspector, do the following:

a.	 Click the Add pop-up menu, then choose Rotation.

b.	 Click the Add pop-up menu, then choose Opacity.

c.	 Click the Add pop-up menu, then choose Scale.

The added parameters appear above the Add and Remove pop-up menus. No 
animation occurs until you set a value for the parameters.
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3.	 Ensure that keyframe recording is turned off (make sure the Record button in the timing 
toolbar is not highlighted solid red).

4.	 In the Behaviors Inspector, drag the Rotation dial to set a spin value. 

In this example, Rotation is set to 160 degrees, so that each element rotates from 0 
degrees to 160 degrees over the pattern for the duration of the Sequence Replicator 
behavior.

Note: If the elements are already rotated (in the Cell Controls), the elements are rotated 
160 degrees from their original rotation value.

Play your project (press the Space bar). Each element rotates 160 degrees in sequence, 
popping into place before the next element begins rotating.

5.	 To ease the transition between each element’s animation, drag the Spread value slider 
to the right.

In this example, Spread is set to 12. In addition to creating a more graceful animation, 
changing the Spread value can also dramatically change the appearance of the pattern.

6.	 Drag the Opacity slider to the lowest value you want the elements to fade to during the 
animation. 
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In this example, Opacity is set to 0. Each element fades from 100% opacity to 0% 
opacity over the duration of the Sequence Replicator behavior.

Note: If the elements already contain some transparency, they fade from their original 
opacity value to 0%.

7.	 Drag the Scale slider to the right to increase the size of each element over time. 

In this example, Scale is set to 190%.

When you play your project, the animation begins at the original value for any added 
parameter, then transforms to the value you specified in the Sequence Replicator 
parameters. The animation begins at the origin of the pattern (set in the Origin or Build 
Style parameter of the Replicator Inspector or HUD) and moves to through the elements to 
the end of the pattern.
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Change the way the sequence moves through the pattern
After you apply parameters to the Sequence Replicator behavior, you can use Sequence 
Controls parameters to change the way the sequence moves through the replicator pattern. 
The following task continues with the project used in the previous example.

1.	 In Motion, with the Sequence Replicator behavior selected, play the project (press the 
Space bar) to see the effects of the sequencing.

By default, the Sequencing parameter (in the Behaviors Inspector) is set to “To,” which 
specifies that the animation begins at the original value of the cells and moves to the 
value set in the Sequence Replicator behavior for that parameter. The starting point for 
the sequence animation is based on the build or origin of the pattern (as defined in the 
Origin or Build Style parameters in the Replicator Inspector). In the current example, 
the elements begin completely opaque, at 100% scale, and with 0 degrees of rotation 
at the origin of the pattern. As the sequence moves toward the end of the pattern, the 
elements become completely transparent, are scaled to 190%, and are rotated 160 
degrees.

2.	 In the Behaviors Inspector, click the Sequencing pop-up menu, then choose From.

Play your project. The animation now moves from the value set in the Sequence 
Replicator behavior to the original value of the cells. This is the opposite of the To 
Sequencing option.

3.	 Click the Sequencing pop-up menu, then choose Through.

Play your project. The sequence goes through a full animation cycle starting at the 
original value of the cells, moving to the value set in the Sequence Replicator, then 
returning to the original value of the cells. This is similar to combining the To and From 
Sequencing options.
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4.	 Click the Unit Size pop-up menu, then choose All.

When you play your project, the sequence animation affects all replicator elements 
simultaneously. The default Unit Size setting is Object, which applies the sequence 
animation to the elements of the replicator based on the origin of the pattern.

5.	 Drag the Loops slider to the right to set a value of 3.

When you play your project, the sequence loops three times.

6.	 In the Behaviors Inspector, click the End Condition pop-up menu, then choose Ping 
Pong.

By default, the End Condition parameter is set to Hold, which completes a sequence 
animation cycle, then starts the cycle again from the beginning. When End Condition 
is set to Ping Pong, the animation cycles forward one time, then cycles backward, then 
forward, and so on.

Note: The End Condition parameter has no effect for Loop values less than or equal to 1.

Sequence Replicator controls in Motion
Use the following controls in the Behaviors Inspector to modify the sequence animation:

•	 Parameter: Two pop-up menus (Add and Remove) that designate pattern elements to 
animate in sequence. When you choose an item from the Add pop-up menu, additional 
controls appear at the top of the Behaviors Inspector. You can adjust these controls 
(or keyframe them) to modify the sequence animation, which is based on the change in 
value between these parameters and the original values of the cells. The Add pop-up 
menu items include the following options:

•	 Rotation: Adds a rotation dial and value slider to specify (in degrees) the rotation of 
replicator elements.

•	 Color: Adds a row of color controls to set a tint for replicator elements. Click the 
color well to choose a color or open the disclosure triangle and adjust the Red, 
Green, and Blue sliders. For more information about using color controls, see Use 
basic color controls. 

•	 Opacity: Adds an opacity slider to define the transparency of the pattern elements.

•	 Scale: Adds a scale slider to define the size of replicator elements. Click the 
disclosure triangle next to the Scale parameter to reveal separate X, Y, and Z scaling 
subparameters. Use X and Y to resize the width and height of elements separately; 
use Z to change the depth of 3D text elements. By default, Scale is set to 100%—the 
size of the replicator cells is equal to the original size defined in the cell parameters. 
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•	 Position: Adds two value fields that define the offset of elements from their original 
position in X and Y space. Click the disclosure triangle next to the parameter name 
to reveal separate X, Y, and Z position subparameters. For example, to create an 
animation in which elements move upward along the Y axis over the replicator 
pattern, enter a positive value in the Y Position field. In the following images, Y 
Position is set to 300.

•	 Sequencing: A pop-up menu to set how the sequence animation moves through the 
elements of the pattern, based on the change from the original parameter value to the 
value set in the Sequence Replicator parameters. The starting point for the sequence 
animation is based on the selected Origin or Build Style parameters (in the Replicator 
Inspector). For example, if a line replicator’s Origin parameter is set to End Point, the 
sequence animation begins at the end of the line and moves toward the start of the line 
by default. To change the starting point for the sequence animation, change the Origin 
or Build Style of the pattern in the Replicator Inspector or HUD. The Sequencing pop-up 
menu contains the following options:

•	 To: Animation begins at the original value of the cells and moves to the value set 
in the Sequence Replicator behavior for that parameter. For example, if the original 
opacity value of a cell is 100%, and opacity is set to 0% in the Sequence Replicator 
parameters, onscreen elements begin completely opaque and become completely 
transparent.

•	 From: Animation moves from the value set in the Sequence Replicator behavior to 
the original value of the cells. For example, if the original opacity value of a cell is 
100% and opacity is set to 0% in the Sequence Replicator parameters, onscreen 
elements begin completely transparent and become completely opaque. This is the 
opposite of the To option in the Sequencing pop-up menu.

•	 Through: The sequence goes through a full animation cycle starting at the original 
value of the cells, moving to the value set in the Sequence Replicator, and then 
returning to the original value of the cells. For example, if the original opacity value 
of a cell is 100% and opacity is set to 0% in the Sequence Replicator parameters, 
onscreen elements begin completely opaque, become transparent, and then become 
completely opaque again.

•	 Through Inverted: The sequence goes through an inverted animation cycle starting 
from the value set in the Sequence Replicator, moving to the original value of the 
cells, and then returning to the value set in the Sequence Replicator. For example, if 
the original opacity value of a cell is 100% and opacity is set to 0% in the Sequence 
Replicator parameters, the onscreen elements begin completely transparent, 
become opaque, and then become completely transparent. This is the opposite of 
the Through Sequencing option.
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•	 From Keyframes: Lets you use animation created in the source layer’s parameters 
(except alpha parameters). Additionally, you can keyframe how the animation moves 
through the values set in the Sequence Replicator parameters.

•	 Source: A pop-up menu (available when the Sequencing pop-up menu is set to From 
Keyframes) to enable animation created by keyframes in a replicated source layer (the 
layer that’s disabled when the replicator is created). There are two options: Use Source 
Animation and Ignore Source Animation.

•	 Unit Size: A pop-up menu to specify whether the sequence animation is applied to the 
replicator pattern as a whole, to its elements, or to a keyframed range. There are three 
options:

•	 Object: The default setting, applies the animation to each element in sequence over 
the duration of the behavior.

•	 All: Applies the sequence animation to all replicator elements simultaneously.
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•	 Custom: Lets you specify the percentage of elements in the pattern affected by the 
sequence animation simultaneously. As shown in the following images, the Object 
and All options allow you to sequence the animation through the origin or build style 
of the pattern, or through all pattern elements simultaneously.

When you choose Custom from the Unit Size pop-up menu, the Start and End 
parameters (described below) become available.

•	 Start: A slider (available when the Unit Size pop-up menu is set to Custom) to specify 
the offset of the start of the range of elements affected by the sequence animation. In 
the above image, Start is set to 10%.

•	 End: A slider (available when the Unit Size pop-up menu is set to Custom) to specify the 
end of the range of elements affected by the sequence animation. By default, End is set 
to 10%. In the above image, End is set to 30%.

Note: If the Sequencing pop-up menu is set to From Keyframes, the Custom option in 
the Unit Size parameter has no affect.

•	 Spread: A slider to control the amount of falloff of the animation. To create a softer 
transition between each element, increase the Spread value.

•	 Traversal: A pop-up menu to set the action of the sequence behavior to one of the 
following:

•	 Constant Speed: The sequence animation moves from the origin of the replicator 
pattern through the end of the pattern at a constant speed. The sequence moves in 
the direction specified in the Replicator Inspector (such as Origin or Build Style).

•	 Ease In: The sequence animation begins slowly and increases to normal speed as it 
moves through the replicator pattern.

•	 Ease Out: The sequence animation begins at normal speed and slows toward the end 
of the replicator pattern.

•	 Ease In/Out: The sequence animation begins slowly, increases to normal speed as it 
moves toward the middle of the duration of the replicator pattern, then slows as it 
reaches the end of the replicator pattern.

•	 Accelerate: The sequence animation increases in speed.

•	 Decelerate: The sequence animation decreases in speed.

•	 Custom: This option lets you keyframe how the animation moves through the 
replicator pattern. When the Traversal pop-up menu is set to Custom, the Location 
parameter replaces the Loops parameter.
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•	 Location: A slider (available when Traversal is set to Custom) to define where on the 
pattern the animation is in effect.

For more information on using the Custom Traversal option, see Control sequence 
timing with keyframes.

•	 Loops: A slider to set the number of times the animation sequences through the 
replicator pattern over its duration.

Note: Loops is not available when the Traversal parameter is set to Custom.

•	 End Condition: A pop-up menu that sets how the sequence animation is repeated over 
the duration of the replicator object. This parameter has no effect for Loop values less 
than or equal to 1. There are three End Condition options:

•	 Hold: Completes the sequence animation cycle one time, then starts it again from 
the beginning (after the last element in the sequence completes its animation).

•	 Wrap: Treats the sequence animation as a continuous loop so the spread wraps from 
the last element in the sequence to the first element.

•	 Ping Pong: Completes the sequence animation cycle forward, then completes the 
animation backward, then forward, and so on.

Control sequence timing with keyframes in Motion
When the Traversal parameter in the Sequence Replicator behavior is set to Custom, 
you can create location keyframes to specify where on the pattern the animation is in 
effect. Use the Traversal parameter to create a sequence animation that travels through 
a replicator pattern in a unique way. The following example shows how to use the Custom 
Traversal option to scale the elements around a circle replicator shape by creating 
keyframes.

Use keyframes to create custom sequence timing
1.	 In Motion, add a Sequence Replicator behavior to a replicator, then, in the Behaviors 

Inspector, add parameters and set their values.

In this example, the Scale parameter is added and the Scale value set to 200%.

2.	 Click the Traversal pop-up menu, then choose Custom.

3.	 Press A to enable keyframe recording, then move the playhead to the frame where you 
want to begin the animation.
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4.	 In the Behaviors Inspector, drag the Location slider (or use the adjacent value slider) to 
set where the sequence begins.

As you drag the slider, the sequence moves through the pattern elements. Location 
values specify (in percentage points) where in the pattern animation is occurring, with 
0% representing the origin of the pattern, and 100% representing the end of the pattern.

A keyframe is added to the Location parameter.

5.	 Go to the next frame where you want to set a keyframe, the adjust the Location slider.

Another keyframe is added to the Location parameter.

6.	 Repeat step 5 until you create all your keyframes.

7.	 Press A again to turn off keyframe recording.

8.	 Play the project (press the Space bar).

The animation moves through the replicator pattern based on its keyframed locations. In 
this case, the scale moves erratically back and forth around the circle, rather than in a 
constant direction.
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Use Parameter behaviors with Sequence Replicator in 
Motion
You can add Parameter behaviors to Sequence Replicator parameters to create even more 
varied, complex effects without keyframing. (Parameter behaviors are a special kind of 
behavior applied to a specific parameter of an object. See Intro to Parameter behaviors.)

Apply a Parameter behavior to a Sequence Replicator behavior
1.	 In Motion, add a Sequence Replicator behavior to a replicator.

2.	 In the Layers list or Timeline, select the Sequence Replicator behavior.

3.	 In the Behaviors Inspector, Control-click the parameter you want to add a Parameter 
behavior to, then choose a behavior from the Add Parameter Behavior submenu.

Note: You can add a Parameter behavior only to a parameter that has an Animation 
menu (which appears as a down arrow when you place the pointer over the right side of 
a parameter row in the Inspector).

The Parameter behavior is added and appears above the Sequence Replicator behavior 
in the Behaviors Inspector. A behavior icon appears in the Animation menu of the 
Sequence Replicator parameter.

Note: When the Wriggle or Randomize parameter behavior is added to a Sequence 
Replicator parameter, the Affect Subobjects checkbox becomes available. Select 
the checkbox if you want each element in the pattern to display a different random 
behavior.

For more information about applying and adjusting Parameter behaviors, see Add or 
remove a Parameter behavior.
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Display replicator animation curves in Motion
When you keyframe parameters in the Properties Inspector, Replicator Inspector, and 
Replicator Cell Inspector, you can view the resulting keyframe curves in the Keyframe 
Editor.

Different parameters (and their keyframe curves) appear in the Keyframe Editor depending 
on which layer you select in the Layers list:

•	 Select the replicator layer to display animated parameters of the Replicator Inspector, 
such as Position and Rotation in the Properties Inspector, or Size or Tile Offset 
(available when the shape is a rectangle).

•	 Select the cell layer to display animated parameters of the Replicator Cell Inspector, 
such as Angle or Scale.

See Intro to keyframing.

1.	 In Motion, click the Show/Hide Keyframe Editor button on the right side of the timing 
toolbar (above the Timeline).

The Keyframe Editor opens in the Timing pane. Make sure the pop-up menu in the top-
left corner of the Keyframe Editor is set to Animated.

2.	 Do one of the following:

•	 To display animation curves representing keyframed replicator parameters in the 
Properties Inspector and Replicator Inspector (Position, Rotation, Size, Tile Offset, 
and so on), select a replicator object in the Layers list or Timeline.

•	 To display animation curves representing keyframed replicator parameters in the 
Replicator Cell Inspector (Angle, Angle Randomness, and so on), select a replicator 
cell object in the Layers list or Timeline.

For more information about keyframe curves, see Choose a curve view.
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Work with 3D replicators in Motion
Two replicator pattern styles in the Shapes pop-up menu have 3D properties: Box and 
Sphere. The Box and Sphere shape options are available only when the 3D checkbox is 
selected in the Replicator Inspector. Box and Sphere replicators build a pattern of elements 
in 3D space. The 2D Rectangle and Circle replicator shapes have columns (in the Y plane) 
and rows (in the X plane), but Box and Sphere have an additional Ranks parameter, which 
adds depth (in Z space) to the replicator.

Although the Rectangle, Circle, Line, Wave, Image, and Geometry replicators have no 
inherent 3D parameters, as with any other Layer in Motion, they can be moved and rotated 
in 3D space. Additionally, Line and Wave replicator shapes have quasi-3D properties: Their 
start and end points can be moved into Z space. In the following image, the Z Start Point 
and Z End Point have been adjusted to give the replicator depth.

Create a 3D replicator
1.	 After adding a replicator to a Motion project, select the 3D checkbox in the Replicator 

Inspector.

For more information on adding a replicator to a project, see Add a replicator.

2.	 In the Replicator Inspector, click the Shape pop-up menu, then choose Box or Sphere.

If your project is not yet 3D, the replicator pattern appears flat.

3.	 If your project does not contain a camera, click Add Object in the toolbar, choose 
Camera, then click Switch to 3D.

A camera is added to the project, and your layers are converted to 3D layers.
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4.	 In the 3D view tools (in the upper-right corner of the canvas), drag in the Orbit tool (the 
center tool).

As the camera rotates, you can see that the replicator cells are aligned in Z space.

 Tip: Use Simulation behaviors to create animated replicators in 3D space that 
interact with other objects in the project. For example, use Orbit Around to make 
replicator elements circle around a target object. See Intro to Simulation behaviors.

Make replicators interact with other objects
When a replicator is a member of a 3D group, certain behaviors can be applied to pull 
replicator pattern elements out of their X and Y planes.

1.	 After adding a replicator to a Motion project, select the 3D checkbox in the Replicator 
Inspector.

This example uses a burst replicator shape. For more information on adding a replicator 
to a project, see Add a replicator.

2.	 If your project does not contain a camera, click Add Object in the toolbar, choose 
Camera, then click Switch to 3D.

A camera is added to the project, and your layers are turned into 3D layers.

3.	 In the Layers list, select an object (a white circle shape in this example), and in the 
Properties Inspector, click the Position disclosure triangle, then drag in the Z value slider.

In this example, the white circle’s Z Position is set to 225.

4.	 In the Layers list, select the replicator, click Behaviors in the toolbar, then choose 
Simulations > Attracted To.

No animation occurs until an object is assigned to the Attracted To behavior.

5.	 With the Attracted To behavior selected in the Layers list, drag the target object (in this 
example, the white circle) to the Object well in the Behaviors Inspector.

With the default Attracted To settings, the entire replicator pattern moves (as a single 
unit) toward the target object.

6.	 In the Behaviors Inspector, select the Affect Subobjects checkbox. 

7.	 To play the project, press the Space bar.

As the project plays, each replicator element moves individually forward in Z space, 
toward the attractor. Under the behavior’s influence, the replicator elements move past 
their attractor element, then return to their original position.

For more information about working in 3D, see Intro to 3D compositing.
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Replicator timing in Motion
After you create a replicator, its duration can be as long or short as necessary, regardless 
of the duration of the original source layers used for the pattern cells. The duration of a 
replicator is defined by the duration of the replicator timebar in the Timeline track area. 
Changing the In or Out points of a replicator in the Properties Inspector, Timeline, or mini-
Timeline changes the duration of its timebar.

Although the duration of source layers has no effect on the replicator, the duration of each 
cell affects how long the elements created from that cell are visible in the project. You can 
change a cell’s duration by dragging its In and Out points in the Timeline. In this way, you 
can adjust the timing that defines when each cell type appears. For example, to create a 
pattern in which three types of elements appear at different times in the animation, you can 
offset the cells in the Timeline. In the following image, the “circle” cells appear first. One 
second later, the “star” cells appear. One second after that, the “square” cells appear.

 Tip: You can animate the opacity of each cell to create a fade-in effect; you do this by 
keyframing the Opacity parameter in the Replicator or the Replicator Cell Inspector.

For more information on adjusting the timing of layers in the Timeline, see Intro to the 
Timeline.

Using filters and masks with replicators in Motion
You can apply filters or masks to a replicator or to its image source (the disabled layer 
in the Layers list used to create the replicator cell). However, you cannot apply filters or 
masks to the replicator cells themselves.

Filters
When applied to the replicator, a filter affects every element of the replicator pattern. 
When applied to an image source layer, the effect of a filter is retained when the layer is 
replicated. 

For more information on applying filters to layers in your project, see Intro to filters.
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Masks
When you apply a mask to a replicator source layer, the effect of the mask is retained when 
the layer is replicated.

You can also apply a mask to the replicator object itself.

Note: Although you cannot apply masks to a 3D replicator, you can apply them to the image 
source layer used to create a cell in a 3D replicator.

For more information on working with masks, see Intro to masks and transparency.

Save custom replicators in Motion
After you create a replicator you like, you can save it as a replicator preset in the Replicator 
or Favorites category of the Library for future use. 

Save a custom replicator to the Library
1.	 In Motion, open the Library and select the Replicators, Favorites, or Favorites Menu 

category.

Note: For organizational purposes, you may find it useful to create a folder of your own 
in the Favorites or Favorites Menu category to store replicators.

2.	 From the Layers list or Timeline, drag the replicator to save into the stack at the bottom 
of the Library.

The customized replicator is saved as a file on your computer in the /Users/username/
Library/Application Support/Motion/Library/ folder (in the Replicators, Favorites, or 
Favorites Menu subfolder). Any custom layers created in Motion (such as a shape layer) 
used to create that replicator are included in the file.



612Motion User Guide

Create and edit basic text

Intro to basic text in Motion
A balanced use of type and graphics remains key to achieving the right effect in 
commercials, documentaries, title sequences, broadcast logos, corporate presentations, 
and personal video projects. No matter what style your project requires, Motion provides 
unique tools for creating dynamic text effects.

This chapter covers the basics of text creation and modification, including how to:

•	 Add text

•	 Select and modify text in the canvas

•	 Preview and apply fonts

•	 Use preset text styles

•	 Edit text in the Inspector

•	 Modify text glyphs, adjusting text character by character

After you add text and format it to your liking, you can begin to create dynamic animation 
effects (see Intro to animated text). You can also create and animate sophisticated 3D text 
(see Intro to 3D text). 
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Add text to a project

Set preferences before you add text in Motion
You can set Motion to create text at either the current frame (the frame where the playhead 
is positioned when you add the text) or at the start of the project. You can also specify a 
default duration for new text layers.

Set layer creation and duration preferences
1.	 Choose Motion > Settings (or press Command-Comma), then click the Project icon.

2.	 In the Still Images & Layers section of the Project pane, select a Default Layer Duration 
preference:

•	 Use project duration: New text layers (and any other new layers you add) run the 
length of the project. This means that if you’re working in a 300-frame project and 
you create text, the duration of the text (in the Timeline) is 300 frames.

•	 Use custom duration: New text layers (and any other new layers you add) run for 
the duration you enter in the adjacent text field (measured in seconds or frames, 
depending on the option you choose in the pop-up menu). 

3.	 Select a Create Layers At preference:

•	 Current frame: New text layers (and any other new layers you add) are created at the 
current location of the playhead.

•	 Start of project: New text layers (and any other new layers you add) are created at 
the beginning of the project, regardless of the playhead location.

Add text in Motion
You can add text to a Motion project in a number of ways.

Add basic text in the canvas
1.	 In the Layers list in Motion, select the group to add a text layer to.

Note: If no group is selected, the text is added to the last selected group (the 
underscored group in the Layers list).

2.	 In the canvas toolbar, click the Text tool (or press T).

3.	 Click in the canvas.

The insertion point flashes in the canvas. Before you enter text, an empty text layer is 
added to the project, and the Text HUD appears.
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Note: If the HUD does not appear, press F7 or click the HUD button in the toolbar.

4.	 Optional: Choose font formatting options in the Format pane of the Text Inspector or in 
the HUD.

You can choose a font type, size, alignment, and more.

5.	 Enter text. As you type, he text appears in the canvas.

Note: By default, the text layout method (adjustable in the Layout pane of the Text 
Inspector) is set to Type. The Type layout option creates no right margin. Therefore, if 
you enter a long string of text, the characters extend on a single line beyond the edge 
of the canvas until you create a manual line break (by pressing Return). The Type layout 
mode is useful when you’re working with short strings of text and also when animating 
horizontal scrolling effects in the canvas. For information on changing text layout and 
setting margins, see “Add paragraph-style text with margins that wrap,” below.

6.	 When you finish typing, do one of the following:

•	 Press Esc.

•	 Press Command-Return.

•	 In the canvas toolbar, click the Select/Transform tool.

The text is selected (and appears with a bounding box in the canvas), the Select/
Transform tool is selected, and the following occurs:

•	 The mini-Timeline and the text layer in the Layers list are labeled using the 
characters you typed.
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•	 The same text appears in the timebars of the group and layer in the Timeline.

Important: After you finish typing, press Esc or select another tool in the canvas 
toolbar—don’t use a keyboard shortcut. When the Text tool is selected, typing a 
keyboard shortcut (other than Esc) adds text to the canvas.

Add paragraph-style text with margins that wrap
When the Text tool is selected, clicking in the canvas activates basic text entry; dragging 
in the canvas activates paragraph-style text entry. Paragraph-style text is contained within 
margins that cause the text you type to wrap to the next line. You can adjust the margins of 
the paragraph to create a column of text as narrow or as wide as you like.

1.	 In the Motion canvas toolbar, click the Text tool (or press T).

2.	 Drag in the canvas.

When you release the mouse button, a paragraph-style text entry field appears in 
the canvas. The field is enclosed within a bounding box representing margins; a ruler 
appears above the bounding box. In the Layout pane of the Text Inspector, the Layout 
Method pop-up menu is set to Paragraph.
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3.	 Begin typing at the flashing insertion point.

Text automatically wraps to the next line when you reach the right margin (the right side 
of the bounding box).

Note: You can also type paragraph text in the Text editor field of the Format pane (in the 
Text Inspector).

4.	 When you finish typing, press Esc or Command-Return.

5.	 To adjust the margins, drag a handle on the bounding box. 

When text extends beyond the upper and lower edges of the text-entry field, a scroll 
control appears on the right side of the text-entry field.

For more information about text margins, see Create and adjust text margins and Text 
Margins controls.

Add text from the Inspector
After you add a blank text object to your project (by selecting the Text tool and clicking in 
the canvas), you can enter and edit text in the Text editor of the Inspector, rather than in 
the canvas. The Text editor, located at the bottom of the Text Inspector’s Format pane, is 
useful when working with large amounts of text.

1.	 In Motion, click the Text tool (or press T), then click or drag in the canvas to create a 
blank text object.

If you click in the canvas, you activate the default layout method (Type), which requires 
that you insert manual line breaks (by pressing Return) to make text wrap to a new line.

If you drag in the canvas, you activate the Paragraph layout method, which wraps text 
into a column.

2.	 In the Text Inspector, click Format to open the Format pane.

3.	 Optional: Choose font formatting options in the Format pane.

You can choose a font type, size, alignment, and more.
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4.	 Click in the Text editor at the bottom of the Format pane, then begin typing.

Note: To resize the Text editor, drag the three small gray circles along the bottom edge 
of the text field.

Import a text file
You can add plain text (TXT) or Rich Text Format (RTF) text to a Motion project. After you 
add a text file, you can edit its content the same way you edit Motion-created text. The 
appearance (font, size, layout, and so on) of the text imported from an RTF file is preserved 
(although some formatting options available in RTF files, such as text wrapping, are not 
supported in Motion); the text appearance in a TXT file is based on the settings in the 
Motion Text Inspector.

For more information about importing text files, see Using TXT and RTF files.

•	 In Motion, import the TXT or RTF file you want to use.

The text is added to the canvas, ready to be modified.
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Copy and paste text from another application
You can copy text from another document or browser and paste the text into a Motion 
project.

1.	 Open the text document (an RTF, TXT, Pages, or other text file) in a text-editing 
application.

2.	 Select and copy the text.

3.	 In the canvas toolbar of Motion, select the Text tool, click in the canvas, then choose 
Edit > Paste (or press Command-V).

Consider the following guidelines when pasting text from another application into Motion:

•	 Pasted RTF text retains the original font attributes, including family and typeface, size, 
color, outline, and drop shadow.

•	 When pasted, pure black text is converted to white text.

•	 White text copied from Motion is pasted to the clipboard as black text.

•	 Text pasted into an empty text-entry field in the canvas or into the Text editor (in the 
Format pane of the Text Inspector) retains its original paragraph format, including 
alignment, justification, and tabs.

•	 Text pasted into existing text in the canvas or in the Text editor does not retain its 
original paragraph format. 

•	 If an image is copied with the text, the image is not included when the text is pasted in 
Motion.

•	 Dynamically numbered lists are not supported. Lists become standard text when 
pasted.

Using TXT and RTF files in Motion

TXT files
When you add a TXT file to a project, the following occurs:

•	 The text is formatted based on the settings in the Text Inspector.

•	 The Layout Method (in the Layout pane of the Text Inspector) is set to Paragraph.

Note: To change the layout of the text, choose another option from the Layout Method 
pop-up menu. The ruler and scroll controls become available in the Paragraph and 
Scroll layouts. The scroll control becomes available in the Crawl layout.

•	 The paragraph margins are set to the Safe Zones of the project. (Press the Apostrophe 
key to turn Safe Zones on and off.)
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RTF files
When you add an RTF file to a project, the following occurs:

•	 The formatting of the text (font, style, line spacing, outline, and other styles set in the 
text editing application) is preserved in the project.

•	 The Layout Method (in the Layout pane of the Text Inspector) is set to Paragraph.

•	 Margins in the original text file are preserved in the canvas. 

•	 When you double click the imported text in the canvas, a paragraph-style text-entry 
field becomes active, displaying the following in the canvas: 

•	 An adjustable bounding box representing the margins of the text

•	 A ruler at the top of the bounding box

•	 A scroll control to the right of the bounding box (if text extends vertically beyond the 
borders of the bounding box)

•	 Any tabs from the original text file, displayed as black icons in the ruler at the top of 
the bounding box

You can resize the margins by dragging the edges of the bounding box or adjusting the 
Margins controls in the Layout pane of the Text Inspector. See Select and modify text in 
the canvas and Display the text Layout pane.

Select and modify text in the Motion canvas
After you add text to Motion, you can select and edit text directly in the canvas. To select 
text characters for modification, use the Text tool. 

To select text as an object, use the Select/Transform tool.

Select text characters
Do one of the following:

•	 In the Motion canvas toolbar, select the Text tool, then drag within the text in the canvas.

If you don’t begin the drag within existing text, a new text object is created.

•	 In the canvas toolbar, select the Text tool, click between two text characters in the 
canvas, press and hold the Shift key, then press the Right Arrow key or the Left Arrow 
key to select characters. 

•	 In the canvas toolbar, click the Select/Transform tool, then double-click text in the canvas.

•	 In the Layers list, select a text layer, then in the Text editor (at the bottom of the Text 
Inspector’s Format pane), drag within or double-click text. 
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Move the text insertion point
1.	 With the Text tool selected in Motion, click text in the canvas. 

2.	 Do any of the following:

•	 Move the text insertion point: Press the Right Arrow or Left Arrow key.

•	 Jump to the beginning of a text line: Press Control-Left Arrow.

•	 Jump to the end of a text line: Press Control-Right Arrow.

•	 Jump to the beginning of the word: Press Option-Left Arrow.

•	 Jump to the end of the word: Press Option-Right Arrow.

•	 Move the insertion point through multiple lines of text (for a single text object): 
Press the Up Arrow key or the Down Arrow key.

Note: Some keyboard shortcuts are affected by macOS. See macOS Help (in the Finder, 
choose Help > macOS Help).

Replace or modify text
•	 In Motion, select text in the canvas, then begin typing.

The selected text is replaced by the new text.

Delete a word
In the Motion canvas, do one of the following:

•	 Double-click a word, then press Delete.

•	 Click at the end of a word, then press Option-Delete.

Preview and apply fonts in Motion
You can choose a font before you enter text, or just start typing text and then modify the 
font later. You can preview available fonts in the Library, then apply them from the Library, 
from the Format pane of the Text Inspector, or from the HUD.

Find a font in the Library
You can find specific fonts in the Library.

In Motion, do one of the following:

•	 Select any font name or thumbnail in the font stack of the Library, then quickly type the 
first two letters of font name you want.

The font you seek is highlighted in the stack.

•	 Click the magnifying glass icon at the bottom of the Library, then type the name of the 
font in the Search field.

Only fonts containing the search term appear in the stack. 
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Preview fonts in the Library
1.	 In the Library in Motion, click the Fonts category.

2.	 Click a font subcategory to preview available fonts.

Note: The first subcategory, All Fonts, contains all fonts from the other subcategories.

If you’re in list view, the font list appears in the stack. If you’re in icon view, font 
thumbnails appear in the stack, as shown in the image below.

3.	 In the stack, click a font thumbnail or name.

The font is displayed in the preview area, with the font name and type.

Preview and apply fonts in the canvas
If you’ve already added text to your project, you can preview different fonts in the canvas.

1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Format pane of the Text Inspector, click the Font pop-up menu.

3.	 Drag the pointer up or down in the menu to preview fonts.

As you drag through the menu, the text changes in the canvas.

4.	 After you choose a font, release the mouse button.

Note: You can also use the wheel of a three-button mouse or a two-finger swipe on a 
trackpad to move up and down the menu.

For more information about controls in the Format pane, see Text Format controls.
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Preview and apply fonts in the HUD
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the HUD (press F7 if it’s not already open), click the Font pop-up menu.

3.	 Drag the pointer up or down in the menu to preview fonts.

As you drag through the menu, the text changes in the canvas.

4.	 After you choose a font, release the mouse button.

Note: You can also use the wheel of a three-button mouse or a two-finger swipe on a 
trackpad to move up and down the menu.

Change the font of text in your project by dragging a font type to the canvas
1.	 In the Library in Motion, click the Fonts category, then click a font subcategory.

2.	 Drag a font from the Library stack onto the existing text in the canvas.
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As you drag the font over the text, a transparent thumbnail of the font appears and the 
pointer becomes a green add pointer (+). When you release the mouse button, the text 
is changed to the selected font.

Change the font of text in your project using the Apply button
1.	 In the Motion canvas, Layers list, or Timeline, select a text layer to modify.

2.	 In the Library, click the Fonts category, then click a font subcategory.

3.	 In the stack, click a font.

4.	 In the preview area, click Apply.

The text is changed to the selected font.

Motion uses supported fonts located in the following folders on your computer:

•	 /Library/Fonts/

•	 /Users/username/Library/Fonts/

For information on installing fonts, see macOS Help (in the Finder, choose Help > macOS 
Help).
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Use preset text styles in Motion
The Motion Library contains preset 2D and 3D text styles that you can apply to text. A text 
style is a group of Appearance parameters that are modified and saved in the Library. For 
example, the Neon text style applies a rounded font style and includes a gradient outline 
simulating the bright glow of an electrified glass tube filled with neon gas. You can apply 
these presets from the Library or from the Text Inspector.

Apply a preset text style from the Library
1.	 In the Library in Motion, select the Text Styles category.

2.	 Select the 2D Styles or 3D Styles category, then select a style from the stack.
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3.	 Do one of the following:

•	 Select the text in the canvas, then click the Apply button in the preview area.

•	 Drag the style from the stack to text in the canvas, Layers list, or Timeline.

The text style is applied to the text. If you applied a 3D style, the text is extruded 
and becomes 3D text (the 3D Text checkbox is selected in the Appearance pane of 
the Text Inspector). See Intro to 3D text.

Apply a preset text style from the Text Inspector
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Appearance pane or Format pane of the Text Inspector, click the preset pop-up 
menu and choose an item from the 2D Styles or 3D Styles categories.

The text style is applied to the text. If you applied a 3D text style, the text is extruded 
and becomes 3D text (the 3D Text checkbox is selected in the Appearance pane of the 
Text Inspector). See Intro to 3D text.
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Apply a preset text style from the HUD
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the HUD (press F7 if it’s not already open), click the preset pop-up menu (below 
the Blend Mode pop-up menu) and choose an item from the 2D Styles or 3D Styles 
categories.

The text style is applied to the text. If you applied a 3D text style, the text is extruded 
and becomes 3D text (the 3D Text checkbox is selected in the Appearance pane of the 
Text Inspector). See Intro to 3D text.

You can also customize and save your own text style or format (or both) in the Library. See 
Save a custom text style.

Edit text

Intro to editing text in Motion
You can edit text in the Text HUD or in the Text Inspector.

The Text HUD contains a subset of commonly used controls to adjust font, alignment, size, 
face color, and line spacing.

The Text Inspector contains all available text controls and is divided into three subpanes:

•	 Format: Contains controls for adjusting basic text parameters such as font, size, 
alignment, line spacing, tracking, and kerning. See Display the text Format pane. 

•	 Appearance: Contains controls for adjusting visual text styles, including opacity, blur, 
color, outline, glow, and drop shadows. See Display the text Appearance pane.

•	 Layout: Contains controls for adjusting text arrangement settings such as margins, tabs, 
scrolling, word wrapping, and text on a path. Display the text Layout pane.

If a text parameter can be animated, moving the pointer over the right side of the 
parameter’s row in the Inspector displays the Add Keyframe button and the Animation 
menu. Click either to access keyframe and animation controls. See Keyframe controls in 
the Inspector and Animation menu controls.

To reset a parameter to its default settings (including removing keyframes), click the 
parameter’s animation menu, then choose Reset Parameter. 
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Display the Text Inspector or HUD in Motion
Open the Text Inspector to access advanced parameter controls that adjust text format, 
appearance, and layout. Some of these controls are also available in the Text HUD.

Display the Text Inspector
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 Do one of the following:

•	 Click Inspector (in the upper-left corner of the Motion window), then click Text.

•	 Click the “i” button on the HUD.

Display the Text HUD
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the toolbar, click the HUD button (or press F7).

Edit text format

Display the text Format pane in Motion
The Format pane of the Text Inspector contains controls for adjusting basic text attributes 
such as font, typeface, size, kerning, and character rotation. 

Show the Format pane
•	 In the Text Inspector in Motion, click Format.
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For information about common formatting tasks, see Format text. For a list of all Format 
pane controls, see Text Format controls.

Format text in Motion
The following tasks are useful when editing text format. For a complete list of available 
controls, see Text Format controls.

Resize text
In Motion, do any of the following:

•	 Change font size: Drag the Size slider in the Basic Formatting controls.

•	 Scale the text: Drag the Scale slider in the Advanced Formatting controls.

Click the disclosure triangle to reveal separate X and Y scale controls.

Note: To scale the text as a layer, select text, then drag a scale handle in the canvas.

Rotate or slant text
In the Advanced Formatting controls of Motion, do any of the following:

•	 Rotate text characters: Adjust the Rotation dial.

Click the disclosure triangle to expose separate X, Y, and Z rotation controls.

•	 Shear text characters: Drag the Slant slider.

Adjust the spacing between text characters
1.	 In the Motion canvas toolbar, click the Text tool (or press T).

2.	 In the canvas, click between the characters you want to adjust, then do one of the 
following:

•	 In the Format pane of the Text Inspector, drag the Kerning slider or adjacent value 
slider to set a kerning (character spacing) value.



629Motion User Guide

•	 Press Option-Command-Right Bracket (]) to increase the space between characters 
by one-pixel increments.

•	 Press Option-Command-Left Bracket ([) to reduce the space between characters by 
one-pixel increments.

Text Format controls in Motion
The parameter controls in the Format pane of the Text Inspector allow for common text 
adjustments. 

Basic Formatting controls
•	 Preset: A pop-up menu at the top of the Format pane used to apply preset text styles 

from the Library. You can also use this pop-up menu to save format settings (and 
appearance settings from the Appearance pane) of text in your project. The default 
menu item is Normal—which means that no presets are applied.

For more information on applying and saving text styles, see Use preset text styles.

•	 Collection: A pop-up menu to filter the font categories available in the Font pop-up 
menu. When set to All Fonts, every font installed on your macOS system appears in the 
Font pop-up menu.

•	 Font: A pop-up menu to choose a font for selected text.

•	 Typeface: An unlabeled pop-up menu (to the right of the Font pop-up menu) to choose 
a type style, such as Regular, Bold, Condensed, and so on. The available typefaces are 
specific to the font family selected in the Font pop-up menu.
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•	 Size: A slider to set the point size of the text. The slider is constrained to a maximum of 
288 points. To create larger text, drag to the right over the numeric value, or click the 
value, type a new number, then press Return.

Note: You can also scale text in the canvas using onscreen controls, but doing so scales 
text as an object independently of type point size.

•	 Alignment: Buttons to set the alignment and justification of text.

•	 Vertical Alignment: Buttons to set the vertical alignment of text.

•	 Line Spacing: A slider to set the distance between each line of text (leading) in point-
size increments.

 Tip: To modify the spacing for individual lines of text when hard returns are present, 
select text with the Text tool, then adjust the Line Spacing slider. Spacing is modified on 
the line that includes the selected text.

•	 Tracking: A slider to set the spacing between text characters, applying a uniform value 
between each character.

•	 Kerning: A slider to adjust spacing between text characters.

•	 Baseline: A slider to adjust the baseline of text characters (an invisible horizontal line 
defining the bottom alignment of characters).

Advanced Formatting controls
•	 Scale: A slider to resize text characters proportionally. To scale in only X or Y space, 

click the disclosure triangle to set separate X and Y scale values.
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•	 Affects Layout: A checkbox (available when the Scale parameter is disclosed) to set 
how scaling affects text. For example, when Affects Layout is deselected and text is 
on an open spline path (and Wrap Around is deselected in the Layout pane), increasing 
the Scale parameter causes text characters to bunch up along the length of the path. 
When Affects Layout is selected, increasing scale extends text characters beyond the 
path; decreasing scale bunches up characters toward their set alignment (left, right, or 
center).

•	 Offset: Value sliders to offset text from its original position (anchor point). Click the 
disclosure triangle to access separate X, Y, and Z position values.

•	 Rotation: A dial to rotate text characters in Z space. Click the disclosure triangle to 
access separate X, Y, and Z rotation controls and also the Animate pop-up menu.

•	 Animate: A pop-up menu (available when the Rotation parameter is disclosed) to change 
the interpolation for animated 3D rotation channels. There are two menu options:

•	 Use Rotation: The default interpolation method, whereby text characters rotate from 
their start rotation to their final rotation. Depending on the animation, the characters 
may twist before reaching their final orientation (the last keyframed value). For 
example, if the X, Y, and Z Rotation parameters are animated from 0 degrees to 180 
degrees in a project, the text characters rotate on all axes before reaching their final 
orientation.

•	 Use Orientation: This method provides smoother interpolation but does not allow 
multiple revolutions; interpolates between the text characters’ start orientation (first 
keyframe) and their end orientation (second keyframe).

For more information about the Animate parameter, see Properties Inspector controls.

Note: You must keyframe the Rotation parameter for the Animate parameter options 
have an effect.

•	 Slant: A slider to simulate italics by adding a slant value to text characters.

•	 Monospace: A checkbox that, when selected, applies a fixed amount of space between 
each text character.

•	 All Caps: A checkbox to make text characters uppercase.

•	 All Caps Size: A slider (available when the All Caps checkbox is selected) to set the size 
of uppercase characters based on a percentage of the font point size.

•	 Editable in FCP: A checkbox that, when selected, allows editing of text strings, text size, 
and text tracking in templates published to Final Cut Pro.

For more information on publishing to Final Cut Pro, see Intro to Final Cut Pro templates.

Text editor
•	 Text: A text field (the darker shaded area) to add and edit text in your project from the 

Inspector. See Add text.
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Edit text appearance

Display the text Appearance pane in Motion
The Appearance pane of the Text Inspector contains controls for adjusting visual text 
styles, including color, outlines, glow effects, and drop shadows. 

There are several groups of controls in the Appearance pane: 

•	 Face controls

•	 Outline controls

•	 Glow controls

•	 Drop shadow controls

When you select 3D text (by clicking its activation checkbox), two additional groups of 
controls become available in the Appearance pane: 

•	 3D Text controls

•	 Lighting and environment controls

You can enable or disable a group of style controls by selecting or deselecting the 
activation checkbox to the left of the group heading. By default, Outline, Glow, and Drop 
Shadow are deselected.

Show the Appearance pane
•	 In the Text Inspector in Motion, click Appearance.
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Modify text color in Motion
You can change the color of text (or apply a gradient to text) using the color controls in the 
Appearance pane of the Text Inspector. You can also make basic changes to text color in 
the Text HUD). 

Set text color in the Inspector
1.	 In Motion, select text in the Layers list, canvas, or Timeline.

2.	 In the Appearance pane of the Text Inspector, make sure that the “Fill with” pop-up 
menu is set to Color.

3.	 Do one of the following:

•	 Click the Color well, then use the Colors window to set the text color.

•	 Click the down arrow to the right of the color well (or Control-click the color well), 
then click in the pop-up color palette to select a color; or click in the lower palette to 
set the color to a grayscale color.

•	 Click the eyedropper tool to the left of the Color well, then click a color in the 
canvas.
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•	 Click the Color disclosure triangle to show the color channel parameters, then use 
the sliders to adjust each color channel.

For information on setting colors in high-dynamic-range (HDR) projects, see Choose 
HDR colors.

Set text color in the HUD
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Text HUD (if it’s not displayed, press F7 or D) click the color well, then choose a 
new color in the Colors window.

The text is dynamically updated as you select a color.

Note: To select a color from the canvas (or anything on the desktop), click the color 
picker in the Colors window, position the picker over the color you want to select, then 
click again.
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Apply a text gradient
In the Inspector, you can apply a gradient fill to text, then customize or animate the 
gradient in the Gradient editor. 

1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Appearance pane of the Text Inspector, click the “Fill with” pop-up menu, then 
choose Gradient.

In the Inspector, the Color controls are replaced with the Gradient editor. The default 
gradient is white and blue (Atlantic Blue).

In the canvas, the default gradient is applied to the text. 

3.	 To customize the gradient, see Gradient editor controls.

Apply a preset text gradient in the Inspector
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Appearance pane of the Text Inspector, click the “Fill with” pop-up menu, then 
choose Gradient.

3.	 Click the Gradient preset pop-up menu (on the right side of the Gradient row), then 
choose a preset gradient.

The selected gradient is applied to the text.
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Apply a preset gradient from the Library
1.	 In the Library in Motion, click the Gradients category.

2.	 In the stack, select a gradient.

A preview of the selected gradient appears in the preview area.

3.	 Do one of the following:

•	 Drag the gradient to text in the canvas, Layers list, or Timeline.

•	 Make sure text is selected in the canvas, Layers list, or Timeline, then click Apply in 
the preview area.

The gradient is applied to the text.
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Modify text opacity in Motion
There are several ways to change the opacity of text:

•	 To change the overall opacity of a text object, use the Opacity slider in the Properties 
Inspector or HUD.

•	 To change the opacity of an appearance parameter such as Face, Glow, Drop Shadow, or 
Outline, use the respective Opacity controls in the Appearance pane of the Text Inspector.

Note: The Opacity parameter in the Properties Inspector and the Opacity parameter in 
the Appearance pane of the Text Inspector are separate controls. When you adjust both 
for a text object, the effect is multiplicative. In other words, if Opacity is set to 50% 
in the Properties Inspector and then set to 50% in the Appearance pane, the resulting 
opacity for the text is 25%.

Set text opacity in the Properties Inspector
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 Open the Properties Inspector.

3.	 In the Blending controls, drag the Opacity slider or enter an opacity value in the field.

The Opacity parameter in the HUD is also updated.

Set text opacity in the Appearance pane of the Text Inspector
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Text Inspector, click Appearance to open the Appearance pane.

3.	 In the Face controls, drag the Opacity slider or enter an opacity value in the field.

Set text opacity in the HUD
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 Press F7 or D to display the HUD.

3.	 Drag the Opacity slider.

Text opacity is updated as you drag the slider.

The Opacity parameter in the Properties Inspector (not in the Text Appearance pane) is 
also updated.
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Modify text softness in Motion
Use the Blur parameter in the Appearance pane of the Text Inspector to adjust the softness 
of text.

Adjust text softness in the Inspector
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Text Inspector, click Appearance to open the Appearance pane.

3.	 In the Face controls, drag the Blur slider, or enter a blur amount in the value field.

The text softness is updated as you drag the slider.

Add an image texture to text in Motion
Use the Texture image well to apply, adjust, animate, and remove textures.

Apply a texture fill to text
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Text Inspector, click Appearance to open the Appearance pane.

3.	 Choose Texture from the “Fill with” pop-up menu.

The Color (or Gradient) controls are replaced with Texture controls.

By default, no texture is applied to the text.

4.	 Drag an image from the Layers list or Media list into the Image well.

Important: When dragging an image to the well, be sure to click and drag in one 
movement. If you click the image and release the mouse button, the image is selected 
and its Inspector appears.

The image appears in the well and is applied to the text.

 Tip: When text is filled with an image, the texture is applied to each text character. 
To learn how to make the texture continuous through all text characters, see Intro to 
image masks.
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Remove a texture fill
In Motion, in the Appearance pane of the Text Inspector, do one of the following:

•	 Move the pointer over the right side of Texture controls group until the down arrow 
appears, then click the down arrow and choose Reset Parameter from the pop-up menu.

•	 Drag the image out of the well, then release the mouse button. 

The image disappears.

Change the position of a texture fill
In Motion, in the Texture controls group in the Appearance pane of the Text Inspector, do 
one of the following:

•	 Press and hold the Command key, and drag in the Image well.

The image moves in the well and is offset in the text in the canvas.

•	 Adjust the Offset value sliders.

The left value slider represents X position values; the right value slider represents Y 
position values.

Note: You can adjust the position of a texture for a single glyph by selecting the glyph 
with the Text tool or by using the Transform Glyph tool. For more information on working 
with glyphs, see Intro to text glyphs.
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Animate a texture fill using keyframe recording
You can set keyframes for the offset values of the texture source to create a moving 
element within text. In the following example, an image of a leopard lying in the grass is 
used as the texture source for the text “leopard.”

1.	 In Motion, apply a texture fill to text.

2.	 In the Timeline, move the playhead to the frame where you want the texture animation 
to begin.

3.	 Turn on keyframe recording by clicking the Record button in the timing toolbar (or press 
A).

Note: When keyframe recording is enabled, a keyframe is created for any change you 
make to an object in your project.

4.	 To position the texture, do one of the following in the Texture controls in the 
Appearance pane of the Text Inspector:

•	 Press and hold the Command key, and drag in the Image well.

•	 Adjust the Offset value sliders.

The image within the text moves, and a keyframe is created in the Offset parameters.



641Motion User Guide

5.	 Move the playhead to the next frame where you want to set a keyframe.

6.	 Repeat step 4 to move the texture to a new position.

7.	 Click the Record button (or press A) to turn off keyframe recording.

When you play back the project, the texture is animated.

Animate a texture fill by manually adding a keyframe
1.	 In Motion, apply a texture fill to text.

2.	 In the Timeline, move the playhead to the frame where you want the texture animation 
to begin.

3.	 In the Appearance pane of the Text Inspector, move the pointer over the right side of 
the Offset parameter row until the down arrow appears, then click the down arrow and 
choose Add.

4.	 To position the texture, do one of the following:

•	 Press and hold the Command key, and drag in the Image well.

•	 Use the Offset value sliders to enter an offset value.

The image within the text moves, and a keyframe is created in the Offset parameters.

5.	 Move the playhead to the next frame where you want to set a keyframe.

6.	 Repeat step 4 to move the texture to a new position.

A keyframe is added.

Note: After a parameter contains a keyframe, any further adjustment to that parameter 
adds a keyframe at the current playhead position, regardless of the Record button 
state.

When you play back the project, the texture is animated.

Note: When you use an object with applied filters or behaviors as a texture source for text, 
the effect of filters is inherited by the texture. However, behaviors are ignored.
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Add a text outline, glow, or drop shadow in Motion

Create an outline for text
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Text Inspector, click Appearance to open the Appearance pane.

3.	 In the Outline controls, select the Outline checkbox.

The Outline controls become available, and a red default outline with a width of one 
point is added to the selected text in the canvas.

 Tip: Deselect the Face checkbox in the Appearance pane to display a text outline 
with no fill.

Create a glow for text
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Text Inspector, click Appearance to open the Appearance pane.

3.	 In the Glow controls, select the Glow activation checkbox.

A default yellow glow (with Scale and Opacity set to 100%, and Radius set to 0) is 
applied to the selected text in the canvas.

 Tip: Deselect the Face parameter activation checkbox (and other active parameters) 
to display only the text glow.



643Motion User Guide

Add a drop shadow
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Text Inspector, click Appearance to open the Appearance pane.

3.	 In the Drop Shadow controls, select the Drop Shadow checkbox.

A default black drop shadow is applied to the text.

Appearance controls in the Text Inspector

3D Text controls in Motion

When you select 2D text in your project, the 3D Text controls in the Appearance pane 
remain dimmed. To activate the 3D Text controls and convert selected text to extruded 3D 
text, click the 3D Text activation checkbox.

For more information about creating and editing 3D text, see Intro to 3D text. For a detailed 
description of 3D Text controls in the Appearance pane, see 3D Text controls.
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Text Face controls in Motion

Use the Face controls to specify whether text is a solid color, a color gradient, or a texture.

The Face controls are not available for 3D text.

Note: You can distort the Face parameters of text independently of other Appearance 
parameters. See Distort a glyph in the canvas.

•	 Preset: An unlabeled pop-up menu at the top of the Appearance pane (above the 3D 
Text controls) to save the format, style, or format and style of the text to the Library, 
or to apply a preset text style from the Library to the text. The default menu item is 
Normal.

For more information on applying and saving text styles, see Use preset text styles.

•	 Face: An activation checkbox to enable or disable all Face parameters (Fill, Color, 
Opacity, Blur, and Four Corner). This checkbox is selected by default.

•	 Fill with: A pop-up menu to set text fill to Color, Gradient, or Texture.

•	 Color/Gradient/Texture: Color controls to set the text fill color, gradient, or texture. 
These controls vary depending on the “Fill with” setting (described above). Click the 
disclosure triangle to reveal additional controls. For more information about the color 
and gradient controls, see Modify text color.

When the “Fill with” pop-up menu is set to Texture, the following controls become 
available:

•	 Image: An image well to set a texture source (an image, video clip, or other object). 
See Add an image texture to text.

•	 Frame: A slider (available when the Image well contains a movie or image sequence) 
to specify a start frame for the texture.
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•	 Hold Frame: A checkbox (available when the Image well contains a movie or image 
sequence) that, when selected, uses the frame specified by the Frame slider 
(described above). The selected frame is used as the texture for the text object’s 
total duration.

•	 Offset: Value sliders to specify the X and Y values of the position of the source 
texture (relative to the text object). If the object applied to the image well is visible in 
your project, adjusting the Offset parameter does not reposition the object.

•	 Wrap Mode: A pop-up menu to specify how the edge of a texture is treated when the 
texture is offset and appears cut off in the text, or when it’s too small to fill the text 
it’s applied to. There are three options:

•	 None: The texture remains transparent beyond the edge of the source image.

•	 Repeat: The texture source is repeated beyond the edge of the source image.

•	 Mirror: Beyond the edge of the source image, the texture source is reflected, 
as in a mirror—duplicated, tiled, and reversed to encompass the full width and 
height of the text.

•	 Opacity: A slider to set text opacity, regardless of the fill option (Color, Gradient, or 
Texture).

See Modify text opacity.

•	 Blur: A slider to set the softness of the text, regardless of the fill option.

•	 Four Corner: Value sliders to control the position of the face attribute and distort the 
text characters. In the following illustration, the Four Corner parameter in the Face 
controls has been modified (but the Four Corner parameter for the red outline has not 
been modified).

Click the disclosure triangle to reveal the following value sliders:

•	 Bottom Left: Offsets the text fill from the lower left of its original position.

•	 Bottom Right: Offsets the text fill from the lower right of its original position. 

•	 Top Right: Offsets the text fill from the upper right of its original position. 

•	 Top Left: Offsets the text fill from the upper left of its original position.

Note: You can also adjust the Four Corner parameters using onscreen controls. See 
Glyph controls in the Text HUD.
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Text Outline controls in Motion

Use the Outline controls in the Appearance pane of the Text Inspector to create text 
outlines. You can change the fill of the outline, as well as its opacity, softness, width, and 
layer order.

The Outline controls are not available for 3D text.

Note: You can distort text outlines independently of other Appearance parameters. See 
Distort a glyph in the canvas.

•	 Outline: An activation checkbox to enable or disable all Outline parameters. This 
checkbox is deselected by default.

•	 Fill with: A pop-up menu to set the fill for the outline. As with the Face controls, you can 
set the outline fill to Color, Gradient, or Texture.

The Outline fill controls—Color, Gradient, and Texture—are equivalent to the Face 
controls. For information on using these controls, see Text Face controls.

•	 Color/Gradient/Texture: Color controls to set the color, gradient, or texture of the text 
outline, depending on which item is selected in the “Fill with” pop-up menu. Click the 
disclosure triangle to adjust additional parameters.

•	 Opacity: A slider to set the opacity of the text outline.

•	 Blur: A slider to set the softness of the text outline.

•	 Width: A slider to set the thickness of the text outline.

•	 Layer Order: A pop-up menu to set whether the outline is drawn over or under the text 
face.

•	 Four Corner: Click the disclosure triangle to reveal value sliders to control the position 
of the outline attribute:

•	 Bottom Left: Offsets the text outline from the lower left of its original position.

•	 Bottom Right: Offsets the text outline from the lower right of its original position.

•	 Top Right: Offsets the text outline from the upper right of its original position. 

•	 Top Left: Offsets the text outline from the upper left of its original position. 

Note: You can also adjust the Four Corner parameters using onscreen controls. See Glyph 
controls in the Text HUD.
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Text Glow controls in Motion

Use the Glow controls in the Appearance pane of the Text Inspector to create a glow in 
front of or behind text. Except for Layer Order, all Glow parameters can be animated.

Note: You can distort the glow of text independently of other Appearance parameters. See 
Distort a glyph in the canvas.

•	 Glow: An activation checkbox to enable or disable glow parameters in this group. This 
checkbox is deselected by default.

Note: When the Glow activation checkbox is selected, the text is rasterized. See Intro to 
rasterization.

•	 Fill with: A pop-up menu to set the fill for the glow. As with the Face and Outline 
controls, you can set the glow fill to Color, Gradient, or Texture.

The Glow “Fill with” options—Color, Gradient, and Texture—are equivalent to the Face 
controls. For information on using these controls, see Text Face controls.

•	 Color/Gradient/Texture: Color controls to set the color, gradient, or texture of the glow 
effect. Click the disclosure triangle to adjust additional parameters.

•	 Opacity: A slider to set the opacity of the text glow.

•	 Blur: A slider to set the softness of the text glow. To ensure that the glow is visible, set 
the Blur value above 0.

•	 Radius: A slider to set the circumference of the glow.

•	 Scale: A slider to set the size of the glow.

•	 Offset: Value sliders to offset the glow in the X or Y position.

•	 Layer Order: A pop-up menu to specify whether the glow is drawn over or under the text 
face.

•	 Four Corner: Click the disclosure triangle to reveal value sliders to control the position 
of the glow attribute, allowing for glow distorting effects:

•	 Bottom Left: Offsets the text glow from the lower left of its original position.

•	 Bottom Right: Offsets the text glow from the lower right of its original position. 

•	 Top Right: Offsets the text glow from the upper right of its original position.

•	 Top Left: Offsets the text glow from the upper left of its original position.

Note: You can also adjust the Four Corner parameters using onscreen controls. See 
Glyph controls in the Text HUD.
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Text Drop Shadow controls in Motion

Use the Drop Shadow controls to create a shadow behind text, and to adjust the shadow 
color, opacity, offset from the text object, softness, and angle. All Drop Shadow parameters 
can be animated.

•	 Drop Shadow: An activation checkbox to enable or disable the drop shadow effect. This 
checkbox is deselected by default.

Note: When the Flatten checkbox is selected in the Layout pane of the Text Inspector, 
additional Drop Shadow controls appear in the Properties Inspector. Drop Shadow 
controls in the Properties Inspector are independent of the controls in the Text 
Inspector. Enabling Drop Shadow in both locations adds to the existing shadow.

•	 Fill with: A pop-up menu to set the fill for the shadow. As with the Face, Outline, and 
Glow controls, you can set the shadow fill to Color, Gradient, or Texture.

The Shadow “Fill with” options are equivalent to the Face controls. For information on 
using these controls, see Text Face controls.

•	 Color/Gradient/Texture: Color controls to set the color, gradient, or texture of the 
shadow. Click the disclosure triangle to adjust additional parameters.

•	 Opacity: A slider to set the opacity of the text shadow.

•	 Blur: A slider to set the softness of the text shadow.

•	 Scale: A slider to set the size of the shadow.

•	 Distance: A slider to specify the offset of the text shadow.

•	 Angle: A dial to set the angle (or direction) of the drop shadow.

•	 Fixed Source: A checkbox that, when selected, makes the drop shadow behave as if 
cast by a fixed light source, regardless of camera or text movement. 

•	 Four Corner: Click the disclosure triangle to reveal value sliders to control the position 
of the drop shadow attribute, allowing for outline distorting effects:

•	 Bottom Left: Offsets the text drop shadow from the lower left of its original position. 

•	 Bottom Right: Offsets the text drop shadow from the lower right of its original 
position. 

•	 Top Right: Offsets the text drop shadow from the upper right of its original position.

•	 Top Left: Offsets the text drop shadow from the upper left of its original position.

Note: You can also adjust the Four Corner parameters using onscreen controls. See 
Glyph controls in the Text HUD.
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Save a custom text style in Motion
After you modify parameters in the Appearance pane (such as Gradient or Glow) or Format 
pane (such as Tracking or Slant), you can save the style you create to the Text Styles 
category in the Library. These custom styles can then be used and applied like preset 
styles.

Save a modified text style to the Library
1.	 In Motion, select the text with the modified parameters you want to save as a style.

2.	 In the Appearance pane or Format pane of the Text Inspector, open the Preset pop-up 
menu (at the top of the pane) and choose any of the following:

•	 Save Format Attributes: Saves only Format pane parameters.

•	 Save Appearance Attributes: Saves only the Appearance pane parameters.

•	 Save All Format and Appearance Attributes: Saves parameters from both the 
Appearance and Format panes.

3.	 In the Save Preset To Library dialog, enter the name for the preset.

4.	 Click Save.

The custom preset is saved to the Text Styles category in the Library. Custom presets 
can be identified in the Library by the small user badge that appears in the lower-right 
corner of the text style icon.

Note: Custom presets saved to the Library are stored on your computer in the /Users/
username/Library/Application Support/Motion/Library/Text Styles/ folder.
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Edit text layout

Display the text Layout pane in Motion
Use the Layout pane of the Text Inspector to create text on a path, to set direction and 
rendering options, to add a typewriter effect, and more. 

There are seven groups of controls in the Layout pane:

•	 Layout controls

•	 Text Rendering controls

•	 Behavior controls

•	 Type On controls

•	 Path Options controls

•	 Margins controls

•	 Tabs controls

Show the Text Layout pane
•	 In the Text Inspector in Motion, click Layout.
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Create text on a path

Create text on a path in Motion

The Path layout method lets you place text on a baseline path that you can warp to create 
curving or angular trails of text. After you create text on a path, you can modify or extend 
the path, add or remove control points, or animate text on the path (see Animate text on a 
path).

You can always edit text on a path, changing text characters or fonts, tracking, and 
kerning, as well as Appearance pane settings. 

Note: To view and edit a text path, the Text tool (in the canvas toolbar) must be selected. 

Create text on a path
1.	 In Motion, select text in the canvas, Layers list, or Timeline.

2.	 In the Layout pane of the Text Inspector, click the Layout Method pop-up menu, then 
choose Path.

The Path Options controls become available, near the bottom of the Layout pane.

3.	 In the canvas toolbar, select the Text tool (or press T), then click the text in the canvas.

Step 3 is important—the Text tool must be selected to view or edit the text path.

The path appears below the text. The default path shape is a straight line (an open 
spline) with three control points.
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Adjust a text path in the canvas
•	 In Motion, with the Text tool selected, drag a path control point to change the shape of 

the path.

Extend a text path in the canvas
When you add additional text characters to text on a path, you may need to extend the 
default path, by dragging it in the canvas.
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•	 In Motion, with the Text tool selected, drag the last control point of the text path toward 
the end of the text.

 Tip: When dragging, press Shift to constrain the path to a straight line. 

After you extend a path, you can add control points to further manipulate the shape of 
the path, as described in the next task.

Add, modify, or remove control points from a text path in the canvas
In Motion, do any of the following:

•	 Add a control point: Option-click or double-click the text path.

Note: If nothing happens, make sure the Path Shape pop-up menu (in the Path Options 
group of controls in the Layout pane) is set to Open Spline or Closed Spline. 

•	 Remove a control point: Select a point on the text path, then press Delete. 

You can also Control-click the point, then choose Delete Point from the shortcut menu.

•	 Create a linear point: Control-click a point on the text path, then choose Linear from the 
shortcut menu.

•	 Create a smooth (Bezier) point: Control-click a point on the text path, then choose 
Smooth from the shortcut menu.

When Path Type is set to B-Spline (in the Path Options group of controls in the Layout 
pane), the Very Smooth option becomes available in the shortcut menu.

•	 Lock a point: Control-click a point on the text path, then choose Lock Point from the 
shortcut menu.

A locked point cannot be edited.
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•	 Unlock a point: Control-click a point on the text path, then choose Unlock Point from 
the shortcut menu.

Text paths are modified in the same way as shape control points. For complete 
information, see Intro to shapes, masks, and paint strokes.

Note: Clicking any path control point and holding down the mouse button displays the 
point number (based on the order the points are drawn on the path) and X, Y, and Z 
coordinates in the status bar (above the canvas). Path control points are also listed by 
number in the Path Options group of controls in the Layout pane of the Text Inspector.

Modify a text path in 3D space in Motion

You can manipulate a spline text path to make text extend through 3D space. 

Adjust a text path in 3D space
1.	 If there’s no camera in your Motion project, add a camera by doing one of the following:

•	 In the toolbar, click Add Object, then choose Camera from the pop-up menu.

•	 Choose Object > New Camera (or press Option-Command-C).

Note: If none of your project groups is set to 3D, a dialog appears asking you if you 
want to switch your 2D groups to 3D groups. Click Switch to 3D to allow the camera 
to affect the groups.

2.	 To see your text path from above, change the default camera view to Top by doing one 
of the following:

•	 Click Active Camera in the upper-left corner of the canvas, then choose Top from 
the pop-up menu.

•	 Choose View > 3D View > Top.

The text is no longer visible because the camera is now looking down 
perpendicularly (along the Y axis) at the text on a path. The text path and its points 
are still visible. (The yellow wireframe camera icon in the canvas represents the 
scene camera you added in step 1.)

If the text path is not visible, you may need to zoom out of the canvas.
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3.	 Drag a control point to adjust the text path in X, Y, or Z space.

Note: Make sure you are in text edit mode (the text is selected with the cursor, not the 
Select/Transform tool). If you lose the selection, you may need to choose Active Camera 
from the camera menu, enter text edit mode, then choose Top from the camera menu.

Manipulating text on a path in 3D space only works when Path Shape is set to Open 
Spline or Closed Spline (in the Path Options controls in the Layout pane).

If the path selection disappears, choose Active Camera from the camera menu, enter text 
edit mode (double-click the text in the canvas), then choose Top from the camera menu. 
To enter values for the control point locations for Open Spline or Closed Spline, click the 
Control Points disclosure triangle in the Path Options group of the Layout pane. The first 
value slider is X, the second value slider is Y, and the third value slider is Z.

4.	 To change the camera view, click the pop-up menu in the upper-left corner of the 
canvas, then choose a new view.

5.	 To reset the camera view, do one of the following:

•	 Click the pop-up menu in the upper-left corner of the canvas, then choose Active 
Camera.

•	 Choose View > 3D View > Active.

 Tip: When working with text in a 3D project (especially text that moves close to 
the camera), before exporting, set Render Quality to Best (choose View > Quality > 
Best). Best mode dramatically slows project performance and interactivity, so you 
might want to set the Render Quality to Normal while working. You can also set the 
Render Quality when you export, by using the pop-up menus in the Render pane of 
the Export window.
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Isolate a group or layer to modify text on a 3D path
When working with text on a 3D path, type may become difficult to read depending on its 
orientation and distance from the camera. To edit the text, you can snap the text object to 
its original face-forward orientation using the Isolate button in the Layers list (or Timeline) 
or the Isolate command in the Object menu.

Note: The Isolate command is available only for selected objects.

In Motion, do one of the following:

•	 In the Layers list (or Timeline), click the Isolate button.

•	 Control-click the layer or group, then choose Isolate from the shortcut menu.

•	 Choose Object > Isolate.

Click the Isolate button again to return to your previous view.

Note: Clicking a camera’s Isolate button activates that camera’s view.

Use a geometry shape as a text path in Motion

The following section describes how to use a shape as the source for a text path.

Use geometry for a text path source
1.	 In Motion, import or draw the shape you want to use as the path source.

2.	 Select text i n the Layers list, canvas, or Timeline. 

3.	 In the Layout pane of the Text Inspector, click the Layout Method pop-up menu, then 
choose Path.
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4.	 In the Path Options section of the Layout pane, click the Path Shape pop-up menu, then 
choose Geometry.

The Shape Source well appears in the Inspector.

5.	 From the Layers list, drag the shape to the Shape Source well.

6.	 When the pointer becomes a curved arrow, release the mouse button.

A thumbnail of the shape appears in the well and the shape is used as the source shape 
for the text path.

Note: You might want to disable (deselect) the original source shape in the Layers list 
so it’s not visible in your project.

Select another geometry source for a text path shape
•	 In Motion, in the Layout pane of the Text Inspector, click the To pop-up menu (next to 

the Shape Source image well) and choose a different object to use as the text path’s 
shape source. All shapes or masks in the project appear in this pop-up menu.
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Animate text on a path in Motion

You can animate text so that it moves across the text path.

Animate text on a path
1.	 In Motion, create a path for the text to travel along.

2.	 In the Timeline, move the playhead to the frame where you want to begin the animation, 
then press A to turn on keyframe recording.

3.	 In the Layout pane of the Text Inspector, adjust the Path Offset slider (or the adjacent 
value slider) to the amount you want to move the text on the path.

A keyframe is added to the Path Offset parameter.

A positive value moves the text toward the right, and a negative value moves the text 
toward the left. You can enter values greater than 100% or less than 0% in the value 
slider. 

4.	 Move the playhead to the frame where you want to place the next keyframe.

5.	 Adjust the Path Offset slider or value slider.

6.	 Press A again to turn off keyframe recording.

When you play back the project, the text travels long the path. 
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Work with margins and tabs

Create and adjust text margins in Motion

You can create a custom margin using the Margins controls in the Layout pane of the Text 
Inspector.

Create text margins in the Inspector
1.	 In the canvas toolbar in Motion, select the Text tool, click in the canvas, then enter 

some text.

When the Text tool is selected, clicking in the canvas (without dragging) creates a blank 
text layer.

2.	 In the Layout pane of the Text Inspector, click the Layout Method pop-up menu, then 
choose Paragraph.

A bounding box appears in the canvas surrounding the text.

3.	 In the Margins section of the Layout pane, adjust the sliders to set the left, right, top, 
and bottom margins.

4.	 Press Esc to exit text-editing mode.

Note: Alternatively, you can create text margins by selecting the Text tool, then dragging in 
the Canvas. See Add paragraph-style text with margins that wrap.

Adjust text margins without scaling the text
This task uses paragraph-style text with margins (as described in the previous task). 

1.	 In Motion, double-click paragraph-style text in the canvas.

The Text tool is selected, and a bounding box appears in the canvas surrounding the 
paragraph-style text. 

2.	 Do one of the following: 

•	 In the canvas, drag one of the scale handles on the bounding box.

Note: The Text tool must be selected when you drag in the canvas. If the Text tool is 
not selected, dragging scale handles resizes the text itself, not its margins.
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•	 In the Layout pane of the Text Inspector, adjust the Margins controls.

The text margins change, and the text inside the bounding box adjusts to the new margins.

Note: When text is deleted from a paragraph, the paragraph margins remain in their original 
locations.
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Add, remove, and modify text tabs in Motion

Motion allows paragraph-formatted text to contain an unlimited number of tabs to control 
word spacing in text. By default, text created in Motion has no tabs. Adding, moving, and 
removing tabs is done in the canvas—but you can also move tabs by modifying their values 
in the Inspector. When you import a Rich Text Format (RTF) file, tabs in the RTF file are 
retained in the Motion project and appear in the Tabs section of the Layout pane of the 
Text Inspector. 

There are four types of tabs:

•	 Left tab: Aligns the left edge of the text with the tab.

•	 Right tab: Aligns the right edge of the text with the tab.

•	 Center tab: Aligns the center of the text with the tab.

•	 Decimal tab: Aligns decimal points in numbers on multiple lines.

The tasks below use paragraph-style text. For information about creating paragraph-style 
text, see Add paragraph-style text with margins that wrap.

Add a tab
1.	 Double-click paragraph-style text in the Motion canvas to display the text-entry field.

2.	 In the ruler above the text-entry field, do one of the following:

•	 Click to add a left tab.

•	 Double-click to add a center tab.

•	 Control-click and choose a tab type from the shortcut menu.

When you add a tab, its black icon appears in the ruler.

Change a tab type in the canvas
1.	 Double-click paragraph-style text in the Motion canvas to display the text-entry field.

2.	 Double-click a tab icon in the ruler above the text-entry field.

The tabs cycle through the right, center, left, and decimal types.

Change a tab type in the Inspector
1.	 Double-click paragraph-style text in the Motion canvas to display the text-entry field.

2.	 In the Tabs section of the Layout pane of the Text Inspector, click the Tab type pop-up 
menu, then choose an option.

The tabs icon is updated in the ruler in the canvas.
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Move the tabs
1.	 In Motion, in the Layout pane of the Text Inspector, make sure Paragraph (or Scroll) is 

selected in the Layout Method pop-up menu.

2.	 Double-click paragraph-style text in the canvas to display the text-entry field.

3.	 Do one of the following:

•	 In the canvas, drag a tab (the small black icon) in the ruler above the text-entry field.

•	 In the Layout pane of the Text Inspector, use the Tabs controls to adjust the position 
and layout of the tabs.

The affected text is repositioned to the tab.

Remove a tab
1.	 Double-click paragraph-style text in the Motion canvas to display the text-entry field.

2.	 Drag the tab (the small black icon) away from the ruler and release the mouse button.

The tab is removed from the ruler in the Tabs controls in the Layout pane of the Text 
Inspector.

Layout controls in the Text Inspector

Text Layout controls in Motion

Use the Layout Controls group to set basic layout options for a text object:

•	 Layout Method: A pop-up menu to set any of five kinds of text layouts:

•	 Type: The default method, creates a single line of text. As text is added, the string 
of text continues off the canvas. (If you need text to wrap to multiple lines, use the 
Paragraph layout method instead, described below.)

•	 Paragraph: Creates text with margins and line wrapping. When Layout Method is 
set to Paragraph, Margins controls become available in the lower area of the Layout 
pane. Double-click the text in the canvas when Layout Method is set to Paragraph 
to display a bounding box, ruler, and scroll control around the text-entry field. When 
you delete text from a paragraph text-entry field, paragraph margins do not change. 
For information on modifying or creating paragraph-style text, see Add text.

•	 Path: Creates text on a path and makes the Path Options controls available. The 
path can be an open or closed spline, a circle, a rectangle, a wave, or based on a 
geometry shape. See Create text on a path.

•	 Scroll: Positions the margins of the text-entry field to match the project’s safe 
zones in preparation for a scrolling animation. Double-click the text in the canvas to 
display a ruler and an enhanced scroll control showing a preview of the text. Drag 
in the scroll bar to navigate through large amounts of text. Scroll does not animate 
the text—text is only positioned and formatted in preparation for you to create 
scrolling animation using keyframes or behaviors. For more information on animating 
text, see Intro to animated text. When Layout Method is set to Scroll, the following 
occurs: The Transform Glyph tool is not available; the Offset, Rotation, and Affects 
Layout controls in the Format pane are not available; and the text is flattened, so the 
Flatten, Render Text, and Face Camera controls are not available. (See the Flatten 
checkbox description in Text Rendering controls.) 
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•	 Crawl: Positions the text in a single string (within project safe zones) along the 
bottom of the project in preparation for a crawl or ticker-type animation. Double-
click the text in the canvas to display a scroll control below the text-entry field. 
Crawl does not animate the text—text is only positioned and formatted in preparation 
for you to create an animation using keyframes or behaviors. For more information 
on animating text, see Intro to animated text. When Layout Method is set to Crawl, 
the following occurs: Tabs are not available; the Transform Glyph tool is not 
available; the Offset, Rotation, and Affects Layout controls in the Format pane are 
not available; and the text is flattened. As a result, the Flatten, Render Text, and Face 
Camera controls are not available. (See the Flatten checkbox description in Text 
Rendering controls.)

•	 Direction: A pop-up menu to set the direction for the flow of letters. Choose Horizontal 
or Vertical.

•	 Auto-Shrink: A pop-up menu (available when Layout Method is set to Paragraph, Scroll, 
or Crawl) to decrease the vertical or horizontal scale of selected letters to ensure that 
text fits within the margins of the text object. Choose one of the following options:

•	 Off: No scaling occurs. Text exceeding the width or height of the text object extends 
beyond the visible edges of the screen for scrolling or crawling text, or wraps to the 
next line for paragraph text.

•	 Left and Right: Proportionally scales the text to fit within the left and right margins of 
the text object.

•	 Left and Right Stretch: Stretches the text to fit within the left and right margins of 
the text object. This setting is primarily used with scrolling text, to ensure that no 
characters are cut off. However, it can be applied to other text objects.

•	 Top and Bottom Stretch: Stretches the text to fit within the top and bottom margins 
of the text object. This setting is primarily used for crawling text, to ensure that no 
characters are cut off. However, it can be applied to other text objects.

•	 To All Margins: Proportionally scales the text to fit within the left, right, top, and 
bottom margins of the text object.

•	 Crop At Margins: A checkbox that, when selected, crops text that extends past the 
margins of the text object. This control is disabled when Auto-Shrink (described above) 
is enabled.

Note: For Crop At Margins to be active, Layout Method must be set to Paragraph, and 
the text object must be flattened. For more information about flattening text, see Text 
Rendering controls.
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Text Rendering controls in Motion

Use the Text Rendering controls to set how text objects are displayed in 3D layers:

•	 Flatten: A checkbox that, when selected, forces text characters to remain in a 2D plane. 
In 3D groups, text characters on a path may be influenced by behaviors in ways that 
interfere with linear alignment. For instance, a simulation behavior might pull nearby 
text characters out of their plane. When Flatten is selected, the text can still interact 
with other objects in 3D space, but only as a flattened image, like a card.

After you select Flatten, the text characters no longer move in 3D space.

Make sure to select the Flatten checkbox when you want:

•	 Text to receive reflections. If the Flatten checkbox is not selected, the Reflections 
parameter does not appear in the Properties Inspector. For more information on 
using reflections, see Cast a reflection.

•	 To use the Distort and Drop Shadow tools in the canvas toolbar.

•	 To apply a mask to text. The mask tools in the canvas toolbar are not available when 
Flatten is deselected.

Note: When a text object rotated in Z space is flattened, text that is farther from the 
camera (farther away in Z space) appears smaller. See 2D and 3D group properties.
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•	 Render Text: A pop-up menu to choose a text-rendering method. This control is not 
available when the Flatten checkbox is selected, or when Scroll or Crawl is selected 
from the Layout Method pop-up menu. There are two menu items:

•	 In Global 3D (Better): Allows text to intersect with objects in the text group and with 
objects in other groups. When working with a camera, allows text in 3D space to be 
affected by the camera’s Depth of Field settings (text outside the camera range of 
focus is blurred). When this option is enabled, project performance and interactivity 
may slow.

For text to cast shadows and to be affected by depth of field settings, In Global 3D 
(Better) must be enabled. For more information on using shadows, see Intro to 3D 
shadows. For more information on using depth of field, see Intro to depth of field.

•	 In Local 3D (Faster): Renders text more quickly, but does not allow for intersections 
with objects in the text group or with objects in other groups, nor does it allow text 
to cast shadows.

•	 Face Camera: A checkbox that, when selected, forces text characters to face the 
camera, even when the camera is rotated or the text is rotated. This checkbox is not 
available when the Flatten checkbox is selected (because text cannot face the camera 
and flatten to the text plane at the same time). Additionally, this setting is not available 
when Scroll or Crawl is selected from the Layout Method pop-up menu (because those 
layout methods cause text to flatten).

Note: Because basic text characters are 2D (flat) objects, text may not be visible when 
you use orthogonal reference camera views, such as Left, Right, and Top (unless the 
text object or characters are rotated in 3D space). This is because orthogonal views are 
at right angles (perpendicular) to objects in the canvas. For more information on using 
cameras, see Add a camera.

Text Behavior controls in Motion

Use the Behavior Controls group to adjust how a text object is treated when behaviors are 
applied, based on the position of the text object’s anchor points:

•	 Anchor Point: A pop-up menu to specify how anchor points are assigned: by character, 
word, or line, or as a single object. For example, when you rotate text using the Format 
pane of the Text Inspector or by applying a text sequence behavior, the effect varies 
depending on the type of anchor point you’ve assigned. When Anchor Point is set to All, 
the text rotates as a single object; when Anchor Point is set to Character, each glyph 
rotates independently. To see a visual representation of the anchor point, select the text 
with the Transform Glyph tool. For more information on the Transform Glyph tool, see 
Intro to text glyphs.
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Note: The anchor point specified in the Layout pane is not the same as the anchor point 
for the object. Object anchor point controls are available in the Properties Inspector and 
via the Anchor Point tool in the canvas toolbar. For more information on adjusting the 
anchor point of an object, see Move a layer’s anchor point.

The Anchor Point pop-up menu has four options:

•	 Character: Rotates each character as if each glyph has its own anchor point.

•	 Word: Rotates each word as if each word has its own anchor point.

•	 Line: Rotates each line as if individual lines had their own anchor points.

•	 All: Rotates all text as a single object.

•	 Anchor Position: A pop-up menu to specify the per-glyph anchor point position. To see 
a visual representation of the anchor point, select the text with the Transform Glyph 
tool. For more information on the Transform Glyph tool, see Intro to text glyphs.

The Anchor Position pop-up menu has five options:

•	 Baseline: Positions the anchor point at the baseline (default).

•	 Center: Positions the anchor point at the depth center and vertical center of the 
character, word, or line of text.

•	 Typographic Center: Positions the anchor point at the depth center and typographic 
center (the midpoint between ascender and descender heights).

•	 Top Center: Positions the anchor point at the depth center and the top of the 
character, word, or line of text.

•	 Left Center: Positions the anchor point on the Y axis at the depth center and the left 
of the character, word, or line of text.

•	 Right Center: Positions the anchor point on the Y axis at the depth center and the 
right of the character, word, or line of text

•	 Position: Value sliders to define the position of the anchor point specified in the Anchor 
Point pop-up menu. Click the disclosure triangle to display individual X, Y, and Z value 
sliders. To see a visual representation of the anchor point, select the text with the 
Transform Glyph tool. For more information on the Transform Glyph tool, see Intro to 
text glyphs.
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Text Type On controls in Motion

Use the Type On controls to create a type-on effect, similar to a typewriter-style animation. 
You can keyframe the type-on effect to occur forward or backward, or to move in both 
directions.

Note: There’s also a Text Animation behavior called Type On that creates a forward type-on 
effect without setting keyframes. For more information on using that behavior, see Use the 
Type On behavior.

•	 Start: A slider to set the start point of the type-on effect (from the left side of the text). 
When set to the default 0%, the text is fully “typed on.” When set to 100%, the text is 
fully “typed off.” If the value animates from 0 to 100 over time, the text types off from 
left to right. If the value animates from 100 to 0, the text types on from right to left.

•	 End: A slider to set the end point of the type-on effect (from the right side) of the text. 
When set to the default 100%, the text is fully “typed on.” When set to 0%, the text is 
fully “typed off.” If the value animates from 100 to 0 over time, the text types off from 
right to left. If the value animates from 0 to 100, the text types on from left to right.

•	 Fade In: A checkbox that, when selected, causes text characters to fade on or off. When 
Fade In is deselected, the text characters pop on as they appear.

Text Path Options controls in Motion

Use the Path Options controls to specify the initial shape of a text path, and to modify the 
path and text on that path. This group of controls is active only when the Layout Method 
pop-up menu at the top of the Layout pane is set to Path. For more information about 
creating a text path, see Create text on a path.

The Transform Glyph tool can be used with text on a path. See Intro to text glyphs.

•	 Path Shape: A pop-up menu to set the shape of the path. Choosing different shapes will 
cause different controls to appear (described below). There are six menu options:

•	 Open Spline: The default shape, a straight path defined by one point at the 
beginning and one point at the end of the path. You can work with Bezier or B-Spline 
control points. Option-click (or double-click) on the path to add points.

•	 Closed Spline: A closed path where the last point is in the same location as the first 
point. You can use Bezier or B-Spline control points. Option-click (or double-click) 
on the path to add points.

•	 Circle: A simplified version of Closed Spline, in which the X radius or Y radius can be 
adjusted to create a circle or an ellipse.

•	 Rectangle: A closed path where the width and the height can be adjusted to create a 
square or a rectangle.

•	 Wave: A wavy path (a sine wave) defined by one point at the beginning and one 
point at the end, and controlled by the End Point, Amplitude, Frequency, Phase, and 
Damping parameters.

•	 Geometry: A shape path where the object travels along the edge of a shape or mask. 
An animated shape can be used as the text path source—for example, a circle shape 
with an applied Oscillate Shape behavior.
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•	 Path Type: A pop-up menu (available when Path Shape is set to Open Spline or Closed 
Spline) to choose how to manipulate the shape of the path. There are two menu 
choices:

•	 Bezier: Lets you manipulate the keyframe curve by dragging Bezier tangent handles. 
For more information about creating and adjusting Bezier curves, see Edit Bezier 
control points.

•	 B-Spline: Lets you manipulate the keyframe curve by dragging B-Spline points. 
B-Splines are manipulated using points—there are no tangent handles. The points 
themselves do not lie on the surface of the shape. Instead, each B-Spline control 
point is offset from the shape’s surface, “magnetically” pulling that section of the 
shape toward itself to create a curve. B-Splines are extremely smooth: By default, 
there are no sharp angles in B-Spline shapes, although you can create sharper 
curves, if necessary. For more information about working with B-Spline curves, see 
Edit B-Spline control points.

•	 Radius: A slider (available when Path Shape is set to Circle) to change the size of the 
circular path. Click the disclosure triangle to adjust the X radius and Y radius.

Note: When the Text tool is selected, you can also use onscreen control points to resize 
the circle. Press Shift to resize the X and Y radii uniformly.

•	 Size: A slider (available when Path Shape is set to Rectangle) to change the size of the 
rectangular path. Click the disclosure triangle to adjust the X scale and Y scale.

Note: When the Text tool is selected, you can also use onscreen control points to resize 
the rectangle. Press Shift to resize the X and Y scales uniformly.

•	 Start Point: Value sliders (available when Path Shape is set to Wave) to set the location 
of the start point on the wave’s path. The left value slider sets the X coordinate of the 
start point. The right value slider sets the Y coordinate of the start point. The start point 
can also be adjusted using the wave’s onscreen controls (active by default when the 
Text tool is selected).

•	 End Point: Value sliders (available when Path Shape is set to Wave) to set the location 
of the end point on the path. The left value slider sets the X coordinate of the end point. 
The right value slider sets the Y coordinate of the end point. The end point can also be 
adjusted using the wave’s onscreen controls (active by default when the Text tool is 
selected).

•	 Amplitude: A slider (available when Path Shape is set to Wave) to define half the 
distance from the highest point to the lowest point in the wave. Higher values result in 
more extreme waves.

•	 Frequency: A slider (available when Path Shape is set to Wave) to set the number of 
waves. Higher values result in more waves.

•	 Phase: A dial (available when Path Shape is set to Wave) to define the percentage of the 
offset of the waves from the start and end points of the path. When set to 0% (default), 
the wave begins and ends at half the distance from the highest point to the lowest point 
in the wave. When set to 90%, the wave begins and ends at the highest point in the 
wave. When set to –90%, the wave begins at the lowest point in the wave. When set to 
180%, the waves are the same as 0%, but inverted.
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•	 Damping: A value slider (available when Path Shape is set to Wave) to progressively 
diminish the oscillation of the wave. Positive damping values diminish the wave forward 
(from left to right). Negative values diminish the wave backward (from right to left).

•	 Shape Source: An image well (available when Path Shape is set to Geometry) to define 
the object (shape or mask) used as the motion path source.

•	 To: A pop-up menu (available when Path Shape is set to Geometry) to choose an object 
in the project to be used as a shape source for the motion path.

•	 Attach to Shape: A checkbox (available when Path Shape is set to Geometry) that, when 
selected, forces the motion path to follow the source shape at the shape’s original 
location. When Attach to Shape is deselected, the text can be offset from its source 
shape. To learn how to use spline objects as a text path source shape, see Use a 
geometry shape as a text path.

Note: When Attach to Shape is selected, you cannot drag the shape object to another 
location.

•	 Path Offset: A slider to set where text begins on the path. Animate this value to move 
text along a path. At 0%, the first text character is at the beginning of the path; at 100%, 
the first character is at the end of the path.

•	 Wrap Around: A checkbox (available when Path Shape is set to Open Spline or Wave) 
that, when selected, wraps text from the end of the path to the first point of the path. 
Wrap Around is selected by default.

•	 Inside Path: A checkbox that, when selected, shifts the baseline of text on a loop path 
so the text appears inside the loop.

•	 Align to Path: A checkbox that, when selected, aligns the text to the shape of the path. 
When the checkbox is deselected, text characters align vertically, regardless of the 
shape of the path.

•	 Control Points: Value sliders (available when Path Shape is set to Open Spline or Closed 
Spline) to adjust the X, Y, and Z coordinates of the control points.
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Text Margins controls in Motion

Use the Margins controls—available when the Layout Method is set to Paragraph, Scroll, or 
Crawl—to set the size and location of text margins.

When a text file is imported into Motion, its margin and tab information is retained in the 
Motion project. The Layout Method (in the Layout pane of the Text Inspector) for the 
imported text is set to Paragraph. By default, text created in Motion is set to Type, creating 
one string of text until you enter a line break. To create columns with tabs or to use 
margins with text created in Motion, you must set the Layout Method (in the Layout pane of 
the Text Inspector) to Paragraph or Scroll. 

There are several ways to create and adjust text margins, including using onscreen controls 
and controls in the Layout pane in the Text Inspector. You can set a margin for text before 
you create it.

•	 Left Margin, Right Margin, Top Margin, and Bottom Margin: Sliders (available when 
Layout Method is set to Paragraph, Scroll, or Crawl) to define the text margins in the 
canvas.
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Text Tabs controls in Motion

Motion allows paragraph-formatted text to contain an unlimited number of tabs to control 
word spacing in text. By default, text created in Motion has no tabs, so there are no 
controls in the Tabs section of the Layout pane. Adding, moving, and removing tabs is done 
in the canvas. You can also move tabs by modifying their values in the Inspector. When you 
import a Rich Text Format (RTF) file, tabs in the RTF file are retained in the Motion project 
and appear in the Tabs section of the Layout pane.

•	 Tab 0, 1, 2, and so on: A list of tabs in the selected paragraph, including their type and 
positions.

•	 Tab type pop-up menu: An unlabeled pop-up menu (the up-and-down arrows) to 
set the tab to Left, Center, Right, or Decimal (aligns decimal points in numbers on 
multiple lines).

•	 Tab value slider: An unlabeled the value slider (the numeric value) to adjust the 
position of the tab.

You can add, move, and remove tabs in the canvas. See Add, remove, and modify 
text tabs.



672Motion User Guide

Work with text glyphs

Intro to text glyphs in Motion
Glyphs are the individual characters in a text layer—the letters, numbers, or symbols. In 
Motion, you can select and then modify or animate individual glyphs independently of 
the word, line, or paragraph of which they are a member. Using glyph transform handles, 
you can drag in the canvas to spatially transform several glyph attributes, including 
position, rotation, scale, face (fill), outline, glow, or drop shadow. And using controls in the 
Inspector, you can modify many other text attributes, including fill color, outline color, font, 
font size, slant, and so on.

You modify glyphs by selecting the Transform Glyph tool (in the canvas toolbar), selecting 
the glyphs you want to transform in the canvas, and then either adjusting controls in the 
Inspector or dragging handles in the canvas.

To animate glyphs, see Animate text characters with the Transform Glyph tool.

Select characters with the Transform Glyph tool
Before you can transform a glyph, you must select it using the Transform Glyph tool in the 
canvas toolbar. You can select a single glyph or multiple glyphs in a text layer. When more 
than one glyph is selected, the last Shift-selected glyph is enclosed in a bounding box with 
transform handles. This is known as the focused glyph. Each of the other glyphs in the 
selection are enclosed in a bounding box without transform handles. Any selected glyph 
(focused or not) is affected by transforms applied to the focused glyph. 

Note: If you use the Transform Glyph tool to distort an appearance attribute of a glyph 
(Face, Outline, Glow, Drop Shadow), only one glyph can be selected at a time.

Select a single glyph
1.	 In Motion, select a text layer in the Layers list, canvas, or Timeline.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Transform Glyph.

A bounding box with transform handles appears around the first glyph in the text. (Or, if 
a different glyph was previously selected, the bounding box surrounds that glyph).

3.	 If you want to select a different glyph in the text layer, click another glyph in the canvas.
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Select all glyphs in a text layer
1.	 In Motion, select a text layer in the Layers list, canvas, or Timeline.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Transform Glyph.

Ensure that the Attribute pop-up menu in the HUD is set to Transform Glyph (because 
the other settings in the menu allow only one glyph selection at a time).

A glyph is selected in the canvas.

3.	 Choose Edit > Select All (or press Command-A).

All glyphs are selected.

Select multiple glyphs in a text layer
1.	 In Motion, select a text layer in the Layers list, canvas, or Timeline.

2.	 In the canvas toolbar, click the transform tools pop-up menu, then choose Transform 
Glyph.

Ensure that the Attribute pop-up menu in the HUD is set to Transform Glyph (because 
the other settings in the menu allow only one glyph selection at a time).

A glyph is selected in the canvas.
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3.	 Do one of the following:

•	 Select contiguous glyphs: Pressing and holding the Shift key, click in the canvas to 
select additional adjacent glyphs; or drag in the canvas to select adjacent glyphs.

•	 Select noncontiguous glyphs: Pressing and holding the Command key, click to select 
nonadjacent glyphs.

Although the onscreen controls appear only around the focused (last selected) glyph, 
any glyph surrounded by a box is affected when you adjust the onscreen controls.

Deselect a group of selected glyphs
•	 In Motion, choose Edit > Deselect All (or press Shift-Command-A).

Any previously selected glyphs are deselected.

Select a glyph in another text layer
•	 With an active Transform Glyph tool selection in Motion, click a different text layer in 

the Layers list or Timeline. 

The selection shifts to the second text layer.

Modify a text glyph in Motion
You can modify nearly any attribute of a selected glyph by adjusting controls in the Text 
Inspector or Text HUD.

1.	 In Motion, select a text layer in the Layers list, canvas, or Timeline.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Transform Glyph.
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A glyph is selected in the canvas. To select a different glyph, click another glyph in the 
canvas. For information about selecting multiple glyphs, see Select characters with the 
Transform Glyph tool.

3.	 In the Text Inspector or Text HUD, adjust any available parameter control.

Note: If the Text HUD is not visible, click the HUD button in the toolbar (or press F7).

Distort a glyph in the canvas in Motion
When you select the Transform Glyph tool, you can spatially adjust glyphs in the canvas by 
choosing between two types of onscreen transform controls: 

•	 Handles that adjust scale, position or rotation (identical to 3D onscreen controls)

•	 Handles that spatially distort face (fill color), outline, glow, or drop shadow—stretching 
or shearing one of those attributes

You choose a handle type from the Attribute pop-up menu in the Text HUD.

Transform a glyph’s scale, position, or rotation
1.	 In Motion, select a text layer in the Layers list, canvas, or Timeline.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Transform Glyph.

A glyph is selected in the canvas. To select a different glyph, click another glyph in the 
canvas. For information about selecting multiple glyphs, see Select characters with the 
Transform Glyph tool.

3.	 In the Text HUD, ensure that the Attribute pop-up menu is set to Transform Glyph.

This setting activates scale, position, and rotation handles in the canvas.

Note: If the HUD is not visible, choose Window > Show HUD (or press F7).

4.	 Drag a transform handle in the canvas.

The glyph is modified in the canvas.

In the Format pane of the Text Inspector, the Scale, Offset, or Rotation parameter is 
modified simultaneously. (Offset represents a glyph’s position in the canvas.) 
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Spatially distort a glyph’s face (fill color), outline, glow, or drop shadow
1.	 In Motion, select a text layer in the Layers list, canvas, or Timeline.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Transform Glyph.

A glyph is selected in the canvas. To select a different glyph, click another glyph in the 
canvas. For information about selecting multiple glyphs, see Select characters with the 
Transform Glyph tool.

3.	 In the Text HUD, click the Attribute pop-up menu, then choose one of the following: 
Face, Outline, Glow, or Drop Shadow.

Note: If the HUD is not visible, click the HUD button in the toolbar (or press F7).
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The selected glyph (or the focused glyph, if multiple glyphs are selected) is enclosed by 
a bounding box with eight handles: four corner handles for distorting, and four middle 
handles for shearing.

4.	 Do any of the following:

•	 Shear the style attribute: Drag a middle handle.

•	 Distort the style attribute: Drag a corner handle.

The glyph’s face, outline, glow, or drop shadow is sheared or distorted in the canvas.

In the Appearance pane of the Text Inspector, the activation checkbox for the attribute you 
adjusted is selected, and related controls become available for further adjustment. 

Reset glyphs in Motion
If you’ve modified a glyph in the Inspector or in the canvas using transform handles, you 
can restore the glyph to its original parameters.

Reset a glyph that’s been modified in the Inspector
You can reset transformed glyphs to their original state via the Animation menu.

1.	 In the canvas in Motion, select a glyph or glyphs that you’ve modified. 

See Select characters with the Transform Glyph tool.

2.	 In the Text Inspector, find the parameter that you modified, click its Animation menu 
(the down arrow that appears when you move the pointer to the right side of the 
parameter row), then choose Reset Parameter.
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Reset a scaled, offset, or rotated glyph
When you scale, move, or rotate a glyph, the changes are reflected in the Format pane 
of the Text Inspector, in the Scale, Offset, and Rotation parameter rows. You can reset 
transformed glyphs to their original state via the Animation menu in those rows. 

1.	 In the canvas in Motion, select a glyph or glyphs that you’ve already scaled, moved, or 
rotated. 

See Select characters with the Transform Glyph tool.

2.	 In the Format pane of the Text Inspector, do any of the following:

•	 Restore a glyph to its default scale: In the Scale parameter row, click the Animation 
menu (the down arrow that appears when you move the pointer to the right side of 
the row), then choose Reset Parameter.

•	 Restore a glyph to its default position: In the Offset parameter row, click the 
Animation menu (the down arrow that appears when you move the pointer to the 
right side of the row), then choose Reset Parameter.

•	 Restore a glyph to its default rotation: In the Rotation parameter row, click the 
Animation menu (the down arrow that appears when you move the pointer to the 
right side of the row), then choose Reset Parameter.

Reset distorted appearance attributes (Face, Outline, Glow, or Drop Shadow)
When you spatially distort a glyph’s Face, Outline, Glow, or Drop Shadow attribute using 
onscreen controls, the changes are reflected in the Appearance pane of the Text Inspector, 
in the Four Corner parameter for that attribute. You can reset distorted glyphs to their 
original state using the Four Corner reset button for affected attribute.

1.	 In the canvas, select a glyph or glyphs with an appearance attribute that you’ve 
distorted or sheared. 

See Select characters with the Transform Glyph tool.

2.	 In the Appearance pane of the Text Inspector, click the down arrow that appears when 
you move the pointer to the right side of the Four Corner parameter row for the affected 
attribute (Face, Outline, Glow, or Drop Shadow), then choose Reset Parameter.
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Glyph controls in the Text HUD in Motion
When you select the Transform Glyph tool, additional controls become available in the 
Text HUD. 

Note: In addition to text parameters, the Text HUD contains 3D transform tools, the Adjust 
Around pop-up menu (see Transform layers in 3D space), and the Attribute pop-up menu 
(described below).

•	 Attribute: A pop-up menu to specify the glyph attribute to be modified by onscreen 
transform handles. There are five menu options:

•	 Transform Glyph: Displays onscreen controls that allow you to scale, move, or rotate 
the glyph.

•	 Face: Displays onscreen controls that allow you to spatially distort the face (color 
fill) of the glyph.

•	 Outline: Displays onscreen controls that allow you to spatially distort the outline of 
the glyph.

•	 Glow: Displays onscreen controls that allow you to spatially distort the glow of the 
glyph.

•	 Drop Shadow: Displays onscreen controls that allow you to spatially distort the drop 
shadow of the glyph.
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Convert standard text to 3D text in Motion
You can convert standard 2D text to 3D text, and vice versa.

•	 In Motion, in the Appearance pane of the Text Inspector, select the 3D Text activation 
checkbox (to the left of the 3D Text group heading).

When you select the 3D Text checkbox, parameters specific to 3D text become 
available, and the Face and Outline controls are replaced with the Lighting, Materials, 
and Options groups of controls. The Glow and Drop Shadow controls remain available.

To convert from 3D text back to 2D text, deselect the 3D Text activation checkbox.

To learn how to create and work with 3D text, see Intro to 3D text. For a description of 
each 3D text parameter, see 3D Text controls.

Check spelling in Motion
You can check the spelling of a text layer in your project using the Text editor.

Use the spelling checker in the Text editor
In Motion, in the Format pane of the Text Inspector, do one of the following:

•	 Click in the Text editor, then choose Edit > Spelling and Grammar and choose an option 
from the submenu.

•	 Control-click in the Text editor, then choose an option from the shortcut menu.

When a spelling error is found, the text is highlighted in the Text editor. If the Text tool 
is active when the spelling is checked, the text is also selected in the canvas.
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Find and replace text in Motion
The Find and Replace window lets you locate and change a word (or a set of characters) in 
a Motion project. You can search in a selected text object, or in all text objects. This tool is 
useful for changes to long-form text objects, such as credit rolls.

1.	 In Motion, choose Edit > Find and Replace (or press Command-F).

The Find and Replace window appears.

2.	 In the Find field, enter the text to search for; in the Replace field enter the replacement 
text. 

3.	 Select an option from the “Search in” pop-up menu:

•	 All Text Objects in Project: Search all text in your project.

•	 Selected Text Object: Search text you’ve already selected in your project.

4.	 Do any of the following:

•	 Press Return or click Next to find the text you entered in the Find field: 

Note: Select the “Loop search” checkbox to continue searching from the beginning 
of your project after reaching the end of the text.

•	 Click Previous to find the previous occurrence of the text you entered in the Find 
field.

Found text is selected in the canvas.

5.	 To replace the selected text, do one of the following:

•	 Click Replace to replace the current selection.

•	 Click Replace All to replace all occurrences of the Find text.

To replace the current selection and immediately find the next occurrence of the 
Find text, click Replace & Find.

•	 Click Replace & Find to replace the current selection and immediately find the next 
occurrence of the Find text.

Note: To undo an operation performed in the Find and Replace window, click in the 
canvas to make it active, then choose Edit > Undo Text Replace (or press Command-Z).
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Using filters with text in Motion
Filters are applied to text the same way they are to other objects in Motion. This section 
provides a quick guide to applying filters to text.

When a filter is applied to text, the text is flattened. When text is flattened, filters are 
applied to the text in local space—that is, “flat” to the text.

See Intro to filters.

Note: Certain operations, such as the application of some filters or selecting the Crop 
checkbox in the Properties Inspector, can cause a group to be rasterized. See How 
rasterization affects basic text.
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Build 3D text

Intro to 3D text in Motion
In addition to basic 2D text, Motion lets you create text objects with depth, complete 
with sides, edges, and backs. 3D text in Motion exhibits the same characteristics as real 
three-dimensional objects, simulating natural lighting and shading effects, and displaying 
textures.

To get started with 3D text and learn about its powerful features, see 3D text workflow.

For information about creating basic 2D text, see Intro to basic text.

For information about animating 2D text and 3D text, Intro to animated text.
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3D text workflow in Motion
Although 3D text can be customized in unlimited ways, you can create impressive-looking 
3D text in just a few simple steps.

Step 1: Create a 3D text object
You can create a new 3D text object from scratch or convert an existing 2D text object into 
3D text. Both approaches result in basic 3D text: white characters with a smooth plastic 
texture that are gently extruded in Z space (depth). 
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Step 2: Apply a preset style
To give basic 3D text a more dynamic appearance, you can apply one of the ready-made 
3D text styles that come with Motion.

The preset 3D text styles artfully combine font, depth, and texture settings. 
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Step 3: Adjust text settings
You can further modify your 3D text by adjusting basic text settings (including font, size, 
tracking, line spacing, and capitalization) or adjusting 3D-specific text attributes (such as 
depth, text weight, edge style, and corner style) in the Text Inspector or HUD. 

To get a good look at all sides of your 3D text, you can move and rotate it in 3D space.



687Motion User Guide

Step 4: Modify the materials
If you want to, you can customize the texture of your 3D text by applying different textures 
and finishes available in the Materials category of the Motion Library. Materials include 
substances (such as metal or plastic), paint layers, distress layers, and more. Each layer 
has many attributes, allowing you to create limitless variations. You can even apply 
different materials to different facets of 3D text (front, back, side, and edges).
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Step 5: Add a lighting style
Another way to customize the appearance of your 3D text is to add a lighting style.

You can customize lighting in a variety of different ways, but these presets are a great way 
to create a unique and realistic look very quickly.
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Step 6: Integrate the text with your composition
Finally, combine your 3D text with backgrounds, shadows, and other elements to create an 
organic, integrated scene. 

Add 3D text to a project

Add 3D text in Motion
You can add 3D text to your project using the 3D Text tool.

1.	 In Motion, do one of the following:

•	 In the canvas toolbar, click and hold the Text tool, then choose 3D Text from the 
pop-up menu.

•	 Press the T key twice (pressing T once activates the basic Text tool, and pressing T 
again activates the 3D Text tool).

2.	 Click anywhere in the canvas to create an insertion point, then begin typing.

 Tip: You can also choose the 3D Text tool, then drag in the canvas to create a 
paragraph-style text-entry field with adjustable margins. See Add paragraph-style text 
with margins that wrap.

The 3D text appears in the canvas. By default, newly created 3D text objects are given 
a smooth, white plastic appearance. To give basic 3D text a more dynamic look, you can 
quickly apply one of the ready-made 3D text styles that come with Motion. These preset 
text styles artfully combine font, depth, and texture settings. Or, if you want to create a 
custom look, you can apply textures and finishes available in the Motion Library. 
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Convert 2D text to 3D text in Motion
You can easily convert a 2D text object in your project to 3D text. This process, called 
extruding, replaces the Face and Outline text settings with depth, weight, edge, lighting, 
and material settings designed to simulate realistic three-dimensional objects. You can 
also convert a 3D text object back to 2D text.

Convert a text object from 2D to 3D
1.	 In the Layers list, Timeline, or canvas in Motion, select a 2D text object. 

2.	 In the Appearance pane or Format pane of the Text Inspector, select the 3D Text 
activation checkbox.

The selected text is converted to basic 3D text, and given a smooth, white plastic 
texture. The Face and Outline controls in the Appearance pane are hidden, and the 3D 
Text, Lighting, and Material controls are enabled. 

To give basic 3D text a more dynamic look, you can quickly apply one of the ready-
made 3D text styles that come with Motion. These preset text styles artfully combine 
font, depth, and texture settings. Or, if you want to create a custom look, you can apply 
textures and finishes available in the Motion Library.
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Convert a text object from 2D to a preset 3D style
You can also convert 2D text to any of the preset 3D text styles available in Motion. In 
addition to converting 2D text to 3D, preset 3D text styles apply a specific font, color, and 
3D material to create a particular text treatment.

1.	 In the Layers list, Timeline, or canvas in Motion, select a 2D text object. 

2.	 In the Text Inspector, click the pop-up menu at the top of the Appearance pane or 
Format pane, choose 3D Styles, then choose a preset style from the submenu.

The text is converted to 3D text in the style you chose. The Face and Outline controls 
in the Appearance pane are hidden, and the 3D Text, Lighting, and Material controls are 
enabled. 

Convert a text object from 3D to 2D
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, deselect the 3D Text checkbox.



692Motion User Guide

The text is converted to 2D text. The Lighting and Material controls in the Appearance 
pane are replaced by the Face and Outline sections, and the 3D Text section is dimmed.

The icon in the Layers list indicates whether a text object is 2D or 3D.

Apply a preset 3D text style in Motion
The easiest way to give basic 3D text a dynamic appearance is to apply one of the ready-
made 3D text styles that come with Motion. These preset styles combine font, depth, and 
texture settings to create an “instant” 3D graphical treatment. 

1.	 In the Layers list, canvas, or Timeline in Motion, select a 3D text object.

2.	 In the Text Inspector, click the preset pop-up menu at the top of the Format pane or 
Appearance pane, then choose 3D Styles.
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3.	 Choose a 3D text style from the submenu that appears.

The 3D text style is applied to the selected text.

Alternatively, you can create your own custom 3D text styles and looks by applying several 
of the numerous 3D textures and finishes (materials) available in the Motion Library. You 
can also create your own materials using images imported into Motion. See Intro to 3D text 
surface materials.
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Move and rotate 3D text in Motion
3D text has multiple facets—front, extruded sides, edges (bevels), and back. When you 
add 3D text to your project, you’ll see the front facet, but depending on the angle of the 
text, you may not be able to see the other facets.

You can view these other facets by moving or rotating the 3D text object.
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Move or rotate 3D text using onscreen handles
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the canvas toolbar, click the 3D Transform tool.

3D transform controls appear on the selected 3D text object in the canvas. 

3.	 Do any of the following:

•	 Move the text object horizontally along its X axis: Drag the red arrow.

•	 Move the text object vertically along its Y axis: Drag the green arrow.

•	 Move the text object forward or backward along its Z axis: Drag the blue arrow.

•	 Rotate the text object around its X axis: Move the pointer over the rotation handles 
until a red rotation ring appears, then drag the red ring.

•	 Rotate the text object around its Y axis: Move the pointer over the rotation handles 
until a green rotation ring appears, then drag the green ring.

•	 Rotate the text object around its Z axis: Move the pointer over the rotation handles 
until a blue rotation ring appears, then drag the blue ring.

See Transform layers in 3D space.
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Move or rotate 3D text using HUD controls
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the canvas toolbar, click the 3D Transform tool.

3.	 Press F7 to open the HUD (if it’s not already open).

4.	 In the HUD, drag in the Move or Rotate squares.

See Transform layers in 3D space.



697Motion User Guide

Move or rotate individual text characters
You can also move or rotate individual characters (glyphs) of a 3D text object.

1.	 In the Layers list, Timeline, or canvas of Motion, select a 3D text object.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Transform Glyph.

3.	 In the canvas, select the glyph you want to move or rotate.

A 3D bounding box with position handles and rotation handles appears around the 
selected glyph.

4.	 Do any of the following:

•	 In the canvas, drag a position handle (a color arrow) to move the selected glyph 
along its X, Y, or Z (depth) axis.

•	 In the canvas, drag a rotation handle (a small white circle) to rotate the selected 
glyph around its X, Y, or Z axis. 

As you drag, three rotation rings appear (red, green, and blue), each corresponding 
to an axis. The ring for the currently active axis is highlighted.
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For more information about transforming glyphs, see Intro to text glyphs.

 Tip: You can also view 3D text from different perspectives by adding a camera and 
converting your project to 3D. See Add a camera.

Modify basic 3D text attributes

Modify 3D text format and layout in Motion
You can modify basic 3D text attributes (including font, size, tracking, line spacing, and 
capitalization) the same way you modify them for 2D text: by adjusting controls in the 
Format pane and Layout pane in the Text Inspector.

Note: To modify the depth, texture, and lighting attributes of 3D text, use the controls in 
the Appearance pane of the Text Inspector. See Modify 3D text depth and weight, Intro to 
3D text surface materials, and Intro to lighting 3D text.

Change text format settings
•	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object, then open 

the Format pane of the Text Inspector and adjust font, size, alignment, line spacing, 
tracking and other basic attributes.

For more information about specific formatting settings, see Text Format controls.

Change text layout settings
•	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object, then open the 

Layout pane of the Text Inspector and adjust the layout method, direction, and other 
standard text layout attributes.

For more information about specific layout settings, see Text Layout controls.
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Modify 3D text depth and weight in Motion
One of the most obvious differences between 2D text and 3D text is that 3D text has 
depth.

You can adjust text depth, as well as a number of other 3D text attributes (such as text 
weight, edge style, and corner style) in the Appearance pane of the Text Inspector.

Adjust 3D text depth
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 Do one of the following:

•	 In the 3D Text section of the Text Inspector’s Appearance pane, drag the Depth 
slider left or right.

•	 In the HUD (press D if it’s not visible), drag the Depth slider left or right.
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Change the direction of 3D text depth
You can set 3D text depth to extrude in different directions: forwards, backwards, or 
centered on the original text plane. 

1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the 3D Text section of the Text Inspector’s Appearance pane, click the Depth 
Direction pop-up menu, then choose any of the following: 

•	 Backward: The text object is extruded backwards from the plane where the text was 
initially added.

•	 Forward: The text object is extruded forwards from the plane where the text was 
initially added.

•	 Centered: The text object is extruded equally forward and backward from the plane 
where the text was initially added.

To see the resulting effect, drag the Depth slider in the Appearance pane or HUD.

 Tip: Setting an extrusion direction and then keyframing the Depth parameter lets 
you animate text so that it appears to extrude forward or backward or in both directions 
over time.

Adjust 3D text weight
You can adjust 3D text to appear thicker or thinner. Whereas increasing the Size value in 
the Format pane makes text larger by substituting a larger version of the font, increasing 
the Weight value uniformly thickens all the lines and serifs that comprise the letters in the 
text object.
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1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the 3D Text section of the Text Inspector’s Appearance pane, drag the Weight slider 
to the left to make the text appear thinner, or to the right to make it appear thicker.

Set the style of 3D text edges
The places where the different facets of a 3D text meet are called edges. You can add 
bevels, ridges, rings, and other shapes to customize the appearance of these edges.

By default, the back edge of 3D text (between the back facet and the sides) is identical to 
the front edge (between the front facet and the sides). However, you can set the front and 
back edges to different edge shapes.

1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the 3D Text section of the Text Inspector’s Appearance pane, click the Front Edge 
pop-up menu, then choose an edge style.
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3.	 Click the Back Edge pop-up menu, then choose an edge style.

If you choose Same As Front, the style you chose in step 2 is applied to the back edge 
of the 3D text object.

Adjust the size of 3D text edges
After you change the style of the front edge or back edge of a 3D text object to anything 
other than square, you can also adjust the size of that edge. If the back edge is set to 
something other than Same As Front (or Square), you can adjust the size of the back edge 
independently from that of the front.

1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the 3D Text section of the Text Inspector’s Appearance pane, click the Front Edge 
pop-up menu, then choose a setting other than Square.

The Front Edge Size slider appears.

3.	 Drag the Front Edge Size slider to the left to make the edge smaller, or to the right to 
make the edge larger.

To modify the width and depth of the edges independently, click the disclosure triangle 
to the left of the Front Edge Size slider, then drag the Width or Depth slider.
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4.	 Click the Back Edge pop-up menu, then choose a setting other than Same As Front or 
Square.

The Back Edge Size slider appears.

5.	 Drag the Back Edge Size slider to the left to make the edge smaller, or to the right to 
make the edge larger.

Note: You can’t see the back edge of the object unless you rotate the object or add a 
camera that’s pointed at the back of the object. See Move and rotate 3D text.

Set the style of 3D text inside corners
When the front edge or back edge of a text object is set to anything other than Square, you 
can customize the inside edge corners (such as the angles in a letter E).

1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the 3D Text section of the Text Inspector’s Appearance pane, click the Inside Corners 
pop-up menu, then choose an option: 

•	 Straight: Sets all edge corners to sharp angles.

•	 Round: Softens the sharpness of edge corners by adding a round curve to each 
sharp angle.

•	 Miter: Smooths the sharpness of edge corners in a more subtle way, by adding an 
additional angle, known as a miter.
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Adjust the depth, weight, or edge size of individual text characters
You can also create different depths, weights, or edge sizes for different characters 
(glyphs) in a 3D text object.

1.	 In the Motion canvas toolbar, click and hold the transform tools pop-up menu, then 
choose Transform Glyph.

2.	 In the canvas, click the glyph you want to adjust.

A 3D bounding box appears around the character.

3.	 Do one of the following:

•	 In the 3D Text section of the Text Inspector’s Appearance pane, drag the Depth, 
Weight, or Front Edge Size slider left or right.

•	 In the HUD (press F7 if it’s not visible), drag the Depth, Weight, or Front Edge Size 
slider left or right.

For more information about transforming glyphs, see Intro to text glyphs.

For a complete list of depth, weight, and edge controls, see 3D Text controls.
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3D Text controls in Motion
Adjust depth, weight and edge attributes using the 3D Text controls in the Appearance 
pane of the Text Inspector:

•	 3D Text: An activation checkbox that, when selected, applies 3D attributes to selected 
text in your project and enables 3D controls in the Appearance pane. Deselecting this 
checkbox converts selected 3D text to flat 2D text and disables 3D controls in the 
Appearance pane.

When this checkbox is selected, the following controls become available for adjustment:

•	 Depth: A slider that sets the thickness of selected 3D text.

•	 Depth Direction: A pop-up menu that sets whether selected 3D text is extruded 
backward, forward, or equally from front to back.

•	 Weight: A slider that makes selected 3D text appear heavier or lighter.

•	 Front Edge: A pop-up menu that sets the style of the front edge of selected 3D text.

•	 Front Edge Size: A slider that adjusts the width and depth of the chosen edge style. 
Click the disclosure triangle to reveal separate Width and Depth sliders.

•	 Back Edge: A pop-up menu that sets the style of the back edge of selected 3D text.

•	 Inside Corners: A pop-up menu that sets the style of the inner corners of the front 
and back edges (such as angles in the letter E) in selected 3D text. The Front Edge 
or Back Edge of a text object must be set to an option other than Square to see the 
effect of this parameter.

For information on using these controls, see Modify 3D text depth and weight.
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Modify surface appearance

Intro to 3D text surface materials in Motion
3D text objects in Motion have properties designed to give them a natural and realistic 
appearance. They respond to lighting conditions and exhibit shading, reflectivity, and other 
attributes of real-world objects.

Attributes that define a 3D text object’s surface appearance are called materials.

After you create a 3D text object, you can apply a preset material or create a custom 
material by combining a collection of one or more material layers—image overlays that 
combine to create a naturalistic 3D texture.
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Think of material layers as the building blocks for creating an object in real life. For 
example, you might begin creating an object by deciding what substance it should be made 
of—wood, plastic, metal, and so on. Depending on that basic substance, the object will 
have some fundamental properties, including color, texture, reflectivity, and so on. Next, 
you apply paint or another finish to the object to modify its color, sheen, and reflectivity. 
Motion even allows you to apply a “distress” layer to add a bit of texture, aging, or other 
elements to make the object feel more organic and realistic.

Each material layer type has a variety of controls and settings to customize the specific 
look and feel of the material. 

You can apply multiple material layers of differing types to compound their effects, and you 
can rearrange the order in which material layers are applied to create varied results. You 
can also apply different materials to specific facets of a 3D text object. 
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Apply materials to 3D text

Apply a preset material to 3D text in Motion

A quick way to give your 3D text a naturalistic texture is to apply one of the preset 
materials built into Motion.

Examples of some of the many preset 3D materials available in Motion include:

Apply a preset material from the Library
In Motion, do one of the following:

•	 In the Library, select Materials in the left column, select a category from the right 
column, then drag a material from the stack to a 3D text object in the Layers list, 
Timeline, or canvas.
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Before you drag the material into your project, a rotating preview appears at the top of 
the Library.

•	 In the Layers list, Timeline, or canvas, select a 3D text object, then in the Library, select 
Materials, select a category, select a material from the stack, then click Apply.

Before you apply the material, a rotating preview appears at the top of the Library.

The preset 3D material is applied to the text object. 

You can modify any of the preset materials or add new material layers to create custom 
textures. See Modify 3D text materials and Add or remove 3D text material layers.
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Apply a preset material from the Text Inspector
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D object, then in the Text 

Inspector’s Appearance pane, click the preview thumbnail in the Material area.

A pop-up menu showing the material presets categories appears.

2.	 Choose a category from the pop-up menu, then choose a material preset from the 
submenu that appears.

The preset 3D material is applied to the text object.

You can modify any of the preset materials or add new material layers to create custom 
textures. See Modify 3D text materials and Add or remove 3D text material layers.

Note: The preset 3D materials are not same as the preset 3D text styles. Whereas preset 
materials apply a ready-made texture to 3D text, preset text styles apply a complete “look,” 
including a specific font, depth, texture, and other attributes. See Apply a preset 3D text 
style. 
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Apply a custom material to 3D text in Motion

You can use your own image or clip to create a custom 3D text material layer. As with the 
preset materials, you can add paint layers, finish layers, distress layers, and emit layers to 
your custom material layer.

Apply a custom image or video clip as a material
1.	 In Motion, import (or add from the Library) the image or clip you want to use as your 3D 

text material.

2.	 In the Layers list, Timeline, or canvas, select a 3D object, then in the Text Inspector’s 
Appearance pane, click Substance and choose Generic from the pop-up menu.

3.	 Click Surface, then choose Image from the pop-up menu.

An image well becomes available in the Image Options controls.
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4.	 Drag the image or clip you imported in step 1 from the Layers list to the image well.

Note: Drag the image from the Layers list in one continuous movement. If you click the 
image and release the mouse button, the 3D text is deselected and the image well is no 
longer available.

The image is mapped onto the 3D text object and the preview thumbnail in the 
Appearance pane is updated.
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5.	 Adjust how the mapped image appears on the 3D text object using the Image Options 
controls. 

For example, you may want to adjust the scale of the image or apply the image 
individually to each text character rather than have it mapped across all text characters.

In this example, the Scale parameter is set to 20 percent so the image more clearly 
appears on the front surface of the 3D text.

For a description of the Image Options parameters, see “When Substance is set to 
Generic” in 3D text Substance controls. For a description of the Placement parameters, 
see 3D text Placement controls. 
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Modify 3D text materials in Motion

When you create a new 3D text object, it appears in the canvas with a default 3D material 
preset applied: a smooth, white plastic texture (Basic). Most of the other preset materials 
in Motion Library are more complex, composed of multiple material layers—combinations 
of substance, paint, finish, and distress overlays that combine to create a naturalistic 3D 
texture. For example, the “Motion” preset consists of a colorful image used as a substance 
layer combined with an Enamel finish layer and a Reflective paint layer.

The Golf Ball preset consists of a Plastic substance layer combined with a Polish finish 
layer, a Dirt distress layer, and a Bumps distress layer (set to –500% to create a dimple 
effect).

You can adjust each of these material layers in the Text Inspector (in the Material section 
of the Appearance pane). As you modify these settings, your 3D text is updated instantly in 
the canvas, allowing you to fine-tune the look you want to achieve. 

Note: Material layers (which appear stacked in the Appearance pane of the Text Inspector 
when you select a 3D text object) are not to be confused with the image layers that 
comprise a Motion project (which are represented in the Layers list, Timeline, and canvas).



715Motion User Guide

Modify material layers used in a 3D texture
Adjust the material layers in a 3D texture using the controls in the Appearance pane of 
the Text Inspector. This example shows how to modify the Substance layer of a simple 3D 
texture.

1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

A preview thumbnail of the preset currently applied to the text appears in the Text 
Inspector, in the Material section of the Appearance pane.

The material layers comprising the preset are shown under the preview thumbnail. For 
example, the Basic material preset has a single material layer: Substance, which is set 
to Plastic. Additional Substance settings specify the type of plastic (Shiny) as well as 
the color (White).

2.	 Click the Substance pop-up menu and choose a substance category.

Depending on the option you select, additional controls may appear in the Appearance 
pane.

3.	 Click the Type pop-up menu (under the Substance pop-up menu) and select a specific 
substance belonging to the category you selected above.

Depending on the option you select, additional controls may appear in the Appearance 
pane.
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4.	 Adjust other available Substance settings, such as Color, Brightness, Roughness, and 
so on.

As you make adjustments, the preview thumbnail is updated in the Material section of 
the Appearance pane, and the 3D text is updated in the canvas. 

For a description of all material layer controls, see Intro to 3D text material controls.

Rename a modified material
When you modify material layers, the preview thumbnail in the Material section of the 
Appearance pane is updated show the new texture. However, the preset name under the 
thumbnail remains the same (“Basic” for text added with the 3D Text tool). You can rename 
the material to better describe the modified material.

•	 In Motion, in the Material section of the Text Inspector’s Appearance pane, double-click 
the name of the material (beneath the preview thumbnail), then type a new name and 
press Return.

The material is renamed for the selected 3D text object. The original preset remains 
unchanged.

Restore a material’s preset settings
If you’re not satisfied with the results of your modifications to a preset material, you can 
revert the material back to its original settings, or to the settings of any preset.

•	 In the Appearance pane of the Text Inspector, click the preview thumbnail in the 
Material area, then choose a preset from the pop-up menu.

The settings of the chosen preset are applied to 3D text object, and are shown in the 
updated preview thumbnail. Other customized instances of the preset are not affected.
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Add or remove 3D text material layers in Motion

You can add multiple material layers to create more complicated textures for 3D text. For 
example, if you combine an Aluminum substance layer with a Grey Granite substance layer, 
your 3D text takes on a metallic ore finish that may or may not exist in nature. Likewise, you 
can add paint layers, finish layers, distress layers, and emit layers to create highly realistic 
(or highly fanciful) textures that show signs of aging, dirtiness, radiance, and other real-
world qualities.

The order in which material layers are applied affects the appearance of the object. For 
example, you might add a wood surface layer, a paint layer, and various distress layers to 
create a material that looks like it’s made of painted wood that has been aged and worn. 
Each layer affects the layers stacked beneath it in the Appearance pane, and rearranging 
the layers creates different results.

You can also remove, rearrange, or temporarily disable material layers.

Add a material layer to a 3D texture
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, click Add Layer (in the Options section), 
then choose a new material layer option (Substance, Paint, Finish, Distress, or Emit) and 
subtype from the pop-up menu.

The new material layer and its adjustable controls are added in the Appearance pane.

3.	 To add another material layer, repeat step 2.

4.	 Adjust material layer controls in the Appearance pane to achieve the look you want.

For a description of all material layer controls, see Intro to 3D text material controls.
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Enable or disable a material layer
You can temporarily turn off or turn on any material layer to see how it’s affecting the 
overall texture.

•	 In the Appearance pane of the Text Inspector in Motion, click the activation checkbox to 
the left of the material layer name (Substance, Paint, Distress, and so on).

When the checkbox is selected, the material layer effect is visible in the canvas. When 
the checkbox is deselected, the effect is turned off.

Rearrange the stacking order of material layers
The stacking order of material layers in the Appearance pane affects a 3D texture’s 
appearance in the canvas. You can rearrange the stacking order to create different looks.

•	 In the Appearance pane of the Text Inspector in Motion, drag a material layer name 
(Substance, Paint, Distress, and so on), to a new position in the stack.

Remove a material layer
•	 In the Appearance pane of the Text Inspector in Motion, click a material layer name 

(Substance, Paint, Distress, and so on), then press Delete.

 Tip: To select and modify multiple material layers at once, Shift-click or Command-click 
the layers. This is especially useful if you want to delete or rearrange all the layers at once.
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Make light-emitting 3D text in Motion

The Emit material layer causes the selected 3D text layer to appear to be self-illuminating 
rather than just reflecting other light. The light emitted using this method does not act like 
other light sources in a 3D project: it doesn’t illuminate other objects or cause shadows to 
be cast.

In fact, the Emit layer is a texture with a single color, gradient, or image, which is 
superimposed over the 3D text object using an Add blend mode to make the text appear 
brighter.

1.	 In the Appearance pane of the Text inspector in Motion, click the Add Layer pop-up 
menu, then choose Emit.

An Emit material layer is added in the Options section of the Appearance pane.

2.	 Click the Fill pop-up menu and choose a fill type (Color, Gradient, or Texture).

Depending on the Fill option you choose, additional parameter controls appear in the 
Emit material layer. For a full description of all Emit parameter controls, see 3D text Emit 
controls.
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Apply materials to 3D text facets in Motion

By default, applying a material to a 3D text object causes all facets of the text to display 
the same material. But a 3D text object can also display different materials on its different 
facets. For example, you can apply a shiny wood finish to the front facet, and a brushed 
metal appearance to the side facet. You can even apply a different material to the edges 
(the border between the face and the sides or the back and the sides).

If the same material is applied to more than one facet, you can modify the multiple facets’ 
settings simultaneously to ensure the settings remain consistent. You can also link facets 
together so that they remain identical.
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Apply a material to a specific facet of 3D text
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, click the Material pop-up menu, then 
choose Multiple. 

Five preview thumbnails appear, representing the five facets of 3D text: Front, Front 
Edge, Side, Back Edge, and Back. 

3.	 Do any of the following:

•	 Apply a preset material to a facet: Click a preview thumbnail for any facet, then 
choose a new preset material from the pop-up menu.

•	 Apply a custom material to a facet: Click the name of a facet to display its material 
layers in the Appearance pane, then adjust those material layers or add new ones.

See Modify 3D text materials.

The facet is updated to display the new material—in your 3D text object in the canvas 
and in the Material preview thumbnail in the Appearance pane.

Apply a material to multiple facets simultaneously
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, click the Material pop-up menu, then 
choose Multiple. 

Five preview thumbnails appear, representing the five facets of 3D text: Front, Front 
Edge, Side, Back Edge, and Back. 

3.	 Shift-click the names of the facets you want to modify.

The selected facets are highlighted blue.
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4.	 Click the preview thumbnail of any of the highlighted facets, then choose a new preset 
material from the pop-up menu.

The selected facets are updated to display the new material—in your 3D text object in 
the canvas and in the highlighted Material preview thumbnails in the Appearance pane. 
The facets are also automatically linked together so further changes to any of them will 
affect all of them.

Link facets together
You can link two or more facets together so that any changes made to one of them 
automatically updates the others.

1.	 In Motion, with a 3D text object selected in your project and the Material pop-up menu 
in the Appearance pane set to Multiple, Shift-click the names of two or more facets you 
want to link.

2.	 Click the broken link icon on one of the selected facets.

All selected facets are linked and display blue active link icons.

3.	 To add another facet to the selected group, click its broken link icon.

The additional facet is linked to the group. Now, when you select any facet in the linked 
group, all linked facets are highlighted. Changes made to any of the highlighted facets 
are automatically made to all other facets in the linked group.

Unlink facets
•	 In Motion, to remove a facet from a linked group, click any member of the group to 

select the group, then click the link icon for the facet you want to unlink. 

The facet is deselected and removed from the group.

Revert multiple facets back to a single facet
•	 In the Appearance pane of the Text Inspector in Motion, click the Material pop-up menu, 

then choose Single. 

The five thumbnail previews are replaced by a single thumbnail preview, and all facets 
revert to the material that was applied to the selected facet. Any modifications you 
made to materials on other facets are permanently discarded. 
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Save a modified 3D text material in Motion

After you create your own materials, you can save those textures as custom presets for 
reuse or for sharing with colleagues, clients, or customers. Saving a modified material as a 
custom preset includes all material layers shown in the Material section of the Appearance 
pane at the time of saving (including disabled material layers). 

By default, custom preset materials are saved to the root level of the Materials category 
in the Library. If you want your custom preset materials grouped into a folder, you can 
manually organize them in the Library.

Save the currently selected material as a preset
1.	 In the Appearance pane of the Text Inspector in Motion, click the preview thumbnail in 

the Material section, then choose Save Material from the pop-up menu.

The Save Preset to Library dialog appears.

2.	 Type a descriptive name for the preset, then click Save.

The currently selected material is saved as a preset, in the Material category in the 
Library. You can apply the preset as you would any other material in the Library. See 
Apply a preset material to 3D text.
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Organize saved custom preset materials
1.	 In the Motion Library, select Materials in the left column.

The preset materials for that category appear in the stack area below.

2.	 Click the Add a Folder button (+) in the lower-left corner of the Library.

A new, untitled folder appears in the right column, above the stack.

Note: If you select a category of materials (Concrete or Fabric, for example) before you 
add the folder, the folder will be added within that category and will appear in the stack 
instead of in the category column.
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3.	 Double-click the name of the untitled folder, then type a new name and press Return.

4.	 Drag the custom preset material into the new folder.

The presets will now appear in the category you created, in both the Library and in the 
Material section of the Text Inspector’s Appearance pane (when the preview thumbnail 
is clicked).

Material controls

Intro to 3D text material controls in Motion

The preset or custom materials you apply to 3D text are made up of one or more material 
layers—Substance, Paint, Finish, Distress, and so on—that combine to create a complex 
texture. When you select a 3D text object, its material layers appear in the Appearance 
pane of the Text Inspector, stacked under the Material preview thumbnail.
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You can adjust the parameter controls in each of these material layers to modify the texture 
applied to your 3D text. For a complete list of controls in each type of material layer, see 
the following:

•	 3D text Substance controls

•	 3D text Paint controls

•	 3D text Finish controls

•	 3D text Distress controls

•	 3D text Emit controls

•	 3D text Placement controls

3D text Substance controls in Motion

Use the Substance controls in the Appearance pane of the Text Inspector to modify the 
basic surface texture of 3D text. Depending on the option you choose in the Substance 
pop-up menu (at the top of the Substance section of the Appearance pane), different 
parameter controls become available.

•	 Substance: A pop-up menu to set a substance type: Concrete, Fabric, Metal, Plastic, 
Stone, Wood, Flat, or Generic. 

When Substance is set to Concrete

•	 Type: A pop-up menu to choose a style of concrete (Aged, Colored, Smooth, and so on).

•	 Depth: A slider to adjust the depth of surface irregularities in the concrete substance. 

•	 Placement: A group of controls (available when you click the disclosure triangle) to 
set how the concrete pattern is applied to the text object. For details, see 3D text 
Placement controls.
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When Substance is set to Fabric

•	 Type: A pop-up menu to choose a style of fabric (Denim, Tweed, Wool, and so on).

•	 Roughness: A slider to adjust how raised and uneven the fabric pattern appears.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the fabric pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Substance is set to Metal

•	 Type: A pop-up menu to choose a style of metal (brass, aluminum, steel, and so on). 
There’s also a Custom option to modify the gradient for the metal’s reflection. See 
Example: Customize a metal gradient.

•	 Shininess: A slider to adjust how reflective the surface appears.

•	 Thickness: A slider to adjust the apparent thickness of the metal surface when it’s 
applied on top of another substance layer. Control this parameter more precisely by 
clicking the disclosure triangle, then adjusting individual Base and Highlight sliders.

When Substance is set to Plastic

•	 Type: A pop-up menu to choose any of three plastic styles: Shiny, Matte, or Textured.

•	 Color Type: A pop-up menu to choose whether you want the plastic surface to be a 
solid color or a gradient. For information on using gradients, see Intro to using the 
gradient editor.

•	 Color: A color control (available when Color Type is set to Color) to set the color of the 
plastic.

•	 Gradient Controls: A gradient control (available when Color Type is set to Gradient) to 
set a preset gradient or create a custom gradient, and to determine how the gradient is 
applied to the text object.
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•	 Texture Depth: A slider (available when Type is set to Textured) to adjust how visible the 
texture appears on the object.

•	 Placement: A group of controls (available when Color Type is set to Textured) to 
determine how the texture is applied to the text object. For details, see 3D text 
Placement controls.

When Substance is set to Stone

•	 Type: A pop-up menu to choose a style of stone (Limestone, Dark Granite, Slate, and so 
on).

•	 Depth: A slider to adjust the depth of surface irregularities in the stone substance.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the stone pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Substance is set to Wood

•	 Type: A pop-up menu to choose a style of wood (Ash, Walnut, Bamboo, and so on).

•	 Grain Depth: A slider to adjust the depth of grain in the wood substance.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the wood pattern is applied to the text object. For details, see 3D text Placement 
controls.
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When Substance is set to Flat

Use the Flat substance type to create an object that has depth, but which is unaffected 
by light or shadows. Flat creates a “2.5-dimensional” look popular in graffiti and pop-art 
styles.

•	 Surface: A pop-up menu to choose whether the surface should display a color, a 
gradient, or an image. For information on using gradients, see Intro to using the 
gradient editor.

•	 Color: A color control (available when Surface is set to Color) to set the color of the 
text.

•	 Gradient: A gradient control (available when Surface is set to Gradient) to set a preset 
gradient or create a custom gradient.

•	 Image: An image well (available when Surface is set to Image). Drag an image layer from 
the Layers list, Media list, Library, or Import dialog into the image well to use as the 
surface material of the 3D text object.

•	 Wrap Mode: A pop-up menu (available when Surface is set to Image) that determines 
how the selected image is applied to the 3D text object if the image is smaller or larger 
than the text object. Choose any of the following options:

•	 None: The image is applied once to the text, and areas of the text object that exceed 
the scope of the image are not covered.

•	 Repeat: The image is applied and reapplied to the text object as often as necessary, 
creating a pattern to fill in the area beyond the scope of the original image.

•	 Mirror: The image is applied to the text object, then applied again in an inverted, 
reversed orientation to cover the area beyond the scope of the original image.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the image pattern is applied to the text object. For details, see 3D text Placement 
controls.

•	 Intensity: A slider to adjust the vibrancy of the chosen Surface option (Color, Gradient, 
Image).

•	 Opacity: A slider to adjust the transparency of the chosen Surface option (Color, 
Gradient, Image). Drag to the left to make the surface appear more transparent; drag to 
the right to make the surface appear more opaque.
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•	 Enable Edge: A group of controls (available when you click Show on the right side of the 
heading row) that creates a dynamic effect for how edges are rendered depending on 
the relative position of the camera. As the text changes position (relative to the camera) 
the shading changes.

You can enable or disable these controls by selecting or deselecting the activation 
checkbox to the left of the Enable Edge row.

•	 Edge Amount: A slider to adjust how visible the edges of the selected substance 
layer appear.

•	 Invert: A checkbox that, when selected, inverts the visible area of the edges for the 
selected substance layer.

•	 Blend Mode: A pop-up menu to control how flat substance layers interact with layers 
beneath them. Choose any of the following methods:

•	 Normal: The visible areas of the topmost substance layer obscures the edges of 
the layers beneath it.

•	 Multiply: The visible areas of the substance layers are multiplied together so the 
darker areas of each layer appear on the edges of the text object.

•	 Add: The visible areas of the layers are added together so the lighter areas of 
each layer appear on the edges of the text object.

When Substance is set to Generic

The generic substance type (often called “diffuse” in other 3D applications) is used in 
several of the preset materials available in the Library. When Substance is set to Generic, 
a neutral surface is generated, onto which a solid color, gradient, or image can be applied. 
This substance type is usually used in conjunction with the Custom Specular or Custom 
Bump finish layers to create unique looks.

•	 Surface: A pop-up menu to choose whether the surface should display a color, a 
gradient, or an image.

•	 Color: A color control (available when Surface is set to Color) to set the color of the 
paint.

•	 Gradient: A gradient control (available when Surface is set to Gradient) to set a preset 
gradient or create a custom gradient. For information on using gradients, see Intro to 
using the gradient editor.

•	 Image: An image well (available when Surface is set to Image). Drag an image layer from 
the Layers list, Media list, or Library into the image well to use as the surface material of 
the 3D text object. See Apply a custom material to 3D text.

•	 Placement: A group of controls (available when Surface is set to Image) to determine 
how the image is applied to the text object. For details, see 3D text Placement controls.
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•	 Wrap Mode: A pop-up menu (available when Surface is set to Image) to choose how the 
selected image is applied to the 3D text object if the image is smaller or larger than the 
3D text object. Choose any of the following options:

•	 None: The image is applied once, and areas of the text object that exceed the scope 
of the image are not covered.

•	 Repeat: The image is applied and reapplied as often as necessary, creating a pattern 
to fill the area beyond the scope of the original image.

•	 Mirror: The image is applied to the text object, then applied again in an inverted, 
reversed orientation to cover the area beyond the scope of the original image.

•	 Brightness: A slider to adjust how much light is reflected by the surface of the text 
object. Control this effect with more precision by clicking the disclosure triangle and 
separately adjusting the following subcontrols:

•	 Lights: A slider to adjust the amount of light reflected in the object’s surface, based 
on the light type chosen in the Lighting Style pop-up menu (in the Lighting group of 
controls).

•	 Environment: A slider to adjust the amount of light reflected in the object’s surface, 
based on the environment type chosen in the Environment Type pop-up menu (in the 
Lighting group of controls).

•	 Opacity: A slider to adjust the visibility of the substance layer. Drag to the left to make 
the substance more transparent, or drag to the right to make it more opaque.

3D text Paint controls in Motion

Use the Paint controls in the Appearance pane of the Text Inspector to simulate a coat of 
paint on the 3D text object. Depending on the option you choose in the Paint pop-up menu 
(at the top of the Paint section of the Appearance pane), different parameter controls 
become available.

•	 Paint: A pop-up menu to set a paint type: Smooth Paint, Textured Paint, Watercolor, or 
Reflective Paint.
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When Paint is set to Smooth Paint

•	 Color Type: A pop-up menu to choose whether the paint is a solid color or a gradient. 
For information on using gradients, see Intro to using the gradient editor.

•	 Paint Color: A color control (available when Color Type is set to Color) to set the color 
of the paint.

•	 Paint Gradient: A gradient control (available when Color Type is set to Gradient) to set a 
preset gradient or create a custom gradient.

•	 Sheen: A slider to adjust the apparent shininess of the paint surface.

•	 Opacity: A slider to adjust the visibility of the paint. Drag to the left to make the paint 
more transparent; drag to the right to make it more opaque.

When Paint is set to Textured Paint

•	 Color Type: A pop-up menu to choose whether the paint is a solid color or a gradient. 
For information on using gradients, see Intro to using the gradient editor.

•	 Paint Color: A color control (available when Color Type is set to Color) to set the color 
of the paint.

•	 Paint Gradient: A gradient control (available when Color Type is set to Gradient) to set a 
preset gradient or create a custom gradient.

•	 Sheen: A slider to adjust the apparent shininess of the paint surface.

•	 Surface Texture: A pop-up menu to apply a texture.

•	 Texture Depth: A slider to adjust the visibility of the texture on the surface of the 3D 
text object.

•	 Opacity: A slider to adjust the visibility of the paint. Drag to the left to make the paint 
more transparent; drag to the right to make it more opaque.
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When Paint is set to Watercolor

•	 Paint Color: A color control (available when Color Type is set to Color) to set the color 
of the paint.

•	 Sheen: A slider to adjust the apparent shininess of the paint surface.

•	 Opacity: A slider to adjust the visibility of the paint. Drag to the left to make the paint 
more transparent, or drag to the right to make it more opaque.

•	 Placement: A group of controls (available when you click the disclosure triangle) to 
set how the watercolor pattern is applied to the text object. For details, see 3D text 
Placement controls.

When Paint is set to Reflective Paint

•	 Paint Job: A pop-up menu to select the type of reflective paint (Velvet, Pearl, Electric, 
and so on).

•	 Paint Color: A color control to set the color of the reflective paint.

•	 Second Color: Some Paint Job types use a second color. Use this color control to set 
that second color.

•	 Sheen: A slider to adjust the apparent shininess of the paint surface.

•	 Diffuse Brightness: A slider (available when Paint Job is set to Custom) to set the 
amount of color reflected by the text object. 

•	 Specular Brightness: A slider (available when Paint Job is set to Custom) to set the 
amount of light reflected by the text object.

•	 Shininess: A slider (available when Paint Job is set to Custom) to set how mirror-like the 
surface appears.

•	 Face Opacity: A slider (available when Paint Job is set to Custom) to set how 
transparent the paint effect is on surfaces that are more perpendicular to the camera.

•	 Edge Opacity: A slider (available when Paint Job is set to Custom) to set how 
transparent the paint effect appears on surfaces that are more parallel to the camera.

•	 Opacity: A slider to adjust the visibility of the paint. Drag to the left to make the paint 
more transparent; drag to the right to make it more opaque. 
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•	 Fresnel: A slider (available when Paint Job is set to Custom) to set the amount that a 
change in viewing angle impacts the reflectiveness of the object. A high Fresnel value 
means that there’s a strong change in reflectivity as the viewing angle changes; a low 
Fresnel value means that the reflectivity remains relatively consistent regardless of 
viewing angle. 

3D text Finish controls in Motion

Use the Finish controls in the Appearance pane of the Text Inspector to create the effect of 
a reflective finish (such as polish, enamel, and so on) on the surface of the 3D text object. 
Depending on the option you choose in the Finish pop-up menu (at the top of the Finish 
section of the Appearance pane), different parameter controls become available.

•	 Finish: A pop-up menu to set a finish type: Polish, Enamel, Brushed, Textured, or 
Custom Specular.

When Finish is set to Polish
•	 Reflectivity: A slider to adjust the brightness of reflections that appear on the surface 

of the object. Similarly to light intensity, Reflectivity can be set above 100% to create a 
high-dynamic-range (HDR)-type effect.

•	 Glossiness: A slider to adjust how dull or sharp reflections are. A setting of 0 creates a 
blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.

When Finish is set to Enamel
•	 Reflectivity: A slider to adjust the brightness of reflections that appear in the surface 

of the object. Similarly to light intensity, Reflectivity can be set above 100% to create a 
high-dynamic-range (HDR)-type effect.

•	 Glossiness: A slider to adjust how dull or sharp reflections are. A setting of 0 creates a 
blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.

•	 Highlight Color: A color control to set a color to tint the highlights that appear in 
reflections on the text object’s surface.

Note: The enamel setting effectively negates any bumpiness on layers beneath it (just 
like the effect of adding enamel to a rough surface in the real world). For example if you 
place this layer over a wood layer, the grain depth of the wood will be ignored no matter 
high you set that parameter.

When Finish is set to Brushed
•	 Type: A pop-up menu to choose a brushed pattern—Linear, Circular, or Overlapping 

Circular.

•	 Reflectivity: A slider to adjust the brightness of reflections that appear in the surface 
of the object. Similarly to light intensity, Reflectivity can be set above 100% to create a 
high-dynamic-range (HDR)-type effect.

•	 Glossiness: A slider to adjust how dull or sharp reflections are. A setting of 0 creates a 
blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.
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•	 Depth: A slider to adjust the apparent depth of the brush pattern.

•	 Reverse Depth: A checkbox that, when selected, inverts the brush pattern, making dark 
areas appear raised and light areas appear sunken into the surface.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the brush pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Finish is set to Textured
•	 Type: A pop-up menu to choose a texture: Combed, Cracked, Eggshell, and so on.

•	 Reflectivity: A slider to adjust the brightness of reflections that appear in the surface 
of the object. Similarly to light intensity, Reflectivity can be set above 100% to create a 
high-dynamic-range (HDR)-type effect.

•	 Glossiness: A slider to adjust how dull or sharp reflections are. A setting of 0 creates a 
blurry reflection; a setting of 100 creates a sharp, mirror-like reflection.

•	 Depth: A slider to adjust the apparent depth of the texture pattern.

•	 Reverse Depth: A checkbox that, when selected, inverts the texture pattern, making 
dark areas appear raised and light areas appear sunken into the surface.

•	 Placement: A group of controls (available when you click the disclosure triangle) to 
set how the texture is applied to the text object. For details, see 3D text Placement 
controls.

When Finish is set to Custom Specular
•	 Intensity: A slider to adjust the amount of light reflected in the text object’s surface.

You can control the intensity of lights and environmental light separately by clicking the 
disclosure triangle and exposing the following two sliders:

•	 Lights: A slider to adjust the amount of light reflected in the object’s surface, based 
on the kind of light chosen in the Lighting Style pop-up menu (in the Lighting group 
of controls).

•	 Environment: A slider to adjust the amount of light reflected in the object’s surface, 
based on the type of environment chosen in the Environment Type pop-up menu (in 
the Lighting group of controls).

For more information about these lighting options, see Intro to lighting 3D text.

•	 Intensity Image: A checkbox that, when selected, activates a group of controls for 
adding a custom image as an “intensity map.” An intensity map makes brighter areas of 
the image reflect more light, and darker areas limit the reflection. Use an intensity map 
to create the effect of a pattern or smudge on the object’s surface that dynamically 
modifies or limits the reflectiveness of the object. Click Show on the right side of the 
heading row to reveal the following controls:

•	 Image: An image well to assign an image used as the intensity map. Drag an image 
from the Layers list or Media list into this well.

•	 White Level: A slider that sets the brightness point above which areas of the 
intensity map allow reflections to pass and be visible. Lowering the White Level 
makes the intensity map more transparent, reducing reflectivity.
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•	 Black Level: A slider that sets the brightness point below which areas of the intensity 
map prevent reflections from passing. Raising the Black Level means more of the 
image will appear opaque.

•	 Wrap Mode: A pop-up menu that sets what happens if the image is smaller than the 
text object. Choose one of the following options:

•	 None: The image is applied once, and areas of the text object that exceed the 
scope of the image are not covered.

•	 Repeat: The image is applied and reapplied as often as necessary, creating a 
pattern to fill the area beyond the scope of the original image.

•	 Mirror: The image is applied to the text object, then applied again in an inverted, 
reversed orientation to cover the area beyond the scope of the original image.

•	 Placement: A group of controls (available when you click the disclosure triangle) 
to set how the intensity map is applied to the text object. For details, see 3D text 
Placement controls.

•	 Shininess: A slider to adjust how mirror-like the object appears. Control this effect more 
precisely by clicking the disclosure triangle and adjusting two additional sliders:

•	 Lights: A slider to adjust how sharply lights are reflected in the surface of the object. 
A higher setting makes reflections more sharply defined, and a lower setting creates 
a blurrier reflection.

•	 Environment: A slider to adjust how sharply the environment image is reflected in the 
surface of the object. A higher setting makes the environment more clearly visible, 
and a lower setting creates a blurrier reflection.

For more about lighting options, see Adjust 3D text lighting.

•	 Shininess Image: A checkbox that, when selected, activates a group of controls for 
adding a custom image as an “shininess map.” A shininess map controls the sharpness 
(or mirror-likeness) of the object. Click Show on the right side of heading row to reveal 
the following controls:

•	 Image: An image well to assign an image used as the shininess map. Drag an image 
from the Layers list or Media list into this well. Areas of the image that are white 
allow the reflection to appear sharp and mirror-like. Areas that are black make the 
reflection appear dull and blurry.

•	 White Level: A slider that sets the brightness point above which areas of the 
shininess map enable a clear, mirror-like reflection in the surface. Lowering the 
White Level means more of the reflection will appear clear and mirror-like.

•	 Black Level: A slider that sets the brightness point below which areas of the 
Shininess Image create a dulling or blurring effect on the object’s reflections. Raising 
the Black Level means more of the reflection will appear blurry.

•	 Wrap Mode: A pop-up menu that sets what happens if the image is smaller than the 
text object. Choose one of the following options:

•	 None: The image is applied once, and areas of the text object that exceed the 
scope of the image are not covered.

•	 Repeat: The image is applied and reapplied as often as necessary, creating a 
pattern to fill the area beyond the scope of the original image.

•	 Mirror: The image is applied to the text object, then applied again in an inverted, 
reversed orientation to cover the area beyond the scope of the original image.
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•	 Placement: A group of controls (available when you click the disclosure triangle) 
to set how the shininess map is applied to the text object. For details, see 3D text 
Placement controls.

•	 Specular Color: A pop-up menu to choose whether the specular color is based on the 
current surface, a solid color, or an image. Use this control to add a hue (or pattern) 
that colors the reflection as if the material were made of that color or pattern. For 
example, adding an orange specular color causes reflections to have an orange hue, as 
if the 3D text object were made of copper.

•	 Surface Blend: A slider (available when Specular Color is set to From Surface) to adjust 
the amount of the underlying color blended into the highlights.

•	 Color: A color control (available when Specular Color is set to Solid Color) to set the 
Specular color.

•	 Anisotropic: A checkbox that, when selected, activates a group of controls that limit the 
custom specular effect to a particular pattern or direction (as opposed to the default 
method, which disperses the specular effect in many directions at once). This allows 
you to distort the highlights created by lighting styles and scene lights. Click Show on 
the right side of the heading row to reveal the following controls:

•	 Geometry: A pop-up menu to choose whether the anisotropic effect is linear, 
cylindrical, or based on a custom image.

•	 Placement: A pop-up menu to set how the anisotropic specular effect is applied to 
the text object. For details, see 3D text Placement controls.

•	 Place On: A pop-up menu to choose whether the anisotropic effect is applied per 
glyph or per object. For details, see 3D text Placement controls.

•	 Orientation: Three dials (X, Y, and Z), available when Geometry is set to Linear, to set 
the direction of the linear anisotropic specular effect.

•	 Position: Value sliders (available when Geometry is set to Cylindrical) to set the 
position where the cylindrical anisotropic specular effect is centered. 

•	 Anisotropic Angle Image: An image well (available when Geometry is set to Image). 
Drag an image from the Layers list or Media list into this well to use as a map that 
determines the appearance of the anisotropic specular effect.

•	 Wrap Mode: A pop-up menu (available when Geometry is set to Image) to choose 
how the intensity map is applied to the 3D text object if the image is smaller or larger 
than the 3D text object. Choose any of the following options:

•	 None: The image is applied once, and areas of the text object that exceed the 
scope of the image are not covered.

•	 Repeat: The image is applied and reapplied as often as necessary, creating a 
pattern to fill the area beyond the scope of the original image.

•	 Mirror: The image is applied to the text object, then applied again in an inverted, 
reversed orientation to cover the area beyond the scope of the original image.

•	 Highlight Sharpness: A slider to adjust the shape of the reflected highlight, making it 
narrow or wide.
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3D text Distress controls in Motion

Use the Distress controls in the Appearance pane of the Text Inspector to create the effect 
of adding wear or degradation to the surface of the 3D text object. Depending on the 
option you choose in the Distress pop-up menu (at the top of the Distress section of the 
Appearance pane), different parameter controls become available.

•	 Distress: A pop-up menu to set a distress type: Scratches, Stains, Dirt, Dents, Wavy, 
Bumps, Perforated, Wrinkles, or Custom Bumps.

When Distress is set to Scratches
•	 Type: A pop-up menu to choose a scratch pattern.

•	 Depth: A slider to adjust the apparent depth of the scratches.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the scratch pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Distress is set to Stains
•	 Type: A pop-up menu to choose a stain pattern.

•	 Opacity: A slider to adjust the visibility of the stain pattern. 

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the stain pattern is applied to the text object. For details, see 3D text Placement 
controls.
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When Distress is set to Dirt
•	 Type: A pop-up menu to choose a dirt pattern.

•	 Opacity: A slider to adjust the visibility of the dirt pattern.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the dirt pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Distress is set to Dents
•	 Type: A pop-up menu to choose a dents pattern.

•	 Depth: A slider to adjust the apparent depth of the dents in the 3D text object.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the dent pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Distress is set to Wavy
•	 Depth: A slider to adjust the apparent depth of the wave pattern. 

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the wave pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Distress is set to Bumps
•	 Type: A pop-up menu to choose a bump pattern.

•	 Depth: A slider to adjust the apparent depth of the bump pattern.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the bump pattern is applied to the text object. For details, see 3D text Placement 
controls.

When Distress is set to Perforated
•	 Type: A pop-up menu to choose a perforation pattern.

•	 Depth: A slider to adjust the apparent depth of the perforation pattern.

•	 Placement: A group of controls (available when you click the disclosure triangle) to 
set how the perforation pattern is applied to the text object. For details, see 3D text 
Placement controls.

When Distress is set to Wrinkles
•	 Type: A pop-up menu to choose a wrinkle pattern.

•	 Depth: A slider to adjust the apparent depth of the wrinkles.

•	 Placement: A group of controls (available when you click the disclosure triangle) to set 
how the wrinkle pattern is applied to the text object. For details, see 3D text Placement 
controls.
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When Distress is set to Custom Bumps

This option lets you select an image to serve as the texture map for the selected object.

•	 Bump map gain: A slider to increase or decrease the contrast of the selected image, 
giving the effect of larger or smaller bumps.

•	 Image: An image well to assign a custom image to use as the bump map. Drag an image 
from the Layers list or Media list into this well.

•	 Bump Map Type: A pop-up menu to set whether the bump map is interpreted as Height, 
which uses the luminance of an image to define the bump pattern, or as Normal, which 
uses an RGB map image to define the bump pattern.

•	 Invert: A checkbox that, when selected, swaps the light and dark elements of the image, 
effectively inverting the apparent height of the bumps.

•	 Wrap Mode: A pop-up menu to set what happens if the image is smaller than the text 
object. Choose from one of the following options:

•	 None: The image is applied once, and areas of the text object that exceed the scope 
of the image are not covered.

•	 Repeat: The image is applied and reapplied as often as necessary, creating a pattern 
to fill the area beyond the scope of the original image.

•	 Mirror: The image is applied to the text object, then applied again in an inverted, 
reversed orientation to cover the area beyond the scope of the original image.

•	 Placement: A group of controls (available when you click the disclosure triangle) to 
set how the texture is applied to the text object. For details, see 3D text Placement 
controls.

•	 Blend Mode: A pop-up menu to set how multiple bump layers interact with each other. 
Use this parameter to create even more unique textures. Choose one of two options:

•	 Add: Uses a mathematical add operation to combine the texture with underlying 
bump maps.

•	 Replace: Overrides the bump attributes of underlying layers.
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3D text Emit controls in Motion

Use the Emit controls in the Appearance pane of the Text Inspector to add a radiance 
effect to 3D text, as if the text were emitting its own light.

•	 Fill: A pop-up menu to set whether the light emitted is based on a solid color, a 
gradient, or a texture. For information on using gradients, see Intro to using the gradient 
editor.

•	 Color: A color control (available when Fill is set to Color) to select the color to be 
emitted.

•	 Gradient: A gradient control (available when Fill is set to Gradient) to set a preset 
gradient or create a custom gradient for the colors to be emitted.

•	 Image: An image well (available when Fill is set to Texture) to assign a custom image 
to use as the texture emitted. Drag an image from the Layers list or Media list into this 
well.
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•	 Wrap Mode: A pop-up menu (available when Fill is set to Texture) to set what happens if 
the image is smaller than the text object. Choose from one of the following options:

•	 None: The image is applied once, and areas of the text object that exceed the scope 
of the image are not covered.

•	 Repeat: The image is applied and reapplied as often as necessary, creating a pattern 
to fill the area beyond the scope of the original image.

•	 Mirror: The image is applied to the text object, then applied again in an inverted, 
reversed orientation to cover the area beyond the scope of the original image.

•	 Placement: A group of controls (available when Fill is set to Texture) to set how the 
texture is applied to the text object. For details, see 3D text Placement controls.

•	 Intensity: A slider to adjust how visible the emitted light appears on the object.

•	 Coverage: A slider to adjust how much the emit layer is visible based on the opacity of 
the layer. A value of 100% (the default) causes the emit layer to display, regardless of 
the opacity of the layers beneath it. A value of 0% means that the emit layer shines only 
where the material is opaque.

3D text Placement controls in Motion

Many material layers use graphic images with fixed dimensions that are “mapped” to 
the 3D text object—for example, the pattern of a fabric substance or the scratches of a 
distress layer. When a material layer uses a mapped image, Placement controls become 
available at the bottom of that layer’s section in the Appearance pane of the Text Inspector. 
You can use these controls to set how the image is mapped onto the text object. 

If you have multiple material layers—each using a different mapped image—you can adjust 
each layer’s Placement controls independently. For example, for a material made of a wood 
substance and a scratched distress layer, you can rotate the orientation of the wood grain 
one way, and then rotate the orientation of scratches the other way.

You can also adjust the orientation of multiple material layers at once using a shared set 
of Placement controls. For example, you can rotate the wood grain and the scratches as 
a group, in the same direction. The Shared Placement controls, located in the Options 
section of the Appearance pane (above the material layers controls), become available 
when you designate the placement for one or more material layers as Shared. 

The Options section of the Appearance pane also has a set of Global Placement controls 
you can use to randomize the placement of any textures applied in any material layer. 
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Independent Placement controls
These controls appear at the bottom of each material layer in the Appearance pane that 
uses a texture or image. To see all the controls, click the disclosure triangle.

•	 Placement: A pop-up menu to set whether the image or texture is mapped to the 3D 
text object independently of other material layers or in combination with other material 
layers. There are two options:

•	 Independent: Activates controls (described below) for adjusting the position, scale, 
and rotation of this material layer’s image or texture. 

•	 Shared: Disables the Placement controls for this material layer, and enables Shared 
Placement controls in the Options section of the Appearance pane. Use the Shared 
Placement controls (described in the next section below) to adjust the position, 
scale, and rotation of this material layer’s image or texture, as well as those of any 
other material layers set to Shared.

•	 Place On: A pop-up menu to choose whether to apply the image or texture once to the 
entire text object, or to apply it individually to each glyph (character).

•	 Side Placement: A pop-up menu to set how the mapped image or texture is applied to 
the sides of the text object. Choose one of the following options:

•	 Normal: The image or texture is mapped to the front of the text object as well as to 
the side.

•	 Turn 90°: The image or texture is mapped to the front of the text object; the same 
image is mapped to side the of text object, but is rotated by 90 degrees.
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•	 Stretch From Side: The image or texture is mapped to the front of the text object, 
and to the side, and the pixels on the edge are repeated, so that the pattern appears 
to be stretched over the sides of the text object.

•	 Position: Value sliders to offset the location where the image or texture is mapped to 
the object.

•	 Scale: A slider to adjust the image or texture being mapped. Click the disclosure 
triangle to reveal separate X and Y scale sliders and the Scale With Font Size checkbox 
(described below).

•	 Scale With Font Size: A checkbox (visible when you click the Scale disclosure triangle) 
that, when selected, causes the size of the applied image or texture to change 
proportionally whenever you modify the font size of the text object.

•	 Rotation: A dial to rotate the mapped image or texture around the Z axis. Click the 
disclosure triangle to reveal separate dials for rotating around the X, Y, and Z axes.

Shared Placement controls
These controls appear in the Options section of the Inspector when one or more 
material layers are set to Shared placement. These controls are identical to the controls 
described in the Independent Placement controls above. Adjusting these controls adjusts 
the placement (position, scale, rotation, and so on) of all material layers set to Shared 
placement.

Global Placement controls
These settings modify all images that are affected by placement controls, independent or 
shared.

•	 Randomize: A pop-up menu to apply randomly generated variations of the pattern 
placement on the different facets of the 3D text object. Choose an option from the 
pop-up menu to limit the randomness to just the sides, just the front and back, or to all 
facets.

•	 Random Seed: A control to choose a different random number to change the random 
pattern placement. Click the button to the right of the seed value to have Motion select 
a random number, or enter your own number directly into the text field.
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Example: Customize a metal gradient in Motion

Each of metal materials in the Motion Library has a default reflection gradient governing 
how colors reflect off the surface of metallic 3D text. You can customize the preset metal 
materials to create unique effects. This example shows how to add colorful iridescence to 
a default metal reflection gradient.

1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Text Inspector’s Appearance pane, click the preview thumbnail in the Material 
area, choose Metal from the pop-up menu, then choose a metal type from the submenu.
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3.	 Do one of the following:

•	 If you chose Aluminum Foil, Brushed Metal, Chrome, Copper, Gold, or Nickel: In 
the Substance controls, click the Type pop-up menu, then choose Custom (at the 
bottom of the list).

•	 If you chose Brushed Circular, Distressed Metal, Grunge Metal, Iron, Old Steel, or 
Rust: Click the Substance pop-up menu, and choose Metal; then click the Type pop-
up menu, and choose Custom. 

The Reflection Gradient control for the selected metal appears.
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4.	 Modify the gradient using the gradient editor.

For more information about using gradient controls, see Intro to using the gradient 
editor.

In the final text treatment, the colors that you set on the left side of the gradient 
editor (the fuchsia and light blue colors, in this example) are more visible when 3D text 
surfaces are perpendicular to the screen. The colors that you set on the right side of 
the gradient (violet and gray, in this example) are more visible in the final text treatment 
when 3D surfaces are parallel to the screen. And when the 3D text is rotated (or the 
camera is animated in a 3D project), the text reflects the different gradient colors, 
shimmering as it moves.

For more information on using the gradient editor, see Intro to using the gradient editor. 
For information on the metal material controls, see 3D text Substance controls.
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Modify lighting style

Intro to lighting 3D text in Motion
3D text in Motion is designed to simulate the shading and reflectivity of a three-
dimensional object in the real world reacting to local lighting conditions and the 
surrounding environment.

Although you can manually add light objects to your project to achieve precise lighting 
effects, it’s not a requirement when working with 3D text. The built-in lighting and 
environment controls in Motion greatly simplify the process of creating natural-looking 3D 
text objects.

Also, because reflectivity is a fundamental aspect of what makes three-dimensional 
objects appear realistic, Motion allows you to control what’s reflected in 3D text objects. 
You can choose from a range of preset environments, or you can create your own custom 
environment.
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Adjust 3D text lighting in Motion
All 3D text objects in Motion have a set of built-in options that simulate basic lighting 
conditions. This enables you to quickly and easily create natural-looking scenes quickly 
and easily.

Additionally, you can add light objects to your project if you need to illuminate your 3D text 
objects in more complex or specific ways.

Modify the lighting style
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, click the Lighting Style pop-up menu and 
choose one of the lighting options.
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3.	 Drag the Intensity slider to increase or decrease the amount of illumination.

Your 3D text object is illuminated in style you chose.

For a detailed list of all 3D text lighting controls, see 3D text Lighting and Environment 
controls.

Control how 3D text objects cast self-shadows
In the real world, complex objects often cast shadows on parts of themselves. You can 
simulate this effect in Motion by having 3D text cast “self-shadows.”

Note: The self-shadow effect does not cast shadows on other objects in your project. To 
make 3D text cast shadows on other objects, you must add light objects (described in “Use 
external lights to illuminate a 3D text object,” below). 
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1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, click the Self Shadows checkbox (in the 
Lighting section).

Note: The Self Shadows checkbox is hidden when Lighting Style is set to Off.

With self-shadows enabled, one part of a 3D text object will cast a shadow on another 
part of the same object (depending on the light source position). Although this effect 
can add realism to a text object, in some cases it may add unwanted or distracting 
shadows.

3.	 Click Show on the right side of the Self Shadows heading row to reveal additional 
controls.

4.	 Drag the Opacity slider to the left to decrease the visibility of self-shadows.

5.	 Drag the Softness slider to the right to soften the edges of self-shadows, making them 
more subtle.

For a more information about self-shadow controls, see 3D text Lighting and Environment 
controls.
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Use external lights to illuminate a 3D text object
To create more precise or complex lighting and shadow effects, you can add light objects 
to your project. This technique is useful if you want to illuminate multiple objects in a 
consistent and naturalistic way, if you want to use very specific types of lights, or if you 
want to use color lights.

1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text inspector, click the Lighting Style pop-up menu and 
choose Off, then deselect the Environment checkbox (if it’s not already deselected).

Note: This step is optional, but turning off 3D text’s built-in lighting effects before you 
manually add light objects prevents conflicting lighting results.

3.	 Choose Object > New Light (or press Shift-Command-L) to add a new light object to the 
scene.

If your 3D text is currently in a 2D group, a dialog appears asking if you want to switch 
your 2D groups to 3D.
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4.	 Click Switch to 3D.

A light object is added to your project.

5.	 In the canvas, drag the light object’s onscreen handles to illuminate your objects.

For more information about moving and orienting lights, see Add lights.

6.	 In the Light Inspector, choose a light type and adjust other settings as needed.

7.	 If necessary, drag or rotate the light object in the canvas using its onscreen controls.

For detailed information about using lights and shadows in 3D projects, see Add lights and 
Intro to 3D shadows.

Use external lights to cast shadows from a 3D text object
In addition to self-shadowing, 3D text can cast shadows on other objects in the project.
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1.	 In Motion, repeat steps 1–7 in “Use external lights to illuminate a 3D text object,” above.

2.	 Select a light object in the canvas, Layers list, or Timeline.

Note: The Shadows controls are not available when the Light Type pop-up menu is set 
to Ambient.

For more information about using the shadow controls, see and 3D shadow controls.

3.	 In the Light Inspector, select the Shadows activation checkbox.

When selected, the checkbox is highlighted blue. 

4.	 Double-click the Shadows heading to expose the shadow controls, then adjust them to 
your liking. 

5.	 Select the layer you want your 3D text to cast the shadow on, open the Properties 
Inspector, double-click Shadows heading to expose the shadow controls, then select 
the Receive Shadows checkbox. 

Note: The layer receiving the shadow needs to be offset from the object casting the 
shadow.

Modify 3D text environment lighting in Motion
Reflective objects such as 3D text need something to reflect. In Motion, you can choose 
what’s reflected in the surface of 3D text objects by enabling environment lighting.

Environment lighting projects an image onto the 3D text object to simulate a reflected 
world.

Because environment lighting emulates the reflective properties of real-world objects, its 
effects are more noticeable on 3D text with shiny surfaces.
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Set the image to be reflected by a 3D text object
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text inspector, double-click the Environment heading to 
reveal parameter controls.

3.	 Click the Type pop-up menu and choose an environment.

Choose one of the preset images (such as Roof Top, Light Box, and so on), or choose 
Gradient and customize the gradient to act as the source of the reflection. For 
information on using gradients, see Intro to using the gradient editor.

 Tip: You may need to rotate the 3D text object around its X or Y axis to see different 
parts of the reflected environment. For more about rotating a text object, see Move and 
rotate 3D text.
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Modify the appearance of a reflected environment
In the Appearance pane of the Text inspector (in the Environment section) in Motion, do 
any of the following:

•	 Drag the Intensity slider to the left to make the reflected image appear dimmer, or drag 
the slider to the right to make the reflected image appear brighter.

•	 Drag the Rotation dial to change the angle at which the environment image appears 
reflected in the 3D text object.

 Tip: By default, environments rotate around the Y axis (unlike other rotation controls 
in Motion which default to rotating around the Z axis). If you want to rotate around a 
different axis than the default, click the disclosure triangle next to the Rotation dial to 
reveal separate X, Y, and Z axis rotation dials. 

•	 Drag the Contrast slider to the right to make the reflected image to create a sharper 
difference between the light and dark areas.

•	 Drag the Saturation slider to the left to reduce the amount of color visible in the 
reflected image.

Turn off the environment reflection
Because the environment control effectively adds a light source to your 3D text object 
(even when Lighting Style is set to Off), you may want to turn off the Environment 
entirely—for example if you add scene lights to create a custom lighting environment. 

•	 In Motion, deselect the activation checkbox to the left of the Environment controls.

 Tip: If your project has more than one 3D text object, for more realistic results make 
sure that all text objects use same reflection environment.

For a list of Environment controls, see 3D text Lighting and Environment controls.
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3D text Lighting and Environment controls in Motion
Adjust the controls in the Lighting section of the Text Inspector’s Appearance pane to 
modify 3D text lighting:

Lighting controls
•	 Lighting Style: A pop-up menu to select a preset lighting style for the selected 3D text 

object. Choose any of the following:

•	 Off: Disables the 3D text lighting controls. Choose this option if you want to 
manually add your own lights to the project.

Note: You may also want to disable environmental lighting. See Modify 3D text 
environment lighting.

•	 Standard: Illuminates the text object from the front, from the left, and from the right.

•	 Medium Center: Creates a soft, flat light illuminating the text object from the center.

•	 Medium Left: Creates a soft, flat light illuminating the text object from the left.

•	 Medium Right: Creates a soft, flat light illuminating the text object from the right.

•	 Above: Illuminates the text object from above.

•	 Backlit: Illuminates the text object from behind.

Note: By default, environmental light causes additional illumination to fall on the 
front surface of the text object. To create a backlighting effect where the front 
of the text object appears entirely unlit, deselect the activation checkbox for 
the Environment controls to disable environmental lighting. See Modify 3D text 
environment lighting.

•	 Below: Illuminates the text object from the bottom.

•	 Diagonal Left: Illuminates the text object from the upper-left corner.
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•	 Diagonal Right: Illuminates the text object from the upper-right corner.

•	 Drama Top Left: Illuminates the text object from the top and left sides, with no 
illumination at all on the right or bottom.

•	 Drama Top Right: Illuminates the text object from the top and right sides, with no 
illumination at all on the left or bottom.

•	 Intensity: A slider to adjust the strength of the lights cast on the 3D text object.

•	 Self Shadows: A group of controls (available when you click Show on the right side of 
the heading row) to set if and how the lighting causes text glyphs (individual characters) 
to cast shadows upon the other glyphs in the text object.

When Self Shadows is enabled, two additional controls become available: 

•	 Opacity: A slider to adjust how visible the shadows are. This can be set above 100% 
to override the effect of the default light shading (based on the lighting model and 
setup).

•	 Softness: A slider to adjust how blurred the shadows appear.

Environment controls
•	 Environment: An activation checkbox that, when selected, causes 3D text to appear to 

reflect lighting from a surrounding “environment.” Click Show on the right side of the 
Environment heading row to reveal additional adjustment controls: 

•	 Type: A pop-up menu to choose the image, gradient, or pattern that’s reflected. For 
information on using gradients, see Intro to using the gradient editor.

•	 Intensity: A slider to adjust the strength of the environment light.

•	 Rotation: A dial that controls the angle at which the environment image is mapped 
onto the object.

•	 Contrast: A slider that increases or decreases the contrast of the environment 
image. More contrast creates weaker midtones, brighter highlights, and darker 
shadows; lower contrast creates stronger midtones, muted highlights, and muted 
shadows.

•	 Saturation: A slider to adjust the visibility of the colors within the environment 
image. More saturation creates more visible color; less saturation creates a more 
monochromatic image.

•	 Anisotropic: A checkbox that creates more realistic distortions in reflections (when 
used in conjunction with Finish > Brushed layers or with the Anisotropy parameters 
in the Finish > Custom Specular layers).

Note: Although selecting the Anisotropic checkbox improves realism in your 3D text 
project, it may slow performance.
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Add a glow or drop shadow to 3D text in Motion
You can apply standard glow and drop shadow effects to 3D text objects just as you would 
to 2D text objects. However, the results always appear in only two dimensions.

Add a glow effect to a 3D text object
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, select the activation checkbox to the left 
of the Glow heading (near the bottom of the Appearance pane).

A default yellow glow is applied to the text object.

3.	 Double-click the Glow heading to display parameter controls, then adjust Color, 
Opacity, and other settings to customize the glow effect.

Note: Adding a Glow effect to a 3D text object forces the object to be rasterized. For 
details, see How rasterization affects basic text.

Add a Drop Shadow effect to a 3D text object
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D text object.

2.	 In the Appearance pane of the Text Inspector, select the activation checkbox to the left 
of the Drop Shadow heading (at the bottom of the Appearance pane).

3.	 Double-click the Drop Shadow heading to display parameter controls, then adjust Color, 
Opacity, and other settings to customize the drop shadow effect.
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3D text intersection in Motion
Use the following intersection and layer order guidelines when working with 3D text:

•	 3D text intersects only with other 3D text.

•	 For 3D text layers in the same group to intersect, they must be contiguous in the Layers 
list (with no other layers separating the 3D text layers).

•	 For 3D text layers in different groups to intersect, the 3D text layers must be contiguous 
in the Layers list (with no other layers in either group separating the 3D text layers). 
Additionally, the groups must be set to 3D. For more information about converting 2D 
groups to 3D groups, see Create 3D intersection.

•	 3D text uses only layer order: For 3D text to appear above other non-3D text layers, the 
3D text must be positioned above the other layers in the Layers list.

For more information about layer order, see Create 3D intersection.

Certain operations, such as the application of some filters or selecting the Crop checkbox 
in the Properties Inspector, can cause a group containing 3D text to be rasterized. See 
How rasterization affects basic text.
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Animate text

Intro to animated text in Motion
After you create 2D or 3D text, you can apply dynamic animation effects using behaviors, 
keyframes, or a combination of both.

Although you can animate text using standard behavior types (Basic Motion, Parameter, or 
Simulation behaviors), two behavior categories in Motion are designed specifically for text:

•	 Text Sequence behaviors are preset behaviors that apply specific effects with no further 
customization necessary (although you can easily adjust them if you want to modify 
their effects). There are dozens of expressive presets to choose from, including Blur In, 
Frightened, Shock, Inflate Out, and Squish.

•	 Text Animation behaviors are highly customizable animation effects that allow you to 
create scrolls and crawls for titles, credits, and lower thirds; animated text tracking, 
which makes characters spread apart or compress together; “Type-on” effects, which 
make characters pop into view sequentially); and powerful custom sequencing effects 
that animate color, outline, opacity, scale, and other attributes character by character.

You apply a text behavior to a text object the same way you apply standard behaviors to 
any object in Motion. And after you apply and customize a text behavior, you can save it to 
the Library for future use.
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Apply a text behavior in Motion
You apply text behaviors in the same manner as all other behaviors in Motion—from the 
Library or from the Behaviors pop-up menu in the toolbar. 

Apply a text behavior from the Library
1.	 In Motion, create a text layer in your project.

See Add text or Add 3D text.

2.	 In the Library, select the Behaviors category, then select the Text Animation or Text 
Sequence subcategory.

The Text Animation subcategory contains behaviors for creating scrolls and crawls, 
text tracking, type-on effects, and custom text animation effects. The Text Sequence 
subcategory contains ready-made text animation presets that create specific effects 
with little or no customization necessary. 
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3.	 Select a text behavior in the stack.

A preview of the animation plays in the preview area. The preview merely represents the 
default animation of the behavior, which can be modified later.

4.	 Do one of the following:

•	 Drag the behavior to a text layer in the canvas, Layers list, or Timeline.

•	 Click the Apply button in the preview area.

The behavior is applied, and the Text HUD is replaced with the Text Behavior HUD (if the 
HUD is not visible, press F7).

Note: When you apply a behavior by dragging it from the Library, you can apply the 
behavior to only one text layer in your project at a time. If you need to apply a behavior to 
multiple text layers at the same time, use the Behaviors pop-up menu, described in the 
next task. 

Apply a text behavior from the Behaviors pop-up menu
1.	 In Motion, create a text layer in your project.

See Add text or Add 3D text.

2.	 In the toolbar, click Behaviors, then do one of the following:

•	 Choose Text Animation, then choose a behavior from the submenu.

•	 Choose Text-Basic, Text-Continuous, Text-Energetic, Text-Glow, Text-Highlighter, or 
Text-Subtle, then choose a preset behavior from the submenu.

The behavior is applied, and the Text HUD is replaced with the Text Behavior HUD (if the 
HUD is not visible, press F7).
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Use preset text behaviors

Preset text behaviors in Motion
Preset text sequence behaviors, found in the Text Sequence subcategory of behaviors 
in the Library, are preset versions of the Sequence Text behavior. The parameters in 
these preset behaviors are already animated (often with keyframes), requiring little or no 
customization on your part (although you can always modify them).

There are six classes of preset behaviors in the Text Sequence subcategory:

•	 Text-Basic: Simple animations with a start (text appears) and end (text disappears), 
such as a fade-in or a blur-out.

•	 Text-Continuous: Animations without a start or end, such as text that wiggles 
continuously.

•	 Text-Energetic: Animations with a start (text appears) and end (text disappears) with a 
little more pizazz, such as text that bounces in or twirls out.

•	 Text-Glow: Animations with a start (text appears) and end (text disappears) that create 
glowing effects, such as a wisp-in or a flare-out.

•	 Text-Highlighter: Animations that are applied to the beginning of a text layer, such as a 
quick shiver or stretch.

•	 Text-Subtle: Animations with a start (text appears) and end (text disappears) that create 
soft, mellow effects, such as text that shimmers in or glows out.

After you apply a preset text behavior, you can leave it as is, or customize it to adjust 
the text effect or timing. Because these presets are all based on the highly customizable 
Sequence Text behavior, you can easily modify parameter values, add additional 
parameters, or remove parameters. For example, the Arrange In behavior automatically 
animates text Opacity, Scale, and Rotation values by default. However, you can add a 
parameter, such as Position, to the behavior.

The parameter controls in the Behaviors Inspector vary depending on the preset behavior 
you apply. Some preset behaviors are composed of multiple behaviors. For example, 
the Quiver preset behavior is made from a customized Sequence Text behavior and a 
Randomize parameter behavior.

For more information about the adjustable controls in preset text behaviors, see Sequence 
Text behavior controls. For more information about Parameter behaviors, see Intro to 
Parameter behaviors.
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 Tip: Because most preset text sequence behaviors are keyframed, it’s often helpful to 
see where the keyframes occur when customizing. In the Timeline, click the Show/Hide 
Keyframes button to display keyframes superimposed over the behavior’s timebar.

Customize a preset text behavior in Motion
After you apply a preset text behavior from the Text Sequence subcategory, you can 
modify its settings to suit your needs.

Add a parameter to a preset text behavior 
1.	 In the Layers list or Timeline in Motion, select a preset text sequence behavior.

2.	 In the Parameter row of the Behaviors Inspector, click the Add pop-up menu, then 
choose a parameter.

The parameter is added to the preset.

Modify the speed of a preset text behavior
When you add a preset text behavior, its bar in the Timeline is usually much shorter than 
that of the text layer it’s applied to. This is by design: most preset text animations apply a 
brief introductory effect to a text layer (a fade-in, for example).
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You slow down or speed up the animation by changing the duration of the behavior’s bar in 
the Timeline.

1.	 In the Layers list or Timeline in Motion, select a preset text sequence behavior.

2.	 In the mini-Timeline or Timeline, do one of the following:

•	 To slow the effect, drag the right end of the behavior bar right (to lengthen the 
effect) to the frame where you want the animation to end.

Note: You can also move the playhead to the frame where you want to set the new 
Out point, then choose Mark > Mark Out (or press O).

•	 To speed up the effect, drag the right end of the behavior bar left (to shorten the 
behavior) to the frame where you want the animation to end.

Note: You can also move the playhead to the frame where you want to set the new 
Out point, then choose Mark > Mark Out (or press O).

Change the default glow color of a preset text behavior
If a preset text behavior contains a glow parameter, you can change the default glow color 
in two ways: in the Text Inspector or in the Behaviors Inspector.

1.	 In the Layers list or Timeline in Motion, select the preset text behavior.

2.	 Do one of the following:

•	 In the Appearance pane of the Text Inspector, choose a color in the Color well of the 
Glow controls.

Important: Selecting the Glow checkbox results in an additive effect: The values 
defined in the Appearance pane are added to those in the text behavior. This may 
cause the look of the preset to change. Deselecting the Glow checkbox retains the 
color change without the additive effect.

•	 In the Parameter row of the Behaviors Inspector, click the Add pop-up menu, then 
choose Glow > Color.

The Color parameter is added to the Glow parameters in the behavior.
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Example: Modify the Flare In behavior in Motion
In this section, the Flare In behavior (from the Text-Glow subcategory of preset text 
behaviors) is used to show how to modify a preset text behavior.

The following steps begin at the first frame of the text.

1.	 In Motion, select the text layer to be animated, then click Behaviors in the toolbar and 
choose Text-Glow > Flare In.

At the first frame, the text is not visible because Face opacity and Glow opacity start at 
0%, then move to 100%.

2.	 Press the Space bar to play the project and see the applied effect.

The text characters fade in from 0% to 100% percent opacity, and sharpen from a blur 
value of 10. A glow overlays the effect as the text appears. 

3.	 In the Layers list, select the Flare In behavior.

The Behaviors Inspector opens, listing the specific text parameters used to create the 
animation (above the Add and Remove pop-up menus in the Parameter row).

4.	 In the Parameter row, click the Add pop-up menu, then choose Format > Rotation.

A Rotation parameter is added to the sequence (click the Format disclosure triangle to 
see the Rotation parameter).



768Motion User Guide

5.	 Move the playhead to the first frame of the text, then click the Record button in the 
timing toolbar (or press A) to turn on keyframe recording.

6.	 In the Behaviors Inspector, set the Rotation dial to 90.

7.	 Press the Space bar to play the project and see the result.

Because the Rotation parameter has only a single keyframe, the text remains static at 
90 degrees.

8.	 Move the playhead to the frame where you want the rotation animation to end, and then 
in the Behaviors Inspector, set Rotation to 0.

Now that you’ve set a second keyframe value, the sequence is animated. 

Note: You can edit the keyframes in the Keyframe Editor. See Intro to keyframing.

9.	 Return the playhead to frame 1 of the text and press the Space bar to play the project.

As the project plays, the text rotates from 90 degrees to 0 degrees.

You can change the color or other attributes of the text glow by using the Glow controls 
in the Appearance pane of the Text Inspector.
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Create custom text sequence behaviors

Apply the Sequence Text behavior in Motion
You can build custom text sequence animations using the Sequence Text behavior (in the 
Text Animation category of behaviors in the Library). The Sequence Text behavior (not 
to be confused with the Text Sequence category of preset behaviors in the Library) lets 
you animate text attributes—scale, position, color, opacity, glow, and so on—in sequence, 
character by character. For example, you can create a sequence in which text characters 
fall vertically into place as they scale down, fade in, and rotate.

Because the Sequence Text behavior is not a preset, applying and activating it is a two-
step process: 

•	 Step 1: Apply the Sequence Text behavior to a text layer in your project.

•	 Step 2: In the Behaviors Inspector, assign the parameters you want to animate, then 
adjust controls to set the animation’s direction, speed, number of loops, and other 
qualities. (Optionally, you can assign the Position, Rotation, and Scale parameters by 
dragging onscreen controls in the canvas. See Assign and activate Sequence Text 
parameters in the canvas below.)

 Tip: Using the Transform Glyph tool, you can modify individual text characters 
independently of the influence of the applied Sequence Text behavior. See Intro to text 
glyphs. 

Apply the Sequence Text behavior
•	 In Motion, select a text layer in your project, then click Behaviors in the toolbar and 

choose Text Animation > Sequence Text.

The behavior is applied, and the first character of text is selected with the Adjust Item 
tool.

Important: You must add at least one parameter to the behavior before animation can 
occur. For details, see the next task.
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Assign and activate Sequence Text parameters in the Inspector
After you apply the Sequence Text behavior to a text layer in your project (as described in 
the previous task), you must assign the parameters you want to animate.

1.	 In the Layers list or Timeline in Motion, select an applied Sequence Text behavior.

The Behaviors Inspector opens.

In the upper area of the Sequence Text controls are Add and Remove pop-up menus, 
used to select text parameters to be sequenced, or to remove parameters after they’re 
added. Under the pop-up menus are sequence controls, which include options for 
setting the direction and speed of the animation, whether the animation is applied per 
character, per word, per text object, and so on.

In this simple example, assign the Opacity, Scale, and Glow Scale parameters to the 
behavior.

2.	 In the Parameter row, click the Add pop-up menu, then choose Format > Opacity.

An Opacity slider is added in the Behaviors Inspector, in the Format area above the Add 
and Remove pop-up menus.
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3.	 Set the Opacity slider to 0. 

When you play the project (press the Space Bar), the opacity sequences from the value 
set in the behavior (0%) to the original value of the text (100%). You can change this 
sequencing order in the Sequencing pop-up menu.

4.	 Click the Sequencing pop-up menu, then choose To.

Now, when you play the project from the beginning, the opacity fades to the value set in 
the behavior (0%) from the original value of the text (100%).

5.	 Click the Add pop-up menu, then choose Format > Scale.

The Scale slider is added to the Behaviors Inspector.

6.	 Set the Scale slider to 250%, then set the Spread slider (in the Controls section of the 
Behaviors Inspector) to 4.

The scale and opacity sequences to the values defined in the behavior from the original 
values. The increased spread value softens the sequence between the characters.

The above example covers only a portion of the options in the Sequence Text behavior. 
Using the behavior’s parameters, you can create a nearly endless variety of sequences. 
You can define the speed in which the sequence moves through the text, as well as 
whether the sequence moves through the text per character, word, or line. You can also 
change the direction of the sequence and define the number of times the sequence loops 
over its duration. Variance and randomization can also be added to values defined in the 
behavior. For more information on these controls, see Sequence Text behavior controls.

Note: Although the style effects created in the Sequence Text behavior (Face, Outline, 
Glow, and Drop Shadow) are independent of parameters in the Appearance pane of the 
Text Inspector (Face, Outline, Glow, and Drop Shadow), changes made in the Appearance 
pane affect the sequenced text.
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Assign and activate Sequence Text parameters in the canvas
As an alternative to assigning parameters to the Sequence Text behavior in the Behaviors 
Inspector, you can assign three basic parameters (Position, Rotation, and Scale) by 
dragging onscreen controls in the canvas.

1.	 In Motion, with the Sequence Text behavior applied and the first character (glyph) 
selected (using the Adjust Item tool in the canvas toolbar), do any of the following:

•	 Sequence the position of the text: Drag the character in the canvas to a new 
position.

In the Behaviors Inspector, the Position parameter is added to the Format category 
(above the Add and Remove pop-up menus). The values in the Position parameter 
can be modified in the Behaviors Inspector (using the Position value sliders) as well 
as in the canvas (by dragging the glyphs of the text object).
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•	 Sequence the rotation of the text: Drag a rotation handle of a selected glyph in the 
canvas. To display the rotation handles, click in the canvas, then press and hold 
the Command key. For more information on using onscreen transform controls, see 
Transform layers in 3D space.

In this example, the text is rotated on its Y axis. In the Behaviors Inspector, the 
Rotation parameter is added to the Format category (above the Add and Remove 
pop-up menus). 

•	 Sequence the scale of the text: Drag a scale handle of a selected glyph in the 
canvas. (To scale the text uniformly, press Shift while dragging.)

In the Behaviors Inspector, the Scale parameter is added to the Format category 
(above the Add and Remove pop-up menus).
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2.	 Press the Space bar to play the project.

Note that in the Controls section of the Behaviors Inspector, the Sequencing pop-
up menu is set to From, the default setting. As a result, upon playback, the text in 
your project moves from the value in the Position parameter to the original value (the 
position of the text before you dragged it in the canvas).

For more information on Sequence Text parameters, see Sequence Text behavior 
controls.

Note: When using the Sequence Text behavior, glyphs are selected with the Adjust Item 
tool rather than the Transform Glyph tool. For more information on the Transform Glyph 
tool, see Intro to text glyphs.

When you select a glyph with the Adjust Item tool, a section of the Timeline is 
highlighted, indicating when the selected glyph is affected by the sequence behavior. 

Fine-tune a Sequence Text behavior in Motion
You can further customize an applied Sequence Text behavior by softening transitions 
between characters and words or removing parameters. You can also adjust the 
appearance of the text independently of the Sequence Text behavior.

Remove a parameter from the Sequence Text behavior
•	 In Motion, select an applied Sequence Text behavior in the Layers list or Timeline, then, 

in the Parameter row of the Behaviors Inspector, click the Remove pop-up menu and 
choose a parameter.

The chosen parameter is removed from the behavior.
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Create a softer transition between each text character
If the transition between two characters in a sequence animation is too abrupt, control the 
amount of falloff by adjusting the Spread value. 

•	 In Motion, after assigning parameters to a Sequence Text behavior, drag the Spread 
slider (in the Behaviors Inspector) to the right to soften the changes between the text 
characters.

Modify a parameter without adding it to the animated sequence
If you want to modify the face, outline, glow, or drop shadow of text, but don’t want that 
modification to be animated, make the adjustment in the Appearance pane of the Text 
Inspector. Parameters modified in the Appearance pane do not affect an applied Sequence 
Text behavior. For example, by adding an outline to text via the Appearance pane, the text 
outline remains constant during the sequence animation.

1.	 In Motion, select a text object has an applied Sequence Text behavior, then open the 
Appearance pane in the Text Inspector.

2.	 Select the Outline activation checkbox.

The Outline controls become available, and an outline is added to the selected text in 
the canvas.

3.	 In the Appearance pane, adjust the Outline controls.

When you play back the project, the text is animated according to settings in the 
Sequence Text behavior, but the text outline remains constant, and does not sequence.

Note: Because parameters set in the Sequence Text behavior are independent of 
parameters set in the Appearance pane, you may see changes in the appearance of some 
attributes when you select parameter checkboxes in the Appearance pane. For example, if 
you create a sequence that animates text glow and then select the Glow checkbox in the 
Appearance pane of the Text Inspector, the effect is additive: The glow in the Appearance 
pane is added to the glow created in the Sequence Text behavior.
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Add keyframes to a Sequence Text behavior in Motion
When From, To, Through, or Through Inverted are chosen from the Sequencing pop-up 
menu, the animation moves from one side of the text object to another, animating the text 
by character, word, or line. By choosing From Keyframes from the Sequencing pop-up 
menu, you can create a sequenced animation with specific timing. 

For example, you can create an uneven flicker effect by keyframing the opacity of the text, 
or move text characters in sequence to specific locations in the canvas at certain points in 
time by keyframing the position of the text.

Add keyframe animation to a Sequence Text behavior
This example keyframes the Position parameter.

1.	 In Motion, select a text layer in your project, then click Behaviors in the toolbar and 
choose Text Animation > Sequence Text.

2.	 In the Behaviors Inspector, click the Sequencing pop-up menu, then choose From 
Keyframes.

3.	 Drag the playhead to the frame where you want to begin the animation, then click the 
Record button in the timing toolbar (or press A) to turn on keyframe recording.

When keyframe recording is enabled, the values in the Inspector for parameters that 
can be animated turn red.

4.	 Do one of the following:

•	 In the Behaviors Inspector, click the Add pop-up menu, choose Format > Position, 
then use the Position value sliders to define the beginning (or ending) position of 
the text. You can also click the Add Keyframe button that appears when you position 
your pointer over the right side of the Position parameter row.

•	 In the canvas, drag the selected text character to its beginning (or ending) position.

A keyframe is added to the Position parameter.

5.	 Drag the playhead to the next frame where you want to set a position keyframe, then do 
one of the following:

•	 In the Behaviors Inspector, change the Position value.

•	 In the canvas, drag the selected text character to a new position.
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A second position keyframe is created.

6.	 Repeat Step 5 until you add all the keyframes needed.

When you play the project (press the Space bar), the text characters move in sequence 
along the path defined by the keyframes.

Note: If you subsequently change the Sequencing parameter to another option (such 
as Through Inverted or To) and then change Sequencing back to From Keyframes, the 
keyframed animation path is retained.

Sequence the distortion of 2D text in Motion
In addition to using the sliders and value sliders in the Inspector, you can use onscreen 
controls to sequence the Four Corner parameter, creating warp effects that manipulate the 
text Face (color fill), Outline, Glow, and Drop Shadow parameters of text. In the following 
simple example, the distortion of the text glow is sequenced.

Note: You cannot sequence the distortion of an appearance attribute for 3D text.

Sequence the warping of a text glow effect
1.	 In Motion, select a text layer in your project, then click Behaviors in the toolbar and 

choose Text Animation > Sequence Text.

2.	 In the Parameter row of the Behaviors Inspector, click the Add pop-up menu, then 
choose Glow > Four Corner.

In the Inspector, the Glow Four Corner parameter is added to the sequence above the 
Add and Remove pop-up menus. The Four Corner parameter is used to spatially distort 
the text’s glow effect.
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3.	 To activate onscreen handles, click the Attribute pop-up menu in the lower portion of 
the Behaviors Inspector, then choose Glow.

Onscreen handles appear.
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4.	 Do one of the following:

•	 To distort the glow, drag a distort handle (any of the corner handles).

Note: Some characters may not appear to be affected when you drag in the canvas. 
However, when you play the project, all characters are affected.

•	 To shear the glow, drag a shearing handle (any of the middle handles).

You can also drag the value sliders in the Four Corner parameter for Glow in the 
Behaviors Inspector. Click the Four Corner disclosure triangle to show the individual 
Bottom Left, Bottom Right, Top Right, and Top Left controls. 

5.	 Press the Space bar to play the project.

The glow distortion is sequenced through the text, based on the settings in the 
Sequence Text behavior parameters.
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Sequence Text behavior controls in Motion
The Sequence Text behavior has the following parameter controls in the Behaviors 
Inspector:

Parameter selection controls
•	 Parameter (Add and Remove): Two pop-up menus to add the text format and style 

parameters you want to animate in the sequence, or to remove them. After you use 
the Add pop-up menu to add a parameter to the sequence, that parameter’s controls 
appear above the Add and Remove pop-up menus. The Add pop-up menu items include:

•	 Format: Opens a submenu containing the following format parameters for 
sequencing: Position, Opacity, Scale, Rotation, Tracking, Baseline, Slant, and 
Character Offset. Except for Character Offset, these parameters are also found 
in the Format pane of the Text Inspector. (For more information on text format 
parameters, see Display the text Format pane.) 

Choose the Character Offset option to offset characters alphabetically or 
numerically. The amount of the offset is determined by the value set in the Character 
Offset slider. For example, if you begin with the text ABC, then set the Character 
Offset slider to 3, the text at the beginning of the sequence becomes DEF. In the 
following examples, Character Offset and Position are sequenced; the Character 
Offset slider is set to 3. The words move in sequence from the character offset value 
to form the original words, “offset 123.”

Choosing Character Offset also activates the Character Set pop-up menu, where you 
can choose Preserve Case & Digits to ensure that offset characters respect the case 
and number of the original text. For example, with this option selected, an uppercase 
letter remains uppercase as other letters cycle through its position.

•	 3D: Opens a submenu containing the following 3D text-specific format parameters 
for sequencing: Extrusion Depth, Front Edge Size, and Back Edge Size. These 
parameters are also found in the Appearance pane of the Text Inspector when the 
3D activation checkbox is selected. See 3D Text controls.

•	 Face: Opens a submenu (available for 2D text) containing the following face 
parameters for sequencing: Color, Opacity, Blur, and Four Corner. For more 
information on text face parameters, see Text Face controls.

•	 Outline: Opens a submenu (available for 2D text) containing the following outline 
parameters for sequencing: Color, Opacity, Blur, Width, Layer Order, and Four 
Corner. For more information on text outline parameters, see Text Outline controls.

•	 Glow: Opens a submenu containing the following glow parameters for sequencing: 
Color, Opacity, Blur, Radius, Scale, Offset, Layer Order, and Four Corner. For more 
information on text glow parameters, see Text Glow controls.

Note: The Glow parameter cannot be adjusted or sequenced with 3D text.
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•	 Drop Shadow: Opens a submenu containing the following drop shadow parameters 
for sequencing: Color, Opacity, Blur, Scale, Distance, Angle, and Four Corner. For 
more information on text drop shadow parameters, see Text Drop Shadow controls.

Note: The Drop Shadow parameter cannot be adjusted or sequenced with 3D text.

•	 [3D text material] (name varies depending on applied material): Opens a submenu 
containing the materials and material layers applied to the 3D text object for 
sequencing. For more information on 3D text materials, see Intro to 3D text surface 
materials.

Sequencing controls
Adjust these controls to set how the sequencing occurs. Specify the direction, scope, and 
speed of the sequencing action, and what happens when the sequencing action reaches 
the end of your text object.

•	 Sequencing: A pop-up menu to set how the sequence animation moves through the text 
unit. (A text unit can be a character, word, line, or an entire text object, as set in the 
Animate pop-up menu, described below.) There are five items in the Sequencing pop-up 
menu:

•	 To: Animation begins at the original parameter value and moves to the value set in 
the sequence behavior. For example, if the original opacity value is 100% and opacity 
is set to 0% in the Sequence Text parameters, the text unit begins completely 
opaque and becomes completely transparent.

•	 From: Animation moves from the value set in the sequence behavior to the original 
parameter value. For example, if the original opacity value is 100% and opacity is set 
to 0% in the Sequence Text parameters, the text unit begins completely transparent 
and becomes completely opaque. This is the opposite of the To option in the 
Sequencing pop-up menu.

•	 Through: The sequence goes through a full animation cycle starting at the original 
value of the parameter, moving to the value set in the sequence behavior, then 
returning to the original value of the parameter. For example, if the original opacity 
value is 100%, and opacity is set to 0% in the Sequence Text parameters, the text 
unit begins completely opaque, becomes transparent, and then becomes completely 
opaque again.

•	 Through Inverted: The sequence goes through an inverted animation cycle starting 
from the value set in the sequence behavior, moving to the original value, then 
returning to the value set in the sequence behavior. For example, if the original 
opacity value is 100% and opacity is set to 0% in the Sequence Text parameters, 
the text unit begins completely transparent, becomes opaque, and then becomes 
completely transparent. This is the opposite of the Through Sequencing option.

•	 From Keyframes: Lets you keyframe how the animation moves through the values 
set in the Sequence Text parameters. When From Keyframes is selected from the 
Sequencing pop-up menu, the Minimum and Maximum parameters in the Variance 
controls (see description below) are replaced with the Amount parameter, and the 
Fix pop-up menu appears. See Add keyframes to a Sequence Text behavior.
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•	 Animate: A pop-up menu to specify how animation is sequenced. There are six options:

•	 Character: Sequences the animation by single characters of text (including spaces).

•	 Character (without spaces): Like the Character setting, sequences single characters 
of text, but does not treat spaces as characters (spaces are ignored).

•	 Word: Sequences the animation by word.

•	 Line: Sequences the animation by lines of text.

•	 All: Sequences the animation through the entire text object.

•	 Custom: Lets you customize the size of the sequenced text unit. 

•	 Start: A slider (available when Animate is set to Custom) to define the starting point of 
the selection to be sequenced.

•	 End: A slider (available when Animate is set to Custom) to define the ending point of the 
selection to be sequenced.

•	 Select: Controls to set the range of characters affected by the animation defined in the 
Animate pop-up menu. Click the disclosure triangle to reveal the controls:

•	 Range: A pop-up menu (used in combination with the Start Index and End Index 
parameters, described below) to specify the range of text sequenced by All (the 
default setting), Character, Character in Word, Character in Line, Word, Word in Line, 
or Line.

•	 Start Index: A slider to set the beginning of the range for the sequence animation.

In a simple example, if Animate is set to Character for a multiline text object, the 
sequence moves through the characters one at a time, line by line. If the Range 
parameter is then set to Character in Line and Start Index set to 1, the first character 
of each line is not animated, but the remaining characters are animated (as long as 
the End Index parameter is set to the number of characters in the longest line of 
text).

•	 End Index: A slider to set the end of the range for the sequence animation.

•	 Invert: A checkbox that, when selected, transposes the animation. In a simple 
example, the first character of each word in a line of text fades in. When Invert 
is selected, the first character of each word is fully visible, and the rest of the 
characters fade in.

•	 Reverse: A checkbox that, when selected, reverses the animation. In a simple 
example, the first character of each word in a line of text fades in. When Reverse is 
selected, the last character of each word fades in.

•	 Spread: A slider to control the amount of falloff at the beginning and end of the 
sequencing. To create a softer transition between each text unit, increase the Spread 
value. See Fine-tune a Sequence Text behavior.

•	 Direction: A pop-up menu to set the direction of the sequencing. There are five options:

•	 Forwards: Sequences in the direction of the letters (typically left to right).

•	 Backwards: Sequences in the reverse direction (typically right to left).

•	 Center to Ends: Sequences from the center of the text outwards.

•	 Ends to Center: Sequences from the outer edges of the text inwards.

•	 Random: Randomizes the direction of the sequencing. 
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•	 Random Seed: Controls (available when Direction is set to Random) to change the 
current “randomness” (seed number) of the direction of the sequence. Type a new 
number in the text field or click the button to the right of the seed value.

•	 Speed: A pop-up menu to set whether the rate of the sequence remains constant or 
changes. There are seven options:

•	 Constant: The sequence animation moves from one end of the text to the other at a 
constant rate. The sequence moves in the direction specified in the Direction pop-up 
menu.

•	 Ease In: The sequence animation begins slowly and increases to normal speed as it 
moves through the text.

•	 Ease Out: The sequence animation begins at normal speed and slows toward the end 
of the text.

•	 Ease Both: The sequence animation begins slowly, increases to normal speed as it 
moves toward the middle of the duration of the text, then slows as it reaches the end 
of the text.

•	 Accelerate: The rate of the sequence animation increases as it moves through the 
text.

•	 Decelerate: The rate of the sequence animation decreases as it moves though the 
text.

•	 Custom: Lets you keyframe how the selection (the animation) moves through the 
text. 

•	 Custom Speed: A slider (available when Speed is set to Custom) to keyframe the 
completion of the sequencing by defining the location of the text where the animation is 
in effect.

•	 Loops: A slider to set the number of times the animation sequences through the text 
over its duration.

•	 Apply Speed: A pop-up menu to control the speed of the sequencing over multiple 
loops. There are three options:

•	 Once Per Loop: The setting chosen in the Speed pop-up menu is applied one time 
for each loop. For example, if Speed is set to Accelerate, the rate of the sequence 
animation increases as it moves through the text for every loop.

•	 Over Entire Duration: The setting chosen in the Speed pop-up menu is applied one 
time for the length of the behavior. For example, if Speed is set to Accelerate, the 
rate of the sequence animation increases as it moves through the text over the entire 
duration of the behavior, regardless of the number of loops.

•	 Per Object: The setting chosen in the Speed pop-up menu is applied one time for 
each object for every loop. For example, if Speed is set to Accelerate, the rate of the 
sequence animation increases as it moves through each text object for every loop.

•	 Start Offset: A slider to offset the start of the effect of the sequence behavior. By 
default, the sequence animation is in effect from the beginning of the behavior. For 
example, to start the sequencing 60 frames in from the start of the text object (or 
project), drag the Start Offset slider to 60 or enter 60 in the adjacent value slider. 
Using this slider to start the effect, rather than trimming the start of the behavior in the 
Timeline, freezes the start of the effect (in this example) until frame 61. Trimming the 
start of the behavior resets the text to its original settings.
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•	 End Condition: A pop-up menu to specify how the animation is applied to the end of the 
sequence animation. There are three options:

•	 Hold: Completes the sequence animation cycle one time, then starts it over from the 
beginning (after the last text unit in the sequence completes its animation).

•	 Wrap: Treats the sequence animation as a continuous loop so the spread wraps from 
the last text unit in the sequence to the first text unit.

•	 Ping-Pong: Completes the sequence animation cycle forward, then completes the 
animation backward, then forward, and so on.

•	 End Offset: A slider to offset the end of the effect of the sequence behavior. By default, 
the sequence animation is in effect until the end of the behavior. For example, to stop 
the sequencing 60 frames from the end of the text object (or project), drag the End 
Offset slider to 60 or enter 60 in the adjacent value slider. Using this slider to stop the 
effect, rather than trimming the end of the behavior in the Timeline, freezes the end of 
the effect for the remaining duration of the object. Trimming the end of the behavior 
resets the text to its original settings.

Variance controls
Adjust these controls to randomize the attributes assigned to sequence through the text. 
For example, if you add variance to a scale sequence, the text scale is randomized rather 
than moving from the original Scale value to the Scale value defined in the sequence 
behavior. These sliders control the frequency of the randomness. When sequencing is set 
to To, From, Through, or Through Inverted, it’s useful to see how the Variance numbers 
affect the randomness. The following image shows a sequence animation in which the Y 
Position is offset. When a low variance value (frequency) is applied, the randomness is very 
smooth along the line of text—like the text is riding a very slow and smooth wave.

As the variance is increased, the randomness increases across the line of text. Because 
the text is riding on very short and frequent waves, the letters are offset in the Y axis with 
more randomness.
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When From Keyframes is chosen from the Sequencing pop-up menu, the same principle 
applies, so a low variance value causes the text to offset from its animation with a smooth 
path, while a high variance causes more randomness. 

Note: Because the Variance parameters are sensitive, low values are necessary for smooth 
animation results.

•	 Variance: A slider to fluctuate the values of the attributes assigned to sequence through 
the text. For example, if you add variance to an opacity sequence, the text opacity is 
randomized rather than moving strictly from the original Scale value to the Scale value 
defined in the sequence behavior.

•	 Minimum: A slider to define the lower boundary of the variance for the sequenced 
parameter value. For example, if you set Minimum to 25% for a sequence animating text 
scale, the minimum size that the text unit will scale to is 25% of the Scale value set in 
the behavior.

•	 Maximum: A slider to define the upper boundary of the variance for the sequenced 
parameter value. For example, if you set Maximum to 75% for a sequence animating text 
scale, the maximum size that the text unit scales to is 75% of the Scale value set in the 
behavior.

•	 Amount: A slider (available when From Keyframes is chosen from the Sequencing pop-
up menu) to define the maximum amount that the animated parameter can deviate from 
its animation value. For example, the following image shows a custom animation of a 
glyph in the positive Y direction. When Amount is set to 50, the glyph deviates no more 
than 50 pixels to the left or right of the animation path. The bold red line shows the 
animation path, and the thinner red line displays the randomized path.

•	 Noisiness: A slider to add an additional overlay of random variance. Higher Noisiness 
values result in more erratic variations in the affected parameter.

•	 Seed: Click the button to the right of the 0 to create an initial seed for creating 
randomness in the Variance parameters. To change the randomness results after you 
click the button, click the button again or enter a value in the field.
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•	 Fix: A pop-up menu (available when Sequencing is set to From Keyframes) to fix the 
values defined in the behavior to the start, end, or start and end of the behavior. 
There’s also an option to not fix the values. Variance must be greater than 0 for this 
parameter to have any effect. There are four menu options:

•	 Start Point: When variance is applied, the values defined in the Sequence Text 
behavior (above the Add and Remove pop-up menus in the Behaviors Inspector) at 
the start and end of the behavior are fixed to the first frame of the behavior. In the 
following images, the text position is sequenced. Fix is set to Start Point.

•	 End Point: When variance is applied, the values defined in the Sequence Text 
behavior (above the Add and Remove pop-up menus) at the start and end of the 
behavior are fixed to the last frame of the behavior. In the following images, the text 
position is sequenced. Fix is set to End Point.

•	 Both: When variance is applied, the values defined in the Sequence Text behavior 
(above the Add and Remove pop-up menus) at the start and end of the behavior are 
fixed to the first and last frames of the behavior.

•	 Neither: When variance is applied, the values defined in the Sequence Text behavior 
(above the Add and Remove pop-up menus) at the start and end of the behavior are 
not fixed to the first or last frames of the behavior. In the following images, the text 
position is sequenced. Fix is set to Neither.
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•	 Attribute: A pop-up menu to sequence the warping of attributes. There are five options:

•	 Transform Glyph: Displays the glyph onscreen controls, allowing for the selection 
of characters of a text object for direct manipulation. For more information about 
sequencing using the glyph onscreen tools, see Add keyframes to a Sequence Text 
behavior.

•	 Face: Displays onscreen controls that allow you to modify the shape, size, and 
position of the face (color fill) of text characters.

•	 Outline: Displays onscreen controls that allow you to modify the shape, size, and 
position of the outline of text characters.

•	 Glow: Displays onscreen controls that allow you to modify the shape, size, and 
position of the glow of text characters.

•	 Drop Shadow: Displays onscreen controls that allow you to modify the shape, size, 
and position of the drop shadow of text characters. 

For more information about sequencing the warping of text attributes, see Sequence 
the distortion of 2D text.

•	 Position Type: A pop-up menu to specify whether an attribute is offset from the text 
uniformly or based on the size of text characters. There are two options:

•	 Absolute: When offsetting attributes, such as glows, shadows, and so on from text 
objects, choose Absolute to create an even offset regardless of the size of the text 
characters. In the following image, the yellow glow is uniformly offset from the white 
text because Absolute is chosen from the Position Type pop-up menu.

•	 Relative: When offsetting attributes, such as glows, shadows, and so on from text 
objects, choose Relative to create an offset based on the size of the text characters. 
In the following image, the yellow glow is offset from the white text based on the 
size of the text characters because Relative is chosen from the Position Type pop-up 
menu.
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Create scrolling text

Use the Scroll Text behavior in Motion
The Scroll Text behavior (in the Text Animation category of behaviors in the Library) 
creates scrolling or crawling text, and is often used to create end credits in film and 
television production. However, Scroll Text is flexible and can be applied to other objects in 
a Motion project—shapes and images, for example.

You can apply the Scroll Text behavior to any kind of text in your project, including text 
imported from RTF or TXT files. When you apply the Scroll Text behavior, text scrolls 
vertically in the canvas by default. However, you can set the Scroll Text behavior to scroll 
horizontally (a text crawl), as well.

Create a vertical scroll
1.	 In Motion, apply the Scroll Text behavior (from the Text Animation behavior category) to 

the text layer (or any object) you want to animate.

See Apply a text behavior.

Because vertical scrolling is the default option, the text shifts to below the canvas for 
the beginning of the scroll. You can change the direction, position, and speed of the 
scroll in the Behaviors Inspector or HUD.

2.	 In the timing toolbar, click the Play button (or press the Space bar).

The text scrolls upward in the canvas.

3.	 To edit the text, double-click the text in the canvas.

The text stops scrolling, the ruler appears at the top edge of the text, and the scroll 
control becomes available at the right edge of the text. To continue playback, deselect 
the text by pressing Esc or by clicking in an empty area of the Layers list or the Timeline 
layers list. For more information on scroll controls, see Text Layout controls.

4.	 To customize the scroll, adjust the parameters in the Behaviors Inspector.

For more information on Scroll Text behavior parameters, see Scroll Text controls.

Create a horizontal scroll
1.	 In Motion, apply the Scroll Text behavior (from the Text Animation behavior category) to 

the text (or any object) you want to animate.

See Apply a text behavior.

2.	 In the Scroll Text HUD or Behaviors Inspector, click the Scroll Direction pop-up menu, 
then choose Horizontal.

The text shifts off the canvas to the right for the beginning of the crawl, and is 
positioned in a single line, as the Layout Method parameter in the Layout pane of the 
Text Inspector switches to Crawl.

Note: When the Scroll Text behavior is applied to text, the Layout Method parameter is 
dimmed, indicating that you cannot manually change the layout method in the Layout 
pane. However, you can override this limitation by selecting the Allow Layout Override 
checkbox in the Behaviors Inspector. See Scroll Text controls.
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3.	 Click the Play button.

The text crawls leftward in the canvas.

4.	 To edit the text, double-click the text in the canvas.

The text stops scrolling, and the scroll control becomes available at the lower edge of 
the text. To continue playback, deselect the text by pressing Esc or clicking in an empty 
area of the Layers list or Timeline layers list. For more information on scroll controls, see 
Text Layout controls.

5.	 To customize the scroll, adjust the parameters in the Behaviors Inspector.

For more information on Scroll Text behavior parameters, see Scroll Text controls.

Change the speed of the scroll in the Timeline
In the Timeline in Motion, do one of the following:

•	 Trim the behavior by dragging the end of the its bar to the left to speed up the scroll.

•	 Trim the behavior by dragging the end of its bar to the right to slow down the scroll.

For more information about adjusting behaviors in the Timeline, see Intro to behavior 
timing.

Scroll Text controls in Motion
Use the parameter controls in the Behaviors Inspector to adjust the direction, rate, and 
position of the scroll:

•	 Scroll Direction: A pop-up menu to set the direction of the text scroll to Vertical or 
Horizontal.

•	 Speed Control: A pop-up menu to set the speed of the scroll or crawl. There are three 
options:

•	 Automatic: The speed of the scroll is determined by the length of the behavior in 
the Timeline. In other words, the length of the behavior determines how long it takes 
the object to scroll or crawl across the canvas. By default, the duration of an applied 
Scroll Text behavior is the same as the object or group to which it is applied.

•	 Fixed: The speed of the scroll is based on the value in the Scroll Rate parameter 
(described below).

•	 Custom: Specifies the start and end positions (defined as offsets from the current 
position) of the scrolling object.

•	 Scroll Rate Mult: A slider (available when Speed Control is set to Automatic) to multiply 
the rate of the scroll. Amounts higher than those available in the slider can be entered 
in the value slider (the number field to the right of the slider).
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•	 Scroll Rate: A slider (available when Speed Control is set to Fixed) to set the speed of 
the scroll in pixels per second.

•	 Reduce Flicker: A pop-up menu to modify the speed of the scroll to reduce flickering on 
interlaced or progressive displays. The menu options vary, depending other parameter 
settings:

•	 None: Available when Scroll Direction is set to Vertical, this option has no effect on 
the speed of the scroll.

•	 Progressive: Available when Scroll Direction is set to Vertical, this option prevents 
flicker on a progressive display (such as an LCD television). The Progressive 
setting is not guaranteed to prevent flicker on an interlaced display (such as a CRT 
television).

•	 Interlaced: Available when Scroll Direction is set to Vertical, this option prevents 
flicker on a progressive display (such as an LCD television) or on an interlaced 
display (such as a CRT television).

Note: Because the minimum speed to prevent flicker on an interlaced display is 2 
pixels per frame, and the minimum speed to prevent flicker on a progressive display 
is 1 pixel per frame, the Interlaced option may result in faster scroll rates.

•	 No: Available when Scroll Direction is set to Horizontal, this option does not modify 
the scroll speed to reduce flickering on interlaced or progressive displays.

•	 Yes: Available when Scroll Direction is set to Horizontal, this option modifies the 
speed of the scroll to reduce flickering on interlaced or progressive displays.

•	 Allow Layout Override: A checkbox that, when selected, permits manual changes to the 
layout method (set in the Layout Method pop-up menu in the Layout pane of the Text 
Inspector). For example, when you apply the Scroll Text behavior to RTF text and set 
Scroll Direction to Horizontal, the text is placed in a single line. If you select the Allow 
Layout Override checkbox, the text retains its paragraph format.

Note: This parameter is available only when the Scroll Text behavior is applied to a text 
object.

•	 Start Off-Screen: A checkbox that, when selected, moves the text to an off-canvas 
position for the start of the scroll. 
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Create animated text tracking

Use the Text Tracking behavior in Motion
The Text Tracking behavior applies a rate of change to the Tracking parameter of the 
Format pane (in the Text Inspector). Tracking applies a uniform space between each 
character of text, resulting in an expansion effect, with text characters expanding apart.

Use the Text Tracking behavior
•	 In Motion, apply the Text Tracking behavior (from the Text Animation behavior category) 

to text in your project.

See Apply a text behavior.

When you play the project, characters spread out based on the rate set in the Rate 
parameter in the Behaviors Inspector or HUD.

Note: Like the Tracking parameter in the Format pane of the Text Inspector, the Text 
Tracking behavior respects the Alignment setting of the text. For example, to track from 
the center of the text outward, the Alignment of the text must be set to Center. This 
parameter is located in the Text HUD or the Layout pane of the Text Inspector.

Use Text Tracking controls to modify the rate and end offset of character tracking. The 
identical Text Tracking behavior parameters appear in the Text Tracking HUD and in the 
Behaviors Inspector. See Text Tracking controls.
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Text Tracking controls in Motion
Use the Text Tracking parameter controls in the Behaviors Inspector or HUD to control the 
rate and end offset of the tracking animation:

•	 Rate: A slider to control the rate of the change in tracking values. The higher the rate, 
the greater the tracking values.

•	 End Offset: A slider to offset the end of the effect of the Tracking parameter. By default, 
text characters track to the end of the duration of text. For example, to stop tracking 
animation 60 frames from the end of the text object (or project), drag the End Offset 
slider to 60 or enter 60 in the value slider.

Note: Use the End Offset parameter to stop the effect of the tracking behavior before 
the end of the text object (or project) rather than changing the duration of the Tracking 
behavior in the mini-Timeline or Timeline. If you trim the end of the behavior, the text 
snaps back to its default tracking value at the end of the behavior.

Create a “type-on” effect

Use the Type On behavior in Motion
The Type On behavior creates a typewriter effect, with text appearing character by 
character.

Apply the Type On behavior
•	 In Motion, apply the Type On behavior (from the Text Animation behavior category) to 

text in your project.

See Apply a text behavior.

When you play the project, the text pops on character by character. To create a softer 
fade-in effect, select the Fade In checkbox in the Behaviors Inspector or HUD.

The Type On behavior is applied over the duration of the text object. 
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Increase the speed of the type on effect
1.	 In the Layers list or Timeline in Motion, select an applied Type On behavior.

The Type On behavior bar is selected in the mini-Timeline and Timeline.

2.	 Do one of the following:

•	 In the Timeline or mini-Timeline, trim Type On behavior by dragging the right end 
of its bar toward the left, to the frame where you want the animation to end. As you 
drag, a tooltip displays the duration and delta (amount of change) of the behavior.

•	 Drag the playhead to the frame where you want to set the new Out point, then 
choose Mark > Mark Out (or press O).

By the time the playhead reaches the end of the new behavior duration bar, the 
type-on effect is complete.

Note: You can also slow the type-on effect by extending the behavior bar in the 
Timeline beyond the duration of the text object.

Create a softer type-on text
1.	 In the Layers list or Timeline in Motion, select an applied Type On behavior.

2.	 In the Behaviors Inspector or HUD, select the Fade In checkbox.

Type On controls in Motion
The Type On behavior in the Behaviors Inspector or HUD contains a single control:

•	 Fade In: Select this checkbox to make each text character fade in rather than appearing 
with the default pop-in effect.

Note: You can also create this type of animation using the Type On parameter group in 
the Layout pane of the Text Inspector. See Text Layout controls.
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Animate individual text glyphs in Motion
The Transform Glyph tool lets you animate text characters independently of their text 
objects.

Animate text characters with the Transform Glyph tool
1.	 In Motion, select the text object that contains the glyphs to modify.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Transform Glyph.

Selecting the Transform Glyph tool activates glyph transform handles in the canvas and 
adds additional controls to the Text HUD. 

3.	 In the Text HUD, ensure that the Attribute pop-up menu is set to Transform Glyph.

The Transform Glyph option in the Attribute pop-up menu lets you modify and animate 
the position, rotation, and scale of text characters by dragging in the canvas. You can 
choose other options from the Attribute pop-up menu to activate transform handles that 
spatially distort the Face, Outline, Glow, and Drop Shadow attributes of text characters.

4.	 Move the playhead to the frame where you want the animation to begin, then click the 
Record button in the timing toolbar (or press A) to enable keyframe recording.
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5.	 In the canvas, select and drag glyphs to their starting position in the animation 
sequence.

6.	 Move the playhead to the frame where you want the animation to end, then drag the 
glyphs in the canvas to their ending positions.

An editable animation path is created for the keyframed glyphs. You can add and 
remove control points and change the shape of the path in the canvas. For more 
information on working with animation paths, see Modify animation paths.

7.	 Move the playhead back to the start frame and press the Space bar to play the project.

The glyphs animate from their starting positions to their ending positions.

Note: The other options in the Attribute pop-up menu—Face, Outline, Glow, and Drop 
Shadow—can be animated in the same manner as the Transform Glyph option.
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Animating 2D text in 3D space in Motion
Although 2D text has no inherent 3D parameters, you can move and rotate a 2D text layer 
in 3D space. Simulation behaviors can also influence text characters to move out of their X 
and Y planes into Z space (depth). Additionally, text on a Spline path can be manipulated in 
3D space.

When the Face Camera checkbox is selected (in the Layout pane of the Text Inspector), the 
text characters actively face the camera if the camera or text is rotated.

 Tip: When working with 2D or 3D text in a 3D project, especially text that moves close 
to the camera, set the Render Quality in the View pop-up menu or the View pull-down 
menu to Best before exporting (choose View > Render Quality > Best). Use Normal when 
working in your project, because Best mode dramatically slows your project’s interactivity. 
You can also set the Render Quality on export using the pop-up menus in the Render pane 
of the Export window.

For more information about 3D effects in Motion, see Intro to 3D compositing. For more 
information about using true (extruded) 3D text, see Intro to 3D text.

Make text interact with other objects using a Simulation behavior
When text is a member of a 3D group, certain behaviors can be applied to pull text 
characters out of their X and Y planes.

1.	 In a Motion project that contains text and at least one other object (such as a shape), 
select the nontext object.

2.	 In the Properties pane of the Inspector, adjust the Z position of the object so that the 
object and text are offset in Z space. 

3.	 Apply the Orbit Around behavior (from the Simulation behavior category) to the text in 
your project.

4.	 Drag the object that is offset in Z space from the Layers list to the Object well in the 
Behaviors Inspector.

By default, the text orbits around the object (as a single object) in X and Y space.

5.	 In the Behaviors Inspector, select Affect Subobjects, then click Z.

When you play the project, the text characters circle about the target object in X, Y, and 
Z space.

For more information about 3D, see Intro to 3D compositing.
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When to use keyframes to animate text in Motion
As an alternative to animating with behaviors, you can animate most text parameters using 
keyframes. The text animation method you use (keyframing or behaviors) depends on your 
project, or more specifically, your timing needs: 

•	 Use keyframes if you need an action to happen at a specific point in time in your 
project. For example, if you want text to be completely transparent at frame 1, become 
completely opaque at frame 60, become transparent again at frame 90, and opaque 
again at frame 120, use keyframing. Keyframes apply specific values to an object’s 
parameters at specific frames.

•	 Use behaviors if the timing of the animation doesn’t need to be precise. For example, if 
you want the text to be completely transparent at frame 1, become opaque over frames 
60–90, and become transparent by frame 120, use the Fade In/Fade Out behavior. 
Behaviors generate a range of values that are applied to an object’s parameters.

You can combine keyframing and behaviors to animate any object in Motion. For example, 
if you keyframe text opacity, you can then apply the Tracking behavior to animate text 
tracking, or you can keyframe the Tracking parameter. However, if you keyframe the text 
Opacity parameter and then apply a Fade In/Fade Out behavior to the text, unexpected 
results may occur. See Combining behaviors with keyframes.

Adding nontext behaviors to text in Motion
Even though text behaviors are typically the most convenient way to animate text, you can 
apply any other behavior to your text. 

Nontext behaviors applied to text can affect the whole text object or its individual text 
characters, depending on the settings you choose. For example, when you apply the Spin 
behavior to a text phrase on a circular path, the entire phrase rotates around its anchor 
point. To rotate individual text characters, select the Affect Subobjects checkbox in the 
Behaviors Inspector. 
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Save a modified text behavior in Motion
As with all modified behaviors, filters, generators, and so on, you can save a modified text 
behavior to the Library.

Save a modified behavior to the Library in Motion
1.	 If necessary for organizational purposes, rename an applied text behavior by double-

clicking its name in the Layers list, typing a new name, then pressing Return.

2.	 In the Library, select the Behaviors subcategory where you want to store the behavior, 
such as the Text Sequence subcategory or Favorites category.

The Library stack displays behaviors already in the selected subcategory.

3.	 From the Layers list or Timeline, drag the behavior into the Library stack, releasing the 
mouse button when the green add pointer (+) appears over the stack window.

The behavior is saved to the Library in the behaviors subcategory you selected. A 
custom behavior is represented by a user icon in the lower-right corner of the behavior 
icon.

See Save custom objects to the Library and Manage Library folders and files.
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Draw shapes, masks, and paint strokes

Intro to shapes, masks, and paint strokes in Motion
Shapes, masks, and paint strokes are vector-based layers that you create in Motion.

Shapes
Shapes are primarily used to create visual elements in a composition. You can use a single 
shape as a background or color graphic in a composition, or you can create elaborate 
illustrations that combine many shapes. Shapes work like any other layer. But unlike an 
image or video clip that you import as a layer, a shape layer is created in Motion, either 
by adding a premade shape from the Library or by drawing a custom shape in the canvas. 
There are two categories of custom shapes: simple shapes drawn as a rectangle or ellipse, 
and complex shapes drawn point by point as a Bezier or B-Spline shape. Each control point 
in a complex shape defines some sort of corner or curve, and the actual spline that makes 
up the shape connects these control points together like a connect-the-dots drawing.

To begin using shapes, see Intro to simple shapes and masks and Intro to complex shapes 
and masks.
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Masks
Masks are a special type of shape used to create regions of transparency in layers. 
Although shapes work as layers by themselves, masks must be assigned to an image 
layer to have an effect. For example, if you have a picture in which you want to isolate the 
foreground subject, you can create a mask to cut out the background. As with shapes, 
there are two categories of masks: simple masks drawn as a rectangle or ellipse, and 
complex masks drawn point by point in the canvas as Bezier or B-Spline shapes.

To begin using masks, see Intro to simple shapes and masks and Intro to complex shapes 
and masks. For more information about mask transparency, see Intro to masks and 
transparency.

Paint strokes
Like shapes, paint strokes are used to create visual elements in a composition. Paint 
strokes are drawn in the canvas in a single, continuous movement, or are created from 
existing shapes. You can use a stylus and graphics tablet to draw paint strokes in a fluid 
fashion, or you can use a mouse or trackpad.

To begin using paint strokes, see Intro to paint strokes.

As with all objects in Motion, shapes, masks, and paint strokes can be edited or animated 
by keyframing their parameters or by applying behaviors. Additionally, the Shape Behaviors 
category contains behaviors designed specifically to animate shapes, including a behavior 
to sequence effects over the length of a paint stroke. For more information on using the 
Shape behaviors, see Intro to Shape behaviors.
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Add simple shapes and masks

Intro to simple shapes and masks in Motion
Use simple shapes and masks to quickly add a rectangular or elliptical form to your project. 
Simple shapes and masks are easily manipulated in the canvas using onscreen controls 
that modify height, width, curvature, or roundness. Simple shapes and masks have no 
editable control points or individual splines.

You can add a simple shape or mask to a project in the following ways:

•	 Use the Rectangle tool or Circle tool to draw a simple rectangular shape or elliptical 
shape in the canvas.

•	 Use the Rectangle Mask tool or Circle Mask tool to draw a simple rectangular mask or 
elliptical mask in the canvas.

You can convert simple shapes or masks to complex shapes or masks with editable control 
points using the Convert to Points command.

Draw simple shapes in Motion
Use the Rectangle tool or the Circle tool to create simple shapes in the canvas. Use the 
Line tool to draw straight lines in the canvas.

Draw a rectangle shape
1.	 In Motion, click the Rectangle tool in the canvas toolbar (or press R).

The Rectangle Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the 
color, outline, and roundness of the rectangle before you draw the shape, use the 
controls in the HUD.

Note: You can also edit the rectangle color, outline, and roundness after the shape is 
drawn.

2.	 Drag in the canvas until the resulting rectangle is the size you want, then release the 
mouse button.

To draw a perfect square, press and hold the Shift key while you drag. To draw the 
rectangle from its center, press and hold the Option key while you drag.

3.	 After you create the shape, press Esc to exit shape-drawing mode and activate the 
Select/Transform tool.

The Shape HUD appears. (If the HUD is not displayed, press F7.)
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Adjust the size, roundness, feather, or rotation of a rectangle shape
1.	 In Motion, do one of the following:

•	 In the canvas, double-click the rectangle shape.

•	 In the canvas, Layers list, or Timeline, select the rectangle shape, then click and hold 
the transform tools in the canvas toolbar and choose Edit Rectangle.

Simple shape transform handles appear in the canvas.

2.	 In the canvas, do any of the following:
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•	 Adjust corner roundness: Drag the roundness handle in the upper-left corner of the 
shape.

•	 Adjust size: Drag a size handle (on the side of the shape). To scale the shape 
uniformly, drag the inner edge of the shape or Shift-drag a size handle.

The inner and outer edges overlap by default; you must drag the outer (feather) 
edge prior to dragging the inner (scale) edge.

•	 Adjust softness: Drag the shape’s outer edge away from the rectangle to feather 
outward, or toward the center of the circle to feather inward.

•	 Adjust rotation: Drag the rotation handle.

•	 Adjust position: Drag anywhere within the shape.

Draw a circle or ellipse shape
1.	 In the canvas toolbar in Motion, click and hold the shape tools pop-up menu, then 

choose Circle (or press C).

The Circle Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the color 
and outline of the circle before you draw the shape, use the controls in the HUD.

Note: You can also edit the circle color and outline after you draw the shape.

2.	 Drag in the canvas until the resulting ellipse is the size you want, then release the 
mouse button.

To draw a perfectly symmetrical circle, press and hold the Shift key while you drag. To 
draw the ellipse from its center, press and hold the Option key while you drag.

3.	 After you create the shape, press Esc to activate the Select/Transform tool.

The Shape HUD appears. (If the HUD isn’t displayed, press F7.)
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Adjust the size, curvature, or feather of a circle shape
1.	 In Motion, do one of the following:

•	 In the canvas, double-click the ellipse shape.

•	 In the Layers list, canvas, or Timeline, select the ellipse shape, then click and hold 
the transform tools pop-up menu in the canvas toolbar and choose Edit Ellipse.

Simple shape transform handles appear in the canvas.

2.	 In the canvas, do any of the following:
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•	 Adjust curvature: Drag the curvature handle in the upper-left corner of the shape to 
add angular corners.

•	 Adjust size: Drag a radius handle (on the edge of the shape). To scale the shape 
uniformly, drag the inner edge of the shape or Shift-drag a radius handle.

The inner and outer edges overlap by default; you must drag the outer (feather) 
edge prior to dragging the inner (scale) edge.

•	 Adjust softness: Drag the shape’s outer edge away from the shape to feather 
outward, or toward the center of the shape to feather inward.

•	 Adjust rotation: Drag the rotation handle.

•	 Adjust position: Drag anywhere within the shape.

Draw a line
1.	 In the canvas toolbar in Motion, click and hold the shape tools pop-up menu, then 

choose Line.

The Line Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the color 
and width of the line before you draw it, adjust the controls in the HUD.

Note: You can also edit the line color and width after you draw the line.

2.	 Drag in the canvas until the resulting line is the length you want, then release the mouse 
button.

Pressing and holding Shift key while dragging constrains the line to 45-degree angles.

3.	 After you create the shape, press Esc to activate the Select/Transform tool.

The Shape HUD appears. (If the HUD is not displayed, press F7.)

Change the style of the start or end of a line
You can customize the end points (end caps) of the line to add arrows, bevels, and more. 

1.	 In Motion, select a line shape in the canvas, Layers list, or Timeline.

2.	 In the Style pane of the Shape Inspector, click the Start Cap or End Cap pop-up menu, 
then choose None, Square, Round, Bevel, or Arrow. 

When you choose Arrow, additional length and width sliders become available that allow 
you to further customize the arrow cap.
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Add shapes from the Library in Motion
The Shapes category in the Library contains pre-drawn shapes that you can add to a 
project. After you add a shape from the Library, you can edit the shape.

Add a shape from the Library
1.	 In the Library in Motion, select the Shapes category.

2.	 Do one of the following:

•	 Select a shape in the Library stack, then click Apply in the preview area.

•	 Drag a shape from the Library stack into the canvas, Layers list, or Timeline.

The shape is added to the project and can be modified. For information on editing 
shapes, see Edit fill, outline, and feathering.

Draw simple masks in Motion
The Rectangle Mask and Circle Mask tools create simple masks, which create regions of 
transparency in layers.

Create a rectangle mask
1.	 In the canvas, Layers list or Timeline in Motion, select the image layer you want to mask, 

then click the Rectangle Mask tool in the canvas toolbar (or press Option-R).

The Rectangle Mask Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust 
the blend mode, softness, roundness, or spline color before the mask is drawn, adjust 
the controls in the HUD.

Note: You can also edit the mask parameters after you draw the mask.

2.	 Drag in the canvas until the resulting rectangle is the size you want, then release the 
mouse button.

To draw a perfectly square mask, press and hold the Shift key while you drag. To draw 
the rectangle mask from its center, press and hold the Option key while you drag.
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Adjust the size, roundness, feathering, or rotation of a rectangle mask
1.	 In Motion, do one of the following:

•	 In the canvas, double-click the mask.

•	 In the Layers list, canvas, or Timeline, select the mask, then click and hold the 
transform tools in the canvas toolbar and choose Edit Rectangle.

Simple shape transform handles appear in the canvas.

2.	 Do any of the following:
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•	 Adjust corner roundness: Drag the roundness handle in the upper-left corner of the 
mask.

•	 Adjust size: Drag a size handle (on the side of the mask shape). To scale the mask 
uniformly, drag the inner edge of the mask or Shift-drag a size handle.

The inner and outer edges overlap by default; you must drag the outer (feather) 
edge prior to dragging the inner (scale) edge.

•	 Adjust softness: Drag the mask’s outer edge away from the rectangle to feather 
outward, or toward the center of the rectangle to feather inward.

•	 Adjust rotation: Drag the rotation handle.

•	 Adjust position: Drag anywhere within the mask.

Create a circle mask
1.	 In the canvas toolbar in Motion, click and hold the mask tools pop-up menu, then 

choose Circle Mask (or press Option-C). 

The Circle Mask Tool HUD appears. (If the HUD isn’t displayed, press F7.) To adjust the 
blend mode, softness, or spline color before you draw the mask, use the controls in the 
HUD.

Note: You can also edit the mask parameters after you draw the mask.

2.	 Drag in the canvas until the resulting ellipse is the size you want, then release the 
mouse button.

To draw a perfectly symmetrical circle, press and hold the Shift key while you drag. To 
draw the ellipse from its center, press and hold the Option key while you drag.
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Adjust the size, curvature, or feather of a circle mask
1.	 In Motion, do one of the following:

•	 In the canvas, double-click the mask.

•	 In the Layers list, canvas, or Timeline, select the mask, then click and hold the 
transform tools in the canvas toolbar and choose Edit Ellipse.

Simple shape transform handles appear in the canvas.

2.	 In the canvas, do any of the following:
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•	 Adjust curvature: Drag the curvature handle in the upper-left corner of the mask.

•	 Adjust size: Drag a radius handle (on the edge of the mask shape). To scale the mask 
uniformly, drag the inner edge of the mask or Shift-drag a radius handle.

The inner and outer edges overlap by default; you must drag the outer (feather) 
edge prior to dragging the inner (scale) edge.

•	 Adjust softness: Drag the mask’s outer edge away from the mask to feather outward, 
or toward the center of the mask to feather inward.

•	 Adjust rotation: Drag the rotation handle.

•	 Adjust position: Drag anywhere within the mask.

Convert a shape or mask to control points in Motion
You can further refine the contours of a simple shape or mask by converting its outline to 
a complex shape (a spline with editable control points that allow you to adjust shape and 
curvature).

Convert a simple shape or mask
In Motion, do one of the following:

•	 In the canvas, Layers list or Timeline, select a simple shape or mask (rectangle or 
circle), then choose Object > Convert to Points (or press Option-Command-B).

•	 In the canvas, Control-click a simple shape or mask (rectangle or circle), then choose 
Convert to Points from the shortcut menu.

•	 In the canvas, Layers list or Timeline, select a simple shape or mask (rectangle or 
circle), then click the Convert to Points button in the Geometry pane of the Shape 
Inspector or in the Mask Inspector.

If you’ve animated the curvature, radius, or size parameters, a dialog appears asking 
you to confirm the conversion. The animation is not retained after the shape is 
converted.

Note: Animated feather values are retained when a simple shape or mask is converted.

Red control points appear on the shape or mask. See Intro to editing control points.

Note: The only way to convert the complex shape back to a simple shape is to use the 
Undo command (Command-Z).



811Motion User Guide

Edit control points on a line
There’s no “simple” shape mode for a line shape, so you don’t need to convert the line to 
edit its control points.

•	 In Motion, double-click the line in the canvas.

Red control points appear on both ends of the line. See Intro to editing control points.

Add complex shapes and masks

Intro to complex shapes and masks in Motion
In Motion, you can draw complex shapes and masks using splines. Splines are vector-based 
curves that allow for complex, customized shapes. There are two spline-drawing methods:

•	 Bezier splines: Bezier splines are good for drawing shapes for illustration. The controls 
used to manipulate Bezier splines are similar to those found in many other drawing 
and compositing applications, so they may be familiar to you. Bezier controls lend 
themselves to the creation of precise, detailed shapes. Tangent handles adjust the 
curvature of the shape on either side of the control point, and this defines the surface 
of the shape.

•	 B-Splines: You can also use B-Splines to draw complex shapes. But unlike Bezier 
splines, B-Splines are manipulated using only points—there are no tangent handles. 
Furthermore, the points themselves do not lie on the surface of the shape. Instead, 
each B-Spline control point is offset from the shape’s surface, “magnetically” pulling 
that section of the shape toward itself to create a curve. By combining the influence 
of multiple B-Spline points, you can create different curves. B-Splines are extremely 
smooth—by default, there are no sharp angles in B-Spline shapes, although you can 
create sharper curves, if necessary.
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Because B-Spline controls are so simple, they’re easy to animate and manipulate. The 
tools you use for a specific task are largely a matter of personal preference.

You can add a Bezier and B-Spline shapes and masks to a project in the following ways:

•	 Use the Bezier tool or B-Spline tool to draw complex shapes with editable control 
points.

•	 Use the Bezier Mask tool, B-Spline Mask tool, or Freehand Mask tool to draw complex 
masks with editable control points.

You can use Bezier splines and B-Spline splines interchangeably for any task, and for either 
shapes or masks.

Draw complex shapes and masks in Motion
Complex masks use spline shapes that you can customize to create complex contours. 

Draw a Bezier shape or mask
1.	 In Motion, select the Bezier tool in the canvas toolbar (or press B).

Note: The Bezier Mask tool is located in the mask tools pop-up menu in the canvas 
toolbar.

The Bezier Tool HUD (or Bezier Mask Tool HUD) appears. (If it doesn’t appear, press F7.) 
To change the parameters of the shape (or mask) before you draw it, adjust the controls 
in this HUD. 

Note: You can also edit the shape parameters after you draw the mask.

2.	 Click in the canvas to draw the first point.



813Motion User Guide

3.	 To add points to further define the shape, do one of the following:

•	 Click in the canvas to make a linear corner point.

•	 Drag in the canvas to make a curved Bezier point, adjusting it to the shape you want.

Press and hold the Shift key while making a curved point to constrain its tangents to 
45-degree angles. Press and hold Command–Equal Sign (=) to zoom in for a closer look 
and Command-Hyphen (–) to zoom out. You can scroll around by pressing the Space bar 
as you drag in the canvas. If you have a trackpad, it’s even easier: pinch open or closed 
to zoom in or out, and use a two-finger swipe to scroll around.

4.	 To finish the shape, do one of the following:

•	 Click the first point you drew to create a closed shape.

•	 Press C to close the shape, joining the first point you created to the last.

•	 Double-click anywhere in the canvas to create the last point of an open shape.
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•	 Press Return to create the last point of an open shape.

Note: Before a shape is closed, you can press Esc to cancel the entire operation, 
deleting the shape.

Immediately after finishing a shape, the Shape HUD appears and the Edit Points tool is 
selected, which lets you edit the shape you’ve just created.

Draw a B-Spline shape or mask
1.	 In the canvas toolbar in Motion, click and hold the path shape tools pop-up menu, then 

choose B-Spline.

Note: If the Bezier tool is selected, pressing B once selects the B-Spline tool. If another 
tool is selected, such as the Text tool, pressing B twice selects the B-Spline tool. The 
B-Spline Mask tool is located in the mask tools pop-up menu in the canvas toolbar. 

The B-Spline Tool HUD (or B-Spline Mask Tool HUD) appears. (If it doesn’t appear, 
press F7.) To change the parameters of the shape (or mask) before it is drawn, adjust 
the controls in this HUD.

2.	 Click in the canvas to draw the first point.
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3.	 Continue clicking in the canvas to draw additional points to define the shape you need.

 Tip: While drawing a shape, you can move and adjust the control points you’ve 
created before finishing the shape. You can adjust any control point except the first one 
you created, because clicking the first point closes the shape. Press and hold the Shift 
key while making a curved point to constrain its tangents to 45-degree angles.

As you create new B-Spline control points, keep the following in mind:

•	 The control points you draw influence the shape of the curve from a distance. They 
do not lie directly on the surface of the curve.

•	 To create more detailed curves, create more points. However, it’s best to use the 
fewest number of points necessary to create the amount of detail you need. Shapes 
with an excessive number of points can be difficult to edit later on.

•	 In many instances, it’s easier to create a loose group of control points first and then 
adjust them afterwards to create the precise curve you need in a later step.

4.	 When you’re ready to finish your shape, do one of the following:

•	 Click the first point you drew to create a closed shape.

•	 Press C to close the shape, joining the first point you created to the last.

•	 Press Return to finish an open shape at the last point you made.

•	 Double-click anywhere in the canvas to define the last point of an open shape.

Note: You can press Esc to cancel the entire operation and delete the shape.

Immediately after finishing a shape, the Shape HUD appears and the Edit Points tool is 
selected, which lets you edit the shape you’ve just created. 

Draw a freehand mask
Freehand masks create a mask shape in one movement, rather than in a point-by-point 
fashion (like a Bezier or B-Spline shape). For best results, use a stylus and tablet when 
drawing freehand masks. 

1.	 In the Layers list in Motion, select the layer to mask; then in the canvas toolbar, click 
and hold the mask tools pop-up menu and choose Freehand Mask.

The Freehand Mask Tool HUD appears. To change the parameters of the mask before 
you draw it, adjust the controls in this HUD.
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2.	 Do any of the following:

•	 Using a mouse: Drag in the canvas to draw a shape, finishing the mask at the 
starting point.

•	 Using a tablet: With a stylus, draw on the tablet, finishing the mask at the starting 
point.

A small circle appears when the pointer is over the starting point.

Note: If you don’t close the mask at its starting point, the mask is closed when you 
release the mouse button or lift the stylus.

The mask is completed.

3.	 Edit your control points to fine-tune the mask.

Draw paint strokes

Intro to paint strokes in Motion
The easiest way to draw a paint stroke is in one continuous movement, rather than one 
point at a time. Depending on the effect you want, you may achieve better results using a 
stylus and graphics tablet. Additionally, many styles and brushes in Motion take advantage 
of stylus pressure and speed.

There are two ways to create a paint stroke:

•	 Use the Paint Stroke tool to draw a freehand stroke in the canvas.

•	 Convert an existing shape into a paint stroke.

Technically, paint strokes are outline-only shapes created using any shape tool. The 
outline is composed of dabs—vector or image parcels that combine to create the onscreen 
“stroke.” Dabs are analogous to the particles of a particle system but are arrayed along a 
spline.

Using the Sequence Paint behavior, you can sequence effects (such as opacity, rotation, 
and scale) over the length of a paint stroke. For more information on using the Shape 
behaviors, see Intro to Shape behaviors.

Note: The Paint Stroke feature is a design and graphics tool, not a retouching or 
rotoscoping tool.
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Create a paint stroke in Motion
Create paint strokes and preview the stroke attributes using controls in the HUD.

Draw a freehand paint stroke
1.	 In the canvas toolbar in Motion, click the Paint Stroke tool (or press P).

The Paint Stroke Tool HUD appears. (If it doesn’t appear, press F7.)

Important: Like the other drawing tool HUDs, the Paint Stroke Tool HUD is available 
only after you select the Paint Stroke tool, and before you create your stroke in the 
canvas. The Paint Stroke Tool HUD lets you set the properties derived from the pressure 
and speed of the stylus before you draw the stroke.

The default brush type (in the Shape Style parameter) is Basic Solid. You can change 
the brush type by defining a paint stroke style.

2.	 Define a paint stroke style in the HUD:

a.	 Click the Shape Style preset pop-up menu, then choose an option.

b.	 Modify the Brush Color and Width settings.

If a preset is not used, a Basic Solid stroke is created. You can still apply a preset to 
the stroke using the Inspector after the stroke is drawn. Presets do not override the 
width or color of the stroke set in the HUD.

Note: The Pen Pressure and Pen Speed parameters are not available in the HUD when 
Shape Style is set to Solid Brush.

3.	 If you want to create a stroke that’s drawn over time, select the Write On checkbox.

Selecting the Write On checkbox applies a Write On behavior the stroke. As with 
any other behavior, you can modify its parameters in the HUD or Inspector. For more 
information on using the Write On behavior, see Write On behavior.
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4.	 Draw your stroke in the canvas, then press S or Esc to activate the Select/Transform 
tool.

The Paint Stroke Tool HUD is replaced with the Shape HUD, which contains basic 
parameters identical to those in all other shape HUDs. Consequently, after a stroke is 
drawn, you must use the Inspector to modify parameters unique to the paint brush and 
its dabs.

Preview the paint stroke in the Paint Stroke Tool HUD
The lower portion of the Paint Stroke Tool HUD contains a sketch area that displays a 
preview of a paint stroke effect. After you select a style for your paint stroke, that style 
remains selected for subsequent paint strokes until you choose another shape style. You 
can select another style before you create a paint stroke in the HUD, or after you create a 
paint stroke in the Inspector.

1.	 In the canvas toolbar in Motion, click the Paint Stroke tool.

2.	 Do one of the following:

•	 Choose a brush from the Shape Style pop-up menu in the Paint Stroke Tool HUD, 
then draw a stroke in the sketch area (of the HUD) to see a preview of the paint 
stroke.

•	 Select the Write On checkbox, draw a stroke in the sketch area, then click the Play 
button to see a preview of the write-on stroke.

•	 Apply a preset from the Shape Style pop-up menu to an existing stroke in the sketch 
area of the HUD.

If the preset is an animated stroke, the stroke is automatically drawn in the sketch 
area. Press the Play button to see the stroke animation again. 
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Change the style of an existing paint stroke
1.	 In Motion, select an existing paint stroke in the Layers list or Timeline.

2.	 In the Shape HUD or the Style pane of the Shape Inspector, click the Shape Style pop-
up menu, then choose a different option.

“Particle-ize” a paint stroke
You can animate the individual dabs in a paint stroke to create an exploding particle effect.

1.	 In Motion, select an existing paint stroke in the Layers list or Timeline.

2.	 In the Style pane of the Shape Inspector, choose Airbrush from the Brush Type pop-up 
menu (if it’s not already chosen).

3.	 In the Advanced pane, select the Dynamics checkbox, then play the project (press the 
Space bar).

The dabs spread out in the canvas.

4.	 To further refine the dab animation, adjust the Dynamics controls.

Paint a stroke over time
1.	 In the canvas toolbar in Motion, click the Paint Stroke tool (or press P).

The Paint Stroke Tool HUD appears. If the HUD does not appear, press F7 or D.

2.	 In the HUD, select the Write On checkbox and any other desired stroke settings.

3.	 In the canvas, create your stroke.

4.	 When you complete stroke, press Esc to exit the paint mode.

The Paint Stroke Tool HUD is replaced with the Shape HUD. In the Layers list, a Write 
On Shape behavior is applied to the stroke. To modify the Write On parameters, select 
the behavior and use the HUD or the Behaviors Inspector.

The faster you draw a stroke, the shorter the duration of the Write On behavior.

Note: If the Create Layers At option in the Project pane of Motion Settings is set to 
Current Frame, the paint stroke is created at the current playhead position. If set to 
Start of Project, the stroke is created at frame 1. For more information about the Create 
Layers At option, see If it’s your first import. 

5.	 Press the Space Bar to play back your project. 

The stroke is “painted on” as the project plays.

6.	 To modify the speed at which the stroke is painted, adjust the duration of the behavior 
bar in the Timeline or mini-Timeline.

See Write On behavior.
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Create a write-on stroke using an existing shape
You can apply the Write On behavior to an existing shape to draw its outline over time. 
Because the Write On behavior only affects outlines, the Outline checkbox must be 
selected in the Style pane of the Shape Inspector.

Note: When you add a Write On behavior to an existing shape, the behavior spans the 
duration of the shape (the length of its bar in the Timeline).

1.	 In Motion, select the shape you want to use and select its Outline checkbox in the HUD 
or Style pane of the Shape Inspector.

Note: You can leave the Fill checkbox selected, but only the outline is affected by the 
Write On behavior.

2.	 In the toolbar, click Behaviors, then choose Shape > Write On.

The Write On behavior appears in the Layers list. If the playhead is located at the start 
of the shape, the visual shape disappears and only the path is visible.

3.	 Play the project (press the Space bar).

The outline is drawn over the length of the behavior.

4.	 To adjust the speed at which the stroke is painted, adjust the duration of the behavior 
bar in the Timeline or mini-Timeline.

5.	 To adjust the properties of the stroke, use the Shape Inspector. 

See Stroke pane controls.
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Convert outlines to paint strokes in Motion
You can convert a shape outline into a paint stroke by modifying the brush type in the 
Inspector. After you assign a different brush type, paint stroke parameters become 
available. You can modify and animate the paint stroke’s brush parameters.

Convert an existing shape into an editable paint stroke
1.	 In Motion, select an existing shape in the Layers list, canvas, or Timeline.

2.	 In the Shape HUD or Style pane of the Shape Inspector, select the Outline checkbox.

Modify any Outline parameter you want. In this example, the outline is widened and 
tinted orange.

3.	 In the Style pane of the Shape Inspector, click the Brush Type pop-up menu, then 
choose Airbrush.

After you change the brush type to Airbrush (or Image), the following occurs:

•	 The shape fill options are disabled (because the shape fill options are not available 
unless the Brush Type is set to Solid).

•	 The shape icon in the Layers list becomes a paint stroke icon.

•	 The stroke softens. You can modify the brush profile to vary opacity within the 
brush, or apply a custom opacity gradient to the brush profile in the Style pane of 
the Inspector.

•	 The Stroke pane becomes available in the Shape Inspector. Use the Stroke pane to 
set the Stroke Color Mode and Brush Scale parameters, and to adjust other options.

•	 The Advanced pane becomes available in the Shape Inspector. The Advanced pane 
contains a single group of Dynamics controls that allow the dabs of a paint stroke to 
be animated like particles. For more information on Dynamics, see Advanced pane 
controls.
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4.	 Use the controls in the Style, Stroke, and Advanced panes of the Shape Inspector to 
modify or animate your paint stroke.

In the example below, the Additive Blend parameter is enabled in the Style pane. 
Additionally, the Color Over Stroke, Spacing Over Stroke, Width Over Stroke, Brush 
Scale, and Brush Scale Randomness parameters are modified in the Stroke pane.

Adjust stroke width in the Motion canvas
Typically the Width Over Stroke settings are controlled by a mini-curve editor in the Stroke 
pane of the Shape Inspector. However, you can also adjust Width Over Stroke values by 
dragging in the canvas. 

Note: The Width Over Stroke settings are only available when Brush Type is set to Airbrush 
or Image in the Style pane of the Shape Inspector.

Use the onscreen Width Over Stroke controls
1.	 In the Motion canvas, Control-click the paint stroke, then choose Stroke from the 

shortcut menu.

Small control points (+) appear at along the red spline.

2.	 Click the control point that you want to adjust.

Handles appear on either side of the control point.

3.	 To increase the width of the dabs, drag a handle away from the point; to decrease the 
width of the dabs, drag toward the point.

4.	 To change the position of a control, drag the control point to the left to move the point 
toward the stroke’s origin; drag the control point to the right to move the point toward 
the stroke’s end. (Points can be dragged over one another.)

5.	 To add width controls, Option-click the red spline. 

6.	 To delete width controls, select a control point, then press Delete.
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Paint Stroke controls in the HUD in Motion
When you select the Paint Stroke tool in the canvas toolbar, the Paint Stroke Tool HUD 
appears before you draw a stroke. Use this HUD to specify stroke-drawing settings before 
you draw. 

The Paint Stroke Tool HUD contains the following controls:

•	 Brush Color: Color controls that set the color of the brush. For more information on 
using these controls, see Use basic color controls.

•	 Width: A slider that defines the width of the paint stroke.

•	 Pen Pressure: A pop-up menu that sets stroke properties derived from the pressure 
of your pen before creating the stroke. This parameter is not available for solid brush 
types. Only strokes drawn using a stylus and tablet will have recorded pressure 
variations. Choose from one of the following:

•	 Nothing: Pen pressure is ignored.

•	 Width: The harder the pen pressure, the wider the stroke. To adjust the width of the 
dabs after the stroke is created, use the width and brush scale controls in the Style 
and Stroke panes of the Shape Inspector.

•	 Opacity: The harder the pen pressure, the more opaque the stroke. To adjust the 
opacity of the dabs after the stroke is created, use the opacity controls in the Style 
or Stroke pane of the Shape Inspector.

•	 Spacing: The harder the pen pressure, the greater the spacing between stroke 
dabs. To adjust the spacing of the dabs after the stroke is created, use the spacing 
controls in the Style or Stroke pane of the Shape Inspector.

•	 Angle: The harder the pen pressure, the greater the angle of the stroke dabs. To 
adjust the angle of the dabs after the stroke is created, use the angle controls in the 
Stroke pane of the Shape Inspector.

•	 Jitter: The harder the pen pressure, the larger the amount of jitter on the stroke. 
Jitter randomizes the position of the paint dabs, giving the dabs a particle-like 
appearance. To adjust the jitter of the dabs after the stroke is created, use the jitter 
controls in the Stroke pane of the Shape Inspector.
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Note: You can affect multiple parameters to a single stroke so that, for example, 
pressure affects both opacity and spacing. Choose an option, such as Opacity, 
before the stroke is created. After you create the stroke, apply a pen shape behavior 
to the stroke and apply the action to another parameter, such as Spacing. For more 
information on the pen shape behaviors, see Intro to Shape behaviors.

•	 Pen Speed: A pop-up menu that sets the stroke’s width, opacity, spacing, angle, and 
jitter based on the speed recorded when drawing the stroke with the Paint Stroke tool. 
These settings can be applied to paint strokes created using a stylus and graphics 
tablet or a mouse. This parameter is not available for solid brush types. Choose from 
one of the following:

•	 Nothing: Pen speed is ignored.

•	 Width: The faster you move the pen, the more narrow the stroke; the slower you 
move the pen, the wider the stroke. To adjust the width of the dabs after the stroke 
is created, use the width and brush scale controls in the Style and Stroke panes of 
the Shape Inspector.

•	 Opacity: The faster you move the pen, the less opaque the stroke. To adjust the 
opacity of the dabs after the stroke is created, use the opacity controls in the Style 
or Stroke pane of the Shape Inspector.

•	 Spacing: The faster you move the pen, the greater the spacing between the dabs 
of the stroke. To adjust the spacing of the dabs after the stroke is created, use the 
spacing controls in the Style or Stroke pane of the Shape Inspector.

•	 Angle: The faster you move the pen, the greater the angle of the stroke dabs. To 
adjust the angle of the dabs after the stroke is created, use the angle controls in the 
Stroke pane of the Shape Inspector.

•	 Jitter: The faster you move the pen, the larger the amount of jitter on the stroke. 
Jitter randomizes the position of the paint dabs so they appear more like particles. 
To adjust the jitter of the dabs after the stroke is created, use the jitter controls in 
the Stroke pane of the Shape Inspector.

•	 Write On: A checkbox that, when selected, allows a stroke to be “painted” on the 
canvas over time. See Write On behavior.

•	 Smoothing: A checkbox that, when selected, creates a smoother stroke with fewer 
control points. Paint strokes drawn with smoothing on are created as Bezier shapes. 
Paint strokes drawn with smoothing off are created as linear shapes.

•	 Shape Style: A pop-up menu that specifies a preset shape style (from the Library) to 
the selected shape. You can also save any custom shape style to the Library using this 
pop-up menu. Any stroke (shape) presets you have saved to the Library also appear in 
this list.

•	 Sketch area: An empty field where you can preview brush styles in combination with the 
current Paint Stroke Tool HUD settings.
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Edit shape control points

Intro to editing control points in Motion
Complex shapes, masks, and paint strokes are defined by Bezier splines and B-Splines, 
which are built with control points. The control points, which lie along the spline in 
connect-the-dot fashion, determine the shape of the spline.

You can modify a spline by adjusting its control points in the canvas. This section covers 
how to:

•	 Show control points

•	 Select or lock control points

•	 Add or delete control points

•	 Move control points to adjust shapes

•	 Edit Bezier control points

•	 Edit B-Spline control points

•	 Use dynamic guides and snapping to align controls points to other control points and to 
other objects

Show control points in Motion
There are several ways to display the control points of a complex shape to allow point-by-
point editing in the canvas.

Display a complex shape’s control points
In Motion, do one of the following:

•	 In the Layers list, canvas, or Timeline, select a shape containing control points (a spline 
shape), then in the canvas toolbar, click and hold the transform tools pop-up menu and 
choose Edit Points.
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•	 Double-click a spline shape in the canvas.

•	 Control-click a spline shape in the canvas, then choose Edit Points from the shortcut 
menu.

Note: Overlays must be enabled in the View menu (or in the View pop-up menu above 
the canvas) for control points and the spline of a shape to be visible. In addition, if 
Handles and Lines are disabled in the View > Overlays submenu (or in the View pop-up 
menu), Bezier or B-Spline control points will not be visible in the canvas.

After you display a shape’s control points, select control points to edit them. While editing 
the control points of a shape, you can select another shape and remain in control point-
adjustment mode. This allows for quick modification of multiple shapes’ control points.

Select or lock control points in Motion
For all of the following procedures, the Edit Points tool (in the transform tools pop-up menu 
in the canvas toolbar) must be selected.

Select control points
In the Motion canvas, do one of the following:

•	 Click any control point.

•	 Drag a selection rectangle over multiple control points.

•	 Shift-click unselected control points to add them to the selection.

•	 Shift-drag a selection rectangle around unselected control points to add them to the 
selection.
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Note: In Edit Points mode, when you place the pointer over a control point, an info window 
appears identifying the control point name. When dragging a control point, the status 
bar displays the point’s name and coordinates. You can choose not to display the info 
window by opening the General pane of the Motion Settings window and deselecting Show 
Tooltips. For more information on showing and hiding the status bar, see View dynamic 
canvas feedback.

Select every control point on a shape
•	 In Motion, choose Edit > Select All (or press Command-A).

Deselect control points
In Motion, do one of the following:

•	 Shift-click selected points.

•	 Pressing and holding the Shift key, drag a selection rectangle over selected points.

Deselect every control point on a shape
In Motion, do one of the following:

•	 Click the canvas anywhere outside the selected shape.

•	 Choose Edit > Deselect All (or press Shift-Command-A).

View control point numbers
By default, shape control points are numerically labeled in the order they were created in 
the canvas.

•	 In the Motion canvas, position the pointer over any control point.

The numeric name of the control point (“Control Point 1,” for example) is displayed.

Note: Shape control points are also listed by number in the Geometry pane of the Shape 
Inspector.
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Lock and unlock control points
You can lock control points in a shape to fix them in place and prevent accidental 
modification. A shape with locked points can still be moved.

In Motion, do one of the following:

•	 Lock a control point: Control-click a control point, then choose Lock Point from the 
shortcut menu.

•	 Unlock a control point: Control-click a locked control point, then choose Unlock Point 
from the shortcut menu.

Add or delete control points in Motion
If you didn’t create enough control points to make the complex shape you need, you can 
add more to the existing shape. You can also extend or close an open shape.

For all of the following procedures, the Edit Points tool (in the transform tools pop-up menu 
in the canvas toolbar) must be selected.
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Add control points to a shape
In Motion, do one of the following:

•	 Option-click or double-click the edge of a shape to add a new control point.

Note: To add control points to a B-Spline shape, Option-click or double-click the 
B-Spline frame’s edge, rather than the edge of the shape itself.

•	 Control-click the edge of a shape, then choose Add Point from the shortcut menu.

Add control points to the end of an open shape
1.	 In the Motion canvas, Option-click anywhere outside the shape to add control points to 

the end of the shape.

Close an open shape
In Motion, do one of the following:

•	 Click the first point in the shape to close it (or press C).

•	 Control-click a control point, then choose Close Curve from the shortcut menu.

•	 Display the Geometry pane in the Shape Inspector, then select the Closed checkbox.

You can reopen the shape by deselecting the Closed checkbox.

Create an open shape from a closed shape
In Motion, do one of the following:

•	 Control-click a point on the shape, then choose Open Curve from the shortcut menu.

The segment before the point (in a clockwise order) is removed from the shape. This 
action causes the selected point to become Control Point 1 and the remaining points 
to be renamed accordingly. If the originally closed shape was filled, the Fill checkbox 
remains selected. To disable the fill, deselect the Fill checkbox in the HUD or in the 
Style pane of the Shape Inspector.

•	 Select the shape and deselect the Closed checkbox in the Geometry pane of the Shape 
Inspector.

Note: The spline before the first point drawn is removed. To change the start point (the 
first point drawn) of the shape, Control-click a point and choose Set Start Point from 
the shortcut menu.
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Delete control points from a shape
If a shape has more control points than are necessary, you can delete them to make the 
shape easier to edit. This can be helpful if you animate the shape later on.

1.	 In Motion, select points to delete.

2.	 Do one of the following:

•	 Choose Edit > Delete.

•	 Control-click the selected points, then choose Delete Point from the shortcut menu.

•	 Press Delete.

The shape changes to adjust to the missing point. If you remove points from a closed 
shape, the shape remains closed.

Important: If you delete a point from a shape that has a keyframed shape animation 
parameter in the Keyframe Editor, that control point is removed from the entire animation.

Move control points to adjust shapes in Motion
Because control points define the contours of a complex shape, you can move control 
points to change the shape.

For all of the following procedures, the Edit Points tool (in the transform tools pop-up menu 
in the canvas toolbar) must be selected.

 Tip: You can also modify multiple control points across different shapes simultaneously 
by selecting them all at once.
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Move control points
In Motion, do one of the following:

•	 Select control points on the shape in the canvas, then drag the points to a new position.

As you drag selected control points, the rest of the shape stretches or curves to 
accommodate the change. 

•	 Select a control point, then press Command-Left Arrow, Command-Right Arrow, 
Command-Up Arrow, or Command-Down Arrow to nudge the point by one pixel (or 
Shift-Command to nudge by 10 pixels).

Constrain the movement of selected control points
1.	 In the Motion canvas, select one or more control points.

2.	 Press and hold the Shift key while you drag a selected point horizontally, vertically, or 
diagonally.

Note: To rotate or scale control points, you must use the Transform Control Points 
command. See Transform a group of control points, below.

Transform a group of control points
You can scale and rotate a group of points as if they were a single object by using the 
Transform Control Points command. The lines connecting the selected points to unselected 
points will move and adjust.

1.	 In the Motion canvas, drag a selection rectangle around the points you want to modify.

2.	 Choose Edit > Transform Control Points.

A bounding box appears around the selected points.

Note: The Transform Control Points command is available only when at least two points 
on the same spline are selected.

3.	 Drag bounding box handles to scale, rotate, or reposition the group of points as if they 
were a single object; drag the anchor point handle to reposition the anchor point.

4.	 To release the selection, click anywhere outside the selection, or choose to a different 
tool in the canvas toolbar.
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Move a shape edge
You can also select the line between two control points and drag the edge of the shape.

1.	 In the Motion canvas, drag any edge of a shape object.

The control points on either side of the line are selected, and the line segment moves as 
you drag.

The distance between the two points remains constant, but the line can be moved 
freely. Press and hold the Shift key to constrain the movement horizontally, vertically, or 
diagonally.

2.	 To release the selection, click anywhere outside the selection, or choose a different tool 
in the canvas toolbar.

Edit Bezier control points in Motion
The methods used to adjust Bezier shapes are similar to those used by many other 
applications. Each point in a Bezier shape can be converted from a hard corner to a curve.

For all of the following procedures, the Edit Points tool (in the transform tools pop-up menu 
in the canvas toolbar) must be selected.



833Motion User Guide

Convert Bezier control points from corners to curves
In the Motion canvas, do one of the following:

•	 Command-click a curved point to turn it into a corner (Linear) point.

•	 Command-drag a corner point to turn it into a curved (Bezier) point, creating adjustable 
tangent handles.

•	 Control-click selected points, then choose Linear or Smooth from the shortcut menu to 
change the control point type.

Adjust a Bezier curve using a control point’s tangent handles
Curved Bezier control points have two tangent handles that you use to adjust the curvature 
of the shape on either side of the control point. These handles can be adjusted in various 
ways to create symmetrical and asymmetrical curves. By default, these tangent handles are 
locked to one another at an angle of 180 degrees, but you can override this restriction to 
adjust each tangent handle independently.

1.	 In the Motion canvas, select a Bezier point.

Two tangent handles appear over the point.

2.	 Do any of the following:

•	 Adjust a tangent handle’s length or angle: Drag the tangent handle.

The Bezier curve is pulled or twisted in the direction you drag. By default, the 
opposing tangent handle is locked to 180 degrees, and adjusting the angle of 
one tangent handle adjusts the other. However, you can adjust the length of each 
tangent handle independently.

•	 Break a tangent handle to adjust side each separately: Option-drag the tangent 
handle; or Control-click it, then choose Break Handle from the shortcut menu.



834Motion User Guide

After this relationship is broken, adjustments to one tangent handle have no effect 
on the other, and you can rotate both tangent handles independently.

•	 Lock broken tangent handles to a custom angle: Option-drag a broken tangent 
handle point; or Control-click it and choose Link Handle from the shortcut menu. 

The tangent handles now maintain their relationship when moved and rotated. You 
can also press and hold the Command key while dragging a handle point so that two 
tangent handles with differing lengths scale proportionally.

•	 Restore broken tangent handles to their default alignment: Control-click a broken 
tangent handle point and choose Align Handles from the shortcut menu to align the 
tangent handles to a 180-degree angle.

Press and hold the Shift key while you adjust a tangent handle to constrain its 
movement to 45-degree angles. To simultaneously modify the handles for more than 
one control point, Shift-select the points (on the same spline) and then adjust the 
tangent handles.

Important: If the Record button (in the timing toolbar) is enabled, curve adjustments 
are keyframed, creating animated shape changes. Additionally, if a keyframe has 
been added to the Control Points parameter in the Geometry pane of the Shape 
Inspector, curve adjustments are keyframed, regardless of the Record button state.
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Edit B-Spline control points in Motion
Editing the position of control points in B-Spline shapes is similar to editing Bezier shapes. 
In fact, the steps for selecting, moving, adding, deleting, and locking control points are 
almost exactly the same. The main difference in editing both types of shapes lies in how 
you manipulate and adjust curves.

The simplest, and usually fastest, way to manipulate B-Spline curves is to move B-Spline 
points closer to or farther from one another. When B-Spline points are moved closer to one 
another, a sharper curve is created. B-Spline points moved farther from one another create 
shallower curves.

Each B-Spline control point tugs on a section of the shape, pulling it toward itself. As a 
result, you manipulate a shape’s curve by moving its control points in the direction you 
want to pull the shape. For example, notice how every control point creating the S curve 
below is offset in the direction of the curve it influences.

Note: You can show and hide the B-Spline frame lines that enclose B-Spline control points 
by choosing View > Overlays > Lines.

By default, B-Spline shapes have no corners. However, you can adjust the amount of 
curvature at each B-Spline control point to create sharper curves using fewer control 
points. (You can even create corners at a single point, if necessary.)

The easiest way to adjust B-Spline point curvature is by dragging the control point while 
pressing and holding the Command key. You can also switch among three preset degrees 
of curvature.
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Adjust B-Spline control point curvature
1.	 In the Motion canvas, select a B-Spline shape, then in the canvas toolbar, click and hold 

the transform tools pop-up menu and choose Edit Points.

2.	 In the canvas, drag B-Spline control points while holding down the Command key to 
make their curves progressively sharper. 

A perpendicular handle appears representing the curvature adjustment you’re making.

3.	 Do any of the following:

•	 Drag away from the point to make the curve progressively sharper.

•	 Drag toward the point to make the curve progressively looser.

Note: After the handle appears, you can modify the curve without the Command key, 
by dragging the handle.

4.	 Optional: Command-click the handle to switch between three progressively sharper 
amounts of curvature.

Alternatively, you can Control-click a B-Spline point, then choose Very Smooth, Smooth, 
or Linear from the shortcut menu.
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Use dynamic guides and snapping in Motion
The canvas dynamic guides and control point snapping help you align selected points with 
other objects.

Use control point snapping on a shape
1.	 In Motion, choose View > Overlays and make sure the Dynamic Guides menu item is 

checkmarked.

2.	 Choose View > Snap and make sure the Snap menu item is checkmarked.

3.	 In the canvas, Layers list, or Timeline, select the shape to edit.

4.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose Edit 
Points.

Note: In the canvas, you can also Control-click a shape and choose Edit Points from the 
shortcut menu.
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5.	 In the canvas, drag a control point.

Yellow guides appear when the selected control point aligns with the edges or center of 
the original shape, the edges or center of other objects, or the center of the canvas.

Turn off snapping while editing control points
You can temporarily disable snapping to allow for subtle shape adjustments.

In Motion, do one of the following:

•	 Press N to turn off snapping; press N again to turn snapping back on.

•	 As you begin to move the selected control point, press and hold the Command key to 
turn off snapping as you drag the point.

Specify whether control points snap to the center, edges, or both the center and 
edges of an object
1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 In the Canvas pane, click the Snap Objects At Their pop-up menu, then choose an 
option.

Edit fill, outline, and feathering in Motion
After you draw a shape, you can adjust the fill, outline, and feathering to suit your needs. 
Because a line is really an outline, all Outline parameters in the Inspector apply to a line.

For information on adjusting shape and mask splines and controls points, see Intro to 
editing control points.

Turn a shape’s outline on or off
1.	 In Motion, select a shape in the Layers list, canvas, or Timeline.

2.	 In the Style pane of the Shape Inspector, select or deselect the Outline activation 
checkbox.

Note: You can also use the Shape HUD to turn the outline on or off.
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Edit a shape’s outline
1.	 In Motion, select a shape in the Layers list, canvas, or Timeline.

2.	 In the Style pane of the Shape Inspector, do any of the following in the Outline controls:

•	 Turn a shape’s outline on or off: Select or deselect the Outline activation checkbox.

•	 Change the color of the outline: Select a different color from the Brush Color control.

•	 Change the width of the outline: Drag the Width slider.

Note: You can also use the Shape HUD to change outline color, roundness, and 
width.

•	 Change how the outline’s sharp corners are drawn: Click the Joint pop-up menu, 
then choose an option.

•	 Change the shape of an outline’s start and end caps: Click the Start Cap or End Cap 
pop-up menu, then choose an option.

•	 Change whether the outline appears over or under a shape’s fill: Click the Order 
pop-up menu, then choose an option.

•	 Change the outline from the default solid to an editable paint stroke: Set Brush Type 
to Airbrush or Image. See Style pane controls.

3.	 To change the roundness of the outline, open the Geometry pane of the Shape 
Inspector and adjust the Roundness slider.

Edit a shape’s fill
1.	 In Motion, select a shape in the Layers list, canvas, or Timeline.

2.	 In the Style pane of the Shape Inspector, do any of the following in the Fill controls:

•	 Turn a shape’s fill on or off: Select or deselect the Fill activation checkbox. 

•	 Change a shape’s fill mode from a solid color to a gradient: Click the Fill Mode pop-
up menu, then choose Gradient.

If the shape’s fill mode is set to a solid color, you can choose the color using the Fill 
Color control.

If the shape’s fill mode is set to a gradient, you can choose a gradient from the 
Gradient preset pop-up menu, or click the Gradient parameter’s disclosure triangle 
to display the gradient editor and create your own custom gradient. For more 
information on using gradient editors, see Gradient editor controls.
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Feather a shape
1.	 In Motion, select a shape in the Layers list, canvas, or Timeline.

2.	 If the shape’s outline is visible, deselect the Outline activation checkbox in the Style 
pane of the Shape Inspector.

3.	 Do one of the following:

•	 Adjust the Feather slider in the HUD or in the Style pane of the Shape Inspector.

Positive values spread the feathering outward, while negative values feather the 
shape inward.

•	 Drag the outer edge of a simple shape inward or outward in the canvas.

Note: You can only feather shapes that have the outline turned off.

4.	 Optionally, you can also adjust the Falloff parameter in the Style pane of the Shape 
Inspector, which controls how steep the feathering is.
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Shape controls in the Inspector

Intro to shape controls in Motion
The Shape Inspector appears when you select a shape in the canvas, Layers list, or 
Timeline. This Inspector comprises four panes:

•	 The Style pane contains controls to modify the fill color, opacity, feathering, and outline 
of a shape. The Style pane also contains brush controls for a paint stroke or an outline.

•	 The Stroke pane contains controls to set paint brush parameters, such as the spacing of 
the brush stoke dabs or the angle of the brush. The Stroke pane also contains gradient 
editor controls for the color stroke mode.

•	 The Advanced pane contains controls to animate the dabs of a paint stroke like 
particles. The Advanced pane parameters control the life, speed, and spin of the 
animated dabs.

•	 The Geometry pane contains controls to adjust the roundness or curvature of a shape, 
to close or open a shape, and to individually adjust the position of a shape’s control 
points using value sliders. The Convert To Points button is available when a simple 
shape is selected, allowing you to convert the simple shape to a Bezier shape with 
editable control points. You can also change the shape type (to Linear, Bezier, or 
B-Spline).

Style pane controls in Motion
The Shape Inspector’s Style pane contains controls to modify the fill and outline of a 
shape, including changing the brush type for an outline or paint stroke. The parameters are 
grouped into two main categories of controls: Fill and Outline. The Style pane is available 
for all shapes and paint strokes.

Shape Style pop-up menu
Use this pop-up menu to apply a preset shape style (from the Shape Styles category in the 
Library) to the selected shape. In addition to the preset styles, any custom styles you’ve 
saved to the Library appear in this list.

Fill controls
Adjust this group of parameters to set custom color, opacity, and feathering attributes 
of shape fills. An activation checkbox turns on or off the fill parameters for the selected 
shape.

•	 Fill Mode: A pop-up menu that sets how a shape is filled. There are two options:

•	 Color: Activates the Fill Color and Fill Opacity controls.

•	 Gradient: Activates the Gradient editor and Gradient preset pop-up menu.

•	 Fill Color: Color controls (available when Fill Mode is set to Color) that let you pick a 
color fill for the shape. For more information on using color controls, see Use basic 
color controls.

For information on selecting colors suitable for high-dynamic-range (HDR) projects, see 
Choose HDR colors.
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•	 Fill Opacity: A slider (available when Fill Mode is set to Color) that adjusts the opacity of 
the fill (independently of the outline, if the Outline parameter is enabled).

•	 Gradient preset pop-up menu (unlabeled): A pop-up menu (available when Fill Mode 
is set to Gradient) that applies a preset gradient (from the Gradients category in the 
Library) to the selected shape. In addition to the preset gradients, any custom gradients 
you’ve saved to the Library appear in this list.

•	 Gradient editor: A standard gradient editor (available when Fill Mode is set to Gradient) 
that sets custom color and opacity gradients. Click the disclosure triangle to the left 
to display all the gradient controls. For more information on using gradient editors, 
see Gradient editor controls. The controls for the Gradient editor are identical to the 
gradient controls for text, with one exception: The text gradient parameters include a 
dial to control the angle of the gradient. The shape gradient parameters, however, use 
Start and End point controls, available in the Inspector or via onscreen controls.

•	 Feather: A slider that feathers (softens) the edges of a shape. Positive feathering values 
soften the edge of the shape from its edge outward. Negative feathering values soften 
the edge of a shape inward from the edge.

Note: You cannot feather an object when the Outline activation checkbox is selected.

•	 Falloff: A slider that controls how “steep” the feathering is. Higher values result in 
feathering that’s pushed farther inward, so the edge of the feathering effect is more 
transparent. Lower values result in the “core” of the feathering effect being pushed 
farther outward, so the edge of the feathering effect is less transparent.

Note: You cannot adjust Falloff when the Outline activation checkbox is selected.

•	 Fixed Feather: A checkbox that controls feathering when a shape is scaled using the 
Scale parameter in the Properties Inspector (or using the 2D or 3D Transform tools in 
the canvas).

•	 Set the feather to ignore scaling: Turn the checkbox on. Feathering is applied after 
the shape is scaled, so scaling only affects the shape (not the feathered edge). If 
you adjust the scale disproportionately, the feathering remains constant.

•	 Set the feather to scale with the shape: Turn the checkbox off. Feathering is applied 
before the shape is scaled, so scaling affects both the shape and the feathered 
edge. If you adjust the scale disproportionately, feathering variations are introduced.

Note: When you scale a shape using the Size or Radius parameters in the Geometry 
pane of the Shape Inspector, the Fixed Feather checkbox has no effect.



843Motion User Guide

Outline controls
Use this group of parameters to set the outline attributes of a shape. An activation 
checkbox turns on or off the outline parameters for a selected shape. When you select the 
Outline checkbox, outline controls become available.

•	 Brush Type: A pop-up menu that sets the kind of brush used to draw the outline. There 
are three options:

•	 Solid: Creates a solid outline along the shape spline or paint stroke. This is the 
default setting. 

•	 Airbrush: Creates an outline made up of editable brush strokes referred to as dabs. 
You can set the dabs to be close together so the line appears solid, or you can space 
the dabs further apart. When Brush Type is set to Airbrush, the Stroke and Advanced 
panes become available in the Shape Inspector.

•	 Image: Lets you use an image layer in your project as a dab source. When Brush 
Type is set to Image, the Stroke and Advanced panes become available in the Shape 
Inspector.

•	 Brush Color: Color controls that let you pick a color to use for the outline or paint dabs. 
These color controls are identical to the shape Fill Color controls (and all color controls 
throughout Motion).

Note: When Stroke Color Mode (in the Stroke pane) is set to Color Over Stroke or Pick 
From Color Range, the Brush Color controls are not available.

•	 Brush Opacity: A slider that defines the opacity of the entire stroke, regardless of the 
Brush Type setting.

Note: When Stroke Color Mode (in the Stroke pane) is set to Color Over Stroke or Pick 
From Color Range, the Brush Opacity control is not available. When Stroke Color Mode 
(in the Stroke pane) is set to Use Brush Color, you can adjust the opacity (in the Stroke 
pane) to change over the course of the stroke. For more information on using the 
Opacity Over Stroke parameter, see Stroke pane controls.
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The Brush Opacity control defines a different opacity value for a shape and its outline.

•	 Brush Source: An image well (available when Brush Type is set to Image) that lets you 
set an image layer in your project as the outline’s brush source. Drag an image, image 
sequence, QuickTime movie, text object, or shape from the Layers list into the Brush 
Source image well.

Note: When a movie or image sequence is the brush source, additional parameters 
appear in the Outline group of controls. See Style pane movie controls.

•	 Brush Profile: A gradient editor (available when Brush Type is set to Airbrush) that sets 
varying levels of opacity within the brush. The brush profile uses the same opacity 
controls as a standard gradient editor. See Gradient editor controls. The default Brush 
Profile gradient creates a soft airbrush.

Modify the Brush Profile opacity gradient to create new brush looks.

•	 Width: A slider that changes the width of a shape’s outline or width of a paint 
stroke’s dabs. On paint strokes, width adjustments alter the size of the dab while also 
maintaining the spacing between each dab. 

Note: If you used the pressure parameters in the Paint Stroke Tool HUD to create 
variations in the stroke when the stroke was created, adjusting the Width parameter 
affects the width of the stroke uniformly.
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•	 Preserve Width: A checkbox (available when Brush Type is set to Solid) that, when 
selected, maintains the defined width of the shape outline or paint stroke when the 
shape or stroke is scaled.

•	 Joint: A pop-up menu (available when Brush Type is set to Solid) that sets how hard 
corners on a shape’s outline are drawn. There are three options:

•	 Square: All corners are squared off.

•	 Round: All corners are rounded.

•	 Bevel: All corners are cut at an angle.

•	 Start Cap: A pop-up menu (available when Brush Type is set to Solid) to choose the 
shape of an open outline’s start cap (the shape of the start point of an outline). There 
are five options:

•	 None: The stroke ends at the control point.

•	 Square: The cap is squared off.

•	 Round: The cap is rounded.

•	 Bevel: The cap is cut at an angle.

•	 Arrow: The cap is a customizable arrow. When Arrow is selected from the Start Cap 
or End Cap pop-up menus, the Arrow Length and Arrow Width sliders appear.

•	 End Cap: A pop-up menu (available when Brush Type is set to Solid) to choose the 
shape of an outline’s end cap (the shape of the end point of an outline). There are five 
options:

•	 None: The stroke ends at the control point.

•	 Square: The cap is squared off.

•	 Round: The cap is rounded.

•	 Bevel: The cap is cut at an angle.

•	 Arrow: The cap is a customizable arrow. When Arrow is selected from the Start Cap 
or End Cap pop-up menus, the Arrow Length and Arrow Width sliders appear.

•	 Spacing: A slider (available when Brush Type is set to Airbrush or Image) that defines 
the space between dabs. A lower number creates a more solid line, and a higher number 
creates a greater distance between dabs.

•	 Additive Blend: A checkbox (available when Brush Type is set to Airbrush or Image) that 
composites all overlapping dabs together using the Additive blend mode. By default, 
dabs are composited together using the Normal blend mode. The Additive blend mode 
occurs in addition to whichever compositing method is already in use (the Blend Mode 
setting in the Properties Inspector).

•	 Reverse Stacking: A checkbox (available when Brush Type is set to Airbrush or Image) 
that inverts the order in which the dabs are stacked. To see the effect of this parameter, 
dabs must be overlapping.

•	 First Point Offset: A slider to offset and animate the start point of the outline. This is 
very useful for effects such as drawing a line across a map over time.

•	 Last Point Offset: A slider to offset and animate the end point of the outline.
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You can manually animate the First Point Offset and Last Point Offset parameters in the 
Style pane of the Shape Inspector to achieve the same effect as the Write On behavior. 
(You can also use the Shape Write On behaviors to draw a stroke or outline over time. 
See Write On behavior.)

•	 Order: A pop-up menu that sets whether an outline is drawn over or under the fill color 
or gradient. The effect is more apparent with thicker outline widths. There are two menu 
options:

•	 Over Fill: Outlines appear on top of the selected fill of the shape.

•	 Under Fill: Outlines are obscured beneath the selected fill of the shape.

Style pane movie controls in Motion
Additional controls appear in the Shape Inspector’s Style pane when the Brush Source is a 
multi-frame object such as a QuickTime movie or image sequence:

•	 Play Frames: A checkbox that controls playback of Brush Source movie or image 
sequence. If the checkbox is selected, playback of the clip loops; if the checkbox is 
deselected, the paint dabs use the still frame specified by the Random Start Frame 
parameter or the Source Start Frame parameter (described below).

•	 Random Start Frame: A checkbox that introduces variation to image brush strokes 
when the Brush Source parameter contains a multiframe movie or image sequence. If 
the checkbox is selected, each dab uses a different random frame in the source clip. If 
the Play Frames checkbox is selected, dabs begin animating from this random frame. If 
the Play Frames checkbox is deselected, dabs do not animate, but display the random 
frame as a still frame. You can adjust this pattern of randomness using the Random 
Seed button in the Stroke pane.

•	 Source Start Frame: A mini-curve editor (available when Random Start Frame is 
deselected) that defines the frame where playback of the source clip begins in the paint 
dabs. (See Use the mini-curve editor.) The Source Start Frame default keyframe value 
is 0. You can change the start frame for all dabs, or you can create a curve so start 
frames vary over the length of the stroke (different dabs use different start frames). For 
example, if the first Source Start Frame value is 50, each dab begins playback at frame 
50. If you create an animation curve that begins at 50 and ends at 250, each dab begins 
clip playback at a progressively later frame.

Note: The Play Frames checkbox must be selected for playback to occur. If Play Frames 
is deselected, you can display different still frames over the length of the stroke. 

Click the Source Start Frame disclosure triangle to see the Stroke Length and Source 
Start Frame controls:

•	 Source Start Frame Over Stoke: A slider that adjusts the value of the selected 
keyframe in the mini-curve editor.

•	 Stroke Length: A slider that adjusts the value of the selected keyframe. Stroke 
Length is mapped horizontally on the mini-curve editor graph and provides a visual 
representation of the position of the changes in start frame value (keyframes) over 
the length of the stroke.

•	 Hold Frames: A slider that sets the number of times each frame of the source movie is 
repeated during playback. The larger the Hold Frames value, the slower your playback.

•	 Hold Frames Randomness: A slider that varies the number of frames to “hold.”
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Stroke pane controls in Motion
The Stroke pane becomes available when the Brush Type pop-up menu in the Shape 
Inspector’s Style pane is set to Airbrush or Image. The Stroke pane contains adjustable 
parameters specific to the paint stroke and brush, such as opacity, width, brush size, and 
so on.

Stroke controls
•	 Stroke Color Mode: A pop-up menu that specifies how color is applied to the stroke 

over its length. There are three options:

•	 Use Brush Color: Uses the color of the brush as defined by the Brush Color 
parameter in the Style pane. The stroke is a solid color over its length. 

•	 Color Over Stroke: Dabs are tinted based on their position over the length of the 
paint stroke.

•	 Pick From Color Range: Dabs are tinted at random, with the range of possible colors 
defined by a gradient editor. A point on the gradient is randomly chosen, so the 
relative sizes of each color region determine the frequency of the color being used.

•	 Opacity Over Stroke: An opacity gradient editor (available when Stroke Color Mode is 
set to Use Brush Color) to change the opacity of dabs based on their location on the 
stroke. This gradient control is limited to grayscale values, which are used to represent 
varying levels of transparency. White represents solid dabs, progressively darker levels 
of gray represent decreasing opacity, and black represents complete transparency. A 
simple white-to-black gradient represents a stroke that is solid at its start, but fades 
out gradually over its length until finally vanishing at the end. For information on using 
gradient editors, see Gradient editor controls.
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•	 Color Over Stroke: A gradient editor (available when Stroke Color Mode is set to Color 
Over Stroke) to define the range of color in the stroke, beginning with the leftmost color 
in the gradient, and progressing through the range of colors until reaching the rightmost 
color at the end of the stroke. Gradual color changes do not appear in each dab, but 
only across the stroke as a whole. An opacity bar appears at the top of the gradient 
editor. For information on using gradient editors, see Gradient editor controls.

•	 Color Range: A gradient editor (available when Stroke Color Mode is set to Pick From 
Color Range) to define a range of colors to randomly tint the stroke’s paint dabs. The 
direction of the gradient colors is not relevant (because this control merely defines 
the colors to be used in the random tinting). The Color Range parameter has the same 
controls as the Color Over Stroke parameter. For information on using gradient editors, 
see Gradient editor controls.

•	 Color Repetitions: A slider (available when the Stroke Color Mode is set to choose 
Color Over Stroke) that increases the number of times the gradient is repeated over the 
stroke.

•	 Spacing Over Stroke: A mini-curve editor that lets you customize the spacing of the 
dabs over the length of the stroke. You can create a curve that gradually increases the 
dabs’ spacing over the length of the stroke, create a curve that varies the dabs’ spacing 
over the length of the stroke, and so on. 
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In the following images, the default Spacing Over Stroke value of 100% in the mini-curve 
editor creates an even distribution of the dabs—based on the value set in the Spacing 
parameter in the Style pane. For more information on using the mini-curve editor, see 
Use the mini-curve editor.

In the following images, the Spacing Over Stroke curve in the mini-curve editor is 
adjusted to use a greater value at the start of the stroke, and 100% at the end of the 
stroke. The dabs at the beginning of the stroke are spaced more widely apart and get 
closer at the end of the stroke.
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Two additional controls in the mini-curve editor let you fine-tune the values of selected 
points in the curve:

•	 Spacing Over Stroke: A slider that adjusts the spacing between dabs at the selected 
keyframe. Increasing this parameter increases the spacing between each dab in the 
stroke.

•	 Stroke Length: A slider that determines where along the range of the dabs within the 
stroke the Spacing Over Stroke value (for the selected keyframe) is applied. 

•	 Fixed Brush Dabs: A checkbox that, when selected, keeps the number and spacing of 
the dabs constant regardless of the changes in the stroke’s shape over time caused 
by behaviors or keyframe animation. The effect of this parameter is not visible when 
editing a paint stroke on a single frame.

•	 Anchor Dabs To: A pop-up menu (available when the Fixed Brush Dabs checkbox is 
deselected) that defines how dabs are added to or removed from a paint stroke when 
the length of the paint stroke is modified. There are two options:

•	 Start: Adds dabs to or removes dabs from the start point of a paint stroke when the 
length of the paint stroke is modified. The first dab on the stroke remains fixed.

•	 Start and End: Adds dabs to or removes dabs from the start and end points of a 
paint stroke when the length of the paint stroke is modified. The first and last dabs 
on the stroke remain fixed.

Note: Changing a shape’s control points or adjusting the Width or Spacing 
parameters (in the Style pane) or Spacing Over Stroke and Width Over Stroke 
parameters (in the Stroke pane) affects the dab spacing because larger dabs can be 
spaced further apart.

•	 Width Over Stroke: A mini-curve editor that lets you customize the width of the dabs 
over the length of the stroke. You can create a curve that gradually increases the dabs’ 
width over the length of the stroke, create a curve that varies the dabs’ width over the 
length of the stroke, and so on. The start value for the dab width is based on the value 
set in the Width parameter in the Style pane. For more information on using the mini-
curve editor, see Use the mini-curve editor.

Two additional controls in the mini-curve editor let you fine-tune the values of selected 
points in the curve:

•	 Width Over Stroke: A slider that adjusts the width of the dab at the selected 
keyframe.

•	 Stroke Length: A slider that determines where along the range of the dabs within the 
stroke the Width Over Stroke value (for the selected keyframe) is applied.

You can also adjust the Width Over Stroke parameter for a selected paint stroke in the 
canvas. See Adjust stroke width in the canvas.

•	 Brush Scale: A slider that adjusts the size of the brush (the source of the dabs). Click 
the disclosure triangle to adjust the X and Y scale values independently. By default, 
Scale is set to 100%—the size of the dabs is equal to the size of the source brush. 
Unlike the width parameter in the Style pane, brush scale adjustments affect only the 
size of the dabs and don’t preserve the spacing between dabs.
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•	 Brush Scale Randomness: A slider that defines an amount of variance in the scale of the 
stroke’s brush. A value of 0 results in no variance—all dabs in the stroke are the same 
size. A value greater than 0 introduces a variance. The scale for an individual dab is 
defined by the Scale parameter, plus or minus a random value falling within the Brush 
Scale, Width Over Stroke, and Width (in the Style pane) parameters. Click the disclosure 
triangle to adjust the X and Y values independently.

•	 Align Brush Angle: A checkbox that, when selected, causes the stroke dabs to rotate to 
match the shape on which they are positioned.

•	 Brush Angle: A dial that specifies (in degrees) the rotation of the stroke dabs. Using 
the default dial or value slider modifies the Z angle. When the Local 3D checkbox 
(described below) is selected, additional Brush Angle Randomness controls become 
available. Click the disclosure triangle to expose X, Y, and Z rotation dials and the 
Animate pop-up menu.

•	 Animate: A pop-up menu (available when the Local 3D checkbox—described below—
is selected) that lets you change the interpolation for animated 3D rotation channels. 
Click the Brush Angle disclosure triangle to display the Animate parameter. There are 
two menu options:

•	 Use Rotation: Dabs rotate from their start rotation to their final rotation. 
Depending on the animation, the elements may rotate multiple times before 
reaching their final orientation (the last keyframed value). For example, if the X, Y, 
and Z angle parameters are animated from 0 degrees to 180 degrees in a project, 
the elements rotate on all axes before reaching their final orientation.

•	 Use Orientation: Dabs rotate more smoothly and without multiple rotations. This 
option interpolates between the dabs’ start orientation (first keyframe) and their 
end orientation (second keyframe).

•	 Angle Over Stroke: A mini-curve editor that lets you customize the Z rotation (in 
degrees) of the dabs over the length of the stroke. You can create a curve that gradually 
increases the dabs’ angle over the length of the stroke, a curve that varies the dabs’ 
angle over the length of the stroke, and so on. For more information on using the mini-
curve editor, see Use the mini-curve editor.

Two additional controls in the mini-curve editor let you fine-tune the values of selected 
points in the curve:

•	 Angle Over Stroke: A dial that adjusts the angle of the dab at the selected keyframe.

•	 Stroke Length: A slider that determines where along the range of the dabs within the 
stroke the Angle Over Stroke value (for the selected keyframe) is applied.
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•	 Brush Angle Randomness: A dial that defines an amount of variance in the rotation of 
the stroke dabs. A value of 0 results in no variance—all dabs have the same rotational 
value. A value greater than 0 introduces a variance. The angle for an individual dab is 
defined by the Brush Angle and Angle Over Stroke parameters, plus or minus a random 
value falling within the Brush Angle Randomness. Using the default dial modifies the Z 
angle. To modify the rotation of the dabs in X, Y, and Z space, or to access the Animate 
parameter (available when the Local 3D checkbox is selected), click the disclosure 
triangle.

•	 Animate: A pop-up menu (available when the Local 3D checkbox—described below—
is selected) that lets you change the interpolation for animated 3D rotation channels. 
Click the Brush Angle Randomness disclosure triangle to display the Animate 
parameter.

•	 Use Rotation: Dabs rotate from their start rotation to their final rotation. 
Depending on the animation, the elements may rotate multiple times before 
reaching their final orientation (the last keyframed value). For example, if the X, Y, 
and Z Angle parameters are animated from 0 degrees to 180 degrees in a project, 
the elements rotate on all axes before reaching their final orientation.

•	 Use Orientation: Dabs rotate more smoothly and without multiple rotations. This 
option interpolates between the dabs’ start orientation (first keyframe) and their 
end orientation (second keyframe).

•	 Local 3D: A checkbox that lets you take advantage of the Motion 3D workspace. When 
the Local 3D checkbox is selected, the following become possible:

•	 When the Face Camera checkbox (described below) is selected, paint dabs actively 
face the camera when the camera or stroke is rotated or animated.

•	 When the Dab Depth Ordered checkbox (described below) is deselected, dab 
ordering remains consistent when the paint stroke (or the camera) is rotated in X or 
Y space. When this checkbox is selected, the dabs jump in front of each other each 
time the stroke rotates 180 degrees. In other words, this checkbox draws the dabs 
in the stroke according to each dab’s actual 3D position in the project. Dabs that are 
closer to the camera appear closer; dabs that are farther from the camera appear 
more distant.

•	 When the Dynamics checkbox is selected in the Advanced pane, a paint stroke acts 
similarly to an emitter—the dabs become particles. When the Local 3D checkbox 
is selected, the dabs are animated in 3D space. When the Local 3D checkbox is 
deselected, the particles are animated in X and Y space only. For more information 
on Dynamics, see Advanced pane controls.

•	 When the Dynamics checkbox is selected in the Advanced pane, some applied 
Simulation behaviors will pull dabs out of their plane. For example, if a paint 
stroke has an applied Attracted To behavior (with the Affect Subobjects checkbox 
selected), and the target layer is in a different location in Z space, the dabs are 
pulled into Z space and move toward the target layer. The paint stroke must be a 
member of a 3D group for a behavior to pull dabs out of the X and Y planes. For 
information about 3D groups, see Create 3D intersection.
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Use the following guidelines when working in 3D with paint strokes:

•	 Even in a 2D project, you can adjust a paint stroke’s general properties in 3D space. 
For example, you can modify the Z parameter (depth) using the Position, Scale, 
Rotation, and Anchor Point controls in the Properties Inspector.

•	 Paint strokes do not receive reflections (controlled in the Properties Inspector) 
unless the Local 3D checkbox is deselected.

•	 Paint strokes do not cast shadows (controlled in the Properties Inspector) unless the 
Local 3D checkbox is deselected.

•	 Lighting does not affect paint strokes unless the Local 3D checkbox is deselected.

Important: Even if the Local 3D checkbox is selected, paint strokes do not intersect 
with the “global” 3D world. This means that paint strokes can exist in 3D space, but 
do not intersect with objects that exist inside their own group, or with objects in other 
groups. A 3D paint stroke is composited with the rest of the objects in the project based 
on layer order. 

•	 Face Camera: A checkbox (available when the Local 3D checkbox is selected) that 
forces stroke dabs to actively face the camera if the camera is rotated or if the paint 
stroke is rotated or animated. When the Face Camera checkbox is deselected, the dabs 
face forward in the stroke and appear flat (unless the source layer or paint dabs are 
rotated in 3D space).

Because paint source dabs are 2D (flat) objects, dabs are not visible when you use the 
orthogonal reference camera views, such as Left, Right, and Top (unless the source 
layer or dabs are rotated in 3D space). This is because orthogonal views are at right 
angles (perpendicular) to the dabs. For more information on using cameras, see Add a 
camera.

•	 Dab Depth Ordered: A checkbox (available when the Local 3D checkbox is selected) 
that keeps paint dab ordering consistent when the paint stroke is rotated in X or Y 
space. When Dab Depth Ordered is deselected, the dabs jump in front of each other 
each time the stroke rotates 180 degrees.

•	 Jitter: A slider that lets you create a little chaos in your paint dabs. The higher the value, 
the more dispersed the dabs become (parallel to and perpendicular to the stroke’s 
control points). Jitter can be animated with keyframes so the dabs behave like particles. 
Click the disclosure triangle to display the individual X and Y sliders: 

•	 X: Moves the dabs parallel to the stroke’s curves at control points.

•	 Y: Moves the dabs perpendicular to the stroke’s curves at control points.
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•	 Jitter Over Stroke: A mini-curve editor that lets you customize the scatter of the dabs 
over the length of the stroke. You can create a curve that gradually increases the dabs’ 
jitter over the length of the stroke, a curve that varies the dabs’ jitter over the length of 
the stroke, and so on. For more information on using the mini-curve editor, see Use the 
mini-curve editor.

Two additional controls in the mini-curve editor let you fine-tune the values of selected 
points in the curve:

•	 Jitter Over Stroke: A slider that adjusts the amount of dab movement along the X 
and Y axes at specific points along the curve. Click the disclosure triangle to reveal 
individual X and Y axis sliders, to customize the jitter effect. Drag the X slider to 
adjust keyframes that define the amount of dab movement parallel to the stroke’s 
curve at specific points along the stroke. Drag the Y slider to adjust keyframes that 
define the amount of dab movement perpendicular to the stroke’s curve at specific 
points along the stroke. Use the Jitter Over Stroke parameter to adjust the amount 
of dab movement in both directions at specific points along the curve (adjusts the 
purple and green curves simultaneously).

•	 Stroke Length: A slider that determines where along the range of the dabs within the 
stroke the Jitter Over Stroke value (for the selected keyframe) is applied.

•	 Random Seed: Controls that vary the Jitter, Brush Angle Randomness, and Brush 
Scale Randomness parameters (in the Stroke pane) and the Life, Speed, and Spin 
Randomness parameters (in the Advanced pane). If you don’t like the current random 
distribution of the dabs, you can change the seed number by typing a new number 
in the value field or clicking Generate. The Jitter value must be 1 or more for this 
parameter to have any effect.



855Motion User Guide

Advanced pane controls in Motion
The Advanced pane becomes available when the Brush Type pop-up menu in the Shape 
Inspector’s Style pane is set to Airbrush or Image. The Advanced pane contains Dynamics 
controls that animate the dabs of a paint stroke like particles. Unlike particles, dabs are 
only “born” one time; but they can age and die like particles. When the Dynamics checkbox 
is deselected, dabs are immortal and are not animated.

Note: Although the Dynamics parameters are animated by default, you can customize the 
animation by keyframing or applying Parameter behaviors to the Dynamics parameters in 
the Advanced pane. 

In addition to the Dynamics controls, the Advanced pane also contains controls for 
adjusting pen pressure and speed.

Dynamics controls
Select the activation checkbox and adjust this group of parameters to animate paint stroke 
dabs in particle-like fashion. Double-click the Dynamics heading to reveal the Dynamics 
controls:

•	 Emission Angle: A dial and value slider that set the direction in which the paint dabs 
travel. This parameter works in conjunction with the Emission Range parameter 
(described below).

•	 Emission Range: A dial and value slider that restrict the area in which the dabs travel, in 
the direction of the Emission Angle. Setting the Emission Range parameter to 0 degrees 
keeps dabs perpendicular to the paint stroke.

•	 Life: A slider that defines the duration of each dab, in seconds, controlling how long 
each dab lasts before disappearing—similar to how sparks disappear after flying away 
from a sparkler.

•	 Life Randomness: A slider and adjacent value slider that define an amount of variance in 
the life of the paint dabs. A value of 0 results in no variance—all dabs from the selected 
stroke share the same life span. A value greater than 0 introduces a variance defined 
by the Life parameter, plus or minus a random value falling within the Life Randomness 
value.

•	 Speed: A slider that defines initial speed, determining how quickly each dab flies away 
from the stroke.

•	 Speed Randomness: A slider that defines an amount of variance in the speed of the 
paint dabs. A value of 0 results in no variance—all dabs from the selected stroke move 
with the same speed. A value greater than 0 introduces a variance defined by the 
Speed parameter, plus or minus a predetermined random value falling within the Speed 
Randomness value.

•	 Spin: A dial that animates the dabs of a paint stroke by initially spinning each dab 
around its center. Adjustments to this control are in degrees per second.

•	 Spin Randomness: A dial that defines an amount of variance in the spin of the paint 
dabs. A value of 0 results in no variance—all dabs from the selected stroke spin at the 
same rate. A value greater than 0 introduces a variance defined by the Spin parameter, 
plus or minus a random value falling within the Spin Randomness value.
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Pen Pressure and Pen Speed controls
When you draw paint strokes with a connected Wacom stylus and tablet, or apply a shape 
style from the Shape Style pop-up menu to an existing paint stroke, two additional groups 
of controls appear in the Advanced pane:

•	 Pen Pressure: Controls that let you adjust the width, opacity, spacing, angle, or jitter of 
the paint stroke based on the pressure of your stylus on the tablet when the stroke was 
created. These controls are identical to the controls in the Apply Pen Pressure shape 
behavior. For more information, Apply Pen Pressure behavior.

•	 Pen Speed: Controls that let you adjust the width, opacity, spacing, angle, or jitter of 
the paint stroke based on the speed of your stylus on the tablet when the stroke was 
created. These controls are identical to the controls in the Apply Pen Pressure shape 
behavior. See Apply Pen Speed behavior.

Note: Only strokes drawn using a stylus and tablet have recorded pressure variations. You 
can select how the pressure of the stylus affects the stroke in the Paint Tool HUD before 
you draw the stroke, or afterwards by activating this parameter in the Advanced pane.

Geometry pane controls in Motion
The Geometry pane of the Shape Inspector contains controls to change the shape type, to 
close or open a shape, and to individually adjust the position of a shape’s control points.

The Geometry pane controls are available for all shapes regardless of what is selected 
in the Brush Type pop-up menu in the Style pane. You can change a shape’s type at any 
time. Changing a shape’s type changes its form. For example, a single set of control points 
produces the following three shapes, depending on the selected Shape Type:

The Geometry pane contains the following adjustable controls:

Basic Geometry controls
•	 Roundness: A slider (available when a simple rectangle shape, Bezier shape, or B-Spline 

shape is selected) that adjusts the roundness of shape corners. Use this control to 
create rounded rectangles or to smooth the edges of any shape.

•	 Curvature: A slider (available when a simple circle shape is selected) that adjusts the 
degree of curvature of the circle. When set to 100%, the shape is elliptical. When set to 
0%, the shape is rectangular.

•	 Preserve Scale: A checkbox (available when a simple rectangle shape, Bezier shape, 
or B-Spline shape is selected) that controls whether the Roundness setting is absolute 
or relative to the overall shape size. When this checkbox is selected, the roundness 
remains at the same approximate percentage of curvature as the object is scaled. When 
this checkbox is deselected, the curvature varies as the overall shape changes size.
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•	 Radius: A slider (available when a simple circle shape is selected) that controls the 
width and height of the shape. Click the disclosure triangle to reveal individual X (width) 
and Y (height) sliders.

•	 Size: A slider (available when a simple rectangle shape is selected) that controls the 
scale of the shape. Click the disclosure triangle to reveal individual Width and Height 
sliders.

•	 Shape Type: A pop-up menu (available when a complex shape with control points is 
selected) that sets the type of control points used to define the shape. For example, 
if you originally created a Bezier shape, you can choose B-Spline from this menu to 
change each Bezier control point into a B-Spline control point. Changing the shape 
type does not move the control points, although the shape is changed, sometimes 
dramatically. There are three options:

•	 Linear: All control points are joined by hard angles, and the resulting shape is a 
polygon. The control points of a Linear shape lie directly on its edges.

•	 Bezier: Control points can be a mix of Bezier curves and hard angles, creating any 
sort of shape. The control points of a Bezier shape lie directly on its edge.

•	 B-Spline: Control points are all B-Spline points, with different degrees of curvature. 
B-Spline control points lie inside, outside, or on the edge of the shape, and are 
connected by the B-Spline frame.

•	 Closed: A checkbox (available when a complex shape with control points is selected) 
that, when selected, connects the first and last points of an open shape. If you select 
a closed shape in the canvas, this checkbox is selected. Deselecting this checkbox 
disconnects the first and last points, converting the object into an open shape.

•	 Convert To Points: A button (available when a simple shape is selected) that, when 
clicked, converts a simple shape to a complex shape with editable control points. See 
Convert a shape or mask to control points.

Control Points controls
When a complex shape with control points is selected, this list becomes available, 
displaying the X and Y position parameters for the shape’s control points. The Control 
Points list also contains a single Animation menu (the down arrow that appears when you 
move the pointer over the right side of the Control Points heading row) that affects all 
the control points, letting you add keyframes, reset the shape’s animation, display the 
animation curve in the Keyframe Editor, and so on. For more information on using the 
Animation menu, see Animation menu controls. 
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Shape behaviors

Intro to Shape behaviors in Motion
Although you can animate shapes in your project by applying standard behaviors, a special 
category of behaviors is designed for use with shapes and their parameters. 

There are nine Shape behaviors:

•	 Apply Pen Pressure behavior maps stylus pressure to width, opacity, spacing, jitter, and 
other parameters when you draw a paint stroke with a Wacom tablet.

•	 Apply Pen Speed behavior maps stylus speed to width, opacity, spacing, jitter, and 
other parameters when you draw a paint stroke with a Wacom tablet.

•	 Apply Pen Tilt behavior maps stylus angle to width, opacity, spacing, jitter, and other 
parameters when you draw a paint stroke with a Wacom tablet.

•	 Oscillate Shape behavior animates a shape by cycling its control points between two 
values.

•	 Randomize Shape behavior animates a shape by applying a random offset to each 
control point.

•	 Sequence Paint behavior animates the individual dabs of a paint stroke in sequence 
over time.

•	 Track Points behavior pins the control points of a shape or mask to a moving clip or 
animated object.

•	 Wriggle Shape behavior animates a shape with an effect similar to the Randomize Shape 
behavior, but more slowly.

•	 Write On behavior draws a paint stroke or shape outline in the canvas over time.

You apply a Shape behavior the same way you apply standard behaviors to any object 
in Motion. And after you apply a Shape behavior, you can modify its parameters in the 
Behaviors Inspector to create highly customized animations.

Note: For general information about animating with behaviors, see Intro to behaviors.

Add a Shape behavior in Motion
Shape behaviors are applied like any other behavior in Motion.

Do one of the following:

•	 From the Behaviors section of the Library, drag a Shape behavior to a shape, mask, or 
paint stroke in the canvas, Layers list, or Timeline.

•	 Select a shape, mask, or paint stroke in the canvas, Layers list, or Timeline, then select 
a Shape behavior in the Library and click Apply in the preview area.

•	 Select a shape, mask, or paint stroke in the canvas, Layers list, or Timeline, then click 
Behaviors in the toolbar and choose a behavior from the Shape category.

Note: When you apply a Shape behavior to a simple shape (a shape without control 
points), a dialog appears asking if you want to convert the shape to a complex shape 
with control points.

The Shape behavior is applied to the shape, mask, or paint stroke.
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Apply Pen Pressure behavior in Motion
When you use a Wacom stylus and tablet to create paint strokes with the Paint Stroke tool, 
the Apply Pen Pressure behavior controls width, opacity, spacing, angle, or jitter of the 
stroke based on the pressure of your stylus on the tablet.

Note: These parameters are identical to the Pen Pressure parameters in the Advanced 
pane of the Shape Inspector. You can choose to use the Advanced pane parameters or this 
shape behavior to apply the pressure data to the paint stroke. You can use a combination 
of Pen Pressure parameters in the Advanced pane and Apply Pen Pressure behaviors to 
affect more than one parameter (such as Opacity, Width, or Jitter) of the stroke using the 
same pressure data.

You can adjust the Apply Pen Pressure behavior using the following controls in the 
Behaviors Inspector:

•	 Apply To: A pop-up menu that sets how your paint stroke is affected by pen pressure. 
There are five options:

•	 Width: Pen pressure affects the width of the stroke. The harder the pressure, the 
wider the stroke.

•	 Opacity: Pen pressure affects the opacity of the stroke. The harder the pressure, the 
more opaque the stroke.

•	 Spacing: The harder the pressure, the greater the spacing between stroke dabs.

•	 Angle: The harder the pressure, the greater the angle of the stroke dabs.

•	 Jitter: The harder the pressure, the larger the amount of jitter on the stroke. Jitter 
randomizes the position of the paint dabs so they appear more like particles.

•	 Min Pressure: A slider that adjusts the minimum threshold of pressure sensitivity. 
Pressure values below the minimum value are remapped to 0. For Opacity and Width, 
those remapped values do not appear. For Spacing, Angle, and Jitter, the values are 
not modified. If the Min Pressure and Max Pressure (described below) parameters are 
plotted on a graph, Min Pressure represents the minimum value, or 0. The area of the 
graph between Min Pressure and Max Pressure is remapped to the output values.

•	 Max Pressure: A slider that adjusts the maximum threshold of pressure sensitivity. 
Pressure values above the maximum value are remapped to 1. For Opacity, Width, 
Spacing, Angle, and Jitter, those values will have the greatest effect. If the Min Pressure 
and Max Pressures parameters are plotted on a graph, Max Pressure represents the 
maximum value, or 1. The area of the graph between Min Pressure and Max Pressure is 
remapped to the output values.

•	 Scale: A slider that sets the magnitude of the effect. The Scale slider defines the output 
range for the dabs based on the mapped values between minimum (0) and maximum 
(1) pressure, multiplied by the value defined in the slider (or adjacent value slider). This 
amount is then applied to the parameter (width, opacity, and so on) by multiplying (for 
width, opacity, spacing, and jitter) or adding (for angle). This control is independent of 
the Scale parameter in the Stroke pane of the Shape Inspector.

•	 Invert: A checkbox that, when selected, inverts the attributes of the stroke created by 
the behavior. For example, if pen pressure is set to affect the opacity of the stroke, 
transparent areas of the stroke become more opaque and opaque areas become more 
transparent when the checkbox is selected.
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Apply Pen Speed behavior in Motion
When you use a Wacom stylus and tablet to create paint strokes with the Paint Stroke tool, 
the Apply Pen Speed behavior controls the width, opacity, spacing, angle, or jitter of the 
paint stroke based on the speed of your stylus on the tablet. (A paint stroke created using 
a mouse or trackpad can also be affected by the Apply Pen Speed behavior.)

Note: In the Paint Stroke Tool HUD, you can select how the speed of the stylus affects the 
stroke before the stroke is created. Use the Pen Speed setting in the HUD in combination 
with a Pen Speed behavior to affect more than one parameter of the stroke (such as 
Opacity, Width, or Jitter) using the same pressure data. The Pen Speed parameter also 
appears in the Advanced pane of the Shape Inspector.

You can adjust the Apply Pen Speed behavior using the following controls in the Behaviors 
Inspector:

•	 Apply To: A pop-up menu that sets how your paint stroke is affected by pen speed. 
There are five options:

•	 Width: The faster you move the pen, the more narrow the stroke; the slower you 
move the pen, the wider the stroke.

•	 Opacity: The faster you move the pen, the less opaque the stroke.

•	 Spacing: The faster you move the pen, the greater the spacing between stroke dabs.

•	 Angle: The faster you move the pen, the greater the angle of the stroke dabs.

•	 Jitter: The faster you move the pen, the greater the amount of jitter on the stroke. 
Jitter randomizes the position of the paint dabs so they appear more like particles.

•	 Min Speed: A slider that adjusts the minimum threshold of speed sensitivity. Speed 
values below the minimum value are remapped to 0. For Opacity and Width, those 
values do not appear. For Spacing, Angle, and Jitter, the values are not modified. If the 
Min Speed and Max Speed (described below) parameters are plotted on a graph, Min 
Speed represents the minimum value, or 0. The area of the graph between Min Speed 
and Max Speed is remapped to the output values.

•	 Max Speed: A slider that adjusts the maximum threshold of speed sensitivity. Speed 
values above the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, 
and Jitter, those values will have the greatest effect. If the Min Speed and Max Speed 
parameters are plotted on a graph, Max Speed represents the maximum value, or 1. The 
area of the graph between Min Speed and Max Speed is remapped to the output values.

•	 Scale: A slider that determines the magnitude of the effect. The Scale slider defines 
the output range for the dabs based on the mapped values between minimum (0) and 
maximum (1) speed, multiplied by the value defined in the slider (or adjacent value 
slider). This amount is then applied to the channel (width, opacity, and so on) by 
multiplying (for width, opacity, spacing, and jitter) or adding (for angle). This control is 
independent of the Scale parameter in the Stroke pane of the Shape Inspector.

•	 Invert: A checkbox that, when selected, inverts the attributes of the stroke created by 
the behavior. For example, if pen speed is set to affect the width of the stroke, thin 
areas of the stroke become wide and wide areas become thin when the checkbox is 
selected.
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Apply Pen Tilt behavior in Motion
When you use a Wacom stylus and tablet to create paint strokes with the Paint Stroke tool, 
the Apply Pen Tilt behavior controls the width, opacity, spacing, angle, or jitter of the paint 
stroke based on the tilt of the pen.

Note: You can use a combination of Apply Pen Tilt shape behaviors to affect more than one 
parameter (such as Opacity, Width, or Jitter) of the stroke using the same tilt data.

You can adjust the Apply Pen Tilt behavior using the following controls in the Behaviors 
Inspector:

•	 Apply To: A pop-up menu that sets how your paint stroke is affected by the tilt of your 
pen as you draw. There are five options:

•	 Width: The tilt of the stylus affects the width of the stroke. The greater the tilt, the 
wider the stroke.

•	 Opacity: The tilt of the stylus affects the opacity of the stroke. The greater the tilt, 
the more opaque the stroke.

•	 Spacing: The greater the tilt of the stylus, the greater the spacing between stroke 
dabs.

•	 Angle: The greater the tilt of the stylus, the larger the value of the angle of the 
stroke.

•	 Jitter: The greater the tilt of the stylus, the larger the amount of jitter on the stroke. 
Jitter randomizes the position of the paint dabs so they appear more like particles.

•	 Calculate Tilt: A pop-up menu that sets how the tilt of the stylus affects the stroke. Pen 
tilt is measured on two axes: X and Y. X represents the stylus tilting to the right and left 
(toward the right or left side of the tablet); Y represents the stylus tilting up and down 
(toward the top or bottom of the tablet). There are five menu options:

•	 Absolute: Takes the maximum tilt from any axis.

•	 X Only: Measures the tilt only on the X axis.

•	 Y Only: Measures the tilt only on the Y axis.

•	 Axis: Makes the Tilt Axis parameter (described below) available.

•	 Polar: Uses the tilt of the stylus as if it were an angle. When viewed from above, the 
stylus points in a specific direction. That angle represents a polar value.

•	 Tilt Axis: A dial and value slider (available when Calculate Tilt is set to Axis) that defines 
the axis along which the tilt is measured.

•	 Min Tilt: Adjusts the minimum threshold of tilt sensitivity. Tilt values below the minimum 
value are remapped to 0. For Opacity and Width, those remapped values do not appear. 
For Spacing, Angle, and Jitter, the values are not modified. If the Min Tilt and Max Tilt 
parameters are plotted on a graph, Min Tilt represents the minimum value, or 0. The 
area of the graph between Min Tilt and Max Tilt is remapped to the output values.

•	 Max Tilt: A slider that adjusts the maximum threshold of tilt sensitivity. Tilt values above 
the maximum value are remapped to 1. For Opacity, Width, Spacing, Angle, and Jitter, 
those values will have the greatest effect. If the Min Tilt and Max Tilt parameters are 
plotted on a graph, Max Tilt represents the maximum value, or 1. The area of the graph 
between Min Tilt and Max Tilt is remapped to the output values.
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•	 Scale: A slider that determines the magnitude of the effect. The Scale slider defines 
the output range for the dabs based on the mapped values between minimum (0) and 
maximum (1) tilt, multiplied by the value defined in the slider (or adjacent value slider). 
This amount is then applied to the parameter (width, opacity, and so on) by multiplying 
(for width, opacity, spacing, and jitter) or adding (for angle). This control is independent 
of the Scale parameter in the Stroke pane of the Behaviors Inspector.

•	 Invert: A checkbox that, when selected, inverts the attributes of the stroke created by 
the behavior. For example, if pen tilt is set to affect the width of the stroke, thin areas of 
the stroke become wide and wide areas become thin when the checkbox is selected.

Oscillate Shape behavior in Motion
The Oscillate Shape behavior animates a shape by cycling its control points between 
two values. You can customize how wide apart the high and low values are, as well as 
the number of oscillations per minute. This behavior is useful for creating fluid shape 
movements that would be time-consuming to keyframe.

When the Oscillate Shape behavior is applied to a shape, all control points of the shape are 
affected by default. When the behavior is selected in the Layers list, affected control points 
are highlighted in white on the blue shape behavior spline. To disable control points, click 
the control points. A disabled point appears blue.

Note: When the Oscillate behavior is applied to a simple shape (without control points), a 
dialog appears asking if you want to convert the shape.

You can adjust the Oscillate behavior using the following controls in the Behaviors 
Inspector:

•	 Wave Shape: A pop-up menu that sets the shape of the oscillation’s wave. The options 
are Sine (default), Square, Sawtooth, and Triangle. For more information on wave 
shapes, see Oscillate behavior.

•	 Phase: A slider that adjusts the point of the specified oscillation where the behavior 
starts. Use this control to place multiple shapes with identical Oscillate behaviors out of 
phase with one another (so they don’t all look the same).

•	 Amplitude: A slider that adjusts the maximum values that the control points oscillate 
between. The control point swings between the amplitude value, and the negative of the 
amplitude value. Higher values result in more extreme swings from the beginning to the 
ending of each oscillation.

•	 Speed: A slider that adjusts the speed at which the oscillation occurs, in oscillations per 
minute. Higher values result in faster oscillations.

•	 Alternate Phase: A checkbox that, when selected, offsets the motion of each control 
point by a phase of 180 degrees from its neighboring control point.

•	 Oscillate Around: A pop-up menu that sets whether the oscillation for each vertex is 
generated from a point or a perpendicular line. There are two options:

•	 Point Origin: Each vertex’s oscillation is generated from a point. You can change the 
location of the point using the onscreen controls (dragging the small blue circle at 
the center of the shape) or using the X and Y Origin parameters in the Inspector.

•	 Line: Each vertex’s oscillation is generated from a line. You can change the location 
of the line using the onscreen controls (dragging the ends of the blue dotted line) or 
using the using the Start and End coordinates in the Inspector.
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Randomize Shape behavior in Motion
The Randomize Shape behavior animates the control points of a shape by applying a 
random offset to each point of the shape.

When the Randomize Shape behavior is applied to a shape, all control points of the shape 
are affected by default. When the behavior is selected, affected control points appear blue 
with white dots in the center of the point. To disable control points, click the control points. 
A disabled point is blue with a dark dot in its center.

Note: When you apply the Randomize Shape behavior to a simple shape (without control 
points), a dialog appears asking if you want to convert the shape.

You can adjust the Randomize Shape behavior using the following controls in the Behaviors 
Inspector:

•	 Amount: A slider (available when Apply Mode—described below—is set to Add, 
Subtract, or Add and Subtract) that defines the maximum value the Randomize behavior 
will generate.

•	 Multiplier: A slider (available when Apply Mode—described below—is set to Multiply) 
that defines the maximum value the Randomize behavior will generate.

•	 Apply To: A pop-up menu that defines where on the shape the behavior is applied. 
There are three options:

•	 Points: The control points of the shape are randomized, changing their position over 
the duration of the behavior.

•	 Tangents: The control points’ tangent handles (rather than the control points 
themselves) of the shape are randomized. The control points stay in a fixed position 
while the curves between the points are animated.

•	 Points and Tangents: Both the control points and handles are animated.
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•	 Apply Mode: A pop-up menu that determines how values generated by this behavior are 
combined with other behaviors and keyframes that affect the same parameter. There 
are four options:

•	 Add: Values generated by this behavior are added to other behaviors and keyframes 
that affect the same parameter.

•	 Subtract: Values generated by this behavior are subtracted from other behaviors and 
keyframes that affect the same parameter.

•	 Multiply: Values generated by this behavior are multiplied by other behaviors and 
keyframes that affect the same parameter.

•	 Add and Subtract: Values generated by this behavior are added to and subtracted 
from other behaviors and keyframes that affect the same parameter.

•	 Frequency: A slider that lets you adjust the amount of random variation per second. 
Higher values generate faster variations, whereas lower values generate slower 
variations.

•	 Noisiness: A slider that adds an additional overlay of random variance to the Frequency 
you’ve set. Higher Noisiness values result in more erratic variations in the affected 
parameter.

•	 Link: A checkbox, available when you apply this behavior to a two-dimensional 
parameter (such as Distort) or three-dimensional parameter (such as Position or 
Rotation), that consists of X, Y, or Z values. Select this checkbox if you want the 
transformation applied to the X and Y vertices to be the same. For instance, a +10 
change to X will result in an identical +10 change to Y.

•	 Preserve Angle: A checkbox that, when selected, causes the tangent handles become 
(or remain) flat, maintaining the continuity of the curves.

•	 Random Seed: A button to select a new random seed number. This number is used to 
randomly generate new sequences of values, based on the other parameters of this 
behavior.

Sequence Paint behavior in Motion
The Sequence Paint behavior animates the individual dabs of a paint stroke in sequence 
over time. This is the only way to animate the dabs individually—keyframing the stroke 
parameters or applying other behaviors affects all dabs in the stroke uniformly.

The Sequence Paint behavior is very similar to the Sequence Text and Sequence Replicator 
behaviors, which allow you to animate the Rotation, Color, Opacity, Scale, and Position 
parameters in sequence through the characters of a text layer or the elements of a 
replicator pattern. The Sequence Paint behavior adds Width to that list of parameters, 
allowing you to create sequenced animation through the dabs of a paint stroke.

For an example of using a sequence behavior, see Apply the Sequence Replicator behavior.
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Before any sequencing animation can occur, you must add at least one parameter to 
the behavior in the Inspector, then set a value for that parameter. Until a parameter is 
added, adjustments in the Inspector or HUD have no effect. You can add parameters to 
the Sequence Paint behavior and adjust the behavior using the following controls in the 
Behaviors Inspector:

•	 Parameter: Add and Remove pop-up menus that add and remove parameters to the 
sequence. After you add the parameter, additional controls appear in the Behaviors 
Inspector (above the Add and Remove pop-up menus). Adjust those controls to create a 
sequence animation based on the difference between the original value of the dabs and 
the modified value. There are six menu options:

•	 Rotation: Specifies (in degrees) the rotation of the stroke dabs. You can rotate 
the dial or use the value slider. Click the disclosure triangle next to the Rotation 
parameter to reveal separate X, Y, and Z Rotation controls.

•	 Color: Specifies a color to tint the stroke dabs. You can click the color well to choose 
a color, or open the disclosure triangle and use the Red, Green, and Blue sliders.

•	 Opacity: Defines the opacity of the stroke dabs. Set a new value using the slider.

•	 Scale: Defines the scale of the stroke dabs. Click the disclosure triangle next to the 
Scale parameter to reveal separate X Scaling and Y Scaling subparameters to adjust 
the width and height of the dabs separately. By default, Scale is set to 100%—the 
size of the stroke dabs is equal to the original size defined in the stroke parameters.

•	 Width: Defines the width of the dabs. Unlike Scale, Width adjustments alter the size 
of the dab while also maintaining the spacing between each dab. Set a new value 
using the slider.

•	 Position: Defines the offset of the dabs from their original position. Click the 
disclosure triangle next to the Position parameter to reveal separate X, Y, and Z 
Position subparameters. For example, to create an animation in which the dabs move 
upward in the Y axis over the paint stroke, enter a positive value in the Y Position 
field.

•	 Sequencing: A pop-up menu that specifies how the sequence animation (the value 
change from the original parameter value to the value set in the Sequence Paint 
parameters) moves through the dabs of the stroke. The starting point for the sequence 
animation is based on the first control point of the paint stroke. (To change the start 
point of the shape, select the shape, click and hold the transform tools in the canvas 
toolbar and choose Edit Points, then Control-click a control point in the canvas and 
choose Set Start Point from the shortcut menu.) There are five Sequencing options:

•	 To: The animation begins at the original value of the dabs and moves to the value 
set in the Sequence Paint behavior for that parameter. For example, if the original 
opacity value of a stroke is 100%, and opacity is set to 0% in the Sequence Paint 
parameters, the dabs begin completely opaque and become completely transparent.

•	 From: The animation moves from the value set in the Sequence Paint behavior to 
the original value of the stroke. For example, if the original opacity value of a stroke 
is 100%, and opacity is set to 0% in the Sequence Paint parameters, the dabs begin 
completely transparent and become completely opaque. This is the opposite of the 
To Sequencing option.
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•	 Through: The sequence goes through a full animation cycle starting at the original 
value of the stroke, moving to the value set in the Sequence Paint behavior, then 
returning to the original value of the stroke. For example, if the original opacity value 
of a stroke dab is 100%, and opacity is set to 0% in the Sequence Paint parameters, 
the dabs begin completely opaque, become transparent, and then become 
completely opaque again.

•	 Through Inverted: The sequence goes through an inverted animation cycle starting 
from the value set in the Sequence Paint behavior, moving to the original value 
of the stroke, then returning to the value set in the Sequence Paint behavior. For 
example, if the original opacity value of a stroke is 100%, and opacity is set to 0% 
in the Sequence Paint parameters, the dabs begin completely transparent, become 
opaque, and then become completely transparent. This is the opposite of the 
Through option. 

•	 From Keyframes: Lets you keyframe how the animation moves through the values set 
in the Sequence Paint parameters over a stroke. Each dab undergoes the same value 
sequence. When Custom is selected, added parameters must be animated to yield 
any effect.

•	 Unit Size: A pop-up menu that specifies whether the sequence animation is applied 
to the stroke as a whole, to its individual dabs, or to a custom range. There are three 
options:

•	 Dab: Applies the sequence animation over each dab as its own entity. Dab is the 
default setting.

•	 All: Applies the sequence animation to all stroke dabs simultaneously.

•	 Custom: Lets you specify the percentage of dabs on the stroke affected by the 
sequence animation at once. Although you can create keyframes for the Custom 
option, it’s not required to affect the sequence. Use Custom to define an area of 
dabs affected by the sequence.

•	 Start: A slider (available when Unit Size is set to Custom) that sets the starting point for 
the dabs on the stroke affected by the animation.

•	 End: A slider (available when Unit Size is set to Custom) that sets the ending point for 
the dabs on the stroke affected by the animation.

•	 Spread: A slider that, when increased, creates a softer transition between dabs. (This 
parameter control is not available when Unit Size is set to All.)

•	 Traversal: A pop-up menu that sets the action of the sequence behavior to any of the 
following options:

•	 Constant Speed: Moves the animation from the origin of the paint stroke through the 
end of the stroke at a constant speed.

•	 Ease In: The sequence animation begins slowly and increases to normal speed as it 
moves through the paint stroke.

•	 Ease Out: The sequence animation begins at normal speed and slows toward the end 
of the paint stroke.

•	 Ease In/Out: The sequence animation begins slowly, increases to normal speed as it 
moves toward the middle of the stroke, and slows as it reaches the end of the paint 
stroke.

•	 Accelerate: The sequence animation increases in speed.
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•	 Decelerate: The sequence animation decreases in speed.

•	 Custom: Lets you keyframe how the animation moves through the paint stroke. 

•	 Loops: A slider that sets the number of times the animation sequences through the 
paint stroke over its duration.

Note: Loops is not available when Traversal is set to Custom.

•	 Location: A slider (available when Traversal is set to Custom) that defines the location 
of the stroke where the animation is in effect.

For more information on using the Custom Traversal option, see Control sequence 
timing with keyframes.

•	 End Condition: A pop-up menu that determines how the sequence animation is repeated 
over the duration of the sequence behavior. This parameter has no effect for Loop 
values less than or equal to 1. The End Condition options are:

•	 Hold: Completes the sequence animation cycle one time, then starts it over again 
from the beginning (after the last dab in the sequence has completed its animation).

•	 Wrap: Treats the sequence animation as a continuous loop so the spread wraps from 
the last dab in the sequence to the first dab.

•	 Ping Pong: Completes the sequence animation cycle forward, then completes the 
animation backward, then forward, and so on.

Track Points behavior in Motion
This behavior lets you track the control points of a shape or mask to a moving clip or 
animated object, or to apply existing tracking data to a shape or mask. For information on 
using the Track Points behavior, see Track shapes, masks, and paint strokes.

Wriggle Shape behavior in Motion
This behavior works similarly to the Randomize behavior, but with a slower effect.

When you apply the Wriggle Shape behavior to a shape, all control points of the shape are 
affected by default. When you select the behavior in the Layers list, affected control points 
in the canvas appear blue with a white center. To disable control points, click the control 
points. A disabled point in the canvas appears blue with a dark center. 

Note: When you apply the Randomize Shape behavior to a simple shape (without control 
points), a dialog appears asking if you want to convert the shape.

Y
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ou can adjust the Wriggle Shape behavior using the following controls in the Behaviors 
Inspector:

•	 Amount A slider (available when Apply Mode—described below—is set to Add, Subtract, 
or Add and Subtract) that defines the maximum value the Wriggle behavior generates. 

•	 Multiplier: A slider (available when Apply Mode—described below—is set to Multiplier) 
that defines the maximum value the Wriggle behavior generates.

•	 Apply To: A pop-up menu that defines where on the shape the behavior is applied. 
There are three options:

•	 Points: The control points of the shape are wriggled, changing their position over the 
duration of the behavior.

•	 Tangents: The control points’ tangent handles (rather than the control points) are 
wriggled. The control points stay in a fixed position while the curves between the 
points are animated.

•	 Points and Tangents: Both the control points and tangent handles are animated.

•	 Apply Mode: A pop-up menu that determines how values generated by this behavior 
are combined with other behaviors and keyframes that affect the same parameter. 
This provides you with different ways of using a Wriggle behavior to modify a vertex’s 
preexisting values. There are four options:

•	 Add: Values generated by this behavior are added to other behaviors and keyframes 
that affect the same parameter.

•	 Subtract: Values generated by this behavior are subtracted from other behaviors and 
keyframes that affect the same parameter.

•	 Multiply: Values generated by this behavior are multiplied by other behaviors and 
keyframes that affect the same parameter.

•	 Add and Subtract: Values generated by this behavior are added to and subtracted 
from other behaviors and keyframes that affect the same parameter.

•	 Frequency: A slider that sets the amount of random variation per second. Higher values 
generate faster variations, whereas lower values generate slower variations.

•	 Wriggle Offset: A slider that offsets the sequence of random values when you want to 
apply the same Wriggle behavior to multiple shapes. By offsetting each shape’s version 
of the Wriggle behavior, you can prevent them from moving in sync.

•	 Noisiness: A slider that adds an additional overlay of random variance to the Frequency 
you’ve set. Higher Noisiness values result in more erratic variations in the affected 
vertices.

•	 Link: A checkbox available when you apply this behavior to a two-dimensional 
parameter (such as Distort) or three-dimensional parameter (such as Position or 
Rotation) that consists of X, Y, or Z values. Select this checkbox to keep the behavior’s 
effect on each value proportional.

•	 Preserve Angle: A checkbox that, when selected, causes the tangent handles to 
become (or remain) flat, maintaining the continuity of the curves.

•	 Random Seed: A button to pick a new random seed number. This number is used to 
generate new sequences of values, based on the other parameters of this behavior.
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Write On behavior in Motion
The Write On behavior provides a quick way to draw a paint stroke or outline on the canvas 
over time. Write On lets you create a handwritten text effect, build the ever-popular old-
time serial travel map effect, create a hand-sketched alpha mask for a transition or reveal, 
and so on. The Write On behavior can be applied to a paint stroke created with the Paint 
Stroke tool or added to an existing shape.

You set the animation effect to draw, erase, draw and erase, draw in reverse, and so on, 
over time. When you apply Write On to a filled shape with an outline, only the outline of the 
shape is drawn.

You can adjust the Write On Shape behavior using the following controls in the Behaviors 
Inspector:

•	 Shape Outline: A pop-up menu that sets whether the stroke is drawn, erased, or drawn 
and erased. Choose one of the following menu items:

•	 Draw: The stroke is drawn over the duration of the behavior.

•	 Erase: The stroke is completely drawn at the beginning of the behavior and is erased 
over the duration of the behavior.

•	 Draw and Erase: The stroke is drawn, then erased over the duration of the behavior.

•	 Erase and Draw: The stroke is completely drawn at the beginning of the behavior, is 
erased, then is drawn again.

•	 Stroke Length: A slider that defines the length as a percentage of the drawn or erased 
stroke. A value of 100% uses the entire length of the stroke, bounded by the First Point 
Offset and Last Point Offset parameters. If Stroke Length is set to 50%, when 50% of 
the stroke is drawn on, it begins to erase (from the beginning of the stroke) so only half 
of the length of the stroke is ever displayed over the duration of the behavior.

•	 Stroke Offset: A slider that offsets where the stroke begins on the shape. The value is 
expressed as a percentage of the total length of the shape from the start point defined 
on the shape.

•	 Direction: A pop-up menu that sets the direction in which the stroke is drawn. There are 
two options:

•	 Forward: The stroke is drawn in a forward direction.

•	 Reverse: The stroke is drawn in reverse.

•	 Speed: A pop-up menu that defines the stroke’s “draw-on” velocity from the first to the 
last point in the stroke. There are nine options:

•	 Constant: The stroke is drawn at a steady speed from the first to the last point in the 
stroke.

•	 Ease In: The drawing of the stroke starts at a slow speed, then reaches and 
maintains a steady speed through the last point on the stroke.

•	 Ease Out: The drawing of the stroke starts at a steady speed, then slows down as it 
gradually decelerates to a stop at the last point of the stroke.

•	 Ease Both: The drawing of the stroke slowly accelerates from the first point on the 
stroke, and then slows down as it gradually decelerates to a stop at the last point of 
the stroke.

•	 Accelerate: The stroke is drawn with increasing speed.
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•	 Decelerate: The stroke is drawn with decreasing speed.

•	 Natural: The speed at which the stroke is drawn along the path is determined by the 
shape of the path. For example, if the stroke is a U-shape curve, the stroke is drawn 
along more quickly as it moves toward the low point of the U, and more slowly as it 
moves up the edges.

•	 Recorded: This option appears only if there’s a recorded time over which the stroke 
was drawn. In other words, if a shape is converted to a paint stroke, this option does 
not appear. If the paint stroke is created with the Paint Stroke tool in the toolbar 
(using a stylus or mouse), this option does appear.

•	 Custom: Lets you draw the stroke along its path by setting keyframes for the stroke’s 
speed from 0 to 100%. In other words, you determine which portion of the stroke is 
drawn along its path in time.

•	 Custom Speed: A slider that becomes available when Speed is set to Custom. You can 
modify the Custom Speed velocity curve in the Keyframe Editor. For example, you can 
keyframe custom values to draw a stroke forward to a specific percentage of its path, 
then backward, then forward, and so on before it reaches the end of the animation.

•	 End Offset: A slider that offsets the end of the behavior inward from the defined Out 
point and holds the last value. In other words, it offsets the visible paint stroke from the 
end of the path of the stroke.

Keyframe shape control points in Motion
You can keyframe the control points of a shape. When you do so, the changes are recorded 
to the Shape Animation parameter, visible in the Keyframe Editor. Keyframes added to the 
animation parameter affect all the shape’s control points simultaneously.

The process used to animate both masks and shapes is identical. To see an example of 
mask animation, see Rotoscope a mask’s shape. For more information on keyframing in 
general, see Intro to keyframing.
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Keyframe a shape’s control points
1.	 In the Layers list, canvas, or Timeline in Motion, select a shape.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose Edit 
Points.

The selected shape’s control points appear in the canvas.

3.	 Click the Record button in the timing toolbar (or press A) to turn on keyframe recording.

4.	 Move the playhead to the frame where you want to change the shape, then make any 
necessary changes to the shape’s control points by dragging them in the canvas or by 
adjusting the Control Points controls in the Geometry pane of the Shape Inspector.
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In the Keyframe Editor (press Command-8 to open it), a keyframe appears for each 
adjustment you make at a new frame.

Note: Adjusting a shape while the playhead is on an existing keyframe adjusts the shape 
at that keyframe.

5.	 Continue advancing frames and making changes.

Every time you make a change to the shape at a new frame, you create a keyframe in 
that shape’s animation channel.

6.	 When you’re done animating the shape, click the Record button in the timing toolbar to 
turn off keyframe recording.

The animated shape object interpolates between each keyframed shape. If you don’t 
like how the interpolation is working, you can add more keyframes to force the control 
points to follow the path you want.

In the Keyframe Editor, you can also create, delete, and edit the timing of keyframes in the 
shape’s animation parameter. For simplicity, each change you make to a shape is recorded 
as a single keyframe, no matter how many control points are edited. The shape’s animation 
parameter allows only keyframes set to linear interpolation. You cannot use any other form 
of keyframe interpolation. 
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Work with masks and transparency

Intro to masks and transparency in Motion
Masks are a special type of shape used to create regions of transparency in layers. When 
you create a mask to define transparency in a layer, you’re drawing a shape to use as that 
layer’s alpha channel. (For more information about drawing shapes and masks, see Draw 
simple masks and Draw complex shapes and masks.) Because a layer’s alpha channel 
is a grayscale channel, masks are grayscale objects, where white defines solid areas, 
progressively darker levels of gray define decreasingly opaque areas, and black defines 
areas of complete transparency.

You can apply masks to layers that already have an alpha channel to add to, subtract from, 
intersect, or replace the layer’s original alpha channel. You can also use another layer as an 
image mask to mask a layer. See Intro to image masks.

This section describes how to:

•	 Mask a layer, then adjust the mask

•	 Mask layers in a 3D project

•	 Combine multiple masks to isolate complex contours

•	 Apply filters or behaviors to masks

•	 Use masks for rotoscope animation

•	 Make advanced adjustments to masks in the Mask Inspector

•	 Use an image to mask a layer

Important: When a mask is applied to a 2D group or a flattened 3D group, the group is 
rasterized. See How rasterization affects shapes.
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Mask a layer in Motion
You can add a mask to any image layer in a Motion project. After you add the mask, you 
can fine-tune its effect.

Add a mask to a layer
1.	 In Motion, select a layer in the Layers list or canvas.

2.	 In the canvas toolbar, click and hold the mask tools pop-up menu, then choose a mask 
tool (Rectangle Mask, Circle Mask, Freehand Mask, Bezier Mask, or B-Spline Mask).

Note: If you haven’t selected a layer, the mask tools are not available.

3.	 Do any of the following, based on the mask tool you chose in step 2:

•	 Rectangle Mask tool or Circle Mask tool: Drag in the canvas to create a simple 
rectangular or elliptical shape mask.

•	 Freehand Mask tool: Drag in the canvas to draw a complex shape with Bezier control 
points. To close the mask shape, join the end of the shape outline to the target circle 
at the beginning of the outline. If you don’t reach the beginning of the outline, the 
mask shape is closed when you lift the stylus or release the mouse button.

•	 Bezier Mask tool or B-Spline Mask tool: Click in the canvas to add control points to 
create a complex shape with Bezier or B-Spline control points. To close the mask 
shape, click the first point you made in the shape outline (or press C, or press 
Return, or double-click).

 Tip: Turn off snapping to prevent your mask control points from aligning with 
unwanted elements. Press the N key to turn snapping on or off.

For more information about how to draw masks, see Draw simple masks and Draw 
complex shapes and masks.
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The example below uses a Bezier Mask tool. 

Note: Unlike standard shapes, masks are always closed.

After you finish drawing the mask, the following happens: 

•	 In the Layers list, the mask object you created appears nested underneath the layer 
it’s applied to.

•	 In the canvas, the region of the layer outside the shape becomes transparent, in 
effect cutting out the background of the layer. In the example below, the black area 
is the canvas background showing through the transparent region of the fish layer. 

 Tip: You can turn the effect of the mask on or off while fine-tuning the mask. See 
“Show or hide the effect of a mask,” below. 



876Motion User Guide

Show or hide the effect of a mask
When a mask is attached to a layer, a mask icon appears in the Layers list and Timeline, to 
the right of the name of the layer.

•	 In the Layers list or Timeline in Motion, click the mask icon to turn the mask effect on or 
off.

View the alpha channel created by the mask in the canvas
Masks apply an alpha channel (transparency) to a layer. You can view the alpha channel as 
a grayscale shape, isolating it for further modification. 

•	 In Motion, choose View > Channels > Alpha (or press Shift-A).

The alpha channel created by the mask is displayed in the canvas. To return to color 
view, choose View > Channels > Color (or press Shift-C).

Feather the edges of a mask
You can soften the edges of a mask (feathering) by a few pixels to make the masked object 
blend more seamlessly with a background. Feathering a mask by larger amounts creates 
progressively softer edges for various design purposes.

1.	 In Motion, select a mask in the Layers list.

2.	 Do one of the following:

•	 In the Mask Inspector, drag the Feather slider to the right to feather the mask 
outward or to the left to feather the mask inward.

•	 If the mask is a simple Rectangle Mask or Circle Mask, drag the outer edge of the 
mask inward or outward in the canvas.
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Mask a layer in a 3D project
When working in a 3D project, you might want to mask a layer that’s already angled in 3D 
space. You can immediately switch an angled object into a “work view” using the Isolate 
command. After you add a camera to a project, the Isolate option becomes available for 
any layer, group, or camera in the project. For more information about cameras, see Add a 
camera.

Note: You cannot manipulate masks in 3D space.

1.	 In a 3D project in Motion, select the layer to mask. 

2.	 In the Layers list, click the Isolate button (to the right of the layer name) or choose 
Object > Isolate.

Note: A project must contain a camera or a light before you can access the Isolate 
option. See Add a camera or Add lights.

The layer is switched into “work view,” allowing you to mask the layer at its original 
orientation.

3.	 To return to your previous view (the view before you isolated the layer), click the Isolate 
button again.

Note: Clicking a camera’s Isolate button activates that camera’s view.

Add a mask to a 3D group
You can apply masks to the layers in a 3D group, but not the 3D group itself—unless you 
flatten the 3D group).

1.	 Select a 3D group in your Motion project.

2.	 In the Group Inspector, select the Flatten checkbox.

3.	 Apply a mask to the group. 
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Combining multiple masks in Motion
Often you may find that it’s impossible to create the mask shape you need using only a 
single mask. For example, when masking an image that has a hole in it, you need at least 
two masks—one with its blend mode set to Add (to mask the overall object), and a second 
one with its blend mode set to Subtract (to cut the necessary hole in the middle of the 
image). In the following example, the only way to mask the space between the diver’s arms 
and legs is to create three overlapping masks, two with blend modes set to Subtract.

Multiple masks are also useful when you need to mask an image with complex contours or 
when you’re rotoscoping an object with multiple moving parts. See Rotoscope a mask’s 
shape.

Whatever the reason, you can easily combine multiple masks for any object by adjusting 
each mask’s Mask Blend Mode parameter in the Mask Inspector.

Each mask’s blend mode determines whether the mask adds to, subtracts from, or replaces 
a layer’s previously existing alpha channel. Additionally, blend modes affect how masks 
interact with one another. Ultimately, every mask applied to a layer combines according to 
the specified blend modes to create that layer’s final alpha channel. 

Blend mode operations are also determined by the order of each mask in the Layers list, 
particularly with the Replace and Intersect blend modes. For example, a mask set to 
Intersect affects all masks nested underneath it in the Layers list, masking only the areas 
of the layer where the masks overlap one another. Similarly, a mask set to Replace mode 
effectively turns off any masks beneath it in the Layers list (including the image layer’s 
built-in alpha channel, if one exists).

For more information on mask blend modes, see Mask controls in the Inspector.
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Applying filters or behaviors to masks in Motion
You can apply filters and behaviors to masks. Masks remain editable even after the 
application of a filter or mask.

Filters and masks
Applying a filter to a mask is an extremely powerful way to further manipulate the alpha 
channel created by a mask. For example, you can apply the Crystallize filter to a mask to 
add stylized, jagged edges that resemble facets of crystal.

When you apply a filter to a mask, it’s useful to bear in mind that a mask is just a grayscale 
image. In the example above, the Crystallize filter creates patterns in the grayscale mask 
image, which results in a rippled translucent pattern.

You apply a filter to a mask the same way you apply a filter to any other layer in your 
project. See Apply or remove filters. 

Behaviors and masks
When you apply a behavior to a mask, the mask is animated like any other layer. However, 
because the mask affects only the transparency in a layer, and not the position, rotation, or 
scale of the layer, the result is similar to that of a “traveling matte,” where the mask moves 
in the layer it’s applied to, hiding and showing different areas of the image as it moves.

You apply a behavior to a mask the same way you apply a behavior to any other layer in 
your project. See Intro to applying behaviors. 
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Use keyframes to rotoscope a mask

Rotoscope a mask’s shape in Motion

You can keyframe a mask’s control points to animate a changing shape over time. For 
example, you can animate a subtractive mask to change the shape of a hole in a foreground 
object, allowing other layers in the background to show through.

A more conventional use of animated masks is to rotoscope a foreground subject. 
Rotoscoping is the process of manually tracing a foreground subject to isolate it from 
the background. The result is similar to a blue screen or green screen effect. Why would 
you bother? In a wide variety of situations, keying is impractical or impossible if the shot 
wasn’t well planned. Even for shots where keying is possible, manual rotoscoping is often 
necessary to create garbage masks or holdout masks to improve the effect. (See Crop 
background with a garbage mask and Restore foreground with a holdout mask.)

The following task demonstrates how to use a mask to isolate an object in a clip in order to 
apply separate effects to the isolated object and its background.

The process used to animate both masks and shapes is identical. To see an example of 
shape animation, see Keyframe shape control points. For more information on keyframing 
in general, see Intro to keyframing.
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Rotoscope a subject by animating a mask
1.	 In Motion, choose View > Resolution > Full to ensure that you’re viewing the canvas at 

full resolution.

Important: If the canvas resolution is not set to full, the outlines of objects and 
images may shift slightly. As a result, masks created to trace a subject at less than full 
resolution may not be accurate.

2.	 Move the playhead to the first frame where the mask animation should begin, then draw 
a mask that accurately isolates the subject.

For details on how to draw a complex mask, see Draw complex shapes and masks.

3.	 When you’re finished drawing the first mask, click the Record button in the timing 
toolbar (or press A) to turn on keyframe recording.

4.	 Move to the first frame of the Timeline where you want to change the shape of the 
mask, then drag the mask’s control points in the canvas.

Note: If the mask is deselected, you must select it in the Layers list so its control points 
become visible in the canvas. Make sure that the Show/Hide Masks button is selected in 
the Layers list so masks are visible.

5.	 Continue moving the playhead and dragging control points.

One imprecise method is to move to the frame that’s halfway between any two 
keyframed mask shapes and make new adjustments. Continue keyframing shape 
changes at the halfway point between every two keyframes until the mask accurately 
follows the motion of the subject. For irregularly shaped objects or objects with 
complex motion, don’t be surprised if you need to add a large number of keyframes. 
Nobody ever said that rotoscoping was fast!

Every time you move the playhead to a new frame and make a change to the mask’s 
shape, a keyframe is created in that shape’s Shape Animation channel in the Keyframe 
Editor. If you move the playhead directly on top of a previously existing keyframe, you 
change the mask’s shape at that point without creating a keyframe.

6.	 When you’ve finished animating the mask, click the Record button again (or press A) to 
turn off keyframe recording.
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Rotoscoping tips in Motion

Use the following guidelines when rotoscoping:

•	 Find the frame with the most detail showing in the subject you’re masking and use 
that as your starting frame. For example, if you’re masking someone walking, choose a 
frame where that person’s arms and legs are extended in mid-stride. Doing so lets you 
specify how many control points to start with. Using as few control points to achieve the 
necessary level of detail in your mask simplifies the animation process.

•	 Use as few control points to achieve the necessary level of detail in your mask.

•	 Animated masks trigger the same motion blur as any other keyframed parameter in 
Motion. For example, if you animate a layer’s position so it moves really fast, the layer 
is blurred when you enable motion blur. If you animate a layer’s mask so it also moves 
fast, the edges of the mask are blurred as well. This is important because an animated 
mask’s blur should match any blur present in the foreground subject.

•	 When rotoscoping a moving subject, it’s a good idea to play the clip and examine its 
direction and speed to get a sense of how the mask must be animated. You may find it 
helpful to place markers indicating frames where the subject or camera stops, changes 
direction, or changes speed, because these are likely candidates for your first pass 
of keyframed mask changes. By noting these changes, you can attempt to reduce the 
amount of keyframing by making your first keyframed mask shape adjustments at these 
major changes in speed and direction. Because animated masks are interpolated to 
change from one keyframed shape to another, you can let Motion do some of your work 
for you.

•	 All mask animation is stored in the Shape Animation channel in the Keyframe Editor. 
There, you can create, delete, and edit the timing of a mask’s Shape Animation channel 
keyframes. For simplicity, each change you make to a mask is recorded as a single 
keyframe, no matter how many control points you edited. The Shape Animation channel 
allows only keyframes set to Constant—you cannot use any other form of keyframe 
interpolation.

•	 It may not be necessary to rotoscope an entire subject with a single mask. Motion lets 
you apply multiple masks to a single object, so you can rotoscope different parts of a 
subject with separate masks. See Combining multiple masks.

•	 To pan the image while rotoscoping, press and hold the Space bar while dragging in the 
canvas. This lets you modify your view without losing your mask selection or progress.

•	 Use the Track Points behavior to apply tracking data to a shape or mask. See Track 
shapes, masks, and paint strokes.
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Mask controls in the Inspector in Motion
A selected mask’s parameters appear in the Mask Inspector. These controls allow you to 
adjust how the mask is drawn, how each mask operates upon an object, and how masks are 
combined with one another. The Mask Inspector also lets you fine-tune mask control point 
positions.

The Mask Inspector contains the following adjustable controls:

Mask Controls
•	 Roundness: A slider (available when a simple rectangle mask, Bezier mask, or B-Spline 

mask is selected) that adjusts the roundness of mask corners. Use this control to create 
rounded rectangles or to smooth the edges of a mask.

•	 Preserve Scale: A checkbox (available when a simple rectangle mask, Bezier mask, or 
B-Spline mask is selected) that controls whether the Roundness setting is absolute or 
relative to the overall mask size. When the checkbox is selected, the roundness remains 
at the same approximate percentage of curvature as the object is scaled. When the 
checkbox is deselected, the curvature varies as the overall mask changes size.

•	 Curvature: A slider (available when a simple circle mask is selected) that adjusts the 
degree of curvature of the circle. When set to 100 percent, the mask is elliptical. When 
set to 0 percent, the mask is a rectangular.

•	 Radius: A slider (available when a simple circle mask is selected) that controls the width 
(X) and height (Y) of the mask. Click the disclosure triangle to reveal individual X and Y 
sliders.

•	 Size: A slider (available when a simple rectangle mask is selected) that controls the size 
of the mask. Click the disclosure triangle to reveal individual Width and Height sliders.

•	 Shape Type: A pop-up menu (available only for complex shapes) that sets the type of 
control points used to define the mask. For example, if you originally created a Bezier 
mask, you can choose B-Spline from this menu to change how the mask is drawn. 
Changing the shape type might dramatically change the mask’s form even though its 
control points remain fixed at their original coordinates. There are three options:

•	 Linear: All of a mask’s control points are joined by hard angles, and the resulting 
mask is a polygon. The control points of a Linear mask lie directly on its edge.

•	 Bezier: Control points can be a mix of Bezier curves and hard angles, creating any 
sort of mask. The control points of a Bezier mask lie directly on its edge.

•	 B-Spline: Control points are all B-Spline points, with different degrees of curvature. 
B-Spline control points lie outside the surface of the mask, but are connected by the 
B-Spline frame.

Note: You can hide the B-Spline frame by deselecting the Lines menu item in the 
View pop-up menu above the canvas.
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•	 Mask Blend Mode: A pop-up menu that determines how a mask interacts with the 
alpha channel of the layer to which it’s applied. When a layer has multiple masks, each 
mask can have a different Mask Blend Mode. When this happens, each mask adds to, 
or subtracts from, the layer’s alpha channel according to the selected mode. The final 
alpha channel is the combined result of all masks applied. There are four menu options:

•	 Add: Removes all pixels from areas outside the mask shape. Each new mask adds 
more transparency, letting more of the underlying image show through. The Add 
blend mode (the default for new masks) is useful for adding back regions of an image 
that other masks are cutting out or when masking multiple areas that do not intersect 
in a single image. In the following example, both the rectangle and circle masks 
remove areas outside of the mask shapes, revealing the underlying black canvas.

If the layer contains an alpha channel, a mask set to Add mode reveals only the 
masked section of the original alpha channel.

Note: To display the rest of a masked layer so you can trace it to create a second 
mask, turn off the first mask in the Layers list or Timeline. The outline of the first 
mask remains visible, even though it’s no longer affecting the layer’s transparency.

•	 Subtract: Removes all pixels from the area inside the mask shape, effectively 
punching a hole in the image. In the following example, the rectangle and circle masks 
punch a hole through the blue gradient object, revealing the underlying black canvas.
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•	 Replace: Completely replaces the image object’s alpha channel as well as any other 
masks that appear beneath the mask in the Layers list. In the following example, the 
circle mask overrides the rectangle mask, because the circle mask (set to Replace) 
appears above the rectangle mask in the Layers list. See Combining multiple masks.

•	 Intersect: Shows pixels only in regions where masks overlap. In the following 
example, only the overlapping areas of the rectangle and circle masks are visible.

In another example, if you import a TIFF file with an alpha channel and you want to 
cut out part of it without losing alpha information, you must use the Intersect blend 
mode. This is also true for layers with keying filters applied.
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•	 Invert Mask: A checkbox that, when selected, reverses the mask—swapping its solid 
and transparent areas. This is useful if you need to switch the solid and transparent 
areas of an existing mask.

 Tip: You can apply different filters and effects to the foreground and background of 
an image by first masking the foreground subject, duplicating the layer and its mask, 
then inverting the duplicate layer’s mask. Effects applied to the background can then be 
completely isolated from the foreground, or vice versa. You can adjust the opacity of a 
mask in the Properties Inspector.

•	 Feather: A slider that softens the edges of a mask. Positive feathering values soften the 
edge of the mask from its edge outward. Negative feathering values soften the edge 
of a mask inward from the edge. Feathering the edge of a mask can soften a harsh 
rotoscoping job, making the masked object blend more easily with the background.

•	 Falloff: A slider that controls how “steep” the feathering is. Higher values result in 
feathering that’s pushed farther inward, so the edge of the feathering effect is more 
transparent. Lower values result in the “core” of the feathering effect being pushed 
farther outward, so the edge of the feathering effect is less transparent.

•	 Fixed Feather: A checkbox that controls feathering when a mask is scaled using the 
Scale parameter in the Properties Inspector (or using the 2D or 3D Transform tools in 
the canvas).

•	 Set the feather to ignore scaling: Turn the checkbox on. Feathering is applied after 
the mask is scaled, so scaling only affects the mask (not the feathered edge). If you 
adjust the scale disproportionately, the feathering remains constant.

•	 Set the feather to scale with the mask: Turn the checkbox off. Feathering is applied 
before the mask is scaled, so scaling affects both the mask and the feathered edge. 
If you adjust the scale disproportionately, feathering variations are introduced.

Note: When you scale a mask using the Size or Radius parameters in the Mask 
Inspector, the Fixed Feather checkbox has no effect.

•	 Mask Color: A pop-up menu that controls the color of the mask as displayed in the 
canvas when it’s selected. This setting has no effect on the final output. Setting masks 
to different colors may aid you in identifying which mask is which.

•	 Convert to Points: A button (available when a simple mask is selected) that, when 
clicked, converts a simple mask to a complex mask with editable control points. See 
Convert a shape or mask to control points.
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Control Points controls
When a complex mask with control points is selected, this list becomes available, 
displaying the X and Y position parameters for the mask’s control points. The Control 
Points list also contains a single Animation menu (the down arrow that appears when you 
move the pointer over the right side of the Control Points heading row) that affects all 
the control points, letting you add keyframes, reset the shape’s animation, display the 
animation curve in the Keyframe Editor, and so on. For more information on using the 
Animation menu, see Animation menu controls.

To show or hide the Control Point lists, double-click the Control Points name in the 
Inspector.

Use Image masks

Intro to image masks in Motion

Another way to create transparency in a layer is by using image masks. An image mask 
creates transparency in a layer by deriving an alpha channel from another layer, such as a 
shape, text, movie, or still image.

Note: You can use masks and image masks together.

The power of image masks is that they do not have to be drawn or animated.

Using image masks is easy. First you apply an image mask, and then you make adjustments 
in the Behaviors Inspector.

You can add filters to image masks to further manipulate the transparency effect. You may 
be able to improve an image mask by using Color filters such as Brightness, Contrast, and 
Gamma to manipulate the effect, enhancing or reducing detail to create the transparency 
you need. See Applying filters or behaviors to masks.

You can also apply behaviors to image masks to create animated transparency effects. See 
Applying filters or behaviors to masks.
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Apply an image mask to a layer in Motion

Assigning an image mask is a two-part process. First, you create a blank image mask 
underneath a layer. Then you assign the image you want to use to create transparency.

Add an image mask to a layer
1.	 In Motion, select a layer to mask.

2.	 Choose Object > Add Image Mask (or press Shift-Command-M).

The image mask appears underneath the layer in the Layers list and Timeline.

3.	 With the image mask selected, do one of the following:

•	 Open the Image Mask Inspector, then drag a layer to use as the mask from the 
Layers list to the Mask Source well.

•	 Open the HUD (if the HUD is not visible, press D or F7), then drag the layer to use as 
the mask from the Layers list into the Mask Source well.

Important: Click and drag in one movement to successfully drop a layer in an image 
well. If you select the layer to use as the source, then release the mouse button, you 
lose the selection.

In this example, text is used as the image mask.
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4.	 In the Mask Inspector, click the Source Channel pop-up menu and choose the color 
channel (red, green, blue, alpha, and so on) you want to use to create transparency.

For more information about choosing a color channel, see the following task.

Select the image mask’s color channel
When you use a layer as an image mask, you can choose which of the layer’s color 
channels to apply to create transparency. 

1.	 In Motion, apply an image mask and assign a mask source, as described in the previous 
task.

2.	 In the Image Mask Inspector, click the Source Channel pop-up menu, then choose a 
color channel (Red, Green, Blue, Alpha, or Luminance).

Because alpha channels are basically 8-bit grayscale images, you can use any single 
color channel as an image mask. Luminance lets you use the aggregate luminance from 
the red, green, and blue channels of an image to create transparency. 

For more information about the Source Channel pop-up menu, see Image mask controls.

Image mask controls in Motion

After you add an image mask to a layer, the following parameters become available in the 
Image Mask Inspector:

•	 Mask Source: An image well to assign a layer (a shape, text, an image, a movie, particle 
emitter, numbered image sequence, and so on) to use to mask a layer.

•	 Frame: A slider (available when you use a movie or image sequence as the assigned 
image) that sets the start frame for playback.

•	 Hold Frame: A checkbox (available when you use a movie or an image sequence as 
the assigned image) that, when selected, freezes the frame specified in the Frame 
parameter. That frame is then used as the mask for the masked layer’s total duration.

•	 Offset: Value sliders that offset the X and Y values of the mask’s position, relative to the 
layer being masked, allowing you to change which part of the layer is masked.
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•	 Wrap Mode: A pop-up menu that increases the area an image mask affects (if the image 
mask is smaller than the layer it’s assigned to). There are three options:

•	 None: The object is used as is.

•	 Repeat: The object is duplicated and tiled to fill up the full width and height of the 
image.

•	 Mirror: The layer is duplicated, tiled, and reversed to fill the full width and height of 
the image. This may create a more seamless repetition for some images.

•	 Source Channel: A pop-up menu that sets which channel of the assigned image is used 
to create the mask. There are five options:

•	 Red: Uses the red channel as a grayscale mask.

•	 Green: Uses the green channel as a grayscale mask.

•	 Blue: Uses the blue channel as a grayscale mask.

•	 Alpha: Uses the alpha channel from the mask layer.

•	 Luminance: Uses the aggregate luminance from the red, green, and blue channels as 
a grayscale mask.

•	 Mask Blend Mode: A pop-up menu that determines how an image mask interacts with 
the alpha channel of the layer it’s applied to. When a layer has multiple image masks, 
each mask can have a different Mask Blend mode. When this happens, each mask adds 
to, or subtracts from, the layer’s alpha channel according to the selected mode. The 
final alpha channel is the combined result of all image masks applied. These modes 
are identical to the Mask Blend Mode options available for shape masks. There are four 
menu options:

•	 Add: Adds the mask to the alpha channel (the default setting). This is useful for 
adding back regions of an image that other masks are cutting out.

•	 Subtract: Subtracts a mask from the alpha channel. This is useful for creating holes 
in the middle of layers, or for masking out additional regions of an image that are 
untouched by other masks.

•	 Replace: Replaces the layer’s original alpha channel, as well as any other masks 
applied to the same layer that appear underneath the current mask in the Layers list, 
with the current mask. You can add masks above, set to whatever blending mode 
you like.

•	 Intersect: Masks out all regions of the layer that do not overlap the mask itself (but 
does not replace a layer’s original alpha channel). This includes other masks applied 
to the same layer that appear nested underneath the intersecting mask in the Layers 
list.

•	 Invert Mask: A checkbox that, when selected, reverses the mask—swapping its solid 
and transparent areas. This is useful if you need to switch the solid and transparent 
areas of an existing mask.

•	 Stencil: A checkbox that preserves the layer’s geometric transforms. If you’re creating 
a mask with transformed Scale, Position, Rotation, or other parameters, select this 
checkbox to use the modified layer.

•	 Stretch: A checkbox (available when Stencil is deselected) that stretches the mask to fit 
the boundaries of the image and centers the mask on the layer’s center point.
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Convert between shapes and masks in Motion
Because masks and shapes are created in similar ways but perform different tasks, there 
are occasions where you may create a shape and later want to convert it into a mask, or 
vice versa. Different options are available when converting shapes to masks, depending on 
the type of object being masked. When you need to convert a shape to a mask, consider 
the following:

•	 When a shape is converted to a mask and applied to a scaled object, the resulting 
mask is scaled as well. This may lead to unexpected results. To prevent surprises, set 
the object to 100% scale or place the object in a new group and apply the mask to the 
group.

•	 Converting a shape that has been manipulated in 3D space into a mask may produce 
unexpected results. For more information on working with masks in 3D projects, see 
Mask a layer.

•	 When a transformed (scaled, rotated, or anchor point-adjusted) shape is converted to a 
mask, the transforms are not maintained.

Note: Masks are cannot be applied to 3D paint strokes, 3D particle systems or replicators, 
3D text, or unflattened 3D groups. To convert a shape to a mask on such an object, the 
item must be flattened.

Convert a shape to mask an image
1.	 In Motion, use any of the shape tools to create a shape.

Note: You can also add a preset shape from Shapes category in the Library.

2.	 In the Layers list, drag the shape object onto the layer to be masked.

The shape is converted into a mask. If the layer to which the mask is applied is not 
centered in the canvas, the position of the mask is slightly offset. This is because the 
position of the converted mask is dependent upon the original position of the shape 
relative to the center of its parent group.

Convert a shape to a mask a group
You can convert a shape into a mask and apply that mask to any group in a project.

1.	 In Motion, use any of the shape tools to create a shape.

2.	 In the Layers list, drag the shape onto the group layer and pause, holding down the 
mouse button, then when the drop menu appears, choose Move Mask To Group. 

Convert a shape to mask its enclosing group
You can convert a shape into mask and apply that mask to its parent (enclosing) group.

1.	 In Motion, use any of the shape tools to create a shape.

2.	 In the Layers list, select the shape layer and do one of the following: 

•	 Drag the shape onto the group and pause, holding the mouse button; when the drop 
menu appears, choose Move Mask To Group, then release the mouse button.

•	 Choose Object > Convert to Mask.
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Convert a shape to a mask another shape
1.	 In Motion, use any of the shape tools to create a shape.

2.	 In the Layers list, drag the shape object onto another shape object and pause, holding 
the mouse button.

3.	 When the drop menu appears, choose Add Mask To Shape, then release the mouse 
button.

The shape is converted into a mask and is applied to the other shape.

Note: Masks cannot be applied to 3D paint strokes.

Convert a shape to mask a particle emitter or replicator
1.	 In Motion, use any of the shape tools to create a shape.

2.	 In the Layers list, drag the shape object onto an emitter or replicator and pause, holding 
the mouse button.

3.	 When the drop menu appears, choose Add Mask To Emitter or Add Mask to Replicator, 
then release the mouse button.

The shape is converted into a mask on the particle emitter or replicator.

Note: The 3D checkbox must be deselected in the Emitter or Replicator Inspector for 
the drop menu to appear.

Convert a shape to mask 2D text or 3D text
1.	 In the Layers list, select the text layer to mask.

2.	 In the Layout pane of the Text Inspector, ensure that the Flatten checkbox is selected.

3.	 Use any of the shape tools to create a shape.

4.	 In the Layers list, drag the shape object onto the text layer.

Convert a mask to a shape
•	 In the Layers list in Motion, select a mask and do one of the following:

•	 Choose Object > Convert To Shape.

The shape moves to the bottom of the group.

•	 Drag the mask between two objects in the Layers list.

•	 Drag the mask onto the group layer and pause, holding the mouse button; when the 
drop menu appears, choose Move Shape To Group.
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Using filters and masks with shapes in Motion

Filters
You can apply filters to individual shapes or to a group that contains a number of shapes. 
You can use filters to stylize shapes far beyond the options available in the Shape 
Inspector. When you apply a filter to a shape, the shape remains editable. See Intro to 
filters.

Important: After you apply a filter to a shape, you can no longer smoothly increase the size 
of that shape using the object’s transform controls. This is because filters change shapes 
from vector objects to bitmapped objects. As a result, they scale like other bitmapped 
objects, which display artifacts if they’re enlarged too much.

Masks
Use the mask-drawing tools in the canvas toolbar to create masks that punch holes inside 
shapes. You can also apply an image mask to a shape, using another layer in Motion to 
define areas of transparency. For more information on using masks and image masks, see 
Intro to masks and transparency.

Important: Some operations, as well the application of some filters or a mask, cause a 
group to be rasterized. When a group is rasterized, it’s converted into a bitmap image. 
Because all shape layers (masks, shapes, and paint strokes) are contained in groups, 
this affects how shapes interact with other objects in your project. See How rasterization 
affects shapes.



894Motion User Guide

Copy shape styles in Motion
After modifying the fill or outline of a shape, you can apply that shape style to another 
shape in the project.

Apply a shape’s style to another shape
1.	 In the Layers list in Motion, drag the stylized shape object onto another shape object 

and pause, holding the mouse button.

A drop menu appears.

2.	 When the drop menu appears, choose Copy Style To Shape, then release the mouse 
button.

The shape’s fill and outline are copied to the other shape.

Save custom shapes and shape styles in Motion
After you create a shape or mask you like, you can save it as a preset in the Shapes or 
Favorites category of the Library for future use. You can also save the style (fill, outline, 
feathering, and so on) of a shape.

Note: When you drag a custom mask from the Library into a project, the mask retains the 
position where it was saved (relative to the image or footage on which it is dropped).

Save a shape to the Library
1.	 In Motion, open the Library and select the Favorites, Favorites Menu, or Shapes 

category.

2.	 Drag the shape you want to save from the Layers list or Timeline into the stack at the 
bottom of the Library.

Shapes saved to the Favorites Menu category can be added to a project via the 
Favorites menu.

Save multiple shapes to the Library
1.	 In Motion, open the Library and select the Favorites, Favorites Menu, or Shapes 

category.

2.	 In the Layers list, select the shapes to save, drag them into the stack at the bottom of 
the Library, and continue holding the mouse button.

3.	 When the drop menu appears, choose “All in one file” or “Multiple files.”

“All in one file” saves the shapes together, and they’re listed as one item in the Library. 
“Multiple files” saves the shapes as individual objects in the Library.

Note: When you drag shapes that were saved with the “All in one file” option to the 
canvas, the shapes are dropped where you release the mouse button and are positioned 
according to their arrangement when originally saved to the Library. If you use the Apply 
button in the preview area to add the shapes, the shapes are added at the center of the 
canvas.
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Save a shape style to the Library
1.	 In Motion, with the shape selected, click the Shape Style pop-up menu in the Style pane 

of the Shape Inspector (or in the Shape HUD), then choose Save Shape Style.

2.	 Enter a name for the style in the Save Preset to Library dialog, then click Save (or press 
Return).

The custom style is saved to the Library in the All subcategory of the Shape Styles 
category. You can move the preset into an existing subcategory, or create your own 
folders to organize your custom styles.

When you select the saved style in the Library stack, a preview is displayed in the 
preview pane. The new preset now appears in the Shape Style pop-up menu in the Style 
pane of the Shape Inspector.
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Create graphics with generators

Intro to using generators in Motion
You can add generators to a project to create instant graphical treatments such as color 
backgrounds, bars, stripes, noise, or gradients. Some generators create animated patterns. 
However, most generators default to static, patterned images that you can animate using 
behaviors or keyframes.

After you add a generator to your project, you can adjust its settings or animate it in the 
Generator Inspector or HUD, or by using onscreen controls (handles in the canvas). 

There are two categories of generators in the Library:

•	 Generators: A collection of both static images (such as the Checkerboard generator) 
and animated images (such as the Clouds generator). Although static generators are 
not animated by default, you can keyframe their parameters to create an animated 
pattern. For a description of each generator and its adjustable controls, see Intro to 
image generators.

•	 Text Generators: A collection of animated text treatments, such as advancing timecode 
and number countdowns. For a description of each text generator and its adjustable 
controls, see Intro to text generators.

As with all other image layers in a Motion project, generators can be moved, duplicated, set 
to different blend modes, used as the source for a particle or replicator cell, and so on.
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Add a generator in Motion
There are two ways to add generators: by dragging a generator from the Library to your 
project or by using the Add Object pop-up menu in the toolbar. After you add a generator, 
it becomes a layer in the Layers list (and Timeline) and appears in the canvas. The 
generator is set to the duration and size of your project by default. For example, if you’re 
working on a 4K Ultra HD project and you add a generator, the generator has a resolution 
of 3840 x 2160 (16:9 aspect ratio).

Note: The duration and start frame of the generator depends on the Project settings in 
Motion Settings. See If it’s your first import.

Add a generator by dragging from the Library
1.	 In the Library in Motion, click the Generators category.

2.	 In the stack, click a generator.

The generator preview appears in the preview area. If the generator is animated, such 
as Clouds, the animation plays in the preview area.

3.	 Do one of the following:

•	 Drag the generator to the canvas, Layers list, or Timeline.

•	 Click the Apply button in the preview area.

Note: Generators added to a project are not added to the Media list. The Media list 
includes only media files imported into Motion, such as image sequences, video files, 
Photoshop files, and audio files. See Show, sort, and search the Media list.

Add a generator from the toolbar
•	 In Motion, click Add Object in the toolbar, choose Generators, then choose a generator 

from the Image Generators or Text Generators submenu.
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Customize a generator

Modify or animate a generator in Motion
You can modify an applied generator in the Inspector or HUD, or by using onscreen 
transform controls. You can animate generator parameters with keyframes or behaviors, 
and you can use a generator as the basis for a particle system. After you customize a 
generator, you can save it to the Library for future use.

While each generator is unique, there are a small set of controls that are shared between 
all generators. See Controls common to all generators.

Modify a generator in the Inspector
1.	 In the Layers list, Timeline, or canvas in Motion, select an applied generator.

Note: For information on adding a generator to your project, see Add a generator.

2.	 In the Generator Inspector, adjust the parameter controls.

For information on controls specific to each generator, see Intro to image generators or 
Intro to text generators.

Modify a generator using onscreen controls
As with any other image layer in Motion, you can make basic transform adjustments to an 
applied generator (modifying size, distorting, changing the anchor point, and so on) using 
onscreen transform handles. Changes to these basic transform parameters are reflected in 
the Properties Inspector. Additionally, some generators have specific onscreen controls—
usually to adjust the Center or Offset parameter—that you enable by selecting the Adjust 
Item tool in the canvas toolbar. The Spiral Drawing generator has unique onscreen controls 
that simulate a stator (ring) and a rotor (gear) of a spiral-drawing tool. These changes are 
reflected in the Generator Inspector. For more information about the transform tools, see 
Transform layer properties in the canvas.

1.	 In Motion, select a generator in Layers list, Timeline, or canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Adjust Item. 

Note: If the generator has no onscreen controls, the Adjust Item tool is not available.
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In the center of the canvas, the Center onscreen control or the Offset onscreen control 
appears (depending on the generator).

3.	 In the canvas, drag the Center control or the Offset control to a new position.

The Offset or Center parameter is adjusted accordingly in the Generator Inspector.

 Tip: Always adjust transform-related generator parameters (such as center and 
angle) using onscreen controls (or using the controls in the Generator Inspector) rather 
than from the Properties Inspector; the equivalent controls in the Properties Inspector 
cause the generator to be resampled, resulting in a lower-quality output.

For more information about the Offset and Center parameters, see the controls 
descriptions for Image Generators.

Animate a generator using keyframes
Although most generators create static images, you can animate the parameters of a 
generator to create a moving texture over time.

1.	 In the Layers list, canvas, or Timeline in Motion, select the generator you want to 
animate.

2.	 Move the playhead to the frame where you want the animation to begin, then press A to 
turn on keyframe animation recording.

3.	 In the Generator Inspector or using the onscreen controls (if available), adjust a 
generator parameter.

A keyframe is added to the parameter.

4.	 Move the playhead to the frame where you want to create the next keyframe, then 
adjust the generator parameter again.

5.	 Play the project (press the Space bar).

The animated generator parameters create a moving, changing texture based on your 
keyframes.

6.	 When you’re satisfied with the result, press A again to turn off keyframe recording.

Note: For more information on keyframing, see Intro to keyframing.
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Animate a generator using behaviors
As with all other objects in Motion, you can apply Basic Motion, Parameter, or Simulation 
behaviors to a generator. The following example applies the Random parameter behavior to 
randomize the opacity of the Star generator, creating a flickering star.

1.	 Add the Star generator to your Motion project.

2.	 In the Generator Inspector, move the pointer over the right side of the Spike Opacity 
parameter row.

The Animation menu (a down arrow) appears.

3.	 Click the Animation menu for the Spike Opacity parameter, then choose Add Parameter 
Behavior > Randomize.

The Randomize parameter behavior is applied to the Spike Opacity parameter, and the 
Behaviors Inspector is displayed so you can adjust the Randomize parameters. 

4.	 In the Behaviors Inspector, drag the Amount slider to the right to increase the 
randomization effect. 
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5.	 In the timing toolbar (above the Timeline), click the Play button (or press the Space 
bar).

Because the Randomize parameter behavior is applied to the opacity of the star spikes, 
the star appears to flicker. When a Parameter behavior is applied to a parameter in a 
generator, a behavior icon (a gear) appears in the Generator Inspector in the row for 
the affected parameter. In this example, the behavior icon appears in the Spike Opacity 
parameter row.

6.	 To increase or decrease the effect of the flicker, adjust the Randomize parameters (in 
the Behaviors Inspector).

You can show the Behaviors Inspector by Control-clicking the parameter name and 
choosing the applied behavior from the shortcut menu.

For more information on using Parameter behaviors such as the Randomize behavior, 
see Randomize behavior.



902Motion User Guide

Use a generator as a particle cell source
As with other objects, generators can be used as a source for particle cells. The following 
example uses the Soft Gradient generator. To give your particle system more flexibility and 
reduce processing strain on your computer, scale the generator down in the Generator 
Inspector.

1.	 Add the Soft Gradient generator to your Motion project.

2.	 In the HUD or Generator Inspector, reduce the Radius value. 

This example uses a Radius value of 40.

3.	 Reduce the Width and Height values. 

In the canvas, the gradient and its bounding box are scaled down.

4.	 With the generator still selected, do one of the following:

•	 Press E.

•	 In the toolbar, click Make Particles.
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After you add an emitter to the project, the new Emitter object is selected In the Layers 
list; a duplicate of the source object (the Soft Gradient generator) becomes an emitter 
cell for the new particle system; and the original source object (the Soft Gradient 
generator) is disabled.

In the canvas, the emitter bounding box appears. You can transform the bounding box 
using the onscreen controls or controls in the Inspector. The particle appears in the 
canvas in the same location as the original object. Although it appears as if the particle 
is selected, it’s the bounding box for the emitter that’s selected.

5.	 Press the Space bar to play the project.

Soft gradient particles are emitted.

You can change the particle color, emitter shape, scale, emission angle, birth rate, and 
so on in the Emitter Inspector or HUD. For more information on working with particles, 
see Intro to particles.
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Controls common to all generators in Motion
All image generators have common controls, located in the Generator Inspector. For lists of 
controls specific to each type of image generator, see Intro to image generators.

The Generator Inspector contains the following controls for all image generators:

•	 Reset: An item in the Animation menu (the down arrow that appears when you move the 
pointer over the right side of the generator name row), that resets the generator to its 
default state.

•	 Width: A slider that sets the width of the generator, in pixels. Values range from 1 to the 
width of your project.

•	 Height: A slider that sets the height of the generator, in pixels. Values range from 1 to 
the height of your project.

•	 Pixel Aspect Ratio: A pop-up menu that sets the aspect ratio of the pixels drawn by 
the generator. Options include Square, NTSC D1/DV, NTSC D1/DV Anamorphic, PAL 
D1/DV, PAL D1/DV Anamorphic, Anamorphic 2:1, D4/D16, D4/D16 Anamorphic, HD 
(960 x 720, 1440 x 1080), HD (1280 x 1080), or Custom. When you select a value other 
than Custom, the Pixel Aspect Ratio of that selection appears in a value field next to 
the pop-up menu. Enter values from 0 to 10000 in the value field. If the value does not 
correspond to a preset value (for example, 2 for Anamorphic 2:1), the pop-up menu is 
set to Custom.

Important: The Opacity parameter in the Generator HUD is identical to the Opacity control 
located in the Properties Inspector. This slider sets the transparency of the generator as 
a whole. Several generators contain a separate opacity control in the Generator Inspector, 
which is independent of the like-named control in the Properties Inspector.
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Image generators

Intro to image generators in Motion
Image generators quickly add animated or static graphics, such as stars, swirls, rays of 
color, or lens flares to a project. The image generator category is labeled Generators in the 
Library.

There are 28 image generators:

•	 Caustics generator creates an animated, simulated water surface.

•	 Cellular generator creates an animated pattern that looks like cells moving under a 
microscope.

•	 Checkerboard generator creates a checkerboard pattern.

•	 Clouds generator creates an animated cloud pattern.

•	 Color Solid generator creates a single-color object.

•	 Concentric Polka Dots generator creates a repeating pattern of concentric circles, 
polygons, or stars.

•	 Concentric Shapes generator creates a repeating pattern of shapes.

•	 Gradient generator creates a basic gradient ready for customization. 

•	 Grid generator creates a grid pattern made of two color lines.

•	 Japanese Pattern generator creates a pattern of overlapping waves or congruent 
circles.

•	 Lens Flare generator superimposes a simulated lens flare effect.

•	 Manga Lines generator creates radial or linear Manga-style graphic lines.

•	 Membrane generator creates a sheer, animated sheet that flows gracefully in 3D space.

•	 Noise generator creates a random, static pattern.

•	 One Color Ray generator creates a ray pattern based on variations of a color.

•	 Op Art 1 generator, Op Art 2 generator, and Op Art 3 generator create artsy patterns to 
confuse your background-foreground senses.

•	 Overlapping Circles generator creates orbs of two different colors that overlay each 
other.

•	 Radial Bars generator creates bars of equal width that extend from a center point to the 
edge of the canvas.

•	 Soft Gradient generator creates a soft-edged, radial gradient.

•	 Spirals generator creates a repeating circular spiral pattern.

•	 Spiral Drawing generator draws overlapping geometric curves like the toy from your 
youth.
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•	 Star generator creates a glowing star shape that contains an alpha channel.

•	 Stripes generator creates a default image with vertical bands of two alternating colors.

•	 Sunburst generator creates “beams” that radiate from a center point.

•	 Truchet Tiles generator creates a two-color pattern based on simple shapes in different 
orientations.

For a list of common parameter controls, see Controls common to all generators. For a 
description of each image generator and its specific controls, see the other topics in this 
section.

Caustics generator in Motion
The Caustics generator creates an animated, simulated water surface. The size, speed, 
refraction, brightness, and color of the Caustics pattern can be modified and animated. 
You can use the Caustics generator to add light patterns to a project, or as the source 
object for an image map.

Adjust this generator using the controls in the Generator Inspector:

•	 Size: A slider that sets the size of the shapes and spaces in the pattern.

•	 Speed: A slider that sets the speed of movement of the light patterns.

•	 Refraction: A slider that sets the refraction of the light shapes.

•	 Brightness: A slider that sets the brightness of the light shapes.

•	 Color: Color controls that set the color of the light shapes. For more precise color 
selection, click the disclosure triangle to display Red, Green, and Blue sliders.
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Cellular generator in Motion
The Cellular generator creates an animated pattern that looks like cells moving under a 
microscope. You can change the color, size, and speed of the cells.

Adjust this generator using the controls in the Generator Inspector:

•	 Size: A slider that sets the size of cells in the pattern. Values range from 3 to 64.

•	 Speed: A slider that sets the speed of movement of cells. Values range from 0 to 2.

•	 Gradient: Controls that set the color gradient used for cells. For information on using 
gradients, see Gradient editor controls.

Checkerboard generator in Motion
The Checkerboard generator creates a static checkerboard pattern. The contrast, color, 
size, and position of checkerboard squares can be edited and keyframed.

The Checkerboard generator is compatible with 360° projects.

Adjust this generator using the controls in the Generator Inspector:

•	 Checkerboard Type: A pop-up menu that sets the shape of the pattern elements. There 
are four choices:

•	 Grid: Creates checkerboard squares.

•	 Radial: Creates a checkerboard set in a radial pattern.

•	 Shape: Creates a checkerboard of two different shapes. The shapes choices include 
Square, Circle, Polygon, and Star.

•	 Triangular: Creates a checkerboard of triangle shapes.
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•	 Center: Value sliders that set the center of the generator. (You can also use the Adjust 
Item tool to adjust this parameter via onscreen controls. See Modify or animate a 
generator.)

•	 Color 1: Color controls that set the first color in the checkerboard. For more precise 
color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity 
sliders.

•	 Color 2: Color controls that set the second color in the checkerboard. For more precise 
color selection, click the disclosure triangle to display Red, Green, Blue, and Opacity 
sliders.

•	 Size: A slider that sets the size of the squares in the checkerboard. Values range from 0 
to 800.

•	 Board Angle: A dial that rotates the pattern.

•	 Tile Height: A slider (available when Checkerboard Type is set to Radial) that sets the 
height of the pattern elements.

•	 Divisions: A slider (available when Checkerboard Type is set to Radial) that sets the 
number of slices in the radial pattern.

•	 Twirl: A slider (available when Checkerboard Type is set to Radial) that sets the amount 
of twist in the radial pattern.

•	 Checker shape: A pop-up menu that sets the shape of the pattern elements to Square 
or Triangle.

•	 Shape 1: A pop-up menu (available when Checkerboard Type is set to Shape) that sets 
the first shape of the pattern to Square, Circle, Polygon, or Star.

•	 Shape 2: A pop-up menu (available when Checkerboard Type is set to Shape) that sets 
the second shape of the pattern to Square, Circle, Polygon, or Star.

•	 Vertical Scale: A slider (available when Checkerboard Type is set to Triangular) that sets 
the height of the triangles in the pattern.

•	 Contrast: A slider that sets the sharpness of the division between squares. Values range 
from 0 to 1.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.

The Checkerboard generator does not create seams or unwanted artifacts when added to 
a 360° environment. For more information on working in 360° projects, see Intro to 360° 
video.
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Clouds generator in Motion
The Clouds generator creates an animated cloud pattern. You can modify or animate the 
color, scale, speed, and strength of the cloud layers.

Adjust this generator using the controls in the Generator Inspector:

•	 Horizontal Scale: A slider that simulates zooming into or out of the cloud pattern by 
horizontally scaling the generator. 

•	 Vertical Scale: A slider that simulates zooming into or out of the cloud pattern by 
vertically scaling the generator. 

•	 Speed: A slider that sets the speed of movement of the clouds. Values range from 0 to 
2.

•	 Gradient: Controls that set the color gradient used for the clouds. For information on 
using gradients, see Use a gradient preset.

•	 Method: A pop-up menu that sets the algorithm used to generate the clouds. Values 
can be set to Normal (the default) or Turbulent.

•	 Offset: Value sliders that set the coordinates of the center of the clouds. Coordinates 
are calculated from the center of your object, which is the coordinate origin. (You can 
also use the Adjust Item tool to modify this parameter using onscreen controls. See 
Modify or animate a generator.)

•	 1st Layer Strength, 2nd Layer Strength, 3rd Layer Strength, 4th Layer Strength: Sliders 
that set the strength of each of the four layers of clouds. Values range from 0 to 1.
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Color Solid generator in Motion
The Color Solid generator creates a single-color object. You can adjust the color of the 
solid, as well as keyframe the color to create an animated texture of changing colors.

The Color Solid generator is compatible with 360° projects.

Note: To create and animate a small, color-filled box or shape, use the Shape tools to draw 
a vector-based shape rather than creating and masking a Color Solid generator. This is 
more efficient in terms of processor performance and workflow.

Adjust this generator using a single set of controls in the Generator Inspector:

•	 Color: Color controls that set the color. For more precise color selection, click the 
disclosure triangle to display Red, Green, and Blue sliders.

Concentric Polka Dots generator in Motion
The Concentric Polka Dots generator creates a repeating pattern concentric circles, 
polygons, or stars.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: A slider that sets the center of the generator pattern.

•	 Dot Color: Color controls that set the color of the polka dots.

•	 Background Color: Color controls that set the color behind the polka dots.

•	 Ring Width: A slider that defines the width of the concentric rings of dots.

•	 Angle: A dial that rotates the generator pattern.

•	 Dot Radius: A slider that sets the width of the polka dots.

•	 Dot Spacing: A slider that sets how far apart the dots are from each other.
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•	 Dot Shape: A pop-up menu that sets the shape of the pattern elements. There are three 
choices:

•	 Circles: Creates round polka dots.

•	 Polygons: Creates polygons. When selected, the Number of Sides, Dot Rotation, and 
Align Dots parameters become available.

•	 Stars: Creates stars. When selected, the Number of Points, Dot Rotation, Align Dots, 
and Star Radius parameters becomes available.

•	 Contrast: A slider that controls the transition between the dot and background colors. 
A value of 1 creates the highest contrast between the colors; lower values create less 
contrast, softening the shapes.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.

Concentric Shapes generator in Motion
The Concentric Shapes generator creates a repeating pattern of shapes.

Adjust this generator using the controls in the Generator Inspector:

•	 Shape: A pop-up menu that sets the shape type. There are two choices:

•	 Circles: Creates concentric circles.

•	 Polygons: Creates concentric polygons with a minimum of three sides.

•	 Number of Sides: A slider (available when shape is set to Polygons) that determines the 
number of sides on the polygonal shape. A polygon must have at least three sides.

•	 Rotation: A dial (available when Shape is set to Polygons) that determines the 
orientation of the polygonal shapes.

•	 Center: Value sliders that set the center point of the generator in the canvas. The left 
value slider represents X; the right value slider represents Y. To access individual X and 
Y controls, click the disclosure triangle.

•	 Inner Cutoff: A slider that defines a center stopping area for the generator. A value 
greater than 0 creates a hole in the middle of the generator; the greater the value, the 
larger the hole. Objects composited below the generator in the project appear in the 
cutoff areas. 
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•	 Outer Cutoff: A slider that defines an outer stopping area for the generator. The lower 
the value, the more the outer edges of the generator are cut off. Objects composited 
below the generator in the project appear in the cutoff areas. 

•	 Color Type: A pop-up menu that specifies color type. There are two choices:

•	 2 Color: Creates two-color concentric shapes.

•	 Gradient: Adds additional gradient parameters to the Inspector: the Gradient editor 
and Gradient Handling pop-up menu (described below). For more information on 
gradient editors, see Gradient editor controls.

•	 Color 1: Color controls (available when Color Type is set to 2 Color) that set the first 
color in the generator. Using the default settings, this color appears in the center of the 
concentric shapes.

•	 Color 2: Color controls (available when Color Type is set to 2 Color) that set the second 
color in the generator. 

•	 Gradient Handling: A pop-up menu (available when Color Type is set to Gradient) that 
specifies whether to clamp, repeat, or mirror the gradient in the areas beyond the end 
of the shape (determined by the Center parameter and the rightmost color tag in the 
gradient). There are three choices:

•	 Clamp to End Point: Limits the gradient to its edge (as defined by the Center 
parameter and the rightmost color tag in the gradient).

•	 Mirror: Mirrors the gradient from its edge (as defined by the Center parameter and 
the rightmost color tag in the gradient).

•	 Repeat: Repeats the gradient from its edge (as defined by the Center parameter and 
the rightmost color tag in the gradient).

•	 Width: A slider that sets the width of the concentric shapes.

•	 Contrast: A slider (available when Color Type is set to 2 Color) that controls the 
transition between the two colors. A value of 1 creates the highest contrast between the 
colors; lower values create less contrast, softening the shapes.

•	 Phase: A slider that cycles through the colors or gradient.

 Tip: Animate the Phase parameter to create a hypnotic effect.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.
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Gradient generator in Motion
The Gradient generator initially creates a linear gradient. You can change the gradient type 
from linear to radial, add and remove colors in the gradient, and change the gradient start 
and end points. You can save a modified gradient to the Gradient category in the Library 
and apply it to shapes, text objects, or particle cells. Additionally, gradient controls can be 
keyframed to create a moving, color-changing gradient.

The Gradient generator is compatible with 360° projects.

Adjust this generator using the controls in the Generator Inspector:

•	 Gradient: Controls that set the color gradient. For information on using gradients, see 
Gradient editor controls. 

Note: To adjust the gradient in the canvas, Control-click the selected generator and 
choose Edit Position from the shortcut menu (or choose the Adjust Item tool from the 
transform tools pop-up menu in the canvas toolbar).

•	 End Condition: A pop-up menu (available when Radial is chosen from the Type pop-up 
menu in the Gradient editor) that specifies the end condition. (For more information on 
the Type pop-up menu, see Basic gradient controls.) The End Condition pop-up menu 
has two choices:

•	 Hold Last Tag: Extends the last color defined in the gradient editor beyond the 
gradient (defined by the Start and End parameters) to the edge of the canvas.

•	 Transparent Tag: Ends the gradient at the location defined by the Start and End 
parameters. Because transparency is created, objects below the gradient in the 
project appear beyond the end of the gradient. 

•	 360° Aware: Eliminates seams created when the generator is added to a 360° 
environment.
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Grid generator in Motion
The Grid generator creates a grid pattern made of two color lines. By default, they’re white 
lines on a black background. Using the controls in the Inspector, you can customize the 
colors and line widths of the grid, and add graph paper lines.

Adjust this generator using the controls in the Generator Inspector:

•	 Offset: Value sliders that set the coordinates of the center of the grid. Coordinates are 
calculated from the center of your object, which is the coordinate origin. (You can also 
use the Adjust Item tool to modify this parameter with onscreen controls. See Modify or 
animate a generator.)

•	 Line Color: Color controls that set the color of grid lines.

•	 BG Color: Color controls that set the color of the grid background.

•	 BG Opacity: A slider that sets the opacity of the background. Values range from 0 to 1.

•	 Feather: A slider that sets the feathering or sharpness of grid lines. Values range from 0 
to 1.

•	 Line Width: A slider that sets the width of grid lines.

•	 Autofit: A checkbox that, when selected, bounds grid background width and height 
values to ensure that there aren’t partial columns or rows at the edge of the grid.

•	 BG Width: A slider that sets the width of the background or space between lines.

•	 BG Height: A slider that sets the height of the background or space between lines.

•	 Graph Paper Lines: A checkbox that, when selected, adds a grid pattern on top of the 
existing grid. With this option selected, the Graph Line Color and Graph Line Frequency 
controls become available.

•	 Graph Line Color: Color controls (available when the Graph Paper Lines checkbox is 
selected) that set the color of the “graph paper” lines.

•	 Graph Line Frequency: A slider (available when the Graph Paper Lines checkbox is 
selected) that sets how frequently a grid line is also a graph line.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.
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Japanese Pattern generator in Motion
The Japanese Pattern generator creates a pattern of overlapping waves or congruent 
circles.

Adjust this generator using the controls in the Generator Inspector:

•	 Japanese Pattern: A pop-up menu that selects the generator pattern. There are two 
choices:

•	 Seigaiha (Waves): Creates a pattern of radial gradients. 

•	 Shippo: Creates a pattern of overlapping circles that are divided into quarters.

•	 Gradient Editor: Controls (available when Japanese Pattern is set to Seigaiha [Waves]) 
that define the gradient fill of the overlapping circles. See Gradient editor controls.

•	 Vertical Spacing: A slider (available when Japanese Pattern is set to Seigaiha [Waves]) 
that sets the vertical distance between the overlapping circles.

•	 Leaf Color: Color controls (available when Japanese Pattern is set to Shippo) that set 
the color of the “leaves” in the pattern circles.

•	 Radius: A slider (available when Japanese Pattern is set to Shippo) that defines the 
width of leaves in the pattern. The larger the Radius value, the larger the leaves.

•	 Contrast: A slider (available when Japanese Pattern is set to Shippo) that controls the 
transition between the colors of the shapes. A value of 1 creates the highest contrast 
between the colors; lower values create less contrast, softening the shapes.

•	 Outside Shape: A checkbox (available when Japanese Pattern is set to Shippo) that, 
when selected, creates a shape (in the color chosen in the Leaf Color parameter) 
outside of each circle. If you see no difference in the pattern when Outside Shape is 
selected, adjust the Radius value.

•	 Inside Shape: A checkbox (available when Japanese Pattern is set to Shippo) that, when 
selected, adds a square (in the color chosen in the Leaf Color parameter) to the center 
of each circle in the pattern.

•	 Center: A slider that sets the center of the generator pattern.

•	 Background Color: Color controls that set the background color of the generator.

•	 Size: A slider that sets the size of the overlapping circles.

•	 Board Angle: A dial that rotates the generator pattern.
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Lens Flare generator in Motion
Lens flares result from a bright light source pointed right at a lens, refracting off multiple 
elements in the lens assembly of a camera. This generator adds a simulated lens flare.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: Value sliders that set the position of the center of the lens flare. (You can also 
use the Adjust Item tool to modify this parameter with onscreen controls. See Modify or 
animate a generator.)

•	 Size: A slider that sets the radius of the ring of the lens flare.

•	 Intensity: A slider that sets the intensity of the lens flare. Values range from 0 to 4.

•	 Falloff: A slider that sets how fast the lens flare falls off. Values range from 0 to 10.

•	 Color: Color controls that pick the color of the lens flare. Click the disclosure triangle to 
display Red, Green, and Blue sliders for more precise color selection.

•	 Outer Color: Color controls that pick the outer color of the lens flare.

•	 Ring Color: Color controls that pick the color of the ring of the lens flare.

•	 Streak Color: Color controls that pick the color of the streaks in the lens flare.

•	 Streak Intensity: A slider that sets the intensity of the streaks. Values range from 0 to 1.

•	 Streak Count: A slider that sets the number of streaks in the lens flare. Values range 
from 1 to 100.

•	 Streak Noise Frequency: A slider that sets the frequency of the noise in the streaks. 
Values range from 1 to 100.

•	 Streak Noise Level: A slider that sets the level of noise in the streaks of the lens flare. 
Values range from 0 to 20.

•	 Ring Radius: A slider that sets the radius of the ring of the lens flare. Values range from 
0 to 1.

•	 Ring Width: A slider that sets the ring’s width. Values range from 0 to 1.

•	 Glow Falloff: A slider that sets how fast the glow falls off of the lens flare. Values range 
from 0 to 20.

•	 Streak Map: An image well that displays a thumbnail of the map chosen for the streaks 
of the lens flare.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.
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Manga Lines generator in Motion
The Manga Lines generator creates radial or linear Manga-style graphic lines.

Adjust this generator using the controls in the Generator Inspector:

•	 Line Style: A pop-up menu that sets the generator pattern. The choices include:

•	 Radial Inward: Creates spoked lines that originate from the outer edges and extend 
toward the center of the generator.

•	 Radial Outward: Creates spoked lines that originate from the center of the generator 
and extend outward.

•	 Linear One Side: Creates lines that originate from one side of the generator.

•	 Linear Inward: Creates lines that originate from two sides and extend toward the 
center of the generator.

•	 Linear Outward: Creates lines that originate from the center of the generator and 
extend outward on two sides.

•	 Center: A slider (available when Line Style is set to Radial Inward or Radial Outward) 
that sets the center of the generator pattern.

•	 Inner Radius: A slider (available when Line Style is set to Radial Inward or Radial 
Outward) that defines the inner boundary of the generator.

•	 Outer Radius: A slider (available when Line Style is set to Radial Inward or Radial 
Outward) that defines the outer boundary of the generator.

•	 Angle: A dial (available when Line Style is set to Radial Inward or Radial Outward) that 
rotates the radial lines.

•	 Point 1: Sliders (available when Line Style is set to Linear One Side, Linear Inward, or 
Linear Outward) that set the X and Y positions of the start of the lines.

•	 Point 2: Sliders (available when Line Style is set to Linear One Side, Linear Inward, or 
Linear Outward) that set the X and Y positions of the end of the lines.

•	 Line Thickness: A slider (available when Line Style is set to Linear One Side, Linear 
Inward, or Linear Outward) that defines the thickness of each line.

•	 Color: Color controls that set the color of the lines.

•	 Background Color: Color controls that set the color appearing behind the lines.
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•	 Contrast: A slider that controls the transition between the line color and the background 
color. A value of 1 creates the highest contrast between the colors; lower values create 
less contrast, softening the lines.

•	 Number of Lines: A slider that sets how many lines appear in the generator.

•	 Waviness: A slider that warps the lines into waves. For more waves, adjust the Number 
of Waves parameter.

•	 Number of Waves: A slider that sets the number of waves when Waviness is set to any 
value other than 0. Higher values result in more waves.

•	 Wave Offset: A slider that defines the phase of the waves when Waviness is set to any 
value other than 0. (Animate this value to create interesting effects.)

•	 Random Seed: A slider that changes the random calculations to display the lines 
differently. Modifying this value over time yields a constantly changing pattern. The 
easiest way to see and use the Random Seed parameter is to add a Ramp behavior to it 
(in the Parameter behavior category), then ramp from a very small random seed value to 
a very large random seed value over time.

Membrane generator in Motion
The Membrane generator creates a sheer, animated sheet that appears to move gracefully 
in 3D space. The speed, start and end points, offset, brightness, and color can be modified 
and animated. To expand the animation beyond the canvas borders, increase the Width and 
Height parameters in the Inspector.

Adjust this generator using the controls in the Generator Inspector:

•	 Speed: A slider that sets the speed of movement of the sheet.

•	 Start 1–4: Sliders that set the starting point for the sheet wave. Experiment with these 
controls to find wave shapes.

•	 End 1–4: Sliders that set the ending point for the sheet wave. Experiment with these 
controls to find wave shapes.

•	 Offset: A slider that sets the coordinates of the center of the sheet. Coordinates are 
calculated from the center of your object, which is the coordinate origin.

•	 Brightness: A slider that sets the brightness of the sheet.

•	 Color: Color controls that pick the color of the membrane. Click the disclosure triangle 
to display Red, Green, and Blue sliders for more precise color selection.
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Noise generator in Motion
The Noise generator creates a random, color static pattern. To make animated noise, you 
can keyframe the Random Seed parameter in the HUD or Generator Inspector. When filters 
are applied to an animated Noise generator, you can create unique textures. In the second 
image below, the Stripes distortion filter is applied to an animated Noise generator to 
create a vibrant, electric light-type texture.

Adjust this generator using the controls in the Generator Inspector:

•	 Random Seed: A slider that sets a different noise value. Modifying this value over time 
yields a constantly changing noise pattern. The easiest way to see and use the Random 
Seed parameter is to add a Ramp behavior to it (in the Parameter behavior category), 
then ramp from a very small random seed value to a very large random seed value over 
time.

One Color Ray generator in Motion
The One Color Ray generator creates a ray pattern based on variations of a color. You 
can select the color, the degree of variance, the number of divisions represented, and the 
rotation of the pattern.

Adjust this generator using the controls in the Generator Inspector:

•	 Offset: Value sliders that set the coordinates of the ray pattern’s center. Coordinates 
are calculated from the center of your object, which is the coordinate origin. (You can 
also use the Adjust Item tool to modify this parameter with onscreen controls. See 
Modify or animate a generator.)

•	 Color: Color controls that pick the base color.
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•	 Color Variance: A slider that sets how much the colors differ from each other.

•	 Divisions: A slider that sets the number of divisions in the ray pattern.

•	 Rotation: A dial that sets the rotation of the whole pattern from the center point.

•	 Sharpness: A slider that defines the hardness of the edges of the rays. Values range 
from .25 to 1.

•	 Waviness: A slider that warps the rays into waves. Values range from –10 to 10.

•	 Frequency: A slider that determines the number of waves in the rays when Waviness is 
set to any value other than 0.

•	 Phase: A slider that defines the offset of the waves from the start and end of the rays 
when Waviness is set to any value other than 0. (Animate this value to create interesting 
effects.)

•	 Inner Cutoff: A slider that defines a center stopping area for the generator. A value 
greater than 0 creates a hole in the middle of the generator; the greater the value, the 
larger the hole. Objects composited below the generator in the project appear in the 
cutoff areas.

•	 Outer Cutoff: A slider that defines an outer stopping area for the generator. The lower 
the value, the more the outer edges of the generator are cut off. Objects composited 
below the generator in the project appear in the cutoff areas.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.

Op Art 1 generator in Motion
There are three Op Art generators to help confuse your background-foreground senses. 
The Op Art generators create mathematically oriented patterns using a repetition of simple 
shapes. Although some static patterns create a visual illusion of movement, you can build 
truly moving moiré patterns by keyframing Op Art parameters.

Adjust this generator using the controls in the Generator Inspector:

•	 Line Thickness: A slider that sets the thickness of the lines in the pattern.

•	 Color 1: Color controls that set the first color of the pattern. Click the disclosure triangle 
to display Red, Green, Blue, and Opacity sliders for more precise color selection.
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•	 Color 2: Color controls that set the second color of the pattern. Click the disclosure 
triangle to display Red, Green, Blue, and Opacity sliders for more precise color 
selection.

•	 Contrast: A slider that sets how sharp or blurred the division is between the lines and 
the background.

•	 Wavelength 1: A slider that sets the frequency of the wave up and down.

•	 Wavelength 2: A slider that sets the frequency of the wave from left to right.

•	 Amplitude: A slider that sets the amplitude of the waves.

•	 Roundness: A slider that sets the shape of the waves.

Op Art 2 generator in Motion
This generator creates mathematically oriented patterns using a repetition of simple 
shapes. Although some static patterns create a visual illusion of movement, you can build 
truly moving moiré patterns by keyframing Op Art parameters.

Adjust this generator using the controls in the Generator Inspector:

•	 Scale: A slider that sets how close or far away the dots appear.

•	 Angle: A dial that sets the angle of the dot rows.

•	 Dot Color: Color controls that set the color of the dots.

•	 Background Color: Color controls that set the color of the background. For more 
information on using the color controls, see Use basic color controls.

•	 Contrast: A slider that sets how sharp or blurred the division is between the dots and 
the background.

•	 Dot Size: A slider that sets the dot size.

•	 Compression: A slider that sets how shallow or deep the fold in the imaginary paper 
appears.
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Op Art 3 generator in Motion
This generator creates mathematically oriented patterns using a repetition of simple 
shapes. Although some static patterns create a visual illusion of movement, you can build 
truly moving moiré patterns by keyframing Op Art parameters.

Adjust this generator using the controls in the Generator Inspector:

•	 Line Thickness: A slider that sets the thickness of the lines in the pattern.

•	 Color 1: Color controls that set the first color of the generator.

•	 Color 2: Color controls that set the second color of the generator. For more information 
on using the color controls, see Use basic color controls.

•	 Contrast: A slider that sets how sharp or blurred the division is between the lines and 
the background.

•	 Wavelength: A slider that sets the frequency of the wave.

•	 Amplitude: A slider that sets the height of the wave.

•	 Skew: A slider that sets rotation of the wave pattern.

•	 Roundness: A slider that adjusts the shape of the wave.

Overlapping Circles generator in Motion
The Overlapping Circles generator creates orbs of two different colors that overlay each 
other. You can use a third color for the background.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: A slider that sets the center of the generator pattern.

•	 Color 1: Color controls that set the first color of the generator.
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•	 Color 2: Color controls that set the second color of the generator. For more information 
on using the color controls, see Use basic color controls.

•	 Background Color: Color controls that set the background color of the generator. If the 
background color is not visible, adjust the Circle Offset parameter.

•	 Size: A slider that adjusts the size of the circles.

•	 Circle Offset: A slider that adjusts the space between the circles.

•	 Angle: A dial that rotates the overlapping circles pattern.

•	 Contrast: A slider that sets how sharp or blurred the division is between the circles and 
the background.

Radial Bars generator in Motion
The Radial Bars generator creates bars of equal width that extend from a center point to 
the edge of the canvas.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: A slider that sets the center of the generator pattern.

•	 Bar Color: Color controls that set the color of the bars.

•	 Background Color: Color controls that set the background color of the generator.

•	 Number of Bars: A slider that sets the quantity of bars in the generator.

•	 Bar Width: A slider that defines the thickness of each bar.

•	 Angle: A dial that rotates the bars pattern.

•	 Contrast: A slider that sets how sharp or blurred the division is between the bars and 
the background.
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•	 Convergence: A pop-up menu that sets how the bars meet in the center. The choices 
include:

•	 Modern: Creates bars that appear to extend from one edge of the canvas to the 
other, overlapping in the center.

•	 Classic: Creates bars that appear to extend inward from the edges of the canvas, 
meeting in the center with an offset overlap.

Soft Gradient generator in Motion
The Soft Gradient generator creates a soft-edged, radial gradient. The gradient contains 
an alpha channel, so you can place the generator over another image in the project. You 
can change and keyframe the color, size, and position of the gradient.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: Value sliders that set the position of the center of the gradient. (You can also 
use the Adjust Item tool to modify this parameter with onscreen controls. See Modify or 
animate a generator.)

•	 Color: Color controls that set the color of the gradient. Click the disclosure triangle to 
display Red, Green, and Blue sliders for more precise color selection.

•	 Radius: A slider that sets the radius of the gradient circle. Values range from 0 to 1000.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.
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Spirals generator in Motion
This generator creates a repeating circular spiral pattern.

Adjust this generator using the controls in the Generator Inspector:

•	 Type: A pop-up menu that specifies whether a modern or classic spiral is created. There 
are two menu items:

•	 Modern (Linear): Creates a modern spiral pattern, with the color swirls evenly 
spaced as they move toward the center of the spiral. 

•	 Classic (Exponential): Creates a classic spiral pattern with color swirls becoming 
thinner as they move toward the center of the spiral. 

•	 Center: Value sliders that set the center point of the generator in the canvas. The left 
value slider represents X position; the right value slider represents Y position. To access 
individual X and Y controls, click the disclosure triangle. (You can also use the Adjust 
Item tool to modify this parameter with onscreen controls. See Modify or animate a 
generator.)
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•	 Color Type: A pop-up menu that specifies whether the spirals are two-color or a 
gradient fill.

•	 2 Color: Creates two-color spirals. When 2 Color is selected from the Color Type 
pop-up menu, the Color 1, Color 2, and Contrast parameters become available.

•	 Gradient: Lets you add colors to the spiral, creating soft transitions between colors. 
Spiral colors are determined by the Gradient editor. You can create a custom 
gradient or apply a preset gradient to the spirals. For more information on using 
gradient editors, see Modify gradient tags.

•	 Color 1: Color controls (available when Color Type is set to 2 Color) that set the first 
color of the spiral.

•	 Color 2: Color controls (available when Color Type is set to 2 Color) that set the second 
color of the spiral.

•	 Gradient: Gradient controls (available when Color Type is set to Gradient) that allow you 
to pick a gradient from the Library.

•	 Scale: A slider (available when Type is set to Modern) that determines the size of the 
spiral arms.

•	 Tightness: A slider (available when Type is set to Classic) that determines the curl of 
the spiral. The lower the Tightness value, the looser the spiral.

•	 Contrast: A slider that controls the transition between the two colors. A value of 
1 creates the highest contrast between colors; lower values create less contrast, 
softening the spiral. The Contrast parameter is not available when Gradient is chosen 
from the Color Type pop-up menu.

•	 Rotation: A dial that rotates the spiral around its center. (Animate the Rotation 
parameter to create a hypnotic effect.)

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.
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Spiral Drawing generator in Motion
Like a toy from our youth, the Spiral Drawing generator draws curves based on a “pen” 
that’s locked to a point on a gear (a rotor) that rolls within—or without—a larger ring (a 
stator). While the pattern draws, the ring remains in a fixed location, and the gear rolls 
along the inner edge or outer edge of the ring.

For an example using the Spiral Drawing generator, see Use Spiral Drawing onscreen 
controls.

Adjust this generator using the controls in the Generator Inspector:

•	 Auto Draw: A checkbox that, when selected, creates an animated drawing. When Auto 
Draw is deselected, the drawing is static.

•	 Auto Draw Style: A pop-up menu that sets the style of the drawing instrument. There 
are two choices:

•	 Pen: Draws solid, even lines in the canvas in a pattern defined by the generator 
controls.

•	 Laser: Simulates a laser in the canvas in a pattern defined by the generator controls.

•	 Draw Speed: A slider that adjusts how quickly the drawing is created.

•	 Cycle Start: A slider that sets the beginning location of the drawing.

•	 Center: A slider that sets the center of the generator pattern.

•	 Pen Color: Color controls that set the color of the drawing.

•	 Pen Width: A slider that defines the thickness of the drawn lines (Pen or Laser).

•	 Pen Blend Mode: A pop-up menu that sets the blend mode of the generator to Normal 
or Add.

This setting is a separate from the blend mode of the group. Setting the Pen Blend 
Mode to Add results in an additive effect (it’s added to the blend mode of the group).

•	 Pen Location: A slider that sets the position of the pen within the drawing gear. (You 
can also use the Adjust Item tool to modify this parameter with onscreen controls. See 
Modify or animate a generator.)

•	 Line Smoothness: A slider that defines how uniform the lines are. Lower the value to 
create more crimped, linear lines.

•	 Ring Radius: A slider that controls the size of the drawing. When Inside Ring is chosen 
from the Gear location pop-up menu, all drawing occurs inside the radius of the ring. 
When Outside Ring is chosen from the Gear location pop-up menu, all drawing occurs 
outside the radius of the ring. (You can also use the Adjust Item tool to modify this 
parameter with onscreen controls.)
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•	 Ring Teeth: A slider that controls the number of teeth on the outer drawing ring.

•	 Gear Teeth: A slider that controls the number of teeth on the inner gear. A lower Gear 
Teeth value results in a more complex drawing. (You can also use the Adjust Item tool to 
modify this parameter with onscreen controls.)

•	 Gear Location: A pop-up menu that sets whether the drawing occurs outside or inside 
the ring. There are two choices:

•	 Inside Ring: All drawing occurs within the radius of the ring.

•	 Outside Ring: All drawing occurs outside the radius of the ring.

•	 Ring Rotation: A dial that turns the ring (and the attached gear).

•	 Gear Rotation: A dial that turns the gear (and the attached pen point).

Use Spiral Drawing onscreen controls in Motion
You can use the Spiral Drawing onscreen controls to adjust the position of the drawing 
in the canvas, the location of the pen within the gear, the size of the stator ring, and the 
number of teeth and rotation of the gear.

Adjust the Spiral Drawing using onscreen controls
1.	 In the Layers list, canvas, Timeline, select an applied Spiral Drawing generator.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Adjust Item.

3.	 In the canvas, do any of the following:

•	 Drag the center onscreen control (or any blank area within the ring or gears) to 
reposition the drawing in the canvas.

•	 Drag the ring inward to decrease its radius or outward to increase its radius.

•	 Drag the gear inward to decrease its teeth value or outward to increase its teeth 
value. This affects how closely the pattern is drawn to the center of the spiral.
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•	 Drag the white circle in the gear to adjust the location of the pen and the rotation of 
the gear.

For a complete description of the Spiral Drawing parameters, see Spiral Drawing 
generator.

Star generator in Motion
The Star generator creates a glowing star shape that contains an alpha channel. The scale, 
width, angle, epsilon (which fine-tunes the size of the star spikes), and opacity of the 
spikes can be modified and keyframed, as can the position, color, and radius of the star.
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Adjust this generator using the controls in the Generator Inspector:

•	 Center: Value sliders that set the position of the center of the star. (You can also use 
the Adjust Item tool to modify this parameter with onscreen controls. See Modify or 
animate a generator.)

•	 Color: Color controls that pick the color of the halo around the star. Click the disclosure 
triangle to display Red, Green, Blue, and Opacity sliders for more precise color 
selection.

•	 Radius: A slider that sets the radius of the circle at the center of the star. Values range 
from 0 to 300.

•	 Spike Scale: A slider that sets the size of the star spikes. Values range from 0 to 100.

•	 Spike Angle: A dial that sets the angles of the star spikes.

•	 Spike Opacity: A slider that sets the opacity of the star spikes. Values range from –8 to 
0.

•	 Spike Width: A slider that sets the width of the star spikes. Values range from 0 to 50.

•	 Epsilon: A slider that fine-tunes the strength of the star spikes. Values ranges from –2 
to 0.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.

Stripes generator in Motion
The Stripes generator creates a default image with vertical bands of two alternating 
colors. You can change and keyframe the position, colors, size, and contrast of the stripes. 
Animate the Center parameter to make the stripes move continuously across the screen.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: Value sliders that set the position of the center of the stripe pattern. (You can 
also use the Adjust Item tool to modify this parameter with onscreen controls. See 
Modify or animate a generator.)

•	 Color 1: Color controls that set the color of the first stripe. For more precise color 
selection, click the disclosure triangle to display Red, Green, Blue, and Opacity sliders.
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•	 Color 2: Color controls that set the color of the second stripe. For more precise color 
selection, click the disclosure triangle to display Red, Green, Blue, and Opacity sliders.

•	 Size: A slider that sets the width of individual stripes.

•	 Contrast: A slider that sets the sharpness or blurriness of the edge between stripes. 
Values range from 0 to 1.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.

Sunburst generator in Motion
The Sunburst generator creates “beams” that radiate from a center point.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: A slider that sets the center of the generator pattern.

•	 Color: Color controls that set the color of the sunburst.

•	 Background Color: Color controls that set the color (and opacity of that color) that 
appears behind the sunburst.

•	 Number of Arms: A slider that sets the number of spikes on the sunburst.

•	 Radius: A slider that defines the outer boundary of the sunburst’s spikes. (You can also 
use the Adjust Item tool to modify this parameter with onscreen controls. See Modify or 
animate a generator.)

•	 Inner Radius: A slider that defines the inner radius of the generator. A value of 1 results 
in no spikes; a value of .01 results in the sharpest spikes.

•	 Angle: A dial that rotates the sunburst.

•	 Waviness: A slider that warps the spikes into waves. For more waves, adjust the Number 
of Waves slider (described below).

•	 Number of Waves: A slider that sets the number of waves when Waviness is set to any 
value other than 0. Higher values result in more waves.

•	 Wave Offset: A slider that defines the phase of the waves when Waviness is set to any 
value other than 0. (Animate this value to create interesting effects.)

•	 Contrast: A slider that sets how sharp or blurred the division is between the circles and 
the background.
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Truchet Tiles generator in Motion
The Truchet Tiles generator creates a two-color pattern based on simple shapes in 
different orientations, such as quarter-circles or white squares with black diagonal lines. 
You can also use an image layer to create a custom tile pattern.

Adjust this generator using the controls in the Generator Inspector:

•	 Center: A slider that sets the center of the generator pattern.

•	 Size: A slider that sets the scale of the tiles.

•	 Shape: A pop-up menu that sets shape of the tile pattern to Diagonal Lines, Arcs, Dots, 
Pipes, or Custom. When Shape is set to Custom, you can assign an image layer (shape, 
text, image, and so on) as the tile for the generator.

•	 Color 1: Color controls (available when Shape is set to Diagonal Lines, Arcs, Dots, or 
Pipes) that set the first color of the pattern. For more precise color selection, click the 
disclosure triangle to display Red, Green, Blue, and Opacity sliders.

•	 Color 2: Color controls (available when Shape is set to Diagonal Lines, Arcs, Dots, or 
Pipes) that set the second color of the pattern. For more precise color selection, click 
the disclosure triangle to display Red, Green, Blue, and Opacity sliders.

•	 Custom Tile Options: An image well and group of checkboxes that become available 
when Shape is set to Custom. Drag an image layer into the Custom Tile Image well to 
create custom tiles. Select or deselect the checkboxes to flip or rotate the custom 
tiles. When the No Transform checkbox is selected, a random selection of tiles are not 
flipped or rotated.

•	 Random Seed: A slider that changes the random calculations to display the tiles 
differently. Modifying this value over time yields a constantly changing pattern. The 
easiest way to see and use the Random Seed parameter is to add a Ramp behavior to it 
(in the Parameter behavior category), then ramp from a very small random seed value to 
a very large random seed value over time.

•	 Contrast: A slider (available when Shape is set to Diagonal Lines, Arcs, Dots, or Pipes) 
that sets how sharp or blurred the division is between the tiles and the background.
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Two Color Ray generator in Motion
The Two Color Ray generator creates a ray pattern alternating between two colors. You can 
select the colors, the number of divisions represented, and rotation of the pattern.

Adjust this generator using the controls in the Generator Inspector:

•	 Offset: Value sliders that set the coordinates of the center of the ray pattern. 
Coordinates are calculated from the center of the object, which is the coordinate origin. 
(You can also use the Adjust Item tool to modify this parameter with onscreen controls. 
See Modify or animate a generator.)

•	 Color 1: Color controls that set the base color for the two-color ray.

•	 Color 2: Color controls that set the alternating color for the two-color ray.

•	 Divisions: A slider that sets the number of divisions in the ray pattern.

•	 Rotation: A dial that sets the rotation of the whole pattern from the center point.

•	 Contrast: A slider that sets the sharpness or softness of the division between rays.

•	 Waviness: A slider that makes the rays wavy. Positive or negative values create waves in 
the rays. Values range from –10 to 10.

•	 Frequency: A slider that determines the number of waves in the rays when Waviness is 
set to a value other than 0.

•	 Phase: A slider that determines the offset of the waves from the start and end of the 
rays when Waviness is set to a value other than 0.

•	 Inner Cutoff: A slider that defines a center stopping area for the generator. A value 
greater than 0 creates a hole in the middle of the generator; the greater the value, the 
larger the hole. Objects composited below the generator in the project appear in the 
cutoff areas.

•	 Outer Cutoff: A slider that defines an outer stopping area for the generator. The lower 
the value, the more the outer edges of the generator are cut off. Objects composited 
below the generator in the project appear in the cutoff areas.

•	 Publish OSC: A checkbox that, when selected, ensures that if this generator is 
sent to Final Cut Pro as part of a template, the onscreen controls are accessible in 
Final Cut Pro. For more information about publishing onscreen controls and other 
parameters, see Intro to Final Cut Pro templates.
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Text generators

Intro to text generators in Motion
Text generators use text characters to create text-and-number-based animations, such as 
timecode, time-and-date, or countdown animations. The Inspector for each Text generator 
contains four panes: Format, Appearance, Layout, and Text Generator.

The first three panes (Format, Appearance, and Layout) control the font, size, color, 
outline, glow, drop shadow, and other standard text attributes. These panes are nearly 
identical to those in the Text Inspector for standard text layers, with two exceptions: The 
Text Generator Inspector has no Text editor (a field in which custom text can be typed) and 
no Editable in FCP checkbox. Additionally, the Text and Transform Glyph tools cannot be 
used to modify text in Text generators. For information on the Format, Appearance, and 
Layout panes, see Intro to editing text.

There are four Text generators:

•	 File generator displays the contents of a text file, line by line.

•	 Numbers generator displays random numbers based on settings in the Inspector.

•	 Time Date generator displays the date and time based on settings in the Inspector.

•	 Timecode generator displays timecode based on the current project or the settings in 
the Inspector.

File generator in Motion
The File generator displays the contents of a text file. The appearance (font, weight, 
size, and so on) of the text in the source text file is ignored in favor of the settings in the 
Inspector. The text file must be in plain text (TXT) format.

In a File generator, each line of text appears onscreen, holds for a moment, and then 
disappears before the next line appears. You can control how the text appears using the 
controls in the Inspector. The duration of the generator bar in the Timeline determines how 
long it takes for all lines of text in the source file to reveal themselves. 

Adjust this generator using the controls in the Generator Inspector:

•	 Browse: A button that opens a browser window where you can select the plain text 
(TXT) file to use as the text source.

•	 Speed: A pop-up menu that sets the behavior of the text as it appears and disappears 
onscreen. Choose any of several options:

•	 Constant: The text appears and disappears at a steady speed from the first word or 
line to the last word or line in the text file.

•	 Ease In: The text appears at a slow speed.

•	 Ease Out: The text disappears at a slow speed.

•	 Ease Both: The text appears and disappears at a slow speed.

•	 Accelerate: The text appears and disappears with increasing speed.
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•	 Decelerate: The text appears and disappears with decreasing speed.

•	 Custom: Defines the speed of appearance and disappearance of the text by setting 
keyframes for the text from 0 to 100 percent using the Custom Speed slider, 
described below. In other words, you determine the rate of the appearance and 
disappearance of the text over time.

•	 Custom Speed: A slider (available when Speed is set to Custom) that lets you keyframe the 
timing of the appearance or disappearance of the text. At 0 percent, none of the text has 
appeared; at 100 percent, the last of the text in the file is displayed (the last line or word). 

•	 Random: A checkbox that, when selected, randomizes the order in which the lines of 
text appear.

•	 Random Seed: Controls that let you change the seed number (by typing a new number 
in the text field or clicking Generate). This changes the random calculations to display 
the text in a different order.

Numbers generator in Motion
The Numbers text generator displays random numbers based on settings in the Inspector.

Adjust this generator using the controls in the Generator Inspector:

•	 Animate: A checkbox that, when selected, enables animation of the numbers as the 
project plays. When deselected, a static number is displayed.

•	 Start: A slider that sets the beginning number for the generator. Slider values range 
from 0 to 100. For negative numbers or numbers greater than 100, use the value slider 
(to the right of the slider). Default values are based on the project. For example, when 
the Numbers generator is added to a default project of 300 frames, the Start value is 1 
and the End value is 300.

 Tip: You can use the Link parameter behavior to set the numbers to show values of 
any parameter used in your project. In some cases, the number display may appear at 
a scaled rate. In other cases, the number display may be translated into another form 
(such as a percentage). For example, if you use the Link behavior to link to the value of 
a point light’s Falloff parameter, the number is scaled by a factor of .1 and the Intensity 
parameter is displayed as a percentage. You can scale and offset the value of the linked 
parameter using the Scale slider in the Behaviors Inspector. To convert the number to 
a different format, use the Format pop-up menu in the Numbers generator. For more 
information about the Link behavior, see Link behavior.

•	 End: A slider that sets the ending number for the generator. Slider values range from 
0 to 100. For negative numbers or numbers greater than 100, use the value slider (to 
the right of the slider). Default values are based on the project. For example, when the 
Numbers generator is added to a default project of 300 frames, the Start value is 0 and 
the End value is 300. If the End value is set to 200, a range of 0 to 200 is counted over 
the 300 frames.

•	 Format: A pop-up menu that specifies the format of displayed numbers. There are 
seven choices:

•	 Number: Numbers are used in the generator.

•	 Currency: Currency is used for the generator. The default is U.S. dollars. To change 
to another currency, chose an option in the Region pop-up menu.

•	 Percent: Percentages are used for the generator.
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•	 Scientific: Scientific numbers are used for the generator.

•	 Spell Out: Numbers are spelled out in the generator.

•	 Binary: The binary numeral system is used for the generator. The binary system uses 
two symbols (0 and 1) to represent numeric values.

•	 Hexadecimal: Hexadecimal numerals are used for the generator. This system uses 16 
symbols. The symbols 0 to 9 represent the numbers 0 to 9, and the letters A through 
F represent 10 to 15.

 Tip: When using Hexadecimal or Binary formats, inputs of very large numbers 
are required to create change in every character in the generator. For example, if 
the default Start and End values of 1 and 300 are used (in a default project of 300 
frames), only the last two or three digits appear animated in the Hexadecimal format.

If a number such as 4,294,967,296 is used, nearly all characters are animated.

•	 Decimals: A slider (available when Format is set to Number, Currency, Percent, 
Scientific, or Spell Out) that sets the number of decimal places.

•	 Capitalize: A checkbox (available only when Format is set to Spell Out) that, when 
selected, displays initial uppercase letters.

•	 Minimum Digits: A slider (available when Format is set to Number) that defines the 
minimum digits used in the generator. The default value is 1.

•	 Thousands Separator: A checkbox (available when Format is set to Number, Currency, 
or Percent) that displays a comma or other character to separate thousands (based on 
what is chosen in the Region pop-up menu).

•	 Random: A checkbox that, when selected, displays numbers randomly.

•	 Random Seed: Controls that change the Random Seed number if you don’t like the 
current random number count. Enter a new number in the text field or click Generate. 
This changes the random calculations to display different numbers.

•	 Random Hold Frame: A slider that specifies how long (in frames) each number is held 
onscreen. For example, If Random is selected and Random Hold Frame is set to 20, a 
number is displayed for 20 frames, then the next number is displayed and held for 20 
frames, and so on.

•	 Region: Controls that change the numeric format to that of another geographical region. 
By default, the generator uses the current system’s region. Click the Current button to 
set the current system’s region as the region for the generator. Click the Region pop-up 
menu to select another region.

Note: The selected region is saved with the generator. If opened on another computer 
with a different regional setting, the generator retains the saved region.
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Time Date generator in Motion
The Time Date text generator displays the date and time based on settings in the 
Inspector. You can create a countdown or count-up animation by defining start and end 
values. You can also specify time units, as well as time and date format. The default date 
and time are based on the computer’s system clock at the time the generator is added to 
the project. This can be changed in the Inspector by manually entering a value or clicking 
the Set Current Time button.

Adjust this generator using the controls in the Generator Inspector:

•	 Animate: A checkbox that, when selected, enables animation of the time and date as 
the project plays. The animation, such as a countdown or count up, is based on the 
values set in the Start and End fields. When Animate is deselected, static information is 
displayed.

•	 Start: A field (available when the Animate checkbox is selected) that sets the start date 
and time for the generator. This parameter can be animated using keyframes.

•	 End: A field (available when the Animate checkbox is selected) that sets the end date 
and time for the generator. This parameter can be animated using keyframes.

•	 Value: A field that specifies the date and time displayed in the generator. Value is not 
available when the Animate checkbox is selected. This parameter can be animated 
using keyframes.

•	 Set Current Time: A button that loads the current time into the generator.

•	 Time Units: A pop-up menu that sets the units of time used in the generator to Seconds, 
Minutes, Hours, Days, Months, or Years.

•	 Time Format: A pop-up menu that sets the time format used in the generator. Choose 
one of four options:

•	 None: Displays no time in the generator. (The date appears in the generator if any 
option other than None is chosen from the Date Format pop-up menu.)

•	 Short: Displays the time in hours and minutes. 
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•	 Medium: Displays the time in hours, minutes, and seconds.

•	 Long: Displays the time in hours, minutes, seconds, and time zone.

•	 Date Format: A pop-up menu that sets the date format used in the generator. Choose 
one of five options:

•	 None: Displays no date in the generator. (The time appears in the generator if any 
option other than None is chosen from the Time Format pop-up menu.)

•	 Short: Displays the month, day, and year in all-numeral style.

•	 Medium: Displays the month abbreviated to three letters without a period, the day, 
and the year.

•	 Long: Displays the month spelled out completely, the day, and the year.

•	 Full: Displays the day of the week and the month spelled out completely, the day, 
and the year.

•	 Region: Controls that change the numeric format to that of another geographical region. 
By default, the generator uses the current system’s region. Click the Current button to 
set the current system’s region as the region for the generator. Click the Region pop-up 
menu to select another region.

•	 Padding: A checkbox that, when selected, adds a 0 in front of single-digit times or 
dates.
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Timecode generator in Motion
The Timecode text generator displays timecode based on the current project or the 
settings in the Inspector. You can specify a specific timecode value, an offset to the 
current timecode, the timecode format, and the timecode base. You can also customize the 
color of the text and the color and opacity of the background.

Adjust this generator using the controls in the Generator Inspector:

•	 Current Timecode: A checkbox that, when selected, loads the project’s current 
timecode as the value displayed in the generator.

•	 Value: A field (available when the Current Timecode checkbox is deselected) that sets 
the timecode value displayed. This parameter can be animated using keyframes.

•	 Offset: A field (available when the Current Timecode checkbox is selected) that 
specifies an offset value to the current timecode. This parameter can be animated using 
keyframes.

•	 Format: A pop-up menu that sets the timecode format. There are three choices:

•	 HMSF: Timecode is displayed in hours, minutes, seconds, frames format.

•	 HMS: Timecode is displayed in hours, minutes, seconds format.

•	 Frames: Frame numbers are displayed.

•	 Timecode Base: A pop-up menu that sets the timecode for the generator to the frame 
rate of the current project. Menu choices include 10, 15, 23.976, 24, 25, 29.97, 29.97 
Drop, 30, 50, 59.94, 59.94 Drop, or 60.

•	 Label: A field that specifies a label. Text entered in the Label field is added as a prefix to 
the timecode displayed in the canvas.

•	 Background Color: Color controls that set the background color for the timecode 
window. By default, the background color is black. Click the disclosure triangle to 
access Red, Green, Blue, and Opacity sliders.
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Save a modified generator in Motion
After you modify or animate the parameters of a generator, you can save the generator to 
the Library for future use. For organizational purposes, name objects that you save to the 
Library with a descriptive title.

Save a customized generator to the Library
1.	 In the Library in Motion, navigate to the Generators or Favorites category.

2.	 From the Layers list or Timeline, drag the generator into the Library stack, releasing the 
mouse button when the green add pointer (+) appears over the stack window.

The behavior is saved to the Library in the behaviors subcategory you selected. 
A custom generator is represented by a user icon in the lower-right corner of the 
generator icon.

Note: You can rename the behavior for organizational purposes.

The modified generator is saved in the Generators category and appears organized 
alphabetically in the stack. Custom items saved in the Library are identified with a user 
badge in the lower-right corner of the icon.

See Save custom objects to the Library and Manage Library folders and files.
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Add effects with filters

Intro to filters in Motion
Filters are special effects used to modify the appearance of images and video clips. You 
can apply filters to create artistic effects (blurs, distortions, glows, stylized looks), to 
perform image corrections (color balancing, color channels, brightness), and to create 
sophisticated compositing effects (green screen keying). For information on keying filters, 
see Intro to color keying.

Filter categories are organized alphabetically in the Library.

•	 You can preview a filter in the Library before you apply it.

•	 You can apply a filter by dragging it from the Library onto a Layer or group in the Layers 
list, Timeline, or canvas, or by using the Filters pop-up menu in the toolbar.

•	 You can adjust an applied filter using controls in the Filters Inspector or HUD, or by 
dragging onscreen controls. (For a list of parameter controls in each filter, see Intro to 
filter types.)

•	 You can animate filter parameters using keyframes or by applying behaviors.

•	 When you create templates in Motion for use in Final Cut Pro that include filters, you 
can specify which filter controls are available in the effect, title, transition, or generator 
when it’s applied to a clip in Final Cut Pro.
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Browse and preview filters in Motion
Filters appear in the Filters category in the Library, organized into subcategories specific to 
their function (such as Color, Blur, and Tiling). After you select a filter in the Library stack, 
a preview and brief description of the filter appears in the Library preview area.

Browse for a filter
1.	 In the Library in Motion, click the Filters category.

A list of subcategories appears on the right side of the sidebar.

2.	 Click a filter subcategory.

A list of filters in that subcategory appears in the Library stack.

3.	 Click a filter in the stack to select it.

A preview and short description of the filter appear in the preview area at the top of the 
Library.
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Apply or remove filters in Motion
Filters are applied to image layers (still images, video clips, shapes, and so on) or groups 
in the canvas, Layers list, or Timeline. An applied filter appears in the Layers list nested 
underneath its target layer or group. When applied to a group, a filter affects all layers 
inside the group.

The more filters you use in a project, the more you impact the performance of Motion.

Important: Some filters can cause a group to be rasterized. When a group is rasterized, 
it’s converted into a bitmap image. In 2D groups, the application of any filter causes 
rasterization. In 3D groups, the application of specific filters causes rasterization. For more 
information, see How rasterization affects filters.

Apply a filter
In Motion, do one of the following:

•	 Drag a filter from the Library stack to a layer or group in the Layers list, Timeline, or 
canvas.

•	 Select a layer or group in the Layers list, Timeline, or canvas, then select a filter from 
the Library stack and click Apply in the preview area.

•	 Select a layer or group in the Layers list, Timeline, or canvas, then click Filters in the 
toolbar and choose a category and filter type.

The filter is applied to an image layer or to a group.

Note: Although you can apply a filter from the Library to another effects object in the 
Layers list (a behavior or another filter), the filter affects the parent image layer (or all 
layers in a group, if the filter was applied to a group), not the effects object.

Apply multiple filters to a layer
When you apply multiple filters to a layer, they have a cumulative effect. In the Layers list 
and Timeline, multiple filters appear nested under the layer or group they’re applied to.
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In Motion, do one of the following:

•	 Select an image layer or group in the Layers list, Timeline, or canvas; select multiple 
filters in the Library; then click Apply.

 Tip: Shift-click to select multiple contiguous filters. Command-click to select 
multiple noncontiguous filters.

•	 Select multiple filters in the Library, then drag them onto an image layer or group in the 
Layers list, Timeline, or canvas.

The filters are applied to the image layer in the order they’re selected. For example, if you 
select Echo, Brightness, and Bevel, in that order, then apply them to a layer, their stacking 
order in the Layers list is Bevel above Brightness above Echo. The stacking order of filters 
determines the result of the composite effect.

Copy and paste a filter to another layer or group
1.	 In the Layers list or Timeline in Motion, select a filter.

2.	 Choose Edit > Copy (or press Command-C) to copy the behavior to the Clipboard.

3.	 In the Layers list or Timeline, select the target layer or group.

4.	 Choose Edit > Paste (or press Command-V).

The copied filter is applied to the selected layer or group, with all its parameter settings 
intact.

Remove a filter from the Layers list or Timeline
•	 In the Layers list or Timeline in Motion, select a filter that’s been applied to a layer or 

group, then do one of the following:

•	 Choose Edit > Delete (or press Delete).

•	 Choose Edit > Cut (or press Command-X).

•	 Control-click the filter and choose Cut or Delete from the shortcut menu.

The filter is removed from the project.

Remove a filter from the Filters Inspector
•	 In Motion, select a filter in the Filters Inspector and do one of the following:

•	 Choose Edit > Delete (or press Delete).

•	 Choose Edit > Cut (or press Command-X).

Apply a filter to a cropped image
In Motion, cropping is always applied after a filter is applied. To apply a crop before a filter, 
do one of the following:

•	 Select an image or video clip in the Media list (in the Project pane), crop the image 
using the Crop sliders in the Media Inspector, then apply the filter to the layer in the 
Layers list.

•	 In the Layers list, select the cropped layer, choose Object > Group (or press Shift-
Command-G), then apply the filter to the layer.

For more information about cropping, see Crop a layer.
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Adjust filters

Intro to adjusting filters in Motion
After you apply a filter to a layer or group, the filter is represented in the following places in 
the Motion project window, allowing you to make adjustments:

•	 In the Filters Inspector, where you can turn the filter’s effect on or off, select and delete 
the filter, or adjust its parameters using sliders and other controls. See Adjust filters in 
the Inspector or HUD. For a list of parameter controls available for each filter type, see 
Intro to filter types.

•	 In the canvas, where you can manipulate the filter’s onscreen controls (where available). 
See Adjust filters in the canvas.

•	 In the Layers list and Timeline layers list, underneath the layer or group the filter was 
applied to, where you can select the filter, turn its effect on or off, reorder it, or lock it 
to prevent modification. See Intro to the Layers list.

•	 In the Timeline track area, as a purple bar underneath the blue bar of the layer or group 
it was applied to, where you can select the filter and modify its timing by slipping or 
trimming the bar. See Edit in the Timeline.

•	 In the HUD, where you can adjust many filter parameters using sliders and other 
controls. See Adjust filters in the Inspector or HUD.
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Adjust filters in the Inspector or HUD in Motion
The easiest way to modify an applied filter is to adjust its parameter controls in the Filters 
Inspector or in the HUD.

Adjust a filter in the Filters Inspector
1.	 In Motion, select an applied filter in the Layers list or Timeline.

2.	 Open the Inspector, then click Filters.

The Filters Inspector appears, showing parameter controls for the currently selected 
filter (and for any other filters applied to the parent layer or group). 

3.	 Adjust the parameter controls to modify the filter.

For a complete list of parameter controls in each filter, see Intro to filter types.

Adjust a filter in the HUD
1.	 In Motion, select a filter in the Layers list or Timeline.

2.	 In the toolbar, click the HUD button.

The HUD appears, containing a subset of parameter controls for the currently selected 
filter. (To access all of a filter’s parameter controls, use the Filters Inspector.)

3.	 Adjust the parameter controls to modify the filter.

For a complete list of parameter controls in each filter, see Intro to filter types.

Adjust filters in the Motion canvas
Many filters have onscreen controls that let you manipulate parameters by dragging in the 
canvas. 

Adjust a filter’s onscreen controls
1.	 In Motion, select an applied filter in the Layers list or Timeline.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Adjust Item.

Onscreen controls for the selected filter appear in the canvas.

3.	 Drag the onscreen controls in the canvas.
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When you modify a filter parameter in the canvas, the parameter values are updated in the 
Inspector, as well. For information, see Types of onscreen filter controls.

Note: Many filter onscreen controls adjust multiple parameters. To modify one parameter at 
a time, use the Filters Inspector or HUD. 

Types of onscreen filter controls in Motion
Several onscreen controls are common to many filters. Other onscreen controls are unique 
to specific filters. The following list provides examples of the types of controls available. 
If you’re unsure of an onscreen control’s function, drag it in the canvas while viewing the 
Filters Inspector to see which parameter value changes.

•	 Center: The most common filter onscreen control. Drag in the center of the circle to 
reposition the filter’s Center parameter (the center of the effect).
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•	 Amount: An onscreen control with different representations, depending on the filter. In 
the Zoom Blur filter, drag the small circular handle (above the Center onscreen control) 
to adjust the Amount parameter.

In the Prism filter, drag the arrow handle inward or outward to adjust the Amount 
parameter. (Dragging the arrow in an arc adjusts the Angle parameter.)

•	 Angle: An onscreen control with different representations, depending on the filter. In the 
Page Curl Filter, drag the circular middle handle to adjust the Angle parameter. In the 
Kaleidotile filter, drag a corner handle to adjust the Angle parameter.
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•	 Rotate/Rotation/Twirl: An onscreen control with different representations, depending 
on the filter. In the Page Curl Filter, drag the outer arrow handle to adjust the Rotation 
parameter. In the Scrape, Stripes, and Target filters, drag the small outer handle to 
adjust the Rotation parameter.

•	 Radius/Thickness/Size/Falloff: An onscreen control with different representations, 
depending on the filter. In the Disc Warp and Circle Blur filters, drag the large ring 
inward and outward to adjust the Radius parameter. In the Droplet and Ring Lens filters, 
drag the inner ring to adjust the Radius and Thickness parameters simultaneously. Drag 
in the area between the inner and outer rings to adjust the Radius parameter. Drag the 
outer ring to adjust the Thickness parameter.
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In the Vignette filter, drag the inner ring to adjust the Size parameter, and drag the outer 
ring to adjust the Falloff parameter. Drag in the area between the inner and outer ring to 
adjust both parameters simultaneously.

•	 Segment Angle/Offset Angle: An onscreen control with multiple representations, 
depending on the filter. In the Kaleidoscope filter, drag the outer handle to adjust the 
Segment Angle parameter. Drag the middle handle (between the center and outer 
handle) to adjust the Offset Angle parameter.

Filter types and controls

Intro to filter types in Motion
There are 13 filter types in Motion:

•	 360° filters are designed to work with 360° footage.

•	 Blur filters create design effects or simulate the real-world blurring that occurs due to 
the depth of field in photographed material. 

•	 Border filters frame layers in a composition in various ways. 

•	 Color filters create design effects or fix a problem with contrast, color, gamma, or 
brightness.

•	 Distortion filters change the shape of layers—warping, twisting, and pulling them in 
different directions.

•	 Glow filters combine blur with brightness and color effects.

•	 Masks and Keying filters isolate a foreground image from a uniform background color (a 
green screen, for example) for special effects compositing. 

•	 Looks filters give images a special look, such as black-and-white film noir or film photos 
from the 1960s.



951Motion User Guide

•	 Sharpen filters create a high-contrast overlay that emphasizes edges in an image.

•	 Stylize filters simulate different media, such as film, television, or print.

•	 Tiling filters create geometric patterns using shapes that are arranged into mosaics.

•	 Time filters manipulate video clips temporally. 

•	 Video filters are utilitarian in nature, and can help prepare a project for broadcast 
output.

For detailed information about each filter and its parameter controls, click the links in the 
list above.

Blur filters

Intro to Blur filters in Motion

Use Blur filters to simulate the real-world blurring that occurs due to the depth of field in 
photographed material, or to create designed effects.

There are 12 Blur filters:

•	 Channel Blur gives you control over blurring each color channel of an object.

•	 Circle Blur creates a circular blur within an image.

•	 Compound Blur blurs an object using the specified channel of a designated map image.

•	 Defocus filter mimics the out-of-focus effect that occurs through a real-world camera 
lens.

•	 Directional Blur blurs an object along a specific angle, to create a blurred streaking 
effect.

•	 Gaussian Blur creates a soft blur effect.

•	 Gradient Blur creates a graduated blur between two points.

•	 Prism blurs and refracts the image as if seen through a prism, creating a rainbow effect.

•	 Radial Blur creates a rotational blur centered on a point.

•	 Soft Focus duplicates and blurs an image.

•	 Variable Blur creates a tunnel focus effect with a blur applied inside or outside a circular 
region.

•	 Zoom Blur creates a blur that simulates a fast camera zoom-in to a point.
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Channel Blur filter in Motion

Lets you apply a blur effect selectively to each color channel of a layer: red, green, blue, 
and alpha. Create custom glow effects that retain sharpness in selected channels while 
softening other channels.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the blur.

•	 Blur Red: Sets the blur to affect the red channel.

•	 Blur Green: Sets the blur to affect the green channel.

•	 Blur Blue: Sets the blur to affect the blue channel.

•	 Blur Alpha: Sets the blur to affect the alpha channel.

•	 Horizontal: Sets the percentage of maximum horizontal blur. This is a percentage of the 
Amount parameter.

•	 Vertical: Sets the percentage of maximum vertical blur.

•	 Crop: Sets whether the image is cropped beyond its original borders.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.

Circle Blur filter in Motion

Creates a circular blur within an image. A center point sets the center of the blur effect, 
and a radius value sets the size of the affected region. You can also customize the amount 
of blur in the affected area.

Use Circle Blur to blur a limited area in an image. For more sophisticated control of the 
image region to be blurred, use the Compound Blur filter.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the blur effect. You can also drag the Center 
onscreen control in the canvas.

•	 Amount: Sets the amount of the blur.

•	 Radius: Sets the radius of the circle defining the blurred area. You can also drag the 
onscreen controls in the canvas.

•	 Crop: Sets whether the image is cropped beyond its original borders.

•	 Mix: Sets the percentage at which the original image is blended with the blurred image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Compound Blur filter in Motion

Blurs an object using the specified channel of a designated image used as a map image. 
Use a shape, text layer, still image, or movie file as the map image, then designate the red, 
green, blue, alpha, or luminance channel to create the shape of the blur.

 Tip: Use this filter to blur specific sections of an image. For example, trace the subject 
of the image to blur with a Bezier or B-spline shape, then assign this shape as the Blur 
Map image. Use its Luminance or Alpha channel to define the blurred area, then disable 
the original shape layer in the Layers list to hide the source of the blur. See Edit fill, outline, 
and feathering.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the blur.

•	 Blur Map: An image well to set the map image. Drag a layer (an image, shape, text 
object, and so on) from the Layers list into the well.

Note: You can also apply or replace the blur map by dragging the source layer onto the 
filter in the Layers list.

•	 Map Channel: Sets the channel to be blurred: red, green, blue, alpha, or luminance.

•	 Invert Map: Sets whether the blur map is inverted.

•	 Stretch Map: Stretches (or compresses) the map image so it exactly overlaps the image 
the filter is applied to.

•	 Horizontal: Sets the percentage of maximum horizontal blur.

•	 Vertical: Sets the percentage of maximum vertical blur.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.
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Defocus filter in Motion

Simulates the out-of-focus effect that occurs through a real-world camera lens. The 
Defocus filter blurs an image while creating realistic lens artifacts that mimic the aperture 
shape in a camera in brighter areas of the image. You can customize the shape of the blur.

 Tip: Use this filter when you’re trying to blur an image to match video or stills shot 
with a camera. For example, if you key a woman standing in front of a blue screen, and 
you intend to place a background image behind her to make it look like she’s standing in a 
valley with mountains in the background, use the Defocus filter instead of a Gaussian Blur 
filter to create a realistic depth-of-field effect for the mountains in the distance.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the defocus effect.

•	 Gain: Sets the amount of gain applied to the high-luminance areas.

•	 Shape: Sets the shape of the lens aperture to Circle or Polygon.

•	 Sides: Sets the number of sides of the lens aperture, if Shape is set to Polygon.

•	 Rotation: Sets the angle of rotation of the polygonal lens aperture, if Shape is set to 
Polygon.

•	 Aspect Ratio: Sets the aspect ratio of the lens aperture.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.
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Directional Blur filter in Motion

Blurs an object along a specific angle, to create a blurred streaking effect.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the blur. You can also drag the arrow onscreen control in the 
canvas to adjust the amount (and angle) of the blur.

•	 Angle: Sets the angle of the direction of movement. You can also drag the arrow 
onscreen control in the canvas to adjust the angle (and amount) of blur.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Gaussian Blur filter in Motion

Creates a soft blur effect. The Gaussian blur is the softest blur effect you can apply and is 
a frequently used blur effect. By default, this filter affects the image uniformly, although 
you can control the amount of horizontal and vertical blur independently.

Gaussian Blur is relevant for most motion graphics tasks. You can animate it to create 
focus-control effects. However, to more accurately simulate camera focus, use the Defocus 
filter.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the blur.

•	 Horizontal: Sets the percentage of the Amount parameter applied in the horizontal 
direction.

•	 Vertical: Sets the percentage of the Amount parameter applied in the vertical direction.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.

Gradient Blur filter in Motion

Creates a graduated blur between two points.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Point 1: Sets the position of the start point of the gradient. You can also drag the Point 1 
onscreen control (the lower-left point) in the canvas.

•	 Point 2: Sets the position of the end point of the gradient. You can also drag the Point 2 
onscreen control (the upper-right point) in the canvas.

•	 Amount: Sets the radius of the blur.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Prism filter in Motion

Blurs and refracts the image as if seen through a prism, creating a rainbow effect.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the blur. Drag the arrow onscreen control in the canvas 
inward and outward to adjust the amount (and angle) of the blur.

•	 Angle: Sets the angle of refraction. Drag the arrow onscreen control in the canvas in an 
arc to adjust the angle of the blur.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred and 
refracted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Radial Blur filter in Motion

Creates a rotational blur centered on a point. The effect is similar to the motion blur you 
would see if an image were spinning quickly.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the radial blur. Drag the Center onscreen 
control in the canvas to change the center position.

•	 Angle: Sets the angle of rotation of the blur.
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•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Soft Focus filter in Motion

Creates an effect similar to duplicating an object, applying the Screen blend mode to 
composite the object against itself, then blurring an overlapping layer—within a single 
filter. The Strength parameter controls how much of the blurred image is added back to the 
original image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the blur.

•	 Strength: Sets the amount of opacity of the blurred composite.

•	 Horizontal: Sets the percentage of the maximum horizontal blur.

•	 Vertical: Sets the percentage of the maximum vertical blur.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.
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Variable Blur filter in Motion

Creates a tunnel focus effect with a blur applied inside or outside a circular region. If the 
inner radius of the circle is larger than the outer radius of the circle, the blur is applied 
inside the circle.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the circle. Drag the center onscreen control in 
the canvas to adjust the center position.

•	 Amount: Sets the percentage of the blur.

•	 Inner Radius: Sets the inner radius of the circle.

•	 Outer Radius: Sets the outer radius of the circle.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Zoom Blur filter in Motion

Creates a blur that simulates a fast camera zoom-in to a point.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Look: Sets the type of blur operation. This pop-up menu has two options:

•	 Variable: The blur increases toward the edges of the image. This option is faster 
when using high blur values.

•	 Uniform: The blur is consistent from the center of the image outward.

•	 Amount: Sets the radius of the blur. Drag the small circle (above the Center onscreen 
control) in the canvas to adjust the blur amount.

•	 Swirl: Sets the quantity and direction of the swirl. Positive and negative values affect 
the direction of the swirl.

•	 Center: Sets the position of the center of the blur. Drag the Center onscreen control in 
the canvas to adjust the center position.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the blurred image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more information 
on creating content for use in Final Cut Pro, see Intro to Final Cut Pro templates.

Border filters

Intro to Border filters in Motion

Border filters allow you to frame layers in a composition in various ways.

There are four Border filters:

•	 Bevel creates a beveled border around the edges of an image.

•	 Simple Border creates a solid color border of variable width around the edges of an image.

•	 Stroke creates a solid or gradient outline around the edge of an alpha channel in an 
image, shape, or text object.

•	 Widescreen “letterboxes” an object by horizontally masking its top and bottom.

Bevel filter in Motion

Creates a beveled border around the edges of an image by superimposing an angled frame 
over the original image. You can adjust the simulated direction of reflected light and the 
opacity of the bevel to vary the effect.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Light Angle: Sets the angle at which the light hits the bevel.

•	 Bevel Width: Sets the width of the bevel as a percentage of the area of the layer.

•	 Opacity: Sets the opacity of the bevel, ranging from 0 (invisible) to 1.0 (opaque).

•	 Light Color: Picks the color of the light hitting the bevel border. Expand the color 
controls to adjust individual Red, Green, and Blue sliders, to more precisely select 
colors.

•	 Mix: Sets the percentage of the original image that’s blended with the beveled image.

Simple Border filter in Motion

Creates a solid color border of variable width around the edges of an image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Width: Sets the thickness of the border.

•	 Color: Picks the color of the border. Expand the color controls to adjust individual Red, 
Green, and Blue sliders, to more precisely set the color of the border.

•	 Border Placement: Sets where the border is drawn on the image. This pop-up menu has 
three options:

•	 Inside: Places the border along the inner edge of the image.

•	 Overlap: Centers the border over the inner and outer edges of the image.

•	 Outside: Draws the border along the outer edge of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the bordered image.
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Stroke filter in Motion

Creates a solid color or gradient color outline of variable width around the edge of an 
image or object based on its alpha channel (such as a color-keyed clip, a shape, or a text 
object). Using the gradient controls, you can create multiple strokes within a single filter.

 Tip: Apply multiple Stroke filters to an object for even more fun. Each subsequent filter 
builds on the alpha channel that’s modified by the previous filter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Stroke Type: Sets the color type of the stroke drawn around the edge of the alpha 
channel. This pop-up menu has three options:

•	 Color: Creates a single color stroke around the edge of the alpha channel.

•	 Gradient: Creates a gradient color stroke around the edge of the alpha channel.

•	 Outline Gradient: Creates a gradient color stroke around the edge of the alpha 
channel; the gradient starts at the inner edge of the stroke and ends at the outer 
edge of the stroke. Use this setting to create multiple distinct strokes around an 
alpha channel.

•	 Color: Picks the color of the stroke. Expand the color controls to adjust individual Red, 
Green, and Blue sliders, to more precisely set the color of the stroke. This parameter 
becomes available when Type is set to Color.

•	 Gradient: Defines the gradient of the stroke. This parameter becomes available when 
Type is set to Gradient or Outline Gradient.

See Intro to using the gradient editor.
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•	 Width: Sets the thickness of the stroke.

•	 Position: Sets where the stroke is drawn on the edge of the alpha channel. This pop-up 
menu has three options:

•	 Outside: Draws the stroke over the outer edge of the alpha channel.

•	 Centered: Draws the stroke over the inner and outer edges of the alpha channel.

•	 Inside: Draws the stroke over the inner edge of the alpha channel.

Each option above sets a different default value in the Threshold parameter.

•	 Offset: Offsets the stroke from the edge of the alpha channel.

•	 Threshold: Sets the alpha threshold of the stroke. Lower values draw the stroke around 
edge of the alpha channel’s low-opacity pixels; higher values draw the stroke around 
the edge of the alpha channel’s opaque pixels. The option you choose in the Position 
parameter defines the initial value of the Threshold parameter.

•	 Fade Inside: Increases transparency from the inner edge of the stroke outward.

•	 Fade Outside: Increases transparency from the outer edge of the stroke inward.

•	 Fade Width: Sets the thickness of the fade. This parameter has no effect if Fade Inside 
and Fade Outside are set to 0.

•	 Fade Falloff: Sets how the fade falls off the stroke. This parameter has no effect if Fade 
Inside and Fade Outside are set to 0.

•	 Hide Source: Hides the original image, shape, or text object used to generate the 
stroke.

•	 Blend Mode: Sets the blend mode used in the stroke. This checkbox is available only 
when Hide Source is turned off. For blend mode descriptions, see Types of blend 
modes.

•	 Mix: Sets the percentage of the original image that’s blended with the bordered image.

Widescreen filter in Motion

“Letterboxes” an object by masking it horizontally at the top and bottom to simulate 
different video and film aspect ratios. Because the image is masked, the layer beneath it 
in the composition (or the background color of the project) appears in the border space 
above and below the image. You can add a border to the masked image and customize the 
color and size of the border.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Aspect Ratio: Sets the aspect ratio of the mask. Values include 1.66:1, 1.70:1, 1.78:1, 
1.85:1, 2.35:1, 2.55:1, and 3.00:1.

•	 Offset: Sets the position of the mask relative to the Y center of the layer. Values range 
from –1.0 (the bottom of the layer) to 0 (the center of the layer) to 1.0 (the top of the 
layer).

•	 Border Size: Sets the thickness of the border.

Note: The border has no effect on the aspect ratio mask. The Border Size control 
merely adds a frame at the top and bottom edges of the filtered image.

•	 Border Color: Picks the color of the border. Color controls can be expanded with the 
disclosure triangle to include Red, Green, Blue, and Opacity sliders to more precisely 
select the color of the border.

•	 Mix: Sets the percentage of the original image that’s blended with the letterboxed 
image.

Color filters

Intro to Color filters in Motion

The filters in the Color category can be used in a number of ways. For example, you can 
set a mood by making an image sepia-toned. In addition, these filters can fix problems with 
contrast, color, gamma, or brightness.

There are 21 Color filters:

•	 Brightness boosts or lowers the uniform brightness of an image.

•	 Channel Mixer allows cross-mixing of red, green, blue, and alpha channels into one 
another.

•	 Color Adjustments tunes the exposure, contrast, brightness, saturation, and other color 
correction properties of an image within correct HDR luminance ranges.

•	 Color Balance adjusts the relative balance of all three color channels of an image, 
allowing two images to be color-matched, for example.

•	 Color Curves adjusts the components of individual color channels in an image, as well 
as the luma channel.

•	 Color Reduce reduces the full range of color in an image to two, three, or four colors.

•	 Color Wheels adjusts color in an image using four color wheels (Global, Shadows, 
Midtones, and Highlights). You can also adjust the image brightness and saturation 
levels using sliders on the sides of the color wheels.

•	 Colorize substitutes the blacks and whites in an image with colors you select.

•	 Contrast adjusts the difference between the lightest and darkest parts of an image.

•	 Custom LUT applies a lookup table (LUT) to an image. a set of data that enables a 
numeric transformation of pixel values to change the way an image looks.)

•	 Gamma adjusts the relative distribution of brightness in the midtones of an image.

•	 Gradient Colorize uses each pixel’s color value to determine the application of a color 
value from a gradient.
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•	 HDR Tools converts wide-gamut HDR images from one color space to another or sets 
the maximum brightness of an image.

•	 Hue/Saturation adjusts the hue, saturation, and value levels in an image.

•	 Hue/Saturation Curves adjusts the hue, saturation, and brightness of any color in an 
image.

•	 Levels remaps the white and black points of an image.

•	 Negative inverts color and brightness in an image.

•	 OpenEXR Tone Map applies tone mapping to an OpenEXR image.

•	 Sepia tints an image with a sepia tone.

•	 Threshold reduces all colors in an image to a duotone.

•	 Tint tints an image with a single color.

Brightness filter in Motion

Boosts or lowers the uniform brightness of an image by a specified amount.

Although this may seem to be the first filter to use for correcting for improper exposure 
in an image, Brightness boosts or lowers everything in an image at once. This means that 
raising the brightness in an image raises brightness everywhere, including in the shadows. 
Consequently, a brightened image may look washed out.

However, this filter is useful for modifying the edges and effects of shapes, masks, particle 
systems, and generators.

A better filter for exposure correction is the Gamma filter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Brightness: Sets the multiplying brightness value applied to the image.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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Channel Mixer filter in Motion

Cross-mixes the red, green, blue, and alpha channels into one another. The Channel Mixer 
filter’s main parameters are divided into four sections—Red Output, Green Output, Blue 
Output, and Alpha Output—each of which manipulates an individual channel. In each 
section, you can adjust the value of the relevant color channel added to or subtracted from 
the red, green, blue, and alpha channels.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Red - Red: Sets the amount of input red added to the output red. The default value is 
1.0, which leaves the red channel unmodified. As this value increases, the output value 
of red increases by the amount of input red multiplied by the value of Red - Red.

•	 Red - Green: Sets the amount of input green added to the output red. The default value 
is 0, which leaves the red channel unmodified. As this value increases, the output value 
of red increases by the amount of input green multiplied by the value of Red - Green.

•	 Red - Blue: Sets the amount of input blue added to the output red. The default value is 
0, which leaves the red channel unmodified. As this value increases, the output value of 
red increases by the amount of input blue multiplied by the value of Red - Blue.

•	 Red - Alpha: Sets the amount of input alpha added to the red channel. The default value 
is 0, which leaves the red channel unmodified. As this value increases, the value of red 
increases by the amount of input alpha multiplied by the value of Red - Alpha.

•	 Green - Red: Sets the amount of input red added to the output green. The default value 
is 0, which leaves the green channel unmodified. As this value increases, the output 
value of green increases by the amount of input red multiplied by the value of Green - 
Red.

•	 Green - Green: Sets the amount of input green added to the output green. The default 
value is 1.0, which leaves the green channel unmodified. As this value increases, the 
output value of green increases by the amount of input green multiplied by the value of 
Green - Green.

•	 Green - Blue: Sets the amount of input blue added to the output green. The default 
value is 0, which leaves the green channel unmodified. As this value increases, the 
output value of green increases by the amount of input blue multiplied by the value of 
Green - Blue.

•	 Green - Alpha: Sets the amount of input alpha added to the green channel. The default 
value is 0, which leaves the green channel unmodified. As this value increases, the 
value of green increases by the amount of input alpha multiplied by the value of Green - 
Alpha.

•	 Blue - Red: Sets the amount of input red added to the output blue. The default value is 
0, which leaves the blue channel unmodified. As this value increases, the output value 
of blue increases by the amount of input red multiplied by the value of Blue - Red.

•	 Blue - Green: Sets the amount of input green added to the output blue. The default 
value is 0, which leaves the blue channel unmodified. As this value increases, the output 
value of blue increases by the amount of input green multiplied by the value of Blue - 
Green.
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•	 Blue - Blue: Sets the amount of input blue added to the output blue. The default value is 
1.0, which leaves the blue channel unmodified. As this value increases, the output value 
of blue increases by the amount of input blue multiplied by the value of Blue - Blue.

•	 Blue - Alpha: Sets the amount of input alpha added to the blue channel. The default 
value is 0, which leaves the blue channel unmodified. As this value increases, the value 
of blue increases by the amount of input alpha multiplied by the value of Blue - Alpha.

•	 Alpha - Red: Sets the amount of input red added to the output alpha. The default 
value is 0, which leaves the alpha channel unmodified. As this value increases, the 
output value of pixels with nontransparent alpha increases by the amount of input red 
multiplied by the value of Alpha - Red.

•	 Alpha - Green: Sets the amount of input green added to the output alpha. The default 
value is 0, which leaves the alpha channel unmodified. As this value increases, the 
output value of pixels with nontransparent alpha increases by the amount of input green 
multiplied by the value of Alpha - Green.

•	 Alpha - Blue: Sets the amount of input blue added to the output alpha. The default 
value is 0, which leaves the alpha channel unmodified. As this value increases, the 
output value of pixels with nontransparent alpha increases by the amount of input blue 
multiplied by the value of Alpha - Blue.

•	 Alpha - Alpha: Sets the amount of input alpha added to the output alpha channel. The 
default value is 1.0, which leaves the alpha channel unmodified. As this value increases, 
more alpha is added to the pixels in the alpha channel. Values above 1 have no effect, 
unless the alpha is eroded by negative values in other alpha parameters.

•	 Monochrome: Sets the filter to monochrome mode. In monochrome mode, all three color 
channels are affected by the Red controls.

•	 Allow Mono > 1: Allows monochromatic color channels to be set to values greater than 
1. By default, this checkbox is selected. Color values are normally between 0 and 1, but 
can go over 1 or below 0 because the project’s bit depth is set to 16 bits per channel. 
If this checkbox is deselected, each Red color output control is linked. Moving any of 
them causes the others to adjust so the total value remains at 1.0. The filter must be in 
monochrome mode for this parameter to be active.

•	 Include Alpha: Sets whether to include the alpha channel in the mono calculation. The 
filter must be in monochrome mode for this parameter to be active.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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Color Adjustments filter in Motion

Adjusts common color and luminance details of an image or clip (such as highlights, 
exposure, midtones, and saturation) using machine learning (ML) to automatically create 
a more natural appearance in the clip, with better color balance, brightness, and contrast. 
You can also manually adjust any parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Control Range: Sets the scale of the sliders in this filter to the correct luminance range 
of a clip. Choose an option that matches the color space of the selected image or clip:

•	 SDR

•	 HLG

•	 PQ 1000 nits

•	 PQ 2000 nits

•	 PQ 4000 nits

•	 PQ 10000 nits

For example, to adjust the highlights of a  PQ (1000 nits) clip, click the Control Range 
pop-up menu, then choose “PQ 1000 nits.” This option maps all the sliders in the 
filter to the PQ clip’s peak brightness of 1000 nits, allowing you to modify the correct 
luminance ranges of the clip when you adjust the Highlights slider. (In this example, if 
you set the Control Range pop-up menu to SDR, the sliders are mapped to 100 nits peak 
brightness, well below the PQ luminance range. Adjusting the Highlights slider would 
then have minimal or no effect on the clip.)

If you change the project’s Render Color Space setting (in the View pull-down menu) 
after choosing a Control Range option, you may need to choose the Control Range 
option again. For example, if you’ve set control range to PQ 2000 nits, then set render 
color space to HDR Rec. 2020 PQ, the control range is set to PQ 1000 nits.

 Tip: To determine a clip’s color space, select the clip in the Media list, then check 
Color Space in the Metadata area of the Media Inspector. To determine the nits value of 
an image or clip, you can display HDR luminance values in the Motion canvas.

•	 Enhance Light and Color: Uses machine learning to analyze and adjust the tonal range 
of an image or clip, removing any visible color cast. When you click this button, the 
sliders in this filter are automatically set to that analysis and any overall color cast is 
removed. You can individually deselect the Light button or the Color button to exclude 
those parameters from the analysis.

Important: For best results when working with RAW or Log formats, use the Custom 
LUT filter to apply the appropriate camera manufacturer’s LUT to your media before 
using Enhance Light and Color.

To reset an analysis, deselect Enhance Light and Color, then select it again. (The slider 
values only change if you move the playhead to a different frame where the image has 
different tonal values, or when you choose another option from the Control Range pop-
up menu.)



969Motion User Guide

•	 Light: Adjusts the tonal range of an image. When you click this button, the six sliders 
below it are automatically set using machine learning. Manually adjusting a slider 
deselects the Light button, but retains the other slider values set by the machine 
learning analysis.

•	 Exposure: Lightens or darkens the image, revealing more detail at the low end or 
high end of the image.

•	 Contrast: Sets the relative amount of contrast between light and dark areas.

•	 Brightness: Sets the overall of brightness of the image.

Note: Because increasing brightness affects the entire image (including the 
shadows), a brightened image may look washed out.

•	 Highlights: Adjusts color, saturation, and brightness in the lightest regions of the 
image.

•	 Black Point: Sets the point at which the darkest parts of the image become 
completely black (no detail can be seen). Setting the black point can improve the 
contrast in a washed-out image.

•	 Shadows: Adjusts the detail that appears in the darkest regions of the image.

•	 Color: Adjusts the color of an image. When you click this button, the seven sliders 
below it are automatically set using machine learning to remove any overall color cast. 
Manually adjusting a slider deselects the Color button, but retains the other slider 
values set by the machine learning analysis.

•	 Saturation: Adjusts the color (chroma) intensity of the image.

•	 Highlights Warmth: Adjusts the color temperature in the lightest regions of the 
image. Increase the value to add warm (orange) tones to the image, or decrease the 
value to add cool (blue) tones.

•	 Highlights Tint: Fine-tunes the white balance in the lightest regions of the image 
by neutralizing green or magenta. Increase the value to add a magenta tint to the 
image, or decrease the value to add a green tint.

•	 Midtones Warmth: Adjusts the color temperature in the midtone areas of the image. 
Increase the value to add warm (orange) tones to the image, or decrease the value to 
add cool (blue) tones.

•	 Midtones Tint: Fine-tunes the white balance in the midtone regions of the image 
by neutralizing green or magenta. Increase the value to add a magenta tint to the 
image, or decrease the value to add a green tint.

•	 Shadows Warmth: Adjusts the color temperature in the darkest regions of the image. 
Increase the value to add warm (orange) tones to the image, or decrease the value to 
add cool (blue) tones.

•	 Shadows Tint: Fine-tunes the white balance in the darkest regions of the image 
by neutralizing green or magenta. Increase the value to add a magenta tint to the 
image, or decrease the value to add a green tint.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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Color Balance filter in Motion

Color balance refers to the relative strength of the red, green, and blue channels that 
constitute an image. For example, a blue-tinted image has a strong blue channel and 
weaker green and red channels.

For an example of using the Color Balance filter to match two composited layers, see 
Example: Color-balance two layers.

The Color Balance filter lets you adjust the relative balance of all three color channels of 
an image at once—for example, lowering the blue channel and raising the red and green 
channels to reduce blue tinting and yield an image that appears more orange and warm.

Color balance also relates to color temperature, which describes the quality of light in an 
image. For example, sunlight is generally more bluish than tungsten light, which is more 
orange. In professional film and video productions, white-balancing the camera before 
shooting usually ensures that whites in an image are neutral (with all three color channels 
balanced evenly). However, film stocks, optical filters, and digital white-balance settings 
can modify the tint of an image.

Note: The imbalanced color channels caused by a dominant color temperature in the 
lighting of an image is often referred to as a color cast.

You can use the Color Balance filter to adjust the three color channels of an image to 
eliminate a color cast or introduce one. Here are some uses for the Color Balance filter:

•	 Correct problems in lighting: For example, you can rebalance an image that’s too orange 
to appear more neutral.

•	 Match two images to one another: For example, you can match the quality of light on an 
actor in a foreground green screen clip to the lighting in a background image.

•	 Stylize the color of an image used in a creative composition: For example, you can 
create a high-contrast, blue-tinted silhouette from the image of two actors dancing for 
a title sequence.
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The Color Balance filter doesn’t just let you rebalance the overall strength of an image’s 
three color channels, it also lets you rebalance color specifically in three tonal zones of an 
image: shadows, midtones, and highlights. Three correspondingly named color controls let 
you make color balance adjustments in each zone of image tonality.

To make an adjustment to a zone, click the corresponding color well to open the macOS 
Colors window, then drag in the color wheel. As you drag, the image updates. Dragging in 
a specific hue’s direction rebalances the image, tinting it with that hue. The farther toward 
the edge of the color wheel you drag, the more intensely you tint the image.

 Tip: You can use any controls in the macOS Colors window to make color adjustments, 
including sliders, web-safe colors, and the magnifying glass picker. Further, you can save 
frequently used tints by dragging a color from the color bar at the top to an empty white 
swatch below. Clicking a filled swatch selects that color.

The adjustments to shadows, midtones, and highlights of an image overlap widely. For 
example, adjustments to shadows affect the darkest parts of the image the most, but the 
effect also influences midtones and lower highlights. This overlap ensures that adjustments 
you make blend seamlessly with the original colors of the image.

Note: Although you can make small contrast adjustments using the vertical lightness slider 
in the color wheel pane of the Colors window, it’s better to use a Contrast filter or a Levels 
filter to adjust the overall lightness and darkness of an image.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Shadows: Adjusts color channels in the darkest regions of the image. Click the color 
well to open the Colors window, then click a color in the color picker area, or click the 
eyedropper and click anywhere in the canvas to sample a color. You can also click the 
disclosure triangle to reveal individual red, green, and blue channel sliders.

•	 Midtones: Adjusts color channels in midtone regions of the image. Click the color well 
to open the Colors window, then then click a color in the color picker area, or click the 
eyedropper and click anywhere in the canvas to sample a color. You can also click the 
disclosure triangle to reveal red, green, and blue channel sliders.

•	 Highlights: Adjusts color channels in the lightest regions of the image. Click the color 
well to open the Colors window, then click a color in the color picker area, or click the 
eyedropper and click anywhere in the canvas to sample a color. You can also click the 
disclosure triangle to reveal red, green, and blue channel sliders.

In an SDR project, the Shadows, Midtones, and Highlights sliders have a numeric range 
from 0 (no color) to 0.5 (unaltered color) to 1.0 (maximum color). In an HDR project or 
Automatic project, the Shadows, Midtones, and Highlights sliders have a numeric range 
of 0 (no color) to 0.5 (unaltered color) to 4.0 (maximum color).

•	 Boost: Multiplies the values set in the Shadows, Midtones, and Highlights parameters. 
This is useful when using Color Balance for exposure balancing, allowing you to “blow 
out” an image. A boost applied to strong colors may yield unexpected results.

•	 Clip Color Values: Turns clipping on and off. Clipping prevents color adjustments from 
forcing color values out of the allowable range. Clipping can prevent illegal signal levels 
in clips that are output to video. There are four menu options:

•	 None: No clipping occurs.

•	 At White: In SDR, any color channel exceeding the maximum value of 1 is clipped to 
1; in HDR, any color channel exceeding the maximum value of 4 is clipped to 4.

•	 At Black: Any color channel falling below the minimum value of 0 is clipped to 0.

•	 At Black and White: In SDR, all color channels are clipped to a minimum of 0 and 
a maximum of 1; in HDR, all color channels are clipped to a minimum of 0 and a 
maximum of 4.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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Example: Color-balance two layers in Motion

This example demonstrates how to use the Color Balance filter to match the color of a 
green-screened foreground image to a background image. A green screen clip has been 
composited with a background layer using the Green Screen Keyer filter. (For information 
about using the Green Screen Keyer filter, see Intro to the Green Screen Keyer filter.) 
The background layer has already been modified with the Defocus and Contrast filters to 
appear moody and blurred (simulating a shallow depth of field).

Although the key is successful, the light illuminating the woman doesn’t quite match the 
light that illuminates the background.

You can fix this using the Color Balance filter.

Match a foreground subject to a background image using the Color Balance filter
1.	 In Motion, open the Library, click the Filters category, then click the Color category to 

reveal the color-correction filters in the stack.

2.	 Drag the Color Balance filter from the stack to the Layers list, onto the topmost layer of 
the composite (the keyed foreground layer).

The Color Balance filter appears above of the Green Screen Keyer filter in the Layers 
list.

3.	 In the Filters Inspector, click the Highlights color well in the Color Balance controls.

Highlights are often a good place to start when you need to match the color 
temperature of one image to another.
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4.	 In the macOS Colors window, drag from the center of the color wheel toward a color 
applicable to your image, such as the predominant color of the background layer’s 
lighting in this example.

As you drag in the color wheel, the color of highlights in the canvas changes, with the 
color in the brightest highlights of the foreground image changing the most. Midtones 
are less affected, and shadows aren’t affected at all.

Stop adjusting when the color of the foreground layer’s highlights matches the color of 
similar highlights in the background.

 Tip: You can also use the eyedropper tool in the Highlights color control to sample a 
highlight color in the background layer. (Click the eyedropper, then click a color in the 
background.) This can be a simpler adjustment, but it can also be tricky to sample the 
best color for a natural-looking match.

Color Curves filter in Motion

Provides color curves for precise adjustments of the components of individual color 
channels in an image, as well as the luma channel.

To learn how to use the controls described below, see Use the Color Curves filter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 View: Sets the layout of the curves. This pop-up menu has two options:

•	 All Curves: Displays the Luma, Red, Green, and Blue curves at once.

•	 Single Curves: Displays one large curve at a time. In Single Curves view, click a 
button above the curve to display a specific curve.

•	 Luma: A curve control to adjust the brightness in the image.

•	 Red: A curve control to adjust the red color channel in the image.

•	 Green: A curve control to adjust the green color channel in the image.

•	 Blue: A curve control to adjust the blue color channel in the image.
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•	 Eyedropper tool: Available for each curve, selects the luma value or the color to be 
adjusted in the curve.

•	 Reset button: Available for each curve, resets the curve to its default value.

•	 Preserve Luma: Select this checkbox to maintain the overall brightness of a clip despite 
changes in one or more color channels.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected image.

Use the Color Curves filter in Motion
You can use color curves to adjust the components of individual color channels in an 
image. You can adjust the global luma channel as well as the red, green, and blue color 
channels. You can also select a custom color in a clip and adjust its intensity, or select a 
mix of different colors in a clip and adjust their intensities at the same time.

When you apply the Color Curves filter, its settings appear in the Filters Inspector:

A color curve is a graph that lets you remap a color channel’s luminance (intensity) values. 
The straight diagonal line represents the tonal ranges of the color channel before you make 
changes to the image, with shadows on the left side of the diagonal line, midtones in the 
center, and highlights on the right.
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The vertical axis in the graph represents the luminance changes you make to the color 
channel, by dragging up or down at any point along the diagonal line. So, for example, 
in the Red curve control, dragging up on the left side of the diagonal line increases the 
intensity of red in the shadows—making the dark areas look more intensely red. Dragging 
down on the left side of the line reduces the intensity of red in the shadows—making the 
dark areas look more blue-green.

Note: Because you can apply multiple color filters to an image, you’re not required to follow 
all of the steps below, nor the order of those steps. For example, you might adjust the 
overall contrast with the Color Curves filter and adjust a color tint with the Color Wheels 
filter. Or you could achieve the same results with multiple instances of the same effect.

 Tip: You can simultaneously animate all parameters of the Color Curves filter. See 
Globally animate all parameters of a Color Curves, Color Wheels, or Hue/Saturation Curves 
filter.

Apply the Color Curves filter
1.	 In Motion, open the Library, click the Filters category, then click the Color category to 

reveal the color-correction filters.

2.	 Drag the Color Curves filter to the layer in the Layers list you want to adjust.

The Color Curves controls appear in the Filters Inspector.
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3.	 In the Filters Inspector, click the View pop-up menu at the top of the filter controls and 
choose a display option:

•	 All Curves: Displays all four curves (Luma, Red, Green, and Blue) at once.

•	 Single Curves: Displays one large curve at a time. In Single Curves view, click a 
button above the curve to display a specific curve.

To color-correct the image, follow the instructions below.

Adjust the intensity of a primary color channel or luma channel
1.	 In Motion, apply a Color Curves filter to a clip or image, as described in the previous 

task.

2.	 Do one of the following:

•	 Adjust a primary color channel: Click the Red, Green, or Blue curve (the diagonal 
line) to add a control point.

 Tip: Click somewhere on the lower-left side of the line to adjust mostly shadows 
of a given color; click in the center of the line to adjust mostly midtones; or click the 
upper-right side of the line to adjust mostly highlights

•	 Adjust the luma channel: To set the black and white points, drag the control points 
on the ends of the Luma curve. Click the Luma curve (the white diagonal line) to add 
a control point.

Adjust the white point to modify the very brightest parts of an image; adjust the 
black point to modify the very darkest parts of an image. You can expand the tonal 
range of your image by increasing the white point and black point as far as you can 
without clipping (forcing values out of the allowable range).
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3.	 Drag the control point up to increase the intensity of the color or luma value, or down to 
decrease the intensity.

To constrain the control point to vertical or horizontal movement, press and hold the 
Shift key as you drag. To make fine adjustments, press and hold the Option key as you 
drag.

Adjusting the image with a single control point affects most of the midtones as well as 
some shadows and highlights.

4.	 To narrow the tonal range for your adjustments, add more control points.

The default diagonal line for each curve indicates the original state of the image. 
Wherever the curve diverges from the diagonal line, the image is altered. Wherever the 
curve touches the diagonal line, the values of the image at that tonality are the same 
as in the original image. For example, to prevent any change to the shadows, you could 
add a control point to pin the curve to the diagonal line in the shadows area.

5.	 Add and drag control points as needed.

To delete a control point, select it and press Delete.
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To reset the values for a color curve, click its reset button (the curved arrow). To reset 
the values for all color curves and value sliders, move the pointer over the upper-right 
corner of the filter controls, then click the Animation pop-up menu (the down arrow that 
appears) and choose Reset Parameter.

6.	 At the bottom of the filter controls, adjust any of the following:

•	 Preserve Luma: Select this checkbox to maintain the overall brightness of a clip 
despite changes in one or more color channels.

•	 Mix: Set the amount of the original image that’s blended with the color-corrected 
image.

Adjust the intensity of a custom color or range of colors
You can also select a custom color or a range of custom colors and then adjust the 
intensity.

1.	 In Motion, apply a Color Curves filter to a clip or image.

2.	 Do one of the following:

•	 Select a custom color using the eyedropper tool: Click the eyedropper tool at the top 
of one of the color curves, then click in the canvas to select a single color, or drag in 
the canvas to select a range of colors.

•	 Select a custom color using a color wheel control: Click the name of a color curve (in 
the top-left corner of the curve), then click or drag in the color wheel.

3.	 Click the curve (the diagonal line) to add a control point.

To delete a control point, select it and press Delete.

 Tip: Click somewhere on the lower-left side of the line to adjust mostly shadows of a 
given color; click in the center of the line to adjust mostly midtones; or click the upper-
right side of the line to adjust mostly highlights.

4.	 Drag the control point up to increase the intensity of the color or down to decrease its 
intensity.

5.	 To narrow the tonal range for your adjustments, add more control points.
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Reduce color cast in a clip
If a clip wasn’t white-balanced properly during shooting, it may exhibit a strong color cast 
(a bluish or other hue). Oftentimes, you can correct or reduce this issue using the Color 
Curves filter.

1.	 In Motion, apply a Color Curves filter to the clip or image.

2.	 Click the eyedropper tool at the top of one of the color curves, then click or drag in the 
canvas over an area of the image that’s supposed to be white, such as a white sheet of 
paper. 

A vertical gray line appears on the color curve.

3.	 Click to add a control point where the gray line intersects the curve, then drag the 
control point down until the selected color in the canvas turns white.

To delete a control point, select it and press Delete.

After you apply a color correction, you can copy it to another image or group. See Copy 
and paste a filter to another layer or group.

 Tip: If you frequently add a particular color filter, you can speed up your workflow by 
saving the correction as a Motion template. (However, you cannot publish the Color Curves 
filter as a custom Final Cut Pro effects template.)

Color Reduce filter in Motion

Reduces the full range of color in an image to two, three, or four colors that you select. 
Depending on the number of substitute colors you choose in the Reduce To parameter, this 
filter breaks down the full range of colors in the image into a color range for each Match 
Color parameter that’s available. The filter then substitutes the selected Replace With color 
for each interpreted range of color.

If two colors are selected, color information in the layer is reduced to the selected two 
colors; if three colors are selected, color information is reduced to three colors; and so on.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Smoothness: Sets the smoothness of the transitions between reduced areas. Values 
range from 0 (hard edges) to 1 (smooth blending).

•	 Reduce To: Sets the number of colors in the reduced layer to two, three, or four colors.

•	 Match Color 1–4: Picks the color to be replaced. Click the disclosure triangle to reveal 
Red, Green, and Blue sliders for more precise color selection.
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•	 Replace With: Picks the color to replace the color shown in the previous Match Color 
control.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.

Color Wheels filter in Motion

Provides four color wheel controls to adjust color in your images. You can also adjust a 
clip’s brightness and saturation levels using sliders on the sides of the color wheels.

To learn how to use the controls described below, see Use the Color Wheels filter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 View: Sets the layout of the color wheels. This pop-up menu has two options:

•	 All Wheels: Displays all four color wheels (Global, Shadows, Midtones, and 
Highlights).

•	 Single Wheels: Displays one large color wheel at a time. In Single Wheels view, click 
a button to display a specific wheel (Global, Shadows, Midtones, or Highlights).

•	 Color wheels: Graphical controls to adjust the color, saturation, and brightness of an 
image. Drag the center control to modify color; drag the left slider to modify saturation; 
drag the right slider to modify brightness. Click the reset button (the curved arrow) 
below a wheel to reset the wheel to its default values. There are four color wheels:

•	 Global: Adjusts the color, saturation, and brightness of the entire image.

•	 Shadows: Adjusts color, saturation, and brightness in the darkest regions of the 
image.

•	 Highlights: Adjusts color, saturation, and brightness in the lightest regions of the 
image.

•	 Midtones: Adjusts color, saturation, and brightness in the midtone regions of the 
image.

•	 Temperature: Adjusts the color temperature (warmness versus coolness) of the image.

•	 Tint: Adjusts the mix of green versus magenta in an image.

•	 Hue: Uniformly remaps the colors throughout an image.

•	 Global, Shadows, Midtones, Highlights: Click the disclosure triangles to reveal four sets 
of numeric sliders that adjust the same parameters (color, saturation, and brightness) 
as the color wheels described above.

•	 Mix: Sets the amount of the original image that’s blended with the color-corrected 
image.
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Use the Color Wheels filter in Motion

The Color Wheels filter contains four color wheel controls (Global, Shadows, Midtones, and 
Highlights) to adjust color, brightness, and saturation in clips and images.

When you apply the Color Wheels filter, its settings appear in the Filters Inspector:

Note: Because you can apply multiple color filters to an image, you’re not required to follow 
all of the steps below, nor the order of those steps. For example, you might adjust the 
overall contrast with the Color Curves filter and adjust a color tint with the Color Wheels 
filter. Or you could achieve the same results with multiple instances of the same effect.

 Tip: You can simultaneously animate all parameters of the Color Wheels filter. See 
Globally animate all parameters of a Color Curves, Color Wheels, or Hue/Saturation Curves 
filter.

1.	 In Motion, open the Library, click the Filters category, then click the Color category to 
reveal the color-correction filters.

2.	 Drag the Color Wheels filter to the layer in the Layers list you want to adjust.

The Color Wheels controls appear in the Filters Inspector.



983Motion User Guide

3.	 In the Filters Inspector, click the View pop-up menu at the top of the filter controls and 
choose a display option:

•	 All Wheels: Displays all four color wheels at once.

•	 Single Wheels: Displays one large color wheel at a time. In Single Wheels view, click 
a button above the curve to display a specific wheel.

The Global color wheel adjusts the entire tonal range of the image; the other color 
wheels adjust only the shadows, midtones, or highlights.

4.	 To change an image’s brightness, color, or saturation, adjust the controls for a color 
wheel in any of the tonal ranges:

•	 Adjust the color value: Drag the color control in the center of a wheel.

You can also move the color control by selecting it, then pressing the Up Arrow, 
Down Arrow, Left Arrow, or Right Arrow key.

•	 Adjust the saturation: Drag the Saturation slider on the left side of a wheel.

•	 Adjust the brightness: Drag the Brightness slider on the right side of a wheel.

Note: You can also adjust color, saturation, and brightness values using the Global, 
Shadows, Midtones, and Highlights value sliders below the color wheels. Click the 
disclosure triangles to reveal these controls.
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To make fine adjustments, press and hold the Option key as you drag a control in a color 
wheel.

5.	 Use the controls under the color wheels to adjust any of the following:

•	 Temperature: Adjust the color temperature, in degrees kelvin, so that the image 
looks as natural as possible. Color temperature describes the color value of light 
when the image was shot (not the light’s heat value). Drag the slider to the left to 
increase blue tones, or to the right to increase yellow-red tones. For example, if 
the image was shot under tungsten lights but the camera was set to daylight white 
balance, set the value between 2500 and 2900 degrees kelvin to white-balance the 
image.

•	 Tint: Fine-tune the white-balance adjustment by neutralizing a remaining green or 
magenta tint. Drag the Tint slider to the left to add a green tint to the image, or to 
the right to add a magenta tint.

•	 Hue: Use the Hue dial or value slider to set a value from 0° to 360°, effectively 
rotating all hues in the image around the perimeter of the color wheel. A value of 0° 
represents the original image.

•	 Mix: Adjust this slider to set the amount of the original image that’s blended with the 
color-corrected image.
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To reset the values for a color wheel, click its Reset button. To reset the values for all 
color wheels and value sliders, click the down arrow (in the upper-right corner of the 
filter controls) to open the Animation pop-up menu, then choose Reset Parameter.

Note: You cannot publish the Color Wheels filter as a Final Cut Pro custom effects template.

Colorize filter in Motion

Substitutes the blacks and whites in an image with colors you select. All other colors in the 
image are remapped to a duochrome range that falls between these two colors.

You can create interesting colorized negative effects by mapping a lighter color to the 
blacks and a darker color to the whites.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Remap Black To: Sets the color that’s mapped to black. Click the disclosure triangle to 
reveal individual Red, Green, and Blue sliders to more precisely select the color.

•	 Remap White To: Sets the color that’s mapped to white. Click the disclosure triangle to 
reveal individual Red, Green, and Blue sliders to more precisely select the color.

•	 Intensity: Sets the strength of the colorization. Values range from 0 (no colorization) to 1.0.

•	 Mix: Sets the percentage at which the original image is blended with the color-
corrected image.
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Contrast filter in Motion

Adjusts the difference between the lightest and darkest parts of an image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Contrast: Sets the amount of contrast to be applied to the image.

•	 Pivot: Sets the point around which the contrast is adjusted. The point of contrast 
adjustment is the level that’s displayed if Contrast is set to 0.

•	 Smooth Contrast: Smooths the falloff on both the low and high ends of the contrast 
change.

•	 Luminance Only: Select this checkbox to protect the image from oversaturation when its 
contrast is increased.

•	 Clip Color Values: Turns clipping on and off. Clipping prevents color adjustments from 
forcing color values out of the allowable range. Clipping can prevent illegal signal levels 
in clips that are output to video. This pop-up menu has four options:

•	 None: No clipping occurs.

•	 At White: Any color channel exceeding the maximum value of 1 is clipped to 1.

•	 At Black: Any color channel falling below the minimum value of 0 is clipped to 0.

•	 At Black and White: All color channels are clipped to a minimum of 0 and a maximum 
of 1.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.



987Motion User Guide

Custom LUT filter in Motion

Applies a lookup table (LUT) to an image. A lookup table (LUT) is a set of data that enables 
a numeric transformation of pixel values to change the way an image looks.

A common use of LUTs is to stylize video clips with a particular “look.” Beyond just 
matching some objective model of exposure, you can subtly mix color to enhance the story 
you’re telling with your project. Color adjustments can alter the audience’s perception of 
the scene being played, changing a program’s mood.

Another common use of LUTs in video post-production is log conversion. Many modern 
cameras have a log or wide-dynamic-range recording option that provides more f-stops of 
exposure latitude in the image. Video footage recorded with this option initially looks “flat.” 
You can apply LUTs to change the appearance of log footage to a standard broadcast 
specification.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 LUT: Selects the LUT that’s applied to the layer or group. This pop-up menu has the 
following options:

•	 None: No LUT is applied.

•	 [List of available custom LUTs]: Displays a list of LUTs added using the Choose 
Custom LUT command (described below). Choose any LUT in this list to apply the 
LUT to a clip or image in the affected layer.

•	 Recent: Opens a submenu with two options:

•	 [LUT list]: Lists recently imported LUTs.

•	 Clear Recent: Clears the list of recently imported LUTs (but doesn’t clear the list 
of available custom LUTs).

•	 Choose Custom LUT: Opens an import window that allows you to navigate to and 
import a LUT. (You can import 3D LUT files with the filename extensions .cube and 
.mga. Motion doesn’t support 1D LUTs.)

•	 Reveal in Finder: Shows the location of the current LUT in the Finder.

•	 Convert: Sets the color space of the selected LUT. This parameter has two options:

•	 Input: Sets the input color space of the selected LUT to Rec. 709, Rec. 2020, Rec. 
2020 PQ, or Rec. 2020 HLG.

•	 Output: Sets the output color space of the selected LUT to Rec. 709, Rec. 2020, 
Rec. 2020 PQ, or Rec. 2020 HLG.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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Use the Custom LUT filter in Motion

The Custom LUT filter in Motion applies stylized film and video “looks” (such as Summer, 
Old Timey, Sci-Fi, and so on), camera LUTs, or tone mapping (to convert footage from one 
color space to another).

To use LUTs in Motion, add the Custom LUT filter to a layer in your project, import third-
party LUTs into the filter, then choose the LUT you want to apply to your footage.

Note: Stylized LUT effects are available from a variety of third-party sources. Camera 
LUTs, used to convert “flat” or log footage from high-end cameras to standard color 
spaces, are available from many camera manufacturers and other sources.

Apply a LUT
1.	 In Motion, open the Library, click the Filters category, then click the Color category to 

reveal the color-correction filters.

2.	 Drag the Custom LUT filter to the layer in the Layers list you want to adjust.

The Custom LUT controls appear in the Filters Inspector.

3.	 In the Filters Inspector, click the LUT pop-up menu and select Choose Custom LUT. 

4.	 In the dialog that appears, navigate to the LUT file you want to import, then select it.

You can import LUT files with the filename extensions .cube and .mga. (Motion does not 
support 1D LUTs.) You can select single files, multiple files, or a folder of files.

5.	 Click Open.

The LUT you imported appears as the selected LUT at the top of the Custom LUT 
section.

If you imported a folder of LUT files, it appears as a submenu in the LUT pop-up menu. 
(In this case, choose a LUT from the submenu.)
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6.	 To add additional LUTs to your project, repeat steps 3 through 5, above.

To apply a different LUT, click the LUT pop-up menu and choose a LUT from the list.

Note: Although you can import multiple LUTs into the Custom LUT filter, you can apply 
only one LUT at a time. (To apply additional LUTs to the same footage, you must apply 
additional Custom LUT filters).

7.	 Click the Input pop-up menu and choose the color space the LUT converts from.

This color space was determined when the custom LUT was created.

Note: Camera LUTs and custom LUTs typically include the names of the input (source) 
color space and intended output (target) color space in the LUT filename. If you’re not 
sure which color space to choose, see the LUT creator for more information.

8.	 Click the Output pop-up menu and choose the color space the LUT converts to.

This color space was determined when the custom LUT was created.

9.	 To optionally set the amount of the original image to be blended with the adjusted 
image, drag the Mix slider.

Remove a LUT
When you import a LUT into the Custom LUT filter, a copy of the LUT is placed in the /
Users/username/Library/Application Support/ProApps/Custom LUTs/ folder.

To remove a LUT from the Custom LUT filter, use the Reveal in Finder command, then 
delete the LUT file.

1.	 In Motion, in the Custom LUT controls in the Filters Inspector, click the LUT pop-up 
menu and choose Reveal in Finder.

The Custom LUTs folder opens in the Finder.

2.	 Drag the LUT file you want to remove to the Trash, then quit and reopen Motion.
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Share a LUT
You can also use the Reveal in Finder command to locate a LUT and then share it with 
others.

1.	 In Motion, in the Custom LUT controls in the Filters Inspector, click the LUT pop-up 
menu and choose Reveal in Finder.

The Custom LUTs folder is in the following location:

/Users/username/Library/Application Support/ProApps/Custom LUTs/

2.	 In the Finder, select the LUT files you want to share, then choose File > Compress.

Compressing the files prevents any change to custom LUTs during transit.

3.	 Transfer the resulting ZIP file (with the filename extension .zip) to your friend or 
colleague using email or another convenient method.

Note: Because Motion stores third-party LUTs externally (outside of Motion projects), it’s 
inadvisable to use LUTs in templates created for Final Cut Pro. 

Gamma filter in Motion

Adjusts the relative distribution of brightness in the midtones of an image, without 
adjusting the white and black points. The perceived result is to brighten and darken 
the areas of medium brightness in an image, while leaving the highlights and shadows 
untouched. This avoids a washed-out effect.

This is one of the most useful filters for correcting poor exposure in images, and should 
almost always be used first before trying the Brightness filter.

 Tip: When opening projects created in earlier versions of Motion, previous gamma 
adjustments may be lost. Use the Gamma filter to reproduce the effect.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Gamma: Sets the gamma correction.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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Gradient Colorize filter in Motion

Uses each pixel’s color value to determine the application of a color value from a gradient.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Gradient: Selects a gradient preset to be applied to the image. You can also use this 
control also used to edit a custom gradient.

For more information on using the Gradient editor, see Change gradient color and 
opacity.

•	 Offset: Sets an amount, in degrees, that the color wheel is offset to determine color 
application. Values start at 0 degrees.

•	 Repeats: Sets the number of times the gradient repeats over the course of its range.

•	 Repeat Method: Sets the method by which the gradient is mapped when repeating. 
Values can be set to Mirror (default) or Wrap. This parameter affects the filter when 
Repeats is set to a number greater than 1.

•	 Map Channel: Sets the channel used to determine how the image is colorized. Values 
can be selected from the following: Luminance (default), Red, Green, Blue, or Alpha.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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HDR Tools filter in Motion

Use the HDR Tools filter to manually convert HDR or SDR images, clips, or Motion objects 
from one color space to another or to set the luminance (nits) of a video clip to a specific 
level.

The HDR Tools filters is best used in Standard Gamut SDR projects or Wide Gamut HDR 
projects. It’s not recommended for use in Automatic projects, where the color space of 
your media is automatically managed. (Applying the HDR Tools filter in an Automatic 
project has an additive effect to any existing conversion.)

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Mode: Sets one of nine color space options:

•	 SDR to 100% HDR (HLG): Converts Rec. 709 SDR media to full HDR HLG luminance 
levels.

•	 SDR to 75% HDR (HLG): Converts Rec. 709 SDR media to partial HDR HLG luminance 
levels.

•	 SDR to HDR (PQ): Converts Rec. 709 SDR media to full HDR PQ luminance levels.

•	 HLG to Rec. 709 SDR: Converts HLG media to Rec. 709 SDR luminance levels.

•	 PQ to Rec. 709 SDR: Converts PQ media to Rec. 709 SDR luminance levels.

•	 HLG to PQ (Rec. 2100): Converts HLG media to PQ luminance levels. Maintains the 
brightness at a level you set in the Peak Brightness slider (in accordance with Rec. 
ITU-R BT.2100-1) when applied to HLG media in PQ projects.

•	 PQ to HLG (Rec. 2100): Converts PQ media to HLG luminance levels. Maintains the 
brightness at a level you set in the Peak Brightness slider (in accordance with Rec. 
ITU-R BT.2100-1) when applied to PQ media in HLG projects.

•	 HDR to Rec. 709 SDR: Converts HDR media (such as PQ, HLG, or log media that has 
been color-corrected in HDR) to Rec. 709 SDR luminance levels.

•	 PQ Output Tone Map: Reduces the brightness of PQ media to the level you set in the 
Peak Brightness slider (described below), and applies a soft rolloff to the highlights 
so they don’t clip abruptly. Use this setting in PQ projects only, and apply it as the 
last effect.

Note: For some modes, such as SDR to 100% HDR (HLG), further adjustments to the 
image may be necessary to fine-tune the look.
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•	 Peak Brightness: For some Mode settings, this slider becomes available. Sets the 
nominal peak luminance of a display or sets a clip’s maximum luminance on a display to 
a specific level:

•	 When Mode is set to SDR to HDR (PQ), this slider sets the nominal peak luminance 
of the (HDR) display on which the SDR content is displayed. For example, if you want 
to convert an SDR clip to HDR PQ and want the resulting PQ clip to look identical to 
an HDR clip on a 1000-nit display, set the Peak Brightness slider to 1000.

•	 When Mode is set to PQ to Rec. 709 SDR, this slider sets the peak input level of the 
PQ media being converted to Rec. 709 SDR luminance levels. To avoid clipping, set 
the Peak Brightness to match the peak levels of the PQ media you’re converting. For 
example, if you apply this conversion to a PQ clip graded at 2,000 nits, everything 
above 1,000 nits will be clipped in the conversion. To retain and tone map the 
highlight detail into the Rec. 709 SDR color space, set Peak Brightness to 2000.

Note: PQ to SDR conversions are limited to a maximum input of 5,000 nits using the 
HDR Tools filter.

•	 When Mode is set to HLG to PQ (Rec. 2100) or PQ to HLG (Rec. 2100), this slider 
sets the nominal peak luminance of the (HLG) display on which the HLG content 
is displayed. For example, if you want to convert an HLG clip to PQ and want the 
resulting PQ clip to look identical to an HLG clip on a 1000-nit display, set the Peak 
Brightness parameter to 1000.

•	 When Mode is set to PQ Output Tone Map, this slider limits the clip’s peak 
luminance. For example, if you want to limit your clip to 1,000 nits, set Peak 
Brightness to 1000.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image. For the most accurate results when using the HDR Tools filter, keep this setting 
at 100%.

Hue/Saturation filter in Motion

Provides controls to adjust hue, saturation, and value levels in an image. The Hue control 
is an angular representation of the color values in an image. By rotating the Hue dial, you 
uniformly remap the colors throughout an image, similar to the effect of turning the hue or 
phase knob of a broadcast monitor.

The Saturation slider controls the intensity of color in an image, with a high value resulting 
in vivid color, and a low value resulting in a grayscale image with no color at all. The Value 
slider adjusts the overall brightness or darkness of all colors in an image, including the 
blacks and whites in a desaturated image.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Hue: Sets the angle of adjustment used to set the zero point of the color wheel.

•	 Saturation: Sets the color saturation of the image, ranging from –1.0 (no color 
information) to 0.0 (unadjusted color) to 3.0.

•	 Value: Sets the intensity adjustment applied to the image.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.

Hue/Saturation Curves filter in Motion

Provides adjustable curves that let you precisely control the hue, saturation, and 
brightness of any color in an image layer in your project. Using the curves and control 
points, you can adjust ranges of brightness or saturation, rather than the overall image.

To learn how to use the controls described below, see Use the Hue/Saturation Curves filter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 View: Sets the layout of the curves. This pop-up menu has two options:

•	 All Curves: Displays all six curves at once.

•	 Single Curves: Displays one large curve at a time. In Single Curves view, click a 
button above the curve to display a specific curve.
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•	 Hue vs Hue: A curve control to change the color (hue) of any range of hues in the 
image.

•	 Hue vs Sat: A curve control to change the saturation of any hue in the image.

•	 Hue vs Luma: A curve control to adjust the brightness of any hue in the image.

•	 Luma vs Sat: A curve control to adjust the saturation for a range of brightness in an 
image.

•	 Sat vs Sat: A curve control to adjust the saturation of a range of saturation in the 
original image.

•	 Orange vs Sat: A curve control to adjust a specific color’s saturation at any point along 
its range of tonality from darkest to brightest. The default color to adjust is orange 
(because it aligns with skin tone); click the down arrow next to the curve name to 
choose a different color.

•	 Eyedropper tool: Available for each curve, selects the color to be adjusted in the curve.

•	 Reset button: Available for each curve, resets the curve to its default value.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.

Use the Hue/Saturation Curves filter in Motion

The six curve controls in the Hue/Saturation Curves filter provide maximum precision for 
color-correcting your images. Not only can you adjust the hue, saturation, and brightness 
of any color in your project, you can also adjust the saturation for a range of brightness or 
a range of saturation in a clip, and you can adjust the saturation of a specific color at any 
point in its range of brightness.

To use the curve controls, apply the Hue/Saturation Curves filter to a layer in your project.

Note: Because you can apply multiple color filters to an image, you’re not required to follow 
all of the steps below, nor the order of those steps.

Apply the Hue/Saturation Curves filter
1.	 In Motion, open the Library, click the Filters category, then click the Color category to 

reveal the color-correction filters.
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2.	 Drag the Hue/Saturation Curves filter to the layer in the Layers list you want to adjust.

The Hue/Saturation Curves controls appear in the Filters Inspector.

3.	 In the Filters Inspector, click the View pop-up menu at the top of the filter controls and 
choose a display option:

•	 All Curves: Displays all six curves at once.

•	 Single Curves: Displays one large curve at a time. In Single Curves view, click a 
button above the curve to display a specific curve.

To color-correct the image, follow the instructions below for the adjustment you want 
to make.
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Adjust the hue, saturation, or brightness of a color
1.	 In Motion, apply a Hue/Saturation Curves filter, as described in the previous task.

2.	 In the Filters Inspector, click the eyedropper for the curve that you want to use:

•	 Hue vs Hue: Changes the color (hue) of any range of hues in the image.

•	 Hue vs Sat: Changes the saturation of any hue in the image.

•	 Hue vs Luma: Changes the brightness of any hue in the image.

3.	 In the canvas, click or drag over the color in the image that you want to adjust.

Dragging increases the range of color selected.

Three control points appear on the curve in the Filters Inspector. The control point with 
the vertical line represents the color you selected with the eyedropper. Two additional 
control points represent a buffer range of adjacent hues that were also selected (to 
ensure a more natural gradient of selected color). In the following image, the orange 
control point represents the color selected with the eyedropper, and the green and 
magenta control points represent adjacent hues on the color spectrum.

In the above image, notice that red hues appear on the left side of the graph and on 
the right side of the graph. This is because the hue curve wraps around the graph, 
representing the spectrum of colors.
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Note: You can also create control points by clicking the curve, but the eyedropper 
method is generally more precise. To delete a control point, select the point, then press 
the Delete key.

4.	 Drag the control point with the vertical line to modify the selected color range.

Each curve modifies a selected color in a different way:

•	 Hue vs Hue: Dragging the control point up or down moves the selection through the 
hues of the spectrum.

When the orange control point is moved, the curve adjusts on both sides of the 
graph. This is because the buffer range of hues adjacent to the orange control point 
wrap around the curve. (When viewed on a color wheel, orange and red hues appear 
between the green and magenta hues.) In this case, hue adjustment is limited to the 
values between control points on either side of the orange control point. Hues in the 
center of the graph—the range between the green and magenta control points—are 
not affected.

The image updates in the canvas, showing the new color selection.



999Motion User Guide

Note: If you use the Hue vs Hue curve to change the hue and then use the 
eyedropper in any other curve in the same instance of the Hue/Saturation Curves 
filter, the eyedropper selects the original hue—not the altered hue. To select the 
altered hue, adjust the control points without using the eyedropper, or add a second 
instance of the Hue/Saturation Curves filter.

•	 Hue vs Sat: Dragging the control point up increases the selected color’s saturation, 
and dragging the control point down decreases the saturation.

•	 Hue vs. Luma: Dragging the control point up increases the selected color’s 
brightness, and dragging the control point down decreases the brightness.

Note: To make fine adjustments, press and hold the Option key as you drag a control 
point. To constrain the control point to vertical or horizontal movement only, press 
and hold the Shift key as you drag.
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5.	 To broaden the selected color range, drag the two outer control points to the left or the 
right, or just delete them.

To reset the values for a color curve, click its Reset button (the curved arrow). To reset 
the values for all curves, click the down arrow in the upper-right corner of the filter 
controls to open the Animation pop-up menu, then choose Reset Parameter.

Adjust the saturation for a range of brightness
You can use the Luma vs Sat curve to create special looks and to make a clip broadcast-
safe by reducing oversaturation.

1.	 In Motion, apply a Hue/Saturation Curves filter, as described above.

2.	 In the Filters Inspector, click the eyedropper for the Luma vs Sat curve.

If all six curves are shown in the Inspector, you may need to scroll to see the Luma vs. 
Sat curve. In Single Curves view, click the LvS button at the top to display the curve.

3.	 In the canvas, click or drag over the color in your image whose saturation you want to 
adjust.
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Control points (in addition to the two start and end control points) appear on the curve 
in the Filters Inspector. The control point with the vertical line represents the level of 
luma (brightness) for the color you selected with the eyedropper. The control points on 
either side of the control point with the vertical line represent a buffer range of adjacent 
brightness values (to ensure a more natural gradient of selected brightness).

Note: You can also create control points by clicking the curve, but the eyedropper 
method is generally more precise. To delete a control point, select the point, then press 
the Delete key.

4.	 Drag the control point with the vertical line up to increase color saturation in the 
selected range of brightness, or down to decrease the color saturation.

Note: To make fine adjustments, press and hold the Option key as you drag a control 
point. To constrain the control point to vertical or horizontal movement only, press and 
hold the Shift key as you drag.

The luma change is updated in the canvas.
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5.	 To adjust the range of luma values selected, drag the two outer control points to the left 
or the right, or just delete them.

6.	 To adjust the saturation for a different range of brightness, click the curve to add 
control points, then adjust them as needed.

Add and adjust control points on the left end of the curve to adjust shadows; add and 
adjust control points in the middle of the curve to adjust midtones; or add and adjust 
control points on the right end of the curve to adjust highlights. Drag any control point 
up or down to increase or decrease saturation for that region of brightness.

Adjust the saturation within a range of saturation
The Sat vs Sat curve allows you to create special looks by selecting and adjusting a range 
of saturation within the image’s original saturation. You can increase the saturation of 
areas with low saturation, or you can desaturate oversaturated areas to make them safe for 
broadcast. In the example below, the saturation is increased in a region of low saturation in 
the original image.

1.	 In Motion, apply a Hue/Saturation Curves filter, as described above.

2.	 In the Filters Inspector, click the eyedropper for the Sat vs Sat curve.

If all six curves are shown in the Inspector, you may need to scroll to see the Sat vs. Sat 
curve. In Single Curves view, click the SvS button at the top to display the curve.

3.	 In the canvas, click or drag over the color in your clip whose saturation you want to 
adjust.

Control points (in addition to the two start and end control points) appear on the curve 
in the Filters Inspector. The control point with the vertical line represents the level of 
saturation you selected with the eyedropper. Two additional control points on either 
side of the middle point represent a buffer range of adjacent saturation values that were 
also selected (to ensure a more natural gradient of selected saturation values).
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Note: You can also create control points by clicking the curve, but the eyedropper 
method is generally more precise. To delete a control point, select the point, then press 
the Delete key.

4.	 Drag the control point with the vertical line up to increase the color saturation in the 
selected saturation range, or down to decrease the saturation.

Note: To make fine adjustments, press and hold the Option key as you drag a control 
point. To constrain the control point to vertical or horizontal movement only, press and 
hold the Shift key as you drag.

The saturation change is updated in the canvas.

5.	 To change the range of saturation selected, drag the two outer control points to the left 
or the right, or just delete them.

6.	 To adjust the saturation for a different range of saturation, click the curve to add control 
points, and adjust them as needed.

Add and adjust control points on the left end of the curve to adjust regions of low 
saturation; add and adjust control points in the middle of the curve to adjust regions 
of medium saturation; or add and adjust control points on the right end of the curve 
to adjust highly saturated regions. Drag any control point up or down to increase or 
decrease saturation for that region of saturation.
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Adjust the saturation of a specific color at any point along its range of brightness
You can use the Orange vs Sat curve to adjust a specific color’s saturation at any point 
along its range of tonality from darkest to brightest.

Note: The default color for the curve is orange (because it aligns with skin tone), but you 
can select any color and adjust its saturation.

1.	 In Motion, apply a Hue/Saturation Curves filter, as described above.

2.	 In the Filters Inspector, click the eyedropper for the Orange vs Sat curve.

If all six curves are shown in the Inspector, you may need to scroll to see the Orange vs. 
Sat curve. In Single Curves view, click the Orange button at the top to display the curve.

3.	 In the canvas, click or drag over the color in your clip whose saturation you want to 
adjust.

The curve color changes to the color you selected in the viewer. The name of the curve 
also changes to reflect the selection—for example, to “Cyan vs Sat.”



1005Motion User Guide

You can also change the color of a curve by clicking its name (in the top-left corner of 
the curve) and then clicking or dragging in the color wheel to select a color.

4.	 Click the curve to add control points, then drag them up or down to increase or 
decrease the saturation of the selected color.

To delete a control point, select the point, then press the Delete key.

To make fine adjustments, press and hold the Option key as you drag a control.

Add and adjust control points on the left end of the curve to adjust shadows; add and 
adjust control points in the middle of the curve to adjust midtones; or add and adjust 
control points on the right end of the curve to adjust highlights.

Offset an entire curve by the same amount
1.	 In Motion, apply and adjust a Hue/Saturation Curves filter, as described above.

2.	 In the Filters Inspector, drag the control on the left side of any of the six curve controls 
up or down.

The entire curve is uniformly adjusted.
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Animate color changes over time with keyframes
You can animate color changes over time using keyframe recording.

Note: You can also animate color changes using behaviors.

1.	 In Motion, apply a Hue/Saturation Curves filter, as described above.

2.	 Navigate to the frame you want to color animation to begin.

3.	 In the Filters Inspector, do one of the following:

•	 Position the pointer in the upper-right corner of the filter, then click the Add 
Keyframe button (a plus sign in a gray diamond).

•	 Position the pointer in the upper-right corner of the filter, click the down arrow to 
open the Animation pop-up menu, then choose Add.

•	 Control-click the filter name, then choose Add from the shortcut menu.

A keyframe is added at the current playhead position.

4.	 In the Filters Inspector, click the eyedropper for the Hue vs Hue curve, then click or 
drag over the color in the image in the canvas that you want to adjust.

When you release the mouse button, control points appear on the curve in the Filters 
Inspector. The control point with the vertical line represents the color you selected with 
the eyedropper.
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5.	 In the Filters Inspector, drag the color’s control point to change the hue of the selected 
color.

6.	 Move the playhead to the next frame where you want a keyframe.

7.	 Repeat steps 5–6 until you finish.

You can also simultaneously animate all parameters of the Hue/Saturation Curves filter. For 
more information about animating filters, see Animate filter parameters with keyframes or 
Animate filters using behaviors.

Note: You cannot publish the Hue/Saturation Curves filter as a Final Cut Pro custom effects 
template. 

Levels filter in Motion

Provides controls to remap the white and black points of an image (the lightest and darkest 
tones), with a gamma control to adjust midtones, all at once. A histogram provides an 
analysis of the image to help you judge the adjustments to make.

A powerful option in this filter is the ability to make independent adjustments to the red, 
green, blue, and alpha channels of a layer.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Histogram: Displays an analysis of the layer. By default, the RGB channels are selected. 
A pop-up menu can be used to select Red, Green, Blue, or Alpha channels for viewing.

Click the disclosure triangles to expose the RGB, Red, Green, Blue, and Opacity 
parameter groups. Click the group parameter disclosure triangles to display sliders:

•	 Black In: Sets the In point for black, below which values are considered black.

•	 Black Out: Sets the minimum brightness value that appears in the output. Other 
values are scaled between Black Out and White Out values.

•	 White In: Sets the In point for white, above which values are not output.

•	 White Out: Sets the maximum brightness value that appears in the output. Other 
values are scaled between Black Out and White Out values.

•	 Gamma: Sets the amount of gamma correction.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.
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Negative filter in Motion

Inverts color and brightness in an image. This filter can be used to turn a scanned negative 
image into a positive.

Adjust this filter using the control in the Filters Inspector:

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.

OpenEXR Tone Map filter in Motion

Applies tone mapping to an OpenEXR image, reducing the dynamic range of the image 
so that it can be viewed on your display. The Exposure, Defog, Knee Low, and Knee High 
parameters allow you to control how the pixels in the high-dynamic-range image are 
mapped to a lower dynamic range.

A recommended workflow is to apply the OpenEXR Tone Map filter to the result of your 
composite. In other words, apply the OpenEXR Tone Map filter after you’ve applied other 
filters to the OpenEXR image or blended the image with other images in your project.

Note: An OpenEXR file imported into Motion 5.0.2 or later is maintained as a high-
dynamic-range image and will appear brighter than in earlier versions of Motion (until 
you specifically alter the image). Prior to version 5.0.2, Motion forced tone mapping 
on imported OpenEXR images. In Motion 5.0.2 or later, when you open an older project 
containing an OpenEXR image, an OpenEXR Tone Map filter is automatically applied to the 
image so that the project retains its original appearance.

To maintain the full dynamic range of an image being exported as an OpenEXR file, disable 
the OpenEXR Tone Map filter prior to exporting.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Exposure: Lightens or darkens the displayed image, revealing more detail at the low end 
or high end of the image.

•	 Defog: Attempts to remove “fog” in an image. While recording, stray light in the camera 
may cause fogging of your image, creating unwanted light.

•	 Knee Low: Sets the low end of the white and middle gray values displayed in the image. 
Values between Knee Low and Knee High are compressed, allowing you to display a 
wider range of pixel values without clipping.

•	 Knee High: Sets the high end of the white and middle gray values displayed in the 
image.

•	 Mix: Sets the percentage of the original image that’s blended with the modified image.
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Sepia filter in Motion

Tints a layer with a sepia tone. The black and white points are remapped to dark and light 
sepia colors. You can adjust the tinting amount to achieve a subtle mix of the original and 
tinted colors, or a completely tinted image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the amount of sepia tone applied to the image.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.

Threshold filter in Motion

Reduces all colors in an image to a duotone, and optionally limits the range of midtones 
preserved in the image. The result is an extremely high-contrast image that defaults to 
black and white—but you can reduce the image to any two colors.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Threshold: Sets the threshold of selection for color substitution. The threshold 
determines what is considered light and what is considered dark in the image.

•	 Smoothness: Sets the smoothness of transition between the substituted colors.

•	 Dark Color: Sets the color used to represent the dark interpreted areas of the image. 
Click the disclosure triangle to reveal Red, Green, and Blue sliders, for more precise 
color selection.
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•	 Light Color: Sets the color used to represent the light-interpreted areas of the image. 
Click the disclosure triangle to reveal Red, Green, and Blue sliders, for more precise 
color selection.

•	 Correct For Alpha: Renders semitransparent pixels correctly. Enable this setting if the 
edges of the filtered image show artifacts.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.

Tint filter in Motion

Tints an image with a single color. Shadows and highlights are less affected, but all 
midrange colors in the image are gradually replaced with the tint color as the Intensity 
parameter is increased.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Color: Picks the color used to tint the image. Click the disclosure triangle to reveal Red, 
Green, and Blue sliders for more precise color selection.

•	 Intensity: Sets the amount of tint applied to the image.

•	 Mix: Sets the percentage of the original image that’s blended with the color-corrected 
image.

Distortion filters

Intro to Distortion filters in Motion

Distortion filters are used to change the shape of layers—warping, twisting, and pulling 
them in different directions.

There are 29 Distortion filters:

•	 Black Hole distorts an image by causing part of it to disappear into the specified center 
point, bowing the top, bottom, and sides inward.

•	 Bulge distorts an image as if forced outward by something pushing from behind.

•	 Bump Map uses a source object to define a bump pattern that’s used to displace an 
image.

•	 Disc Warp stretches the object outward around a circular region.
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•	 Droplet simulates the effect of a drop of liquid falling onto the surface of a pool.

•	 Earthquake creates an animated displacement effect on an object.

•	 Fisheye distorts an object as if it were seen through the view of a fisheye lens.

•	 Flop reverses an object horizontally, vertically, or in both directions.

•	 Fun House simulates the distortion caused by an imperfectly shaped mirror, similar to 
those in a carnival fun house.

•	 Glass Block cuts an object into a series of tiles, creating a duplicated pattern effect.

•	 Glass Distortion simulates the effect of the object being deformed as it shows through a 
piece of glass.

•	 Insect Eye maps a repeating hexagonal distortion pattern to an image, mimicking the 
POV of an insect.

•	 Mirror splits an object in half vertically and reverses the remaining half to create a 
reflection.

•	 Page Curl animates an object as if it is a page peeling away.

•	 Poke distorts an object by bowing the edges inward.

•	 Polar converts images from rectangular coordinates to polar coordinates, and vice 
versa.

•	 Refraction creates a glass-distortion effect on an image.

•	 Ring Lens creates a ring of distortion over the image, creating a donut-like bulge.

•	 Ripple creates animated ripples over the surface of an object.

•	 Scrape smears an image along an angle.

•	 Sliced Scale divides an image or shape into nine portions or slices, then resizes or tiles 
the slices to prevent distortion of the image’s intrinsic shape or pattern.

•	 Sphere simulates the effect of an image wrapped around a sphere.

•	 Starburst radiates solid-color streaks from the center of a layer.

•	 Stripes turns an image into a series of vertical stripes.

•	 Target draws bands of concentric circles outward from the center point value.

•	 Tiny Planet Converts 360° video footage into an image that resembles a miniature 
planet.

•	 Twirl twirls an image like a fork twisting a plate of spaghetti.

•	 Underwater applies an animated distortion to an image, simulating a view through water.

•	 Wave distorts an image to simulate waves oscillating across it.
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Black Hole filter in Motion

Distorts an image by causing part of it to disappear into the specified center point, and by 
bowing the top, bottom, and sides inward. As the value of the Amount parameter increases, 
the more the sides bow in, and the more of the image at the center point disappears into it. 
The Poke filter has a similar effect without removing part of the image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the black hole. You can also drag the Center 
onscreen control in the canvas.

•	 Amount: Sets the amount of force pulling on the layer. Default values range from 0 (no 
gravity) to 3000 (the entire layer is pulled into the black hole).

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Bulge filter in Motion

Distorts an image as if forced outward by something pushing from behind.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the bulge. You can also drag the Center 
onscreen control in the canvas.

•	 Amount: Sets the amount of the bulge.

•	 Scale: Sets the direction and scale of the bulge. Lower values make the image appear to 
bulge inwards; higher values make the image appear to bulge outwards.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Bump Map filter in Motion

Uses a source object to define a bump pattern that can be used to deform an image, with 
parameters to control the amount of displacement. You can use any image, movie, or shape 
as the source object.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Map Image: Displays a thumbnail of the map chosen. To add a map image or replace the 
current one, drag an object (image, shape, text, and so on) into the well.

•	 Controls: Sets the map controls to either of two settings:

•	 Direction and Amount: Lets you offset the angle and amount of the map protrusion.

•	 Horizontal and Vertical Scale: Lets you offset the map by a single axis (X or Y).

•	 Direction: Sets the angle at which the bump map protrudes when the Controls pop-up 
menu is set to Direction and Amount.

•	 Amount: Sets how far the bump map protrudes when the Controls pop-up menu is set 
to Direction and Amount. Positive values push upward; negative values push downward.

•	 Horizontal Scale: Sets horizontal scaling of the map image when the Controls pop-up 
menu is set to Horizontal and Vertical Scale.

•	 Vertical Scale: Sets the vertical scaling of the map image when the Controls pop-up 
menu is set to Horizontal and Vertical Scale.

•	 Repeat Edges: Sets whether the edges of the object are repeated.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.
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Disc Warp filter in Motion

Stretches the image outward around a circular region. As the radius of the warping region 
increases, the image is warped outward with a greater amount of distortion. The color of 
the resulting disk is determined by the color value of the pixel where the center is placed.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the disk. You can also drag the Center 
onscreen control in the canvas.

•	 Radius: Sets the size of the disk. You can also drag the outer circle of the onscreen 
controls in the canvas.

•	 Crop: Sets whether the filtered layer is sharply cropped at its original boundaries. When 
this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Droplet filter in Motion

Simulates the effect of a drop of liquid falling onto the surface of a pool, with the image 
displaced by concentric ripples. This filter is not automatically animated, but animating the 
Thickness parameter of this filter creates the effect of the ripples spreading out from the 
center.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the droplet effect. You can also drag the 
Center onscreen control in the canvas.

•	 Radius: Sets the radius of the droplet effect. You can also drag the inner circle of the 
onscreen controls in the canvas. Drag between the inner and outer circles to adjust the 
Radius and Thickness parameters simultaneously.

•	 Thickness: Sets the width of the rippling waves from the droplet. You can also drag the 
outer circle of the onscreen controls in the canvas. Drag between the inner and outer 
circles to adjust the Thickness and Radius parameters simultaneously.

•	 Height: Sets the height of the droplet ripples.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more information 
on creating content for use in Final Cut Pro, see Intro to Final Cut Pro templates.

Earthquake filter in Motion

Creates an animated displacement effect on an image, adjusting its position as if shaken by 
an earthquake.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Twist: Sets the amount the image is rotated as it is displaced.

•	 Horizontal Shake: Sets the maximum amount the image is displaced horizontally.

•	 Vertical Shake: Sets the maximum amount the image is displaced vertically.

•	 Layers: Sets the number of copies of the original image that are overlaid. Larger values 
create a motion-blurred effect.

•	 Epicenter: Sets the position of the center of the earthquake, around which the Twist 
occurs. You can also drag the center onscreen control in the canvas.

•	 Random Seed: Sets the value of the random seed used to determine which frames are 
changed by the filter.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more information 
on creating content for use in Final Cut Pro, see Intro to Final Cut Pro templates.
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Fisheye filter in Motion

Distorts an image as if it were seen through a fisheye lens. The result is an extremely wide-
angle warping effect also known as barrel distortion. Use the Fisheye filter with a negative 
Amount value as an imprecise way to correct for barrel distortion in images shot using a 
wide-angle lens.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Radius: Sets the radius of the fisheye lens effect.

•	 Amount: Sets the amount and nature of the distortion. Lower values create concave 
distortion; higher values create convex distortion.

•	 Center: Sets the position of the center of the fisheye effect. Drag the Center onscreen 
control to adjust its value in the canvas.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Flop filter in Motion

Reverses an image horizontally, vertically, or in both directions.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Flop: Sets the direction in which the image is flopped (Horizontal, Vertical, or Both).

•	 Mix: Sets the percentage of the original image that’s blended with the flopped image.
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Fun House filter in Motion

Simulates the distortion caused by an imperfectly shaped mirror, similar to a mirror in a 
carnival fun house.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the fun house mirror. You can also drag the 
Center onscreen control in the canvas.

•	 Width: Sets the width of the fun house mirror.

•	 Amount: Sets the amount of distortion of the fun house mirror.

•	 Angle: Sets the angle at which the fun house mirror is set.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Glass Block filter in Motion

Cuts an object into a series of tiles and offsets a portion of the image in each tile to create 
a duplicated pattern effect. The number of tiles and the amount that each tile is offset can 
be customized.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the origin of the glass block effect. You can also drag the 
Center onscreen control in the canvas.

•	 Scale: Sets the scale of the portions of the duplicated parts.
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•	 Angle: Sets the angle of offset used to sample the duplicated parts.

•	 Tile Size: Sets the size of the glass blocks.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Glass Distortion filter in Motion

Simulates an image being deformed as if through a pane of glass. An image well lets you 
assign an image, movie, or shape to use as the pattern in the glass. Other parameters let 
you control the scale and amount of distortion.

By default, Glass Distortion behaves as if there were a black image applied to the Distort 
Input well, which leaves the target layer unchanged.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the tiling of the glass distortion. You can also 
drag the Center onscreen control in the canvas.

•	 Distort Input: Displays a thumbnail of the image map chosen.

•	 Fit: Sets the relative scale of the map image.

•	 X Scale: Sets the horizontal scale of the map image (when the Fit checkbox is 
deselected).

•	 Y Scale: Sets the vertical scale of the map image (when the Fit checkbox is deselected).

•	 Amount: Sets the amount of offset.

•	 Softness: Sets how much blur is applied to the map image.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Insect Eye filter in Motion

Maps a repeating hexagonal distortion pattern to an image, mimicking the POV of an 
insect.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Size: Sets the size of the hexagons, in pixels.

•	 Refraction: Sets the amount of distortion present in each hex.

•	 Border Size: Sets the width, in pixels, of the border of each hex.

•	 Border Color: Picks the color of the border of the hexagons. Click the disclosure 
triangle to display Red, Green, and Blue sliders for more precise color selection.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

Mirror filter in Motion

Splits an image in half vertically and reverses the remaining half to create a reflection. The 
center point and angle of the split can be customized. This filter is excellent for recreating 
the magic of 1980s music videos.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the mirror. You can also drag the Center 
onscreen control in the canvas.

•	 Angle: Sets the angle of the mirror’s orientation.

•	 Repeat Border Pixels: Sets the edge pixels to repeat to fill in the remainder of the shape 
when the Center and Angle parameters are offset from the center.
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•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Page Curl filter in Motion

Animates an image as if it’s a page peeling away from an upper corner of the canvas.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Direction: Sets the animation of the page curl to Open or Close. 

•	 Angle: Defines the angle of the page turn. Alternatively, use the Angle onscreen control 
(the small circle between the center circle and arrow) with the Rotate control (the arrow) 
to set the direction of the page turn. For example, at an Angle value of 180 degrees, the 
page turn begins along the right edge of the image. 

•	 Rotation: Defines the rotation of the page turn. Alternatively, use the Rotation onscreen 
control (the arrow) with the Angle control (the small circle between the center circle 
and arrow) to set the direction of the page turn. For example, when Angle is set to 180 
degrees and Rotation is set to 130 degrees, the page turn begins along the upper-right 
corner of the image.

•	 Radius: Defines the size of the page curl. The larger the value, the more subtle the curl.

•	 Fade Out: Defines the image’s opacity over the page curl animation. When set to 1, 
the image remains opaque throughout the animation. When set to 100, the image is 
transparent by the end of the animation.

•	 Shadow: Controls the darkness of the shadow that appears beneath the curling portion 
of the image.

•	 Highlight Color: Defines a highlighted color on the back of the page.

•	 Back Color: Defines the color and opacity on the back of the page.

•	 Animate: Turns animation of the page-turn effect on and off.

•	 Percent: Defines the amount of curl in the static image when the Animate checkbox is 
deselected.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Poke filter in Motion

Distorts an image by bowing the top, bottom, and sides inward, and appears to push the 
image into the canvas at the specified Center point. As the value of the Amount parameter 
increases, the more the sides bow in. The Black Hole filter has a similar effect but also 
removes part of the image at the center point.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the poke. You can also drag the Center 
onscreen control in the canvas.

•	 Radius: Sets the radius of the poke effect. The higher the value, the smaller the image 
appears. Scale must be set to greater than 0 for the Radius parameter to have an effect.

•	 Scale: Sets the scale of the distortion.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Polar filter in Motion

Converts images from rectangular coordinates to polar coordinates, and vice versa.

 Tip: This filter works well with layers containing horizontal or vertical lines, such as the 
Stripes or Checkerboard generators. A similar effect can be created with any image by 
adding the Line Screen or other related filters. 
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the center point of the distortion from Polar to Rectangular or Rectangular 
to Polar. You can also drag the Center onscreen control in the canvas.

•	 Polar to Rect: Applies a Polar-to-Rectangular distortion to the image. 

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Refraction filter in Motion

Creates a glass-distortion effect on an image, with an optional height map.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Softness: Sets the amount of softness applied to the refracted edges.

•	 Refraction: Sets the amount that the image is distorted.

•	 Height Map: Displays a thumbnail of the height map chosen. The height map is used to 
determine the edges along which the image is refracted.
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•	 Map Channel: Sets the channel used to determine how the image is refracted. If a 
height map is present, the channel is selected from the height map; otherwise the 
channel is selected from the source object. Values can be selected from the following: 
Luminance (default), Red, Green, Blue, or Alpha.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

Ring Lens filter in Motion

Creates a ring of distortion over the image, creating a donut-like bulge.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the lens. You can also drag the Center 
onscreen control in the canvas.

•	 Radius: Sets the radius of the ring. Drag the inner circle of the onscreen controls to 
adjust the Radius value. Drag between the inner and outer circles to adjust the Radius 
and Thickness parameters simultaneously.

•	 Thickness: Sets the thickness of the ring as a percentage of the radius. Values range 
from 0 (no thickness) to 1.0 (no hole in the center of the ring lens). Drag the outer circle 
of the onscreen controls to adjust the Thickness value. Drag between the inner and 
outer circles to adjust the Thickness and Radius values simultaneously.

•	 Refraction: Sets the amount of refraction of the lens.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Ripple filter in Motion

Creates animated ripples over the surface of an image, to create an undulating effect. The 
amplitude can be adjusted to increase or decrease the rippling effect.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the origin of the effect. You can also drag the Center 
onscreen control in the canvas.

•	 Amplitude: Sets the width of the waves.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Scrape filter in Motion

Smears an image along an angle defined by the Rotation parameter. The Scrape effect 
starts at the center point, and continues to the edge of the layer.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the scrape. You can also drag the Center 
onscreen control the canvas.

•	 Rotation: Sets the angle of rotation of the scrape. You can also drag the outer handle of 
the onscreen control in the canvas.
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•	 Amount: Sets the ramping of the number of pixels spread across the range of the 
scrape. Values range from 0 (very gradual) to 200 (hard edge).

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Sliced Scale filter in Motion

Divides an image or shape into nine portions, or slices, then resizes or tiles the slices to 
prevent distortion of the image’s intrinsic shape or pattern.

When creating Final Cut Pro templates, you can use this filter to dynamically scale lower-
third titles, speech bubbles, and other images with linked objects (using the Link parameter 
behavior). See Use the Sliced Scale filter.

Note: Using multiple Sliced Scale filters on a single image is not recommended.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Edit Slices: Displays onscreen controls to define the position and size of the center slice 
(the “stretchable” area of the image).

•	 Slice Right Top: Sets the upper-right position and the size of the center slice. This 
parameter becomes available when the Edit Slices checkbox is selected.

•	 Slice Left Bottom: Sets the lower-left position and the size of the center slice. This 
parameter becomes available when the Edit Slices checkbox is selected.

•	 Scale Method: Sets the scaling behavior of the center slice. This pop-up menu, 
available when the Edit Slices checkbox is deselected, has three options:

•	 Stretch: Stretches the portion of the image within the defined center slice. Use this 
option for images with gradients or solid colors.

•	 Partial Tiles: Fills the stretched portion of the center slice with repeating partial tiles. 
Use this option for images with smaller patterns, such as a halftone dot pattern or 
random noise.

•	 Whole Tiles: Fills the stretched portion of the center slice with repeating whole tiles. 
Use this option for images with larger patterns and textures that need more exact 
placement, such as a picture frame with an ornate pattern.

•	 Scale: Sets the size of the center slice. This parameter becomes available when the Edit 
Slices checkbox is deselected.

You can also use the onscreen controls to adjust the Scale parameter values.
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•	 Offset: Offsets the image relative to its original position. This parameter becomes 
available when the Edit Slices checkbox is deselected, and may readjust automatically 
when you use the onscreen scale handles.

•	 Expand: Available when the Edit Slices checkbox is deselected, expands the left, right, 
top, or bottom of the image. You can use this option, for example, to add a “margin” 
outside of the center slice.

•	 Mix: Sets the percentage of the original image that’s blended with the sliced image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. See Intro to 
Final Cut Pro templates.

Use the Sliced Scale filter in Motion

You can use the Sliced Scale filter to scale and tile an image or shape while protecting 
portions of the image from distortion. The filter is especially useful for creating Final Cut 
Pro templates that dynamically scale lower-third titles, arrows, rectangles, and other 
images with linked objects (using the Link parameter behavior). For example, you can 
scale a speech bubble to accommodate changes in text without affecting the shape of the 
bubble’s corners or tail, or scale a lower third without distorting its pattern.

Scale a portion of an image without distorting its shape or pattern
1.	 In the Layers list in Motion, select the image or shape you want to scale, click Filters in 

the toolbar, then choose Distortion > Sliced Scale.

2.	 To define the center slice (which will be resized in step 3), select the Edit Slices 
checkbox, then do either of the following:

•	 Define the slice in the canvas: To specify the size or aspect ratio of the center slice, 
drag a corner handle or dashed line. To reposition the center slice within the image, 
drag inside the slice.
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The center slice represents the stretchable area of the image that will be scaled.

 Tip: Shift-drag a handle to proportionally adjust the slice, Option-drag a handle 
to adjust the slice around its center, or Option-Shift-drag a handle to adjust the slice 
proportionally around its center.

•	 Define the slice in the Filters Inspector: To specify the size or aspect ratio of the 
center slice, drag the Slice Right Top or Slice Left Bottom value sliders.

3.	 To resize the center slice and the image proportionally, deselect the Edit Slices 
checkbox in the Filters Inspector, then do either of the following:

•	 Resize in the canvas: Drag a scale handle.

When you scale the center slice, the upper and lower slices scale horizontally, the 
left and right slices scale vertically, and the corner slices move to accommodate the 
scale change, preserving the intrinsic shape of the image.

•	 Resize in the Filters Inspector: Drag the Scale slider. Click the disclosure triangle to 
reveal X and Y sliders to more precisely scale the slice.

4.	 Optional: If the image contains a pattern that should be repeated instead of stretched, 
do either of the following:

•	 Tile an image with a small pattern or texture, such as a halftone dot pattern: Click 
the Scale Method pop-up menu, then choose Partial Tiles.

•	 Tile an image with a large pattern or texture, such as an ornate picture frame: Click 
the Scale Method pop-up menu, then choose Whole Tiles.

Example: Dynamically scale a portion of a shape or image without distorting its 
shape or pattern
This advanced example uses the Sliced Scale filter, the Align To behavior, and the Link 
parameter behavior to create a shape that dynamically resizes based on text positioned 
within the shape. You use the Align To behavior to align the shape with the text, the Sliced 
Scale filter to slice the shape into nine slices, and the Link behavior to link the scale of the 
shape to the size of the text. Once linked, the shape resizes with any changes in the text—
without changing its intrinsic shape.

This example assumes you’re working in a Final Cut title template, effect template, or 
generator template project that contains a shape or image (such as a speech bubble 
shape, a rectangle shape, or lower-third image) and a text object that’s positioned above 
the shape or image in the Layers list.
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Once the template is applied to your Final Cut Pro project, the shape (or image) 
dynamically scales as you add, remove, or resize text in Final Cut Pro.

1.	 In the Layers list in Motion, select the shape, click Filters in the toolbar, then choose 
Distortion > Sliced Scale.

2.	 In the Filters Inspector, select the Edit Slices checkbox.

3.	 In the canvas, drag the corner handles to define the portion of the shape that 
dynamically scales when you make any changes to the text.

In this example, the center slice doesn’t overlap the rounded corners or tail of the 
speech bubble. When the slice is scaled, the shape of the speech bubble is preserved.

4.	 In the Filters Inspector, deselect the Edit Slices checkbox, move the pointer over the 
right side of the Scale parameter row, then click the down arrow and choose Add 
Parameter > Link.

The Link behavior lets you link the size of the shape to the size of the text object.

5.	 Drag the text object from the Layers list to the Source Object well in the Behaviors 
Inspector.

6.	 In the Behaviors Inspector, click the Compatible Parameters pop-up menu, then choose 
Object Attributes > Size > All.

The shape may temporarily appear distorted, but will be corrected in step 10.

7.	 In the Layers list in Motion, select the shape object, click Behaviors in the toolbar, then 
choose Basic Motion > Align To from the pop-up menu.



1029Motion User Guide

8.	 Drag the text object from the Layers list to the Object well in the Behaviors Inspector.

9.	 In the Behaviors Inspector, click the Align pop-up menu and choose an option, then 
click the To pop-up menu and choose an option to specify how the text aligns with the 
shape.

10.	In the Layers list, select the Sliced Scale filter, click the Expand disclosure triangle in 
the Filters Inspector, then adjust the Left, Right, Top, and Bottom parameters until the 
text looks correctly positioned in the shape.

11.	In the Layers list, select the text object, then modify the text in the canvas (or in the 
Text field at the bottom of the Format pane of the Text Inspector).

As you change the text, the shape dynamically scales with the text without distorting its 
original form.

Note: If the shape contains a pattern that becomes stretched when the slice is scaled, 
you can choose Partial Tiles or Whole Tiles in the Scale Method pop-up menu to tile the 
pattern. Unless the scale is large enough to trigger an additional tile, choosing Whole 
Tiles has no effect on the pattern.

12.	In the Filters Inspector, choose which parameter controls are available in the title, 
effect, or generator template when it’s applied to a clip in Final Cut Pro, then save the 
project.

See Create an effect template, Create a title template, or Create a generator template.

Sphere filter in Motion

Simulates the effect of an image wrapped around a sphere. This filter can be used to turn 
an image of a map into an imprecise globe.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the sphere. You can also drag the Center 
onscreen control in the canvas.

•	 Radius: Sets the radius of the sphere.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Starburst filter in Motion

Radiates solid-color streaks from the center of an image. The colors are derived from pixel 
values around the selected center point, with the number of colors used determined by the 
Radius parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the starburst. You can also drag the Center 
onscreen control in the canvas.

•	 Radius: Sets the radius of pixel sampling for ray color determination.

•	 Mix: Sets the percentage at which the original image is blended with the distorted 
image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Stripes filter in Motion

Turns an image into a series of vertical stripes. The angle of generated stripes can be 
changed using the Angle parameter. The stripe colors are derived from pixel values 
along a line through the center point at the angle specified by the Angle parameter. The 
distribution of colors is determined by the Offset parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the stripe effect. You can also drag the Center 
onscreen control in the canvas.

•	 Angle: Sets the angle of the stripes. You can also drag the outer handle of the onscreen 
control in the canvas.

•	 Offset: Sets the angle of pixel sampling used for sampling pixel color values.

•	 Mix: Sets the percentage of the original image that’s blended with the striped image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Target filter in Motion

Draws bands of concentric circles outward from the center point value. The target colors 
are derived from pixel values around the selected center point, with the distribution of 
colors determined by the Angle parameter.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the target. You can also drag the Center 
onscreen control in the canvas.

•	 Angle: Sets the angle of the line used to select pixels for the bands of circles in the 
target. You can also drag the outer handle of the onscreen control in the canvas.

•	 Crop: Sets whether the image is cropped beyond its original borders.

•	 Mix: Sets the percentage at which the original image is blended with the distorted 
image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Tiny Planet filter in Motion

Converts 360° video into stereographic projection, creating a “tiny planet” effect.

Although you can apply the Tiny Planet filter to any type of footage, applying it to 360° 
video provides the best results. This is because the entire 360° sphere can be mapped 
onto a flat plane so that the image edges align seamlessly when the globe effect is 
created. If you apply the Tiny Planet filter to normal (non-360°) images, a seam appears 
where the image edges meet, similar to the result of applying the Polar filter.

You can create interesting stylistic effects by applying the Tiny Planet filter to generators 
or other images.

Important: To create a tiny planet using 360° video, place the video in a non-360°, 
standard project or standard group.

 Tip: Have some fun and take a stroll around your tiny planet: Position your 360° camera, 
start recording, take 2 or 3 large steps away from the camera, then walk, ride, or skate in a 
concentric circle around the camera.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 X, Y, and Z Rotation: Reorients the 360° layer on the X axis, Y axis, or Z axis.

•	 Field of View: Controls how much of the 360° sphere is mapped onto a flat plane.

•	 Rotation Order: Changes the processing order of the rotation parameters. The options 
are ZYX, ZXY, XYZ, and YXZ. The default rotation order is ZYX.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter renders pixels outside of the image’s 
original boundaries.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

For more information on working with 360° video, see Intro to 360° video.

Twirl filter in Motion

Twirls an image like a fork twisting a plate of spaghetti. The image appears to stretch 
from the sides to the center in a spiral. The amount of spiraling is determined by the Twirl 
parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the twirl effect. Larger values affect more of the image. 
Values range from 0 (none of the image is affected) to 1.0 (largest amount of the image 
is affected). You can also drag the outer circle of the onscreen controls in the canvas.

•	 Twirl: Sets the amount of twist. You can also drag the handle of the onscreen control in 
the canvas.

•	 Center: Sets the position of the center of the twirl. You can also drag the Center 
onscreen control in the canvas.
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•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the twirled image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Underwater filter in Motion

Applies an animated distortion to an image, simulating a view through water.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Size: Sets the size of the ripples in the water. The smaller the number, the more ripples 
there are in the water simulation.

•	 Speed: Sets the speed at which the distortion is animated.

•	 Refraction: Sets the amount that the image is distorted.

•	 Repeat Edges: Sets whether the edges of the object are repeated.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.
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Wave filter in Motion

Distorts an image to simulate waves oscillating across it. The wave filter is not 
automatically animated, but you can animate the Offset parameter to create an undulating 
effect.

For information on animating parameters, see Intro to Parameter behaviors.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amplitude: Sets the amplitude of the waves.

•	 Wavelength: Sets the length of the waves.

•	 Offset: Sets the offset of the wave.

•	 Vertical: Sets whether the waves run vertically or horizontally.

•	 Repeat Edges: Sets whether the edges of the image are repeated.

•	 Mix: Sets the percentage of the original image that’s blended with the distorted image.

Glow filters

Intro to Glow filters in Motion

Glow filters combine blur with brightness and color effects. The results are automatically 
recomposited over the original image in various ways. Glows can be used to simulate film 
effects, as a method to render your footage more abstract, or as accents to make elements 
in a composition stand out.

There are 10 Glow filters:

•	 Aura adds stylized light or dark halos around well-defined areas of an image.

•	 Bloom simulates the effect of extremely overexposed highlights on film.

•	 Dazzle adds glowing star-shaped accents to the highlights in an image.

•	 Glint adds a bloom effect and rays of light to the brightest portions of an image.

•	 Gloom creates a muted, dark glow.

•	 Glow creates a basic glow effect.

•	 Light Rays creates light rays shining through an image from a specified point.

•	 Neon simulates the pop and glow of a neon light on text, shape outlines, particles, or 
other objects.
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•	 Outer Glow creates glow around the outside of an image.

•	 Overdrive creates an animated glow by compositing numerous glowing tinted duplicates 
of the original image.

Aura filter in Motion

Adds highly stylized light or dark halos around well-defined areas of an image. The 
resulting glow appears solarized, and the underlying image creates outlines that show 
through the glow effect.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Inner Radius: Sets the amount the aura extends inward from its point of origin.

•	 Outer Radius: Sets the amount the aura extends outward from its point of origin.

•	 Brightness: Sets the brightness of the aura.

•	 Clip to White: Any color channel exceeding the maximum value of 1 is clipped to 1.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Bloom filter in Motion

Simulates the effect of extremely overexposed highlights on film. Highlights above a 
specific threshold are blurred, brightened, and recomposited with the original. Unaffected 
regions of the image interact with the glow effect, but otherwise retain their detail.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the amount of the bloom.

•	 Brightness: Sets the brightness of the bloom.

•	 Threshold: Sets the luminance threshold at which the bloom starts.

•	 Horizontal: Sets the distance of horizontal bloom.

•	 Vertical: Sets the distance of vertical bloom.

•	 Clip to White: Any color channel exceeding the maximum value of 1 is clipped to 1.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Dazzle filter in Motion

Adds glowing star-shaped accents to the highlights in an image. You can customize this 
filter to create effects ranging from subtle highlights to outrageous, colorful flashes of 
color.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the radius of the spikes from the glow.

•	 Angle: Sets the angle of rotation of the spikes.

•	 Brightness: Sets the brightness of the glow.

•	 Threshold: Sets the luminance threshold of the glow.

•	 Spike Count: Sets the number of spikes coming off of glows.

•	 Clip to White: Any color channel exceeding the maximum value of 1 is clipped to 1.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Glint filter in Motion

Adds a bloom effect and rays of light that are reflected at an angle to the brightest 
portions of an image. You can adjust the Glint filter to create effects ranging from subtle 
glows to intense, multi-spiked flares of color. The Glint filter is especially useful with 3D 
text—it integrates beautifully with lights and changes based on the surface properties of 
the 3D text. Combine the Glint filter with lights for realistic-looking lighting and camera 
movements.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Exposure: Lightens or darkens the glint highlights.

•	 Tint: Sets the strength of the color specified in the Tint Color parameter.

•	 Tint Color: Sets the color of the glint.

•	 Glint Size: Sets the size of the glint’s spikes.

•	 Streaks: Sets the number of spikes emanating from the glint.

•	 Glint Softness: Sets the amount of softness applied to the glint.

•	 Glow Amount: Sets the brightness multiplier of the glint.

•	 Glint Angle: Sets the angle of the glint streaks.

•	 Intensity: Controls the intensity of the glow effect; a high value brightens the light 
portions of an image.

•	 Color Fringing: Creates an effect similar to when a camera lens fails to focus colors to 
the same point. This is also known as chromatic aberration.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Gloom filter in Motion

Creates a muted, dark glow. The image is darkened, and areas of detail are evened out into 
larger regions of color. It’s spooky.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Radius: Sets the radius of the gloom.

•	 Amount: Sets the amount of gloom. Values range from 0 (no gloom) to 2 (maximum 
gloominess).

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Glow filter in Motion

Creates a basic glow effect. Glow is the most basic glow filter in this category, but can be 
customized to create many effects.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Radius: Sets the radius of the glow.

•	 Opacity: Sets the opacity of the glow.

•	 Threshold: Sets the luminance threshold at which the glow begins.

•	 Softness: Sets the amount of softness applied to the glow.

•	 Clip to White: Any color channel exceeding the maximum value of 1 is clipped to 1.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Light Rays filter in Motion

Uses a zoom blur rather than a Gaussian blur to distribute a glow. The resulting effect is 
that of light rays shining through an object from a specified point.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the amount of the light ray effect. Larger values extend the length of the 
rays.

•	 Center: Sets the position of the center point of the light source. You can also drag the 
center onscreen in the canvas.

•	 Glow: Sets the brightness multiplier of the light rays.

•	 Expansion: Sets the distance the light rays extend outside the boundary of the layer.

•	 Clip to White: Any color channel exceeding the maximum value of 1 is clipped to 1.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Neon filter in Motion

Simulates the effect of a neon light by brightening an object (such as text or a shape 
outline) and creating a color glow of adjustable width around the object’s edges.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Outer Brightness: Sets the brightness of the outer glow around the edges of an object.

•	 Outer Glow: Sets the size of the outer glow around the edges of an object.

•	 Inner Brightness: Sets the brightness of the inner glow of an object.
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•	 Inner Glow: Sets the size of the inner glow of an object.

•	 Edge Intensity: Sets the brightness of the edges of the object. Higher values create 
more defined edges; lower values soften the edges.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Outer Glow filter in Motion

Adds a glow to the alpha channel of an image. The result is a glow around the outside of 
the image that leaves the interior unaffected.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Radius: Sets the size of the glow.

•	 Brightness: Sets the brightness of the glow.

•	 Inner Color: Picks the inner color of the glow. Click the disclosure triangle to display 
Red, Green, and Blue sliders for more precise color selection.

•	 Outer Color: Picks the outer color of the glow.

•	 Range: Sets the gradient position between the glow colors.

•	 Horizontal: Sets the amount of horizontal glow.

•	 Vertical: Sets the amount of vertical glow.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Overdrive filter in Motion

Creates an animated glow effect by compositing numerous glowing tinted duplicates of the 
original image. Fine detail is lost, and the highlights of the image are emphasized. You can 
customize the inner glow and outer glow colors.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Intensity: Sets the number of samples.

•	 Size: Sets the radius of the effect.

•	 Rotation: Sets the angle of rotation of the collected offsets.

•	 Inner Glow: Picks the color of the inner part of the glow. Click the disclosure triangle to 
display Red, Green, and Blue sliders for more precise color selection.

•	 Outer Glow: Picks the color of the outer part of the glow. Click the disclosure triangle to 
display Red, Green, and Blue sliders for more precise color selection.

•	 Clip to White: Any color channel exceeding the maximum value of 1 is clipped to 1.

•	 Crop: Sets whether the filtered image is sharply cropped at its original boundaries. 
When this checkbox is deselected, the filter affects the edges of the image.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Looks filters

Intro to Looks filters in Motion

The Looks filters apply stylish visual treatments to image layers. In addition to all the filters 
available in the Photos app, Looks filters in Motion include cinematic color grades, such 
as Bleach, New York, and Chrome. Looks filters use look up tables (LUTs) to apply a color 
transform to an image layer.

Each Looks filter contains a single parameter control—Mix, which sets the percentage of 
the original image that’s blended with the filtered image.

There are 14 Looks filters:

•	 Bleach simulates a film bleach-bypass effect.

•	 California simulates the feel of a bright day at the beach.

•	 Chrome simulates the look of 35mm film.

•	 Cool adds a cool wash to an image.
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•	 Fade simulates the look of a faded photograph.

•	 Instant simulates the look of instant film.

•	 Mono simulates the look of monochromatic film.

•	 Nevada simulates the look of a bright desert day.

•	 New York simulates the look of dusk in the city.

•	 Noir simulates the look of black-and-white film noir.

•	 Process simulates the look of cross-processing film.

•	 Sixties simulates the look of photographs taken in the 1960s.

•	 Tonal desaturates and brightens an image.

•	 Transfer simulates a film-transfer look.

Bleach filter in Motion

Simulates the high-contrast bleach-bypass effect traditionally achieved during color film 
processing by skipping the bleaching step, leaving silver on the negative.

The Bleach filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

California filter in Motion

Simulates the colors of a warm, golden day at the beach.

The California filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.
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Chrome filter in Motion

Creates a more saturated and brightened image, simulating the look of 35mm film.

The Chrome filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Cool filter in Motion

Saturates and tints an image in cooler (bluish) colors.

The Cool filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Fade filter in Motion

Creates the look of an old photograph, lightening the image and lowering its color 
saturation.

The Fade filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.
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Instant filter in Motion

Simulates the nostalgic look of instant film, with faded, washed-out colors.

The Instant filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Mono filter in Motion

Simulates the look of monochromatic film, with diminished black and white values.

The Mono filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Nevada filter in Motion

Simulates the colors of a sun-bleached day in the desert.

The Nevada filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.
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New York filter in Motion

Simulates the cool color wash of a city at dusk.

The New York filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Noir filter in Motion

Creates the look of high-contrast, black-and-white film noir.

The Noir filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Process filter in Motion

Simulates the look of cross-processed film, where one type of film is purposely processed 
using chemicals intended for another type of film. This usually creates a strong color cast.

The Process filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.
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Sixties filter in Motion

Simulates the look of a photograph shot in the 1950s or 1960s, retaining but subduing 
bright colors.

The Sixties filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Tonal filter in Motion

Creates a desaturated and brightened black and white image.

The Tonal filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.

Transfer filter in Motion

Simulates the appearance of film-to-video transfer (also known as Telecine).

The Transfer filter has a single parameter control—Mix, which sets the percentage of the 
original image that’s blended with the filtered image.
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Sharpen filters

Intro to Sharpen filters in Motion

Sharpen filters sharpen images by creating a high contrast overlay that emphasizes edges 
in the image.

There are two Sharpen filters:

•	 Sharpen sharpens an image.

•	 Unsharp Mask creates an effect similar to Sharpen, but with more control over the 
amount of sharpening.

Sharpen filter in Motion

Sharpens an image by enhancing the color contrast around edges in the image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Intensity: Sets the radius for the effect.

•	 Amount: Adjusts the contrast for the sharpening.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the sharpened image.

Unsharp Mask filter in Motion

Creates an effect similar to Sharpen, but provides more options to refine and control the 
amount of sharpening applied to the image.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Radius: Sets the amount of the mask’s effect.

•	 Amount: Sets the amount of the multiplier used to sharpen the layer’s edges.

•	 Threshold: Sets the threshold of luminance difference to be considered as a high 
contrast range, between 0 and 1.

•	 Horizontal: Sets the horizontal width of the unsharp mask.

•	 Vertical: Sets the vertical scale of the unsharp mask.

•	 360° Aware: Eliminates seams created when the filter is applied to 360° media (in a 
360° environment).

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Stylize filters

Intro to Stylize filters in Motion

Unlike distortion filters, which warp and deform an image, stylize filters simulate different 
media, such as film, television, or print, for example.

There are 27 Stylize filters:

•	 Add Noise adds noise to an image.

•	 Bad Film simulates old or damaged film or playback equipment.

•	 Bad TV simulates poor analog television reception.

•	 Circle Screen simulates an etched screening technique using a pattern of concentric 
circles.

•	 Circles adds elliptical facets to an image, giving it a mosaic-like appearance.

•	 Color Emboss gives the image the appearance of being stamped into the canvas.

•	 Comic alters an image to look like a comic book panel.

•	 Crystallize simulates the effect of viewing an image through a pane of glass with 
irregular facets.

•	 Edges creates an edge-detection effect.

•	 Extrude gives an object simulated depth.

•	 Fill fills a layer with a solid color or gradient.

•	 Halftone simulates the halftone screening method for print.

•	 Hatched Screen simulates a halftone pen-and-ink method of shading an image.

•	 Highpass stylizes the colors in an image to create a psychedelic display.

•	 Indent creates a shiny, bump-mapped effect, giving the appearance of depressed and 
flat areas.

•	 Line Art creates an effect similar to a line drawing on paper.

•	 Line Screen simulates an etched screening technique using a pattern of straight lines.
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•	 MinMax erodes or dilates the light or dark areas of your image into soft, blocky regions.

•	 Noise Dissolve dissolves an object by adding a pattern of noise to it.

•	 Pixellate turns an image into a mosaic of blocks using colors taken from an object.

•	 Posterize reduces the number of colors in an image.

•	 Relief creates the appearance of a 3D height map.

•	 Slit Scan creates an animated fly-through effect similar to “stargate” images in science 
fiction films.

•	 Slit Tunnel creates an animated fly-through effect similar to “warp tunnel” images in 
science fiction films.

•	 Texture Screen uses a source layer to create a screen on an image.

•	 Vignette simulates the light fall-off and corner-blurring effect characteristic of images 
viewed through some camera lenses.

•	 Wavy Screen simulates an etched screening technique using a pattern of zigzagging 
lines.

Add Noise filter in Motion

Adds an overlay noise of the selected type to an image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: Sets the amount of noise added to the image.

•	 Type: Sets the type of noise added to the image. Values include Pink Noise (TV Static), 
White Noise (Uniform), Gaussian Noise (Film Grain), and Blue Noise, which reduces 
banding.

•	 Monochrome: Sets whether the added noise is monochrome or color.

•	 Blend Mode: Sets the blend mode used to add noise to the image. For blend mode 
descriptions, see How do blend modes work?

•	 Autoanimate: Sets whether the noise is animated automatically.

•	 Random Seed: Sets the seed used to generate the position of the noise. This parameter 
is available only if Autoanimate is deselected.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Bad Film filter in Motion

Simulates old or damaged film or playback equipment. This filter is animated.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Focus Amount: Sets the amount of blur applied to the image, simulating a projector lens 
going in and out of focus. 

•	 Focus Variance: Varies the amount defined in the Focus Amount parameter. For 
example, if Focus Amount is set to 3 and Focus Variance set to 1, the Focus Amount 
varies between 2 and 4. 

•	 Brightness Amount: Simulates underexposed footage or an inconsistent projector bulb 
by lightening and darkening the image.

•	 Brightness Variance: Varies the amount defined in the Brightness Amount parameter. 
For example, if Brightness Amount is set to 2.5 and Brightness Variance set to 2, the 
Brightness Amount varies between .5 and 4.5.

•	 Saturate Amount: Adjusts the effect to simulate aged film stocks. Values below 0 lower 
the saturation, creating a faded film appearance. A value of –100 removes saturation to 
simulate black-and-white film. Values above 0 simulates oversaturation.

•	 Saturate Variance: Varies the amount defined in the Saturate Amount parameter. For 
example, if Saturate Amount is set to –20 and Saturate Variance set to 10, the Saturate 
Amount varies between –30 and –10.

•	 Scratches: Simulates scratches on film. The higher the value, the more scratches.

•	 Scratch Color: Sets the color of the film scratches. The color controls can be expanded 
with the disclosure triangle to include Red, Green, Blue, and Opacity sliders to more 
precisely select the color.

•	 Hairs: Simulates hairs on film. The higher the value, the more hairs.

•	 Dust: Simulates dust or dirt on film. The higher the value, the more dirt.

 Tip: Hair, dust, and scratches occur with random variance and may not appear on 
every frame. If you don’t see any effect while adjusting these sliders, play the clip and 
observe the effect over the duration of the shot.

•	 Jitter Amount: Simulates the look of a film projector that has a problem with its gate, 
reminding you of high school, if you are old. Increasing the amount of jitter increases 
the appearance of horizontal shake in the film.

•	 Jitter Variance: Varies the amount defined in the Jitter Amount parameter. For example, 
if Jitter Amount is set to .25 and Jitter Variance set to .05, the Jitter Amount varies 
between .2 and .3.
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•	 Grain: Sets the amount of grain, allowing you to simulate different types of film stock.

•	 Frequency of Change: Defines how often (in frames) the values set in the parameters 
with variance are recalculated. For example, if Frequency of Change is set to 30, 
and Jitter Amount and Jitter Frequency are set to values greater than 0, the jitter 
parameters are recalculated every 30 frames, creating additional randomness.

•	 Random Seed: Lets you pick a new random seed number. This number is used to 
randomly generate new sequences of values, based on the other parameters of this 
behavior.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Bad TV filter in Motion

Simulates poor analog television reception, adding attributes like exaggerated video field 
scan lines, static and roll.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Waviness: Sets the amount of horizontal offset applied to video fields.

•	 Roll: Sets the amount of vertical offset applied to the image. The entire image is 
displayed, but the image is split along the roll line, with the otherwise missing part of 
the footage shown joined along the roll line.

•	 Static: Sets the amount of static added to the image.

•	 Color Synch: Sets the amount of horizontal RGB channel offset applied to the image.

•	 Saturate: Sets the amount of color saturation applied to the image. Negative values 
reduce saturation; positive values add saturation.

•	 Scan Line Brightness: Sets the brightness of the video field scan lines added to the 
image.

•	 Scan Line Percentage: Sets the thickness of the video field scan lines added to the 
image.

•	 Number of Scan Lines: Sets the amount of scan lines added to the image.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Circle Screen filter in Motion

Reduces an image to a high-contrast grayscale version of itself, then screens the result 
using a pattern of concentric circles, simulating an etched screening technique. The image 
is represented by varying thicknesses in the circular pattern.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the circle screen. You can also drag the 
Center onscreen control in the canvas.

•	 Scale: Sets the scale of the circle screen.

•	 Contrast: Sets the contrast level.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more information 
on creating content for use in Final Cut Pro, see Intro to Final Cut Pro templates.

Circles filter in Motion

Adds elliptical facets to an image, giving it a mosaic-like appearance. Each facet takes a 
color sample from the center of itself. Unlike other mosaic filters, the edges of the facets 
do not join, allowing parts of the untouched image to be visible between facets.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Size: Sets the size of the facets.

•	 Falloff: Sets the amount of alpha blending done at the edges of each facet.

•	 Invert: Sets whether the facets are elliptical or tiles with elliptical cut-outs.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Color Emboss filter in Motion

Traces high-contrast edges in the image with darker versions of the color in the image. 
This gives the layer the appearance of being stamped into the canvas, while retaining the 
colors of the original image. The Direction and amount of Relief can be customized.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Direction: Sets the angle of direction of the offset emboss.

•	 Relief: Sets the amount of the offset.

•	 Crop: Sets whether the image is cropped beyond its original borders.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Comic filter in Motion

Modifies an image to look like a hand-drawn comic book panel.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Style: Sets the overall appearance of the comic look. This pop-up menu has three 
options:

•	 Color: Sets the comic look using the colors of the original image.

•	 Gray: Sets the comic look to grayscale.

•	 Black & White: Sets the comic look to black and white.

•	 Ink Color: Picks the color of the ink lines. This parameter becomes available when Style 
is set to Black & White.

•	 Fill Color: Picks the color of the image within the ink lines. This parameter becomes 
available when Style is set to Black & White.

•	 Smoothness: Adjusts the level of detail in the ink and fill areas of the image. Lower 
values allow more detail; higher values remove detail.
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•	 Ink Edges: Adjusts the line detail in the image. Lower values allow less ink detail; higher 
values add more ink detail.

•	 Ink Smoothness: Adjusts the smoothness of the ink lines. Lower values create sharper 
lines; higher values create smoother lines.

•	 Ink Fill: Adjusts the amount of ink in the image. Lower values create less ink; higher 
values fill in the image with more ink.

•	 Posterize Levels: Sets the number of color levels in the fill (non-ink) areas.

•	 Affect Alpha: Softens the edges of an image’s alpha channel to create a soft drop 
shadow effect or glow. The effect is more noticeable when Smoothness and Ink 
Smoothness are set to higher values. This parameter becomes available when Style is 
set to Black & White.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Crystallize filter in Motion

Simulates the effect of viewing an image through a pane of glass with irregular facets 
patterned into it. These mosaic-like facets give an image a crystallized appearance. This 
filter is automatically animated, and the facets appear to shift and turn according to the 
value in the Speed parameter. To prevent the facets from moving, set the Speed to 0.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Size: Sets the size of the facets.

•	 Speed: Sets the speed of the animation of the facets.

•	 Smooth: Sets whether facet colors are based on average values in the area they are 
replacing, or single samples taken from the center of the facet.

•	 Feathering: Sets the amount of feathering applied to the edges of facets.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Edges filter in Motion

Creates an edge-detection effect by examining the luminance of an image to render high 
contrast borders between regions of brightness. These edges are then traced, and all other 
detail is replaced by black. The amount of eliminated detail depends on the value of the 
Intensity parameter. The colors of the resulting highlights are intensified variants of the 
colors from the original image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Intensity: Sets the intensity of the edges.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Extrude filter in Motion

Gives an image simulated depth, by creating a front and back side, and then offsetting 
them and extruding the edges so they connect.

Note: Because this filter only simulates depth, an object with the Extrude filter applied 
does not interact with 3D aspects of Motion.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Angle: Sets the angle at which the image is extruded. Drag the onscreen control to 
adjust its value in the canvas.

•	 Distance: Sets the distance the image is extruded. Drag the onscreen control to adjust 
its value in the canvas.

•	 Clipping: Sets the distance at which the extrusion is clipped.
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•	 Back Size: Sets the size of the simulated back of the image, as a proportion of its 
original size.

•	 Face Brightness: Sets a brightness level applied to the face of the image.

•	 Front Brightness: Sets a brightness level applied to the front of the image.

•	 Back Brightness: Sets a brightness level applied to the back of the image.

•	 Extrude Style: Selects the method used to extrude the sides of the image. Shading or 
Gradient can be selected. With Shading selected, the color values of the pixels at the 
edges of the image are used along the extrusion. With Gradient selected, a gradient 
preset or custom gradient can be used.

•	 Gradient: Selects a gradient preset to be applied to the image. Can also be used to edit 
a custom gradient. The gradient is applied only if Extrude Style is set to Gradient.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Fill filter in Motion

Fills an image layer or alpha channel with a solid color or gradient.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Fill With: Sets how the image or alpha channel is filled. This pop-up menu has two 
options:

•	 Color: Fills the image or alpha channel with a solid color. For more information on 
using color controls, see Use basic color controls.

•	 Gradient: Fills the image or alpha channel with a gradient. You can choose a gradient 
from the Gradient preset pop-up menu, or click the Gradient parameter’s disclosure 
triangle to display the gradient editor and create your own custom gradient. For 
more information on using gradient editors, see Gradient editor controls.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Halftone filter in Motion

Reduces an image to a black and white version of itself, simulating the halftone screening 
method for print, in which the shadows and highlights of an image are recreated using 
patterns of small and large dots.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the halftone dots. You can also drag the 
center onscreen control in the canvas.

•	 Angle: Sets the angle of the alignment of the dots.

•	 Scale: Sets the scale of the halftone dots.

•	 Contrast: Sets the amount of contrast between lightest and darkest dots.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Hatched Screen filter in Motion

Reduces an image to a black and white version of itself, simulating a halftone pen-and-
ink method of shading an image, in which the shadows and highlights of an image are 
recreated using hatched patterns of lines.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the hatched screen. You can also drag the 
Center onscreen control in the canvas.

•	 Angle: Sets the angle of the hatched screen.

•	 Scale: Sets the scale of the hatched screen.

•	 Skew: Sets the amount of skew of the hatched screen.

•	 Stretch: Sets the amount of stretch of the hatched screen.

•	 Contrast: Sets the relative amount of contrast between light and dark areas.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Highpass filter in Motion

Emphasizes areas of detail in an image and stylizes the colors in the resulting image to 
create a mind-blowing psychedelic display.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Radius: Sets the amount of variance of detail to consider. Values range from 0 (entire 
range of color) to 100 (only the most detailed portions).

•	 Amount: Sets the amount of emphasis.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Indent filter in Motion

Creates a shiny, bump-mapped effect, giving the appearance of depressed and flat areas 
in the image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Softness: Sets the softness of the transition between flat and raised areas.

•	 Brightness: Sets the level of brightness of the image.

•	 Ambient: Sets the amount of ambient light hitting the image.

•	 Highlight Brightness: Sets the amount of brightness applied to highlights of the image.

•	 Highlight Sharpness: Sets the degree of sharpness applied to highlights of the image.

•	 Light Rotation: Sets the angle, in degrees, at which the ambient light hits the image.

•	 Depth: Sets the amount of depth between flat and raised areas.

•	 Height Map: Displays a thumbnail of the height map chosen. If present, the height map 
is used to determine the flat and raised areas of the layer.

•	 Map Channel: Sets the channel from the image used to determine the flat and raised 
areas of the image. If a height map is present, the channel is selected from the height 
map. Otherwise, values include Luminance (default), Red, Green, Blue, or Alpha.

•	 Stretch To Fit: Sets whether the Height Map is stretched to fit the dimensions of the 
filtered layer.

•	 Height Map X Scale: Sets the scaling used to determine the width of the Height Map. 
This parameter becomes available when the Stretch To Fit checkbox is deselected.

•	 Height Map Y Scale: Sets the scaling used to determine the height of the Height Map. 
This parameter becomes available when the Stretch To Fit checkbox is deselected.

•	 Height Map X Offset: Sets the amount of offset used to position the Height Map 
horizontally. This parameter becomes available when the Stretch To Fit checkbox is 
deselected.

•	 Height Map Y Offset: Sets the amount of offset used to position the Height Map 
vertically. This parameter becomes available when the Stretch To Fit checkbox is 
deselected.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Line Art filter in Motion

Performs an edge detection of the high-contrast borders between regions of differing 
brightness in an image, tracing the edges and reducing other detail in the image to the 
color specified by the Paper Color parameter. The color of the resulting outline can also be 
customized. The effect is that of a line drawing on paper.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Threshold: Sets the threshold of edge detection.

•	 Smoothness: Sets the level of smoothness of transition between the lines and the 
background.

•	 Paper Color: Sets the color of the paper. Click the disclosure triangle to reveal Red, 
Green, and Blue sliders to more precisely select the color.

•	 Paper Opacity: Sets the opacity of the paper.

•	 Ink Color: Sets the color of the ink used in the line drawing.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Line Screen filter in Motion

Reduces an image to a high-contrast grayscale version of itself, then screens the image 
using a pattern of straight lines, simulating an etched screening technique. The image is 
represented by varying thicknesses in the pattern of the parallel lines.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the line screen. You can also drag the Center 
onscreen control in the canvas.

•	 Angle: Sets the angle of the line screen.

•	 Scale: Sets the scale of the line screen.

•	 Skew: Sets the amount of skew of the line screen.

•	 Stretch: Sets the amount that the line screen is stretched.

•	 Contrast: Sets the relative amount of contrast between light and dark areas.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

MinMax filter in Motion

Softly patterns an image by setting a maximum or minimum color value for pixels in the 
specified radius. The result erodes or dilates the light or dark areas of your layer into soft, 
blocky regions.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Mode: Sets the mode of the effect. The following modes are available: Minimum and 
Maximum.

•	 Radius: Sets the radius of the effect.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Noise Dissolve filter in Motion

The Noise Dissolve filter dissolves an image by adding a pattern of noise to it. Raising 
the value of the Dissolve Amount parameter gradually eats away at more and more of the 
image. The alpha channel is set to zero within the noisy areas, so background images are 
revealed as the Dissolve Amount increases.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Dissolve Amount: Sets the percentage of pixels dissolved by noise.

•	 Random Seed: Sets a number to be used as a seed for noise placement.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Pixellate filter in Motion

Turns an image into a mosaic of blocks using colors taken from the image. You can 
increase or decrease the scale of the blocks.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the pixelation effect. You can also drag the 
Center onscreen control in the canvas.

•	 Scale: Sets the scale of the pixelation.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Posterize filter in Motion

Reduces the number of colors in an image to a set number per color channel, adjustable 
using the Levels parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Levels: Sets the number of levels of posterization.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Relief filter in Motion

Uses the color values of an image to calculate height vertices, creating the appearance of 
a 3D height map.

Note: Because this filter merely simulates depth, an object with the Relief filter applied 
does not interact with 3D aspects of Motion.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Front: Sets the position of the center point of the front of the height map, determining 
the direction to which the height vertices are projected. Values are coordinates. Drag 
the inner or outer onscreen controls in the canvas to adjust this value.

•	 Front Size: Sets the size of the front of the height map, as a proportion of its original 
size.

•	 Back: Sets the position of the center point of the back of the height map, determining 
the direction from which height vertices are projected. Values are coordinates. Drag the 
inner or outer onscreen controls in the canvas to adjust this value.
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•	 Back Size: Sets the size of the back of the height map, as a proportion of its original 
size.

•	 Fuzziness: Sets the amount of fuzziness applied to the height vertices. The higher the 
value, the softer the edges of the height vertices.

•	 Height Map: Displays a thumbnail of the height map chosen. If present, the height map 
is used to calculate height vertices.

•	 Map Channel: Sets the channel used to calculate height vertices. If a height map is 
present, the channel is selected from the height map, otherwise the channel is selected 
from the image. Values can be selected from the following: Luminance (default), Red, 
Green, Blue, or Alpha.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Slit Scan filter in Motion

Creates an animated fly-through effect by simulating the slit scan process used to create 
“stargate” images in science fiction films.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the slit. You can also drag the Center 
onscreen control in the canvas.

•	 Rotation: Sets the angle of rotation of the slit.

•	 Speed: Sets the speed of the simulation.

•	 Perspective: Sets the angle of perspective on the layer.

•	 Glow: Sets the amount of the glow on the slit.

•	 Glow Color: Sets the color of the glow of the slit. Click the disclosure triangle to display 
Red, Green, and Blue sliders for more precise color selection.

•	 Offset: Sets the amount of offset between what is above and what is below the slit.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Slit Tunnel filter in Motion

Simulates a circular version of the slit scan process used to create “warp tunnel” images in 
science fiction films. This filter is automatically animated to create a fly-through effect.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the tunnel. You can also drag the Center 
onscreen control in the canvas.

•	 Rotation: Sets the angle of rotation of the tunnel effect.

•	 Speed: Sets the speed of the simulation.

•	 Perspective: Sets the angle of perspective on the tunnel effect.

•	 Glow: Sets the amount of the glow at the end of the tunnel.

•	 Glow Color: Picks the color of the glow at the end of the tunnel. Click the disclosure 
triangle to display Red, Green, and Blue sliders for more precise color selection.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Texture Screen filter in Motion

Uses a source object specified by the Map Image parameter to screen the target image. 
The source object can be any image, movie, or shape. By default, Texture Screen behaves 
as if there were a black image applied to the Map Image well, which makes the target 
appear desaturated and washed out.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Map Image: Displays a thumbnail of the map chosen to generate the screen.

•	 Center: Sets the position of the center of the texture screen. You can also drag the 
Center onscreen control in the canvas.

•	 Angle: Sets the angle at which the texture screen is placed.

•	 Skew: Sets the amount of skew applied to the map image.

•	 Stretch: Sets the amount of stretch applied to the map image.

•	 Scale: Sets the scale applied to the map image. 

•	 Contrast: Sets the amount of contrast applied to the image by the screen.

•	 Threshold: Sets the threshold of brightness of the background image used to determine 
the brightness of the luminance map.

•	 Noise Contrast: Sets the amount of contrast added to the noise.

•	 Noisiness: Sets the amount of noise.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Vignette filter in Motion

Simulates the light fall-off and corner-blurring effect characteristic of images viewed 
through some camera lenses.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Size: Sets the size of the vignette. The larger the size, the more area of the object is 
affected by the vignette. You can also adjust this parameter in the canvas, by dragging 
the inner ring of the onscreen control. Drag in the center of the inner and outer rings to 
adjust the Size and Falloff values simultaneously.

•	 Falloff: Sets the amount of feathering applied to the border of the vignette. The higher 
the falloff, the softer the edge of the vignette. You can also adjust the Falloff parameter 
by dragging the outer ring of the onscreen control in the canvas. Drag in the center of 
the inner and outer rings to adjust the Size and Falloff values simultaneously.

•	 Center: Sets the position of the center of the vignette. You can also drag the Center 
onscreen control in the canvas.

•	 Blur Amount: Sets the amount of blur applied to the part of the image affected by the 
vignette.

•	 Darken: Sets the amount the affected part of image is darkened by the vignette.

•	 Saturation: Sets the amount of color saturation applied to the parts of the image 
affected by the vignette.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Wavy Screen filter in Motion

Reduces an image to a high-contrast grayscale version of itself, then screens the resulting 
image using a pattern of angled lines, simulating an etched screening technique. The 
image is represented by varying thicknesses in the pattern of the zigzagging lines.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amplitude: Sets the amplitude of the waves.

•	 Wavelength: Sets the wavelength.

•	 Scale: Sets the scale of the waves.

•	 Contrast: Sets the contrast of the screen.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Tiling filters

Intro to Tiling filters in Motion

Tiling filters convert images, shapes, text, and other objects geometric patterns.

There are eight Tiling filters:

•	 Kaleidoscope simulates the effect of looking at an image through a kaleidoscope.

•	 Kaleidotile simulates looking through a kaleidoscope with rectangular facets.

•	 Offset treats an image as a tile, offsetting its origins but displaying the entire layer.

•	 Parallelogram Tile simulates looking through a kaleidoscope with facets made of 
parallelograms.

•	 Perspective Tile endlessly tiles an image, mapping it onto a grid.

•	 Random Tile tiles an image in an irregular pattern with circular panels.

•	 Tile tiles an image.

•	 Triangle Tile tiles an image with triangular shaped panels.
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Kaleidoscope filter in Motion

Simulates the effect of looking at an image through a kaleidoscope. This filter isn’t 
automatically animated, but by animating the Offset Angle parameter you can simulate 
rotating kaleidoscope imagery.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the center of the kaleidoscope. You can also drag the 
Center onscreen control in the canvas.

•	 Segment Angle: Sets the angle at the tip of each triangular tile. You can also drag the 
outer handle of the onscreen control to adjust this value.

•	 Offset Angle: Sets the rotation of the whole kaleidoscope. Values range from 0 to 
360. You can also drag the inner handle (between the center and outer handle) of the 
onscreen control to adjust this value.

•	 Partial Segments: Sets whether partial segments are used to complete the radius of the 
kaleidoscope. When Partial Segments is deselected, segments may be distorted.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Kaleidotile filter in Motion

Simulates looking through a kaleidoscope with rectangular facets. This filter is not 
automatically animated, but by animating the Angle parameter you can simulate rotating 
kaleidoscope imagery.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the origin of the kaleidotile effect. You can also drag in the center of the 
onscreen control (the box) in the canvas.

•	 Width: Sets the width of the panels of the kaleidotile effect. You can also adjust the 
Width parameter by dragging the right or left center handle of the onscreen control 
in the canvas. Drag a corner handle to adjust the Width and Height parameters 
simultaneously.

•	 Height: Sets the height of each panel. You can also drag the top or bottom center 
handle of the onscreen control to adjust this value. Drag a corner handle to adjust the 
Height and Width parameters simultaneously.

•	 Angle: Sets the angle of rotation of the panels. Drag a corner handle in an arc to adjust 
this value.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Offset filter in Motion

Treats an object as a tile, offsetting its horizontal and vertical origins but displaying the 
entire layer.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Horizontal Offset: Sets the horizontal offset of the layer.

•	 Vertical Offset: Sets the vertical offset of the layer.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Parallelogram Tile filter in Motion

Simulates looking through a kaleidoscope with facets made of parallelograms. This filter 
is not automatically animated, but by animating the Angle parameter you can simulate 
twisting kaleidoscope imagery.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the origin of the parallelogram tiles. You can also drag the 
Center onscreen control in the canvas.

•	 Angle: Sets the angle of rotation of the panels.

•	 Acute Angle: Sets the acute angle at which the parallelogram sides meet.

•	 Tile Size: Sets the size of the panels.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Perspective Tile filter in Motion

Endlessly tiles an image, mapping it onto a grid that can be positioned in simulated 3D 
space. Use Perspective Tile to create an endlessly repeating video wall stretching off into 
the distance.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Top Left: Sets the position of the top-left corner of the grid.

•	 Top Right: Sets the position of the top-right corner of the grid. 

•	 Bottom Right: Sets the position of the bottom-right corner of the grid.

•	 Bottom Left: Sets the position of the bottom-left corner of the grid.

Note: Drag the onscreen control handles to adjust the Top Left, Top Right, Bottom 
Right, and Bottom Left values.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Random Tile filter in Motion

Tiles an image in an irregular pattern with circular panels.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the center point on the object where the tiles are generated. Values are 
coordinates. You can also drag the Center onscreen control in the canvas.

•	 Radius: Sets the radius of each tile.

•	 Feathering: Sets the amount of feathering applied to the edges of each tile.

•	 Seed: Sets a number to be used as a seed for tile placement and stacking.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.
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Tile filter in Motion

Tiles an image. The number of tiles depends on the value of the Scale parameter.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the position of the origin of the tiles. You can also drag the Center 
onscreen control in the canvas.

•	 Skew: Sets the amount of skew applied to tiles.

•	 Scale: Sets how much tiles are scaled.

•	 Stretch: Sets the amount tiles are stretched vertically. 

•	 Angle: Sets the angle of rotation of tiles.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Triangle Tile filter in Motion

Tiles an image with triangular shaped panels. The effect is similar to a kaleidoscope filter. 
This filter is not automatically animated, but by animating the Angle parameter you can 
simulate a twisting kaleidoscope.
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Adjust this filter using the parameter controls in the Filters Inspector:

•	 Center: Sets the origin of the tile. You can also drag the Center onscreen control in the 
canvas.

•	 Angle: Sets the angle of rotation of the triangles.

•	 Tile Size: Sets the size of the triangles. 

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

•	 Publish OSC: Publishes the filter’s onscreen controls in Final Cut Pro. For more 
information on creating content for use in Final Cut Pro, see Intro to Final Cut Pro 
templates.

Time filters

Intro to Time filters in Motion

Time filters manipulate layers temporally. Time filters are most often used to modify moving 
footage.

There are five Time filters:

•	 Echo leaves a streaking trail behind the moving areas of an image.

•	 Scrub allows you to change the timing of the clip without moving it in the Timeline, via a 
virtual playhead.

•	 Strobe strobes the image, resulting in moving images that appear to skip frames as they 
play.

•	 Trails draws light or dark trails following a moving image.

•	 WideTime stretches the image’s motion out in time.

Echo filter in Motion

Creates a streaking trail behind the moving areas of an image.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Delay: Sets the amount of delay between echoes. Values range from 0.1 to 1. A value of 
0.1 is a zero frame echo, and a value of 1 represents a 60-frame echo.

•	 Number: Sets the number of echoes.

•	 Decay: Sets the amount of time it takes for an echo to decay.

•	 Amount: Sets the relative opacity of each echo.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.
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Scrub filter in Motion

Moves a virtual playhead around a clip, allowing you to change the timing of the clip 
without moving it in the Timeline. Additionally, this filter lets you animate the offset 
parameter, often with interesting results. Try adding the Scrub filter to a video clip, then 
applying a Randomize parameter behavior to the “Frame offset” parameter, with the 
“Offset from” parameter set to Current Frame. Also, you can create a hold frame by setting 
Offset to First Frame, then adjusting “Frame offset” to find the frame you want.

Important: Scrub does not affect clip audio.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Frame offset: Sets the offset of the virtual playhead.

•	 Offset from: Sets the position where the virtual playhead is offset. Values include First 
Frame or Current Frame.

•	 Frame Blending: Turns the blending between frames on and off.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Strobe filter in Motion

Strobes the image by holding frames for a set duration. As a result, moving images appear 
to skip frames as they play.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Strobe Rate: Controls the number of frames played back per second.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Trails filter in Motion

Draws light or dark trails following an image’s movement. This filter is effective only with 
moving footage.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Duration: Sets the duration of trails.

•	 Echoes: Sets the number of echoes trailing behind.

•	 Decay: Sets whether trails decay over time or disappear at the end of the duration.

•	 Trail On: Sets the value type that triggers trails. This pop-up menu can be set to Light 
or Dark.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

WideTime filter in Motion

Holds frames before and after the current frame to stretch the image’s motion out in time. 

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Duration: Sets the number of frames before and after the current frame that are 
blended.

•	 Decay: Sets the amount of time the added frames are held.
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•	 Amount: Sets the amount of opacity of the delayed layer being overlaid. Values range 
from 0 (no reduction) to 1.0 (transparent).

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Video filters

Intro to Video filters in Motion

Video filters are utilitarian in nature, and can help prepare a project for broadcast output.

There are two Video filters:

•	 Broadcast Safe limits the range of luminance or chrominance in an image to the 
broadcast legal limit.

•	 Deinterlace converts interlaced clips into noninterlaced clips.

Broadcast Safe filter in Motion

Reduces the luminance and chrominance levels that exceed the broadcast-legal limits for 
either standard gamut or wide color gamut spaces.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Amount: When you export a Motion project to a compressed video format, compression 
artifacts may push bright pixels above—or dark pixels below—broadcast-legal limits. 
Adjust this slider to override broadcast-legal limits by adding additional “headroom” 
for light and dark pixels. At this parameter’s minimum value of 0.0%, luma and 
chroma levels are limited to corresponding RGB white levels of 100% intensity (the 
upper threshold for broadcast-safe video) and RGB black levels of 0% intensity (the 
lower threshold for broadcast-safe video); in other words, no headroom is available 
and compression artifacts may cause some pixels to exceed the 0–100% range. At 
this parameter’s maximum value of 10.0%, luma and chroma levels are limited to 
corresponding RGB white levels of 90% intensity and black levels of 10% intensity; in 
other words, 10% headroom is available to accommodate for potential compression 
artifacts.

•	 Color Space: Sets luminance and chrominance levels to the broadcast legal limit for the 
selected color space. Color space can be Rec. 601 (NTSC or PAL), Rec. 709, or Rec. 
2020.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Deinterlace filter in Motion

Converts interlaced clips into noninterlaced clips using one of several possible methods.

 Tip: In order to create a progressive scan clip when using the Deinterlace filter, ensure 
the Field Order pop-up menu in the Media Inspector is set to None.

Adjust this filter using the parameter controls in the Filters Inspector:

•	 Dominant Field: Sets the dominant field. There are two options: Upper or Lower.

•	 Method: Sets how the object is interlaced. This pop-up menu has three options:
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•	 Duplicate: The nondominant field is eliminated, and the data from the dominant field 
is duplicated to fill in the missing lines.

•	 Interpolate: The nondominant field is eliminated, and a new field is created by 
averaging each pair of adjacent video lines to create new ones.

•	 Blend: The nondominant field is eliminated, and new lines are created by averaging 
the eliminated line with each pair of adjacent video lines.

•	 Mix: Sets the percentage of the original image that’s blended with the filtered image.

Animate filter controls

Animate filter parameters with keyframes in Motion
Although several Motion filters are animated (Bad Film, Bad TV, and Overdrive, for 
example), most are not. However, it’s easy to create filter animations by using keyframes to 
change parameters over time.

Animate filter parameters using the Record button
1.	 In Motion, select an applied filter in the Layers list, Timeline, or canvas.

2.	 In the timing toolbar (above the Timeline), click the Record button (or press A) to enable 
keyframe recording.

3.	 Move the playhead to the frame where you want to add a keyframe.

4.	 In the Filters Inspector or HUD, change one or more parameters to a new value.

A keyframe is added when you modify a parameter value.

5.	 Move the playhead to the next frame where you want a keyframe.

6.	 Repeat steps 4–5 until you finish.

7.	 Click the Record button again to turn off keyframe recording. 

Click the Play button (or press the Space bar) to see the results.

Animate filter parameters using the Record button and onscreen controls
1.	 In Motion, select an applied filter in the Layers list, Timeline, or canvas.

If the filter has an onscreen control, the Adjust Item tool is selected in the canvas 
toolbar and the onscreen controls appear in the Inspector.

2.	 In the timing toolbar (above the Timeline), click the Record button (or press A) to enable 
recording.

3.	 Move the playhead to the frame where you want to add a keyframe.

4.	 In the canvas, drag the onscreen control.

A keyframe is added when you modify a parameter value using the onscreen control.

5.	 Move the playhead to the next frame where you want a keyframe.

6.	 Repeat steps 4–5 until you finish.

7.	 Click the Record button again to turn off keyframe recording. 

Click the Play button (or press the Space bar) to see the results.
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Animate filter parameters using the Add Keyframe button or the Animation menu
1.	 In Motion, select an applied filter in the Layers list, Timeline, or canvas.

2.	 Move the playhead to the frame where you want to add a keyframe.

3.	 In the Filters Inspector, do one of the following:

•	 Position the pointer over the right side of the row of the parameter to animate. When 
the Add Keyframe button (a plus sign in a gray diamond) appears, click it.

•	 Position the pointer over the right side of the parameter row, click the down arrow to 
open the Animation pop-up menu, then choose Add.

•	 Control-click the parameter name, then choose Add from the shortcut menu.

A keyframe is added at the current playhead position.

4.	 In the Inspector or HUD, or via the onscreen controls (if available), adjust the parameter 
value.

5.	 Move the playhead to the next frame where you want a keyframe.

6.	 Repeat steps 4–5 until you finish.

Click the Play button (or press the Space bar) to see the results.
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Globally animate all parameters of a Color Curves, Color Wheels, or Hue/
Saturation Curves filter
Using a special global Add Keyframe button, you can simultaneously keyframe all 
parameters of the Color Curves filter, the Color Wheels filter, or the Hue/Saturation Curves 
filter.

1.	 In Motion, select an applied Color Curves, Color Wheels, or Hue/Saturation Curves filter 
in the Layers list.

2.	 Move the playhead to the frame where you want to add a keyframe.

3.	 In the Filters Inspector, do one of the following:

•	 Position the pointer in the upper-right corner of the filter, then click the Add 
Keyframe button (a plus sign in a gray diamond).

•	 Position the pointer in the upper-right corner of the filter, click the down arrow to 
open the Animation pop-up menu, then choose Add.

A keyframe is added at the current playhead position.

4.	 In the Inspector, adjust any curve or parameter value.

5.	 Move the playhead to the next frame where you want a keyframe.

6.	 Repeat steps 4–5 until you finish.

Use the Keyframe Editor to fine-tune the timing of keyframes.

For more detail on using the Animation menu to add keyframes, see Animation menu 
controls.
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Animate filters using behaviors in Motion
Animating filter parameters is easy using Parameter behaviors, a special class of behaviors 
that animate a single parameter of an object. For example, if you have a layer with an 
applied Circle Blur filter, you can use a Parameter behavior to randomize the amount of blur 
applied to the object over time.

Animate a filter parameter using a Parameter behavior
1.	 In Motion, in the Layers list, Timeline, or canvas, select an applied filter.

2.	 In the Filters Inspector, do one of the following:

•	 Place the pointer over the right side of a parameter row until the Animation pop-up 
menu appears (a down arrow), then click the arrow, choose Add Parameter Behavior, 
and choose a behavior from the submenu.

•	 Control-click a parameter name, choose Add Parameter Behavior from the shortcut 
menu, then choose a behavior from the submenu.

A behavior icon (a gear) appears in the parameter row, and the Behaviors Inspector 
opens.

3.	 In the Behaviors Inspector, adjust the parameters of the newly applied Parameter 
behavior.

Click the Play button (or press the Space bar) to see the results.
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About filters and color processing
A Motion project’s Color Processing setting (in the Project Properties Inspector) can 
change the way filters affect images. For example, if you change a project’s color 
processing from Standard Gamut SDR to Automatic, the effect of some filters (or blend 
modes) may change in appearance.

Additionally, when Color Processing is set to Automatic, an HDR White Level slider lets you 
brighten or dim SDR elements such as SDR images, text, and shapes created in Motion. 
This slider has no effect on HDR media in the project. However, some filters, when applied 
to an HDR image or clip, may cause the clip to react to the HDR White Level slider. This 
is because some filters apply SDR colors to HDR media, and the SDR colors react to 
the slider. For example, filters with a color well add SDR colors to an HDR image or clip, 
causing all or part of the HDR media to react to the HDR White Level slider.

Note: The Color Balance filter, even though it contains color wells to adjust shadows, 
midtones, and highlights, does not cause HDR media to react to the HDR White Level slider.

In the following images, an Insect Eye filter (which contains a color well to select the 
hexagon border color) is applied to an HLG clip in an Automatic project. In the left image, 
the HDR White Level slider is set to the default value of 75%; in the right image, the slider 
is increased to 100%. Increasing the HDR White Level value brightens the border (where 
the SDR color is applied), but not the HLG clip.

In the following images, a Tint filter (which contains a color well to select the tint’s color) 
is applied to an HLG clip in an Automatic project. In the left image, the HDR White Level 
slider is set to the default value of 75%; in the right image, the slider is increased to 95%. 
Increasing the HDR White Level value brightens the HLG clip.

Note: Some Motion filters process only in SDR. When Color Processing is set to Automatic 
and an SDR-only filter is applied to an image or clip, the image is tone mapped to SDR 
levels, processed by the filter, then automatically inverse tone mapped to HDR levels. In 
some cases, applying filters to a bright PQ clip (with peak luminance levels greater than 
1,000 nits), may result in clipping of the image (or dimming of the project output).
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Publish Motion filter controls to Final Cut Pro
When you create templates in Motion for use in Final Cut Pro, you can choose which 
parameter controls are available in the effect, title, transition, or generator when it’s 
applied to a clip in Final Cut Pro. For example, if you create a Final Cut Effect template 
using a Variable Blur filter, you might choose to export only the Inner Radius and Outer 
Radius sliders to Final Cut Pro (and not the Amount slider). In essence, you place limits on 
how the effect can be modified in Final Cut Pro by deciding which parameters to publish. 
You can also publish filter onscreen controls.

Publish filter controls in a Final Cut Pro template
1.	 In Motion, in an open Final Cut Pro template project, select an applied filter.

2.	 In the Filters Inspector, do one of the following:

•	 Click the Animation menu (the down arrow that appears when you move the pointer 
over the right side of the parameter row), then choose Publish from the pop-up 
menu.

•	 Control-click the parameter name, then choose Publish from the shortcut menu.

Important: Choosing Publish in the filter name row (the row containing the activation 
checkbox) publishes the filter’s activation checkbox—but not parameter controls for 
the filter (sliders, dials, and so on). Publishing a filter’s checkbox lets you turn on or 
off all published parameters simultaneously in Final Cut Pro.
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Publish a filter’s onscreen controls
1.	 In Motion, in an open Final Cut template project, select an applied filter.

2.	 In the Filters Inspector, select the Publish OSC checkbox.

Review parameters set to be published in your template
1.	 In the Layers list in Motion, click the Project object (at the top of the list).

2.	 In the Project Inspector, click Publishing.

All parameters (for all object types) set to be published appear in the Publishing pane.

Note: Published filter onscreen controls do not appear in the Publishing pane.

Unpublish filter parameters in the Filters Inspector
•	 In the Filters Inspector in Motion, do one of the following:

•	 Click the Animation menu (the down arrow that appears when you move the pointer 
over the right side of the parameter row), then choose Unpublish from the pop-up 
menu.

•	 Control-click the parameter name, then choose Unpublish from the shortcut menu.

Unpublish filter parameters in the Publishing pane
1.	 In the Layers list in Motion, click the Project object.

2.	 In the Project Inspector, click Publishing, then do one of the following:

•	 Click the Animation menu (the down arrow that appears when you move the pointer 
over the right side of the parameter row), then choose Unpublish from the pop-up 
menu.

•	 Control-click the parameter name, then choose Unpublish from the shortcut menu.
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Using filters on alpha channels in Motion
There are filters you can use to manipulate or even replace a layer’s alpha channel. For 
example, the Green Screen Keyer and Luma Keyer filters create transparency by generating 
an alpha channel based on color or luminance values in that layer. Keying filters are usually 
used on layers that have no alpha channel information; these filters add a new alpha 
channel to the layers to which they’re applied. For more information on the use of the 
keying filters, see Intro to color keying.

The process of improving a keying effect or of customizing an alpha channel created using 
shape or image masks may require the use of special filters. Although you can apply any 
filter to a shape or image mask to modify that mask’s effect, the filters described in this 
section modify a layer’s entire alpha channel, including the sum of all masks and other 
filters applied to that layer.

For example, if you’ve applied a keying filter, you can use the following filters to modify 
the resulting alpha channel even though no mask appears for that layer in the Layers list or 
Timeline:

•	 Channel Blur: This filter, found in the Blur category of the Filters library, lets you 
selectively blur the alpha channel. You can set the amount of horizontal and vertical 
blur independently.

•	 Matte Magic: This filter, found in the Keying subcategory of the Filters library, lets you 
manipulate various qualities of an alpha channel, shrinking, feathering, and eroding the 
alpha channel to fine-tune it. See Matte Magic filter.
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Filter performance in Motion

Filter performance considerations 
In large projects with complex motion graphics, applying multiple filters can adversely 
affect your computer’s performance. To ensure smooth playback, use the following 
suggestions to optimize your use of filters:

•	 When multiple layers are affected by a filter, place the targeted layers in a single group 
and apply the filter to the group (rather than applying the filter multiple times).

•	 When applying filters to very large 2D groups (such as a group containing a growing 
particle system), select the Fixed Resolution checkbox in the Group Inspector. When 
Fixed Resolution is enabled, layers in the group that expand beyond the edges of the 
canvas are cropped, reducing the processing load on your computer. See Constrain 
group size.

Filters affect text, 2D groups, and 3D groups in different ways. See 2D and 3D group 
properties.

Third-party party effects and obsolete filters
Many third-party companies offer FxPlug filters and effects. If you install a third-party 
product, additional effects appear in the Filters list, usually in a separate, custom-named 
category.

If you open a project created in a previous version of Motion containing filters or media that 
are no longer available, an alert message appears listing the missing or obsolete items. For 
filter descriptions in earlier versions of Motion, see the user manual associated with that 
version of the application.

Save custom filters in Motion
After you add and edit a filter, you can save it as an effect preset in the Filters, Favorites, or 
Favorites Menu category in the Library, for future use.

Save a filter to the Library
1.	 In Motion, open the Library and select the Filters, Favorites, or Favorites Menu category.

2.	 Drag the filter you want to save from the Layers list into the stack at the bottom of the 
Library.

The customized emitter is saved to the category you chose in the Library. 

 Tip: For organizational purposes, create a folder of your own in the Favorites or 
Favorites Menu category to store custom filters.
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Composite with color and luma keys

Intro to color keying in Motion
Keying is the process of isolating a foreground subject against a background area of 
uniform color or brightness to generate an alpha channel (a matte) based on the shape of 
the color area. Keying is commonly performed on subjects photographed against a blue 
or green background, but keys can be based on any color (color or chroma keying) or on a 
specific range of brightness values (luma keying).

Color keying (also known as chroma keying) is commonly used on television to create the 
familiar effect of a newsreader or show host backed by animated graphics. You can do the 
same thing in Motion using the Masks and Keying filters.

Important: Most keys are “pulled” using more than one tool. Good compositing artists 
usually combine keying filters, matte adjustment filters, spill suppression operations, 
and garbage or holdout masks to isolate a single subject. The Green Screen Keyer filter 
in Motion combines many of these operations within a single set of parameters. In some 
instances, it may be necessary to apply different keyer settings to different areas of the 
subject, requiring the use of multiple keying filters and masks.

There are two types of keyer filters in Motion:

•	 Use the Green Screen Keyer for blue screen or green screen keying, or for keying any 
range of color you choose.

•	 Use the Luma Keyer to generate mattes based on a sampled range of lightness in the 
image.

Two other filters provide standalone access to matte finishing operations:

•	 Use the Matte Magic filter to refine the edges of a matte.

•	 Use the Spill Suppression filter to manually correct matte problems created when the 
background color creates a reflection on the foreground subject.
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Use the Green Screen Keyer filter

Intro to the Green Screen Keyer filter in Motion
The Green Screen Keyer filter is intended for subjects shot in front of a blue screen or 
green screen. However, you can also use this filter to “pull” chroma keys from any range 
of color within a shot. The keyed portions of the image are rendered transparent, allowing 
background images to show through.

At its default settings, the Green Screen Keyer filter attempts to work as automatically as 
possible. When you apply the Green Screen Keyer filter to an object, Motion analyzes the 
visible frame in the canvas to detect a dominant color such as a green or blue background. 
The dominant color becomes the initial sample that generates the tolerance, or core 
transparency, of the underlying key; this key is rendered as transparent in your composite. 
You can override the automatic initial color sampling to key any color, and you can refine 
your settings using the parameter controls in the Filters Inspector.

Use the Green Screen Keyer filter in Motion
You apply a Green Screen Keyer filter like any other filter in Motion—from the Library or the 
Filters pop-up menu in the toolbar. See Apply or remove filters.

After you apply the filter and create a basic key, you can fine-tune the default color 
sampling or set the key colors manually. If necessary, further refine the key using advanced 
color-selection controls and matte tools in the Filters Inspector.

 Tip: If you’re applying the Green Screen Keyer filter to HDR media in an Automatic 
project (or using the filter in a Final Cut template), set Render Color Space (in the View 
pull-down menu) to HDR Rec. 2020 HLG (or PQ) before applying the filter. Once you’ve 
applied and adjusted the filter, set Render Color Space to Rec. 709 and further refine the 
key. When you change the project’s color space (or apply the template to the Final Cut Pro 
timeline), the key now remains consistent.

Create a basic key
1.	 Import a background image into your Motion project.

2.	 Import a foreground image or video clip of a subject positioned in front of a green 
screen or blue screen.

This example uses video footage of an actor standing in front of a green screen. Make 
sure the foreground layer (the actor and green screen) is above the background layer in 
the Layers list.

3.	 Move the playhead to a frame where the green screen is visible in the canvas, then 
select the foreground layer in the Layers list (the layer with the green screen).
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4.	 In the toolbar, click Filters, then choose Masks and Keying > Green Screen Keyer from 
the pop-up menu.

The Green Screen Keyer filter removes the dominant color in the image (if blue or 
green). For best results, apply the filter to the frame with the greatest amount of the 
color to key.

If the filter removes the wrong color, you can manually set the color. See Override 
automatic color sampling and set your own key colors.

The background layer shows through as long as the View control in the Filters Inspector 
is set to Composite.

Note: If the clip you add a Green Screen Keyer filter to is not visible in the canvas, the 
initial key is pulled based on the first or last frame of the clip, whichever is closest to 
the playhead.

5.	 If the automatic key is too aggressive (keying out soft details of the foreground subject 
that you want to preserve), open the Filters Inspector, then slowly drag the Strength 
slider left to reduce the tolerance (core transparency) of the matte until you’re satisfied 
with the amount of edge detail in the key.

Doing so allows areas of marginal transparency like hair, smoke, and reflections to show 
through. In general, it’s better to err on the side of a less aggressive key, using the 
parameters within the Matte Tools group to fine-tune the soft details you’re trying to 
preserve. See Refine a key using matte tools, below.

 Tip: To see how the Chroma and Luma parameters are affected as you adjust the 
Strength slider, look at the Color Selection controls in the Filters Inspector. (Click the 
disclosure triangle beside the Color Selection parameter to see the controls.) 
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Override automatic color sampling and set your own key colors
Although the Green Screen Keyer filter automatically samples your keying color, you can 
override that sampling and set the key colors manually. You might want to do this if you use 
a background screen color other than green or blue, or if the green screen or blue screen 
was unevenly lit.

1.	 In Motion, select an applied Green Screen Keyer filter in the Layers list, then open the 
Filters Inspector or HUD.

2.	 Set the Strength slider to 0.

Automatic color sampling is disabled, and the color screen background becomes visible 
in the canvas.

3.	 In the Filters Inspector (or HUD), click to select the Sample Color tool.

4.	 In the canvas, drag a selection rectangle over an area of the screen color you want to 
key.
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Most of the color screen should disappear and be replaced by the image in the layer 
underneath the foreground layer in the Layers list. You can add as many selection 
rectangles as necessary to sample areas of the color screen (for example, highlights or 
shadows on the color screen) to achieve a better result.

If the edges of the foreground subject are too sharp, use the Edges tool to soften the 
foreground edges. The Edges tool is also effective for fine-tuning semitransparent 
features such as smoke, glass reflections, and shadows.

5.	 In the Filters Inspector or HUD, click to select the Edges tool.

6.	 In the canvas, drag over the edge of the foreground subject and, when an Edges control 
line appears, keep dragging so that one end point lies in the interior of the foreground 
subject and the other end point lies in the background.

7.	 In the canvas, drag the center handle of the Edges control line to adjust the edge 
transparency of the keyed subject.

You can also set the View mode to Matte in the Filters Inspector, which helps you see 
the effect of using the Edges tool.

 Tip: To see how the Edges control alters the outer softness graph of the Chroma 
control and the bottom softness handles of the Luma controls, look at the Color 
Selection controls in the Filters Inspector as you make adjustments. (Click the 
disclosure triangle beside the Color Selection parameter to see the controls.) 

Set your own key colors using keyboard shortcuts
When manually sampling colors to create a key, you can use keyboard shortcuts instead of 
clicking the Sample Color tool and Edge tool in the Inspector.

1.	 In the Layers list in Motion, select the Green Screen Keyer filter to adjust.

2.	 Do one of the following:

•	 To create a Sample Color selection rectangle, press and hold the Shift key while 
dragging over the color you want to key in the canvas.

•	 To create an Edges sampling control, press and hold the Command key while 
dragging to draw a line that crosses over the edge of the subject you’re keying in the 
canvas.
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•	 To remove a Sample Color or an Edges control, Option-click anywhere in the sample 
control you want to delete, or click to select a sample control, then press the Delete 
key.

Refine a key using the Color Selection controls
1.	 With the Green Screen Keyer filter selected in the Layers list in Motion, set the View 

mode in the Filters Inspector to Matte.

Matte mode lets you see how your adjustments affect the transparency of the image. 
The keyed image now appears in grayscale: white areas represent solid pixels in the 
final matte; black areas represent transparent pixels in the final matte; and varying 
levels of gray represent translucent pixels in the final matte (darker gray is more 
transparent; lighter gray is more opaque).

2.	 Click the disclosure triangle in the Color Selection row of the Filters Inspector to reveal 
additional controls.

3.	 Click one of the two Graph views to select a mode for the adjustments you need:

•	 Scrub Boxes: Remain in Scrub Boxes mode (the default) if you’re satisfied with the 
current key but want to adjust the edge softness of the resulting matte. In Scrub 
Boxes mode, you can adjust the outer graph of the Chroma control and the lower 
handles of the Luma control to increase or decrease the translucency of the edges 
of the matte.

•	 Manual: Click Manual to make substantial alterations to tolerance (core 
transparency) and edge softness in the matte. In Manual mode, you can adjust 
the inner and outer graphs of the Chroma control, as well as the upper and lower 
handles of the Luma control to alter all aspects of transparency in the matte. In 
Manual mode, you cannot alter the Strength parameter or add more Sample Color or 
Edges controls in the canvas.

After you enter Manual mode, do not return to Scrub Boxes mode.

Note: For more information on keyframing the Color Selection controls, see 
Animating color key parameters.
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4.	 Depending on the mode you selected in the previous step, adjust the controls to alter 
your matte:

•	 In Scrub Boxes mode, drag any side of the outer graph in the Chroma control to 
alter the range of hue and saturation contributing to the matte’s edge softness 
(transparency around the edges of the key).

Note: In Scrub Boxes mode, you can also drag the two lower handles of the Luma 
control to alter the range of lightness and darkness contributing to the matte’s edge 
softness.

•	 In Manual mode, drag any side of the outer graph in the Chroma control to alter the 
range of hue and saturation contributing to the matte’s edge softness. Drag any side 
of the inner graph to alter the range of hue and saturation contributing to the matte’s 
tolerance (core softness). Drag in the center of the inner graph to rotate the graph to 
a new position in the color wheel.

Note: In Manual mode, you can also drag any of the four Luma control handles. The 
two upper Luma handles alter the range of lightness and darkness contributing to 
the matte’s tolerance (core transparency); the two lower handles alter the range of 
lightness and darkness contributing to matte’s edge softness.
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In either mode, expanding the Chroma graph or Luma handle outward increases the 
regions of transparency in the keyed image. Dragging the side of a Chroma graph or 
a Luma handle inward diminishes the transparent regions in the keyed image. In the 
example below, the top image shows the holes in the matte that result from increasing 
edge softness using the outer graph of the Chroma control. The bottom image shows 
how reducing edge softness closes these holes.

5.	 If you haven’t adjusted the Luma control, drag the left or right lower handles to alter the 
softness of the luma component of the image.

 Tip: In Manual mode, you can adjust the lower handles by dragging the bar 
connecting the top and bottom handles. To adjust all handles simultaneously, drag 
inside the curve in the graph.

6.	 Adjust the Chroma and Luma Rolloff sliders to subtly alter the falloff between the 
tolerance and softness of the key.
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Refine a key using matte tools
1.	 With the Green Screen Keyer filter selected in the Layers list in Motion, set the View 

mode in the Filters Inspector to Matte.

Matte mode lets you see how adjustments affect the transparency of the image. The 
keyed image appears in grayscale: white areas represent solid pixels in the final matte; 
black areas represent transparent pixels in the final matte; and varying levels of gray 
represent translucent pixels in the final matte (darker gray is more transparent; lighter 
gray is more opaque).

2.	 In the Filters Inspector, click the disclosure triangle of the Matte Tools row.

The row expands to reveal the Levels control, which adjusts the contrast of the matte. 
Also revealed are the Shrink/Expand slider, the Soften slider, and the Erode slider.

3.	 Use the Levels control to modify transparency and contrast in the matte. 

A general rule for using the Levels control is to drag the center Bias handle left to 
decrease transparency in the matte or right to increase transparency in the matte. The 
Black slider on the left and the White slider on the right modify contrast in the shadows 
and highlights of the matte. 

The effects of Levels adjustments are best seen when View is set to Matte. In this view, 
the white area of the matte is the solid part, and the black area of the matte is the 
transparent part. Gray is translucent, with lighter grays creating progressively more 
transparency. With this in mind, here are some guidelines:

•	 Dragging the black bias handle right pushes gray areas to black, expanding areas of 
transparency within the matte.

•	 Dragging the center bias handle left pushes the grays in the matte towards white, 
widening solid areas of the key as semitransparent areas are made solid.

•	 Dragging the center bias handle right pushes the grays in the matte towards 
black, widening transparent areas of the key as semitransparent areas are made 
transparent.

•	 Dragging the white bias handle left pushes the grays in the matte towards white, 
expanding areas of solidity within the matte.

4.	 Drag the Shrink/Expand slider left to shrink the matte inwards, widening holes in the 
matte; drag the Shrink/Expand slider right to expand the matte outward, filling in holes 
in the matte.
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5.	 Drag the Soften slider right to blur the matte overall, resulting in softer edges 
throughout the matte.

6.	 Drag the Erode slider right to soften the matte from the edge inward, while preserving 
the original matte outlines as a translucent outer boundary.

Green Screen Keyer filter controls in Motion
After you apply the Green Screen Keyer filter to a video or image layer in your project, you 
can modify and refine the keying parameters in the Filters Inspector, which contains the 
following controls:
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Refine Key tools
Use the Refine Key tools—Sample Color and Edges—to manually sample regions of an 
image to modify the tolerance (core transparency) of the generated key. 

•	 Sample Color: A button that activates an onscreen control to select regions of the 
image to be turned transparent. Click the Sample Color tool, then drag a selection 
rectangle in the canvas to define a range of color to key. After you create a selection 
rectangle, you can resize it to sample more or fewer shades of color, increasing or 
decreasing the range of background color used to create transparency. You can also 
add more selection rectangles to expand the range of color that is keyed, or add more 
selection rectangles at other frames of the clip to maintain transparency when lighting 
conditions change. (To add selection boxes, select the Green Screen Keyer filter in the 
Layers list, then press and hold the Shift key while dragging in the canvas.)

Note: Adding a Sample Color selection box to a frame adds to the sampled region that’s 
defined when you first apply this filter.

When you sample regions in multiple frames, keyframes are added to interpolate the 
difference from one frame to the next. (Unlike standard keyframes, color-sampling 
keyframes are hidden in the Motion window by default.) The Jump to Sample buttons let 
you navigate between frames you’ve sampled, to make changes. See Animating color 
key parameters.

•	 Edges: A button that activates an onscreen control to refine the transparency of 
marginal regions of the keyed subject, such as hair, reflections, smoke, or moving 
subjects with motion blur. Click the Edges tool, then drag in the canvas to draw a line 
that crosses the boundary of the semitransparent region you want to adjust (with 
one point on the keyed foreground subject and the other point on the transparent 
background). Next, adjust the slider handle in the middle of this control line, outward to 
soften the matte, or inward to harden it. 

Note: To remove a Sample Color selection rectangle or Edges control line, select the 
rectangle or control line in the canvas, then press Delete. Alternatively, Option-click 
inside the selection box or control line.



1098Motion User Guide

Additional key controls
•	 Strength: A slider to adjust the tolerance (core transparency) of the Green Screen Keyer 

filter’s automatic sampling. The default value is 100%. Reducing this value narrows the 
range of color sampled, resulting in less transparency in the keyed image. Increasing 
the Strength value expands the range of color sampled, resulting in more transparency 
in the keyed image. Use the Strength slider to retrieve areas of semitransparent detail 
such as hair, smoke, or reflections. 

Important: Setting Strength to 0 bypasses the filter’s automatic sampling altogether, 
allowing you to manually sample a range of color using the Refine Key tools (described 
above).

•	 Jump to Sample: Left and right arrow buttons to navigate to frames that have been 
manually sampled using the Sample Color and Edges tools. When the playhead is at a 
sampled frame, a numeric counter to the right of these buttons indicates your current 
position in the range of sampled frames (for example, “3 of 5”).

•	 View: Buttons to switch between three keying preview modes in the canvas, useful for 
refining your key. The View setting affects what is rendered in your final output. For 
example, setting View to Matte lets you export a grayscale matte image that you can 
use as a luma channel matte in another application. There are three buttons:

•	 Composite: A button that, when selected, displays the final composited image in the 
canvas, with the keyed foreground object isolated against a transparent background, 
which lets layers underneath show through.

•	 Matte: A button that, when selected, displays the grayscale matte, or alpha channel, 
generated by the keying operation. Viewing the alpha channel directly lets you 
evaluate the parts of the generated matte. Areas in the matte that appear white are 
visible in the final composite; areas that appear black are transparent; and areas 
with shades of gray are semitransparent (lighter grays being more solid). Viewing the 
alpha channel makes it easier to spot unwanted holes in the key, or areas of the key 
that aren’t transparent enough.

•	 Original: A button that, when selected, displays the original, unkeyed image in the 
canvas. This view is useful to sample colors from the original image.

•	 Fill Holes: A slider to adjust solidity in regions of marginal transparency throughout a 
key. This control is useful when you’re satisfied with the edges of your keyed matte, 
but you have unwanted holes in the interior of the foreground subject that you can’t 
eliminate using the Strength parameter without ruining your edges. Higher slider values 
fill more holes in the solid areas of the keyed subject.
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•	 Edge Distance: A slider to adjust how close to the edge of your keyed subject the 
effect of the Fill Holes parameter gets. Decreasing this parameter brings the solid, 
nontransparent area of the matte closer to the edge of the subject being keyed, 
sacrificing translucence at the edges in favor of filling unwanted holes at the edge of 
the keyed subject, or retrieving areas of semitransparent detail, such as hair, smoke, or 
reflections. Increasing this parameter value pushes the filled area of the matte farther 
to the interior of the subject, away from the edges, adding translucence to regions 
of the image that aren’t being keyed aggressively enough. Increasing this parameter 
too much may introduce regions of unwanted translucence in parts of the subject that 
should be solid.

•	 Spill Level: A slider to set how much spill suppression is applied to the keyed subject. 
Spill suppression is a color correction that neutralizes the green or blue light that often 
bounces off a green screen or blue screen background and tints the edges of a subject 
during a shoot. Consequently, it becomes more difficult to separate the foreground 
subject from the background during the keying process. Spill suppression is applied 
when you add the Green Screen Keyer filter. 

The color that is suppressed in the final image is based on the sampled portion of 
the image. The Spill Level slider controls how much spill suppression is applied to 
the keyed subject. For example, if the subject was shot in front of a green screen 
background, increasing the Spill Level value adds magenta to the foreground image, 
which neutralizes any unwanted green cast that your subject may be exhibiting. Spill 
suppression can be further customized using the controls in the Spill Suppression 
group, described later. Setting Spill to 0 turns off spill suppression.

•	 Invert: A checkbox that, when selected, inverts the generated matte, so that solid areas 
become transparent, and vice versa.
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Color Selection controls
Click the disclosure triangle in the Color Selection row to reveal controls for adjusting the 
tolerance (core transparency) and softness (edge transparency) in the chroma and luma 
channels of the keyed region. Available controls vary depending on the Graph mode (Scrub 
Boxes or Manual) you select.

These controls are meant to be used after you begin creating a key using automatic 
sampling or the Sample Color and Edges tools. (However, you can skip those tools and 
create a key using the Color Selection controls in Manual mode.) The graphical Chroma and 
Luma controls in the Color Selection group provide a detailed way of refining the range of 
hue, saturation, and image lightness that define the keyed matte.

Before you adjust these controls, the graphs in the Chroma and Luma controls represent 
ranges of color and luma in the image that have been automatically and manually sampled 
(using the Refine Key tools and the Strength slider).

The Color Selection group contains the following controls:

•	 Graph: Two buttons to set how the adjustable graphs in the Chroma and Luma controls 
are used to fine-tune a key: 

•	 Scrub Boxes: When selected, this button limits the Chroma and Luma controls 
to adjusting softness (edge transparency) in the matte you’re creating. In Scrub 
Boxes mode, you cannot manually adjust tolerance (core transparency), which is 
determined by the Green Screen Keyer filter’s automatic sampling, or any Sample 
Color selection boxes you’ve added in the canvas. To increase matte tolerance, add 
more Sample Color selection boxes or adjust the Strength slider.)

•	 Manual: When selected, this button allows Chroma and Luma controls to adjust the 
softness (edge transparency) and tolerance (core transparency) in the matte you’re 
creating. Make sure the Strength slider is set to a value greater than 0 before you 
switch into Manual mode (to prevent the Chroma and Luma controls from being 
disabled). When you switch to Manual mode, the Refine Key tools and Strength 
slider become disabled, but samples you’ve made with those controls continue to 
contribute to the matte. 
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Important: After you switch to Manual mode, it’s inadvisable to switch back to Scrub 
Boxes mode. For best results, begin keying an image using the Sample Color and Edges 
tools in Scrub Boxes mode. Switch to Manual mode afterwards if you feel it’s necessary 
to refine your matte using the Chroma and Luma controls. However, after you switch to 
Manual mode, do not switch back to Scrub Boxes mode. If you do, you may experience 
unexpected combinations of additionally sampled and keyframed values that are 
difficult to control.

•	 Chroma: Two graphic controls in the color wheel control to adjust the isolated range of 
hue and saturation that help define the keyed matte. The selected Graph mode governs 
which graphs in the color wheel are adjustable. The outer graph controls the softness 
(edge transparency) of the matte you’re creating, and can be adjusted in either Scrub 
Boxes or Manual mode. The inner graph controls tolerance (core transparency), and is 
only adjustable when in Manual mode.

Drag any side of either graphic control to expand or contract the graph’s border, 
adding to or subtracting from the range of hue and saturation contributing to the key. In 
manual mode, you can also drag inside the tolerance graphic control to adjust its overall 
position in the color wheel.

To the left of the color wheel, a small graph displays the slope of chroma rolloff, the 
relative softness of matte edges in regions most affected by the Chroma control. 
Dragging the Chroma Rolloff slider (described below) modifies the shape of this slope.

It’s possible to zoom into and pan around the Chroma control to more precisely adjust 
the graphs:

•	 To zoom incrementally into the Chroma control, press and hold the Z key and click 
the color wheel. To zoom out, press and hold the Option and Z keys and click the 
color wheel. To smoothly zoom out, press and hold the Z key and drag left in the 
color wheel. To smoothly zoom in, press and hold the Z key and drag right in the 
color wheel. You can also press and hold the Space bar and Command key (in that 
order) and drag left in the color wheel to zoom out or drag right to zoom in.

•	 To pan in the Chroma control, press and hold the H key and drag in the color wheel. 
You can also press and hold the Space bar and drag in the color wheel in the 
direction you want to move it.

•	 To reset the zoom and recenter the Chroma control, move the pointer over the 
Chroma control and press Shift-Z.

•	 Luma: A grayscale gradient control with adjustable handles to modify the isolated 
range of the luma channel (the range of lightness and darkness) that also helps define 
the keyed matte. The upper handles (which only appear in Manual mode) adjust the 
tolerance (core transparency) of the luma channel’s contribution to the key. The lower 
handles adjust the softness (edge transparency) of the luma channel’s contribution to 
the key.

The Graph mode governs which handles are adjustable. In Scrub Boxes mode, you can 
adjust only the lower softness handles. In addition to using the handles, you can drag 
the slope in the graph to adjust the softness.

In Manual mode, you can also adjust the upper tolerance handles, which modify core 
transparency within the luma channel of the matte. Dragging the slope in the graph 
adjusts the lower handles (the softness). To adjust all handles simultaneously, drag 
inside the curve in the gradient control.
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By default, the slope of the left and right sides of the Luma graph has a slight “S” 
curve. You can modify the shape of the curve by adjusting the Luma Rolloff slider 
(described below).

Note: The luma softness handles may extend past the outer boundaries of the Luma 
control. This is due to the floating-point precision of the Green Screen Keyer filter, and 
is an expected behavior.

•	 Chroma Rolloff: A slider to adjust the linearity of the chroma rolloff slope (displayed in 
the small graph to the left of the Chroma control). Chroma rolloff modifies the softness 
of the matte around the edges of regions that are affected most by the Chroma control. 
Lowering this value makes the slope of the graph more linear, which softens the edges 
of the matte. Raising this value makes the slope of the graph steeper, which sharpens 
the edges of the matte. 

•	 Luma Rolloff: A slider to adjust the linearity of the luma rolloff slope (the ends of the 
bell-shaped luma curve displayed in the Luma control). Luma rolloff modifies the 
softness of the matte around the edges of regions that are affected most by the Luma 
control. Lowering this value makes the slope between the upper and lower handles in 
the Luma control more linear, which increases edge softness in the matte. Raising this 
value makes the slope steeper, sharpening the edges of the matte and making them 
more abrupt.

•	 Fix Video: Select this checkbox to apply subpixel smoothing to the chroma components 
of the image, reducing the jagged edges that result from keying compressed media 
using 4:2:0, 4:1:1, or 4:2:2 chroma subsampling. Although selected by default, this 
checkbox can be deselected if subpixel smoothing degrades the quality of your keys.

Matte Tools controls
Click the disclosure triangle in the Matte Tools row to reveal controls for post-processing 
the transparency matte generated by the previous sets of parameters. These parameters 
don’t alter the range of values sampled to create the keyed matte. Instead, they alter the 
matte generated by the Green Screen Keyer filter’s basic and advanced controls (in the 
Color Selection parameter group), letting you shrink, expand, soften, or invert the matte to 
achieve a better composite.
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The Matte Tools group contains the following controls:

•	 Levels: A grayscale gradient to alter the contrast of the keyed matte. Drag this control’s 
three handles to set the black point, white point, and bias (distribution of gray values 
between the black point and white point). Adjusting the contrast of a matte can be 
useful for manipulating translucent areas of the key to make them more solid (by 
lowering the white point) or more translucent (by raising the black point). Dragging the 
Bias handle (the gray tag under the gradient) right erodes translucent regions of the 
key, while dragging the Bias handle left makes translucent regions of the key more solid.

•	 Black, White, Bias: Click the disclosure triangle in the Levels row to reveal sliders for 
the Black, White, and Bias parameters. These sliders, which mirror the settings of the 
Levels handles described above, allow you to keyframe the three Levels parameters 
(via the Add Keyframe button to the right of each slider). Keyframing the Black, White, 
and Bias parameters may yield a better key, one that adapts to changing blue screen or 
green screen conditions. 

•	 Shrink/Expand: A slider to manipulate the contrast of the matte to affect matte 
translucence and matte size simultaneously. Drag the slider left to make translucent 
regions more translucent while simultaneously shrinking the matte. Drag the slider right 
to make translucent regions more solid while simultaneously expanding the matte. 

•	 Soften: A slider to blur the keyed matte, feathering the edges by a uniform amount.

•	 Erode: A slider that you can drag to the right to gradually increase transparency from 
the edge of the solid portion of the key inward. 

Spill Suppression controls
Click the disclosure triangle in the Spill Suppression row to reveal controls for neutralizing 
blue or green light that bounces off the blue screen or green screen and contaminates the 
isolated foreground subject. This fringing around the edge of the subject is called spill, and 
is difficult to eliminate because it’s part of the subject you’re trying to preserve.

The Spill Suppression controls work by letting you adjust the color correction that 
neutralizes unwanted color in the foreground subject. Whereas the Spill Level slider 
(described above) controls how much suppression is applied, the controls in this group let 
you customize the quality of suppression being performed.

When first applied, the Green Screen Keyer filter adds spill suppression to the video clip 
or image, based on the dominant color sampled to create the initial key. This automatic 
spill suppression desaturates the key color so fringing around the foreground subject 
appears gray (rather than blue or green). But if you reduce the Spill Level slider to 0, 
effectively turning off spill suppression, the gray fringing turns blue or green (the color of 
your background), proving that successful spill suppression is rendering the background a 
neutral gray.
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The Spill Suppression group contains the following controls:

•	 Spill Contrast: A grayscale gradient to adjust the contrast of the color being 
suppressed, using Black point and White point handles (the tags under the gradient). 
Modifying spill contrast can reduce the gray fringing surrounding a foreground subject. 
The Black point handle (on the left side of the gradient control) lightens edge fringing 
that’s too dark for a successful composite. The White point handle (on the right side of 
the gradient control) darkens edge fringing that is too light. Depending on how much 
spill is neutralized by the Spill Level slider, these controls may have a greater or lesser 
effect on the subject.

•	 Black, White: Click the disclosure triangle in the Spill Contrast row to reveal sliders 
for the Black and White point parameters. These sliders, which mirror the settings of 
the Spill Contrast handles described above, allow you to keyframe the Black point and 
White point parameters (via the Add Keyframe button to the right of each slider).

•	 Tint: A slider to restore the natural color of the keyed foreground subject. Because the 
Spill Suppression controls eliminate blue or green spill by desaturating subtle blue or 
green fringing and reflection on the subject, the Tint slider lets you add hues to restore 
the natural color of the subject. Overdoing this parameter results in over-tinting the 
subject with the complementary color of the hue being suppressed—magenta if green, 
and orange if blue.

•	 Saturation: A slider to alter the range of hues introduced by the Tint slider (when the 
Tint slider is used at moderate levels).

Light Wrap controls
Click the disclosure triangle in the Light Wrap row to reveal controls for blending color and 
lightness values from the background layer of your composite with the keyed foreground 
layer. Using these controls, you can simulate the interaction of environmental lighting with 
the keyed subject, making it appear as if background light wraps around the edges of a 
subject. In the following image on the right, with Light Wrap applied, environmental lighting 
from the orange sky background layer “wraps around” the edges of the candle and the 
right edge of the woman’s hair.

In Motion, the Light Wrap operation blends light and dark values from the background with 
the edges of the keyed foreground subject, and can be used to create color-mixing effects 
around the edges of the solid part of a key to better marry the background and foreground 
layers of your keyed composite.
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Light Wrap is the last operation in the image-processing pipeline. In other words, the 
light-wrap effect is added after every other image operation is processed, including filters, 
lights and shading, and other composited effects. As a result, Light Wrap accounts for any 
other visual effect that might alter the look of the object it is applied to, yielding the most 
desirable result.

Note: If the layer is set to the Light Wrap blend mode and you increase the Light Wrap 
parameter in the Green Screen Keyer filter above 0, the Light Wrap parameters of the 
Green Screen Keyer filter take precedence (and the Light Wrap blend mode in the 
Properties Inspector is ignored). However, the Light Wrap blend mode in the Properties 
Inspector for a group overrides the Light Wrap parameters of any Green Screen Keyer 
filters applied to layers in that group.

The Light Wrap group contains the following controls:

•	 Amount: A slider to control the overall light-wrap effect, setting how far into the 
foreground the light wrap extends.

•	 Intensity: A slider to adjust gamma levels to lighten or darken the interaction of wrapped 
edge values with the keyed foreground subject.

•	 Opacity: A slider to fade the light-wrap effect up or down.

•	 Mode: A pop-up menu to choose the compositing method that blends the sampled 
background values with the edges of the keyed subject. There are five options:

•	 Normal: Evenly blends light and dark values from the background layer with the 
edges of the keyed foreground layer.

•	 Lighten: Compares overlapping pixels from the foreground and background layers, 
then preserves the lighter of the two. Good for creating a selective light-wrap effect.

•	 Screen: Superimposes lighter portions of the background layer over wrapped areas 
of the keyed foreground layer. Good for creating an aggressive light-wrap effect.

•	 Overlay: Combines the background layer with the wrapped areas of the keyed 
foreground layer so overlapping dark portions become darker, light portions become 
lighter, and colors become intensified.

•	 Hard Light: Similar to the Overlay composite mode, except that colors become 
muted.

Mix slider
A slider to set the percentage of the original image to be blended with the keyed image. 
100% is the fully keyed image, while 0% is the original, unkeyed image.
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Animating color key parameters in Motion
If necessary, you can animate the parameters of the Green Screen Keyer filter to account 
for changes in the background screen you’re keying. For example, if there’s uneven lighting 
in the background, and the camera pans along with a moving subject as she walks from 
a bright part to a darker part of the color background, you can animate the Green Screen 
Keyer filter parameters to adjust to this change.

There are two ways of doing this. You can use the Refine Key controls (Sample Color and 
Edges) to sample background colors on multiple frames, or you can set manual keyframes 
using the Animation pop-up menu and keyframe controls found in the Filters Inspector.

•	 Create keyframes using the Refine Key controls: When you add a Sample Color box or 
Edges control to a clip you’re keying, keyframes corresponding to the Chroma and Luma 
controls (in the Color Selection group) are placed at that frame. This is the only way to 
keyframe tolerance while in Scrub Boxes mode, although you can manually keyframe 
the softness of the Chroma and Luma controls no matter what mode you’re in by using 
the Animation menu of the Filters Inspector. For more information about keyframe 
animation, see Animate from the Inspector.

•	 Create keyframes using the Color Selection controls in Manual mode: In Manual 
mode, you can keyframe all aspects of the Chroma and Luma controls using the 
keyframe controls or Animation menu. Alternatively, you can use the Record button 
(in the transport controls under the canvas) to keyframe changes to the Chroma and 
Luma controls. After you add the first keyframe to the Chroma or Luma parameters, 
additional keyframes are added at each frame where you make modifications. For 
more information about the Color Selection parameters, see Green Screen Keyer filter 
controls and Use the Green Screen Keyer filter.

After you’ve added at least one keyframe—by using the Refine Key tools or by manually 
keyframing—adjustments to the Chroma and Luma controls on other frames will generate 
more keyframes, whether the Record button is enabled or not.

 Tip: To make an adjustment without adding keyframes, use the Jump to Sample buttons 
(in Scrub Boxes mode only), or the Next/Previous keyframe buttons to the right of the 
Chroma and Luma controls in the Filters Inspector (in Scrub Boxes or Manual modes) to 
navigate to a previously keyframed frame.

After you switch from Scrub Boxes mode to Manual mode, work in Manual mode from 
that point onward. Switching from Manual mode back to Scrub boxes mode can create 
unexpected combinations of additionally sampled and keyframed values that are difficult to 
control.

Note: Chroma and Luma control keyframes do not appear in the Keyframe Editor. They’re 
only visible using the keyframe controls on the right of each parameter row in the Filters 
Inspector.
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Use the Luma Keyer filter

Intro to the Luma Keyer filter in Motion
The Luma Keyer filter pulls a key from an image or clip based on a selected range of image 
lightness. Although typically used to key out a white background behind a foreground 
subject, the Luma Keyer filter can also be used to generate creative effects by turning 
a narrow range of image brightness transparent. The Luma Keyer filter can also isolate 
rasterized logo and text graphics from a black or white background.

Luma keys are most effective when you’re keying a subject with a range of lightness 
different from the area you’re turning transparent. For example, if you’re keying a black 
background, the foreground subject should not have deep shadows or dark areas that 
might get keyed with the background. Generally speaking, shadows and highlights in the 
image usually make this a difficult filter for pulling a perfect key.

You apply a Luma Keyer filter like any other filter in Motion—from the Library or the Filters 
pop-up menu in the toolbar. For more information about applying filters, see Apply or 
remove filters.

For a description of the Luma Keyer filter parameters, see Luma Keyer filter controls.
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Luma Keyer filter controls in Motion
After you apply the Luma Keyer filter to a video or image layer in your project, you can 
refine the keying parameters in the Filters Inspector, which contains the following controls:

Basic controls
•	 Luma: A grayscale gradient control with handles to adjust tolerance and softness in the 

matte. When you first apply the Luma Keyer filter to an image layer in Motion, the Luma 
control displays two handles: a Tolerance handle in the upper right, and a Softness 
handle in the lower left. Dragging the top handle to the left reveals a second tolerance 
handle. Together, these handles define the range of image lightness used to set the 
core transparency of the resulting matte. The range of lightness turned transparent 
is indicated by a checkerboard pattern behind the gradient. Two handles under the 
gradient define the softness, or edge transparency, of the key. (The second softness 
handle may not be visible until you drag the two tolerance handles left.) Dragging either 
of the lower softness handles farther out and away from the upper tolerance handles 
results in a key with softer edges. You can also drag the slope in the graph to adjust the 
softness handles.

•	 Invert: A checkbox that, when selected, inverts which area is transparent and which is 
opaque.

•	 Luma Rolloff: A slider to adjust the linearity of the falloff between the Luma control’s 
tolerance and softness handles. Modifying this parameter changes the softness of 
the matte around the edges in regions that are affected most by the Luma control. 
Decreasing the Luma Rolloff value makes the slope between the two handles of the 
Luma control more linear, which visibly increases edge softness. Increasing this value 
makes the slope between the handles of the Luma control steeper, sharpening the 
edges of the matte and making them more abrupt.

•	 View: A group of buttons to switch among three keying preview modes in the canvas, 
useful for refining your key:

•	 Composite: The leftmost button, when selected, displays the final composited image 
in the canvas, with the keyed foreground subject isolated against a transparent 
background, which lets layers underneath show through.

•	 Matte: The center button, when selected, displays the grayscale matte, or alpha 
channel, generated by the keying operation. Areas in the matte that appear white are 
visible in the final composite; areas that appear black are transparent; and areas with 
shades of gray are semitransparent (lighter grays being more solid, and darker grays 
being more translucent). Viewing the alpha channel makes it easier to spot unwanted 
holes in the key, or areas of the key that aren’t transparent enough.

•	 Original: The rightmost button, when selected, displays the original, unkeyed image 
in the canvas.
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Matte Tools controls
Click the disclosure triangle in the Matte Tools row to reveal controls for post-processing 
the transparency matte generated by the previous sets of parameters. These parameters 
do not alter the range of values sampled to create the keyed matte. Instead, they alter the 
matte generated by the Luma and Luma Rolloff controls, letting you shrink, expand, soften, 
or invert the matte to achieve a better composite.

•	 Fill Holes: A slider to adjust solidity in regions of marginal transparency throughout 
a key. This parameter is useful when you’re satisfied with the edges of your keyed 
matte but have unwanted holes in the interior of the foreground subject that you can’t 
eliminate using the Strength parameter without ruining edges. Higher slider values fill 
more holes in the solid areas of the keyed subject.

•	 Edge Distance: A slider to adjust how close to the edge of your keyed subject the 
effect of the Fill Holes parameter gets. Reducing this parameter brings the solid, 
nontransparent area of the matte closer to the edge of the subject being keyed, 
sacrificing translucence at the edges in favor of filling unwanted holes at the edge of 
the keyed subject, or retrieving areas of semitransparent detail, such as hair, smoke, 
or reflections. Raising this parameter pushes the filled area of the matte farther to the 
interior of the subject, away from the edges, adding translucence to regions of the 
image that aren’t being keyed aggressively enough. Raising this parameter too much 
can introduce regions of unwanted translucence in parts of the subject that should be 
solid.

•	 Levels: A grayscale gradient control to alter the contrast of the keyed matte. Drag this 
control’s three handles that set the black point, white point, and bias (distribution of 
gray values between the black point and white point). Adjusting the contrast of a matte 
can be useful for manipulating translucent areas of the key to make them more solid (by 
lowering the white point) or more translucent (by raising the black point). Dragging the 
Bias handle right erodes translucent regions of the key, while dragging the Bias handle 
left makes translucent regions of the key more solid.

•	 Black, White, Bias: Click the disclosure triangle in the Levels row to reveal sliders for 
the Black, White, and Bias parameters. These sliders, which mirror the settings of the 
Levels handles described above, allow you to keyframe and apply Parameter behaviors 
to the three Levels parameters (via the Add Keyframe button to the right of each slider). 
Keyframing the Black, White, and Bias parameters may yield a better key, one that 
adapts to changing blue screen or green screen conditions. 

•	 Shrink/Expand: A slider to manipulate the contrast of the matte to affect matte 
translucence and matte size simultaneously. Drag the slider left to make translucent 
regions more translucent while simultaneously shrinking the matte. Drag the slider right 
to make translucent regions more solid while simultaneously expanding the matte. 

•	 Soften: A slider to blur the keyed matte, feathering the edges by a uniform amount.

•	 Erode: A slider that you can drag to the right to increase edge transparency from the 
outer edge of the matte progressively farther into the interior of the keyed matte.
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Light Wrap controls
Click the disclosure triangle in the Light Wrap row to reveal controls for blending color and 
lightness values from the background layer of your composite with the keyed foreground 
layer. Using these controls, you can simulate the interaction of environmental lighting 
with the keyed subject, making it appear as if background light wraps around the edges 
of a subject. In Motion, the Light Wrap operation blends light and dark values from the 
background with the edges of the keyed foreground subject, and can be used to create 
color-mixing effects around the edges of the solid part of a key to better marry the 
background and foreground layers of your keyed composite.

Light Wrap is the last operation in the image-processing pipeline. In other words, the light-
wrap effect is added after every other image operation is processed, including filters, lights 
and shading, and other composited effects. As a result, Light Wrap accounts for any visual 
effect that might alter the look of the object it is applied to, yielding the most desirable 
result.

A separate Light Wrap option appears in the Blend Mode pop-up menu of the Properties 
Inspector for a selected layer or group in Motion. The Light Wrap blend mode in the 
Properties Inspector for a layer is ignored when you add a Luma Keyer filter to that layer 
and set the Light Wrap Amount parameter to a value greater than 0. (The Light Wrap 
parameters of the Luma Keyer Keyer filter take precedence.) However, if you set the 
Amount parameter of the Light Wrap group to 0, the Light Wrap blend mode becomes 
active again. Further, the Light Wrap blend mode in the Properties Inspector for a group 
overrides the Light Wrap parameters of any Luma Keyer filters in that group.

•	 Amount: A slider to control the light-wrap effect, setting how far into the foreground the 
light wrap extends.

•	 Intensity: A slider to adjust gamma levels to lighten or darken the interaction of wrapped 
edge values with the keyed foreground subject.

•	 Opacity: A slider to fade the light-wrap effect up or down.

•	 Mode: A this pop-up menu to choose a compositing method to blend the sampled 
background values with the edges of the keyed subject. There are five options:

•	 Normal: Evenly blends light and dark values from the background layer with the 
edges of the keyed foreground layer.

•	 Lighten: Compares overlapping pixels from the foreground and background layers, 
then preserves the lighter of the two. Good for creating a selective light-wrap effect.

•	 Screen: Superimposes lighter portions of the background layer over wrapped areas 
of the keyed foreground layer. Good for creating an aggressive light-wrap effect.

•	 Overlay: Combines the background layer with the wrapped areas of the keyed 
foreground layer so overlapping dark portions become darker, light portions become 
lighter, and colors become intensified.

•	 Hard Light: Acts like the Overlay composite mode, except that colors become muted.
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Additional controls
•	 Preserve RGB: A checkbox that, when selected, preserves smooth graphics and text. 

Some images may be rendered as if they have an alpha channel, even though they 
don’t. A good example is white text on a black background. Rasterized text in most 
images is anti-aliased properly, and further modification to the RGB channels by the 
Luma Keyer can degrade the quality of the edges. Selecting the Preserve RGB checkbox 
adds transparency to the image without modifying the RGB channels, leaving smoothly 
aliased text or graphics visually intact.

•	 Mix: A slider to set the percentage of the original image to be blended with the keyed 
image. 100% is the fully keyed image, while 0% is the original, unkeyed image.

Correct or refine an existing matte

Intro to refining mattes in Motion
Keying is rarely a one-step process. Although adding a keying filter is the first step, 
additional work is often necessary to create a good key that retains detail around the edge 
of your subject. You can use the mask tools and alpha channel filters to turn a decent key 
into a great one:

•	 Create a garbage mask to crop unwanted background objects in the shot that can’t be 
keyed, such as the edge of a blue screen stage, lighting rigs, or tape that appears in the 
background. 

•	 Create a holdout mask to restore part of a foreground image that has been removed by 
the key.

•	 Add a Matte Magic filter to refine matte edges. 

•	 Add a Spill Suppression filter to manually neutralize a key color. 

•	 Use multiple keys to isolate difficult-to-key regions in your foreground subject.

Important: When using masks with keying, apply any masks after applying the keyer filter. 
Additionally, be sure to apply the masks to the same image layer that you applied the keyer 
filter to.
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Crop background with a garbage mask in Motion
After you apply a key, you may need to crop unwanted background elements that can’t be 
keyed, such as the edge of a blue screen stage, lighting rigs, or tape that appears in the 
background. Using the Mask tool, you can create a garbage mask that removes unwanted 
elements. 

You can also use a garbage mask to conceal parts of the background too difficult to key 
without the loss of foreground detail.

Create a garbage mask
•	 In Motion, select a keyed layer and use a mask tool to draw a mask around the 

foreground subject.

Note: If the subject is moving, the garbage mask must be animated.

By default, the Mask Blend Mode is set to Add, which crops everything outside the 
mask, while leaving the transparent areas in the mask alone. To crop out areas within 
masks, as shown in the following image, choose Subtract from the Mask Blend Mode 
pop-up menu.

For more information about creating masks, see Intro to masks and transparency.
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Restore foreground with a holdout mask in Motion
Sometimes, while pulling a key, you lose part of the image you’re trying to keep. This can 
happen when the color of the subject’s clothing is too close to the color of the background 
being keyed out, or when you need to use keying values that are too aggressive. In this 
example, small parts of the bird’s head and wings are getting removed with the key, rather 
than just the blue sky. If left uncorrected, the background image will show through the bird 
in these areas.

In these cases, you can duplicate the original layer, mask the part of the subject that’s 
being incorrectly keyed, and composite it over the keyed version to fill it back in.

Note: The Spill Suppressor filter can modify the color of the foreground subject as well. If 
you’re using the Spill Suppressor filter on the keyed layer, you may have to apply the same 
filter to the holdout mask layer to make sure the color matches. For more information on 
the Spill Suppressor filter, see Spill Suppression filter.

Create a holdout mask
1.	 In Motion, apply a keyer filter to the foreground subject.

2.	 In the Layers list, Control-click the image layer you applied a keyer filter to, then choose 
Duplicate from the shortcut menu.

A duplicate image layer with a duplicate keyer filter appears in the Layers list, above the 
original image layer and its keyer filter.

3.	 In the newly duplicated layer, delete the keying filter.

If you’ve used a Spill Suppressor filter, don’t delete it, because it’s probably changing 
the color of the subject.

4.	 In the duplicated image layer, use a mask tool to draw a mask over the area of the 
foreground that’s incorrectly keyed.

Make sure that the mask is entirely within the subject being keyed.

Note: If the subject is moving, the holdout mask must be animated.

5.	 If necessary, feather the edge of the mask you’ve just created, to ensure that it blends 
in with the image you initially keyed.
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In the following image, a clean key is created within the mask by removing the “dirt” left 
by the original key.

6.	 As an optional step, you can nest the originally keyed layer and the holdout mask you 
just created inside a dedicated group so you can manipulate the entire subject as a 
single object.

Matte Magic filter in Motion
The Matte Magic filter lets you manipulate the edges of a matte by shrinking, feathering, 
and eroding them to improve difficult keys. The Green Screen Keyer and Luma Keyer 
filters have much of the same functionality. Matte Magic is a refinement filter to let you 
manipulate mattes you create via other means. After you apply a Matte Magic filter, you 
can adjust its controls in the Filters Inspector:

•	 Shrink: A slider to manipulate the contrast of the matte in a way that renders translucent 
regions of the keyed matte more translucent while shrinking the matte.

•	 Feather: A slider to blur the keyed matte, softening the edges by a uniform amount.

•	 Erode: A slider that, when dragged to the right, increases transparency from the edge 
of the solid portion of the key inward.

•	 Levels: A grayscale gradient control to alter the contrast of any matte or alpha channel. 
Drag the three handles that set the black point, white point, and bias (distribution of 
gray values between the black point and white point). Adjusting the contrast of a matte 
can be useful for manipulating translucent areas of the key to make them more solid (by 
lowering the white point) or more translucent (by raising the black point). Dragging the 
Bias handle right erodes translucent regions of the key, while dragging the Bias handle 
left makes translucent regions of the key more solid.

•	 Black, White, Bias: Click the disclosure triangle in the Levels row to reveal sliders for 
the Black, White, and Bias parameters. These sliders, which mirror the settings of the 
Levels handles described above, allow you to keyframe the three Levels parameters 
(via the Add Keyframe button to the right of each slider). Keyframing the Black, White, 
and Bias parameters may yield a better key, one that adapts to changing blue screen or 
green screen conditions.

•	 Mix: A slider to set the percentage of the original image to be blended with the filtered 
image. 100% is the filtered image, while 0% is the original, unfiltered image.
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Spill Suppression filter in Motion
When you key an image that was shot against a blue screen or green screen, some color 
will have reflected from the screen to illuminate the edges, or even the interior, of the 
foreground subject. This unwanted coloration of the subject is called spill, and can be 
difficult to eliminate from the foreground subject you’re trying to preserve.

Unlike the spill suppression controls found in the Green Screen Keyer filter, which 
automatically neutralize the color being keyed, the Spill Suppression filter lets you deal 
with this problem by manually choosing the color to be neutralized. After you apply a Spill 
Suppression filter, you can adjust its controls in the Filters Inspector:

•	 Color: A color control to sample the color to suppress. Click the color well and choose a 
hue from the Colors window, or use the eyedropper to sample a color in the canvas.

•	 Level: A slider to adjust the amount of spill removal applied to the keyed image.

 Tip: Green screen clips typically benefit from a lower spill-level setting than blue 
screen clips. Good starting points to try are 46% for green and 73% for blue, although 
you’ll need to customize these values for your composites.

•	 Spill Contrast: A grayscale gradient control to adjust the contrast of the color being 
suppressed, using Black point and White point handles (and corresponding sliders). 
Modifying spill contrast can reduce the gray fringing surrounding a foreground subject. 
The Black point handle (on the left side of the control) lightens edge fringing that’s too 
dark. The White point handle (on the right side of the control) darkens edge fringing 
that is too light. Depending on how much spill is neutralized by the Spill Level slider, 
these controls may have a greater or lesser effect on the subject.

•	 Black, White: Click the disclosure triangle in the Spill Contrast row to reveal sliders 
for the Black and White point parameters. These sliders, which mirror the settings of 
the Spill Contrast handles described above, allow you to keyframe the Black point and 
White point parameters (via the Add Keyframe button to the right of each slider).

•	 Tint: A slider to restore the natural color of the keyed foreground subject. Because Spill 
Suppression controls eliminate blue or green spill by desaturating subtle blue or green 
fringing and reflection on the subject, the Tint slider lets you add hues to restore the 
natural color of the subject. Overdoing this parameter results in over-tinting the subject 
with the complementary color of the hue being suppressed—magenta if green, and 
orange if blue.

•	 Saturation: A slider to alter the range of hues introduced by the Tint slider (when the 
Tint slider is used at moderate levels).

 Tip: The best order in which to use these controls is to adjust Tint before you adjust 
Saturation.

•	 Mix: A slider to set the percentage of the original image to be blended with the filtered 
image. 100% is the filtered image, while 0% is the original, unfiltered image.
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Apply multiple keys in Motion
In some instances, it may be difficult to key an entire subject with a single keying filter 
while retaining fine details. For example, uneven lighting or background color might mean 
that the best settings to key a subject’s hair may not work elsewhere. In such cases, you 
can use masks to isolate different parts of a subject, and then apply different keying 
settings to each area.

Segment a subject into separate keying zones
1.	 In the Layers list in Motion, create a new group, then drag the image layer you’re keying 

into that group.

2.	 In the Layers list, Control-click the image layer, then choose Duplicate from the shortcut 
menu.

Create a duplicate for each part of the image that you want key separately.

3.	 Use a mask tool to mask each part of the subject in the duplicate layers.

Make sure the masks overlap, so there are no gaps in the foreground.

Note: If the foreground subject is moving, you may need to animate the overlapping 
masks.

4.	 Apply the relevant keying filter to the isolated parts of the subject, then adjust each 
filter’s settings.

Eventually, you may find you can achieve an optimal key for each part of the subject. 
Furthermore, with all duplicates nested in a single group, you can continue to 
manipulate the subject as a single object.
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Work with 3D objects

Intro to 3D objects in Motion
Motion lets you add 3D models to your projects. 3D models simulate natural lighting, 
shading, and texture effects. You can choose 3D models from a collection of ready-made 
3D objects in the Motion Library or you can import 3D models in the USDZ file format 
created with 3D software or 3D scanning. Motion supports both individual 3D objects and 
groups of 3D objects called scenes.

Attributes specific to 3D objects, such as inherent animation, vertices, edges, faces, or 
textures, cannot be edited in Motion. However, when you adjust the timing controls of 
an animated 3D object, you can retime or stop its animation. You can also correct a 3D 
object’s inherent orientation or size.

You can add 3D objects to both 2D and 3D Motion projects. Once added to a project, 
a 3D object works like any other layer in Motion: You can animate it using behaviors or 
keyframes, apply filters to it, use it as a particle or replicator source, and so on. In a 
2D project, you can animate a 3D object along the X, Y, and Z axes using behaviors or 
keyframes. In a 3D project, you can also animate the camera around the 3D object or add 
lights that interact with the object.
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Add a 3D object in Motion
There are two ways to add a 3D object to a Motion project:

•	 Choose a preset from the 3D Objects category of the Library.

•	 Import your own custom 3D object (in the USDZ file format).

Add a premade 3D object from the Library
1.	 In the Library in Motion, select the 3D Objects category, then select a subcategory, 

such as Education, Nature, or Sports.

2.	 In the Library stack under the categories and subcategories, select a 3D object.

3.	 Do one of the following:

•	 Click Apply in the preview area to add the 3D object to the canvas.

Note: If Create Layers At is set to “Start of project” in the Project pane of Motion 
Settings, the 3D object is added at the first frame. See If it’s your first import.

•	 Drag the 3D object from the Library stack into the canvas at the position where you 
want it to appear.

•	 Drag the 3D object from the Library stack to a group in the Layers list or Timeline 
layers list.
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•	 Drag the 3D object to the track area of the Timeline or mini-Timeline. When you 
reach the frame where you want the new 3D object to start, release the mouse 
button.

The 3D object appears in the canvas, composited above objects that are below it in 
the Layers list. Depending upon the 3D object, the anchor point may not be located 
in the center of the layer. Because all transformations occur around each object’s 
own anchor point, you may want to reposition the anchor point.

Import a USDZ 3D object
You can import your own 3D objects or third-party 3D objects into your Motion project.

Important: Motion only supports 3D objects in the USDZ file format. Additionally, if you 
import 3D objects from sources other than the Motion Library (even in the USDZ file 
format), you may see unexpected results. Objects that appear problematic in Motion also 
appear incorrect when viewed in the macOS Finder or in the Preview app.

1.	 In Motion, do any of the following:

•	 Choose File > Import (or press Command-I).

•	 In the toolbar, click the Import button.

•	 Control-click an empty area of the Layers list or canvas, then choose Import from 
the shortcut menu.

2.	 In the dialog that appears, navigate to and select one or more USDZ 3D object files.

3.	 Click Import.

The 3D object appears in the canvas, composited above objects that are below it in the 
Layers list. Depending upon the 3D object, the anchor point may not be located in the 
center of the layer. Because all transformations occur around each object’s own anchor 
point, you may want to reposition the anchor point.

 Tip: If an imported 3D object appears in the Layers list but is not visible in the 
canvas, it may be positioned beyond edge the canvas. Try adjusting the size of the 3D 
object or zooming out of the canvas to see the object.

If you add a single USDZ file that contains multiple objects, you cannot modify the 
individual objects in the scene. To control the individual 3D objects, you must import each 
object as a separate file so it becomes its own editable layer in Motion.

For information on converting 3D objects created in other applications or downloaded from 
the internet to the USDZ format, see Working with imported 3D objects.
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Move and rotate a 3D object in Motion
3D objects have multiple spatial properties, including faces (flat or curved surfaces on a 
3D shape), edges (edges where two faces meet), and vertices (points or corners where 
edges meet). When you first add a 3D object to your project, the face and edges you see 
depend on the orientation of the object as it was saved in the 3D application.

You can move or rotate a 3D object by dragging in the canvas or HUD.
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Move or rotate a 3D object using onscreen handles
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D object.

2.	 In the canvas toolbar, click the 3D Transform tool.

3D transform controls appear on the selected 3D object in the canvas.

3.	 To change the position of the object, do any of the following:

•	 Move the 3D object horizontally along its X axis: Drag the red arrow.

•	 Move the 3D object vertically along its Y axis: Drag the green arrow.

•	 Move the 3D object forward or backward along its Z axis: Drag the blue arrow.

If you want to move the 3D object only along the X and Y axes (or if you want to scale 
the object), you can use the Transform tool in the canvas toolbar.

4.	 To rotate the object, do any of the following:

•	 Rotate the 3D object around its X axis: Move the pointer over the rotation handles 
until a red rotation ring appears, then drag the red ring.

•	 Rotate the 3D object around its Y axis: Move the pointer over the rotation handles 
until a green rotation ring appears, then drag the green ring.
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•	 Rotate the 3D object around its Z axis: Move the pointer over the rotation handles 
until a blue rotation ring appears, then drag the blue ring.

Move or rotate a 3D object using HUD controls
1.	 In the Layers list, Timeline, or canvas in Motion, select a 3D object.

2.	 In the canvas toolbar, click the 3D Transform tool.

3.	 Click the HUD button in the toolbar or press F7 to open the HUD (if it’s not already 
open).

4.	 In the HUD, drag in the Move or Rotate squares.

Note: You can also adjust the 3D object’s opacity and blend mode in the HUD.



1123Motion User Guide

Reposition a 3D object’s anchor point in Motion
When you add a 3D object to a Motion project, its anchor point may be located at the 
object’s center, bottom, or other position. Because the anchor point is the spot around 
which a layer rotates or scales, you may want to reposition the anchor point. Selecting the 
Anchor Point tool in the toolbar activates canvas controls to adjust the point.

Adjust the anchor point of a 3D object in the canvas
1.	 In Motion, select a 3D object in the Layers list or canvas.

A bounding box appears around the selected layer in the canvas.

2.	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Anchor Point.
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In the canvas, the selected layer’s anchor point appears as a round target surrounded 
with three color arrows representing the X, Y, and Z coordinate axes. If the anchor point 
is not centered, a line stretches from the center of the object to the current position of 
the anchor point.

For more information on coordinate axes, see Transform layers in 3D space.

3.	 Do one of the following:

•	 Drag the white circle to move the anchor point vertically or horizontally.

•	 Drag a color arrow to move the anchor point along the corresponding axis.

As you drag the anchor point, a line stretches from the center of the object to the 
anchor point’s current position.

Note: If the anchor point is close to the center or edges of the layer, and both snapping 
and dynamic guides are turned on, the anchor point snaps to that location. You can 
change these settings in the View menu.

4.	 Align the anchor point with the object’s center (or move the anchor point to the location 
you prefer).

5.	 Optional: To fine tune the position of the anchor point, adjust its Position parameters in 
the Properties Inspector.

For more information on layers and their anchor points, see Move a layer’s anchor point.
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Modify 3D object properties

Intro to modifying 3D objects in Motion
When you add a 3D object to a project, Motion treats the object similarly to image and 
video files. You can make the following adjustments to 3D objects in the Inspector:

•	 Modify 3D object properties including position, rotation, scale, anchor point, and blend 
mode, in the object’s Property Inspector.

•	 Modify 3D object environment lighting at the project level in the Project Properties 
Inspector.

•	 Modify an object’s unit size and orientation in the 3D Object Inspector.

Modify 3D object properties in Motion
After you add a 3D object to a Motion project, you can adjust the object’s lighting, blend 
mode, timing, and other properties.

Adjust 3D object properties in the Inspector
1.	 In Motion, select a 3D object in the Layers list, Timeline, or canvas.

2.	 In the Inspector, click Properties.
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3.	 Adjust the Transform, Blending, Lighting, Media, or Timing controls.

Note: The Lighting parameter is not available if the 3D object is contained within a 2D 
group.

The Lighting section of the Properties Inspector controls how layers react to lights that 
you add to a Motion project (Ambient, Directional, Point, or Spot lights). To change the 
intensity of light reflected on the surface of 3D objects, see the following task.

Several properties that are available to other layers, such as drop shadows, reflections, 
or four corner controls, are not available for 3D objects. If the 3D objects are contained 
in a 2D group, these parameters are available in the Group Properties Inspector.

Adjust the 3D object environment lighting in the Inspector
You can control the intensity of the 3D object environment—the amount of light reflected 
in the surface of all objects in the project. This is especially useful when:

•	 You’re integrating 3D objects with reflective textures, such as water, glass, or chrome, 
into your Motion composition

•	 You want to control the 3D object environment lighting without adding lights to your 
project

•	 You want to enhance shading created on the 3D objects when you add lights to the 
project

1.	 In a Motion project that contains at least one 3D object, select the Project object in the 
Layers list.
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2.	 In the Rendering section of the Project Properties Inspector, drag the 3D Object 
Environment slider to the right to increase the environment intensity or to the left to 
decrease the environment intensity.

The 3D Object Environment parameter is a global control—all 3D objects within the 
Motion project are uniformly affected. Other layers in the project are not affected.

You can also access the 3D Object Environment parameter in the 3D Object Inspector.

For detailed information on all Properties Inspector parameters, see Properties Inspector 
controls and Project Properties Inspector controls.
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Modify a 3D object’s inherent size and orientation in Motion
Although you cannot edit 3D objects in Motion, you can use controls in the 3D Object 
Inspector to change an object’s inherent size and X, Y, or Z orientation. It’s a good practice 
to adjust these parameters before you animate a 3D object or when:

•	 You import a 3D object that’s not modeled to scale, or you need to adjust an object’s 
inherent size to better suit your project

•	 You import a 3D object saved from a 3D modeling app that doesn’t share Motion’s 3D 
coordinate system, resulting in the object being rotated in the wrong direction

•	 You import multiple 3D objects (especially from different sources) with varying scales or 
orientations

Adjust the unit size of a 3D object
3D modeling applications use real-world units of measure, such as inches, meters, feet, 
and so on. When a 3D object is added to a project, Motion normalizes the size of the object 
so that it properly scales within the pixel-based units of a Motion project.

1.	 In Motion, select a 3D object in the Layers list, Timeline, or canvas.

2.	 In the Inspector, click 3D Object (if it’s not already selected).

3.	 Choose one of the following from the Unit Size pop-up menu:

•	 Automatic: Sets the units of the 3D object to the equivalent of approximately 500 
pixels in the Motion project.

•	 Original: Sets a 1:1 translation of units to pixels. This may result in an object so small 
that it’s not visible in the project canvas, or so large it extends well beyond the edge 
of the canvas.

•	 Custom: Lets you manually set the size of the 3D object by dragging a slider (or 
entering a specific amount in a value field).

Although Custom is disabled when you select Automatic or Original, its value 
updates to display the current Unit Size value of the 3D object.



1129Motion User Guide

Changing the Unit Size value does not affect the 3D object’s Scale parameter value 
in the Property Inspector.

Note: When you resize a 3D object, there’s no computational advantage to using 
the Custom Unit Size parameter over an object’s Scale parameter in the Properties 
Inspector. Once you’ve defined values in the 3D Object Inspector, you’ll generally 
use parameters in the Properties Inspector for transforming or animating your 
objects.

Change the orientation of a 3D object
1.	 In Motion, select a 3D object in the Layers list, Timeline, or canvas.

2.	 In the Inspector, click 3D Object (if it’s not already selected).

3.	 Click the disclosure triangle to reveal separate dials for rotating around the X, Y, and Z 
axes, then adjust the dials (or enter specific amounts in the value fields).

Changing the X, Y, and Z Orientation values does not affect the 3D object’s Rotation 
parameter values in the Property Inspector.

You can also lower the amount of light reflected in the surface of all 3D objects in the 
project to create more dramatic and realistic shading, especially if you plan to add lights to 
your project. See Adjust the 3D object environment lighting in the Inspector.

Exchange a 3D object file in Motion
After you add a 3D object to a Motion project, you can exchange it with another 3D 
object while preserving any parameter changes you’ve made, including animation. This is 
especially useful if you’re using a 3D object as the source object for a replicator, particle 
emitter, or other graphic element.

Exchange a 3D object in a layer
1.	 In Motion, do one of the following:

•	 Drag a 3D object file from the Finder onto the layer in the Layers list containing the 
original 3D object.

•	 Drag a 3D object from the Library onto the layer in the Layers list containing the 
original 3D object.

2.	 When a curved pointer appears, release the mouse button.

The original 3D object is replaced by the new 3D object.

Exchange source media in the 3D Object Media Inspector
1.	 In the Media list in Motion, select the 3D object to replace.

2.	 In the 3D Object Media Inspector, click Replace Media File.

3.	 In the dialog that appears, navigate to the 3D file that will replace the current source 
media.

Note: Only compatible 3D files will be selectable.

4.	 Click Open.

The original 3D file is replaced by the new source file in the Media list and in any layers in 
the project linked to the source file.
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3D object intersection and layer order in Motion
Use the following intersection and layer order guidelines when working with 3D objects:

•	 3D objects intersect only with other 3D objects, and do not intersect with 3D text.

•	 For 3D objects in the same group to intersect, they must be contiguous in the Layers 
list (with no other layers separating the layers containing the 3D objects).

•	 For 3D objects in different groups to intersect, the layers containing the 3D objects 
must be contiguous in the Layers list (with no other layers in either group separating the 
3D object layers).

•	 3D objects use layer order: For 3D objects to appear in front of other non-3D object 
layers in the canvas, the 3D object must be positioned above the other layers in the 
Layers list. The object’s Z position in the canvas has no effect.

See Create 3D intersection.

•	 3D objects will not intersect with each other if a 3D object or its parent group is 
rasterized. Rasterization is triggered by the application of certain filters, or by making 
blending or opacity changes. See Intro to rasterization and How rasterization affects 3D 
text and 3D objects.

Adjust 3D object timing in Motion

Intro to 3D object timing in Motion
When you add a 3D object to a project, its duration can be as long or short as necessary, 
regardless of the duration of the original source object.

Use the following guidelines when adjusting the timing of 3D objects:

•	 Like all layers in Motion, all 3D objects can be edited in the Timeline.

•	 Animated 3D objects can be retimed using the Timing controls in the Properties Inspector.

•	 When added to a project, nonanimated 3D objects assume a duration equal to the 
current duration of the project (or the custom duration set in Project Settings).

•	 When added to a project, animated 3D objects retain their original duration regardless 
of the current duration of the project. Generally, an animated 3D object’s duration will 
be shorter than your project’s duration. For example, the duration of the Robot object is 
147 frames; the duration of the Helicopter object is 159 frames.

•	 Motion’s animated 3D objects are designed to loop seamlessly. Once you add a 3D 
object, you can adjust its playback to loop, reverse, hold, or ping pong for the duration 
of the project.

•	 When added to a project, an animated 3D object’s End Condition (in the Timing controls 
in the Properties Inspector) is set to Loop.

•	 As with all clips in Motion, you can adjust the duration of an animated 3D object source 
file. For 3D objects, these controls are located in the Timing controls in the 3D Object 
Media Inspector.

•	 You can apply Retiming behaviors (behaviors that modify timing and playback, such as 
slowing down, speeding up, stuttering, and reversing clips) to animated 3D objects. The 
3D object’s inherent animation is retimed by the effect of the Retiming behavior.
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Modify 3D object timing in Motion
Just like video clips, animated 3D objects have multiple frames. When you add an animated 
3D object to your project, you can set it to loop once it reaches its last frame. Additionally, 
if you want to use only the 3D object and not its inherent animation, you can isolate a 
single frame in the object layer by adjusting its timing controls.

Loop an animated 3D object
When a looped 3D object reaches its last frame, it starts playing again from its first frame.

1.	 In Motion, select an animated 3D object in the Layers list, Timeline, or canvas.

2.	 In the Properties Inspector, move the pointer over the right side of the Timing row, then 
click Show.

3.	 In the End Condition row, click the pop-up menu, then choose Loop (if it’s not already 
selected).

4.	 Do one of the following:

•	 Enter a frame number in the Out value field to set the last frame of the layer in the 
Timeline.

•	 Enter a frame number in the Duration value field to set the total duration of the layer.

•	 In the Timeline, position the pointer over the end of the 3d object’s timebar (the 
pointer changes to a trim pointer), then drag the edge of the bar to change its 
duration.

The 3D object’s animation loops over its duration. The duration of the source file (in the 
Media list in the Project pane) is not changed.
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Select a specific frame of an animated 3D object
1.	 In a Motion project that contains at least one animated 3D object, use the playback 

controls to locate the frame of the animated 3D object you want to use, then note the 
frame number.

 Tip: Press the Right Arrow key or Left Arrow key to move the playhead to the next 
and previous frames.

2.	 In the Layers list, select the animated 3D object.

3.	 In the Properties Inspector, move the pointer over the right side of the Timing row, then 
click Show.

4.	 In both the In and Out value fields, enter the frame number (from step 1).

In the Timeline, the object is shortened to a single frame, located at the frame number 
you entered. You may need to zoom in on the Timeline to see the object’s shortened 
timebar.

5.	 To extend the duration of the freeze-frame image, drag the End Duration slider (or value 
field).

If necessary, you can move the object’s timebar to the left in the Timeline so the object 
begins at frame 1 of the project.

The 3D object layer now contains no animation and is the duration set in step 5.
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Using cameras and lights with 3D objects in 
Motion
Although the built-in environment controls in Motion simplify the process of adjusting the 
amount of light reflected in the surface of all 3D objects in a project, you can manually add 
light objects to illuminate your 3D objects in more complex or specific ways.

And in 3D projects, you can add and animate cameras to enhance the depth and scope of 
compositions.

Use the following lighting and camera guidelines when working with 3D objects:

•	 Motion’s lighting and camera systems work only on 3D groups (and the layers and 
groups nested within them). See Intro to 3D lighting and Intro to 3D cameras.

•	 3D objects are not affected by the Depth of Field parameters (in the Camera Inspector).

•	 3D objects cannot cast shadows or reflect their environment within a Motion project.

•	 3D objects cannot receive shadows cast by other layers in Motion.

•	 Shadows present in imported 3D objects or 3D scenes do not interact with other layers 
in Motion.

•	 Any lights added in the Motion project are additive to the lighting set in the imported 3D 
file. Lighting inherent to the 3D file is not editable in Motion.
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Save custom 3D objects in Motion
After you import and modify 3D object, you can save it as a preset in the 3D Objects or 
Favorites category of the Library for future use.

Save an imported 3D object to the Library
1.	 In Motion, open the Library and select the 3D Objects, Favorites, or Favorites Menu 

category.

Note: For organizational purposes, you may find it useful to create a folder of your own 
in the Favorites or Favorites Menu category.

2.	 From the Layers list or Timeline, drag the customized 3D object to save into the stack at 
the bottom of the Library.

A reference to the layer is saved as a file on your computer in the /Users/username/
Library/Application Support/Motion/Library/ folder (in the 3D Objects, Favorites, or 
Favorites Menu subfolder). Any modifications made to the 3D object, such as the 
application of filters or animation, are also saved. The 3D object itself, however, is not 
moved from its original location on your computer or connected device.

Important: If you move, delete, or rename the source 3D object file, you must reconnect 
the source file to use the 3D object in a project. For instructions on reconnecting a file, 
see the following task.

Reconnect a 3D object source file
1.	 In Motion, open the Media list (in the Project pane), then select the missing 3D object 

file.

Note: Missing source files appear with a question mark icon in the missing media 
preview thumbnail.

2.	 Open the Media Inspector, then click the Reconnect Media File button under the Linked 
Objects list.

Motion attempts to find the first missing 3D object file in the list. If the search is 
successful, a dialog appears with the file selected. If the search is unsuccessful, you 
must navigate manually to the file’s location, then select the file.

3.	 Click Open to reconnect the 3D object file.

See Reconnect offline media files.
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Guidelines for working with 3D objects in Motion
To get the best results when working with 3D objects, keep the following in mind:

•	 Only 3D files in the USDZ format are supported in Motion.

•	 A USDZ file is read-only and its inherent attributes (such as vertices, faces, and 
textures) cannot be edited in Motion. You can, however, adjust an object’s orientation or 
size in Motion.

•	 Motion’s cameras and lights interact with 3D objects, but shadows, drop shadows, and 
reflections are not available for 3D objects. Additionally, camera depth-of-field settings 
have no effect on 3D objects (but do affect other layers in a 3D project that contains 3D 
objects).

•	 If you download and import 3D objects from sources other than the Motion Library 
(even in the USDZ file format), you may see unexpected results due to issues with the 
3D file, such as missing textures. Objects that appear problematic in Motion also appear 
incorrect when viewed in the Finder or in Xcode.

For more information on using Xcode with imported 3D objects, see Working with 
imported 3D objects.

•	 When imported into a Motion project, a 3D object may be positioned beyond edge the 
canvas and may not be visible in the canvas. You may need to adjust the unit size of the 
3D object, reposition the anchor point of the 3D object, or zoom out of the canvas to 
see and reposition the 3D object.

•	 Any camera data associated with an imported 3D object (or scene) is ignored when 
added to a Motion project. You can add Motion camera objects to your 3D projects.

•	 Any audio associated with an imported USDZ file is disregarded when added to a Motion 
project.

•	 You can’t apply a mask to a 3D object, but you can apply a mask to the object’s 
parent group. When you apply a mask to the group, the group must be a 2D group or a 
flattened 3D group. See Add a mask to a 3D group.

•	 A 3D object used as a source layer confers its 3D attributes to the source layer. For 
example, if you use a 3D object as the source for a particle emitter, the 3D checkbox 
is turned on in the Emitter Inspector. To use a flattened 3D object as a 2D source for 
a particle emitter, place the 3D object into a 2D group, then use the 2D group as the 
emitter source.
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Working with imported 3D objects in Motion
If you’re feeling adventurous, you can create your own 3D objects in the USDZ format or 
convert 3D objects in other file formats to the USDZ format for import into Motion. Apple 
provides two applications to help you create or convert your own 3D objects:

•	 Reality Composer: A developer tool bundled with Xcode 11 or later that lets you make or 
customize your own USDZ 3D objects and scenes. Xcode is an integrated development 
environment (IDE) that includes a suite of software development tools. Xcode is 
available on the Mac App Store.

Note: Some USDZ files created and animated using behaviors and physics in Reality 
Composer may not play back in Motion.

See the Apple Developer support articles Creating 3D Content with Reality Composer 
and Exporting a Reality Composer Scene to USDZ.

•	 Reality Converter: A developer tool available on the Apple Developer website that lets 
you import into Motion a 3D object or scene that’s in a format other than USDZ (such as 
OBJ, GLTF, or USD).

See the Apple Developer support article Creation tools for spatial apps.

Because some USDZ objects obtained from unknown creators (objects downloaded from 
3D model websites, for example) may be problematic, you can download Python-based 
tools for generating, validating, and inspecting USDZ files. These tools also include a 
converter that creates USDZ files from other 3D file formats.

https://developer.apple.com/documentation/realitykit/creating_3d_content_with_reality_composer
https://developer.apple.com/documentation/realitykit/exporting-a-reality-composer-scene-to-usdz
https://developer.apple.com/augmented-reality/tools/
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Work with 360-degree video

Intro to 360° video in Motion
360° video (sometimes called spherical video) is footage captured by special cameras that 
point lenses in all directions to create a panoramic sphere of video.

A viewer can watch 360° video in any of several ways:

•	 Through a virtual-reality (VR) headset, a hardware device that displays video on a small 
face-mounted screen that updates dynamically to show different parts of a scene as 
the viewer turns their head. Some VR headsets can also display stereoscopic (3D) 360° 
video, enhancing the immersive experience.

•	 In a rectangular window on a smart phone, tablet, or computer; the viewer can scroll the 
window to see different parts of the scene.

•	 On a standard display, with the audience unable to control viewing angles. This viewing 
method is similar to watching conventional video, with the added benefit of giving the 
filmmaker more options for angle choices during editing.

360° video cameras capture overlapping fields of view using multiple lenses (or multiple 
cameras rigged together). Using special software, the different views are stitched 
together and typically stored in a rectangular frame called an equirectangular projection. 
Equirectangular projection squeezes the image much like the way a flat world map displays 
the entire surface of the round Earth.
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360° video can be monoscopic (2D) or stereoscopic (3D). Stereoscopic video is more 
challenging to capture and process because each field of view is divided into an additional 
left-eye image and right-eye image to create the illusion of depth.

In Motion, you can work with 360° monoscopic video in equirectangular format. In 
Final Cut Pro, you can work with 360° stereoscopic video and 360° monoscopic video in 
equirectangular format.

Note: You can use Motion to create templates for use with 360° stereoscopic projects 
in Final Cut Pro. When you add a Motion template to a 360° stereoscopic project in 
Final Cut Pro, the template is applied to both the left-eye image and the right-eye image.

Motion offers tools that let you import, edit, and share equirectangular media to create 
immersive 360° viewing experiences. This chapter covers how to:

•	 Create new 360° video-ready projects and convert existing projects

•	 Add media to 360° projects

•	 View 360° video using the camera controls in the canvas

•	 View 360° video in a VR headset

•	 Reorient 360° media

•	 Integrate elements such as titles and particles into a 360° scene

•	 Create templates for use in Final Cut Pro 360° projects

•	 Apply effects to 360° video, such as blurs or glows, without creating seams or other 
artifacts

•	 Export and share 360° projects to a variety of video and social media websites, such as 
YouTube 360 and Vimeo 360

•	 Use the Tiny Planet filter to convert 360° footage into a stereographic projection, 
creating a miniature planet effect.

https://support.apple.com/guide/final-cut-pro/welcome/mac
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About 360° projects in Motion
When you create a new 360° project, Motion places an object called a 360° environment in 
the Layers list. Like a group, a 360° environment is an enclosing object that contains other 
objects. However, a 360° environment has special requirements:

•	 Equirectangular media must reside in a 360° environment; otherwise, the spherical 
projection will not render correctly.

•	 Only image-based media and filters should reside in a 360° environment. Other objects 
such as text, particle systems, and shapes must be placed inside a standard group in 
order to project properly in 360° equirectangular space.

A 360° project differs from a normal Motion project in other ways as well:

•	 The Projection pop-up menu in the Project Properties Inspector is set to 
360° Monoscopic.

The following image shows the Checkerboard generator in a 360° Motion project. 
Because the project is set to 360° Monoscopic projection (and the generator resides in 
the 360° environment), the checkerboard image is “projected” spherically in the canvas.
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With the Camera pop-up menu in the canvas set to 360° Look Around, you can drag the 
Orbit control to “look around” inside the 360° projection.

Note: When you drag the Orbit control in a non-360° project (with Projection set to 
Normal), the checkerboard image appears flat in the canvas.

•	 The Layers list includes a single 360° environment to contain 360° media, images, and 
filters (but not objects such as shapes, text, or replicators).

•	 The Layers list contains a single 3D group to which you can add objects such as 
shapes, text, replicators, and so on.

•	 You can add additional 3D groups.

•	 Root-level groups must be 3D groups (you can, however, nest 2D groups within 3D 
groups).

•	 No onscreen controls (such as transform handles or filter controls) are available for 
objects in 360° environments. In 360° projects, onscreen controls are available only for 
objects in groups.

Note: Because there are no onscreen controls for objects in a 360° environment, 
drawing tools in the canvas toolbar are not available.
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•	 The canvas is automatically set to side-by-side viewports, and the zoom level is set 
to Fit. 360° Look Around is the selected camera view in the left viewport, and 360° 
Overview is the selected camera view in the right viewport.

•	 The project contains a single Viewpoint camera. (A 360° project must contain at least 
one camera.)

•	 When you add an additional camera to the project, the Camera Type pop-up menu in 
the Camera Inspector is set to Viewpoint.

•	 The Depth of Field option is not available in the Render menu in the canvas.

•	 Export is based on what appears in the current 360° Overview camera view.

•	 360° projects use progressive frames and square pixels.

•	 360° metadata is not supported in all export options. For example, 360° metadata is not 
supported by the JPEG image format.

•	 360° video is navigable only on specific websites, such as Vimeo 360, or by using a VR 
headset.

Create 360° projects in Motion
To work with equirectangular footage in Motion, create a new 360° project or convert a 
normal project to a 360° project.

Create a 360° video-ready project
1.	 Open Motion, then choose File > New from Project Browser (or press Option-

Command-N).

2.	 In the Project Browser, click a project icon (such as Motion Project or Final Cut Effect).

3.	 In the right column, click the Preset pop-up menu, then do one of the following:

•	 Choose a 360° Video option.
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•	 Choose Custom, click the Projection pop-up menu and choose 360° Monoscopic, 
then manually set the resolution, frame rate, and duration.

Use the frame size that matches the resolution of your 360° source footage, or of the 
output you intend to share.

4.	 Click Open.

A new, untitled 360° Motion project is created containing a 3D group, a Viewpoint 
camera, and a 360° environment. The canvas viewport layout is set is to two-up 
split view. The left viewport, set to 360° Look Around, lets you observe the scene 
as if looking through a VR headset (but does not alter the camera position). The 
right viewport, set to 360° Overview, displays the full spherical video as a squished 
equirectangular image (like a flat world map).

In the Project Properties Inspector, Projection is set to 360° Monoscopic.

For information on the differences between camera types, see Cameras and views.
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Create a project prepopulated with specific 360° media files
1.	 In Motion, do one of the following:

•	 Choose File > Import As > Project (or press Shift-Command-I).

•	 Choose File > New from Project Browser, then click Import as Project.

2.	 In the dialog that appears, navigate to and select one or more 360° media files.

3.	 Click Show Options.

Format settings appear at the bottom of the dialog. Fixed settings inherent to the 
selected files remain dimmed, but will propagate to the new project. For example, 
because 360° movie files have an inherent frame rate, aspect ratio, and field order, 
those settings are dimmed in the dialog.
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4.	 If it’s not already selected, select Import as 360°.

Note: If the media contains the correct 360° metadata, the Import as 360° checkbox is 
automatically selected.

5.	 Click Import as Project.

A new 360° project populated with the 360° media you selected opens.

Convert a normal project to a 360° project
You can convert a normal project to a 360° project by making a few adjustments.

1.	 In the Layers list in Motion, click the Project object.

2.	 In the Properties Inspector, click the Projection pop-up menu, then choose 360° 
Monoscopic.

Any existing root-level 2D groups in your project are converted to 3D groups. (If the 
project includes 2D groups nested within 3D groups, the 2D groups remain unchanged.)
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3.	 Click Add Object in the toolbar, then choose 360° Environment.

A new 360° environment is added to the Layers list.

4.	 In the Layers list, move the 360° environment to the bottom of the list.

Although not required, this step sets up the project to add and composite elements 
above the 360° environment.

5.	 Do one of the following:

•	 If your project does not contain a camera, click Add Object, then choose Camera.

A new Viewpoint camera is added to your project.

•	 If your project contains a camera, select the camera in the Layers list, then in the 
Camera Inspector, click the Camera Type pop-up menu and choose Viewpoint.

6.	 In the canvas, click the gray box in the top-right corner of the canvas, then choose the 
second arrangement in the list (two-up, split view).

The canvas is split into two viewports.

7.	 In the left viewport, click the Camera pop-up menu and choose 360° Look Around.

Your project now correctly projects the equirectangular footage. The 360° Look Around 
view uses the field of view of the active camera.

8.	 In the right viewport, click the Camera pop-up menu and choose 360° Overview.

The canvas displays the entire 360° scene as a flat, equirectangular image alongside 
the spherical viewer. This image represents the final output of your project.
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When you convert a normal project to a 360° project, normal footage already in the project 
is not projected in 360°. Other objects in the project also need to be adjusted. For example, 
if the project contains a generator that you want projected onto the 360° sphere, you must 
move the generator inside the 360° environment.

Important: Most generators do not project seamlessly or evenly in a 360° environment. 
See 360°-aware filters and generators.

Add 360° video to a project in Motion
You import 360° video the same way you import any other media in Motion. However, there 
are a few special requirements to consider:

•	 Before you import, make sure the footage has been properly formatted (using third-
party stitching software) as a monoscopic equirectangular projection.

•	 Make sure you import the footage into a 360° video-ready Motion project.

•	 After import, make sure you place the footage in a special kind of container called a 
360° environment. If you add 360° video to a standard group, Motion (and VR headsets) 
will display the video incorrectly.

Note: If you select the Import as 360° checkbox in the import dialog, 360° footage is 
automatically placed in a 360° environment. 

Import 360° media files using the Import command or the Import button
1.	 In a 360° project in Motion, do any of the following:

•	 Choose File > Import.

•	 In the toolbar, click Import.

•	 Control-click an empty area of the Layers list or canvas (in the black area outside of 
the project), then choose Import from the shortcut menu.

2.	 In the dialog that appears, navigate to and select one or more 360° media files.

When you select 360° media, Motion enables the Import as 360° checkbox in the 
import dialog. (If you select both 360° and non-360° media and leave the Import as 
360° checkbox selected, all media will be placed in the 360° environment.)
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3.	 Do any of the following:

•	 Click Import.

If there are multiple 360° environments in the project and a 360° environment is 
not active when you click Import, the 360° media is added to the topmost 360° 
environment.

•	 Drag the file or files to the canvas.

•	 Drag the file or files into a 360° environment in the Layers list or into the empty 
lower area of the Layers list.

If added to a 360° environment, the imported files appear as new layers in that 
container, placed above existing layers in the environment. If added to the empty 
area, the imported files are added to the topmost 360° environment.

•	 Drag the file or files into the Timeline.

Note: For more information on adding objects to the Timeline, see Intro to the 
Timeline.

If you import media that has a 2:1 aspect ratio, Motion places the media in the project’s 
360° environment (or if no 360° environment exists, in a new 360° environment).

Import 360° media files from the Finder into Motion
1.	 In the Finder, select one or more 360° media files.

2.	 With a 360° project open, do any of the following:

•	 Drag one or more files from the Finder to a location in the Motion canvas.

If standard footage and 360° media are added simultaneously, the standard footage 
is added to a new group and the 360° video is added to the existing (or active) 360° 
environment.

•	 Drag one or more files from the Finder to the 360° environment in the Layers list in 
Motion, or into the empty lower area of the Layers list.

If added to a 360° environment, the imported files appear as new layers in that 
container, placed above existing layers in the environment. If added to the empty 
area, the imported files are added to the topmost 360° environment.

If standard footage and 360° media are added simultaneously, the standard footage 
is added to a new group and the 360° video is added to the existing (or active) 360° 
environment.

•	 Drag the file or files from the Finder into the Timeline in Motion.

Note: For more information on adding objects to the Timeline, see Intro to the 
Timeline.

If you import media that has a 2:1 aspect ratio, Motion places the media in the project’s 
360° environment (or if no 360° environment exists, in a new 360° environment).
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View and navigate 360-degree projects

View 360° projects in Motion
When you create a 360° project, Motion divides the canvas into side-by-side viewports, 
with the spherical projection of your 360° footage in the left viewport and the 
equirectangular overview in the right viewport.

You view and navigate 360° video by using the Orbit control in the canvas to pan and tilt 
the camera. To display the camera controls in the canvas, make sure Show 3D Overlays in 
the View menu in the canvas has a checkmark.

View and navigate spherical video in the canvas
1.	 In Motion, ensure that the Camera pop-up menu in the left viewport is set to 360° Look 

Around.

The left viewport displays a nondistorted portion of the spherical projection.
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2.	 In the canvas, drag the Orbit control in any direction to pan and tilt the camera.

The view is rotated and other areas of the spherical projection become visible. Your 
media’s default orientation (what viewers will see in the VR headset) is not altered. (To 
alter the default orientation, see Reorient 360° media.)

You can also use the Orbit control to navigate 360° media during playback.

The spherical projection may appear sharper at the top and bottom. This is because you’re 
seeing only a portion of the 4K image at once, and the portion within your viewing angle 
may be closer to 1080p in resolution (or less). Additionally, spherical projections may 
create uneven pixel spacing.

View the equirectangular image
While the 360° Look Around camera shows you an interactive, “WYSIWYG” view of the 
360° effect, the 360° Overview camera displays the equirectangular image in its raw form 
(distorted). It’s helpful to monitor this view as you make changes to the project.

•	 In Motion, ensure that the Camera pop-up menu in the right viewport is set to 360° 
Overview.
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The right viewport displays the entire 360° scene as a flat, equirectangular image. This 
image represents what is rendered when you share your project.

Reset the view 
After you pan the 360° Look Around view using the Orbit control, you can reset the view to 
its default orientation.

•	 In the Motion canvas, do one of the following:

•	 Click the Camera pop-up menu, then choose Reset View (or press Control-R).

•	 Double-click the Orbit control.

•	 Choose View > 3D View > Reset View.

The footage returns to its default orientation.

Use the canvas rulers or grid as orientation guides
To help you keep track of the horizon line as you navigate the 360° video in 360° Look 
Around view, you can use the canvas rulers or grid as guides.

•	 In Motion, do any of the following:

•	 Choose Rulers from the View menu in the upper-left corner of the canvas.
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See Use rulers and guides.

•	 Choose Grid from the View menu in the upper-left corner of the canvas.

You can customize the grid settings in the Canvas pane of Motion Settings (press 
Command-Comma to open Settings).

Change the camera’s angle of view
When the camera is set to 360° Look Around view, you can zoom the 360° image.

1.	 In the Layers list in Motion, select the camera.

2.	 In the Camera Inspector, adjust the Angle of View slider, dragging left to zoom in, or 
dragging right to zoom out.

If you zoom out too far, you’ll see the stretched edges of the footage in the viewport. 
This is normal and expected.

3.	 To reset the camera’s angle of view, Click the Animation menu (the down arrow that 
appears on the right when you move the pointer over the Angle of View parameter), 
then choose Reset Parameter.

Changing the camera’s angle of view affects only the view within the 360° Look Around 
viewport or Active Camera viewport—it does not affect the final output of your project. 
If you’re viewing your 360° video in a VR headset, the camera Angle of View setting is 
ignored. However, if you’re mirroring the VR headset’s image in the Motion canvas, the 
Angle of View setting affects the view in the canvas.



1152Motion User Guide

View 360° video in a VR headset in Motion
You can view your 360° project using a VR headset attached to your Mac.

Important: Using a VR headset with Motion requires macOS 10.13 or later, minimum 
hardware, and the installation of a third-party app. For details, see Motion Tech Specs.

For more information about setting up a VR headset and about supported hardware, see 
Use a VR headset with Final Cut Pro and Motion.

View 360° video in an attached VR headset
If you have a VR headset connected to your Mac (and properly configured), you can use it 
to view the output of your Motion project.

1.	 Connect a VR headset to your Mac.

For setup instructions, see Use a VR headset with Final Cut Pro and Motion.

2.	 Choose Window > Output to VR Headset (or press F10).

The 360° video appears in the VR Headset display.

Note: The VR headset does not work in non-360° Motion projects.

3.	 Put the headset on, then rotate your head and look in any direction.

As you move and rotate your head to navigate the 360° video, the headset display 
updates.

Note: To play back your project in the VR headset, Mirror VR Headset must be enabled.

Mirror the VR headset’s display in the canvas
•	 In Motion, do one of the following:

•	 In the canvas, click the Camera pop-up menu, then choose Mirror VR Headset.

•	 Choose View > 3D View > Mirror VR Headset (or press Control-H).

The 360° video appears in the VR headset display and is mirrored in the 360° Look 
Around view in Motion. Whatever part of the sphere is currently displayed in the VR 
headset appears in the canvas.

https://www.apple.com/final-cut-pro/motion/specs/
https://support.apple.com/119607
https://support.apple.com/119607
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Reset the VR headset’s orientation
Because the forward orientation of the headset can change, you may want to reset the 
headset’s orientation.

Note: Resetting the headset’s orientation works only when the headset display is mirrored 
in the canvas.

•	 With the headset on, look in the direction that you consider to be the default 
orientation, then in Motion do one of the following:

•	 Choose Reset VR Headset Orientation from the camera menu in the canvas.

•	 Choose View > 3D View > Reset VR Headset Orientation (or press Control-R).

The view inside the VR headset is reoriented.

Note: Changing the orientation of the headset only temporarily changes the view—no 
permanent change to the default orientation of the media occurs.
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Integrate graphics in 360-degree projects

Intro to graphics in 360° projects in Motion
As with normal projects, you can add 2D or 3D elements to 360° projects to create 
complex scenes.

The same layering rules that govern normal projects apply to 360° projects, but there are 
some additional considerations when integrating layers with 360° projects:

•	 You can add any type of object to a 3D group in a 360° project, including 2D or 3D text, 
replicators, flat images, lights, and so on. Once added, objects are integrated correctly 
into the scene—locked in place as you pan the 360° video.

•	 You cannot add objects (such as shapes or text) to a 360° environment. However, you 
can add image-based media and filters to a 360° environment.
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•	 The tools in the canvas toolbar (such as the Text tool or the Shape tool) are not 
available while the 360° Overview viewport is active.

•	 Nonequirectangular images such as logos or standard video clips should be placed in a 
normal 3D group, where they can be positioned in 360° space as a flat element. Adding 
such images to a 360° environment stretches the image to fill the entire 360° sphere, 
causing it to look distorted.

You can convert a normal image into an equirectangular image so it can be placed 
directly in a 360° environment without distortion. See Create an equirectangular image.

•	 The Pass Through blend mode is not available for 360° environments. Pass Through 
(the default blend mode for groups) lets each layer in a group blend with all layers and 
groups that appear underneath it in the Layers list—including layers in other groups. In 
a 360° project, only layers contained in the same 360° environment will blend together.
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In certain situations, images in a 360° Look Around viewport may not represent your 
project’s final output. When in doubt, choose 360° Overview from the Camera pop-up 
menu in the canvas to display your project.

•	 You can’t add a mask directly to 360° footage in a 360° environment. You can, however, 
use a clone layer to mask 360° footage. (Adding a clone layer is only recommended 
when masking 360° images. Cloning other objects may yield unexpected results.) 

•	 Because you’re working on the “inside” of a sphere, you must be aware of what’s above, 
behind, and below you in the project. Z space plays a much bigger role than in a normal 
project—you’re always working in 3D in a 360° project. It may be helpful to think of the 
center of the sphere as both the viewer’s head and as the main camera position.

•	 To correctly place elements into the scene, you may need to use camera views and 
canvas layouts that you wouldn’t normally use (such as top or bottom camera views or 
more than two viewports).

•	 Objects added to a 360° project cannot follow the movement of a VR headset. If you 
add an object to your 360° project, it’s integrated into the scene—locked in place 
on the inner surface of the sphere as you pan the 360° video. As in normal projects, 
however, you can animate objects (using keyframes or behaviors).

•	 Although you can add any generator to a 360° environment, most generators do not 
project correctly and will appear with visible seams or other unwanted distortions. 
Generators may also appear at very low resolution. To avoid these issues, use 
360°-compatible generators.

•	 When working with 3D text, keep in mind that if you adjust the 3D text’s Lighting 
parameters to match the current view, the light will continue to come from the same 
direction when you rotate the camera or change the scene.

For more information about working in 3D, see Intro to 3D compositing. For more 
information on working with multiple viewports and different camera views, see Cameras 
and views.
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Use graphics in 360° projects in Motion
You can integrate graphics and other elements into a 360° project. Elements are added to 
360° projects in the same way as in normal projects.

Integrate an image into a 360° project
•	 In Motion, add your text, shape, particle emitter, or other object to a 3D Group in the 

Layers list.

The object is added to the scene. As you navigate the 360° scene, the layer floats at 
the origin (where the Position parameters are X = 0, Y = 0, and Z = 0) in 3D space.

Mask 360° media
You can’t add masks directly to 360° footage in a 360° environment. However, you 
can move the 360° footage to a 3D group, mask and clone the footage, then move the 
clone layer back to the 360° environment. This lets you to draw and adjust the mask in a 
standard view rather than in a distorted, spherical view.

1.	 In the Layers list in Motion, drag the 360° media to a standard 3D group.

2.	 In the canvas toolbar, click the Mask tools pop-up menu, then choose a mask tool from 
the list.

3.	 In the 360° Look Around viewport in the canvas, draw a mask over the 360° layer.

 Tip: For a larger drawing area, you may want to change the canvas layout to a single 
viewport and change the camera view while working on your mask.

For more information on working with masks, see Intro to shapes, masks, and paint 
strokes.

4.	 Select the 360° layer with the applied mask, then choose Object > Make Clone Layer (or 
press K).
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A clone layer is created and appears in the canvas on top of the original layer. Any 
further adjustments you make to the mask will be applied to the clone layer.

See Clone a layer.

5.	 In the Layers list, deselect the checkbox of the 360° layer with the applied mask.

Make sure you don’t deselect the checkbox of the mask layer.

6.	 Drag the clone layer into the 360° environment.

As you navigate the 360° media, the mask is integrated into the scene.

Refine a mask applied to 360° media (using a clone layer)
After you’ve moved the cloned 360° layer into the 360° environment, you may need to 
make further adjustments to the mask.

•	 In the Layers list in Motion, select the mask layer, then make adjustments.

The mask adjustments propagate to the clone layer in the 360° environment.

 Tip: It may be useful to isolate the layer you’re masking. When a layer is isolated, the 
layer is set to its default orientation and all other layers are hidden. See Mask a layer in 
a 3D project.
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Create an equirectangular image
Non-360° image layers such as text or logos must be contained in a 360° environment for 
blend modes to operate correctly between layers. When you import an equirectangular 
image into a 360° project, the image is automatically added to the 360° environment.

You can create equirectangular images in Motion by importing a normal image into a 360° 
project, then exporting the image.

1.	 Create a new 360° project in Motion, then click Import.

2.	 In the dialog that appears, navigate to and select a still image, then click Import.

The image is added to the 3D group.

3.	 Make adjustments to the image, then choose Share > Save Current Frame.

The message “360° metadata is not supported by the Still Image format” appears in the 
dialog. You can disregard this message.

4.	 Click Next, enter a name and save location for the exported file, then click Save.
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The image is saved with the equirectangular projection “baked in” and with the correct 
aspect ratio (2:1).

When you import the equirectangular still image back into your 360° project, Motion 
adds it directly to the 360° environment. You can now apply blend modes to the image.

Convert 360° video into flat video
You can export a 360° equirectangular video with a single field of view for watching on 
traditional display devices.

1.	 In a normal Motion project, click Import.

2.	 In the dialog that appears, navigate to and select your 360° video, then click Import.

The video is added to a group.

3.	 Click Add Object in the toolbar, then choose 360° Environment.

A new 360° environment is added to the project.
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4.	 In the Layers list, drag the imported 360° video to the 360° environment.

5.	 To select the field of view you want to export, do one of the following:

•	 Click Add Object in the toolbar, choose Camera, then adjust the camera’s Angle 
of View in the Camera Inspector or the camera’s Transform parameters in the 
Properties Inspector.

•	 Select the 360° media in the Layers list, click Filters in the toolbar and choose 
360° > 360° Reorient, then adjust the filter’s parameters in the Filters Inspector.

Note: You can also use a combination of a camera and a Reorient filter to select the 
field of view you want to export, and to keyframe camera zooms, pans, and tilts.

For details about the 360° Reorient filter parameters, see Change the default 
orientation of 360° media.

6.	 After you’ve framed the area of the image you want to export, choose Share, select an 
export option, then follow the onscreen instructions. See Intro to exporting projects.

A normal projection video with a single field of view is exported.

To export 360° video with a “tiny planet” effect, see Tiny Planet filter.

Example: Integrate particles into a 360° project
You can integrate particles, replicators, and other objects into a 360° scene. Keep in mind 
that the equirectangular projection is navigable by the viewer at all times.

This example demonstrates how to integrate a particle system into a 360° project. In this 
case, the position parameters of the project’s camera are copied to the particle emitter, 
and then the position of the particle emitter is moved so that it sits on top of the camera. 
Snow appears to fall all around the viewer.

Note: This advanced example assumes a familiarity with 3D space and cameras, particle 
emitters, and simulation behaviors. Use these steps as a guideline; make additional 
modifications to achieve the effect you want.

1.	 In the Layers list in Motion, select the 3D group.

2.	 In the Library, select the Particle Emitters category, select a subcategory, then select a 
particle preset.

This example uses the Snow Flurry emitter in the Nature subcategory.
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3.	 In the Library preview area, click Apply.

The particle emitter is added to the 3D group.

4.	 In the canvas, click the gray box in the top-right corner, then choose the fourth 
arrangement in the list (two viewports above, large viewport below).

The Top view of the 3D scene is displayed in the lower viewport. If necessary, drag the 
Dolly and Pan controls in the canvas to adjust the view so that the camera and particle 
emitter are both visible.

5.	 In the Layers list, select the camera, then drag the Position parameters from the 
Properties Inspector to the emitter in the Layers list.

The emitter is moved to the same position as the camera.
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6.	 In the canvas, click the Camera pop-up menu in the lower viewport, then choose a side 
view (Left or Right).

7.	 In the Layers list, select the Emitter, then do one of the following:

•	 In the canvas, drag the green arrow up to move the emitter vertically along the Y 
axis.

•	 In the Properties Inspector, increase the Y Position parameter.

8.	 In the Emitter Inspector, choose Box (or Sphere) from the Shape pop-up menu, ensure 
that the 3D checkbox is selected, then increase the value of the Size (or Radius) 
parameter.

You can experiment with various particle shapes for different snow-flurry effects.

9.	 So that the particles fall downward, set the emitter’s Emission Angle to approximately 
270°.

Note: You can also use the Gravity behavior (in the Simulations category) to control how 
the particles fall over time.

10.	To improve particle visibility, you can adjust the Life, Birth Rate, Size, or other 
parameters in the Particle Cell Inspector and the Emitter Inspector.

Because the emitter is directly above the camera (and its particles surround the 
camera), snow appears to fall all around the person viewing the scene.
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Create a tiny planet effect in Motion
You can use the Tiny Planet filter (in the Distortion filter category in the Motion Library) to 
convert 360° video into a stereographic “tiny planet” (or inverted tiny planet) projection. 

For the best results, import your 360° footage into a standard (non-360°) project or group. 
See Tiny Planet filter.

Reorient 360° media in Motion
Every 360° video is recorded with a default orientation—a field of view that the viewer sees 
when they look “straight ahead” (without turning their head in a VR headset or navigating 
a 360° viewing window). You can change the default orientation of 360° video by using the 
360° Reorient filter, or by adjusting the camera parameters.

Additionally, as you navigate your 360° video by tilting, panning, or rotating the camera, 
you may lose track of the 360° media’s horizon line. You can correct the horizon using the 
Reorient filter.

Important: Changing the default orientation of 360° media using the 360° Reorient filter or 
by adjusting the camera Transform parameters significantly affects the final output of your 
project.

Change the default orientation of 360° media
Use the 360° Reorient filter to rotate the 360° sphere along the X, Y, or Z axis to change 
the default orientation of the 360° media.

1.	 In the Layers list in Motion, select the 360° media you want to reorient.

2.	 In the toolbar, click Filters, then choose 360° > 360° Reorient.

3.	 In the Filters Inspector, adjust the reorient parameters:

•	 Tilt (X): Rotates the image along the X (horizontal) axis.

•	 Pan (Y): Rotates the image along the Y (vertical) axis.

•	 Roll (Z): Rotates the image along the Z (depth) axis.

•	 Mix: Sets the percentage of the original image to be blended with the reoriented 
image.
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Reorient 360° media using the camera
You can also direct the viewer’s focus to a particular area of the 360° footage by adjusting 
the Transform parameters of the camera. Using these controls, rather than the 360° 
Reorient filter, is handy for reorienting multiple layers of 360° video simultaneously.

1.	 In the Layers list in Motion, select the camera.

2.	 In the Properties Inspector, click the Rotation disclosure triangle to reveal the X, Y, and 
Z parameters.

3.	 To adjust the rotation of the camera, do any of the following:

•	 Adjust the X Rotation dial (or value slider) to tilt the camera up or down (around the 
X axis).

•	 Adjust the Y Rotation dial (or value slider) to pan the camera left or right (around the 
Y axis).

•	 Adjust the Z Rotation dial (or value slider) to roll the camera clockwise or 
counterclockwise (around the Z axis).

To reset the camera, click the Animation menu (the down arrow that appears on 
the right when you move the pointer over the parameter row), then choose Reset 
Parameter.

Note: For more information on working with cameras, see Intro to 3D cameras.

It’s possible to create cinematic camera moves in your 360° projects using keyframes or 
behaviors to animate the camera or the 360° Reorient filter parameters over time. However, 
this may not be appropriate given that a 360° video is fully interactive and navigable by the 
viewing audience at all times.

 Tip: The 360° Reorient filter can be used in normal (non-360°) projects to reframe an 
image.

Creating 360° templates for Final Cut Pro in Motion
Final Cut Pro ships with a handful of generator, effect, and title templates designed for use 
with 360° projects. In Motion, you can modify most of these default Final Cut Pro effects or 
create your own 360° templates from scratch.

360° templates for Final Cut Pro are created in the same way as standard templates, but 
there are a few things to keep in mind:

•	 When creating effects or generator 360° templates, it’s recommended that you use 
pixel-independent filters and 360°-compatible generators. Effects that use pixel 
transforms, such as the Kaleidoscope filter, may create seams, unwanted distortions, 
or other artifacts in your template. The Hue/Saturation filter, for example, works 
seamlessly because the filter uses no pixel transforms. A Gaussian Blur filter works 
correctly—provided its 360° Aware checkbox is selected.

See 360°-aware filters and generators.

•	 Although Motion currently supports only monoscopic 360° video, you can create 
templates in Motion that can be used with either monoscopic 360° media or 
stereoscopic 360° media in Final Cut Pro. When applied to the Final Cut Pro timeline, 
the template automatically conforms to either type of media.
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•	 If a normal, non-360° title template is applied to a 360° project in Final Cut Pro, the 
360° Transform controls are available in the Final Cut Pro Video inspector.

•	 If a 360° title template is applied to a 360° project in Final Cut Pro, the Reorient 
parameters are available in the Final Cut Pro Video inspector.

For more information on working with titles in Final Cut Pro, see the Final Cut Pro User 
Guide.

For complete instructions on creating and modifying Final Cut Pro templates, see Intro to 
Final Cut Pro templates.

360°-aware filters and generators in Motion

360°-aware filters
You can apply filters to 360° media in your project. However, because many filters 
transform pixels, seams and other artifacts may appear as you pan the 360° media. To 
avoid this, use filters that include a 360° Aware checkbox. Selecting this checkbox lets you 
apply the filter to 360° footage without creating unwanted distortions.

The following Motion filters are 360°-aware:

•	 Blur filters: Channel Blur, Gaussian Blur, Soft Focus

•	 Glow filters: Aura, Bloom, Gloom, Glow

•	 Sharpen filters: Sharpen, Unsharp Mask

These aren’t the only filters applicable to 360° footage—you can apply many other filters 
to 360° footage without causing any issues, including filters in the Color and Looks 
categories. You can also apply keying filters, but you may see unexpected results.

360°-aware generators
When added to a 360° environment, some generators may appear with seams or other 
unwanted distortions.

However, two generators are 360°-aware and won’t add artifacts to your composition:

•	 Color Solid

•	 Gradient (when the 360° Aware checkbox in the Inspector is selected)

Other generators, although they may add visible seams, can be creatively useful in 360° 
projects. In some cases, you may be able to eliminate generator seams by adjusting the 
generator’s parameters in the Inspector. For example, adjusting the Size parameter of the 
Checkerboard generator eliminates seams.

https://support.apple.com/guide/final-cut-pro/welcome/mac
https://support.apple.com/guide/final-cut-pro/welcome/mac
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Export and share 360° projects in Motion
When you complete and export your 360° project, you can publish it to a variety of video-
sharing and social-media websites including YouTube’s VR channel, Vimeo 360, and 
more. Motion includes the appropriate 360° metadata in the output media file so that it’s 
recognized and displayed appropriately by the video-sharing sites.

For information about exporting projects, see Intro to exporting projects.

Before exporting, you may want to confirm your video’s orientation and review the 
suggested video specs of the site where you plan to post your 360° videos.

Confirm your video’s orientation before you export
After you’ve navigated around a 360° project, things may appear a bit topsy-turvy in the 
canvas. Keep in mind that if you’ve changed the active camera view (by zooming in or 
panning and tilting using the Orbit control), the 360° media is exported with the same 
default orientation as when it was imported. But if you’ve reoriented the 360° media using 
the 360° Reorient filter or by rotating the camera, the project will export with the new 
orientation.

•	 To confirm the orientation of the media in your Motion project’s export, do one of the 
following:

•	 Click the Camera pop-up menu in the canvas, then choose 360° Overview.

The orientation shown when the 360° Overview camera is active is how your final 
render will appear.

•	 Click the Camera pop-up menu in the canvas, then choose Active Camera.

The view is set to the front (what the viewer sees when they look “straight ahead”).

•	 Choose File > Share, select an export option (such as Export Movie), then review the 
thumbnail image of the project in the Share window.

The orientation shown in the Share window is how your final render appears.
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Guidelines for better 360° projects in Motion
To get the best results when working in 360° projects, consider the following suggestions:

•	 Make sure your 360° media is formatted for equirectangular projection.

•	 Try to use images that match the resolution of your project. Low-resolution media may 
stretch and scale incorrectly, yielding undesirable results.

•	 You can add clone objects to a 360° environment—however this is only recommended 
when you’re masking 360° media. Cloning other objects may yield unexpected results.

•	 360° projects with resolutions lower than 2K are not recommended.

•	 Make sure your Mac meets the minimum and recommended system requirements for 
working with 360º video. See the Motion tech specs.

•	 Converting normal projects or normal Final Cut Pro templates into 360° projects may 
yield undesirable results. Whenever possible, create your 360° projects from scratch.

•	 To “cut to” different default views during playback, add multiple scene cameras (or 
Reorient filters) with different rotations and offset them in the Timeline.

•	 To export multiple versions of your 360° video, each with different default views, 
disable all but one camera, and then export. Next, enable a different camera and export 
again.

•	 To lock the active camera and prevent the unwanted reorientation of a scene, click the 
lock icon to the right of the camera name in the Layers list. Click the lock icon again to 
unlock the camera.

•	 When viewing your project, use the 360° Look Around camera view rather than the 
actual camera in order to:

•	 Avoid altering the default orientation of the 360° media

•	 Avoid unwanted keyframing

•	 Update your view based on the Active Camera orientation at the current frame

•	 For a fully immersive project-viewing experience, use a VR headset while working with 
360° video in Motion. For setup instructions, see Use a VR headset with Final Cut Pro 
and Motion.

•	 To ensure that viewers see text or images that you add to the project, add those 
elements to each of quadrant of the sphere. Viewers may not see graphics placed too 
high or too low in the sphere.

•	 To customize your workspace, you can temporarily change the canvas layout—swapping 
the viewports, adding additional viewports, displaying one viewport at a time, and so 
on. See 3D viewport layouts.

•	 The 360° environment is always centered around the position of the active camera. For 
this reason, you may want to position the camera at the origin (the point where all three 
axes—X, Y, and Z—meet in the center of the canvas, where X = 0, Y = 0, and Z = 0). 
This way, objects with negative Z Position values always appear in front of the camera 
and objects with positive Z Position values always appear behind the camera. See Intro 
to 3D coordinates.

•	 If you move an equirectangular image that has been animated with keyframes or applied 
behaviors into a 360° environment, the animation is disabled. Once the image is moved 
back to a standard group, the animation is enabled again.

https://www.apple.com/final-cut-pro/motion/specs/
https://support.apple.com/119607
https://support.apple.com/119607
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Track motion in clips

Intro to tracking in Motion
Motion tracking is a method of recording the movement of an element in a source video 
clip, then applying that recorded movement data to a target, or destination object, such 
as an image, a particle emitter, a filter, a mask, or text. For example, you can use motion 
tracking techniques to:

•	 Track a name to a footballer as she zooms across the pitch

•	 Stabilize an overly shaky camera to improve a “found-footage” thriller

•	 Track a mask to a moving car to separate the vehicle from the background

•	 Pin a post-production graphic to the side of a moving bus

•	 Track a blurry circle to a person’s face to preserve an innocent bystander’s anonymity

•	 Track a sparkling particle system to an animated star shape

There are six tracking behaviors in Motion. You apply a tracking behavior to a video clip 
in your project; analyze the clip to record movement, rotation, or changes in scale; then 
apply that movement data to any other object in the project, transferring the motion of the 
tracked source element to the destination object. You can also use a tracking behavior to 
apply the movement of an animated (source) object to another (destination) object, or to 
track the position parameter of a filter or object.



1170Motion User Guide

How does motion tracking work?
The tracking behaviors in Motion analyze an area of pixels known as a reference pattern in 
a clip to “lock onto” the pattern as it moves across the canvas. You specify the reference 
pattern by dragging one or more onscreen trackers to the area of the clip you want to 
analyze. Motion analyzes and records the motion of the designated reference pattern.

Ideally, the reference pattern should be a consistent, easily identifiable detail with high 
contrast. This makes the pattern easier to track.

Each of the six tracking behaviors in Motion is optimized to perform a different type of 
motion tracking:

•	 Analyze Motion: Generates and stores tracking information from a source video clip that 
can be applied to other objects. See Analyze and record movement in a clip.

•	 Match Move: Applies the movement of a source video clip (or animated object) to 
another object so they appear locked together. See Intro to match moving.

•	 Stabilize: Removes unwanted motion in a video clip, such as camera jitter. See Stabilize 
a shaky clip.

•	 Unstabilize: Applies the movement recorded by a Stabilize behavior to a video clip or 
object. For example, you can use this behavior to match the camera shake in a clip to 
elements added in post-production. See Unstabilize a clip.

•	 Track Points: Matches the control points of a shape, paint stroke, or mask to a reference 
feature in a video clip. For example, you can draw a mask around a car in a clip and 
then track the control points of the mask to the moving car, cutting the car out of the 
background. See Track shapes, masks, and paint strokes.

•	 Track: Matches the position or anchor point parameters of shapes, images, or filters to 
a reference feature in a video clip. For example, you can match the center of a Circle 
Blur filter to follow and obscure a person’s face. See Track the position of a filter or 
object.

The Analyze, Match Move, and Track behaviors have two optional modes of analyzing 
reference patterns:

•	 Object mode: Uses machine learning or point cloud analysis (or a combination of both 
methods) to recognize and track subjects such as people or faces, pets, cars, or other 
common patterns. Or, if you want to manually specify a reference pattern, you can drag 
the onscreen object tracker (an adjustable onscreen control, shown below) to the area 
in the canvas you want to analyze.

Note: Mac computers with Apple silicon use an enhanced machine learning model to 
analyze the movement of faces and other objects, resulting in accelerated and more 
accurate tracking results compared with Intel-based Macs.
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•	 Point mode: Analyzes a pixel pattern within a search region, then tracks that pattern as 
it moves over time. You specify the reference pattern to be analyzed by dragging one or 
more onscreen point trackers (a yellow or red crosshair in a circle, shown below) to the 
area in the canvas you want to analyze.

The more point trackers you use, the more spatial information you’ll record: One-
point tracking records position data; two-point tracking and four-point tracking record 
position, rotation, and scale data (by comparing the relative change between the 
points); multiple-point tracking can record all the control points (vertices) on a shape.

Note: Tracking in Motion is not 3D—it doesn’t occur in Z space (depth). When you 
analyze two features in a clip—and that clip is moving in 3D space—you record the 
changes in position, scale, or rotation over time in the clip, but not its actual 3D 
transformation.

As it analyzes motion in your project, Motion records the data, which you can then apply to 
any other object in your project. Additionally, motion created by keyframing or behaviors 
can also be applied to other objects using some tracking behaviors.

Analyze and record movement in a clip in Motion
The Analyze Motion behavior analyzes and stores tracking data from a video clip, which 
you can then apply to objects in your project using other tracking behaviors. Use Object 
mode to recognize and track common subjects such as people or faces, pets, and cars. 
Use Point mode to track a pixel pattern.

Note: Tracking in one pass rarely yields perfect results. Successful tracking often requires 
trying different tracking modes or analysis methods. For information on tracking methods 
and tips, see Tracking guidelines.

Analyze and record the motion of an object in a clip
Set the Analyze Motion behavior to Object mode to track recognizable subjects in a clip 
such as faces and people, animals, and cars.

1.	 In the Layers list in Motion, select the video clip to track, then click Behaviors in the 
toolbar and choose Motion Tracking > Analyze Motion.

An object tracker is added to the center of the canvas.
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2.	 Play your clip several times to determine a good reference pattern or subject, then 
move the playhead to the frame where you want to start the track analysis.

3.	 Do any of the following:

•	 Track an area of the clip: In the canvas, drag the object tracker to the reference 
pattern you want to track.

•	 Track a suggested subject in the clip: While pressing and holding the Option key, 
drag the object tracker over elements in the canvas. As you drag, bounding boxes 
appear over elements, suggesting regions of interest that may be trackable.

Additionally, elliptical shapes appear over faces.

When you release the mouse button over the element you want to track, the object 
tracker conforms to the subject.

•	 Track a face in the clip: In the Behaviors Inspector, click the Detect pop-up menu, 
then choose Faces. Onscreen controls appear around any faces detected in the 
frame. When you click the onscreen control for the face you want to track, the object 
tracker conforms to the subject.

Note: A subject identified in a clip isn’t necessarily trackable; it’s a potential region 
of interest in the scene that the machine learning model recognizes.

4.	 If necessary, change the shape or size of the object tracker.
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5.	 In the Behaviors Inspector, click the Analysis Method pop-up menu, then choose one of 
the following options:

•	 Automatic: Automatically chooses the most suitable analysis method. Because the 
best method is highly dependent on the properties of a clip and each use case, you 
may need to experiment with different analysis methods to achieve the best result.

•	 Combined: Uses a combination of the Machine Learning and Point Cloud analysis 
methods (described below) to track position, scale, and rotation.

•	 Machine Learning: Uses a machine learning model trained on a dataset to identify 
people, animals, and many other common objects, allowing the tracker to follow the 
subject in a specified region of video. Choose this option when absolute tracking 
precision isn’t required, such as when attaching titles or graphics to objects or 
people. This method can overcome moderate occlusion—when an object (such as a 
tree or car) briefly obscures the subject being tracked.

•	 Point Cloud: Tracks a specific reference pattern and identifies how the pattern 
transforms from one frame to the next. Choose this option when you need more 
precise tracking of specific pixels. This method tracks position, scale, and rotation, 
and excels at tracking regions that are rigid and somewhat flat (from the camera’s 
point of view).

Note: You can use different tracking analysis methods over different ranges of 
frames (in the same clip).

6.	 In the Behaviors Inspector, do any of the following:

•	 Analyze the entire clip: Click Analyze. The clip is analyzed forward from the playhead 
position to the end of the clip (or to the frame where the reference pattern can no 
longer be tracked), and then backward from the playhead position to the start of the 
clip.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

The tracking analysis progress window displays the analysis method used for the track.

 Tip: If you’re using the Machine Learning analysis method and observe jitter 
during the analysis (the onscreen object tracker bouncing or jumping from one size 
to another), try switching to the Point Cloud analysis method. Its tracker is much less 
susceptible to quick changes.
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7.	 To stop the tracking analysis, click the Stop button in the progress window or press Esc.

Tracking keyframes appear in the Keyframe Editor. If the Keyframe Editor is not visible, 
click the Show/Hide Keyframe Editor button in the lower-left corner of the Motion 
window.

In addition to the tracking keyframes, a confidence curve is displayed in the Keyframe 
Editor. This curve provides a visual indication of the tracker’s accuracy relative to its 
parameter settings in the Inspector. The confidence curve is for reference only and is 
not used for editing purposes.

The analyzed track (contained in the Analyze Motion behavior) can now be used to match 
move an object using other tracking behaviors. See Match move an object or Load existing 
tracking data.

Analyze and record the motion of points or patterns in a clip
Set the Analyze Motion behavior to Point mode to track specific points or a pattern in 
a clip.

1.	 In the Layers list in Motion, select the video clip to track, then click Behaviors in the 
toolbar and choose Motion Tracking > Analyze Motion.

By default, an object tracker is added to the center of the canvas.

2.	 In the Behaviors Inspector, click the Mode pop-up menu, then choose Point.

The onscreen tracker changes to a point tracker.

3.	 Play your clip several times to determine a good reference point, then move the 
playhead to the frame where you want to start the track analysis.

4.	 In the canvas, drag the point tracker to the reference point you want to use.
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Note: For more information about adjusting the onscreen point tracker, see Adjust 
onscreen trackers.

5.	 Optional: To add more point trackers, click the Add button in the Behaviors Inspector, 
then drag them to reference points in the canvas.

To remove a point tracker, click Remove in the track row in the Behaviors Inspector.

6.	 In the Behaviors Inspector (or HUD), do one of the following:

•	 Analyze the clip forward from the position of the playhead: Click Analyze.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

When the tracking analysis begins, a progress window opens and displays the analysis 
method used for the track. Additionally, points appear on a motion path in the canvas. 
The point at the current playhead position is emphasized.

7.	 To stop a track analysis, click the Stop button in the progress window or press Esc.

 Tip: If the tracker loses its reference pattern, don’t click the Stop button; allow the 
analysis to continue for a few seconds. When the tracker fails, the playhead jumps to 
the frame where the reference pattern was lost.

The points in the canvas correspond to the tracking keyframes that appear in the 
Keyframe Editor. If the Keyframe Editor is not visible, click the Show/Hide Keyframe 
Editor button in the lower-left corner of the Motion window.
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A confidence curve is also displayed in the Keyframe Editor. This curve provides a visual 
indication of the tracker’s accuracy relative to its parameter settings in the Inspector. 
The confidence curve is for reference only and is not used for editing purposes.

The recorded tracking data (contained in the Analyze Motion behavior) can now be used 
to match move objects using other tracking behaviors. See Match move an object or Load 
existing tracking data.

For a full description of the Analyze Motion parameters, see Analyze Motion controls.

Match move an object to a clip

Intro to match moving in Motion
You can use the Match Move behavior to match the movement of an element in a source 
video clip to a destination object. The Match Move behavior can perform its own tracking 
analysis, or it can reference tracking data recorded by another behavior, such as Analyze 
Motion. Additionally, you can match the movement of an animated object to a destination 
object.

Use the Match Move behavior in the following ways:

•	 Match the position of a destination object to the position of a source object so they 
appear locked together. Use Object mode to track familiar objects such as people, 
animals, and cars, or use Point mode track patterns.

•	 Use two-point tracking to match the position, scale, and rotation of a destination object 
to the position, scale, and rotation of a source object.

•	 Use four-point tracking to match the position, scale, and rotation of a destination object 
to a source object with four corners—a computer screen or billboard space on the side 
of a bus, for example.

•	 Combine animation and tracking data.

Note: Tracking in one pass rarely yields perfect results. For information on tracking 
methods and tips, see Tracking guidelines.
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Match move an object in Motion
To use a Match Move behavior, you need at least two objects in your project: a source 
object and a destination object. Typically, the source is a video clip, but can also be an 
object animated by keyframes or behaviors. The source object provides movement data 
based on a tracking analysis of its video or its animation attributes. That movement data 
is then applied to the destination object. The destination object can be an image, a shape, 
text, a particle emitter, a camera, and so on.

Match move a destination object to a source object in a clip
In this workflow, the Match Move behavior tracks recognizable objects such as people 
or faces, animals, and cars in the source clip, then applies that resulting track data to 
a destination object. As a result, the destination object matches the movement of the 
tracked element in the source clip.

1.	 Import a source clip into your Motion project, then import a destination object (such as 
an image or clip), or add a destination object (such as a shape, particle emitter, or text).

The destination layer must be above the source video clip layer in the Layers list.

2.	 In the Layers list, select the destination object, click Behaviors in the toolbar, then 
choose Motion Tracking > Match Move.

Important: If you’re applying the Match Move behavior to a group, make sure the 
footage being analyzed resides outside of that group.

An object tracker conforming to the destination object is added to the canvas.

3.	 If necessary, change the shape or size of the object tracker.

4.	 In the Behaviors Inspector, click the Analysis Method pop-up menu, then choose one of 
the following options:

•	 Automatic: Automatically chooses the most suitable analysis method. Because the 
best method is highly dependent on the properties of a clip and each use case, you 
may need to experiment with different analysis methods to achieve the best result.

•	 Combined: Uses a combination of the Machine Learning and Point Cloud analysis 
methods (described below) to track position, scale, and rotation.

•	 Machine Learning: Uses a machine learning model trained on a dataset to identify 
people, animals, and many other common objects, allowing the tracker to follow the 
subject in a specified region of video. Choose this option when absolute tracking 
precision isn’t required, such as when attaching titles or graphics to objects or 
people. This method can overcome moderate occlusion—when an object (such as a 
tree or car) briefly obscures the subject being tracked.

•	 Point Cloud: Tracks a specific reference pattern and identifies how the pattern 
transforms from one frame to the next. Choose this option when you need more 
precise tracking of specific pixels. This method tracks position, scale, and rotation, 
and excels at tracking regions that are rigid and somewhat flat (from the camera’s 
point of view).

Note: You can use different tracking analysis methods over different ranges of 
frames (in the same clip).
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5.	 In the Behaviors Inspector, do one of the following:

•	 Analyze the entire clip: Click Analyze. The clip is analyzed forward from the playhead 
position to the end of the clip (or to the frame where the reference pattern can no 
longer be tracked), and then backward from the playhead position to the start of the 
clip.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

The tracking analysis progress window displays the analysis method used for the track.

 Tip: If you’re using the Machine Learning analysis method and observe jitter 
during the analysis (the onscreen object tracker bouncing or jumping from one size 
to another), try switching to the Point Cloud analysis method. Its tracker is much less 
susceptible to quick changes.

6.	 To stop the tracking analysis, click the Stop button in the progress window or press Esc.

Tracking keyframes and the transformed object’s keyframes appear in the Keyframe 
Editor. If the Keyframe Editor is not visible, click the Show/Hide Keyframe Editor button 
in the lower-left corner of the Motion window.

A confidence curve is also displayed in the Keyframe Editor. This curve provides a visual 
indication of the tracker’s accuracy relative to its parameter settings in the Inspector. 
The confidence curve is for reference only and is not used for editing purposes.
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The movement of the destination object is matched to the movement of the reference 
pattern analyzed in the clip, but you can still reposition the object in the canvas. To apply 
scale changes in the source object to the destination object, see the following task Adjust 
the scale of a match-moved object.

Adjust the scale of a match-moved object
When you match move a destination object to a source clip using Object mode tracking, 
changes in the size of the source object are not automatically applied to the destination 
object. Using the Scale Mode pop-up menu, you can match changes in scale of the source 
object to the destination object.

1.	 In Motion, complete steps 1–5 in the previous task, Match move a destination object to 
a source object in a clip.

2.	 In the Adjust parameter row of the Behaviors Inspector, select Scale.

3.	 Do one of the following:

•	 Uniformly scale the destination object to the minimum dimension of the tracker 
region: Click the Scale Mode pop-up menu, then choose Scale All (Fit). If the 
destination object contains changes in scale, this setting scales the maximum size of 
the object to the minimum dimension of the tracker region.

•	 Uniformly scale the destination object to the maximum dimension of the tracker 
region: Click the Scale Mode pop-up menu, then choose Scale All (Fill). If the 
destination object contains changes in scale, this setting scales the minimum size of 
the object to the maximum dimension of the tracker region.

•	 Nonuniformly scale the destination object based on the size of the tracker region: 
Click the Scale Mode pop-up menu, then choose Scale X & Y. If the source object 
contains changes in scale, this setting may cause the destination object to be 
stretched or squashed.

Match move a destination object to points or patterns in a source clip
In this typical workflow, the Match Move behavior tracks points or patterns in the source 
clip, then applies that resulting track data to a destination object. As a result, the 
destination object matches the movement of the tracked element in the source clip.

1.	 Import a source video clip into your Motion project, then import a destination object 
(such as an image or clip), or add a destination object (such as a shape, particle 
emitter, or text).

The destination layer must be above the video clip layer in the Layers list.

2.	 In the Layers list, select the destination object, click Behaviors in the toolbar, then 
choose Motion Tracking > Match Move.

Important: If you’re applying the Match Move behavior to a group, make sure the 
footage being analyzed resides outside of that group.

By default, an object tracker conforming to the destination object is added to the center 
of the canvas.
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3.	 In the Behaviors Inspector, click the Mode pop-up menu, then choose Point.

In the canvas, the object tracker changes to a point tracker. Because the default Match 
Move tracker records position data, it’s known as an anchor tracker.

4.	 Optional: To track more complex motion (such as a rotating element or an element with 
four corners), do one of the following:

•	 Add a second point tracker to track additional rotation and scale data: In the 
Behaviors Inspector, select the Rotation-Scale checkbox (under the Anchor 
checkbox), then drag the new point tracker into position in the canvas. See Two-
point tracking.

•	 Add four point trackers to track an element with four corners: In the Behaviors 
Inspector, click the Type pop-up menu, choose Four Corners, then proceed to step 3 
of Use four-corner tracking to pin a destination object to a source object.

To remove a point tracker, click Remove in the track row in the Behaviors Inspector.

5.	 Move the playhead to the frame where you want the track analysis to begin.

6.	 In the canvas, drag the tracker (or trackers) to the area (or areas) you want to track.

As you drag the tracker in the canvas, the region around the tracker becomes magnified 
to help you find a suitable reference pattern.

Note: For more information about adjusting the point tracker, see Adjust onscreen 
trackers.

7.	 In the Behaviors Inspector (or HUD), do one of the following:

•	 Analyze the clip forward from the position of the playhead: Click Analyze.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

The behavior analyzes the movement of the reference pattern in the video clip, then 
matches the movement of the destination object to it.
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8.	 To stop the tracking analysis, click the Stop button in the progress window or press Esc.

The points in the canvas correspond to the tracking keyframes that appear in the 
Keyframe Editor. If the Keyframe Editor is not visible, click the Show/Hide Keyframe 
Editor button in the lower-left corner of the Motion window.

A confidence curve is also displayed in the Keyframe Editor. This curve provides a visual 
indication of the tracker’s accuracy relative to its parameter settings in the Inspector. 
The confidence curve is for reference only and is not used for editing purposes.

Match move using animation data from keyframes or behaviors
Because objects animated with keyframes or with behaviors already contain motion data, 
you can apply that data to a destination object using the Match Move behavior without 
performing a tracking analysis.

The following simple example uses a “magic wand” image (a rectangular shape) animated 
using the Spin behavior and the Magic Dust particle emitter (available in the Library). 
The Match Move behavior extracts the animation of the magic wand and applies it to 
the Magic Dust particle emitter to create the illusion of sparkles flying off the tip of the 
spinning wand.

1.	 In Motion, make sure the destination object (the particle emitter) is above the source 
object (the magic wand shape) in the Layers list.

2.	 In the Layers list, select the destination object, click Behaviors in the toolbar, then 
choose Motion Tracking > Match Move.
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In the Layers list, the Match Move behavior appears directly under the particle emitter.

Because the animated source object (the spinning magic wand) is below the Match 
Move behavior in the Layers list, the source animation data is automatically loaded into 
the Source well in the Behaviors Inspector. If you don’t see the animated object in the 
Source well, drag the animated object from the Layers list into the Source well.

3.	 In the canvas, drag the destination object (the particle emitter) to the tip of the magic 
wand.

The motion path inherited from the source object appears in the canvas, attached to the 
destination object.

As a result, the particle emitter and the wand now share the same animation path.
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4.	 Play the project (press the Space bar).

The particles match the movement of the wand.

Once you’ve match moved an object, you can still adjust the object (resize, rotate, 
scale, move, apply filters to, and so on). Tracking data is separate from an object’s own 
properties or transform parameters.

For a full description of Match Move parameters, see Match Move controls.

Two-point tracking in Motion
You can use the Match Move behavior to track two points on a source clip to analyze and 
record changes in position, scale, and rotation of the tracked region, then apply those 
changes to a destination object. You can manually disable any of these parameters (in the 
Adjust row of the Behaviors Inspector) to achieve different effects.

Note: Two-point tracking is only available when Mode is set to Point in the Match Move 
behavior.

In the following example, an elliptical shape (the destination object) is match moved to a 
video clip of picture frames (the source object) using two-point tracking. In the first three 
images below, only Position is enabled in the Adjust row of the Behaviors Inspector. As a 
result, although the camera pushes in toward the picture frames, the white elliptical shape 
does not change its scale or rotation based on the position of the two trackers.
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When Position, Scale, and Rotation are selected in the Adjust row of the Behaviors 
Inspector, the elliptical shape changes its position, scale, and rotation based on the 
position of the two trackers, matching the camera’s push toward the picture frames, 
preserving the illusion that the shape is physically attached to the picture frame.

For a full description of Match Move parameters, see Match Move controls.

Corner-pin an object in Motion
You can use the Match Move behavior to track four points on a source clip and then apply 
the recorded motion to the four corners of a destination object. This process is known as 
corner pinning.

Note: Four-point tracking is only available when Mode is set to Point in the Match Move 
behavior.

Use four-corner tracking to pin a destination object to a source object
This workflow is ideal for a four-corner pin in which the transformed or pinned image is the 
same size as the source reference pattern it’s being tracked to. In the following example, 
an image is pinned to a source clip of a picture frame.

 Tip: If the position, size, or angle of the destination object is radically different from 
that of the source pattern (an angled TV screen or picture frame, for example), you may 
need to adjust the object before you apply the Match Move behavior. You can reorient the 
object in the canvas using the Distort tool (available in the transform tools pop-up menu in 
the canvas toolbar).

1.	 In Motion, drag the playhead to the frame where you want to start the track analysis, 
then apply a Match Move behavior to the destination object.

By default, an object tracker is added to the center of the canvas.

Note: If you apply the Match Move behavior to a 2D group (rather than an individual 
layer in a group), make sure the Fixed Resolution checkbox is selected in the Group 
Inspector. When you apply the Match Move behavior to a 3D group, the Four Corners 
option is not available. To corner-pin a 3D group, select the Flatten checkbox in the 
Group Inspector.

2.	 In the Behaviors Inspector, click the Mode pop-up menu, then choose Point.

In the canvas, the object tracker changes to a point tracker. Because the default Match 
Move tracker records position data, it’s known as an anchor tracker.
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3.	 In the Behaviors Inspector, click the Type pop-up menu, then choose Four Corners.

In the canvas, a point tracker appears at each corner of the destination object’s 
bounding box. In the Inspector, the Anchor and Rotation-Scale checkboxes are replaced 
with the Top Left, Top Right, Bottom Right, and Bottom Left checkboxes; each checkbox 
activates or deactivates a tracker in the canvas.

4.	 In the canvas, drag each tracker to a corner of the source object (in this example, the 
corners of the picture frame).

As you drag a tracker, a magnified inset appears to help you position each tracker.

5.	 In the Behaviors Inspector (or HUD), do one of the following:

•	 Analyze the clip forward from the position of the playhead: Click Analyze.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.



1186Motion User Guide

The behavior analyzes the movement of the reference pattern in the video clip, and 
the destination object is pinned to the source object; four motion paths show the 
transformation occurring at each corner.

6.	 If necessary, make minor adjustments to the destination object (such as modifying scale 
or rotation) by doing the following:

a.	 Click the Transform pop-up menu in the Behaviors Inspector, then choose Mimic 
Source.

The default option in the Transform pop-up menu (Attach to Source) does not permit 
transformations of the object.

b.	 Open the Properties Inspector and make any necessary adjustments to the object 
using the Scale slider, Rotation dial, or other controls.

For more information on the Mimic Source and Attach to Source transform options, see 
Match Move controls.

If corner pinning does not produce a successful track
If the Match Move corner pinning method described above fails to yield a successful track, 
try four-point tracking using the Analyze Motion behavior. In this workflow, the four-point 
tracking data collected from the Analyze Motion behavior is loaded into a Match Move 
behavior to corner-pin a destination object.

1.	 In Motion, go to the frame where you want to start the track and apply an Analyze 
Motion behavior to the source object.

Important: Whereas the Match Move behavior is always applied to the destination 
object, the Analyze Motion behavior is always applied to the source object (clip).

By default, an object tracker appears in the canvas.

2.	 In the Behaviors Inspector, click the Mode pop-up menu, then choose Point.

In the canvas, the object tracker changes to a point tracker.
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3.	 In the canvas, drag the tracker (Track 1) to a reference pattern in the top-left corner of 
the source object.

4.	 In the Behaviors Inspector, click Add to add a second tracker, then in the canvas drag 
the second tracker (Track 2) to a reference pattern in the top-right corner of the source 
object.

5.	 Add another tracker (Track 3), then drag it to a reference pattern in the bottom-right 
corner of the source object.

6.	 Add another tracker (Track 4), then drag it to the reference pattern in the bottom-left 
corner of the source object.

Positioning the point trackers in a clockwise order (starting in the upper-left corner) 
ensures the proper alignment of your element when the transformation is applied.

Note: To modify parameters for any of the trackers, position the pointer over the right 
side of the track parameter row and click Show.

7.	 In the Behaviors Inspector (or HUD), do one of the following:

•	 Analyze the clip forward from the position of the playhead: Click Analyze.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

The track is generated and its data is saved in the behavior.

8.	 Apply a Match Move behavior to the destination object you want to corner-pin.

By default, an object tracker is added to the center of the canvas.

9.	 In the Behaviors Inspector, click the Mode pop-up menu, then choose Point.

In the canvas, the object tracker changes to a point tracker.
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10.	In the Match Move area of the Behaviors Inspector, click the Action pop-up menu (with 
the gear icon), then choose the Analyze Motion track.

The Analyze Motion tracking data recorded in step 6 is applied to the Match Move 
behavior.

11.	In the Match Move area of the Behaviors Inspector, click the Type pop-up menu, then 
choose Four Corners.

Trackers are placed in the correct order (clockwise from the top left) in the canvas 
and the four-point tracking data from the Analyze Motion behavior is applied to the 
destination object.

Remove parallax from tracked 3D groups
When you match move 3D groups that contain objects offset in Z space (depth), parallax is 
simulated. Parallax is the apparent shift of an object against a distant background caused 
by a change in perspective, such as a change in camera position. You can disable this 
effect, if necessary, by doing the following:

•	 In Motion, select the Flatten checkbox for the tracked group in the Group Inspector.

The parallax effect is removed.

For a full description of Match Move parameters, see Match Move controls.

Combining animation and tracking data in the Match Move 
behavior in Motion
When the destination object that’s been match moved has no animation of its own, it 
precisely follows the motion of the source object. However, if the destination object is also 
animated (has its own applied behaviors or keyframes), more complicated motion effects 
can be achieved by combining both movements in the Match Move behavior.

You can specify whether the animation of the destination object is ignored by or added to 
the Match Move behavior in the Match Move Behaviors Inspector by choosing one of two 
options from the Transform pop-up menu:

•	 Attach to Source: Applies the movement of the source object to the destination object, 
but disables any animation inherent in the destination object. (However, you can 
reactivate the destination object’s own animation and deactivate the source object’s 
recorded track by turning off the Position, Scale, and Rotation buttons in the Adjust row 
of the Behaviors Inspector.)

•	 Mimic Source: Combines the source object’s recorded track with and destination 
object’s own animation. In other words, the destination object maintains its own 
animation while at the same time mimicking the motion in the source object’s recorded 
track. When the Match Move behavior is set to Mimic Source, turning off the Position, 
Scale, and Rotation buttons deactivates the source object’s recorded track. For more 
information on Attach to Source and Mimic Source, see Match Move controls.
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Remove unwanted camera shake

Stabilize a shaky clip in Motion
You can use the Stabilize tracking behavior to smooth shaky motion in a video clip or 
image sequence, such as eliminating teetering from handheld walking shots, or reducing 
vibrations in automotive shots.

There are three ways to analyze a clip using the Stabilize behavior:

•	 Use the behavior’s default advanced motion analysis to evaluate the entire frame of a 
clip to extract movement data without using onscreen trackers. This automatic analysis 
works best with real images—artificial images (such as those with no texture) or shots 
with very strong pans are not recommended.

•	 Use onscreen trackers to analyze a reference pattern (a small group of pixels) in the 
canvas. These are the same trackers used by the Match Move and Analyze Motion 
behaviors.

•	 Use a combination of the advanced motion analysis and onscreen trackers.

Correct a shaky clip using the Stabilize behavior
1.	 In the Layers list, select the video clip you want to stabilize, click Behaviors in the 

toolbar, then choose Motion Tracking > Stabilize.

2.	 In the Behaviors Inspector, set the options for the analysis:

a.	 Click the Quality pop-up menu, then choose an option:

•	 Faster: Allows for a faster operation, but motion analysis is less detailed.

•	 Better: Provides a more detailed analysis, but is slower.

b.	 To define a specific portion of the clip to be analyzed (and to speed processing), 
select the Track Region checkbox. See the following task, Limit the area analyzed by 
the Stabilize behavior.

c.	 Click the Method pop-up menu, then choose an option:

•	 Stabilize: Locks down an image, removing problems such as camera shake. The 
resulting effect is similar to footage shot on a camera mounted to a stationary 
tripod.

•	 Smooth: Eliminates camera jitter while maintaining the general motion of the 
camera. When Smooth is selected, the Translation Smooth, Rotation Smooth, and 
Scale Smooth parameters become available. See Stabilize controls.

d.	 Click the Borders pop-up menu, then choose an option:

•	 Normal: Maintains the size of the stabilized footage. Resulting transformations 
made to the stabilized image may cause moving black borders to appear around 
the edges of the clip. A very shaky clip results in large black borders.



1190Motion User Guide

•	 Zoom: Expands the clip to the full size of the canvas, preventing black borders 
from appearing around the edges of the stabilized clip.

Note: For suggestions on correcting the black borders, see Remove borders from 
stabilized clips.

e.	 Click the Direction pop-up menu, then choose one of the following options:

•	 Horizontal and Vertical: Applies the stabilize transformation to the X and Y 
positions.

•	 Horizontal: Applies the stabilize transformation to the X position.

•	 Vertical: Applies the stabilize transformation to the Y position.

f.	 Select (or deselect) the Adjust settings:

•	 Position: Applies the analyzed position data to the clip. (The X and Y position 
changes in the footage are smoothed or stabilized.) To stabilize the X and Y 
position of the shot and leave scale or rotation changes intact, enable Position 
and disable Scale and Rotation.

•	 Scale: Applies any analyzed scale data to the clip. (Scale changes in the footage 
are smoothed or stabilized.) To stabilize or smooth changes in scale and leave 
position or rotation changes intact, enable Scale and disable Position and 
Rotation. (The Scale option is not related to the Zoom option in the Borders pop-
up menu.)

•	 Rotation: Applies analyzed rotation data to the clip. (Changes in the rotation 
of the footage are smoothed or stabilized.) To stabilize or smooth changes in 
rotation in the shot and leave position or scale changes intact, enable Rotation 
and disable Position and Scale.

For the smoothest result, select all three Adjust buttons (Position, Scale, and 
Rotation).

Note: You can change the Method, Borders, Direction, and Adjust parameters before 
or after the clip is analyzed.
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3.	 In the Behaviors Inspector (or HUD), click Analyze (or the right arrows next to the 
Analyze button).

The clip is stabilized according to defined parameters. Any motion blur present in the 
original image remains.

By default, the Stabilize behavior does not use onscreen trackers to analyze motion 
or create keyframes in the Keyframe Editor. But you can add trackers for additional 
smoothing. See the Add trackers to a portion of a stabilize operation task, below.

Note: The stabilized object’s transformation can be converted to keyframes. See 
Advanced tracking strategies. When trackers are added to and analyzed with the 
Stabilize behavior, keyframes are created.

Limit the area analyzed by the Stabilize behavior
When stabilizing a clip, you can define a specific region to be analyzed. During analysis, 
the area outside this region is ignored. Use this option for faster processing of a clip.

1.	 In the Layers list in Motion, select an applied Stabilize behavior.

2.	 In the Behaviors Inspector, select the Track Region checkbox.

A transparent red overlay representing the track region appears in the canvas.

3.	 Do any of the following:

•	 Change the position of track region: Drag in the region.

•	 Resize the track region: Drag a handle on the bounding box of the region. The corner 
handles simultaneously resize width and height; the top and bottom center handles 
resize height; the left and right center handles resize width.

•	 Resize the track region from its center: Press and hold the Option key while dragging 
a handle.

•	 Change the angle of the track region: Drag the rotation handle in the center of the 
track region.

4.	 After defining the track region, click Analyze in the Behaviors Inspector.

Because analysis takes place in the defined track region, the clip is analyzed more 
quickly.
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Add trackers to a portion of a stabilize operation
If a stabilized clip has a bumpy section that’s not getting smoothed (from an accidental 
camera bump affecting a range of frames, for example), you can add point trackers to 
correct that section of the clip.

1.	 In Motion, after the Stabilize motion analysis is complete, play the clip to determine the 
section you want to correct.

2.	 Set an Out point for the tracker analysis by positioning the playhead at the frame where 
you want to stop the analysis, then choose Mark > Mark Play Range Out.

To yield the best results, use a large range of frames.

3.	 Position the playhead at the frame where you want to start the tracker analysis, then do 
one of the following:

•	 Analyze X and Y position changes in the footage: Click the Add button in the 
Behaviors Inspector to add an Anchor tracker.

•	 Analyze changes in X and Y position as well as rotation and scale in the footage: 
Click the Add button in the Behaviors Inspector once to add an Anchor tracker, then 
click Add again to add a Rotation-Scale tracker.

4.	 In the canvas, position the newly added point tracker on the reference pattern you want 
to track, then click Analyze in the Behaviors Inspector.

The play range is tracked, creating track points in the canvas and tracking keyframes in 
the Keyframe Editor.

Any stabilization data from the automatic motion analysis is overwritten by the portions 
of the clip analyzed using the onscreen trackers.

 Tip: When using this strategy to track multiple noncontiguous sections of the clip, 
use the same tracker to simplify the track and to avoid clutter in the Keyframe Editor.

Modify smoothing parameters
If you’re trying to smooth the motion in a stabilized clip, first try adjusting the smoothing 
parameters (without reanalyzing the clip).

1.	 In the Layers list in Motion, select the Stabilization behavior (that’s already analyzed the 
clip).

2.	 In the Behaviors Inspector, click the Method pop-up menu, then choose Smooth.

3.	 Do any of the following:

•	 Smooth motion in the X and Y positions: Adjust the Translation Smooth slider.

•	 Smooth image rotation: Adjust the Rotation Smooth slider.

•	 Smooth an uneven zoom: Adjust the Scale Smooth slider.

Note: Don’t set the Scale Smooth value above 0 unless you’re positive the clip is 
being zoomed.
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Perform multiple stabilization analyses on a shaky clip
If a clip is particularly shaky, it may be necessary to stabilize the clip more than once to 
remove camera movement not corrected in the first stabilization analysis.

•	 In Motion, stabilize a clip, export the clip, import the clip, then stabilize the clip again.

For a full description of the Stabilize parameters, see Stabilize controls.

Remove borders from stabilized clips in Motion
When you use the Stabilize behavior, the resulting transformations that smooth or stabilize 
the shot cause moving black borders to appear around the edges of the image. Although 
this is necessary to achieve the desired effect, you probably don’t want these black 
borders to appear in the final shot.

To remove the moving black borders, you can zoom or scale the clip, or distort the edges 
of the clip using a filter.

Zoom the stabilized clip
1.	 In the Layers list in Motion, select the Stabilization behavior (that’s already analyzed the 

clip).

2.	 In the Behaviors Inspector, click the Borders pop-up menu, then choose Zoom.

The clip is expanded to hide the black borders.

Distort the edges of the stabilized clip
You can experiment with filters to stretch the edges of the image to fill gaps created 
around the edges of stabilized clips. The following example uses the Scrape filter. (This 
solution is highly dependent on the type of image and may introduce other image artifacts 
that may not be acceptable.)

1.	 In Motion, select the group containing the stabilized clip.

In this example, the project background is white to better illustrate the clip’s shift in 
position due to the stabilization.

2.	 Click Filters in the toolbar, then choose Filters > Distortion > Scrape. 
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3.	 In the Filters Inspector, turn off the Crop checkbox, then adjust its parameters.

You can also use the filter’s onscreen controls to adjust the Center and Rotation 
parameters.

The left image shows the clip when the filter is first applied to the group. The right 
image shows the result of adjusting the Center parameter’s Y position: the top edge is 
stretched to the top of the canvas.

If none of the above options achieve your goal, you can apply a framing filter or apply a 
letterboxing filter to the stabilized clip to hide the moving black border created by the 
stabilization.

Unstabilize a clip in Motion
The Unstabilize behavior’s sole function is to apply movement recorded by a Stabilize 
behavior, letting you do any of the following:

•	 Reapply camera shake or movement into a finished clip

•	 Match the camera shake in a source clip to elements added in post-production

•	 Unstabilize a stabilized clip

Note: A project must include a Stabilize behavior with recorded motion data before you can 
use the Unstabilize behavior.

Reapply camera shake or movement into a finished clip
1.	 In the layers list in Motion, select the layer to unstabilize, click Behaviors in the toolbar, 

then choose Motion Tracking > Unstabilize.

The recorded motion data from the existing Stabilization behavior is automatically 
applied to the Unstabilize behavior.

2.	 If you don’t want to use the automatically selected Stabilize behavior, do one of the 
following:

•	 In the Behaviors Inspector or HUD, click the Action pop-up menu (with a gear icon), 
then choose a different Stabilize behavior.

•	 Drag an analyzed tracking behavior from the Layers list to the Source well in the 
Behaviors Inspector or HUD. 

The motion is applied to the selected layer.

For a full description of Unstabilize parameters, see Unstabilize controls.
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Track shapes, masks, and paint strokes in Motion
You can use the Track Points behavior (located in the Shape Behaviors category) with 
shapes, masks, and paint strokes to:

•	 Match the control points of a shape, paint stroke, or mask to points or patterns in a 
video clip (for example, when rotoscoping)

•	 Apply tracking data recorded by the Analyze Motion, Match Move, or Stabilize behaviors 
to the control points of a shape or mask

•	 Apply the animation of one shape (or other object) to the control points of another 
shape or mask

Note: To apply the analyzed movement of an object to a shape or mask as a whole (rather 
than to the shape’s individual control points), use the Match Move behavior.

Track a mask using the Track Points behavior
In the following example, the Track Points behavior is applied to a mask with many control 
points, isolating a plane in a video clip.

1.	 With a clip visible in the Motion canvas, use a mask tool to isolate part of the clip.

For more information on working with masks, see Intro to masks and transparency.

2.	 In the Layers list, select the mask object, then click Behaviors in the toolbar and choose 
Shape > Track Points.

The tracker is applied to the mask and track points.

Note: If necessary, drag the footage containing the object you are isolating to the Track 
Point’s Source well in the Behaviors Inspector.

Trackers appear for each control point on the shape. The trackers are arrayed in the 
same order that the shape was drawn: Control Point 1 is Track 1, Control Point 2 is Track 
2, and so on.
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3.	 Drag the trackers to fine-tune their positions on the reference patterns of the source 
footage.

As you drag, a magnified inset view of the area around the tracker appears.

4.	 To disable a tracker, deselect its checkbox in the Behaviors Inspector.

Note: Control points without an associated tracker are not modified.

5.	 In the Behaviors Inspector (or HUD), do one of the following:

•	 Analyze the clip forward from the position of the playhead: Click Analyze.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

The mask control points are tracked to the reference patterns in the source footage.

The image on the left shows the original unmodified clip. The image on the right 
shows the tracked mask isolating the plane, allowing separate effects to be applied to 
the plane and its background even though they’re part of the same image. The mask 
protects the plane from the results of the color effects, blur, and cloud generator.

As with all behaviors, you can drag or copy (by Option-dragging) a Track Points 
behavior to a new shape in the Layers list. When you apply the behavior to a new shape, 
the trackers are applied to the control points of the new shape. If the new shape has 
more control points than the originally tracked shape, only the original track points are 
applied. For example, if the originally tracked shape has three control points, and the 
new shape has five control points, trackers are applied to the first three control points 
of the new shape. If the new shape has fewer control points than the originally tracked 
shape, trackers are applied to the existing points on the new shape. 

Note: Paint strokes usually have a large number of control points. Simplify a paint stroke 
by deleting or disabling control points before applying a Track Points behavior to the 
stroke. To track the stroke as a whole, rather than by its control points, use the Match 
Move behavior. For more information about paint strokes, see Intro to paint strokes.
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Apply the animation of one shape to the control points of another shape
Applying the animation of one animated shape to another is an easy way to create fun, 
complementary animations in which the objects appear to play with each other. For this 
workflow, your project must contain an object animated with keyframes or behaviors.

1.	 In a Motion project that contains two shapes, animate one of the shapes using 
keyframes or a Basic Motion behavior.

In this example, a simple line shape is animated with the Spin behavior.

For more information about animating with keyframes, see Intro to keyframing. For more 
information about Basic Motion behaviors, such as the Spin behavior, see Intro to basic 
Motion behaviors.

2.	 In the Layers list, select the nonanimated shape, then click Behaviors in the toolbar and 
choose Shape > Track Points.

Note: When you apply the Track Points behavior to a simple shape, a dialog appears. 
Click Add to convert the shape’s geometry to control points.

3.	 Drag the animated shape from the Layers list to the Track Points behavior’s Source well 
in the Behaviors Inspector.

Note: If the nonanimated shape is positioned immediately above the animated shape 
in the Layers list when the Track Points behavior is applied, the animated shape is 
automatically used as the Track Point behavior’s source.

A thumbnail of the animated object appears in the Source well of the Track Points 
Behaviors Inspector.

4.	 In the Behaviors Inspector, click the Transform pop-up menu, then choose Attach to 
Source.

The spinning animation of the line is applied to the Bezier shape, which spins and 
changes shape because the vertex tangents match the transformation of the source 
animation.

5.	 To align the tangents to the transformation of the source object, select the Align 
Tangents checkbox in the Behaviors Inspector.
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The spinning animation of the line is applied to the Bezier shape, which now spins and 
but does not change shape because its vertex tangents remain aligned at their original 
angles along the shape.

Note: By default, the Transform pop-up menu is set to Mimic Source.

For a full description of the Track Points parameters, see Track Points controls.

Track the position of a filter or object in Motion
You can use the Track behavior to analyze motion in a video clip, then apply that tracking 
data to the center parameter of a filter. For example, you can track the center of a Light 
Rays filter to a moving light in a clip.

You can also use the Track behavior to apply existing tracking data (recorded by another 
tracking behavior) to the position or anchor point parameter of an object, such as a shape 
or text.

Note: This behavior applies only to filters with Center parameters, such as Scrape, Ring 
Warp, Light Rays, Slit Tunnel, and so on.

Track the position parameter of a filter to a source object in a clip
1.	 In Motion, apply a filter (that includes a Center parameter) to a layer in your project.

2.	 Move the playhead to the frame where you want to start the track analysis.

3.	 In the canvas, drag the center point of the filter to the region of the layer (a video clip or 
animated shape) you want to track.

If the filter’s onscreen controls aren’t visible in the canvas, make sure the filter is 
selected in the Layers list.
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4.	 Do one of the following:

•	 In the canvas, Control-click the Center onscreen control, then choose Track.

•	 In the Filters Inspector, Control-click the Center parameter, then choose Add 
Parameter Behavior > Track from the shortcut menu.

In the canvas, the filter’s onscreen control is replaced with an object tracker.

 Tip: If the reference pattern you want to track is offset from the center of the 
filter, use the Offset Track checkbox. For more information on using the Offset Track 
parameter, see Track obscured or off-frame points.

5.	 Do any of the following:

•	 Track an area of the clip: In the canvas, drag the object tracker to the reference 
pattern you want to track. (To better see the reference pattern, turn off the filter in 
the Layers list.)

•	 Track a suggested subject in the clip: Press and hold the Option key, then drag 
over elements in the canvas. As you drag, bounding boxes appear over elements 
and elliptical shapes appear over faces, suggesting regions of interest that may be 
trackable.

When you release the mouse button over the element you want to track, the object 
tracker conforms to the subject.

•	 Track a face in the clip: In the Behaviors Inspector, click the Detect pop-up menu, 
then choose Faces. Onscreen controls appear around any faces detected in the 
frame. When you click the onscreen control for the face you want to track, the object 
tracker conforms to the subject.

Note: A subject identified in a clip isn’t necessarily trackable; it’s a potential region 
of interest in the scene that the machine learning model recognizes.

6.	 If necessary, change the shape or size of the object tracker.
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7.	 In the Behaviors Inspector, click the Analysis Method pop-up menu, then choose one of 
the following options:

•	 Automatic: Automatically chooses the most suitable analysis method. Because the 
best method is highly dependent on the properties of a clip and each use case, you 
may need to experiment with different analysis methods to achieve the best result.

•	 Combined: Uses a combination of the Machine Learning and Point Cloud analysis 
methods (described below) to track position, scale, and rotation.

•	 Machine Learning: Uses a machine learning model trained on a dataset to identify 
people, animals, and many other common objects, allowing the tracker to follow the 
subject in a specified region of video. Choose this option when absolute tracking 
precision isn’t required, such as when attaching titles or graphics to objects or 
people. This method can overcome moderate occlusion—when an object (such as a 
tree or car) briefly obscures the subject being tracked.

•	 Point Cloud: Tracks a specific reference pattern and identifies how the pattern 
transforms from one frame to the next. Choose this option when you need more 
precise tracking of specific pixels. This method tracks position, scale, and rotation, 
and excels at tracking regions that are rigid and somewhat flat (from the camera’s 
point of view).

Note: You can use different tracking analysis methods over different ranges of 
frames (in the same clip).

8.	 In the Behaviors Inspector, do one of the following:

•	 Analyze the entire clip: Click Analyze. The clip is analyzed forward from the playhead 
position to the end of the clip (or to the frame where the reference pattern can no 
longer be tracked), and then backward from the playhead position to the start of the 
clip.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

The tracking analysis progress window displays the analysis method used for the track.

 Tip: If you’re using the Machine Learning analysis method and observe jitter 
during the analysis (the onscreen object tracker bouncing or jumping from one size 
to another), try switching to the Point Cloud analysis method. Its tracker is much less 
susceptible to quick changes. 
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9.	 To stop the tracking analysis, click the Stop button in the progress window or press Esc.

Tracking keyframes appear in the Keyframe Editor. If the Keyframe Editor is not visible, 
click the Show/Hide Keyframe Editor button in the lower-left corner of the Motion window.

In addition to the tracking keyframes, a confidence curve is displayed in the Keyframe 
Editor. This curve provides a visual indication of the tracker’s accuracy relative to its 
parameter settings in the Inspector. The confidence curve is for reference only and is 
not used for editing purposes.

The filter’s center is tracked to the clip. You can make changes to the filter parameters 
after the analysis is performed. The Track parameter behavior can also use existing 
tracking data recorded by another tracking behavior.

Track the position parameter of a filter to points or patterns in a source clip
1.	 In Motion, follow steps 1–4 in the above task.

2.	 In the Behaviors Inspector, click the Mode pop-up menu, then choose Point.

The onscreen tracker changes to a point tracker.

3.	 In the canvas, drag the point tracker to the reference point you want to use.

4.	 In the Behaviors Inspector (or HUD), do one of the following:

•	 Analyze the clip forward from the position of the playhead: Click Analyze.

•	 Analyze the portion of the clip before the playhead position: Click the left arrows 
next to the Analyze button.

•	 Analyze the portion of the clip after the playhead position: Click the right arrows 
next to the Analyze button.

When the tracking analysis begins, a progress window opens and points appear on a 
motion path in the canvas.
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5.	 To stop a track analysis, click the Stop button in the progress window or press Esc.

The points in the canvas correspond to the tracking keyframes that appear in the 
Keyframe Editor. If the Keyframe Editor is not visible, click the Show/Hide Keyframe 
Editor button in the lower-left corner of the Motion window.

A confidence curve is also displayed in the Keyframe Editor. This curve provides a visual 
indication of the tracker’s accuracy relative to its parameter settings in the Inspector. 
The confidence curve is for reference only and is not used for editing purposes.

Apply tracking data to the position or anchor point of an object
Using the Track behavior, you can apply existing tracking data to the Position or Anchor 
Point parameters of an object.

Important: Before you can apply tracking data to an object’s parameters, your project must 
contain a tracking behavior (such as Analyze Motion) that has analyzed a clip.

1.	 In the Layers list in Motion, select the object that you want to apply the tracking data to.

2.	 In the Properties Inspector, do either of the following:

•	 Control-click the Position (or Anchor Point) parameter, then choose Add Parameter 
Behavior > Track.

•	 Click the Position (or Anchor Point) parameter’s Animation menu (the down arrow 
that appears when you move the pointer over the right side of a parameter row), 
then choose Add Parameter Behavior > Track.
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3.	 In the Behaviors Inspector, click the Action pop-up menu (with the gear icon), then 
choose a tracking behavior.

Tracking data from the selected behavior in the project is applied to the Position (or 
Anchor Point) parameter.

4.	 To quickly reassign the tracking data from the Position parameter to the Anchor Point 
parameter (or vice-versa), click “To” in the Apply To row (in the Behaviors Inspector), 
choose Properties > Transform, then choose Position or Anchor Point.

For a full description of adjustable controls in the Track behavior, see Track controls.

Adjust onscreen trackers in Motion
The Analyze Motion, Match Move, and Track behaviors use onscreen trackers that you can 
position and adjust to better analyze an area of pixels (a reference pattern) in a clip.

Adjust the object tracker
1.	 Select a tracking behavior in the Layers list in Motion.

2.	 In the Behaviors Inspector, make sure the Mode pop-up menu is set to Object.

3.	 Do any of the following:

•	 Adjust the object tracker in the canvas: Drag a size handle, roundness handle, or 
rotation handle. To reposition the tracker, drag inside of it.

To resize the tracker uniformly, press and hold the Shift key while dragging a size 
handle.
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•	 Adjust the object tracker from the Behaviors Inspector: Drag the Curvature, Position, 
Rotation, or Scale control.

•	 Automatically identify potential subjects of interest: While pressing and holding the 
Option key, drag the object tracker in the canvas. As you Option-drag, bounding 
boxes appear over elements in the clip, and oval shapes appear over faces.

4.	 To show or hide the onscreen tracker, do either of the following in the Behaviors 
Inspector:

•	 Show or hide the grid lines: Select or deselect the Show Grid checkbox.

•	 Show or hide the entire tracker: Select or deselect the Shape checkbox.

Adjust the point tracker
1.	 Select a tracking behavior in the Layers list in Motion.

2.	 In the Behaviors Inspector, click the Mode pop-up menu, then choose Point.

The onscreen point tracker is a crosshair in a circle.

The default point tracker colors are red (when unselected) and yellow (when selected). 
If necessary, you can change the color of the tracker.
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3.	 Do either of the following:

•	 Reposition the point tracker in the canvas: Drag the crosshair in the canvas. As you 
drag, a magnified inset shows the tracker’s position and an info window displays the 
tracker coordinates.

•	 Reposition the point tracker from the Behaviors Inspector: Drag in the Tracker 
Preview area or move the pointer over a track row (labeled “Track 1,” “Track 2,” and 
so on), click Show, then drag the Position controls.

4.	 To adjust the search size of the point tracker in the Behaviors Inspector, do one of the 
following:

•	 Option-drag left in the Tracker Preview area to reduce the size of the search pattern 
in the canvas, and Option-drag right to increase the pattern search size.

•	 Move the pointer over the parameter row of the track you want to modify, click Show, 
then drag the Track Size slider.

5.	 To remove a point tracker, click Remove in the parameter row of the track.
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Move multiple point trackers at the same time
•	 In the Motion canvas, drag a selection rectangle over multiple trackers, then drag the 

selection to a new position.

Selected point trackers appear yellow.

Turn off onscreen point trackers
In Motion, do one of the following:

•	 Control-click a point tracker in the canvas, then choose Hide Selected Tracker.

If there are multiple point trackers, you can choose to hide the selected point tracker or 
to hide the other point trackers.

•	 In the Behaviors Inspector, deselect the relevant Track checkbox.

When a point tracker is deselected, it’s not used in the analysis.

Change the color of the onscreen point tracker
1.	 In the Behaviors Inspector, move the pointer over the parameter row of the track you 

want to modify, then click Show.

2.	 Adjust the Color controls.

See Use basic color controls.
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Load existing tracking data in Motion
If you’ve already recorded tracking data (using the Analyze Motion behavior, for example), 
you can load that data into a Match Move, Stabilize, or Unstabilize behavior in your project. 
Likewise, if your project contains animation (keyframes or an applied behavior), you can 
load that animation data into a tracking behavior. Motion data from one object is applied to 
another object in your project.

1.	 In the Layers list in Motion, select an object to receive tracking or animation data.

2.	 Click Behaviors in the toolbar, choose Motion Tracking, then choose Match Move, 
Stabilize, or Unstabilize.

The new tracking behavior is added to the Layers list, under the selected object. 
If your project already contains tracking data or animation data (from an Analyze 
Motion behavior or from keyframed animation, for example), that data is automatically 
applied to the new behavior (when the new behavior is above the object with tracking 
or animation data in the Layers list). The source of the data appears in the Behaviors 
Inspector (in the Source well).

If the Source well is empty, you must manually apply tracking or animation data, as 
described in the next step.

3.	 To manually apply tracking data to the new behavior, do one of the following:

•	 In the Behaviors Inspector or HUD, click the Action pop-up menu (with a gear), then 
choose a new source for tracking data.

•	 From the Layers list, drag a tracking behavior, footage with tracking data, or an 
animated object to the Source well in the Behaviors Inspector or HUD.

•	 In the Layers list drag a tracking behavior, footage with tracking data, or an animated 
object onto the new tracking behavior in the Layers list. 

Tracking or animation data is applied to the new behavior, and the source of that data (a 
video clip or animated object) appears in the Source well in the Behaviors Inspector or 
HUD.

Note: To clear a Source well, drag the item away from the well, then release the mouse 
button.
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Specify a portion of a clip for analysis in Motion
With the exception of the Stabilize behavior, the tracking behaviors begin their analysis at 
the current playhead position. You can specify a range of frames to be analyzed by setting 
In and Out points for the clip, or by trimming the tracking behavior in the Timeline or mini-
Timeline.

Change the In point of the tracking behavior
In Motion, do one of the following:

•	 Drag the playhead to the frame where you want the tracking analysis to begin, select 
the clip in the Layers list, then choose Mark > Mark Play Range In (or press Option-
Command-I).

•	 In the Timeline, drag the left edge of the tracking behavior’s purple bar to the frame 
where you want the tracking analysis to begin.

Change the Out point of the tracking behavior
In Motion, do one of the following:

•	 Position the playhead at the frame where you want the tracking analysis to end, select 
the clip, then choose Mark > Mark Play Range Out (or press Option-Command-O).

•	 In the Timeline, drag the right edge of the tracking behavior’s purple bar to the frame 
where you want the tracking analysis to end.
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Guidelines for better tracking

Intro to tracking guidelines in Motion
Selecting a good tracking reference pattern in a clip or image sequence is crucial to 
achieving accurate tracking results. However, due to myriad differences in source clips, 
tracking in one pass rarely yields perfect results. More often, a successful track combines 
automatic and manual tracking, experimenting with parameter settings (such as the Point 
or Object tracking modes and the Point Cloud or Machine Learning analysis modes), and 
resetting reference points at various locations in the clip.

Additionally, a successful track may employ more advanced techniques, such as smoothing 
a track curve or converting tracking data to modifiable animation curves in the Keyframe 
Editor, or manually coaxing your tracking analysis.

See the following topics to improve your tracking results:

•	 Basic tracking strategies

•	 Advanced tracking strategies

•	 Track perspective, scale, or rotational shifts

•	 Track obscured or off-frame points

•	 Tracking retimed footage

•	 Use masks with tracking behaviors

Basic tracking strategies in Motion
Use the following basic techniques to improve your tracking results.

Find a good reference pattern
•	 In Motion, play the footage several times to locate a reference pattern that:

•	 Is in focus

•	 Contains perpendicular edges, such as dots, intersections, and corners (avoid lines 
and straight boundaries)

•	 Is a high-contrast pattern

•	 Contains smooth or even changes in brightness or color (for example, avoid sharp-
edged shadows that pass over your reference pattern)

•	 Appears in every frame of the clip (does not move offscreen or become obscured by 
other objects)

•	 Is distinct from other patterns in the same region in the clip
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Manually modify track points or tracking keyframes in the canvas
In Point mode tracking, you can drag an individual point on a post-analysis motion path in 
the canvas to adjust its position. Although Object mode tracking doesn’t create onscreen 
track points, you can also drag the object tracker in the canvas to adjust its position.

Adjusting a track point or object tracker in the canvas also updates the tracking keyframes 
in the Keyframe Editor.

1.	 In Motion, position the playhead at the frame you want to modify.

2.	 Do one of the following:

•	 Modify a track point in Point mode: Drag the highlighted track point in the canvas to 
adjust its position.

•	 Modify a track keyframe in Object mode: Drag the object tracker in the canvas to 
adjust its position.

You can also adjust a tracking curve in the Keyframe Editor. See Modify keyframes in the 
Keyframe Editor.

Delete bad keyframes in the Keyframe Editor
When an analysis is complete, you might need to reanalyze a portion of the clip. Rather 
than recording over bad tracking keyframes (for example, keyframes where the tracker lost 
its reference pattern), delete bad keyframes before reanalyzing. If bad keyframes are not 
deleted, the tracking behavior may continue to use the old reference point.

1.	 In Motion, position the playhead at the frame where you want to reanalyze the reference 
pattern.

2.	 In the Keyframe Editor, drag a selection rectangle around the keyframes you want to 
delete.

If the Keyframe Editor is not visible, click the Show/Hide Keyframe Editor button on the 
right side of the timing toolbar.

3.	 Control-click in the Keyframe Editor, then choose Cut from the shortcut menu (or press 
Delete).

4.	 In the canvas, drag the tracker to the reference point, then click Analyze.

New track keyframes are created.



1211Motion User Guide

Delete bad track points in the canvas
In Point mode tracking, you can delete bad track points (for example, at points where the 
tracker lost its reference pattern) during or after analysis.

Note: Track points in the canvas correspond to keyframes in the Keyframe Editor.

1.	 In the canvas toolbar in Motion, make sure the Adjust Item tool is selected.

You can zoom into the canvas to better see the active track points. The track point at 
the current playhead position appears larger than other track points.

2.	 Do one of the following:

•	 Press Delete to delete the track point at the current position of the playhead. (If you 
press Delete when a track point is not selected, the entire path is deleted.)

•	 Move the playhead to the frame where you want to begin deleting track points, and 
press Delete.

Each press of the Delete key removes one track point. Only active track points are 
deleted.

 Tip: The direction in which track points are deleted is determined by the Reverse 
checkbox in the Behaviors Inspector. When Reverse is deselected, each track point 
you delete moves the playhead toward the beginning of the clip. When Reverse is 
selected, each track point you delete moves the playhead toward the end of the clip.
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Ask Motion for a hint
In Point mode tracking, you can have Motion display suggested tracking points. You need 
at least one point tracker in the canvas to display suggested tracking reference points.

•	 In Motion, press and hold the Option key, place the pointer over a point tracker in the 
canvas, then press and hold the mouse button.

The suggested reference points appear in the canvas and in the magnified inset as 
small red crosshairs.

When you move a point tracker toward a suggested point, the tracker snaps to the 
point. The suggested points are not necessarily ideal tracking reference points for the 
feature you want to track in the clip. Motion merely picks locations in the current frame 
that meet the reference pattern criteria, such as an area of high contrast.

Sharpen a clip’s reference area
A sharp, high-contrast pattern can provide a good tracking reference area. You may be 
able to sharpen the reference pattern of a clip by applying a filter to a clip before tracking. 
The tracker analyzes the clip, but not the result of a filter applied to the clip.

1.	 In Motion, apply the Sharpen filter to the clip and adjust its parameters in the Filters 
Inspector.

2.	 Export the clip, reimport the clip into your project, then delete or disable the original 
(exported) clip.

3.	 Perform your tracking operation again.

Because the tracker analyzes the clip, not the result of a filter applied to the clip, the clip 
must be exported and reimported to your project.
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Advanced tracking strategies in Motion
In Motion, use the following advanced techniques to improve your tracking results.

Apply different tracking analysis methods to a clip
In Object mode tracking, if your chosen tracking analysis method (such as Point Cloud) 
works well only on portions of a clip, you can instruct the tracker to use a combination of 
analysis methods on the clip.

1.	 In a Motion project with an applied Analyze Motion, Match Move, or Track behavior (and 
the Mode pop-up menu set to Object), move the playhead to the frame where you want 
to start the first analysis.

2.	 In the canvas, position the object tracker on the subject or reference pattern you want 
to track (see steps 3–4 in Analyze movement in a clip using Object tracking mode).

3.	 In the Behaviors Inspector, click the Analysis Method pop-up menu, then choose the 
Automatic, Combined, Machine Learning, or Point Cloud option.

4.	 In the Behaviors Inspector, click Analyze.

When the tracking analysis begins, a progress window opens and displays the analysis 
method used for the track.

5.	 When the analysis reaches the frame in which you want to change analysis methods, 
click Stop.

6.	 Repeat steps 3–5, choosing different analysis methods.

Smooth a track curve in the Keyframe Editor
You can smooth a track with the Keyframe Thinning function. Before smoothing the curve, 
you might want to copy the behavior (as a backup) to the Library or duplicate the behavior 
in the project. See Save custom objects to the Library.

In the following graph, there’s a keyframe at every frame, and the curve is somewhat 
jagged. The following example shows how you can simplify and smooth this curve.
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1.	 In the parameter list of the Keyframe Editor in Motion, move the pointer over the 
parameter you want to smooth; when the down arrow appears on the right, click it and 
choose Reduce Keyframes.

The Reduce Keyframes dialog appears.

The Reduce Keyframes dialog applies a thinning algorithm to the keyframes for the 
parameter, reducing the number of keyframes while attempting to maintain a similar 
curve shape.

2.	 Adjust the sliders to smooth the curve:

•	 Error Tolerance: Drag right to reduce the number of keyframes used in the curve.

•	 Smoothing (frames): Drag right to create smoother curves between keyframes. 

The Smoothing (frames) control modifies the curve by calculating the average of each 
track point plus its neighboring track points. In other words, if you set Smoothing 
(frames) to 5, when the value of frame 12 is computed, frames 10, 11, 12, 13, and 14 
are considered. If Smoothing (frames) is set to 3, the algorithm uses frames 11, 12, and 
13. The larger the Smoothing value, the more points are considered (and thus more 
calculations done) for every point in the curve.

As you adjust the sliders in the dialog, the curve is modified in the Keyframe Editor.

3.	 Click OK.



1215Motion User Guide

Apply an Average parameter behavior to a track curve
You can apply the Average parameter behavior to a track curve in the Keyframe Editor to 
smooth the transition from one keyframe value to another. Averaged motion moves more 
fluidly.

•	 In the parameter list of the Keyframe Editor in Motion, control-click the name of the 
keyframed parameter, then choose Average from the shortcut menu.

The track is averaged, and its curve is simplified in the Keyframe Editor.

See Average behavior.

Convert motion tracks to keyframes
If your motion track includes problem tracking points (such as points where the Confidence 
value is low), you can “bake” the tracking data recorded or referenced by the Match Move, 
Stabilize, or Unstabilize behavior into keyframes on the transformed object.

Because the Analyze Motion behavior does not transform the image, analyzed tracks 
cannot be converted into keyframes. However, a Match Move or Stabilize behavior that 
references data from an Analyze Motion behavior can be converted into keyframes.

1.	 In the Layers list in Motion, select the Match Move, Stabilize, or Unstabilize behavior to 
convert.

2.	 Choose Object > Convert to Keyframes (or press Command-K).

A dialog appears confirming the conversion.

3.	 Click Convert.

The tracking keyframes are applied to the tracked object, and the tracking behavior is 
deleted. You can now modify the animation curves in the Keyframe Editor.

See Convert behaviors to keyframes and Modify keyframes in the Keyframe Editor.

Define look-ahead frames
In Point mode tracking in the Analyze Motion behavior, you can direct a tracker where to 
look in a later frame for its reference pattern. This tool is ideal for the following types of 
clips:

•	 Clips that contain fast-moving features

•	 Clips with subjects moving in a relatively straight vector (with or without obstructions)

•	 Clips with swish pans (you may need to reset the “look-ahead” tracker at each panning 
change)

Important: If your track fails and you reposition your point tracker, you must also reset the 
look-ahead tracker in the canvas to provide a new motion vector from the new reference 
point.
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1.	 In Motion, apply an Analyze Motion behavior to a clip.

2.	 In the canvas, position the point tracker on a reference pattern.

In the following image, the point tracker is positioned on a reference pattern on the 
front of the kayak.

3.	 In the Behaviors Inspector, adjust the Look Ahead Frames slider to specify how many 
frames you want the tracker to look ahead.

Note: The maximum default for the Look Ahead Frames slider is 10 frames. However, 
you can enter a larger frame amount using the adjacent value slider.

4.	 Press and hold the Command key, then drag the point tracker in the canvas in the 
direction the reference pattern is moving in the clip.

As you Command-drag the track point, a magnified inset displays the frame specified in 
the Look Ahead Frames parameter.

5.	 When the look-ahead tracker is positioned on the reference pattern, release the mouse 
button.

When you click the Analyze button, the new reference point is used as the tracking 
pattern.

Important: If your track fails and you reposition your tracker, you must also reset the 
look-ahead tracker in the canvas to provide a new motion vector from the new reference 
point.
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Manually coax a motion track using keyframes
You can manually insert track position keyframes to help guide the tracker toward a 
reference pattern for challenging tracks. For example, if you have footage with significant 
motion blur or objects that partially obscure the tracking pattern, you can manually create 
tracker position keyframes to help guide the tracker.

1.	 In Motion, apply a Motion Tracking behavior to the clip, then press A to enable keyframe 
recording.

2.	 In the canvas, drag the tracker to the reference point you want to track.

A track position keyframe is created in the behavior (visible in the Keyframe Editor).

3.	 Navigate to the next frame where you want to create a keyframe.

You can press Shift-Right Arrow to jump forward ten frames or press Shift-Left Arrow to 
jump backward ten frames.

4.	 In the canvas, position the tracker at the reference point you want to track.

5.	 Repeat steps 3–4 until you’ve completed the track.

If you’re using Object mode tracking, skip to step 7.

6.	 If you’re using Point mode tracking, do the following:

a.	 In the Behaviors Inspector, move the pointer over the row of the track you manually 
adjusted, then click Show.

b.	 Click the Fail Behavior pop-up menu, then choose Use Existing Keyframes.

c.	 Press A again to turn off keyframe recording.

7.	 Go to the first frame of the clip, then click Analyze in the Behaviors Inspector.

The object tracker analyzes the frames from the first frame of the clip to the next 
manual keyframe. The point tracker analyzes all frames, retaining the manual 
keyframes.

Manually coax a motion track without using keyframes
1.	 In Motion, apply a Motion Tracking behavior to the clip.

2.	 In the canvas, drag the tracker to the reference point you want to track.

3.	 Choose Object > Add Position Keyframe.

This command is available for the Analyze Motion, Match Move, Stabilize (when you use 
manual trackers), Track Points, and Track behaviors.

Note: Keyframes cannot be created for automatically stabilized footage. Use the Track 
Region option for adjusting automatic stabilization, or convert the stabilized footage to 
keyframes. For more information on the Track Region parameter, see Stabilize a shaky 
clip. For more information on converting tracking data to keyframes, see Convert motion 
tracks to keyframes above.

4.	 Navigate to the next frame where you want to create a keyframe.

5.	 Repeat steps 2–4 until you’ve completed the track.

If you’re using Object mode tracking, skip to step 7.
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6.	 If you’re using Point mode tracking, do the following:

a.	 In the Behaviors Inspector, move the pointer over the row of the track you manually 
adjusted, then click Show.

b.	 Click the Fail Behavior pop-up menu, then choose Use Existing Keyframes.

7.	 Go to the first frame of the clip, then click Analyze in the Behaviors Inspector.

The object tracker analyzes the frames from the first frame of the clip to the next 
manual keyframe. The point tracker analyzes all frames, retaining the manual 
keyframes.

Track perspective, scale, or rotational shifts in Motion
For clips that undergo significant changes in size and camera angle, you can try a few 
different strategies. 

Use a larger search area
•	 To resize the object tracker, see Adjust the object tracker.

•	 To resize the point tracker, see Adjust the point tracker.

Lower the Fail Tolerance value
In Point mode tracking, you can adjust the tracker’s fail behavior. With a lower Fail 
Tolerance value, the tracker is more likely to find a false match. With a higher value, the 
tracker is more strict in finding a match.

•	 In the Behaviors Inspector in Motion, move the pointer over the track row, click Show to 
display the Fail Tolerance parameter, then decrease its value.

Track obscured or off-frame points in Motion
In addition to experimenting with tracker parameter settings, there’s a basic technique to 
correct track points that become obscured by moving offscreen or by an object passing in 
front of them.

When a reference pattern becomes obscured, use the Offset Track checkbox to move 
the tracker, picking a new reference pattern in a different area from the original reference 
pattern. The offset between the original reference pattern and the new pattern is 
calculated to maintain continuity in the resulting track path. Even though one region is 
examined, the points are saved in another region. The second tracking pattern should 
travel in the same direction as your original pattern.

Offset (move) the onscreen tracker to an unobstructed area of the image
1.	 In Motion, move the playhead to the frame where you want to begin the offset track.

When a track is lost during an analysis, Motion jumps back to the frame where the track 
failed. The bad track point is usually identified by an “x” in the canvas.
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2.	 Select the Offset Track checkbox in the Behaviors Inspector or HUD.

Note: Offset Track is available in the Analyze Motion, Match Move, Stabilize, Track 
Points, and Track behaviors. Before the parameter becomes available in the Stabilize 
behavior, you must manually add a tracker using the Add button in the Inspector.

3.	 In the canvas, drag the tracker to a new, unobscured reference pattern.

4.	 Click Analyze to restart the motion analysis.

Motion continues to analyze the trajectory of the original track point, based on the 
movement of the new offset reference pattern.

 Tip: When you use the Offset Track feature, make sure that the new reference 
pattern is as close to the original reference pattern as possible. Ideally, the offset 
reference pattern should share the same motion as the original reference pattern.

Tracking retimed footage in Motion
When working in a project that combines tracking behaviors and retiming operations, use 
the following guidelines for more successful results:

•	 Because the Motion tracker analyzes in a project’s frame rate, ensure that the frame 
rate of the footage you plan to track matches the frame rate of your project. For 
example, to track 24 frames-per-second (fps) footage, your project’s frame rate should 
be 24 fps. When the tracking analysis is completed, retime the clip using the Retiming 
parameters in the Media list or by using the Retiming behaviors.

•	 Do not retime the footage before the tracking analysis.

•	 Do not retime the footage, perform a tracking analysis, then retime the footage again. 
This may adversely affect your tracking analysis.

Note: To track the motion of a clip after it’s retimed, export the retimed clip, then import it 
back into your project before you perform the tracking analysis.
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Use masks with tracking behaviors in Motion
When you add a mask to an object that has applied tracking data, the data is applied to the 
mask. In the following image, a destination object is tracked to four points on a source clip 
(with a Match Move behavior using data from an Analyze Motion behavior), then is masked 
to fit into the picture frame.

By masking the image being tracked, you can include only the portion of the image you 
want to fit in the frame.

Although the mask is attached to the destination object, you might need to animate 
changes in the mask’s position and scale to accommodate changes in the source clip 
over time.

Note: As an alternative to using masks, you can also crop an object with applied tracking 
data using Crop controls in the Properties Inspector.

You can also track the control points of a mask to a clip or apply existing tracking data to 
the control points of a mask. See Track shapes, masks, and paint strokes.
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Tracking behavior controls

Analyze Motion controls in Motion
The Analyze Motion behavior analyzes and stores tracking data from a video clip or image 
sequence but does not transform the tracked footage. Analyze Motion data tracks are 
meant to be referenced by the Match Move, Stabilize, Track Parameter, and Track Shape 
behaviors.

After you apply an Analyze Motion behavior to an object in your project, adjust the behavior 
using the parameter controls in the Behaviors Inspector:

•	 Analyze: Three buttons used for the motion tracking analysis:

•	 Left arrows: Analyzes the portion of the clip before the playhead position.

•	 Analyze: Analyzes the entire clip forward from the playhead position to the end of 
the clip (or to where the reference pattern can no longer be tracked), then backward 
from the playhead position to the beginning of the clip.

•	 Right arrows: Analyzes the portion of the clip after the playhead position.

The start frame of the track analysis is based on the current playhead position, 
rather than the beginning of the behavior bar in the Timeline.

•	 Mode: A pop-up menu to choose the tracking analysis mode. There are two options:

•	 Object: Choose to track subjects such as people or faces, pets, cars, or other 
reference patterns using machine learning or point cloud analysis methods, or a 
combination of both.

•	 Point: Choose to track one or more specific points—or a very specific feature—in a 
clip.

•	 Analysis Method: Available when Mode is set to Object, a pop-up menu to set how the 
selected reference pattern is analyzed. There are four options:

•	 Automatic: Evaluates the clip, then attempts to select the most suitable analysis 
method.

•	 Combined: Uses a combination of the Machine Learning and Point Cloud analysis 
methods to track position, scale, and rotation.

•	 Machine Learning: Uses a machine learning model trained on a dataset to identify 
people, animals, and many other common objects, allowing the tracker follow the 
subject in a specified region of video.

•	 Point Cloud: Analyzes a “cloud” of point positions (or a pattern) within a search 
region.

•	 Detect: Available when Mode is set to Object, a pop-up menu to turn automatic face 
detection on or off.

•	 Show Grid: Available when Mode is set to Object, a checkbox that shows or hides the 
grid in the onscreen object tracker.
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•	 Shape: Available when Mode is set to Object, a group of controls used to adjust the 
onscreen object tracker:

•	 Curvature: A slider to increase or decrease the roundness of the object tracker.

•	 Position: Value sliders to adjust the position of the object tracker.

•	 Rotation: A dial to adjust the rotation of the object tracker.

•	 Scale: A slider to adjust the size of the object tracker.

•	 Tracker: Available when Mode is set to Point, a row that contains an Add button to add 
onscreen trackers.

•	 Tracker Preview: Available when Mode is set to Point, a preview providing a magnified 
view of the tracking reference area for a selected tracker. The preview updates as you 
adjust the position of the tracker in the canvas. You can also drag in the preview area to 
adjust the position of the tracker. When you do so, the image in the preview area moves 
around the red crosshair representing the tracker, and the tracker moves in the canvas. 
You can also Option-drag left or right in the preview area to decrease or increase the 
size of the reference pattern to be analyzed in the canvas. (Alternatively, you can adjust 
the Track Size slider, described below, to achieve the same result.)

•	 Offset Track: A checkbox that, when selected, lets you set a new tracker position when 
the original reference pattern becomes temporarily obstructed by an obstacle, or goes 
off the screen. Motion uses the tracker position to continue the same tracking path 
begun by the original reference pattern. For more information on offset tracking, see 
Track obscured or off-frame points.

•	 Auto-Zoom: Available when Mode is set to Point, a pop-up menu to choose a 
magnification level when positioning the tracker in the canvas. You can zoom in on the 
canvas when searching for an ideal tracking reference pattern. There are five options: 
None, 2x, 4x, 8x, and 16x.

•	 Auto-Zoom Mode: Available when Mode is set to Point, a pop-up menu to set the 
display of the auto-zoomed tracker in the canvas. There are three options:

•	 Normal: Displays a normal pattern.

•	 Contrast: Displays the tracker pattern with contrast detection.

•	 Edge: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the canvas and does not affect the 
Tracker Preview in the Behaviors Inspector.

Note: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.

•	 Look Ahead Frames: Available when Mode is set to Point, a slider and value slider to 
specify the number of future frames to be analyzed by the tracker. In other words, you 
can direct the tracker to look in a specific location for its reference point, which helps 
the tracker follow fast-moving objects. For more information about the Look Ahead 
Frames control, see Advanced tracking strategies.
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•	 Track 1, Track 2, and so on: Available when Mode is set to Point, a list displaying the 
trackers in the behavior. To disable a tracker, deselect its checkbox. (Disabled trackers 
are not analyzed.) To remove a tracker, click its adjacent Remove button. To expose the 
following additional track controls, move the pointer over the track row, then click Show:

•	 Position: Value sliders displaying the X and Y positions of the tracker.

•	 Track Size: A slider to set (in pixels) the pattern search size for the tracker. As you 
adjust the tracker size, the Tracker Preview is updated to show the new pattern 
search size. However, there’s no visual change in the onscreen tracker.

Alternatively, you can adjust the Track Size parameter by Option-dragging left or 
right in the Tracker Preview area. 

•	 Search Size: A slider to set search area size for the tracker. In Motion, you do not 
specify the size of a search area when setting up trackers in the canvas. If your clip 
contains a lot of rapid movement, you may have better results increasing the Search 
Size. For example, if Search Size is set to 150%, the tracker searches 50% further 
beyond the Track Size setting.

•	 Fail Tolerance: A slider to set the amount of tolerance for error, or confidence value, 
of the tracker. In other words, Fail Tolerance defines a threshold score at which the 
tracker determines it can match a reference feature. When the analysis yields a 
score above the Fail Tolerance value, the tracker accepts the match. When the score 
is below the value, the tracker rejects the match.

•	 Fail Behavior: A pop-up menu to specify what happens if the track confidence value 
falls below the Fail Tolerance amount. There are six menu options:

•	 Smart Retry: The tracker attempts to find the reference pattern in a larger search 
area. If the pattern still cannot be found, the tracker switches to the Predict 
option (described below). Smart Retry is the default Fail Behavior setting.

•	 Stop: The analysis stops when the tracker loses the reference pattern. 

•	 Predict: The tracker predicts a new search area without creating keyframes until 
it finds a match for the reference pattern. This option is excellent for tracked 
elements that pass behind foreground elements.

•	 Predict and Key: If a failure is detected, the tracker predicts the location of the 
next track point (keyframe) based on a vector of the last two keyframes and 
continues tracking in the new area.

•	 Don’t Predict: The tracker remains in its position and searches for subsequent 
matches as the clip’s frames progress. While searching for a match, the tracker 
does not create keyframes.

•	 Use Existing Keyframes: The tracker uses keyframes you have manually created 
as a guide. After manually adding keyframes, return to the start frame and start 
the tracking analysis. If the tracker has difficulty locating the reference pattern, 
the manually created tracking keyframes help guide the tracker.

•	 Color: A color control to set a new color for the onscreen tracker. The default tracker 
color is red. A selected tracker is yellow. When a tracker is being positioned, its 
center crosshair is yellow and the border of its magnified inset is the color set in the 
color well. To adjust individual color channels, including the tracker’s opacity, click 
the disclosure triangle. For more information about color controls, see Use basic 
color controls.
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Match Move controls in Motion
The Match Move behavior analyzes the movement of a source object (such as a video clip), 
then applies that movement data to a destination object (such as a shape, particle emitter, 
camera, or other object in Motion).

After you apply a Match Move behavior to an object in your project, adjust the behavior 
using the parameter controls in the Behaviors Inspector:

•	 Source: A well to specify the source object supplying tracking data to the destination 
object. The source object can be another tracking behavior, an animated object, or a 
video clip. When you apply a Match Move behavior to a destination object, the nearest 
animated object, recorded track, or footage object beneath the behavior in the Layers 
list appears in this well. If a source object isn’t automatically assigned, drag one from 
the Layers list into this well. To clear the Source well, drag its thumbnail away from the 
well and release the mouse button.

When you drag any nonfootage object (such as a shape or mask) into the Source well, 
the trackers are no longer available in the Match Move behavior as there is no clip to 
analyze. Whatever animation (keyframes or behaviors) is present in the shape or mask 
is applied.

Note: When you apply the Match Move behavior to a mask, the masked object is 
selected as the source.

•	 Action pop-up menu: A pop-up menu (with a gear icon) to manually assign tracking data 
(from other tracking behaviors in your project).

•	 Analyze: Three buttons used for the motion tracking analysis:

•	 Left arrows: Analyzes the portion of the clip before the playhead position.

•	 Analyze: Analyzes the entire clip forward from the playhead position to the end of 
the clip (or to where the reference pattern can no longer be tracked), then backward 
from the playhead position to the beginning of the clip.

•	 Right arrows: Analyzes the portion of the clip after the playhead position.

The start frame of the track analysis is based on the current playhead position, 
rather than the beginning of the behavior bar in the Timeline.

•	 Mode: A pop-up menu to choose the tracking analysis mode. There are two options:

•	 Object: Choose to track subjects such as people or faces, pets, cars, or other 
reference patterns using machine learning or point cloud analysis methods, or a 
combination of both.

•	 Point: Choose to track one or more specific points—or a very specific feature—in a 
clip.
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•	 Analysis Method: Available when Mode is set to Object, a pop-up menu to set how the 
selected reference pattern is analyzed. There are four options:

•	 Automatic: Evaluates the clip, then attempts to select the most suitable analysis 
method.

•	 Combined: Uses a combination of the Machine Learning and Point Cloud analysis 
methods to track position, scale, and rotation.

•	 Machine Learning: Uses a machine learning model trained on a dataset to identify 
people, animals, and many other common objects, allowing the tracker follow the 
subject in a specified region of video.

•	 Point Cloud: Analyzes a “cloud” of point positions (or a pattern) within a search 
region.

•	 Detect: Available when Mode is set to Object, a pop-up menu to turn automatic face 
detection on or off.

•	 Transform: A pop-up menu to set how the destination object moves. There are two 
options:

•	 Attach to Source: Anchors the destination object to the recorded track or animation 
source. Use Attach to Source when the source object is scaling or rotating, and you 
want the destination object to “stick” to a spot on the source object.

When using Point mode tracking, you can preserve preexisting animation in the 
source object by using the Adjust buttons (Position, Scale, and Rotation), available 
when the Type pop-up menu (described below) is set to Transformation.

Note: Although the destination object is “attached” to the movement of the source 
object, you can adjust the position of the destination object (offset it from the 
source object).

In the following example, the Match Move behavior is applied to the red pill shape 
and uses the animated white arrow as the source object. The white arrow has an 
applied Spin behavior that causes it to spin in a clockwise direction. Additionally, the 
arrow’s anchor point is positioned at the bottom of the arrow (at the opposite end 
from the tip).

When the Transform pop-up menu is set Attach to Source, and you select the 
Position and Rotation buttons in the Adjust parameter row, the red shape is anchored 
to one spot on the arrow (the tip, in this example) and matches the clockwise 
movement of the arrow.
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•	 Mimic Source: Allows the destination object to “mimic” the recorded track or 
animation of the source object.

When using Point mode tracking, you can preserve preexisting animation in the 
destination object by using the Adjust buttons (Position, Scale, and Rotation), 
available when the Type pop-up menu (described below) is set to Transformation.

Note: Although the destination object is “attached” to the movement of the source 
object, the position of the destination object can be changed (offset from the source 
object). Additionally, the destination object can be scaled and rotated.

In the following images, the Transform pop-up menu is set to Mimic Source, and 
Position and Rotation are selected in the Adjust parameter row. The red shape is not 
locked to one spot on the white arrow. Instead, the red shape mirrors the arrow’s 
animation.

•	 Adjust: Three buttons to set the type of transformation applied to the destination 
object.

•	 Position: Applies the position of the source object to the destination object.

•	 Scale: Applies the scale of the source object to the destination object. The source 
track must include scale data for this parameter to have any effect.

•	 Rotation: Applies the rotation of the source object to the destination object. The 
source track must include rotation data for this parameter to have any effect.

•	 Scale Mode: Sets how changes in the source object’s scale are applied to the 
destination object. This parameter is available when Scale is turned on in the Adjust 
parameter row.

Note: Scale Mode is only available when the Mode parameter is set to Object. See 
Match move a destination object to a source object in a clip.

•	 Scale All (Fit): Uniformly scales the maximum size of the destination object to the 
minimum dimension of the tracker region.

•	 Scale All (Fill): Uniformly scales the minimum size of the destination object to the 
maximum dimension of the tracker region.

•	 Scale X & Y: Nonuniformly scales the destination object based on the dimension of 
the tracker region.
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•	 Offset Track: A checkbox that, when selected, lets you set a new tracker position when 
the original reference pattern becomes temporarily obstructed by an obstacle, or goes 
off the screen. Motion uses the tracker position to continue the same tracking path 
begun by the original reference pattern. See Track obscured or off-frame points.

•	 Show Grid: Available when Mode is set to Object, a checkbox that shows or hides the 
grid in the onscreen object tracker.

•	 Shape: Available when Mode is set to Object, a group of controls used to adjust the 
onscreen object tracker:

•	 Curvature: A slider to increase or decrease the roundness of the object tracker.

•	 Position: Value sliders to adjust the position of the object tracker.

•	 Rotation: A dial to adjust the rotation of the object tracker.

•	 Scale: A slider to adjust the size of the object tracker.

•	 Type: Available when Mode is set to Point, a pop-up menu to set the type of point 
tracking used in the analysis. There are two options:

•	 Transformation: Enables one-point (position) tracking or two-point (position, scale, 
and rotation) tracking, transforming the destination object.

•	 Four Corners: Enables four-point tracking, corner-pinning the destination object. 
When Type is set to Four Corners, the Direction and Adjust parameters (described 
below) are no longer available.

Note: When you apply the Match Move behavior to a 3D group or to a mask, the 
Four Corners option is not available. To corner-pin a 3D group, select the Flatten 
checkbox in the Group Inspector.

•	 Direction: Available when Mode is set to Point, a pop-up menu to specify the dimension 
in which the recorded movement is applied to the destination object: Horizontal and 
Vertical (X and Y), Horizontal (only X), or Vertical (only Y).

•	 Tracker Preview: Available when Mode is set to Point, a preview providing a magnified 
view of the tracking reference area for a selected tracker. The preview updates as you 
adjust the position of the tracker in the canvas. You can drag in the preview area to 
adjust the position of the tracker. When you do so, the image in the preview area moves 
around the red crosshair representing the tracker, and the tracker moves in the canvas. 
You can also Option-drag left or right in the preview area to decrease or increase the 
size reference pattern to be analyzed in the canvas. (You can also adjust the Track Size 
slider, described below, to achieve the same result.)

•	 Auto-Zoom: Available when Mode is set to Point, a pop-up menu to choose a 
magnification level when positioning the tracker in the canvas. You can zoom in on the 
canvas when searching for an ideal tracking reference pattern. There are five options: 
None, 2x, 4x, 8x, and 16x.

•	 Auto-Zoom Mode: Available when Mode is set to Point, a pop-up menu to set the 
display of the auto-zoomed tracker in the canvas. There are three options:

•	 Normal: Displays a normal pattern.

•	 Contrast: Displays the tracker pattern with contrast detection.

•	 Edge: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the canvas and does not affect the 
Tracker Preview in the Behaviors Inspector.

Note: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.
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•	 Look Ahead Frames: Available when Mode is set to Point, a slider and value slider to 
specify the number of future frames to be analyzed by the tracker. In other words, you 
can direct the tracker to look in a specific location for its reference point, which helps 
the tracker follow fast-moving objects. For more information about the Look Ahead 
Frames control, see Advanced tracking strategies.

•	 Anchor/Rotation-Scale: Available when Mode is set to Point (and when the Type pop-
up menu is set to Transformation), checkboxes to enable or disable the Anchor and 
Rotation-Scale trackers. The Anchor tracker records position data. The Anchor tracker 
and Rotation-Scale tracker in combination record position, rotation, and scale data (by 
comparing the relative coordinate change between the two trackers). 

Note: When the Source well (described above) contains tracking data from another 
behavior (such as Analyze Motion), these checkboxes become pop-up menus used to 
assign which trackers (from the source tracking data) will provide anchor (position) 
data to the destination object, and which will provide rotation-scale data. And because 
trackers are no longer needed in the Match Move behavior, onscreen trackers are 
removed from the canvas.

Move the pointer over the Anchor or Rotation-Scale row, then click Show to reveal 
additional parameters:

•	 Position: Value sliders displaying the X and Y positions of the tracker.

•	 Track Size: A slider to set (in pixels) the pattern search size for the tracker. As you 
adjust the tracker size, the Tracker Preview is updated to show the new pattern 
search size. However, there’s no visual change in the onscreen tracker. 

Alternatively, you can adjust the Track Size parameter by Option-dragging left or 
right in the Tracker Preview area. 

•	 Search Size: A slider to set search area size for the tracker. In Motion, you do not 
specify the size of a search area when setting up trackers in the canvas. If your clip 
contains a lot of rapid movement, you may have better results increasing the Search 
Size. For example, if Search Size is set to 150%, the tracker searches 50% further 
beyond the Track Size setting.

•	 Fail Tolerance: A slider to set the amount of tolerance for error, or confidence value, 
of the tracker. In other words, Fail Tolerance defines a threshold score at which the 
tracker determines it can match a reference feature. When the analysis yields a 
score above the Fail Tolerance value, the tracker accepts the match. When the score 
is below the value, the tracker rejects the match.

•	 Fail Behavior: A pop-up menu to specify what happens if the track confidence value 
falls below the Fail Tolerance amount. There are six menu options:

•	 Smart Retry: The tracker attempts to find the reference pattern in a larger search 
area. If the pattern still cannot be found, the tracker switches to the Predict 
option (described below). Smart Retry is the default Fail Behavior setting.

•	 Stop: The analysis stops when the tracker loses the reference pattern. 

•	 Predict: The tracker predicts a new search area without creating keyframes until 
it finds a match for the reference pattern. This option is excellent for tracked 
elements that pass behind foreground elements.

•	 Predict and Key: If a failure is detected, the tracker predicts the location of the 
next track point (keyframe) based on a vector of the last two keyframes and 
continues tracking in the new area.
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•	 Don’t Predict: The tracker remains in its position and searches for subsequent 
matches as the clip’s frames progress. While searching for a match, the tracker 
does not create keyframes.

•	 Use Existing Keyframes: The tracker uses keyframes you have manually created 
as a guide. After manually adding keyframes, return to the start frame and start 
the tracking analysis. If the tracker has difficulty locating the reference pattern, 
the manually created tracking keyframes help guide the tracker.

•	 Color: A color control to set a new color for the onscreen tracker. The default tracker 
color is red. A selected tracker is yellow. When a tracker is being positioned, its 
center crosshair is yellow and the border of its magnified inset is the color set in the 
color well. To adjust individual color channels, including the tracker’s opacity, click 
the disclosure triangle. For more information about color controls, see Use basic 
color controls.

•	 Top Left, Top Right, Bottom Right, Bottom Left (control groups): Available when Mode 
is set to Point (and when the Type pop-up menu is set to Four Corners and the Source 
well contains the footage being analyzed by the Match Move behavior), controls to 
adjust the Position, Track Size, Search Size, Fail Tolerance, Fail Behavior, and Color for 
each of the four-corner trackers individually.

•	 Top Left, Top Right, Bottom Right, Bottom Left (pop-up menus): Available when Mode 
is set to Point (and when the Type pop-up menu is set to Four Corners and the Source 
well contains tracking data from another behavior, such as Analyze Motion) pop-up 
menus to assign trackers from the source behavior to each of the four corners. 

Stabilize controls in Motion
The Stabilize behavior uses motion analysis to track every pixel from one frame to the next, 
considering horizontal, vertical, or horizontal and vertical movement in the clip, as well as 
position, scale, and rotation in order to remove unwanted movement in a clip.

After you apply a Stabilize behavior to an object in your project, adjust the behavior using 
the parameter controls in the Behaviors Inspector:

•	 Source: A well to designate the source object supplying the tracking data used to 
stabilize the clip. By default, the clip you apply the Stabilize behavior to appears in this 
well, ready to be analyzed. However, you can manually drag a different source object 
into the well—another Stabilize behavior in your project or even a different footage 
object in your project. To clear a Source well, drag the thumbnail away from the well and 
release the mouse button.

•	 Action pop-up menu: A pop-up menu (with a gear icon) to manually assign tracking data 
(from other tracking behaviors in your project).
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•	 Analyze: Three buttons used for the motion tracking analysis:

•	 Left arrows: A button that analyzes the portion of the clip before the playhead 
position.

If you haven’t added a tracker, the left arrow button is not available.

•	 Analyze: A button that analyzes the entire clip.

•	 Right arrows: A button that analyzes the portion of the clip after the playhead 
position.

If you haven’t added a tracker, the track begins at the start of the clip, rather than 
the current playhead position.

•	 Quality: A pop-up menu to define the level of detail in the motion analysis. There are 
two options:

•	 Faster: Allows for a faster operation, but motion analysis is less detailed.

•	 Better: Provides a more detailed analysis, but is slower. This is the recommended 
option when the clip contains rotation.

•	 Track Region: A checkbox that lets you manually define an area in the frame to be 
analyzed. A red overlay appears in the canvas. The area outside this overlay is ignored 
by the analysis. The track region’s onscreen controls are similar to a shape’s onscreen 
controls, allowing you to modify the size, shape, and position of the track region.

For more information on setting a track region, see Stabilize a shaky clip.

•	 Method: A pop-up menu to define how the stabilization is applied to the clip. There are 
two options:

•	 Smooth: Smooths the apparent motion of the camera, while allowing the general 
movement in the frame to proceed. Use this method to remove camera jitter. 

•	 Stabilize: Attempts to lock the motion of the principal subject in the shot to eliminate 
motion. As a result, the background appears to move around the subject being 
tracked.

•	 Translation Smooth: A slider (available when Method is set to Smooth) to smooth motion 
in the X and Y positions.

•	 Rotation Smooth: A slider (available when Method is set to Smooth) to smooth image 
rotation.

•	 Scale Smooth: A slider (available when Method is set to Smooth) to smooth an uneven 
zoom.

Note: Don’t set the Scale Smooth value above 0 unless you’re positive the clip is being 
zoomed.

•	 Borders: A pop-up menu to set how moving border artifacts are handled. When you 
stabilize a clip, the resulting transformations may cause moving black borders to appear 
around the edges of the clip. There are two Borders options:

•	 Normal: Maintains the size of the stabilized footage. The moving black borders 
remain around the edges of the clip.

•	 Zoom: Expands the clip to fill the canvas. This prevents black borders from 
appearing around the edges, but scales up the stabilized clip, which may degrade 
image quality.

See Remove borders from stabilized clips.
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•	 Direction: A pop-up menu to specify the dimensions in which the recorded movement 
are applied—Horizontal and Vertical (X and Y), Horizontal (only X), or Vertical (only Y).

•	 Adjust: Three buttons to set the type of transformation applied. Select any combination 
of the three:

•	 Position: Stabilizes the position of the analyzed image.

•	 Scale: Stabilizes the scale of the analyzed image.

•	 Rotation: Stabilizes the rotation of the analyzed image.

•	 Tracker: A row that contains an Add button to add onscreen trackers to the Stabilize 
behavior. You can add a maximum of two trackers to the Stabilize behavior. The first 
tracker is the Anchor tracker, used to analyze changes in X and Y position. The second 
tracker is the Rotation-Scale tracker, used to analyze changes in rotation and scale.

Note: When another behavior is used as the source for the stabilization, you cannot add 
trackers to the Stabilize behavior.

When you add trackers, the following occurs:

•	 The Track Region parameter is no longer available.

•	 The Reverse checkbox becomes available, allowing you to analyze a clip backwards 
from the playhead position (in reverse).

•	 The Tracker Preview, Offset Track, Auto-Zoom, Auto-Zoom Mode, Look Ahead 
Frames, and track list controls become available.

For more information about the Anchor and Rotation-Scale controls, see “Anchor/
Rotation-Scale” in Match Move controls.

Unstabilize controls in Motion
The Unstabilize behavior applies movement data recorded in a Stabilize behavior, but does 
not perform its own tracking analysis.

After you apply an Unstabilize behavior to an object in your project, adjust the behavior 
using the parameter controls in the Behaviors Inspector:

•	 Source: A well to designate the source object supplying the tracking data used to 
“unstabilize” (add motion to) the clip. The source object can be another Stabilize 
behavior. To clear a Source well, drag the item away from the well and release the 
mouse button.

•	 Action pop-up menu: A pop-up menu (with a gear icon) to manually assign tracking data 
(from other tracking behaviors in your project).
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Track Points controls in Motion
The Track Points behavior (available in the Shape subcategory of Behaviors in the Library) 
lets you link the control points of a shape or mask (including paint strokes) to reference 
features on a source clip. This behavior also lets you apply tracking data recorded by the 
Analyze Motion, Match Move, or Stabilize tracking behaviors to the control points of a 
shape or mask.

After you apply a Track Points behavior to an object in your project, adjust the behavior 
using the parameter controls in the Behaviors Inspector:

•	 Source: A well to specify the source object supplying tracking data. Drag a source 
object from the Layers list into the well. The source object can be another tracking 
behavior, a footage object, or an animated object. To clear a Source well, drag the 
thumbnail away from the well and release the mouse button.

•	 Action pop-up menu: A pop-up menu (with a gear icon) to manually assign tracking data 
(from other tracking behaviors in your project).

•	 Transform: A pop-up menu to set how the destination object moves. There are two 
options:

•	 Attach to Source: Anchors the destination object to the recorded track or animation 
source. Use Attach to Source when the source object is scaling or rotating, and you 
want the destination object to “stick” to a specific spot on the source object. You 
can preserve preexisting animation in the destination object by using the Adjust 
buttons (Position, Scale, and Rotation), available when the Type pop-up menu is set 
to Transformation.

Note: Although the destination object is “attached” to the movement of the source 
object, the destination object can be offset from the source object.

•	 Mimic Source: Allows the destination object to “mimic” the recorded track or 
animation source. You can preserve preexisting animation in the destination object 
by using the Adjust buttons (Position, Rotation, or Scale).

Note: The destination object can be offset from the source object.

•	 Align Tangents: A checkbox that, when deselected, forces tangents to remain aligned 
at their original angles. When the checkbox is selected, the tangents match the 
transformation of the source animation, and the shape changes its form.

•	 Analyze: Three buttons used for the motion tracking analysis (available when the Source 
well contains footage):

•	 Left arrows: Analyzes the portion of the clip before the playhead position.

•	 Analyze: Analyzes the entire clip forward from the playhead position to the end of 
the clip (or to where the reference pattern can no longer be tracked).

•	 Right arrows: Analyzes the portion of the clip after the playhead position.
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•	 Tracker Preview: A preview area (available when the Source well contains source 
footage) providing a magnified view of the tracking reference area for the selected 
tracker. The preview updates as you adjust the position of the tracker in the canvas. 
You can drag in the preview area to adjust the position of the tracker. When you do so, 
the image moves around the red crosshair in the preview, and the tracker moves in the 
canvas.

•	 Offset Track: A checkbox (available when the Source well contains source footage) that, 
when selected, lets you set a new tracker position when the original reference pattern 
becomes temporarily obstructed by an obstacle or goes off the screen. Motion uses 
the tracker position to continue the same tracking path begun by the original reference 
pattern. For more information on offset tracking, see Track obscured or off-frame 
points.

•	 Auto-Zoom: A pop-up menu to choose a magnification level when positioning the 
tracker in the canvas. You can zoom in on the canvas when searching for an ideal 
tracking reference pattern. There are five options: None, 2x, 4x, 8x, and 16x.

•	 Auto-Zoom Mode: A pop-up menu to set the display of the auto-zoomed tracker in the 
canvas. There are three options:

•	 Normal: Displays a normal pattern.

•	 Contrast: Displays the tracker pattern with contrast detection.

•	 Edge: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the canvas and does not affect the 
Tracker Preview in the Behaviors Inspector.

Note: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.

•	 Look Ahead Frames: A slider and value slider to specify the number of future frames 
to be analyzed by the tracker. In other words, you can direct the tracker to look in a 
specific location for its reference point, which helps the tracker follow fast-moving 
objects. For more information about the Look Ahead Frames control, see Advanced 
tracking strategies.

•	 Track 1, Track 2, and so on: A list displaying the trackers in the behavior. To disable 
a tracker, deselect its checkbox. A deselected tracker is not analyzed. To remove a 
tracker, click its adjacent Remove button. 

Note: When the Source well (described above) contains tracking data from another 
behavior (such as Analyze Motion), these checkboxes become pop-up menus used to 
assign which trackers (from the source tracking data) will provide anchor (position) 
data to the destination object, and which will provide rotation-scale data. And because 
trackers are no longer needed in the Match Move behavior, onscreen trackers are 
removed from the canvas.

To expose the following additional track controls, move the pointer over the track row, 
then click Show:

•	 Position: Value sliders displaying the X and Y positions of the tracker.

•	 Track Size: A slider to set (in pixels) the pattern search size for the tracker. As you 
adjust the tracker size, the Tracker Preview is updated to show the new pattern 
search size. However, there’s no visual change in the onscreen tracker. 

Alternatively, you can adjust the Track Size parameter by Option-dragging left or 
right in the Tracker Preview area. 
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•	 Search Size: A slider to set search area size for the tracker. In Motion, you do not 
specify the size of a search area when setting up trackers in the canvas. If your clip 
contains a lot of rapid movement, you may have better results increasing the Search 
Size. For example, if Search Size is set to 150%, the tracker searches 50% further 
beyond the Track Size setting.

•	 Fail Tolerance: A slider to set the amount of tolerance for error, or confidence value, 
of the tracker. In other words, Fail Tolerance defines a threshold score at which the 
tracker determines it can match a reference feature. When the analysis yields a 
score above the Fail Tolerance value, the tracker accepts the match. When the score 
is below the value, the tracker rejects the match.

•	 Fail Behavior: A pop-up menu to specify what happens if the track confidence value 
falls below the Fail Tolerance amount. There are six menu options:

•	 Smart Retry: The tracker attempts to find the reference pattern in a larger search 
area. If the pattern still cannot be found, the tracker switches to the Predict 
option (described below). Smart Retry is the default Fail Behavior setting.

•	 Stop: The analysis stops when the tracker loses the reference pattern. 

•	 Predict: The tracker predicts a new search area without creating keyframes until 
it finds a match for the reference pattern. This option is excellent for tracked 
elements that pass behind foreground elements.

•	 Predict and Key: If a failure is detected, the tracker predicts the location of the 
next track point (keyframe) based on a vector of the last two keyframes and 
continues tracking in the new area.

•	 Don’t Predict: The tracker remains in its position and searches for subsequent 
matches as the clip’s frames progress. While searching for a match, the tracker 
does not create keyframes.

•	 Use Existing Keyframes: The tracker uses keyframes you have manually created 
as a guide. After manually adding keyframes, return to the start frame and start 
the tracking analysis. If the tracker has difficulty locating the reference pattern, 
the manually created tracking keyframes help guide the tracker.

•	 Color: A color control to set a new color for the onscreen tracker. The default tracker 
color is red. A selected tracker is yellow. When a tracker is being positioned, its 
center crosshair is yellow and the border of its magnified inset is the color set in the 
color well. To adjust individual color channels, including the tracker’s opacity, click 
the disclosure triangle. For more information about color controls, see Use basic 
color controls.
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Track controls in Motion
The Track parameter behavior (available in the Parameter subcategory of Behaviors in 
the Library) lets you track the position parameter of an object (such as a filter, shape, or 
particle emitter) to a reference feature of a clip, or to apply tracking data to the position 
parameter of an object.

After you apply a Track behavior to an object in your project, adjust the behavior using the 
parameter controls in the Behaviors Inspector:

•	 Source: A well to specify the source object supplying tracking data. Drag a source 
object from the Layers list into the well. The source object can be another tracking 
behavior or a footage object. To clear a Source well, drag the thumbnail away from the 
well and release the mouse button.

Note: An animated object cannot be used as a source for the Track parameter behavior.

•	 Action pop-up menu: A pop-up menu (with a gear icon) to manually assign tracking data 
(from other tracking behaviors in your project).

•	 Analyze: Three buttons used for the motion tracking analysis:

•	 Left arrows: Analyzes the portion of the clip before the playhead position.

•	 Analyze: Analyzes the entire clip forward from the playhead position to the end of 
the clip (or to where the reference pattern can no longer be tracked), then backward 
from the playhead position to the beginning of the clip.

•	 Right arrows: Analyzes the portion of the clip after the playhead position.

•	 Mode: A pop-up menu to choose the tracking analysis mode. There are two options:

•	 Object: Choose Object mode to track subjects such as people or faces, pets, cars, 
or other reference patterns using machine learning or point cloud analysis methods, 
or a combination of both.

•	 Point: Choose to track one or more specific points—or a very specific feature—in a 
clip.

•	 Transform: A pop-up menu to set how the destination object moves. There are two 
options:

•	 Attach to Source: Anchors the destination object to the recorded track or animation 
source. Use Attach to Source when the source object is scaling or rotating, and you 
want the destination object to “stick” to a specific spot on the source object. When 
using Point mode tracking, you can preserve preexisting animation in the destination 
object by using the Adjust buttons (Position, Scale, and Rotation), available when the 
Type pop-up menu is set to Transformation.

Note: Although the destination object is “attached” to the movement of the source 
object, the destination object can be offset from the source object.
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•	 Mimic Source: Allows the destination object to “mimic” the recorded track or 
animation source. You can preserve preexisting animation in the destination object 
by using the Adjust buttons (Position, Rotation, or Scale).

Note: The destination object can be offset from the source object.

•	 Analysis Method: Available when Mode is set to Object, a pop-up menu to set how the 
selected reference pattern is analyzed. There are four options:

•	 Automatic: Evaluates the clip, then attempts to select the most suitable analysis 
method.

•	 Combined: Uses a combination of the Machine Learning and Point Cloud analysis 
methods to track position, scale, and rotation.

•	 Machine Learning: Uses a machine learning model trained on a dataset to identify 
people, animals, and many other common objects, allowing the tracker follow the 
subject in a specified region of video.

•	 Point Cloud: Analyzes a “cloud” of point positions (or a pattern) within a search 
region.

•	 Detect: Available when Mode is set to Object, a pop-up menu to turn automatic face 
detection on or off.

•	 Offset Track: A checkbox (available when the Source well contains footage) that, 
when selected, lets you set a new tracker position when the original reference pattern 
becomes temporarily obstructed by an obstacle or goes off the screen. Motion uses 
the tracker position to continue the same tracking path begun by the original reference 
pattern. For more information on offset tracking, see Track obscured or off-frame 
points.

•	 Show Grid: Available when Mode is set to Object, a checkbox that shows or hides the 
grid in the onscreen object tracker.

•	 Shape: Available when Mode is set to Object, a group of controls used to adjust the 
onscreen object tracker:

•	 Curvature: A slider to increase or decrease the roundness of the object tracker.

•	 Position: Value sliders to adjust the position of the object tracker.

•	 Rotation: A dial to adjust the rotation of the object tracker.

•	 Scale: A slider to adjust the size of the object tracker.

•	 Tracker Preview: Available when Mode is set to Point (and when the Source well 
contains source footage), a preview area providing a magnified view of the tracking 
reference area for the selected tracker. The preview updates as you adjust the position 
of the tracker in the canvas. You can drag in the preview area to adjust the position of 
the tracker. When you do so, the image moves around the red crosshair in the preview, 
and the tracker moves in the canvas.

•	 Offset Track: Available when Mode is set to Point (and when the Source well contains 
footage), a checkbox that, when selected, lets you set a new tracker position when the 
original reference pattern becomes temporarily obstructed by an obstacle or goes off 
the screen. Motion uses the tracker position to continue the same tracking path begun 
by the original reference pattern. For more information on offset tracking, see Track 
obscured or off-frame points.
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•	 Auto-Zoom: Available when Mode is set to Point, a pop-up menu to choose a 
magnification level when positioning the tracker in the canvas. You can zoom in on the 
canvas when searching for an ideal tracking reference pattern. There are five options: 
None, 2x, 4x, 8x, and 16x.

•	 Auto-Zoom Mode: Available when Mode is set to Point, a pop-up menu to set the 
display of the auto-zoomed tracker in the canvas. There are three options:

•	 Normal: Displays a normal pattern.

•	 Contrast: Displays the tracker pattern with contrast detection.

•	 Edge: Displays the tracker pattern with edge detection.

The Auto-Zoom Mode applies to trackers in the canvas and does not affect the 
Tracker Preview in the Behaviors Inspector.

Note: When Auto-Zoom is set to None, the Auto-Zoom Mode setting has no effect.

•	 Look Ahead Frames: Available when Mode is set to Point, a slider and value slider to 
specify the number of future frames to be analyzed by the tracker. In other words, you 
can direct the tracker to look in a specific location for its reference point, which helps 
the tracker follow fast-moving objects. For more information about the Look Ahead 
Frames control, see Advanced tracking strategies.

•	 Track 1, Track 2, and so on: Available when Mode is set to Point, a list displaying the 
trackers in the behavior. To disable a tracker, deselect its checkbox. Disabled tracks are 
not analyzed. To remove a tracker, click its adjacent Remove button.

Note: When the Source well (described above) contains tracking data from another 
behavior (such as Analyze Motion), these checkboxes become pop-up menus used to 
assign which trackers (from the source tracking data) will provide anchor (position) 
data to the destination object, and which will provide rotation-scale data. And because 
trackers are no longer needed in the Match Move behavior, onscreen trackers are 
removed from the canvas.

To expose the following additional track controls, move the pointer over the track row, 
then click Show:

•	 Position: Value sliders displaying the X and Y positions of the tracker.

•	 Track Size: A slider to set (in pixels) the pattern search size for the tracker. As you 
adjust the tracker size, the Tracker Preview is updated to show the new pattern 
search size. However, there’s no visual change in the onscreen tracker.

Alternatively, you can adjust the Track Size parameter by Option-dragging left or 
right in the Tracker Preview area. 

•	 Search Size: A slider to set search area size for the tracker. In Motion, you do not 
specify the size of a search area when setting up trackers in the canvas. If your clip 
contains a lot of rapid movement, you may have better results increasing the Search 
Size. For example, if Search Size is set to 150%, the tracker searches 50% further 
beyond the Track Size setting.

•	 Fail Tolerance: A slider to set the amount of tolerance for error, or confidence value, 
of the tracker. In other words, Fail Tolerance defines a threshold score at which the 
tracker determines it can match a reference feature. When the analysis yields a 
score above the Fail Tolerance value, the tracker accepts the match. When the score 
is below the value, the tracker rejects the match.



1238Motion User Guide

•	 Fail Behavior: A pop-up menu to specify what happens if the track confidence value 
falls below the Fail Tolerance amount. There are six menu options:

•	 Smart Retry: The tracker attempts to find the reference pattern in a larger search 
area. If the pattern still cannot be found, the tracker switches to the Predict 
option (described below). Smart Retry is the default Fail Behavior setting.

•	 Stop: The analysis stops when the tracker loses the reference pattern. 

•	 Predict: The tracker predicts a new search area without creating keyframes until 
it finds a match for the reference pattern. This option is excellent for tracked 
elements that pass behind foreground elements.

•	 Predict and Key: If a failure is detected, the tracker predicts the location of the 
next track point (keyframe) based on a vector of the last two keyframes and 
continues tracking in the new area.

•	 Don’t Predict: The tracker remains in its position and searches for subsequent 
matches as the clip’s frames progress. While searching for a match, the tracker 
does not create keyframes.

•	 Use Existing Keyframes: The tracker uses keyframes you’ve manually created as 
a guide. After manually adding keyframes, return to the start frame and start the 
tracking analysis. If the tracker has difficulty locating the reference pattern, the 
manually created tracking keyframes help guide the tracker.

•	 Color: A color control to set a new color for the onscreen tracker. The default tracker 
color is red. A selected tracker is yellow. When a tracker is being positioned, its 
center crosshair is yellow and the border of its magnified inset is the color set in the 
color well. To adjust individual color channels, including the tracker’s opacity, click 
the disclosure triangle. For more information about color controls, see Use basic 
color controls.

•	 Apply To: A pop-up menu to assign the parameter affected by the Track behavior. 
Click the To pop-up menu, then choose a parameter. For example, if the Track 
parameter is applied to the X Position parameter of the tracked object, and you want 
to apply the tracking data to the X and Y Position parameters, click To, then choose 
Properties > Transform > Position > X and Y.

Save tracks to the Library in Motion
As with all behaviors in Motion, you can save tracking behaviors to the Library. However, 
a tracking behavior must reference the tracked source object. Therefore, it makes more 
sense to save the group that contains the tracking behavior and the source footage to the 
Library.

Save a group to the Library
1.	 In Motion, open the Library and select the category where you want to save the group, 

such as the Favorites category.

2.	 From the Layers list or Timeline, drag the group that contains the tracking behavior and 
its source (tracked) footage into the stack at the bottom of the Library.

The group is added to the Library category.
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Work with audio

Intro to audio in Motion
You can view the audio elements in your project in several places in the Motion interface. 
You can import audio and video files into Motion, and then adjust individual audio tracks or 
the overall sound mix in your project. The workflow for adding and adjusting audio tracks in 
Motion is similar to the basic video workflow: 

•	 Add audio files to your project (or add video files that contain audio).

•	 Select and preview specific tracks.

•	 Adjust individual audio tracks or adjust the Output audio track (the overall mix).

•	 Adjust audio timing by trimming, slipping, and sliding tracks or by changing the speed 
of tracks.

•	 Add effects such as fade-ins, crossfades, and pans using keyframes or using behaviors.

•	 Finally, export audio with video, or export audio alone, in various formats.
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View audio files in Motion
The Audio list, located in the Project pane, displays audio tracks in your project, as well as 
the Output audio track, which controls your project’s overall audio mix. You can adjust the 
settings for each track using controls in the Audio list (see Adjust audio).

You can view additional information about your audio files in the Audio Timeline, in the 
Keyframe Editor, in the Media list, and in the Audio Track Inspector. 

Show the Audio list
In Motion, do one of the following:

•	 If the Project pane is visible, click the Audio tab at the top of the pane.

•	 Choose Window > Audio (or press Command-6).

For information about adjusting audio tracks in the Audio list, see Adjust audio.

Sort the Audio list
•	 In Motion, with the Audio list open, click the Search button at the bottom of the Project 

pane, then enter the name of a track in the Search field.

The Audio list shows the track (or tracks) that match your search term.

To stop filtering and return to the complete Audio list, click the Clear button on the right 
side of the Search field.

Open the Audio Track Inspector
•	 In Motion, select an audio track in the Audio list or Audio Timeline, then click Audio 

Track in the Inspector.

Level, Pan, and Output Bus controls become available.

Show waveforms in the Audio Timeline
To see your audio tracks as waveforms laid out over time, open the Audio Timeline.

•	 In Motion, click the Show/Hide Audio Timeline button in the timing toolbar.
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The Audio Timeline opens (in the Timing pane), displaying a green bar containing the 
waveform of the file. (If the bar does not show a waveform, adjust the height of the 
tracks (see Customize the Timeline).

Important: In a multichannel audio file, all audio channels in the file appear in the Audio 
Timeline.

Show waveforms in the Keyframe Editor
You can also view an audio track in the Keyframe Editor, to compare the waveforms of the 
track to keyframe placement in your project.

1.	 To open the Keyframe Editor in Motion, click the Show/Hide Keyframe Editor button in 
the timing toolbar.

2.	 Click the waveform pop-up menu at the top-right side of the Keyframe Editor, then 
choose a track.

The waveform of the track appears in the Keyframe Editor, along with keyframes.
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View individual tracks in the Keyframe Editor in a multitrack project
If there are multiple audio tracks in the project, by default only the waveform of the Output 
audio track appears in the Keyframe Editor. Use the waveform pop-up menu to select a 
different track.

•	 In Motion, click the waveform pop-up menu at the top-right side of the Keyframe Editor, 
then choose a track name.

Show additional information about your project’s audio files
In Motion, do one of the following:

•	 In the Project pane, open the Media list.

•	 Select the audio file in the Media list, then open the Media Inspector.

The Media list in the Project pane and the Media Inspector display information about 
each audio file, including kind, duration, sample rate, format, file size, and other details.

Add audio files in Motion
You can add different kinds of audio files to a Motion project. Motion lets you preview files 
before adding them to your project. Motion supports audio in a variety of common file 
formats, sample rates, and bit depths. For a complete list, see Supported media formats.

Audio files added to a project are converted to a Motion-specific internal format, allowing 
you to mix audio files with differing formats, sample rates, and bit depths in the same 
project. 

Note: When you add an audio file, its start point in the Timeline is determined by the Create 
Layers At preference in the Project pane of Motion Settings. To adjust this preference, see 
If it’s your first import.

Add an audio file to a project
In Motion, do one of the following:

•	 In the toolbar, click Import, locate and select an audio file, then click Import.

•	 Choose File > Import (or press Command-I), locate and select an audio file, then click 
Import.
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•	 Drag an audio file from the Finder into the Layers list, Timeline, canvas, Audio Timeline, 
or Audio list.

•	 Control-click in the Audio list, choose Import Audio, locate and select an audio file, then 
click Import.

The audio file is added to the project and appears in the Audio Timeline, Audio list, mini-
Timeline, and Media list (but does not appear in the Layers list).

Important: Audio tracks from files with more than two tracks of audio (such as 5.1 surround 
audio) are imported as individual audio objects.

Add an audio file from Music
1.	 In the Library in Motion, select the Music category.

2.	 Select a subcategory, such as Music, Movies, or a playlist, then select a file.

If your Music library contains rights-protected audio files, such as songs purchased 
through the iTunes Store or downloaded with an Apple Music subscription, those items 
do not appear in the Music category of the Motion Library.

Note: To use a song you purchased from the iTunes Store in your project, you must be 
the copyright holder of the song or have express permission from the copyright holder. 
For more information, see the Motion software license agreement (choose Motion > 
About Motion, then click License Agreement).

3.	 Do one of the following:

•	 In the preview area, click Apply.

•	 Drag the file to the Layers list, canvas, Timeline, Audio Timeline, or Audio list.

The audio file is added to the project and appears in the Audio Timeline, Audio list, mini-
Timeline, and Media list (but does not appear in the Layers list).

Add an audio file to a project for later use
You can also add an audio file to your project without having it appear in the composition. 
For example, you might want to archive an audio file for later use. You do this by dragging 
the file into the Media list.

1.	 In Motion, click Media in the Project pane to open the Media list.

2.	 Drag an audio file from the Finder or Import dialog into the Media list.

The audio file is added to the Media list, but not to the Audio Timeline or Audio list. If you 
later decide to add the file to the active composition, drag its row from the Media list to the 
canvas, Timeline, or Audio Timeline. 

Add only the audio from a QuickTime movie
When you add a QuickTime movie to your project, the movie’s video and audio tracks 
are both imported. If you don’t need the video, you can add only the audio track to your 
project.

•	 In Motion, drag a QuickTime movie file from the Finder into the Audio list.

The audio track from the movie is added to your project, without the video footage. The 
video footage is added to the Media list (but isn’t used in your composition).
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Add multi-channel audio from a QuickTime movie
You can import multi-channel audio from QuickTime files as a single stereo track or as 
individual tracks.

1.	 In Motion, choose File > Import (or press Command-I).

2.	 In the dialog, select a QuickTime movie file that contains stereo or multi-channel audio 
tracks.

3.	 Click the Audio pop-up menu at the bottom of the Import Files dialog, then choose an 
import option:

•	 Mix to Stereo: Imports the movie file as a single stereo track.

•	 Import All Tracks: Imports the movie file with a separate audio track for each 
channel. 

4.	 Click Import.

If you chose Mix To Stereo, the Audio list displays a single audio track

If you chose Import all Tracks, the Audio list displays an individual audio track for each 
channel in the file. The following image shows the Audio list after importing a stereo 
QuickTime movie file using the Import All Tracks option, with the resulting left and right 
tracks.

When you export a multichannel audio file from Motion, you can export all channels or mix 
them down into a single track. See Select audio output channels.

Play audio files in Motion
Play audio in your project
•	 In Motion, click the Play button in the timing toolbar above the Timeline.

All audio tracks in the project that are turned on and not muted play back.

Scrub an audio track
You can scrub an audio track to hear the audio in your project as you drag the playhead.

•	 In Motion, press and hold the Option key while dragging the playhead in the Timeline, 
mini-Timeline, or Audio Timeline.

Pausing while dragging (but continuing to press and hold the Option key and mouse 
button) loops the five frames adjacent to the current frame.

Audio looping while scrubbing is turned on by default. You can turn off looping by 
choosing Motion > Settings, clicking the Time icon, then deselecting the “Loop audio while 
scrubbing” checkbox.
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Edit audio

Intro to audio editing in Motion
There are multiple ways to edit audio in your project. You can:

•	 Adjust audio using controls in the Audio list

•	 Cut, copy, paste, and delete audio in the Audio list

•	 Slip, slide, and trim audio

•	 Use markers with audio to help synchronize visual and audio events

•	 Make advanced audio adjustments, controlling the Output audio track, setting output 
channels, keyframing level and pan effects, and syncing audio and video tracks

•	 Retime audio tracks in your project, speeding them up, slowing them down, or playing 
them at a different speed

Adjust audio in Motion
When you add an audio file to your project, Motion creates one or more audio tracks for 
the file. In the Audio list of the Project pane, you can turn audio tracks on and off, select 
tracks, mute and solo tracks, and control their volume and pan settings:

Important: Changes you make to an audio track, such as renaming or trimming it, do not 
affect the source audio file.

Adjust audio tracks
In Motion, do any of the following:

•	 Select an audio track: In the Audio list or Audio Timeline, click in the row containing the 
audio track’s name and controls. Selected tracks are highlighted. Shift-click to select 
multiple tracks.

•	 Turn an audio track on or off: In the Audio list or Audio Timeline, click the activation 
checkbox on the left side of the audio track row. Deselecting an audio track’s checkbox 
removes the track from the audio mix.

•	 Rename a track: In the Audio list or Audio Timeline, double-click a track’s name, then 
enter a new name.
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•	 Adjust a track’s audio volume: In the Audio list, the track’s HUD, or the Audio Track 
Inspector, drag the Level slider. You can also change the parameter numerically in the 
Audio Track Inspector using the value slider to the right of the Level slider.

•	 Set how sound is distributed in the stereo field: In the Audio list, adjust the Pan dial, or, 
in the Audio Track Inspector or Audio Track HUD, drag the Pan slider.

•	 Mute a track, temporarily silencing it during playback: In the Audio list, click the track’s 
Mute button (the speaker icon on the right side of the row). Muted audio tracks remain 
silent during playback, but are still part of the mix when you export your project. You 
can also mute tracks in the Audio Timeline by Control-clicking a track, then choosing 
Mute from the shortcut menu.

•	 Solo a track, temporarily muting all other tracks: In the Audio list, click the track’s Solo 
button (the headphones icon on the right side of the row). Soloing an audio track mutes 
all other audio tracks during playback, soloing multiple audio tracks mutes all tracks not 
soloed during playback.

•	 Unlink a track: In the Audio list, click the track’s link icon on the right side of the row. 
Unlinked audio can be moved independently of its accompanying video track in the 
Timeline. Click the link icon again to relink it to the same video track it was originally 
linked to. If you’ve offset its position in the Timeline, the offset is maintained when the 
audio track is linked again.

•	 Lock a track, preventing it from being edited: In the Audio list, click the track’s lock icon 
on the right side of the row. Click the lock icon again to unlock the track. When a track 
is locked, you cannot mute or solo the track, change its level or pan, move or trim it, or 
add keyframes. You can still play the track, and turn it on or off.

•	 Specify an output channel: In the Audio list, click the track’s output channel pop-up 
menu on the left side of the row, then choose an output channel for the audio track, 
such as Stereo, Left, Right, Center, and so on. You can also specify an output channel 
using the Output Bus pop-up menu in the Audio Track Inspector. 

Cut, copy, paste, and delete audio in Motion
You can cut, copy, and paste audio tracks in the Audio list. You can also duplicate tracks.

Cut an audio track
•	 In the Audio list in Motion, select an audio track, then do one of the following:

•	 Choose Edit > Cut (or press Command-X).

•	 Control-click the track, then choose Cut from the shortcut menu.

Copy an audio track
•	 In the Audio list in Motion, select an audio track, then do one of the following:

•	 Choose Edit > Copy (or press Command-C).

•	 Control-click the track, then choose Copy from the shortcut menu.

Paste an audio track
•	 In the Audio list in Motion, do one of the following:

•	 Choose Edit > Paste (or press Command-V).

•	 Control-click an empty area, then choose Paste from the shortcut menu.
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Duplicate an audio track
•	 In the Audio list in Motion, select an audio track, then do one of the following:

•	 Choose Edit > Duplicate (or press Command-D).

•	 Control-click the track, then choose Duplicate from the shortcut menu.

The duplicate appears below the original file in the Audio list.

Delete an audio track
There are two ways to remove an audio track from your project.

•	 In the Audio list in Motion, do one of the following:

•	 Select an audio track, then press Delete.

•	 Control-click an audio track, then choose Delete from the shortcut menu.

The file is removed from the project.

If you try to delete an audio file with linked video, an alert appears, warning that 
“One or more linked video objects will also be deleted.”

Note: Deleting an audio track from the Audio list removes the associated file from the 
Media list if “Automatically manage unused media” is selected in the General pane of 
Motion Settings.

Slip, slide, and trim audio in Motion
The Audio Timeline provides a view of audio elements over time. The audio tracks appear as 
green bars with the audio waveform superimposed on the bar, and can be edited like other 
objects in the Timeline. The Audio Timeline uses the same ruler, buttons, and other controls 
as the Timeline. For more information on the Timeline interface, see Intro to the Timeline.

When you import an audio file, its start point is placed at the start of the project or at the 
current playhead position (depending on the setting of the Create Layers At parameter in 
Motion Settings—see If it’s your first import). 

You can adjust audio tracks in the Timeline using standard nonlinear editing techniques: 

•	 Slide an audio track in the Audio Timeline or mini-Timeline so the track starts playing at 
a different point in time.

•	 Slip a trimmed audio track in the Audio Timeline or mini-Timeline so a different range of 
media plays at the same location.

•	 Trim an audio track in the Audio Timeline or mini-Timeline to reduce track length or to 
have the media start or end at a specific point in time. 

Each of these editing techniques is nondestructive—it doesn’t alter the audio source file on 
your computer or external storage device.
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Show the Audio Timeline
In Motion, do one of the following:

•	 Choose Window > Audio Timeline (or press Command-9).

•	 Click the Show/Hide Audio Timeline button in the timing toolbar (above the Timeline).

Slide an audio track
Slide an audio track to change its position in the Timeline. 

In Motion, do one of the following:

•	 In the Audio Timeline, drag an audio track’s green bar left or right.

•	 Select an audio track in the Audio list, then in the mini-Timeline, drag the track’s green 
bar to the left or right.

Slip an audio track
Slip an audio track to change the range of playable media. When you slip an audio track, its 
In and Out points remain unchanged in the Timeline, but the playable portion of the audio 
file changes. 

In Motion, do one of the following:

•	 In the Audio Timeline, press and hold the Option key, then drag left or right to slip the 
portion of the audio file.

As you drag, the pointer becomes a slip pointer, a dimmed bar representing the full 
range of the audio clip appears over the green bar, and a tooltip appears, showing the In 
and Out points of the audio clip.

•	 In the Audio list, select a track, then press and hold the Option key and drag left or right 
over the green bar in the mini-Timeline. 
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As you drag, the pointer becomes a slip pointer, a dimmed bar representing the full 
range of the audio clip appears over the green bar, and a tooltip appears, showing the In 
and Out points of the audio clip.

Note: You can only slip media that has had its In or Out points trimmed, leaving unused 
audio available on either side or both sides of the green bar.

Trim an audio track visually
Trim an audio track to reduce track length or to have it start or end at a specific point 
in time.

In Motion, do one of the following:

•	 In the Audio Timeline, place the pointer over the beginning or end of a green bar until 
the trim pointer appears, then drag left or right.

As you drag, a tooltip shows you the new In or Out point and the duration of the 
modified track.

•	 In the Audio list, select a track, place the pointer over the beginning or end of the green 
bar in the mini-Timeline until the trim pointer appears, then drag left or right.

As you drag, a tooltip shows you the new In or Out point and the duration of the 
modified track.

Trim an audio track numerically
1.	 In the Audio list in Motion, select an audio track.

2.	 Open the Properties Inspector and show the Timing parameters.

3.	 Adjust the In, Out, or Duration value sliders.

As you adjust the value sliders, the green bars in the Audio Timeline and mini-Timeline are 
updated.

Trim an audio track from the Mark menu
•	 In the Audio list in Motion, select an audio track, then do one of the following:

•	 Change the track’s start point: Move the playhead to the frame you want, then 
choose Mark > Move Selected In Point.

•	 Change the track’s end point: Move the playhead to the frame you want, then choose 
Mark > Move Selected Out Point.
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Use markers with audio in Motion
When you add project markers to the Timeline, they’re visible in the ruler at the top of the 
Timing pane. You can use project markers to designate “hit points” as you play the project, 
to jump to a specific point, or to highlight points to synchronize visual and audio events.

For information on adding and deleting markers, moving markers, editing marker 
information, and using markers, see Intro to Timeline markers.

Make advanced audio adjustments

Work with the Output audio track in Motion

Each project has an Output audio track. The controls for the Output audio track are located 
at the bottom of the Audio list, below the individual audio tracks. Using the Output audio 
track’s controls, you can make changes that affect the final mixed output of all audio 
tracks. For example, you can lower the volume of all tracks at once, or pan all tracks to the 
left or right. In addition, you can turn the Output audio track on or off, or mute it.

You select the Output audio track by clicking its area at the bottom of the Audio list. When 
selected, the Output audio track area is highlighted.

Turn the Output audio track on or off
The Output audio track is turned on by default. When its activation checkbox is deselected, 
no sound is audible when you play the project, and no audio is included when you export 
your project. When the checkbox is selected, all audio tracks that are active are included in 
your export.

•	 In Motion, click the checkbox on the left side of the Output audio track; click the 
checkbox again to return the Output audio track to its previous state.

Set the overall level of audio in your project
You can use the Level slider to set the overall volume of audio in your project.

•	 In the Output audio track in Motion, drag the Level slider left or right.

The Level slider multiplies the level setting for each track. For example, if you set a 
track’s level to 0.5 and you set the output audio level to 0.5, the combined level is 0.25 
(one-fourth of the original).

Note: If you raise an individual track’s level and the output audio level so that the 
combined increase is greater than 2, you may cause audio distortion, known as clipping.
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Reset the clipping indicators
On the right side of the Output audio track controls, a pair of stereo level meters displays 
the combined level of all audible tracks. If either of the two red dots above the level meters 
(called clipping indicators) illuminates during playback, your output audio levels are too 
high, causing distortion, known as clipping. You need to find where clipping is occurring 
and lower the level.

Play the project and observe where the clipping indicators illuminate. You can solo each 
audio track to determine which track is causing the clipping. After you determine which 
track is causing the clipping, you can lower that track’s overall level, or use keyframes to 
lower the track’s level at the specific point where clipping occurs. The clipping indicators 
are “sticky,” meaning that when they illuminate, they stay lit until you reset them or close 
the project. This helps remind you to find and eliminate the cause of the clipping before 
you export your project. As you work to eliminate clipping, reset the clipping indicators and 
play the project again to make sure clipping no longer occurs.

•	 To reset a clipping indicator in Motion, click a lit clipping indicator in the Output audio 
track.

Set how sound is distributed in the stereo field
•	 In the Output audio track in Motion, adjust the Pan dial to place the sound where you 

want it in the stereo field.

The Pan dial in the Output audio track works with the pan setting for each track. For 
example, if you pan a track to –100 (hard left) and you pan the Output audio track to 100 
(hard right), the track is inaudible.

Select audio output channels in Motion

If you’re working with more than one audio track, you can adjust which tracks are assigned 
to which output channels, or you can create your own multichannel file from mono tracks.

Important: To export multichannel audio from Motion, you must first set the Output audio 
track to 5.1 Surround. You can then export up to six channels of mono audio. See Export 
audio only.

Set or change output channels
In Motion, do one of the following:

•	 Set the channel for a specific audio track: In the Audio list, click the output channel 
pop-up menu for the audio track.
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•	 Set the Output audio track channel: In the Audio list, click the output channel pop-up 
menu in the Output audio track area, then choose 5.1 Surround or Stereo.

Animate audio level and pan in Motion

You can use keyframes to automate level and pan changes over time. Audio keyframes for 
level and pan changes are visible in the Audio Timeline and Keyframe Editor. You can adjust 
these keyframes (and their curves) to create fade-ins and fade-outs, to drop audio levels 
for voiceovers and other sound effects, and to eliminate clipping. (For general information 
about using keyframes and editing curves, see Intro to keyframing.)

Add audio keyframes
1.	 In Motion, move the playhead to the frame where you want to record a keyframe.

2.	 Select an audio track in the Audio list or Audio Timeline, then do one of the following:

•	 Click the Record button in the timing toolbar, open the Audio Track Inspector, then 
adjust the Level slider or Pan slider. 

•	 Open the Audio Track Inspector, adjust the Level slider or Pan slider, then click the 
Add Keyframe button (the diamond icon) to the right of the slider you adjusted. 

A keyframe is added at the current frame. To see the keyframe in the Audio Editor, click 
the Show Keyframes button in the upper-right corner of the Timing pane.

3.	 Move the playhead to a new frame.

4.	 In the Audio Track Inspector, drag the Level slider or Pan slider to set a different value.

A keyframe is added at the current frame.

If you turned on keyframe recording in step 2 by clicking the Record button, click it again 
to turn off keyframe recording.

Edit audio keyframes
After you add Level or Pan keyframes, you can change their values in the Audio Timeline 
or Keyframe Editor. In the Audio Timeline, keyframes appear in sequence along a flat line, 
showing their relative positions in time. In the Keyframe Editor, keyframes appear in a two-
dimensional graph showing their positions in time (horizontally) and their parameter values 
(vertically).

In Motion, do one of the following:

•	 Edit keyframes in the Audio Timeline: Drag keyframes left or right to adjust their 
positions in time.

If you added Level and Pan keyframes at the same frame, dragging the keyframe in the 
Audio Timeline adjusts all audio keyframes at that frame.

•	 Edit keyframes in the Keyframe Editor: Drag keyframes left or right to adjust their 
positions in time; drag keyframes up or down to change their Level or Pan values. 



1253Motion User Guide

The Level and Pan parameters are adjusted using different numeric ranges:

•	 Level curves range from –96 to 6 with 0 equivalent to 0 dB (unity gain).

•	 Pan curves range from –100 to 100.

Because Level and Pan curves each use a different scale, it can be difficult to frame them 
at the same time in the Keyframe Editor.

Delete an audio keyframe
In Motion, do one of the following:

•	 In the Audio Timeline, select a Level or Pan keyframe, then press delete.

•	 In the Audio Timeline, Option-click a Level or Pan keyframe, then choose Delete from 
the shortcut menu.

Crossfade audio tracks
To create a crossfade between two audio tracks in Motion, add keyframes to the level 
curve of each track at the same (or nearly the same) points where you want the crossfade 
to start and end.

1.	 In Motion, move the playhead to the frame where you want to start the crossfade.

2.	 In the Audio list or Audio Timeline, select an audio track, then do one of the following:

•	 Click the Record button in the timing toolbar, open the Audio Track Inspector, then 
drag the Level slider to the left. 

•	 Open the Audio Track Inspector, drag the Level slider to the left, then click the Add 
Keyframe button (the diamond icon) to the right of the slider you adjusted.

A keyframe is added at the current frame. To see the keyframe in the Audio Editor, click 
the Show Keyframes button in the upper-right corner of the Timing pane.

3.	 Move the playhead to the point where you want the audio completely faded out, then do 
one of the following:

•	 If you added a keyframe in step 2 using the Record button method, set the Level 
slider to zero.

•	 If you added a keyframe in step 2 using the Add Keyframe button method, click the 
Add Keyframe button again, then set the Level slider to 0.

A keyframe is added at the current frame. 

4.	 In the Audio list or Audio Timeline, select another audio track, then do one of the 
following:

•	 If you used the Record button method in previous steps, open the Audio Track 
Inspector, then adjust the Level slider to 0. 

•	 If you used the Add Keyframe button method in previous steps, open the Audio Track 
Inspector, adjust the Level slider to 0, then click the Add Keyframe button to the 
right of the slider you adjusted. 

A keyframe is added at the current frame. 
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5.	 Move the playhead to the point where you want the audio completely faded in, then do 
one of the following:

•	 If you used the Record button method in previous steps, set the Level slider to the 
level you want.

•	 If you used the Add Keyframe button method in previous steps, click the Add 
Keyframe button again, then set the Level slider to 0.

A keyframe is added at the current frame. 

If you used the Record button method in previous steps, click the Record button again 
to turn off keyframe recording.

Listen to the crossfade as you work. You may find that the best-sounding results are 
achieved by having the level curves for the two tracks be slightly asymmetrical. This is 
because the perceived loudness of different sounds with the same numerical value can be 
different.

Sync audio and video in Motion

Motion lets you determine how to handle the playback of audio when audio tracks are not 
in sync with the video. You can skip video frames to resync with the audio, or pause audio 
playback to avoid skipping frames if the video is out of sync.

Set audio sync preferences
1.	 In Motion, choose Motion > Settings, then open the Time pane.

2.	 In the Playback Control section, select one of the following: 

•	 Skip video frames: Video frames are dropped to enable an uninterrupted flow of 
audio, for as close to real-time playback as possible.

•	 Pause audio playback: Audio playback pauses when video and audio are out of sync, 
then begins when audio catches up on the next loop. This enables an uninterrupted 
flow of video frames (at the expense of playback slowing down) to evaluate the look 
of your composition.
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Retime audio in Motion
Motion lets you retime audio tracks in your project, to speed them up, slow them down, or 
play them at a different speed. There are several ways to retime audio tracks:

•	 Adjust the Timing controls in the Properties Inspector to modify an audio track’s 
playback speed, In and Out points, duration, and end condition (whether the track 
stops, loops, or “ping-pongs” back and forth).

•	 Adjust the green bar in the Audio Timeline to modify an audio track’s duration and 
playback speed, and to set whether or not the track loops.

Adjust an audio track’s timing parameters in the Properties Inspector
Each audio object in your project has timing parameters in the Properties Inspector.

1.	 In Motion, select an audio track in the Audio list or Audio Timeline.

2.	 Open the Properties Inspector, move the pointer over the Timing row, then click the 
Show button on the right.

The Timing parameters appear.

Note: The Show button is hidden until you move the pointer over the right side of the 
Timing row.

3.	 Adjust the Timing parameters:

•	 Speed: Drag over the number to set the speed of the audio track as a percentage. 
The default is 100%. Values lower than 100 play the audio track more slowly than its 
original speed, and also extend the Duration of the audio track. Values higher than 
100 play the track faster than its original speed, and shorten its duration.

•	 In: Click the left or right arrow (or enter a new value in the field) to change the In 
point of the audio track. Adjusting this parameter moves the audio track In point to 
the specified frame without affecting track duration.

•	 Out: Click the left or right arrow (or enter a new value in the field) to change the Out 
point of the audio track. Adjusting this parameter moves the audio track Out point to 
the specified frame without affecting track duration.

•	 Duration: Click the left or right arrow (or enter a new value in the field) to set the 
total duration of the audio track. Adjusting Duration also affects the Speed and the 
Out point.

•	 End Condition: Click the pop-up menu, then choose an option to set how playback 
continues when audio ends in the track:

•	 None: The audio track’s duration in your project is equal to the duration of its 
source media file (the default setting).

•	 Loop: When the end of the audio track is reached, the track loops back to the 
beginning of the track and plays again. This can cause a jump in the audio track’s 
apparent playback unless the track is designed to loop seamlessly. The End 
Duration value must be greater than 0 for this parameter to have any effect.
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•	 Ping-Pong: When the end of the audio track is reached, the next iteration of track 
playback is reversed. The End Duration value must be greater than 0 for this 
parameter to have any effect. (The Ping-Pong option is mainly for reference—
the reversed section of the audio track sounds noisy, because Motion does not 
support true reverse playback.)

•	 Hold: The audio stops at the loop point.

•	 End Duration: Drag the slider to set the number of frames by which the track is 
extended at the end of its duration. This control is available only when End Condition 
is set to a value other than None.

Change the audio track’s duration and playback speed in the Audio Timeline
Motion lets you change the timing of audio tracks in the Audio Timeline.

Important: To affect all channels of a multichannel audio file, select all tracks in the Audio 
list before making adjustments in the Audio Timeline.

1.	 In the Audio Timeline in Motion, position the pointer over the end of an audio track’s the 
green bar.

2.	 Do any of the following:

•	 Shorten track duration and increase playback speed: Press and hold the Option key, 
and drag the end of the green bar to the left.

•	 Lengthen track duration and slow playback speed: Press and hold the Option key, 
and drag the end of the green bar to the right.

As you drag, the retiming pointer appears, and a tooltip displays the track’s duration 
and speed. 

Loop an audio track
Another way to extend an audio track’s duration is to loop it. You can easily loop a track 
by adjusting it in the Audio Timeline. When a looped audio track reaches its last frame, the 
audio starts playing from its first frame.

1.	 In the Audio Timeline in Motion, position the pointer close to the end of an audio track’s 
green bar.

2.	 Press and hold the Option and Shift keys, and drag the end of the green bar to the left.

As you drag, the loop pointer appears, and a tooltip displays the track’s In and Out 
points, duration, and loop duration. 

The Audio Timeline displays looped tracks with barriers to indicate where loops begin 
and end. The first loop barrier in a track’s bar is interactive. Dragging the barrier left or 
right changes the point where the track loops.
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Automate effects with audio behaviors

Intro to audio behaviors in Motion
You can use audio behaviors to automate common audio effects such as pans and fades, 
as well as create sophisticated audio-driven animations.

There are three audio behaviors:

•	 Audio Auto Pan behavior automates commonly used panning effects in an audio track.

•	 Audio Fade In/Fade Out behavior automates the fading in and out an audio track. 

•	 Audio parameter behavior performs an analysis of an audio parameter (volume or bass, 
for example), then links changes in that property to any other object parameter in your 
project. For example, you can use the Audio parameter behavior to make a shape pulse 
to the bass of an audio track. 

The Audio Auto Pan behavior and Audio Fade In/Fade Out behavior are located in the Audio 
category of behaviors. You apply them like any other standard behavior: by dragging them 
from the Library to an object in the Layers list, or by using the Behaviors pop-up menu in 
the toolbar. See Intro to applying behaviors. 

The Audio parameter behavior is located in the Parameter category of behaviors. See Apply 
the Audio parameter behavior.

Audio Auto Pan behavior in Motion
The Audio Auto Pan behavior automates commonly used panning effects in an audio track. 
Adjust this behavior using the controls in the Behaviors Inspector:

•	 Pan Position: A slider that sets the position of the pan. If the Pan Position slider is set 
to 0, the sound is equally balanced between the left and right channels. With larger 
negative values of Pan Position, the sound increases in volume in the left channel and 
decreases in the right channel. With larger positive values of Pan Position, the sound 
increases in volume in the right channel and decreases in the left channel.

•	 Depth: A slider that sets how far the automatic pan occurs in the left and right channels. 
Values range from 0 to 100.

•	 Direction: A pop-up menu that sets the direction in which the pan moves over the 
behavior’s duration. Choose Left or Right to increase volume in one channel and 
decrease volume in the other channel over the behavior’s duration, giving the 
impression of a sound moving from one direction to another. 

•	 Volume: A pop-up menu that sets how audio levels are affected during the pan. Choose 
from five options:

•	 Constant: An animation curve that allows no change in volume.

•	 Ramp Up: An animation curve that creates a constant increase in volume

•	 Ramp Down: An animation curve that creates a constant decrease in volume

•	 Crescendo: A logarithmic animation curve that creates a slowly accelerating increase 
in volume

•	 Decrescendo: A logarithmic animation curve that creates a slowly decelerating 
decrease in volume



1258Motion User Guide

•	 Gain: A slider that sets the target gain used for volume. Values range from –96 dB to +6 
dB.

•	 Loops: A slider that sets the number of times the auto pan effect repeats. Values range 
from 1 to 30.

•	 Apply Volume: A pop-up menu that sets how audio levels change when the Auto Pan 
effect repeats. Choose Once Per Loop or Over Entire Duration. If you choose Once Per 
Loop, the Auto Pan affects audio level changes each time a loop barrier is met. If you 
choose Over Entire Duration, the Auto Pan affects audio level changes over the duration 
of the track.

•	 End Condition: A pop-up menu that sets how the pan loops when the Auto Pan effect 
repeats. Choose Repeat or Ping Pong. This setting has an effect only if Loops is set to a 
value greater than 1.

•	 Start Offset: A slider that sets the number of frames from the beginning of the audio 
after which the audio effect starts.

•	 End Offset: A slider that sets the number of frames from the end of the audio before 
which the audio effect stops.

Audio Fade In/Fade Out behavior in Motion
The Fade In/Fade Out behavior automates fading in and out an audio track. Adjust this 
behavior using the controls in the Behaviors Inspector:

•	 Fade In Time: A slider that sets the number of frames over which the audio fades in, 
from –96 dB to 0 dB. A duration of 0 frames leaves the beginning of the audio track 
unmodified.

•	 Fade Out Time: A slider that sets the number of frames over which the audio fades, 
out from 0 dB to –96 dB. A duration of 0 frames leaves the end of the audio track 
unmodified.

•	 Start Offset: A slider that sets the number of frames from the beginning of the audio 
track after which the volume animation starts. Adjust this parameter to make the 
behavior start after the beginning of the audio track.

•	 End Offset: A slider that sets the number of frames from the end of the audio before 
which the animation stops. Adjust this parameter to make the behavior end before the 
end of the audio track.

The Audio Fade In/Fade Out behavior has a custom graphical control in the HUD. Drag the 
beginning or end of the graph to modify the Fade In Time and Fade Out Time parameters:

Note: The HUD control for the Audio Fade In/Fade Out HUD behavior is identical to that of 
the Fade In/Fade Out behavior behavior (in the Basic Motion category of behaviors).
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Audio parameter behavior in Motion
The Audio parameter behavior performs an analysis of a specific property of an audio 
track, then applies an animation curve to a parameter of another object in your project 
based on that analysis. You can apply the Audio parameter behavior to parameters of 
filters, replicators, shapes, particle systems, lights, text, and even other behaviors to make 
your visuals pulse in sync to the beat of a soundtrack.

Adjust this behavior using the controls in the Behaviors Inspector:

•	 Source Audio: A source well that sets the audio track from which to read audio data. 
Drag an audio clip or a video clip containing audio into the Source Audio well, or use the 
pop-up menu to choose a source for audio analysis.

Note: For the Audio parameter behavior to have an effect on an object, audio must be 
present in the Audio Timeline at the position of the behavior.

•	 Respond To: A pop-up menu that sets the type of audio data analysis to perform. 
Choose Amplitude or Transients. If set to Amplitude, the behavior responds to peak 
values of a particular frequency. If set to Transients, the behavior responds to rapid 
changes in frequency.

•	 Graph Range: A pop-up menu that sets the initial range of frequency values to be 
analyzed by the behavior. There are four options: All Frequencies, Bass, Mid, or Treble. 
The option you choose affects the frequency range of the Low Frequency and High 
Frequency parameters (described below).

•	 Audio Graph: A graph displaying a visual representation of the Source Audio data 
analyzed by the behavior per frame.

Click the Play button beneath the Audio Graph to see the selected Source Audio data as 
it plays back live. If analysis underway, a progress bar appears in the Audio Graph area. 
The Output level meter shows the amount of audio data from this behavior being sent to 
the visual effect in Motion. (Output is controlled by the Scale slider, described below.)

Set Low Frequency, High Frequency, Floor, and Ceiling values by dragging the small 
tags along the bottom or right side of the graph. Alternatively, you can set these values 
numerically using the four sliders underneath the graph to isolate specific frequencies 
and values for analysis:

•	 Low Frequency: A slider that sets the low frequency threshold of audio analysis. Only 
audio frequencies above this value are analyzed. Values range from 1 Hz to 22,050 Hz.

•	 High Frequency: A slider that sets the high frequency threshold of audio analysis. Only 
audio frequencies below this value are analyzed. Values range from 1 Hz to 22,050 Hz.
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•	 Floor: A slider that sets the minimum value of audio input, below which results are 
ignored. Values range from 0 to 1.

•	 Ceiling: A slider that sets the maximum value of audio input, above which results are 
ignored. Values range from 0 to 1.

•	 Smoothness: A slider (available when Respond To is set to Amplitude) that sets the 
window size to smooth the result curve. Any value other than 0 triggers a keyframe 
reduction with an error tolerance of 1%. Values range from 0 to 10. 

Note: Depending on your audio file, Smoothness values greater than 7 may result in 
audio playing out of sync.

•	 Sensitivity: A slider (available when Respond To is set to Transients) that sets the 
sensitivity of the transient detection. Values range from 0% to 100%.

•	 Channel: A pop-up menu that sets the audio channel to analyze. Choose Mix/Mono, 
Left, or Right.

Note: With a multichannel audio file used as a source, you must select Mix/Mono for 
audio analysis to be performed properly.

•	 Peaks: A pop-up menu that sets how Motion generates peak curves in the Keyframe 
Editor based on audio analysis data. Changing peak options affects how the Audio 
behavior is applied to its parent object. There are four menu options:

•	 Sharp: Peaks are generated from the maximum amplitude of the audio channels 
you choose from the Channel parameter and the frequencies you set in the Graph 
Range. You can adjust which portion of the audio bandwidth is analyzed using the 
Graph Range pop-up menu and the sliders in the Audio Graph. When Respond To is 
set to Transients, two keyframes are added before and after each transient keyframe 
(attack and release), and the transient keyframes are interpolated as linear sharp 
peaks.

•	 Smooth: Peak curves are generated from the average amplitude of the audio 
channels you choose from the Channel parameter and the frequencies you set in the 
Graph Range. You can adjust which portion of the audio bandwidth is analyzed using 
the Graph Range pop-up menu and the sliders in the Audio Graph. When Respond 
To is set to Transients, two keyframes are added before and after each transient 
keyframe (attack and release), and the transient keyframes are interpolated as 
smooth curves.

•	 Square: When Respond To is set to Transients, this option appears. Two keyframes 
are added before and after each transient keyframe (attack and release), and the 
transient keyframes are constantly interpolated as square peaks.

•	 Continuous: When Respond To is set to Transients, this option appears. The 
transient values are interpolated with no additional processing and appear as is.

•	 Attack: A slider (available when Respond To is set to Transients) that modifies the 
animation curve to the amount of the offset in frames between the peak of the curve 
generated by the Audio behavior and the first frame of the curve. The number of frames 
that the curve takes to reach its peak value from its initial value is called the Attack. 

•	 Release: A slider (available when Respond To is set to Transients) that modifies the 
animation curve to the amount of the offset in frames between the peak of the curve 
generated by the Audio behavior and the last frame of the curve. The number of frames 
that the curve takes to reach its final value from its peak is called the Release.
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•	 Apply Mode: A pop-up menu that sets the method by which the audio analysis affects 
the curve. Choose Add, Subtract, Multiply, or Add and Subtract.

•	 Delay: A slider that sets a delay in frames to offset the resulting keyframes.

•	 Scale: A slider that sets the scale factor to affect the result of the audio analysis.

•	 Apply To: A parameter assignment pop-up menu that sets the object parameter to 
which the audio behavior is applied.

Apply the Audio parameter behavior in Motion
The Audio parameter behavior generates audio-driven animations in your projects by 
linking changes in an audio track to any other object parameter, including parameters 
of filters, replicators, particle systems, lights, text, and even other behaviors. The Audio 
parameter behavior lets you make a particle system pulse to the beat of a bass line, text 
jitter to the treble of a vocal track, or a light strobe to the rhythm of a funky guitar riff.

For a list of all parameter controls in this behavior, see Audio parameter behavior.

Apply the Audio parameter behavior to an object parameter
1.	 In the Layers list, Timeline, or canvas in Motion, select an object.

2.	 In the Properties Inspector, do one of the following:

•	 Control-click a parameter name (Position or Rotation, for example), then choose Add 
Parameter Behavior > Audio from the shortcut menu.

•	 Click the Animation menu (the down arrow that appears when you move the pointer 
over the right side of a parameter row) for the parameter you want to animate, then 
choose Add Parameter Behavior > Audio. 

The Audio parameter behavior is applied to the chosen parameter of the selected 
object, but no source audio is yet applied.

3.	 In the Behaviors Inspector, click the To pop-up menu (in the Source Audio row), then 
choose a source audio track.

Play back the project to see how the Audio behavior affects the object.

4.	 To increase the intensity of the effect, drag the Scale slider (in the Behaviors Inspector) 
to the right.

5.	 Adjust the other parameters in the Behaviors Inspector as needed, particularly the 
Frequency parameters. For a complete list of parameter controls in this behavior, see 
Audio parameter behavior. 
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Apply the Audio parameter behavior from the Behaviors pop-up menu
1.	 In the Layers list, Timeline, or canvas in Motion, select an object.

2.	 In the toolbar, click Behaviors, then choose Parameter > Audio.

The Audio parameter behavior is applied to the selected object. However, you still need 
to assign a parameter to be animated and apply source audio to drive the animation.

3.	 To assign a parameter to animate, click the To pop-up menu in the Apply To row (at the 
bottom of the Behaviors Inspector), then choose a parameter. 

4.	 To apply source audio to drive the animated parameter, click the To pop-up menu in the 
Source Audio row (at the top of the Behaviors Inspector), then choose a source audio 
track.

Play back the project to see how the Audio behavior affects the object.

5.	 To increase the intensity of the effect, drag the Scale slider (in the Behaviors Inspector) 
to the right.

6.	 Adjust the other parameter controls in the Audio section of the Behaviors Inspector as 
needed, particularly the frequency sliders. For a complete list of parameter controls in 
this behavior, see Audio parameter behavior. 
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Share Motion projects

Intro to sharing Motion projects
Motion provides a variety of preconfigured export settings, called destinations, that you 
can use to output your project. For example, you can export a project as a QuickTime 
movie, export it for viewing on Apple devices such as iPhone, iPad, and Apple TV, or export 
it as an image sequence. You can also export a single frame or export a single selection as 
a movie. Each of these options uses a different destination.

When you first open Motion, a default set of destinations appears in the Share menu in the 
toolbar.

Details about each destination in the default set are listed in the table below.

Destination Use to

Export Movie (default) Export your project as a QuickTime movie file. See 
Export a QuickTime movie.

Export Selection to Movie Export a selected object from your project as a movie 
file. See Export a QuickTime movie.

Export Audio Export only your project’s audio. See Export audio only.

Save Current Frame Export a single image file of any video frame in your 
project. See Export a still image.

Export Image Sequence Export your project as an image sequence. See Export 
an image sequence.
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Destination Use to

Apple Devices Export files for Apple devices, such as iPhone, iPad, 
iPod Touch, and Apple TV. See Export to Apple devices.

Email Create an email message in the macOS Mail app and 
include your movie as an attachment. See Export to 
email.

Add Destination Create your own customized destination. See Create 
and modify share destinations.

If you have Compressor installed (Apple’s professional transcoding application), you 
can further customize your output file or spread the processing work across multiple 
computers, for faster rendering. For more information about Compressor, see the 
Compressor website.

Export a QuickTime movie in Motion
Export your project as a QuickTime movie file when you want to:

•	 Use the movie file in another Apple application, such as GarageBand, Pages, or 
Keynote; or when you want to use it in a third-party application

•	 Copy the movie file to an external storage device or post it to a server for a client to 
review

•	 Publish the movie file to a video-sharing website such as YouTube and Vimeo

Note: You can also export your Motion 360° projects for posting on YouTube’s Virtual 
Reality channel or Vimeo 360. See Export and share 360° projects.

Share your project as a movie file
1.	 In Motion, do one of the following:

•	 Choose File > Share > Export Movie (or press Command-E).

•	 On the right side of the toolbar, click Share, then choose Export Movie.

2.	 In the Info pane of the Export Movie window, view or modify project attributes, such as 
the title and description.

https://www.apple.com/final-cut-pro/compressor/
https://www.youtube.com/channel/UCzuqhhs6NWbgTzMuM09WKDQ
https://www.youtube.com/channel/UCzuqhhs6NWbgTzMuM09WKDQ
https://join.vimeo.com/360/
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3.	 In the Settings pane of the Export Movie window, choose your preferred export settings:

•	 Format: Choose whether to export video only or video and audio.

Note: You can also select a publishing format, including Apple Devices (such as iPhone 
and iPad), Computer (for playback on Mac and PC), and Web Hosting (such as YouTube 
or Vimeo). Your choice of format determines the options in the pop-up menus below.

•	 Video Codec: The source codec is chosen by default, but you may choose another 
codec.

•	 Resolution: The default frame size, defined by the Project Properties.

•	 Color Space: The range of color used in the exported movie. The default option (“Use 
canvas setting”) applies your project’s color space, but you can choose a different 
color space. For more information about color space, see About color space.

•	 Color Channels: Choose whether to output color channels (RGB) only, or color 
channels plus an alpha channel (transparency).

Note: Not all codecs support an embedded alpha channel. For codecs that don’t 
support an alpha channel, no alpha channel is saved, regardless of the option you 
choose in this pop-up menu.

•	 Audio Format: The audio format is chosen by default based on the selected video 
codec. (To choose another audio format, you must choose Audio Only from the 
Format pop-up menu, which then only exports the project’s audio.)

•	 Duration: Select whether to export the entire project or a play range set in the Timeline.

•	 Export selected layer only: Select to export only the layer that’s currently selected 
in the project. If no image layer is selected, or if an object that does not render is 
selected (such as a rig, a light, or a camera), this option is dimmed.

•	 Action: Choose what you want to happen after the export is complete. See Export 
File destination.

You must have Compressor installed on your system for Open with Compressor to 
work.

Note: If you change the destination’s settings, the changes are saved as the default 
settings for the destination. See Create and modify share destinations.
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4.	 In the Render pane of the Export Movie window, specify additional Motion-specific 
export options.

For a description of each setting in the Render pane, see Render settings.

5.	 Click Next.

6.	 Enter a name and choose a save location for the exported file, then click Save.

Share a selected object from your project as a movie file
1.	 In Motion, select an object in the Layers list or Timeline, then do one of the following:

•	 Choose File > Share > Export Selection to Movie (or press Option-Command-E).

•	 On the right side of the toolbar, click Share, then choose Export Selection to Movie.

Note: If an object that does not render is selected (such as a rig, a light, or a 
camera), the Export Selection to Movie option is not available.

2.	 In the Info pane of the Export Selection to Movie window, view or modify project 
attributes, such as the title and description.

3.	 In the Settings pane of the Export Selection to Movie window, choose your preferred 
export settings:

•	 Format: Choose whether to export video only or video and audio.

Note: You can also select a publishing format, including Apple Devices (such as 
iPhone and iPad), Computer (for playback on Mac and PC), and Web Hosting (such 
as YouTube or Vimeo). Your choice of format determines the options in the pop-up 
menus below.

•	 Video Codec: The source codec is chosen by default, but you may choose another 
codec.
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•	 Resolution: The default frame size, defined by the Project Properties.

•	 Color Space: The range of color used in the exported movie. The default option 
(“Use canvas setting”) applies your project’s color space, but you can choose a 
different color space. For more information about color space, see About color 
space.

•	 Color Channels: Choose whether to output color channels (RGB) only, or color 
channels plus an alpha channel (transparency).

Note: Not all codecs support an embedded alpha channel. For codecs that don’t 
support an alpha channel, no alpha channel is saved, regardless of the option you 
choose in this pop-up menu.

•	 Audio Format: The audio format is chosen by default based on the selected video 
codec. (To choose another audio format, you must choose Audio Only from the 
Format pop-up menu, which then only exports the project’s audio.)

•	 Duration: Select whether to export the entire project or a play range set in the 
Timeline.

•	 Export selected layer only: Leave this checkbox selected to export only the object 
selected in the project.

•	 Action: Choose what you want to happen after the export is complete. See Export 
File destination.

Note: If you change the destination’s settings, the changes are saved as the default 
settings for the destination. See Create and modify share destinations.

4.	 In the Render pane of the Export Selection to Movie window, specify additional Motion-
specific export options.

For a description of each setting in the Render pane, see Render settings. 

5.	 Click Next.

6.	 Enter a name and choose a save location for the exported file, then click Save.

You can monitor the progress of your export in the Background Task List, and you can 
continue to work in Motion while the file is rendered.

When exporting is complete, a notification appears. Click the notification to display the 
shared file in the Finder.

 Tip: When you export your project, the audio is exported according to your computer’s 
current audio settings. You can change the exported audio sample rate using the Audio 
MIDI Setup application in macOS. To do so, quit Motion, then in the Finder, choose Go > 
Utilities and open the Audio MIDI Setup application. In the Output pane, specify a new 
sample rate. When you reopen Motion, although the chosen sample rate is not displayed in 
the Motion share dialog, your project is exported with the sample rate set in the Audio MIDI 
Setup application.



1268Motion User Guide

Export audio only in Motion
You can export your project’s audio using the Export Audio command. You might want to 
do this to create a single audio file that contains a mix of all the project’s audio tracks.

Note: When using Export Audio, Motion’s audio export is limited to 44.1 kHz.

Share your project’s audio by itself
1.	 In Motion, do one of the following:

•	 Choose File > Share > Export Audio.

•	 On the right side of the toolbar, click Share, then choose Export Audio.

2.	 In the Info pane of the Export Audio window, view or modify project attributes, such as 
the title and description.

3.	 In the Settings pane of the Export Audio window, choose your preferred export settings:

•	 Format: The Audio Only export format is chosen by default.

•	 Audio Format: The audio format is chosen by default based on the selected video 
codec. (To choose another audio format, you must choose Audio Only from the 
Format pop-up menu, which then only exports the project’s audio.)

•	 Duration: Select whether to export the entire project or a play range set in the 
Timeline.
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•	 Action: Choose what you want to happen after the export is complete. See Export 
File destination.

The default application depends on the selected Audio Format:

•	 AAC and MP3 files open in Music.

•	 AIFF, CAF, and WAVE files open in QuickTime.

•	 AC3 files open in Compressor (or in the application set by the Finder as the 
default application for AC3 files). For more information on the Finder, see macOS 
Help (in the Finder, choose Help > macOS Help).

You must have Compressor installed on your system for Open with Compressor to 
work.

Note: If you change the destination’s settings, the changes are saved as the default 
settings for the destination. See Create and modify share destinations.

4.	 Click Next.

5.	 Enter a name and choose a save location for the exported file, then click Save.

You can monitor the progress of your export in the Background Task List, and you can 
continue to work in Motion while the file is rendered.

When exporting is complete, a notification appears. Click the notification to display the 
shared file in the Finder.

Export a still image in Motion
You can save a single image file of any video frame in your project using the Save Current 
Frame command.

Share a still frame
1.	 In your Motion project, move the playhead to the frame to be saved, then do one of the 

following:

•	 Choose File > Share > Save Current Frame.

•	 On the right side of the toolbar, click Share, then choose Save Current Frame.

2.	 In the Info pane of the Save Current Frame window, view or modify project attributes, 
such as the title and description.
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3.	 In the Settings pane of the Save Current Frame window, choose your preferred export 
settings:

•	 Export: Choose an export file type, such as Photoshop, PNG, or TIFF.

•	 Scale image to preserve aspect ratio: Leave this checkbox selected unless your 
project uses a nonsquare pixel format (such as 1440 x 1080) and you want to use 
the exported still image in another video project with the same nonsquare pixel 
properties.

•	 Color Space: The range of color used in the exported image. The default option 
(“Use canvas setting”) applies your project’s color space, but you can choose a 
different color space. For more information about color space, see About color 
space.

•	 Color Channels: Choose whether to output color channels (RGB) only, or color 
channels plus an alpha channel (transparency).

Note: Not all file types in the Export menu support an embedded alpha channel. For 
file types that don’t support an alpha channel, no alpha channel is saved, regardless 
of the option you choose in this pop-up menu.

•	 Export selected layer only: Select to export a single frame of a single layer selected 
in the project. If no layer is selected, or if an object that does not render is selected 
(such as a rig, a light, or a camera), this option is dimmed.

Note: If you change the destination’s settings, the changes are saved as the default 
settings for the destination. See Create and modify share destinations.

4.	 In the Render pane of the Export Selection to Movie window, specify additional Motion-
specific export options.

For a description of each setting in the Render pane, see Render settings.

5.	 Click Next.

6.	 Enter a name and choose a save location for the exported file, then click Save.

You can monitor the progress of your export in the Background Task List, and you can 
continue to work in Motion while the file is rendered.

When exporting is complete, a notification appears. Click the notification to display the 
shared file in the Finder.
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Export an image sequence in Motion
You can export your project’s visuals as an image sequence—a set of sequentially 
numbered still-image files that are compatible with many professional finishing, 
compositing, and grading applications—using the Export Image Sequence command.

Share your project as an image sequence
1.	 In Motion, do one of the following:

•	 Choose File > Share > Export Image Sequence.

•	 On the right side of the toolbar, click Share, then choose Export Image Sequence.

2.	 In the Info pane of the Export Image Sequence window, view or modify project 
attributes, such as the title and description.

3.	 In the Settings pane of the Export Image Sequence window, choose your preferred 
export settings:

•	 Export: Choose an export format such as PNG, TIFF, or OpenEXR.

•	 Scale image to preserve aspect ratio: Leave this checkbox selected unless your 
project uses a nonsquare pixel format (such as 1440 x 1080) and you want to use the 
exported image sequence in another video project with the same nonsquare pixel 
properties.

•	 Create sticker sequence: Select this checkbox if you’re creating animated stickers 
for the Messages app on iOS and iPadOS devices. See Create stickers for Messages 
or go to developer.apple.com/support/stickers/motion/.

•	 Color Space: The range of color used in the exported image sequence. The default 
option (“Use canvas setting”) applies your project’s color space, but you can choose 
a different color space. For more information about color space, see About color 
space.

https://developer.apple.com/support/stickers/motion/
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•	 Color Channels: Choose whether to output color channels (RGB) only, or color 
channels plus an alpha channel (transparency).

Note: Not all file types in the Export menu support an embedded alpha channel. For 
file types that don’t support an alpha channel, no alpha channel is saved, regardless 
of the option you choose in this pop-up menu.

•	 Duration: Select whether to export the entire project or a play range set in the 
Timeline.

•	 Export selected layer only: Select to export an image sequence of a single layer 
selected in the project. If no layer is selected, or if an object that does not render is 
selected (such as a rig, a light, or a camera), this option is dimmed.

Note: If you change the destination’s settings, the changes are saved as the default 
settings for the destination. See Create and modify share destinations.

4.	 In the Render pane of the Export Selection to Movie window, specify additional Motion-
specific export options.

For a description of each setting in the Render pane, see Render settings. 

5.	 Click Next.

6.	 Enter a name and choose a save location for the exported file, then click Save.

Important: This command creates a folder using the name you entered. The image 
sequence files are saved here.

You can monitor the progress of your export in the Background Task List, and you can 
continue to work in Motion while the file is rendered.

When exporting is complete, a notification appears. Click the notification to display the 
shared file in the Finder.

Export to Apple devices in Motion
You can export your project for playback on an Apple device such as iPhone or iPad, or 
on a home theater system using Apple TV. You can use the default export settings or 
customize the settings to suit your needs. For information about customizing settings, see 
Create and modify share destinations.

Share to Apple devices
1.	 In Motion, do one of the following:

•	 Choose File > Share > Apple Devices.

•	 On the right side of the toolbar, click Share, then choose Apple Devices.

2.	 In the Info pane of the Apple Devices window, view or modify project attributes, such as 
the title and description.
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3.	 In the Settings pane of the share window, choose your preferred export settings:

•	 Format: Leave this pop-up menu set to Apple Devices.

•	 Video Codec: Choose H.264 Better Quality to maximize the quality of your export; 
choose H.264 Faster Encode to speed up your export. Additional options include 
HEVC 8-bit, HEVC 10-bit, and HEVC 10-bit (HLG with Dolby Vision 8.4).

Note: Dolby Vision 8.4 is a format designed to optimize HDR content for Apple 
Devices. For more information, see the Apple Support article about editing HDR 
video and the Apple Support article about possible color shifts in shared Dolby 
Vision HDR video.

•	 Resolution: Choose a frame size (for example 1920 x 1080 for HD or 3840 x 2160 for 
4K). If the Motion project is a lower resolution than the setting you choose here, the 
exported file uses the project resolution.

•	 Color Space: The range of color used in the exported movie. The default option 
(“Use canvas setting”) applies your project’s color space, but you can choose a 
different color space. For more information about color space, see About color 
space.

•	 Color Channels: Choose whether to output color channels (RGB) only, or color 
channels plus an alpha channel (transparency).

Note: Not all codecs support an embedded alpha channel. For codecs that don’t 
support an alpha channel, no alpha channel is saved, regardless of the option you 
choose in this pop-up menu.

•	 Audio Format: The audio format is chosen by default based on the selected video 
codec. (To choose another audio format, you must choose Audio Only from the 
Format pop-up menu, which then only exports the project’s audio.)

•	 Duration: Select whether to export the entire project or a play range set in the 
Timeline.

•	 Export selected layer only: Select to export a single layer selected in the project. If 
no layer is selected, or if an object that does not render is selected (such as a rig, a 
light, or a camera), this option is dimmed.

https://support.apple.com/102241
https://support.apple.com/102241
https://support.apple.com/101849
https://support.apple.com/101849


1274Motion User Guide

•	 Action: Choose what you want to happen after the export is complete, such as 
adding the file to the Apple TV app or opening the file in QuickTime Player. See 
Export File destination.

Note: If you change the destination’s settings, the changes are saved as the default 
settings for the destination. See Create and modify share destinations.

4.	 To see a list of devices that will play the exported file, move the pointer over the 
compatibility icon in the lower-right corner.

5.	 In the Render pane of the Apple Devices window, specify additional Motion-specific 
export options.

For a description of each setting in the Render pane, see Render settings.

6.	 Click Share.

If this is your first time sharing to the Music app or to the Apple TV app, a permissions 
message appears. Click OK to allow Motion access to the apps.

You can monitor the progress of your export in the Background Task List, and you can 
continue to work in Motion while the file is rendered.

Export to email in Motion
You can create an email message in the macOS Mail app and include your movie as an 
attachment.

Share a project using email
1.	 In Motion, do one of the following:

•	 Choose File > Share > Email.

•	 On the right side of the toolbar, click Share, then choose Email.

2.	 In the Info pane of the Email window, view or modify project attributes, such as the title 
and description.
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3.	 In the Settings pane of the Email window, choose your preferred export settings:

•	 Compression: Choose a render quality. “Faster encode” sacrifices quality for faster 
processing.

•	 Resolution: Choose a frame size for your movie.

•	 Color Space: The range of color used in the exported movie. The default option 
(“Use canvas setting”) applies your project’s color space, but you can choose a 
different color space. For more information about color space, see About color 
space.

•	 Color Channels: Choose whether to output color channels (RGB) only, or color 
channels plus an alpha channel (transparency).

•	 Duration: Select whether to export the entire project or a play range set in the 
Timeline.

•	 Export selected layer only: Select to export a single layer selected in the project. If 
no layer is selected, or if an object that does not render is selected (such as a rig, a 
light, or a camera), this option is dimmed.

4.	 To specify additional Motion-specific options, click Render.

See Render settings.

5.	 Click Share.

If this is your first time sharing to email, a permissions message appears. Click OK to 
allow Motion access to the Mail app.

After rendering is complete, the Mail app opens and an email is created with the Subject 
field filled in and the movie attached.

Important: Many email services limit the file size for attachments. If the message 
exceeds the recommended email size limit, a warning appears in the Email share 
window.
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Export from Motion using Compressor
The destinations available in Motion provide many options for exporting projects. If you 
need more options, you can create highly customized export settings using Compressor, 
the professional transcoding app designed to work directly with Motion. For example, you 
can use the Compressor frame resizing and retiming controls to make high-quality frame 
size and frame rate adjustments in your output files.

Important: To export using Compressor, you must have a compatible version of 
Compressor installed. Compressor must be purchased separately. See the Compressor 
website.

There are two ways you can use Motion and Compressor together:

•	 Use the Compressor Settings destination in Motion to apply Compressor settings (either 
the Apple-supplied setting or custom settings you create). Exporting a project this way 
lets you render your project using Compressor settings without opening your project 
in Compressor. Each Compressor setting you select results in an additional version of 
your project being rendered. After you choose settings and click Save, your project is 
rendered in the background.

•	 You can send your project to Compressor using the File > Send to Compressor 
command, to take advantage of the options available in Compressor to customize your 
output.

Share using the Compressor Settings destination
Using this method, you add destinations in the Share menu that are based on Compressor 
settings.

1.	 In Motion, create a new destination using the Compressor Settings destination.

2.	 Do one of the following:

•	 Choose File > Share, then choose the destination you created in step 1 from the 
submenu.

•	 On the right side of the toolbar, click Share, then choose the destination you created 
in step 1.

3.	 In the Info pane of the share window that appears, view or modify project attributes, 
such as the title and description.

https://www.apple.com/final-cut-pro/compressor/
https://www.apple.com/final-cut-pro/compressor/
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4.	 In the Settings pane of the share window, choose your preferred export settings:

•	 Change: Click to select a different Compressor setting.

•	 Duration: Select whether to export the entire project or a play range set in the 
Timeline.

•	 Export selected layer only: Select to export a single layer selected in the project. If 
no layer is selected, or if an object that does not render is selected (such as a rig, a 
light, or a camera), this option is dimmed.

See Compressor Settings destination.

5.	 To specify additional Motion-specific options, click Render.

See Render settings.

6.	 Click Next.

7.	 Enter a file name, choose a save location for the output files, then click Save.

Your project begins rendering, as shown by an analysis indicator on the right side of the 
canvas toolbar.

Send a project to Compressor
1.	 In Motion, choose File > Send to Compressor.

Note: The Send to Compressor command is dimmed if Compressor is not installed on 
the same computer as Motion.

Compressor opens, adding the project to the batch area.

2.	 In Compressor, click Add, select one or more output settings, then click OK.

3.	 Click Start Batch.

See the Compressor User Guide.

https://support.apple.com/guide/compressor/welcome/mac
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Send a project with Automatic color processing to Compressor
When you send an Automatic project to Compressor, automatic color processing is retained 
for certain settings. You can choose a different color space in the Compressor Video 
Properties pane.

1.	 In Motion, choose File > Send to Compressor.

2.	 In Compressor, click Add in the batch area, select one or more output settings that 
support automatic color processing (such as Uncompressed 8-bit or 10-bit 422, 
OpenEXR Image Sequence, or an Apple ProRes option), then click OK.

In Video Properties (in the Video inspector), the “Color space” pop-up menu is set to 
Automatic.

3.	 Optional: To change a setting’s color space, select the setting in the batch area, then 
click the “Color space” pop-up menu and choose an option (such as Rec. 709 or Rec. 
2020 HLG).

Note: Choosing a color space other than Automatic may result in output that appears 
different than in Motion. You can preview what your transcoded project will look like in 
Compressor’s preview area. See Preview jobs in the Compressor User Guide.

4.	 Click Start Batch.

See the Compressor User Guide.

Create and modify share destinations in Motion
In the Destinations pane of the Motion Settings window, you can add new destinations, 
modify or delete existing destinations, and create destination bundles, which allow 
you to export multiple types of output at once. You can also revert to the default set of 
destinations that were available when you first opened Motion.

For information about sharing projects and clips from Motion, see Intro to exporting 
projects.

https://support.apple.com/guide/compressor/preview-jobs-cpsr836968b5/4.6.1/mac/11.5.1
https://support.apple.com/guide/compressor/welcome/mac
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Create a new destination
1.	 In Motion, do one of the following:

•	 Choose File > Share > Add Destination.

•	 Choose Motion > Settings, click Destinations at the top of the window, then select 
Add Destination in the list on the left.

•	 On the right side of the toolbar, click Share, then choose Add Destination.

2.	 In the Destinations pane of the Settings window, do one of the following:

•	 Drag a destination from the area on the right to the Destinations list on the left (or 
double-click a destination on the right).

•	 Control-click a destination in the list on the left, then choose Duplicate.

The new destination appears selected in the list on the left, and the settings for the 
destination appear on the right.
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3.	 Specify settings for the new destination.

For descriptions of the controls in each destination, see Intro to Destinations settings. 
For information on using each default destination, see the previous topics in this 
chapter.

Here are some tips for setting up various types of destinations:

•	 Use the Export File destination to export a movie, a single layer as a movie, or an 
audio file, or if you want to share to Apple devices. Choose an option from the 
Format pop-up menu in the Export File settings.

•	 Rename the new destination to better describe its settings by double-clicking its 
name in the Destinations list, typing a new name, then pressing Return.

•	 If you chose the Compressor Settings destination, select a Compressor setting (or 
select multiple Compressor settings) in the window that appears, then click OK. The 
settings that are displayed include the Compressor settings that come with Motion 
as well as any settings you added.

Important: You can use the Compressor Settings destination only if you have 
Compressor installed or someone gives you a Compressor setting.

4.	 Close Motion Settings.

When you choose File > Share, or click Share on the right side of the toolbar, your new 
destination appears in the list.

You can make changes to the destination at any time. As you customize the destination, 
your changes are saved automatically.
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Modify existing destinations
1.	 Choose Motion > Settings, then click Destinations at the top of the window.

The Destinations pane appears, with a list of destinations on the left.

2.	 Do any of the following:

•	 Change a destination’s settings: Select a destination, then modify the destination’s 
settings on the right.

3.	 Restore a destination to its original settings: Control-click a destination in the 
Destinations list, then choose Revert to Original Settings.

4.	 Rename a destination: Double-click a destination in the list on the left, then type a new 
name.

5.	 Change the order of destinations in the list: Drag a destination to a different location in 
the list.

For descriptions of the controls in each destination, see Intro to Destinations settings. 
For information on using each default destination, see the previous topics in this 
chapter.

As you modify destinations, your changes are saved automatically.
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Create a bundle of destinations
Bundles make it easy to create several types of output in a single step. A bundle holds a 
set of destinations. When you share a project using the bundle, a file is output for each 
destination in the bundle.

1.	 Choose Motion > Settings, then click Destinations at the top of the window.

2.	 Select Add Destination in the Destinations list, then double-click the Bundle destination 
(or drag it from the area on the right to the Destinations list on the left).

An empty bundle appears in the Destinations list.

3.	 To add destinations to the bundle, drag existing destinations into it from the 
Destinations list, or select Add Destination and drag destinations from the area on the 
right into the bundle.

 Tip: To quickly make a bundle from destinations in the Destinations list, select one or 
more destinations in the list, then Control-click in the Destinations list and choose New 
Bundle from Selection.

Delete a destination
1.	 Choose Motion > Settings, then click Destinations at the top of the window.

2.	 Do one of the following:

•	 Control-click a destination in the Destinations list, then choose Delete.

•	 Select a destination in the Destinations list, then press Delete.

•	 Select a destination in the Destinations list, then click the Remove button (–) below 
the list.

Assign a default destination
1.	 Choose Motion > Settings, then click Destinations at the top of the window.

2.	 Control-click the destination or bundle you want to make the default, then choose Make 
Default.

The name of the new default destination is appended with “(default).”

After you set the default destination, you can quickly share to that destination by pressing 
Command-E. To use the Command-E keyboard shortcut to share to another destination (or 
destination bundle), you can make that destination or bundle the default.
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Revert to the set of destinations that came with Motion
1.	 Choose Motion > Settings, then click Destinations at the top of the window.

2.	 Control-click an empty area in the list on the left, then choose Restore Default 
Destinations from the shortcut menu.

Any custom destinations are deleted, and the default set of destinations appears. For a list 
of the default destinations, see Intro to exporting projects.

Share destinations between Motion users
1.	 Choose Motion > Settings, then click Destinations at the top of the window.

2.	 Do any of the following:

•	 Export destinations from your copy of Motion: Drag one or more destinations from 
the Destinations list to a location in the macOS Finder.

The destination file is appended with the filename extension .motndest.

•	 Import destinations into your copy of Motion: Drag a destination file from a location 
in the macOS Finder to the Destinations list.

The destination you added appears in the Destinations list, in the Share submenu of 
the File menu, and in the menu that appears when you click the Share button in the 
toolbar.
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Render settings in Motion
When sharing a Motion project, you can choose from different Motion-specific export 
options to balance image quality versus rendering time.

These settings are listed in the Render pane of the share window. The share window 
appears after you choose a destination from the right side of the toolbar (or from the File > 
Share submenu).

Rendering shortcuts
To quickly set your rendering preferences, click one of the two buttons at the top of the 
Render pane:

•	 Highest Quality: Click to set the best render options for your export, including motion 
blur, frame blending, lighting, shadows, reflections, and depth of field.

•	 Use Canvas Settings: Click to use the settings in the canvas Render menu for your 
export.

Note: Once you’ve selected Use Canvas Settings, any changes you make in the Render 
menu in the canvas (or in the File > View menu) are reflected in the Render pane. For 
example, if Render Quality is set to Normal in the share Render pane, and you return to 
the canvas and set Quality to Best in the Render menu, future exports will use Best.

Standard rendering options
Use these options to manually set the quality of your project’s output, as well as whether 
effects, such as motion blur and frame blending, appear in your project’s output.

•	 Render Quality: A pop-up menu that sets Render Quality to Draft, Normal, Best, or 
Custom. This setting affects the image quality of specific effects, but not the image as 
a whole. Choosing a lower render quality reduces render times, and choosing a higher 
render quality improves the quality of output.

•	 Fields: A checkbox that sets whether to render individual fields.

•	 Motion Blur: A checkbox that sets whether to apply motion blur to moving objects.

•	 Frame Blending: A checkbox that sets whether to render frame blending to output 
smoother, higher-quality slow motion in your project.
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3D rendering options
Use these options to choose whether 3D effects, such as lighting, shadow, and reflections, 
appear in your 3D project’s output.

•	 Camera: A pop-up menu to choose the cameras used to render your project, when your 
project contains 3D layers.

•	 Lighting: A checkbox that turns on lighting rendering. Turning this option off reduces 
rendering time (and eliminates lighting effects from the output).

•	 Shadows: A checkbox that turns on shadow rendering. Turning this option off reduces 
rendering time (and eliminates shadow effects from the output).

•	 Reflections: A checkbox that turns on reflections rendering. Turning this option off 
reduces rendering times (and eliminates reflections effects from the output).

•	 Depth of Field: A checkbox that turns on depth-of-field rendering. Turning this option 
off reduces rendering times (and eliminates depth-of-field effects from the output).

Note: Depth of Field does not affect 360° projects.

View the status of shared items in Motion
You can render Share operations in the background while you continue to work in Motion. 
To review or cancel projects in the render queue, display the Background Task List.

Display the Background Task List
In Motion, do one of the following:

•	 Choose Window > Show Task List (or press F9).

•	 Click the analysis indicator that appears on the right side of the canvas toolbar when 
Motion is rendering a file for output.

The Background Task List window appears, displaying all background processes. Each 
task is labeled and has a progress bar.

Note: Any current retiming (such as optical flow) analyses are also displayed in the 
Background Task List. Although you can reorder the priority of the retiming jobs, you 
cannot rearrange the priority of shared projects.
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Cancel the share
•	 In the Background Task List in Motion, click the Cancel button next to the process you 

want to stop.

Share notifications in Motion
As you work in Motion, the macOS Notification Center provides a convenient way to 
receive alerts when your background share operations are complete (or have failed). These 
settings are controlled in macOS System Settings.

Set Motion Share alerts in macOS System Settings
1.	 Choose Apple menu () > System Settings.

2.	 In the Notifications pane of System Settings, select Motion in the list, then set an alert 
style:

•	 Banners: The share notifications appear on your screen and disappear after a while.

•	 Alerts: The share notifications stay on your screen until you dismiss them.

If the share fails, click “Details” in the alert to view a dialog displaying the error 
message.

See macOS Help (in the Finder, choose Help > macOS Help).
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Manage color

About color space
No image device is capable of capturing and displaying the full spectrum of colors visible 
to the human eye. Consequently, image devices record, edit, display, or output a subset 
of those colors. This range of reproducible color is known as the device’s color gamut. 
Additionally, devices capture, process, and display different ratios between the lightest 
and darkest parts of an image, from pure black to brightest white. This luminance range 
is known as dynamic range. Together, these attributes define an image’s or device’s color 
space.

Standard-gamut versus wide-gamut color
Traditional computer displays and HDTVs support a limited color space that’s based on a 
decades-old industry standard called Rec. 709. Rec. 709 devices (and the video content 
created for display on them) have standard-gamut color, the constrained color palette you 
see whenever you view a broadcast HDTV show, DVD, or Blu-ray disc.

A more recent generation of displays—including 4K TVs and computer displays, Apple TV 
4K, and newer Mac, iOS, and iPadOS devices—can render a much wider palette of colors. 
These wide-gamut color devices display more vivid and lifelike hues (in addition to all 
the hues that standard-gamut devices can display). Accordingly, the video industry has 
adopted a wide-gamut color standard called Rec. 2020.

SDR versus HDR
Older displays and TVs are also limited in the levels of brightness they’re capable of 
reproducing, known as their dynamic range.

Standard dynamic range (SDR) is the conventional imaging approach that captures, 
processes, and displays a narrow range of luminance values (levels of brightness) and 
color values. SDR can represent a maximum luminance value of around 100 nits (candelas 
per square meter) and a dynamic range of 6 to 10 stops.

High dynamic range (HDR) imaging captures, processes, and displays a much wider range 
of luminance and color values. HDR can represent luminance values as high as 10,000 nits 
and a dynamic range of 14 stops or more.
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HDR displays typically process video at 10 or 12 bits per color component rather than 8 
bits. The additional data lets HDR displays render more discrete steps from the minimum 
to maximum brightness value in each color, creating more realistic color transitions and 
revealing more detail in both shadows and highlights.

There are multiple HDR formats, including HDR10, Dolby Vision, Hybrid Log-Gamma (HLG), 
and Perceptual Quantizer (PQ). Although PQ can represent luminance levels of up to 
10,000 nits, no display is capable of showing such levels. As a result, HDR content must 
be mastered with a lower peak brightness, usually around 1,000 nits. All common formats 
require HDR be delivered with wide color gamuts.

HDR imaging requires preservation of luminance and color data throughout the production 
pipeline: Images or clips must be captured on a device capable of recording HDR-level 
color and luminance ranges, stored and distributed with their HDR data intact, then 
displayed on a monitor capable of converting that HDR data to corresponding light values 
onscreen using a mathematical formula called a transfer function. If a monitor isn’t capable 
of displaying HDR, tone mapping is applied to restrict the wide range of luminance values 
in HDR images to the narrower range of brightness values supported by an SDR display. 
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Intro to color management in Motion
Motion projects often combine media files that have different color spaces. To reconcile 
these differences, Motion employs a color management system to ensure that images look 
the same on any output device.

In a Motion project, each imported media file is converted to the project’s working color 
space—the color space used for all processing operations (such as color correcting, 
blending, retiming, and so on). Next, the image or clip is converted from the working color 
space to the render color space—the color space that specifies how color is managed 
on your display (what you see in the Motion canvas), as well as the appearance of your 
exported project.

You can choose any of three color processing options for a project in Motion. The color 
processing option you choose sets your project’s working color space:

•	 Automatic: The best option if your project combines high-dynamic-range (HDR) media, 
standard-dynamic-range (SDR) media, and SDR objects created in Motion (such as text, 
shapes, and particles). Automatic uses tone mapping to adjust the elements in your 
project (clips, images, and objects) to match your project’s Render Color Space setting. 
When Render Color Space is set to an HDR option, Automatic boosts the luminance 
of SDR elements in your project; when Render Color Space is set to an SDR option, 
Automatic reduces the luminance of HDR media in your project. As a result, SDR and 
HDR elements are integrated in your project and have similar levels of brightness.

Automatic color processing is also the best option if you’re creating a Final Cut 
template. When the effect, generator, transition, or title is applied to the timeline in 
Final Cut Pro for Mac, the template automatically conforms to the color space of the 
project.

•	 Standard Gamut SDR: The best option when you want to create an SDR project, when 
all your media files are SDR, or when you want to manually convert any images, clips, 
or graphic elements to a different color space. Standard Gamut SDR sets your project’s 
working color space to linear RGB with Rec. 709 color primaries. Rec. 709 is the current 
standard for HDTV projects, including HD cable and Blu-ray discs.

•	 Wide Gamut HDR: The best option when you want to create an HDR project, when all 
your media files are HDR, or when you want to manually convert any images, clips, or 
graphic elements to a different color space. Wide Gamut HDR sets the working color 
space to linear RGB with Rec. 2020 color primaries, a color space with a wider range of 
colors than Rec. 709. Rec. 2020 is useful for 4K and 8K UHDTV and HDR projects.

Important: To create the wider range of colors in an HDR project and to view the most 
accurate presentation of those colors as possible, use a wide-gamut HDR display (such as 
an Apple Pro Display XDR or a MacBook Pro with a Liquid Retina XDR display). 
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Set the color processing method in Motion
To work in a wide-gamut HDR color space, you must configure two settings:

•	 Color Processing: Located in the Project Properties Inspector, this pop-up menu sets 
how color is processed in the project—the working color space. Choose Wide Gamut 
HDR or Automatic if you plan to export an HDR project; choose Automatic if you plan to 
mix HDR and SDR elements in the same project.

•	 Render Color Space: Located in the View pull-down menu, this submenu sets how color 
is processed in the Motion interface—what you see in the canvas as you work, as well 
as the color space and appearance of your exported project.

Important: To view the wider range of HDR colors, use a wide-gamut HDR computer 
display, such as an Apple Pro Display XDR or a MacBook Pro with a Liquid Retina XDR 
display.

Set the color processing method in a Motion project
You can assign a color processing method when you create a project, or change the 
method in an existing project.

1.	 In Motion, do one of the following:

•	 Create a new project: Follow steps 1 through 3 in Create a project with custom 
properties.

•	 Open an existing project: Choose File > Open, navigate to the file you want, click 
Open, select the Project object at the top of the Layers list, then show the Properties 
Inspector.

2.	 Click the Color Processing pop-up menu, then choose one of the following:

•	 Standard Gamut SDR: Sets the working color space to linear RGB with Rec. 709 color 
primaries. Rec. 709 is the current standard for HDTV projects, including HD cable 
and Blu-ray discs.

•	 Wide Gamut HDR: Sets the working color space to linear RGB with Rec. 2020 color 
primaries, a color space with a wider range of colors than Rec. 709. Rec. 2020 is 
useful for 4K and 8K UHDTV and HDR projects. Wide Gamut HDR also sets your 
project’s render color space to HDR Rec. 2020 PQ by default, a setting you can 
modify later.

•	 Automatic: Sets the working color space based on your project’s render color space. 
If the render color space is Rec. 2020, HDR Rec. 2020 HLG, or HDR Rec. 2020 PQ, 
the working color space is set to linear RGB with Rec. 2020 color primaries. If the 
render color space is Rec. 709, the working color space is set to linear RGB with Rec. 
709 color primaries.
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When you choose Automatic, an HDR White Level slider becomes available for 
adjusting the brightness of SDR elements in the project. See Manage automatic color 
processing.

3.	 If you created a new project, set the resolution (width and height), projection type, field 
order, aspect ratio, frame rate, and default duration, then click Open.

Note: The Color Processing setting may affect the look of your exported video. For 
example, when the project is changed from Standard Gamut SDR to Wide Gamut HDR or 
Automatic, the effect of some filters or blend modes may change in appearance.

When you choose Automatic color processing, your project’s render color space is set 
according to your computer display. When the Motion canvas appears on an SDR display, 
the render color space is set to Automatic (Rec. 709); when the Motion canvas appears on 
an HDR display (such as a MacBook Pro with a Liquid Retina XDR display), the render color 
space is set to Automatic (HDR Rec. 2020 HLG). You can override this setting by choosing 
a different render color space.
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Set the render color space for a project
You can choose any of several render color space options for your project.

•	 In Motion, choose View > Render Color Space, then choose one of the following 
settings:

•	 Automatic: Choose this option to match the render color space to the color 
processing method set in the previous task.

•	 Rec. 709: Choose this option for SDR projects in the standard Rec. 709 color space. 
You can also create a project that uses Rec. 709 with wide-gamut HDR media—
for example, if you have wide-gamut media but need to deliver a standard-gamut 
project, or if you need to deliver both standard- and wide-gamut versions of a 
project.

•	 Rec. 2020: Choose this setting for projects created in previous versions of Motion 
using the Wide Gamut - Rec. 2020 color space.

•	 HDR Rec. 2020 HLG: Choose this option if you intend to create an HDR project with 
the Rec. 2020 color space and HLG transfer function (Rec. 2100 standard), using 
formats such as HLG or Advanced HDR.

•	 HDR Rec. 2020 PQ: Choose this option for HDR projects with the Rec. 2020 color 
space and PQ transfer function (Rec. 2100 standard), such as the PQ, HDR10, 
HDR10+, Dolby Vision, or Advanced HDR format.

When Color Processing (in the Project Properties Inspector) is set to Standard Gamut 
SDR or Wide Gamut HDR, changing the Render Color Space setting controls how the 
image is displayed in the Motion canvas (the image is clipped to the gamut of the render 
color space, providing a preview of your export).

When Color Processing is set to Automatic, changing the Render Color Space setting 
controls not only how the image is displayed in the Motion canvas, but also controls 
the entire render (including any necessary tone mapping). For example, setting Render 
Color Space to HDR Rec. 2020 HLG renders any SDR and HDR elements in the project in 
HLG—from display through export.

By default, when you export a project, it’s rendered using the Render Color Space 
setting. However, you can override this setting by choosing a different option from the 
Color Space pop-up menu in export settings. See Intro to exporting projects.
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Manage automatic color processing in Motion
When a project contains a mixture of SDR elements created in Motion (such as text, 
shapes, or generators), SDR media, and HDR media, use Automatic color processing 
to have Motion manage your project’s color space. Automatic color processing uses 
intelligent tone mapping to integrate media elements with varying color spaces.

The left image below shows a project with Color Processing set to Standard Gamut SDR; 
the project contains white text superimposed over an HLG video clip. Because the dynamic 
range of both text and clip is uncorrected, the clip appears blown out, and the white text 
appears too bright. In the right image, Color Processing is set to Automatic. Because the 
elements are now automatically tone mapped, the clip appears accurate and the text is 
better integrated with the image.

When a project’s Color Processing is set to Automatic, the following occurs:

•	 The project’s render color space is automatically determined by your computer display. 
With an SDR display, the Render Color Space setting (in the View pull-down menu) is 
set to Rec. 709. With an HDR display, the Render Color Space setting is set to HDR Rec. 
2020 HLG.

•	 All images or clips in the project are automatically converted to the project’s working 
color space. When necessary, inverse tone mapping is applied to SDR elements to 
expand their range of brightness, and tone mapping is applied to HDR elements to 
narrow their range of brightness.

•	 Changing the render color space lets you preview how your project will look when 
exported to a movie file (or, if it’s a Final Cut effect, generator, transition, or title, how it 
will appear when it’s applied to the Final Cut Pro timeline).

•	 An HDR White Level slider becomes available, letting you adjust the brightness of SDR 
elements in a project.

•	 A Final Cut effect, transition, title, or generator template automatically conforms to the 
color space of the Final Cut Pro project when the template is applied to the timeline. 
Additionally, you can publish the HDR White Level slider with the template, allowing 
Final Cut Pro users to adjust the brightness of any SDR elements in the template.

•	 Additional color controls become available in the Properties Inspector to override the 
automatically assigned conversion type of an image or clip.
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Adjust the brightness of SDR elements
When a project’s Color Processing is set to Automatic, you can adjust the brightness levels 
of SDR elements (such as images, titles, shapes, and other graphics created in Motion) to 
better match the brighter levels of HDR media.

1.	 In a Motion project, set Color Processing to Automatic and set Render Color Space to 
HDR Rec. 2020 HLG or HDR Rec. 2020 PQ.

2.	 In the Layers list, select the Project object (or press Command-J).

3.	 In the Properties Inspector, drag the HDR White Level slider to increase or decrease the 
brightness of any SDR elements in the project.

Adjusting the HDR White Level slider affects all SDR elements in the project. If you don’t 
want the slider to affect a certain SDR image or clip, you can change its conversion type 
(see Change the automatic color conversion type for an image or clip).

Note: In general, the HDR White Level slider has no effect on HDR media. However, when 
you apply a filter that contains a color well (with the exception of Color Balance) to an HDR 
image or clip, the HDR image may be affected by the HDR White Level slider. See About 
filters and color processing.
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Change the automatic color conversion type for an image or clip
When a project’s Color Processing is set to Automatic, Motion adjusts the dynamic range 
of an image or clip to better match the project’s Render Color Space setting (in the View 
pull-down menu) using different conversion types. If necessary, you can choose another 
conversion type.

1.	 In a Motion project, set Color Processing to Automatic.

2.	 In the Layers list, select the image or clip whose color conversion type you want to 
modify.

3.	 In the Properties Inspector, move the pointer over the end of the Color row, then click 
Show.

4.	 Click the Conversion pop-up menu, then choose Manual.

5.	 Click the Conversion Type pop-up menu, then choose one of the following:

•	 To/From 100% HDR (HLG): Converts a clip to or from 100% of the HDR HLG dynamic 
range whenever the clip needs to be tone mapped. For example, if the Render Color 
Space is set to Rec. 709, the full dynamic range of HLG is tone mapped to the full 
(but more limited) dynamic range of SDR, resulting in an HLG image that appears 
correct in the project. If the Render Color Space is set to HDR Rec. 2020 HLG, 
the full (but limited) dynamic range of Rec. 709 is inverse tone mapped to the full 
dynamic range of HLG. (If the clip is HLG and the render color space is set to HDR 
Rec. 2020 HLG, then no conversion occurs.)

In general, use this option when your SDR media needs to expand to the maximum 
dynamic range of HLG HDR, or when HLG media contains HDR-level brightness 
(brighter than SDR media).

(This is the default conversion type applied to HLG media when the Conversion pop-
up menu is set to Automatic.)
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•	 To/From 75% HDR (HLG): Converts a clip to or from 75% of the HDR HLG dynamic 
range whenever the clip needs to be tone mapped. For example, if the Render Color 
Space is set to Rec. 709, 75% of the dynamic range of HLG is tone mapped to the 
full (but more limited) dynamic range of SDR. If the Render Color Space is set to HDR 
Rec. 2020 HLG, the full (but limited) dynamic range of SDR is tone mapped to 75% of 
the dynamic range of HLG. (If the clip is HLG and Render Color Space is set to HDR 
Rec. 2020 HLG, then no conversion occurs.)

In general, use this option to keep SDR media at SDR-level brightness when used in 
an HDR HLG project, or when HLG media doesn’t contain HDR-level brightness (such 
as an SDR clip that’s recorded and encoded as HLG).

•	 To/From HDR (PQ): Converts a clip to or from HDR PQ based on the project’s current 
render color space. For example, when the render color space is set to Rec. 2020 
HLG, a PQ clip is converted from PQ to HLG so it appears correct in the project.

When this option is selected, the PQ Peak (nits) slider becomes available in the clip’s 
Properties Inspector, letting you adjust the peak brightness (nits value) of a PQ clip. 
The PQ Peak (nits) value is the default value of the PQ clip (1,000 nits, or the value 
of any peak mastering metadata in the clip).

(This is the default conversion type for PQ media when the Conversion pop-up menu 
is set to Automatic.)

•	 Use HDR White Level (75%): Instructs an image or clip to use the HDR White 
Level slider (in the Project Properties Inspector) to adjust its brightness. If you’ve 
previously changed the default value of the HDR White Level slider in the Project 
Properties Inspector, that value is displayed in the pop-up menu.

(This is the default conversion type for SDR media when the Conversion pop-up 
menu is set to Automatic.)

•	 None: No conversion occurs.

If you choose Use HDR White Level (75%) for an HDR image or clip when Render Color 
Space is set to HDR Rec. 2020 HLG or HDR Rec. 2020 PQ, the HDR White Level slider 
has no effect on the image. If Render Color Space is set to Rec. 709 or Rec. 2020, the 
HDR White Level slider does affect the HDR image. SDR elements in a project (such as 
text, shapes, and particles created in Motion) are always affected by the slider.

Note: If a filter that contains a color well is applied to an HDR image, the HDR White 
Level slider does affect the image when Render Color Space is set to HDR Rec. 2020 
HLG or HDR Rec. 2020 PQ.

Preview a project in a different SDR or HDR color spaces
You can quickly preview the appearance of a project in different SDR or HDR color spaces 
(and preview the how a project will look when exported). This is most useful if you’re 
working on an HDR display, such as an Apple Pro Display XDR or a MacBook Pro with a 
Liquid Retina XDR display.

•	 Choose View > Render Color Space, then select the color space you want to preview 
your project in. For example, if you’re working in wide-gamut Rec. 2020 and plan to 
export to a standard-gamut Rec. 709 format, set Render Color Space to Rec. 709 to 
view any clipping that may occur.

You can manually set tone mapping to view a project without clipping. See Turn tone 
mapping on or off.



1297Motion User Guide

View HDR media in the Motion canvas
In Motion, the way HDR images and projects are displayed in the canvas changes based on 
the capabilities of your computer display. When you’re viewing HDR images on an HDR or 
SDR display, Motion applies tone mapping, compressing bright image content and reducing 
the apparent dynamic range of the video to fit the viewable range of the display. You can 
turn tone mapping on or off.

 Tip: To determine the nits value of an image or clip, you can display HDR luminance 
values in the Motion canvas.

Turn tone mapping on or off
1.	 In Motion, open a project that’s set to Wide Gamut HDR or Automatic color processing.

2.	 Choose View > Show HDR as Tone Mapped.

A checkmark indicates that tone mapping is turned on.

The Show HDR as Tone Mapped setting is not available if Render Color Space is set to 
Rec. 709 or Rec. 2020.

When tone mapping is turned off on a system using an SDR display, HDR images are 
clipped.

If you’re using an Apple Pro Display XDR or a MacBook Pro with a Liquid Retina XDR 
display, Show HDR as Tone Mapped is automatically turned off when you choose a 
reference mode preset, such as HDR Video (P3-ST 2084), from the Presets list in the 
Displays pane of macOS System Settings.

Note: The Show HDR as Tone Mapped setting only affects how your project appears on 
your display—it does not affect your final render.

View HDR media on an XDR display in reference mode
If you’re using a MacBook Pro with a Liquid Retina XDR display or have the Apple Pro 
Display XDR connected to your computer, you can use it as a professional reference 
monitor to view HDR images.

1.	 In Motion, open a project that’s set to Wide Gamut HDR or Automatic color processing.

2.	 Choose Apple menu > System Settings, then click Displays.

3.	 In the Displays pane, click the Presets pop-up menu, then choose a reference mode 
preset, such as HDR Video (P3-ST 2084).

Motion automatically turns off tone mapping to provide the maximum color and 
brightness accuracy for HDR media playback on the XDR display.

Note: Only the Motion canvas (and export preview image) are capable of displaying 
accurate HDR color on an HDR monitor. Other areas of the Motion application, such as 
color pickers or gradient editors, do not display HDR color.
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Adjust HDR media in Motion
You can manually adjust HDR media in Motion in the following ways:

•	 Use the HDR Tools filter to convert HDR or SDR media from one color space to another. 
This method is usually only necessary for converting media in projects with Standard 
Gamut SDR or Wide Gamut HDR color processing.

•	 Use the Media Inspector to assign or correct a media file’s color profile.

•	 In a project with Automatic color processing, change the color conversion type for 
media in the Properties Inspector.

Adjust the color space of HDR media using the HDR Tools filter
1.	 In the Layers list in Motion, select an HDR image or clip.

2.	 In the toolbar, click Filters, then choose Color > HDR Tools.

3.	 In the Filters Inspector, click the Mode pop-up menu, then choose an adjustments 
option:

•	 SDR to 100% HDR (HLG): Converts Rec. 709 SDR media to full HDR HLG luminance 
levels.

•	 SDR to 75% HDR (HLG): Converts Rec. 709 SDR media to partial HDR HLG luminance 
levels.

•	 SDR to HDR (PQ): Converts Rec. 709 SDR media to full HDR PQ luminance levels.

•	 HLG to Rec. 709 SDR: Converts HLG media to Rec. 709 SDR luminance levels.

•	 PQ to Rec. 709 SDR: Converts PQ media to Rec. 709 SDR luminance levels.

•	 HLG to PQ (Rec. 2100): Converts HLG media to PQ luminance levels. Maintains the 
brightness at a level you set in the Peak Brightness slider (in accordance with Rec. 
ITU-R BT.2100-1) when applied to HLG media in PQ projects.
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•	 PQ to HLG (Rec. 2100): Converts PQ media to HLG luminance levels. Maintains the 
brightness at a level you set in the Peak Brightness slider (in accordance with Rec. 
ITU-R BT.2100-1) when applied to PQ media in HLG projects.

•	 HDR to Rec. 709 SDR: Converts HDR media (such as PQ, HLG, or log media that has 
been color-corrected in HDR) to Rec. 709 SDR luminance levels.

•	 PQ Output Tone Map: Reduces the brightness of PQ media to the level you set in the 
Peak Brightness slider (described below), and applies a soft rolloff to the highlights 
so they don’t clip abruptly. Use this setting in PQ projects only, and apply it as the 
last effect.

When you choose certain Mode settings, the Peak Brightness slider becomes available. 
Use the slider to set a clip’s maximum luminance on a display to a specific level or to 
set the nominal peak luminance of a display:

•	 When Mode is set to SDR to HDR (PQ), the Peak Brightness slider sets the nominal 
peak luminance of an HDR display on which SDR content is displayed. For example, 
if you want to convert an SDR clip to HDR PQ and want the resulting PQ clip to look 
identical to an HDR clip on a 1000-nit display, set the Peak Brightness slider to 1000.

•	 When Mode is set to PQ to Rec. 709 SDR, the Peak Brightness slider sets the 
nominal peak luminance of an SDR display on which PQ content is displayed.

•	 When Mode is set to HLG to PQ (Rec. 2100) or PQ to HLG (Rec. 2100), the Peak 
Brightness slider sets the nominal peak luminance of an HDR display on which HLG 
content is displayed. For example, if you want to convert an HLG clip to PQ and want 
the resulting PQ clip to look identical to an HLG clip on a 1000-nit display, set the 
Peak Brightness slider to 1000.

•	 When Mode is set to PQ Output Tone Map, the Peak Brightness slider sets the 
number of nits to which the output of the filter is limited. For example, if you want to 
limit your clip to 1,000 nits peak, set Peak Brightness to 1000.

 Tip: For the most accurate results when using the HDR Tools filter, keep the Mix 
setting at 100%.

For projects with Standard Gamut SDR or Wide Gamut HDR color processing, you can use 
the HDR Tools filter on any of the following kinds of wide-gamut HDR images:

•	 MOV or MXF files that were encoded using the HLG or PQ standard, such as media 
originating from a camera or media exported from Motion, Final Cut Pro, Compressor, or 
another app.

•	 A source file that is not HLG or PQ (it could be RAW, for example) to which a LUT filter 
has been applied (before application of the HDR Tools filter) to output HLG or PQ video.

•	 A video clip that has been set to either PQ or HLG. For example, you might modify a PQ 
project (a project configured for Rec. 2020 PQ), and then export the project as a movie 
and place it in an HLG project. For information about wide-gamut HDR project settings, 
see Set the color processing method.

Note: If you’re working in a project with Automatic color processing, the effect of applying 
the HDR Tools filter is additive to any existing tone mapping or conversion in the project.



1300Motion User Guide

Override a file’s color profile in the Media pane
If a media file is not tagged or is tagged incorrectly prior to importing into Motion, you can 
manually set its color profile in the Media pane of the Inspector.

1.	 In Motion, open the Media list, then select the image or clip.

2.	 In the Media Inspector, click the Color Space Override pop-up menu, then choose an 
option.

The options vary depending on the selected file. Rec. 601, Rec. 709, and Rec. 2020, 
Rec. 2020 HLG, and Rec. 2020 PQ are available for most files.

Note: Overriding a media file’s color space may affect how a project with Automatic 
color processing converts the file.

Choose HDR colors in Motion
Objects you create in Motion—text, shapes, generators, and so on—use color wells to 
control their color. When necessary—usually only when you’re working in projects with 
Standard Gamut SDR or Wide Gamut HDR color processing—you can manually set an 
object’s HDR colors (to match a color present in an HDR clip, for example).

In projects with Automatic color processing, the color wells are considered SDR, so you can 
use the HDR White Level slider to quickly adjust the brightness of Motion objects.

Note: HDR colors and gradients may not appear as expected on an SDR display. To create 
the wider range of colors in an HDR project and to view the most accurate presentation of 
those colors as possible, use a wide-gamut HDR display (such as an Apple Pro Display XDR 
or a MacBook Pro with a Liquid Retina XDR display).

Apply HDR colors to Motion objects
In SDR color space, red, green, and blue are represented by color values that range from 0 
to 1. In HDR color space, additional color values are necessary to represent the more vivid 
colors, ranging from –6 to 8 for each color channel (red, green, and blue).

In this example, set a shape’s fill to an HDR color.

1.	 In Motion, select a shape object in the canvas or Layers list.

2.	 In the Shape Inspector, click the disclosure triangle beside Fill Color, then do one of the 
following:

•	 In an Wide Gamut HDR project, drag the Red, Green, or Blue value sliders between 0 
and 4, or enter values from –6 to 8 in value fields.
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•	 In a Standard Gamut SDR (or Automatic) project, drag the Red, Green, or Blue value 
sliders between 0 and 1, or enter values from –6 to 8 in value fields.

You may need to adjust all three color channels to get the correct result.

The new color is applied to the shape. If you change the project’s render color space 
setting, the appearance of the shape’s color may change.

 Tip: Although you can use the Fill Color eyedropper to sample an HDR image color 
in the canvas, you can’t choose HDR colors by clicking the color wells in the Inspector 
(including the macOS Colors window).

See HDR and Wide Color Gamut in Final Cut Pro.

Display HDR luminance values in Motion
Motion can display dynamic luminance values (in nits) in the status bar above the canvas.

Important: Luminance values only appear in the status bar when your project’s Render 
Color Space is set to HDR Rec. 2020 PQ.

1.	 In Motion, choose Motion > Settings (or press Command-Comma).

2.	 Click Appearance.

3.	 In the Status Bar area, select Color.

4.	 Close Settings.

5.	 Choose View > Render Color Space > HDR Rec. 2020 PQ.

When you move the pointer in the canvas over an image or object, an additional nits 
value is displayed in the status bar, along with the pixel (red, green, blue, and alpha) 
values.

https://www.apple.com/final-cut-pro/docs/HDR_WideColor.pdf
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Tips for color management in Motion
The following tips can help you streamline or improve your HDR workflow:

•	 HDR colors may not appear as expected on an SDR display. To view the wider range of 
colors in an HDR project accurately, use an HDR display, such as an Apple Pro Display 
XDR or a MacBook Pro with a Liquid Retina XDR display.

•	 If you’re mixing SDR and HDR elements, set your project’s Color Processing setting (in 
the Project Properties Inspector) to Automatic to have Motion inverse tone map SDR 
elements (expand their range of brightness) or to tone map HDR elements (narrow their 
range of brightness) to match the project’s render color space. See Manage automatic 
color processing.

•	 When a project’s color processing is set to Automatic, an HDR White Level slider 
becomes available in the Project Properties Inspector. Use the slider to adjust the 
brightness levels of SDR elements (such as images or titles, shapes, and other graphics 
created in Motion) to better match the brighter levels of HDR media when Render Color 
Space is set to HDR Rec. 2020 HLG or HDR Rec. 2020 PQ.

•	 Adjusting the HDR White Level slider affects all SDR elements in the project. If you don’t 
want the slider to affect a certain SDR image or clip, you can change its conversion 
type.

•	 When adjusting the brightness of SDR elements using the HDR White Level slider 
in projects with Automatic color processing, make sure to review the elements’ 
appearance against any underlying clips. Varying luminance levels in different HDR clips 
may appear to change the brightness of the SDR elements.

•	 In general, adjusting the HDR White Level slider doesn’t affect the brightness of HDR 
media in the project. For example, in a project that contains text and particles that use 
an HDR image as the particle cell source, adjusting the HDR White Level slider affects 
the brightness of the text, but doesn’t affect the brightness of the particles.

However, if you apply a filter that contains a color well to HDR media (or use certain 
blend modes), adjusting the HDR White Level slider may affect the brightness of the 
HDR clip. In the particles example above, if you apply the Tint filter to the particles 
using the HDR image as a cell source, the slider affects the brightness of the particles. 
See About filters and color processing.

•	 Although the HDR White Level slider is primarily used to increase the brightness of SDR 
elements (clips, images, shapes, and so on) to better match the brightness of HDR clips 
in a project with Automatic color processing, you can also use the slider to decrease the 
brightness of an HDR element in an SDR project. For example, in an SDR project that’s 
set to Automatic color processing, set the conversion type of an HDR clip to Use White 
Level (75%), then change the project’s render color space to Rec. 709. In the Project 
Properties Inspector, drag the HDR White Level slider right to decrease the clip’s HDR 
brightness (at 100 percent, the HDR clip’s brightness matches peak SDR white levels 
and looks like other SDR clips in the project). Drag the slider left to increase the clip’s 
HDR brightness (at 50 percent, the HDR clip’s brightness matches peak HDR white 
levels, and therefore looks blown out).

Note: In most cases, an Automatic project will correctly tone map any SDR or HDR 
media in the project, so there’s no need to change the conversion.
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•	 Use the HDR Tools filter to convert images, clips, and Motion elements between color 
spaces and HDR standards, or to limit the brightness of a clip to a specific level. See 
HDR Tools filter.

Note: Using the HDR Tools filter is usually unnecessary in projects with Automatic color 
processing because you can change conversion types in the Properties Inspector.

•	 You can fix missing or incorrect color space metadata using the Color Space Override 
pop-up menu in the Media Inspector. See Adjust HDR media.

•	 Generally, your render color space should match your output color space (the color 
space you’re required to deliver the project in). If you’re rendering to multiple output 
color spaces, your render color space should match the output color space with the 
largest gamut.

•	 When adjusting the blend modes of SDR media in Automatic projects with Render Color 
Space set to HDR HLG, effects may appear dimmer than expected. To increase the 
brightness of the effect of the blend mode, increase the HDR White Level slider in the 
Project Properties Inspector.

•	 Changing a project’s Color Processing setting (in the Project Properties Inspector) 
can change an image’s luminance or color space. This may affect the appearance of 
blended images or groups. See About color space.

•	 If you’re unsure of an imported clip’s format (HLG, PQ, and so on), select the clip in the 
Media list, then check its metadata in the Media Inspector.

•	 To determine the nits value of an image or clip, you can display HDR luminance values in 
the Motion canvas.

•	 When creating templates for Final Cut Pro for Mac, you can ensure parity between your 
Motion template’s color space and your Final Cut Pro project’s color space in two ways:

•	 Set the template’s Color Processing (in the Project Properties Inspector) to 
Automatic to conform the template to the color space of the Final Cut Pro project. 
See Create templates that conform to the Final Cut Pro color space.

•	 If the template’s Color Processing is set to Standard Gamut HDR or Wide Gamut 
HDR, use the Override FCP Color Space checkbox in the template’s Project 
Properties Inspector. See Override the Final Cut Pro color space.

•	 To avoid losing HDR data when transferring HLG video clips from iPhone to Mac, use Air 
Drop, Image Capture, or the Photos app (to import video using iCloud or by connecting 
your device to your Mac or to export video).

•	 Motion is optimized to provide maximum HDR luminance and color accuracy on the 
Apple Pro Display XDR for playback, making the display the ideal professional reference 
monitor.

If you’re working in a Standard Gamut SDR or Wide Gamut HDR project on a system 
with an SDR display, you can use the Show HDR as Tone Mapped setting to reduce the 
apparent dynamic range of the image to fit the display’s viewable range. See View HDR 
media.

If you’re working in an Automatic project, tone mapping is handled automatically.

For more information HDR industry standards and practices, see the following white papers:

•	 Best Practices for Mapping BT.709 Content to HDR10 from MovieLabs

•	 Inverse Tone Mapping: Upscaling SDR Content to HDR from Dolby

•	 Guidance for operational practices in HDR television production from ITU-R

https://support.apple.com/119857
https://support.apple.com/119857
https://support.apple.com/guide/image-capture/transfer-images-imgcp1003/mac
https://support.apple.com/HT201302
https://support.apple.com/HT201302
https://support.apple.com/guide/photos/export-photos-videos-slideshows-and-memories-pht6e157c5f/mac
https://www.movielabs.com/ngvideo/MovieLabs_Mapping_BT.709_to_HDR10_v1.0.pdf
https://professionalsupport.dolby.com/s/article/Inverse-tone-mapping-upscaling-SDR-content-to-HDR?language=en_US
https://www.itu.int/dms_pub/itu-r/opb/rep/R-REP-BT.2408-4-2021-PDF-E.pdf
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Work with Cinematic mode video

Intro to Cinematic mode video in Motion
In Motion, you can change the focus of video clips recorded in Cinematic mode on iPhone 
13 and later. Cinematic mode creates clips with a simulated depth-of-field effect that 
keeps your subjects—people, pets, and more—in sharp focus while applying a pleasing 
blur to the background (or foreground). As you record, the camera uses machine learning 
to automatically detect and focus on subjects in the scene. You can also tap the camera 
screen while recording to manually focus on a subject.

These automatic and manual focus decisions are called focus points. Focus points, as well 
as depth-of-field data, are saved with the Cinematic mode video clip.

When you import a Cinematic clip into Motion, you can:

•	 Add new focus points and switch the focus between different subjects

•	 Lock the focus on a specific point at a specific distance from the camera 

•	 Create or modify a rack focus effect by adjusting the clip’s focus points

•	 Adjust or animate a clip’s depth of field

•	 Delete manual focus points (added during recording or added in Motion)

Note: To edit Cinematic mode video shot on an iPhone with a recent version of iOS, you 
may need to update to the latest version of macOS.

For information on recording in Cinematic mode, see Record video in Cinematic mode with 
your iPhone camera in the iPhone User Guide.

https://support.apple.com/guide/iphone/record-video-in-cinematic-mode-ipha0706e2bc/16.0/ios/16.0
https://support.apple.com/guide/iphone/record-video-in-cinematic-mode-ipha0706e2bc/16.0/ios/16.0
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Move Cinematic mode clips to your Mac before 
importing them into Motion
To use Cinematic mode video in Motion, you must transfer the clips from iPhone to Mac 
using any of the following methods, which preserve depth and focus metadata.

Use AirDrop to transfer Cinematic mode video clips from iPhone to Mac
1.	 In the Photos app on your iPhone, open the Cinematic mode video, then tap the Share 

button.

2.	 Tap Options at the top of the screen, turn on All Photos Data, the tap Done.

3.	 Tap AirDrop, then tap the Mac you want to share with (make sure the Mac you’re 
sharing with has AirDrop turned on).

Each Cinematic clip is transferred to the Mac as four separate files, for example:

•	 IMG_0001.AAE

•	 IMG_O0001.AAE

•	 IMG_0001.MOV

•	 IMG_E0001.mov

The MOV file without the E in its name contains depth and focus metadata. The MOV 
file with the E in its name indicates that the cinematic effects are baked into the clip and 
cannot be edited in Motion. The AAE files are not used by Motion and can be ignored.

Use Image Capture to transfer Cinematic mode video clips from iPhone to Mac
Use the macOS Image Capture app to transfer Cinematic clips from your iPhone to your 
Mac with a USB cable.

1.	 Connect your iPhone to your Mac using a USB or USB-C cable.

2.	 Open the Image Capture app on your Mac, select your iPhone in the sidebar, then 
unlock your iPhone.

Note: The Image Capture app is installed with macOS and is located in your Applications 
folder.

Each Cinematic clip may appear as two files, for example:

•	 IMG_0001.mov

•	 IMG_E0001.mov

The MOV file without the E in its name contains depth and focus metadata. The MOV 
file with the E in its name indicates that the cinematic effects are baked into the clip and 
cannot be edited in Motion.

3.	 Select the clips you want, click Import To to choose a save location, then click 
Download.
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Use the macOS Photos app to export Cinematic mode video clips to your Mac
You can export Cinematic clips from the Photos app to a save location on your Mac.

If you use iCloud Photos on your Mac, your Cinematic clips appear automatically in the 
macOS Photos app. If you don’t use iCloud Photos, you can manually sync an iPhone to 
your Mac to transfer videos to the Photos app. See Sync photos between your Mac and 
iPhone or iPad in the Photos User Guide.

1.	 Open the Photos app on your Mac, open Media Types in the sidebar, then select 
Cinematic.

2.	 Select one or more Cinematic clips, then choose File > Export > Export Unmodified 
Original For [numeral] Videos.

If you’re importing Cinematic clips transferred to your Mac using AirDrop or the Image 
Capture app, select the MOV file without the E in its name.

3.	 In the dialog, click the File Name pop-up menu to choose a file name, then click Export.

4.	 In the dialog, navigate to the location where you want to save the files, then click Export 
Originals.

Note: Alternatively, you can Option-drag a Cinematic clip from the Photos app to a 
location on your Mac.

Once the Cinematic clips are saved to your Mac, you can import them into your Motion 
project.

Enable Cinematic mode video adjustments in 
Motion
Before you can view and adjust focus points in Cinematic mode video clips, you must 
import the clips, show the Timeline, and enable the Cinematic onscreen controls.

Step 1: Create a project and import Cinematic mode video clips
•	 In Motion, do one of the following:

•	 If you recorded Cinematic mode clips in HDR (the default on iPhone):Create an HDR 
project prepopulated with Cinematic mode clips.

•	 If you recorded the Cinematic mode clips in SDR:Create a new project, then import 
Cinematic mode clips using the import command or import button or by dragging 
SDR clips from the Photos category in the Motion Library.

Make sure that each Cinematic clip you import is a MOV file without a capital E in its 
filename. See Move Cinematic clips to your Mac.

Note: If you want to use HDR clips in an SDR project, after importing the clips, convert 
them to SDR using the HDR Tools filter or by overriding the clip’s color profile. See 
Adjust HDR media.

https://support.apple.com/guide/mac-help/sync-photos-to-your-device-mchl4af095d3/mac
https://support.apple.com/guide/mac-help/sync-photos-to-your-device-mchl4af095d3/mac
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Step 2: Show the Timeline to display the Cinematic clip’s focus points
•	 In Motion, click the Show/Hide Timeline button in the timing toolbar.

In the Timeline, two kinds of focus points appear along the bottom of the Cinematic 
clip’s timebar:

•	 Automatic focus points: These are created automatically while recording in 
Cinematic mode in the Camera app. In the Timeline in Motion, automatic focus points 
appear as white dots.

•	 Manual focus points: These are created manually while recording in Cinematic mode 
in the Camera app when you tap the iPhone screen (to focus on a particular element 
in the scene). In the Timeline in Motion, manual focus points appear as yellow dots.

Focus points are not keyframes—they represent focus decisions created when the video 
was recorded.

Step 3: Show the Cinematic onscreen controls in the canvas
1.	 In the Layers list or Timeline in Motion, select a Cinematic clip.

2.	 Do either of the following:

•	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Cinematic.
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•	 Control-click in the canvas, then choose Cinematic.

Note: If the Cinematic tool isn’t available, make sure to select the Cinematic 
activation checkbox in the Properties Inspector.

The Cinematic onscreen controls appear in the canvas.

If you drag the playhead, different types of controls appear in the canvas around 
elements in the scene. These controls indicate focus decisions made while recording on 
iPhone, either automatically (by the Camera app) or manually (by the person recording 
the video). There are four types of controls:

Item Name Description

Current focus indicator Yellow brackets indicate the current 
subject or area of focus tracked 
automatically by the camera.

Suggested focus indicator White frames indicate potential 
subjects of focus tracked 
automatically by the camera. Move 
the pointer over the canvas to 
reveal additional suggested focus 
points. You can convert a suggested 
focus point to the current subject 
of focus.

AF tracking lock A yellow frame indicates the 
current subject or area of focus 
set manually by the user (during 
recording or in Motion). AF tracking 
lock focuses on a subject while 
following its movement, even when 
other potential subjects of focus 
appear in the clip.

AF lock A small yellow square with tick 
marks indicates a fixed-focus point 
set manually by the user (during 
recording or in Motion). AF lock 
focuses on a specific area of the 
clip at a specific distance from the 
camera, ignoring all other elements 
in the clip (until the next focus 
change).

Note: The colors of the onscreen controls have been brightened for illustrative purposes 
in this user guide. The controls appear muted in the Motion canvas. Depending on focus 
decisions made by the user during recording, some of the controls described above 
may not appear in the canvas.
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Adjust focus points in Cinematic mode video clips 
in Motion
When you record in Cinematic mode on iPhone, the Camera app automatically targets the 
most likely subject of focus in the scene. If another element comes into frame, the camera 
may automatically switch the focus to that subject. For example, if you’re focusing on one 
subject and that subject moves away from center (or the camera pans) and another subject 
comes into view, the camera may automatically focus on the second subject.

Once you’ve enabled Cinematic adjustments in Motion, you can lock the focus on subjects, 
switch the focus between subjects, or fix the focus on a point in the scene at a specific 
distance from the camera.

Switch the focus in a Cinematic mode video clip
1.	 In the Motion Timeline, go to the frame that contains the subject you want focus on (or 

select an existing focus point in the Timeline).

 Tip: To move to the next or previous focus point, choose Mark > Go to > Next Focus 
Point or Mark > Go to > Previous Focus Point.

2.	 In the canvas, click a suggested focus indicator (a white frame).

The current focus indicator (the yellow brackets) switches to the area you clicked. A 
manual focus point (a yellow dot) is added to the clip’s timebar in the Timeline. The 
subject you selected remains in focus (if possible) until the end of the clip or until the 
next focus point in the Timeline.
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Lock the focus in a Cinematic mode video clip
1.	 In the Motion Timeline, go to the frame that contains the subject you want to lock focus 

on (or select an existing focus point in the Timeline).

2.	 In the canvas, click the current focus indicator (the yellow brackets) or double-click a 
suggested focus indicator (a white frame).

The indicator you clicked changes to the AF tracking lock (a yellow frame), and a 
manual focus point (a yellow dot) is added to the clip’s timebar in the Timeline. The 
focus remains locked on the subject you selected (if possible) until the end of the clip 
or until the next focus point (a white or yellow dot in the Timeline).

3.	 To turn off the AF tracking lock, click the center of the closed yellow frame.

The control reverts to the current focus indicator (yellow brackets).

If you retime a Cinematic mode video clip, you can’t adjust focus points. However, you can 
still adjust the clip’s depth of field.

Fix the focus at a specific distance from the camera in a Cinematic mode video clip
You can lock the focus on a specific point in the frame at a specific distance from the 
camera using AF lock. AF lock is useful, for example, when you want to maintain focus on a 
specific spot in the scene—regardless of the subject’s movement. If you set the AF lock to 
the scene’s middle ground, a blurred subject in the background can move into focus in the 
middle ground, then become blurry again moving into the foreground.

1.	 In the Timeline in Motion, go to the frame where you want to add a fixed-focus point.

2.	 In the canvas, do one of the following:

•	 Set a fixed-focus point from the current playhead position to the next manual focus 
point: Move the pointer to the area in the canvas where you want to lock focus, press 
and hold the mouse button, then release it.

A small yellow square with long tick marks appears in the canvas and is labeled AF 
Lock, indicating the depth of the selected point in the scene. A manual focus point (a 
yellow dot) is added to the clip’s timebar in the Timeline, and subsequent automatic 
focus points (white dots) are overwritten.

Focus is maintained at the specified distance from the camera. The focus doesn’t 
follow a subject, and it remains locked on the area you selected until the next manual 
focus point (yellow dot) in the Timeline, or until the end of the clip.
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•	 Set a fixed-focus point from the current playhead position to the next manual or 
automatic focus point: Click the area in the canvas you want to lock the focus on.

A small yellow square with short tick marks appears in the canvas. A manual focus 
point (a yellow dot) is added to the clip’s timebar in the Timeline, and no subsequent 
focus points (white or yellow dots) are overwritten.

The focus doesn’t follow a subject, and it remains locked on the area you selected 
until the next manual focus point (yellow dot) or automatic focus point (white dot) in 
the Timeline, or until the end of the clip.

Note: If the fixed focus point falls outside of the clip’s depth-of-field range, AF lock 
doesn’t bring the point into focus.

If you retime a Cinematic mode video clip, you can’t adjust focus points. However, you can 
still adjust depth of field.

Delete a focus point in a Cinematic mode video clip
•	 Click a manual focus point (yellow dot) in the Timeline, then click Delete Focus Point.

Note: Pressing the Delete key when a Cinematic clip is selected deletes the entire clip.

You cannot delete or modify automatic focus points (white dots in the Timeline). Although 
automatic focus points may be overwritten when you add manual focus points, they’re 
restored when the manual focus point is deleted.
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Adjust or animate depth of field in Cinematic mode 
video clips in Motion
When you import a Cinematic clip, it includes an inherent depth-of-field value that you can 
adjust and animate. For example, you can soften or sharpen the background behind your 
subject.

1.	 In the Layers list or Timeline in Motion, select a Cinematic clip.

2.	 In the Properties Inspector, drag the Depth of Field slider left or right.

Lower Depth of Field values result in a smaller or more narrow area of an image that’s 
in focus. For example, if a tree is in focus in the foreground, lowering the Depth of Field 
value blurs the background. This is known as a “shallow depth of field.”

Like all other parameters, you can animate the Depth of Field parameter using 
keyframes or Parameter behaviors.
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Work smarter

Intro to settings and shortcuts in Motion
This chapter covers information and techniques that will help you work more efficiently in 
Motion, including how to:

•	 Customize Motion Settings

•	 Access all Motion menu commands

•	 Use keyboard shortcuts

•	 Create custom keyboard shortcuts

•	 Use Touch Bar shortcuts

•	 Move projects, objects, or presets to another computer

•	 Use color and gradient controls

•	 Learn how rasterization impacts a project

•	 Work with an eGPU
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Motion Settings

Change settings in Motion
Motion Settings let you customize your workspace, tailor the interface for different types of 
projects, and define the presets for new projects and exported finished movies. 

Open Motion Settings 
1.	 In Motion, choose Motion > Settings (or press Command-Comma).

Note: On Macs running macOS Monterey or earlier, Settings is listed as Preferences 
in the Motion menu. The recommended system requirement for Motion 5.8 is macOS 
Ventura 13.5.

2.	 Click a button at the top of the window to open a settings pane:

•	 General settings affect what happens when you open Motion.

•	 Appearance settings control visual elements of the Motion interface.

•	 Project settings affect project and layer duration and other project options.

•	 Time settings affect how time is displayed, as well as playback and keyframing.

•	 Cache settings affect memory management and disk usage for projects.

•	 Canvas settings customize your canvas view.

•	 3D settings customize various aspects of working in the Motion 3D workspace.

•	 Presets settings set a default project type to open whenever you create a new 
project.

•	 Intro to Destinations settings create new share destinations and manage existing 
share destinations.

Reset settings in Motion
1.	 Press and hold the Option and Command keys while opening the Motion app.

2.	 In the dialog that appears, click Delete.

Motion opens, and settings are reset to the defaults.
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General settings in Motion
General settings affect basic preferences in Motion.

Startup
•	 At Startup: A pop-up menu that sets one of two default behaviors when Motion is 

launched:

•	 Create New Project: Opens a new empty project. If a default preset has not been 
chosen, the Project Browser appears at startup.

•	 Open Last Project: Opens the saved project from the previous session.

Interface
•	 Drop Menu Delay: A slider that sets how long you must wait before the drop menu 

appears when dragging to the Timeline, Layers list, or canvas. The drop menu provides 
additional choices for editing and importing objects into the project.

•	 Show Tooltips: A checkbox that, when selected, turns tooltips on across the application. 
Tooltips provide explanatory information such as names and basic usage techniques. 
They appear when you pause the pointer over tools and controls.
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Library
•	 Display Folders: A pop-up menu that sets how folders appear in the Library. Menu items 

include the following:

•	 Alphabetically in List: Lists folders alphabetically.

•	 Last in List: Groups the folders together at the end of the list after all nonfolder 
items.

•	 Photo Application: A pop-up menu that sets the photo application (Photos or Photo 
Booth) that appears in the Photos category of the Motion Library.

•	 Show preview icons: A checkbox that, when selected, turns preview icons on and off 
in the Library. For example, when looking at replicators in the Library with the “Show 
preview icons” checkbox selected, thumbnails of the replicators are shown.

When the checkbox is deselected, the generic icon for each item type is displayed. 

•	 Play items automatically on a single click: A checkbox that controls whether the preview 
area plays the contents of the item selected in the file stack.

Media
•	 Automatically manage unused media: A checkbox that, when selected, has Motion 

remove unused media from the Media list when you delete that media from the canvas, 
Layers list, or Timeline. If you want to retain (in the Media list) a copy of media that’s no 
longer used in your project, deselect this checkbox.

Appearance settings in Motion
Appearance settings affect visual elements of the Motion interface.
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Timeline
•	 Timebar Display: A pop-up menu that sets the Timeline display. There are three options:

•	 Name: Displays bars in the Timeline track area by object name.

•	 Name Plus Thumbnail: Displays bars in the Timeline track area by name and with a 
thumbnail image representing the first frame of the layer. This setting is the default. 
Only layers (shapes, images, image sequences, text, and so on) display a thumbnail. 
Objects such as cameras, lights, and behaviors do not display a thumbnail.

•	 Filmstrip: Displays bars in the Timeline as a continuous strip of frames. The name 
text does not appear. Only layers (shapes, images, image sequences, text, and 
so on) display a continuous strip of frames. Objects such as cameras, lights, and 
behaviors do not display frames.

Canvas
•	 Full View Opacity: A slider that controls the opacity of the part of a layer that extends 

beyond the edge of the canvas into the background. When set to 100%, the layer is 
transparent. When set to 0%, the layer is fully opaque. This setting takes effect when 
Show Full View Area is enabled in the View menu.

Thumbnail Preview
•	 Background: A pop-up menu that sets the background for thumbnail previews in the 

Layers list when layers are partially transparent (contain an alpha channel). There are 
two options:

•	 Checkerboard: Displays a checkerboard pattern over transparent pixels.

•	 Color: Displays a solid color over transparent pixels.

•	 Background color control: When Background is set to Color, this color control lets you 
select a new background color from the macOS Colors window or from the Motion pop-
up color palette.

Status Bar
These controls set the information that’s displayed in the status bar (above the canvas).

•	 Dynamic Tool Info: A checkbox that enables the display of transform information in 
the status bar when you actively adjust an object using the onscreen controls. When 
rotating an object in the canvas, for example, the original rotation value and the current 
degree of change are displayed in the status bar.

•	 Color: A checkbox that enables display of pixel color value in the status bar when you 
move the pointer in the canvas. Colors are displayed in the format chosen in the Display 
Color As pop-up menu (described below).

Note: If you position the pointer over a color that is out of gamut, the pixel color value 
appears yellow in the status bar.
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•	 Coordinates: A checkbox that enables display of the X and Y coordinates of the current 
pointer position.

•	 Frame rate (only during playback): A checkbox that enables display of playback frame 
rate. Nothing is displayed unless the project is playing.

•	 Display Color As: A pop-up menu that sets the style of color data display (when the 
Color checkbox is selected). Choose one of the following:

•	 RGB: Displays the red, green, blue, and alpha values of each pixel.

•	 RGB (Percent): Displays the red, green, blue, and alpha values of each pixel in 
percentages.

•	 HSV: Displays the color as hue, saturation, and value (brightness), where hue is a 
percentage from 1–360, and saturation and value are ranged from 1–100 degrees. 
Alpha is also displayed in a range of 1–100 degrees.

Project settings in Motion
Project settings affect project and layer duration and other project options.
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Default Project Settings
These controls determine default values for new projects. (These settings take effect in 
new projects created after you quit, then reopen Motion.) To change the settings of an 
open project, use the Properties Inspector (press Command-J to open the Properties 
Inspector). 

•	 Project Duration: A value field that sets the default duration for new projects. You can 
enter a number into the value field and choose Frames or Seconds from the pop-up 
menu.

•	 Background Color: A color control that sets the color of the background for any new 
projects created (but does not change the background color of the current project.)

Note: To render a new background color into your final output, you must choose Solid 
from the Background Color pop-up menu in the Properties Inspector (press Command-J 
to open it).

•	 For New Documents: Buttons that set what occurs when you create a project:

•	 Show Project Browser: Sets the Project Browser to appear whenever you create a 
project.

•	 Use Project: Sets a specific saved project to be opened whenever you create a 
project. When you select Use Project, the Choose button becomes available. Click 
Choose to specify the project to be opened. (If the project you want does not 
appear in the browser, click Open Other to locate the project in the Finder.) For more 
information on bypassing the Project Browser, see Bypass the Project Browser.

Still Images & Layers
These settings control the default duration, placement, and size of still images and 
imported layers, as well as layers created in Motion, such as text, shapes, and masks.

•	 Default Layer Duration: Buttons that set the duration of still images, generators, and 
other layers that lack an inherent duration. There are two options:

•	 Use project duration: Sets all layers to have the same duration as the project.

•	 Use custom duration: Sets a custom layer duration, defined in the adjacent value 
field.

•	 Create Layers At: Buttons that set where new layers are placed in the Timeline. There 
are two options:

•	 Current frame: Creates layers at the current playhead position.

•	 Start of project: Creates layers at the first frame of the project.

•	 Large Stills: A pop-up menu that sets the size of imported files. There are two options:

•	 Do Nothing: Imports the image at its original size.

•	 Scale to Canvas Size: Imports and scales the image to fit the project size while 
maintaining the file’s aspect ratio.

Note: For more information on the differences between the Large Stills options, see Set 
the import size of large images.
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Time settings in Motion
Time settings set how time is displayed in the project, as well as playback and keyframing 
options.

Time Display
These controls set how time is counted in the canvas toolbar’s timing display.

•	 Display Time As: A pop-up menu containing the following two items:

•	 Frames: Shows incrementing frame numbers in the timing display.

•	 Timecode: Shows eight-digit timecode numbers in the timing display.

•	 Frame Numbering: A pop-up menu that sets whether frame counts begin at 0 or 1.

Playback Control
•	 Time View Updating: A pop-up menu that sets how the Timeline updates when you play 

a project. Menu items include:

•	 Don’t update: Prevents the Timeline from advancing as you play. This setting 
improves performance.

•	 Jump by pages: Sets the Timeline track area to jump forward when the playhead 
reaches the far right side of the Timeline. 

•	 Scroll continuously: Sets the Timeline to scroll behind a static playhead.

•	 If Audio Sync Is Lost: Buttons that set how Motion attempts to keep audio and video 
playback in sync if the project is too complex to play both audio and video smoothly. 
There are two options:

•	 Skip video frames: Plays audio continuously but skips video frames to keep up.

•	 Pause audio playback: Temporarily suspends audio playback when the project 
cannot play smoothly.
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•	 Limit playback speed to project frame rate: A checkbox that, when selected, prevents 
the playback rate from exceeding the frame rate of the project. By default, Motion plays 
back your project as fast as possible based on the complexity of the effects and the 
processing power of your computer. When this checkbox is deselected, playback rate is 
limited only by your processor power; consequently, playback rate may exceed project 
frame rate.

•	 Loop audio while scrubbing: A checkbox that, when selected, sets the audio for the 
frames where you drag the playhead to repeat. When this checkbox is deselected, the 
audio for those frames plays only once.

Keyframing
•	 Lock keyframes in time in Keyframe Editor: A checkbox that, when selected, sets 

the values of keyframes in the Keyframe Editor, but prevents you from moving the 
keyframes forward or back in time. This helps prevent changing your animation timing 
as you adjust parameter values.

•	 Allow sub-frame keyframing: A checkbox option that ensures smoother animations 
when recording during playback or when scaling a group of keyframes in the Keyframe 
Editor using the Transform Keyframes tool.

Cache settings in Motion
Cache settings affect memory management and disk usage for projects.
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Memory & Cache
•	 Project Cache: A value field that specifies the percentage of your total system memory 

to use for the project cache. Enter a larger number to make more memory available to 
Motion to cache frames, to ensure consistently smooth playback.

Autosave
These settings control how frequently projects are saved, as well as the location of the 
saved files. Saved projects are time- and date-stamped. For more information about 
customizing autosave, see Save, autosave, and revert projects.

•	 Use Autosave Vault: A checkbox that, when selected, stores autosaved projects to the 
location specified by the Autosave Vault Folder path. By default, the Autosave Vault 
folder is located in the Users/username/Movies/Motion Projects/ folder. 

•	 Save a copy every: A value field that specifies how often, in minutes, a project is saved.

•	 Keep at most: A value field that specifies how many versions of the autosaved project to 
store in the vault.

•	 Maximum of: A value field that specifies the maximum number of autosaved projects to 
store in the vault.

•	 Autosave Vault Folder: A group of controls that let you set where the autosave files are 
kept. The Reset button sets the autosave location back to its default.

Optical Flow Retiming
When you retime footage, Motion stores the retiming files on your computer. The settings 
in this section specify the storage location.

•	 Save Retiming Files: Two buttons that set the storage location of retimed footage:

•	 In folder with source media: When enabled, this button tells Motion to save the 
retiming files in the same location as the source footage.

•	 In this folder: When enabled, this button sets a custom storage location. Click 
Choose, then select a new location in the file dialog. By default, the Optical Flow 
folder is located in the /Users/username/Library/Caches/com.apple.motionapp/
Retiming Cache Files/ folder.

•	 Delete Retiming Cache: A button that deletes any optical flow retiming files and resets 
any objects with optical flow to frame blending. An alert dialog appears asking if you 
want to remove all retiming files.

•	 Reveal in Finder: A button that, when clicked, shows the location of the retimed file 
folder in the Finder.



1323Motion User Guide

Canvas settings in Motion
Canvas settings customize your canvas view. Changes made in this pane take immediate 
effect in your current project.

Alignment
These settings control the color and display of the optional grid, rulers, and guides that 
appear in the canvas. Grids, guides, and rulers can be turned on and off in the View menu 
or in the View pop-up menu in the upper-right corner of the canvas.

•	 Grid Spacing: A slider that sets the width for the grid in pixels.

•	 Grid Color: A color control that sets the color of the grid lines.

•	 Guide Color: A color control that sets the color of guides.

•	 Dynamic Guide Color: A color control that sets the color for dynamic guides.

•	 Snap Objects At Their: A pop-up menu that defines how objects are aligned with other 
objects when moved in the canvas. There are three options:

•	 Center: Aligns objects at their centers.

•	 Edges: Aligns object at their edges.

•	 Center and Edges: Aligns objects at their centers and edges.

•	 Ruler Location: A pop-up menu the sets the position of the ruler in the canvas. There 
are four options: Bottom Left, Top Left, Top Right, and Bottom Right.
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Zones
These settings (available when you click the Zones button at the top of Canvas Settings) 
control safe zone sizes and colors. Safe zones are special guides to help you avoid placing 
images in areas of the screen that might not appear correctly on consumer television sets. 
Images that appear outside the action-safe region might be cut off. The area outside the 
title-safe region might have distortions that make text hard to read.

When producing output to be used for both television and film, it’s helpful to see the 
area of the TV frame that will be cut off when the clip is converted to film. The film zone 
settings allow you to display a guide that identifies the aspect ratio of the film gauge you 
are working in.

The safe zone and film zone guides can be turned on and off in the View menu, or in the 
View pop-up menu in the upper-right corner of the canvas.

•	 Action Safe Region: A slider that sets the percentage of the canvas where the action-
safe guides appear. (Default is 93% of the canvas size.)

•	 Title Safe Region: A slider that sets the percentage of the canvas where the title-safe 
guides appear. (Default is 90% of the canvas size.)

•	 Safe Zone Color: Controls that set the color of the safe zone guides.

•	 Film Zone: A pop-up menu that sets the guide size to match a standard aspect ratio. 
Entering a number into the value field to the right of the pop-up menu sets a custom 
aspect ratio. There are five menu choices:

•	 Academy Flat 1.85:1

•	 Anamorphic Scope 2.35:1

•	 High Definition 16:9

•	 Academy Standard 4:3

•	 Custom

•	 Film Zone Color: Controls that set the color of the film zone guides.
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3D settings in Motion
The 3D settings affect various aspects of working in the Motion 3D workspace.

General 3D
•	 Display Inset View: A pop-up menu that sets when the Inset view (a temporary window 

that displays a camera view) appears in the canvas. Inset View must be enabled in the 
View menu or View pop-up menu (in the upper-right corner of the canvas) for the Inset 
view to appear. There are three menu items:

•	 On Transform Change: Sets the Inset view to appear when adjusting an object’s 
transform parameters, such as position, rotation, or scale.

•	 On All Changes: Sets the Inset view to appear when making adjustments specific to 
an object, such as adjusting the parameters of a replicator, in the HUD or Inspector.

•	 Manually: Sets the Inset view to be displayed all the time.

•	 Inset View Size: A slider that sets the size of the Inset view.

See Set a 3D inset view.

•	 Default New Group Type: A pop-up menu that specifies whether new groups are 
created in 2D or 3D mode. When set to Automatic, Motion determines the type of group 
that’s created based on the project. For example, when Automatic is selected and you 
are working in a 3D project, new groups are 3D. If you are working in a 2D project (no 
camera), new groups are 2D.

3D Grid
These controls let you modify settings for the grid that appears in the Motion 3D 
workspace.

•	 3D Grid Spacing: A slider that specifies the spacing between grid lines, in pixels.

•	 Primary Grid Color: Controls that set the color of the main grid lines. The main grid lines 
appear slightly heavier than the secondary grid lines.

•	 Secondary Grid Color: Controls that set the color of the secondary grid lines (the lines 
that appear within the main grid lines).
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Presets settings in Motion
Presets settings let you select a default project preset, which determines the settings 
assigned when you create a project. You can change any of these settings while you work 
by selecting the Project object in the Layers list, then clicking Properties in the Inspector.

After you set default project preset this pane, all new projects opened from the Project 
Browser are created with this setting (unless you choose another option from the Preset 
pop-up menu in the Project Browser).

•	 Project Preset list: Displays the current list of presets. The checkbox to the left of each 
name identifies the default preset. The column on the right shows which presets are 
locked. Locked presets cannot be modified. You can duplicate a locked preset and edit 
the copy.

•	 Default: A column of checkboxes used to designate the default project setting used for 
new projects. Check a different box to select a new preset.

•	 Summary box (not labeled): To the right of the Project Preset list, the Summary box 
displays details of the selected preset.

•	 Add Preset (+): A button that displays the Project Preset Editor dialog used to create a 
preset.

•	 Delete Preset (–): A button that removes a preset selected in the Project Preset list 
above.

•	 Duplicate: A button that creates a duplicate of the preset selected in the Project Preset 
list above.

•	 Edit: A button that displays the Project Preset Editor, where you can modify preset 
settings.

See Project Preset Editor.
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Destinations settings in Motion

Intro to Destinations settings in Motion

You create and modify share destinations in the Destinations pane of Motion Settings. The 
destinations in the Destinations list (on the left side of the Destinations pane) also appear 
in the menu that appears when you click the Share button in the toolbar.

When you first open Motion, a default set of destinations appears in the Destinations list, 
but you can add other destinations and customize destinations. When you select Add 
Destination in the Destinations list, a list of destination types appears on the right. You 
can add any of these destinations to the Destinations list and then customize them for 
future use.

After you add a destination type to the Destinations list, select it in the list to see (and 
modify) its settings on the right. Those settings are described in the following topics.

For information about sharing projects using the preconfigured destinations, see Intro to 
exporting projects. For information about using Motion-specific render settings with shared 
projects, see Render settings.



1328Motion User Guide

Email destination in Motion

Use this destination to email your project using the macOS Mail app. The Email destination 
automatically creates an email message that includes the exported file.

The Email destination includes the following settings:

•	 Compression: Sets render quality. “Faster encode” sacrifices quality for faster processing.

•	 Resolution: Sets the frame size for your movie.

•	 Color Space: Sets the range of color used in the exported movie.

•	 Color Channels: Sets which color channels are output—RGB only, RGB with alpha 
channel (transparency), or alpha channel only.

•	 Duration: Sets whether to export the entire project or a play range set in the Timeline.

•	 Export selected layer only: When selected, exports a single layer selected in the 
project. If no layer is selected, or if an object that does not render is selected (such as a 
rig, a light, or a camera), this option is dimmed.

Save Current Frame destination in Motion

Use this destination to export a still image of any video frame in your project.

The Save Current Frame destination includes the following settings:

•	 Export: Sets the export file type, such as Photoshop, PNG, or TIFF.

•	 Scale image to preserve aspect ratio: When selected, exports frames from a project 
that uses a nonsquare pixel format (such as NTSC or PAL) into a square pixel format.

•	 Color Space: Sets the range of color used in the exported image.

•	 Color Channels: Sets which color channels are output—RGB only, RGB with alpha 
channel (transparency), or alpha channel only.

•	 Export selected layer only: When selected, exports a single layer selected in the 
project. If no layer is selected, or if an object that does not render is selected (such as a 
rig, a light, or a camera), this option is dimmed.

Export Image Sequence destination in Motion

Use this destination to export a set of sequentially numbered still-image files.

•	 Export: Sets the export file type to an image format such as PNG, TIFF, or OpenEXR.

•	 Scale image to preserve aspect ratio: When selected, exports frames from a project 
that uses a nonsquare pixel format (such as NTSC or PAL) into a square pixel format.

•	 Create sticker sequence: When selected, creates animated stickers for the Messages 
app on iOS and iPadOS. See Create stickers for Messages.

•	 Color Space: Sets the range of color used in the exported image sequence.

•	 Color Channels: Sets which color channels are output—RGB only, RGB with alpha 
channel (transparency), or alpha channel only.

•	 Duration: Sets whether to export the entire project or a play range set in the Timeline.

•	 Export selected layer only: When selected, exports a single layer selected in the 
project. If no layer is selected, or if an object that does not render is selected (such as a 
rig, a light, or a camera), this option is dimmed.
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Export File destination in Motion

This destination is used as the basis for four of the destinations in the default set: Export 
Movie, Export Selection to Movie, Export Audio, and Apple Devices.

Use this destination to export your project or clip as a movie file with video and audio, 
as a video file (with no audio), or as an audio file (with no video). You can also use this 
destination to export files for Apple devices, computers, and web hosting.

You can customize the Export File destination by choosing one of several resolutions, 
depending on the intended playback device. For example, choose 1280 x 720 resolution for 
iPhone and iPod, and 1920 x 1080 resolution for iPad.

The Export File destination includes the following settings:

•	 Format: Sets the mastering format (Video and Audio, Video Only, Audio Only) or 
publishing formats, including Apple Devices (such as iPhone and iPad), Computer (for 
playback on Mac and PC), and Web Hosting (such as YouTube or Vimeo). Your choice of 
format determines the options in the pop-up menus below.

•	 Video Codec: Sets the codec to use for the exported file. Available choices are based 
on the source clip or project media format.

•	 Resolution: Sets the default frame size. If the Motion project is a lower resolution than 
the setting you choose here, the exported file uses the project resolution. See Edit 
project properties.

•	 Color Space: Sets the range of color used in the exported movie.

•	 Color Channels: Sets which color channels are output—RGB only, RGB with alpha 
channel (transparency), or alpha channel only.

•	 Audio Format: When the Format pop-up menu is set to Audio Only, choose an audio 
format from this pop-up menu. If you chose another option from the Format pop-up 
menu, this item lists the audio format that will be used for the exported file.

•	 Duration: Sets whether to export the entire project or a play range set in the Timeline.

•	 Export selected layer only: When selected, exports a single layer selected in the 
project. If no layer is selected, or if an object that does not render is selected (such as a 
rig, a light, or a camera), this option is dimmed.

•	 Action: Sets what happens when the export is complete. You can choose the following 
options:

•	 Save only: Saves the file to a location you choose.

•	 Open with: Opens the exported file in the specified application. The options change 
based on the selection in the Format pop-up menu. For example, when Format is set 
to Video and Audio, QuickTime Player is the selected application; when Format is set 
to Audio Only, Music is the selected application.

•	 Other: Opens your Applications folder in a Finder window, allowing you to choose the 
application in which to open your exported file.

•	 Add to TV: Adds the exported file to Home Videos in your Apple TV app library.

When your export is complete, your shared file appears in the Home Videos category 
in the Library pane of the Apple TV app in macOS. In the Finder, the file is located in 
/Users/username/Movies/TV/Media/Home Videos.
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•	 Scale image to preserve aspect ratio: When selected, exports frames from a project 
that uses a nonsquare pixel format (such as NTSC or PAL) into a square pixel format.

•	 Create sticker sequence: When selected, creates animated stickers for Messages on 
iOS and iPadOS. See Create stickers for Messages.

Compressor Settings destination in Motion

Use this destination to export a project using settings from Compressor, the professional 
transcoding application designed to work directly with Motion.

Note: The Compressor Settings destination does not appear by default. To add it to the 
Destinations list, see Create and modify share destinations.

Exporting a project with a Compressor setting provides many of the benefits of 
Compressor without requiring you to open your project in Compressor. You can use 
Compressor to create multiple output files in one share operation, or create custom 
settings that modify your output file (for example, to add a watermark to the video). If you 
have Compressor installed on your system, you can use any of your Compressor settings 
with Motion.

If you don’t have Compressor installed on your system and you receive a Compressor 
setting from someone else, put the setting in this location so that Motion and Compressor 
can access it:

/Users/username/Library/Application Support/Compressor/Settings/

You may need to create the Compressor and Settings folders using the Finder.

 Tip: The Library folder within your home folder is hidden by default. To access it in the 
Finder, press and hold the Option key and choose Go > Library. See macOS Help, available 
from the Help menu when the Finder is active.

Bundle destination in Motion

You can group sets of destinations together in a bundle to create several types of output in 
a single step. When you share a project or clip using the bundle, a file for each destination 
in the bundle is output automatically. To learn how to create a bundle, see Create and 
modify share destinations.



1331Motion User Guide

Project Preset Editor in Motion
You make changes to a project preset in the Project Preset Editor. This window opens when 
you click the Add Preset button (+) or attempt to edit any of the existing presets in the 
Presets pane of the Motion Settings window. For more information on how to create, edit, 
or delete project presets, see Create and modify project presets.

Note: Locked presets cannot be edited. If you attempt to edit a locked preset, an alert 
dialog appears, a duplicate copy of the preset is made, and your edits are applied to the 
duplicate.

The Project Preset Editor contains the following settings:

•	 Name: An editable field containing the name for the preset.

•	 Description: A field containing descriptive text to identify the preset. You can enter your 
own descriptive text in this field. The new text will appear in the summary box in the 
Preset pane of Motion Settings.

Note: In the lower-right corner of the Project Browser, only the resolution, field order, 
and aspect ratio appear—the descriptive text (or preset name) does not appear.

•	 Width and Height: Fields to set the frame size for the preset.

•	 Projection Type: A pop-up menu that sets the projection preset to Normal or to 360° 
Monoscopic to create a 360° project preset.

•	 Color Processing: A pop-up menu that sets the color processing of the preset to 
Standard Gamut SDR, Wide Gamut HDR, or Automatic. See Set the color processing 
method.

•	 Pixel Aspect Ratio: A pop-up menu that sets the pixel aspect ratio for the preset. This 
setting should match the type of media in your project.

•	 Field Order: A pop-up menu that sets the field order for your project.

•	 Frame Rate: A pop-up menu that sets the frame rate for your preset.
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Motion menus

Intro to menus in Motion
The Motion menu bar provides access to many categories of commands in the application.

Many commands are context-sensitive—they change depending on the current state of the 
Motion application. For example, a menu item might appear dimmed when a command is 
not available due to the current state of the application or what is selected.

•	 The Application (Motion) menu contains general functions to control the application, 
modify settings, and access the Apple website.

•	 The File menu contains functions and commands for saving and managing Motion files.

•	 The Edit menu contains familiar commands such as Undo, Cut, Copy, and Paste and also 
commands to select and delete objects, modify project properties, and more.

•	 The Mark menu contains commands to set In and Out points, add markers to the 
Timeline, navigate through your project, and control animation of effects.

•	 The Object menu contains commands for manipulating objects in Motion, including 
object placement in the layer hierarchy and physical alignment in the canvas.

•	 The Favorites menu lets you apply saved custom content.

•	 The View menu contains commands for controlling the visual layout of the canvas and 
Timeline.

•	 The Window menu contains controls to show and hide the panes in the Motion interface.

•	 The Help menu provides access to resources for learning more about Motion.

Note: Many commands have shortcut keys that allow you to perform the same action from 
the keyboard. In this chapter, these shortcuts are listed in parentheses after the command 
description.

Application (Motion) menu
The Motion menu contains general functions to control the application, modify settings, 
and access the Apple website. It also provides access to system-level services.

•	 About Motion: Opens the About Motion window, which contains version, registration, 
and trademark information.

•	 Settings: Opens the Motion app settings. See Change settings.

•	 Command Sets: Opens a submenu of the following items for customizing keyboard 
shortcuts:

•	 Customize: Opens the Command Editor. See Intro to the Command Editor.

•	 Import: Opens a dialog used to import a customized key command set.

•	 Export: Opens a dialog used to export a customized key command set.

•	 Command Sets: Lets you load a customized key command set.

•	 Final Cut Pro Set: Sets the active keyboard to match the default key command layout 
in Final Cut Pro wherever possible. Choose English, Japanese, French, or German.

•	 Standard Set: Sets the active keyboard to the default key command layout. Choose 
English, Japanese, French, or German.
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•	 Provide Motion Feedback: Opens a webpage where you can send comments to Apple 
about Motion.

•	 Download Additional Content: Downloads additional Motion Library content such as 
templates, particle emitters, and replicators when your computer is connected to the 
internet.

•	 Services: Provides access to macOS keyboard shortcut settings in System Settings. See 
macOS Help.

•	 Hide Motion: Hides all Motion windows, but keeps the application running in the 
background. You can bring Motion windows back to the front by clicking the Motion icon 
in the Dock. (Command-H)

•	 Hide Others: Hides windows from all applications other than Motion. (Option-
Command-H)

•	 Show All: Shows all windows from all applications currently running.

•	 Quit Motion: Stops the application from running. You are prompted to save your open 
document. (Command-Q)

File menu in Motion
The File menu contains functions and commands for managing Motion files.

•	 New: Opens either the Project Browser or a new default Motion project (if you’ve 
already set a default project). (Command-N)

•	 New from Project Browser: Opens the Project Browser. (Option-Command-N)

•	 Open: Opens a dialog to select a Motion project to open. (Command-O)

•	 Open Recent: Opens a submenu that lists the most recently opened files.

•	 Close: Closes the current project. If the project has not been saved, Motion asks you to 
save the project before closing the window. (Command-W)

•	 Save: Stores the current state of the project to disk. (Command-S)

•	 Save As: Saves the current state of the project with a new name. (Shift-Command-S)

•	 Publish Template: Available when the current project is a standard Motion project, saves 
the current project as a Motion template or a Final Cut Generator template (for use in 
Final Cut Pro). See Intro to using templates and Create a generator template.

•	 Revert to Saved: Restores the selected project to the last saved state. Changes made 
after the last save are lost. Use caution; you cannot undo this operation.

•	 Restore from Autosave: Displays a dialog where you can choose a project previously 
saved to the Autosave Vault. See Cache settings.

•	 Import: Opens a dialog to select a file to import into your project. (Command-I)

•	 Import As: Opens a submenu of options for importing:

•	 Project: Opens a dialog to select a file to import as the basis of a new project using 
the file’s dimensions and duration. If multiple items are selected, they’re all placed in 
the same project. Additional options are available if an image sequence is selected. 
See Open an existing project. (Shift-Command-I)
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•	 Unused Media: Opens a dialog to select a file to import into the Media list. The 
imported media file isn’t added to your composition; instead, it’s stored in the Media 
list for future use in your project.

•	 Audio: Opens a dialog to select an audio file to import into your project. If you select 
a video clip that has audio, only the audio component is imported.

•	 Share: Opens a submenu of options for sharing your project:

•	 Export Movie: Exports your project as a QuickTime movie to a Finder folder to use 
in other projects and applications or to distribute manually. See Export a QuickTime 
movie.

•	 Export Selection to Movie: Exports the current selection as a QuickTime movie to a 
Finder folder. See Export a QuickTime movie.

•	 Export Audio: Exports only the audio portion your project as an audio file to a Finder 
folder. See Export a QuickTime movie.

•	 Save Current Frame: Saves the frame currently visible in the canvas as a still image 
file to a Finder folder. See Export a still image.

•	 Export Image Sequence: Exports your project as an image sequence to a Finder 
folder. See Export a QuickTime movie.

•	 Apple Devices: Exports your project using presets that allow you to watch it on 
Apple TV, or download it to iPad, iPhone, or iPod. See Export to Apple devices.

•	 Email: Opens the Mail application and attaches your project as a rendered movie file. 
See Export to email.

•	 [Custom Compressor Setting]: If you’ve created a custom Compressor setting (in 
the Compressor app), exports your project using that predefined export setting. See 
Export using Compressor.

•	 Add Destination: Opens the Destinations pane of Motion Settings. See Create and 
modify share destinations.

•	 Send to Compressor: Renders your project through the Compressor app (if installed), 
allowing you to further customize your export settings and output a single movie file 
to a Finder folder. See Export using Compressor.

•	 Convert Project To: Opens a submenu of options for converting a standard Motion 
project to a Final Cut Effect, Final Cut Generator, Final Cut Title, or Final Cut 
Transition template, converting a Final Cut template to a different template type, or 
converting any template to a standard Motion project. See Convert a Motion project 
to a template or Convert a template to another type.

•	 Reconnect Media: Reestablishes a link to a file on disk when a layer in your project has 
been moved or modified.

•	 Remove Unused Media: Removes a media item from your project when the item is 
stored in the Media list but not used in the project.

•	 Remove Optical Flow Retiming: Resets the retiming information file when a media item 
has been processed for retiming. See Intro to retiming media in the Timeline.

•	 Page Setup: Displays the standard macOS Page Setup dialog, where you can set paper 
size and orientation for printing. (Shift-Command-P)

•	 Print: Displays the standard macOS Print dialog, where you can print the contents of the 
canvas. (Command-P)
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Edit menu in Motion
The Edit menu contains familiar commands such as Undo, Cut, Copy, and Paste and also 
contains commands to select and delete objects, modify project properties, and control 
the Motion spelling checker.

•	 Undo: Restores the project to the state prior to the action previously taken. This 
command is usually followed by the name of the last command performed (Undo Move 
or Undo Rotation Change, for example). If the menu item is dimmed, you cannot undo. 
(Command-Z)

•	 Redo: Performs the action that was previously undone. This command is usually 
followed by the name of the last command performed (Redo Move or Redo Rotation 
Change, for example). It’s only active if one or more actions have been undone. (Shift-
Command-Z)

•	 Cut: Removes the selection and stores it on the Clipboard so it can be pasted later. 
(Command-X)

•	 Copy: Copies the selection and stores it on the Clipboard so it can be pasted later. 
(Command-C)

•	 Paste: Adds the current Clipboard selection to the project based on the current 
selection. This command is not available if nothing is on the Clipboard or if the contents 
of the Clipboard cannot be pasted to the current selection—for example, text cannot be 
pasted onto a keyframe. (Command-V)

•	 Paste Special: Gives you the choice to paste the contents of the Clipboard into the 
active Timeline by inserting (pushing existing objects out of the way) or exchanging or 
overwriting (replacing existing objects with the selected object). See Copy and paste 
objects in the Timeline. (Option-Command-V)

•	 Duplicate: Makes a copy of the current selection and immediately adds it to the project. 
(Command-D)

•	 Delete: Removes the current selection, leaving a gap in the Timeline. (Delete)

•	 Ripple Delete: Removes the current selection and closes the gap in the Timeline. (Shift-
Delete)

•	 Insert Time: Adds blank space into the Timeline. You can use Insert Time only after 
selecting a time region in the Timeline ruler. See Edit a range of frames in the Timeline.

•	 Split: Breaks an object into two objects, each on its own Timeline track. The split occurs 
at the current playhead position. If no object is selected, or if the playhead is not 
positioned over a selected object, this menu item is dimmed.

•	 Transform Control Points: When multiple control points of a shape or mask are selected, 
choosing this command creates a bounding box around the points. See Add or delete 
control points. (Option-Shift-Command-T)

•	 Select All: Selects all objects in the project. (Command-A)

•	 Deselect All: Releases any objects selected in the project. (Shift-Command-A)

•	 Project Properties: Selects the Project object in the Layers list and opens the Properties 
Inspector. Use this pane to change the settings for the project. See Intro to project 
properties. (Command-J)
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•	 Spelling and Grammar: Opens the macOS submenu of spell-checking controls that allow 
you to search through the selected text for spelling and grammatical errors. See macOS 
Help.

•	 Find and Replace: Opens the Find and Replace dialog, where you can locate and change 
a word (or any set of characters) that you’ve used in a Motion project. See Find and 
replace text.

•	 Start Dictation: Enables and disables dictation. Dictation must be turned on in the 
Dictation pane of Keyboard settings. See macOS Help.

•	 Emoji & Symbols: Opens the macOS Character Viewer, which provides access to 
nontypical text characters like bullets, arrows, and currency icons. It can be used 
when typing in a text object in the canvas, or when typing in the Text editor in the Text 
Inspector. (Control-Command-Space bar) 

Mark menu in Motion
The Mark menu contains commands to set the beginning and end points of your objects, 
add markers to the Timeline, navigate through your project, and control the animation of 
effects.

•	 Mark In: Sets the beginning frame of the play range to the current playhead position if 
no object is selected. If an object is selected, this command trims the In point for that 
object to the current playhead frame. (I)

•	 Mark Out: Sets the ending frame of the play range to the current playhead position if 
no object is selected. If an object is selected, this command trims the Out point for that 
object to the current playhead position. (O)

•	 Move Selected In Point: Moves the selected object or objects so the In point aligns with 
the current playhead position. (Shift-Left Bracket)

•	 Move Selected Out Point: Moves the selected object or objects so the Out point aligns 
with the current playhead position. (Shift-Right Bracket)

•	 Markers: Opens a submenu of commands for creating, modifying, and deleting markers. 
See Intro to Timeline markers. The submenu includes the following commands:

•	 Add Marker: Adds a marker at the current playhead frame. If an object is selected, an 
object marker is added. If no object is selected, a project marker is added. (Press M 
or the Tilde key [~] to add an object marker; press Shift-M to add a project marker.)

•	 Edit Marker: Opens the Edit Marker dialog, where you can set a marker’s name, type 
(for project markers), color, duration, and comment. A marker must be selected for 
this menu item to be active. (Option-Command-M)

•	 Delete Marker: Removes the selected marker from the project.

•	 Delete All Markers: Removes all markers from the selected object. If no object is 
selected, this command deletes all project markers.

•	 Mark Play Range In: Sets the play range In point to the location of the playhead. 
(Option-Command-I)

•	 Mark Play Range Out: Sets the play range Out point to the location of the playhead. 
(Option-Command-O)

•	 Reset Play Range: Moves the play range In and Out points to the first and last frame of 
the project. (Option-X)
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•	 Play: Starts playback of the project. (Space bar)

•	 Play Selection: Starts playback at the beginning of the selected object or objects. Any 
unselected areas of the Timeline are dimmed during playback. (Backslash)

•	 Loop Playback: Turns looping on and off. When looping is enabled, playback repeats 
from the beginning of the play range after the end is reached. (Shift-L)

•	 Record Animation: Turns keyframe recording on and off. See Add keyframes.

•	 Recording Options: Opens the Recording Options dialog, where you can define user 
preferences for keyframe recording. See Simplify a keyframe curve. 

•	 Go to: Opens a submenu of commands for navigating to a specific frame in a project. 
The submenu includes the following commands:

•	 Project Start: Moves the playhead to the first frame of the project. (Home)

•	 Project End: Moves the playhead to the last frame of the project. (End)

•	 Play Range Start: Moves the playhead to the project In point. (Shift-Home)

•	 Play Range End: Moves the playhead to the project Out point. (Shift-End)

•	 Previous Frame: Moves the playhead backward by one frame. (Left Arrow)

•	 Next Frame: Moves the playhead forward by one frame. (Right Arrow)

•	 10 Frames Back: Moves the playhead backward ten frames. (Shift-Left Arrow)

•	 10 Frames Forward: Moves the playhead forward ten frames. (Shift-Right Arrow)

•	 Previous Keyframe: Moves the playhead to the previous keyframe in the project. 
(Option-K)

•	 Next Keyframe: Moves the playhead to the next keyframe in the project. (Shift-K)

•	 Previous Marker: Moves the playhead to the closest marker earlier in time. (Option-
Command-Left Arrow)

•	 Next Marker: Moves the playhead to the closest marker later in time. (Option-
Command-Right Arrow)

•	 Selection In Point: Moves the playhead to the first frame of the selected object. 
(Shift-I)

•	 Selection Out Point: Moves the playhead to the last frame of the selected object. 
(Shift-O)

•	 RAM Preview: Opens a submenu of commands to play back your project in real time, by 
temporarily storing the frames in a RAM buffer. See Play back a project. The submenu 
includes the following commands:

•	 Play Range: Renders the area between the project In and Out points and stores the 
frames in RAM. After the frames are stored, the region plays back at full speed. 
(Command-R)

•	 Selection: Renders the range of time occupied by the selected objects and stores 
the frames in RAM. After the frames are stored, the region plays back at full speed. 
(Option-Command-R)

•	 All: Renders the entire project and stores the frames in RAM. After the frames are 
stored, the region plays back at full speed. (Option-Shift-Command-R)

•	 Clear RAM Preview: Clears the RAM cache.
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Object menu in Motion
The Object menu contains commands for manipulating objects in Motion, including object 
placement in the layer hierarchy and physical alignment in the canvas.

•	 New Group: Adds a new empty group to the project. (Shift-Command-N)

•	 New Camera: Adds a new scene camera to the project, and lets you specify whether to 
use 2D or 3D mode (if the project is not empty). (Option-Command-C)

•	 New Light: Adds a new light to the project, and lets you specify whether to use 2D or 
3D mode (if the project is not empty). (Shift-Command-L)

•	 New Light Setup: Adds a preset lighting environment to the project, and lets you specify 
whether to use 2D or 3D mode (if the project is not empty). 

•	 New Drop Zone: Adds a new drop zone to your project. Drop zones allow you to replace 
footage in a project by dropping clips onto the canvas. See Intro to drop zones.(Shift-
Command-D)

•	 New Rig: Adds a new rig to the project. Rigging lets you create complex animations that 
are easy to modify, by aggregating many separate parameters into a single control, such 
as a slider or pop-up menu. See Intro to rigging.

•	 New 360° Environment: Adds a 360° environment to the project (Shift-Command-E). 
See Intro to 360° video.

•	 Bring to Front: Moves the selected object to the top of the layers in a group. 
(Command-Right Brace)

•	 Send to Back: Moves the selected object to the bottom of the layers in a group. 
(Command-Left Brace)

•	 Bring Forward: Moves the selected object upward in the Layers list by one object. 
(Command-Right Bracket)

•	 Send Backward: Moves the selected object downward in the Layers list by one object. 
(Command-Left Bracket)

•	 Alignment: Opens a submenu of commands for aligning and distributing multiple objects 
in the canvas. See Align layers in the canvas. Submenu commands include the following:

•	 Align Left Edges: Moves the selected objects so their left edges line up with the 
leftmost edge in the selection.

•	 Align Right Edges: Moves the selected objects so their right edges line up with the 
rightmost edge in the selection.

•	 Align Top Edges: Moves the selected objects so their top edges line up with the 
topmost edge in the selection.

•	 Align Bottom Edges: Moves the selected objects so their bottom edges line up with 
the bottommost edge in the selection.

•	 Align Far Edges: In 3D mode, aligns the farthest edges of each object along the Z 
(depth) axis.

•	 Align Near Edges: In 3D mode, aligns the nearest edges of each object along the Z 
(depth) axis.

•	 Align Horizontal Centers: Lines up the selected objects on their horizontal center 
points.
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•	 Align Vertical Centers: Lines up the selected objects on their vertical center points.

•	 Align Depth Centers: Lines up the selected objects on their Z (depth) center points.

•	 Distribute Lefts: Spreads the selected objects evenly between the leftmost and 
rightmost objects based on their left edges.

•	 Distribute Rights: Spreads the selected objects evenly between the leftmost and 
rightmost objects based on their right edges.

•	 Distribute Tops: Spreads the selected objects evenly between the topmost and 
bottommost objects based on their top edges.

•	 Distribute Bottoms: Spreads the selected objects evenly between the topmost and 
bottommost objects based on their bottom edges.

•	 Distribute Far: Spreads the selected objects evenly between each object’s farthest 
point.

•	 Distribute Near: Spreads the selected layers evenly between each object’s nearest 
point.

•	 Distribute Horizontal Centers: Spreads the selected objects evenly between the 
leftmost and rightmost objects based on their horizontal center points.

•	 Distribute Vertical Centers: Spreads the selected objects evenly between the 
topmost and bottommost objects based on their vertical center points.

•	 Distribute Depth Centers: Spreads the selected objects evenly between the nearest 
and farthest objects, based on their Z (depth) center points.

•	 Group: Combines the selected objects into a group. (Shift-Command-G)

•	 Ungroup: Removes the grouping so you can manipulate the objects individually. 
(Option-Command-G)

•	 Active: Sets whether an object is active. When an object is not active, it doesn’t appear 
in the canvas and doesn’t appear in the final output. When the selected item is active, 
the menu item has a checkmark beside it. (Control-T)

•	 Solo: Hides all other objects in the project (but not the selected object). When the 
selected item is soloed, the menu item has a checkmark beside it. (Alternatively, you 
can Control-click an object in the Layers list and choose Solo from the shortcut menu.) 
You cannot solo a camera, light, or rig. (Control-S)

•	 Isolate: Displays the selected object in its original front-facing orientation if it has been 
rotated in 3D space. (Control-I) 

•	 Lock: Prevents any changes from affecting the selected object. When the selected 
object is locked, the menu item has a checkmark beside it. (Control-L)

•	 Unsolo: Opens a submenu that lets you turn a soloed object back to its normal state. 
There are three choices: Video Only (Control-Shift-S), Audio Only, or Video and Audio. 
This menu item is available only when a soloed object is selected.

•	 3D Group: Changes the selected group to a 3D group. Deselecting the menu option 
changes the group back to a 2D group. (Control-D)

•	 Blend Mode: Opens a submenu for setting the blend mode of the selected layer. A layer 
must be selected for blend mode options to be available. A layer can only have one 
blend mode set at a time. See Types of blend modes.

•	 Add Image Mask: Adds a mask to the selected layer. (Shift-Command-M)
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•	 Add Keyframe: Adds a keyframe to the selected object, based on the last parameter 
adjusted. The name change is based on your last action (positioning an object, 
adjusting the scale handles, and so on). (Control-K)

•	 Convert to Keyframes: Converts all behaviors to keyframes on the parameters that the 
behaviors affect. This command is available only when the selected object or objects 
have behaviors applied. (Command-K)

•	 Convert to Mask: Converts a selected shape to a mask and applies the mask to the 
enclosing group. This command is available only when the selected object is a shape in 
a 2D group or a flattened 3D group. See Convert between shapes and masks.

•	 Convert to Points: Converts a selected shape to editable Bezier points. This command 
is available only when the selected object is a simple shape. (Option-Command-B)

•	 Make Particles: Uses the selected layer as a cell source for a new particle emitter. (E)

•	 Replicate: Replicates the selected layer. (L)

•	 Make Clone Layer: Creates a clone of the selected layer or group. See Add and remove 
layers and groups.

•	 Reveal Source Media: Opens the Media list and highlights the item that corresponds 
with the selected object. (Shift-F)

Favorites menu in Motion
The Favorites menu remains empty until you create your own favorite effects. After you’ve 
created favorites and stored them in the Favorites Menu folder in the Library, they appear 
in the Favorites menu, grouped by type. Use this menu to apply saved favorites to your 
project.

•	 Show Favorites Menu Items: Opens the Library and displays the Favorites Menu folder.

View menu in Motion
The View menu contains commands for controlling the Motion interface. Most of these 
items affect the canvas, but some also apply to the Timeline and other areas of the 
interface.

•	 Zoom In: Zooms into the canvas. (Command-Equal Sign)

•	 Zoom Out: Zooms out of the canvas. (Command-Hyphen)

•	 Zoom Level: This submenu lets you set a specific zoom level, including a Fit in Window 
option. (Shift-Z)

•	 Zoom Time View: Opens a submenu of the following commands for zooming the 
contents of the Timeline:

•	 Zoom In: Zooms in to the Timeline. (Option-Command-Equal Sign)

•	 Zoom Out: Zooms out of the Timeline. (Option-Command-Minus Sign)

•	 To Project: Zooms your Timeline so the entire duration of the project fills the window.

•	 To Play Range: Zooms your Timeline so the area between the project In and Out 
points fills the window.

•	 Correct for Aspect Ratio: Adjusts the display of the canvas to simulate the nonsquare 
pixels that appear on a TV monitor.
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•	 Show Full View Area: Turns on or off the display of layers that extend beyond the 
edges of the canvas. Areas that extend beyond the edges of the canvas appear 
semitransparent. (Shift-V)

•	 Use Drop Zones: Turns drop zones on and off.

•	 Save View Defaults: Saves the current state of all overlay settings (rulers, safe zones, 
animation paths, 3D overlays, and so on) as the default state for new projects. See 
Custom canvas view options.

•	 3D View: Opens a submenu of camera view options in a 3D project. This menu is 
identical to the Camera pop-up menu in the upper-left corner of the canvas. See Intro 
to 3D compositing. The submenu contains the following options:

•	 Active Camera: Shows the view from the active camera. Cameras added to your 
project appear in this list as Camera, Camera 1, Camera 2, and so on. (Control-A) 

•	 Perspective: Shows the perspective camera view.

•	 Front: Shows the front camera view.

•	 Back: Shows the back camera view (the view from the back of the scene).

•	 Left: Shows the left camera view (the view from the left of the scene).

•	 Right: Shows the right camera view (the view from the right of the scene).

•	 Top: Shows the top camera view (the view from the top of the scene).

•	 Bottom: Shows the bottom camera view (the view from the bottom of the scene).

•	 360° Look Around: Sets the view to 360° Look Around. (Control-V)

•	 360° Overview: Sets the view to 360° Overview. (Control-O)

•	 Mirror VR Headset: Sets the view to Mirror VR Headset. (Control-H)

For more information on working with 360° video and VR headsets, see Intro to 360° 
video.

•	 Next Camera: When the canvas is active, this command changes your view to the 
next scene camera based on camera order in the Layers list. (Control-C)

•	 Select Active Camera: Selects the “active” camera in the project—the topmost 
camera in the Layers list when there are multiple cameras existing at the same frame 
in time). (Control-Option-C)

•	 Reset View: Resets the camera view to its default orientation. (Control-R)

•	 Fit Objects into View: Reframes the current camera to fit the selected objects into 
the canvas. (F)

•	 Frame Object: Frames the selected objects in the active view. If no objects are 
selected, Frame Object resets the reference camera to view all objects in the scene. 
See Use 3D view tools. (Shift-Command-F)

•	 Focus on Object: Used when a camera has depth of field turned on. Adjusts the 
camera’s Focus Offset to the selected object. See Intro to depth of field. (Control-F) 



1342Motion User Guide

•	 Channels: Opens a submenu of options to set which color and transparency channels 
are displayed in the canvas This menu is identical to the Channels pop-up menu above 
the canvas. The submenu contains the following options:

•	 Color: Shows the image just as it would appear on a video monitor. Visible layers 
appear in natural color and transparent areas reveal the background color (black by 
default) as set in the Project Properties. (Shift-C)

•	 Transparent: Shows the background area of the canvas as transparent. A 
checkerboard pattern appears by default where no images block the background. 
(Shift-T)

•	 Alpha Overlay: Displays the image in normal color, but adds a red highlight over 
transparent areas of the image. (Option-Shift-T)

•	 RGB Only: Displays the normal mix of red, green, and blue channels but transparent 
areas (including semitransparent areas) are treated as opaque. (Option-Shift-C)

•	 Red: Sets the canvas to display only the red channel as a range of black to white. 
(Shift-R)

•	 Green: Sets the canvas to display only the green channel as a range of black to 
white. (Shift-G)

•	 Blue: Sets the canvas to display only the blue channel as a range of black to white. 
(Shift-B)

•	 Alpha: Sets the canvas to display the alpha (transparency) channel of the layers in 
the canvas. (Shift-A)

•	 Inverted Alpha: Sets the canvas to display an inverted view of the alpha 
(transparency) channel. (Option-Shift-A)

•	 Toggle Current & Alpha: Switches back and forth between viewing the current state 
and just the alpha channel. (V)

•	 Exposure: Displays the overexposed areas of the composition relative to the 
project’s render color space. Out-of-gamut values are indicated by a red-and-white 
stripe pattern. You can use the Broadcast Safe filter to limit the range of luminance 
or chrominance in an image to the broadcast legal limit. (Option-Shift-O)

•	 Saturation: Displays the oversaturated areas of the composition. Out-of-gamut 
values are indicated by a blue-and-white stripe pattern.

•	 Resolution: Opens a submenu of options for playback quality and visual quality in 
the canvas. Choosing a lower resolution option improves playback performance. The 
submenu includes the following options:

•	 Dynamic: Reduces the quality of the image displayed in the canvas during playback 
or scrubbing in the Timeline or mini-Timeline, allowing for faster feedback. Also 
reduces the quality of an image as it is actively modified in the canvas. After 
playback or scrubbing is stopped or the modification is completed in the canvas, 
the image quality is restored (based on the Quality and Resolution settings for the 
project). Shift-Q)

•	 Full, Half, or Quarter: Sets image quality. Each lower setting further degrades the 
image.
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•	 Quality: Opens a submenu of display mode settings for objects in the canvas, such as 
text and images:

•	 Draft: Renders objects in the canvas at a lower quality to allow optimal project 
interactivity. There’s no anti-aliasing.

•	 Normal: Renders objects in the canvas at a medium quality (the default setting). 
Shapes are anti-aliased, but 3D intersections are not.

•	 Best: Renders objects in the canvas at best quality, which includes higher-quality 
image resampling, anti-aliased intersections, and anti-aliased particle edges. This 
option slows down project interactivity.

•	 Custom: Lets you set additional controls to customize render quality. Choosing 
Custom opens the Advanced Quality Options dialog. See Advanced Quality settings.

 Tip: When working in your project, work in Draft or Normal for better interactivity. 
When you’re ready to export your project, use Best or Custom.

•	 Render Color Space: Opens a submenu of color space settings that determine the 
appearance of images you see in the canvas. This setting also determines the color 
space and appearance of your exported project (the output media file) when “Use 
canvas setting” is selected in the Settings pane of the share window. The submenu 
contains the following options:

•	 Automatic: Automatically sets the render color space based on the Color Processing 
parameter (in the Project Properties Inspector). When you create a wide-gamut HDR 
project, HDR Rec. 2020 PQ is set by default.

•	 Rec. 709: Sets your project to use the Rec. 709 color space, the current standard 
for HDTV projects, including HD cable, Blu-ray discs, and most streaming video 
today. You can also create a project that uses the standard color space with wide-
gamut media—for example, if you have wide-gamut media but need to deliver a 
standard project, or if you need to deliver both standard and wide-gamut versions of 
a project.

•	 Rec. 2020: Choose this legacy setting for projects created previously using the Wide 
Gamut - Rec. 2020 color space. If you intend to export an HDR movie, choose one of 
the following Wide Gamut HDR options.

•	 HDR Rec. 2020 HLG: Choose this option if you intend to create an HDR project with 
the Rec. 2020 color space and HLG transfer function (Rec. 2100 standard), using 
formats such as HLG or Advanced HDR. HLG, or Hybrid Log-Gamma, was developed 
by the BBC and NHK broadcasting networks and is compatible with older standard-
dynamic-range (SDR) televisions and monitors. Projects created with this color 
space option in Motion are compatible with HLG HDR televisions and displays.

•	 HDR Rec. 2020 PQ: Choose this option if you intend to create an HDR project with 
the Rec. 2020 color space and PQ transfer function (Rec. 2100 standard), using 
formats such as HDR10, HDR10+, Dolby Vision, or Advanced HDR.

When you select HDR Rec. 2020 PQ from the Render Color Space submenu (and 
have Color selected in the Appearance pane of Motion Settings), an additional nits 
value is displayed in the status bar. This shows the luminance value of the pixel 
under the pointer.
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Use the Render Color Space options to preview how your project will appear in the 
selected format. For example, if you’re working in Rec. 2020 color space and plan to 
export to a Rec. 709 format, set Render Color Space to Rec. 709 to view any clipping 
that may occur. (This setting is most useful if you’re working on a wide-gamut display.) 
See About color space.

When Color Processing is set to Automatic (in the Project Properties Inspector), the 
Render Color Space setting is determined by your display.

•	 Show HDR as Tone Mapped: Use the Show HDR as Tone Mapped setting in the View 
menu to show HDR content on an SDR display or an HDR display in a non-reference 
configuration. See View HDR media.

Note: Show HDR as Tone Mapped is only available in Wide Gamut HDR and Automatic 
projects.

•	 Render Options: Opens a submenu to enable or disable rendering settings that 
may impact playback speed. The submenu contains the following options: Lighting 
(Option-L), Shadows (Control-Option-S), Reflections (Control-Option-R), Depth of Field 
(Control-Option-D), Motion Blur (Option-M), Field Rendering (Option-F), Frame Blending 
(Control-Option-B).

•	 Show Overlays: Turns the display of all overlays on and off in the canvas. This 
setting must be on to view any other overlay items (rulers, grids, guides, and so on). 
(Command-Slash)

•	 Show Rulers: Turns display of rulers in the canvas on and off. (Shift-Command-R)

•	 Overlays: Opens a submenu to enable or disable various indicators, guides, and grids in 
the canvas. The submenu contains the following options:

•	 Grid: Turns the display of a grid on and off. You can customize the grid in the Canvas 
pane of Motion Settings. (Command-Apostrophe)

•	 Guides: Turns the display of guides on and off. (Command-Semicolon)

•	 Dynamic Guides: Turns dynamic guides on and off. Dynamic guides are the lines that 
appear when you drag one item into alignment with another layer. Press N to turn 
snapping on or off. (Shift-Command-Semicolon) 

•	 Safe Zones: Turns the display of title-safe and action-safe guides on and off. You 
can customize the safe zones in the Canvas pane (Zones) of Motion Settings. 
(Apostrophe)

•	 Film Zones: Turns the display of film-based aspect ratio guides on and off. You can 
customize the film zones in the Canvas pane (Zones) of Motion Settings. (Shift-
Apostrophe)

•	 Handles: Turns the display of object handles in the canvas on and off. The handles 
are the corner points that let you manipulate an object. 

•	 Lines: Turns the display of object border lines on and off.

•	 Animation Path: Turns the display of keyframe animation paths—lines that show 
where an object moves in the canvas—on and off.
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•	 Guides: Opens a submenu of commands that control the guides in the canvas:

•	 Lock Guides: Causes all guides to be fixed in their current position to prevent you 
from accidentally moving a guide instead of moving an object. (Option-Command-
Semicolon)

•	 Unlock Guides: Releases guides to be manually manipulated.

•	 Clear Guides: Removes all guides from the canvas.

•	 Add Vertical Guide: Adds a moveable, vertical guide to the center of the canvas.

•	 Add Horizontal Guide: Adds a moveable, horizontal guide to the center of the 
canvas.

•	 Snap: Turns object snapping on and off in the canvas and Timeline. Snapping aligns 
objects as you drag them. (N)

•	 Show 3D Overlays: Turns all 3D overlays on and off, including the 3D view tools, 3D 
compass, Inset view, 3D grid, and 3D scene icons.

•	 3D Overlays: Opens a submenu of the following items that set the display of 3D overlays 
in the canvas:

•	 3D View Tools: Turns the Camera menu and 3D view tools on and off.

•	 Compass: Turns the 3D compass on and off. The compass shows your current 
orientation in 3D space. 

•	 Inset View: Turns on inset view—a window in the lower-right corner of the canvas 
that displays a perspective or active-camera view of your project as you move 
objects in 3D space, helping you stay oriented. 

•	 3D Grid: Turns the 3D grid on and off. The 3D grid helps you stay oriented while 
working in 3D space and can be used to guide the placement of objects in your 
project. (Shift-Command-Apostrophe)

•	 3D Scene Icons: Turns all 3D scene icons, such as lights and cameras, on and off.

•	 Layers Columns: Opens a submenu to enable or disable the following controls in the 
Layers list of the Project pane:

•	 Preview: Shows a thumbnail of the object. The group thumbnail represents the 
cumulative result of the composite up to that point in the project.

•	 Opacity: Displays the current opacity (transparency) of the group or layer. You can 
adjust the slider to change the item’s opacity.

•	 Blend Mode: Displays the current blend mode of the layer or group. Choose a new 
blend mode from the pop-up menu. See Types of blend modes.

•	 Media Columns: Opens a submenu of the following commands to turn on or off the 
display of technical information in the Media list of the Project pane:

•	 Preview: Shows a thumbnail of the media file. The thumbnail for an audio file (with no 
associated image) appears as a speaker icon.

•	 Kind: Identifies the type of media, including QuickTime movie, still image, QuickTime 
audio, or PDF. See Supported media formats.

•	 In Use: Indicates whether a media item is being used in your project.

•	 Duration: Displays the duration of the media in frames or timecode.
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•	 Frame Size: Displays the native size of the image in pixels. The numbers represent 
width and height. This column remains blank for audio-only files.

•	 Format: Displays the format of the clip. This is also sometimes referred to as a 
codec.

•	 Depth: Displays the number of colors (bit depth) of the file. Any item listed as 
Millions of Colors+ indicates that the media contains an alpha channel in addition to 
the RGB data.

•	 Video Rate: Displays the frame rate of the media.

•	 Audio Rate: Displays the sample rate in the audio track, measured in kilohertz (kHz).

•	 Audio Bit Depth: Displays the bit depth of the audio file.

•	 File Size: Displays the overall file size of the media on disk.

•	 File Created: Displays the creation date of the media.

•	 File Modified: Displays the last date on which the media was modified.

•	 Show/Hide Fonts: Displays or hides the macOS Fonts window for selecting fonts and 
font attributes. (Command-T)

•	 Show/Hide Colors: Displays or hides the macOS Colors window for selecting colors. 
(Shift-Command-C)

Window menu in Motion
The Window menu contains controls to show and hide the panes in the Motion interface.

•	 Minimize: Shrinks the active window to the Dock—equivalent to clicking the Minimize 
button in the upper-left corner of the window. (Command-M)

•	 Minimize All: Shrinks the Motion project window and the viewer window (if you’re using 
a viewer window to preview an image or clip) to the Dock.

•	 Zoom: Resizes the active window to maximize desktop real estate, switching between 
full screen and the previously saved non-full screen state.

•	 Window Layout: Adjusts the Motion interface to either Classic layout (Library and 
Inspector on the left side of the interface) or Cinema layout (Library and Inspector on 
the right side of the interface).

•	 Show Inspector: Opens a submenu of commands to open the four Inspectors: Properties 
(F1), Behaviors (F2), Filters (F3), and Object (F4).

•	 Show/Hide Project Pane: Turns the display of the Project pane on or off. (F5)

•	 Show/Hide Timing Pane: Turns the display of the Timing pane on or off. (F6)

•	 Show/Hide HUD: Turns the display of the HUD on or off. (F7)

•	 Show/Hide Task List: Displays the Background Task List window. See View the status of 
shared items. (F9)

•	 Player Mode: Expands canvas to fill the Motion window. (F8)

•	 Show canvas on Second Display/Show Canvas in the Main Window: Shows the canvas 
and Project pane (Layers, Media, and Audio lists) on a second display, if you have two 
displays connected to your computer.
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•	 Show Timing Pane on Second Display/Show Timing Pane in the Main Window: Shows the 
Timing pane (Timeline, Audio Timeline, and Keyframe Editor) on a second display, if you 
have two displays connected to your computer.

•	 Revert to Single Display Layout: Shows the Timing pane or canvas in the main project 
window if the Timing pane or canvas is displayed on a second monitor.

•	 Output to VR Headset: Shows the 360° project in an attached VR headset. (F10) See 
View 360° video in a VR headset.

•	 Library: Displays the Library. (Command-2)

•	 Inspector: Displays the Inspector. (Command-3)

•	 Layers: Displays the Layers list in the Project pane. (Command-4)

•	 Media: Displays the Media list in the Project pane. (Command-5)

•	 Audio: Displays the Audio list in the Project pane. (Command-6)

•	 Video Timeline: Turns the display of the Timeline on or off. (Command-7)

•	 Keyframe Editor: Turns the display of the Keyframe Editor on or off. (Command-8)

•	 Audio Timeline: Turns the display of the Audio Timeline on or off. (Command-9)

•	 Bring All to Front: Moves the Motion window to the front if the main Motion window is 
behind windows of other applications. 

•	 Enter Full Screen: Hides the menu bar and the Dock. (Control-Command-F)

•	 Open Project/Untitled List: Displays a list of open projects and any images that are open 
in a viewer window. 

Help menu in Motion
The Help menu provides access to resources for learning more about Motion.

•	 Motion 5 Help: Opens the Motion User Guide in macOS Help Viewer.

•	 What’s New in Motion: Opens a window listing the latest updates to Motion (based on 
the version installed on your computer).

•	 Motion Support: Opens a webpage that contains up-to-date technical support 
information about Motion, including links to the user guide, release notes, and 
supported file formats.

•	 Install Rosetta: Displays a dialog to install Rosetta. You may need to install Rosetta when 
you import media in a video format—or when you open a Motion project that contains 
media in a video format—that is not compatible with Apple silicon. This menu item only 
appears on Mac computers with Apple silicon.

Note: After installing Rosetta, you must quit and reopen Motion.

For more information, see the Apple Support article about Rosetta.

•	 Gather App Diagnostics: Collects and saves Motion app diagnostic information in a 
single archive named “VideoAppDiagnostics-motionapp.” You may be asked to submit 
this file when troubleshooting issues with Apple support.

https://support.apple.com/102527
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Keyboard shortcuts

Intro to keyboard shortcuts in Motion
Use keyboard shortcuts to streamline your work in Motion. Some keyboard shortcuts are 
active only under special circumstances. And some of the keyboard shortcuts described in 
this section may conflict with system commands assigned to the macOS Finder.

This section lists all the keyboard shortcuts available in Motion, organized into the 
following categories:

•	 General interface commands

•	 Intro to menu bar keyboard shortcuts

•	 Audio list keyboard shortcuts

•	 Intro to tools keyboard shortcuts

•	 Transport control keyboard shortcuts

•	 View option keyboard shortcuts

•	 Miscellaneous keyboard shortcuts

•	 HUD keyboard shortcuts

•	 Inspector keyboard shortcuts

•	 Keyframe Editor keyboard shortcuts

•	 Layers keyboard shortcuts

•	 Library keyboard shortcuts

•	 Media list keyboard shortcuts

•	 Timeline keyboard shortcuts

•	 Keyframing keyboard shortcuts

•	 Shape and Mask keyboard shortcuts

•	 3D keyboard shortcuts
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Use function keys in Motion
You can change keyboard settings so the F-keys work as Motion keyboard shortcuts.

Enable traditional function keys in Motion
1.	 Choose Apple menu () > System Settings, click Keyboard, then open the Keyboard 

pane (if it’s not already open).

2.	 Select the “Use all F1, F2, etc. keys as standard function keys” checkbox.

Uncheck the box to return to the default setting.

General keyboard shortcuts in Motion

Action Shortcut

Open a project Command-O

Create a project Command-N

Create a project from the Project Browser Option-Command-N

Open the project’s Properties Inspector Command-J

Save a project Command-S

Save a project as a new project Shift-Command-S

Close a project or active window Command-W

Import a file Command-I

Import a file as a project Shift-Command-I

Export movie Command-E

Export a selection as a movie Option-Command-E

Undo the last change Command-Z

Redo the last change Shift-Command-Z

Cut the selection Command-X

Copy the selection Command-C

Paste the selection Command-V

Duplicate selection Command-D

Select all items Command-A

Deselect all items Shift-Command-A

Delete the selection Delete 

Minimize the active window Command-M

Open Motion Settings Command-Comma

Display Page Setup dialog Shift-Command-P
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Action Shortcut

Hide Motion Command-H

Hide other open application files Option-Command-H

Quit Motion Command-Q

Play/pause a project Space bar 

Turn on/off animation recording A

Go to the start of a project Home 

Go to the end of a project End 

Show or hide the toolbar Option-Command-T

Menu commands

Intro to menu bar keyboard shortcuts in Motion

This section lists all the keyboard shortcuts for commands in the Motion menu bar, 
organized into the following categories:

•	 Motion menu keyboard shortcuts

•	 File menu keyboard shortcuts

•	 Edit menu keyboard shortcuts

•	 Mark menu keyboard shortcuts

•	 Object menu keyboard shortcuts

•	 View menu keyboard shortcuts

•	 Share menu keyboard shortcuts

•	 Window menu keyboard shortcuts

•	 Help menu keyboard shortcuts

Motion menu keyboard shortcuts

Action Shortcut

Open Motion Settings Command-Comma (,)

Hide Motion Command-H

Hide other open application files Option-Command-H

Quit Motion Command-Q
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File menu keyboard shortcuts in Motion

Action Shortcut

Create a project from the Project Browser Command-N

Open a project Command-O

Close a project Command-W

Save a project Command-S

Save a project as a new project Shift-Command-S

Import a file Command-I

Import files as a project Shift-Command-I

Close all open projects Option-Command-W

Open the Page Setup window Shift-Command-P

Print the current canvas view Command-P

Edit menu keyboard shortcuts in Motion

Action Shortcut

Undo the last change Command-Z

Redo the last change Shift-Command-Z

Cut Command-X

Copy Command-C

Paste Command-V

Paste special Option-Command-V

Duplicate Command-D

Delete Delete 

Ripple delete (remove the current selection and close 
the gap in the Timeline)

Shift-Delete

Transform control points (on a complex shape) Option-Shift-Command-T

Select all items Command-A

Deselect all items Shift-Command-A

Open the project’s Properties Inspector Command-J

Show spelling and grammar Command-Colon (:)

Find and replace Command-F

Start Dictation Press Fn twice

Emoji and Symbols Control-Command-Space bar
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Mark menu keyboard shortcuts in Motion

Action Shortcut

Mark In point of a selected object or set the play range 
when no object is selected 

I

Mark Out point of a selected object or set the play 
range when no object is selected

O

Move the selected object’s In point to the location of 
the playhead 

Shift-Left Brace ({)

Move the selected object’s Out point to the location of 
the playhead 

Shift-Right Brace (})

Add a project marker at the current frame (with no 
selection) or add object marker (with selection) 

M

Add a project marker at the current frame (with no 
selection) or add object marker (with selection) 

Grave Accent (`)

Open the Edit Marker dialog Option-Command-M

Mark In point of play range Option-Command-I

Mark Out point of play range Option-Command-O

Reset play range Option-X

Play selection Backslash (\)

Turn on Loop Playback Shift-L

Turn animation recording on and off A

Open the Recording Options window Option-A

Go to the start of a project Function-Left Arrow

Go to the end of a project Function-Right Arrow

Go to the start of the play range Shift-Function-Left Arrow

Go to the end of the play range Shift-Function-Right Arrow

Go to the previous frame Left Arrow

Go to the next frame Right Arrow

Go backward ten frames Shift-Left Arrow

Go forward ten frames Shift-Right Arrow

Go to the previous keyframe Option-K

Go to the next keyframe Shift-K

Go to the previous marker Option-Command-Left Arrow

Go to the next marker Option-Command-Right Arrow

Go to the selection In point Shift-I

Go to the selection Out point Shift-O
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Action Shortcut

Perform a RAM preview of the play range area Command-R

Perform a RAM preview of the current selection Option-Command-R

Perform a RAM preview for the whole project Option-Shift-Command-R

Object menu keyboard shortcuts in Motion

Action Shortcut

Add an empty group to the project Shift-Command-N

Add a camera to the project Option-Command-C

Add a light to the project Shift-Command-L

Add a drop zone to the project Shift-Command-D

Add a rig to the project Control-Command-R

Add a 360° environment to the project Shift-Command-E

Move the selected object to the top of the Layers list Shift-Command-Right Bracket (])

Move the selected object to the bottom of the Layers 
list 

Shift-Command-Left Bracket ([)

Move the selected object up the Layers list by one level Command-Right Bracket (])

Move the selected object down the Layers list by one 
level 

Command-Left Bracket ([)

Group the selected objects into a new layer Shift-Command-G

Ungroup a group of objects Option-Command-G

Make an object active or deactivate an object Control-T

For an audio track, enable/disable the Solo button of 
the selected track; for an object, solo the object 

Control-S

Isolate the selected group or layer Control-I

Lock/unlock an object Control-L

Unsolo only the video portion of a file that contains 
video 

Control-Shift-S

Convert a 2D group to 3D, or convert a 3D group to 2D Control-D

Add an image mask to the selected object Shift-Command-M

Add a keyframe (to the last modified parameter for the 
selected object) 

Control-K

Convert the applied behaviors to keyframes Command-K

Convert a simple shape to a complex shape (with 
editable control points) 

Option-Command-B
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Action Shortcut

Make the selected object the cell source for a particle 
emitter 

E

Replicate the selected object L

Clone the selected layer K

Open the Media list and Inspector to display the source 
and properties of media objects 

Shift-F

View menu keyboard shortcuts in Motion

Action Shortcut

Zoom in Command-Equal Sign (=)

Zoom out Command-Minus Sign (–)

Zoom to 100 percent Option-Z

Zoom to fit in window Shift-Z

Zoom Timeline in Option-Command-Equal Sign (=)

Zoom Timeline out Option-Command-Minus Sign (–)

Zoom Timeline to project duration Option-Command-0

Show full view area (the portion of layers that extend 
beyond the edge of the canvas) 

Shift-V

Set 3D view to active camera Control-A

Set 3D view to perspective camera Control-P

Set 3D view to 360° Look Around Control-V

Set 3D view to 360° Overview Control-O

Set 3D view to Mirror VR Headset Control-H

Set 3D view to next camera Control-C

Select the current active camera Control-Option-C

Reset 3D camera view Control-R

Fit the selected objects into view F

Frame the selected object Shift-Command-F

Focus on the selected object Control-F

Show all color channels Shift-C

Show the transparent channel Shift-T

Show the alpha channel overlay Option-Shift-T

Show the RGB channels only Option-Shift-C
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Action Shortcut

Show the red channel Shift-R

Show the green channel Shift-G

Show the blue channel Shift-B

Show the alpha channel Shift-A

Show the inverted alpha channel Option-Shift-A

Switch between the current channel and alpha 
channels 

V

Show the out of gamut exposure overlay in the canvas Option-Shift-O

Show the canvas at full resolution Shift-Q

Enable/disable lighting in the canvas Option-L

Enable/disable shadows in the canvas Control-Option-S

Enable/disable reflections in the canvas Control-Option-R

Enable/disable depth of field in the canvas Control-Option-D

Enable/disable motion blur in the canvas Option-M

Enable/disable field rendering in the canvas Option-F

Enable/disable frame blending in the canvas Control-Option-B

Show overlays Command-Slash (/)

Show the rulers Shift-Command-R

Show/hide the grid Command-Apostrophe (’)

Show/hide the guides Command-Semicolon (;)

Show/hide the dynamic guides Shift-Command-Semicolon (;)

Show/hide the safe zones Apostrophe (’)

Show/hide the film zones Shift-Quotation Mark (”)

Lock the guides Option-Command-Semicolon (;)

Enable/disable snapping to guides N

Show 3D overlays Option-Command-Slash (/)

Show 3D grid Shift-Command-Apostrophe (’)

Show the Font dialog Command-T

Show the macOS Colors window Shift-Command-C
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Share menu keyboard shortcuts in Motion

Action Shortcut

Export movie Command-E

Window menu keyboard shortcuts in Motion

Note: You can change keyboard settings so the F keys work as Motion keyboard shortcuts. 
See Use function keys.

Action Shortcut

Minimize the active window Command-M

Set the Motion window to Classic layout Control-U

Set Motion window to Cinema layout Control-Option-U

Show the Properties Inspector F1

Show the Behaviors Inspector F2

Show the Filters Inspector F3

Show the Object Inspector F4

Show/hide the Project pane F5

Show/hide the Timing pane F6

Show/hide the HUD F7

Show/hide the Background Task list F9

Enter/exit Player mode F8

Output to VR headset F10

Show/hide the Library Command-2

Show/hide the Inspector Command-3

Show/hide the Layers list or Project pane Command-4

Show/hide the Media list Command-5

Show/hide the Audio list Command-6

Show/hide the Video Timeline Command-7

Show/hide the Keyframe Editor Command-8

Show/hide the Audio Timeline Command-9

Enter/exit full screen Control-Command-F
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Help menu keyboard shortcuts in Motion

Action Shortcut

Open Motion Help Shift-Command-Question Mark (?)

Audio list keyboard shortcuts in Motion

Action Shortcut

Show/hide the Audio list Command-6

Make object active or inactive Control-T

Lock/unlock an audio file Control-L

Enable/disable the Solo button of a selected track Control-S

Move selection up one level in the Audio list Up Arrow

Move selection down one level in the Audio list Down Arrow

Import Command-I

Tools

Intro to tools keyboard shortcuts in Motion

This section lists all the keyboard shortcuts for tools in the canvas toolbar, organized into 
the following categories:

•	 Transform tool keyboard shortcuts

•	 Select/Transform tool keyboard shortcuts

•	 Crop tool keyboard shortcuts

•	 Edit Points tool keyboard shortcuts

•	 Edit shape tool keyboard shortcuts

•	 Pan and Zoom tool keyboard shortcuts

•	 Shape tool keyboard shortcuts

•	 Bezier Mask tool keyboard shortcuts

•	 B-Spline Mask tool keyboard shortcuts
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Transform tool keyboard shortcuts in Motion

Action Shortcut

Activate the current transform tool (when another item 
in the transform tools pop-up menu is selected) 

S

Choose the Select/Transform tool Shift-S

Cycle through the transform modes (press repeatedly 
until the transform mode you want is selected)

Tab

Constrain the movement of an object to the X axis or 
Y axis 

Shift-drag the object 

Override snapping while moving an object Command-drag the object 

Duplicate a selected object Option-drag the object 

Nudge a selected object by a single pixel Command-Up Arrow, Down Arrow, Left Arrow, or Right 
Arrow 

Nudge a selected object 10 pixels Shift-Command-Up Arrow, Down Arrow, Left Arrow, or 
Right Arrow

Select/Transform tool keyboard shortcuts in Motion

Action Shortcut

Scale an object proportionally Shift-drag the object handle 

Scale an object from its anchor point Option-drag the object handle 

Scale an object proportionally from its anchor point Option-Shift-drag the object handle 

Snap the rotation of an object to 45-degree increments Shift-drag the object rotation handle 

Select the 3D transform tool Q

Crop tool keyboard shortcuts in Motion

Action Shortcut

Crop an object proportionally Shift-drag the object handle 

Crop an object from its center Option-drag the object handle 

Crop an object proportionally from its center Option-Shift-drag the object handle 

Pan a cropped object within the bounding box Command-drag over the object 

Move the bounding box around a cropped object Drag over the object 

Move the bounding with the cropped object Option-Command-drag over the object 
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Edit Points tool keyboard shortcuts in Motion

Action Shortcut

Add a point to a path Double-click the path or Option-click the path

Convert a point to linear Command-click the point 

Convert a linear point to Bezier Command-drag the point 

Scale a tangent proportionally Command-drag the tangent handle 

Break or relink a tangent handle Option-drag the tangent handle 

Constrain a tangent handle to 45-degree increments Shift-drag the tangent handle 

Adjust a B-Spline point bias Command-drag the B-Spline point 

Switch a B-Spline point bias Command-click the B-Spline point 

Edit shape tool keyboard shortcuts in Motion

Action Shortcut

Convert a simple ellipse, rectangle, or mask to a 
complex shape or mask (with editable control points)

Option-Command-B

Pan and Zoom tool keyboard shortcuts in Motion

Action Shortcut

Select the Pan tool H

Select the Zoom tool Z

Zoom out with the Zoom tool selected Option-click in the canvas 

Shape tool keyboard shortcuts in Motion

Action Shortcut

Select the Rectangle Shape tool R

Select the Circle Shape tool C

Draw a shape proportionally Shift-drag in the canvas 

Draw a shape from its center Option-drag in the canvas 

Draw a shape proportionally from its center Option-Shift-drag in the canvas 

Snap the rotation of an object to 45-degree increments Shift-drag a rotation handle
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Bezier tool keyboard shortcuts in Motion

Action Shortcut

Select the Bezier tool B

Switch between the Bezier and B-spline tools B

Close shape C

Add a point to the path Command-click a path 

Add a point to the path Double-click a path 

Convert a point to linear Command-click a point 

Create tangents on a point Command-drag a point 

Scale a tangent handle proportionally Command-drag a tangent handle 

Break or relink a tangent handle Option-drag a tangent handle 

Constrain a tangent handle to 45-degree increments Shift-drag a tangent handle 

Cancel shape drawing and delete the open shape Escape

Exit shape-drawing mode Return

B-Spline tool keyboard shortcuts in Motion

Action Shortcut

Select the B-Spline tool B

Switch between the Bezier and B-Spline tools B

Close the shape C

Add a point to the path Double-click a path 

Add a point to the path Command-click a path 

Adjust a B-Spline point bias Command-drag a B-Spline point 

Switch a B-Spline point bias Command-click a B-Spline point 

Cancel shape drawing and delete the open shape Escape

Exit shape-drawing mode Return

Paint Stroke tool keyboard shortcuts in Motion

Shortcut Action

Select the Paint Stroke tool P

Adjust stroke width With the Adjust Item tool selected, Command-drag in 
the canvas on a control point (+) 
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Text tool keyboard shortcuts in Motion

Action Shortcut

Select the Text tool T

Move the insertion point to the next character Up Arrow, Down Arrow, Left Arrow, or Right Arrow

Move the insertion point to the next word Option-Right Arrow

Move the insertion point to the previous word Option-Left Arrow

Move to the beginning of a line of text Command-Left Arrow

Move to the end of a line of text Command-Right Arrow

Move to the beginning of a paragraph Option-Up Arrow

Move to the end of a paragraph Option-Down Arrow

Move to the beginning of a text object Command-Up Arrow

Move to the end of a text object Command-Down Arrow

Select characters from the insertion point Shift-Right Arrow, or Left Arrow

Select words from the insertion point Option-Shift-Left Arrow, or Right Arrow

Select text from the insertion point to the beginning of 
a line

Shift-Command-Left Arrow

Select text from the insertion point to the end of a line Shift-Command-Right Arrow

When Layout Method is set to Paragraph (in the Text 
Inspector’s Layout Controls), select the rest of a 
paragraph from the insertion point 

Option-Shift-Up Arrow, or Down Arrow

Select the rest of a text object from the insertion point Shift-Command-Up Arrow, or Down Arrow

Increase kerning from the insertion point Option-Command-Right Bracket (])

Decrease kerning from the insertion point Option-Command-Left Bracket ([)

Select All Command-A

Select paragraph (when Layout Method is set to 
Paragraph in the Text Inspector) 

Triple-click

Deselect All Shift-Command-A

Exit the Text tool Escape
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Shape mask tool keyboard shortcuts in Motion

Action Shortcut

Select the Rectangle Mask tool Option-R

Select the Circle Mask tool Option-C

Select the Freehand Mask tool Option-P

Draw a mask proportionally Shift-drag in the canvas 

Draw a mask from its center Option-drag in the canvas 

Draw a mask proportionally from its center Option-Shift-drag in the canvas 

Snap the rotation of a mask to 45-degree increments Shift-drag a rotation handle 

Bezier Mask tool keyboard shortcuts in Motion

Action Shortcut

Select the Bezier Mask tool Option-B

Switch between the Bezier Mask and B-Spline Mask 
tools 

Option-B

Close the mask shape C

Add a point to the path Double-click a path 

Add a point to the path Command-click a path 

Convert a point to linear Command-click a point 

Create tangents on a point Command-drag a point 

Scale tangents proportionally Command-drag a tangent handle 

Break or relink a tangent handle Option-drag a tangent handle 

Constrain a tangent handle to 45-degree increments Option-Shift-drag a tangent handle 

Cancel shape drawing and delete the open mask Escape

Exit mask-drawing mode Return
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B-Spline Mask tool keyboard shortcuts in Motion

Action Shortcut

Select the B-Spline Mask tool Option-B

Switch between the Bezier Mask and B-Spline Mask 
tools

Option-B

Close the mask shape C

Add a point to the path Double-click a path 

Add a point to the path Command-click a path 

Adjust a B-Spline point bias Command-drag a B-Spline point 

Switch a B-Spline point bias Command-click a B-Spline point 

Cancel mask drawing and delete the open shape Escape

Exit mask-drawing mode Return

Select the Bezier Mask tool Option-B

Transport control keyboard shortcuts in Motion

Action Shortcut

Play/pause a project Space bar 

Turn animation recording on or off A

Enable/disable loop playback Shift-L

Go to the start of a project Home

Go to the end of a project End

Go to the start of the play range Shift-Home

Go to the end of the play range Shift-End

Go to the previous frame Left Arrow

Go to the next frame Right Arrow

Go backward ten frames Shift-Left Arrow

Go forward ten frames Shift-Right Arrow
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View option keyboard shortcuts in Motion

Action Shortcut

Zoom in Command-Equal Sign (=)

Zoom out Command-Minus Sign (–)

Zoom out with the Zoom tool selected Option-click the canvas 

Zoom to region Command-drag in the canvas with the Zoom tool

Zoom to 100 percent Option-Z

Zoom to fit in the canvas Shift-Z

Show all color channels Shift-C

Show the transparent channel Shift-T

Show the alpha channel overlay Option-Shift-T

Show the RGB channels only Option-Shift-C

Show the red channel Shift-R

Show the green channel Shift-G

Show the blue channel Shift-B

Show the alpha channel Shift-A

Show the inverted alpha channel Option-Shift-A

Switch between the current channel and alpha channel V

Show the canvas at full resolution Shift-Q

Enable/disable field rendering in the canvas Option-F

Enable/disable motion blur in the canvas Option-M

Show the rulers Shift-Command-R

Lock the guides Option-Command-Semicolon (;)

Show/hide the grid Command-Apostrophe (’)

Show/hide the guides Command-Semicolon (;)

Show/hide dynamic guides Shift-Command-Semicolon (;)

Show/hide film zones Shift-Quotation Mark (”)

Show overlays Command-Slash (/)

Show/hide safe zones Apostrophe (’)

Enable/disable snapping to guides N

Expose active layers X

Expose all layers Shift-X
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HUD keyboard shortcuts in Motion

Action Shortcut

Show/hide the HUD F7

Cycle through the HUDs from top to bottom (when 
more than one effect is applied to an object) 

D

Cycle through the HUDs from bottom to top (when 
more than one effect is applied to an object) 

Shift-D

Inspector keyboard shortcuts in Motion

Action Shortcut

Show/hide the Inspector Command-3

Increase a slider value by an increment of one Up Arrow

Decrease a slider value by an increment of one Down Arrow

Increase a slider value by an increment of ten Shift-Up Arrow

Decrease a slider value by an increment of ten Shift-Down Arrow

Keyframe Editor keyboard shortcuts in Motion

Action Shortcut

Show/hide the Keyframe Editor Command-8

Convert the applied behaviors to keyframes Command-K

Fit visible curves F

Layers keyboard shortcuts in Motion

Action Shortcut

Create a group Shift-Command-N

Bring an object up one level in the Layers list Command-Right Bracket (])

Send an object down one level in the Layers list Command-Left Bracket ([)

Place the selected objects in a new group Shift-Command-G

Ungroup a group of objects so you can manipulate 
each object 

Option-Command-G

Make the object active or deactivate the object Control-T

Enable/disable the Solo button of a selected track Control-S
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Action Shortcut

Isolate the selected group or layer Control-I

Lock/unlock an object Control-L

Move up one level in the Layers list Up Arrow

Move down one level in the Layers list Down Arrow

Expand a group in the Layers list Option-Left Arrow

Collapse a group in the Layers list Option-Right Arrow

Import Command-I

Add an image mask to the selected object Shift-Command-M

Convert the applied behaviors to keyframes Command-K

Open the Media list and Inspector to reveal the source 
and properties of media objects 

Shift-F

Clone the selected layer K

Library keyboard shortcuts in Motion

Action Shortcut

Show/hide the Library Command-2

Select the first item in the sidebar or file stack Space bar 

Move up one item in the sidebar or file stack Up Arrow

Move down one item in the sidebar or file stack Down Arrow

Move left one item in the file stack Left Arrow

Move right one item in the file stack Right Arrow

Move up one level in the folder hierarchy of the file 
stack 

Up Arrow

Media list keyboard shortcuts in Motion

Action Shortcut

Show/hide the Media list Command-5

Move up one level in the Media list Up Arrow

Move down one level in the Media list Down Arrow

Import Command-I
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Timeline keyboard shortcuts in Motion

Action Shortcut

Nudge one frame forward Command-Right Arrow

Nudge one frame backward Command-Left Arrow

Nudge ten frames forward Shift-Command-Right Arrow

Nudge ten frames backward Shift-Command-Left Arrow

Move the selected object to the In point Shift-Left Brace ({)

Move the selected object to the Out point Shift-Right Brace (})

Mark the In point of the play range or selected object I

Mark the Out point of the play range or selected object O

Reset the play range by moving the In and Out points 
to the first and last frames of the project 

Option-X

Bring an object up one level in the Timeline layers list Command-Right Bracket (])

Send an object down one level in the Timeline layers 
list 

Command-Left Bracket ([)

Enable/disable loop playback Shift-L

Open the Recording Options dialog Option-A

Go to the start of the play range Shift-Home

Go to the end of the play range Shift-End

Go to the In point of the selected object Shift-I

Go to the Out point of the selected object Shift-O

Go to the previous frame Left Arrow

Go to the next frame Right Arrow

Go backward ten frames Shift-Left Arrow

Go forward ten frames Shift-Right Arrow

Go to the next marker Option-Command-Left Arrow

Go to the previous marker Option-Command-Right Arrow

Render a RAM preview for the play range Command-R

Render a RAM preview for the selected object Option-Command-R

Render a RAM preview for the project Option-Shift-Command-R

Add a marker at the current frame M

Add a marker at the current frame Apostrophe (`)

Open the Edit Marker dialog Option-Command-M

Play/pause the project Space bar 
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Action Shortcut

Turn on/off animation recording A

Go to the start of project Home

Go to the end of project End

Convert the applied behaviors to keyframes Command-K

Ripple delete (remove the current selection and close 
the gap in the Timeline)

Shift-Delete

Paste special Option-Shift-V

Zoom Timeline in Option-Command-Equal Sign (=)

Zoom Timeline out Option-Command-Minus Sign (–)

Fit Timeline in window Shift-Z

Zoom Timeline to project duration Option-Command-0

Keyframing keyboard shortcuts in Motion

Action Shortcut

Add a point to the path Double-click a path or Option-click a path

Create tangents on a point Command-drag a Bezier point 

Convert a point to linear Command-click a Bezier point 

Adjust a B-Spline point bias Command-drag a B-Spline point 

Switch a B-Spline point bias Command-click a B-Spline point 

Scale tangents proportionally Command-drag a tangent handle 

Break or relink a tangent handle Option-drag a tangent handle 

Constrain a tangent to 45 degrees and original value Shift-drag a tangent handle 
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Shape and Mask keyboard shortcuts in Motion
Action Shortcut

Draw a shape proportionally with the Rectangle, Circle 
Shape, and Mask tools 

Shift-drag in the canvas 

Draw a shape from its center with the Rectangle, Circle 
Shape, and Mask tools 

Option-drag in the canvas 

Draw a shape proportionally from its center with the 
Rectangle, Circle Shape, and Mask tools 

Option-Shift-drag in the canvas 

Cancel spline drawing and delete the open spline Escape

Exit spline drawing mode and complete the existing 
spline drawing 

Return

Add a point to the path Double-click a path 

Add a point to the path Option-click a path 

Convert a point to linear Command-click a Bezier point 

Create tangents on a point Command-drag a Bezier point 

Scale tangents proportionally Command-drag a tangent handle 

Adjust a B-Spline point bias Command-drag a B-Spline point 

Switch a B-Spline point bias Command-click a B-Spline point 

Break or relink a tangent handle Option-drag a tangent handle 

Constrain a tangent to 45 degrees and original value Shift-drag a tangent handle 

Convert a simple shape to a complex shape (with 
editable control points)

Option-Command-B

3D keyboard shortcuts in Motion
Action Shortcut

Select the 3D transform tool Q

Switch the 3D transform tool between position-only 
and universal 

Comma (,)

Switch the 3D transform tool between rotate-only and 
universal 

Period (.)

Switch the 3D transform tool between scale-only and 
universal 

Slash (/)

Set 3D View to Active Camera Control-A

Set 3D View to Perspective Control-P

Set 3D View to next camera Control-C

Reset the 3D camera view Control-R

Switches a group between 2D and 3D Control-D

Shift-Command-Apostrophe (’) Switch the 3D grid on and off 
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Miscellaneous keyboard shortcuts in Motion

Action Shortcut

Create a particle emitter E

Add an image mask to the selected layer Shift-Command-M

In the Green Screen Keyer filter, zoom incrementally 
into the Chroma control 

Z and click the color wheel

In the Green Screen Keyer filter, zoom incrementally 
out of the Chroma control 

Option-Z and click the color wheel

In the Green Screen Keyer filter, zoom smoothly into 
the Chroma control 

Z and drag right in the color wheel

In the Green Screen Keyer filter, zoom smoothly out of 
the Chroma control 

Z and drag left in the color wheel

In the Green Screen Keyer filter, zoom smoothly in or 
out of the Chroma control 

Space bar-Command (in that order) and drag right or 
left in the color wheel

In the Green Screen Keyer filter, pan the Chroma 
control 

H and drag the color wheel

In the Green Screen Keyer filter, reset the chroma 
zoom and center (when the pointer is over the Chroma 
control) 

Shift-Z

Select the next object above Up Arrow

Select the next object below Down Arrow

Nudge the selected objects one pixel Command-Up Arrow, Down Arrow, Left Arrow, or Right 
Arrow 

Nudge the selected objects 10 pixels Shift-Command-Up Arrow, Down Arrow, Left Arrow, or 
Right Arrow

Add/Remove selected objects using the region box Shift-drag in the canvas 

Select multiple objects in a group or layer Command-click an object or objects 

Add to selection Shift-click an object 
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Search and customize keyboard shortcuts

Intro to the Command Editor in Motion

The Command Editor shows a visual representation of your keyboard, allowing you to:

•	 Search for keyboard shortcuts and commands

•	 Customize keyboard shortcuts to streamline the way you work

•	 Import or export keyboard shortcuts to use a command set from another application or 
to share a custom command set with other users 

If you’re more familiar with keyboard commands from other applications, you can use the 
Command Editor to substitute those commands for Motion’s default set.

Display the Command Editor in Motion
•	 In Motion, choose Motion > Command Sets > Customize.

The Command Editor appears.

For a description of the Command Editor controls and options, see Command Editor 
interface.
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Command Editor interface in Motion

The upper half of the Command Editor displays a virtual keyboard. The lower half contains 
a list that sorts menu commands by group and offers a brief description of each command, 
along with its associated key combination, if any.

The virtual keyboard is color-coded to help you identify the type of command each key 
performs. For example, transport commands, such as Play (press the Space bar) and 
Record (press A), are light blue. The Command Groups column on the left side of the 
Command List are color coded and clickable for reference.

The Command List displays several groupings of commands, organized by Motion menus 
as well as types of commands (Alignment, Go To, Mark, Tools, Transport, and View). Click a 
group to filter the Command list and display only the commands and keyboard shortcuts in 
that group.

The pane on the right shows additional information about a selected key in the virtual 
keyboard (or a selected command in the Command List). When you select a key in the 
virtual keyboard, this pane displays a list of all keyboard shortcuts associated with that key.
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When you select a command in the Command List, this pane displays a brief description of 
the command.

Search for keyboard shortcuts in Motion

Although the Command Editor is used primarily for creating new shortcuts (as described in 
Create custom keyboard shortcuts), it can also be used to identify existing shortcuts.

Choose a key command set
By default, Motion uses the Standard Set of commands, with the language choice that you 
specified when you set up your computer.

In Motion, do one of the following:

•	 Choose Motion > Command Sets, then choose a command set from the submenu.

•	 If the Command Editor is open, click the pop-up menu in the top-left corner of the 
window, then choose a command set.

After you choose the command set you want, the keyboard shortcuts in the set become 
active in Motion.

Search for a keyboard shortcut
Use the Search field in the top-right corner of the Command Editor to locate a command or 
keyboard shortcut. You can search by command name, description, or keyboard shortcut.

•	 In the Command Editor in Motion, click in the Search field and enter a word that 
describes the keyboard shortcut you need.

The Command List immediately displays the search results, listing all commands and 
keyboard shortcuts related to the search term. You can narrow your search by choosing 
a category from the Search field pop-up menu (click the down arrow next to the 
magnifying glass icon). The menu items include All, Command, Description, and Key 
Equivalent.

Note: Do not use the Shift key to capitalize letters when typing in the Search field. The 
Search field recognizes the Shift key as a modifier key in a keyboard shortcut.
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Search for and highlight a shortcut on the virtual keyboard
You can use the Search field with the virtual keyboard to highlight keyboard shortcuts.

1.	 In the Command Editor in Motion, click the Keyboard Highlight button to the left of the 
Search field.

The keyboard dims.

2.	 Click in the Search field and begin typing.

Motion filters the Command List as you type and highlights the keys related to your 
search term.

For example, in the image below, the search term “mark” returns keyboard shortcuts 
marker commands, and the command keys are highlighted in the virtual keyboard.

Note: When you enable the Keyboard Highlight button, only command keys are highlighted. 
Modifier keys that may be part of the keyboard shortcut (Command, Shift, Option, and 
Control) are not highlighted.

Filter by modifier keys
You can use the Modifier buttons (Command, Shift, Option, and Control) at the top of the 
Command Editor to see which keys work with the modifier keys.

1.	 In Motion, click one of the four modifier buttons at the top of the Command Editor (or 
click a modifier key on the virtual keyboard).

2.	 If necessary, click another modifier button (or a modifier key in the virtual keyboard) to 
create a combination.

The virtual keyboard updates to show which keys are assigned to shortcuts that use 
those combined modifier keys.
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Create custom keyboard shortcuts in Motion

Customizing shortcuts in the Command Editor is easy. Because the default Standard Set 
includes commands for which no shortcut is defined, you may want to apply a new shortcut 
to them. Because you cannot modify the Standard Set, you must duplicate that set and 
then customize the new duplicate set.

Duplicate the active command set
1.	 In the top-left corner of the Command Editor in Motion, click the pop-up menu and 

choose Duplicate.

2.	 Enter a name in the dialog, then click OK.

The new duplicate set is saved and appears as an item at the bottom of the pop-up 
menu, as well as in the Motion > Command Sets menu (in the menu bar).

Add or modify a keyboard shortcut
After you duplicate a set of assigned keyboard shortcuts, you can modify the key settings 
to create new or modified shortcuts.

1.	 Using the Search field of the Command Editor in Motion, find and select the command 
you want to assign a keyboard shortcut to.

Alternatively, you can find the command by browsing through the Command List.

2.	 Using your physical keyboard, press the combination of keys you want to use for the 
command (for example, Option-Shift-T).

If the key combination is not assigned to a command, the virtual keyboard updates to 
show the new key assignment. A gray dot appears on a newly assigned key (or keys), 
and a color is applied if the command belongs to a color-coded command group.

Note: The keys on the Command Editor keyboard that are shaded with diagonal lines are 
reserved for macOS system use and can’t be assigned.

If the key combination is already assigned to a command, Motion displays the current 
setting, and asks you to confirm the change.

Save a command set
•	 Click the Save button in the lower-right corner of the Command Editor in Motion.

If you close the Command Editor with unsaved changes, Motion asks you to save the 
set.

Delete a command set
1.	 Make sure the set you want to delete is selected as the active set, then click the pop-up 

menu in the top-right corner of the Command Editor in Motion and choose Delete.

2.	 In the dialog that appears, click Delete.

The set is removed, and the Standard Set becomes the active set of commands.
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Import and export keyboard shortcuts in Motion

After you save a command set, you can export it to create a backup or to share the set with 
another user. Exported sets are saved in a file that can be imported back into Motion later.

Export a set of keyboard shortcuts
1.	 If necessary, use the pop-up menu in the top-left corner of the Command Editor in 

Motion to activate the command set you want to export, then do one of the following:

•	 In the Command Editor, click the pop-up menu, then choose Export.

•	 Choose Motion > Command Sets > Export.

2.	 In the dialog the appears, navigate to the location where you want to save the exported 
set, then enter a name in the Save As field.

3.	 Click OK.

The file is saved in the location you chose, with the .commandset filename extension.

Import a set of shortcuts
1.	 In Motion, do one of the following:

•	 In the Command Editor, click the pop-up menu in the upper-left corner, then choose 
Import.

•	 Choose Motion > Command Sets > Import.

2.	 In the dialog that appears, navigate to the location where you stored a command set 
file, select it, then click Open.

The new command set is added to the Motion > Command Sets submenu in the menu 
bar and in the pop-up menu in the Command Editor. If you use a set with the same 
name, a dialog appears asking you to rename the set.
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Touch Bar

Touch Bar shortcuts in Motion
If your MacBook Pro has a Touch Bar, you can use familiar gestures like swipe and tap to 
quickly perform common tasks in Motion. Most of the Touch Bar controls are dynamic: 
Buttons change depending on your current selection within Motion and other applications. 
Related buttons and sliders appear together in groups in the Touch Bar.

Note: Depending on your MacBook Pro model, controls in the Touch Bar may vary.

For more information about the Control Strip and Esc button, see MacBook Pro Essentials. 
To learn more about the Touch Bar, see Use the Touch Bar on Mac in the macOS User 
Guide.

Project Browser

When you open the Project Browser in Motion, the following controls appear in the 
Touch Bar:

Icon Tool/Item Description

Open Other Opens a dialog to select an existing 
project that doesn’t appear in the 
Project Browser.

Import As Project Opens a dialog to select media files 
to include in a new project. 

Cancel Closes the Project Browser and 
any open dialogs while leaving the 
Motion application open.

Open Opens the project selected in the 
Project Browser.

https://support.apple.com/guide/macbook-pro/welcome/mac
https://support.apple.com/guide/mac-help/touch-bar-mchlbfd5b039/mac
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Motion project

When a Motion project is open and no object is selected, the following controls appear in 
the Touch Bar: 

Icon Tool/Item Description

Tools Opens tools for selecting and 
manipulating objects. See Tools, 
below.

New Project Opens the Project Browser (if 
Create New Project is selected 
in the General pane of Motion 
Settings).

Import Opens a dialog for selecting media 
files to import into your project.

View When you select a media clip in the 
import dialog, this button (in the 
Control Strip portion of the Touch 
Bar) activates controls to play or 
scrub the clip before you import it.

Add Camera Adds a camera to your project.

Add Light Adds a light to your project.

Project Navigation Opens project navigation controls. 
See Project navigation, below. 

Motion project with object selected

When you select an object in your project, the following controls appear in the Touch Bar.

Icon Tool/Item Description

Tools Opens tools for selecting and 
manipulating objects. See Tools, 
below.

Timing Opens timing controls to change or 
mark In and Out points, and to play 
a selection. See Timing, below.

Project Navigation Opens project navigation controls. 
See Project navigation, below. 
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Project navigation

When you tap the Project Navigation button , project navigation tools appear in the 
Touch Bar.

Icon Tool/Item Description

Close Returns you to the previous Touch 
Bar screen. 

Project Navigation bar Displays your project in a timeline 
bar with a playhead. Drag the 
playhead to navigate through your 
project. Drag the left end of the bar 
to mark a new play range In point; 
drag the right end of the bar to 
mark a new play range Out point. 

Snap Activates snapping in the Project 
Navigation bar. When snapping 
is on, drag the playhead in the 
bar to snap to a selected object’s 
beginning or end, or to a project 
marker. (The playhead doesn’t 
snap to object markers.) When you 
drag either end of the bar, the play 
range snaps to the location of the 
playhead.

Timing

When you tap the Timing button, the following controls appear in the Touch Bar:

Icon Tool/Item Description

Close Returns you to the previous Touch 
Bar screen. 

Go to In Point Positions the playhead at the 
beginning (In point) of the selected 
object.

Go to Out Point Positions the playhead at the end 
(Out point) of the selected object.

Mark In Sets a new In point for the selected 
object.

Mark Out Sets a new Out point for the 
selected object.

Play Selection Plays all layers as a composite 
based on the duration of the 
selected layer.
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Group

When multiple objects are selected, the following controls appear in the Touch Bar:

Icon Tool/Item Description

Tools Opens tools for selecting and 
manipulating objects. See Tools, 
below.

Group Nests selected objects in a group.

Project Navigation Opens project navigation controls. 
See Project navigation. 

Tools

When you tap the Tools button , tools for creating objects, transforming objects, and 
navigating the canvas appear in the Touch Bar.

Not all tools are available for all objects. For example, the Edit Points tool is only available 
when a Bezier shape or a B-Spline shape is selected.

Note: To see all of the available tools, you may need to swipe in the Touch Bar. 

Icon Tool/Item Description

Close Returns you to the previous Touch 
Bar screen. 

Select/Transform Activates the Select/Transform 
tool, allowing you to scale, move, or 
rotate objects.

3D Transform Activates the 3D Transform tool, 
allowing you to manipulate any 2D 
or 3D object in 3D space.

Anchor Point Activates the Anchor Point tool, 
allowing you to reposition a layer’s 
anchor point.

Drop Shadow Activates the Drop Shadow tool, 
allowing you to modify the direction 
or offset of a layer’s drop shadow.

Distort tool Activates the Distort tool, allowing 
you to shear or distort a layer.

Crop tool Activates the Crop tool, allowing 
you to crop a layer.
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Icon Tool/Item Description

Edit Points Activates the Edit Points tool, 
allowing you to adjust points and 
Bezier handles for complex masks, 
shapes, and motion paths. This 
button is displayed only when 
a Bezier or B-Spline shape is 
selected.

Edit Shape (Rectangle or Circle) Activates the Edit Shape tool, 
allowing you to modify the size, 
shape, feathering, position, or 
rotation of simple shapes. This 
button is displayed only when a 
simple shape is selected.

Transform Glyph Activates the Transform Glyph tool, 
allowing you to modify selected text 
characters (glyphs). The Transform 
Glyph button appears only when 
text is selected.

Adjust Item Activates the Adjust Item tool, 
allowing you to modify specific 
parameters such as the shape of 
a replicator or the start and end 
points of a gradient.

Rectangle Activates the Rectangle tool, 
allowing you to draw a rectangle 
shape.

Circle Activates the Circle tool, allowing 
you to draw a circle or ellipse shape.

Line Activates the Line tool, allowing you 
to draw a line shape.

Bezier Activates the Bezier tool, allowing 
you to draw a Bezier shape created 
with Bezier points and tangent 
handles.

B-Spline Activates the B-Spline tool, allowing 
you to draw a B-Spline shape 
created with B-Spline points.

Paint Stroke Activates the Paint Stroke tool, 
allowing you to paint shapes in the 
canvas.

Text Activates the Text tool, allowing you 
to add text in the canvas.

3D Text Activates the 3D text tool, allowing 
you to create textured, dimensional 
text.

Rectangle Mask Activates the Rectangle Mask tool, 
allowing you to add a rectangle-
shaped mask to a layer.



1382Motion User Guide

Icon Tool/Item Description

Circle Mask Activates the Circle Mask tool, 
allowing you to add a circle-shaped 
or ellipse-shaped mask to a layer.

Freehand Mask Activates the Freehand Mask tool, 
allowing you to add a hand-drawn 
mask to a layer.

Bezier Mask Activates the Bezier Mask tool, 
allowing you to add a mask created 
with Bezier points and tangent 
handles to a layer.

B-Spline Mask Activates the B-Spline Mask tool, 
allowing you to add a mask created 
with B-Spline points to a layer.

Pan Activates the Pan tool, allowing you 
to pan the canvas.

Zoom Activates the Zoom tool, allowing 
you to zoom in on the canvas.

Walk 3D View Activates the Walk 3D View tool, 
allowing you to position a camera 
in 3D space as you would in a 
computer game, using a keyboard-
and-mouse navigation method.

Text editing

When the text insertion point is active in the canvas, the following text-editing controls 
appear in the Touch Bar:

Icon Tool/Item Description

Done Returns you to the previous Touch 
Bar screen.

Note: The Done button does not 
appear in the Touch Bar on certain 
MacBook Pro models.

Tools When the Text tool is active, this 
control displays the tool buttons 
described in Tools, above.

Text Alignment and Appearance Activates controls for text 
alignment, style, and appearance. 
See Text alignment and appearance, 
below.

Text Size Activates a slider for text size. See 
Text size, below.

Text Kerning Activates a slider for text kerning. 
See Text kerning, below.
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Icon Tool/Item Description

3D Text Switches the selected text from 2D 
to 3D (and vice versa).

Text Color Activates color picker, hue, 
brightness, and saturation controls. 
See Text color, below.

Note: To affect text color, the Fill 
With parameter must be set to Color 
(in the Appearance pane of the Text 
Inspector).

Project Navigation Opens project navigation controls. 
See Project navigation. 

Text alignment and appearance

When you tap the Text Alignment and Appearance button , the following controls appear 
in the Touch Bar:

Icon Tool/Item Description

Close Returns you to the previous Touch 
Bar screen. 

Align Text Aligns text to the left, center, or 
right.

Bold Text Makes the selected text object bold 
(if available for the selected font).

Italic Text Makes the selected text object italic 
(if available for the selected font).

Text Face Turns the text Face parameter on 
or off.

Text Outline Turns the text Outline parameter on 
or off.

Text Glow Turns the text Glow parameter on 
or off.

Text Drop Shadow Turns the text Drop Shadow 
parameter on or off.
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Text size

When you tap the Text Size button , the following controls appear in the Touch Bar:

Icon Tool/Item Description

Close Returns you to the previous Touch 
Bar screen. 

Text Size slider Drag the slider to change the size 
of the text.

Text kerning

When you tap the Text Kerning button , the following controls appear in the 
Touch Bar:

Icon Tool/Item Description

Close Returns you to the previous Touch 
Bar screen. 

Text Kerning Slider Drag the slider to increase or 
decrease the space between the 
text characters. (The text insertion 
point must be positioned between 
text characters in the canvas to 
access the kerning control.)
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Text color

When you tap the Text Color button , the following controls appear in the Touch Bar:

Icon Tool/Item Description

Close Returns you to the previous Touch 
Bar screen. 

Active Color Displays the active color, based on 
your current color settings.

Brightness Available when the Hue color control 
is active, turns on a slider to adjust 
brightness of the selected text 
object.

Saturation Available when the Hue color 
control is active, turns on a slider 
to adjust saturation of the selected 
text object.

Hue/Swatch Color Switches between the Hue color 
control and Swatch color control. 
Drag or tap the controls to change 
text color.

To change the color of an individual 
text character, select the character 
in the canvas (or position the text 
insertion point to the right of the 
character), then tap or drag the 
color control. To change the color of 
multiple (adjacent) text characters, 
select the characters in the canvas, 
then tap or drag the control.
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Move Motion assets to another computer
You can move Motion project files, custom objects, or project presets to another computer 
that has Motion installed. 

Copy a Motion project file to another computer
To move a Motion project file to another computer, you must also move all media that the 
project uses, including all QuickTime, still image, and audio files. In addition, any third-
party Motion plug-ins or nonstandard fonts used in the project must be installed on the 
new computer, or they’ll be unavailable to your project.

Similarly, when you finish a project and want to archive it, it’s a good idea to archive the 
project file and all media, graphics, fonts, custom behaviors, filters, and third-party add-
ons used in the project. If you need to restore the project for later revisions, you’ll have 
everything you need to get started quickly.

1.	 In Motion, save the project file using the Collect Media option as described in Save a 
project and collect all project media into a folder.

2.	 Copy the folder containing the saved project file and all media used in the project to 
another computer.

Note: If you move a project to another computer without selecting the Collect Media 
option, media can go offline (even if you’ve manually moved the media files). For more 
information on how to relink media files to your project, see Reconnect offline media files.

Copy a custom object to another computer
Each customized object you drag to the Motion Library is saved as a separate file in the /
Users/username/Library/Application Support/Motion/Library/ folder on your computer. 
Although these saved custom objects appear in the macOS Finder with a .molo filename 
extension (“Motion Library object”), you cannot open them from the Finder.

You can, however, move saved objects to another computer that has Motion installed, then 
access them from the Motion Library. For more information about saving custom objects, 
see Save custom objects to the Library.

1.	 In the macOS Finder, open your /Users/username/Library/Application Support/Motion/
Library/ folder.

Note: If the Library folder is hidden in the Finder, press and hold the Option key, then 
choose Go > Library.

2.	 Copy a custom saved object file (with a .molo filename extension) to the /Users/
username/Library/Application Support/Motion/Library/ folder on another computer that 
has Motion installed.

Make sure that you also copy any imported graphics, images, or movie files used to create 
your custom material (such as a JPEG file used as the source for a particle emitter). After 
you open the project, relink to the source media files. See Reconnect offline media in the 
Media Inspector.
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Copy a project preset to another computer
Each custom project preset you create (such as Broadcast HD 720) is saved as a 
separate file in your computer’s /Users/username/Library/Application Support/Motion/
Presets/ folder. If you create custom presets that you rely on, you can move them to other 
computers that have Motion installed.

1.	 In the macOS Finder, open your custom preset files to that computer’s /Users/
username/Library/Application Support/Motion/Presets/ folder.

Note: If the Library folder is hidden in the Finder, press and hold the Option key, then 
choose Go > Library.

2.	 Copy a custom preset file (with a .preset filename extension) to that computer’s /Users/
username/Library/Application Support/Motion/Presets/ folder.

For information on creating project presets, see Create and modify project presets.

Use color and gradient controls

Intro to using color controls in Motion
Use color controls to set the color of objects such as shapes, text, replicators, particles, 
and gradients. Use the gradient editor to select a preset gradient or to change gradient 
parameters, such as color, opacity, direction, and so on.

For information about selecting colors suitable for high-dynamic-range (HDR) projects, see 
Choose HDR colors.

Color controls

Use basic color controls in Motion

There are several basic color controls in Motion:

•	 Color well: A small color swatch that, when clicked, opens the macOS Colors window

•	 Down arrow: A down arrow button beside the color well that opens the Motion pop-up 
color palette, an alternative to the macOS Colors window

•	 Eyedropper: A control used to pick a color in use in the canvas

•	 Disclosure triangle: A control that, when clicked, reveals advanced color controls
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Change the color of an object using the basic Motion color controls
In Motion, do one of the following:

•	 Click the color well swatch, then pick a color from the macOS Colors window. See Use 
the Colors window.

•	 Click the down arrow or Control-click the color well, then pick a color from the Motion 
pop-up color palette. See Use the pop-up color palette.

•	 Click the eyedropper, then click an object of the desired color in the canvas. See Use 
the color eyedropper.

•	 Click the disclosure triangle on the left side of the color controls to expose individual 
Red, Green, Blue, and, when applicable, Opacity sliders. See Use expanded color 
controls.

Use the pop-up color palette in Motion

Use the pop-up color palette to select a color from the spectrum of hues, saturation, and 
brightness. You can also select a grayscale value.

Pick a color in the pop-up color palette
1.	 In the pop-up color palette in Motion, Control-click a color well or click the adjacent 

down arrow button.

2.	 Do any of the following:

•	 Click in the top area to select a color from the spectrum of hues, saturation, and 
lightness.

As you drag in either area, the pointer becomes an eyedropper, the column on the 
right displays the RGB and HLS values for the sampled colors, and two swatches 
above the RGB information display the current and sampled colors. As you sample in 
the spectrum, the selected object in the canvas updates dynamically.

•	 Click in the bottom gradient to select a grayscale value.
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Use the Colors window in Motion

You can use the macOS Colors window in Motion, giving you access to the familiar color 
pickers such as the color wheel, sliders, or pencils.

The row of boxes along the bottom of the Colors window can be used to save swatches.

Show the Colors window
In Motion, do one of the following:

•	 Click a color well.

•	 Choose View > Show Colors.

•	 Press Shift-Command-C.

Pick a color in the Colors window
In Motion, do one of the following:

•	 Click a color in the color picker area. 

•	 Click the magnifying glass, then click anywhere on the computer screen to choose a 
color.

Note: When you open the Colors window by clicking a Motion color well, the color you click 
in the Colors window loads into the well, and the selected object in the canvas changes 
color. However, when you open the Colors window from the View menu (or by pressing 
Shift-Command-C), clicking a color in the Colors window does not load the color into 
the well or change the selected object. In this case, drag a color swatch from the Colors 
window to the color well. Similarly, if you leave the Colors window open and select another 
object in the canvas, clicking in the Colors window does not change the newly selected 
object.
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Save a color to the swatch area in the Colors window
1.	 In the Colors window in Motion, click the magnifying glass, then click in the color picker 

or anywhere on the computer screen.

2.	 Drag the color you selected from the large swatch to a white square at the bottom of 
the Colors window. 

Colors saved in this area remain accessible across applications and restarts.

Remove a color from the swatch area in the Colors window
•	 In the swatch area of the Colors window in Motion, double-click a saved color square, 

then press Delete.

Use the color eyedropper in Motion

An eyedropper control beside the color well lets you pick a color in use in the canvas. By 
choosing from colors in your scene, you ensure that elements remain in the same palette, 
creating a more cohesive and integrated design. 

Pick a color using the eyedropper
1.	 In the Inspector in Motion, click the eyedropper for the color parameter you want to set.

The pointer turns into an eyedropper.

2.	 Click a color in the canvas.

That color is assigned to the color well.

Use expanded color controls in Motion

Sometimes you need precise numerical control over colors. You might also need to match 
two colors exactly or adjust a color channel independently. 

Every set of color controls has a disclosure triangle, which, when clicked, reveals sliders 
for the Red, Green, and Blue color channels. You can choose or fine-tune a color by 
adjusting these sliders. Among other uses, these controls are handy when you need to 
keyframe each color channel differently.

For information on setting colors in high-dynamic-range (HDR) projects, see Choose HDR 
colors.
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Gradient controls

Intro to using the gradient editor in Motion

Most attributes that can be filled with a color can also be filled with a gradient. Like color 
controls, gradient controls are a group of compound settings that can be expanded for 
more precise control.

You can apply a preset gradient style, create your own custom gradient style, and save 
gradient styles to the Library. 

Use a gradient preset in Motion

When the gradient editor is collapsed, you can select a preset gradient from the Gradient 
preset pop-up menu, located to the right of the gradient preview bar.

Change the current gradient to a saved preset
•	 In Motion, click the Gradient preset pop-up menu and choose a gradient preset.

The new gradient is shown in the gradient bar and is applied to the selected object in 
the canvas.
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Change gradient color and opacity in Motion

The gradient editor is a flexible and powerful tool, allowing you to create custom styles. 

Change the colors in a gradient
1.	 In Motion, click the Gradient disclosure triangle to show the gradient editor.

2.	 To change the color of a color tag in the gradient editor, do one of the following:

•	 Double-click a color tag.

The Colors window appears. Use the Colors window to set a color for the tag.

•	 Click a color tag, click the disclosure triangle to the left of Color parameter name, 
then adjust the Red, Green, and Blue color channel sliders.

•	 Control-click a color tag to display the pop-up color palette. Drag the eyedropper in 
the palette to select a color. Drag in the lower palette to set the tag to a grayscale 
color.

•	 Click a color tag, then Control-click the color well to display the pop-up color 
palette.

•	 Click a color tag, click the eyedropper tool, then click a color in the canvas.
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Change the opacity in a gradient
1.	 In Motion, click an opacity tag.

The Opacity slider is enabled.

2.	 Use the Opacity slider to change the level of transparency.

The gradient transparency reflects the new opacity values.

 Tip: The lower the percentage of the opacity, the greater the transparency.

Add or remove a color tag
•	 In Motion, position the pointer in the lower gradient bar where you want to add the new 

color, then click.

A new color tag is added to the gradient.

Note: Although the color, opacity, and position of the tags of a gradient can be 
animated, the number of color tags and opacity tags cannot.
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Add an opacity tag to a gradient
•	 In Motion, position the pointer in the opacity bar where you want to add the tag, then 

click.

A new opacity tag is added to the gradient. Until the value is adjusted, the gradient 
opacity is 100%.

Remove a color or opacity tag from the gradient
•	 In Motion, drag the tag away from the gradient bar.

The tag is removed.

Change gradient direction and spread in Motion

You can reverse the direction or evenly distribute the gradient color and opacity tags.

Reverse the gradient color or opacity direction
•	 In Motion, click the reverse tags icon next to the opacity or color bar.

The tags are reversed.

Evenly distribute the gradient color or opacity tags
•	 In Motion, click the distribute tags icon next to the opacity or color bar.

Change the direction of a shape’s gradient
1.	 In Motion, with the shape selected and the Inspector open, click the Gradient disclosure 

triangle to show the gradient editor.

2.	 Use the Start and End value sliders to change the direction of the gradient. 
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Modify gradient tags in Motion

There are many ways to manipulate tags in the gradient editor to create a custom gradient.

Move the position of a color tag or opacity tag
1.	 In Motion, click the color tag or opacity tag to move.

2.	 Do one of the following:

•	 Drag the color tag left or right.

•	 Use the Location slider to modify the position of the selected tag. A value of 100% is 
the rightmost position of the gradient, and a value of 0% is the leftmost position of 
the gradient.

Duplicate a color or opacity tag
•	 In Motion, Option-drag the tag to a position.

Change the transition midpoint between adjacent color or opacity tags
•	 In Motion, drag the small triangle between adjacent color tags or opacity tags to change 

the point where one tag’s effect ends and the next tag’s effect begins. The closer the 
middle control is to a tag, the sharper the color or opacity transition.

Note: The middle control does not appear for color or opacity tags set to Linear or 
Constant.

Change the color or opacity tag interpolation
•	 In Motion, click a tag, then click the Interpolation pop-up menu and choose Constant, 

Linear, or Continuous.

Save gradients in Motion

As with shape styles, after you create a gradient, you can save it in the Library.

Save a gradient in the Library
1.	 In the canvas or Layers list in Motion, select the object with the gradient to save.

2.	 In the Inspector, click the Gradient preset pop-up menu, then choose Save Gradient.

3.	 In the Save Preset To Library dialog, enter the name of the gradient.

4.	 Click Save.

The custom gradient appears in the Gradients category in the Library. Custom presets 
can be identified in the Library by the small user badge that appears in the lower-right 
corner of the larger gradient icon. The gradient also appears in the Gradient preset 
pop-up menu.
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Use onscreen gradient controls in Motion

Onscreen controls provide a more interactive way to edit a gradient’s attributes—color, 
location and value of color tags and opacity tags, and start and end points—in the canvas. 
You can also use onscreen controls to add color tags and opacity tags, as well as change 
their interpolation.

Display the onscreen gradient controls
Do one of the following:

•	 In the Motion canvas, Control-click the object with the applied gradient, then choose 
Edit Gradient from the shortcut menu.

Note: To adjust a Gradient generator’s gradient in the canvas, Control-click the 
generator and choose Edit Position from the shortcut menu.

•	 In the canvas toolbar, click and hold the transform tools pop-up menu, then choose 
Adjust Item.

The onscreen controls appear.
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Adjust the start and end gradient positions
In Motion, do one of the following:

•	 In the canvas, adjust the Start X and Y position of the gradient by dragging the top 
triangle (at the end of the gradient line).

•	 In the canvas, adjust the End X and Y position of the gradient by dragging the bottom 
triangle (at the end of the gradient line).

•	 In the canvas, adjust the End X and Y position of the gradient by dragging the circle. 
This onscreen control is only available when Radial is selected from the Type pop-up 
menu.

Change the location of gradient tags
In Motion, do one of the following:

•	 To change the location of gradient colors, drag the color tags along the gradient line in 
the canvas.

•	 To change the location of the gradient opacity, drag the opacity tags along the gradient 
line in the canvas.

Add a color or opacity tag
In Motion, do one of the following:

•	 To add a color tag, double-click the gradient control line.

•	 Control-click the gradient control line where you want the tag, then choose Add Color 
Tag or Add Opacity Tag from the shortcut menu.

•	 Option-click the gradient control line where you want a color tag.

•	 Option-Shift-click the gradient control line at the location where you want the tag.

Remove a color or opacity tag
•	 In Motion, drag the color tag or opacity tag away from the gradient line and release the 

mouse button.

Change the color or opacity of a gradient tag
•	 In Motion, Control-click the tag, then drag the eyedropper in the pop-up color palette to 

select a color or opacity value. For Opacity, white represents more opaque values and 
black represents complete transparency. As you drag, the gradient is actively updated.

Adjust the gradient interpolation, direction, or distribution
In Motion, do any of the following:

•	 Change a tag’s interpolation: Control-click the gradient control line next to the tag, 
choose Color Interpolation or Opacity Interpolation, then choose Constant, Linear, or 
Continuous from the submenu.

•	 Reverse the direction of a gradient: Control-click the gradient control line, then choose 
Reverse Color or Reverse Opacity from the shortcut menu.

•	 Evenly distribute tags: Control-click the gradient control line, then choose Distribute 
Color from the shortcut menu to distribute color tags, or Distribute Opacity to distribute 
opacity tags.
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Basic gradient controls in Motion

Most attributes that can be filled with a color can also be filled with a gradient. There are 
three basic gradient controls.

•	 Gradient preview bar: A horizontal bar that displays the currently selected gradient

•	 Gradient preset pop-up menu: An unlabeled pop-up menu to the right of the preview 
bar containing a list of gradient presets

•	 Disclosure triangle: A control that, when clicked, expands to show the gradient editor

Gradient editor controls in Motion

When you click the disclosure triangle to the left of the basic gradient controls, the 
expanded controls of the gradient editor become available. You can use these expanded 
controls to add keyframes and create animated gradient effects.

•	 Gradient preset pop-up menu: An unlabeled pop-up menu at the top of the gradient 
controls used to apply preset gradients or to save custom gradients.

•	 Graphical controls: Three horizontal bars that let you set and preview the opacity, color, 
and spread of a gradient.

The narrow, white top bar (the opacity bar) controls opacity and transparency in the 
gradient. Adjust the spread of opacity across the gradient by dragging one of the small 
box-shaped opacity tags horizontally along the bar. Click in the opacity bar to add 
opacity tags, creating a gradient with varying levels of transparency. Delete an opacity 
tag by dragging it away from the color bar. Change the value of an opacity tag by 
selecting it and dragging the Opacity slider (described below).

Opacity tags have a value range of 0% (completely transparent) to 100% (completely 
opaque). Adjust the transition between two opacity tags by dragging the middle 
control—a small triangle between adjacent tags, available when Interpolation is set to 
Continuous (described below). By default, the opacity of a gradient applied to text is 
100%. 
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The wide middle bar shows a preview of the current gradient. 

The narrow bottom bar (the gradient bar) controls color in the gradient. Adjust the 
spread of color across the gradient by dragging one of the small box-shaped color tags 
horizontally along the bar. Click in the gradient bar to add more color tags. Delete a 
color tag by dragging it away from the gradient bar. Change the value of a color tag by 
selecting it and choosing a color from the color well below, or by double-clicking the tag 
and choosing a color from the Colors window. Adjust the transition between color tags 
by dragging the middle control—a small triangle between adjacent tags, available when 
Interpolation is set to Continuous (described below). 

Selecting a color tag activates the Color and Location controls (described below). 
Selecting an opacity tag activates the Opacity slider (described below). Selecting a 
middle control activates the Middle slider (described below). 

•	 Color: A color well and eyedropper that sets the hue of a selected color tag in the 
gradient bar. For more information about color wells, see Use basic color controls.

•	 Opacity: A slider that sets the transparency of a selected opacity tag in the opacity bar. 
Values range from 0% (completely transparent) to 100% (completely opaque).

•	 Interpolation: A pop-up menu that sets the interpolation of a selected color tag or 
opacity tag. There are three options:

•	 Linear: Creates a uniform distribution of opacity or color between the tags.

•	 Continuous: Sets an adjustable rate of change between adjacent opacity or color 
tags. Adjust the rate of change by dragging a middle control in the opacity bar or 
gradient bar, or by dragging the Middle slider (described below).

•	 Constant: Creates a constant color distribution from the color or opacity tag, moving 
from left to right in the gradient. For example, if the left color tag is set to Constant, 
the area of the gradient between that tag and the next one to the right is a single, 
solid color.

•	 Middle: A slider that duplicates the function of the middle controls in the opacity bar 
and gradient bar, adjusting the transition point between opacity tags or color tags. 
When you select a middle control, the Middle slider becomes available. 

•	 Location: A slider that adjusts the location of a selected opacity tag or color tag.

•	 Type: A pop-up menu that lets you choose a linear or radial gradient.
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•	 Start: Value sliders that set the start position of the gradient in the selected object. This 
parameter affects the gradient as a whole—colors and opacity. Clicking the disclosure 
triangle stacks the X and Y value sliders vertically instead of horizontally.

•	 X: Controls the X start position of the gradient.

•	 Y: Controls the Y start position of the gradient.

•	 End: Value sliders that set the end position of the gradient in the selected object. This 
parameter affects the gradient as a whole—colors and opacity. Clicking the disclosure 
triangle stacks the X and Y value sliders vertically instead of horizontally.

•	 X: Controls the X end position of the gradient.

•	 Y: Controls the Y end position of the gradient.

Note: The Start and End parameters do not appear in text gradients.

•	 Angle: When the Type pop-up menu is set to Linear, this dial specifies the direction of a 
linear gradient. This parameter only appears for text gradients.
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Rasterization

Intro to rasterization in Motion
Some operations, as well as the application of specific filters or a mask, cause a group to 
be rasterized. When a group is rasterized, it’s converted into a bitmap image. This affects 
how the rasterized group interacts with other objects in the project.

Rasterization affects 2D and 3D groups in different ways:

•	 When a 2D group is rasterized, the blend modes on objects in the group no longer 
interact with objects outside the group.

•	 When a 3D group is rasterized, the group as a whole can no longer intersect with 
objects outside the group. The rasterized 3D group is treated as a single object and 
uses layer order (in the Layers list), rather than depth order when composited in 
the project. (For more information on layer order versus depth order, see Create 3D 
intersection.)

When a group is rasterized, cameras and lights in the project still interact with objects in 
the rasterized group.

Important: Lighting in a flattened 3D group does not pass beyond the boundaries of that 
group, whether rasterized or not.

The following operations on a 2D group trigger the rasterization of that group:

•	 Making Blending changes (to the Opacity, Blend Mode, or Preserve Opacity parameters)

•	 Turning on the Drop Shadow parameter

•	 Turning on the Four Corner parameter

•	 Turning on the Crop parameter

•	 Applying any filter

•	 Adding a mask

•	 Adding a light (if the 2D group the light is added to is nested in a 3D group)

The following operations on a 3D group trigger the rasterization of that group:

•	 Making blending changes

•	 Applying specific filters

See How rasterization affects filters.

•	 Adding a light to a 3D project with the Flatten parameter enabled (in the Group 
Inspector)
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When an operation triggers a rasterization on a group, the following occurs:

•	 A rasterization indicator (a small box containing an “R”) appears next to the parameter 
in the Properties Inspector.

•	 A small outline surrounds the rasterized group in the Layers list and Timeline. This is 
called a rasterization frame.

Unlike vector graphics, rasterized 2D groups may lose quality when scaled if the Fixed 
Resolution checkbox is selected in the Group Inspector.

Important: 3D particle emitters, 3D replicators, and nonflattened text objects are treated 
as 3D groups for rasterization

Examples of rasterization in Motion

2D groups and rasterization
The following pair of images shows the effect of rasterization on the blend modes of 
2D groups. In both images, the lone elephant layer, which is in the topmost group in the 
Layers list, overlaps a portion of the family of elephants layer, which resides in a separate 
2D group in the Layers list. In both examples, the lone elephant layer has its Blend Mode 
parameter set to Vivid Light. In the nonrasterized left example, the lone elephant’s blend 
mode interacts with the pixels of the group underneath it (the family of elephants). 
However, in the right example, the topmost group is rasterized. Consequently, its Vivid 
Light blend mode no longer interacts with the pixels of the second group. 

Important: If a group’s Blend Mode is set to Pass Through and the group’s layers have 
different Blend Modes applied, the layers are not rasterized.
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3D groups and rasterization
The next pair of images shows the effect of rasterization on the intersection of 3D groups. 
In the left image, the nonrasterized example, two groups (Group A and Group B) containing 
rectangle shapes intersect in 3D space. In the right image, Group A is rasterized; 
consequently, Group A and Group B no longer intersect.

How rasterization affects basic text in Motion
Rasterization affects how basic text interacts with other objects in your project.

If a text layer in a nonrasterized 2D group is set to a blend mode, such as Soft Light, 
it interacts with images in groups beneath it in the layer stack. After the 2D group is 
rasterized, the Soft Light blend mode no longer interacts with the layer beneath it.

 Tip: In this case, moving the image into the group that contains the text eliminates the 
rasterization issue.

Sometimes, text is rasterized independently of the group in which it resides, and that 
rasterization affects how the text interacts with objects in its own group. For example, 
applying a Circle Blur filter to basic text that exists in 3D space (such as text on a path) 
causes the text to no longer intersect with other objects in the same group.
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How rasterization affects 3D text and 3D objects in Motion
When rasterized, 3D text and 3D objects are converted into bitmap images, which changes 
how they intersect with each other and interact with other objects in your project. 3D text 
and 3D objects can be rasterized independently of the group in which they reside. 

The same operations that cause a 3D group to rasterize cause 3D text and 3D objects to 
rasterize. Consider the following rasterization guidelines when working with 3D text or 3D 
objects:

•	 3D objects intersect only with like objects. In other words, 3D text objects intersect only 
with other 3D text objects, and 3D objects intersect only with other 3D objects.

•	 When a 3D group containing 3D text or 3D objects is rasterized, the group as a whole 
can no longer intersect with objects outside the group. The rasterized 3D group 
is treated as a single object and uses layer order, rather than depth order, when 
composited in the project.

•	 When two 3D text objects or two 3D objects intersect with each other in a 2D group or 
3D group, and you apply a filter or make blending or opacity changes to an individual 
object, the objects no longer intersect.

•	 When two 3D text objects or two 3D objects intersect with each other in a 2D group, 
and you apply a filter or make blending or opacity changes to the 2D group, the objects 
still intersect.

•	 If two 3D text objects or two 3D objects intersect with each other in a 3D group, and 
you apply a filter to the 3D group, the objects no longer intersect.

•	 3D text and 3D objects use layer order: For 3D text or 3D objects to appear in front of 
other non-3D text or non-3D object layers, the 3D text or 3D object must be positioned 
above the other layers in the Layers list; the Z position (depth) of the 3D text or 3D 
object has no effect.

•	 In some situations, selecting the Flatten checkbox in the Layout pane of the Text 
Inspector can minimize the rasterization effect on 3D text.

How rasterization affects shapes in Motion
When a group becomes rasterized, all masks, shapes, and paint strokes in that group are 
affected and may no longer interact with other layers and groups as expected. Because 
paint strokes are rendered in a plane, they are always rasterized (independent of other 
objects in the same group). This affects how the dabs that comprise a paint stroke interact 
with objects in the same group.

Note: Because a paint stroke is always rasterized, no rasterization indicator appears around 
the paint stroke icon.



1405Motion User Guide

How rasterization affects particles and replicators in Motion
When a group becomes rasterized, particles and replicator elements in that group are 
affected and may no longer interact with other layers and groups as expected. Particles 
and replicators still interact in 3D with elements in the rasterized group.

A 3D particle emitter can be rasterized independently of the group in which it resides. 
Consequently, the resulting particles may not interact as expected with objects inside 
the same group. For example, applying a Circle Blur filter to a particle emitter causes the 
particles to no longer intersect with other objects in the same group. The same operations 
that cause a 3D group to rasterize cause a 3D particle emitter to rasterize. To minimize this 
effect, apply the filter to the emitter’s source object, or deselect the 3D checkbox in the 
Emitter Inspector.

When a group or a 3D particle emitter is rasterized, the group can no longer intersect with 
objects outside the group. In the following image on the left, the nonrasterized group that 
contains the particle emitter intersects with elements from another group (when Render 
Particles is set to In Global 3D). In the image on the right, a Bloom filter applied to the 
star particles group has triggered a rasterization, so the emitter no longer intersects with 
elements from another group.

Note: Unlike vector graphics, rasterized 2D groups may lose quality when scaled if the 
Fixed Resolution checkbox is selected in the Group Inspector.

In the following illustration on the left, the nonrasterized group that contains the replicator 
intersects with an image from another group. In the illustration on the right, a Gradient 
Blur filter applied to the replicator group has caused the replicator group to rasterize. As a 
result, the replicator no longer intersects with the image from another group.



1406Motion User Guide

How rasterization affects shadows in Motion
Rasterized 3D objects do not cast shadows. If you perform an action that causes a group 
to be rasterized (such as modifying the group opacity or enabling the glow setting for a 
text object), and you still want that group to cast a shadow, you must flatten the group. 

Flattened groups act as 2D layers and can cast and receive shadows as long as they 
are embedded in a 3D group. Text objects are flattened in the Layout pane of the Text 
Inspector, and 3D groups are flattened in the Group Inspector. Particle systems and 
replicators are flattened by deselecting the 3D checkbox in the Emitter Inspector or 
Replicator Inspector.

Rasterizing causes layers to be rendered in the stacking order shown in the Layers list. So 
even if the shadow-casting object is in front of the shadow-receiving object in the canvas, 
rasterizing it may cause it to change position to reflect the relative order of the layers in 
the Layers list. You may need to rearrange the layer order in the Layers list to enable the 
rasterized, flattened object to cast a shadow.

How rasterization affects filters in Motion
The application of some filters can cause a group to be rasterized. When a group is 
rasterized, it is converted into a bitmap image. In 2D groups, the application of any filter 
causes rasterization. In 3D groups, the application of specific filters causes rasterization.

The following filters force rasterization of 3D groups:

Blur filters
•	 Circle Blur

•	 Compound Blur

•	 Defocus

•	 Gradient Blur

•	 Radial Blur

•	 Variable Blur

•	 Zoom Blur
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Border filters
All Border filters force rasterization of 3D groups.

Color filters
No Color filters cause rasterization of 3D groups.

Distortion filters
All Distortion filters force rasterization of 3D groups.

Glow filters
•	 Gloom

•	 Light Rays

•	 Outer Glow

•	 Overdrive

Masks and Keying filters
•	 Green Screen Keyer

•	 Luma Keyer

•	 Matte Magic

Sharpen filters
All Sharpen filters force rasterization of 3D groups.

Stylize filters
•	 Add Noise

•	 Bad Film

•	 Bad TV

•	 Circle Screen

•	 Circles

•	 Color Emboss

•	 Crystallize

•	 Edges

•	 Extrude

•	 Halftone

•	 Hatched Screen

•	 Highpass

•	 Indent

•	 Line Art

•	 Line Screen
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•	 MinMax

•	 Noise Dissolve

•	 Pixellate

•	 Relief

•	 Slit Scan

•	 Slit Tunnel

•	 Texture Screen

•	 Vignette

•	 Wavy Screen

Tiling filters
All Tiling filters force rasterization of 3D groups.

Time filters
All Time filters force rasterization of 3D groups.

Video filters
The Deinterlace filter forces rasterization of 3D groups.

Work with GPUs in Motion
If you use an external graphics card (eGPU), you can choose whether to use your 
computer’s internal GPU or your eGPU when using Motion.

Use an eGPU with a second display 
In Motion, do one of the following:

•	 Choose Window > Show Canvas on Second Display.

•	 Drag the Motion project window to the eGPU’s display.

Motion now uses the eGPU for graphics rendering during playback and for RAM preview 
rendering.

To switch back to your internal GPU, drag the project window back to your computer’s 
display.

Use an eGPU without a second display
1.	 In the macOS Finder, select the Motion application, then choose File > Get Info (press 

Command-I).

2.	 In the Motion Info window, select Prefer eGPU.

The Prefer eGPU checkbox appears only if you have an eGPU connected to your 
computer. See the Apple Support article Use an external graphics processor with your 
Mac.

https://support.apple.com/102363
https://support.apple.com/102363
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GPU usage in Motion
If you have not selected Prefer eGPU in the Motion Info window (as described in the task 
above), the GPU used to render your project is also used to drive the display on which the 
canvas appears. Any additional GPUs that match the GPU that’s driving the display are also 
used (matching GPUs are identical internal models). If you have selected Prefer eGPU in 
the Motion Info window, only the eGPU is used, regardless of how many internal GPUs the 
system contains.

Although Motion does not use mismatched GPUs to render a single project, you can use 
mismatched GPUs to play back separate projects. For example, if you have one project 
open on your display (driven by your computer’s internal GPU) and another project open on 
a second display (driven by an eGPU), Motion uses the computer’s GPU to play back the 
first project and the eGPU to play back the second project.
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Glossary

alpha channel  Ordinary video clips and image files have three channels of color 
information: red, green, and blue. Many video and image file formats also support an 
additional alpha channel, which contains information defining areas of transparency. An 
alpha channel is a grayscale channel where white represents areas of 100 percent opacity 
(solid), gray regions represent translucent areas, and black represents 0 percent opacity 
(transparent).

When you import a QuickTime movie or an image file into a project, its alpha channel is 
immediately recognized by Motion. The alpha channel is then used to composite that 
object against other objects in the canvas.

aspect ratio  A film or video frame’s width-to-height ratio on any viewing screen. High-
definition (HD) video has an aspect ratio of 16:9.

canvas  The visual workspace in Motion. Here you can arrange objects in your project, 
adjust object parameters using onscreen controls, and play back your project. What you 
see in the canvas is what is exported when you share your project.

canvas toolbar  A row of tools in the center of the Motion window (under the canvas and 
above the timing toolbar), for manipulating objects in the canvas. Tools on the left side of 
the canvas toolbar let you transform objects in the canvas in 2D or 3D space, as well as 
zoom or pan the view in the canvas. Tools in the center of the canvas toolbar let you create 
shapes, paint strokes, text, and masks.

chroma  The color information contained in an image, consisting of hue, which represents 
the color itself, and saturation, which represents the intensity of the color.

clipping  In digital video, the state of an image with a color gamut that falls outside of the 
minimum and maximum level that can be represented in a color space. For example, when a 
Rec. 2020 source image is converted to Rec. 709, the image may appear “clipped” (colors 
muted or over- or underexposed when compared with the original) because the smaller 
target color space (Rec. 709) cannot reproduce the detail in the image’s original color 
space (Rec. 2020). Clipping can occur in any color channel of an image.

In digital audio, clipping describes a signal that exceeds the maximum sample value of 0 
dBFS during playback or recording, resulting in audio distortion.

codec  Short for compressor/decompressor, or encode/decode. A software component 
used to translate video or audio from its current form to a different, digitally compressed 
form. Apple ProRes and H.264 are common QuickTime video codecs.
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destination  A set of preconfigured export settings that you can use to share a project 
from Motion. Destinations make it easy to export a project as a movie, as an image 
sequence, as a single frame, or to export using the Compressor app. Motion comes with a 
variety of preconfigured destinations, and you can also modify destinations and create new 
destinations. You add and modify destinations in the Destinations pane of Motion Settings.

floating point  In computing, a formulaic representation of real numbers (whole numbers 
or fractions) as a sequence of digits separated by a decimal point. Depending on the 
number represented, the position of the decimal point moves (“floats”) left or right 
relative to the significant digits. Floating point numbers can represent both very large and 
very small numbers using a limited number of bits. Motion uses floating-point numbers 
(sometimes called float) to calculate values (such as color) quickly and precisely at orders 
of magnitude large and small.

high dynamic range (HDR)  A range of luminance values (levels of brightness) in an image 
that exceeds the luminance values of traditional, or standard-dynamic-range (SDR), 
images. For example, the HDR PQ standard can represent luminance values as high as 
10,000 nits (candelas per square meter) with a dynamic range of 14 stops or more, creating 
more realistic color transitions and revealing more detail in both shadows and highlights.

HDR10  A widely supported HDR media profile specified by the Consumer Technology 
Association, used in Ultra HD Blu-ray, and supported by most video streaming services.

HLG (Hybrid Log-Gamma)  One of the two supported systems in the ITU-R Rec. 2100 
standard for high-dynamic-range (HDR) video. The HLG transfer function relates image 
signal values to scene-relative light levels and is compatible with standard-dynamic-range 
(SDR) displays without the need for metadata. HLG was developed by the BBC and NHK 
broadcasting networks.

Inspector  A pane on the left side of the Motion window for adjusting the parameters of a 
selected object (an image, video clip, or effect) in your project.

inverse tone mapping  A technique that expands the narrower range of luminance values 
in standard-dynamic-range (SDR) images to a wider range of brightness values that can be 
shown on a high-dynamic-range (HDR) display.

Library  A pane on the left side of the Motion window for adding built-in filter effects, 
content, presets, behaviors, and other elements to your project.

luma  A value describing the brightness of an image. A luma channel is a grayscale image 
showing the range of brightness across the whole image or clip.

luminance  An objective measurement of light corresponding to intensity weighted by the 
spectral sensitivity of human vision. Luminance is measured in units of candelas per square 
meter (cd/m2), often referred to as nits.

marker  A visual reference point in the Timeline that identifies a specific frame. You can 
use markers to align different objects at specific points in time, quickly navigate to specific 
points in a sequence, add notes about a specific area in your project, and more. There are 
several kinds of markers: 

•	 Project markers are fixed to a specific frame or timecode value in the Timeline ruler.

•	 Object markers are attached to an object (or clip) in the Timeline.

•	 Template markers control the timing of templates that you export to Final Cut Pro.
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MOV  The QuickTime movie file format from Apple. This digital media container format is 
the basis for the MPEG-4 (MP4) format.

PQ (Perceptual Quantizer)  A high-dynamic-range (HDR) transfer function that relates 
image signal values to absolute light levels produced by a display. PQ is standardized in 
SMPTE ST 2084 and is one of the two supported transfer functions in the ITU-R Rec. 2100 
standard for HDR video. PQ is used in formats such as HDR10, HDR10+, and Dolby Vision.

Project Browser  A window that appears when you create a new project or open an existing 
project. In the Project Browser, you can choose from a list of preset project types or set 
custom project properties (resolution, frame rate, and duration).

Project pane  A pane containing three lists, each of which provides access to a different 
aspect of your project. The Layers list displays the stacking order of objects (groups, 
layers, cameras, lights, behaviors, filters, and so on) in your project. The Media list shows 
all still-image files and video files imported into your project. The Audio list shows all audio 
files imported in your project (and allows you to adjust basic audio parameters of each 
audio file, such as volume).

Rec. 709  Short for ITU-R Recommendation BT.709, the standard broadcast color space 
for high-definition (HD) television.

Rec. 2020  Short for ITU-R Recommendation BT.2020, the designated color space for 
ultra-high-definition (UHDTV) television with standard dynamic range and wide color 
gamut.

Rec. 2100  A wide-gamut HDR standard that uses Rec. 2020 color primaries and either PQ 
or HLG transfer functions.

Rosetta  A translation process that provides application compatibility between different 
CPU architectures. When Mac computers transitioned from PowerPC-based systems to 
Intel-based systems, Rosetta dynamically translated most PowerPC-based applications to 
work with Intel-based Macs. Using the translation technology of Rosetta 2 in macOS Big 
Sur, Mac apps that haven’t been updated will run on Apple silicon.

standard dynamic range (SDR)  The conventional technique for processing luminance 
(brightness) and color values in images, developed in the mid-1900s, with a nominal 
maximum brightness of 100 nits (candelas per square meter) and a dynamic range of 6 
to 10 stops. Some newer imaging devices can display high dynamic-range (HDR) images, 
representing a much wider range of brightness levels.

Timing pane  A pane at the bottom of the Motion window, lets you view and modify the 
time component of a project’s contents. In the Timing pane, you can view the Video 
Timeline, Audio Timeline, or Keyframe Editor (each alone or in a combined view).

timing toolbar  Controls immediately below the canvas toolbar for project playback 
(transport controls), keyframe recording, muting audio, looping playback, and showing or 
hiding elements in the Timing pane.

tone mapping  A technique that restricts the wide range of luminance values in high-
dynamic-range (HDR) images to a narrower range of brightness values that can be shown 
on a standard-dynamic-range (SDR) display.

toolbar  Controls at the top of the Motion window to import media, add effects and other 
objects to your project, display interface components, and export your finished project.
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transcode  To convert a media file to a different format or change its properties. All media 
files use a format. Video format examples include Apple ProRes, H.264, HDV, and MPEG-
4. Video files also have a variety of properties, such as video frame size and frame rate, 
data rate, and audio sample rate. Compressor, an Apple app designed to work with Motion, 
makes transcoding media files a fast and easy process.

transport controls  Controls in the timing toolbar (under the canvas toolbar) for project 
playback.

USDZ  A 3D file format developed by Pixar and Apple based on Pixar’s Universal Scene 
Description (USD) framework. Although the assets are rendered in a single zip archive, the 
file format is a zero-compression, unencrypted zip archive of the USD format. USDZ was 
developed for creating and easily sharing 3D augmented reality (AR) content.

watermark  A visible graphic or text overlay applied to an image or a video clip to indicate 
that it’s protected by a copyright. Watermarks are used to discourage the use of images or 
media without the copyright holder’s explicit permission.
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